
Instrukcja obsługi

1



Zespół dokumentacji Steinberg: Cristina Bachmann, Heiko Bischoff, Lillie Harris, Christina 
Kaboth, Insa Mingers, Matthias Obrecht, Sabine Pfeifer, Benjamin Schütte, Marita Sladek

Tłumaczenie: Ability InterBusiness Solutions (AIBS), Moon Chen, Jérémie Dal Santo, Rosa 
Freitag, Josep Llodra Grimalt, Vadim Kupriianov, Filippo Manfredi, Roland Münchow, Boris 
Rogowski, Sergey Tamarovsky

Ten dokument zapewnia lepszy dostęp dla osób niewidomych lub niedowidzących. Należy 
pamiętać, że ze względu na złożoność i liczbę obrazów w tym dokumencie nie jest możliwe 
zamieszczenie opisów tekstowych obrazów.

Informacje zawarte w tym dokumencie mogą ulec zmianie bez powiadomienia i nie stanowią 
zobowiązania ze strony Steinberg Media Technologies GmbH. Oprogramowanie opisane w tym 
dokumencie podlega Umowie licencyjnej i nie może być kopiowane na inne nośniki, z wyjątkiem 
przypadków wyraźnie dozwolonych w Umowie licencyjnej. Żadna część tej publikacji nie może 
być kopiowana, powielana lub w inny sposób transmitowana lub nagrywana w jakimkolwiek celu 
bez uprzedniej pisemnej zgody Steinberg Media Technologies GmbH. Zarejestrowani 
licencjobiorcy opisanego tutaj produktu mogą wydrukować jedną kopię tego dokumentu do użytku 
osobistego.

Wszystkie nazwy produktów i firm są znakami towarowymi ™ lub ® ich odpowiednich właścicieli.
Więcej informacji można znaleźć na stronie www.steinberg.net/trademarks.

© Steinberg Media Technologies GmbH, 2020.

Wszelkie prawa zastrzeżone.

Cubase Pro_11.0.0_en-US_2020-11-11

2

http://www.steinberg.net/trademarks


Spis treści

8    Nowe funkcje
11 Wprowadzenie
11 Dokumentacja niezależna od platformy
11 Dokumenty PDF i Dokumentacja online
12 Konwencje
13 Skróty klawiaturowe
14 Konfigurowanie systemu
14 Okno dialogowe ustawień Studio
15 Konfigurowanie dźwięku
22 Konfigurowanie MIDI
25 Synchronizatory
26 Połączenia audio
26 Okno połączeń audio
32 Zmiana nazw wejść i wyjść sprzętowych
33 Dodawanie szyn wejściowych i 
     wyjściowych
33 Dodawanie szyn podrzędnych
34 Presety dla szyn wejściowych i 
     wyjściowych
35 Dodawanie kanałów grupowych i FX
35 Szyna monitorująca
35 Zewnętrzne instrumenty i efekty
42 Konfiguracje magistrali
44 Okno projektu
45 Wyświetlanie/ukrywanie stref
45 Strefa Projektu
60 Lewa strefa
68 Strefa dolna
74 Prawa strefa
80 Fokus klawiatury w oknie projektu
82 Powiększanie w oknie projektu
85 Funkcja przyciągania
88 Kursor celownika
88 Okno dialogowe edycji historii
90 Obsługa kolorów
98 Obsługa projektu
98 Tworzenie nowych projektów
98 Piasta
100 Okno Asystenta Projektu
101 Pliki projektu
101 Pliki szablonów
104 Okno dialogowe konfiguracji projektu
107 Otwieranie plików projektu
108 Zapisywanie plików projektu
109 Powrót do ostatnio zapisanej wersji
109 Wybór lokalizacji projektu
110 Samodzielne projekty
112 Ścieżki
112 Okno dialogowe ustawień inspektora ścieżek
115 Okno dialogowe ustawień sterowania ścieżką
121 Okno dialogowe Dodaj ścieżkę
122 Ścieżki dźwiękowe
125 Ścieżki instrumentów
129 Ścieżki samplera
132 Ścieżki MIDI

136 Ścieżki kanałów grupowych
139 Ścieżki kanałów FX
142 Ścieżka tłumika VCA
144 Ścieżka znaczników
146 Ścieżka linijki
148 Folder ścieżek
151 Więcej utworów
161 Obsługa ścieżek
161 Dodawanie torów za pomocą okna dialogowego   
       Dodaj ścieżkę
161 Dodawanie ścieżek za pomocą ustawień 
       wstępnych ścieżek
162 Dodawanie utworów przez przeciąganie plików z
       MediaBay
162 Ścieżka Import
167 Ścieżka Eksport
168 Eksportowanie ścieżek MIDI jako standardowych 
       plików MIDI
170 Dzielenie wielokanałowych ścieżek audio
171 Scalanie monofonicznych ścieżek audio w 
        wielokanałowe ścieżki
173 Usuwanie wybranych ścieżek
173 Usuwanie pustych ścieżek
173 Przenoszenie utworów na liście utworów
173 Zmiana nazw utworów
174 Automatyczne przypisywanie kolorów do nowych 
       ścieżek / kanałów
174 Wyświetlanie obrazów ścieżek
176 Ustawianie wysokości ścieżki
177 Wybieranie utworów
178 Odznaczanie ścieżek
178 Powielanie ścieżek
178 Wyłączanie ścieżek
178 Organizowanie ścieżek w folderach Ścieżki
179 Obsługa nakładających się dźwięków
180 Menu składania ścieżek
180 Zdarzenia wyświetlane na ścieżkach folderów
181 Modyfikowanie wyświetlania zdarzeń na 
       ścieżkach folderów
181 Ścieżki, ujmowanie nakładających się zdarzeń
184 Definiowanie podstawy czasu ścieżki
185 Wersje ścieżek
192 Presety ścieżek
199 Części i zdarzenia
199 Zdarzenia
203 Części
204 Techniki edycji części i zdarzeń
223 Edycja zakresu
223 Tworzenie zakresu wyboru
225 Edycja zakresów wyboru
228 Odtwarzanie i transport
228 Panel transportu
233 Menu transportu
238 Pasek transportu
243 Wyskakujące okienko transportu
244 Okno wyświetlania czasu
245 Lewe i prawe lokalizatory
247 Ustawianie kursora projektu
248 Menu ustawień automatycznego przewijania

3



249 Formaty czasu
249 Pre-Roll i Post-Roll
250 Punch In i Punch Out
251 Kliknij metronom
259 Chase (Pościg)
261 Klawiatura ekranowa
261 Nagrywanie MIDI za pomocą klawiatury       
        ekranowej
261 Opcje klawiatury ekranowej
263 Nagrywanie
263 Podstawowe metody nagrywania
268 Monitorowanie
270 Specyfikacja nagrywania dźwięku
275 Szczegóły nagrywania MIDI
283 Pozostały czas nagrywania
283 Zablokuj nagrywanie
284 Importowanie plików audio i plików 
       MIDI
284 Import plików audio
291 Import plików MIDI
293 Kwantyzacja MIDI i audio
293 Funkcje kwantyzacji
294 Rozpoczęcie kwantyzacji zdarzenia MIDI
295 Długości kwantyzacji zdarzeń MIDI
295 Kwantyzacja zakończeń zdarzeń MIDI
295 Rozpoczyna się kwantyzacja zdarzenia audio
296 długości kwantyzacji zdarzeń audio (kwantyzacja 
        AudioWarp)
296 Kwantyzacja wielu ścieżek audio
298 Panel kwantyzacji
307 Zanikanie, przenikanie i obwiednie
307 Zanikanie oparte na zdarzeniach
311 Tworzenie przejść opartych na klipach
312 Przenikania
315 Zanikanie automatyczne i obwiednie
317 Zdarzenie Envelopes
319 Ścieżka Arranger
319 Dodawanie zdarzeń aranżera na ścieżce Arranger
320 Edytor aranżacji
323 Konfigurowanie łańcucha aranżera i dodawanie
       zdarzeń
325 Tryb Jump
326 Aranżowanie muzyki do wideo
328 Funkcje transpozycji
328 Klucz główny projektu
331 Ścieżka transpozycji
333 Zachowaj transpozycję w zakresie oktaw
334 Transpozycja w linii informacyjnej
335 Wyłączanie poszczególnych części lub zdarzeń z
       globalnej transpozycji
336 Znaczniki
336 Znaczniki pozycji
336 Znaczniki cykli
337 Pokazywanie / ukrywanie linii znaczników w 
       oknie Project Window
338 Pokazywanie/ukrywanie linii znaczników w 
       edytorze Key Editor
339 Okno znaczników
342 Ścieżka znaczników
344 Importowanie i eksportowanie znaczników
347 MixConsole
347 MixConsole w dolnej strefie
349 Okno MixConsole

419 Suwaki (tłumiki) VCA
419 Ustawienia tłumika VCA
421 Tworzenie suwaków VCA w MixConsole
422 Przypisywanie suwaków VCA do grup połączeń
422 Usuwanie suwaków VCA z grup połączeń
423 Zagnieżdżone suwaki VCA
423 Automatyzacja suwaków VCA
425 Pokój kontrolny (Control Room)
425 Dodawanie kanałów do pokoju kontrolnego
426 Routing wyjściowy
426 Wyłączne przypisanie kanałów monitorujących
426 Kanały w pokoju kontrolnym
427 Pokój kontrolny — zakładka główna
433 Pokój kontrolny — zakładka Wstawek (Inserts)
435 Konfigurowanie Cue Mix
436 Regulacja ogólnego poziomu wysyłania Cue
437 Pomiar i głośność
437 Pomiar
443 Efekty Audio
443 Efekty Insert i efekty Send
445 Efekty Insert
453 Selektor efektów VST
453 Efekty Send
459 Łańcuch boczny (Side-Chaining)
463 Efekty Dither
463 Efekty zewnętrzne
464 Panel sterowania efektami
467 Presety efektów
472 Okno informacji o składnikach systemu
475 Bezpośrednie przetwarzanie w trybie 
        offline
476 Bezpośredni przepływ pracy w trybie offline
477 Okno bezpośredniego przetwarzania w trybie 
       offline
488 Wbudowane procesy audio
497 Skróty klawiaturowe do bezpośredniego 
       przetwarzania w trybie offline
499 Algorytmy Time Stretch i Pitch Shift
499 Elastique
499 MPEX
500 Standard
501 Ograniczenia
502 Funkcje audio
502 Okno dialogowe „Wykryj ciszę”
505 Okno analizatora widma
507 Okno statystyk
509 Edytor próbek
511 Pasek narzędzi edytora próbek
515 Linia informacyjna 
516 Linia przeglądowa
516 Inspektor edytora próbek
519 Linijka
520 Wyświetlacz przebiegów
522 Edycja zakresu
526 Lista regionów
528 Punkt przyciągania
531 Punkty uderzenia (Hitpoints)
531 Obliczanie punktów uderzenia
534 Lokalizowanie punktów uderzenia w oknie 
        projektu
534  Kawałki
537 Tworzenie mapy kwantyzacji Groove
537 Tworzenie znaczników
537 Tworzenie regionów

4



538 Tworzenie zdarzeń
538 Tworzenie znaczników osnowy
538 Tworzenie nut MIDI
540 Tempo Matching Audio
540 Presety Algorithm
541 Rozciąganie zdarzeń audio do tempa projektu
541 Tryb muzyczny (Musical)
543 Automatyczna regulacja
544 Regulacja ręczna
545 Wolna osnowa
547 Proces spłaszczania w czasie rzeczywistym
548 Okno dialogowe procesu spłaszczania w czasie 
        rzeczywistym
548 Nierozciągnięte pliki audio 
549 Pitch Editing i Time Correction with
       VariAudio
549 VariAudio i procesy offline
550 Sekcja Inspektora VariAudio
551 Inteligentne sterowanie
553 Segmentacja dźwięku monofonicznego
554 Segmenty i luki
555 Przesłuchanie
555 Nawigacja i Zoom
556 Edycja segmentów
558 Zmiany tonacji
565 Modyfikacje timingu
566 Wyświetlanie ścieżek referencyjnych MIDI
567 Przesunięcie formatu
568 Edycja głośności
568 Menu funkcji
572 głosy harmonii dla Audio
574 Edytor części audio
575 Pasek narzędzi edytora części audio
580 Linia informacyjna
580 Linijka
580 Pasy
581 Operacje
584 Rozszerzenia w Cubase
584 Aktywacja rozszerzeń w Cubase
585 Edytor rozszerzeń
586 Aktywacja rozszerzenia dla kolejnych zdarzeń 
       audio
586 Dezaktywacja rozszerzenia dla zdarzeń audio
587 Edycja zdarzeń audio
588 Ścieżki samplera
588 Ładowanie próbek audio do sterowania samplerem
589 Ładowanie partii MIDI do sterowania samplerem
589 Tworzenie ścieżek samplera
589 Sterowanie samplerem
604 Funkcje edycji i odtwarzania sampli
608 Przesyłanie próbek z kontrolera samplera do
        instrumentów VST
610 Pula (Pool)
610 Okno „Pool” (pula)
614 Praca z pulą
629 MediaBay i Media Rack
629 MrdiaBay w Right Zone
640 Okno MediaBay
667 Praca z woluminowymi bazami danych
669 Ustawienia MediaBay

671 dźwięk przestrzenny
671 Przedmioty dostawy
672 Dostępne konfiguracje kanałów surround
673 Przygotowania do tworzenia miksów  
        przestrzennych
676 VST MultiPanner
688 MixConvert V6
692 Eksport miksu przestrzennego
692 Miksy Ambisonics
705 Automatyzacja
705 Krzywe automatyzacji
705 Linia wartości statycznej
705 Automatyzacja zapisu/odczytu
706 Zapisywanie danych automatyzacji
708 Edycja zdarzeń automatyzacji
712 Ścieżki automatyki
713 Virgin Territory a wartość początkowa
714 Panel automatyki
726 Instrumenty VST
726 Dodawanie instrumentów VST
726 Panel kontrolny instrumentu VST
728 Selektor instrumentów VST
729 Tworzenie ścieżek instrumentów
729 Instrumenty VST w Right Zone
730 Okno Instrumenty VST
730 Pasek narzędzi okna instrumentów VST
731 Sterowanie instrumentami VST
733 Presety dla instrumentów
735 Odtwarzanie instrumentów VST
737 Opóźnienie (Latency)
738 Opcje importu i eksportu
739 Szybkie sterowanie VST
741 Strona-Łańcuch dla instrumentów VST
742 Instrumenty zewnętrzne
743 Instalowanie i zarządzanie wtyczkami  
       VST
743 Wtyczki i kolekcje
746 Dodawanie nowych kolekcji wtyczek
747 Ukrywanie wtyczek
748 Ponowna aktywacja wtyczek z listy   
        zablokowanych
749 Ścieżka „Szybkie Sterowanie”
750 Przypisanie parametrów
753 Sterowanie automatycznymi parametrami
754 Łączenie szybkich sterowań ścieżki ze zdalnym
        sterowaniem
756 Zdalne sterowanie Cubase
756 Łączenie zdalnych urządzeń
756 Usuwanie wejścia zdalnego sterowania ze    
        wszystkich wejść MIDI
757 Konfigurowanie zdalnych urządzeń
759 Urządzenia zdalne i automatyzacja
759 Przypisywanie poleceń zdalnym urządzeniom
760 Ogólna strona zdalnego sterowania
765 Edytor zdalnego sterowania
770 Joysticki
770 Ścieżka szybkie sterowanie (Quick Controls)
770 Szybkie sterowanie VST
771 parametrów MIDI w czasie rzeczywistym i 
efektów MIDI
771 Parametry ścieżki MIDI
773 Modyfikatory MIDI
778 Efekty MIDI
781 Transpozycja i prędkość w linii informacyjnej

5



782 Korzystanie z urządzeń MIDI
782 Komunikaty o zmianie programu i wybór banku
       Wiadomości
783 Patch Banks
783 Menedżer urządzeń MIDI
788 Panele urządzeń
792 Funkcje MIDI
792 Okno dialogowe konfiguracji transpozycji
793 Scalanie zdarzeń MIDI w nową partię
795 Okno dialogowe rozpuszczania części
796 Odbijające się partie MIDI
797 Powtarzanie zdarzeń MIDI niezależnej ścieżki
       Pętle (Loops)
797 Rozszerzanie nut MIDI
797 Ustalanie długości nut MIDI
798 Naprawianie prędkości nut MIDI
798 Renderowanie danych pedału podtrzymującego do 
       długości nut
799 Usuwanie nakładek
799 Edycja Velocity
800 Usuwanie podwójnych nut
800 Usuwanie danych kontrolera
800 Usuwanie ciągłych danych kontrolera
801 Ograniczanie głosów polifonicznych
801 Rozrzedzenie danych kontrolera
801 Ekstrakcja automatyzacji MIDI
802 Odwracanie kolejności odtwarzania zdarzeń MIDI
802 Odwracanie kolejności wybranych zdarzeń MIDI
802 Tworzenie ścieżki tempa na podstawie stukania
804 Edytory MIDI
804 Typowe funkcje edytora MIDI
812 Wyświetlacz kontrolera
836 Edytor klucza (Key)
854 Operacje edytora klucza
870 Edytor perkusyjny (Drum)
881 Operacje edytora perkusyjnego
884 Mapy perkusyjne
889 Edytor listy (List)
898 Operacje edytora list
903 Edytor lokalny
906 Mapy wyrażeń
907 Artykulacje
907 Okno konfiguracji mapy wyrażeń
909 Tworzenie i edytowanie map wyrażeń
915 Wstawianie artykulacji
918 Wyrażenia nut
919 Wyrażenia nut VST
920 Kontrolery MIDI
924 Sekcja inspektora wyrażeń nut
928 Narzędzia do wyrażania nut
928 Mapowanie kontrolera
930 Nagrywanie
933 Edytor zdarzeń wyrażenia nut
938 Przycinanie danych wyrażenia nuty
939 Usuwanie wszystkich danych wyrażenia nutowego
939 Okno dialogowe ustawień wyrażenia nut MIDI
943 Funkcje akordów
943 Ścieżka akordowa (Chord)
944 Zdarzenia akordowe
951 Wydarzenia w skali
953 Głosy
956 Konwertowanie zdarzeń akordowych na MIDI

957 Sterowanie odtwarzaniem MIDI lub audio za   
        pomocą ścieżki akordowej
962 Przypisywanie głosów do nut
962 Wyodrębnianie zdarzeń akordowych z MIDI
963 Nagrywanie zdarzeń akordowych za pomocą  
        klawiatury MIDI
964 Pady akordowe
964 Strefa padów akordowych
967 Menu funkcji
967 Asystent akordów
971 Przypisywanie akordów
974 Zamiana przypisań akordów
975 Kopiowanie przypisań akordów
975 Odtwarzanie i nagrywanie akordów
978 Konfiguracja odtwarzacza
985 Okno dialogowe ustawień padów akordowych
990 Ustawienia padów akordowych
991 Tworzenie zdarzeń akordowych z padów  
        akordowych
991 Tworzenie partii MIDI z padów akordowych
992 Edytor logiczny
992 Przegląd okna
993 Warunki filtrowania
1002 Wybór funkcji
1003 Określanie działań
1005 Stosowanie zdefiniowanych działań
1006 Presety
1007 Edytor logiczny projektu
1007 Omówienie okna Edytora logicznego projektu
1008 Warunki filtrowania
1017 Określanie działań
1020 Wybór funkcji
1021 Stosowanie makr
1021 Stosowanie zdefiniowanych działań
1021 Presety
1023 Edycja tempa i metrum
1023 Tryby tempa projektu
1023 Ścieżka Podstawa czasu
1024 Edytor ścieżek Tempo
1026 Ścieżka Tempo
1028 Zmiany tempa dla projektów
1032 Ustawianie stałego tempa projektu
1034 Kalkulator uderzeń
1035 Wykrywanie tempa
1036 Eksportowanie ścieżki tempa
1036 Importowanie ścieżki tempa
1037 Okno dialogowe procesu tempa
1038 Okno dialogowe pasków procesu
1038 Osnowa czasu
1040 Ustaw definicję z oknem dialogowym Tempo
1040 Zdarzenia metrum
1043 Przeglądarka projektów
1043 Pasek narzędzi przeglądarki projektów
1044 Struktura projektu
1044 Wyświetlanie zdarzeń
1047 Renderowanie Audio i MIDI
1047 Okno dialogowe renderowania ścieżek
1050 Okno wyboru renderowania
1053 Eksport miksu audio
1053 Okno dialogowe eksportu miksu audio
1062 Miksowanie do plików audio
1063 Miksowanie do plików audio za pomocą kolejek  
          zadań

6



1067 Dostępne kanały do eksportu

1067 Pliki Formats
1073 Zapisywanie pliku ustawień wstępnych Formats
1074 Synchronizacja
1074 Master i Slave (Zwierzchnik i podwładny)
1075 Formaty kodu czasowego
1077 Źródła Zegara
1078 Okno dialogowe konfiguracji synchronizacji   
          projektu
1083 Panel główny MMC
1083 Zewnętrzna synchronizacja
1084 Konfigurowanie synchronizacji dla osobistego
          studia muzycznego
1086 Łącze systemowe VST
1086 Konfigurowanie łącza systemowego VST
1091 Aktywacja łącza systemowego VST
1093 Przykłady zastosowań
1097 Wideo (Video)
1097 Zgodność plików wideo
1098 Klatki na sekundę
1099 Urządzenia wyjściowe wideo
1099 Przygotowania do tworzenia projektów wideo
1101 Przygotowania do odtwarzania wideo
1104 Edycja wideo
1105 Eksport wideo
1108 Wyodrębnianie dźwięku z wideo
1109 Wymiana plików z innymi   
         aplikacjami
1109 Pliki OMF
1113 Pliki AAF
1118 ReWire
1118 Włączanie aplikacji ReWire
1119 Start i rezygnacja
1120 Aktywacja kanałów ReWire
1120 Używanie regulatorów transportu i tempa
1121 Jak obsługiwane są kanały ReWire
1122 Routing MIDI przez ReWire
1122 Rozważania i ograniczenia
1123 Skróty klawiaturowe
1123 Okno dialogowe skrótów klawiaturowych
1126 Przypisywanie kluczowych poleceń
1126 Wyszukiwanie kluczowych poleceń
1127 Usuwanie skrótów klawiaturowych
1127 Konfigurowanie makr
1127 Zapisywanie zaprogramowanych skrótów    
          klawiaturowych
1128 Ładowanie ustawień wstępnych poleceń 
          klawiszowych
1128 Resetowanie skrótów klawiaturowych
1128 Domyślne skróty klawiaturowe
1141 Konfigurowanie klawiszy modyfikujących \  
          narzędzia
1142 Dostosowywanie
1142 Obszary robocze
1145 Opcje ustawień
1147 Profile
1151 Okno dialogowe systemu Windows
1152 Gdzie są przechowywane ustawienia?
1152 Okno dialogowe trybu awaryjnego
1155 Optymalizacja wydajności Audio
1155 Aspekty wydajności
1156 Ustawienia wpływające na wydajność
1156 Okno wydajności audio

1157 ASIO-Guard
1159 Preferencje
1159 Okno dialogowe preferencji

1161 Edycja
1165 Edytory
1166 Wyświetlanie zdarzeń
1169 General
1171 MIDI
1174 MediaBay
1175 Pomiar
1175 Nagrywanie
1177 Partytury
1179 Transport
1180 Interfejs użytkownika
1181 VST
1184 VariAudio
1185 Wideo
1186 Indeks

7



Nowe funkcje

Poniższa lista informuje o najważniejszych ulepszeniach w Cubase i zawiera linki do odpowiednich
opisów.
Nowe funkcje w wersji 11.0.0  
Przegląd najważniejszych wydarzeń

Nowe funkcje i czcionki edytora partytury
 Edytor partytury (Score Editor) został wzbogacony o wiele wspaniałych dodatków i 

ulepszeń. Nowa karta Właściwości umożliwia natychmiastowy dostęp do opcji i ustawień 
dla określonych elementów wybranych w zapisie nutowym, a dzięki nakładce edycji nut 
można edytować nuty tak wygodnie, jak w edytorze klawiszy (Key Editor). Jest więcej 
ulepszeń przepływu pracy, a Score Editor obsługuje teraz również format czcionek 
SMuFL, który przenosi piękne czcionki Dorico Bravura i Petaluma do Cubase. Zobacz 
Układ partytury i drukowanie.

Imager
 Ta nowa wtyczka pomaga uzyskać lepszy, czystszy miks. Możesz niezależnie umieszczać 

ścieżki audio w polu stereo w maksymalnie czterech pasmach, co pozwala rozszerzyć lub 
zmniejszyć szerokość stereo dźwięku. Indywidualne wyświetlacze oscyloskopu i korelacji
pomagają uzyskać absolutnie perfekcyjne panoramowanie. Wtyczka jest opisana w 
osobnym dokumencie Informacje o wtyczce. Zobacz Imager

Zgniatacz (Squasher)
 Ta dynamiczna wtyczka łączy kompresję w górę iw dół dla maksymalnie trzech pasm. 

Użyj go, aby pomóc dźwiękom prowadzącym przebić się przez miks, oswoić agresywne 
linie basowe lub wzmocnić subtelny, przestrzenny pogłos. Wtyczka jest opisana w 
osobnym dokumencie Informacje o wtyczce. Zobacz Squasher.

Frequency 2 (Frequency)
 Korektor częstotliwości 2 zapewnia osiem pasm, z których każdy można indywidualnie 

ustawić na dynamiczne filtrowanie w celu uzyskania bardziej dynamicznego miksu. 
Możesz także znaleźć obsługę kanałów środkowych / bocznych i tryb Linear Phase dla 
każdego pasma, funkcję automatycznego słuchania, aby usłyszeć dokonane regulacje, 
wyświetlacz widma, a nawet klawiaturę muzyczną, która pomoże Ci znaleźć właściwy 
ton. Wtyczka jest opisana w osobnym dokumencie Informacje o wtyczce. Patrz 
Częstotliwość 2.

SpectraLayers One
 Ta kompaktowa wersja uznanego narzędzia do wizualnej edycji dźwięku umożliwia 

wizualizację i dokładne oczyszczanie dźwięku. Dzięki najnowocześniejszemu silnikowi 
separacji źródeł możesz oddzielić partię wokalną od dowolnego rodzaju ścieżek audio. 
Jego zaawansowana technologia ARA umożliwia widok spektrogramu ścieżek audio z 
idealną równowagą narzędzi do wyboru, edycji i wyświetlania do zadań edycji 
chirurgicznej, takich jak poprawianie dialogów i dźwięków lokalizacji bezpośrednio z 
rejestratora terenowego, bez potrzeby stosowania aplikacji innych firm. Narzędzie zostało 
opisane w osobnym dokumencie SpectraLayers One. Zobacz Spectralayers One.

Ulepszenia ścieżki samplera
 Ścieżka samplera zawiera wiele wspaniałych nowych funkcji. Nowy tryb krojenia dzieli 

twoje pętle, dzięki czemu są gotowe do gry za pomocą jednego kliknięcia. Dostępne są 
teraz dwa globalne LFO do dodawania ruchu i interesujących efektów. Możesz wybrać 
styl vintage lub najwyższą wierność dzięki nowym trybom jakości silnika sampli. A nowy
mono legato glide jest idealny dla typowych linii basowych 808 i nie tylko. Zobacz 
ścieżki samplera (Sampler Tracks).
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Ulepszenia edycji Pitchbend i kontrolera
● Możesz wybrać, czy chcesz, aby dla nowych zdarzeń kontrolera domyślnym typem były rampy 
czy stopnie. Patrz Menu ustawień pasa kontrolera.
● Możesz skopiować wszystkie zmiany CC na inną ścieżkę. Zobacz Menu kontekstowe toru 
kontrolera.
● Możesz ustawić kroki pitchbendu na półtony, aby zawsze były idealnie dostrojone. Zobacz Pasy 
kontrolera Pitchbend.
● Możesz tworzyć rampy i krzywe na torach CC i Pitchbend, tak jak jesteś przyzwyczajony do 
automatyzacji. Zobacz Tworzenie płynnych przejść między ciągłymi zdarzeniami kontrolera.
● Możesz usuwać nuty MIDI za pomocą prostego, szybkiego dwukrotnego kliknięcia. Zobacz 
Usuwanie zdarzeń nut.
Globalne ścieżki w edytorze Key Editor
● Synchronizacja ze zmianami tempa lub znacznikami ma kluczowe znaczenie podczas 
komponowania dowolnego rodzaju muzyki. Cubase ułatwia życie dzięki globalnym ścieżkom, które
można teraz wyświetlać w edytorze kluczy. Nie musisz już opuszczać Edytora kluczy, to wspaniałe 
odniesienie wizualne sprawi, że Twoje kompozycje będą poruszały się szybko i kreatywnie. Zobacz
ścieżki globalne w edytorze kluczy.
Zarządzanie kolejką zadań
● W większości programów DAW eksport wielu plików jest powtarzalnym i czasochłonnym 
zadaniem. Cubase sprawia, że ta praca jest znacznie szybsza, mniej podatna na błędy i 
wygodniejsza. Zsynchronizuj wybór eksportu z wyborem w projekcie i wyeksportuj pełną ścieżkę 
sygnału, w tym efekty szyny głównej, aby naprawdę odtworzyć miks. Zobacz Okno eksportu miksu
audio.
● Cubase umożliwia zbieranie zadań eksportu w celu wyeksportowania całej kolejki zadań za 
jednym razem, kiedy pijesz kawę. Zobacz Miksowanie do plików audio przy użyciu kolejek zadań.
Predefiniowane formaty plików
● Twórz i przywracaj ustawienia wstępne formatu plików z ulubionych lub najczęściej używanych 
ustawień formatu plików. Zobacz Zapisywanie predefiniowanych formatów plików.
Zmienne DPI w systemie Windows 10
● Cubase obsługuje teraz więcej ustawień skalowania dla Windows 10, takich jak 125%, 150% i 
200%. Nawet wtyczki, które nie obsługują HiDPI, mogą być teraz skalowane na podstawie 
współczynnika skalowania systemu Windows. Zobacz Ogólne.

Więcej nowych funkcji

Obsługa wielu kanałów MultiTap Delay
● Wtyczka MultiTap Delay, obsługująca teraz dźwięk przestrzenny do 5.1, ma wszystkie kreatywne
opcje potrzebne do stworzenia nieziemskiej i przestrzennej atmosfery. Możesz szybko i łatwo 
stworzyć do ośmiu odczepów opóźniających, wykorzystać dźwięk cyfrowych opóźnień lub 
klasycznych jednostek echa i dodać efekty do całego wyjścia, pętli opóźniającej, a nawet każdego 
pojedynczego odbicia. Ta wtyczka jest opisana w osobnym dokumencie Informacje o wtyczce. 
Zobacz Opóźnienie MultiTap.
Nadzór
● Ta wtyczka to w pełni konfigurowalny multimetrowy analizator dźwięku do profesjonalnych 
produkcji. SuperVision umożliwia wybór spośród kilku różnych modułów do analizy sygnału, 
widma, fazy, przestrzeni i kształtu fali. Ten zestaw wtyczek umożliwia stworzenie własnego 
niestandardowego układu z maksymalnie dziewięcioma gniazdami modułów z indywidualnymi 
ustawieniami wyświetlania dla każdego modułu, aby zapewnić niezwykle dokładny obraz wizualny 
dźwięku. Jest to opisane w oddzielnym dokumencie Informacje o wtyczce. Zobacz SuperVision.
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Ulepszenia edycji zakresów w trybie Połącz narzędzia do zaznaczania
● Jeśli narzędzia Połącz zaznaczenie są włączone i podzielisz zakres zaznaczenia, nowo utworzone 
zdarzenia zostaną wybrane automatycznie. Zobacz Dzielenie zakresów zaznaczenia.
Linie znacznikowe
● Możesz włączyć/wyłączyć wyświetlanie pionowych linii znaczników, aby wskazać pozycje 
znaczników na wszystkich ścieżkach w całym projekcie. Możesz zdecydować, czy linie 
znaczników mają być wyświetlane tylko dla aktywnego śladu znaczników, czy też dla wszystkich 
śladów znaczników. Zobacz Znaczniki.
Ulepszone bezpośrednie przetwarzanie w trybie offline
● Okno Bezpośrednie przetwarzanie w trybie offline umożliwia teraz przypinanie procesów, co 
ułatwia korzystanie z wtyczek z funkcją uczenia się. Zobacz przepływ pracy bezpośredniego 
przetwarzania w trybie offline.
Poprawiona obsługa ARA 2.0
● Odbicie nie jest już potrzebne podczas zatwierdzania zdarzenia dźwiękowego w wybranym 
rozszerzeniu ARA. Zobacz Rozszerzenia w Cubase.

Nie mniej ważne

Wskaźnik fokusa klawiatury dla podzielonych list utworów
● Podczas pracy z funkcją Podziel listę ścieżek, teraz wyraźnie widać, która z list ścieżek ma fokus 
na klawiaturze. Zobacz Fokus klawiatury w oknie projektu.
Pokaż nazwę wersji na liście utworów
● Nazwę wersji utworu można pokazać / ukryć na liście utworów. Zobacz Nazwy wersji śledzenia.
Widok szczegółów modułu pasków kanałów Maximizer
● Moduł paska kanałów Maximizer oferuje teraz widok szczegółów w oknie Ustawienia kanału. 
Zobacz Maximizer – Widok szczegółów.
Obsługa wielu wejść łańcuchów bocznych
● W przypadku wtyczek obsługujących wiele wejść łańcucha bocznego, na przykład Częstotliwość 
2 i Squasher, można teraz ustawić indywidualny routing łańcucha bocznego dla dowolnego z tych 
wejść. Pozwala to na sterowanie każdym wejściem łańcucha bocznego wtyczki za pomocą innego 
źródła łańcucha bocznego. Zobacz Routing łańcucha bocznego.
Ulepszenia obsługi torów policiśnieniowych (Poly Pressure)
● Wybieranie i edytowanie zdarzeń policiśnienia na linii kontrolera jest teraz znacznie bardziej 
intuicyjne. Zobacz Dodawanie zdarzeń Poly Pressure.
Zdefiniuj widoczne tony w edytorze kluczy (Key Editor)
● Można określić, które tony mają być widoczne w oknie zdarzeń i na klawiaturze fortepianu w 
edytorze klawiszy. Zobacz Wyświetlanie określonych tonów w edytorze tonacji (Key Editor).
Wyszukaj nuty w akordach
● Nowe zmienne kontekstowe w Edytorze logicznym umożliwiają wyszukiwanie najwyższej lub 
najniższej nuty w sekwencji akordów (najwyższa w akordzie od co najmniej n nut i najniższa w 
akordzie od co najmniej n nut) i operowanie na tych nutach . Zobacz filtr akordów.
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Wstęp

To jest instrukcja obsługi Cubase Steinberga. Tutaj znajdziesz szczegółowe informacje o 
wszystkich cechach i funkcjach programu.

Dokumentacja niezależna od platformy

Dokumentacja dotyczy systemów operacyjnych Windows i macOS.
Funkcje i ustawienia specyficzne dla jednej z tych platform są wyraźnie wskazane. We wszystkich 
innych przypadkach opisy i procedury zawarte w dokumentacji dotyczą systemów Windows 
i macOS.
Niektóre punkty do rozważenia:
● Zrzuty ekranu pochodzą z systemu Windows.
● Niektóre funkcje dostępne w menu Plik w systemie Windows można znaleźć w menu nazwy 
programu w systemie macOS.

Dokumenty PDF i dokumentacja online

Dokumentacja składa się z kilku dokumentów. Można je przeczytać online lub pobrać ze strony 
steinberg.help. Możesz uzyskać dostęp do steinberg.help z poziomu programu, wybierając Pomoc 
(Help) > Pomoc Cubase (Cubase Help).
Instrukcja obsługi

Główna dokumentacja referencyjna Cubase ze szczegółowymi opisami operacji, 
parametrów, funkcji i technik.
Układ partytury i drukowanie

Opisuje profesjonalną notację muzyczną, edycję partytury i funkcje drukowania dostępne w 
edytorze partytury (Score Editor).
Odniesienie do wtyczki

Opisuje funkcje i parametry dołączonych wtyczek VST, instrumentów VST i efektów MIDI.
Urządzenia do zdalnego sterowania

Wyświetla listę obsługiwanych urządzeń zdalnego sterowania MIDI.
Urządzenia MIDI

Opisuje sposób zarządzania urządzeniami MIDI i panelami urządzeń
Groove Agent SE

Opisuje funkcje i parametry dołączonego instrumentu VST Groove Agent SE.
HALion Sonic SE

Opisuje cechy i parametry dołączonego instrumentu VST HALion Sonic SE.
Retrolog

Opisuje funkcje i parametry dołączonego instrumentu VST Retrologue.
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Padshop
Opisuje cechy i parametry dołączonego instrumentu VST Padshop.

Menadżer Biblioteki Steinberga
Opisuje sposób rejestracji i zarządzania bibliotekami VST Sound. 

Konwencje
W naszej dokumentacji używamy elementów typograficznych i znaczników do strukturyzowania 
informacji.

Elementy typograficzne
Następujące elementy typograficzne oznaczają następujące cele:

Warunek wstępny
Wymaga wykonania akcji lub spełnienia warunku przed rozpoczęciem procedury.

Procedura
Zawiera listę kroków, które należy wykonać, aby osiągnąć określony wynik.

Ważne
Informuje o problemach, które mogą mieć wpływ na system, podłączony sprzęt lub mogą 
wiązać się z ryzykiem utraty danych.

Uwaga
Informuje o kwestiach, które należy rozważyć.

Wskazówka
Dodaje dalsze informacje lub przydatne sugestie.

Przykład
Daje ci przykład.

Wynik
Pokazuje wynik procedury.

Po wykonaniu tego zadania
Informuje o czynnościach lub zadaniach, które możesz wykonać po zakończeniu procedury.

Powiązane linki
Wyświetla listę powiązanych tematów, które można znaleźć w tej dokumentacji

Narzut
Tekst pogrubiony wskazuje nazwę menu, opcji, funkcji, okna dialogowego, okna itp.

PRZYKŁAD
Aby otworzyć menu Funkcje (Functions), kliknij Menu funkcji (Functions Menu) w prawym 
górnym rogu MixConsole.

Jeśli pogrubiony tekst jest oddzielony symbolem większości, oznacza to sekwencję różnych menu 
do otwarcia.

PRZYKŁAD
Wybierz Projekt (Select Project) > Dodaj ślad (Add Track)
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Skróty klawiaturowe

Wiele domyślnych poleceń klawiszowych, zwanych także skrótami klawiaturowymi, używa 
klawiszy modyfikujących, a niektóre z nich różnią się w zależności od systemu 
operacyjnego.

Gdy w niniejszej instrukcji opisane są polecenia klawiszy z klawiszami modyfikującymi, są 
one oznaczone najpierw klawiszem modyfikującym Windows, a następnie klawiszem 
modyfikującym macOS i klawiszem .

PRZYKŁAD
Ctrl/Cmd - Z oznacza: naciśnij Ctrl w systemie Windows lub Cmd w systemie macOS, a 
następnie naciśnij Z
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Konfiguracja Twojego systemu

Aby korzystać z Cubase, musisz skonfigurować dźwięk i, jeśli to konieczne, system MIDI.

Okno dialogowe konfiguracji Studio (Studio Setup)
Okno dialogowe Studio Setup umożliwia skonfigurowanie podłączonych urządzeń audio, 
MIDI i urządzeń zdalnego sterowania.

● Aby otworzyć okno dialogowe Ustawienia Studio (Studio Setup), wybierz Studio > Ustawienia 
Studio (Studio Setup).

Dostępne są następujące opcje:

Dodaj urządzenie (Add Device)
Umożliwia ręczne dodawanie urządzeń, takich jak urządzenie wejściowe wyrażenia 
nutowego (Note Expression Input Device), dodatkowe urządzenie wyświetlające czas 
(Time Display) lub określone urządzenia zdalnego sterowania.

Usunąć (Remove)
Umożliwia usuwanie ręcznie dodanych urządzeń.

Resetowanie (Reset)
Resetuje wszystkie urządzenia zdalnego sterowania na liście Urządzenia (Devices)

Lista urządzeń (Devices list)
Wybierz urządzenie z listy Urządzenia, aby wyświetlić jego ustawienia w prawej sekcji.
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Konfigurowanie Audio

Musisz skonfigurować sprzęt audio, zanim będziesz mógł go używać w Cubase.

WAŻNE
Przed wykonaniem jakichkolwiek połączeń upewnij się, że wszystkie urządzenia są wyłączone.

Prosta konfiguracja wejścia i wyjścia stereo
Jeśli używasz tylko wejścia i wyjścia stereo z Cubase, możesz podłączyć sprzęt audio, na 
przykład wejścia karty dźwiękowej lub interfejsu audio, bezpośrednio do źródła 
wejściowego, a wyjścia do wzmacniacza mocy i głośnika.

Połączenia audio

Konfiguracja systemu zależy od wielu różnych czynników, na przykład rodzaju projektu, 
który chcesz utworzyć, sprzętu zewnętrznego, którego chcesz użyć, lub dostępnego sprzętu 
komputerowego. Dlatego poniższe sekcje mogą służyć jedynie jako przykłady.

Sposób podłączenia sprzętu, to znaczy, czy użyć połączeń cyfrowych, czy analogowych, 
zależy również od konfiguracji.

Poziomy nagrywania i wejścia

Podczas podłączania sprzętu upewnij się, że impedancja i poziomy źródeł dźwięku i wejść 
są zgodne. Używanie właściwego typu wejścia jest ważne, aby uniknąć zniekształceń lub 
szumów podczas nagrywania. Na przykład można użyć różnych wejść, takich jak poziom 
linii konsumenckiej (-10 dBV) lub profesjonalny poziom liniowy (+4 dBu).

Czasami można dostosować charakterystykę wejścia w interfejsie audio lub na jego panelu 
sterowania. Szczegółowe informacje można znaleźć w dokumentacji dołączonej do sprzętu 
audio.
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WAŻNE
Cubase nie zapewnia żadnych regulacji poziomu wejściowego dla sygnałów przychodzących do 
twojego sprzętu audio, ponieważ są one obsługiwane inaczej dla każdej karty. Regulacja poziomów
wejściowych odbywa się albo w specjalnej aplikacji dołączonej do sprzętu, albo w jego panelu 
sterowania.

Połączenia Word Clock
Jeśli korzystasz z cyfrowego połączenia audio, może być również potrzebne połączenie Word 
Clock między sprzętem audio a urządzeniami zewnętrznymi. Szczegółowe informacje można 
znaleźć w dokumentacji dołączonej do sprzętu audio.

WAŻNE
Skonfiguruj poprawnie synchronizację Word Clock, w przeciwnym razie w nagraniach mogą 
wystąpić kliknięcia i trzaski.

Wybór sterownika audio
Wybierając sterownik audio, zezwalasz Cubase na komunikację ze sprzętem audio. Zwykle po 
uruchomieniu Cubase otwiera się okno dialogowe z monitem o wybranie sterownika, ale możesz 
także wybrać sterownik sprzętu audio, jak opisano poniżej.

UWAGA
W systemach operacyjnych Windows zalecamy dostęp do sprzętu za pośrednictwem sterownika 
ASIO opracowanego specjalnie dla tego sprzętu. Jeśli żaden sterownik ASIO nie jest 
zainstalowany, skontaktuj się z producentem sprzętu audio, aby uzyskać informacje na temat 
dostępnych sterowników ASIO. Jeśli nie jest dostępny żaden określony sterownik ASIO, można 
użyć sterownika Generic Low Latency ASIO.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz Audio System.
3. Otwórz wyskakujące menu ASIO Driver (Sterownik ASIO) i wybierz sterownik sprzętu audio.
4. Kliknij OK.

Konfigurowanie sprzętu audio
Aby móc z niego korzystać, należy wybrać i skonfigurować sprzęt audio w oknie dialogowym 
Studio Setup (Konfiguracja programu Studio)

WARUNEK WSTĘPNY
Wybrałeś sterownik dla swojego sprzętu audio.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio.
3. Wykonaj jedną z poniższych czynności, aby otworzyć panel sterowania sprzętu audio:

● W systemie Windows kliknij Control Panel (Panel sterowania).
● W systemie macOS kliknij opcję Open Config App (Otwórz aplikację konfiguracyjną).

Ten przycisk jest dostępny tylko w przypadku niektórych produktów sprzętowych. 
Jeśli nie jest dostępny w Twojej konfiguracji, zapoznaj się z dokumentacją sprzętu 
audio.
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UWAGA
Panel sterowania jest dostarczany przez producenta sprzętu audio i jest inny dla każdej marki i 
modelu interfejsu audio. Jednak panele kontrolne dla sterownika Generic Low Latency ASIO 
Driver (tylko Windows) są dostarczane przez firmę Steinberg.

4. Skonfiguruj sprzęt audio zgodnie z zaleceniami producenta.

Strona systemu audio
Na stronie Audio System (System audio) możesz wybrać sterownik ASIO dla swojego sprzętu 
audio.

● Aby otworzyć stronę Audio System, wybierz Studio > Studio Setup (Konfiguracja 
Studio) i wybierz System audio na liście Devices (Urządzenia).

Dostępne są następujące opcje:

ASIO Driver (Sterownik ASIO)
Umożliwia wybór sterownika

Relase Driver when Application is in Background (Zwolnij sterownik, gdy aplikacja działa w 
tle)

Zwalnia sterownik i pozwala innym aplikacjom na odtwarzanie za pośrednictwem sprzętu 
audio, nawet jeśli Cubase jest uruchomiony.

Input Latency (Opóźnienie wejścia)
Pokazuje opóźnienie wejściowe sprzętu audio.

Output Latency (Opóźnienie wyjścia)
Pokazuje opóźnienie wyjściowe sprzętu audio
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ASIO-Guard Latency
Pokazuje opóźnienie ASIO-Guard.

HW Sample Rate (Częstotliwość próbkowania HW)
Pokazuje częstotliwość próbkowania Twojego sprzętu audio.

HW Pull Up / Down (Podciąganie HW w górę/w dół)
Pokazuje stan podnoszenia / opuszczania sprzętu audio.

W sekcji Advanced Options (Opcje zaawansowane) dostępne są następujące opcje:

Set To Defaults (Ustaw na domyślne)
Umożliwia przywrócenie ustawień domyślnych.

Processing Precision (Precyzja przetwarzania)
Umożliwia ustawienie precyzji przetwarzania dźwięku na 32-bitowy zmiennoprzecinkowy 
lub 64-bitowy zmiennoprzecinkowy.
W zależności od tego ustawienia wszystkie kanały są przetwarzane i miksowane w formacie
zmiennoprzecinkowym 32-bitowym lub 64-bitowym.

UWAGA
Precyzja przetwarzania rzędu 64 bitów zmiennoprzecinkowych może zwiększyć obciążenie 
procesora i zużycie pamięci.

Aby wyświetlić wszystkie wtyczki obsługujące 64-bitowe przetwarzanie zmiennoprzecinkowe, 
otwórz VST Plug-in Manager (Menedżera wtyczek VST) i włącz opcję Show Plug-ins That 
Support 64-Bit Float Processing (Pokaż wtyczki obsługujące 64-bitowe przetwarzanie 
zmiennoprzecinkowe) w wyskakującym menu Display Options (Opcje wyświetlania).

UWAGA
Wtyczki i instrumenty VST 2 są zawsze przetwarzane z 32-bitową precyzją.

Activate Multi Processing (Aktywuj przetwarzanie wielokrotne)
Umożliwia równomierne rozłożenie obciążenia przetwarzania na wszystkie dostępne 
procesory. W ten sposób Cubase może w pełni wykorzystać połączoną moc wielu 
procesorów.

Activate ASIO-Guard (Aktywuj ASIO-Guard)
Aktywuje ASIO-Guard. Ta opcja jest dostępna tylko wtedy, gdy włączona jest opcja 
Aktywuj przetwarzanie wielokrotne.

ASIO-Guard Level (Poziom ochrony ASIO)
Umożliwia ustawienie poziomu ASIO-Guard. Im wyższy poziom, tym wyższa stabilność 
przetwarzania i wydajność przetwarzania dźwięku. Jednak wyższe poziomy prowadzą 
również do zwiększonego opóźnienia ASIO-Guard i zużycia pamięci.

Audio Priority (Priorytet dźwięku (tylko Windows))
To ustawienie powinno być ustawione na Normal (Normalne), jeśli pracujesz z Audio 
i MIDI. Jeśli w ogóle nie używasz MIDI, możesz ustawić to na Boost.

Activate Steinberg Audio Power Scheme (Aktywuj schemat mocy dźwięku Steinberga)
Jeśli ta opcja jest włączona, wszystkie tryby oszczędzania energii, które mają wpływ na 
przetwarzanie w czasie rzeczywistym, są dezaktywowane. Należy pamiętać, że jest to 
skuteczne tylko w przypadku bardzo małych opóźnień i zwiększa zużycie energii.

Disk Preload (Wstępne ładowanie dysku)
Pozwala określić, ile sekund dźwięku ma być wstępnie załadowanych do pamięci RAM 
przed rozpoczęciem odtwarzania. Pozwala to na płynne odtwarzanie.

Adjust for Record Latency (Dostosuj opóźnienie nagrywania)
Jeśli ta opcja jest włączona, podczas nagrywania uwzględniane są opóźnienia wtyczek.
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Record Shift (Rekordowa zmiana)
Umożliwia przesunięcie nagrań o określoną wartość.

W sekcji ogólnej dostępne są następujące opcje:

Reset (Resetowanie)
Resetuje wybrane urządzenie zdalne.

Ap[ply (Zastosuj)
Stosuje ustawienia

POWIĄZANE LINKI
Okno Manager Window (menedżera wtyczek) VST na stronie 744

Strona konfiguracji sterownika ASIO (ASIO Driver Setup)
Ta strona umożliwia skonfigurowanie sterownika ASIO.

● Aby otworzyć stronę, na której możesz skonfigurować sterownik ASIO, wybierz Studio >
Studio Setup (Konfiguracja Studio) i wybierz sterownik audio z listy Devices (Urządzenia).

Dostępne są następujące opcje:

Control Panel (Panel sterowania)
Otwiera panel sterowania sprzętu audio.

Input Latency (Opóźnienie wejścia)
Pokazuje opóźnienie wejścia sterownika audio.

Output Latency Opóźnienie wyjścia)
Pokazuje opóźnienie wyjściowe sterownika audio.

Clock Source (Źródło zegara)
Umożliwia wybór źródła zegara.

Externally Clocked (Zewnętrznie taktowany)
Włącz tę opcję, jeśli korzystasz z zewnętrznego źródła zegara.

Direct Monitoring {Monitorowanie bezpośrednie}
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Aktywuj tę opcję, aby monitorować przez sprzęt audio i sterować nim z Cubase.

W sekcji Ports (Porty) dostępne są następujące opcje:

Reset (Resetowanie)
Umożliwia zresetowanie wszystkich nazw portów i widoczności.

I/O (we/wy)
Stan wejścia/wyjścia portu.

Port System Name (Nazwa systemu portu)
Nazwa systemowa portu.

Show As (Pokaż jako)
Umożliwia zmianę nazwy portu. Ta nazwa jest używana w wyskakujących menu Input 
Routing (Kierowanie wejścia) i Output Routing (Kierowanie wyjścia).

Visible (Widoczny)
Umożliwia aktywację/dezaktywację portów audio.

State (Stan)
Stan portu audio.

W sekcji ogólnej dostępne są następujące opcje:

Reset (Resetowanie)
Resetuje wybrane urządzenie zdalne.

Apply (Zastosuj)
Stosuje ustawienia.

Korzystanie z zewnętrznych źródeł zegara
Jeśli używasz zewnętrznego źródła zegara, Cubase musi zostać powiadomiony, że odbiera 
zewnętrzne sygnały zegara i pobiera swoją prędkość z tego źródła.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio.
3. Aktywuj Externally Clocked (Zewnętrznie taktowany).

WYNIK
Cubase czerpie teraz swoją prędkość z zewnętrznego źródła.

UWAGA
Aby zapewnić prawidłowe odtwarzanie i nagrywanie dźwięku, należy ustawić częstotliwość 
próbkowania projektu na częstotliwość próbkowania przychodzących sygnałów zegarowych.

Gdy wystąpi niezgodność częstotliwości próbkowania, pole Record Format w linii stanu okna 
Project jest podświetlone innym kolorem. Cubase akceptuje niedopasowanie częstotliwości 
próbkowania, dlatego odtwarzanie jest szybsze lub wolniejsze.
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Korzystanie z kilku aplikacji audio jednocześnie
Możesz zezwolić innym aplikacjom na odtwarzanie przez sprzęt audio, nawet jeśli Cubase 
jest uruchomiony

WARUNEK WSTĘPNY
Inne aplikacje audio uzyskujące dostęp do sprzętu audio mają ustawione zwalnianie sterownika 
audio.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz Audio System (System audio).
3. Aktywuj Release Drivers when Application is in Background (Zwolnij sterownik, gdy 
aplikacja działa w tle).

WYNIK
Aplikacja, na której znajduje się fokus, uzyskuje dostęp do sprzętu audio.

Konfiguracja sprzętu audio
Większość kart dźwiękowych zawiera jedną lub więcej małych aplikacji, które umożliwiają 
dostosowanie sprzętu.
Ustawienia są zwykle gromadzone w panelu kontrolnym, który można otworzyć z poziomu 
Cubase lub oddzielnie, gdy Cubase nie jest uruchomiony. Szczegółowe informacje można 
znaleźć w dokumentacji sprzętu audio.

Ustawienia obejmują:
● Wybór, które wejścia/wyjścia są aktywne.
● Konfigurowanie synchronizacji Word Clock.
● Włączanie/wyłączanie monitorowania za pomocą sprzętu.
● Ustawianie poziomów dla każdego wejścia.
● Ustawianie poziomów dla wyjść tak, aby odpowiadały sprzętowi używanemu do monitoringu.
● Wybór formatów wejścia i wyjścia cyfrowego.
● Dokonywanie ustawień dla buforów audio.

Konfigurowanie portów wejściowych i wyjściowych
Po wybraniu i skonfigurowaniu sterownika sprzętu audio należy określić, które wejścia i 
wyjścia mają być używane.

WARUNEK WSTĘPNY
Wybrałeś sterownik dla swojego sprzętu audio.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio.
3. Wprowadź zmiany.
4. Kliknij OK.

POWIĄZANE LINKI
Strona konfiguracji sterownika ASIO na stronie 19
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Konfiguracja magistrali audio

Cubase wykorzystuje system szyn wejściowych i wyjściowych do przesyłania dźwięku między 
programem a sprzętem audio.
       ● Szyny wejściowe umożliwiają kierowanie dźwięku z wejść sprzętu audio do Cubase.    
             Oznacza to, że dźwięk jest zawsze nagrywany przez jedną lub kilka szyn wejściowych.
          ● Szyny wyjściowe umożliwiają kierowanie dźwięku z Cubase do wyjść sprzętu audio.  
             Oznacza to, że dźwięk jest zawsze odtwarzany przez jedną lub kilka szyn wyjściowych.
Po skonfigurowaniu wewnętrznych szyn wejściowych i wyjściowych można podłączyć źródło 
dźwięku, na przykład mikrofon, do interfejsu audio i rozpocząć nagrywanie, odtwarzanie i 
miksowanie.

POWIĄZANE LINKI
Połączenia audio na stronie 26.

Monitorowanie
W Cubase monitorowanie oznacza słuchanie sygnału wejściowego podczas nagrywania

Dostępne są następujące sposoby monitorowania:
            ● Zewnętrznie, słuchając sygnału, zanim dotrze on do Cubase.

● Przez Cubase.
            ● Za pomocą ASIO Direct Monitoring. Jest to połączenie pozostałych metod.

POWIĄZANE LINKI
        Monitorowanie zewnętrzne na stronie 268
        Monitorowanie przez Cubase na stronie 268
        Bezpośrednie monitorowanie ASIO na stronie 269

Konfigurowanie MIDI
Musisz skonfigurować swój sprzęt MIDI, zanim będziesz mógł go używać w Cubase.

WAŻNE
Wyłącz wszystkie urządzenia przed wykonaniem jakichkolwiek połączeń.

PROCEDURA
1. Podłącz swój sprzęt MIDI (klawiatura, interfejs MIDI itp.) do komputera.
2. Zainstaluj sterowniki sprzętu MIDI

WYNIK
Możesz używać swojego sprzętu MIDI w Cubase.
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Połączenia MIDI

Aby odtwarzać i nagrywać dane MIDI z urządzenia MIDI, na przykład klawiatury MIDI, 
należy podłączyć porty MIDI.
            Podłącz port wyjściowy MIDI urządzenia MIDI do portu wejściowego MIDI sprzętu audio. 
W ten sposób urządzenie MIDI wysyła dane MIDI do odtwarzania lub nagrywania w komputerze.
            Podłącz port wejściowy MIDI urządzenia MIDI do portu wyjściowego MIDI sprzętu audio. 
W ten sposób możesz przesyłać dane MIDI z Cubase do urządzenia MIDI. Na przykład możesz 
nagrać własną grę, edytować dane MIDI w Cubase, a następnie odtworzyć je na klawiaturze i 
nagrać dźwięk wychodzący z klawiatury, aby uzyskać lepszą edycję.

Pokazywanie lub ukrywanie portów MIDI
          Możesz pokazać porty MIDI, których chcesz używać, i ukryć te, których nie używasz w 
wyskakujących menu MIDI w programie.

PROCEDURA
1. Wybierz Studio >Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz MIDI Port Setup (Konfiguracja portu MIDI).
3. Aby ukryć port MIDI, dezaktywuj jego kolumnę Visible (Widoczne).
4. Kliknij OK.

Konfigurowanie wszystkich wejść MIDI
           Podczas nagrywania MIDI możesz określić, które wejście MIDI ma być używane przez 
każdą nagrywaną ścieżkę MIDI. Można jednak również nagrywać dowolne dane MIDI 
z dowolnego wejścia MIDI. Możesz określić, które wejścia mają być uwzględnione po wybraniu 
opcji All MIDI Inputs (Wszystkie wejścia MIDI) dla ścieżki MIDI.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz MIDI Port Setup (Konfiguracja portu MIDI).
3. Aktywuj opcję All MIDI Inputs (Wszystkie wejścia MIDI) dla portu.

UWAGA
Jeśli masz podłączonego pilota zdalnego sterowania MIDI, pamiętaj o wyłączeniu opcji In „All 
MIDI Inputs” dla tego wejścia MIDI. Pozwala to uniknąć przypadkowego nagrywania danych z 
pilota, gdy jako wejście dla ścieżki MIDI wybrano opcję All MIDI Inputs.

4. Kliknij OK.

WYNIK
Gdy wybierzesz All MIDI Inputs w wyskakującym menu Input Routing ścieżki MIDI 
w Inspector (Inspektorze), ścieżka MIDI będzie wykorzystywać wszystkie wejścia MIDI określone
w MIDI Port Setup (Konfiguracja portu MIDI).

Strona konfiguracji portu MIDI (MIDI Port Setup).

Strona konfiguracji portu MIDI w oknie dialogowym konfiguracji Studio wyświetla podłączone 
urządzenia MIDI i umożliwia skonfigurowanie ich portów.
● Aby otworzyć stronę konfiguracji portu MIDI (MIDI Port Setup), wybierz Studio > Studio 
Setup (Konfiguracja studia) i aktywuj MIDI Port Setup (Konfiguracja portu MIDI) na liście 
Devices (urządzenia).
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Wyświetlane są następujące kolumny:

Device (Urządzenie)
           Podłączone urządzenia MIDI.
I/O (we/wy)
           Stan wejścia/wyjścia portu.
Port System Name (Nazwa systemu portu)
           Nazwa systemowa portu.
Show As (Pokaż jako)
           Umożliwia zmianę nazwy portu. Ta nazwa jest używana w wyskakujących menu Kierowanie
           wejścia i Kierowanie wyjścia.
Visible (Widoczny)
           Umożliwia aktywację/dezaktywację portów MIDI.
State (Stan)
           Stan portu MIDI.
In All MIDI Inputs (We „Wszystkie wejścia MIDI”)
           Umożliwia nagrywanie danych MIDI ze wszystkich wejść MIDI.
           UWAGA
           Wyłącz tę opcję, jeśli korzystasz z urządzeń zdalnego sterowania.

Dostępne są następujące opcje:

Use System Timestamp for „Windows MIDI” Inputs (Użyj systemowego znacznika czasu dla 
wejść „Windows MIDI”).
           Włącz tę opcję, jeśli masz stałe problemy z synchronizacją, takie jak przesunięte nuty. Jeśli   
            ta opcja jest włączona, systemowy znacznik czasu jest używany jako odniesienie czasowe.

Use Device „DirectMusic” (Użyj urządzenia „DirectMusic”).
           Jeśli nie używasz urządzenia ze sterownikiem urządzenia DirectMusic, możesz pozostawić tę
            opcję wyłączoną. Zwiększa to wydajność systemu.
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Use System Timestamp for „DirectMusic” Inputs (Użyj systemowego znacznika czasu dla 
danych wejściowych „DirectMusic”).
           Włącz tę opcję, jeśli masz stałe problemy z synchronizacją, takie jak przesunięte nuty. Jeśli  
           ta opcja jest włączona, systemowy znacznik czasu jest używany jako odniesienie czasowe.

W sekcji ogólnej dostępne są następujące opcje:

Reset (Resetowanie)
          Resetuje wybrane urządzenie zdalne.
Apply (Zastosować)
          Stosuje ustawienia.

Obsługa Plug and Play dla urządzeń USB MIDI
          
           Cubase obsługuje plug and play urządzeń USB MIDI. Urządzenia te można podłączać i   
           włączać podczas działania aplikacji.

Synchronizatory

Używając Cubase z zewnętrznymi transportami taśm, najprawdopodobniej będziesz musiał dodać 
synchronizator do swojego systemu.

WAŻNE
Przed wykonaniem jakichkolwiek połączeń upewnij się, że wszystkie urządzenia są wyłączone.

Aby uzyskać informacje na temat podłączania i konfigurowania synchronizatora, zapoznaj się z 
dokumentacją synchronizatora.

POWIĄZANE LINKI
          Synchronizacja na stronie 1074.
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Połączenia audio

Aby odtwarzać i nagrywać w Cubase, musisz skonfigurować szyny wejściowe i wyjściowe w oknie
Audio Connections (Połączenia audio). Tutaj możesz także skonfigurować kanały grupowe i FX, 
efekty zewnętrzne, instrumenty zewnętrzne i Control Room (pokój kontrolny).

Rodzaje magistrali, których potrzebujesz, zależą od sprzętu audio, ogólnej konfiguracji audio, na 
przykład konfiguracji głośników surround, oraz projektów, z których korzystasz.

Okno połączeń audio (Audio Connections)

Okno Audio Connections umożliwia skonfigurowanie szyn wejściowych i wyjściowych, kanałów 
grupowych i FX, efektów zewnętrznych i instrumentów zewnętrznych. Ponadto możesz użyć tego 
okna, aby uzyskać dostęp do pokoju kontrolnego (Control Room) i skonfigurować go.

    ● Aby otworzyć okno Audio Connections (Połączenia audio), wybierz Studio > Audio 
Connections (Połączenia audio).

Zakładka Wejścia/Wyjścia (Inputs/Outputs)
           Zakładki Wejścia i Wyjścia umożliwiają ustawianie i konfigurowanie szyn wejściowych i  
           wyjściowych.

Nad listą szyn dostępne są następujące opcje:

Add Bus (Dodaj szynę)
            Otwiera okno dialogowe Add Input Bus (Dodaj magistralę wejściową), w którym można  
             utworzyć nową konfigurację magistrali.
Presets (Presety)
           Otwiera wyskakujące menu Presets (Ustawienia wstępne), w którym można wybrać 
           ustawienia wstępne konfiguracji magistrali. Store umożliwia zapisanie konfiguracji   
           magistrali jako ustawienia wstępnego. Delete (Usuń) usuwa wybrane ustawienie wstępne.
Expand All/Collapse (Rozwiń wszystko/zwiń)
           Rozwija/zwija wszystkie szyny na liście magistrali.

Dla listy magistrali dostępne są następujące kolumny:

Bus Name (Nazwa szyny)
           Wyświetla listę szyn. Kliknij nazwę szyny, aby ją wybrać lub zmienić nazwę.
Speakers (Głośniki)
          Wskazuje konfigurację głośników (formaty mono, stereo, surround) każdej szyny.
Audio Device (Urządzenie audio)
          Pokazuje wybrany sterownik ASIO.
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Device Port (Port urządzenia)
Pokazuje, które fizyczne wejścia/wyjścia sprzętu audio są używane przez magistralę. 
Rozwiń wpis magistrali, aby wyświetlić wszystkie kanały głośników. Jeśli wpis magistrali 
jest zwinięty, widoczny jest tylko pierwszy port używany przez tę magistralę.

Wyskakujące menu Device Port wyświetla liczbę magistrali podłączonych do danego portu. Szyny 
są pokazane w nawiasach kwadratowych obok nazwy portu.
W ten sposób można wyświetlić do 3 przyporządkowań magistrali. Jeśli nawiązano więcej 
połączeń, jest to wskazywane przez liczbę na końcu nazwy portu.
Na przykład „Adat 1 [Stereo1] [Stereo2] [Stereo3] (+2)” oznacza, że port Adat1 jest już przypisany 
do 3 szyn stereo plus 2 dodatkowe szyny.

Zakładka Group/FX
Ta zakładka umożliwia tworzenie kanałów/ścieżek grupowych i FX oraz przypisywanie im wyjść.

Nad listą magistrali dostępne są następujące opcje:

Add Group (Dodaj grupę)
          Otwiera okno dialogowe Dodaj ścieżkę kanału grupowego, w którym można utworzyć nową 
          ścieżkę kanału grupowego.
Add FX (Dodaj efekty)
          Otwiera okno dialogowe Add FX Channel Track (Dodaj ścieżkę kanału FX), w którym  
          możesz utworzyć nową ścieżkę kanału FX.
Expand All/Collapse (Rozwiń wszystko/zwiń)
          Rozwija/zwija wszystkie szyny na liście magistrali

Dla listy magistrali dostępne są następujące kolumny:

Bus Name (Nazwa szyny)
           Wyświetla listę szyn. Kliknij nazwę szyny, aby ją wybrać lub zmienić nazwę.
Speakers (Głośniki)
           Wskazuje konfigurację głośników (formaty mono, stereo, surround) każdej szyny.
Output Routing (Routing wyjściowy)
           Umożliwia wybranie trasowania wyjścia dla odpowiedniej magistrali.

Zakładka External FX (efektów zewnętrznych)
Ta zakładka umożliwia tworzenie szyn efektów wysyłkowych lub zwrotnych. Możesz ich użyć do 
podłączenia efektów zewnętrznych, które następnie można wybrać za pomocą wyskakujących 
menu efektów z poziomu programu.
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Nad listą magistrali dostępne są następujące opcje:

Add External FX (Dodaj efekt zewnętrzny)
             Otwiera okno dialogowe Dodaj efekt zewnętrzny, w którym można skonfigurować nowy 
             efekt zewnętrzny.
Favorites (Ulubione)
             Pozwala przechowywać konfiguracje efektów zewnętrznych jako ulubione, które można 
             przywołać.
Expand All/Collapse (Rozwiń wszystko/zwiń)
             Rozwija/zwija wszystkie szyny na liście magistrali.

Dla listy magistrali dostępne są następujące kolumny:

Bus Name (Nazwa szyny)
            Wyświetla listę magistrali. Kliknij nazwę szyny, aby ją wybrać lub zmienić nazwę.
Speakers (Głośniki)
           Wskazuje konfigurację głośników (formaty mono, stereo, surround) każdej szyny.
Audio Device (Urządzenie audio)
           Pokazuje wybrany sterownik ASIO.
Device Port (Port urządzenia)
           Pokazuje, które fizyczne wejścia/wyjścia sprzętu audio są używane przez magistralę. Rozwiń
           wpis magistrali, aby wyświetlić wszystkie kanały głośników. Jeśli wpis magistrali jest 
           zwinięty, widoczny jest tylko pierwszy port używany przez tę magistralę.
           Wyskakujące menu Device Port wyświetla liczbę magistrali podłączonych do danego portu. 
           Szyny są pokazane w nawiasach kwadratowych obok nazwy portu. W ten sposób można  
           wyświetlić do 3 przyporządkowań magistrali. Jeśli nawiązano więcej połączeń, jest to 
           wskazywane przez liczbę na końcu nazwy portu.
           Na przykład „Adat 1 [Stereo1] [Stereo2] [Stereo3] (+2)” oznacza, że port Adat1 jest już 
           przypisany do 3 szyn stereo plus 2 dodatkowych szyn.
Delay (Opóźnienie)
           Umożliwia wprowadzenie wartości kompensującej nieodłączne opóźnienie (opóźnienie)   
           sprzętowego urządzenia efektów podczas odtwarzania. Możesz kliknąć prawym przyciskiem
           myszy kolumnę Delay dla efektu i wybrać opcję Check User Delay (Sprawdź opóźnienie 
           użytkownika), aby automatycznie określić wartość opóźnienia.
UWAGA
Opóźnienie sprzętu audio jest obsługiwane automatycznie przez Cubase.

Send Gain (Wyślij przyrost)
          Umożliwia regulację poziomu sygnału wysyłanego do efektu zewnętrznego.
Return Gain (Zwrot osiągnięcia)
          Umożliwia regulację poziomu sygnału wysyłanego przez efekt zewnętrzny.
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UWAGA
Nadmierne poziomy wyjściowe z zewnętrznego urządzenia efektów mogą powodować 
przesterowanie w sprzęcie audio. Nie można użyć ustawienia Return Gain, aby to zrekompensować.
Zamiast tego należy obniżyć poziom wyjściowy urządzenia efektowego.

MIDI Device (Urządzenie MIDI)
            Gdy klikniesz w tę kolumnę, otworzy się wyskakujące menu, w którym możesz odłączyć 
            efekt od powiązanego urządzenia MIDI, wybrać urządzenie MIDI, utworzyć nowe  
            urządzenie lub otworzyć MIDI Device Manager (Menedżera urządzeń MIDI), aby 
            edytować urządzenie MIDI.
Used (Używany)
           Za każdym razem, gdy wstawiasz efekt zewnętrzny do ścieżki audio, w tej kolumnie pojawia
           się znacznik wyboru (x), aby wskazać, że efekt jest używany.

Karta External Instruments (Instrumenty zewnętrzne)
Ta zakładka umożliwia tworzenie szyn wejścia/wyjścia, które mogą być używane do podłączania 
zewnętrznych instrumentów.

Nad listą szyn dostępne są następujące opcje:

Add External Instrument (Dodaj instrument zewnętrzny)
           Otwiera okno dialogowe Add External Instrument, w którym można skonfigurować nowy 
           instrument zewnętrzny.
Favorites (Ulubione)
           Pozwala przechowywać konfiguracje instrumentów zewnętrznych jako ulubione, które 
           można przywołać.
Expand All/Collapse (Rozwiń wszystko/zwiń)
           Rozwija/zwija wszystkie szyny na liście magistrali.

Dla listy magistrali dostępne są następujące kolumny:

Bus Name (Nazwa szyny)
           Wyświetla listę szyn. Kliknij nazwę szyny, aby ją wybrać lub zmienić nazwę.
Speakers (Głośniki)
          Wskazuje konfigurację głośników (formaty mono, stereo, surround) każdej szyny.
Audio Device (Urządzenie audio)
          Pokazuje wybrany sterownik ASIO.
Device Port (Port urządzenia)
          Pokazuje, które fizyczne wejścia/wyjścia sprzętu audio są używane przez magistralę. Rozwiń 
          wpis magistrali, aby wyświetlić wszystkie kanały głośników. Jeśli wpis magistrali jest 
          zwinięty, widoczny jest tylko pierwszy port używany przez tę magistralę. Wyskakujące menu
          Device Port wyświetla liczbę magistrali podłączonych do danego portu. Autobusy są 
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          pokazane w nawiasach kwadratowych obok nazwy portu.

           W ten sposób można wyświetlić do 3 przyporządkowań magistrali. Jeśli nawiązano więcej 
           połączeń, jest to wskazywane przez liczbę na końcu nazwy portu.
           Na przykład „Adat 1 [Stereo1] [Stereo2] [Stereo3] (+2)” oznacza, że port Adat1 jest już 
           przypisany do 3 szyn stereo plus 2 dodatkowych szyn.

Delay (Opóźnienie)
           Umożliwia wprowadzenie wartości kompensującej nieodłączne opóźnienie (latency)   
           sprzętowego urządzenia efektów podczas odtwarzania. Możesz kliknąć prawym przyciskiem
          myszy kolumnę Delay dla instrumentu i wybrać Check User Delay, aby automatycznie 
          określić wartość opóźnienia używaną do kompensacji opóźnienia.

UWAGA
Opóźnienie sprzętu audio jest obsługiwane automatycznie przez Cubase.

Return Gain
         Umożliwia regulację poziomu sygnału przychodzącego z instrumentu zewnętrznego.

UWAGA
Nadmierne poziomy wyjściowe z zewnętrznego urządzenia efektów mogą powodować 
przesterowanie w sprzęcie audio. Ustawienie Return Gain nie może być użyte do skompensowania
tego. Zamiast tego należy obniżyć poziom wyjściowy urządzenia efektowego.

MIDI Device (Urządzenie MIDI)
           Gdy klikniesz w tę kolumnę, otworzy się wyskakujące menu, w którym możesz odłączyć 
           instrument od powiązanego urządzenia MIDI, wybrać urządzenie MIDI, utworzyć nowe 
           urządzenie lub otworzyć MIDI Device Manager (Menedżera urządzeń MIDI), aby  
           edytować urządzenie MIDI.
Used (Używany)
           Za każdym razem, gdy wkładasz instrument zewnętrzny do gniazda instrumentu VST, w tej 
           kolumnie pojawia się znacznik wyboru (x), aby wskazać, że instrument jest używany.

Zakładka Control Room (Pomieszczenie kontrolne)
Ta zakładka umożliwia włączenie i skonfigurowanie pomieszczenia kontrolnego (Control Room).

Nad listą szyn dostępne są następujące opcje:

Enable/Disable Control Room (Włącz/wyłącz pomieszczenie kontrolne)
          Włącza/wyłącza Control Room.
Open Control Room (Otwórz pomieszczenie kontrolne)
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          Otwiera okno Control Room.

Add Channel (Dodaj kanał)
           Otwiera wyskakujące menu, w którym możesz wybrać typ kanału, który chcesz dodać.
           Możesz dodać następujące kanały:
           ● External Input (Wejście zewnętrzne)
           ● Talkback (Rozmowa)
           ● Cue (Wskazówka)
           ● Headphone (Słuchawki)
           ● Monitor (Monitoruj)

Presets (Presety, ustawienia wstepne)
          Otwiera wyskakujące menu Presets (Ustawienia wstępne), w którym można wybrać 
          ustawienia wstępne konfiguracji magistrali. Store umożliwia zapisanie konfiguracji 
          magistrali jako ustawienia wstępnego. Delete (Usuń) usuwa wybrane ustawienie wstępne.

UWAGA
Możesz zapisać sloty insertów dla kanałów Cue, Monitor i Control Room w ustawieniach 
wstępnych. Jest to przydatne, ponieważ nie są one zapisywane wraz z projektem.

Configuration (Konfiguracja)
          Wyświetla wybraną konfigurację kanału.
Expand All/Collapse (Rozwiń wszystko/zwiń)
          Rozwija/zwija wszystkie szyny na liście magistrali.

Dla listy magistrali dostępne są następujące kolumny:

Bus Name Nazwa szyny)
          Wyświetla listę szyn. Kliknij nazwę szyny, aby ją wybrać lub zmienić nazwę.
Speakers (Głośniki)
          Wskazuje konfigurację głośników (formaty mono, stereo, surround) każdej szyny.
Audio Device (Urządzenie audio)
          Pokazuje wybrany sterownik ASIO.
Device Port (Port urządzenia)
          Pokazuje, które fizyczne wejścia/wyjścia sprzętu audio są używane przez magistralę. Rozwiń 
          wpis magistrali, aby wyświetlić wszystkie kanały głośników. Jeśli wpis magistrali jest 
          zwinięty, widoczny jest tylko pierwszy port używany przez tę magistralę.
          Wyskakujące menu Device Port wyświetla liczbę magistrali podłączonych do danego portu.  
          Szyny są pokazywane w nawiasach kwadratowych obok nazwy portu.
          W ten sposób można wyświetlić do 3 przyporządkowań magistrali. Jeśli nawiązano więcej 
          połączeń, jest to wskazywane przez liczbę na końcu nazwy portu.
          Na przykład „Adat 1 [Stereo1] [Stereo2] [Stereo3] (+2)” oznacza, że port Adat1 jest już 
          przypisany do 3 szyn stereo plus 2 dodatkowych szyn.

POWIĄZANE LINKI
Control Room (Pomieszczenie kontrolne) na stronie 425
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Zmiana nazw wejść i wyjść sprzętowych

Przed skonfigurowaniem szyn należy zmienić nazwy domyślnych wejść i wyjść sprzętu audio. 
Pozwala to na przenoszenie projektów między różnymi komputerami i konfiguracjami. Na 
przykład, jeśli przeniesiesz swój projekt do innego studia, sprzęt audio może być innego modelu. 
Ale jeśli ty i drugi właściciel studia zgodziliście się na identyczne nazwy wejść i wyjść, Cubase 
poprawi wejścia i wyjścia dla waszych szyn.

UWAGA
Jeśli otworzysz projekt, który został utworzony na innym komputerze, a nazwy portów nie są 
zgodne lub konfiguracja portów nie jest taka sama, pojawi się okno dialogowe Missing Ports 
(Brakujące porty). Umożliwia to ręczne przekierowanie portów używanych w projekcie do portów 
dostępnych na komputerze.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz Audio System (System audio).
3. Otwórz wyskakujące menu ASIO Driver (Sterownik ASIO) i wybierz sterownik sprzętu audio.
4. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio.
5. W kolumnie Show As (Pokaż jako) kliknij nazwę portu i wprowadź nową nazwę.
6. Powtarzaj poprzedni krok, aż zmienisz nazwy wszystkich wymaganych portów.
7. Kliknij OK.

POWIĄZANE LINKI
Przekierowywanie brakujących portów na stronie 108.

Ukrywanie portów
Możesz ukryć porty, których nie używasz. Ukryte porty nie są wyświetlane w oknie Audio 
Connections (Połączenia audio).

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio.
3. W kolumnie Visible (Widoczne) dezaktywuj porty, które chcesz ukryć.
4. Kliknij OK.

Aktywacja i dezaktywacja portów (tylko macOS)

W systemie macOS można określić, które porty wejściowe i wyjściowe są aktywne. Pozwala to na 
użycie wejścia mikrofonowego zamiast wejścia liniowego lub dezaktywację wejścia lub wyjścia 
karty dźwiękowej.

UWAGA
Ta funkcja jest dostępna tylko dla wbudowanych urządzeń audio, standardowych urządzeń audio 
USB i określonej liczby innych kart dźwiękowych.

PROCEDURA
1. Wybierz Studio > Studio Setup (Konfiguracja studia).
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2. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio.
3. Kliknij Control Panel (Panel sterowania).
4. Aktywuj/dezaktywuj porty.
5. Kliknij OK.

Dodawanie szyn wejściowych i wyjściowych
Musisz dodać szyny wejściowe i wyjściowe, aby ustanowić połączenie między sprzętem audio a 
Cubase.

PROCEDURA
1. W oknie dialogowym Audio Connections (Połączenia audio) kliknij kartę Inputs (Wejścia) lub  
          Outputs (Wyjścia).
2. Kliknij Add Bus (Dodaj szynę).
3. W oknie dialogowym Add Input Bus (Dodaj magistralę wejściową) skonfiguruj magistralę.
4. Opcjonalnie: Wprowadź nazwę magistrali. Jeśli nie określisz nazwy, magistrala zostanie   
          nazwana zgodnie z konfiguracją kanału.
5. Kliknij Add Bus (Dodaj szynę).
          Nowa szyna zostanie dodana do listy szyn.
6. Dla każdego kanału głośnika w magistrali kliknij kolumnę Device Port (Port urządzenia) i    
          wybierz port twojego sprzętu audio.

Ustawianie domyślnej szyny wyjściowej (Main Mix)
Main Mix to domyślna magistrala wyjściowa, do której automatycznie kierowany jest każdy nowy 
kanał audio, grupa lub kanał FX. Jeśli dostępna jest tylko jedna magistrala, jest ona automatycznie 
używana jako domyślna magistrala wyjściowa.

WARUNEK WSTĘPNY
Dodaj magistralę wyjściową.

PROCEDURA
1. W oknie dialogowym Audio Connections (Połączenia audio) kliknij prawym przyciskiem szynę 
wyjściową, której chcesz użyć jako domyślnej szyny wyjściowej.
2. Wybierz Set (Ustaw) <nazwa magistrali> as Main Mix.

WYNIK
Wybrana magistrala jest używana jako magistrala domyślna. Główny miks jest oznaczony ikoną 
głośnika obok jego nazwy.

POWIĄZANE LINKI
Zakładka Inputs/Outputs (Wejścia/Wyjścia) na stronie 26.

Dodawanie szyn podrzędnych (Child Buses)

Szyny podrzędne umożliwiają kierowanie ścieżek do określonych kanałów w magistrali.

Na przykład, możesz skierować ścieżkę stereo do pary kanałów stereo w szynie surround. Lub 
możesz nagrać parę kanałów stereo w szynie surround na osobnej ścieżce stereo.
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PROCEDURA
1. W zakładce Inputs, Outputs lub Group/FX kliknij prawym przyciskiem szynę surround.
2. Kliknij Add Child Bus i wybierz konfigurację kanału.

WYNIK
Szyna podrzędna jest tworzona i może być używana do wyznaczania tras.

Presety (wstępne ustawienia) dla szyn wejściowych i wyjściowych

W przypadku konfiguracji magistrali wejściowej i wyjściowej można używać różnych rodzajów 
ustawień wstępnych.
     ● Szereg standardowych konfiguracji magistrali.
     ● Automatycznie tworzone ustawienia wstępne dostosowane do konkretnej konfiguracji   
         sprzętowej. Podczas uruchamiania Cubase analizuje fizyczne wejścia i wyjścia zapewniane  
         przez sprzęt audio i tworzy szereg ustawień zależnych od sprzętu.
     ● Własne ustawienia wstępne.

UWAGA
Można utworzyć domyślne ustawienia wstępne dla konfiguracji magistrali wejściowej i wyjściowej.
Jeśli utworzysz nowy pusty projekt, zostaną zastosowane te domyślne ustawienia wstępne. Aby 
utworzyć domyślne ustawienia wstępne, zapisz preferowane konfiguracje magistrali wejściowej i 
wyjściowej pod nazwą Default (Domyślne). Jeśli nie zdefiniowano domyślnych ustawień 
wstępnych, podczas tworzenia nowego pustego projektu stosowana jest ostatnio używana 
konfiguracja magistrali wejściowej i wyjściowej.

Zapisywanie ustawień wstępnych konfiguracji magistrali
Możesz zapisać własną konfigurację magistrali wejściowej i wyjściowej oraz konfigurację studia 
jako ustawienia wstępne.

PROCEDURA
1. Wybierz Studio > Audio Connections (Połączenia audio).
2. Kliknij kartę Inputs (Wejścia) lub Outputs (Wyjścia) i skonfiguruj konfigurację magistrali.
3. Kliknij Store Sklep.
4. W oknie dialogowym Preset Name (Nazwa ustawienia wstępnego) wprowadź nazwę.
5. Kliknij OK.

WYNIK
Ustawienie wstępne jest dostępne w menu Presets (Ustawienia wstępne).

Usuwanie ustawienia wstępnego konfiguracji magistrali
Możesz usunąć ustawienia wstępne konfiguracji magistrali, których już nie potrzebujesz.

PROCEDURA
1. Wybierz Studio > Audio Connections (Połączenia audio).
2. Kliknij kartę Inputs (Wejścia) lub Outputs (Wyjścia) i z menu Presets (Ustawienia wstępne)    
       wybierz ustawienie wstępne, które chcesz usunąć.
3. Kliknij Delete (Usuń).

WYNIK
Ustawienie wstępne zostanie usunięte
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Dodawanie kanałów grupowych i FX (efektów)
Kanały grupowe i kanały FX umożliwiają grupowanie konfiguracji magistrali.

Dodawanie kanałów grupowych i FX w oknie Audio Connections (Połączenia audio) jest 
identyczne z tworzeniem ścieżek kanałów grupowych lub ścieżek kanałów FX w oknie Project.

PROCEDURA
1. W oknie dialogowym Audio Connections (Połączenia audio) kliknij kartę Group/FX.
2. Wykonaj jedną z następujących czynności:
           ● Aby utworzyć kanał grupowy, kliknij Add Group (Dodaj grupę).
           ● Aby utworzyć kanał FX, kliknij Add FX (Dodaj FX).
3. Skonfiguruj kanał.
4. Opcjonalnie: Wprowadź nazwę ścieżki kanału grupowego.
5. Kliknij OK.
          Kanał grupy lub kanał FX zostanie dodany do listy magistrali.
6. Dla każdego kanału głośnikowego w magistrali kliknij kolumnę Output Routing i wybierz port  
    sprzętu audio.

POWIĄZANE LINKI
Efekty dźwiękowe na stronie 443.

Monitorowanie magistrali
W oknie Audio Connections (Połączenia audio) możesz skonfigurować szyny używane do 
monitorowania, aktywować/dezaktywować oraz otwierać Control Room (Pomieszczenie 
kontrolne).

Kiedy Control Room jest wyłączony w zakładce Control Room w oknie Audio Connections 
(Połączenia audio), do monitorowania używana jest magistrala Main Mix. W takim przypadku 
możesz dostosować poziom monitorowania w MixConsole.

POWIĄZANE LINKI
Ustawianie domyślnej szyny wyjściowej (Main Mix) na stronie 33
Control Room (Pomieszczenie kontrolne) na stronie 425
MixConsole na stronie 347

Instrumenty zewnętrzne i efekty
Możesz zintegrować zewnętrzne urządzenia efektów i instrumenty zewnętrzne, na przykład 
syntezatory sprzętowe, z przepływem sygnału sekwencera.

Wymagania
● Aby korzystać z efektów zewnętrznych, potrzebujesz sprzętu audio z wieloma wejściami i 
wyjściami. Efekt zewnętrzny wymaga co najmniej jednego wejścia i jednego wyjścia lub pary 
wejścia/wyjścia dla efektów stereo, oprócz portów wejścia/wyjścia używanych do nagrywania i 
monitorowania.
● Aby korzystać z zewnętrznych instrumentów, do komputera musi być podłączony interfejs MIDI.
● Sprzęt audio ze sterownikami o niskim opóźnieniu.
Cubase kompensuje opóźnienie wejścia/wyjścia i zapewnia, że dźwięk przetwarzany przez efekty 
zewnętrzne nie jest przesunięty w czasie.
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Podłączanie zewnętrznego instrumentu/efektu

Do sprzętu audio komputera można podłączyć zewnętrzne instrumenty/efekty.

WARUNEK WSTĘPNY
Urządzenie sprzętowe ma wejścia i wyjścia stereo.

PROCEDURA
1. Podłącz nieużywaną parę wyjść w sprzęcie audio do pary wejść w zewnętrznym urządzeniu.
2. Podłącz nieużywaną parę wejściową sprzętu audio do pary wyjść w urządzeniu sprzętowym.

WAŻNE
Jeśli wybierzesz porty wejścia/wyjścia dla zewnętrznych instrumentów/efektów, które są już 
używane, istniejące przypisanie portów zostanie przerwane bez ostrzeżenia.

PO WYKONANIU TEGO ZADANIA
Po podłączeniu urządzenia zewnętrznego do sprzętu audio komputera należy skonfigurować 
zewnętrzne szyny wejścia/wyjścia, a także zewnętrzne efekty/instrumenty w Cubase

POWIĄZANE LINKI
Konfigurowanie portów wejściowych i wyjściowych na stronie 21
Konfigurowanie efektów zewnętrznych na stronie 36
Konfigurowanie instrumentów zewnętrznych na stronie 39

Konfigurowanie efektów zewnętrznych

Musisz skonfigurować efekty zewnętrzne w Cubase, zanim będziesz mógł ich używać.

PROCEDURA
1. W oknie Audio Connections (Połączenia audio) kliknij zakładkę External FX (Efekty  
      zewnętrzne).
2. Kliknij Add External FX (Dodaj efekt zewnętrzny).
3. W oknie dialogowym Add External FX (Dodaj efekt zewnętrzny) wprowadź nazwę efektu 
zewnętrznego i określ konfiguracje wysyłania i powrotu. W zależności od rodzaju efektu można 
określić konfiguracje mono, stereo lub surround.
4. Kliknij Associate MIDI Device (Skojarz urządzenie MIDI) i wybierz urządzenie MIDI.
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Możesz także wybrać MIDI Devices (Urządzenia MIDI) > Create Device (Utwórz urządzenie) 
i utworzyć nowe powiązanie urządzenia MIDI.

UWAGA
Kompensacja opóźnienia jest stosowana tylko dla efektu, gdy używasz urządzeń MIDI.

5. Kliknij OK.
    Spowoduje to dodanie nowej zewnętrznej szyny FX.
6. Kliknij kolumnę Device Port (Port urządzenia) dla lewego i prawego portu szyny nadawczej i   
    wybierz wyjścia sprzętu audio, których chcesz użyć.
7. Kliknij kolumnę Device Port dla lewego i prawego portu magistrali powrotnej i wybierz wejścia 
    sprzętu audio, których chcesz użyć.
8. Wprowadź dodatkowe ustawienia dla magistrali.
     Ustawienia można również dostosować podczas korzystania z efektu zewnętrznego. Pozwala to  
      usłyszeć wynik.

POWIĄZANE LINKI
Korzystanie z urządzeń MIDI na stronie 782
Kompensacja opóźnienia na stronie 737

Dodawanie efektów zewnętrznych

Możesz użyć zewnętrznej szyny FX jako efektu insertowego lub jako efektu send, który jest 
efektem insertowym na ścieżce kanału FX.

WARUNEK WSTĘPNY
Skonfiguruj efekty zewnętrzne w oknie Audio Connections (Połączenia audio).

PROCEDURA
1. W Inspector (Inspektor) otwórz panel Inserts (Wstawki).
2. Otwórz menu Select Insert (Wybierz wstawkę).
      

 

3. Wybierz efekt zewnętrzny z podmenu External Plug-ins (Wtyczki zewnętrzne).
Efekty zewnętrzne są oznaczone ikoną x na liście obok ich nazw w wyskakującym menu Select 
Insert (Wybierz wstawkę).
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WYNIK
Zewnętrzna szyna FX jest ładowana do gniazda efektów. Otworzy się okno parametrów, 
pokazujące ustawienia Delay, Send Gain i Return Gain dla zewnętrznej szyny FX. Ustawienia te 
można dostosować podczas odtwarzania.
Sygnał audio z kanału jest przesyłany do wyjść sprzętu audio przez zewnętrzne urządzenie 
efektowe i z powrotem do programu przez wejścia sprzętu audio.

POWIĄZANE LINKI
Konfigurowanie efektów zewnętrznych na stronie 36

Okno parametrów efektu zewnętrznego (External Effect Parameter)

W tym oknie możesz dokonać ustawień opóźnienia (delay) i wzmocnienia (gain) dla wybranego 
efektu zewnętrznego.
● Aby otworzyć okno parametrów efektu zewnętrznego (External Effect Parameter), wybierz 
efekt zewnętrzny z wyskakującego menu Wybierz wstawkę (Select Insert) w Inspektorze 
(Inspector).

                      

Activate Effect (Aktywuj efekt)

Aktywuje/dezaktywuje efekt zewnętrzny.
Bypass Effect (Efekt obejścia)

               Pozwala ominąć efekt zewnętrzny.
Measure Effect’s Loop Delay for Delay Compensation (Zmierz opóźnienie pętli efektu w celu 
kompensacji opóźnienia)

               Jeśli ta opcja jest włączona, Cubase automatycznie określa wartość opóźnienia 
używaną do kompensacji opóźnienia. Jest to ta sama funkcja, co opcja Check User Delay (Sprawdź
opóźnienie użytkownika) w oknie Audio Connections (Połączenia audio).
             Po zdefiniowaniu urządzenia MIDI dla efektu, otworzy się odpowiednie okno urządzenia.
Delay (Opóźnienie)
            Umożliwia dostosowanie opóźnienia efektu zewnętrznego.
Send Gain (Wyślij wzmocnienie)
            Umożliwia dostosowanie wzmocnienia wysyłania dla efektu zewnętrznego.
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Return Gain (Zwrot wzmocnienia)
            Umożliwia regulację wzmocnienia odbicia dla efektu zewnętrznego.

Konfigurowanie instrumentów zewnętrznych

Musisz skonfigurować instrumenty zewnętrzne w Cubase, zanim będziesz mógł z nich korzystać.

PROCEDURA
1. W oknie Audio Connections (Połączenia audio) kliknij kartę External Instruments   
    (Instrumenty zewnętrzne).
2. Kliknij Add External Instrument (Dodaj instrument zewnętrzny).
3. W oknie dialogowym Add External Instrument (Dodaj instrument zewnętrzny) wprowadź    
    nazwę instrumentu zewnętrznego i określ liczbę wymaganych zwrotów mono i/lub stereo. W  
    zależności od typu instrumentu wymagana jest określona liczba kanałów zwrotnych mono i/lub 
    stereo.
4. Kliknij Associate MIDI Device i wybierz urządzenie MIDI.
5. Kliknij OK. Spowoduje to dodanie nowej zewnętrznej szyny instrumentów.
6. Kliknij w kolumnie Device Port (Port urządzenia) dla lewego i prawego portu magistrali 
    zwrotnej i wybierz wejścia sprzętu audio, do którego podłączyłeś instrument zewnętrzny.
7. Wprowadź dodatkowe ustawienia dla magistrali.
   Ustawienia można również dostosować podczas korzystania z instrumentu zewnętrznego. 
   Pozwala to usłyszeć wynik.

POWIĄZANE LINKI
Korzystanie z urządzeń MIDI na stronie 782

Dodawanie instrumentów zewnętrznych
Możesz dodać instrumenty zewnętrzne do listy instrumentów VST.

WARUNEK WSTĘPNY
Skonfiguruj instrumenty zewnętrzne w oknie Połączenia audio.

PROCEDURA
1. Wybierz Studio > VST Instruments (Instrumenty VST).
2. Kliknij Add Track Instrument (Dodaj ścieżkę instrument).
3. Wybierz instrument zewnętrzny z wyskakującego menu Instrument.
    Instrumenty zewnętrzne są oznaczone ikoną x na liście obok ich nazw w menu podręcznym   
    Instrument.

          

4. Kliknij OK

WYNIK
Instrument zewnętrzny zostanie dodany do listy instrumentów VST.
Otworzy się okno parametrów zewnętrznego instrumentu. Może to być okno urządzenia, które 
umożliwia utworzenie ogólnego panelu urządzenia, okno edytora OPT lub edytor domyślny.
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POWIĄZANE LINKI
Okno instrumentów VST na stronie 730

Okno parametrów instrumentów zewnętrznych (External Instruments 
Parameter)
Okno to umożliwia dokonanie ustawień opóźnienia (delay) i wzmocnienia (gain) dla wybranego 
instrumentu zewnętrznego.
● Aby otworzyć okno External Instruments Parameter (Parametry instrumentu zewnętrznego), 
wybierz instrument zewnętrzny w oknie VST Instruments (Instrumenty VST).

                         

Aktywuj instrument zewnętrzny

            Aktywuje/dezaktywuje instrument zewnętrzny.
Pomiń instrument zewnętrzny

         Umożliwia pominięcie instrumentu zewnętrznego.
Delay (Opóźnienie)
        Umożliwia dostosowanie opóźnienia dla instrumentu zewnętrznego.
Return Gain (Zwrot wzmocnienia)
        Umożliwia regulację wzmocnienia odbicia dla instrumentu zewnętrznego.

Wysyłanie nut MIDI do instrumentów zewnętrznych
Możesz wysyłać nuty MIDI ze ścieżki MIDI do zewnętrznego instrumentu.

WARUNEK WSTĘPNY
Skonfiguruj instrumenty zewnętrzne w oknie Połączenia audio i dodaj ścieżkę MIDI.

PROCEDURA
1. W Inspektorze (Inspector) otwórz menu podręczne Output Routing dla odpowiedniej ścieżki 
MIDI.
2. Wybierz urządzenie MIDI, do którego podłączony jest instrument zewnętrzny.

WYNIK
Instrument odtworzy wszystkie nuty MIDI, które otrzyma ze ścieżki i zwróci je do Cubase przez 
skonfigurowane kanały zwrotne. Stosowana jest kompensacja opóźnienia. Zewnętrzny instrument 
zachowuje się jak każdy inny instrument VST w Cubase.

POWIĄZANE LINKI
Kompensacja opóźnienia na stronie 737.

Zapisywanie zewnętrznych konfiguracji instrumentów i efektów jako ulubione
Możesz zapisać zewnętrzne instrumenty i efekty zewnętrzne jako ulubione. Ulubione to 
konfiguracje urządzeń, które można przywołać. Pozwalają również na zapisywanie różnych 
konfiguracji dla tego samego urządzenia, na przykład tablicy multiefektów lub efektu, który 
zapewnia zarówno tryb mono, jak i stereo.
PROCEDURA
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1. Wybierz Studio > Audio Connection (Połączenia audio).
2. Otwórz zakładkę External Instruments (Instrumenty zewnętrzne) lub External FX (Efekty 
zewnętrzne).

3. Wybierz szynę z listy i kliknij Favorites (Ulubione).
4. Wybierz opcję Add Selected Instrument/Effect to Favorites (Dodaj wybrany instrument/efekt  
     do ulubionych).

WYNIK
Zewnętrzna konfiguracja instrumentu lub efektu zostanie zapisana jako ulubiona. Możesz 
przywołać ulubione, klikając Favorites (Ulubione) i wybierając konfigurację, którą chcesz 
przywołać.

Zamrażanie zewnętrznych instrumentów/efektów
Możesz zamrozić zewnętrzne instrumenty lub efekty, aby zaoszczędzić moc obliczeniową.

PROCEDURA
1. Wybierz ścieżkę audio wykorzystującą efekt zewnętrzny lub ścieżkę instrumentu wykorzystującą
    instrument zewnętrzny.
2. W Inspektorze (Inspector) kliknij Freeze Audio Channel (Zablokuj kanał audio) lub Freeze   
    Instrument Channel (Zablokuj kanał instrumentu).
3. W oknie dialogowym dostosuj wartość Tail Size (Rozmiar ogona). Gdy Tail Size jest ustawiony 
    na 0 s, zamrażanie bierze pod uwagę tylko dane w granicach części.

WYNIK
Funkcja zamrażania jest wykonywana w czasie rzeczywistym, aby zapewnić uwzględnienie 
efektów zewnętrznych.

POWIĄZANE LINKI
Instrumenty VST na stronie 726
Efekty dźwiękowe na stronie 443
Zamrażanie instrumentów na stronie 736
Zamrażanie efektów wstawiania na stronie 449

Brakujące wtyczki
Dzieje się tak w następujących sytuacjach:

● Gdy usuniesz urządzenie zewnętrzne z okna Audio Connections (Połączenia audio), mimo że 
jest ono używane w zapisanym projekcie.
● Podczas przesyłania projektu do innego komputera, na którym nie zdefiniowano urządzenia 
zewnętrznego.
● Gdy otworzysz projekt utworzony we wcześniejszej wersji Cubase.
W oknie Audio Connections (Połączenia audio) zerwane połączenie z urządzeniem zewnętrznym 
jest sygnalizowane ikoną w kolumnie Bus Name (Nazwa magistrali).
● Aby przywrócić zerwane połączenie z urządzeniem zewnętrznym, kliknij prawym przyciskiem 
myszy wpis urządzenia w kolumnie Bus Name (Nazwa magistrali) i wybierz opcję Connect 
External Effect (Podłącz efekt zewnętrzny).

UWAGA
Szyny skonfigurowane dla zewnętrznych instrumentów lub efektów zewnętrznych są zapisywane 
globalnie, to znaczy dla określonej konfiguracji komputera.
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Konfiguracje magistrali

Po skonfigurowaniu wszystkich wymaganych magistral dla projektu możesz edytować nazwy i 
zmieniać przypisania portów. Konfiguracja magistrali jest zapisywana wraz z projektem.

Usuwanie magistrali
Możesz usunąć szyny, których już nie potrzebujesz.

PROCEDURA
● W oknie Audio Connections (Połączenia audio) wykonaj jedną z następujących czynności:
          ● Aby usunąć pojedynczą magistralę, kliknij prawym przyciskiem myszy magistralę na liście
             i wybierz Remove Bus (Usuń magistralę). Alternatywnie możesz wybrać szynę i nacisnąć   
              Backspace .
          ● Aby usunąć jednocześnie wiele szyn wejściowych lub wyjściowych, użyj klawisza Shift  
             lub Ctrl/Cmd zaznacz je na liście, kliknij je prawym przyciskiem myszy i wybierz opcję   
              Remove Selected Busses (Usuń wybrane magistrale).

Zmiana przypisań portów
Możesz zmienić przypisanie portów magistrali.

PROCEDURA
1. Wybierz Studio > Audio Connections (Połączenia audio).
2. Wykonaj jedną z następujących czynności:
          ● Aby zmienić przypisanie pojedynczej magistrali, otwórz menu podręczne Device Port   
             (Port urządzenia) i wybierz nowy port.
          ● Aby przypisać kolejne szyny do kilku wybranych szyn, otwórz menu podręczne 
              Device Port (Port urządzenia) dla pierwszego wybranego wpisu, naciśnij klawisz Shift i  
              wybierz port urządzenia.

UWAGA
Wyłączne porty, na przykład porty, które są już przypisane do kanałów w Control Room 
(pomieszczeniu kontrolnym), są pomijane.

         ● Aby przypisać ten sam port do kilku wybranych magistral, otwórz menu podręczne Device 
            Port dla pierwszego wybranego wpisu, naciśnij Shift-Alt/Opt i wybierz port urządzenia.

Zmiana nazwy wielu magistral
Możesz zmienić nazwy wszystkich wybranych autobusów jednocześnie, używając przyrastających 
cyfr lub liter.

PROCEDURA
1. Wybierz Studio > Audio Connections (Połączenia audio).
2. Wybierz magistrale, których nazwy chcesz zmienić.
3. Wykonaj jedną z następujących czynności:
         ● Wprowadź nową nazwę jednej z magistrali, a następnie numer.
         ● Wprowadź nową nazwę jednej z magistrali, po której następuje spacja i wielka litera.
4. Naciśnij Return (Powrót).

WYNIK
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Nazwy magistrali są zmieniane automatycznie przy użyciu wzrastających cyfr lub liter.

UWAGA
Zmiana nazwy rozpoczyna się od magistrali, w której edytujesz nazwę, aż do dołu, a następnie jest 
kontynuowana od góry, aż wszystkie nazwy wybranych magistral zostaną zmienione.

Wyłączne przypisania portów
W przypadku niektórych typów kanałów przypisanie portu jest wyłączne.

Raz przydzielony port do takiej magistrali lub kanału nie może być przypisany do innej magistrali, 
w przeciwnym razie połączenie z pierwszą magistralą zostanie zerwane.

Odpowiednie porty są zaznaczone w oknie Audio Connections (Połączenia audio) 
w wyskakującym menu Device Port (Port urządzenia).
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Okno projektu (Project)

Okno projektu zawiera przegląd projektu i umożliwia nawigację oraz edycję na dużą skalę.

Każdy projekt ma jedno okno projektu. Okno Project (Projekt) jest wyświetlane za każdym razem, 
gdy otwierasz lub tworzysz nowy projekt.
          ● Aby otworzyć projekt, wybierz File > Open (Plik > Otwórz).
          ● Aby utworzyć nowy projekt, wybierz File > New Project (Plik > Nowy projekt).

Okno projektu jest podzielone na kilka stref:

1.  Lewa Strefa
Lewa strefa pokazuje Inspektora, który zawiera dwie zakładki:
          ● Zakładka Ścieżka pokazuje ustawienia ścieżki wybranej na liście ścieżek.
UWAGA
W tej dokumentacji używamy Inspectora (Inspector), aby odnieść się do zakładki Track (Ścieżka) 
w Inspektorze.
          ● Zakładka Edytor pokazuje ustawienia edytora otwartego w dolnej strefie.

Możesz także otworzyć kartę Visibility (Widoczność) zawierającą następujące karty:

         ● Zakładka Track (utwór, ścieżka) umożliwia pokazywanie/ukrywanie poszczególnych   
             utworów na liście ścieżek.
         ● Zakładka Zones (Strefy) umożliwia określenie i zablokowanie pozycji niektórych kanałów  
             MixConsole w dolnej strefie.

2.  Strefa Projektu
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Strefa projektu pokazuje pasek narzędzi, listę ścieżek ze ścieżkami, ekran wydarzeń z częściami i 
wydarzeniami projektu oraz linijkę okna projektu.

Na pasku narzędzi możesz aktywować/dezaktywować linię stanu, linię informacyjną, linię 
przeglądu i pasek transportu (Transport Bar).

3.  Dolna strefa
Dolna strefa pokazuje Chord Pads, Editor, Sampler Control i MixConsole.

4.  Prawa strefa
Prawa strefa przedstawia „stojak” na VST-y, „stojak” na Media, ”stojak” na Control Room 
(pomieszczenie kontrolne) i „stojak” na mierniki (Meter).

POWIĄZANE LINKI
Strefa projektu na stronie 45
Lewa strefa na stronie 60
Strefa dolna na stronie 68
Prawa strefa na stronie 74
Pasek narzędzi okna projektu na stronie 46

Pokazywanie/ukrywanie stref
Możesz pokazać/ukryć strefy w oknie Project zgodnie ze swoimi potrzebami.

PROCEDURA
● Wykonaj jedną z następujących czynności:
          ● Aby pokazać/ukryć lewą strefę, kliknij Show/Hide Left Zone (Pokaż/ukryj lewą strefę) na 
              pasku narzędzi okna projektu (Project).
          ● Aby pokazać/ukryć dolną strefę, kliknij Show/Hide Lower Zone (Pokaż/ukryj dolną  
              strefę) na pasku narzędzi okna projektu.
          ● Aby pokazać/ukryć prawą strefę, kliknij Show/Hide Right Zone (Pokaż/ukryj prawą 
              strefę) na pasku narzędzi okna projektu.

UWAGA
Strefa projektu jest zawsze pokazana.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Strefa Projektu
Strefa projektu jest sercem okna projektu i nie można jej ukryć.

W strefie projektu znajduje się lista utworów oraz wyświetlanie zdarzeń wraz z podziałką. Co 
więcej, możesz aktywować/dezaktywować linię stanu, linię informacyjną, linię przeglądu i pasek 
transportu (Transport Bar) dla strefy projektu.
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POWIĄZANE LINKI
Lista utworów na stronie 54
Wyświetlanie zdarzeń na stronie 55
Globalne sterowanie ścieżką na stronie 55
Linijka na stronie 57
Linia stanu na stronie 58
Linia informacyjna na stronie 59
Przegląd linii na stronie 59
Pasek transportu na stronie 60

Pasek narzędzi okna projektu
Pasek narzędzi zawiera narzędzia i skróty do otwierania innych okien oraz różnych ustawień i 
funkcji projektu.

● Aby pokazać/ukryć narzędzia, otwórz menu kontekstowe paska narzędzi, klikając prawym 
przyciskiem myszy pusty obszar paska narzędzi i aktywuj narzędzia, które chcesz wyświetlić. Aby 
wyświetlić wszystkie narzędzia, wybierz opcję Show All (Pokaż wszystko).

UWAGA
Liczba wyświetlanych elementów zależy również od wielkości okna Projektu i rozdzielczości 
ekranu.

Dostępne są następujące opcje:

Activate Project (Aktywuj projekt)

              

UWAGA
Dostępne tylko wtedy, gdy otwarty jest więcej niż jeden projekt.

Aktywuje projekt.

Project History (Historia projektu)

Undo/Redo (Cofnij/Ponów)

Cofa/ponawia czynności w oknie Project.  

Constrain Delay Compensation (Ograniczenie kompensacji opóźnienia)

Constrain Delay Compensation
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Minimalizuje skutki opóźnienia wynikające z kompensacji opóźnienia.

Left Divider (Lewy rozdzielacz)
Left Divider
Narzędzia umieszczone po lewej stronie separatora są pokazane zawsze.

Windows Media & MixConsole

Open MediaBay (Otwórz MadiaBay)

        Otwiera/zamyka MediaBay.

Open Pool Window (Otwórz okno puli)

        Otwiera/zamyka okno puli.

Open MixConsole (Otwórz MixConsole)

         Otwiera/zamyka MixConsole.

Open Control Room (Otwórz pomieszczenie kontrolne)

         Otwiera/zamyka Control Room.

Open Direct Offline Processing Window (Otwórz okno bezpośredniego przetwarzania offline)

         Otwiera/zamyka okno Direct Offline Processing.

Track Visibility Configurations (Konfiguracje widoczności ścieżki)
Track Visibility Configurations

        Umożliwia tworzenie konfiguracji przydatnych do przełączania między 
różnymi konfiguracjami widoczności.

Set Track Visibility Agents (Ustaw agentów widoczności ścieżki)

          Umożliwia ustawienie agenta widoczności do filtrowania ścieżek.

Set Track Type Filter (Ustaw filtr typu ścieżki)

          Umożliwia filtrowanie utworów według typu utworu. Kliknij Alt/Opt, aby zresetować 
filtr typu ścieżki.

State Buttons  (Stan przycisków)

Deactivate All Mute States (Dezaktywuj wszystkie stany wyciszenia)
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         Dezaktywuje wszystkie stany wyciszenia

Deactivate All Solo States (Dezaktywuj wszystkie stany Solo)

          Dezaktywuje wszystkie stany solo.

Deactivate All Listen States (Dezaktywuj wszystkie stany nasłuchiwania)

          Dezaktywuje wszystkie stany nasłuchiwania.

Activate/Deactivate Read for All Tracks (Włącz/wyłącz opcję Odczyt dla wszystkich ścieżek)

          Włącza/wyłącza automatyzację odczytu dla wszystkich ścieżek.

Activate/Deactivate Write for All Tracks (Włącz/wyłącz zapis dla wszystkich ścieżek)

        Włącza/wyłącza automatyzację zapisu dla wszystkich ścieżek.

Suspend All Read/Write Automation (Zawieś całą automatyzację odczytu/zapisu)

         Wstrzymuje całą automatyzację odczytu/zapisu.

Automation Mode (Tryb automatyzacji)
Automation Follows Events (Automatyzacja podąża za zdarzeniami)

         Umożliwia automatyczne śledzenie zdarzeń automatyzacji po przeniesieniu zdarzenia 
lub części na ścieżkę.

Global Automation Mode (Globalny tryb automatyzacji)

         Umożliwia wybór trybu globalnej automatyzacji.

Open Automation Panel (Otwórz panel automatyzacji)

         Otwiera panel automatyzacji (Automation Panel).

Auto-Scroll
Auto-Scroll

         Pozostawia widoczny kursor projektu podczas odtwarzania.

Select Auto-Scroll Settings (Wybierz Ustawienia automatycznego przewijania)

         Umożliwia aktywację przewijania strony (Page Scroll) lub stacjonarnego kursora 
(Stationary Cursor)oraz aktywację wstrzymania automatycznego przewijania podczas edycji 
(Suspend Auto-Scroll when Editing).

Locators (Lokalizatory)

Goto Left Locator Position (Przejdź do lewej pozycji lokalizatora)

         Umożliwia przejście do lewej pozycji lokalizatora.

Left Locator Position (Lewa pozycja lokalizatora)
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         Pokazuje lewą pozycję lokalizatora.

Goto Right Locator Position (Przejdź do prawej pozycji lokalizatora)

         Pozwala przejść do właściwej pozycji lokalizatora. 

Right Locator Position (Prawa pozycja lokalizatora)

        Pokazuje prawą pozycję lokalizatora.

Locator Range Duration (Czas trwania zasięgu lokalizatora)

Locator to Selection (Lokalizatory do zaznaczenia)

         Umożliwia ustawienie lokalizatorów do zaznaczenia.

Locator Range Duration (Czas trwania zasięgu lokalizatora)

        Pokazuje czas trwania zasięgu lokalizatora.   

Transport Controls (Sterowanie transportem)

Go to Previous Marker/Zero (Przejdź do poprzedniego znacznika/zera)

         Przesuwa kursor projektu do poprzedniego znacznika/pozycji zerowej na osi czasu.

Go to Next Marker/Project End (Przejdź do następnego znacznika/końca projektu)

         Przesuwa kursor projektu do następnego znacznika/końca projektu.

Rewind (Przewijanie do tyłu)     

         Przesuwa się do tyłu.

Forward (Do przodu)

         Przesuwa do przodu.

Activate Cycle (Aktywuj cykl)

        Aktywuje/dezaktywuje tryb cyklu.

Stop

         Zatrzymuje odtwarzanie.

Start

         Rozpoczyna odtwarzanie.

Transport Record (Nagrywanie transportu)

         Włącza/wyłącza tryb nagrywania.
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Time Displays (Wyświetlacze czasu)

Select Primary Time Format (Wybierz podstawowy format czasu)

         Umożliwia wybranie formatu czasu dla głównego wyświetlania czasu.

Primary Time Display (Główny wyświetlacz czasu)

         Pokazuje pozycję kursora projektu w wybranym formacie czasu.

Select Secondary Time Format (Wybierz dodatkowy format czasu)

         Umożliwia wybranie formatu czasu dla dodatkowego wyświetlania czasu.

Secondary Time Display (Wyświetlacz czasu dodatkowego)

         Pokazuje pozycję kursora projektu w wybranym formacie czasu.

Markers (Znaczniki, markery)

Jump to marker (Skok do znacznika)

      Umożliwia ustawianie i lokalizowanie pozycji znaczników.

Open Markers Window (Otwórz okno znaczników)

         Otwiera okno Znaczniki (Markers).

 Tool Buttons (Przyciski narzędziowe)

Combine Selection Tools (Połącz narzędzia do zaznaczania)

        Łączy narzędzie Object Selection (Zaznaczanie obiektów) i narzędzie Range Selection 
(Zaznaczanie zakresów).

Object Selection (Zaznaczanie obiektów)

        Wybiera zdarzenia i części.

Range Selection (Zaznaczanie zakresów)

         Wybiera zakresy.

Draw (Rysuj)

         Rysuje zdarzenia.

Erase (Usuń)            

        Usuwa zdarzenia.

Split (Rozdziel)

         Rozdziela zdarzenia.

50



Glue (Sklej)

         Skleja wydarzenia razem.

Mute (Wycisz)

         Wycisza zdarzenia.

Zoom (Powiększenie)

        Powiększa. Przytrzymaj Alt/Opt i kliknij, aby pomniejszyć.

Comp

         Montaż trwa

Time Warp (Zakrzywienie czasoprzestrzeni)

         Dopasowuje pozycje muzyczne zdarzeń do pozycji czasowych.

Line (Linia)

         Tworzy serię ciągłych zdarzeń.

Play (Graj)

         Umożliwia odtwarzanie zdarzeń.

Color (Kolor)

         Umożliwia kolorowanie zdarzeń.

Color Menu (Menu Kolor)
Select Color for Selected Tracks or Events (Wybierz kolor dla wybranych ścieżek lub zdarzeń)

         Otwiera panel Colorize (Koloruj), który umożliwia pokolorowanie wybranych 
ścieżek lub zdarzeń.

Nudge Palette (Paleta Przesuwanie)
Trim Start Left (Przycinanie Zacznij w lewo)

        Zwiększa długość wybranego zdarzenia, przesuwając jego początek w lewo.

Trim Start Right (Przycinanie Zacznij w prawo)

        Zmniejsza długość wybranego zdarzenia, przesuwając jego początek w prawo.

Move Left (Przesuń w lewo)

         Przesuwa wybrane zdarzenie w lewo.

Move Right (Przesuń w prawo)

        Przesuwa wybrane zdarzenie w prawo.
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Trim End Left (Lewy koniec przycięcia)

         Zmniejsza długość wybranego zdarzenia, przesuwając jego koniec w lewo.

Trim End Right (Prawy koniec przycięcia)

        Zwiększa długość wybranego zdarzenia, przesuwając jego koniec w prawo.

Project Root Key (Klucz główny projektu)
Project Root Key

          Zmienia klucz główny projektu.

Snap (Przyciąganie)
Snap to Zero Crossing (Przyciągnij do przejścia przez zero)  

         Ogranicza edycję do przejść przez zero, czyli pozycji, w których amplituda wynosi zero.

Snap On/Off (Włączanie/wyłączanie przyciągania)

          Ogranicza ruch poziomy i pozycjonowanie do pozycji określonych przez Typ 
przyciągania (Snap Type).

Snap Type (Typ przyciągania)

          Pozwala określić, do jakich pozycji mają być przyciągane zdarzenia.

Grid Type (Typ siatki)
Grid Type

          Umożliwia określenie typu siatki dla funkcji Snap (Skok). To 
ustawienie działa tylko wtedy, gdy Snap Type (Typ przyciągania) jest ustawiony na jedną z opcji 
siatki.

Quantize (Kwantyzacja)
Apply Quantize (Zastosuj kwantyzację)

           Stosuje ustawienia kwantyzacji.

Quantize Presets (Wstępne ustawienia kwantyzacji)

           Umożliwia wybranie ustawienia wstępnego kwantyzacji.

Soft Quantize On/Off (Włączanie/wyłączanie miękkiej kwantyzacji)

         Włącza/wyłącza miękką kwantyzację.

AudioWarp Quantize On/Off (Włącz/wyłącz kwantyzację AudioWarp)
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          Włącza/wyłącza kwantyzację AudioWarp.

Open Quantize Panel (Otwórz panel kwantyzacji)

          Otwiera panel kwantyzacji (Quantize Panel).

Audio Alignment (Wyrównywanie Audio)
Open Audio Alignment Panel (Otwórz panel wyrównywania Audio)

          Otwiera Audio Alignment Panel.

System Performance Meter (Miernik wydajności systemu)
System Performance Meter

         Pokazuje liczniki średniego obciążenia 
przetwarzania dźwięku i obciążenia pamięci podręcznej dysku.

Right Divider (Prawy rozdzielacz)
Right Divider
Narzędzia umieszczone po prawej stronie separatora są zawsze pokazane.

Window Zone Controls (Okno Sterowanie Strefami)
Show/Hide Left Zone (Pokaż/ukryj lewą strefę)

         Pokazuje/ukrywa lewą strefę okna.

Show/Hide Lower Zone (Pokaż/ukryj dolną strefę)

         Pokazuje/ukrywa dolną strefę okna.

Show/Hide Right Zone (Pokaż/ukryj prawą strefę)

         Pokazuje/ukrywa prawą strefę okna.

Set up Window Layout (Skonfiguruj układ okien)

          Umożliwia ustawienie układu okien.

Set up Toolbar (Skonfiguruj pasek narzędzi)
Set up Toolbar

         Otwiera wyskakujące menu, w którym można określić, które elementy paska narzędzi 
mają być widoczne.

POWIĄZANE LINKI
Dzielnik lewego/prawego paska narzędzi na stronie 53
Menu typów przyciągania na stronie 86
Znaczniki na stronie 336
Automatyzacja na stronie 705
Synchronizacja na stronie 1074
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Wyrównywanie Audio na stronie 210

Left/Right Toolbar Divider (Dzielnik lewego/prawego paska narzędzi)

Dzielniki lewego i prawego paska narzędzi umożliwiają zablokowanie pozycji określonych 
narzędzi po lewej lub prawej stronie paska narzędzi, dzięki czemu są one zawsze widoczne.

Wszystkie inne elementy są wyświetlane na środku paska narzędzi. Gdy zmniejszasz szerokość 
okna Projektu (Project), te elementy paska narzędzi są sukcesywnie ukrywane. Po zwiększeniu 
szerokości są one ponownie wyświetlane.

Toolbox (Przybornik)
Przybornik udostępnia narzędzia edycyjne z paska narzędzi w pozycji wskaźnika myszy. Można je 
otworzyć zamiast standardowych menu kontekstowych w oknie zdarzeń i edytorach.

           
      ● Aby aktywować funkcję przybornika, aktywuj opcję Pokaż przybornik po kliknięciu prawym 
przyciskiem myszy (Show Toolbox on Right-Click) w oknie dialogowym Preferencje 
(Preferences) (Edycja (Editing) — strona Narzędzia (Tools)).
      ● Aby otworzyć przybornik, kliknij prawym przyciskiem myszy w oknie zdarzeń lub edytorze. 
Jeśli opcja Pokaż przybornik po kliknięciu prawym przyciskiem myszy (Show Toolbox on Right-
Click) jest wyłączona, otwiera się menu kontekstowe.
      ● Aby otworzyć menu kontekstowe zamiast przybornika, naciśnij dowolny klawisz 
modyfikujący i kliknij prawym przyciskiem myszy w oknie zdarzeń lub edytorze. Jeśli opcja Pokaż 
przybornik po kliknięciu prawym przyciskiem myszy (Show Toolbox on Right-Click) jest 
wyłączona, naciśnij dowolny klawisz modyfikujący, aby otworzyć przybornik zamiast menu 
kontekstowego.

Track List (Lista utworów (ścieżek))
Lista ścieżek zawiera ścieżki użyte w projekcie. Po dodaniu i wybraniu ścieżki zawiera ona pola 
nazw i ustawienia dla tej ścieżki.

        ● Aby zdecydować, które elementy sterujące są widoczne dla każdego typu ścieżki, kliknij 
prawym przyciskiem myszy listę ścieżek i otwórz okno dialogowe Ustawienia elementów 
sterujących ścieżką (Track Control Settings).

POWIĄZANE LINKI
Okno dialogowe ustawień sterowania ścieżką (Track Control Settings) na stronie 115.

Dividing the Track List (Dzielenie listy utworów)
Listę utworów można podzielić na górną i dolną. Te listy utworów mogą mieć niezależne elementy 
sterujące powiększaniem i przewijaniem. Dzielenie listy ścieżek jest przydatne na przykład podczas
pracy ze ścieżką wideo i wielościeżkowym dźwiękiem. Pozwala na umieszczenie ścieżki wideo na 
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górnej liście ścieżek i osobne przewijanie ścieżek audio na dolnej liście ścieżek, tak aby można je 
było ułożyć z wideo.

PROCEDURA
         ● Wykonaj jedną z następujących czynności:
         ● Wybierz Projekt (Project) > Podziel listę utworów (Divide Track List).
         ● Kliknij opcję Podziel listę ścieżek (Divide Track List) w prawym górnym rogu okna 
projektu pod linijką.

WYNIK
Lista ścieżek jest dzielona, a ścieżki wideo, znaczników lub aranżerów są automatycznie 
przenoszone na wyższą listę ścieżek. Wszystkie inne rodzaje utworów zostaną przeniesione na 
dolną listę utworów.

UWAGA
Obszar strefy projektu, który ma fokus, jest oznaczony podświetloną i ciągłą ramką ostrości, 
podczas gdy obszar nieaktywny jest pokazany ramką przerywaną.

PO WYKONANIU TEGO ZADANIA
         ● Aby przenieść dowolny typ ścieżki z dolnej listy ścieżek do górnej i odwrotnie, kliknij go 
prawym przyciskiem myszy na liście ścieżek iz menu kontekstowego wybierz opcję Toggle Track 
List (Przełącz listę ścieżek).
         ● Aby zmienić rozmiar górnej części listy utworów, kliknij i przeciągnij element 
rozdzielający między sekcjami listy utworów.
         ● Aby powrócić do pojedynczej listy utworów, ponownie kliknij opcję Divide Track List 
(Podziel listę utworów).

POWIĄZANE LINKI
Fokus klawiatury w oknie projektu na stronie 80.

Event Display (Wyświetlanie zdarzeń)
Ekran zdarzeń pokazuje części i zdarzenia, które są używane w projekcie. Są one rozmieszczone 
wzdłuż osi czasu.
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Global Track Controls (Globalne sterowanie ścieżką)
Globalne elementy sterujące utworami umożliwiają zarządzanie utworami na liście utworów.
          ● Globalne elementy sterujące utworami są wyświetlane nad listą utworów.

1.  Add Track (Dodaj ścieżkę)
Otwiera okno dialogowe Add Track.
2.  Use Track Preset (Użyj wstępnego ustawienia ścieżki)
Umożliwia dodanie ścieżki za pomocą gotowego ustawienia ścieżki.
3.  Number of Visible Tracks (Liczba widocznych ścieżek)
Wyświetla liczbę ukrytych ścieżek. Kliknij to, aby wyświetlić wszystkie ścieżki odfiltrowane przez 
kartę Visibility (Widoczność).

UWAGA
Jeśli ścieżka była poza widokiem lub była ukryta, jest teraz wyświetlana. Ścieżki, które są ukryte za
pomocą Set Track Type Filter (Ustaw filtr typu ścieżki), nie są wyświetlane.

4.  Set Track Type Filter (Ustaw filtr typu ścieżki)
Określa, jakie typy utworów są wyświetlane na liście utworów.
5.  Set Track Visibility Agents (Ustaw agentów widoczności ścieżki)
Umożliwia ustawienie agenta widoczności do filtrowania ścieżek.
6.  Find Tracks (Znajdź ścieżki)
Wyszukuje i wybiera określone utwory z listy ścieżek.

POWIĄZANE LINKI
Otwieranie Visibility (widoczności) na stronie 65

Filtering Track Types (Filtrowanie typów ścieżek)
Możesz filtrować ścieżki według ich typu.

PROCEDURA
1. Kliknij opcję Set Track Type Filter (Ustaw filtr typu ścieżki) nad listą ścieżek. Spowoduje to 
otwarcie filtra typów ścieżek.
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2.  Usuń zaznaczenie typu ścieżki, aby go ukryć.

WYNIK
Ścieżki filtrowanego typu są usuwane z listy ścieżek, a kolor przycisku Set Track Type Filter 
(Ustaw filtr typu ścieżki) zmienia się, wskazując, że typ ścieżki jest ukryty.

Finding Tracks (Znajdowanie ścieżek)
Funkcja Find Tracks pozwala znaleźć określone ścieżki. Jest to przydatne, jeśli masz duży projekt 
z wieloma ścieżkami lub jeśli masz ukryte ścieżki za pomocą karty Visibility (Widoczność).

PROCEDURA
1. Kliknij Find Tracks (Znajdź ścieżki) nad listą utworów, aby otworzyć selektor z listą wszystkich
utworów.
2. W polu wyszukiwania wprowadź nazwę utworu. Podczas pisania selektor aktualizuje się 
automatycznie.
3. W selektorze wybierz ścieżkę i naciśnij Return .

WYNIK
Selektor zamknie się i utwór zostanie wybrany na liście utworów

UWAGA
Jeśli ścieżka była poza widokiem lub była ukryta, jest teraz wyświetlana. Ścieżki, które są ukryte za
pomocą Set Track Type Filter (Ustaw filtr typu ścieżki), nie są wyświetlane.

Ruler (Linijka)
Linijka pokazuje oś czasu i format wyświetlania projektu.

Początkowo linijka okna Project (projekt) używa formatu wyświetlania określonego w oknie 
dialogowym Project Setup (Ustawienia projektu).
● Aby wybrać niezależny format wyświetlania linijki, kliknij przycisk strzałki po prawej stronie 
linijki i wybierz opcję z wyskakującego menu.
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● Aby ustawić format wyświetlania globalnie dla wszystkich okien, użyj wyskakującego menu 
Select Primary Time Format (Wybierz podstawowy format czasu) w panelu Transport lub 
przytrzymaj Ctrl/Cmd i wybierz format na dowolnej linijce.

POWIĄZANE LINKI
Okno dialogowe konfiguracji projektu (Project Setup) na stronie 104.

Menu formatu wyświetlania linijki
Można wybrać format wyświetlania linijki.
● Aby wyświetlić formaty wyświetlania linijki, kliknij przycisk strzałki po prawej stronie linijki.
  

                               

Dokonany wybór wpływa na formaty wyświetlania czasu w następujących obszarach:
● Ruler (Linijka)
● Info Line (Linia informacyjna)
● Tooltip position values (Wartości pozycji podpowiedzi)

Dostępne są następujące opcje:

Bars+Beats  
           Ustawia wyświetlanie na linijce taktów, uderzeń, szesnastek i tyknięć. Domyślnie na   
           szesnastkę przypada 120 tyknięć. Aby to zmienić, dostosuj ustawienie MIDI Display   
           Resolution (Rozdzielczość wyświetlacza MIDI) w oknie dialogowym Preferences  
          (Preferencje) (strona MIDI).
Seconds (Sekundy)
          Ustawia wyświetlanie na linijce godzin, minut, sekund i milisekund.
Timecode (Kod czasowy)

Ustawia wyświetlanie na linijce godzin, minut, sekund i ramek. Liczba klatek na sekundę 
(fps) jest ustawiana w oknie dialogowym Project Setup (Ustawienia projektu) z 
wyskakującym menu Project Frame Rate (Szybkość klatek projektu). Aby wyświetlić 
ramki podrzędne, aktywuj opcję Show Timecode Subframes (Pokaż ramki podrzędne kodu
czasowego) w oknie dialogowym Preferences (Preferencje) (strona Transport).

Samples (Próbki)
Ustawia linijkę do wyświetlania próbek.

fps (User) (fps (Użytkownik))
Ustawia wyświetlanie na linijce godzin, minut, sekund i klatek z określoną przez 
użytkownika liczbą klatek na sekundę. Aby wyświetlić ramki podrzędne, aktywuj opcję 
Show Timecode Subframes (Pokaż ramki podrzędne kodu czasowego) w oknie 
dialogowym Preferences (Preferencje) (strona Transport). Możesz także ustawić liczbę 
klatek na sekundę.

Time Linear (Czas liniowy)
Ustawia linijkę liniowo względem czasu

Bars+Beats Linear
Ustawia linijkę liniową na takty i uderzenia.
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Status Line (Linia Stanu)
           Linia stanu pokazuje najważniejsze ustawienia projektu.

  ● Aby aktywować linię stanu, kliknij Set up Window Layout (Ustaw układ okna) na 
pasku narzędzi i aktywuj linię stanu (Status Line).

W wierszu stanu wyświetlane są następujące informacje:

Audio Inputs/Audio Outputs (Wejścia audio/wyjścia audio)
Te pola są wyświetlane, jeśli porty urządzeń audio nie są podłączone. Kliknij, aby otworzyć 
okno dialogowe Audio Connections (Połączenia audio) i połączyć porty.

Max. Record Time (Maks. Rekordowy czas)
Wyświetla pozostały czas nagrywania, w zależności od ustawień projektu i dostępnego 
miejsca na dysku twardym. Kliknij to pole, aby wyświetlić pozostały czas nagrywania w 
osobnym oknie

Record Format (Format zapisu)
Wyświetla częstotliwość próbkowania i głębię bitową używaną do nagrywania. Kliknij w 
tym polu, aby otworzyć okno dialogowe Project Setup (Ustawienia projektu).

Project Frame Rate (Szybkość klatek projektu)
Wyświetla liczbę klatek na sekundę używaną w projekcie. Kliknij w tym polu, aby otworzyć
okno dialogowe Project Setup (Ustawienia projektu).

Project Pan Law
Wyświetla bieżące ustawienie panoramy. Kliknij w tym polu, aby otworzyć okno dialogowe
Project Setup (Ustawienia projektu).

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46.

Info Line (Linia informacyjna)
Linia informacyjna zawiera informacje o zdarzeniu lub elemencie wybranym w strefie projektu.

Aby aktywować linię informacyjną, kliknij Set up Window Layout (Ustaw układ okien) na pasku 
narzędzi i aktywuj Info Line (linię informacyjną).

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46.

Reguły edycji wartości w linii informacyjnej
Możesz edytować prawie wszystkie dane zdarzeń lub części w wierszu informacyjnym, używając 
zwykłej edycji wartości.
W przypadku wybrania kilku wydarzeń lub części linia informacyjna jest wyświetlana w innym 
kolorze i wyświetlana jest tylko informacja o pierwszym elemencie zaznaczenia. Obowiązują 
następujące zasady:
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    ● Zmiany wartości są stosowane do wszystkich zaznaczonych elementów względem bieżących 
wartości. Na przykład wybrałeś dwa zdarzenia audio. Pierwsze zdarzenie ma długość 1 taktu, 
drugie 2 takty. Jeśli zmienisz wartość linii informacyjnej na 3, rozmiar pierwszego zdarzenia zmieni
się na 3 takty, a drugiego na 4 takty.
    ● Zmiany wartości są stosowane bezwzględnie do bieżących wartości, jeśli naciśniesz Ctrl/Cmd
podczas modyfikowania wartości w linii informacyjnej. W powyższym przykładzie oba zdarzenia 
mają rozmiar 3 taktów.
UWAGA
Aby zmienić modyfikator, wybierz nowy modyfikator w kategorii Info Line (Linia informacyjna) 
okna dialogowego Preferences (Preferencje) (strona Editing – Tool Modifiers (Edycja — 
Modyfikatory narzędzi).

Przegląd linii (Overview Line)
Przegląd linii umożliwia powiększanie i przechodzenie do innych sekcji w projekcie.

Aby aktywować linię przeglądu, kliknij Set up Window Layout (Ustaw układ okna) na pasku 
narzędzi i aktywuj Overview (Przegląd).
W wierszu przeglądu zdarzenia i części są wyświetlane jako ramki. Prostokąt wskazuje sekcję 
projektu, która jest wyświetlana na ekranie zdarzeń.
     ● Aby powiększyć lub pomniejszyć widok zdarzenia w poziomie, zmień rozmiar prostokąta, 
przeciągając krawędzie.
     ● Aby przejść do innej sekcji ekranu zdarzenia, przeciągnij prostokąt w lewo lub w prawo albo 
kliknij w górnej części przeglądu.
POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46.
Transport Bar (Pasek transportu)
Pasek transportu umożliwia wyświetlenie funkcji transportowych w zintegrowanej i stałej strefie 
okna Projektu (Project).
● Aby aktywować pasek transportu, kliknij Set up Window Layout (Ustaw układ okna) na pasku 
narzędzi okna projektu i aktywuj pasek transportu (Transport Bar).
● Aby pokazać/ukryć narzędzia, otwórz menu kontekstowe paska transportu, klikając prawym 
przyciskiem myszy pusty obszar paska transportu i aktywuj narzędzia, które chcesz wyświetlić. 
Aby wyświetlić wszystkie narzędzia, wybierz opcję Show All (Pokaż wszystko).

POWIĄZANE LINKI
Menu wspólnych trybów nagrywania (Common Record Modes Menu) na stronie 267.
Tryby nagrywania dźwięku (Audio Record Modes) na stronie 272.
Tryby nagrywania MIDI (MIDI Record Modes) na stronie 279.
Dzielnik lewego/prawego paska narzędzi (Left/Right Toolbar Divider) na stronie 53.
Pasek narzędzi okna projektu (Project Window Toolbar) na stronie 46.

Left Zone (Lewa Strefa)

Lewa strefa okna Projektu (Project) umożliwia wyświetlenie Inspektora (Inspector) oraz zakładki 
Widoczność (Visibility).
Aby pokazać/ukryć lewą strefę, kliknij Pokaż/ukryj lewą strefę (Show/Hide Left Zone) na pasku 
narzędzi okna projektu.
W górnej części lewej strefy znajdują się następujące zakładki:
    ● Inspector  (Inspektor)
    ● Visibility  (Widoczność)
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POWIĄZANE LINKI
Inspector (Inspektor) na stronie 61
Visibility (Widoczność) na stronie 64

Pasek narzędzi okna projektu na stronie 46

Inspector (Inspektor)
Inspektor umożliwia wyświetlanie elementów sterujących i parametrów wybranej ścieżki na liście 
ścieżek lub wydarzenia lub części pokazywanej w edytorze w dolnej strefie.

● Aby pokazać/ukryć Inspector (Inspektora), kliknij Show/Hide Left Zone (Pokaż/Ukryj 
lewą strefę) w pasku narzędzi okna Project (projekt).
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Dostępne są następujące zakładki:

Track (Ścieżka)
Otwiera Inspektora ścieżek (Track Inspector) dla wybranej ścieżki.

Editor (Edytor)
Otwiera inspektora edytora (Editor Inspector) dla zdarzenia lub części pokazanej w 
edytorze w dolnej strefie.

POWIĄZANE LINKI
Otwieranie Track Inspector (Inspektora ścieżek)  na stronie 61
Otwieranie Inspektora edytora (Editor Inspector) na stronie 62
Otwieranie Edytora w Strefie Dolnej na stronie 71

Otwieranie inspektora ścieżek (Track Inspector)
Inspektor ścieżek pokazuje elementy sterujące i parametry wybranej ścieżki na liście 
ścieżek.

PROCEDURA
1. Kliknij Pokaż/ukryj lewą strefę (Show.Hide Left Zone) na pasku narzędzi okna Project, aby 
aktywować lewą strefę (Left Zone).
2. W dolnej części lewej strefy kliknij kartę Track (Ścieżka).
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WYNIK
Otworzy się Track Inspector (Inspektor ścieżek) dla wybranej ścieżki. Jeśli na liście ścieżek 
wybrano więcej niż jedną ścieżkę, pokazane zostaną elementy sterujące i parametry dla wybranej 
ścieżki znajdującej się najwyżej.

UWAGA
W tej dokumentacji używamy Inspector, aby odnieść się do zakładki Track w Inspektorze.

Otwieranie inspektora edytora (Editor Inspector)
Editor Inspector (Inspektor edytora) pokazuje elementy sterujące i parametry zdarzenia lub części 
pokazywanej w edytorze w dolnej strefie.

WARUNEK WSTĘPNY
Edytor sampli (Sample Editor), edytor części audio (Audio Part Editor), edytor klawiszy (Key 
Editor), edytor perkusji (Drum Editor) lub edytor partytury (Score Editor) jest pokazany w 
dolnej strefie.

PROCEDURA
1. Kliknij Pokaż/ukryj lewą strefę (Show/Hide Left Zone) na pasku narzędzi okna projektu 
(Project), aby aktywować lewą strefę (Left Zone).
2. W dolnej części lewej strefy kliknij kartę Edytor (Editor).
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WYNIK
Otworzy się Inspektor edytora (Editor Inspector) dla zdarzenia lub części.

UWAGA
Inspektor edytora zawiera informacje tylko wtedy, gdy dolna strefa pokazuje edytora. 
W przeciwnym razie jest pusty.

POWIĄZANE LINKI
Otwieranie Edytora w Strefie Dolnej (Lower Zone) na stronie 71

Otwieranie zakładki Symbols (Symbole) w Score Editor (edytorze partytury)

Score Inspector Editor (Inspektor edytora partytury) umożliwia wybranie następujących zakładek:
Inspector (Inspektor) i Symbols (Symbole).

WARUNEK WSTĘPNY
Score Editor (Edytor partytury) jest pokazany w dolnej strefie.

PROCEDURA
1. W dolnej części lewej strefy kliknij kartę Editor (Edytor).
2. Wybierz opcję z wyskakującego menu Switch Score Editor Inspector Content (Przełącz 
inspektora zawartości edytora partytury).
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WYNIK
Zostanie wyświetlona karta Symbols (Symbole).

POWIĄZANE LINKI
Key Editor Inspector (Inspektor edytora klucza) na stronie 846.

Sekcje inspektorów
Zakładki Track (Ścieżka) i zakładka Editor (Edytor) w Inspector (Inspektorze) są podzielone na 
kilka sekcji, z których każda zawiera różne elementy sterujące dla ścieżki, zdarzenia lub części.

Nie wszystkie sekcje Inspektora są domyślnie wyświetlane. Dostępne sekcje zależą od typu 
wybranej ścieżki, zdarzenia lub części oraz od ustawień w oknie dialogowym ustawień dla zakładki
Track (Ścieżka) i Editor (Edytor) w Inspektorze.
       ● Aby otworzyć/zamknąć sekcje, kliknij ich nazwy.
          Otwarcie jednej sekcji powoduje zamknięcie pozostałych sekcji.
       ● Aby otworzyć sekcję bez zamykania innych sekcji, wciśnij Ctrl/Cmd i kliknij nazwę sekcji.

POWIĄZANE LINKI
Okno dialogowe ustawień inspektora ścieżek na stronie 112
Sekcje dla inspektorów na stronie 113
Inspektor ścieżek audio na stronie 124
Instrument Track Inspector na stronie 127
MIDI Track Inspector na stronie 134
Sampler Track Inspector na stronie 131
Arranger Track Inspector na stronie 152
Marker Track Inspector na stronie 146
Signature Track Inspector na stronie 156
Tempo Track Inspector na stronie 157
Transpose Track Inspector na stronie 158
VCA Fader Track Inspector na stronie 144
Video Track Inspector (Inspektor ścieżek video) na stronie 159
Key Editor Inspector (Inspektor edytora klucza) na stronie 846
Drum Editor Inspector (Inspektor edytora perkusji) na stronie 878
Sample Editor Inspector (Inspektor edytora próbek) na stronie 516

Visibility (Widoczność)

Zakładka Visibility (Widoczność) umożliwia pokazywanie lub ukrywanie poszczególnych ścieżek 
na liście ścieżek oraz określanie pozycji niektórych kanałów MixConsole w dolnej strefie.
           ● Aby otworzyć kartę Visibility, kliknij Visibility.
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Dostępne są następujące zakładki:

Track (Ścieżka)
Umożliwia wyświetlanie lub ukrywanie poszczególnych utworów na liście utworów.

Zones (Strefy)
Umożliwia określenie i zablokowanie pozycji niektórych kanałów MixConsole w dolnej strefie.

POWIĄZANE LINKI
Otwieranie MixConsole w dolnej strefie na stronie 70

Otwieranie Visibility (widoczności)

Zakładka Visibility (Widoczność) umożliwia pokazywanie lub ukrywanie poszczególnych utworów
(ścieżek) na liście utworów (ścieżek).

PROCEDURA
1. Kliknij Show/Hide Left Zone (Pokaż/ukryj lewą strefę) na pasku narzędzi okna Project 
(projekt), aby aktywować Left Zone (lewą strefę).
2. W górnej części lewej strefy kliknij kartę Visibility (Widoczność).
3. W dolnej części lewej strefy kliknij kartę Track (Ścieżka).

66



                                

POWIĄZANE LINKI
Pokazywanie/ukrywanie poszczególnych ścieżek na stronie 66.

Pokazywanie/ukrywanie poszczególnych utworów

Karta Visibility (Widoczność) zawiera listę wszystkich ścieżek Twojego projektu. Ta lista 
umożliwia pokazywanie i ukrywanie poszczególnych ścieżek.

                                 

      ● Aby wyświetlić/ukryć ścieżkę na liście utworów, zaznacz/odznacz ją, klikając po lewej  
            stronie nazwy utworu.
        ● Aby aktywować/dezaktywować kilka utworów jednocześnie, zaznacz je i naciśnij Return.
        ● Aby wyświetlić wyłącznie ukrytą ścieżkę, zaznacz ją, klikając z klawiszem Shift po lewej 
           stronie nazwy ścieżki.
        ● Aby rozwinąć lub zwinąć folder, kliknij trójkąt po lewej stronie ścieżki folderu.

UWAGA
● Kanały MixConsole w dolnej strefie są odpowiednio aktualizowane. Oznacza to, że jeśli ukryjesz
ścieżkę za pomocą zakładki Visibility (Widoczność), kanał odpowiadający tej ścieżce zostanie 
również ukryty w MixConsole w dolnej strefie.
● Jeśli chcesz zsynchronizować widoczność ścieżki i kanału w oddzielnym oknie MixConsole, 
musisz użyć funkcji Sync Visibility of Project and MixConsole (Synchronizuj widoczność 
projektu i MixConsole).
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POWIĄZANE LINKI
Synchronizacja widoczności ścieżki i kanału na stronie 67.

Synchronizacja widoczności ścieżki i kanału

Możesz zsynchronizować widoczność ścieżki w oknie Project z widocznością kanału w osobnym 
oknie MixConsole.

PROCEDURA
1. W górnej części lewej strefy wybierz kartę Visibility (Widoczność).
2. W dolnej części lewej strefy wybierz kartę Track (Ścieżka).
3. Kliknij znak równości, aby otworzyć menu Sync Visibility of Project and MixConsole  
    (Synchronizuj widoczność projektu i MixConsole): Włącz/Wyłącz.

         

4. Wybierz Sync Project and MixConsole, aby zsynchronizować widoczność ścieżki z  
     widocznością kanału.

WYNIK
Widoczność ścieżki i kanału jest zsynchronizowana.

UWAGA
● Możesz zsynchronizować widoczność ścieżki tylko w oknie Projektu z widocznością kanału 
jednej konsoli MixConsole. Jeśli włączysz Sync Visibility of Project and MixConsole 
(synchronizacja widoczności projektu i MixConsole): On/Off (wł./wył.) dla drugiej konsoli 
MixConsole, pierwsze łącze zostanie utracone.
● Jeśli podzielisz listę ścieżek, nie wpłynie to na górną część listy. Podobnie kanały w lewej lub 
prawej strefie MixConsole nie są zsynchronizowane.

POWIĄZANE LINKI
Synchronizacja widoczności kanału i ścieżki na stronie 353.

Otwieranie Stref (Zones)

Zakładka Zones (Strefy) umożliwia określenie i zablokowanie pozycji niektórych kanałów 
MixConsole w dolnej strefie.

PROCEDURA
1. W górnej części lewej strefy kliknij kartę Visibility (Widoczność).
2. W dolnej części lewej strefy kliknij kartę Zones (Strefy).
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WYNIK
MixConsole otwiera się w dolnej strefie.

POWIĄZANE LINKI
Otwieranie MixConsole w dolnej strefie na stronie 70.

Lower Zone (Dolna strefa)
Dolna strefa okna Projektu (Project) umożliwia wyświetlenie określonych okien i edytorów w 
zintegrowanej i stałej strefie okna Projektu. Jest to przydatne, jeśli pracujesz na przykład na 
systemach jednoekranowych i notebookach.
Aby pokazać/ukryć dolną strefę, kliknij Show/Hide Lower Zone (Pokaż/ukryj dolną strefę) na 
pasku narzędzi okna Project.
Dolna strefa zawiera następujące zakładki: Chord Pads, MixConsole, Sampler Control i Editor.
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Aby zamknąć dolną strefę, kliknij Close Lower Zone  (Zamknij dolną strefę) po lewej stronie 
zakładek.

POWIĄZANE LINKI
Otwieranie padów akordowych na stronie 69
Otwieranie MixConsole w dolnej strefie na stronie 70
Otwieranie Sampler Control na stronie 71
Otwieranie Edytora w Strefie Dolnej na stronie 71
Pasek narzędzi okna projektu na stronie 46

Ustawianie Dolnej Strefy (Lower Zone)
W dolnej strefie wyświetlane są zakładki MixConsole, Editor, Sampler Control i Chord Pads. 
Możesz zmienić ich kolejność i ukryć niepotrzebne zakładki.

PROCEDURA
1. Kliknij Set up Lower Zone (Ustaw dolną strefę) w prawym dolnym rogu dolnej strefy.

2. Wykonaj jedną z następujących czynności:
       ● Włącz/wyłącz opcje w wyskakującym menu, aby pokazać/ukryć zakładki w dolnej strefie.
       ● Wybierz Setup (Ustawienia), aby otworzyć okno dialogowe, w którym możesz     
           aktywować/dezaktywować zakładki i zmieniać ich położenie.

UWAGA
W sekcji Presets (wstępne ustawienia) tego okna dialogowego możesz również zapisać preset 
swojej konfiguracji.

WYNIK
Zakładki w dolnej strefie są wyświetlane zgodnie z Twoją konfiguracją.

POWIĄZANE LINKI
Okno dialogowe Setup (konfiguracja) na stronie 1146.

Otwieranie padów akordowych (Chord Pads)

Chord Pads pozwalają grać akordami oraz zmieniać ich brzmienie i napięcie.

PROCEDURA
1. Kliknij Show/Hide Lower Zone (Pokaż/ukryj dolną strefę) na pasku narzędzi okna Project 
(Projekt), aby aktywować dolną strefę.
2. W dolnej części dolnej strefy kliknij zakładkę Chord Pads.
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WYNIK
Chord Pads (Pady akordów) są otwarte.

POWIĄZANE LINKI
Pady akordów na stronie 964
Konfigurowanie dolnej strefy na stronie 69
Pasek narzędzi okna Project (projekt) na stronie 46

Otwieranie MixConsole w Dolnej Strefie (Lower Zone)

MixConsole w dolnej strefie umożliwia wykonywanie wszystkich podstawowych procedur 
miksowania z poziomu dolnej strefy okna Project, a jednocześnie umożliwia przeglądanie 
kontekstu ścieżek i zdarzeń.

PROCEDURA
1. Kliknij Show/Hide Lower Zone (Pokaż/ukryj dolną strefę) na pasku narzędzi okna projektu, aby
aktywować dolną strefę (Lower Zone).
2. W dolnej części dolnej strefy kliknij kartę MixConsole.

WYNIK
MixConsole otwiera się w dolnej strefie.
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POWIĄZANE LINKI
MixConsole w dolnej strefie na stronie 347
Pasek narzędzi okna Project na stronie 46

Otwieranie Sampler Control (kontrolki samplera)
Sterowanie samplerem umożliwia wyświetlanie i edytowanie kształtu fali próbki audio na ścieżce 
samplera.

PROCEDURA
1. Kliknij Show/Hide Lower Zone (Pokaż/ukryj dolną strefę) na pasku narzędzi okna projektu, aby
aktywować dolną strefę.
2. W dolnej części dolnej strefy kliknij zakładkę Sampler Control.

WYNIK
Sampler Control jest otwarty.

POWIĄZANE LINKI
Ścieżki samplera na stronie 588
Pasek narzędzi okna Project na stronie 46

Otwieranie Edytora (Editor) w Strefie Dolnej (Lower Zone)
Edytor w dolnej strefie umożliwia przeprowadzanie procedur edycji zdarzeń z dolnej strefy okna 
Projektu i jednoczesne przeglądanie kontekstu ścieżek i zdarzeń.

UWAGA
Domyślnie dwukrotne kliknięcie zdarzenia/partii audio lub partii MIDI na ekranie zdarzenia lub 
zaznaczenie jej i naciśnięcie klawisza Return otwiera odpowiedni edytor w dolnej strefie okna 
Project. Użycie polecenia menu powoduje otwarcie osobnego okna edytora. Możesz to zmienić w 
oknie dialogowym Preferences (Preferencje) (strona Edytors).

PROCEDURA
1. Kliknij Show/Hide Lower Zone (Pokaż/ukryj dolną strefę) na pasku narzędzi okna Project, aby 
aktywować dolną strefę.
2. W dolnej części dolnej strefy kliknij kartę Editor.
3. Na wyświetlaczu zdarzeń wykonaj jedną z następujących czynności:
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● Select a MIDI part (Wybierz część MIDI). 
● Select an audio event (Wybierz zdarzenie Audio).
● Select an audio part (Wybierz część Audio).

WYNIK
W zależności od wybranego zdarzenia lub partii, dolna strefa pokazuje Audio Part Editor (Edytor 
części audio), Sample Editor (Edytor sampli) lub jeden z edytorów MIDI.

UWAGA
Aby zmienić domyślny edytor MIDI, wybierz MIDI > Set up Editor Preferences (Ustaw 
preferencje edytora) i wybierz opcję z wyskakującego menu Default MIDI Editor (Domyślny 
edytor MIDI).

UWAGA
Jeśli otworzysz edytor i nie zostanie wybrane żadne zdarzenie ani część, edytor w dolnej strefie jest 
pusty.

POWIĄZANE LINKI
Wybieranie innego edytora MIDI na stronie 72
Pasek narzędzi okna projektu na stronie 46

Wybór innego edytora MIDI

Partię MIDI, która jest otwarta w edytorze, można wyświetlić w dolnej strefie innego edytora 
MIDI. Możesz to zrobić bez zmiany domyślnego edytora MIDI.

PROCEDURA
1. W zakładce Editor w edytorze w dolnej strefie kliknij Select MIDI Editor (Wybierz Edytor 
MIDI).
2. Wybierz edytor z wyskakującego menu.
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WYNIK
Partia MIDI zostanie wyświetlona w wybranym edytorze.

UWAGA
Ten wybór jest tymczasowy. Następnym razem, gdy otworzysz partię MIDI, zostanie użyty 
domyślny edytor MIDI.

Połącz kursory edytora projektu i dolnej strefy (Link Project and Lower Zone Editor 
Cursors)

Możesz połączyć kursory i współczynniki powiększenia strefy projektu oraz Edytora klawiszy (Key
Editor), Edytora perkusji (Drum Editor) i Edytora części audio (Audio Part Editor) w dolnej 
strefie.

UWAGA
Link Project and Lower Zone Editor Cursors nie są dostępne w Sample Editor.

UWAGA
Ta funkcja nie ma wpływu na ustawienie formatu wyświetlania linijki. Nadal możesz wybierać 
różne formaty wyświetlania linijek dla strefy projektu i edytora w dolnej strefie.
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Jeśli aktywujesz opcję Link Project and Lower Zone Editor Cursors  (Połącz kursory 
edytora projektu i dolnej strefy) , kursory i współczynniki powiększenia zostaną połączone w 
ekranach zdarzeń strefy projektu i strefy dolnej. Jest to przydatne, jeśli edytujesz w obu strefach i 
chcesz zachować tę samą pozycję w widoku.

UWAGA
W oknie dialogowym Key Commands (Komendy klawiszowe) w kategorii Edit (Edytuj) możesz 
przypisać do tego komendę klawiszową

POWIĄZANE LINKI
Linijka na stronie 57
Menu formatu wyświetlania linijki na stronie 57
Powiększanie w oknie Project na stronie 82

Right Zone (Prawa Strefa)

Prawa strefa okna Project umożliwia wyświetlenie „stojaka” VSTi, „stojaka” na Media, „stojaka” 
w pomieszczeniu kontrolnym Control Room i „stojaka” na mierniki. Meter.

Aby pokazać/ukryć prawą strefę, kliknij Show/Hide Right Zone (Pokaż/ukryj prawą strefę) na 
pasku narzędzi okna Project.

W górnej części prawej strefy znajdują się następujące zakładki: VSTi, Media, CR i Meter.
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UWAGA
Możesz pokazać/ukryć określone karty w prawej strefie, klikając kartę prawym przyciskiem myszy 
i aktywując/dezaktywując opcje w menu kontekstowym.

POWIĄZANE LINKI
„Stojak” VSTi w prawej strefie na stronie 76
„Stojak” na media w prawej strefie na stronie 78
Pasek narzędzi okna Project na stronie 46

Otwieranie „stojaka” VSTi w prawej strefie

Możesz pokazać „stojak” VSTi w prawej strefie okna Project. Dzięki temu możesz dodawać i 
edytować instrumenty VST, a jednocześnie widzieć kontekst swoich utworów i zdarzeń.

PROCEDURA
1. Kliknij Show/Hide Right Zone (Pokaż/ukryj prawą strefę) na pasku narzędzi okna Project, aby 
aktywować Right Zone (prawą strefę).
2. W górnej części prawej strefy kliknij kartę VSTi.
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WYNIK
„Stojak” VSTi jest otwierany w prawej strefie okna Project.

POWIĄZANE LINKI
„Stojak” VSTi w prawej strefie na stronie 76
Instrumenty VST na stronie 726
Pasek narzędzi okna projektu na stronie 46

„Stojak” VSTi w prawej strefie
„Stojak” VSTi w prawej strefie okna Project umożliwia dodawanie i edycję instrumentów VST 
w kontekście okna Project.

Dostępne są następujące sekcje:

                                     

           ● Track (Ścieżka)
Pokazuje powiązany instrument VST dla ścieżki instrumentu.
           ● Rack („Stojak”)
Pokazuje instrument VST.

Dostępne są następujące kontrolki:

 Add Track Instrument (Dodaj ścieżkę instrumentu)

         Otwiera okno dialogowe Add Track (Dodaj ścieżkę), w którym można wybrać 
instrument i dodać ścieżkę instrumentu powiązaną z tym instrumentem.

 Find Instruments (Znajdź instrumenty)

        Otwiera selektor, który pozwala znaleźć załadowany instrument.
 Set Remote-Control Focus for VST Quick Controls to Previous Instrument (Ustaw 

fokus zdalnego sterowania dla szybkich sterowań VST na poprzedni instrument)

        Umożliwia ustawienie fokusa zdalnego sterowania na poprzedni instrument.
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 Set Remote-Control Focus for VST Quick Controls to Next Instrument (Ustaw fokus 
zdalnego sterowania dla szybkich sterowań VST na następny instrument)

        Umożliwia ustawienie fokusa zdalnego sterowania na następny instrument.
 Show/Hide all VST Quick Controls (Pokaż/ukryj wszystkie szybkie sterowanie VST)

        Pokazuje/ukrywa domyślne szybkie elementy sterujące dla wszystkich załadowanych 
instrumentów.

 Settings (Ustwienia)

        

Otwiera wyskakujące menu Settings (Ustawienia), w którym można aktywować/dezaktywować 
następujące tryby:

● Show VST Quick Controls for One Slot Only (Pokaż szybkie nastawy VST tylko dla jednego 
gniazda) pokazuje VST Quick Controls (szybkie nastawy VST) wyłącznie dla wybranego 
instrumentu.
● MIDI Channel follows track selection (Kanał MIDI podąża za wyborem ścieżki) zapewnia, że 
selektor kanałów podąża za ścieżką MIDI wybraną w oknie Project. Użyj tego trybu, jeśli 
pracujesz z instrumentami wielobrzmieniowymi.
● Remote Control Focus for VST Quick Controls follows track selection (Zdalne ustawianie 
fokusa dla VST Quick Controls podąża za wyborem ścieżki) zapewnia, że VST Quick Controls 
(zdalne ustawianie fokusa VST Quick Controls) podąża za wyborem ścieżki.

POWIĄZANE LINKI
Okno instrumentów VST na stronie 730

Otwieranie „stojaka” na media (Media rack) w prawej strefie
Możesz pokazać „stojak” na media w prawej strefie okna Project. Pozwala to zobaczyć kontekst 
ścieżek i zdarzeń podczas przeciągania zdarzeń audio, partii MIDI, ustawień wstępnych lub 
instrumentów do okna Project.

PROCEDURA
1. Kliknij Show/Hide Right Zone (Pokaż/ukryj prawą strefę) na pasku narzędzi okna Project, aby 
aktywować prawą strefę (Right Zone).
2. W górnej części prawej strefy kliknij kartę Media.
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WYNIK
„Stojak” na media (Media rack) jest otwarty w prawej strefie okna projektu.

POWIĄZANE LINKI
Stojak na media w prawej strefie na stronie 78
MediaBay i Media Rack na stronie 629
Pasek narzędzi okna projektu na stronie 46

„Stojak” na media (Media rack) w prawej strefie (Right Zone)
Stojak na multimedia w prawej strefie okna Project umożliwia przeciąganie zdarzeń audio, partii 
MIDI lub ustawień instrumentów do wyświetlacza zdarzeń. Zawiera listę zawartości fabrycznej 
Steinberg i wszelkich zainstalowanych zestawów zawartości Steinberg.
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Karta Strona główna (Home) stojaka na nośniki zawiera następujące kafelki:

VST Instruments (Instrumenty VST)
                Pokazuje wszystkie dołączone instrumenty VST.
VST Effects (Efekty VST)
                Pokazuje wszystkie dołączone efekty VST.
Loops & Samples (Pętle i próbki)
                Wyświetla pętle audio, pętle MIDI lub dźwięki instrumentów uporządkowane według  
                 zestawu treści.
Presets (Presety,  ustawienia wstępne)
                Pokazuje presety ścieżek, presety strip, banki patternów, presety łańcucha efektów i 
                 presety VST FX.
User presets (Ustawienia użytkownika)
               Pokazuje presety ścieżek, presety strip, banki patternów, presety łańcucha efektów, 
               presety VST FX i presety instrumentów, które są wymienione w folderze użytkownika
Favorites (Ulubione)
               Pokazuje ulubione foldery i umożliwia dodawanie nowych ulubionych. Zawartość folderu 
               jest automatycznie dodawana do bazy danych MediaBay.
File Browser (Przeglądarka plików)
               Pokazuje system plików i predefiniowane foldery Favorites (Ulubione), This Computer 
               (Ten komputer), VST Sound (Dźwięk VST), Factory Content (Zawartość fabryczna) i 
               User Content (Zawartość użytkownika), w których można wyszukiwać pliki 
               multimedialne i uzyskać do nich natychmiastowy dostęp.

POWIĄZANE LINKI
„Stojak” na media w prawej strefie na stronie 629
MediaBay i Media Rack na stronie 629
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Otwieranie pomieszczenia kontrolnego (Control Room) w prawej 
strefie (Right Zone)
Możesz pokazać Control Room w prawej strefie okna Project.

PROCEDURA
1. Kliknij Show/Hide Right Zone (Pokaż/ukryj prawą strefę) na pasku narzędzi okna Project, aby 
aktywować Right Zone (prawą strefę).
2. W górnej części prawej strefy kliknij kartę CR.

                               

WYNIK
Control Room (Pomieszczenie kontrolne) jest otwierane w prawej strefie okna Project. Ma 
dokładnie te same funkcje, co Control Room, które otwiera się z menu Studio jako osobne okno.

POWIĄZANE LINKI
Pomieszczenie kontrolne na stronie 425
Pasek narzędzi okna projektu na stronie 46

Otwieranie miernika (Meter) w prawej strefie (Right Zone)
Możesz pokazać Miernik w prawej strefie okna Project.

PROCEDURA
1. Kliknij Show/Hide Right Zone (Pokaż/ukryj prawą strefę) na pasku narzędzi okna Project, aby 
aktywować prawą strefę.
2. W górnej części prawej strefy kliknij kartę Meter (Miernik).
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WYNIK
Meter (Miernik) jest otwierany w prawej strefie okna Project. Ma dokładnie te same funkcje, co 
Miernik, który otwierasz w prawej strefie MixConsole.

POWIĄZANE LINKI
Pomiar i głośność na stronie 437
Pasek narzędzi okna Project na stronie 46

Fokus klawiatury w oknie Project
Różne strefy w oknie projektu można kontrolować za pomocą poleceń klawiszowych. Aby upewnić
się, że polecenie klawisza ma wpływ na określoną strefę, należy upewnić się, że ta strefa ma fokus 
klawiatury.

Następujące strefy okna projektu mogą mieć fokus klawiatury:
● Project Zone (Strefa projektu)

UWAGA
Jeśli aktywujesz opcję Divide Track List (Podziel listę ścieżek), obszar strefy projektu, na którym 
znajduje się fokus, jest oznaczony podświetloną i ciągłą ramką punktu skupienia, podczas gdy 
obszar nieaktywny jest pokazywany ramką przerywaną.
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●   Left Zone (Lewa strefa)
●   Lower Zone (Dolna strefa)
●   Right Zone (Prawa strefa)

Jeśli strefa ma fokus klawiatury, otaczająca ją ramka jest podświetlona określonym kolorem.

UWAGA
Kolor fokusu można zmienić w oknie dialogowym Preferences (Preferencje) (User Interface—
Color Schemes page) Interfejs użytkownika — strona Schematy kolorów).

POWIĄZANE LINKI
Strefa projektu na stronie 45
Lewa strefa na stronie 60
Strefa dolna na stronie 68
Prawa strefa na stronie 74
Okno projektu na stronie 44
Dzielenie listy utworów na stronie 54
Fokus klawiatury w edytorze klawiszy (Key Editor) na stronie 856

Aktywacja fokusu klawiatury dla strefy
Możesz aktywować fokus klawiatury dla strefy, klikając myszką i używając poleceń klawiszowych.

PROCEDURA
● Wykonaj jedną z następujących czynności:
           ● Aby aktywować dowolną strefę, kliknij w nią.
           ● Aby aktywować następną strefę, naciśnij Tab . Pozwala to na przechodzenie do przodu   
               przez strefy.
           ● Aby aktywować poprzednią strefę, naciśnij Shift - Tab .

UWAGA
Edytor w dolnej strefie automatycznie otrzymuje fokus klawiatury, jeśli klikniesz dwukrotnie 
zdarzenie lub część na wyświetlaczu zdarzenia, jeśli wybierzesz zdarzenie lub część i naciśniesz 
Return lub jeśli użyjesz skrótów klawiaturowych do otwarcia strefy.

WYNIK
Fokus klawiatury jest aktywowany dla tej strefy, a granica strefy jest podświetlona.

UWAGA
Strefa projektu i strefa dolna mają osobne paski narzędzi i linie informacyjne. Jeśli użyjesz paska 
narzędzi lub linii informacyjnej dla jednej z tych stref, odpowiednia strefa automatycznie uzyska 
fokus.

POWIĄZANE LINKI
Fokus klawiatury w oknie Project na stronie 80
Fokus klawiatury w Key Editor (edytorze klawiszy) na stronie 856
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Powiększanie w oknie projektu (Project)
Okno Projektu można powiększać zgodnie ze standardowymi technikami powiększania.

UWAGA
Jeśli przerysowywanie ekranu w twoim systemie jest powolne, rozważ włączenie funkcji Szybki 
zoom (Quick Zoom) w oknie dialogowym Preferencje (Preferences) (strona Editing (Edycja)).

Powiększanie w poziomie
● Wybierz narzędzie Zoom (Powiększenie) i kliknij wyświetlacz zdarzenia, aby powiększyć. Aby 
pomniejszyć, przytrzymaj klawisz Alt/Opt i kliknij.
● Użyj poziomych suwaków powiększenia, aby powiększyć i pomniejszyć.
● Kliknij dolną połowę linijki i przeciągnij w dół, aby powiększyć w poziomie. Kliknij dolną 
połowę linijki i przeciągnij w górę, aby pomniejszyć widok w poziomie.
● Kliknij H, aby powiększyć poziomo. Kliknij G, aby pomniejszyć widok w poziomie.

UWAGA
Jeśli Grid Type (typ siatki) na pasku narzędzi okna Project jest ustawiony na Adapt to Zoom 
(Dostosuj do powiększenia), poziom powiększenia wpływa na rozdzielczość siatki i przyciągania w
widoku zdarzeń.

Powiększanie w pionie
● Wybierz narzędzie Zoom (Lupka), kliknij wyświetlacz zdarzenia i przeciągnij prostokąt 
zaznaczenia, aby powiększyć w pionie i w poziomie.

UWAGA
Aby to zadziałało, musisz dezaktywować opcję Zoom Tool Standard Mode: Horizontal Zooming
Only (Standardowy tryb narzędzia Zoom: Tylko powiększanie w poziomie) w oknie dialogowym 
Preferences (Preferencje) (strona Editing – Tools (Edycja — Narzędzia)).

● Użyj pionowych suwaków powiększenia, aby powiększyć i pomniejszyć. Jeśli dokonałeś 
jakichkolwiek indywidualnych regulacji wysokości ścieżki, względne różnice wysokości zostaną 
zachowane.
● Kliknij Shift - H, aby powiększyć w pionie. Kliknij Shift - G, aby pomniejszyć widok w pionie

POWIĄZANE LINKI
Podmenu Zoom na stronie 83
Ustawienia powiększenia na stronie 83
Powiększanie znaczników cyklu na stronie 84
Historia zoomu na stronie 85
Połącz kursory projektu i edytora dolnej strefy na stronie 73
Menu typu siatki na stronie 87

Powiększanie zawartości audio
Możesz powiększać w pionie zawartość części audio i zdarzeń. Jest to przydatne podczas oglądania 
cichych fragmentów audio.

PROCEDURA
● Kliknij suwak powiększenia przebiegu w prawym górnym rogu ekranu zdarzenia i przeciągnij go 
w górę.
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WYNIK
Zawartość części audio i zdarzeń w twoim projekcie jest powiększona w pionie

PO WYKONANIU TEGO ZADANIA
Aby uzyskać przybliżony odczyt poziomu zdarzeń audio, przeglądając przebiegi, pomniejsz, 
przeciągając suwak do końca w dół. W przeciwnym razie powiększone przebiegi mogą zostać 
pomylone z obciętym dźwiękiem.

Podmenu Zoom (powiększenia)

Podmenu Zoom zawiera opcje powiększania w oknie Project.
● Aby otworzyć podmenu Zoom, wybierz kolejno Edit > Zoom (Edycja > Powiększenie).

Dostępne są następujące opcje:

Zoom In/Zoom Out (Przybliż/Oddal)
         Powiększa/oddala o jeden krok, wyśrodkowując kursor projektu.
Zoom Full (Zoom pełny)
         Pomniejsza, aby cały projekt był widoczny. Cały projekt oznacza oś czasu od rozpoczęcia  
         projektu do długości ustawionej w oknie dialogowym Project Setup (Ustawienia projektu).
Zoom to Selection (Powiększ do zaznaczenia)
         Powiększa w poziomie i w pionie, tak aby bieżący wybór wypełnił ekran.
Zoom to Selection (Horiz.) (Powiększ do zaznaczenia (w poziomie))
         Powiększa poziomo, tak aby bieżące zaznaczenie wypełniało ekran.
Zoom to Event (Powiększ do zdarzenia)
         Powiększa, aby pokazać aktualnie wybrane wydarzenie. Ta opcja jest dostępna w Sample 
         Editor (edytorze sampli) i w niektórych edytorach MIDI.
Zoom In Vertically/Zoom Out Vertically (Powiększ w pionie/Pomniejsz w pionie)
         Powiększa/oddala o jeden krok w pionie.
Zoom In Tracks/Zoom Out Tracks (Powiększ ścieżki/pomniejsz ścieżki)
         Powiększa/oddala wybrane ścieżki o jeden krok w pionie
Zoom Selected Tracks (Powiększ wybrane ścieżki)
         Powiększa pionowo wybrane ścieżki i minimalizuje wysokość wszystkich pozostałych 
          ścieżek.
Undo Zoom/Redo Zoom (Cofnij powiększenie/Powtórz powiększenie)
         Te opcje umożliwiają cofnięcie/ponowne wykonanie ostatniej operacji powiększenia.

POWIĄZANE LINKI
Podmenu Zoom na stronie 521

Ustawienia powiększenia
Można tworzyć ustawienia wstępne powiększenia, które umożliwiają skonfigurowanie różnych 
ustawień powiększenia. Na przykład jeden, w którym cały projekt jest wyświetlany w oknie 
Projekt, a drugi z dużym współczynnikiem powiększenia do szczegółowej edycji. Wyskakujące 
menu Zoom Presets (Zadane ustawienia) powiększenia umożliwia wybieranie, tworzenie i 
organizowanie ustawień powiększenia.
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● Aby otworzyć wyskakujące menu Zoom Presets (Zadane ustawienia powiększenia), kliknij 
przycisk po lewej stronie poziomego elementu sterującego powiększeniem.

                            
W górnej części menu znajduje się lista ustawień powiększenia.

                         

● Aby zapisać bieżące ustawienie powiększenia jako ustawienie wstępne, otwórz menu podręczne 
Zoom Presets (Zadane ustawienia powiększenia) i wybierz opcję Add (Dodaj). W otwartym oknie 
dialogowym Type in Preset Nane (Wpisz nazwę ustawienia wstępnego) wpisz nazwę ustawienia 
wstępnego i kliknij przycisk OK.
● Aby wybrać i zastosować ustawienie wstępne, wybierz je z wyskakującego menu Zoom Presets 
(Ustawienia wstępne powiększenia).
● Aby pomniejszyć widok tak, aby cały projekt był widoczny, otwórz menu podręczne Zoom 
Presets (Predefiniowane ustawienia powiększenia) i wybierz Zoom Full (Zoom pełny).
Spowoduje to wyświetlenie projektu od czasu rozpoczęcia projektu (Project Start Time) do 
długości projektu (Project Length) ustawionej w oknie dialogowym Project Setup (Ustawienia 
projektu).
● Aby usunąć ustawienie wstępne, otwórz menu podręczne Zoom Presets (Zadane ustawienia 
powiększenia) i wybierz opcję OrganIze (Organizuj). W otwartym oknie dialogowym wybierz 
ustawienie wstępne z listy i kliknij Delete (Usuń).
● Aby zmienić nazwę ustawienia wstępnego, otwórz menu podręczne Zoom Presets (Ustawienia 
wstępne powiększenia) i wybierz opcję Orgasnize (Organizuj). W otwartym oknie dialogowym 
wybierz ustawienie wstępne z listy i kliknij Rename (Zmień nazwę). W otwartym oknie 
dialogowym wpisz nową nazwę ustawienia wstępnego. Kliknij OK, aby zamknąć okna dialogowe.

WAŻNE
Predefiniowane ustawienia powiększenia (Zoom Presets) są globalne dla wszystkich projektów. Są 
one dostępne we wszystkich otwieranych lub tworzonych projektach.

Powiększanie znaczników cyklu (Cycle Markers)

WARUNEK WSTĘPNY
Utworzyłeś przynajmniej jeden znacznik cyklu dla projektu.

PROCEDURA
● Kliknij przycisk po lewej stronie kontrolki powiększenia w poziomie, aby otworzyć menu 
podręczne Zoom Presets (Zadane ustawienia powiększenia) i wybierz znacznik cyklu.
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W środkowej części wyskakującego menu znajdują się wszystkie znaczniki cykli dodane do 
projektu.

WYNIK
Widok zdarzenia jest powiększony, aby objąć obszar znacznika.

POWIĄZANE LINKI
Okienko znaczników (Markers) na stronie 339.

Historia zoomu
Operacje powiększania można cofać i ponawiać. W ten sposób możesz powiększyć w kilku 
krokach, a następnie łatwo wrócić do etapu powiększenia, od którego zacząłeś.

Operacje powiększenia można cofać i ponawiać w następujący sposób:
● Aby cofnąć powiększenie, wybierz polecenie Edit > ZooM > Undo Zoom (Edycja > 
Powiększenie > Cofnij powiększenie) lub kliknij dwukrotnie narzędziem powiększania.
● Aby ponownie wykonać powiększenie, wybierz polecenie Edit > Zoom > Redo Zoom (Edycja >
Powiększenie > Ponów powiększenie) lub naciśnij klawisz Alt/Opt i kliknij dwukrotnie narzędziem
powiększania.

Funkcja przyciągania (Snap)
Funkcja Snap pomaga znaleźć dokładne pozycje podczas edycji w oknie Project. Czyni to poprzez 
ograniczenie ruchu poziomego i pozycjonowania do określonych pozycji. Operacje, na które ma 
wpływ Snap, obejmują przenoszenie, kopiowanie, rysowanie, zmianę rozmiaru, dzielenie, wybór 
zakresu itp.

● Aby włączyć/wyłączyć Snap (Przyciąganie), włącz/wyłącz Snap  na pasku narzędzi.

Ustawianie punktu przyciągania (Snap Point)
Punkt przyciągania można ustawić w dowolnej pozycji zdarzenia dźwiękowego.

PROCEDURA
1. Wybierz zdarzenie.
2. Umieść kursor projektu w miejscu wybranego zdarzenia audio.
3. Wybierz Audio > Przyciągnij punkt do kursora (Audio > Snap Point to Cursor)

WYNIK
Punkt przyciągania jest ustawiany w pozycji kursora. Punkt przyciągania dla zdarzenia jest 
wyświetlany jako pionowa linia w oknie Project.

UWAGA
Punkt przyciągania można również ustawić w edytorze próbek (Sample Editor).
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POWIĄZANE LINKI
Regulacja punktu przyciągania na stronie 529

Snap to Zero Crossing (Przyciągnij do przejścia przez zero)
Podczas dzielenia i określania rozmiaru zdarzeń dźwiękowych nagłe zmiany amplitudy mogą 
powodować trzaski i kliknięcia. Aby tego uniknąć, możesz aktywować funkcję Snap to Zero 
Crossing (Przyciągaj do przejścia przez zero), aby przyciągać do punktów, w których amplituda 
wynosi zero.

● Aby aktywować Przyciągaj do przejścia przez zero, aktywuj Snap to Zero Crossing  
(Przyciągaj do przejścia przez zero) na pasku narzędzi.

Menu typów przyciągania
Możesz wybrać pomiędzy różnymi typami przyciągania, aby określić punkt przyciągania.
● Aby otworzyć wyskakujące menu Snap Type (Typ przyciągania), kliknij Snap Type (Typ 
przyciągania) na pasku narzędzi.

Dostępne są następujące typy przyciągania:

Grid (Siatka)
Jeśli ta opcja jest włączona, punkty przyciągania są ustawiane w wyskakującym menu Grid Type 
(Typ siatki). Opcje zależą od formatu wyświetlania wybranego dla linijki. Jeśli wybierzesz Seconds
(Sekundy jako format linijki, dostępne będą opcje siatki opartej na czasie. Jeśli jako format linijki 
wybierzesz Bars + Beats dostępne będą opcje siatki muzycznej.
Grid Relative (Siatka wzglédna)
Jeśli ta opcja jest włączona, zdarzenia i części nie są przyciągane magnetycznie do siatki. Siatka 
określa raczej rozmiar kroku do przenoszenia wydarzeń. Oznacza to, że przeniesione zdarzenie 
zachowuje swoją pierwotną pozycję względem siatki.
Na przykład, jeśli zdarzenie rozpoczyna się na pozycji 3.04.01, Snap (Skok) jest ustawiony na 
Relativ (Względny) względem siatki, a Grid Type (Typ siatki) na Bar (Słupkowy), możesz 
przenieść zdarzenie w krokach co jeden słupek do pozycji 4.04.01, 5.04.01, i tak dalej.
UWAGA
Dotyczy to tylko przeciągania istniejących zdarzeń lub części. Podczas tworzenia nowych zdarzeń 
lub części ten typ przyciągania działa jak siatka
Events (Zdarzenia)
Jeśli ta opcja jest aktywna, pozycje początkowe i końcowe innych zdarzeń i części stają się 
magnetyczne. Oznacza to, że jeśli przeciągniesz zdarzenie w miejsce blisko początku lub końca 
innego zdarzenia, zostanie ono automatycznie wyrównane z początkiem lub końcem drugiego 
zdarzenia.
W przypadku zdarzeń dźwiękowych pozycja punktu przyciągania jest również magnetyczna. 
Obejmuje to zdarzenia znaczników na ścieżce znaczników.
Shuffle (Tasować)
Tasowanie jest przydatne, gdy chcesz zmienić kolejność sąsiadujących zdarzeń. Jeśli masz dwa 
sąsiednie zdarzenia i przeciągniesz pierwsze w prawo, poza drugie zdarzenie, oba zdarzenia 
zamienią się miejscami.

Ta sama zasada działa przy zmianie kolejności więcej niż dwóch zdarzeń.
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Cursor (Kursor)
Ten typ siatki sprawia, że kursor projektu staje się magnetyczny. Przeciągnięcie zdarzenia w 
pobliże kursora powoduje wyrównanie zdarzenia z pozycją kursora.
Grid + Cursor (Siatka + Kursor)
Jest to połączenie siatki i kursora.
Events + Cursor (Zdarzenia + Kursor)
Jest to połączenie Zdarzeń i Kursora.
Events + Grid + Cursor (Zdarzenia + Siatka + Kursor)
Jest to połączenie Zdarzeń, Siatki i Kursora

Menu typu siatki (Grid Type)
Umożliwia określenie typu siatki, który określa rozdzielczość siatki i skoku na wyświetlaczu 
zdarzenia.
UWAGA
To ustawienie działa tylko wtedy, gdy Snap Type (Typ przyciągania) jest ustawiony na jedną z 
opcji siatki.

● Aby otworzyć wyskakujące menu Grid Type (Typ siatki), kliknij Grid Type  
    na pasku narzędzi.

Jeśli jako format linijki wybierzesz Bars+Beats (Takty+Uderzenia) dostępne będą następujące typy
siatek:

Bar (Takt)
     Ustawia rozdzielczość siatki i przyciągania na takty.
Beat (Uderzenie)
     Ustawia rozdzielczość siatki i skoku na uderzenia.
Use Quantize (Użyj kwantyzacji)
     Ustawia rozdzielczość siatki i skoku na wartość aktywowaną w wyskakującym menu Quantize 
      Presets (Zadane ustawienia kwantyzacji).
Adapt to Zoom (Dostosuj do powiększenia)
     Ustawia rozdzielczość siatki i przyciągania na poziom powiększenia. Im bardziej przybliżysz  
      ekran zdarzenia, tym dokładniejsza będzie rozdzielczość. Wysokie poziomy powiększenia   
     umożliwiają przyciąganie do nut 64-tych, niskie poziomy powiększenia umożliwiają  
     przyciąganie do taktów.
     UWAGA
     Opcja Adapt to Zoom (Dostosuj do powiększenia) jest dostępna tylko wtedy, gdy jako format   
     wyświetlania linijki wybrano opcję Bars+Beats (takty+uderzenia).

UWAGA
Komendy klawiszowe można przypisać do typów siatki w oknie dialogowym Key Commands  
(Komendy klawiszowe) w kategorii Edit (Edytuj).

Jeśli włączysz Time Linear w menu kontekstowym linijki (ruler), odległości między liniami siatki 
są nadal stałe, ale oparte na wartościach muzycznych, takich jak takty i uderzenia.

Jeśli wybierzesz Seconds (Sekundy) jako format linijki, dostępne będą następujące typy siatek:

1 ms
Ustawia rozdzielczość siatki i przyciągania na 1 ms.
10 ms
Ustawia rozdzielczość siatki i przyciągania na 10 ms.
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100ms
Ustawia rozdzielczość siatki i przyciągania na 100 ms.
1000 ms
Ustawia rozdzielczość siatki i przyciągania na 1000 ms.

POWIĄZANE LINKI
Menu typów przyciągania na stronie 86
Powiększanie w oknie projektu na stronie 82
Menu formatu wyświetlania linijki na stronie 57

Kursor krzyżykowy (Crosss-Hair)
Podczas pracy w oknie Projekt oraz w edytorach wyświetlany jest kursor krzyżykowy, ułatwiający 
nawigację i edycję, szczególnie przy układaniu dużych projektów.
● Możesz ustawić kursor krzyżykowy w oknie dialogowym Preferences (Preferencje) (Editing 
(Edycja) — strona Tools (Narzędzia)). Możesz ustawić kolory linii i maski kursora krzyżykowego 
oraz zdefiniować jego szerokość.

Kursor krzyżykowy działa w następujący sposób:

● Po wybraniu narzędzia Object Selection (Zaznaczanie obiektów) lub jednego z jego narzędzi 
podrzędnych kursor w postaci krzyżyka pojawia się po rozpoczęciu przenoszenia/kopiowania 
części/zdarzenia lub podczas używania uchwytów przycinania zdarzeń.

                    
Kursor krzyżykowy podczas przenoszenia zdarzenia

● Po wybraniu narzędzia Object Selection (Zaznaczanie obiektów), narzędzia Split (Podziel) lub 
dowolnego innego narzędzia korzystającego z tej funkcji kursor w postaci krzyżyka pojawia się 
natychmiast po przesunięciu wskaźnika myszy nad wyświetlanie zdarzeń.
● Kursor z krzyżykiem jest dostępny tylko dla narzędzi, w których taka funkcja ma jakiekolwiek 
zastosowanie. Na przykład narzędzie Mute (Wycisz) nie używa kursora w postaci krzyżyka, 
ponieważ aby wyciszyć zdarzenie, należy kliknąć je bezpośrednio.

UWAGA
Jeśli Key Editor, Drum Editor lub Audio Part Editor jest otwarty w dolnej strefie okna Project 
i aktywowane są Link Project i Lower Zone Cursors, w dolnej strefie edytora i w Project okno.

Okno historia edycji (Edit History)

Okno dialogowe Edit History (Historia Edycji) zawiera listę wszystkich Twoich zmian. Pozwala to
cofnąć wszystkie akcje w oknie Project, jak również w edytorach.
● Aby otworzyć okno dialogowe Edit History (Historia Edycji), wybierz polecenie Edit > History
(Edytuj > Historia)
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Action (Działanie)
       Pokazuje nazwę akcji.
Time (Czas)
       Pokazuje czas wykonania tej czynności.
State (Stan)
       Pokazuje stan akcji.
Details (Detale)
       Wyświetla dalsze szczegóły i umożliwia wprowadzenie nowego tekstu.
Separator
        Przesuń separator w górę, aby cofnąć swoje działania. Aby ponownie wykonać czynność,  
        przesuń separator w dół.

UWAGA
● Możesz także cofnąć zastosowane efekty wtyczek lub procesy audio. Zalecamy jednak 
modyfikowanie lub usuwanie ich za pomocą okna Direct Offline Processing (Bezpośrednie 
przetwarzanie w trybie offline).
● Całe przetwarzanie offline, które zastosowałeś na stałe do dźwięku za pomocą funkcji Make 
Direct Offline Processing Permanent (Utrwal bezpośrednie przetwarzanie offline), nie może 
zostać cofnięte. Dlatego nie jest pokazywane w oknie dialogowym Edit History (Edytuj Historię).

POWIĄZANE LINKI
Bezpośrednie przetwarzanie w trybie offline na stronie 475
Trwałe stosowanie przetwarzania offline na stronie 488

Ustawianie liczby maksymalnych kroków cofania

Możesz ograniczyć liczbę maksymalnych kroków cofania. Jest to przydatne, gdy na przykład 
zabraknie pamięci.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz opcję General (Ogólne).
2. Ustaw liczbę w polu Maximum Undo Steps (Maksymalna liczba kroków cofania).
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Obsługa kolorów
Możesz kolorować wydarzenia i ścieżki w Cubase. Pozwala to na łatwiejszy przegląd w oknie 
Project.

POWIĄZANE LINKI
Próbnik kolorów na stronie 96
Okno dialogowe konfiguracji kolorów projektu na stronie 93
Menu kolorów wydarzenia na stronie 805
Ustawianie kolorów zdarzeń w celu śledzenia kolorów na stronie 93
Kolorowanie wydarzeń w locie na stronie 92
Kolorowanie wybranych wydarzeń lub części na stronie 91
Resetowanie koloru ścieżki na stronie 91
Kolorowanie pojedynczych utworów na stronie 91
Kolorowanie wybranych utworów na stronie 90
Obsługa kolorów na stronie 90
Interfejs użytkownika — Kolory kanałów Track & MixConsole na stronie 1181
Automatyczne przypisywanie kolorów do nowych ścieżek/kanałów na stronie 174

Kolorowanie wybranych ścieżek
      Możesz pokolorować wybrane ścieżki.

PROCEDURA
1. W oknie Project usuń zaznaczenie wszystkich zdarzeń lub części.
2. Wybierz ścieżki, które chcesz pokolorować.
3. Na pasku narzędzi okna Project wybierz opcję Select Color for Selected Trcks or Events 
(Wybierz kolor dla wybranych ścieżek lub zdarzeń). Zostanie otwarte okienko Colorize (Koloruj).

UWAGA
Jeśli zamiast tego chcesz wybrać kolory według nazw, aktywuj opcję Select Color by Name 
(Wybierz kolory według nazwy) w oknie dialogowym Project Colors Setup (Ustawienia kolorów 
projektu) (strona Options (Opcje)).

4. Wybierz kolor.

WYNIK
Wybrane ścieżki zostaną pokolorowane, a zdarzenia i części otrzymają kolor ścieżki.

UWAGA
Jeśli przypiszesz inny kolor do poszczególnych zdarzeń lub części za pomocą narzędzia Color 
(Kolor), zdarzenia lub części nie będą już podążać za zmianami koloru ścieżki.

POWIĄZANE LINKI
Kolorowanie wydarzeń w locie na stronie 92
Zakładka Opcje na stronie 95
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Kolorowanie pojedynczych ścieżek
Możesz pokolorować pojedyncze ścieżki za pomocą Inspektora (Inspector) lub listy ścieżek. Jest to
przydatne, jeśli chcesz mieć pewność, że żadne inne ścieżki, zdarzenia lub części nie zostaną 
przypadkowo pokolorowane.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
● Wybierz ścieżkę, którą chcesz pokolorować, a następnie w Inspektorze kliknij Colorize 
Seledcted Track (Koloruj wybraną ścieżkę).

          
● Ctrl/Cmd – kliknij lewy obszar listy ścieżek.
         Zostanie otwarte okienko Colorize (Koloruj).
UWAGA
Jeśli zamiast tego chcesz wybrać kolory według nazw, aktywuj opcję Select Colors by Name 
(Wybierz kolory według nazw) w oknie dialogowym Project Colors Setup (Ustawienia kolorów 
projektu) (strona Options (Opcje)).
2. Wybierz kolor.

WYNIK
Ścieżka jest pokolorowana, a wszystkie zdarzenia lub części na tej ścieżce otrzymują ten sam kolor.

UWAGA
Jeśli poszczególnym zdarzeniom lub częściom przypiszesz inny kolor za pomocą narzędzia Color 
(Kolor), przestaną one podążać za zmianami koloru ścieżki.

POWIĄZANE LINKI
Kolorowanie wydarzeń w locie na stronie 92
Zakładka Opcje na stronie 95

Resetowanie koloru ścieżki
          Możesz zresetować kolor ścieżki do koloru domyślnego.

PROCEDURA
1. W oknie Project wybierz ścieżkę, której domyślny kolor chcesz przywrócić i usuń zaznaczenie 
wszystkich zdarzeń lub części.
2. Na pasku narzędzi okna Project wybierz opcję Select Color for Selected Tracks or Events 
(Wybierz kolor dla wybranych ścieżek lub zdarzeń).
3. W panelu Colorize (Koloruj) kliknij opcję Select Track Color to Default (Ustaw domyślny 
kolor ścieżki).

WYNIK
Domyślny kolor jest przypisany do wybranej ścieżki.

Kolorowanie wybranych zdarzeń lub części
Możesz pokolorować wybrane wydarzenia lub części za pomocą opcji Select Color for Selected 
Tracks or Events (Wybierz kolor dla wybranych ścieżek lub zdarzeń). Domyślnie zdarzenia lub 
części mają kolor odpowiadającej im ścieżki. Możesz jednak nadpisać to ustawienie i na przykład 
wybrać ten sam kolor dla zdarzeń lub części znajdujących się na różnych ścieżkach.
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PROCEDURA
1. W oknie Project zaznacz wszystkie zdarzenia lub części, które chcesz pokolorować.
2. Na pasku narzędzi okna Project wybierz opcję Select Color for Selected Tracks or Events 
(Wybierz kolor dla wybranych ścieżek lub zdarzeń).
Zostanie otwarte okienko Colorize (Koloruj).
UWAGA
Jeśli chcesz wybrać kolory według nazw, aktywuj opcję Select Colors by Name (Wybierz kolory 
według nazwy) w oknie dialogowym Project Colors Setup (Ustawienia kolorów projektu) (strona 
Options (Opcje)).
3. Wybierz kolor.

WYNIK
Wybrane zdarzenia są kolorowe i nie podążają już za zmianami kolorów ścieżki.

POWIĄZANE LINKI
Kolorowanie wydarzeń w locie na stronie 92
Zakładka Opcje na stronie 95
Menu kolorów wydarzenia na stronie 805

Kolorowanie zdarzeń w locie
Możesz pokolorować zdarzenia lub części za pomocą narzędzia Color (Kolor). Domyślnie 
zdarzenia lub części mają kolor odpowiadającej im ścieżki. Możesz jednak nadpisać to ustawienie i 
na przykład wybrać ten sam kolor dla zdarzeń lub części znajdujących się na różnych ścieżkach.

PROCEDURA
1. Na pasku narzędzi okna Project wybierz narzędzie Color (Kolor).
2. Wykonaj jedną z poniższych czynności, aby wybrać kolor narzędzia:
      ● Alt/Opt – kliknij zdarzenie lub część, aby skopiować jej kolor.
      ● Przesuń wskaźnik myszy nad narzędzie Color i użyj kółka myszy, aby przechodzić przez 
          kolory bieżącego zestawu kolorów.
3. Opcjonalnie: Zaznacz zdarzenia lub części, które chcesz pokolorować za pomocą narzędzia 
Object Selection (Zaznaczanie obiektów). Jest to konieczne tylko wtedy, gdy chcesz pokolorować 
wiele wydarzeń lub części.
4. Na pasku narzędzi okna Project wybierz narzędzie Color.
5. Kliknij zdarzenia lub części, które chcesz pokolorować.

WYNIK
Zdarzenia lub części są pokolorowane i nie podążają już za zmianami koloru ścieżki.

UWAGA
Możesz także nacisnąć klawisz Ctrl/Cmd i kliknąć zdarzenie lub część za pomocą narzędzia Color
(Kolor), aby otworzyć panel Colorize (Koloruj) lub wybrać kolory według nazw.

POWIĄZANE LINKI
Kolorowanie wybranych zdarzeń lub części na stronie 91
Zakładka Options (Opcje) na stronie 95
Menu Event Colors (Kolory zdarzeń) na stronie 805
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Ustawianie kolorów zdarzeń w celu śledzenia kolorów
Możesz ustawić kolor zdarzeń lub części na kolor ścieżki. Jest to przydatne, jeśli pokolorowałeś 
zdarzenia lub części za pomocą narzędzia Color (Kolor) i chcesz, aby ponownie podążały za 
kolorem ścieżki.

PROCEDURA
1. W oknie Project wybierz zdarzenie lub część, dla której chcesz ustawić kolor ścieżki.
2. Na pasku narzędzi okna Project kliknij opcję Select Color for Selected Tracks or Events 
(Wybierz kolor dla wybranych ścieżek lub zdarzeń).
3. W okienku Colorize (Koloruj) kliknij opcję Set Event Color to Track (Ustaw kolor zdarzenia 
na śledzenie).

WYNIK
Kolor ścieżki jest przypisany do wybranego zdarzenia lub części.

POWIĄZANE LINKI
Kolorowanie zdarzeń w locie na stronie 92
Menu Event Colors (Kolory zdarzeń) na stronie 805

Okno dialogowe Project Colors Setup (konfiguracja kolorów projektu)

Okno dialogowe Project Colors Setup (Konfiguracja kolorów projektu) umożliwia 
skonfigurowanie kolorów dla twojego projektu.
● Aby otworzyć okno dialogowe Project Colors Setup (Ustawienia kolorów projektu), wybierz 
Project (Projekt) > Project Colors Setup.

                   

POWIĄZANE LINKI
Próbnik kolorów na stronie 96
Zakładka Color Set (Zestaw kolorów) na stronie 94
Zakładka Presets (Ustawienia wstępne) na stronie 95
Zakładka Options (Opcje) na stronie 95
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Zakładka Color Set (Zestaw kolorów)
Zakładka Color Set (Zestaw kolorów) umożliwia zmianę zestawu kolorów używanego w projekcie.

Dostępne są następujące opcje:

Color fields (Pola kolorów)
            Kliknij pole, aby otworzyć Color Picker (próbnik kolorów), który umożliwia określenie 
            nowego koloru.
Name (Nazwa)
            Pokazuje nazwę koloru. Kliknij dwukrotnie, aby to zmienić.
Set up (Organizuj)
           Umożliwia dodawanie lub usuwanie pól kolorów.
           ● Insert Color (Wstaw kolor)
                     Dodaje nowe pole koloru.
           ● Duplicate Color (Duplikat koloru)
                     Duplikuje wybrane pole koloru.
           ● Remove Color (Usuń kolor)
                     Usuwa wybrane pole koloru.
           ● Reset Color (Resetuj kolor)
                     Resetuje wybrane pole koloru do ustawień fabrycznych. 
Apply (Zastosuj)
          Stosuje zmiany i zamyka okno dialogowe.

POWIĄZANE LINKI
Color Picker (Próbnik kolorów) na stronie 96
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Karta Presets (ustawienia wstępne)
Zakładka Presets (Presety) pozwala rozszerzyć zestaw kolorów do 24 lub nawet 32 kolorów lub 
zredukować go do 8 kolorów. Możesz dodawać odcienie i sortować kolory według ich odcienia lub 
koloru podstawowego.

                    

W sekcji New Color Set Settings (Ustawienia nowego zestawu kolorów) dostępne są następujące 
opcje:

Number of Basic Colors (Liczba kolorów podstawowych)
           Możesz ustawić 8, 16, 24 lub 32 kolory podstawowe.
Number of Color Tints (Liczba odcieni kolorów)
           Można ustawić 1, 2 lub 4 odcienie kolorów.
Sort Colors by (Sortuj kolory według)
Umożliwia sortowanie kolorów zestawu kolorów według ich koloru podstawowego lub odcienia 
koloru.

Sekcja New Color Set (Nowy zestaw kolorów) wyświetla aktualne kolory nowego zestawu 
kolorów.
Sekcja Missing Current Project Colors (Brakujące bieżące kolory projektu) pokazuje, które 
brakujące kolory zostaną zastąpione. Przesuń wskaźnik myszy nad pole koloru brakującego koloru, 
aby podświetlić kolor, który ma go zastąpić w sekcji New Color Set (Nowy zestaw kolorów).
Apply (Zastosuj)
            Stosuje zmiany i zamyka okno dialogowe.

Zakładka Options (Opcje)
Zakładka Opcje umożliwia dostęp do opcji zestawu kolorów.

                    

97



W sekcji Color Set Options (Opcje zestawu kolorów) dostępne są następujące opcje:

Store Color Set as Default (Zapisz zestaw kolorów jako domyślny)
            Zapisuje bieżący zestaw kolorów jako domyślny.
Reset Color Set as Default (Resetuj zestaw kolorów na domyślny)
            Stosuje domyślny zestaw kolorów.
Reset Color Set to Factory Settings (Resetuj zestaw kolorów do ustawień fabrycznych)
            Powraca do standardowej palety kolorów.
Select Colors by Name (Wybierz kolory według nazwy)
           Umożliwia wybranie kolorów według nazwy.
Apply (Zastosuj)
           Stosuje zmiany i zamyka okno dialogowe.

Narzędzie do wybierania kolorów (Color Picker)
Próbnik kolorów umożliwia zdefiniowanie nowych niestandardowych kolorów.

Aby otworzyć Color Picker (próbnik kolorów), wykonaj jedną z następujących czynności:

● Wybierz Project > Project Colors Setup (Ustawienia kolorów projektu) i w oknie dialogowym 
Project Colors Setup (Ustawienia kolorów projektu) na karcie Color Set (Zestaw kolorów) kliknij 
pole koloru.
Pozwala to na zdefiniowanie niestandardowych kolorów projektu.
● Wybierz polecenie Edit (Edytuj) > Preferences (Preferencje), wybierz jedną z pozycji User 
Interface (Interfejs użytkownika) i kliknij pole koloru.
Pozwala to na zdefiniowanie niestandardowych kolorów interfejsu użytkownika.

                                

Color Selectors (Selektory kolorów)
           Pozwala wybrać odcień koloru i niuans odcienia.
Context menu (Menu kontekstowe)
          Umożliwia kopiowanie, wklejanie lub resetowanie kolorów.
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Current Color/New Color (Bieżący kolor/Nowy kolor)
            Pokazuje bieżący kolor i nowy kolor.
Hue/Saturation/Value (Barwa/Nasycenie/Wartość)
           Umożliwia numeryczną edycję kolorów.
Red/Green/Blue (Czerwony/Zielony/Niebieski)
           Umożliwia numeryczną edycję kolorów.
OK
           Potwierdza zmiany kolorów.

UWAGA
Musisz ponownie uruchomić aplikację, aby niektóre zmiany odniosły skutek.
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Project Handling (Obsługa Projektów)

W Cubase projekty są głównymi dokumentami. Aby pracować z programem, należy utworzyć i 
skonfigurować projekt.

Tworzenie nowych projektów
Możesz tworzyć puste projekty lub projekty oparte na szablonie

PROCEDURA
1. Wybierz File > New Project (Plik > Nowy projekt).
           W zależności od ustawień zostanie otwarte okno dialogowe Hub (Centrum) lub Project  
            Assistant (Asystent projektu).
2. W sekcji opcji lokalizacji wybierz miejsce przechowywania nowego projektu.
          ● Aby użyć lokalizacji domyślnej, wybierz opcję Use default location (Użyj lokalizacji 
              domyślnej).
          ● Aby wybrać inną lokalizację, wybierz Prompt for project location (Pytaj o lokalizację 
              projektu).
3. Wykonaj jedną z następujących czynności:
          ● Aby utworzyć pusty nowy projekt, kliknij opcję Create Empty (Utwórz pusty).
          ● Aby utworzyć nowy projekt z szablonu, wybierz szablon (template) i kliknij Create 
             (Utwórz).

WYNIK
Tworzony jest nowy projekt bez tytułu. Jeśli wybrałeś szablon, nowy projekt jest oparty na tym 
szablonie i zawiera odpowiednie ścieżki, zdarzenia i ustawienia.

UWAGA
Jeśli utworzysz pusty projekt, zostaną zastosowane domyślne ustawienia wstępne konfiguracji 
magistrali wejściowej i wyjściowej. Jeśli nie zdefiniowano domyślnych ustawień wstępnych, 
stosowane są ostatnio używane konfiguracje.

POWIĄZANE LINKI
Ustawienia wstępne dla szyn wejściowych i wyjściowych na stronie 34

Hub (Centrum)
Hub zapewnia najświeższe informacje i pomaga w organizowaniu projektów.

Aby otworzyć Hub, wykonaj jedną z następujących czynności:
      ● Wybierz Hub > Open Hub (Hub > Otwórz Hub).
      ● Wybierz File > New Project (Plik > Nowy projekt)
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Sekcja aktualności i samouczków (News and Toturials)
Sekcja News and Toturials (Wiadomości i samouczki) wyświetla wiadomości Steinberg, filmy 
instruktażowe, a także linki do forum użytkowników, pliki do pobrania i Centrum pomocy.
UWAGA
Upewnij się, że masz aktywne połączenie internetowe, aby uzyskać dostęp do tego materiału.

Sekcja projektów (Projects)
Sekcja Projects (Projekty) umożliwia tworzenie nowych projektów, które mogą być puste lub 
oparte na szablonie. Pozwala określić, gdzie zapisać projekty. Umożliwia także dostęp do ostatnio 
otwieranych projektów lub projektów przechowywanych w innych lokalizacjach. Ta sekcja oferuje 
te same funkcje, co okno dialogowe Project Assistant (Asystent projektu).

Category Bar (Pasek kategorii)
W tej sekcji dostępne szablony fabryczne są posortowane według predefiniowanych kategorii 
Recording (Nagrywanie), Scoring (Punktacja), Production (Produkcja) i Mastering. Kategoria 
Recent (Ostatnie) zawiera listę ostatnio otwieranych projektów. Kategoria More (Więcej) zawiera 
domyślny szablon projektu oraz wszystkie szablony, które nie są przypisane do żadnej innej 
kategorii.

Template list (Lista szablonów)
Po kliknięciu na jeden z elementów kategorii, lista pod paskiem kategorii pokazuje dostępne 
szablony dla tej kategorii. Wszystkie nowo utworzone szablony są dodawane na górze 
odpowiedniej listy.

Location options (Opcje lokalizacji)
W tej sekcji możesz określić miejsce przechowywania projektu.

Open Other (Otwórz inne)
Ten przycisk umożliwia otwarcie dowolnego pliku projektu w systemie. Jest to identyczne jak 
użycie polecenia Open (Otwórz) w menu File (Plik).

POWIĄZANE LINKI
Okno dialogowe Ptroject Assistant (Asystent projektu) na stronie 100
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Dezaktywacja koncentratora (Hub)
Aby uruchomić Cubase lub tworzyć nowe projekty bez Huba, możesz go dezaktywować.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz opcję General (Ogólne).
2. Dezaktywuj Use Hub (Użyj Centrum).

WYNIK
Cubase uruchamia się bez otwierania projektu i otwiera okno dialogowe Project Assistant 
(Asystent projektu), gdy tworzysz nowy projekt za pomocą menu File (Plik). Jednak nadal możesz 
otworzyć Hub za pomocą menu Hub.

Okno dialogowe Project Assistent (Asystent projektu)
Okno dialogowe Project Assistent pomaga w organizowaniu projektów.

● Aby otworzyć okno dialogowe Project Assistant (Asystent projektu), wyłącz opcję Use Hub 
(Użyj centrum) w oknie dialogowym Preferences (Preferencje) (strona General (Ogólne)) i 
wybierz File > New Project (Plik > Nowy projekt).

                                

Category bar (Pasek kategorii)
W tej sekcji dostępne szablony fabryczne są posortowane według predefiniowanych kategorii 
Recording (Nagrywanie), Production (Produkcja), Scoring (Punktacja) i Mastering.
Kategoria Recent (Ostatnie) zawiera listę ostatnio otwieranych projektów.
Kategoria More (Więcej) zawiera domyślny szablon projektu oraz wszystkie szablony, które nie są 
przypisane do żadnej innej kategorii.

Template list (Lista szablonów)
Po kliknięciu na jeden z elementów kategorii lista pod paskiem kategorii pokazuje dostępne 
szablony fabryczne dla tej kategorii. Wszystkie nowo utworzone szablony są dodawane na górze 
odpowiedniej listy.

Location Options (Opcje lokalizacji)
W tej sekcji możesz określić miejsce przechowywania projektu.
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Open Other (Otwórz inne)
Ten przycisk umożliwia otwarcie dowolnego pliku projektu w systemie. Jest to identyczne jak 
użycie polecenia Open (Otwórz) z menu File (Plik).

Pliki projektu
Plik projektu (rozszerzenie *.cpr) jest centralnym dokumentem w Cubase. Plik projektu zawiera
odniesienia do danych multimedialnych, które można zapisać w folderze projektu.

UWAGA
Zalecamy zapisywanie plików tylko w folderze projektu, chociaż możesz je zapisać w dowolnej 
innej lokalizacji, do której masz dostęp.

Folder projektu zawiera plik projektu i następujące foldery, które Cubase automatycznie tworzy w 
razie potrzeby:
● Audio (Dźwięk)
● Edits (Edycje)
● Images (Obrazy)
● Track Pictures (Zdjęcia Ścieżki)

Pliki szablonów
Szablony mogą być dobrym punktem wyjścia dla nowych projektów. Szablony to projekty, w 
których można zapisać wszystkie regularnie używane ustawienia, takie jak konfiguracje magistrali, 
częstotliwości próbkowania, formaty nagrań, podstawowe układy ścieżek, konfiguracje VST, 
konfiguracje map perkusyjnych itp.

W Hubie dostępne są następujące typy szablonów:

● Szablony fabryczne dla określonych scenariuszy. Są one wymienione w kategoriach Recording 
(Nagrywanie), Scoring (Tworzenie partytury), Production (Produkcja) czy Mastering.
● Szablon domyślny. Jest on wymieniony w kategorii More (Więcej).
● Wszelkie nowe szablony użytkownika, które utworzysz i zapiszesz. Są one wymienione w 
kategorii More (Więcej).

Projekty szablonów nie są zapisywane w folderach projektów i dlatego nie zawierają podfolderów 
ani plików multimedialnych.

● Aby otworzyć lokalizację określonego szablonu, kliknij prawym przyciskiem myszy szablon na 
liście szablonów i wybierz Show in Explorator (Pokaż w Eksploratorze) (tylko Windows) lub 
Reveal in Finder (Pokaż w Finderze) (tylko macOS).

Okno dialogowe Save As Template (Zapisz jako szablon)

Okno dialogowe Save As Template (Zapisz jako szablon) umożliwia zapisywanie projektów jako 
szablonów.
● Aby otworzyć okno dialogowe Save As Template (Zapisz jako szablon), wybierz File > Save As
Template (Plik > Zapisz jako szablon).
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W sekcji Current Presets (Bieżące ustawienia wstępne) dostępne są następujące opcje:

New Folder (Nowy folder)
      Umożliwia dodanie i nazwanie folderu do listy szablonów.
Template list (Lista szablonów)
      Wyświetla listę szablonów i folderów.

W sekcji Attribute Inspector (Inspektor atrybutów) dostępne są następujące opcje:

Value (Wartość)
      Kliknij to pole, aby wprowadzić opis atrybutu Content Summary (Podsumowanie zawartości) 
       lub wybrać kategorię szablonu dla atrybutu Template Category (Kategoria szablonu).

W sekcji New Preset (Nowe ustawienie wstępne) dostępne są następujące opcje:

New Preset (Nowe ustawienie wstępne)
      Umożliwia wprowadzenie nazwy dla nowego szablonu projektu.
Show Attribute Inspector (Pokaż inspektora atrybutów)
      Pozwala pokazać/ukryć Attribute Inspector (Inspektora atrybutów).
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Zapisywanie pliku szablonu projektu
Bieżący projekt można zapisać jako szablon. Podczas tworzenia nowego projektu możesz wybrać 
ten szablon jako punkt wyjścia dla nowego projektu.

WARUNEK WSTĘPNY
Usunąłeś wszystkie klipy z Pool (puli). Dzięki temu, odniesienia do danych multimedialnych z 
oryginalnego folderu projektu zostaną usunięte.

PROCEDURA
1. Skonfiguruj projekt.
2. Wybierz File > Save As Template (Plik > Zapisz jako szablon).
3. W sekcji New Preset (nowe ustawienia wstępne) okna dialogowego Save As Template (Zapisz 
jako szablon) wprowadź nazwę nowego szablonu projektu.

                          

4. W sekcji Attribute Inspector (Inspektor atrybutów) kliknij dwukrotnie pole Value (Wartość) 
atrybutu Content Summary (Podsumowanie zawartości), aby wprowadzić opis szablonu.
5. Kliknij pole Value (Wartość) atrybutu Template Category (Kategoria szablonu) i wybierz 
kategorię szablonu z wyskakującego menu. Jeśli nie wybierzesz kategorii, nowy szablon zostanie 
wyświetlony w Hub (Centrum) w kategorii More (Więcej).
6. Kliknij OK, aby zapisać szablon.

Zmienianie nazw szablonów
Nazwy plików szablonów można zmieniać z poziomu Hub (Centrum) lub Project Assistant 
(Asystenta projektu).

PROCEDURA
1. W Hub (Hubie) lub Project Assistant (Asystencie projektu) kliknij szablon prawym 
przyciskiem myszy i wybierz Rename (Zmień nazwę).
2. W oknie dialogowym Rename (Zmień nazwę) wprowadź nową nazwę i kliknij OK.

Okno dialogowe Project Setup (konfiguracji projektu)
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Okno dialogowe Project Setup (Ustawienia projektu) umożliwia dokonanie ogólnych ustawień 
projektu.
● Aby otworzyć okno dialogowe Project Setup (Ustawienia projektu), wybierz Project > Project 
Setup
● Aby okno dialogowe Project Setup (Ustawienia projektu) otwierało się automatycznie podczas 
tworzenia nowego projektu, aktywuj Run Setup (Uruchom instalację) przy opcji Create New 
Project (Utwórz nowy projekt) w oknie dialogowym Preferences (Preferencje) (strona General 
(Ogólne)).

WAŻNE
Chociaż większość ustawień konfiguracji projektu można zmienić w dowolnym momencie, 
częstotliwość próbkowania należy ustawić bezpośrednio po utworzeniu nowego projektu. Jeśli 
później zmienisz częstotliwość próbkowania, musisz przekonwertować wszystkie pliki audio w 
projekcie na nową częstotliwość próbkowania, aby były prawidłowo odtwarzane.

W sekcji Project Duration (Czas trwania projektu) dostępne są następujące opcje:

Project Start Time (Czas rozpoczęcia projektu)
Umożliwia określenie czasu rozpoczęcia projektu w formacie kodu czasowego. Określa to również 
pozycję początkową synchronizacji podczas synchronizacji z urządzeniami zewnętrznymi.
Project Length (Długość projektu)
Pozwala określić długość projektu.

Project Frame Rate (Szybkość klatek projektu)
W sekcji Project Frame Rate dostępne są następujące opcje:

Project Frame Rate (Szybkość klatek projektu)
Umożliwia określenie standardu kodu czasowego i liczby klatek na sekundę dla projektu. Podczas 
synchronizacji z urządzeniem zewnętrznym to ustawienie musi odpowiadać szybkości klatek 
przychodzącego kodu czasowego.
Get Frame Rate From Video (Uzyskaj liczbę klatek na sekundę z wideo)
Umożliwia ustawienie szybkości klatek projektu zgodnie z szybkością klatek importowanego pliku 
wideo.
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Project Time Displays (Wyświetlacze czasu projektu)
W sekcji Project Time Displays dostępne są następujące opcje:

Display Format (Format wyswietlania)
     Umożliwia określenie globalnego formatu wyświetlania, który jest używany do wyświetlania 
     wszystkich linijek i pozycji w programie, z wyjątkiem ścieżek linijek. Można jednak dokonywać
     niezależnych wyborów formatu wyświetlania dla poszczególnych linijek i ekranów.
Display Time Offset (Wyświetl przesunięcie czasu)
     Umożliwia określenie przesunięcia pozycji czasu wyświetlanych na linijkach i ekranach pozycji 
     w celu skompensowania ustawienia Project Start Time (Czas rozpoczęcia projektu).
Display Bar Offset (Przesunięcie paska wyświetlania)
     To ustawienie jest używane tylko w przypadku wybrania formatu wyświetlania Bars+Beats 
     (Takty+Uderzenia). Umożliwia określenie przesunięcia pozycji czasu wyświetlanych na 
     linijkach i ekranach pozycji w celu skompensowania ustawienia Project Start Time (Czas 
     rozpoczęcia projektu).

Record File Format (Format pliku nagrania)
W sekcji Record File Format dostępne są następujące opcje:

Sample Rate (tempo próbek, częstotliwość próbkowania)
Umożliwia określenie częstotliwości próbkowania, z jaką Cubase nagrywa i odtwarza dźwięk.
● Jeśli sprzęt audio generuje częstotliwość próbkowania wewnętrznie i wybierzesz nieobsługiwaną 
częstotliwość próbkowania, zostanie to oznaczone innym kolorem. W takim przypadku należy 
ustawić inną częstotliwość próbkowania, aby pliki audio były odtwarzane prawidłowo.
● Jeśli wybierzesz częstotliwość próbkowania obsługiwaną przez sprzęt audio, ale różniącą się od 
aktualnego ustawienia częstotliwości próbkowania, zostanie ona automatycznie zmieniona na 
częstotliwość próbkowania projektu.
● Jeśli sprzęt audio jest taktowany zewnętrznie i odbiera sygnały zegara zewnętrznego, 
niedopasowanie częstotliwości próbkowania jest akceptowane.   

Bit Depth (Głębia bitowa)
Pozwala określić głębię bitową plików audio nagrywanych w Cubase. Wybierz format nagrywania 
zgodnie z głębią bitową zapewnianą przez sprzęt audio. Dostępne opcje to 16-bitowy, 24-bitowy, 
32-bitowy, 32-bitowy zmiennoprzecinkowy i 64-bitowy zmiennoprzecinkowy.
UWAGA
● Jeśli twój interfejs audio obsługuje 32-bitową głębię bitową i chcesz zachować tę precyzję w 
swoich nagraniach, musisz wybrać Processing Precision (Precyzję przetwarzania) 64-bitową 
zmiennoprzecinkową w oknie dialogowym Studio Setup (Ustawienia Studio).
● Podczas nagrywania z efektami rozważ ustawienie głębi bitowej na 32-bitową 
zmiennoprzecinkową lub 64-bitową zmiennoprzecinkową. Zapobiega to obcinaniu 
(zniekształceniom cyfrowym) w nagranych plikach i utrzymuje bardzo wysoką jakość dźwięku. 
Przetwarzanie efektów i zmiany poziomu lub EQ w kanale wejściowym są wykonywane w 32-
bitowym lub 64-bitowym formacie zmiennoprzecinkowym, w zależności od ustawienia Processing 
Precision (Precyzji przetwarzania) w oknie dialogowym Studio Setup (Ustawienia Studio). Jeśli 
nagrywasz w 16-bitowej lub 24-bitowej rozdzielczości, dźwięk zostanie przekonwertowany na tę 
niższą głębię bitową podczas zapisywania do pliku. W rezultacie sygnał może ulec pogorszeniu. 
Jest to niezależne od rzeczywistej głębi bitowej twojego sprzętu audio. Nawet jeśli sygnał ze 
sprzętu audio ma 16-bitową głębię bitową, po dodaniu efektów do kanału wejściowego sygnał 
będzie miał 32-bitowy zmiennoprzecinkowy lub 64-bitowy zmiennoprzecinkowy.
● Im wyższa wartość głębi bitowej, tym większe pliki i tym większe obciążenie dla systemu 
dyskowego. Jeśli stanowi to problem, możesz obniżyć ustawienie formatu nagrywania.

Record File Type (Typ pliku nagrywania)
Pozwala określić typ plików audio, które nagrywasz w Cubase
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UWAGA
● W przypadku nagrań w formacie Wave większych niż 4  GB używany jest standard EBU RIFF. 
Jeśli używany jest dysk FAT 32 (niezalecane), pliki audio są dzielone automatycznie. W oknie 
dialogowym Preferences (Preferencje) możesz określić, co się stanie, jeśli nagrany plik Wave 
będzie większy niż 4 GB.
● Możesz ustawić osadzone ciągi znaków w oknie dialogowym Preferences (Preferencje).

Project Ownership (Własność projektu)
W sekcji Project Ownership dostępne są następujące opcje:

Author (Autor)
Umożliwia określenie autora projektu, który zostanie zapisany w pliku podczas eksportowania 
plików audio i aktywowania opcji Insert iXML chunk (Wstaw porcję iXML). Domyślnego autora 
można określić w polu Default Author Name (Domyślna nazwa autora) w oknie dialogowym 
Preferences (Preferencje) (strona General (Ogólne) — Personalization (Personalizacja)).

Company (Firma)
Umożliwia określenie nazwy firmy, która jest zapisywana w pliku podczas eksportowania plików 
audio i aktywowania opcji Insert iXML chunk (Wstaw porcję iXML). Domyślną firmę można 
określić w polu Default Company Name (Domyślna nazwa firmy) w oknie dialogowym 
Preferences (Preferencje) (strona General (Ogólne) — Personalization (Personalizacja)).

Other Project Settings (Inne ustawienia projektu)
W sekcji Other Project Settings dostępne są następujące opcje:

Stereo Pan Law (Prawo panoramy stereo)
Jeśli przesuwasz kanał w lewo lub w prawo, suma lewej i prawej strony jest wyższa (głośniejsza), 
niż w przypadku panoramowania tego kanału na środku. Tryby te umożliwiają tłumienie sygnałów 
z panoramą centralną. 0 dB wyłącza panoramowanie ze stałą mocą. Equal Power (Równa moc) 
oznacza, że moc sygnału pozostaje taka sama niezależnie od ustawienia panoramy.

Volume Max (Maks. Głośność)
Umożliwia określenie maksymalnego poziomu tłumika. Domyślnie jest to ustawione na +12 dB. 
Jeśli ładujesz projekty, które zostały utworzone w wersjach Cubase starszych niż 5.5, ta wartość jest
ustawiana na starą wartość domyślną +6 dB.

Hermode Tuning (Strojenie Hermode'a)
W sekcji Hermode Tuning dostępne są następujące opcje:

HMT Type (Typ HMT) (tylko MIDI)
      Umożliwia określenie trybu strojenia Hermode'a nut MIDI.
HMT Depth (Głębia HMT) (tylko MIDI)
      Umożliwia określenie ogólnego stopnia dostrajania.

Project Location (Lokalizacja projektu)
W sekcji Project Location dostępne są następujące opcje:

Project Location Information (Informacje o lokalizacji projektu)
      Wyświetla lokalizację projektu.
Show in Explorer/Reveal in Finder (Pokaż w Eksploratorze/Ujawnij w Finderze)
      Otwiera okno dialogowe pliku, które pokazuje położenie pliku projektu.
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POWIĄZANE LINKI
Strona systemu audio na stronie 17
Nagrywanie — Audio na stronie 1175

Otwieranie plików projektu
Możesz jednocześnie otworzyć jeden lub kilka zapisanych plików projektu.

WAŻNE
Jeśli otworzysz projekt zapisany w innej wersji programu, który zawiera dane funkcji 
niedostępnych w Twojej wersji, dane te mogą zostać utracone podczas zapisywania projektu w 
Twojej wersji.

UWAGA
● Jeśli otworzysz projekt zewnętrzny, używany jest ostatnio używany widok zapisany na 
komputerze. Możesz zmienić to ustawienie w oknie dialogowym Preferences (Preferencje) (strona 
General (Ogólne)).
● Zewnętrzne projekty są automatycznie podłączane do szyn wejściowych i wyjściowych. Jeśli 
otworzysz projekt, który został utworzony na komputerze z konfiguracją portu ASIO inną niż 
konfiguracja twojego komputera, może to spowodować niechciane połączenia audio. Możesz 
dezaktywować automatyczne łączenie szyn wejściowych i wyjściowych w oknie dialogowym 
Preferences (Preferencje) (strona VST).

PROCEDURA
1. Wybierz File > Open (Plik > Otwórz).
2. W otwartym oknie dialogowym wybierz projekt, który chcesz otworzyć i kliknij Open (Otwórz).
3. Jeśli istnieje już otwarty projekt, zostaniesz zapytany, czy chcesz aktywować nowy projekt. 
Wykonaj jedną z następujących czynności:
● Aby aktywować projekt, kliknij Activate (Aktywuj).
● Aby otworzyć projekt bez jego aktywacji, kliknij No (Nie). Skraca to czas ładowania projektów.

POWIĄZANE LINKI
Obszary robocze dla projektów zewnętrznych na stronie 1143
Nie podłączaj szyn wejścia/wyjścia podczas ładowania projektów zewnętrznych na stronie 1182
Aktywacja projektów na stronie 107

Aktywacja projektów
Jeśli masz jednocześnie otwartych kilka projektów w Cubase, aktywny może być tylko jeden 
projekt. Aktywny projekt jest wskazywany przez podświetlony przycisk Activate Ptoject (Aktywuj
projekt) w lewym górnym rogu okna Project. Jeśli chcesz pracować nad innym projektem, musisz 
aktywować inny projekt.

PROCEDURA

● Aby aktywować projekt, kliknij Activate Project (Aktywuj projekt)   .

UWAGA
Jeśli zamkniesz aktywny projekt, musisz ręcznie aktywować inny otwarty projekt, ponieważ 
Cubase nie może automatycznie aktywować jednego z pozostałych otwartych projektów.
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Otwieranie ostatnich projektów
Możesz otwierać ostatnie projekty bezpośrednio z listy ostatnich projektów.

PROCEDURA
● Wykonaj jedną z następujących czynności:
● Na pasku kategorii okna dialogowego Hub (Centrum) lub Project Assistant (Asystent projektu) 
kliknij Recent (Ostatnie), wybierz projekt z listy projektów i kliknij Open (Otwórz).
● Wybierz File > Recent Projects (Plik > Ostatnie projekty) i wybierz ostatnio otwarty projekt.

Przekierowywanie brakujących portów
Jeśli otworzysz projekt Cubase, który został utworzony w innym systemie z innym sprzętem audio, 
Cubase spróbuje znaleźć pasujące wejścia i wyjścia audio dla szyn wejścia/wyjścia. Jeśli Cubase 
nie może rozwiązać wszystkich wejść i wyjść audio/MIDI używanych w projekcie, otworzy się 
okno Missing Ports (Brakujące porty).
Umożliwia to ręczne przekierowywanie dowolnych portów określonych w projekcie do portów 
dostępnych w systemie.

UWAGA
Aby usprawnić wyszukiwanie pasujących wejść i wyjść audio dla szyn wejściowych/wyjściowych, 
należy używać opisowych, ogólnych nazw portów wejściowych i wyjściowych.

POWIĄZANE LINKI
Zmiana nazw wejść i wyjść sprzętowych na stronie 32

Zapisywanie plików projektu
Aktywny projekt można zapisać jako plik projektu. Aby Twoje projekty były jak najłatwiejsze do 
zarządzania, upewnij się, że pliki projektu i wszystkie powiązane pliki są zapisywane w 
odpowiednich folderach projektu.
● Aby zapisać projekt i określić nazwę pliku oraz lokalizację, otwórz menu File (Plik) i wybierz 
Save As (Zapisz jako).
● Aby zapisać projekt pod bieżącą nazwą i lokalizacją, otwórz menu File (Plik) i wybierz Save 
(Zapisz).

Zapisywanie automatyczne
Cubase może automatycznie zapisywać kopie zapasowe wszystkich otwartych plików projektu z 
niezapisanymi zmianami.

UWAGA
Tworzona jest kopia zapasowa tylko plików projektu. Jeśli chcesz dołączyć pliki z puli (Pool) i 
zapisać swój projekt w innej lokalizacji, musisz użyć funkcji Back up Project (Utwórz kopię 
zapasową projektu).

Cubase może automatycznie zapisywać kopie zapasowe wszystkich otwartych projektów z 
niezapisanymi zmianami. Aby to ustawić, aktywuj opcję Auto Save (Automatyczne zapisywanie) 
w oknie dialogowym Preferences (Preferencje) (strona General (Ogólne)). Kopie zapasowe mają 
nazwę „<nazwa projektu>-xx.bak”, gdzie xx to liczba przyrostowa. Kopie zapasowe niezapisanych 
projektów są tworzone w podobny sposób jak „UntitledX-xx.bak”, gdzie X to kolejny numer 
niezapisanych projektów. Wszystkie pliki kopii zapasowej są zapisywane w folderze projektu.
● Aby określić odstępy czasu, w jakich tworzona jest kopia zapasowa, użyj ustawienia Auto Save 
Interval (Interwał automatycznego zapisywania).
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● Aby określić, ile plików kopii zapasowych ma być tworzonych za pomocą funkcji Auto Save 
(Automatyczny zapis), użyj opcji Maximum Backup Files (Maksymalna liczba plików kopii 
zapasowych). Po osiągnięciu maksymalnej liczby plików kopii zapasowej istniejące pliki zostaną 
nadpisane, zaczynając od najstarszego pliku.

Zapisywanie plików projektu jako nowej wersji
Możesz utworzyć i aktywować nową wersję aktywnego pliku projektu. Jest to przydatne, jeśli 
eksperymentujesz z edycjami i aranżacjami i chcesz mieć możliwość powrotu do poprzedniej wersji
kiedykolwiek.

PROCEDURA
● Wykonaj jedną z następujących czynności:
● Wybierz File > Save New Version (Plik > Zapisz nową wersję).
● Naciśnij Ctrl/Cmd -Alt/Opt - S .

WYNIK
Nowy plik jest zapisywany pod tą samą nazwą co oryginalny projekt i z dołączonym numerem 
przyrostowym. Na przykład, jeśli twój projekt nazywa się „Mój projekt”, nowe wersje nazywają się
„Mój projekt-01”, „Mój projekt-02” i tak dalej.

Powrót do ostatnio zapisanej wersji
Możesz wrócić do ostatnio zapisanej wersji i odrzucić wszystkie wprowadzone zmiany.

PROCEDURA
1. Wybierz File > Revert (Plik > Przywróć).
2. W komunikacie ostrzegawczym kliknij Revert (Przywróć). Jeśli nagrałeś lub utworzyłeś nowe 
pliki audio od czasu zapisania ostatniej wersji, pojawi się monit o usunięcie lub zachowanie plików.

Wybór lokalizacji projektu
Możesz określić lokalizację projektu do zapisywania projektów w Hub (Centrum) i Project 
Assistant (Asystent projektu).

PROCEDURA
1. Wykonaj jedną z następujących czynności:
● Wybierz opcję Use default location (Użyj lokalizacji domyślnej), aby utworzyć projekt w 
domyślnej lokalizacji projektu, a w polu Project folder (Folder projektu) określ nazwę folderu 
projektu. Jeśli nie określisz tutaj folderu projektu, projekt zostanie zapisany w folderze o nazwie 
Untitled (Bez tytułu).

● Kliknij pole ścieżki, aby zmienić domyślną lokalizację projektu i określ nową domyślną 
lokalizację w otwartym oknie dialogowym pliku.
● Aktywuj Prompt for project locarion (Pytaj o lokalizację projektu), aby otworzyć okno 
dialogowe pliku, w którym możesz określić lokalizację folderu projektu.

2. Wykonaj jedną z następujących czynności:
● Kliknij opcję Create Empty (Utwórz pusty) aby utworzyć nowy pusty projekt.

111



● Wybierz jeden z szablonów projektów i kliknij Create (Utwórz), aby utworzyć projekt na 
podstawie szablonu.

WYNIK
Projekt zostanie utworzony i zapisany w określonej lokalizacji.

Samodzielne projekty
Jeśli chcesz udostępnić swoją pracę lub przenieść ją na inny komputer, Twój projekt musi być 
samowystarczalny.

Poniższe funkcje ułatwiają to zadanie:
● Wybierz Media > Prepare Archive (Media > Przygotuj archiwum), aby sprawdzić, czy każdy 
klip, do którego odwołuje się projekt, znajduje się w folderze projektu i podjąć działania, jeśli tak 
nie jest.
● Wybierz File > Back up Project (Plik > Utwórz kopię zapasową projektu), aby utworzyć nowy 
folder projektu, w którym możesz zapisać plik projektu i niezbędne dane robocze. Pierwotny 
projekt pozostaje bez zmian.

POWIĄZANE LINKI
Przygotowanie archiwów na stronie 110
Tworzenie kopii zapasowych projektów na stronie 110

Przygotowanie archiwów
Funkcja Prepare Archive (Przygotuj archiwum) umożliwia zebranie wszystkich plików, do 
których odwołuje się projekt, aby upewnić się, że znajdują się one w folderze projektu. Jest to 
przydatne, jeśli chcesz przenieść lub zarchiwizować swój projekt.

PROCEDURA
1. Wybierz Media > Prepare Archive (Media > Przygotuj archiwum). Jeśli twój projekt odwołuje 
się do plików zewnętrznych, zostaniesz zapytany, czy chcesz skopiować je do katalogu roboczego. 
Jeśli zastosowano jakiekolwiek przetwarzanie, musisz zdecydować, czy chcesz wyprostować 
zmiany.
2. Kliknij Proceed (Kontynuuj).

WYNIK
Twój projekt jest gotowy do archiwizacji. Możesz przenieść lub skopiować folder projektu do innej 
lokalizacji.
PO WYKONANIU TEGO ZADANIA
Musisz skopiować pliki audio znajdujące się w folderze projektu do folderu Audio lub zapisać je 
oddzielnie. Klipy wideo należy również przenosić ręcznie, ponieważ filmy są tylko odniesieniami i 
nie są zapisywane w folderze projektu.

Tworzenie kopii zapasowych projektów
Możesz utworzyć kopię zapasową swojego projektu. Kopie zapasowe zawierają tylko niezbędne 
dane służbowe. Wszystkie pliki multimedialne z wyjątkiem plików z archiwów VST Sound są 
dołączane jako kopie.

PROCEDURA
1. Wybierz File > Back up Project (Plik > Wykonaj kopię zapasową projektu).
2. Wybierz pusty folder lub utwórz nowy.
3. Wprowadź zmiany w oknie dialogowym Back up Project Options (Opcje kopii zapasowej 
projektu) i kliknij OK.
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WYNIK
Kopia projektu zostanie zapisana w nowym folderze. Oryginalny projekt pozostaje nienaruszony.

UWAGA
Treści VST Sound dostarczane przez firmę Steinberg są chronione przed kopiowaniem i nie są 
uwzględniane w projekcie kopii zapasowej. Jeśli chcesz użyć kopii zapasowej, która wykorzystuje 
zawartość VST Sound na innym komputerze, upewnij się, że odpowiednia zawartość jest również 
dostępna na tym komputerze.

Okno dialogowe Back up Project Options (Opcje tworzenia kopii 
zapasowych projektu)
Okno dialogowe Back up Project Options (Opcje kopii zapasowej projektu) umożliwia 
utworzenie kopii zapasowej projektu.
● Aby otworzyć okno dialogowe Back up Project Options, wybierz File > Back up Project 
(Plik > Wykonaj kopię zapasową projektu).

Project Name (Nazwa Projektu)
       Umożliwia zmianę nazwy projektu objętego kopią zapasową.
Keep Current Project Active (Zachowaj bieżący projekt aktywny)
       Pozwala zachować aktywny projekt po kliknięciu OK
Minimize Audio Files (Zminimalizuj pliki audio)
       Umożliwia uwzględnienie tylko tych części pliku audio, które są faktycznie używane w 
       projekcie. Może to znacznie zmniejszyć rozmiar folderu projektu, jeśli używasz małych sekcji 
       dużych plików. Oznacza to również, że nie możesz używać innych części plików audio, jeśli 
       kontynuujesz pracę z projektem w nowym folderze.
Make Direct Offline Processing Permanent (Ustaw bezpośrednie przetwarzanie offline na stałe)
       Pozwala spłaszczyć wszystkie edycje i trwale przetworzyć i zastosować efekty w każdym 
       klipie w puli (Pool).
Remove Unused Files (Usuń nieużywane pliki)
       Umożliwia usuwanie nieużywanych plików i tworzenie kopii zapasowych tylko tych plików, 
       które są faktycznie używane.
Do Not Back up Video (Nie twórz kopii zapasowej wideo)
       Umożliwia wykluczenie klipów wideo na ścieżce wideo lub w puli (Pool) bieżącego projektu.
Do Not Back up Mixdown Folder (Nie twórz kopii zapasowej folderu Mixdown)
       Umożliwia wykluczenie folderu Mixdown twojego projektu z kopii zapasowej.

POWIĄZANE LINKI 
Okno dialogowe Export Audio Mixdown (eksport miksowania audio) na stronie 1053
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Tracks (Utwory, ścieżki)

Utwory są elementami budulcowymi Twojego projektu. Pozwalają importować, dodawać, 
nagrywać i edytować części i zdarzenia. Ścieżki są wymienione od góry do dołu na liście ścieżek i 
rozciągają się poziomo w oknie Project. Każda ścieżka jest przypisana do konkretnego kanału 
w MixConsole.

Jeśli wybierzesz ścieżkę w oknie Project, kontrolki, ustawienia i parametry wyświetlane 
w Inspector i na liście ścieżek pozwolą ci kontrolować ścieżkę.

Track Inspector Settings Dialog (Okno dialogowe ustawień inspektora
ścieżek)

Okno dialogowe Track Inspector Settings (Ustawienia inspektora ścieżek) umożliwia 
skonfigurowanie dla każdego typu  ścieżki, które sekcje inspektora mają być wyświetlane. Możesz 
także określić kolejność sekcji.

● Aby otworzyć okno dialogowe Track Inspector Settings, kliknij w Set up Inspector (Ustaw 
inspektora) i wybierz Setup (Ustawienia) z wyskakującego menu.
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Hidden Items (Ukryte elementy)
       Wyświetla sekcje, które są ukryte w Inspector.
Visible Items (Widoczne elementy)
       Wyświetla sekcje widoczne w Inspector.
Pin (Szpilka)
       Aktywuj Pin, klikając kolumnę sekcji, aby wykluczyć tę sekcję z automatycznego zamykania.
Add (Dodaj)
       Pozwala przenieść element wybrany z listy ukrytych sekcji na listę widocznych sekcji.
Remove (Usuń)
       Umożliwia przeniesienie elementu zaznaczonego na liście widocznych sekcji na listę ukrytych 
       sekcji.
Move Up/Move Down (Przenieś w górę/Przenieś w dół)
       Umożliwia zmianę pozycji elementu na liście widocznych sekcji.
Presets (Presety)
       Umożliwia zapisanie ustawień inspektora jako ustawień wstępnych.
Reset All (Zresetuj wszystko)
       Umożliwia przywrócenie domyślnych ustawień Inspektora.

Inspector Sections (Sekcje Inspektora)
Każdy typ ścieżki ma swoje podstawowe ustawienia ścieżki, które są zawsze widoczne. Oprócz 
tego możesz skonfigurować inne specyficzne dla ścieżki sekcje Inspectora w oknie dialogowym 
Track Inspector Settings (Ustawienia Inspektora Ścieżek).

W zależności od typu ścieżki możesz skonfigurować następujące sekcje Inspektora:

Track Versions (Wersje ścieżek)
        Umożliwia tworzenie i edytowanie wersji ścieżek.
Chords (Akordy)
       Umożliwia określenie sposobu, w jaki ścieżka podąża za ścieżką akordów.
Inserts (Wstawki)
       Umożliwia dodawanie efektów dźwiękowych do ścieżki.
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Equalizers (Korektory)
       Umożliwia dostosowanie EQ dla ścieżki. Możesz mieć do czterech pasm EQ dla każdej ścieżki.
Sends (Wysyłki)
       Umożliwia skierowanie ścieżki do jednego lub kilku kanałów FX.
Cue Sends (Wysyłanie wskazówek)
       Umożliwia kierowanie miksów cue do cue Control Room (Sterownia).
Strip (Pas)
       Umożliwia skonfigurowanie modułów paska kanałów.
Direct Routing (Kierowanie bezpośrednie)
       Umożliwia skonfigurowanie bezpośredniego routingu.
Surround Pan (Przestrzeń Panoramy)
       Wyświetla panoramę ścieżki.
Fader (Tłumik)
       Pokazuje duplikat odpowiedniego kanału MixConsole.
Notepad (Notatnik)
       Umożliwia wprowadzanie notatek dotyczących utworu.
Device Panel (Panel urządzeń)
       Umożliwia wyświetlanie i używanie paneli urządzeń.
Qwuick Controls (Szybkie sterowanie)
       Umożliwia skonfigurowanie szybkich elementów sterujących na przykład w celu korzystania 
       ze zdalnych urządzeń.
Expression Map (Mapa ekspresyjna)
       Umożliwia pracę z funkcjami Expression Map.
Note Expresion (Uwaga Wyrażenie)
       Umożliwia pracę z funkcjami Note Expression.
MIDI Modifiers (Modyfikatory MIDI)
       Umożliwia transpozycję lub regulację prędkości zdarzeń na ścieżce MIDI w czasie 
        rzeczywistym podczas odtwarzania.
MIDI Inserts (Wstawki MIDI)
       Umożliwia dodawanie efektów insertowych MIDI.
Instrument (Instrument)
       Pokazuje elementy sterujące związane z dźwiękiem dla ścieżki samplera.
MIDI Sends (Wysyłki MIDI)
       Umożliwia dodawanie efektów wysyłania MIDI.
MIDI Fader (Suwak MIDI)
       Pokazuje duplikat odpowiedniego kanału MixConsole.

POWIĄZANE LINKI
Sekcje Inspektora na stronie 64
Okno dialogowe ustawień inspektora ścieżek na stronie 112
Track Versions Section (Sekcja Wersje ścieżek) na stronie 186
Insert Effects (Efekty insertów) na stronie 445
Send Effects (Efekty wysyłania) na stronie 453
Equalizers (Korektory (EQ)) na stronie 387
Chords Section for MIDI Tracks (Sekcja akordów dla ścieżek MIDI) na stronie 958
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Sekcja akordów dla ścieżek audio na stronie 957
Cue Sends na stronie 398
Paski kanałów na stronie 390
Trasowanie bezpośrednie na stronie 399
Widoki miniatur na stronie 679
Panele urządzeń na stronie 788
Track Quick Controls (Ścieżka szybkie sterowanie) na stronie 749
Expression Maps (Mapy wyrażeń) na stronie 906
Note Expression (Uwaga Wyrażenie) na stronie 918
MIDI Modifiers Section (Sekcja Modyfikatory MIDI) na stronie 774
MIDI Inserts (Wstawki MIDI) na stronie 778
MIDI Sends (Wysyłki MIDI) na stronie 780

Track Controls Settings Dialog (Okno dialogowe ustawień sterowania 
ścieżką)
Okno dialogowe Track Controls Settings (Ustawienia sterowania ścieżką) umożliwia 
skonfigurowanie elementów sterujących ścieżki, które mają być wyświetlane na liście ścieżek. 
Możesz także określić kolejność kontrolek i kontrolek grupowych, tak aby były zawsze 
wyświetlane obok siebie.

UWAGA
Okno dialogowe Track Controls Settings (Ustawienia sterowania ścieżką) jest dostępne dla 
głównych typów ścieżek. Typy torów, które można dodać tylko raz, mają stały zestaw elementów 
sterujących specyficznych dla toru. W globalnym oknie dialogowym Add Track (Dodaj ścieżkę) te
są wyświetlane w sekcji More Tracks (Więcej ścieżek). Wyjątkiem są ścieżka akordów (chord 
track) i ścieżka wideo (video track).

● Aby otworzyć okno dialogowe Track Controls Settings (Ustawienia sterowania ścieżką), kliknij
prawym przyciskiem myszy ścieżkę na liście ścieżek i wybierz Ustawienia sterowania ścieżką z 
menu kontekstowego lub kliknij opcję Open Track Controls Settings Dialog (Otwórz okno 
dialogowe ustawień sterowania ścieżką) w prawym dolnym rogu listy ścieżek.
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Track type (Rodzaj ścieżki)
       Umożliwia wybranie typu ścieżki, do którego mają być zastosowane ustawienia.
Hidden Controls (Ukryte elementy sterujące)
       Wyświetla elementy sterujące ukryte na liście utworów.
Visible Controls (Widoczne elementy sterujące)
       Wyświetla elementy sterujące widoczne na liście utworów.
Width (Szerokość)
       Jeśli klikniesz w tej kolumnie, możesz ustawić maksymalną długość nazwy ścieżki.
Group (Grupa)
       Wyświetla numer grupy.
Add (Dodaj)
       Umożliwia przeniesienie elementu wybranego z listy ukrytych elementów sterujących na listę 
       widocznych elementów sterujących. 
Remove (Usuń)
       Umożliwia przeniesienie elementu zaznaczonego na liście widocznych elementów sterujących 
       na listę ukrytych elementów sterujących. Wszystkie elementy sterujące można usunąć z 
       wyjątkiem Mute i Solo.
Move Up/Move Down (Przenieś w górę/Przenieś w dół)
       Umożliwia zmianę kolejności elementu na liście widocznych elementów sterujących.
Group (Grupuj)
       Umożliwia zgrupowanie dwóch lub więcej kontrolek wybranych na widocznej liście kontrolek,
       które sąsiadują ze sobą. Dzięki temu są one zawsze umieszczone obok siebie na liście ścieżek.
Ungroup (Rozgrupuj)
       Umożliwia rozgrupowanie zgrupowanych kontrolek na widocznej liście kontrolek. Aby usunąć 
       całą grupę, zaznacz pierwszy (najwyższy) element należący do tej grupy i kliknij Ungroup.
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Reset (Resetuj)
       Umożliwia przywrócenie wszystkich domyślnych ustawień sterowania torem dla wybranego 
       typu ścieżki.
Controls Area Preview (Podgląd obszaru sterowania)
       Pokazuje podgląd dostosowanych elementów sterujących ścieżki.
Presets (Presety)
       Umożliwia zapisywanie ustawień sterowania ścieżką jako ustawień wstępnych. Aby przywołać 
       ustawienie wstępne, kliknij opcję Switch Presets (Przełącz ustawienia wstępne) w prawym 
       dolnym rogu listy ścieżek. Nazwa wybranego ustawienia wstępnego jest wyświetlana w lewym 
       rogu.
Controls Area Width (Kontroluje szerokość obszaru)
       Umożliwia określenie szerokości obszaru sterowania ścieżką dla wybranego typu ścieżki. 
       W podglądzie obszaru sterowania obszar ten jest wyświetlany w ramce.
Track Name Width (global) (Szerokość nazwy ścieżki (globalna))
       Umożliwia określenie globalnej szerokości nazwy dla wszystkich typów ścieżek.
Apply (Zastosuj)
       Stosuje twoje ustawienia.
Reset All (Zresetuj wszystko)
       Umożliwia przywrócenie wszystkich domyślnych ustawień sterowania torem dla wszystkich 
       typów torów.

POWIĄZANE LINKI
More Tracks (Więcej ścieżek) na stronie 151

Sterowanie ścieżkami
Możesz skonfigurować, które elementy sterujące ścieżki są wyświetlane na liście ścieżek.

UWAGA
Sterowanie ścieżką można skonfigurować tylko dla głównych typów ścieżek. Typy ścieżek, które 
można dodać tylko raz, mają stały zestaw elementów sterujących specyficznych dla ścieżki. 
W globalnym oknie dialogowym Add Track (Dodaj ścieżkę) te są wyświetlane w sekcji More 
Tracks (Więcej ścieżek). Wyjątkiem są ścieżka akordów i ścieżka wideo.

Zawsze wyświetlane są następujące elementy sterujące ścieżki:

 Mute (Wycisz)
       Wycisza utwór.

 Solo
       Solo utworu. Sterowanie nazwą ścieżki jest dostępne dla wszystkich typów ścieżek:

 Name (Nazwa)
       Wyświetla nazwę utworu. Kliknij dwukrotnie, aby zmienić nazwę ścieżki.

Ścieżki związane z Audio

Następujące kontrolki ścieżek są specyficzne dla ścieżek związanych z Audio, to znaczy ścieżek 
audio, ścieżek instrumentów, ścieżek samplera, ścieżek kanałów grupowych, ścieżek kanałów FX:
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 Bypass Inserts (Wstawki obejściowe)
       Pomija inserty dla ścieżki.

 Bypass EQs (Obejście korektorów)
       Pomija korektory ścieżki.

 Bypass Sends (Pomiń wysyłanie)
       Pomija wysyłki dla ścieżki.

 Freeze Channel (Zablokuj kanał)
       Otwiera okno dialogowe Tail Size (Rozmiar ogona), które pozwala ustawić czas Rozmiar 
       ogona w sekundach.

 Channel Configuration (Konfiguracja kanału)
       Pokazuje konfigurację kanałów ścieżki.

 Listen (Słuchaj)
       Wskaźnik słuchania świeci się, gdy ścieżka jest w trybie słuchania.

Ścieżki związane z MIDI

Następujące elementy sterujące są specyficzne dla ścieżek związanych z MIDI, czyli ścieżek MIDI,
ścieżek samplera i ścieżek instrumentów:

 ASIO Latency Compensation (Kompensacja opóźnień ASIO)
       Przesuwa wszystkie nagrane zdarzenia na ścieżce o bieżące opóźnienie.

 Programs (Programy)
       Umożliwia wybór programu.

 Edit In-Place (Edytuj na miejscu)
       Umożliwia edytowanie zdarzeń i partii MIDI na ścieżce w oknie Project.

 Drum Map (Mapa perkusyjna)
       Umożliwia wybranie mapy perkusyjnej dla ścieżki.

Ścieżki audio i MIDI

Następujące kontrolki ścieżek są specyficzne dla ścieżek audio i MIDI:

  Record Enable (Włącz nagrywanie)
       Aktywuje ścieżkę do nagrywania.

  Monitor
W przypadku ścieżek związanych z dźwiękiem kieruje sygnały przychodzące do wybranego 
wyjścia. W przypadku ścieżek MIDI i ścieżek związanych z instrumentami umożliwia to 
kierowanie przychodzących sygnałów MIDI do wybranego wyjścia MIDI. Aby to zadziałało, 
aktywuj MIDI Thru Active w oknie dialogowym Preferences (Preferencje) (strona MIDI).
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   Edit Channel Settings (Edytuj ustawienia kanału)
        Otwiera okno Ustawienia kanału dla ścieżki.

  Show Lanes (Pokaż pasy)
        Dzieli ścieżki na pasy.

  Lock (Zablokuj)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

  Read Automation (Przeczytaj automatyzację)
       Umożliwia odczyt automatyzacji ścieżek.

  Write Automation (Automatyzacja zapisu)
       Umożliwia pisanie automatyzacji ścieżek.

Ścieżki instrumentów

Następujące elementy sterujące są specyficzne dla ścieżek instrumentów:

  Edit Instrument (Edytuj instrument)
       Umożliwia otwarcie panelu Instrument.

  Instrument
       Umożliwia wybór instrumentu.

Ścieżki samplerowe

Następujące elementy sterujące są specyficzne dla ścieżek samplera:

Open/Close Sampler (Otwórz/zamknij sampler)
       Otwiera/zamyka Sampler Control (kontrolka samplera) w dolnej strefie

Ścieżki MIDI

Następujące elementy sterujące są specyficzne dla ścieżek MIDI:

  Channel (Kanał)
       Umożliwia określenie kanału MIDI.

  Output (Wyjście)
       Umożliwia określenie wyjścia dla ścieżki.

  Bypass Inserts (Pomiń wstawki)
       Pomija inserty dla ścieżki.

  Bypass Sends (Pomiń wysyłanie)
       Pomija wysyłki dla ścieżki.
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Ścieżki Group/FX/VCA

Następujące kontrolki ścieżek są specyficzne dla ścieżek Group/FX/VCA:

  Mute Automation (Wycisz Automatyzację)
        Dezaktywuje funkcję odczytu automatyki dla wybranego parametru.

  Lock Automation (Zablokuj automatyzację)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

  Automation Parameter (Parametr automatyzacji)
       Umożliwia wybór parametru do automatyzacji.

  Parameter (Parametr)
       Umożliwia wybór wartości parametru do automatyzacji.

Ścieżki znaczników (Marker Tracks)

Następujące elementy sterujące są specyficzne dla ścieżek znaczników:

  Add Marker (Dodaj znacznik)
       Umożliwia dodanie znacznika pozycji w miejscu kursora projektu. Ta kontrolka ścieżki jest 
       zawsze wyświetlana.

  Add Cycle Marker (Dodaj znacznik cyklu)
       Umożliwia dodanie znacznika cyklu w pozycji kursora projektu. Ta kontrolka ścieżki jest 
       zawsze wyświetlana.

   Locate (Znajdź)
       Umożliwia przesunięcie kursora projektu do wybranej pozycji znacznika.

  Cycle (Cykl)
       Umożliwia wybór znacznika cyklu.

  Zoom (Powiększenie)
       Umożliwia powiększenie znacznika cyklu.

   Activate this Track (Aktywuj tę ścieżkę)
       Aktywuje tę ścieżkę znacznika.

Ścieżki folderów (Folder Tracks)

Następujące elementy sterujące są specyficzne dla ścieżek folderów:

  Group Editing (Edycja grupowa)
       Umożliwia aktywację trybu edycji grupy.
Expand/Collapse Folder (Rozwiń/zwiń folder)
       Pokazuje/ukrywa utwory w folderze. Ukryte ścieżki są odtwarzane jak zwykle.
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Okno dialogowe Add Track (dodaj ścieżkę)
Okno dialogowe Add Track umożliwia konfigurowanie i dodawanie ścieżek.

Aby otworzyć okno dialogowe Dodaj ścieżkę, kliknij opcję Add Track  w globalnym obszarze 
stwerowania ścieżką na liście ścieżek.

Sekcja Add Tracks (Dodaj ścieżki) zawiera typy ścieżek, które można dodać tylko raz.

POWIĄZANE LINKI
Okno dialogowe Add Track – Audio na stronie 122
Okno dialogowe Add Track – Instrument na stronie 126
Okno dialogowe Add Track – Sampler na stronie 129
Okno dialogowe Add Track — MIDI na stronie 132
Okno dialogowe Add Track – Group Channel (kanał grupowy) na stronie 136
Okno dialogowe Add Track – Effect (Efekt) na stronie 139
Okno dialogowe Add Track – VCA na stronie 142
Okno dialogowe Add Track — Marker (Znacznik) na stronie 144
Okno dialogowe Add Track — Ruler (Linijka) na stronie 146
Okno dialogowe Add Track – Folder na stronie 148
More Tracks (Więcej ścieżek) na stronie 151
Tempo Track (Ścieżka Tempo) na stronie 157
Sygnatura Track (Ścieżka Sygnatura) na stronie 156
Arranger Track (Ścieżka aranżera) na stronie 152
Transpose Track (Ścieżka transpozycji) na stronie 158
Chord Track (Ścieżka akordów) na stronie 153
Video Track (Ścieżka wideo) na stronie 159

123



Audio Tracks (Ścieżki Audio)
Ścieżek audio można używać do nagrywania i odtwarzania zdarzeń dźwiękowych i części 
dźwiękowych. Każda ścieżka audio ma odpowiedni kanał audio w MixConsole. Ścieżka audio 
może mieć dowolną liczbę ścieżek automatyzacji do automatyzacji parametrów kanału, ustawień 
efektów itp.

Możesz dodawać ścieżki audio za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Add Track – Audio na stronie 122.

Okno dialogowe Add Track (Dodaj ścieżkę) – Audio
Strona Audio okna dialogowego Add Track umożliwia konfigurowanie i dodawanie ścieżek audio.

Aby otworzyć stronę Audio w oknie dialogowym Add Track, wykonaj jedną z następujących 
czynności:
● Kliknij Add Track w globalnym obszarze kontroli ścieżek na liście ścieżek, a następnie kliknij 
Audio. Spowoduje to otwarcie globalnego okna dialogowego Add Track na stronie Audio.

                               

● Wybierz Project > Add Track (Dodaj ścieżkę) > Audio lub kliknij prawym przyciskiem myszy 
pusty obszar listy ścieżek i wybierz Add Audio Track (Dodaj ścieżkę audio).
Spowoduje to otwarcie tylko strony Audio w oknie dialogowym Add Track (Dodaj ścieżkę).
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Dostępne są następujące ustawienia:

Audio Inputs (Wejścia audio)
      Otwiera okno, w którym można wybrać wejście podłączonego sprzętu audio. Jeśli dodałeś 
      szynę wejściową w oknie Audio Connections (Połączenia audio), możesz połączyć się z tą 
      szyną wejściową.
      Przycisk Open Audio Connections (Otwórz połączenia audio) otwiera okno Audio 
      Connections.
Configuration (Konfiguracja)
     Umożliwia ustawienie konfiguracji kanału. Ścieżki związane z dźwiękiem można skonfigurować
     jako ścieżki mono, stereo lub surround.
Audio Outputs (Wyjścia audio)
     Umożliwia ustawienie routingu wyjściowego.
Name (Nazwa)
     Umożliwia określenie nazwy utworu.
Count (w sumie)
     Umożliwia wprowadzenie liczby utworów, które chcesz dodać.
UWAGA
Możesz dodać nieograniczoną liczbę ścieżek. Jednorazowo można jednak dodać tylko 100 ścieżek.

Keep Dialog Open (Zachowaj otwarte okno dialogowe)
     Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj  
     ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
     więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę) 
z poziomu globalnych elementów sterujących ścieżki.

Add Track (Dodaj ścieżkę)
Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony, i zamyka
okno dialogowe.

POWIĄZANE LINKI
Audio Connections Window (Okno połączeń audio) na stronie 26
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Audio Track Inspector (Inspektor ścieżek audio)
Inspektor ścieżek audio zawiera elementy sterujące i parametry umożliwiające edycję ścieżki audio.

                                      

Górna sekcja Inspektora ścieżek audio zawiera następujące podstawowe ustawienia ścieżek:

  Track Name (Nazwa utworu)
     Kliknij raz, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki. Kliknij dwukrotnie, aby 
     zmienić nazwę ścieżki.

  Colorize Selected Track (Pokoloruj wybraną ścieżkę)
     Pozwala pokolorować wybraną ścieżkę.

  Edit Channel Settings (Edytuj ustawienia kanału)
     Otwiera okno Channel Settings (Ustawienia kanału) dla ścieżki.

  Mute (Wycisz)
      Wycisza utwór.

  Solo
      Solo utworu.

  Read Automation (Czytaj automatyzację)
     Umożliwia odczyt automatyzacji ścieżek.

  Write Auitomation (Automatyzacja zapisu)
     Umożliwia pisanie automatyzacji ścieżek.

  Open Device Panels (Otwórz panele urządzeń)
     Umożliwia utworzenie panelu urządzeń dla parametrów wtyczki i urządzenia na ścieżce.

  Auto Fades Setting (Ustawienia automatycznego zanikania)
     Otwiera okno dialogowe, w którym możesz wprowadzić oddzielne ustawienia zanikania dla 
      ścieżki.

   Record Enable (Włącz nagrywanie)
     Aktywuje ścieżkę do nagrywania.
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   Monitor
      Kieruje przychodzące sygnały do wybranego wyjścia.

   Toggle Time Base (Przełącz podstawę czasu)
      Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
      czasu dla utworu.

   Lock (Zamknij)
      Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Show Lanes (Pokaż pasy)
      Dzieli ścieżki na pasy.

   Freeze Audio Channel (Zamróź kanał audio)
      Umożliwia zamrożenie kanału audio.

   Volume (Głośność)
      Umożliwia regulację poziomu ścieżki.

   Pan (Panorama)
      Umożliwia regulację panoramowania ścieżki.

   Delay (Opóźnienie)
      Umożliwia dostosowanie czasu odtwarzania ścieżki.

 Load/Save/Reload Track Preset (Załaduj/zapisz/ponownie załaduj ustawienie 
ścieżki)
      Ładuje lub zapisuje ustawienie wstępne ścieżki lub przywraca ustawienia domyślne.

   Input Routing (Routing wejściowy)
      Umożliwia określenie szyny wejściowej dla ścieżki.

   Output Routing (Routing wyjściowy)
      Umożliwia określenie szyny wyjściowej dla ścieżki.

POWIĄZANE LINKI
Sekcje Inspektora na stronie 113

Instrument Tracks (Ścieżki instrumentów)
Możesz użyć ścieżek instrumentów dla dedykowanych instrumentów VST. Każda ścieżka 
instrumentu ma odpowiedni kanał instrumentu w MixConsole. Ścieżka instrumentalna może mieć 
dowolną liczbę ścieżek automatyki.

Możesz dodawać ścieżki instrumentów za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Add Track (Dodaj ścieżkę) – Instrument na stronie 126
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Okno dialogowe Add Track (Dodaj ścieżkę) – Instrument

Strona Instrument w oknie dialogowym Add Track (Dodaj ścieżkę) umożliwia konfigurowanie i 
dodawanie ścieżek instrumentów.
Aby otworzyć stronę Instrument w oknie dialogowym Add Track, wykonaj jedną z następujących
czynności:
● Kliknij Add Track w globalnym obszarze kontroli ścieżek na liście ścieżek, a następnie kliknij 
Instrument.
Spowoduje to otwarcie globalnego okna dialogowego Add Track na stronie Instrument 
(Instrument).

                       

● Wybierz Project > Add Track > Instrument (Projekt > Dodaj ścieżkę > Instrument) lub kliknij 
prawym przyciskiem myszy pusty obszar listy ścieżek i wybierz Add Instrument Track (Dodaj 
ścieżkę instrumentu).
Spowoduje to otwarcie tylko strony Instrument okna dialogowego Add Track (Dodaj ścieżkę).

                        

Dostępne są następujące ustawienia:

Instrument
      Umożliwia wybór instrumentu.
Audio Outputs (Wyjścia audio)
      Umożliwia ustawienie routingu wyjściowego.
Count (w sumie)
      Umożliwia wprowadzenie liczby ścieżek, które chcesz dodać.
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UWAGA
Możesz dodać nieograniczoną liczbę ścieżek. Jednorazowo można jednak dodać tylko 100 ścieżek.

Keep Dialog Open (Zachowaj otwarte okno dialogowe)
      Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
      ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
      więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę) 
z poziomu globalnych elementów sterujących ścieżki.

Add Track (Dodaj ścieżkę)
       Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony, 
       i zamyka okno dialogowe.

Instrument Track Inspector (Inspektor ścieżki instrumentalnej)
Inspektor ścieżek instrumentów zawiera elementy sterujące i parametry, które pozwalają 
kontrolować ścieżkę instrumentów. Pokazuje niektóre sekcje z kanałów instrumentów VST i 
ścieżek MIDI.

                               

Górna sekcja narzędzia Instrument Track Inspector zawiera następujące podstawowe ustawienia 
ścieżek:

  Track Name (Nazwa ścieżki)
       Kliknij raz, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki. Kliknij dwukrotnie, aby
       zmienić nazwę ścieżki.

  Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

  Edit Channel Settings (Edytuj ustawienia kanału)
       Otwiera okno Channel Settings (Ustawienia kanału) dla ścieżki.

  Mute (Wycisz)
       Wycisza utwór.

  Solo
       Solo utworu.
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  Read Automation (Przeczytaj automatyzację)
       Umożliwia odczyt automatyzacji ścieżek.

  Write Automation (Automatyzacja zapisu)
       Umożliwia pisanie automatyzacji ścieżek.

  Open Device Panels (Otwórz panele urządzeń)
       Umożliwia otwarcie panelu instrumentu.

  Input Transformer (Transformator wejściowy)
       Otwiera wyskakujące menu, które umożliwia przekształcanie przychodzących zdarzeń MIDI w 
        czasie rzeczywistym.

  Record Enable (Włącz nagrywanie)
      Aktywuje ścieżkę do nagrywania.

  Monitor
      Kieruje przychodzące dane MIDI do wybranego wyjścia MIDI. Aby to zadziałało, aktywuj 
      MIDI Thru Active w oknie dialogowym Preferences (Preferencje) (strona MIDI).

  Toggle Time Base (Przełącz podstawę czasu)
      Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
      czasu dla utworu.

  Lock (Zamknij)
      Wyłącza wszelką edycję wszystkich wydarzeń na ścieżce.

  Freeze Instrument Channel (Zamroź kanał instrumentu)
      Umożliwia zamrożenie instrumentu.

  Volume (Głośność)
      Umożliwia regulację poziomu ścieżki.

  Pan (Panorama)
      Umożliwia regulację panoramowania ścieżki.

  Delay (Opóźnienie)
      Umożliwia dostosowanie czasu odtwarzania ścieżki.

  Show Lanes (Pokaż pasy)
      Dzieli tory na pasy.

  Load/Save/Reload Track Preset (Załaduj/zapisz/ponownie załaduj ustawienie 
                                                                                        ścieżki)
      Ładuje lub zapisuje ustawienie wstępne ścieżki lub przywraca ustawienia domyślne.

  Input Routing (Routing wejściowy)
      Umożliwia określenie magistrali wejściowej dla ścieżki.
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  Activate Outputs (Aktywuj wyjścia)
      To sterowanie jest dostępne tylko wtedy, gdy urządzenie udostępnia więcej niż jedno wyjście.    
      Pozwala aktywować jedno lub więcej wyjść dla instrumentu.

  Edit Instrument (Edytuj instrument)
      Umożliwia otwarcie panelu instrumentu.

   Programs (Programy)
      Umożliwia wybór programu.

   Drum Maps (Mapy perkusyjne)
      Umożliwia wybranie mapy perkusyjnej dla ścieżki.

POWIĄZANE LINKI
Sekcje Inspektora na stronie 113

Sampler Tracks (Samplerowe ścieżki)
Ścieżek samplera można używać do sterowania odtwarzaniem próbek audio przez MIDI. Każda 
ścieżka samplera ma odpowiedni kanał w MixConsole. Ścieżka samplera może mieć dowolną 
liczbę ścieżek automatyzacji.

Ścieżki samplera można dodawać za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Dodaj ścieżkę  – Sampler na stronie 129
Tworzenie ścieżek samplera na stronie 589
Sterowanie samplerem na stronie 589

Okno dialogowe Dodaj ścieżkę  – Sampler (Add Track – Sampler)

Strona Sampler okna dialogowego Add Track (Dodaj ścieżkę) umożliwia konfigurowanie i 
dodawanie ścieżek samplera.

Aby otworzyć stronę Sampler okna dialogowego Add Track, wykonaj jedną z następujących 
czynności:
● Kliknij opcję Add Track w globalnym obszarze kontroli ścieżek na liście ścieżek, a następnie 
kliknij opcję Sampler.
Spowoduje to otwarcie globalnego okna dialogowego Add Track na stronie Sampler.
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● Wybierz Project > Add Track (Dodaj ścieżkę) > Sampler lub kliknij prawym przyciskiem 
myszy pusty obszar listy ścieżek i wybierz Add Sampler Track (Dodaj ścieżkę samplera).
Spowoduje to otwarcie tylko strony Sampler okna dialogowego Add Track (Dodaj ścieżkę).

                          

Dostępne są następujące ustawienia:

Name (Nazwa)
       Umożliwia określenie nazwy utworu.
Count (w sumie)
       Umożliwia wprowadzenie liczby utworów, które chcesz dodać.
Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę) 
z poziomu globalnych elementów sterujących ścieżki.

Add Track (Dodaj ścieżkę)
Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony i zamyka 
okno dialogowe.
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Sampler Track Inspector (Inspektor ścieżki samplerowej)
Inspektor ścieżek samplera zawiera elementy sterujące i parametry umożliwiające edycję ścieżki 
samplera.

                       

Górna sekcja Inspektora ścieżki samplera zawiera następujące podstawowe ustawienia ścieżki:

   Track Name (Nazwa utworu)
       Kliknij raz, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki. Kliknij dwukrotnie, aby
       zmienić nazwę ścieżki.

  Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

   Edit Channel Settings (Edytuj ustawienia kanału)
       Otwiera okno Channel Settings (Ustawienia kanału) dla ścieżki.

   Mute (Wycisz)
       Wycisza utwór.

   Solo
       Solo utworu.

   Read Automation (Przeczytaj automatyzację)
       Umożliwia odczyt automatyzacji ścieżek.

   Write Automation (Automatyzacja zapisu)
       Umożliwia pisanie automatyzacji ścieżek.

   Input Transformer (Transformator wejściowy)
       Otwiera wyskakujące menu, które umożliwia przekształcanie przychodzących zdarzeń MIDI w 
       czasie rzeczywistym.

   Record Enable (Włącz nagrywanie)
       Aktywuje ścieżkę do nagrywania.

   Monitor
       Kieruje przychodzące dane MIDI do wybranego wyjścia MIDI. Aby to zadziałało, aktywuj 
       MIDI Thru Active w oknie dialogowym Preferences (Preferencje) (strona MIDI).
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  Toggle Time Base (Przełącz podstawę czasu)
       Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
       czasu dla ścieżki.

  Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

  Show Lanes (Pokaż pasy)
       Dzieli tory na pasy.

   Freeze Sampler Channel (Zamroź kanał samplera)
       Umożliwia zamrożenie ścieżki samplera.

  Volume (Głośność)
       Umożliwia regulację poziomu ścieżki.

  Pan (Panorama)
       Umożliwia regulację panoramowania ścieżki.

  Delay (Opóźnienie)
       Umożliwia dostosowanie czasu odtwarzania ścieżki.

  Load/Save/Reload Truck Preset (Załaduj/zapisz/ponownie załaduj ustawienie 
ścieżki)
       Ładuje lub zapisuje ustawienie wstępne ścieżki lub przywraca ustawienia domyślne.

 Input Routing (Routing wejściowy)
       Umożliwia określenie magistrali wejściowej dla ścieżki.

POWIĄZANE LINKI
Sekcje inspektora na stronie 113

MIDI Tracks (Ścieżki MIDI)
Ścieżek MIDI można używać do nagrywania i odtwarzania partii MIDI. Każda ścieżka MIDI ma 
odpowiedni kanał MIDI w MixConsole. Ścieżka MIDI może zawierać dowolną liczbę ścieżek 
automatyzacji.

Możesz dodawać ścieżki MIDI za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Add Track (dodaj ścieżkę) — MIDI na stronie 132

Okno dialogowe Add Track (dodaj ścieżkę) — MIDI

Strona MIDI okna dialogowego Add Track (Dodaj ścieżkę) umożliwia konfigurowanie i 
dodawanie ścieżek MIDI.

Aby otworzyć stronę MIDI okna dialogowego Add Track, wykonaj jedną z następujących 
czynności:

● Kliknij Add Track    w globalnym obszarze kontroli ścieżek na liście ścieżek, a następnie 
kliknij MIDI.
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Spowoduje to otwarcie globalnego okna dialogowego Add Track (Dodaj ścieżkę) na stronie MIDI.

                                 

● Wybierz Project > Add Track (Dodaj ścieżkę) > MIDI lub kliknij prawym przyciskiem myszy 
pusty obszar listy ścieżek i wybierz Add MIDI Track (Dodaj ścieżkę MIDI).
Spowoduje to otwarcie tylko strony MIDI okna dialogowego Add Track (Dodaj ścieżkę).

                                   

Dostępne są następujące ustawienia:

Name (Nazwa)
       Umożliwia określenie nazwy ścieżki.
Count (w sumie)
       Umożliwia wprowadzenie liczby ścieżek, które chcesz dodać.
UWAGA
Możesz dodać nieograniczoną liczbę ścieżek. Jednorazowo można jednak dodać tylko 100 ścieżek.

Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę) z 
poziomu globalnych elementów sterujących ścieżki.
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Add Track (Dodaj ścieżkę)
       Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony, 
       i zamyka okno dialogowe.

MIDI Track Inspector (Inspektor Ścieżek MIDI)
Inspector ścieżek MIDI zawiera elementy sterujące i parametry umożliwiające sterowanie ścieżką 
MIDI. Mają one wpływ na zdarzenia MIDI w czasie rzeczywistym, na przykład podczas 
odtwarzania.

                           

Górna sekcja Inspektora ścieżek MIDI zawiera następujące podstawowe ustawienia ścieżek:

  Track Name (Nazwa utworu)
       Kliknij raz, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki. Kliknij dwukrotnie, aby
       zmienić nazwę ścieżki.

  Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

  Edit Channel Settings (Edytuj ustawienia kanału)
       Otwiera okno Channel Settings (Ustawienia kanału) dla ścieżki.

  Mute (Wycisz)
       Wycisza utwór.

  Solo
      Solo utworu.

  Read Automation (Przeczytaj automatyzację)
      Umożliwia odczyt automatyzacji ścieżek.

  Write Automation (Pisz Automatyzację)
      Umożliwia pisanie automatyzacji ścieżek.

  Open Device Panels (Otwórz panele urządzeń)
      Umożliwia otwarcie panelu instrumentu.

  Input Transformer (Transformator wejściowy)
      Otwiera wyskakujące menu, które umożliwia przekształcanie przychodzących zdarzeń MIDI 
       w czasie rzeczywistym.
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   Record Enable (Włącz nagrywanie)
       Aktywuje ścieżkę do nagrywania.

   Monitor
       Kieruje przychodzące dane MIDI do wybranego wyjścia MIDI. Aby to zadziałało, aktywuj 
       MIDI Thru Active w oknie dialogowym Preferences (Preferencje) (strona MIDI).

   Toggle Time Base (Przełącz podstawę czasu)
       Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
       czasu dla utworu.

   Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Show Lanes (Pokaż pasy)
       Dzieli tory na pasy.

   Volume (Głośność)
       Umożliwia regulację poziomu ścieżki.

  MIDI Pan (Panorama MIDI)
       Umożliwia dostosowanie panoramy MIDI ścieżki.

   Delay (Opóźnienie)
       Umożliwia dostosowanie czasu odtwarzania ścieżki.

   Load/Save/Reload Track Preset (Załaduj/zapisz/ponownie załaduj ustawienie 
ścieżki)
       Ładuje lub zapisuje ustawienie wstępne ścieżki lub przywraca ustawienia domyślne.

   Input Routing (Routing wejściowy)
       Umożliwia określenie magistrali wejściowej dla ścieżki.

   Output Routing (Routing wyjściowy)
       Umożliwia określenie szyny wyjściowej dla ścieżki.

   Channel (Kanał)
       Umożliwia określenie kanału MIDI.

   Edit Instrument (Edytuj instrument)
       Umożliwia otwarcie panelu instrumentu.

   Bank Selector (Selektor banku)
       Umożliwia ustawienie komunikatu wyboru banku, który jest wysyłany do urządzenia MIDI.
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Programs (Programy)
       Umożliwia wybór programu.
Program Selector (Selektor programów)
       Umożliwia ustawienie komunikatu o zmianie programu, który jest wysyłany do urządzenia 
       MIDI.
Drum Maps (Mapy perkusyjne)
       Umożliwia wybranie mapy perkusyjnej dla ścieżki.

POWIĄZANE LINKI
Sekcje Inspektora na stronie 113

Group Channel Tracks (Ścieżki Kanału Grupowego)
Możesz użyć ścieżek kanałów grupowych, aby utworzyć podmiks kilku kanałów audio 
i zastosować do nich te same efekty. Ścieżka kanału grupowego nie zawiera żadnych zdarzeń jako 
takich, ale wyświetla ustawienia i automatyzację dla odpowiedniego kanału grupowego.

Wszystkie ścieżki kanałów grupowych są automatycznie umieszczane w specjalnym folderze 
ścieżek grupowych na liście ścieżek, co ułatwia zarządzanie. Każda ścieżka kanału grupowego ma 
odpowiedni kanał w MixConsole. Ścieżka kanału grupowego może mieć dowolną liczbę ścieżek 
automatyzacji.

Możesz dodawać ścieżki kanału grupowego za pomocą okna dialogowego Add Track (Dodaj 
ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Add Track (dodaj ścieżkę) – Group Channel (kanał grupowy) na stronie 136

Okno dialogowe Add Track (dodaj ścieżkę) – Group Channel (kanał 
grupowy)

Strona Group (Grupa) okna dialogowego Add Track (Dodaj ścieżkę) umożliwia konfigurowanie i 
dodawanie grupowych ścieżek kanałów.

Aby otworzyć stronę Group w oknie dialogowym Add Track, wykonaj jedną z następujących 
czynności:

● Kliknij Add Track w globalnym obszarze kontroli ścieżek na liście ścieżek i kliknij Group. 
Spowoduje to otwarcie globalnego okna dialogowego Add Track (Dodaj ścieżkę) na stronie 
Group.
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● Wybierz Project > Add Track (Dodaj ścieżkę) > Group (Grupa).
Spowoduje to otwarcie tylko strony Group w oknie dialogowym Add Track.

                               

Dostępne są następujące ustawienia:

Configuration (Konfiguracja)
       Umożliwia ustawienie konfiguracji kanału. Ścieżki związane z Audio można skonfigurować  
       jako ścieżki mono, stereo lub surround.
Asudio Outputs (Wyjścia audio)
       Umożliwia ustawienie routingu wyjściowego.
Folder Setup (Konfiguracja folderów)
       Pozwala wybrać, czy efekt ma być tworzony w dedykowanym folderze, czy poza nim.
Name (Nazwa)
       Umożliwia określenie nazwy ścieżki.
Count (w sumie)
       Umożliwia wprowadzenie liczby ścieżek, które chcesz dodać.
Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
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UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę) z 
poziomu globalnych elementów sterujących ścieżki.

Add Track (Dodaj ścieżkę)
       Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony i 
       zamyka okno dialogowe.

Group Channel Track Inspector (Inspektor ścieżek kanału 
grupowego)
Inspektor ścieżek kanału grupowego pokazuje ustawienia kanału grupowego.

                              

   Track Name (Nazwa ścieżki)
       Kliknij raz, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki. Kliknij dwukrotnie, aby
       zmienić nazwę ścieżki.

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

   Edit Channel Settings (Edytuj ustawienia kanału)
       Otwiera okno Channel Settings (Ustawienia kanału) dla ścieżki.

   Mute (Wycisz)
       Wycisza utwór.

   Solo
       Solo utworu.

   Read Automation (Przeczytaj automatyzację)
       Umożliwia odczyt automatyzacji ścieżek.

   Write Automation (Automatyzacja zapisu)
       Umożliwia pisanie automatyzacji ścieżek.

   Toggle Time Base (Przełącz podstawę czasu)
       Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
       czasu dla utworu.

   Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.
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   Volume (Głośność)
       Umożliwia regulację poziomu toru.

   Pan (Panorama)
       Umożliwia regulację panoramowania ścieżki.

   Output Routing (Routing wyjściowy)
       Umożliwia określenie szyny wyjściowej dla ścieżki.

UWAGA
Gdy zamiast tego wybierzesz ścieżkę folderu grupowego, Inspector pokaże folder i zawarte w nim 
kanały grupowe. Możesz kliknąć jeden z kanałów grupowych pokazanych w folderze, aby 
Inspektor pokazał ustawienia dla tego kanału grupowego.

           

POWIĄZANE LINKI
Sekcje Inspektora na stronie 113

FX Channel Tracks (Ścieżki kanałów FX)
Możesz użyć ścieżek kanałów FX do dodawania efektów wysyłania. Każdy kanał FX może 
zawierać do ośmiu procesorów efektów. Kierując wysyłki z kanału audio do kanału FX, przesyłasz 
dźwięk z kanału audio do efektów na kanale FX. Ścieżki kanałów FX można umieszczać w 
specjalnym folderze kanałów FX lub na liście ścieżek poza folderem kanałów FX. Każdy kanał FX 
ma odpowiedni kanał w MixConsole. Ścieżka kanału FX może mieć dowolną liczbę ścieżek 
automatyzacji.

Możesz dodawać ścieżki kanałów FX za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Add Track Dialog (Okno dialogowe Dodaj ścieżkę) – Effect (Efekt) na stronie 139

Add Track Dialog (Okno dialogowe Dodaj ścieżkę) – Effect (Efekt)

Strona Effect (Efekt) okna dialogowego Add Track (Dodaj ścieżkę) umożliwia konfigurowanie i 
dodawanie ścieżek kanałów FX.
Aby otworzyć stronę Effect w oknie dialogowym Add Track, wykonaj jedną z następujących 
czynności:

● Kliknij   Add Track (Dodaj ścieżkę) w globalnym obszarze kontroli ścieżek na liście 
ścieżek, a następnie kliknij Effect (Efekt).
Spowoduje to otwarcie globalnego okna dialogowego Add Track na stronie Efekt.
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● Wybierz Project > Add Track (Dodaj ścieżkę) > Effect (Efekt).
Spowoduje to otwarcie tylko strony Effect okna dialogowego Add Track (Dodaj ścieżkę).

                                               

Dostępne są następujące ustawienia:

Effect (Efekt)
       Umożliwia wybór efektu.
Configuration (Konfiguracja)
       Umożliwia ustawienie konfiguracji kanału. Ścieżki związane z dźwiękiem można 
       skonfigurować jako ścieżki mono, stereo lub surround.
Audio Outputs (Wyjścia audio)
       Umożliwia ustawienie routingu wyjściowego.
Folder Setup (Konfiguracja folderów)
       Pozwala wybrać, czy efekt ma być tworzony w dedykowanym folderze, czy poza nim.
Name (Nazwa)
       Umożliwia określenie nazwy ścieżki.
Count (w sumie)
       Umożliwia wprowadzenie liczby utworów, które chcesz dodać.
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Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę)      
z poziomu globalnych elementów sterujących ścieżki.

Add Track (Dodaj ścieżkę)
       Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony i 
       zamyka okno dialogowe.

POWIĄZANE LINKI
Dodawanie ścieżek kanału FX na stronie 454
Dodawanie kanałów FX do wybranych kanałów na stronie 455

Inspektor ścieżek kanałów FX
Inspektor ścieżek kanału FX pokazuje ustawienia kanału FX. Gdy zamiast tego wybierzesz ścieżkę
folderu, Inspector pokaże folder i zawarte w nim kanały FX. Możesz kliknąć jeden z kanałów FX 
pokazanych w folderze, aby Inspektor pokazał ustawienia dla tego kanału FX.

                 

  Track Name (Nazwa ścieżki)
       Kliknij raz, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki. Kliknij dwukrotnie, aby
       zmienić nazwę ścieżki.

  Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

  Edit Channel Settings (Edytuj ustawienia kanału)
       Otwiera okno Channel Settings (Ustawienia kanału) dla ścieżki.

  Mute (Wycisz)
       Wycisza utwór.

  Solo
       Solo utworu.

   Read Automation (Przeczytaj automatyzację)
       Umożliwia odczyt automatyzacji ścieżek.

   Write Automation (Pisz Automatyzację)
       Umożliwia pisanie automatyzacji ścieżek.
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   Toggle Time Base (Przełącz podstawę czasu)
        Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
        czasu dla utworu.

   Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich wydarzeń na ścieżce.

   Volume (Głośność)
       Umożliwia regulację poziomu ścieżki.

   Pan (Panorama)
       Umożliwia regulację panoramowania ścieżki.

   Output Routing (Routing wyjściowy)
       Umożliwia określenie szyny wyjściowej dla ścieżki.

POWIĄZANE LINKI
Sekcje inspektora na stronie 113

VCA Fader Track (Ścieżka suwaka (tłumika) VCA)
Możesz użyć ścieżki suwaka VCA, aby dodać suwaki VCA do swojego projektu.
Możesz dodać ścieżki tłumika VCA za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Add Track – VCA (Dodaj ścieżkę  – VCA) na stronie 142
Suwaki VCA na stronie 419
Automatyzacja tłumików VCA na stronie 423
Automatyzacja na stronie 705

Okno dialogowe Add Track – VCA (Dodaj ścieżkę  – VCA)
Strona VCA okna dialogowego Add Track (Dodaj ścieżkę) umożliwia skonfigurowanie i dodanie 
ścieżek tłumika VCA.

Aby otworzyć stronę VCA okna dialogowego Add Track, wykonaj jedną z następujących 
czynności:

● Kliknij Add Track w globalnym obszarze kontroli ścieżek na liście ścieżek, a następnie kliknij 
VCA.
Spowoduje to otwarcie globalnego okna dialogowego Add Track na stronie VCA.
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● Wybierz Project > Add Track (Dodaj ścieżkę) > VCA.
Spowoduje to otwarcie tylko strony VCA okna dialogowego Add Track.

                              

Dostępne są następujące ustawienia:

Folder Setup (Konfiguracja folderów)
       Pozwala wybrać, czy efekt ma być tworzony w dedykowanym folderze, czy poza nim.
Name (Nazwa)
       Umożliwia określenie nazwy utworu.
Count (w sumie)
       Umożliwia wprowadzenie liczby ścieżek, które chcesz dodać.
Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę) z 
poziomu globalnych elementów sterujących ścieżki.

Add Track (Dodaj ścieżkę)
       Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony i 
       zamyka okno dialogowe.
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VCA Fader Track Inspector (Inspektor ścieżek suwaków VCA)
Inspektor ścieżek tłumików (suwaków) VCA pokazuje ustawienia tłumików VCA.

                       

   Track Name (Nazwa ścieżki)
       Kliknij raz, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki. Kliknij dwukrotnie, aby
       zmienić nazwę ścieżki.

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

   Read Automation (Czytaj automatyzację)
       Umożliwia odczyt automatyzacji ścieżek.

   Write Automation (Pisz automatyzację)
       Umożliwia pisanie automatyzacji ścieżek.

   Toggle Time Base (Przełącz podstawę czasu)
       Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
       czasu dla utworu.

   Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Volume (Głośność)
       Umożliwia regulację poziomu ścieżki.

POWIĄZANE LINKI
Sekcje inspektorów na stronie 113

Marker Track (Ścieżka znaczników)

Za pomocą ścieżek znaczników można dodawać i edytować znaczniki, które pomogą szybko 
zlokalizować określone pozycje.
Możesz dodać znaczniki ścieżek za pomocą okna dialogowego Add Track (Dodaj ścieżkę).
Do projektu można dodać maksymalnie 10 ścieżek znaczników.

POWIĄZANE LINKI
Okno dialogowe dodawania ścieżki — znacznik (Add Track – Marker) na stronie 144

Okno dialogowe dodawania ścieżki — znacznik (Add Track – 
Marker)
Strona Marker (Znacznik) w oknie dialogowym Add Track (Dodaj ścieżkę) umożliwia 
konfigurowanie i dodawanie ścieżek znaczników.
Aby otworzyć stronę Marker w oknie dialogowym Add Track, wykonaj jedną z następujących 
czynności:
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● Kliknij opcję Add Track (Dodaj ścieżkę) w globalnym obszarze kontroli ścieżek na liście 
ścieżek, a następnie kliknij opcję Marker (Znacznik).
Spowoduje to otwarcie globalnego okna dialogowego Add Track na stronie Marker (Znacznik).

                            
● Wybierz Project > Add Track > Marker (Projekt > Dodaj ślad > Znacznik).
Spowoduje to otwarcie tylko strony Marker w oknie dialogowym Add Track.

                              

Dostępne są następujące ustawienia:

Name (Nazwa)
       Umożliwia określenie nazwy ścieżki.
Count (w sumie)
       Umożliwia wprowadzenie liczby utworów, które chcesz dodać.
Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track z poziomu 
globalnych elementów sterujących ścieżki.
Add Track (Dodaj ścieżkę)
Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony
i zamyka okno dialogowe.

POWIĄZANE LINKI
Marker Track (Ścieżka znaczników) na stronie 144
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Marker Track Inspector (Inspektor Ścieżki Znaczników)
Inspektor ścieżek znaczników wyświetla listę znaczników.

                                 

   Track Name (Nazwa ścieżki)
       Kliknij dwukrotnie, aby zmienić nazwę ścieżki.

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

   Open Marker Window (Otwórz okno znaczników)
       Otwiera okno Markers (Znaczniki).

   Marker attributes (Atrybuty znaczników)
       Pokazuje znaczniki, ich identyfikatory i pozycje czasowe. Kliknij znacznik w skrajnej lewej 
       kolumnie, aby przesunąć kursor projektu do pozycji znacznika.

POWIĄZANE LINKI
Sekcje inspektorów na stronie 113

Ruler Track (Ścieżka linijki)
Możesz użyć ścieżek linijek, aby pokazać kilka linijek z różnymi formatami wyświetlania osi czasu.
Jest to całkowicie niezależne od linijki głównej, a także linijek i pozycji wyświetlanych w innych 
oknach.

Możesz dodać ścieżki linijki za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Add Track – Ruler (Dodaj ścieżkę — linijka) na stronie 146

Okno dialogowe Add Track – Ruler (Dodaj ścieżkę — linijka)

Strona Ruler (Linijka) okna dialogowego Add Track (Dodaj ścieżkę) umożliwia konfigurowanie i 
dodawanie ścieżek linijki.
Aby otworzyć stronę Ruler w oknie dialogowym Add Track, wykonaj jedną z następujących 
czynności:

● Kliknij Add Track w globalnym obszarze kontroli ścieżek na liście ścieżek, a następnie kliknij 
Ruler.
Spowoduje to otwarcie globalnego okna dialogowego Add Track (Dodaj ścieżkę) na stronie Ruler 
(Linijka).

149



                              

● Wybierz Project > Add Track > Ruler (Projekt > Dodaj ścieżkę > Linijka).
Spowoduje to otwarcie tylko strony Ruler w oknie dialogowym Add Track.

                                

Dostępne są następujące ustawienia:

Count (w sumie)
        Umożliwia wprowadzenie liczby ścieżek, które chcesz dodać.
Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj  
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track z poziomu 
globalnych elementów sterujących ścieżki

Add Track (Dodaj ścieżkę)
        Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony i 
        zamyka okno dialogowe.

Ruler Track Controls (Sterowanie ścieżką linijki)
Na liście ścieżek dla ścieżek linijki możesz zmienić format wyświetlania linijki.
Kliknij format wyświetlania, aby otworzyć wyskakujące menu.
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Dostępne są następujące formaty wyświetlania:

Bars+Beats (Takty + Uderzenia)
       Aktywuje format wyświetlania taktów, uderzeń, szesnastek i tyknięć. Domyślnie na szesnastkę 
       przypada 120 tyknięć. Aby to zmienić, zmień MIDI Display Resolution (rozdzielczość 
       wyświetlacza MIDI) w oknie dialogowym Preferences (Preferencje) (strona MIDI).
Seconds (Sekundy)
       Aktywuje format wyświetlania godzin, minut, sekund i milisekund.
Timecode (Kod czasowy)
       Aktywuje format wyświetlania godzin, minut, sekund i ramek. Liczba klatek na sekundę (fps) 
       jest ustawiana w oknie dialogowym Project Setup (Ustawienia projektu) z wyskakującym 
       menu Project Frame Rate (Szybkość klatek projektu). Aby wyświetlić ramki podrzędne, 
       aktywuj opcję Show Timecode Subframes (Pokaż ramki podrzędne kodu czasowego) w oknie
       dialogowym Preferences (Preferencje) (strona Transport).
Samples (Próbki)
       Aktywuje format wyświetlania sampli.
fps (User) (fps (użytkownik))
       Aktywuje format wyświetlania godzin, minut, sekund i klatek ze zdefiniowaną przez 
      użytkownika liczbą klatek na sekundę. Aby wyświetlić ramki podrzędne, aktywuj opcję Show 
      Timecode Subframes (Pokaż ramki podrzędne kodu czasowego) w oknie dialogowym 
      Preferences (Preferencje) (strona Transport). Na stronie Transport możesz także ustawić 
       liczbę klatek na sekundę.
UWAGA
Ustawienie formatu wyświetlania w oknie dialogowym Project Setup (Ustawienia projektu) nie ma
wpływu na ścieżki linijki.

Folder Tracks (Ścieżki folderów)
Ścieżki folderów działają jako kontenery dla innych ścieżek, ułatwiając organizowanie i 
zarządzanie strukturą ścieżek. Pozwalają również na edycję kilku utworów jednocześnie.

Możesz dodać ścieżki folderu za pomocą okna dialogowego Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe Add Track – Folder (Dodaj ścieżkę — folder) na stronie 148

Okno dialogowe Add Track – Folder (Dodaj ścieżkę — folder)
Strona Folder okna dialogowego Add Track (Dodaj ścieżkę) umożliwia konfigurowanie 
i dodawanie ścieżek folder.

Aby otworzyć stronę Folder w oknie dialogowym Add Track, wykonaj jedną z następujących 
czynności:

● Kliknij opcję Add Track (Dodaj ścieżkę) w globalnym obszarze kontroli ścieżek na liście 
ścieżek, a następnie kliknij opcję Folder.
Spowoduje to otwarcie globalnego okna dialogowego Add Track na stronie Folder.
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● Wybierz Project > Add Track > Folder (Projekt > Dodaj ścieżkę > Folder).
Spowoduje to otwarcie tylko strony Folder w oknie dialogowym Add Track (Dodaj ścieżkę).

                              

Dostępne są następujące ustawienia:

Name (Nazwa)
       Umożliwia określenie nazwy utworu.
Count (w sumie)
       Umożliwia wprowadzenie liczby ścieżek, które chcesz dodać.
Keep Dialog Open (Zachowaj otwarte okno dialogowe)
       Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Add Track (Dodaj 
       ścieżkę). Dzięki temu możesz kliknąć stronę innego typu ścieżki, aby skonfigurować i dodać 
       więcej ścieżek.
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy otworzysz okno dialogowe Add Track (Dodaj ścieżkę) 
z poziomu globalnych elementów sterujących ścieżki.

Add Track (Dodaj ścieżkę)
Dodaje jedną lub więcej ścieżek, zgodnie z typem ścieżki i ustawieniami aktywnej strony i zamyka 
okno dialogowe.
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Folder Track Inspector (Inspektor ścieżki folder)
Inspektor ścieżek folderów pokazuje folder i jego ścieżkę, podobnie jak struktura folderów 
w Eksploratorze plików/wyszukiwarce macOS. Gdy wybierzesz jedną ze ścieżek pokazanych w 
folderze, Inspektor pokaże ustawienia dla tej ścieżki.

   Track Name (Nazwa utworu)
       Kliknij dwukrotnie, aby zmienić nazwę ścieżki.

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

   Mute (Wycisz)
       Wycisza utwór.

   Solo
       Solo utworu.

   Record Enable (Włącz nagrywanie)
       Aktywuje ścieżkę do nagrywania.

   Monitor
       W przypadku ścieżek związanych z dźwiękiem kieruje sygnały przychodzące do wybranego 
       wyjścia. W przypadku ścieżek MIDI i ścieżek związanych z instrumentami umożliwia to 
       kierowanie przychodzących sygnałów MIDI do wybranego wyjścia MIDI. Aby to zadziałało, 
       aktywuj MIDI Thru Active w oknie dialogowym Preferences (Preferencje) (strona MIDI).

   Group Editing (Edycja grupowa)
       Umożliwia aktywację trybu edycji grupy.

   Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich wydarzeń na ścieżce.

POWIĄZANE LINKI
Sekcje inspektora na stronie 113
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Sterowanie ścieżkami folderów
Lista utworów dla utworów w folderze zawiera elementy sterujące i parametry umożliwiające 
edycję wszystkich ścieżek w folderze.

        

Expand/Collapse Folder (Rozwiń/zwiń folder)
       Pokazuje/ukrywa utwory w folderze. Ukryte ścieżki są odtwarzane jak zwykle.

   Track Name (Nazwa utworu)
       Kliknij dwukrotnie, aby zmienić nazwę ścieżki.

   Mute (Wycisz)
       Wycisza ścieżkę.

   Solo
       Solo utworu.

   Record Enable (Włącz nagrywanie)
       Aktywuje ścieżkę do nagrywania.

   Monitor
       W przypadku ścieżek związanych z dźwiękiem kieruje sygnały przychodzące do wybranego 
       wyjścia. W przypadku ścieżek MIDI i ścieżek związanych z instrumentami umożliwia to 
       kierowanie przychodzących sygnałów MIDI do wybranego wyjścia MIDI. Aby to zadziałało, 
       aktywuj MIDI Thru Active w oknie dialogowym Preferences (Preferencje) (strona MIDI).

   Group Editing (Edytowanie grupy)
       Umożliwia aktywację trybu edycji grupy.

   Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce

More Tracks (Więcej ścieżek)

Niektóre typy ścieżek można dodać tylko raz.

● Ścieżkę tempa (Tempo track)
● Ścieżkę sygnatury (Signature track)
● Ścieżkę aranżera (Arranger track)
● Ścieżkę transpozycji (Transpose track)
● Ścieżkę akordów (Chord track)
● Ścieżkę wideo (Video track)
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Arranger Track (Ścieżka aranżera)
Możesz użyć ścieżki aranżera do aranżacji swojego projektu, zaznaczając sekcje i określając, w 
jakiej kolejności mają być odtwarzane.

● Aby dodać ścieżkę aranżera do projektu, wybierz kolejno Project > Add Track > Arranger 
(Projekt > Dodaj ścieżkę > Aranżer).

Inspektor ścieżki aranżera
Inspektor ścieżek aranżerów wyświetla listę dostępnych łańcuchów aranżerów i zdarzeń 
aranżerów.

                                      

Inspektor ścieżek aranżera zawiera następujące ustawienia:

   Track Name (Nazwa utworu)
       Kliknij dwukrotnie, aby zmienić nazwę ścieżki.

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
       Pozwala pokolorować wybraną ścieżkę.

   Open Arranger Editor (Otwórz edytor aranżacji)
       Otwiera edytor aranżacji (Arranger Editor).

   Select Active Arranger Chain + Functions (Wybierz aktywny łańcuch 
aranżera + funkcje)
       Umożliwia wybranie aktywnego łańcucha aranżerów, zmianę jego nazwy, utworzenie nowego, 
       zduplikowanie lub spłaszczenie.

155



   Current Arranger Chain (Obecny łańcuch aranżerów)
       Pokazuje aktywny łańcuch aranżerów.

   Arranger Events (Zdarzenia aranżerskie)
       Wyświetla listę wszystkich zdarzeń aranżera w Twoim projekcie. Kliknij strzałkę zdarzenia 
       aranżera, aby je odtworzyć i uruchomić tryb na żywo.

   Stop
       Umożliwia zatrzymanie trybu na żywo.

   Jump Mode (Tryb skoku)
       Pozwala określić, jak długo aktywne zdarzenie aranżera ma być odtwarzane przed przejściem 
       do następnego.

Elementy sterujące ścieżki aranżera
Lista ścieżek ścieżki aranżera zawiera elementy sterujące i parametry umożliwiające edycję ścieżki 
aranżera.

                      

   Select Active Arranger Chain (Wybierz łańcuch aktywnego aranżera)
       Umożliwia wybór aktywnego łańcucha aranżerów.

   Current Item/Current Repeat (Bieżąca pozycja/Bieżące powtórzenie)
       Wyświetla, które zdarzenie aranżera i które powtórzenie jest aktywne.

   Activate Arranger Mode (Aktywuj tryb aranżera)
       Umożliwia włączanie i wyłączanie trybu aranżera.

   Toggle Time Base (Przełącz podstawę czasu)
       Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
       czasu dla utworu.

   Open Arranger Editor (Otwórz edytor aranżacji)
       Otwiera Arranger Editor (Edytor aranżera) dla ścieżki.

Ścieżka akordowa (Chord Track)
Ścieżki akordów można używać do dodawania do projektu zdarzeń akordów i skali. Mogą one 
zmienić tony innych zdarzeń.

● Aby dodać ścieżkę akordów do projektu, wybierz Project > Add Track > Chord (Projekt > 
Dodaj ścieżkę > Akord).
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Chord Track Inspector (Inspektor ścieżek akordów)
Inspektor ścieżki akordów zawiera ustawienia zdarzeń akordów.

                                    

Górna sekcja Inspektora ścieżki akordów zawiera następujące ustawienia:

   Track Name (Nazwa utworu)
        Kliknij, aby pokazać/ukryć sekcję podstawowych ustawień ścieżki.

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
        Pozwala pokolorować wybraną ścieżkę.

   Mute Chord Track (Wycisz ścieżkę akordów)
       Wycisza utwór.

   Record Enable (Włącz nagrywanie)
       Aktywuje ścieżkę do nagrywania.

   Acoustic Feedback (Sprzężenie akustyczne)
       Umożliwia odsłuchiwanie zdarzeń na ścieżce akordów. Aby to zadziałało, musisz wybrać 
       utwór do przesłuchania na liście utworów.

   Toggle Time Base (Przełącz podstawę czasu)
       Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
       czasu dla utworu.

   Lock (Zamknij)
       Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Voicing library (Biblioteka głosowa)
       Umożliwia skonfigurowanie biblioteki brzmień dla ścieżki.

   Voicing library subset (Podzbiór biblioteki dźwięczności)
       Umożliwia wybranie podzbioru biblioteki.

   Set up Voicing (Skonfiguruj dźwięczność)
       Umożliwia skonfigurowanie własnych parametrów dźwięczności dla określonego schematu 
       dźwięczności.
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   Adaptive Voicings (Głosy adaptacyjne)
        Jeśli ta opcja jest włączona, głosy są ustawiane automatycznie.

   Automatic Scales (Skale automatyczne)
        Jeśli ta opcja jest włączona, program automatycznie tworzy zdarzenia skali.

   Shift Chords (Przesunięcie akordów)
        Umożliwia określenie wartości przesunięcia, aby mieć pewność, że zdarzenia akordowe będą 
        miały wpływ na nuty MIDI, które zostały wyzwolone zbyt wcześnie (wprowadź wartość 
        ujemną) lub zbyt późno (wprowadź wartość dodatnią).

POWIĄZANE LINKI
Sekcje inspektorów na stronie 113

Chord Track Controls (Sterowanie ścieżką akordów)
Lista ścieżek dla ścieżki z akordami zawiera elementy sterujące i parametry umożliwiające edycję 
ścieżki z akordami.

                                 

Lista ścieżek ścieżki akordów zawiera następujące elementy sterujące:

   Name (Nazwa)
        Wyświetla nazwę utworu. Kliknij dwukrotnie, aby zmienić nazwę ścieżki.

   Record Enable (Włącz nagrywanie)
        Aktywuje ścieżkę do nagrywania.

   Mute Chord Track (Wycisz ścieżkę akordów)
        Wycisza utwór.

   Select Track for Auditioning (Wybierz ścieżkę do przesłuchania)
        Umożliwia wybranie ścieżki do odsłuchania zdarzeń akordowych.

   Resolve Display Conflicts (Rozwiąż konflikty wyświetlania)
        Umożliwia prawidłowe wyświetlanie wszystkich akordów na ścieżce, nawet przy niskim 
        poziomie powiększenia.

   Show Scales (Pokaż Skale)
        Umożliwia pokazanie pasa skali w dolnej części ścieżki akordów.

   Lock (Zamknij)
        Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Toggle Time Base (Przełącz podstawę czasu)
        Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
        czasu dla utworu.
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Signature Track (Ścieżka sygnatury (podpisu))
Możesz użyć ścieżki podpisu, aby dodawać i edytować zdarzenia podpisu oraz konfigurować dla 
nich wzorce kliknięć. Tło ścieżki sygnaturowej zawsze pokazuje paski. Jest to niezależne od 
ustawienia formatu wyświetlania linijki.

● Aby dodać ścieżkę podpisu do swojego projektu, wybierz kolejno Project > Add Track > 
Signature (Projekt > Dodaj ścieżkę > Sygnatura).

POWIĄZANE LINKI
Zdarzenia metrum na stronie 1040
Kliknij kartę Wzory na stronie 258

Signature Track Inspector (Inspektor ścieżki sygnatury)
Inspektor ścieżki podpisu wyświetla listę wszystkich zdarzeń metrum.

                           

Colorize Selected Track (Pokoloruj wybraną ścieżkę)
        Pozwala pokolorować wybraną ścieżkę.
Bar (Takt)
       Pokazuje numer taktu, na którym znajduje się zdarzenie podpisu. Kliknij dwukrotnie pole 
       i wprowadź nową wartość, aby zmienić pozycję zdarzenia podpisu.
UWAGA
Pierwsze zdarzenie podpisu jest zawsze umieszczane na takcie 1. Nie można tego zmienić.

Sign. (Podpisać).
       Pokazuje wartość zdarzenia podpisu. Kliknij dwukrotnie pole i wprowadź nową wartość, aby 
       zmienić metrum.
Pattern (Wzór)
       Pokazuje używany wzór kliknięcia. Kliknij dwukrotnie pole, aby otworzyć Click Pattern Editor
       (Edytor wzorów kliknięć), w którym możesz zmienić wzór.

POWIĄZANE LINKI
Edytor wzorów kliknięć na stronie 252

Signature Track Controls (Kontrolki ścieżki podpisu (sygnatury))

Lista ścieżek dla ścieżki sygnaturowej zawiera elementy sterujące i parametry umożliwiające 
edycję ścieżki sygnaturowej.

                                    

Lock (Zamknij)
         Wyłącza wszelką edycję wszystkich wydarzeń na ścieżce.
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Signature Track Options (Opcje ścieżki podpisu)

● Copy Click Pattern to Clipboard (Kopiuj wzór kliknięcia do schowka)
        Kopiuje wzór kliknięcia (rytmu) wybranego zdarzenia podpisu do schowka.
● Paste Click Pattern to Selected Signatures (Wklej wzór kliknięcia do wybranych sygnatur)
        Wkleja wzór kliknięcia (rytmu) ze schowka do wybranych zdarzeń podpisu.
UWAGA
To działa tylko wtedy, gdy wybrane zdarzenia sygnatury są równe.

● Apply Click Pattern to Equal Signatures (Zastosuj wzór kliknięcia do równych sygnatur)
        Wkleja wzór kliknięcia ze schowka do identycznych zdarzeń sygnatur.
UWAGA
W tym celu nie trzeba najpierw wybierać zdarzeń sygnatury.

● Reset Click Pattern to Default (Zresetuj wzór kliknięcia do domyślnych)
       Ustawia domyślny wzorzec kliknięcia wybranego zdarzenia podpisu. Jeśli nie zostanie wybrane
       żadne zdarzenie podpisu, wzorce kliknięć wszystkich zdarzeń podpisu zostaną ustawione na \ 
       domyślne.
● Show Click Patterns (Pokaż wzorce kliknięć)
       Umożliwia pokazywanie/ukrywanie wzorców kliknięć dla zdarzeń sygnatury.
● Render MIDI Click between Locators (Renderuj MIDI Click pomiędzy lokalizatorami)
       Dodaje ścieżkę MIDI do twojego projektu i tworzy partię MIDI zawierającą wzór kliknięcia 
       między lewym i prawym lokalizatorem.
● Render Audio Click between Locators (Renderuj Audio Click pomiędzy lokalizatorami)
       Dodaje ścieżkę dźwiękową do projektu i tworzy zdarzenie dźwiękowe zawierające wzór 
       kliknięcia między lewym a prawym lokalizatorem.
● Process Bars Dialog (Okno dialogowe procesu taktów)
       Otwiera okno dialogowe Process Bars (Proces taktów).

POWIĄZANE LINKI
Click Patterns (Wzory kliknięcia) na stronie 258
Okno dialogowe Process Bar (Proces taktu) na stronie 1038

Tempo Track (ścieżka Tempo)
Możesz użyć ścieżki tempa do tworzenia zmian tempa w projekcie.

● Aby dodać do projektu ścieżkę tempa, wybierz kolejno Project > Add Track > Tempo 
(Projekt > Dodaj ścieżkę > Tempo)

Inspektor ścieżki tempa
Inspektor ścieżki tempa wyświetla listę wszystkich zdarzeń tempa.

                            

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
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         Pozwala pokolorować wybraną ścieżkę.

   Open Tempo Track Editor (Otwórz edytor ścieżek tempa)
         Otwiera Tempo Track Editor (Edytor ścieżek tempa).

   Tempo event list (Lista zdarzeń tempa)
         Pokazuje listę wszystkich zdarzeń tempa, która umożliwia edycję zdarzeń tempa i ich pozycji.

Sterowanie ścieżką tempa
Lista ścieżek dla ścieżki tempa zawiera elementy sterujące i parametry umożliwiające edycję 
ścieżki tempa.

   Activate Tempo Track (Aktywuj ścieżkę tempa)
         Umożliwia aktywację ścieżki tempa. W tym trybie nie można zmienić tempa w panelu    
         Transport.

   Lock (Zamknij)
         Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Current Tempo (Bieżące tempo)
         Umożliwia zmianę tempa w miejscu kursora projektu.

   Open Process Tempo Dialog (Otwórz okno dialogowe tempa procesu)
         Umożliwia otwarcie okna dialogowego Process Tempo (Tempo procesu).

   New Tempo Points Type (Nowy typ punktów tempa)
         Pozwala określić, czy tempo ma zmieniać się stopniowo (Ramp), czy natychmiast (Step) od 
         poprzedniego punktu krzywej do nowego.

   Visible Tempo Upper Limit/Visible Tempo Lower Limit (Górna granica widocznego 
tempa/Dolna granica widocznego tempa)
         Umożliwia określenie zakresu wyświetlania. Zmienia to skalę wyświetlania ścieżki tempa, ale
         nie ustawienie tempa.

Ścieżka Transpose (Transpozycji)
Możesz użyć ścieżki transpozycji, aby ustawić globalne zmiany tonacji.

● Aby dodać ścieżkę transpozycji do projektu, wybierz kolejno Project > Add Track > Transpose
(Projekt > Dodaj ścieżkę > Transponuj).

Inspektor ścieżki transpozycji
Inspektor ścieżki transpozycji zawiera parametry kontrolujące ścieżkę transpozycji
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   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
        Pozwala pokolorować wybraną ścieżkę.

   Keep Transpose in Octave Range (Zachowaj transpozycję w zakresie oktawy)
        Pozwala zachować transpozycję w zakresie oktaw i zapewnia, że nic nie zostanie 
        przetransponowane o więcej niż siedem półtonów.

   Toggle Time Base (Przełącz podstawę czasu)
        Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
        czasu dla utworu.

Sterowanie ścieżką transportu
Lista ścieżek ścieżki transpozycji zawiera parametry umożliwiające sterowanie ścieżką 
transpozycji.

                            

   Mute Transpose Events (Wycisz zdarzenia transpozycji)
        Wycisza utwór.

   Keep Transpose in Octave Range (Zachowaj transpozycję w zakresie oktawy)
        Pozwala zachować transpozycję w zakresie oktaw i zapewnia, że nic nie zostanie 
        przetransponowane o więcej niż siedem półtonów.

   Toggle Time Base (Przełącz podstawę czasu)
        Przełącza między muzyczną (związaną z tempem) a liniową (związaną z czasem) podstawą 
        czasu dla utworu.

   Lock (Zamknij)
        Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

Ścieżka Video
Możesz użyć ścieżki wideo do odtwarzania zdarzeń wideo. Pliki wideo są wyświetlane jako 
zdarzenia/klipy na ścieżce wideo, z miniaturami reprezentującymi klatki filmu.

● Aby dodać ścieżkę wideo, wybierz Project > Add Track > Video (Projekt > Dodaj ścieżkę > 
Wideo).

Inspektor ścieżki wideo
Inspektor ścieżki wideo zawiera parametry do kontrolowania ścieżki wideo.

                               

   Colorize Selected Track (Pokoloruj wybraną ścieżkę)
        Pozwala pokolorować wybraną ścieżkę.
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   Reveal Video Window (Pokaż okno wideo)
        Otwiera okno Video Player (odtwarzacza wideo).

   Mute Video Track (Wycisz ścieżkę wideo)
        Wycisza utwór.

   Lock (Zamknij)
        Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Show Frame Numbers (Pokaż numery ramek)
        Umożliwia wyświetlenie każdej miniatury z odpowiednim numerem klatki wideo.

   Show Thumbnails (Pokaż miniaturki)
        Umożliwia włączanie/wyłączanie miniatur ścieżki wideo.

POWIĄZANE LINKI
Sekcje inspektorów na stronie 113

Sterowanie ścieżką Video
Lista ścieżek dla ścieżki wideo zawiera parametry do sterowania ścieżką wideo.

                              

   Mute Video Track (Wycisz ścieżkę wideo)
         Wycisza utwór.

   Name (Nazwa)
         Wyświetla nazwę ścieżki. Kliknij dwukrotnie, aby zmienić nazwę ścieżki.

   Lock (Zamknij)
        Wyłącza wszelką edycję wszystkich zdarzeń na ścieżce.

   Show Thumbnails (Pokaż miniaturki)
        Umożliwia włączanie/wyłączanie miniatur ścieżki wideo.

   Show Frame Numbers (Pokaż numery ramek)
        Umożliwia wyświetlenie każdej miniatury z odpowiednim numerem klatki wideo
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          Obsługa Ścieżek

Ścieżki są elementami budulcowymi Twojego projektu. W Cubase zdarzenia i części są 
umieszczane na ścieżkach.

Dodawanie ścieżek za pomocą okna dialogowego Add Track (Dodaj 
ścieżkę)
Możesz dodawać ścieżki za pomocą okna dialogowego Add Track.

PROCEDURA
1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij Add Track.
2. Wykonaj jedną z następujących czynności:
● Kliknij typ ścieżki i skonfiguruj opcje zgodnie ze swoimi potrzebami.
● Aby dodać rodzaje ścieżek, które można dodać tylko raz, otwórz sekcję More Tracks (Więcej 
ścieżek) i kliknij typ śćieżki.
3. Kliknij Add Track (Dodaj ścieżkę).

WYNIK
Nowa ścieżka zostanie dodana do projektu pod wybraną ścieżką.

POWIĄZANE LINKI
Okno dialogowe Add Track – Audio (Dodaj ścieżkę – dźwięk na stronie) 122
Okno dialogowe Add Track – Instrument na stronie 126
Okno dialogowe Add Track – Sampler na stronie 129
Okno dialogowe Add Track - MIDI na stronie 132
Okno dialogowe Add Track – Efect na stronie 139
Okno dialogowe Add Track – Group Channel (kanał grupowy) na stronie 136
Okno dialogowe Add Track – VCA na stronie 142
Okno dialogowe Add Track - Marker na stronie 144
Okno dialogowe Add Track — Ruler na stronie 146
Okno dialogowe Add Track –  Folder na stronie 148
Arranfer Track (Ścieżka aranżera) na stronie 152
Chord Track (Ścieżka akordów) na stronie 153
Sygnatura Track (Ścieżka Sygnatura) na stronie 156
Tempo Track (Ścieżka Tempo) na stronie 157
Transpose Track (Ścieżka transpozycji) na stronie 158
Video Track (Ścieżka wideo) na stronie 159

Dodawanie ścieżek za pomocą ustawień wstępnych 
ścieżek
Możesz dodawać ścieżki na podstawie ustawień wstępnych ścieżek. Ustawienia ścieżki zawierają 
ustawienia dźwięku i kanału.

PROCEDURA
1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij opcję Use Track Preset (Użyj 
ustawień wstępnych ścieżki).
2. Wybierz Using Track Preset (Korzystanie z zaprogramowanych ścieżek).
3. W oknie dialogowym Choose Track Preset (Wybierz ustawienie ścieżki) wybierz ustawienie 
ścieżki.
Liczba i rodzaj dodanych utworów zależy od wybranego ustawienia wstępnego utworów.
4. Kliknij OK.
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WYNIK
Nowe ścieżki zostaną dodane do projektu pod wybraną ścieżką.

POWIĄZANE LINKI
Wstępne ustawienia ścieżki na stronie 192

Dodawanie ścieżek przez przeciąganie plików z MediaBay
Możesz dodawać utwory, przeciągając pliki z MediaBay.

WARUNEK WSTĘPNY
Musi być spełniony jeden z następujących warunków wstępnych:
● MediaBay jest otwarty. Aby otworzyć wnękę MediaBay, naciśnij klawisz F5.
● „Stojak” na media (Media rack) w prawej strefie okna Project (projekt) jest otwarty. Kliknij 
opcję Show/Hide Right Zone (Pokaż/ukryj prawą strefę) i kliknij kartę Media, aby ją otworzyć.

PROCEDURA
1. W MediaBay wybierz pliki, do których chcesz dodać ścieżki.
2. Przeciągnij pliki na listę utworów.
● Wskaźnik podświetla pozycję, w której zostaną dodane nowe utwory.
● Jeśli przeciągniesz wiele plików audio na listę ścieżek, wybierz, czy chcesz umieścić wszystkie 
pliki na jednej ścieżce, czy na różnych ścieżkach.
● Jeśli przeciągniesz wiele plików audio na listę ścieżek, otworzy się okno dialogowe Opcje 
importu, w którym możesz edytować opcje importu.

WYNIK
Nowe ścieżki są dodawane w miejscu, które zostało zaznaczone wskaźnikiem na liście ścieżek. 
Pliki audio są wstawiane w miejscu kursora.

POWIĄZANE LINKI
MediaBay i Media Rack na stronie 629
Media rack („Stojak” na media) w prawej strefie na stronie 629
Okno dialogowe Import Options (opcje importu) dla plików audio na stronie 284

Ścieżka Import
Możesz importować ścieżki z innych projektów Nuendo lub Cubase lub archiwa ścieżek. Pozwala 
to na przykład importować wstępnie zmiksowane ścieżki lub motywy do aktywnego projektu lub 
ponownie wykorzystać ustawienia miksu z poprzedniego projektu w nowym utworze.

Dla każdej indywidualnej ścieżki możesz zdecydować, czy utworzyć nową ścieżkę w aktywnym 
projekcie, czy zastąpić dane na istniejącej ścieżce. Jeśli użyjesz identycznych nazw ścieżek 
zarówno w zaimportowanym, jak i aktywnym projekcie, możesz automatycznie wybrać pasujące 
ścieżki jako miejsce docelowe importu. Możesz zaimportować tylko zdarzenia ścieżki, tylko 
ustawienia ścieżki, uwzględnić lub wykluczyć dane automatyzacji lub zaimportować wszystkie 
dane ścieżki.
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UWAGA
Ustawienia ścieżki dotyczące statusu automatyzacji odczytu/zapisu, włączania nagrywania, 
monitorowania, wyciszania/solowania i widoczności nie są importowane.

Podczas importowania wielu ścieżek, które są ze sobą powiązane za pośrednictwem wysyłek, 
routingu wyjściowego, szybkiego łącza lub suwaka VCA w projekcie źródłowym, relacje te są 
zachowywane w aktywnym projekcie.
UWAGA
Jeśli Twój aktywny projekt zawiera cele tras o identycznych nazwach jak w projekcie źródłowym, 
zaimportowane ścieżki są odpowiednio połączone.

W zależności od rodzaju ścieżki obowiązują następujące zasady importu:

Ścieżki audio, instrumentów, MIDI, samplerów, VCA, grup, efektów i folderów
● Jeśli jako miejsce docelowe wybrano opcję New Track (Nowa ścieżka), w aktywnym projekcie 
zostanie utworzona nowa ścieżka. Ta ścieżka zawiera wszystkie zaimportowane dane ścieżek, w 
tym wersje ścieżek.
● Jeśli istniejąca ścieżka zostanie wybrana jako miejsce docelowe, zaimportowane dane ścieżki 
zostaną zastosowane do tej ścieżki.

Jeśli wydarzenia lub części zostaną zaimportowane do istniejącej ścieżki, istniejące wersje ścieżki 
w aktywnym projekcie zostaną zachowane, dodane zostaną wersje ścieżki z projektu źródłowego i 
utworzona zostanie nowa wersja ścieżki.

Jeśli ścieżka z folderu zostanie zaimportowana do istniejącej ścieżki, zawartość tej ścieżki zostanie 
całkowicie zastąpiona ścieżkami z importowanej ścieżki z folderu.

Ścieżki znaczników (Marker Tracks)
● Jeśli jako miejsce docelowe wybrano New Track (Nowa ścieżka), tworzony jest nowy znacznik 
ścieżki. Jeśli Twój projekt zawiera już 10 znaczników, nie możesz zaimportować znaczników z 
innego projektu. W takim przypadku należy najpierw usunąć istniejącą ścieżkę znacznika.
UWAGA
Projekty z projektów Nuendo mogą zawierać więcej niż 10 ścieżek znaczników. Jeśli zaimportujesz
ścieżki znaczników z tych projektów do Cubase, do projektu zostanie zaimportowanych tylko 10 
pierwszych ścieżek znaczników wybranych w oknie dialogowym Import Options (Opcje importu).
● Jeśli jako miejsce docelowe zostanie wybrany istniejący znacznik ścieżki, zaimportowane dane 
ścieżki zastąpią istniejące dane ścieżki.

Ścieżki akordów (Chord Tracks)
● Jeśli jako miejsce docelowe wybrano opcję New Track (Nowa ścieżka), tworzona jest ścieżka z 
akordami. Jeśli projekt zawiera już ścieżkę akordów, zostanie ona zastąpiona zaimportowaną 
ścieżką akordów.
● Jeśli jako miejsce docelowe wybrano istniejącą ścieżkę z akordami, zaimportowane dane ścieżki 
zastępują istniejące dane ścieżki.

Ścieżki wideo (Video Tracks) 
● Jeśli jako miejsce docelowe wybrano opcję New Track (Nowa ścieżka), tworzona jest nowa 
ścieżka wideo. Jeśli Twój projekt zawiera już ścieżkę wideo, nie możesz zaimportować ścieżki 
wideo z innego projektu. W takim przypadku należy najpierw usunąć istniejącą ścieżkę wideo.
UWAGA
Projekty z projektów Nuendo mogą zawierać więcej niż jedną ścieżkę wideo. Jeśli importujesz 
ścieżki wideo z tych projektów do Cubase, tylko pierwsza ścieżka wideo wybrana w oknie 
dialogowym Import Options (Opcje importu) zostanie zaimportowana do twojego projektu.
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● Jeśli jako miejsce docelowe zostanie wybrana istniejąca ścieżka wideo, zaimportowane dane 
ścieżki zastąpią istniejące dane ścieżki.

POWIĄZANE LINKI
Okno dialogowe Import Options for Tracks (Opcje importu dla ścieżek) na stronie 165

Importowanie ścieżek z projektów
Możesz importować ścieżki z innych projektów Nuendo lub Cubase.

PROCEDURA
1. Wybierz File > Import > Tracks from Project (Plik > Importuj > Ścieżki z projektu).
2. W Eksploratorze plików/macOS Finder wybierz plik projektu zawierający ścieżki, które chcesz 
zaimportować, i kliknij Open (Otwórz).
3. W oknie dialogowym Import Options (Opcje importu) wybierz ścieżki, które chcesz 
zaimportować, i wprowadź dalsze ustawienia.
4. Kliknij OK.

WYNIK
Ścieżki zostaną zaimportowane do aktywnego projektu.

POWIĄZANE LINKI
Okno dialogowe opcji importu dla ścieżek na stronie 165
Wersje ścieżek na stronie 185

Importowanie ścieżek z archiwów ścieżek (Track Archives)
Możesz importować ścieżki z archiwów ścieżek

WARUNEK WSTĘPNY
Utworzyłeś co najmniej jedno archiwum ścieżek, eksportując wybrane ścieżki z projektu.

PROCEDURA
1. Wybierz File > Import > Track Archive (Plik > Importuj > Archiwum ścieżek).
2. W Eksploratorze plików/macOS Finder wybierz plik .xml archiwum ścieżek i kliknij Open 
(Otwórz)
3. W oknie dialogowym Import Options (Opcje importu) wybierz ścieżki, które chcesz 
zaimportować i wprowadź dalsze ustawienia.
4. Kliknij OK.

WYNIK
Ścieżki zostaną zaimportowane do aktywnego projektu.

POWIĄZANE LINKI
Okno dialogowe opcji importu dla ścieżek na stronie 165
Wersje ścieżek na stronie 185
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Okno dialogowe opcji importu dla ścieżek
Okno dialogowe Import Options (Opcje importu) umożliwia aktywację ścieżek do 
zaimportowania, określenie miejsca docelowego w aktywnym projekcie i danych ścieżek, które 
mają zostać zaimportowane, oraz skonfigurowanie dalszych opcji importu.

● Aby otworzyć okno dialogowe Import Options (Opcje importu), wybierz File > Import > 
Track Archive (Plik > Importuj > Archiwum ścieżek) lub File > Import > Tracks from Project 
(Plik > Importuj > Ścieżki z projektu) i otwórz plik projektu, z którego chcesz importować ścieżki.

Tracks (Ścieżki)

Select All (Zaznacz wszystko)
         Zaznacza wszystkie ścieżki.
Deselect All (Odznacz wszystkie)
        Odznacza wszystkie ścieżki.
Expand All (Rozwiń wszystkie)
        Rozszerza listę utworów.
Collapse All (Zwinąć wszystkie)
        Zwija listę utworów.
Select Matching (Wybierz pasujące)
        Ustawia ścieżki o identycznych nazwach jako odpowiednie miejsca docelowe dla wszystkich 
        wybranych ścieżek na liście utworów.
Reset (Resetowanie)
        Ustawia nową ścieżkę jako miejsce docelowe dla wszystkich wybranych ścieżek na liście 
        ścieżek.
Search field (Pole wyszukiwania)
        Umożliwia filtrowanie listy utworów. Clear Search (Wyczyść wyszukiwanie) resetuje filtr.
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Track list (Lista ścieżek)
         Pokazuje ścieżki wybrane w projekcie. Kolumna Source Track (Ścieżka źródłowa) 
         umożliwia wybranie ścieżek, które chcesz zaimportować do swojego projektu. Kolumna 
        Destination Track (Ścieżka docelowa) umożliwia wybranie miejsca docelowego dla 
        odpowiedniej ścieżki.

Track Data (Dane ścieżki) do zaimportowania

Events and Parts (Zdarzenia i części)
        Importuje tylko zdarzenia i części.
UWAGA
● Jeśli importowana ścieżka zawiera wersje ścieżek, są one również importowane.
● Jeśli zdarzenia lub części są importowane do istniejącej ścieżki, tworzona jest nowa wersja 
ścieżki.
Channel and Inspector Settings (Ustawienia kanału i inspektora)
        Importuje wszystkie ustawienia ścieżek, na przykład głośność, panoramę, EQ, ustawienia 
        channel strip i Inspector, routing wyjściowy, wysyłki, cue, połączenia VCA i wtyczki.
UWAGA
Ustawienia ścieżek dla stanu automatyzacji odczytu/zapisu, włączania nagrywania, monitorowania, 
wyciszania/solowania i widoczności nie są importowane z innych projektów.
Automation (Automatyzacja)
        Importuje wszystkie dane automatyki, które są powiązane z zaimportowanymi danymi ścieżek.
UWAGA
Jeśli ta opcja zostanie wyłączona podczas importowania zdarzeń lub ustawień do istniejącej ścieżki,
jej dane automatyzacji zostaną zresetowane.

Project Settings (Ustawienia projektu)

Source Project/Active Project (Projekt źródłowy/Projekt aktywny)
        Pokazuje nazwę pliku, częstotliwość próbkowania, liczbę klatek na sekundę i czas rozpoczęcia
        projektu zarówno dla zaimportowanych ścieżek, jak i aktywnego projektu.
UWAGA
Zaimportowane ścieżki mogą zawierać pliki multimedialne z częstotliwością próbkowania inną niż 
częstotliwość próbkowania projektu docelowego. Pliki o częstotliwości próbkowania innej niż w 
projekcie docelowym są odtwarzane z niewłaściwą szybkością i tonacją.

Import Position for Events and Parts (Pozycja importu dla zdarzeń i części)

Import at Absolute Position (Importuj w pozycji bezwzględnej)
        Umieszcza zaimportowane dane ścieżki w oryginalnej pozycji kodu czasowego w aktywnym 
        projekcie.
Import at Relative Position (Importuj w pozycji względnej)
        Umieszcza zaimportowane dane toru względem czasu rozpoczęcia aktywnego projektu, biorąc 
        pod uwagę czas rozpoczęcia projektu źródłowego. Na przykład, jeśli projekt źródłowy 
        rozpoczyna się o kodzie czasowym 01:00:00:00 ze zdarzeniem zlokalizowanym o godzinie 
        02:00:00:00, a aktywny projekt rozpoczyna się o godzinie 02:00:00:00, zaimportowane 
        zdarzenie jest umieszczane o kodzie czasowym 03:00:00:00.
Import at Cursor Position (Importuj w pozycji kursora)
Umieszcza zaimportowane dane ścieżki względem pozycji kursora w aktywnym projekcie, biorąc 
pod uwagę czas rozpoczęcia projektu źródłowego. Na przykład, jeśli projekt źródłowy rozpoczyna 
się o kodzie czasowym 01:00:00:00 ze zdarzeniem zlokalizowanym o godzinie 02:00:00:00, 
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a kursor w aktywnym projekcie znajduje się na godzinie 02:00:00:00, zaimportowane zdarzenie jest
umieszczane w kodzie czasowym 03:00:00:00.

UWAGA
● Jeśli czas rozpoczęcia aktywnego projektu jest późniejszy niż pozycja zaimportowanych danych 
utworów w projekcie źródłowym, zaimportowane dane nie będą widoczne w aktywnym projekcie 
po zaimportowaniu. W takim przypadku odpowiednio dostosuj czas rozpoczęcia aktywnego 
projektu.
● Jeśli czas zakończenia aktywnego projektu jest wcześniejszy niż czas zakończenia 
zaimportowanych danych utworów, czas zakończenia projektu zostanie odpowiednio 
zmodyfikowany.

Media Files (Pliki medialne)

Copy to Active Project Folder (Skopiuj do aktywnego folderu projektu)
        Kopiuje pliki multimedialne zaimportowanych utworów do aktywnego folderu projektu. Jeśli 
        ta opcja jest wyłączona, odwołuje się do ścieżki pliku multimedialnego oryginalnego projektu.
Convert Sample Rate (Konwertuj częstotliwość próbkowania)
        Konwertuje częstotliwość próbkowania zaimportowanych ścieżek na częstotliwość 
        próbkowania aktywnego projektu
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy częstotliwość próbkowania zaimportowanych ścieżek i 
Twojego aktywnego projektu różni się, a opcja Copy to Active Project Folder (Kopiuj do 
aktywnego folderu projektu) jest włączona.

POWIĄZANE LINKI
Wersje ścieżek na stronie 185

Track Export (Eksport ścieżek)
Możesz wyeksportować wybrane ścieżki jako archiwa ścieżek. Jest to przydatne, jeśli chcesz na 
przykład użyć określonych ścieżek w innych projektach.

Archiwa ścieżek zawierają informacje powiązane ze ścieżkami, takie jak ustawienia kanałów, 
części i zdarzenia oraz automatyzacja.

UWAGA
Ustawienia specyficzne dla projektu, takie jak tempo, nie są eksportowane do archiwów ścieżek.

Archiwa ścieżek są zapisywane jako pliki .xml.

Podczas eksportowania ścieżek audio i wideo możesz odwołać się do plików multimedialnych lub 
skopiować je do osobnego folderu.

POWIĄZANE LINKI
Wstępne ustawienia ścieżki na stronie 192
Eksportowanie ścieżek audio lub wideo jako archiwum ścieżek na stronie 168
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Eksportowanie ścieżek jako archiwów ścieżek
Możesz wyeksportować wybrane ścieżki jako archiwa ścieżek.

PROCEDURA
1. Wybierz ścieżki, które chcesz wyeksportować.
2. Wybierz File > Export > Selected Tracks (Plik > Eksportuj > Wybrane ścieżki).
3. W oknie dialogowym pliku, które zostanie otwarte, wybierz lub utwórz folder do zapisania 
archiwum śladów jako pojedynczy plik .xml.
4. Wprowadź nazwę pliku i kliknij Save (Zapisz).

POWIĄZANE LINKI
Eksportowanie ścieżek audio lub wideo jako archiwum ścieżek na stronie 168.

Eksportowanie ścieżek audio lub wideo jako archiwum ścieżek
Możesz eksportować ścieżki audio lub wideo jako archiwa ścieżek.

PROCEDURA
1. Wybierz ścieżki audio lub wideo oraz inne ścieżki, które chcesz wyeksportować.
2. Wybierz File > Export > Selected Tracks (Plik > Eksportuj > Wybrane ścieżki).
3. W otwartym oknie dialogowym pliku wybierz jedną z następujących opcji:
● Kliknij Copy (Kopiuj), aby dołączyć kopie plików multimedialnych do eksportu. W otwartym 
oknie dialogowym pliku wybierz pusty folder lub utwórz nowy folder do zapisania archiwum 
ścieżek jako pliku .xml i jego podfolderu multimediów. Kliknij OK, aby zapisać archiwum ścieżek.
● Kliknij Reference (Odnośnik), aby dołączyć odniesienie do plików w eksporcie. W oknie 
dialogowym pliku, które zostanie otwarte, wybierz lub utwórz folder do zapisania archiwum 
ścieżek jako pojedynczy plik .xml.
4. Wprowadź nazwę archiwum ścieżek i kliknij Save (Zapisz).

Eksportowanie ścieżek MIDI jako standardowych plików MIDI
Możesz eksportować ścieżki MIDI jako standardowe pliki MIDI. Pozwala to na przesyłanie 
materiału MIDI do praktycznie dowolnej aplikacji MIDI na dowolnej platformie.

PROCEDURA
1. Wybierz File > Export > MIDI File (Plik > Eksportuj > Plik MIDI).
2. W otwartym oknie dialogowym pliku określ lokalizację i nazwę pliku.
3. Kliknij Save (Zapisz).
4. W oknie dialogowym Export Options (Opcje eksportu) aktywuj opcje ustawień, które chcesz 
wyeksportować, i kliknij OK.

WYNIK
Plik MIDI zostanie wyeksportowany. Obejmuje zdarzenia tempa i metrum z Tempo Track Editor 
lub, jeśli ścieżka tempa jest wyłączona w panelu Transport, bieżące tempo i metrum.

UWAGA
Jeśli chcesz dołączyć inne ustawienia (Inspector) Inspektora niż te określone w Export Options 
(Opcje eksportu), użyj Merge MIDI in Loop, aby przekonwertować te ustawienia na rzeczywiste 
zdarzenia MIDI.

POWIĄZANE LINKI
Okno dialogowe opcji eksportu (Export Options) dla plików MIDI na stronie 169
Scalanie zdarzeń MIDI w nową partię na stronie 793
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Okno dialogowe opcji eksportu (Export Options) dla plików MIDI
Opcje eksportu plików MIDI pozwalają określić, jakie dane mają być zawarte w eksportowanych 
plikach MIDI.

● Aby otworzyć Export Options (Opcje eksportu) dla plików MIDI, wybierz File > Export > 
MIDI File (Plik > Eksportuj > Plik MIDI).

              

Export Inspector Patch (Eksportuj ścieżkę dostepu inspektora)
         Zawiera ustawienia patcha MIDI w Inspektorze jako wybór banku MIDI i zdarzenia zmiany 
         programu w pliku MIDI.
Export Inspector Volume/Pan (Eksportuj głośność/panoramę inspektora)
         Zawiera ustawienia głośności i panoramy w Inspektorze jako zdarzenia głośności i panoramy 
         MIDI w pliku MIDI.
Export Automation (Automatyzacja eksportu)
         Obejmuje automatyzację jako zdarzenia kontrolera MIDI w pliku MIDI. Obejmuje to również 
         automatyzację nagraną za pomocą wtyczki MIDI Control. Jeśli zarejestrujesz ciągły  
         kontroler (na przykład CC7) i wyłączysz automatyzację odczytu (Read Automation) dla 
         ścieżki automatyzacji, eksportowane są tylko dane części dla tego kontrolera.
Export Inserts (Eksportuj wstawki)
         Zawiera modyfikatory MIDI i wstawki MIDI w pliku MIDI.
Export Sends (Eksportuj wysyłki)
         Zawiera wysyłki MIDI w pliku MIDI.
Export Markers (Eksportuj znaczniki)
         Zawiera znaczniki jako standardowe zdarzenia znaczników pliku MIDI w pliku MIDI.
Export as Type 0 (Eksportuj jako typ 0)
         Eksportuje plik MIDI typu 0 ze wszystkimi danymi na jednej ścieżce, ale na różnych kanałach
         MIDI. Jeśli wyłączysz tę opcję, zostanie wyeksportowany plik MIDI typu 1 z danymi na 
         osobnych ścieżkach.
Export Resolution (Rozdzielczość eksportu)
        Umożliwia ustawienie rozdzielczości MIDI w zakresie od 24 do 960 dla pliku MIDI. 
        Rozdzielczość to liczba impulsów lub tyknięć na ćwierćnutę (PPQ) i określa precyzję, z jaką 
        będziesz mógł przeglądać i edytować dane MIDI. Im wyższa rozdzielczość, tym większa 
        precyzja. Rozdzielczość należy wybrać w zależności od aplikacji lub sekwencera, z którym 
        będzie używany plik MIDI, ponieważ niektóre aplikacje i sekwencery mogą nie być w stanie 
        obsłużyć niektórych rozdzielczości.
Export Locator Range (Eksportuj zakres lokalizatora)
        Eksportuje tylko zakres między lewym a prawym lokalizatorem.
Export includes Delay (Eksport obejmuje opóźnienie)
        Zawiera ustawienia opóźnienia wprowadzone w Inspektorze w pliku MIDI.
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POWIĄZANE LINKI
Automatyzacja na stronie 705
Znaczniki na stronie 336
Parametry ścieżki MIDI na stronie 771
Scalanie zdarzeń MIDI w nową partię na stronie 793
Opcje eksportu na stronie 1172

Dzielenie wielokanałowych ścieżek audio
Ścieżki wielokanałowe (multi-channel), takie jak stereo lub surround, można podzielić na kilka 
ścieżek mono. Jest to przydatne, jeśli chcesz użyć ścieżek w aplikacji obsługującej tylko ścieżki 
mono lub jeśli chcesz edytować poszczególne kanały pliku wielokanałowego.

PROCEDURA
1. W oknie Project (Projekt) wybierz ścieżkę, którą chcesz podzielić.
2. Wybierz Project  > Convert Tracks > Multi-Channel to Mono (Projekt > Konwertuj ścieżki > 
Wielokanałowe na mono).
3. W oknie dialogowym Split Multi-Channel to Mono dokonaj zmian i kliknij OK.

WYNIK
● Ścieżki są podzielone na tyle ścieżek mono, ile odpowiada konfiguracji kanałów ścieżki 
źródłowej.
● Wszystkie ustawienia kanałów ścieżek źródłowych są kopiowane do ścieżek utworzonych w 
wyniku operacji podziału.
● Wielokanałowy materiał audio ścieżki źródłowej jest dzielony na zdarzenia mono, które są 
wstawiane na nowych ścieżkach.
● W folderze Audio projektu tworzony jest podfolder o nazwie Split, który zawiera nowe pliki 
mono.

UWAGA
● Jeśli podzielisz ścieżkę stereo, powstałe ścieżki mono zostaną przesunięte mocno w lewo i mocno
w prawo przy użyciu standardowej panoramy stereo.
● Jeśli podzielisz ścieżkę wielokanałową i ta ścieżka zostanie skierowana do szyny wyjściowej, 
kanału grupowego lub kanału FX z odpowiednimi szynami podrzędnymi, wszystkie wynikowe 
ścieżki mono zostaną przekierowane do przypisanych im kanałów. W przeciwnym razie wynikowe 
ścieżki mono są przesuwane do środka.
● Jeśli konfiguracje kanałów ścieżki źródłowej i pliku źródłowego nie są zgodne, ponieważ na 
przykład wielokanałowa ścieżka źródłowa zawiera plik mono, ten plik mono jest kopiowany na 
pierwsze 2 ścieżki docelowe. Ponieważ jednak informacje dotyczące panoramowania nie są 
uwzględniane podczas podziału, głośność nowego pliku mono może nie odpowiadać głośności 
pliku na oryginalnej ścieżce.
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Split Multi-Channel to Mono Dialog (Okno dialogowe Rozdziel 
multikanal na mono)
Okno dialogowe Split Multi-Channel to Mono pozwala określić sposób konwersji ścieżek 
wielokanałowych na ścieżki mono.
● Aby otworzyć okno dialogowe Split Multi-Channel to Mono, wybierz Project > Convert 
Tracks > MultiChannel to Mono

                       

Source Tracks (Ścieżki źródłowe)
        Pozwala wybrać, czy chcesz podzielić wszystkie ścieżki wielokanałowe, czy tylko wybrane.
Options (Opcje)
Umożliwia określenie, co się stanie, gdy plik wielokanałowy zostanie podzielony:
● Keep Source Tracks (Zachowaj ścieżki źródłowe)
          Wstawia nowe ścieżki pod ścieżkami źródłowymi.
● Mute Source Tracks (Wycisz ścieżki źródłowe)
          Wstawia nowe ścieżki pod ścieżkami źródłowymi i wycisza ścieżki źródłowe.
● Delete Source Tracks (Usuń ścieżki źródłowe)
          Wstawia nowe ścieżki i usuwa ścieżki źródłowe.
● Create New Project (Utwórz nowy projekt)
          Tworzy nowy projekt zawierający tylko wynikowe ścieżki.
Split File Name Format (Podzielony format nazwy pliku)
          To wyskakujące menu pozwala określić sposób nazywania podzielonych ścieżek i plików.

Scalanie monofonicznych ścieżek Audio ze ścieżkami 
wielokanałowymi
Możesz konwertować ścieżki mono na ścieżki wielokanałowe, aby edycja i miksowanie były 
wygodniejsze.

WARUNEK WSTĘPNY
● Twój projekt zawiera ścieżki ze zdarzeniami dźwiękowymi, które nie są w Musical Mode (trybie
muzycznym).
● Ścieżki pasują równomiernie do wielu plików wielokanałowych w formacie docelowym.
● Utwory znajdują się na tym samym poziomie na liście utworów, to znaczy albo na najwyższym 
poziomie, albo w obrębie tej samej ścieżki folderu.
● Utwory pasują do siebie pod względem ustawień kanałów i automatyzacji. Jeśli ustawienia różnią
się, używane są ustawienia najwyższej ścieżki każdej grupy. Jeśli oddzielne zdarzenia audio mają 
różne obwiednie głośności, są one obliczane w nowym klipie.
● Poziom zdarzeń źródłowych nie powinien przekraczać 0 dB, w przeciwnym razie w tworzonych 
plikach wystąpi przesterowanie. Jedynym wyjątkiem są pliki w 32-bitowym formacie 
zmiennoprzecinkowym.

PROCEDURA
1. Opcjonalnie: Wybierz ścieżki, które chcesz przekonwertować w oknie Project.
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2. Wybierz Project > Convert Tracks > Mono to Multi-Channel (Projekt > Konwertuj ścieżki > 
Mono na wiele kanałów).

3. W oknie dialogowym Merge Mono to Multi-Channel wprowadź zmiany i kliknij OK.

WYNIK
● Ścieżki są konwertowane na tyle ścieżek wielokanałowych, ile odpowiada formatowi 
docelowemu.
● Nazwy ścieżek wielokanałowych pochodzą od ścieżek źródłowych mono.
UWAGA
Obowiązują następujące zasady nazewnictwa:
● Jeśli nazwy ścieżek utworów źródłowych kończą się sufiksem oddzielonym spacją lub znakiem 
specjalnym wskazującym odpowiedni kanał głośnika, na przykład „_L” lub „(L)” dla lewego 
kanału, sufiks ten jest usuwany dla nazwy ścieżki wielokanałowej.
● Jeśli nazwy ścieżek źródłowych nie kończą się sufiksem kanału, do jej nazwy dodawana jest 
konfiguracja kanału ścieżki wielokanałowej.
● Zdarzenia, które mają tę samą pozycję na osi czasu, są konwertowane na zdarzenie 
wielokanałowe na nowej ścieżce.
● Jeśli długości zdarzeń źródłowych nie są dokładnie takie same, nakładanie się jest uwzględniane 
w nowych zdarzeniach.
● W folderze Audio projektu tworzony jest podfolder o nazwie Merge, który zawiera nowe pliki 
wielokanałowe.
UWAGA
Jeśli wyjścia ścieżek mono są kierowane do oddzielnych kanałów w ramach jednej szyny 
wyjściowej, to ta szyna jest wybierana jako wyjście dla ścieżki wielokanałowej.

POWIĄZANE LINKI
Okno dialogowe Merge Mono to Multi-Channel (Połącz Mono w wielokanałowy) na stronie 172
Eksportuj miks audio na stronie 1053

Okno dialogowe Merge Mono to Multi-Channel (Połącz Mono 
w wielokanałowy)
Okno dialogowe Merge Mono to Multi-Channel pozwala określić, w jaki sposób ścieżki mono są 
konwertowane na ścieżki wielokanałowe.

● Aby otworzyć okno dialogowe Merge Mono to Multi-Channel (Scalanie mono na wiele 
kanałów), wybierz Project > Convert Tracks > Mono to Multi-Channel (Projekt > Konwertuj 
ścieżki > Mono na wiele kanałów).

                            

Source Tracks (Ścieżki źródłowe)
         Pozwala wybrać, czy chcesz scalić wszystkie ścieżki mono, czy tylko wybrane.
Options (Opcje)
         Pozwala określić, co się stanie, gdy pliki mono zostaną scalone:
● Keep Source Tracks (Zachowaj ścieżki źródłowe)
         Wstawia nowe ścieżki pod ścieżkami źródłowymi.
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● Mute Source Tracks (Wycisz ścieżki źródłowe)
         Wstawia nowe ścieżki pod ścieżkami źródłowymi i wycisza ścieżki źródłowe.

● Delete Source Tracks (Usuń ścieżki źródłowe)
         Wstawia nowe ścieżki i usuwa ścieżki źródłowe.
● Create New Project (Utwórz nowy projekt)
         Tworzy nowy projekt zawierający tylko wynikowe ścieżki.
Destination Format (Format docelowy)
         Umożliwia wybranie formatu pliku wielokanałowego
UWAGA
Liczba wybranych ścieżek musi być zgodna z tym formatem. Ścieżki są łączone zgodnie z ich 
kolejnością na liście ścieżek.

Usuwanie wybranych ścieżek
Możesz usunąć wybrane ścieżki z listy ścieżek.

PROCEDURA
● Wybierz Project > Remove Selected Tracks (Projekt > Usuń wybrane ścieżki).
Jeśli usuniesz ścieżki, które nie są puste, zostanie wyświetlony komunikat ostrzegawczy.
UWAGA
Możesz dezaktywować tę wiadomość. Aby ponownie aktywować komunikat, aktywuj opcję 
Display Warning before Deleting Non-Empty Tracks (Wyświetl ostrzeżenie przed usunięciem 
niepustych ścieżek) w oknie dialogowym Preferences (Preferencje) (strona Editing (Edycja)).

Usuwanie pustych ścieżek
Możesz usunąć puste ścieżki z listy ścieżek.

PROCEDURA
● Wybierz Project > Remove Empty Tracks (Projekt > Usuń puste ścieżki).

Przenoszenie ścieżek na liście ścieżek
Możesz przesuwać ścieżki w górę lub w dół na liście ścieżek.

PROCEDURA
● Wybierz ścieżkę i przeciągnij ją w górę lub w dół na liście ścieżek.

Zmiana nazw ścieżek
Możesz zmieniać nazwy ścieżek.

PROCEDURA
1. Kliknij dwukrotnie nazwę ścieżki i wpisz nową nazwę ścieżki.
2. Naciśnij Return (Powrót).

Jeśli chcesz, aby wszystkie zdarzenia na ścieżce miały tę samą nazwę, przytrzymaj dowolny 
klawisz modyfikujący i naciśnij Return.

PO WYKONANIU TEGO ZADANIA
Jeśli w oknie dialogowym Preferences (Preferencje) (strona Editing (Edycja)) aktywna jest opcja 
Parts Get Track Names (Części Pobierz nazwy ścieżek), a przeniesiesz wydarzenie z jednej 
ścieżki na drugą, przeniesione wydarzenie zostanie automatycznie nazwane zgodnie z nową 
ścieżką.
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Automatyczne przypisywanie kolorów do nowych ścieżek/kanałów
Możesz automatycznie przypisać kolory nowo dodanym ścieżkom lub kanałom.

PROCEDURA
1. Wybierz Edit > Preferences (Edytuj > Preferencje).
2. Otwórz stronę interfejsu użytkownika (User Interface) i wybierz Track & MixConsole 
Channel Colors (Kolory kanału Track & MixConsole).
3. Otwórz menu podręczne Auto Track/Channel Color Mode (Auto Track/Tryb koloru kanału) 
 i wybierz opcję.
4. Kliknij OK.

WYNIK
Wszystkie ścieżki/kanały, które dodałeś za pomocą opcji Add Track (Dodaj ścieżkę) lub 
przeciągając pliki ze „stojaka” na multimedia (Media rack) do ekranu zdarzenia, są automatycznie 
kolorowane zgodnie z Twoimi ustawieniami.

POWIĄZANE LINKI
User Interface - Track & MixConsole Channel Colors (Interfejs użytkownika — Kolory kanałów 
Track & MixConsole) na stronie 1181

Wyświetlanie obrazów ścieżek
Możesz dodawać zdjęcia do ścieżek, aby łatwo je rozpoznawać. Obrazy ścieżek są dostępne dla 
ścieżek audio, instrumentów, kanałów MIDI, FX i kanałów grupowych.

WARUNEK WSTĘPNY
Dostosuj wysokość ścieżek do co najmniej 2 rzędów.

PROCEDURA
1. Kliknij prawym przyciskiem myszy dowolną ścieżkę na liście ścieżek.
2. Z menu kontekstowego listy utworów wybierz opcję Show Track Pictures (Pokaż obrazki 
        ścieżek).

                            

          Jeśli przesuniesz mysz w lewo na ścieżce, pojawi się podświetlony prostokąt.

PO WYKONANIU TEGO ZADANIA
Kliknij dwukrotnie prostokąt, aby otworzyć przeglądarkę obrazów ścieżek (Track Pictures 
Browser) i skonfigurować obraz ścieżki.

POWIĄZANE LINKI
Track Pictures Browser (Przeglądarka zdjęć ścieżki) na stronie 175
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Track Pictures Browser (Przeglądarka zdjęć ścieżek)
Track Pictures Browser (Przeglądarka obrazów ścieżek) umożliwia konfigurowanie i wybieranie 
obrazów, które mogą być wyświetlane na liście utworów oraz w MixConsole. Obrazy ścieżek są 
przydatne do łatwego rozpoznawania ścieżek i kanałów. Możesz wybrać zdjęcia z zawartości 
fabrycznej lub dodać nowe do biblioteki użytkownika.

● Aby otworzyć przeglądarkę obrazów ścieżek dla ścieżki, kliknij dwukrotnie w lewym dolnym 
rogu listy ścieżek.

Factory (Fabryka)
        Pokazuje fabryczną zawartość w przeglądarce zdjęć.
Pictures browser (Przeglądarka zdjęć)
        Pokazuje obrazy, które można przypisać do wybranej ścieżki/kanału.
User (Użytkownik)
        Pokazuje zawartość użytkownika w przeglądarce zdjęć.
Import
        Otwiera okno dialogowe pliku, które umożliwia wybranie obrazów w formacie bmp, jpeg lub 
        png i dodaje je do biblioteki użytkownika.
Remove Selected Pictures from User Library (Usuń wybrane zdjęcia z biblioteki użytkownika)
        Usuwa wybrane obrazy z biblioteki użytkownika.
Reset Current Picture (Zresetuj bieżący obraz)
        Usuwa obraz z wybranej ścieżki/kanału.
Show Preview/Hide Preview (Pokaż podgląd/Ukryj podgląd)
        Otwiera/zamyka sekcję z dalszymi ustawieniami koloru i powiększenia.
Track Picture Preview (Podgląd obrazu ścieżki)
        Pokazuje aktualny obraz ścieżki. Po powiększeniu obrazu możesz przeciągnąć go myszą, aby 
        zmienić jego widoczną część.
Track Color(Kolor ścieżki)
        Otwiera Color Picker (próbnik kolorów), który pozwala wybrać kolor ścieżki.
Intensity (Intensywność)
        Umożliwia zastosowanie koloru ścieżki do obrazu ścieżki i ustawienie intensywności koloru.
Zoom (Powiększenie)
        Umożliwia zmianę rozmiaru obrazu ścieżki.
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Rotate (Obracaj)
        Umożliwia obracanie obrazu ścieżki.

Ustawianie wysokości ścieżki
Możesz powiększyć wysokość ścieżki, aby szczegółowo pokazać zdarzenia na ścieżce, lub możesz 
zmniejszyć wysokość kilku ścieżek, aby uzyskać lepszy przegląd projektu.

● Aby zmienić wysokość pojedynczej ścieżki, kliknij jej dolną krawędź na liście ścieżek i 
przeciągnij w górę lub w dół.
● Aby zmienić wysokość wszystkich ścieżek jednocześnie, przytrzymaj Ctrl/Cmd, kliknij dolną 
krawędź jednej ścieżki i przeciągnij w górę lub w dół.
● Aby ustawić liczbę ścieżek do wyświetlenia w oknie Project (projekt), użyj menu powiększenia 
ścieżki.
● Aby wysokość ścieżki była ustawiana automatycznie po wybraniu ścieżki, kliknij Edit > Enlarge
Selected Track (Edytuj > Powiększ wybraną ścieżkę).

POWIĄZANE LINKI
Menu Zoom (powiększenia) ścieżki na stronie 176
Okno dialogowe ustawień sterowania ścieżką na stronie 115 

Menu Zoom (powiększenia) ścieżki
Wyskakujące menu powiększenia ścieżki pozwala ustawić liczbę ścieżek i wysokość ścieżki w 
oknie Project (projekt).

● Aby otworzyć wyskakujące menu powiększenia ścieżki w prawym dolnym rogu okna (Project) 
projektu, kliknij przycisk strzałki nad kontrolką powiększenia pionowego.

                             

Dostępne są następujące opcje:

Zoom Tracks x Rows (Powiększ ścieżki x wiersze)
        Powiększa wszystkie wysokości ścieżek tak, aby pokazać określoną liczbę rzędów.
Zoom Tracks Full (Powiększ ścieżki pełne)
        Powiększa wszystkie ścieżki tak, aby zmieściły się w aktywnym oknie projektu.
Zoom Tracks N Rows (Powiększ ścieżki N wierszy)
        Umożliwia ustawienie liczby wierszy, które mają się zmieścić w aktywnym oknie projektu.
Zoom x Tracks (Zoom x Ścieżki)
        Powiększa określoną liczbę ścieżek, aby zmieściły się w aktywnym oknie projektu.
Zoom N Tracks (Zoom N Ścieżek)
        Umożliwia ustawienie liczby ścieżek, które mają się zmieścić w aktywnym oknie projektu.
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Zoom Tracks Minimal (Powiększ Ścieżki Minimalne)
        Powiększa wszystkie wysokości ścieżek do minimalnego rozmiaru.
Snap Track Heights (Przyciągaj wysokości ścieżki)
        Zmienia wysokość ścieżki w stałych przyrostach podczas zmiany jej rozmiaru.

Wybieranie ścieżek

Na liście ścieżek można wybrać jedną lub wiele ścieżek.

● Aby wybrać ścieżkę, kliknij ją na liście ścieżek.
● Aby zaznaczyć kilka ścieżek, Ctrl/Cmd kliknij kilka ścieżek.
● Aby zaznaczyć ciągły zakres ścieżek, kliknij z klawiszem Shift pierwszą i ostatnią ścieżkę w 
ciągłym zakresie ścieżek.

Wybrane ścieżki są podświetlane na liście ścieżek.

POWIĄZANE LINKI
Wybór ścieżki następuje po wyborze zdarzenia na stronie 1162
Przewiń do Wybrana ścieżka na stronie 1164
Wybierz kanał/ścieżkę w Solo na stronie 1164
Wybierz kanał/ścieżkę w (Edit Settings) Edytuj ustawienia na stronie 1164

Wybieranie utworów za pomocą klawiszy strzałek
Możesz wybierać ścieżki  i zdarzenia za pomocą klawisza strzałki w górę lub w dół na klawiaturze 
komputera. Możesz jednak ustawić klawisz Strzałka w górę i Strzałka w dół, aby były dostępne 
wyłącznie do wybierania utworów.

● Aby klawisze Strzałka w górę i Strzałka w dół były dostępne wyłącznie do wybierania ścieżek, 
aktywuj opcję Use Up/Down Navigation Commands for Selecting Tracks Only (Używaj poleceń
nawigacyjnych w górę/w dół tylko do wybierania ścieżek) w oknie dialogowym Preferences 
(Preferencje) (strona Editing (Edycja)).

Obowiązują następujące zasady:

● Jeśli ta opcja jest wyłączona i żadne zdarzenie/część nie jest zaznaczone w oknie Project, 
klawisze Strzałka w górę i Strzałka w dół służą do przechodzenia między ścieżkami na liście 
ścieżek.

● Jeśli ta opcja jest wyłączona, a zdarzenie/część jest zaznaczona w oknie projektu, klawisze 
Strzałka w górę i Strzałka w dół nadal przewijają ścieżki na liście ścieżek – ale na wybranej 
ścieżce pierwsze zdarzenie/część zostanie automatycznie być również wybrane.

● Jeśli ta opcja jest włączona, klawisze Strzałka w górę i Strzałka w dół służą tylko do zmiany 
wyboru ścieżki – bieżący wybór zdarzenia/części w oknie Project nie jest zmieniany.
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Odznaczanie ścieżek
Możesz usunąć zaznaczenie ścieżek zaznaczonych na liście ścieżek.

PROCEDURA
● Kliknij Shift + wybraną ścieżkę.

WYNIK
Utwór jest odznaczony

Powielanie ścieżek
Możesz zduplikować ścieżkę ze wszystkimi ustawieniami zawartości i kanału.

PROCEDURA
● Wybierz Project > Duplicate Tracks (Projekt > Powiel ścieżki).

WYNIK
Zduplikowana ścieżka pojawi się poniżej ścieżki oryginalnej.

Wyłączanie ścieżek
Możesz wyłączyć ścieżki audio, instrumentalne, MIDI i samplery, których nie chcesz w danym 
momencie odtwarzać ani przetwarzać. Wyłączenie ścieżki powoduje wyzerowanie jej głośności 
wyjściowej i wyłączenie całej aktywności dysku oraz przetwarzania ścieżki.

PROCEDURA
● Kliknij prawym przyciskiem myszy listę ścieżek i z menu kontekstowego wybierz opcję Disable 
Track (Wyłącz ścieżkę).

WYNIK
Zmienia się kolor ścieżki, a odpowiadający jej kanał w MixConsole jest ukryty.
Aby włączyć wyłączoną ścieżkę i przywrócić wszystkie ustawienia kanału, kliknij prawym 
przyciskiem myszy na liście ścieżek i wybierz Enable Track (Włącz ścieżkę).

Organizowanie ścieżek w ścieżkach folderów
Możesz uporządkować swoje utwory w folderach, przenosząc utwory do ścieżek folderów. Pozwala
to na edycję kilku ścieżek jako jednej całości. Ścieżki folderów mogą zawierać dowolny typ 
ścieżek, w tym inne ścieżki folderów.

● Aby dodać ścieżkę do folderu, kliknij opcję Add Track (Dodaj ścieżkę) w globalnym obszarze 
kontroli ścieżki na liście ścieżek, a następnie kliknij opcję Folder.
● Aby dodać ścieżkę do folderu i przenieść do niej wszystkie zaznaczone ścieżki, otwórz menu 
Project i z podmenu Track Folding (Składanie ścieżek) wybierz Move Selected Tracks to New 
Folder (Przenieś wybrane ścieżki do nowego folderu).
● Aby przenieść utwory do folderu, zaznacz je i przeciągnij na ścieżkę folderu.
● Aby usunąć utwory z folderu, zaznacz je i przeciągnij poza folder.
● Aby ukryć/pokazać ścieżki w folderze, kliknij przycisk Expand/Collapse Folder (Rozwiń/Zwiń 
folder) ścieżki folderu.
● Aby ukryć/pokazać dane na ścieżce folderu, otwórz menu kontekstowe ścieżki folderu i wybierz
opcję z podmenu Show Data on Folder Tracks (Pokaż dane na ścieżkach folderów).
● Aby wyciszyć/wyłączyć solo wszystkie ścieżki w ścieżce w folderze, kliknij przycisk Mute 
(Wycisz) lub Solo dla ścieżki w folderze.
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.
UWAGA
Ukryte ścieżki są odtwarzane jak zwykłe.

POWIĄZANE LINKI
Group Editing Mode (Tryb edycji grupy) na stronie 220

Przenoszenie ścieżek do ścieżek folderów
Możesz przenieść swoje ścieżki do ścieżek folderów, aby je uporządkować i przeprowadzić edycję 
kilku ścieżek jako jednej całości. Możesz przenieść dowolny typ ścieżki, w tym ścieżki z innych 
folderów, do ścieżek z folderami.

PROCEDURA
● Wybierz Project > Track Folding > Movre Selected Tracks to New Folder (Projekt > 
Składanie ścieżek > Przenieś wybrane ścieżki do nowego folderu).

WYNIK
Spowoduje to utworzenie nowego folderu i przeniesienie do niego wszystkich wybranych ścieżek.

UWAGA
Możesz także przeciągać i upuszczać ścieżki do ścieżki folderu lub z niej.

POWIĄZANE LINKI
Ścieżki folderów na stronie 148

Obsługa nakładających się dźwięków Audio
Podstawową zasadą dotyczącą ścieżek Audio jest to, że każda ścieżka może odtwarzać tylko jedno 
zdarzenie dźwiękowe na raz. Jeśli co najmniej dwa zdarzenia nakładają się na siebie, odtwarzane 
jest tylko to, które jest przed nimi. Możesz jednak wybrać zdarzenie/region, który chcesz 
odtworzyć.

PROCEDURA
● Wykonaj jedną z następujących czynności:
● Kliknij prawym przyciskiem myszy zdarzenie dźwiękowe na ekranie zdarzeń i wybierz żądane 
zdarzenie lub region z podmenu To Front (Do przodu) lub Set to Region (Ustaw na region).
UWAGA
Dostępne opcje zależą od tego, czy wykonałeś rejestrację liniową czy cykliczną oraz od używanego
trybu nagrywania. Podczas nagrywania dźwięku w trybie cyklicznym zarejestrowane zdarzenie jest 
dzielone na regiony, po jednym dla każdego ujęcia.
● Kliknij środkowy uchwyt na dolnej krawędzi zdarzenia skumulowanego i wybierz wpis z 
wyskakującego menu.
● Na liście utworów włącz opcję Show Lanes (Pokaż pasy) i wybierz żądane ujęcie.

POWIĄZANE LINKI
Pasy, próby i nakładające się zdarzenia na stronie 181
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Track Folding Menu (Menu Składanie Ścieżek)
Możesz pokazywać, ukrywać lub odwracać ścieżki, które są wyświetlane w oknie projektu. 
Pozwala to podzielić projekt na kilka części, tworząc kilka ścieżek folderów dla różnych elementów
projektu i pokazując/ukrywając ich zawartość, wybierając funkcję menu lub używając skrótów 
klawiaturowych. W ten sposób można również złożyć ścieżki automatyzacji.

● Aby otworzyć podmenu Track Folding (Składanie ścieżek), wybierz Project > Track Folding 
(Projekt > Składanie ścieżek).

Dostępne są następujące opcje:

Toggle Selected Track (Przełącz wybraną ścieżkę)
        Odwraca stan złożwenia wybranej ścieżki.
Fold Tracks (Złóż ścieżki)
        Składa wszystkie otwarte ścieżki folderów w oknie Project (projektu).
UWAGA
Zachowanie tej funkcji zależy od ustawienia Deep Track Folding w oknie dialogowym 
Preferences (Preferencje).
Unfold Tracks (Rozwiń ścieżki)
        Rozwija wszystkie ścieżki folderów w oknie Project (projekt)
UWAGA
Zachowanie tej funkcji zależy od ustawienia Deep Track Folding w oknie dialogowym 
Preferences (Preferencje).
Flip Fold States (Odwróć stany składania)
        Odwraca stany zagięcia ścieżek w oknie projektu. Oznacza to, że wszystkie ścieżki, które 
        zostały złożone, zostaną rozłożone, a wszystkie rozłożone ścieżki zostaną złożone.
Move Selected Tracks to New Folder (Przenieś wybrane ścieżki do nowego folderu)
        Przenosi wszystkie wybrane ścieżki do ścieżki folderu. Ta opcja menu jest dostępna, jeśli 
        dostępna jest co najmniej jedna ścieżka folderu.
UWAGA
● Do tych opcji menu można przypisać polecenia klawiszowe w oknie dialogowym Key 
Commands (Polecenia klawiszowe) w kategorii Project.
● Jeśli włączysz Deep Track Folding w oknie dialogowym Preferences (Preferencje) (Editing 
(Edycja) — strona Project & MixConsole), składanie ścieżek zostanie zastosowane do wszystkich 
podelementów ścieżek.

Wyświetlanie zdarzeń na ścieżkach folderów
Ścieżki z zamkniętymi folderami mogą wyświetlać dane zawartych ścieżek audio, MIDI i 
instrumentów jako bloki danych lub jako zdarzenia

Po zamknięciu ścieżek folderów zawartość zawartych ścieżek jest wyświetlana jako bloki danych 
lub zdarzenia. W zależności od wysokości ścieżki folderu, wyświetlanie zdarzeń może być mniej 
lub bardziej szczegółowe.
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Modyfikowanie wyświetlania zdarzeń na ścieżkach folderów
Możesz modyfikować wyświetlanie zdarzeń na ścieżkach folderów.

PROCEDURA
1. Kliknij prawym przyciskiem myszy ścieżkę folderu.
2. Z menu kontekstowego wybierz opcję Show Data on Folder Tracks (Pokaż dane na ścieżkach 
folderów).
Masz następujące opcje:
● Always Show Data (Zawsze pokazuj dane)
          Zawsze wyświetla bloki danych lub szczegóły zdarzeń.
● Never Show Data (Nigdy nie pokazuj danych)
          Nic nie wyświetla.
● Hide Data When Expanded (Ukryj dane po rozwinięciu)
          Ukrywa wyświetlanie zdarzeń podczas otwierania ścieżek folderów.
● Show Event Details (Pokaż szczegóły zdarzenia)
          Wyświetla szczegóły zdarzenia zamiast bloków danych.

UWAGA
Możesz zmienić te ustawienia w oknie dialogowym Preferences (Preferencje) Event Display – 
Folders page (Wyświetlanie zdarzeń — strona Foldery).

POWIĄZANE LINKI
Wyświetlanie zdarzeń — foldery na stronie 1168

Pasy, próby i nakładające się zdarzenia
W dalszej części skupimy się na nagraniach cyklicznych z ujęciami. Możesz jednak zastosować 
operacje na pasach i metody kompilacji w przypadku nakładających się zdarzeń lub części, które 
składasz na jednej ścieżce.

Jeśli wykonujesz nagrywanie cykliczne w trybach Keep History lub Cycle History + Replace 
(audio) lub w trybach Stacked lub Mix-Stacked (MIDI), zarejestrowane okrążenia cyklu są 
wyświetlane na ścieżce z ostatnim nagranym dublem aktywnym i na górze .

Tryb Show Lanes (Pokaż pasy) zapewnia dobry przegląd wszystkich ujęć. Jeśli aktywujesz 
przycisk Show Lanes, nagrane duble są wyświetlane na osobnych ścieżkach.

                              
Ścieżki są obsługiwane w różny sposób, w zależności od tego, czy pracujesz z Audio, czy z MIDI:

Audio
Ponieważ każda ścieżka dźwiękowa może odtwarzać tylko jedno zdarzenie dźwiękowe naraz, 
usłyszysz tylko ujęcie aktywowane do odtwarzania, na przykład ostatnie okrążenie nagrywania 
cyklu.
MIDI
Nakładające się duble (partie) MIDI mogą być odtwarzane jednocześnie. Jeśli nagrywałeś w trybie 
Mix-Stacked, usłyszysz wszystkie duble ze wszystkich okrążeń cyklu.

Pasy można zmieniać, zmieniać ich rozmiar i powiększać jak zwykłe ścieżki.
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Aby grać solo na linii, możesz aktywować dla niej przycisk Solo. Pozwala to usłyszeć pas w 
kontekście projektu. Jeśli chcesz usłyszeć ujęcie bez kontekstu projektu, musisz także aktywować 
przycisk Solo na ścieżce głównej.

Montaż idealnego ujęcia
Możesz odtwarzać, dzielić i aktywować duble, aby połączyć najlepsze fragmenty nagrania w 
ostatecznym ujęciu.

PROCEDURA
1. Wybierz narzędzie Comp (kompilacji) lub Object Selection (narzędzie do zaznaczania 
obiektów).
2. Przesuń dubel na wierzch, aby wybrać go do odtworzenia i posłuchaj.
3. Przesłuchaj różne ujęcia, aby porównać je bardziej szczegółowo.
4. Jeśli to konieczne, podziel ujęcia na mniejsze sekcje, utwórz nowe zakresy i przenieś je na 
pierwszy plan.
5. Kontynuuj, aż będziesz zadowolony z rezultatu.

PO WYKONANIU TEGO ZADANIA
Po złożeniu idealnego ujęcia możesz je ulepszyć.
● Aby automatycznie rozwiązać nakładanie się i usunąć puste pasy, kliknij ścieżkę prawym 
przyciskiem myszy i wybierz Clean Up Lanes (Oczyść pasy).

W przypadku Audio wykonaj następujące czynności:
● Zastosuj automatyczne zanikanie i przenikanie do skompilowanych ujęć.
● Aby umieścić wszystkie duble na jednym torze i usunąć wszystkie duble w tle, zaznacz wszystkie
duble i wybierz Audio > Advanced > Delete Overlaps (Audio > Zaawansowane > Usuń nakładki).
● Aby utworzyć nowe i ciągłe zdarzenie ze wszystkich wybranych ujęć, wybierz kolejno Audio > 
Bounce Selection (Audio > Wybór odbicia).

W przypadku MIDI wykonaj następujące czynności:
● Otwieraj duble w edytorze MIDI, aby dokonywać drobnych korekt, takich jak usuwanie lub 
edytowanie nut.
● Aby utworzyć nową i ciągłą część wszystkich wybranych dubli, która jest umieszczona na 
jednym torze, zaznacz wszystkie próby i wybierz MIDI > Bounce MIDI.
● Aby utworzyć nową partię i umieścić ją na nowej ścieżce, wybierz MIDI > Merge MIDI in 
Loop.
Na koniec oczyść pasy w następujący sposób:
● Kliknij tor prawym przyciskiem myszy i wybierz Create Tracks from Lanes (Utwórz ścieżki z 
pasów). Pas zostanie przekształcony w nową ścieżkę.

Operacje montażu
O ile nie zaznaczono inaczej, wszystkie operacje można wykonywać w oknie Project i w Audio 
Part Editor (Edytorze części audio). Snap (Pstryknięcie) jest brany pod uwagę, a wszystkie 
operacje można cofnąć.
Aby złożyć idealne ujęcie, możesz użyć narzędzia Comp, narzędzia do zaznaczania obiektów 
(Object Selection) lub narzędzia do zaznaczania zakresu (Range Selection).
● Narzędzie Comp modyfikuje jednocześnie wszystkie ujęcia na wszystkich ścieżkach.
Jest to przydatne, jeśli nagrane duble mają tę samą pozycję początkową i końcową.
● Narzędzie Object Selection (Zaznaczanie obiektów) i narzędzie Range Selection (Zaznaczanie 
zakresu) wpływają na pojedyncze ujęcia poszczególnych torów.
Jeśli to nie jest to, czego chcesz, możesz wprowadzić zmiany na ścieżce głównej lub użyć narzędzia
Comp.
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UWAGA
Jeśli układasz zdarzenia na ścieżce audio, wyłącz opcję Treat Muted Audio Events like Deleted 
(Traktuj wyciszone zdarzenia audio jak usunięte) w oknie dialogowym Preferences (Preferencje) 
(strona Editing – Audio (Edycja — Audio)).
Możesz wykonać następujące operacje:

Operacje montażu

Operacja Narzędzie Tool Narzędzie Object
Selection/Range Selection

Select (Wybierz)
(Tylko okno Project)

Przytrzymaj Shift i kliknij
ujęcie.

Kliknij ujęcie.

Bring to front (Przesuń na
wierzch)

Kliknij ujęcie. Kliknij
dwukrotnie, aby przełączyć

Umieść wskaźnik myszy nad
środkiem dolnej krawędzi
dubla, aż zmieni się on w
symbol Comp, i kliknij.
Kliknij dwukrotnie, aby

przełączyć.
W przypadku MIDI

wycisza/włącza wyciszenie
dubla.

Comping
(utwórz nowy zakres i

przenieś go na wierzch,
tylko okno Project)

Kliknij i przeciągnij po pasie.
Wszystkie duble są dzielone na
początku i na końcu zakresu.
Jeśli duble audio sąsiadują ze

sobą bez przerw lub zaników, a
sam materiał pasuje, duble są

scalane w zakresie.

_

Audition (Przesłuchanie)

Naciśnij klawisze Ctrl/Cmd,
aby aktywować narzędzie

Speaker (Głośnik), i kliknij
miejsce, w którym chcesz
rozpocząć odtwarzanie.

Patrz po lewej.

Move (Przenieś)
Kliknij i przeciągnij na głównej

ścieżce.
Kliknij i przeciągnij na

dowolnym pasie.

Resize (Zmień rozmiar)

Przeciągnij uchwyty zmiany
rozmiaru. Dotyczy to wszystkich

dubli z tą samą pozycją
początkową i końcową.
Zmiana rozmiaru jest

ograniczona do końca lub
początku sąsiednich ujęć.

Gwarantuje to, że nie utworzysz
przypadkowo nakładek.

Przeciągnij uchwyty zmiany
rozmiaru.

Correct Timing
(Prawidłowy czas)

(Zdarzenie Slip (poślizgu))

Wybierz ujęcie, przytrzymaj
Alt/Opt - Shift (modyfikator

narzędzia dla Slip Event) i
przeciągnij myszą.

Patrz po lewej

Split (Rozdziel) Alt/Opt – kliknij ujęcie. Jeśli Patrz po lewej.
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podzielisz partię MIDI, a pozycja
podziału przecina jedną lub kilka
nut MIDI, wynik zależy od opcji

Split MIDI Events (Rozdziel
zdarzenia MIDI) w oknie
dialogowym Preferences

(Preferencje) (Editing (Edycja)
— strona MIDI).

Adjust Splits (Dostosuj
podziały)

Umieść wskaźnik myszy nad
podziałem i przeciągnij w lewo

lub w prawo.
Patrz po lewej.

Gluing Splits (Klejenie
podziałów)

Wprowadź nowy zakres na
pierwszy plan.

Wybierz zakres obejmujący
wszystkie podziały, które

chcesz skleić, i kliknij
dwukrotnie.

POWIĄZANE LINKI
Dzielenie zdarzeń na stronie 215

Definiowanie podstawy czasu ścieżki  
Podstawa czasu ścieżki określa, czy wydarzenia na ścieżce są rozmieszczone na taktach i 
uderzeniach (muzyczna podstawa czasu), czy na osi czasu (liniowa podstawa czasu). Zmiana tempa
odtwarzania wpływa tylko na pozycję czasową zdarzeń na ścieżkach z muzyczną podstawą czasu.

PROCEDURA

● Na liście utworów kliknij Toggle Timebase  (Przełącz podstawę czasu), aby zmienić 
podstawę czasu.

WYNIK
Muzyczna podstawa czasu jest oznaczona symbolem nuty:

                           

Liniowa podstawa czasu jest oznaczona symbolem zegara:

                          
UWAGA
Przełączanie między liniową a muzyczną podstawą czasu powoduje bardzo niewielką utratę 
precyzji pozycjonowania. Dlatego należy unikać wielokrotnego przełączania między tymi dwoma 
trybami.

POWIĄZANE LINKI
Edytowanie tempa i metrum na stronie 1023
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Definiowanie domyślnej podstawy czasu ścieżki
Możesz określić domyślny typ czasu ścieżki dla nowych ścieżek (ścieżki audio, grupy/FX, MIDI i 
znaczniki).

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz Editing (Edycja).
2. Otwórz menu podręczne Default Track Time Type (Domyślny typ czasu ścieżki) i wybierz 
domyślny typ czasu ścieżki.

            

WYNIK
Jeśli wybrano opcję Follow Transport Main Display (Podążaj za głównym wyświetlaczem 
transportu), używane jest ustawienie podstawowego formatu czasu w panelu Transport. Gdy jest to
ustawione na Bars+Beats (Takty+Uderzenia), dodawane są ścieżki z muzyczną podstawą czasu. 
Gdy ta opcja jest ustawiona na dowolną inną opcję (Sekundy, Kod czasowy, Próbki itp.), wszystkie 
nowe ścieżki korzystają z liniowej podstawy czasu.

POWIĄZANE LINKI
Domyślny typ czasu ścieżki na stronie 1161

Wersje ścieżek
Wersje ścieżek umożliwiają tworzenie i zarządzanie wieloma wersjami zdarzeń i części na tej samej
ścieżce.
Wersje ścieżek są dostępne dla ścieżek audio, MIDI i ścieżek instrumentalnych. Możesz także mieć 
wersje ścieżek akordów, ścieżki podpisu i ścieżki tempa.

Wersje ścieżek są przydatne do następujących zadań:
● Rozpoczynanie nowych nagrań od zera.
● Porównanie różnych ujęć i kompozycji.
● Zarządzanie ujęciami nagranymi w nagraniu wielościeżkowym.
UWAGA:
Wersje ścieżek nie są dostępne dla ścieżek automatyzacji.

Wersje ścieżek są zawarte w archiwach ścieżek i kopiach zapasowych projektów.
Polecenia dotyczące wersji ścieżek można znaleźć w kategorii Track Versions (Wersje ścieżek) w 
oknie dialogowym Key Commands (Polecenia dotyczące klawiszy, Skróty klawiaturowe).

Wyskakujące menu wersji ścieżek
Wyskakujące menu Track Versions (Wersje ścieżek) jest dostępne dla wszystkich typów ścieżek, 
które obsługują wersje ścieżek. Zawiera najważniejsze funkcje do zarządzania wersjami ścieżek 
oraz listę wersji ścieżek.
● Aby otworzyć wyskakujące menu Track Versions dla ścieżki, kliknij strzałkę po prawej stronie 
nazwy ścieżki.
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Dostępne są następujące opcje:

Track Version list (Lista wersji ścieżki)
         Wyświetla listę wszystkich wersji ścieżki, dla której zostało otwarte menu podręczne 
         Track Versions (Wersje ścieżki) i umożliwia aktywację wersji ścieżki.
New Version (Nowa wersja)
         Tworzy nową, pustą wersję ścieżki dla wszystkich wybranych ścieżek.
Duplicate Version (Duplikat wersji)
         Tworzy kopię aktywnej wersji ścieżki dla wszystkich wybranych ścieżek.
Rename Version (Zmień nazwę wersji)
         Otwiera okno dialogowe umożliwiające zmianę nazwy wersji ścieżki dla wybranych ścieżek.
Delete Version (Usuń wersję)
         Usuwa aktywną wersję ścieżki dla wszystkich wybranych ścieżek. Ta opcja jest dostępna 
         tylko wtedy, gdy ścieżka ma więcej niż jedną wersję.
Select Traks with Same Version ID (Wybierz ścieżki z tym samym identyfikatorem wersji)
        Wybiera wszystkie ścieżki, które mają wersję ścieżki o tym samym identyfikatorze.
Show Version Name in Track List (Pokaż nazwę wersji na liście ścieżek).
        Pokazuje/ukrywa nazwę wersji obok nazwy ścieżki na liście ścieżek.

Sekcja wersji ścieżek
Sekcja Track Versions (Wersje ścieżek) w Inspector (Inspektorze) umożliwia przeglądanie wersji 
ścieżek dla wybranej ścieżki i zarządzanie nimi. Jest dostępny dla ścieżek audio, ścieżek MIDI, 
ścieżek instrumentów, ścieżki samplera i ścieżki akordów.
● Aby otworzyć sekcję Track Versions (Wersje ścieżek) dla ścieżki, zaznacz ścieżkę 
i w Inspector kliknij sekcję Track Versions.

                              

Track Version Indicator (Wskaźnik wersji śledzenia)
         Wskazuje, że istnieje więcej niż jedna wersja ścieżki.
Name (Nazwa)
         Pokazuje nazwę wersji. Kliknij dwukrotnie, aby to zmienić. Nazwa zostanie zmieniona dla 
         wszystkich wybranych ścieżek.
ID
        Pokazuje identyfikator wersji ścieżki.
Track Version list (Lista wersji ścieżki)
       Wyświetla listę wszystkich wersji ścieżek i umożliwia aktywację jednej z nich dla wszystkich 
       wybranych ścieżek.
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New Version (Nowa wersja)
         Tworzy nową, pustą wersję ścieżki dla wszystkich wybranych ścieżek.
Duplicate Version (Duplikat wersji)
         Tworzy kopię aktywnej wersji ścieżki dla wszystkich wybranych ścieżek.
Delete Version (Usuń wersję)
        Usuwa aktywną wersję ścieżki dla wszystkich wybranych ścieżek. Ta funkcja jest dostępna 
        tylko wtedy, gdy ścieżka ma więcej niż jedną wersję ścieżki.

Tworzenie nowych wersji ścieżek
Możesz tworzyć nowe, puste wersje ścieżek dla wybranych ścieżek.

PROCEDURA
1. Na liście utworów wybierz utwory, dla których chcesz utworzyć nową wersję utworu.
2. Wybierz Project > Track Versions > New Version (Projekt > Wersje ścieżek > Nowa wersja).
UWAGA
Możesz także użyć sekcji Track Versions (Wersje ścieżek) w Inspector (Inspektorze) (dostępnej 
tylko dla ścieżek audio, ścieżek MIDI, ścieżek instrumentów i ścieżki akordów) lub wyskakującego
menu Track Versions na liście ścieżek, aby utworzyć nową wersję ścieżki.

WYNIK
Wyświetlacz zdarzenia pokazuje nową, pustą wersję ścieżki.  Zdarzenia z poprzednich wersji 
ścieżek są ukryte. Lista ścieżek zawiera domyślną nazwę wersji.

Identyfikatory wersji ścieżki
Wszystkim wersjom ścieżek automatycznie przypisywany jest identyfikator. Wersje ścieżek, które 
są tworzone razem, otrzymują ten sam identyfikator wersji ścieżki i można je wybrać razem.

W sekcji Track Versions (Wersje ścieżki) w Inspector, identyfikator wersji śledzenia jest 
wyświetlany w kolumnie ID (identyfikator) na liście wersji ścieżek.

Na liście ścieżek możesz otworzyć menu podręczne Track Versions, aby zobaczyć identyfikator 
wersji ścieżki.

Wybieranie ścieżek według identyfikatora wersji ścieżki
Możesz jednocześnie wybrać wszystkie ścieżki, które mają ten sam identyfikator wersji ścieżki.

PROCEDURA
1. Aktywuj wersję ścieżki.
2. Wybierz Project > Track Versions > Select Tracks with Same Version ID (Projekt > Wersje 
ścieżek > Wybierz ścieżki z tym samym identyfikatorem wersji).

WYNIK
Zostaną wybrane wszystkie ścieżki, które mają wersje ścieżek o tym samym identyfikatorze.
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Przypisywanie wspólnego identyfikatora
Wersje ścieżek na różnych ścieżkach, które nie zostały utworzone razem, mają różne identyfikatory
wersji ścieżek. Wersje ścieżek z różnymi identyfikatorami nie mogą być aktywowane razem. Aby 
to zrobić, musisz przypisać nowe identyfikatory wersji do tych ścieżek.

PROCEDURA
1. Wybierz ścieżki i aktywuj wersje ścieżek, którym chcesz przypisać wspólny identyfikator wersji.
2. Wybierz Project > Track Versions > Assign Common Version ID (Projekt > Śledź wersje > 
Przypisz wspólny identyfikator wersji).

WYNIK
Nowy identyfikator jest przypisywany do wszystkich aktywnych wersji ścieżek na wybranych 
ścieżkach. Ścieżki są teraz oznaczone jako należące do siebie. Możesz teraz aktywować je razem.

Aktywna wersja ścieżki
Jeśli dla ścieżki utworzono więcej niż jedną wersję ścieżki, możesz wyświetlić zdarzenia z 
określonej wersji ścieżki na ekranie zdarzeń. Ten proces jest określany jako aktywowanie wersji 
ścieżek.

 Aktywacja wersji ścieżki
Możesz aktywować jedną ze swoich wersji ścieżki. Pokazuje to również jej zdarzenia na 
wyświetlaczu zdarzeń.

PROCEDURA
1. Kliknij strzałkę po prawej stronie nazwy ścieżki, aby otworzyć menu podręczne Track Versions 
(Wersje ścieżek).

2. Wybierz wersję ścieżki, którą chcesz aktywować.
3. Opcjonalnie: Aktywuj Show Version Name in Track List (Pokaż nazwę wersji na liście 
ścieżek).
Spowoduje to wyświetlenie nazwy wersji obok nazwy ścieżki na liście ścieżek.

WYNIK
Wybrana wersja zostanie aktywowana, a jej zdarzenia zostaną pokazane na wyświetlaczu zdarzeń.

UWAGA
Jeśli pracujesz ze ścieżkami audio, ścieżkami MIDI, ścieżkami instrumentów, ścieżką samplera lub 
ścieżką akordów, możesz także użyć sekcji Track Versions (Wersje ścieżek) w Inspector, aby 
aktywować wersję ścieżki.

POWIĄZANE LINKI
Menu podręczne Track Versions (Wersje ścieżek) na stronie 185
Nazwy wersji ścieżek na stronie 190
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Aktywacja wersji ścieżki na wielu ścieżkach
Możesz jednocześnie aktywować wersje ścieżek na wielu ścieżkach, jeśli te wersje mają ten sam 
identyfikator.

PROCEDURA
1. Wybierz wszystkie ścieżki, dla których chcesz aktywować określoną wersję ścieżki.
2. Kliknij strzałkę po prawej stronie nazwy ścieżki, aby otworzyć wyskakujące menu Track 
Versions (Wersje ścieżek).
3. Wybierz z listy wersję ścieżki, którą chcesz aktywować.

WYNIK
Wybrana wersja ścieżki zostanie aktywowana dla wszystkich wybranych ścieżek, a odpowiednie 
zdarzenia zostaną pokazane na wyświetlaczu zdarzeń.

UWAGA
Jeśli pracujesz ze ścieżkami audio, ścieżkami MIDI, ścieżkami instrumentów lub ścieżką akordów, 
możesz także użyć sekcji Track Versions (Wersje ścieżek) w Inspector (Inspektorze), aby 
aktywować wersję ścieżki.

Powielanie wersji ścieżek
Możesz zduplikować wersję ścieżki, tworząc nową wersję ścieżki, która zawiera kopię aktywnej 
wersji ścieżki.

PROCEDURA
1. Na liście utworów wybierz utwory i aktywuj wersję utworu, którą chcesz powielić.
2. Wybierz Project > Track Versions > Duplicate Version (Projekt > Wersje ścieżek > Powiel 
wersję). Na ekranie zdarzeń wyświetlana jest zduplikowana wersja utworu. Na liście ścieżek 
wyświetlana jest domyślna nazwa wersji duplikatu.
UWAGA
Możesz także użyć sekcji Track Versions (Wersje ścieżek) w Inspektorze dla ścieżek audio, 
ścieżek MIDI, ścieżek instrumentów i ścieżek akordów lub wyskakującego menu Track Versions 
na liście ścieżek, aby powielić wersję ścieżki.

Usuwanie wersji ścieżek
Możesz usunąć wersje ścieżek, których już nie potrzebujesz.

PROCEDURA
1. Wybierz ścieżki i aktywuj wersje ścieżek, które chcesz usunąć.
2. Wybierz Project > Track Versions > Delete Version (Projekt > Śledź wersje > Usuń wersję).

UWAGA
Możesz także użyć sekcji Track Versions (Wersje ścieżek) w Inspektorze dla ścieżek audio, 
ścieżek MIDI, ścieżek instrumentów i ścieżek akordów lub wyskakującego menu Track Versions 
na liście ścieżek, aby usunąć aktywną wersję ścieżek dla wybranych ścieżek.
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Kopiowanie i wklejanie zakresów zaznaczenia między wersjami 
ścieżek
Możesz kopiować i wklejać zakresy między różnymi wersjami ścieżek, nawet na wielu ścieżkach.

WARUNEK WSTĘPNY
Masz co najmniej 2 wersje utworów.

PROCEDURA
1. Wybierz narzędzie Range Selection (Zaznaczanie zakresów).
2. Wybierz zakres wersji ścieżki, którą chcesz skopiować.
3. Wybierz Edit > Copy (Edytuj > Kopiuj).
4. Aktywuj wersję ścieżki, do której chcesz wstawić skopiowany zakres.
5. Wybierz polecenie Edit > Paste (Edytuj > Wklej).

WYNIK
Skopiowany zakres z pierwszej wersji ścieżki jest wklejany do drugiej wersji ścieżki w dokładnie 
tym samym miejscu.

UWAGA
Jeśli chcesz wykonać bardziej skomplikowane zadania kompilacji, zalecamy wybranie opcji 
Project > Track Versions > Create Lnes from Versions (Projekt > Wersje ścieżek > Utwórz pasy
z wersji) i kontynuowanie korzystania z narzędzia Comp.

Kopiowanie i wklejanie wybranych zdarzeń między wersjami ścieżki.
Możesz kopiować i wklejać wybrane zdarzenia między różnymi wersjami ścieżek, nawet na wielu 
ścieżkach.
WARUNEK WSTĘPNY
Masz co najmniej 2 wersje ścieżki i rozdzieliłeś na przykład odpowiednie zdarzenia za pomocą 
narzędzia Split (Podziel).

PROCEDURA
1. Wybierz narzędzie Object Selection (Zaznaczanie obiektów).
2. Wybierz zdarzenia, które chcesz skopiować.
3. Wybierz Edit > Copy (Edytuj > Kopiuj).
4. Aktywuj wersję ścieżki, do której chcesz wstawić skopiowane zdarzenia.
5. Wybierz Edit > Functions > Paste at Origin (Edycja > Funkcje > Wklej w miejscu 
pochodzenia).
Gwarantuje to, że zdarzenia zostaną wstawione dokładnie w tym samym miejscu.

WYNIK
Skopiowane zdarzenia z pierwszej wersji ścieżki są wklejane do drugiej wersji ścieżki w dokładnie 
tym samym miejscu.

Nazwy wersji ścieżek
Każda wersja ścieżki ma domyślną nazwę wersji ścieżki.

Jeśli dla ścieżki dostępna jest więcej niż jedna wersja, nazwa wersji ścieżki jest wyświetlana na 
liście ścieżek oraz w sekcji Track Versions (Wersje ścieżek) w Inspektorze. Domyślnie wersje 
ścieżek noszą nazwy v1, v2 itd. Możesz jednak zmienić nazwę każdej wersji ścieżki według 
własnych upodobań.
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UWAGA
Możesz pokazać/ukryć nazwę wersji obok nazwy ścieżki na liście ścieżek, aktywując/dezaktywując
opcję Show Version Name in Track List (Pokaż nazwę wersji na liście ścieżek) w wyskakującym 
menu Track Versions (Wersje ścieżek) dla ścieżki.

POWIĄZANE LINKI
Menu podręczne Track Versions (Wersje ścieżek) na stronie 185

Zmiana nazwy wersji ścieżki
Możesz zmieniać nazwy wersji ścieżek.

PROCEDURA
● W sekcji Track Versions (Wersje śledzenia) w Inspector kliknij dwukrotnie nazwę wersji 
śledzenia i wprowadź nową nazwę.
Nazwa została zmieniona. Jeśli dostępne miejsce na liście utworów jest zbyt małe, nazwa zostanie 
automatycznie skrócona.

                                          

Zmienianie nazw wersji ścieżek na wielu ścieżkach
Możesz zmieniać nazwy wersji ścieżek na wielu ścieżkach.

PROCEDURA
1. Aktywuj wszystkie wersje ścieżek, których nazwy chcesz zmienić, i wybierz odpowiednie 
ścieżki.
2. Wybierz Project > Track Versions > Rename Version (Projekt > Wersje ścieżki > Zmień 
nazwę wersji).
3. Wprowadź nazwę nowej wersji ścieżki i kliknij OK.

                         

WYNIK
Na liście ścieżek zostanie wyświetlona nazwa nowej wersji ścieżki.

UWAGA
Jeśli chcesz przypisać ten sam identyfikator do wersji ścieżki, wybierz opcję Project > Track 
Versions > Assign Common Version ID Projekt > Wersje ścieżki > Przypisz wspólny 
identyfikator wersji.
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Wersje ścieżki a pasy
Wersje ścieżek i pasy to indywidualne cechy, które wzajemnie się uzupełniają. Każda wersja 
ścieżki może mieć własny zestaw pasów.

Tworzenie pasów z wersji ścieżki
Jeśli Twój projekt zawiera wersje ścieżek i chcesz kontynuować pracę z pasami, na przykład za 
pomocą narzędzia Comp możesz utworzyć pasy z wersji ścieżek.

PROCEDURA
1. Wybierz ścieżki, dla których chcesz utworzyć pasy.
2. Wybierz Project > Track Versions > Create Lanes from Versions (Projekt > Wersje ścieżki > 
Utwórz pasy z wersji).
Dodano nową wersję toru o nazwie Lanes from Version. Ta wersja ścieżki zawiera wszystkie 
wersje ścieżek na oddzielnych pasach. Oryginalne wersje ścieżek są zachowane. Ścieżki utworzone 
z wersji ścieżek MIDI są wyciszone.
3. Na liście ścieżek lub w Inspektorze aktywuj przycisk Show Lanes (Pokaż pasy) dla ścieżki.
4. Na pasku narzędzi okna projektu aktywuj narzędzie Comp i kontynuuj jak zwykle.

Tworzenie wersji ścieżek z pasów
Jeśli Twój projekt zawiera pasy i chcesz kontynuować pracę z funkcjami wersji ścieżki, możesz 
utworzyć wersje ścieżki na podstawie pasów.

PROCEDURA
1. Wybierz ścieżki, dla których chcesz utworzyć wersje ścieżek.
Jeśli chcesz przekonwertować tylko określone pasy, wybierz te pasy.
2. Wybierz Project > Track Versions > Create Versions from Lanes (Projekt > Wersje ścieżki > 
Utwórz wersje z pasów).

WYNIK
Dodano nowe wersje ścieżek, po jednej dla każdego oddzielnego pasa. Oryginalne pasy są 
zachowane. Wszelkie przejścia między ścieżkami, które utworzyłeś między różnymi pasami, są 
odrzucane.

Wstępne ustawienia ścieżki
Presety ścieżek to szablony, które można zastosować do nowo utworzonych lub istniejących 
ścieżek tego samego typu.

Możesz je tworzyć z praktycznie wszystkich typów ścieżek (audio, MIDI, instrument, sampler, 
grupa, FX, kanał zwrotny instrumentu VST, kanały wejściowe i wyjściowe). Zawierają ustawienia 
dźwięku i kanałów oraz umożliwiają szybkie przeglądanie, podgląd, wybór i zmianę dźwięków lub 
ponowne wykorzystanie ustawień kanałów w różnych projektach.
Predefiniowane ustawienia ścieżek są uporządkowane w MediaBay. Tam możesz kategoryzować je
za pomocą atrybutów.
Zastosowanie ustawienia wstępnego ścieżki powoduje zastosowanie wszystkich ustawień 
zapisanych w ustawieniu wstępnym.
Ustawienia wstępne ścieżek można zastosować tylko do ścieżek własnego typu. Jedynym 
wyjątkiem są ścieżki instrumentów: dla nich dostępne są również presety VST.
UWAGA
● Po zastosowaniu ustawienia wstępnego ścieżki nie można cofnąć zmian. Nie ma możliwości 
usunięcia zastosowanego presetu ze ścieżki i powrotu do poprzedniego stanu. Jeśli nie jesteś 
zadowolony z ustawień ścieżki, musisz ręcznie edytować ustawienia lub zastosować inne 
ustawienie wstępne.
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● Zastosowanie presetów VST do ścieżek instrumentów prowadzi do usunięcia modyfikatorów, 
insertów MIDI, insertów lub EQ. Te ustawienia nie są przechowywane w ustawieniach VST.

Ustawienia wstępne ścieżki Audio
Ustawienia wstępne ścieżek dla ścieżek audio, ścieżek grupowych, ścieżek FX, kanałów 
instrumentów VST, kanałów wejściowych i wyjściowych obejmują wszystkie ustawienia 
definiujące dźwięk.

Możesz użyć ustawień fabrycznych jako punktu wyjścia do własnej edycji i zapisać ustawienia 
audio zoptymalizowane dla artysty, z którym często pracujesz, jako ustawienie wstępne dla 
przyszłych nagrań.

Następujące dane są zapisywane w ustawieniach ścieżek audio:
● Wstaw ustawienia efektów (w tym ustawienia efektów VST)
● Ustawienia EQ
● Głośność (Volume) i panorama (Pan)
● Wzmocnienie wejściowe (Gain) i faza (Phase)
UWAGA
Aby uzyskać dostęp do funkcji presetów ścieżek dla kanałów wejściowych i wyjściowych, aktywuj 
przyciski zapisu (Write) dla kanałów wejściowych i wyjściowych w MixConsole. Spowoduje to 
utworzenie ścieżek kanału wejściowego i wyjściowego na liście ścieżek.

Presety (wstępne ustawienia) ścieżki MIDI
Możesz użyć presetów ścieżek MIDI dla multitimbralowych instrumentów VST. Można ich 
również używać do instrumentów zewnętrznych.

Podczas tworzenia presetów ścieżek MIDI możesz dołączyć kanał lub ścieżkę dostępu (patch).
● Aby upewnić się, że zapisane ustawienia ścieżek MIDI dla instrumentów zewnętrznych będą 
ponownie działać z tym samym instrumentem, zainstaluj instrument jako urządzenie MIDI, patrz 
oddzielny dokument MIDI Devices (Urządzenia MIDI).

Następujące dane są zapisywane w ustawieniach ścieżek MIDI:
● Modyfikatory MIDI (Transpozycja itp.)
● Efekty insertowe MIDI
● Wyjście i zmiana kanału lub programu (Channel Change i Program Change)
● Ustawienia transformatora wejściowego (Input Transformer)
● Głośność (Volume) i panorama (Pan)
● Ustawienia pięciolinii (staff)
● Ustawienia kolorów
● Ustawienia mapy perkusyjnej (Drum Map).

Tworzenie presetu ścieżki
Możesz utworzyć ustawienie wstępne ścieżki z pojedynczej ścieżki lub z kombinacji ścieżek.

PROCEDURA
1. W oknie Project wybierz jedną lub więcej ścieżek.
2. Na liście ścieżek kliknij prawym przyciskiem myszy jedną z wybranych ścieżek i wybierz opcję 
Save Track Preset (Zapisz ustawienie wstępne ścieżki).
3. W sekcji New Preset (Nowe ustawienie wstępne) wprowadź nazwę nowego ustawienia 
wstępnego.
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UWAGA
Możesz także zdefiniować atrybuty dla ustawienia wstępnego.
4. Kliknij OK, aby zapisać ustawienie wstępne i wyjść z okna dialogowego.

WYNIK
Ustawienia wstępne ścieżek są zapisywane w folderze aplikacji w folderze ustawień wstępnych 
ścieżek. Są one zapisywane w domyślnych podfolderach nazwanych zgodnie z typem ścieżki: 
audio, MIDI, instrument i multi.

POWIĄZANE LINKI
Inspektor atrybutów (Attribute Inspector) na stronie 659

Ładowanie presetów dla ścieżek
Możesz wybierać spośród wielu gotowych ustawień ścieżek

PROCEDURA
1. W Inspector kliknij ikonę Preset Management (Zarządzanie ustawieniami wstępnymi) po 
prawej stronie sekcji Inserts (Wstawki).
2. Wybierz opcję From Track Preset (Z ustawień ścieżki).
3. W przeglądarce Results (wyników) kliknij dwukrotnie ustawienie wstępne ścieżki, aby je 
zastosować.

POWIĄZANE LINKI
Ustawienia wstępne ścieżki (Track Presets) na stronie 192

Ładowanie presetów dla instrumentów VST
Podczas pracy z instrumentami VST możesz wybierać spośród wielu ustawień wstępnych za 
pośrednictwem przeglądarki Results.

PROCEDURA
1. Na liście ścieżek kliknij prawym przyciskiem myszy ścieżkę instrumentu i wybierz Load Track 
Preset (Załaduj ustawienie ścieżki).
2. W przeglądarce Results (wyniki) kliknij dwukrotnie ustawienie wstępne, aby je zastosować.

Presety (ustawienia wstępne) ścieżki instrumentu
Presety ścieżek instrumentów oferują zarówno funkcje MIDI, jak i Audio i są najlepszym wyborem 
do obsługi dźwięków prostych, monofonicznych instrumentów VST.

Użyj presetów ścieżek instrumentów do odsłuchu swoich ścieżek lub zapisania preferowanych 
ustawień dźwięku, na przykład. Możesz także wyodrębnić dźwięki z presetów ścieżek 
instrumentów do wykorzystania na ścieżkach instrumentów.

Następujące dane są zapisywane w ustawieniach ścieżek instrumentu:

● Efekty wstawiania dźwięku (Audio Insert)
● Korektor dźwięku (EQ)
● Głośność (Volume) i panorama (Pan) Audio
● Wzmocnienie (Gain) i faza (Phase) wejścia dźwieku
● Efekty insertowe MIDI
● Parametry ścieżki MIDI
● Ustawienia transformatora wejściowego (Input Transformer)
● Instrument VST użyty w utworze

● Ustawienia pięciolinii

197



● Ustawienia kolorów
● Ustawienia mapy perkusyjnej (Drum Map)

Presety VST
Presety instrumentów VST zachowują się jak presety ścieżek instrumentów. Możesz wyodrębnić 
dźwięki z presetów VST do wykorzystania na ścieżkach instrumentów.

Następujące dane są zapisywane w ustawieniach instrumentów VST:

● Instrument VST
● Ustawienia instrumentu VST

UWAGA
Modyfikatory, inserty i ustawienia EQ nie są zapisywane.

Wtyczki efektów VST są dostępne w formacie VST 3 i VST 2.

UWAGA
W niniejszej instrukcji presety VST oznaczają presety instrumentów VST 3, o ile nie zaznaczono 
inaczej

Wyodrębnianie dźwięku ze ścieżki instrumentu lub presetu VST
W przypadku ścieżek instrumentalnych można wyodrębnić dźwięk presetu ścieżki instrumentalnej 
lub presetu VST.

PROCEDURA
1. Wybierz ścieżkę instrumentu, do której chcesz zastosować dźwięk.
2. W Inspector kliknij Extract Sound from Track Preset (Wyodrębnij dźwięk z presetu ścieżki).
3. W przeglądarce presetów wybierz preset ścieżki instrumentu lub preset VST.
4. Kliknij dwukrotnie ustawienie wstępne, aby załadować ustawienia.

WYNIK
Instrument VST i jego ustawienia (ale bez wstawek, korektorów i modyfikatorów) na istniejącej 
ścieżce zostaną nadpisane danymi z ustawienia wstępnego ścieżki. Poprzedni instrument VST dla 
tej ścieżki instrumentu zostanie usunięty, a nowy instrument VST wraz z ustawieniami zostanie 
skonfigurowany dla ścieżki instrumentu.

Presety wielościeżkowe (Multi-Track Presets)

Możesz użyć ustawień wielościeżkowych, na przykład podczas nagrywania konfiguracji 
wymagających kilku mikrofonów (zestawu perkusyjnego lub chóru, gdzie zawsze nagrywasz w 
tych samych warunkach) i musisz edytować powstałe ścieżki w podobny sposób. Co więcej, można 
ich używać podczas pracy ze ścieżkami warstwowymi, gdzie zamiast manipulować tylko jedną 
ścieżką, używasz kilku ścieżek do wygenerowania określonego dźwięku.

Jeśli wybierzesz więcej niż jedną ścieżkę podczas tworzenia ustawienia wstępnego ścieżki, 
ustawienia wszystkich wybranych ścieżek zostaną zapisane jako jedno ustawienie wielościeżkowe. 
Predefiniowane ustawienia wielościeżkowe można zastosować tylko wtedy, gdy ścieżki docelowe 
są tego samego typu, mają taką samą liczbę i kolejność jak ścieżki w ustawieniu wstępnym, dlatego 
należy ich używać w powtarzających się sytuacjach z podobnymi ścieżkami i ustawieniami.
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Ładowanie ustawień wstępnych, wielościeżkowych
Możesz zastosować ustawienia wielościeżkowe do kilku wybranych ścieżek

PROCEDURA
1. W oknie Project zaznacz kilka ścieżek
UWAGA
Ustawienia wielościeżkowe można zastosować tylko wtedy, gdy typ, numer i kolejność ścieżek są 
identyczne dla wybranych ścieżek i ustawienia wstępnego.
2. Na liście ścieżek kliknij ścieżkę prawym przyciskiem myszy i wybierz opcję Load Track Preset 
(Załaduj ustawienie wstępne ścieżki).
3. W przeglądarce presetów wybierz preset wielościeżkowy (multi-track).
4. Kliknij dwukrotnie ustawienie wstępne, aby je załadować.

WYNIK
Ustawienie wstępne zostanie zastosowane.

Presety ścieżki samplera
Możesz użyć presetów ścieżki samplera, aby ponownie wykorzystać utworzone dźwięki w 
późniejszych projektach lub nowo utworzonych ścieżkach samplera.

Następujące dane są zapisywane w ustawieniach ścieżek samplera:
● Efekty insertowe Audio
● Korektor dźwięku (Audio EQ)
● Głośność (Volume) i panorama (Pan) dźwięku
● Wzmocnienie (Volume) i faza (Phase) wejścia audio
● Efekty insertowe MIDI
● Parametry ścieżki MIDI
● Ustawienia transformatora wejściowego (Input Transformer)
● Ustawienia kolorów

POWIĄZANE LINKI
Ścieżki samplera na stronie 129

Tworzenie presetu ścieżki samplera
Możesz utworzyć preset ścieżki samplera ze ścieżki samplera lub użyć paska narzędzi Sampler 
Control.

PROCEDURA
1. Na pasku narzędzi Sampler Control kliknij Preset Management .
2. Kliknij Save Track Preset (Zapisz ustawienie ścieżki).
3. W oknie dialogowym Save Track Preset (Zapisz ustawienie wstępne ścieżki) wpisz nazwę 
nowego ustawienia wstępnego.
4. Kliknij OK, aby zapisać ustawienie wstępne i wyjść z okna dialogowego.

WYNIK
Nowe ustawienie ścieżki samplera zostanie zapisane. Jest ono wyświetlane w polu Preset Name 
(Nazwa ustawienia wstępnego) w wierszu informacyjnym.
Ustawienia wstępne ścieżki samplera są zapisywane w folderze aplikacji w folderze ustawień 
wstępnych ścieżki samplera.

POWIĄZANE LINKI
Tworzenie presetu ścieżki na stronie 193
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Banki wzorów
Banki wzorców to ustawienia wstępne utworzone dla efektu Beat Designer MIDI.

Zachowują się bardzo podobnie do presetów ścieżek.

POWIĄZANE LINKI
Podgląd banków wzorców na stronie 654
Ustawienia wstępne ścieżki na stronie 192

Ładowanie ścieżek lub presetów VST
Możesz zastosować presety ścieżki lub VST do wybranych ścieżek.

PROCEDURA
1. W oknie Project wybierz ścieżkę.
2. Wykonaj jedną z następujących czynności:
● W Inspektorze kliknij Load Track Preset (Załaduj ustawienie wstępne ścieżki).
● Na liście ścieżek kliknij ścieżkę prawym przyciskiem myszy i wybierz opcję Load Track Preset 
(Załaduj wstępnie ustawione ścieżki).
● Na pasku narzędzi sterowania samplerem (Sampler Control) kliknij przycisk Preset 
Management obok pola Preset Name i wybierz Load Track Preset.
3. W przeglądarce presetów wybierz preset ścieżki, VST lub samplera.
4. Kliknij dwukrotnie ustawienie wstępne, aby je załadować.

WYNIK
Ustawienie wstępne zostanie zastosowane.

UWAGA
Możesz także przeciągać i upuszczać ustawienia wstępne ścieżek z MediaBay lub Eksploratora 
plików/macOS Finder na ścieżkę tego samego typu.

POWIĄZANE LINKI
Sekcja filtrów na stronie 655

Ładowanie insertów i EQ z presetów ścieżek
Zamiast ładować kompletne ustawienia wstępne ścieżek, możesz także zastosować ustawienia 
wstawiania lub korektora z ustawień wstępnych ścieżek.

PROCEDURA
1. Wybierz ścieżkę, otwórz okno Inspector lub Channel Settings i kliknij Preset Management 
(Zarządzanie w sekcji Wstawki lub Korektor”.)
2. Wybierz opcję From Track Preset (Z ustawień ścieżki).
3. W przeglądarce presetów wybierz preset ścieżki.
4. Kliknij dwukrotnie ustawienie wstępne, aby załadować ustawienia.

200



Ustawienia wstępne Track Quick Control (ścieżki szybkiego 
sterowania)
W przypadku ścieżek audio, instrumentalnych, MIDI, FX i grupowych można zapisywać i ładować 
własne przypisania szybkich nastaw jako ustawienia wstępne lub korzystać z ustawień fabrycznych.

Zapisywanie/ładowanie przypisań szybkiego sterowania ścieżką jako 
ustawień wstępnych.

PROCEDURA
1. W Inspector swojej ścieżki otwórz sekcję Quick Controls (Szybkie sterowanie). W przypadku 
ścieżek instrumentów szybkie elementy sterujące ścieżki są domyślnie ustawione na 8 domyślnych 
szybkich elementów sterujących VST załadowanego instrumentu.
2. Kliknij opcję Preset Management (Zarządzanie ustawieniami wstępnymi) w prawym górnym 
rogu sekcji Quick Controls (Szybkie sterowanie) i wybierz jedno z ustawień wstępnych.

        

Przypisanie funkcji Track Quick Control zmienia się i zapewnia dostęp do parametrów kanału.

UWAGA
Możesz także tworzyć własne przypisania i zapisywać je jako ustawienia wstępne, a także usuwać 
ustawienia wstępne, zmieniać ich nazwy lub przywracać ustawienia domyślne.
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Części i zdarzenia (Parts and Events)
Części i zdarzenia to podstawowe elementy konstrukcyjne w Cubase.

Events (Zdarzenia)
W Cubase większość typów zdarzeń można przeglądać i edytować na określonych ścieżkach 
w oknie Project.

Zdarzenia można dodawać poprzez importowanie lub nagrywanie.

POWIĄZANE LINKI
Regiony audio na stronie 201
Zdarzenia MIDI na stronie 202

Zdarzenia Audio
Zdarzenia audio są tworzone automatycznie podczas nagrywania lub importowania dźwięku w 
oknie Project.

Możesz przeglądać i edytować zdarzenia audio w oknie projektu i w Sample Editor (edytorze 
sampli).
Zdarzenie dźwiękowe uruchamia odtwarzanie odpowiedniego klipu dźwiękowego. Dostosowując 
wartości Offset (Przesunięcie) i Length (Długość) zdarzenia, możesz określić, która część klipu 
audio jest odtwarzana. Sam klip audio pozostaje niezmieniony.

POWIĄZANE LINKI
Okno projektu na stronie 44
Edytor sampli na stronie 509
Pliki audio i klipy audio na stronie 200
Podstawowe metody nagrywania na stronie 263

Tworzenie zdarzeń Audio
Możesz tworzyć zdarzenia dźwiękowe, nagrywając lub importując dźwięk do okna Project.

PROCEDURA
● Wykonaj jedną z następujących czynności:
● Nagraj dźwięk.
● Wybierz File > Import > Audio File (Plik > Importuj > Plik audio), aby zaimportować plik 
audio z dysku twardego lub dowolnego zewnętrznego urządzenia pamięci masowej.
● Wybierz File > Import > Audio CD (Plik > Importuj > Audio CD), aby zaimportować plik audio
z płyty audio CD.
● Wybierz File > Import > Audio from Video File (Plik > Importuj > Dźwięk z pliku wideo), aby 
zaimportować dźwięk z pliku wideo na dysku twardym lub dowolnym zewnętrznym urządzeniu 
pamięci masowej.
● Przeciągnij plik audio z MediaBay, Audio Part Editor lub Sample Editor i upuść go na ekranie
zdarzenia.
● Skopiuj zdarzenie z innego projektu Cubase i wklej je w oknie zdarzenia.
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POWIĄZANE LINKI
Podstawowe metody nagrywania na stronie 263
Import plików audio na stronie 284
Importowanie ścieżek Audio CD na stronie 287
Importowanie dźwięku z plików wideo na stronie 290
MediaBay i Media Rack na stronie 629
Edytor części audio na stronie 574
Edytor sampli na stronie 509

Tworzenie nowych plików ze zdarzeń
Zdarzenie audio odtwarza fragment klipu audio, który z kolei odnosi się do jednego lub większej 
liczby plików audio na dysku twardym. Można jednak utworzyć nowy plik składający się tylko z 
sekcji odtwarzanej przez zdarzenie.

PROCEDURA
1. Wybierz jedno lub kilka zdarzeń dźwiękowych.
2. Skonfiguruj pojawianie się (fade in), zanikanie (fade out) i głośność (volume) zdarzenia.
          Te ustawienia zostaną zastosowane do nowego pliku.
3. Wybierz kolejno Audio > Bounce Selection (Wybór odbicia).
         Zostaniesz zapytany, czy chcesz zastąpić wybrane zdarzenie, czy nie.
4. Wykonaj jedną z następujących czynności:
● Aby utworzyć nowy plik zawierający tylko dźwięk z oryginalnego zdarzenia, kliknij Replace   
        (Zastąp).
● Aby utworzyć nowy plik i dodać klip dla nowego pliku do puli (Pool), kliknij No (Nie)

WYNIK
Jeśli klikniesz Replace (Zastąp), klip dla nowego pliku zostanie dodany do Pool (puli), a oryginalne
zdarzenie zostanie zastąpione nowym zdarzeniem, w którym zostanie odtworzony nowy klip. Jeśli 
klikniesz No, oryginalne zdarzenie nie zostanie zastąpione.
UWAGA
Możesz także zastosować funkcję Bounce Selection do części audio. W takim przypadku dźwięk ze
wszystkich zdarzeń w części jest łączony w jeden plik audio. Jeśli wybierzesz opcję Replace 
(Zastąp), gdy zostaniesz o to poproszony, część zostanie zastąpiona pojedynczym zdarzeniem 
dźwiękowym odtwarzającym klip z nowego pliku.

POWIĄZANE LINKI
Zanikanie (Fades) na podstawie zdarzeń na stronie 307.

Pliki Audio i klipy Audio
W Cubase edycja i przetwarzanie dźwięku jest nieniszczące.

Kiedy edytujesz lub przetwarzasz dźwięk w oknie projektu, plik audio na dysku twardym pozostaje
nietknięty. Zamiast tego zmiany są zapisywane w klipie audio, który jest tworzony automatycznie 
podczas importowania lub nagrywania i odnosi się do pliku audio. Pozwala to cofnąć zmiany lub 
przywrócić pierwotną wersję.

Jeśli zastosujesz przetwarzanie do określonej sekcji klipu audio, zostanie utworzony nowy plik 
audio zawierający tylko tę sekcję. Przetwarzanie jest stosowane tylko do nowego pliku audio, a klip
audio jest automatycznie dostosowywany, tak aby odnosił się zarówno do oryginalnego pliku, jak i 
do nowego, przetworzonego pliku. Podczas odtwarzania program będzie przełączał się między 
oryginalnym plikiem a przetworzonym plikiem w odpowiednich miejscach. Usłyszysz to jako 
pojedyncze nagranie, z przetwarzaniem zastosowanym tylko do jednej sekcji.
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Pozwala to cofnąć przetwarzanie na późniejszym etapie i zastosować inne przetwarzanie do 
różnych klipów audio, które odnoszą się do tego samego oryginalnego pliku.

Możesz przeglądać i edytować klipy audio w puli (Pool).

POWIĄZANE LINKI
Pool (pula) na stronie 610
Regiony audio na stronie 201
Zastępowanie klipów w zdarzeniach na stronie 201

Zastępowanie klipów w zdarzeniach
Możesz zastępować klipy w zdarzeniach audio.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Przytrzymaj klawisz Shift , przeciągnij plik audio z Eksploratora plików/wyszukiwarki    
              macOS i upuść go na zdarzeniu.
         ● Kliknij klip w Pool (puli), przytrzymaj klawisz Shift i upuść go na zdarzeniu.

WYNIK
Klip w zdarzeniu zostanie zastąpiony. Edycje zdarzeń pozostają jednak niezmienione. Jeśli nowy 
klip jest krótszy niż zastąpiony, długość zdarzenia jest dostosowywana. Jeśli nowy klip jest dłuższy 
niż zastąpiony, długość zdarzenia pozostaje taka sama.

POWIĄZANE LINKI
Wstawianie klipów do projektu metodą „przeciągnij i upuść” na stronie 616.

Regiony Audio
Cubase pozwala tworzyć regiony audio w klipach audio, aby zaznaczyć ważne sekcje w audio.

Regiony audio można przeglądać w Pool (puli). Możesz je tworzyć i edytować w Sample Editor 
(edytorze próbek).
UWAGA
Jeśli chcesz użyć jednego pliku audio w różnych kontekstach lub jeśli chcesz utworzyć kilka pętli z 
jednego pliku audio, przekonwertuj odpowiednie regiony klipu audio na zdarzenia i odbij je do 
osobnych plików audio. Jest to konieczne, ponieważ różne zdarzenia odnoszące się do tego samego 
klipu uzyskują dostęp do tych samych informacji o klipie.

POWIĄZANE LINKI
Pool (pula) na stronie 610
Lista regionów na stronie 526

Tworzenie regionów
Możesz tworzyć regiony z kilku wybranych zdarzeń audio lub z zakresów wyboru.

PROCEDURA
1. Wybierz kilka zdarzeń audio lub zakresów wyboru.
2. Wybierz Audio > Advanced > Event or Range as Region (Audio > Zaawansowane > Zdarzenie
lub Zakres jako region).
3. W oknie dialogowym Create Regions (Utwórz regiony) wprowadź nazwę dla regionów i kliknij 
OK.
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WYNIK
W odpowiednim klipie tworzony jest region z początkową i końcową pozycją regionu określoną 
przez początkową i końcową pozycję zdarzenia lub zakresu zaznaczenia w klipie.

POWIĄZANE LINKI
Tworzenie regionów na stronie 527

Tworzenie zdarzeń z regionów
Możesz tworzyć zdarzenia z regionów. Zastępują one oryginalne zdarzenie.

PROCEDURA
1. Wybierz zdarzenie audio, którego klip zawiera regiony w granicach zdarzenia.
2. Wybierz kolejno Audio > Advanced > Events from Regions (Audio > Zaawansowane > 
Zdarzenia z regionów).

WYNIK
Oryginalne zdarzenie jest usuwane i zastępowane zdarzeniami umiejscowionymi i rozmiarami 
zgodnie z regionami.

Zdarzenia MIDI
Zdarzenia MIDI są tworzone automatycznie podczas nagrywania lub importowania MIDI w oknie 
Project.

In-Place Editor (Edytor lokalny) umożliwia przeglądanie i edytowanie zdarzeń MIDI w oknie 
Project. Możesz także przeglądać i edytować zdarzenia MIDI w Key Editor, Drum Editor, List 
Editor lub Score Editor.

POWIĄZANE LINKI
Okno projektu na stronie 44
Edytor lokalny na stronie 903
Edytor listy na stronie 889
Key Editor na stronie 836
Edytor perkusyjny na stronie 870
Podstawowe metody nagrywania na stronie 263

Tworzenie zdarzeń MIDI
Możesz tworzyć zdarzenia MIDI, nagrywając lub importując dane MIDI do okna projektu.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Nagrywaj MIDI.
         ● Wybierz File > Import > MIDI File (Plik > Importuj > Plik MIDI), aby zaimportować plik 
             MIDI z dysku twardego.
         ● Przeciągnij plik MIDI z Eksploratora plików/wyszukiwarki macOS, z jednego z edytorów 
             MIDI lub z MediaBay i upuść go na wyświetlaczu zdarzeń.
         ● Skopiuj zdarzenie z innego projektu Cubase i wklej je w wyświetlaczu zdarzeń.

POWIĄZANE LINKI
Podstawowe metody nagrywania na stronie 263
Importowanie plików MIDI na stronie 292
Edytory MIDI na stronie 804
MediaBay i Media Rack na stronie 629
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Parts (Partie, części)
Partie to pojemniki na zdarzenia MIDI lub audio oraz na ścieżki.

POWIĄZANE LINKI
Partie Audio na stronie 203
Partie MIDI na stronie 203
Partie Folder na stronie 203

Partie Audio
Partie audio to kontenery na zdarzenia audio. Jeśli chcesz traktować kilka zdarzeń Audio jako jedną
jednostkę w oknie projektu, możesz je przekonwertować na partię.

Możesz tworzyć części audio w następujący sposób:
● Wybierz narzędzie Draw (Rysuj) i rysuj na ścieżce dźwiękowej.
● Naciśnij Alt/Opt, wybierz narzędzie Object Selection (Zaznaczanie obiektów) i rysuj na ścieżce 
dźwiękowej.
● Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i kliknij dwukrotnie ścieżkę audio 
pomiędzy lewym a prawym lokalizatorem.
● Wybierz kilka zdarzeń audio na ścieżce audio i wybierz Audio > Events to Part (Audio > 
Zdarzenia do części).
UWAGA
Aby zdarzenia ponownie pojawiły się na ścieżce jako niezależne obiekty, zaznacz partię i wybierz 
Audio > Dissolve Part (Audio > Rozpuść partię).

POWIĄZANE LINKI
Edytor części audio na stronie 574

Partie MIDI
Partia MIDI jest tworzona automatycznie podczas nagrywania. Zawiera zarejestrowane zdarzenia.

Możesz jednak tworzyć puste partie MIDI w następujący sposób:
● Wybierz narzędzie Draw (Rysuj) i rysuj na ścieżce MIDI.
● Naciśnij Alt/Opt, wybierz narzędzie Object Selection (Zaznaczanie obiektów) i rysuj na ścieżce 
MIDI.
● Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i kliknij dwukrotnie ścieżkę MIDI, 
pomiędzy lewym a prawym lokalizatorem.

         

Partie Folder
Partia folder jest graficzną reprezentacją zdarzeń i części na ścieżkach w folderze.

Partie folderów wskazują pozycję czasową, a także pozycję ścieżki w pionie. Jeśli używane są 
kolory części, są one również pokazane w partii folder.

Każda edycja partii folder wpływa na wszystkie zawarte w niej zdarzenia i części. Ścieżki w 
folderze można edytować jako jedną całość.
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UWAGA
Jeśli chcesz edytować poszczególne ścieżki w folderze, możesz dwukrotnie kliknąć partię folderu. 
Spowoduje to otwarcie edytorów zdarzeń i części obecnych na ścieżkach.

POWIĄZANE LINKI
Menu kolorów zdarzenia na stronie 805
Tryb edycji grupy na stronie 220

Techniki edycji części i zdarzeń
Ta sekcja opisuje techniki edycji w oknie Project. Jeśli nie zostało to wyraźnie określone, 
wszystkie opisy odnoszą się zarówno do zdarzeń, jak i części, mimo że używamy terminu zdarzenie
dla wygody.

W oknie Project możesz edytować zdarzenia, korzystając z następujących technik:
● Wybierając i używając jednego z narzędzi na pasku narzędzi okna Project.
UWAGA
Niektóre narzędzia do edycji posiadają dodatkowe funkcje po naciśnięciu klawiszy 
modyfikujących. Domyślne klawisze modyfikujące można dostosować w oknie dialogowym 
Preferences (Preferencje) (strona Editing – Tool Modifiers (Edycja — narzędzie Modyfikatory)).

● Otwierając menu Edit (Edycja) i wybierając jedną z funkcji.
● Poprzez edycję w wierszu informacyjnym.
● Za pomocą skrótu klawiaturowego (polecenia klawisza).
UWAGA
Snap (skok, przyciąganie) jest brany pod uwagę.

POWIĄZANE LINKI
Edycja — narzędzie Modyfikatory na stronie 1165

Przesłuchiwanie partii Audio i zdarzeń
Możesz odsłuchiwać części audio i zdarzenia w oknie Project za pomocą narzędzia Audition 
(Przesłuchanie).

PROCEDURA
1. Kliknij Play (Graj) i wybierz Play.
2. Kliknij miejsce, w którym chcesz rozpocząć odtwarzanie i przytrzymaj przycisk myszy.
3. Opcjonalnie: Wybierz opcję Media > MediaBay i w sekcji Previewer (Podgląd) dostosuj 
Preview Level (Poziom podglądu).

WYNIK
Ścieżka, którą klikniesz, zostanie odtworzona, zaczynając od miejsca kliknięcia. Odtwarzanie jest 
zatrzymywane po zwolnieniu przycisku myszy.

UWAGA
Podczas przesłuchania dźwięk jest kierowany bezpośrednio do Control Room (pomieszczenia 
sterowania), jeśli Control Room jest włączony. Jeśli Control Room jest wyłączony, dźwięk jest 
kierowany do domyślnej szyny wyjściowej, z pominięciem ustawień kanału audio, efektów i 
korektorów.
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POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46
Sekcja podglądu na stronie 650

Scrubbing (Szorowanie)
Narzędzie Scrub umożliwia lokalizowanie pozycji w zdarzeniach poprzez odtwarzanie, przewijanie
do przodu lub do tyłu.

PROCEDURA
1. Kliknij Play (Odtwórz).
2. Kliknij ponownie, aby otworzyć wyskakujące menu.
3. Wybierz Scrub (Szoruj).
4. Kliknij zdarzenie i przytrzymaj wciśnięty przycisk myszy.
5. Przeciągnij w lewo lub w prawo.

WYNIK
Kursor projektu przesunie się odpowiednio i zdarzenie zostanie odtworzone. Szybkość i wysokość 
odtwarzania zależą od tego, jak szybko poruszasz myszką.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Narzędzie Scrub
Scrubbing (Szorowanie) może być sporym obciążeniem dla twojego systemu. Jeśli wystąpią 
problemy z odtwarzaniem, otwórz okno dialogowe Preferences (Preferencje) (strona Transport —
Scrub) i wyłącz opcję Use High Quality Scrub Mode (Użyj trybu przewijania wysokiej jakości). 
Obniża to jakość ponownego próbkowania, ale sprawia, że czyszczenie jest mniej obciążające dla 
procesora, zwłaszcza w dużych projektach.

W oknie dialogowym Preferences (Preferencje) (strona Transport — Scrub) można również 
dostosować głośność funkcji Scrub.

Wybieranie za pomocą narzędzia do zaznaczania obiektów (Object 
Selection)

PROCEDURA
1. Kliknij Object Selection (Wybór obiektów).
2. Na ekranie zdarzeń kliknij zdarzenia, które chcesz wybrać.

UWAGA
Możesz także użyć klawiszy Strzałka w górę , Strzałka w dół , Strzałka w lewo lub Strzałka w 
prawo na klawiaturze komputera, aby wybrać zdarzenie na górnej lub dolnej ścieżce albo 
poprzednie lub następne zdarzenie na tej samej ścieżce.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46.
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Tryb Połącz narzędzia do zaznaczania
Tryb Combine Selection Tools (Połącz narzędzia do zaznaczania) umożliwia łączenie narzędzi 
Selection Object (Zaznaczanie obiektów) i Range Selection (Zaznaczanie zakresów). Jest to 
przydatne w sytuacjach, w których często przełączasz się między tymi narzędziami.

Jeśli aktywujesz Combine Selection Tools (połącz narzędzia do zaznaczenia) na pasku narzędzi 
okna Project, a wysokość ścieżki jest ustawiona na co najmniej 2 rzędy, pionowa wysokość każdej 
ścieżki zostanie podzielona na dwa obszary. Wskaźnik myszy zmienia się automatycznie z 
narzędzia Selection Object (Zaznaczanie obiektów) na narzędzie Range Selection (Zaznaczanie 
zakresu) i odwrotnie, w zależności od obszaru ścieżki, na którym klikniesz.

● Jeśli przesuniesz wskaźnik myszy w górny obszar ścieżki, narzędzie Range Selection 
(Zaznaczanie zakresu) zostanie aktywowane i możesz wybrać zakresy niezależne od granic 
zdarzenia i części.

                                 

● Jeśli przesuniesz wskaźnik myszy w dolny obszar ścieżki, aktywuje się narzędzie Object 
Selwection (Zaznaczanie obiektów) i możesz wybrać całe zdarzenia lub ich części.
UWAGA
Możesz także aktywować/dezaktywować tryb Combine Selection Tools (Połącz narzędzia do 
zaznaczania), naciskając Alt - Shift - 1.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46
Ustawianie wysokości ścieżki na stronie 176
Tworzenie zakresu wyboru na stronie 223
Zmiana rozmiaru zdarzeń za pomocą narzędzia Zaznaczanie obiektów — normalne rozmiary na 
stronie 213
Zmiana rozmiaru zdarzeń za pomocą narzędzia Zaznaczanie obiektów — zmiana rozmiaru 
przesuwa zawartość na stronie 213
Zmiana rozmiaru zdarzeń za pomocą narzędzia Zaznaczanie obiektów — zmiana rozmiaru dotyczy 
rozciągnięcia czasu na stronie 214

Podmenu Wybierz (Select Submenu)
Jeśli wybrano narzędzie Object Selection (Zaznaczanie obiektów), w podmenu Select (Wybierz) 
dostępne są określone opcje wyboru zdarzeń w oknie Project.

● Aby otworzyć podmenu Select (Wybierz), wybierz kolejno Edit > Select (Edytuj > Wybierz)
All (Wszystko)
         Zaznacza wszystkie zdarzenia w oknie projektu.
None (Nic)
        Odznacza wszystkie zdarzenia w oknie projektu.
Invert (Odwróć)
        Odwraca zaznaczenie. Wszystkie wybrane zdarzenia są odznaczone, a wszystkie zdarzenia,  
         które nie zostały zaznaczone, są wybierane zamiast nich.
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In Loop (W pętli)
         Zaznacza wszystkie zdarzenia, które częściowo lub całkowicie znajdują się między lewym a  
          prawym lokalizatorem.
From Start to Cursor (Od początku do kursora)
         Zaznacza wszystkie zdarzenia, które kończą się po lewej stronie kursora projektu.
From Cursor to End (Od kursora do końca)
         Zaznacza wszystkie zdarzenia rozpoczynające się na prawo od kursora projektu.
Equal Pitch all Octaves/Equal Pitch same Octave (Równa wysokość dźwięku we wszystkich 
oktawach / Równa wysokość dźwięku w tej samej oktawie)
         Funkcje te są dostępne w edytorach MIDI i edytorze próbek (Sample Editor).
Select Controllers in Note Range (Wybierz kontrolery w zakresie nut)
         Ta funkcja jest dostępna w edytorach MIDI.
All on Selected Tracks (Wszystko na wybranych utworach)
         Wybiera wszystkie zdarzenia na wybranej ścieżce.
Events under Cursor (Zdarzenia pod kursorem)
         Automatycznie zaznacza wszystkie wydarzenia na wybranych ścieżkach, które są dotknięte  
         kursorem projektu.
Select Event (Wybierz Zdarzenie)
         Ta funkcja jest dostępna w Sample Editor (edytorze sampli).
Left Selection Side to Cursor/Right Selection Side to Cursor (Lewa strona zaznaczenia do 
kursora/Prawa strona zaznaczenia do kursora)
        Te funkcje są używane tylko do edycji zakresu wyboru.
UWAGA
Po wybraniu narzędzia Range Selection (Zaznaczanie zakresu) podmenu Select (Wybierz) zawiera 
różne funkcje.

POWIĄZANE LINKI
Menu Wybierz dla zakresów wyboru na stronie 223
Edycja zakresu na stronie 522

Usuwanie zdarzeń
Możesz usuwać zdarzenia z okna Project.

PROCEDURA
● Aby usunąć wydarzenie z okna Project, wykonaj jedną z poniższych czynności:
        ● Na pasku narzędzi okna Project aktywuj opcję Erase (Wymaż) i kliknij zdarzenie.
        ● Na wyświetlaczu zdarzeń wybierz zdarzenia i wybierz kolejno Edit > Delete (Edytuj > 
            Usuń).
        ● Na wyświetlaczu zdarzeń wybierz zdarzenia i naciśnij Backspace.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Opcje ruchu zdarzeń
Cubase udostępnia kilka metod przenoszenia zdarzeń w oknie Project.

Zdarzenia można przenosić przy użyciu dowolnej z następujących metod:
● Użyj narzędzia Object Selection (Zaznaczanie obiektów).
● Użyj narzędzia Nudge (Posuń).
● Wybierz kolejno Edit > Move to (Edytuj > Przenieś do) i wybierz jedną z opcji.
● Wybierz zdarzenie i edytuj pozycję początkową w linii informacyjnej.
● Wybierz wiele zdarzeń i użyj funkcji Set Spacer Between Selected Events (Ustaw odstęp 
między wybranymi wydarzeniami).
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POWIĄZANE LINKI
Przenoszenie zdarzeń za pomocą narzędzia Object Selection (wyboru obiektów) na stronie 208
Przenoszenie zdarzeń za pomocą przycisków Nudge (podsuwania) na stronie 208
Podmenu Move to (Przenieś do) na stronie 208
Przenoszenie zdarzeń za pomocą Info Line (linii informacyjnej) na stronie 209
Ustawianie odstępów między zdarzeniami na stronie 209

Przenoszenie zdarzeń za pomocą narzędzia Object Selection (wyboru 
obiektów)
Możesz wybrać jedno lub kilka zdarzeń za pomocą narzędzia Object Selection (Zaznaczanie 
obiektów) i przeciągnąć je w nowe miejsce.

PROCEDURA
1. Wybierz Object Selection.
2. Kliknij zdarzenia, które chcesz przenieść i przeciągnij je w nowe miejsce.
UWAGA
Wydarzenia można przeciągać tylko na ścieżki tego samego typu. Jeśli podczas przeciągania 
przytrzymasz klawisz Ctrl/Cmd, możesz ograniczyć ruch w poziomie lub w pionie.

WYNIK
Zdarzenia są przenoszone. Jeśli przeniosłeś kilka zdarzeń, ich względne pozycje zostaną 
zachowane.
UWAGA
Aby uniknąć przypadkowego przeniesienia zdarzeń po kliknięciu ich w oknie Project, reakcja na 
przeniesienie zdarzenia przez przeciągnięcie jest nieco opóźniona. Opóźnienie to można 
dostosować za pomocą ustawienia Drag Delay (Opóźnienie przeciągania) w oknie dialogowym 
Preferences (Preferencje) (strona Editing (Edycja)).

Przenoszenie zdarzeń za pomocą przycisków Nudge (podsuwania)
Możesz przenieść jedno lub kilka wybranych zdarzeń, używając przycisków podsuwania na pasku 
narzędzi okna Project.

PROCEDURA
1. Kliknij prawym przyciskiem myszy pasek narzędzi okna Project i aktywuj Nudge Palette 
(Paletę podsunięcia).
Przyciski przesuwania staną się dostępne na pasku narzędzi.

               
2. Wybierz zdarzenia, które chcesz przenieść, i kliknij Move Left (Przenieś w lewo) lub Move 
Right (Przenieś w prawo).
Wybrane zdarzenia lub części zostaną przeniesione.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Podmenu Move to (Przenieś do)
Jeśli wybrano narzędzie Object Selection (Zaznaczanie obiektów), w podmenu Move to (Przenieś 
do) dostępne są opcje przenoszenia zdarzeń do określonych pozycji w oknie Project.

● Aby otworzyć podmenu Move to, wybierz kolejno Edit > Move to (Edytuj > Przenieś do).

Dostępne są następujące opcje:
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Cursor (Kursor)
        Przesuwa wybrane zdarzenie do pozycji kursora projektu. Jeśli wybierzesz kilka wydarzeń na  
         tej samej ścieżce, następujące wydarzenia zachowają swoją względną pozycję.
Origin (Pochodzenie)
        Przesuwa wybrane zdarzenia do pozycji, w których zostały pierwotnie nagrane.
Selected Track (Wybrana ścieżka)
        Przenosi wybrane zdarzenia na osobne ścieżki, zaczynając od wybranej ścieżki. Zdarzenia są 
         umieszczane na ich bieżących pozycjach.
Front/Back (Przód/Tył)
       Przesuwa wybrane zdarzenia odpowiednio do przodu lub do tyłu. Jest to przydatne, jeśli masz 
        nakładające się zdarzenia audio i chcesz odtworzyć inne zdarzenie.

Przenoszenie zdarzeń przez Info Line (linię informacyjną)
Możesz przenieść wybrane zdarzenie, zmieniając jego wartość początkową w linii informacyjnej.

PROCEDURA
1. Wybierz zdarzenie, które chcesz przenieść.
2. W wierszu informacyjnym kliknij dwukrotnie pole Start i wprowadź nową wartość rozpoczęcia 
zdarzenia.

WYNIK
Zdarzenie jest przesuwane o ustawioną wartość.

Ustawianie odstępów między zdarzeniami
Możesz zmienić rozmieszczenie wielu zdarzeń na ścieżce, tak aby znajdowały się w określonej 
odległości od siebie.

WARUNEK WSTĘPNY
● Ścieżka zawiera wiele zdarzeń.
● Zdarzenia nie są zablokowane.

PROCEDURA
1. Wybierz wszystkie zdarzenia, które chcesz zmienić.
2. Wybierz polecenie Edit > Functions > Set Spacer between Selected Events (Edytuj > Funkcje 
> Ustaw odstęp między wybranymi zdarzeniami).
3. Ustaw odstęp w sekundach.
4. Kliknij OK.

WYNIK
Wszystkie wybrane zdarzenia na ścieżce znajdują się w określonej odległości od siebie.

UWAGA
● Zgrupowane zdarzenia są obsługiwane jak pojedyncze zdarzenia.
● Ta funkcja nie działa w przypadku ścieżek automatyzacji i sygnatur.

POWIĄZANE LINKI
Blokowanie zdarzeń na stronie 221
Zgrupowane zdarzenia na stronie 220
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Dopasowywanie Audio
Narzędzie Audio Alignment (dopasowywania Audio) umożliwia automatyczne dopasowywanie 
synchronizacji podobnych zdarzeń Audio lub zakresów zaznaczenia, które chcesz odtwarzać 
jednocześnie.

Audio Alignment umożliwia dopasowanie synchronizacji różnych instrumentów lub ścieżek 
wokalnych. Możesz także rozwiązać problemy z fazowaniem, które występują podczas używania 
różnych mikrofonów w tym samym ujęciu. W kontekście postprodukcji możesz na przykład 
dopasować czas nagrania głosu lub alternatywnego ujęcia do dźwięku produkcyjnego.

Narzędzie analizuje dźwięk nakładających się zdarzeń, które wybrałeś do wyrównania i albo używa
funkcji wypaczania Sample Editor (Edytora próbek) do rozciągania czasu, albo przesuwa dźwięk.
UWAGA
● Jeśli konieczne jest rozciąganie w czasie, funkcja Audio Alignment wykorzystuje algorytm 
wypaczania, wybrany w Sample Editor (edytorze próbek).
● Jeśli dźwięk zawiera już efekty w czasie rzeczywistym, funkcja Audio Alignment pozwala 
najpierw go odbić, zachowując istniejące efekty lub nadpisując istniejące przetwarzanie.
● Jeśli Audio jest w Musical Mode (trybie muzycznym), musisz go najpierw odbić.
● Audio Alignment działa zgodnie z przeznaczeniem tylko wtedy, gdy audio do wyrównania i 
projekt mają tę samą częstotliwość próbkowania.

Audio Alignment Panel (Panel dopasowywania Audio) zawiera opcję Match Word (Dopasuj 
słowa) do dopasowywania dźwięku, który zawiera identyczne sformułowania. Jego algorytm 
wykrywa fonemy i sylaby i pozwala na dokładną synchronizację słów w słowa.

Opcja Prefer Time Shifting (Preferuj przesunięcie w czasie) jest szczególnie odpowiednia dla 
dźwięku pochodzącego z tego samego nagrania, na przykład w przypadku nagrywania z wielu 
mikrofonów. Unika rozciągania czasu, jeśli to możliwe. Jednak w razie potrzeby nadal stosuje się 
rozciąganie czasu.

UWAGA
● Jeśli konieczne jest rozciąganie w czasie, funkcja Audio Alignment wykorzystuje algorytm 
wypaczania, wybrany w Sample Editor (edytorze próbek).
● Jeśli dźwięk zawiera już efekty w czasie rzeczywistym, funkcja Audio Alignment pozwala 
najpierw go odbić, zachowując istniejące efekty lub nadpisując istniejące przetwarzanie.
● Jeśli Audio jest w Musical Mode (trybie muzycznym), musisz go najpierw odbić.
● Audio Alignment działa zgodnie z przeznaczeniem tylko wtedy, gdy audio do wyrównania 
i projekt mają tę samą częstotliwość próbkowania.

POWIĄZANE LINKI
Algorytm wstępnych ustawień na stronie 540
Wyrównywanie zdarzeń Audio na stronie 211
Panel dopasowywania Audio (Audio Alignment Panel) na stronie 210
Tryb muzyczny Musical Mode na stronie 541

Panel dopasowywania Audio (Audio Alignment Panel)
W panelu dopasowywania Audio możesz wybrać zdarzenia referencyjne i docelowe, a także 
skonfigurować ustawienia analizy i wyrównywania dźwięku.
Aby otworzyć Audio Alignment Panel, wykonaj jedną z następujących czynności:
● Kliknij Otwórz Audio Alignment Panel (panel dopasowywania dźwięku) na pasku narzędzi 
okna Project.
● Wybierz Audio > Open Audio Alignment Panel (Audio > Otwórz panel dopasowywania audio).
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Audio Alignment Selection (Wybór dopasowywania dźwięku)
       W tej sekcji zdefiniujesz zdarzenia referencyjne i docelowe lub zakresy wyboru dla operacji 
       wyrównania. Na ekranach krzywych podświetlony jest nakładający się zakres czasu między 
       wartością odniesienia a wartością docelową.
       Jeśli wybrano wiele celów, wyskakujące menu umożliwia przełączanie między ich 
        przebiegami.
Audio Alignment Settings (Ustawienia dopasowywania dźwięku)
       Umożliwiają aktywację/dezaktywację opcji analizy i dopasowywania.
   ● Opcja Match Words (Dopasuj słowa) analizuje fonemy i sylaby i pozwala na dokładną  
       synchronizację między słowami. Ta opcja zapewnia najlepsze wyniki, jeśli sformułowania w 
       wyrównanych zdarzeniach są identyczne.
   ● Opcja Prefer Time Shifting (Preferuj przesunięcie w czasie) jest szczególnie przydatna do   
       wyrównywania dźwięku pochodzącego z tego samego nagrania, na przykład w przypadku 
       nagrywania z wielu mikrofonów. Unika rozciągania czasu, jeśli to możliwe. Jednak w razie 
       potrzeby nadal stosuje się rozciąganie czasu.
   ● Alignment Presission (Dokładność wyrównania) umożliwia ustawienie stopnia wyrównania. 
        Zmniejszenie precyzji może pomóc w zachowaniu bardziej naturalnego dźwięku.
Align Audio (Dopasuj Audio)
        Rozpoczyna operację Dopasowywania

Dopasowywanie zdarzeń Audio

Narzędzie Audio Alignment (Dopasowywanie Audio) umożliwia automatyczne wyrównywanie 
dźwięków, nakładających się zdarzeń dźwiękowych lub zakresów zaznaczenia na różnych 
ścieżkach

WARUNEK WSTĘPNY
● Twój projekt zawiera co najmniej dwa zdarzenia dźwiękowe, rozmieszczone na różnych 
ścieżkach i nakładające się w czasie.
● Dźwięk, który chcesz dopasować do odniesienia, nie jest modyfikowany przez operacje 
VariAudio lub AudioWarp.
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UWAGA
● Jeśli Audio zawiera już efekty w czasie rzeczywistym, narzędzie Audio Alignment 
(Wyrównywanie dźwięku) pozwala najpierw go odrzucić, zachowując istniejące efekty lub 
nadpisując istniejące przetwarzanie.
● Jeśli utwór jest w Musical Mode (trybie muzycznym), musisz go najpierw odbić.

PROCEDURA
1. Wybierz zdarzenie lub zakres, którego chcesz użyć jako odniesienia do dopasowania.
2. Na pasku narzędzi okna Project kliknij Open Audio Alignment Panel (Otwórz panel 
dopasowywania dźwięku).
3. W panelu Audio Alignment Panel kliknij opcję Add Selection as Alignment Reference (Dodaj 
zaznaczenie jako odniesienie wyrównania).
4. Wybierz jedno lub wiele zdarzeń, które chcesz dopasować do odniesienia.
5. W panelu Audio Alignment Panel kliknij opcję Add Selection as Alignment Target (Dodaj 
zaznaczenie jako cel wyrównania).

Nakładający się zakres czasu między wartością odniesienia a wartością docelową jest podświetlony 
na odpowiednich kształtach fali. Jeśli wybrano wiele obiektów docelowych, można przełączać ich 
przebiegi za pomocą menu podręcznego.

                        
6. W sekcji Audio Alignment Settings (Ustawienia wyrównania dźwięku) wprowadź zmiany.
7. Kliknij Align Audio (Wyrównaj Audio), aby rozpocząć przetwarzanie.
Zdarzenia docelowe są przetwarzane.

WYNIK
Dźwięk zdarzeń docelowych jest dopasowywany do zdarzenia odniesienia w zakresie czasu, w 
którym zdarzenia się nakładają.

PO WYKONANIU TEGO ZADANIA
Aby zwizualizować wynik dopasowania w Sample Editor (Edytorze próbek), wybierz zdarzenia 
referencyjne i docelowe i aktywuj opcję Show All Selected Audio Events (Pokaż wszystkie 
wybrane zdarzenia audio) na pasku narzędzi Sample Editor (Edytora próbek). Jeśli wynik 
rozciągania czasu nie spełnia Twoich oczekiwań, możesz zmienić algorytm wypaczania na pasku 
narzędzi Sample Editor. Ta zmiana algorytmu jest natychmiast stosowana do dźwięku. 
Alternatywnie możesz użyć narzędzia Free Warp, aby dopasować zdarzenia audio.

POWIĄZANE LINKI
Pasek narzędzi edytora próbek (Sample Editor) na stronie 511
Algorytm Wstępnych ustawień na stronie 540
Algorytmy Time Stretch i Pitch Shift na stronie 499
Free Warp na stronie 545
Panel dopasowywania dźwięku (Audio Alignment) na stronie 210

Zmiana nazw zdarzeń
PROCEDURA
● Wykonaj jedną z następujących czynności:
● Wybierz zdarzenia i wpisz nową nazwę w polu File (Plik) w linii informacyjnej.
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 ● Zmień nazwę ścieżki, przytrzymaj klawisz modyfikujący i naciśnij Return, aby zmienić nazwy 
wszystkich wydarzeń zgodnie z tą ścieżką.

Opcje zmiany rozmiaru zdarzenia
Możesz zmienić rozmiar wydarzeń, przesuwając indywidualnie ich pozycje początkową lub 
końcową.
Aby zmienić rozmiar zdarzeń, możesz użyć narzędzia Object Selection (Zaznaczanie obiektów), 
narzędzia Scrub (Szoruj) lub narzędzi Trim (Przytnij) na palecie Nudge (Posuń).
Zmiana rozmiaru działa również, jeśli włączony jest tryb Combine Selection Tools (Połącz 
narzędzia do zaznaczania).
WAŻNE
Podczas zmiany rozmiaru zdarzeń dane automatyzacji nie są brane pod uwagę.

POWIĄZANE LINKI
Tryb Połącz narzędzia do zaznaczania na stronie 206
Zmiana rozmiaru zdarzeń za pomocą narzędzia Zaznaczanie obiektów — normalne rozmiary na 
stronie 213
Zmiana rozmiaru zdarzeń za pomocą narzędzia Zaznaczanie obiektów — zmiana rozmiaru 
przesuwa zawartość na stronie 213
Zmiana rozmiaru zdarzeń za pomocą narzędzia Zaznaczanie obiektów — zmiana rozmiaru dotyczy 
rozciągnięcia czasu na stronie 214
Zmiana rozmiaru zdarzeń za pomocą narzędzi przycinania na stronie 214
Zmiana rozmiaru zdarzeń za pomocą narzędzia Scrub na stronie 215
Funkcja przyciągania na stronie 85

Zmiana rozmiaru zdarzeń za pomocą narzędzia do zaznaczania 
obiektów — normalne rozmiary
Możesz przenieść punkt początkowy lub końcowy zdarzenia.

PROCEDURA
1. Wybierz Object Selection (Wybór obiektu).
2. Kliknij ponownie narzędzie Object Selection i wybierz Normal Sizing (Normalne rozmiary) z 
wyskakującego menu.
3. Kliknij i przeciągnij lewy lub prawy dolny róg zdarzenia.

                              
WYNIK
Zdarzenie jest zmieniane i w zależności od tego, gdzie przeciągniesz, więcej lub mniej treści 
zostanie ujawnionych. Jeśli zaznaczono kilka zdarzeń, wszystkie są zmieniane w ten sam sposób.
POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Zmiana rozmiaru zdarzeń za pomocą narzędzia wyboru obiektów — 
zmiana rozmiaru przenosi zawartość
Możesz przenieść punkt początkowy lub końcowy zdarzenia oraz przenieść zawartość.
PROCEDURA
1. Wybierz Object Selection (Wybór obiektu).
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2. Kliknij ponownie narzędzie Object Selection i z wyskakującego menu wybierz Sizing Moves 
Contents (Zmienianie rozmiaru przesuwa zawartość).
3. Kliknij i przeciągnij lewy lub prawy dolny róg wydarzenia.

                              
WYNIK
Zdarzenie jest zmieniane, a zawartość następuje. Jeśli zaznaczono kilka zdarzeń, wszystkie są 
zmieniane w ten sam sposób.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Zmiana rozmiaru zdarzeń za pomocą narzędzia do zaznaczania 
obiektów — zmiana rozmiaru dotyczy rozciągnięcia czasu
Możesz przesunąć punkt początkowy lub końcowy zdarzenia i rozciągnąć zawartość w czasie, aby 
dopasować ją do długości nowego zdarzenia.

PROCEDURA
1. Wybierz Object Selection (Wybór obiektu).
2. Kliknij ponownie narzędzie Object Seletion i z menu podręcznego wybierz Sizing Applies 
Time Stretch (Rozmiar dotyczy rozciągnięcia w czasie).
3. Kliknij i przeciągnij lewy lub prawy dolny róg zdarzenia.

WYNIK
Część jest rozciągana lub ściskana w celu dopasowania do nowej długości.
● Jeśli zmienisz rozmiar partii MIDI, zdarzenia nutowe zostaną rozciągnięte (przeniesione i 
zmienione). Dane kontrolera i dane wyrażania nut również są rozciągnięte.
● Jeśli zmienisz rozmiar części audio, zdarzenia zostaną przeniesione, a pliki audio, do których się 
odnoszą, zostaną rozciągnięte w czasie, aby dopasować je do nowej długości.
Jeśli zaznaczono kilka zdarzeń, wszystkie są zmieniane w ten sam sposób.

POWIĄZANE LINKI
Rozciągnięcie czasu na stronie 495
Pasek narzędzi okna projektu na stronie 46

Zmiana rozmiaru zdarzeń za pomocą narzędzi przycinania (Trim)
Punkt początkowy lub końcowy wydarzenia można przesunąć o wartość ustawioną w 
wyskakującym menu Grid Type (Typ siatki).

WARUNEK WSTĘPNY
Narzędzie Object Selection (Zaznaczanie obiektów) jest ustawione na Normal Sizing (Rozmiar 
normalny) lub Sizing Moves Contents (Rozmiar przesuwa zawartość)

PROCEDURA
1. Kliknij prawym przyciskiem myszy pasek narzędzi okna Project  i aktywuj Nudge Palette 
(Paletę podsunięcia).
Przyciski przesuwania staną się dostępne na pasku narzędzi.
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2. Wybierz zdarzenie.
3. Wykonaj jedną z następujących czynności:
        ● Kliknij opcję Trim Start Left (Przytnij początek z lewej).
        ● Kliknij opcję Trim Start Right (Przytnij początek z prawej).
        ● Kliknij opcję Trim End Left (Przytnij koniec z lewej).
        ● Kliknij opcję Trim End Right (Przytnij koniec z prawej).

WYNIK
Pozycja początkowa lub końcowa wybranych wydarzeń zostanie przesunięta o wartość ustawioną w
wyskakującym menu Grid Type (Typ siatki).

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Zmiana rozmiaru zdarzeń za pomocą narzędzia Scrub (szoruj)
Możesz przesuwać zdarzenie podczas przesuwania punktu początkowego lub końcowego zdarzenia.

PROCEDURA
1. Kliknij Play (Odtwórz).
2. Kliknij ponownie Play, aby otworzyć wyskakujące menu.
3. Wybierz Scrub (Szoruj).
4. Kliknij i przeciągnij lewy lub prawy dolny róg zdarzenia.

WYNIK
Rozmiar zdarzenia zostanie zmieniony, a podczas przeciągania pojawi się informacja akustyczna.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Dzielenie zdarzeń

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Wybierz Split (Podziel) i kliknij zdarzenie, które chcesz podzielić.
       ● Wybierz opcję Object Selection (Wybór obiektu), przytrzymaj klawisz Alt/Opt i kliknij 
           zdarzenie.
       ● Przesuń kursor projektu do miejsca, w którym chcesz podzielić wydarzenia i wybierz
          Edit > Functions > Split at Cursor (Edycja > Funkcje > Podziel przy kursorze).

       UWAGA
       Spowoduje to rozdzielenie wszystkich zdarzeń na wszystkich ścieżkach przecinanych przez 
       kursor projektu. Jeśli wybierzesz określone zdarzenia, tylko te zdarzenia zostaną podzielone.

      ● Ustaw lewy i prawy lokalizator w miejscu, w którym chcesz podzielić zdarzenia, a następnie 
         wybierz polecenie Edit > Functions > Split Loop (Edytuj > Funkcje > Podziel pętlę).

      UWAGA
      Spowoduje to rozdzielenie wszystkich zdarzeń na wszystkich ścieżkach przecinanych przez 
      lokalizatory. Jeśli wybierzesz określone zdarzenia, tylko te zdarzenia zostaną podzielone.
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WYNIK
Zdarzenia są podzielone.

UWAGA
Jeśli podzielisz partię MIDI w taki sposób, że pozycja podziału przecina jedną lub kilka nut MIDI, a
w oknie dialogowym Preferences (Preferencje) (Editing (Edycja) — strona MIDI) uaktywniona 
zostanie funkcja Split MIDI Events, przecięte nuty zostaną podzielone, a nowe nuty zostaną 
utworzone na początku drugiej część. Jeśli jest wyłączona, nuty pozostają w pierwszej części, ale 
wystają po jej zakończeniu.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Wielokrotne dzielenie zdarzeń
Możesz wielokrotnie dzielić zdarzenia na wiele zdarzeń o równej wielkości.

PROCEDURA

● Wybierz Split  , przytrzymaj Alt/Opt i kliknij zdarzenie, w którym chcesz dokonać 
pierwszego podziału.

WYNIK
Zdarzenie jest automatycznie dzielone na tyle równych wydarzeń, na ile pozwala długość 
pierwotnego zdarzenia.

Użycie Cut Head (Odetnij głowę) i Cut Tail (Odetnij ogon)
Możesz wyciąć wszystko na lewo lub na prawo od kursora lub wybranego zakresu.

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Wybierz Edit > Range > Cut Head (Edycja > Zakres > Utnij głowę), aby usunąć wszystko 
           na lewo od kursora/zakresu zaznaczenia.
        ● Wybierz polecenie Edit > Range > Cut Tail (Edytuj > Zakres > Skróć ogon), aby usunąć 
           wszystko na prawo od kursora/zakresu zaznaczenia.

Sklejanie zdarzeń
W oknie Project możesz skleić dwa lub więcej zdarzeń na tej samej ścieżce.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Wybierz zdarzenia, które chcesz skleić, a następnie wybierz kolejno Edit > Glue (Edytuj > 
           Przyklej).
       ● Wybierz Glue (Przyklej) i kliknij zdarzenie, które chcesz przykleić do następnego zdarzenia.
       ● Wybierz opcję Glue, przytrzymaj klawisz Alt/Opt i kliknij zdarzenie, które chcesz przykleić 
           do wszystkich kolejnych zdarzeń.

WYNIK
Zdarzenia są ze sobą sklejone.
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UWAGA
Jeśli najpierw podzielisz zdarzenie Audio, a następnie ponownie skleisz części, zostanie utworzone 
zdarzenie. W każdym innym przypadku tworzona jest część.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46.

Wklejanie zdarzeń
Możesz wklejać zdarzenia ze schowka.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Wybierz zdarzenia i wybierz kolejno Edit > Functions > Paste at Origin (Edycja > Funkcje
           > Wklej w punkcie początkowym), aby wkleić zdarzenie w tym samym miejscu, z którego 
           zostało wycięte lub skopiowane.
       ● Wybierz zdarzenia, zaznacz ścieżkę, do której chcesz je wkleić, a następnie wybierz Edit > 
           Functions > Paste Relative to Cursor (Edycja > Funkcje > Wklej względem kursora), aby  
           wkleić zdarzenie, zachowując jego położenie względem kursora projektu.

WYNIK
Jeśli wkleisz zdarzenie dźwiękowe, zostanie ono wstawione na wybranej ścieżce i ustawione tak, 
aby jego punkt przyciągania był wyrównany z pozycją kursora.
Jeśli wybrana ścieżka jest niewłaściwego typu, zdarzenie zostanie wstawione na oryginalnej 
ścieżce.

Wklejanie zdarzeń do pasujących nazw ścieżek
Możesz kopiować wydarzenia z jednego projektu i wklejać je na pierwszej ścieżce, która dokładnie 
odpowiada nazwie ścieżki w innym projekcie.

PROCEDURA
1. Skopiuj zdarzenia w jednym projekcie.
2. Aktywuj projekt, do którego chcesz wkleić zdarzenia.
3. Wybierz kolejno Edit > Functions > Paste to Matching Track Name (Edycja > Funkcje > 
Wklej do pasującej nazwy ścieżki).

WYNIK
Zdarzenia są wstawiane na ścieżce z nazwą, która dokładnie odpowiada oryginalnej nazwie ścieżki.
Dla wszystkich zdarzeń, które nie mają pasującej nazwy ścieżki, tworzone są nowe ścieżki.

Duplikowanie zdarzeń
W oknie Project możesz zduplikować wybrane zdarzenia.

PROCEDURA
● Wybierz zdarzenie i wykonaj jedną z następujących czynności:
● Wybierz polecenie Edit > Functions > Duplicate (Edytuj > Funkcje > Duplikuj).
● Przytrzymaj Alt/Opt i przeciągnij zdarzenie w nowe miejsce.
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UWAGA
Jeśli przytrzymasz również Ctrl/Cmd, kierunek ruchu będzie ograniczony do poziomego lub 
pionowego.

WYNIK
Kopia wybranego wydarzenia zostanie utworzona i umieszczona po oryginale. W przypadku 
wybrania kilku zdarzeń wszystkie są kopiowane jako jedna jednostka, z zachowaniem względnej 
odległości między zdarzeniami.

UWAGA
Jeśli duplikujesz zdarzenia audio, kopie zawsze odnoszą się do tego samego klipu audio.

Powtarzanie zdarzeń

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Wybierz zdarzenia i wybierz Edit > Functions > Repeat (Edycja > Funkcje > Powtórz), aby
            otworzyć okno dialogowe Repeat Events (Powtórz zdarzenia), które umożliwia utworzenie 
            wielu rzeczywistych lub udostępnionych kopii wybranych zdarzeń.
        ● Wybierz zdarzenia, przytrzymaj klawisz Alt/Opt , kliknij uchwyt w prawym dolnym rogu 
           ostatniego wybranego zdarzenia i przeciągnij w prawo, aby utworzyć prawdziwą kopię.
        ● Przesuń wskaźnik myszy nad środek prawej krawędzi zdarzenia, tak aby stał się symbolem  
           wskazującej dłoni, kliknij i przeciągnij w prawo, aby utworzyć prawdziwą kopię.
        ● Wybierz zdarzenia, przytrzymaj klawisze Alt/Opt - Shift i przeciągnij w prawo, aby 
           utworzyć udostępnioną kopię. 
UWAGA
Dotyczy to tylko zdarzeń MIDI.
       ● Przesuń wskaźnik myszy na środek prawej krawędzi zdarzenia, tak aby stał się symbolem 
          wskazującej dłoni, przytrzymaj klawisz Shift , kliknij i przeciągnij w prawo, aby utworzyć 
          współdzieloną kopię.

UWAGA
Powtarzanie przez przeciąganie działa tylko wtedy, gdy ścieżka ma wysokość co najmniej 
2 rzędów.

POWIĄZANE LINKI
Udostępnione kopie na stronie 219
Okno dialogowe Powtórz Zdarzenia na stronie 218
Ustawianie wysokości ścieżki na stronie 176

Okno dialogowe Powtórz Zdarzenia (Repeat Events)
Okno dialogowe Repeat Events umożliwia utworzenie wielu rzeczywistych lub współdzielonych 
kopii wybranych zdarzeń.

● Aby otworzyć okno dialogowe Repeat Events (Powtórz zdarzenia), wybierz polecenie Edit > 
Functions > Repeat (Edytuj > Funkcje > Powtórz).
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Count (w sumie)
         Pozwala określić, ile razy zdarzenie ma się powtarzać.
Shared Copies (Udostępnione kopie)
         Aktywuj tę opcję, aby utworzyć udostępnioną kopię.

POWIĄZANE LINKI
Udostępnione kopie na stronie 219

Udostępnione kopie
Udostępnione kopie są przydatne, jeśli chcesz tworzyć kopie, które są automatycznie edytowane 
w taki sam sposób, jak oryginalne zdarzenie.

Kopie udostępnione można tworzyć za pomocą okna dialogowego Repeat Events (Powtórz 
zdarzenia).

Udostępnioną kopię można przekonwertować na kopię rzeczywistą, wybierając opcję Edit > 
Functions > Convert to Real Copy (Edycja > Funkcje > Konwertuj na kopię rzeczywistą). 
Spowoduje to utworzenie nowej wersji klipu, którą możesz edytować niezależnie. Nowy klip 
zostanie automatycznie dodany do Pool (pula).

POWIĄZANE LINKI
Powtarzające się zdarzenia na stronie 218
Okno dialogowe Powtórz Zdarzenia na stronie 218

Wypełnij pętlę (Fill Loop)
Możesz utworzyć kilka kopii między prawym a lewym lokalizatorem.

● Wybierz Edit > Functions > Fill Loop (Edycja > Funkcje > Wypełnij pętlę), aby utworzyć 
pewną liczbę kopii, zaczynając od lewego lokalizatora i kończąc na prawym lokalizatorze.
Ostatnia kopia jest automatycznie skracana do końca w prawym położeniu lokalizatora.

Przesuwanie zawartości zdarzeń
Możesz przenosić zawartość zdarzenia bez zmiany jego pozycji w oknie Project.

PROCEDURA
● Przytrzymaj Ctrl/Cmd -Alt/Opt , kliknij zdarzenie i przeciągnij w lewo lub w prawo.

WYNIK
Treść zdarzenia została przeniesiona.

UWAGA
Nie można przesunąć zdarzenia audio poza początek lub koniec rzeczywistego klipu audio. Jeśli 
zdarzenie odtwarza cały klip, nie można w ogóle przesuwać audio.
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Grupowanie zdarzeń
Możesz traktować kilka zdarzeń na tej samej lub różnych ścieżkach jako jedną całość, grupując je.

PROCEDURA
● Wybierz zdarzenia i wybierz kolejno Edit > Group (Edytuj > Grupuj).

WYNIK
Zdarzenia są pogrupowane. Wskazuje na to ikona.

                                

Zgrupowane zdarzenia
Jeśli edytujesz jedno z pogrupowanych zdarzeń w oknie Project, wpłynie to również na wszystkie 
inne zdarzenia w tej samej grupie.

Operacje edycji grupowej obejmują:
● Wybieranie
● Przenoszenie i powielanie
● Zmiana rozmiaru
● Regulacja Fade-in (pojawiania się) i Fade-out (zanikania) (tylko zdarzenia Audio)
● Dzielenie (Splitting)
● Blokowanie (Locking)
● Wyciszanie (Muting)
● Usuwanie (Deleting)

POWIĄZANE LINKI
Fades (Zanikanie), Crossfades (przenikanie) i Envelopes (obwiednie) na stronie 307

Group Editing Mode (Tryb edycji grupy)
Tryb edycji grupowej dla ścieżek folderów umożliwia edycję części i zdarzeń w folderze jako 
grupie.

Jeśli Group Editing (Edycja grupowa) jest włączona i wybierzesz zdarzenie, część lub zakres na 
ścieżce znajdującej się w ścieżce folderu, inne zdarzenia, części lub zakresy, które mają ten sam 
czas rozpoczęcia i zakończenia oraz ten sam priorytet odtwarzania, zostaną również wybrane i 
tymczasowo zgrupowane. Pozwala to na wspólną edycję różnych ścieżek perkusyjnych, na 
przykład dla bębna basowego, werbla i tomów.

Tymczasowo oznacza, że przy każdym nowym wyborze narzędziem Object Selection (Wybór 
obiektu) lub Range Selection (Wybór zakresu), Cubase szuka odpowiednich zdarzeń lub części w 
folderze i grupuje je. Jeśli edytujesz punkt początkowy lub końcowy pojedynczego zdarzenia lub 
części przed aktywacją trybu edycji grupowej, zdarzenie to lub część zostanie wykluczona z grupy.

Czynności edycji w trybie Group Rediting (Edycji grupowej) mają wpływ na wszystkie 
zgrupowane zdarzenia, części lub zakresy. Jeśli wybierzesz inny dubel za pomocą podmenu To 
Front, wszystkie inne ścieżki w grupie edycji również przełączą się na odpowiedni dubel. Jest to 
przydatne do porównywania ujęć nagrania wielościeżkowego.
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UWAGA
Group Editing (Edycja grupowa) zastępuje wszelkie ustawienia zwykłej grupy w grupie edycji.

POWIĄZANE LINKI
Wyciszanie zdarzeń na stronie 222
Organizowanie ścieżek w ścieżkach folder na stronie 178

Wykonywanie edycji grupowej
Możesz grupować zdarzenia i części na wielu ścieżkach, które mają ten sam czas rozpoczęcia i 
zakończenia oraz ten sam priorytet odtwarzania, aby edytować je razem.

PROCEDURA

1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij Add Track   (Dodaj ścieżkę)
2. Kliknij Folder.
3. Kliknij Add Track (Dodaj ścieżkę).
4. Przenieś ścieżki zawierające zdarzenia, które chcesz edytować jako grupę, do ścieżki folderu.

5. Na liście ścieżek dla ścieżki folderu kliknij Group Editing   .

WYNIK
Wszystkie zdarzenia, części lub zakresy w folderze, które mają ten sam czas rozpoczęcia i 
zakończenia oraz ten sam priorytet odtwarzania, są tymczasowo zgrupowane.

Blokowanie zdarzeń
Jeśli chcesz się upewnić, że przypadkowo nie edytujesz ani nie przenosisz zdarzenia, możesz je 
zablokować.
PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Wybierz zdarzenia i wybierz kolejno Edit > Lock (Edytuj > Zablokuj), aby zablokować 
            wybrane zdarzenia.
        ● Kliknij przycisk kłódki na liście ścieżek lub w Inspector, aby zablokować wszystkie 
            zdarzenia na ścieżce.

WYNIK
Zdarzenia są zablokowane. Wskazuje na to symbol kłódki.

           
Aby odblokować zdarzenie, zaznacz je i wybierz Edit > Unlock (Edytuj > Odblokuj).

Atrybuty okna dialogowego Lock Event (Zablokuj zdarzenie)
Okno dialogowe Lock Event Attributes (Zablokuj atrybuty zdarzenia) umożliwia zablokowanie 
określonych atrybutów zdarzenia.
● Aby otworzyć okno dialogowe Lock Event Attributes, zaznacz zablokowane zdarzenie i 
wybierz kolejno Edit > Lock (Edycja > Zablokuj).
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Position Locked (Pozycja zablokowana)
         Aktywuj tę opcję, aby zapobiec przeniesieniu zdarzenia.
Size Locked (Rozmiar zablokowany)
         Aktywuj tę opcję, aby zapobiec zmianie rozmiaru zdarzenia.
Others Locked (Inne zablokowane)
         Aktywuj tę opcję, aby uniemożliwić edycję zdarzenia. Obejmuje to regulację zanikania i 
         głośności zdarzeń, przetwarzanie itp.
UWAGA
Możesz także ustawić te atrybuty w oknie dialogowym Preferences (Preferencje) (strona Editing  
(Edycja)).

POWIĄZANE LINKI
Zablokuj atrybuty zdarzeń na stronie 1161

Odwracanie fazy zdarzeń Audio
Możesz odwrócić fazę zdarzeń Audio w oknie Project.

PROCEDURA
1. W oknie Project wybierz jedno lub wiele zdarzeń audio.
2. W wierszu informacyjnym kliknij pole Invert Phase (Odwróć fazę)

WYNIK
Faza zdarzeń jest odwrócona. Znajduje to odzwierciedlenie w linii informacyjnej.

                               

POWIĄZANE LINKI
Linia informacyjna na stronie 59

Wyciszanie zdarzeń
Możesz wyciszyć zdarzenia w oknie projektu. Zdarzenia wyciszone można edytować w zwykły 
sposób, z wyjątkiem regulacji wyciszania, ale nie są one odtwarzane.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Wybierz narzędzie Mute (Wycisz) i kliknij zdarzenia lub przeciągnij wokół nich prostokąt 
             zaznaczenia.
         ● Wybierz zdarzenia i wybierz kolejno Edit > Mute (Edytuj > Wycisz).

WYNIK
Zdarzenia są wyciszone i wyszarzone.

                      

Możesz wyłączyć wyciszenie zdarzeń, zaznaczając je i wybierając EdIt > Unmute (Edytuj > 
Wyłącz wyciszenie).

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

225



Edycja zakresu

Edycja w oknie Projekt nie ogranicza się do obsługi całych zdarzeń i części. Możesz również
pracować z zakresami wyboru, które są niezależne od granic zdarzenia/części i ścieżki.

Tworzenie zakresu wyboru

PROCEDURA
1. Na pasku narzędzi okna Project wybierz Range Selection (Wybór zakresu).
2. Wykonaj jedną z następujących czynności:
● Narysuj prostokąt zaznaczenia wokół zakresu, który chcesz zaznaczyć.
● Wybierz kolejno Edit > Select (Edytuj > Wybierz) i wybierz jedną z funkcji menu.
● Kliknij dwukrotnie zdarzenie, aby utworzyć zakres wyboru, który je obejmuje.

UWAGA
Jeśli przytrzymasz klawisz Shift i klikniesz dwukrotnie kilka zdarzeń z rzędu, możesz utworzyć 
zakres wyboru obejmujący kilka zdarzeń.

POWIĄZANE LINKI
Wybierz menu dla zakresów wyboru na stronie 223
Tryb Połącz narzędzia do zaznaczania na stronie 206

Menu Wybierz dla Zakresów Wyboru
Jeśli wybrane jest narzędzie Range Selection (Zaznaczanie zakresów), w podmenu Select 
(Wybierz) dostępne są określone opcje wyboru zakresów w oknie Project.

● Aby otworzyć menu opcji wyboru zakresu, wybierz narzędzie Range Selection (Zaznaczanie 
zakresu) i wybierz Edit > Select (Edycja > Wybierz).

All (Wszystko)
         Dokonuje wyboru obejmującego wszystkie ścieżki, od początku do końca projektu. Możesz 
          zdefiniować długość ścieżki za pomocą ustawienia Project Length w oknie dialogowym  
          Project Setup.
None (Nic)
         Usuwa bieżący zakres wyboru.
Invert (Odwróć)
         Odwraca zaznaczenie. Wszystkie wybrane zdarzenia zostaną odznaczone, a wszystkie 
         zdarzenia, które nie zostały zaznaczone, zostaną zaznaczone. Używany tylko do wyboru 
          zdarzeń.
In Loop (W pętli)
         Dokonuje wyboru między lewym a prawym lokalizatorem na wszystkich ścieżkach.
From Start to Cursor (Od początku do kursora)
         Dokonuje wyboru na wszystkich ścieżkach, od początku projektu do kursora projektu.
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From Cursor to End (Od kursora do końca)
         Dokonuje wyboru na wszystkich ścieżkach, od kursora projektu do końca projektu.
Equal Pitch - all Octaves (Equal Pitch - wszystkie oktawy)
         Ta funkcja wymaga wybrania pojedynczej nuty. Zaznacza wszystkie nuty tej partii, które mają
          taką samą wysokość w dowolnej oktawie jak wybrana nuta.
Equal Pitch - same Octave (Equal Pitch - ta sama oktawa)
         Ta funkcja wymaga wybrania pojedynczej nuty. Zaznacza wszystkie nuty tej partii, które mają
          tę samą wysokość i tę samą oktawę, co wybrana nuta.
Select Controllers in Note Range (Wybierz kontrolery w zakresie nut)
         Wybiera kontrolery w zakresie nut.
All on Selected Tracks (Wszystko na wybranych ścieżkach)
         Wybiera wszystkie zdarzenia na wybranej ścieżce. Używany tylko do wyboru zdarzeń.
Events under Cursor (Zdarzenia pod kursorem)
         Zaznacza wszystkie zdarzenia na wybranych ścieżkach, które są dotknięte kursorem projektu.
Select Event (Wybierz Zdarzenie)
         Jest to dostępne w Sample Editor (edytorze próbek).
Left Selection Side to Cursor (Lewa strona zaznaczenia do kursora)
         Przesuwa lewą stronę bieżącego zakresu zaznaczenia do pozycji kursora projektu.
Right Selection Side to Cursor (Prawa strona zaznaczenia do kursora)
         Przesuwa prawą stronę bieżącego zakresu zaznaczenia do pozycji kursora projektu.
Range to Next Event (Zakres do następnego zdarzenia)
         Przesuwa zakres wyboru do następnego początku lub końca zdarzenia na wybranych 
         ścieżkach i zmienia zakres wyboru na wybór zerowy.
Range to Previous Event (Zakres do poprzedniego zdarzenia)
         Przesuwa zakres wyboru do początku lub końca poprzedniego zdarzenia na wybranych 
         ścieżkach i zmienia zakres wyboru na wybór zerowy.
Enlarge Range to Next Event (Powiększ zakres do następnego zdarzenia)
         Przesuwa prawą stronę bieżącego zaznaczonego zakresu do następnego początku lub końca 
         zdarzenia na wybranych ścieżkach.
Enlarge Range to Previous Event (Powiększ zakres do poprzedniego zdarzenia)
         Przesuwa lewą stronę bieżącego zaznaczonego zakresu do początku lub końca poprzedniego 
         zdarzenia na wybranych ścieżkach.

POWIĄZANE LINKI
Okno dialogowe konfiguracji projektu na stronie 104
Wybieranie za pomocą narzędzia do zaznaczania obiektów na stronie 205
Podmenu Wybierz na stronie 206

Wybieranie zakresów dla kilku ścieżek
Możesz tworzyć zakresy wyboru obejmujące kilka ścieżek. Możliwe jest również wykluczenie 
ścieżek z zakresu wyboru.

PROCEDURA
1. Utwórz zakres wyboru od pierwszej do ostatniej ścieżki.
2. Naciśnij Ctrl/Cmd Alt/Opt i kliknij w zakresie zaznaczenia ścieżki, które chcesz wykluczyć z 
zaznaczenia
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Edycja zakresów wyboru
Możesz edytować zakresy zaznaczenia, czyli dostosowywać ich rozmiar, przesuwać je lub 
duplikować, dzielić itp.

Dopasowywanie rozmiaru zakresów wyboru

Rozmiar zakresu zaznaczenia można dostosować w następujący sposób:
● Przeciągając jego krawędzie.
         Wskaźnik przybiera kształt podwójnej strzałki, gdy przesuwa się go nad krawędzią
         zakresu wyboru.
● Przytrzymując klawisz Shift i klikając.
        Najbliższa krawędź zakresu zaznaczenia zostanie przesunięta do miejsca kliknięcia.
● Dostosowując długość zakresu wyboru lub pozycję początkową lub końcową w linii  
         informacyjnej.
● Używając przycisków przycinania na pasku narzędzi.
         lewe przyciski przycinania przesuwają początek zakresu wyboru, a prawe przyciski 
         przesuwają koniec. Krawędzie zostaną przesunięte o wartość określoną w wyskakującym 
         menu Grid (Siatka).

UWAGA
Przyciski przycinania znajdują się na Nudge Palette (palecie podsunięcia), która domyślnie nie jest 
widoczna na pasku narzędzi.

● Używając opcji Move Left (Przesuń w lewo) i Move Right (Przesuń w prawo) na pasku 
narzędzi.
         Przesuwają one cały zakres zaznaczenia w lewo lub w prawo. Wielkość ruchu zależy od  
         wybranego formatu wyświetlania i wartości określonej w wyskakującym menu Grid (Siatka).

WAŻNE
Zawartość zaznaczenia nie zostanie przeniesiona. Użycie opcji Move Left/Move Right (Przesuń w 
lewo/Przesuń w prawo) jest równoznaczne z równoczesnym dostosowaniem początku i końca 
zakresu zaznaczenia o tę samą wartość.

UWAGA
Przyciski przesuwania znajdują się na Nudge Palette (palecie podsunięcia), która domyślnie nie 
jest widoczna na pasku narzędzi.

● Aby przyciąć wszystkie zdarzenia lub części, które częściowo mieszczą się w zakresie 
zaznaczenia, wybierz kolejno Edit > Range > Crop (Edytuj > Zakres > Przytnij).
Nie ma to wpływu na zdarzenia, które całkowicie mieszczą się w zakresie zaznaczenia lub znajdują 
się poza nim.

POWIĄZANE LINKI
Skonfiguruj menu kontekstowe na stronie 1145

Przesuwanie zakresów zaznaczenia

WARUNEK WSTĘPNY
Utworzyłeś zakres wyboru.
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PROCEDURA
● Kliknij zakres wyboru i przeciągnij go w nowe miejsce.

WYNIK
Zawartość zakresu wyboru zostanie przeniesiona do nowej pozycji. Jeśli zakres przecinał 
wydarzenia lub części, są one dzielone przed przeniesieniem, tak że dotyczy to tylko sekcji w 
zakresie zaznaczenia.

POWIĄZANE LINKI
Tworzenie zakresu wyboru na stronie 223
Powielanie zdarzeń na stronie 217

Powielanie zakresów wyboru

WARUNEK WSTĘPNY
Utworzyłeś zakres wyboru.

PROCEDURA
● Kliknij zakres zaznaczenia, przytrzymaj klawisz Alt/Opt i przeciągnij.

POWIĄZANE LINKI
Tworzenie zakresu wyboru na stronie 223

Wytnij, skopiuj i wklej zakresy zaznaczenia
Możesz wycinać lub kopiować i wklejać zakresy zaznaczenia, używając funkcji w menu Edit 
(Edycja). Możesz także użyć opcji Cut Time (Czas cięcia) i Paste Time (Czas wklejania).

Cut (Wytnij)
        Wycina dane w zaznaczonym zakresie i przenosi je do schowka. Zakres zaznaczenia jest 
         zastępowany przez puste miejsce na ścieżce w oknie projektu, co oznacza, że zdarzenia po 
         prawej stronie zakresu zachowują swoje pozycje.
Copy (Kopiuj)
        Kopiuje dane z zaznaczonego zakresu do schowka.
Paste (Wklej)
        Wkleja dane ze schowka do pozycji początkowej i ścieżki bieżącego zaznaczenia. Istniejące 
        zdarzenia na ścieżkach pozostają na swoim pierwotnym miejscu.
Paste at Origin (Wklej w miejscu pochodzenia)
        Wkleja dane ze schowka z powrotem do pierwotnej pozycji. Istniejące zdarzenia na torach 
        pozostają na swoim pierwotnym miejscu. Ta opcja jest dostępna w Edit > Functions (Edycja 
        > Funkcje).
Cut Time (Wytnij czas)
        Wycina zakres zaznaczenia i przenosi go do schowka. Zdarzenia po prawej stronie 
        usuniętego zakresu są przesuwane w lewo, aby wypełnić lukę. Ta opcja jest dostępna w Edit >
        Range (Edycja > Zakres).
Paste Time (Wklej Czas)
        Wkleja zakres zaznaczenia ze schowka do pozycji początkowej i ścieżki bieżącego 
        zaznaczenia. Istniejące zdarzenia są przenoszone, aby zrobić miejsce na wklejone dane. Ta 
        opcja jest dostępna w Edit > Range (Edycja > Zakres).
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Paste Time at Origin (Wklej czas w miejscu pochodzenia)
         Wkleja zakres zaznaczenia ze schowka do pierwotnej pozycji. Istniejące wydarzenia są 
          przenoszone, aby zrobić miejsce na wklejone dane.
          Ta opcja jest dostępna w Edit > Range (Edycja > Zakres).
Global Copy (Globalna kopia)
         Kopiuje wszystko między lewym a prawym lokalizatorem.
          Ta opcja jest dostępna w Edit > Range (Edycja > Zakres).

Usuwanie danych w zakresach wyboru

● Aby zastąpić dane w usuniętym zakresie zaznaczenia pustym miejscem na ścieżce, wybierz Edit 
> Delete (Edytuj > Usuń) lub naciśnij Backspace . Zdarzenia po prawej stronie zakresu zachowują 
swoją pozycję.
● Aby usunąć zakres zaznaczenia i sprawić, by zdarzenia po prawej przesunęły się w lewo, aby 
wypełnić lukę, wybierz kolejno Edit > Range > Delete Time (Edytuj > Zakres > Usuń czas).

Rozdzielanie zakresów wyboru
Zdarzenia lub części można dzielić na krawędziach zakresu zaznaczenia, czyli na początku i na 
końcu zakresu zaznaczenia.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
          ● Na pasku narzędzi okna Project aktywuj Combine Selection Tool (narzędzia łączenia 
             zaznaczenia) i przesuń mysz do górnego obszaru zdarzenia lub części, którą chcesz 
             podzielić, aby aktywować narzędzie Range Selection (zaznaczania zakresu).
         ● Na pasku narzędzi okna Project aktywuj narzędzie Range Selection (Zaznaczanie zakresu).
2. Wykonaj jedną z następujących czynności:
         ● Wybierz polecenie Edit > Range > Split (Edytuj > Zakres > Podziel).
         ● Naciśnij Shift-X .

WYNIK
Zdarzenia lub części są dzielone na krawędziach zakresu zaznaczenia. Jeśli aktywowałeś tryb 
Combine Selection Tools (Połącz narzędzia do zaznaczania), podzielone zdarzenia lub części są 
wybierane automatycznie.

POWIĄZANE LINKI
Tryb połącz narzędzia do zaznaczania na stronie 206

Wstawianie ciszy
Możesz wstawić puste miejsce na ścieżkę od początku zakresu wyboru. Długość ciszy jest równa 
długości zakresu zaznaczenia.

● Aby wstawić ciszę, wybierz Edit > Range > Insert Silence (Edytuj > Zakres > Wstaw ciszę).
Zdarzenia po prawej stronie początku zakresu wyboru są przesuwane w prawo, aby zrobić miejsce. 
Zdarzenia przecinane przez początek zakresu wyboru są dzielone, a prawa sekcja jest przesuwana w
prawo.
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Odtwarzanie i transport
Cubase oferuje wiele metod i funkcji do sterowania odtwarzaniem i transportem.

Panel Transport
Panel Transport zawiera główne funkcje transportowe oraz wiele innych powiązanych opcji
do odtwarzania i nagrywania.
● Aby wyświetlić panel Transport, wybierz opcję Transport > Transport Panel (Transport > 
Panel transportu) lub naciśnij klawisz F2 .

Sekcje panelu transportu
Panel Transport zawiera różne sekcje, które można pokazać lub ukryć, aktywując odpowiednie 
opcje w menu kontekstowym panelu Transport.
● Aby wyświetlić wszystkie sekcje panelu Transport, kliknij prawym przyciskiem myszy 
w dowolnym miejscu panelu Transport i wybierz Show All (Pokaż wszystko).

Dostępne są następujące sekcje:

System Performance Meter (Miernik wydajności systemu)
System Performance Meter

          
Pokazuje liczniki średniego obciążenia przetwarzania dźwięku i obciążenia pamięci podręcznej 
dysku.

Common Record Modes  (Typowe tryby nagrywania)
Common Record Modes

           
Umożliwia określenie, co się stanie, jeśli klikniesz Record (Nagraj) podczas nagrywania audio lub 
MIDI, oraz gdzie ma się rozpocząć nagrywanie.

Audio Record Modes  (Tryby nagrywania Audio)
Audio Record Modes

            
Pozwalają wybrać, co się stanie, gdy nagrywasz na istniejących zdarzeniach audio.

MIDI Record Modes  (Tryby nagrywania MIDI)
MIDI Record Modes

              
Pozwala wybrać, co się stanie, gdy nagrywasz na istniejących częściach MIDI.

MIDI Auto Quantize  (Automatyczna kwantyzacja MIDI)
Automatic MIDI Record Quantize  (Automatyczna kwantyzacja nagrań MIDI)

                  
Aktywuje automatyczną kwantyzację podczas nagrywania MIDI.
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Locators  (Lokalizatory)

Go to Left Locator Position  (Przejdź do pozycji lewego lokalizatora)

           
Umożliwia przejście do pozycji lewego lokalizatora.
Left Locator Position  (Pozycja lewego lokalizatora)

           
Pokazuje pozycję lewego lokalizatora.
Go to Right Locator Position  (Przejdź do pozycji prawego lokalizatora)

           
Pozwala przejść do pozycji prawego lokalizatora.
Right Locator Position  (Pozycja prawego lokalizatora)

           
Pokazuje pozycję prawego lokalizatora.

Locator Range Duration  (Czas trwania zasięgu lokalizatora)

Locators to Selection (Lokalizatory do zaznaczenia)

          
Umożliwia ustawienie lokalizatorów do zaznaczenia.
Locator Range Duration (Czas trwania zasięgu lokalizatora)

            
Pokazuje czas trwania zasięgu lokalizatora.

Punch Points  (Punkty uderzenia)

Lock Punch Points to Locators  (Zablokuj punkty uderzenia w lokalizatorach)

           
Blokuje punkty przebijania w lewym i prawym położeniu lokalizatora.
Punch In  (Wejdź)

           
Aktywuje Punch In.
Punch In Position  (Wejdź w pozycję)

            
Umożliwia ustawienie stempla w pozycji. Aby to zadziałało, funkcja Lock Punch Points to 
Locators (Zablokuj punkty przebijania w lokalizatorach) musi być wyłączona. Aby to 
pokazać/ukryć, kliknij punkty na rozdzielaczu.
Punch Out  (Wyjdź)

             
Aktywuje Punch Out.
Punch Out Position (Pozycja wyjścia)

             
Umożliwia ustawienie pozycji wychodzenia. Aby to zadziałało, funkcja Lock Punch Points to 
Locators (Zablokuj punkty uderzenia w lokalizatorach) musi być wyłączona. Aby to 
pokazać/ukryć, kliknij punkty na rozdzielaczu.
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Transport Controls  (Sterowanie transportem)

Go to Previous Marker/Zero  (Przejdź do poprzedniego znacznika/zera)

         
Przesuwa kursor projektu do poprzedniego znacznika/pozycji zerowej na osi czasu.
Go to Next Marker/Project End  (Przejdź do następnego znacznika/końca projektu)

         
Przesuwa kursor projektu do następnego znacznika/końca projektu.
Rewind (Przewijanie do tyłu)

          
Przesuwa się do tyłu.
Forward (Przewijanie do przodu)

          
Przesuwa do przodu.
Cycle (Cykl)

          
Aktywuje/dezaktywuje tryb cyklu.
Stop (Zatrzymaj się)

          
Zatrzymuje odtwarzanie.
Start (Początek)

          
Rozpoczyna odtwarzanie.
Transport Rekord (Nagrywaj)

          
Włącza/wyłącza tryb nagrywania.

Time Display  (Wyświetlanie czasu)

Select Primary Time Format (Wybierz podstawowy format czasu)

          
Umożliwia wybranie formatu czasu dla głównego wyświetlania czasu.
Primary Time Display (Główny wyświetlacz czasu)

           
Pokazuje pozycję kursora projektu w wybranym formacie czasu.
Select Secondary Time Format (Wybierz dodatkowy format czasu)

           
Umożliwia wybranie formatu czasu dla dodatkowego wyświetlania czasu.
Secondary Time Display (Wyświetlacz czasu dodatkowego)

           
Pokazuje pozycję kursora projektu w wybranym formacie czasu.
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Markers (Znaczniki)
Jump to Marker (Skok do znacznika)

          
Umożliwia ustawianie i lokalizowanie pozycji znaczników.
Open Markers Window (Otwórz okno znaczników)

           
Otwiera okno Markers.

Pre-roll & Post-roll  (Przed filmem i po filmie)
Activate Pre-roll (Aktywuj reklamę przed filmem)

          
Aktywuje reklamę przed filmem.
Pre-roll Amount (Kwota przed filmem)

          
Umożliwia ustawienie pozycji przed rolowaniem. Aby to pokazać/ukryć, kliknij punkty na 
rozdzielaczu.
Activate Post-roll (Aktywuj film po filmie)

          
Aktywuje post-roll.
Post-roll Amount (Kwota po filmie)

          
Umożliwia ustawienie pozycji po zakończeniu filmu. Aby to pokazać/ukryć, kliknij punkty na 
rozdzielaczu.

Tempo & Time Signature  (Sygnatura tempa i czasu)
Activate Tempo Track (Aktywuj ścieżkę tempa)

           
Umożliwia włączanie/wyłączanie ścieżki tempa.
Tempo

           
Umożliwia ustawienie wartości tempa.
Time Signature (Podpis czasowy)

           
Umożliwia ustawienie pierwszej wartości metrum. Aby to pokazać/ukryć, kliknij punkty na 
rozdzielaczu.

Activate External Sync  (Aktywuj synchronizację zewnętrzną)
Activate External Sync (Aktywuj synchronizację zewnętrzną)

           
Aktywuje zewnętrzną synchronizację.
Open Synchronization Setup (Otwórz konfigurację synchronizacji)

           
Umożliwia otwarcie okna dialogowego Project Synchronization Setup (Ustawienia 
synchronizacji projektu).
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Click & Count-In & Click Pattern  (Kliknij i odlicz i kliknij wzór)
Activate Metronome Click (Aktywuj kliknięcie metronomu)

           
Aktywuje kliknięcie metronomu.
Activate Count-in (Aktywuj odliczanie)

           
Aktywuje kliknięcie metronomu podczas odliczania.
Click Pattern (Kliknij Wzór)

           
Umożliwia skonfigurowanie wzorca klikania. Aby to pokazać/ukryć, kliknij punkty na 
rozdzielaczu.
Open Metronome Setup (Otwórz konfigurację metronomu)

           
Otwiera okno dialogowe Metronome Setup (Ustawienia metronomu). Aby to pokazać/ukryć, 
kliknij punkty na rozdzielaczu.

Input/Output Activity  (Aktywność wejścia/wyjścia)
MIDI In Activity (Aktywność wejścia MIDI)

           
Wyświetla sygnały wejściowe MIDI.
MIDI Out Activity  (Aktywność wyjścia MIDI)

          
Wyświetla sygnały wyjściowe MIDI.
Audio Activity (Aktywność audio)

          
Wyświetla sygnały wejściowe/wyjściowe audio.
Audio Clipping (Przycinanie Audio)

          
Wyświetla obcinanie dźwięku.
Level Display (Wyświetlacz poziomu)

          
Wyświetla poziom wyjściowy.
Level Control (Kontrola poziomu)

          
Pozwala kontrolować poziom wyjściowy.

Set up Transport  (Skonfiguruj transport)
Set up Transport (Skonfiguruj transport)

          
Otwiera wyskakujące menu, w którym można ustawić, które elementy mają być widoczne.
POWIĄZANE LINKI
Transport na stronie 1179
Transport — szorowanie na stronie 1180
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Menu Transportu
Menu Transport zawiera kilka funkcji transportowych oraz wiele innych powiązanych opcji
do odtwarzania i nagrywania.

Transport Panel (Panel transportu)
         Otwiera panel Transport

Transport Commands  (Polecenia Transportu)

Start (Początek)
         Rozpoczyna odtwarzanie.
Stop (Zatrzymać się)
         Zatrzymuje odtwarzanie.
Start/Stop (Zacząć/zakończyć)
         Rozpoczyna/zatrzymuje odtwarzanie.
Cycle (Cykl)
         Aktywuje/dezaktywuje tryb cyklu.
Record (Nagrywać)
         Włącza/wyłącza tryb nagrywania.
Rewind  (Przewijanie do tyłu)
         Przesuwa do tyłu.
Forward (Przewijanie do przodu)
         Przesuwa do przodu.
Fast Rewind (Szybkie przewijanie do tyłu)
         Przesuwa do tyłu z większą prędkością.
Fast Forward (Szybkie przewijanie do przodu)
         Porusza się do przodu z większą prędkością.
Nudge Cursor Left (Przesuń kursor w lewo)
         Przesuwa pozycję kursora projektu w lewo.
Nudge Cursor Right (Przesuń kursor w prawo)
         Przesuwa pozycję kursora projektu w prawo.
Enter Project Cursor Position (Wprowadź pozycję kursora projektu)
         Umożliwia ręczne wprowadzenie pozycji kursora projektu.
Enter Tempo (Wprowadź Tempo)
         Umożliwia ręczne wprowadzenie tempa.
Enter Time Signature (Wprowadź sygnaturę czasową)
        Umożliwia ręczne wprowadzenie metrum.
Go to Project Start (Przejdź do Start projektu)
        Przesuwa pozycję kursora projektu na początek projektu.
Go to Project End (Przejdź do końca projektu)
        Przesuwa pozycję kursora projektu na koniec projektu.
Exchange Time Formats (Wymień formaty czasu )
        Przełącza główny i dodatkowy wyświetlacz czasu.
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Locators  (Lokalizatory)

Go to Left Locator Position (Przejdź do lewej pozycji lokalizatora)
           Przesuwa pozycję kursora projektu do lewego lokalizatora.
Go to Right Locator Position (Przejdź do pozycji prawego lokalizatora)
           Przesuwa pozycję kursora projektu do prawego lokalizatora.
Set Left Locator to Project Cursor Position (Ustaw lewy lokalizator na pozycję kursora projektu)
           Ustawia lewy lokalizator na pozycję kursora projektu.
Set Right Locator to Project Cursor Position (Ustaw prawy lokalizator na pozycję kursora 
projektu)
          Ustawia prawy lokalizator na pozycję kursora projektu.
Enter Left Locator Position (Wprowadź lewą pozycję lokalizatora)
          Umożliwia ręczne wprowadzenie pozycji lewego lokalizatora.
Enter Right Locator Position (Wprowadź prawą pozycję lokalizatora)
          Umożliwia ręczne wprowadzenie pozycji prawego lokalizatora.
Enter Locator Range Duration (Wprowadź czas trwania zasięgu lokalizatora)
          Umożliwia ręczne wprowadzenie czasu trwania zasięgu lokalizatora.
Set Locators to Selection Range (Ustaw Lokalizatory na Zakres wyboru)
          Ustawia lokalizatory tak, aby obejmowały zaznaczenie.
Exchange Left & Right Locator Positions (Zamień lewe i prawe pozycje lokalizatora)
         Zamienia położenie lewego i prawego lokalizatora.
Loop Selection Range (Zakres wyboru pętli)
         Włącza odtwarzanie od początku bieżącego zaznaczenia i kontynuuje odtwarzanie od nowa
          po dotarciu do końca wyboru.

Punch Points  (Punkty uderzenia)

Activate Punch In (Aktywuj wejście stempla)
         Aktywuje/dezaktywuje wejście.
Activate Punch Out (Aktywuj wyjście stempla)
        Aktywuje/dezaktywuje wyjście.
Go to Punch In Position (Przejdź do opcji Uderzenie w pozycji)
        Przesuwa pozycję kursora projektu do miejsca przebicia.
Go to Punch Out Position (Przejdź do pozycji wybicia)
        Przesuwa pozycję kursora projektu do pozycji wybicia.
Lock Punch Points to Locators (Zablokuj punkty przebijania w lokalizatorach)
       Umożliwia odblokowanie/zablokowanie pozycji wbijania i wybijania do lewego i prawego
        lokalizatora.
Set Punch In to Project Cursor Position (Ustaw opcję Punch In na pozycję kursora projektu)
       Przesuwa przebicie na pozycję kursora projektu.
Set Punch Out to Project Cursor Position (Ustaw opcję Punch Out na pozycję kursora projektu)
       Przesuwa pozycję wybicia do pozycji kursora projektu.
Enter Punch In Position (Wprowadź pozycję przebicia)
       Umożliwia ręczne wprowadzenie pozycji wejścia stempla.
Enter Punch Out Position (Wprowadź pozycję wybicia)
       Umożliwia ręczne wprowadzenie pozycji wyjścia stempla.
Set Punch Points to Selection Range (Ustaw Punkty przebijania na Zakres wyboru)
       Ustawia pozycję wejścia i wyjścia dla wybranego zakresu zdarzenia.
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Set Project Cursor Position  (Ustaw pozycję kursora projektu)

Locate Selection Start (Zlokalizuj początek wyboru)
         Przesuwa kursor projektu na początek zaznaczenia.
Locate Selection End (Zlokalizuj koniec wyboru)
         Przesuwa kursor projektu na koniec zaznaczenia.
Locate Next Marker (Zlokalizuj następny znacznik)
         Przesuwa kursor projektu do następnego znacznika.
Locate Previous Marker (Zlokalizuj poprzedni znacznik)
         Przesuwa kursor projektu do poprzedniego znacznika.
Locate Next Hitpoint (Zlokalizuj następny punkt życia)
         Przesuwa kursor projektu do następnego punktu uderzenia na wybranej ścieżce.
Locate Previous Hitpoint (Zlokalizuj poprzedni punkt życia)
         Przesuwa kursor projektu do poprzedniego punktu uderzenia na wybranej ścieżce.
Locate Next Event (Znajdź następne zdarzenie)
         Przesuwa kursor projektu do następnego zdarzenia na wybranej ścieżce.
Locate Previous Event (Znajdź poprzednie zdarzenie)
        Przesuwa kursor projektu do poprzedniego zdarzenia na wybranej ścieżce.

Play Project Range  (Zagraj zakres projektu)

Play from Selection Start (Odtwórz od początku wyboru)
        Włącza odtwarzanie od początku bieżącego zaznaczenia.
Play from Selection End (Odtwórz od końca wyboru)
        Włącza odtwarzanie od końca bieżącego zaznaczenia.
Play until Selection Start (Graj do rozpoczęcia wyboru)
        Włącza odtwarzanie na dwie sekundy przed rozpoczęciem bieżącego wyboru i zatrzymuje się  
         na początku zaznaczenia.
Play until Selection End (Graj do końca wyboru)
Włącza odtwarzanie na dwie sekundy przed końcem bieżącego wyboru i zatrzymuje się na końcu 
zaznaczenia.
Play until Next Marker (Graj do następnego znacznika)
        Włącza odtwarzanie od kursora projektu i zatrzymuje się na następnym znaczniku.
Play Selection Range (Zagraj zakres wyboru)
        Włącza odtwarzanie od początku bieżącego wyboru i zatrzymuje się na końcu zaznaczenia.

Pre-roll & Post-roll  (Przed filmem i po filmie)

Use Pre-roll (Użyj funkcji Pre-roll)
        Włącza/wyłącza pre-roll.
Use Post-roll (Użyj funkcji Post-roll)
        Aktywuje/dezaktywuje post-roll
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Post-roll from Selection Start (Post-roll z początku wyboru)
        Rozpoczyna odtwarzanie od początku wybranego zakresu i zatrzymuje się po czasie 
        ustawionym w polu post-roll w panelu Transport.
Post-roll from Selection End (Post-roll od końca wyboru)
       Rozpoczyna odtwarzanie od końca wybranego zakresu i zatrzymuje się po czasie ustawionym 
       w polu post-roll w panelu Transport.
Pre-roll to Selection Start (Przewiń do początku wyboru)
       Zatrzymuje odtwarzanie na początku zaznaczenia. Pozycja początkowa odtwarzania jest 
       ustawiana w polu Pre-roll na panelu Transport.
Pre-roll to Selection End (Przewiń do końca wyboru)
       Zatrzymuje odtwarzanie na końcu zaznaczenia. Pozycja początkowa odtwarzania jest   
       ustawiana w polu Pre-roll na panelu Transport.

Use Tempo Track  (Użyj ścieżki tempa)
Aktywuje/dezaktywuje ścieżkę tempa

Common Record Modes  (Typowe tryby nagrywania)

Punch In/Out (Wbicie stempla/wybicie stempla)
        Włącza/wyłącza wejście/wyjście dziurkowania.
Re-Record (Nagraj ponownie)
        Włącza/wyłącza tryb ponownego nagrywania.
Start Recording at Project Cursor Position (Rozpocznij nagrywanie w pozycji kursora projektu)
       Włącza/wyłącza rozpoczęcie nagrywania w miejscu kursora projektu.
Start Recording at Left Locator/Punch In Position (Rozpocznij nagrywanie w lewej pozycji  
              Locatora/Punch In)
       Aktywuje/dezaktywuje rozpoczęcie nagrywania w lewym lokalizatorze.

Audio Record Mode (Tryb nagrywania Audio) 
Te opcje pozwalają wybrać, co się dzieje, gdy nagrywasz na istniejących zdarzeniach.

Keep History (Zachowaj historię)
       Zachowuje istniejące zdarzenia lub fragmenty zdarzeń.
Cycle History + Replace (Historia cyklu + wymiana)
       Zastępuje istniejące wydarzenia lub fragmenty wydarzeń nowym nagraniem. W trybie 
       cyklicznym zachowane są wszystkie duble z bieżącego nagrania cyklicznego.
Replace (Zastąp)
       Zastępuje istniejące zdarzenia lub części zdarzeń ostatnim. 

MIDI Record Mode (Tryb nagrywania MIDI)
Te opcje pozwalają wybrać, co się stanie, gdy nagrywasz na istniejących częściach.

New Parts (Nowe części)
        Zachowuje istniejące partie i zapisuje nowe nagranie jako nową partię.
Merge (Połącz)
        Zachowuje istniejące zdarzenia w częściach i dodaje nowo nagrane zdarzenia.
Replace (Zastąp)
        Zastępuje istniejące zdarzenia w częściach nowym nagraniem.
Auto Quantize in Record (Automatyczna kwantyzacja w nagraniu)
       Aktywuje automatyczną kwantyzację podczas nagrywania.
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MIDI Cycle Record Mode  (Tryb nagrywania cyklu MIDI)

Mix (Mieszaj)
         Dodaje wszystko, co nagrasz do tego, co zostało wcześniej nagrane.
Overwrite (Nadpisz)
        Nadpisuje wszystkie MIDI, które nagrałeś na poprzednich okrążeniach, gdy tylko zagrasz nutę 
        MIDI lub wyślesz dowolną wiadomość MIDI.
Keep Last (Zachowaj ostatnie)
        Zastępuje wcześniej zarejestrowane okrążenia tylko wtedy, gdy nowe okrążenie zostanie 
        zakończone.
Stacked (Ułożone w stos)
        Zamienia każde zarejestrowane okrążenie cyklu w osobną część MIDI i dzieli ścieżkę na pasy 
        dla każdego okrążenia cyklu. Części są ułożone nad sobą, każda na innym pasie. Przyjmuje 
        wszystkie, ale ostatnie są wyciszone.
Mix-Stacked (No Mute) (Mieszanie (bez wyciszenia))
        Tak samo jak Stacked, ale części nie są wyciszone.
Auto Quantize in Record (Kwantyzuj automatycznie w rekordach)
        Aktywuje automatyczną kwantyzację podczas nagrywania.

MIDI Retrospective Recording  (Retrospektywne nagrywanie MIDI)
Umożliwia odzyskanie danych MIDI, które grasz w trybie Stop lub podczas odtwarzania. Dostępne
są następujące opcje:

Insert from All MIDI Inputs (Wstaw ze wszystkich danych wejściowych MIDI)
         Wstawia dane MIDI, które zostały wysłane do wszystkich wejść ścieżek jako liniowa część 
         MIDI na wybranej ścieżce.
Insert from Track Input as Linear Recording (Wstaw z wejścia ścieżki jako rejestrowanie 
liniowe)
         Wprowadza dane MIDI, które zostały wysłane do wejścia ścieżki jako liniowa część MIDI na 
         wybranej ścieżce.
Insert from Track Input as Cycle Recording (Wstaw z wejścia ścieżki jako nagrywanie cyklu)
        Wstawia dane MIDI, które zostały wysłane do wejścia toru jako ułożone części MIDI na 
        wybranej ścieżce.
Empty All Buffers (Opróżnij wszystkie bufory)
        Opróżnia retrospektywny bufor rekordu dla wybranej ścieżki.

Use Video Follows Edit Mode (Użyj trybu edycji podążającego za filmem)
Jeśli ta opcja jest włączona, kursor projektu automatycznie podąża za dokonanymi wyborami lub
podczas wykonywania operacji edycyjnych.

Metronome Setup (Konfiguracja metronomu)
Otwiera okno dialogowe Metronome Setup (Ustawienia metronomu).

Activate Metronome (Włącz metronom)
Aktywuje/dezaktywuje kliknięcie metronomu. 
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Project Synchronization Setup (Konfiguracja synchronizacji projektu)
Otwiera okno dialogowe Project Synchronization Setup (Ustawienia synchronizacji projektu).

Activate External Sync (Aktywuj synchronizację zewnętrzną)
Ustawia synchronizację Cubase zewnętrzną.

POWIĄZANE LINKI
Lewy i prawy lokalizator na stronie 245
Punch In i Punch Out na stronie 250
Pre-Roll i Post-Roll na stronie 249
Menu wspólnych trybów nagrywania na stronie 267
Tryby nagrywania Audio na stronie 272
Tryby nagrywania MIDI na stronie 279
Odzyskiwanie nagrań MIDI na stronie 280
Metronom Kliknij na stronie 251

Transport Bar (Pasek transportu)
Pasek transportu zawiera wszystkie funkcje transportowe w zintegrowanej i stałej strefie okna 
Project.
● Aby aktywować Transport Bar (pasek transportu), kliknij Set up Window Layout (Ustaw 
układ okna) na pasku narzędzi okna Project i aktywuj Transport Bar.
● Aby wyświetlić wszystkie elementy transportu, kliknij prawym przyciskiem myszy pusty obszar 
Transport Bar i wybierz opcję Show All (Pokaż wszystko).
● Aby wyświetlić wszystkie elementy sterujące sekcji, kliknij punkty po prawej stronie sekcji i 
przeciągnij je do końca w prawo. Aby ponownie ukryć elementy sterujące, przeciągnij w lewo.

                                     

POWIĄZANE LINKI
Pasek transportu na stronie 60
Pasek narzędzi okna projektu na stronie 46

Sekcje paska Transport
Pasek transportu ma różne sekcje, które można pokazać lub ukryć, aktywując odpowiednie opcje w 
menu kontekstowym.

● Aby aktywować Transport Bar (pasek transportu), kliknij Set up Window Layout (Ustaw 
układ okna) na pasku narzędzi okna Project i aktywuj Transport Bar.
● Aby pokazać/ukryć narzędzia, otwórz menu kontekstowe paska transportu, klikając prawym 
przyciskiem myszy pusty obszar Transport Bar i aktywuj narzędzia, które chcesz wyświetlić. Aby 
wyświetlić wszystkie narzędzia, wybierz opcję Show All (Pokaż wszystko).

Ograniczenie kompensacji opóźnienia

Constrain Delay Compensation (Ograniczenie kompensacji opóźnienia)

          
        Minimalizuje skutki opóźnienia wynikające z kompensacji opóźnienia
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Common Record Modes  (Typowe tryby nagrywania)

Common Record Modes 

       
Umożliwia określenie, co się stanie, jeśli klikniesz Record (Nagraj) podczas nagrywania Audio lub 
MIDI, oraz gdzie ma się rozpocząć nagrywanie.

Tryby nagrywania Audio
Audio Record Modes (Tryby nagrywania Audio)

        
Pozwalają wybrać, co się stanie, gdy nagrywasz na istniejących zdarzeniach audio.

Tryby nagrywania MIDI        
MIDI Record Modes (Tryby nagrywania MIDI)

        
Pozwala wybrać, co się stanie, gdy nagrywasz na istniejących częściach MIDI.

Automatyczna kwantyzacja MIDI
Automatic MIDI Record Quantize (Automatyczna kwantyzacja nagrań MIDI)

          
Aktywuje automatyczną kwantyzację podczas nagrywania MIDI.

Lewy rozdzielacz (separator)
Left Divider (Lewy rozdzielacz)
Narzędzia umieszczone po lewej stronie separatora są zawsze pokazane.

Miernik wydajności systemu
System Performance Meter (Miernik wydajności systemu)

         
Pokazuje liczniki średniego obciążenia przetwarzania dźwięku i obciążenia pamięci podręcznej 
dysku.
Locators (Lokalizatory)
Go to Left Locator Position (Przejdź do lewej pozycji lokalizatora)

         
Umożliwia przejście do lewej pozycji lokalizatora.
Left Locator Position (Lewa pozycja lokalizatora)

         
Pokazuje lewą pozycję lokalizatora.
Go to Right Locator Position (Przejdź do pozycji prawego lokalizatora)

         
Pozwala przejść do prawej pozycji lokalizatora.
Right Locator Position (Pozycja prawego lokalizatora)

         
Pokazuje prawą pozycję lokalizatora.
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Locator Range Duration  (Czas trwania zasięgu lokalizatora)
Locators to Selection (Lokalizatory do zaznaczenia)

          
Umożliwia ustawienie lokalizatorów do zaznaczenia.
Locator Range Duration (Czas trwania zasięgu lokalizatora)

          
Pokazuje czas trwania zasięgu lokalizatora.

Punch Points (Punkty przebicia (stemplowane))
Punch In (Uderzyć w, przybić stempel)

         
Aktywuje Wbicie.
Punch Out (Wybij, odstempluj)

         
Aktywuje Wybicie.
Lock Punch Points to Locators (Zablokuj punkty stemplowania w lokalizatorach)

         
Blokuje punkty stemplowania w lewym i prawym położeniu lokalizatora.
Punch In Position (Uderzenie w pozycję)

         
Umożliwia ustawienie stempla w pozycji. Aby to zadziałało, funkcja Lock Punch Points to 
Locators (Zablokuj punkty stemplowania w lokalizatorach) musi być wyłączona. Aby to 
pokazać/ukryć, kliknij punkty na separatorze.
Punch Out Position (Pozycja wybicia)

         
Umożliwia ustawienie pozycji stemplowania. Aby to zadziałało, funkcja Lock Punch Points to 
Locators (Zablokuj punkty stemplowania w lokalizatorach) musi być wyłączona. Aby to 
pokazać/ukryć, kliknij punkty na separatorze.
Transport Controls (Sterowanie Transportem)
Go to Previous Marker/Zero (Przejdź do poprzedniego znacznika/zera)

        
Przesuwa kursor projektu do poprzedniego znacznika/pozycji zerowej na osi czasu.
Go to Next Marker/ Project End (Przejdź do następnego znacznika/końca projektu)
Przesuwa kursor projektu do następnego znacznika/końca projektu.

         
Rewind (Przewijanie do tyłu)

         
Przesuwa się do tyłu.
Forward (Do przodu)

        
Przesuwa do przodu.
Cycle (Cykl)

        
Aktywuje/dezaktywuje tryb cyklu.   
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Stop (Zatrzymaj się)

         
        Zatrzymuje odtwarzanie.
Start (Początek)

         
        Rozpoczyna odtwarzanie.
Transport Record (Transport Nagrywaj)

         
       Włącza/wyłącza tryb nagrywania.

Retrospective Record (Zapis retrospektywny)
Insert Retrospective Recording from All MIDI Inputs on Selected Track (Wstaw 
retrospektywne nagranie ze wszystkich wejść MIDI na wybranej ścieżce)

        
        Umożliwia odzyskanie nut MIDI granych w trybie stop lub podczas odtwarzania.

Time Displays (Wyświetlacze czasu)
Select Primary Time Format (Wybierz podstawowy format czasu)

        
       Umożliwia wybranie formatu czasu dla głównego wyświetlania czasu.
Primary Time Display (Główny wyświetlacz czasu)

       
       Pokazuje pozycję kursora projektu w wybranym formacie czasu.
Select Secondary Time Format (Wybierz dodatkowy format czasu)

       
       Umożliwia wybranie formatu czasu dla dodatkowego wyświetlania czasu.
Secondary Time Display (Wyświetlacz czasu dodatkowego)

       
      Pokazuje pozycję kursora projektu w wybranym formacie czasu.

Markers (Markery, znaczniki)
Jump to Marker (Skok do znacznika)

       
       Umożliwia ustawianie i lokalizowanie pozycji znaczników.
Open Markers Window (Otwórz okno znaczników)

       
       Otwiera okno Markers (Znaczniki).

Pre-roll & Post-roll (Przed filmem i po filmie)
Activate Pre-roll (Aktywuj reklamę przed filmem)

       
       Aktywuje reklamę przed filmem.
Pre-roll Amount (Kwota przed filmem)
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        Umożliwia ustawienie pozycji przed rolowaniem. Aby to pokazać/ukryć, kliknij punkty na 
        rozdzielaczu.
Activate Post-roll (Aktywuj film po filmie)

        
        Aktywuje post-roll.
Post-roll Amount (Kwota po filmie)

        
        Umożliwia ustawienie pozycji po zakończeniu filmu. Aby to pokazać/ukryć, kliknij punkty na 
        rozdzielaczu.

Tempo & Time Signature (Sygnatura tempa i czasu)
Activate Tempo Track (Aktywuj ścieżkę tempa)

        
        Umożliwia włączanie/wyłączanie ścieżki tempa.
Tempo

       
       Umożliwia ustawienie wartości tempa.
Time Signature (Metrum)

       
       Umożliwia ustawienie pierwszej wartości metrum. Aby to pokazać/ukryć, kliknij punkty na 
       rozdzielaczu.

Right Divider (Prawy rozdzielacz)
Right Divider
Narzędzia umieszczone po prawej stronie separatora są zawsze pokazane.

Activate External Sync (Aktywuj synchronizację zewnętrzną)
Activate External Sync

        
        Aktywuje zewnętrzną synchronizację.
Open Synchronization Setup (Otwórz konfigurację synchronizacji)

       
       Umożliwia otwarcie okna dialogowego Project Synchronization Setup (Ustawienia 
       synchronizacji projektu).

Click & Count-in (Kliknij i odlicz)
Activate Metronome Click (Aktywuj kliknięcie metronomu)

       
       Aktywuje kliknięcie metronomu.
Activate Count-in (Aktywuj odliczanie)

       
       Aktywuje kliknięcie metronomu podczas odliczania.
Click Pattern (Kliknij Wzór)

       
       Umożliwia skonfigurowanie wzorca klikania. Aby to pokazać/ukryć, kliknij punkty na 
       rozdzielaczu.

245



Open Metronome Setup (Otwórz konfigurację metronomu)

        
       Otwiera okno dialogowe Metronome Setup (Ustawienia metronomu). Aby to pokazać/ukryć, 
       kliknij punkty na rozdzielaczu.

Input/Output Activity (Aktywność wejścia/wyjścia)
MIDI In Activity (Aktywność wejścia MIDI)

       
       Wyświetla sygnały wejściowe MIDI.
MIDI Out Activity (Aktywność wyjścia MIDI)

       
       Wyświetla sygnały wyjściowe MIDI.
Audio Activity (Aktywność audio)

       
       Wyświetla sygnały wejściowe/wyjściowe audio.
Audio Clipping (Przycinanie Audio)

       
       Wyświetla obcinanie Audio.
Level Display (Wyświetlacz poziomu)

       
       Wyświetla poziom wyjściowy.
Level Control (Kontrola poziomu)

       
       Pozwala kontrolować poziom wyjściowy.

Set up Transport Bar (Skonfiguruj pasek transportu)
Set up Transport (Skonfiguruj transport)

       
Otwiera wyskakujące menu, w którym można ustawić, które elementy mają być widoczne.

Wyskakujące okienko Transportu
Okno podręczne Transport umożliwia dostęp do określonych poleceń transportowych, jeśli panel 
Transport, Transport Bar (Pasek transportu) i Transport Controls (Elementy sterujące 
transportem) na pasku narzędzi okna Project są zamknięte lub ukryte.
Następujące domyślne polecenia klawiszowe otwierają okno podręczne Transport Bar:
Wprowadź lewy lokalizator
        Shift - l
Wprowadź prawy lokalizator
        Shift - r
Wprowadź pozycję kursora projektu
        Shift - p
Wprowadź Tempo
        Shift - T
Wprowadź metrum
        Shift - C
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Wprowadź pozycję Punch-In
        Shift -I
Wprowadź pozycję Punch-Out
        Shift - O
Przejdź do lewego lokalizatora
        Num 1
Przejdź do prawego lokalizatora
        Num 2

Użycie określonej komendy klawiszowej otwiera odpowiednią sekcję wyskakującego okna 
Transport:

        
        Wyskakujące okienko transportu do wprowadzania lewej pozycji Locator (lokalizatora).
UWAGA
Aby zamknąć okno podręczne Transport, naciśnij klawisz Esc .

Time Display Window (Okno wyświetlania czasu)
Okno Time Display umożliwia wyświetlanie bieżącej pozycji czasu  w osobnym oknie. Możesz 
dostosować jego rozmiar i określić format czasu, który chcesz wyświetlić.
● Aby otworzyć okno Time Display (Wyświetlanie czasu), wybierz Studio > More Options > 
Time Display (Studio > Więcej opcji > Wyświetlanie czasu).

              

Kliknij okno prawym przyciskiem myszy, aby uzyskać dostęp do następujących opcji:

Bars + Beats (Takty + uderzenia)
       Wyświetla czas w taktach i uderzeniach.
Seconds (Sekundy)
       Wyświetla czas w sekundach.
fps
       Wyświetla czas w klatkach na sekundę.
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Samples (Próbki)
         Wyświetla czas w próbkach.
Show Beat Count Only (Pokaż tylko liczbę uderzeń)
         Pokazuje tylko liczbę uderzeń. Jest to przydatne, jeśli chcesz używać okna wyświetlania czasu
         jako wizualnego metronomu.
Increase Window Size (Zwiększ rozmiar okna)
        Zwiększa rozmiar okna i wyświetlanych wartości.
Decrease Window Size (Zmniejsz rozmiar okna)
        Zmniejsza rozmiar okna i wyświetlanych wartości.
UWAGA
Window Transparency (Przezroczystość okna) można ustawić w oknie dialogowym Studio Setup
(Ustawienia programu Studio) (strona Time Display (Wyświetlanie czasu)).

POWIĄZANE LINKI
Zdarzenia metrum na stronie 1040

Lokalizatory lewy i prawy
Lewy i prawy lokalizator to para znaczników, których możesz użyć jako pozycji odniesienia w 
oknie Project i w edytorach.

Lokalizatory pomagają na przykład wykonać następujące czynności:

● Pozycjonowanie kursora projektu.
● Definiowanie pozycji rozpoczęcia i zakończenia nagrywania.
● Definiowanie pozycji startowych dla importu lub eksportu zdarzeń.
● Ustawianie zakresu cykli.
● Wybieranie, kopiowanie, tworzenie lub dzielenie zdarzeń.

Lokalizatory są oznaczone flagami na linijce.

Obszar między lewym a prawym lokalizatorem to zasięg lokalizatora. Zasięg lokalizatora jest 
podświetlony na linijce i wyświetlaczu zdarzeń.

W oknie zdarzeń edytorów MIDI zakres lokalizatora jest podświetlony tylko wtedy, gdy opcja 
Show Part Borders (Pokaż granice części) jest wyłączona.

● Aby włączyć/wyłączyć tryb cyklu, kliknij zakres lokalizatora w górnej części linijki, lub
aktywuj Activate Cycle (Cykl aktywacji) w kontrolkach transportu.

 

● UWAGA
Jeśli aktywujesz tryb cyklu, a prawy lokalizator znajdzie się przed lewym lokalizatorem,
zakres lokalizatora jest pomijany podczas odtwarzania.
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POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46
Ustawianie kursora projektu na stronie 247
Ręczna aktywacja nagrywania na stronie 264
Automatyczne włączanie nagrywania na stronie 264
Zapis cyklu na stronie 266
Punch In i Punch Out na stronie 250
Menu wspólnych trybów nagrywania na stronie 267
Opcje importu plików MIDI na stronie 291
Okno dialogowe opcji eksportu dla plików MIDI na stronie 169
Eksportuj miks audio na stronie 1053
Ustawianie lokalizatorów za pomocą znaczników cykli na stronie 337
Wybierz podmenu na stronie 206
Wybierz menu dla zakresów wyboru na stronie 223
Wycinanie, kopiowanie i wklejanie zakresów zaznaczenia na stronie 226
Części audio na stronie 203
Partie MIDI na stronie 203
Charakterystyczne elementy sterujące ścieżki na stronie 156
Wypełnij pętlę na stronie 219
Dzielenie zdarzeń na stronie 215
Transport na stronie 1179

Ustawianie lewego lokalizatora
         Ustawienie lewego lokalizatora może być przydatne, jeśli chcesz dodać pozycję odniesienia w
         oknie Project i w edytorach.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Naciśnij Ctrl/Cmd i kliknij w górnej części linijki, aby ustawić na niej pozycję lewego  
           lokalizatora.
       ● Dostosuj wartość Left Locator Position (pozycji lewego lokalizatora).
          Jest to dostępne w sekcji Locators (Lokalizatory) paska narzędzi okna Project, paskach  
          narzędzi edytora, panelu Transport i Transport Bar (Pasku transportu).
       ● Przeciągnij lewy uchwyt lokalizatora w górnej części linijki.
       ● Naciśnij Ctrl/Cmd, a na klawiaturze numerycznej naciśnij 1, aby ustawić lewy lokalizator na
          pozycję kursora projektu.
       ● Naciśnij Alt/Opt i kliknij Go to Left Locator Position (Przejdź do pozycji lewego 
          lokalizatora) w panelu Transport.

Ustawianie prawego lokalizatora
       Ustawienie odpowiedniego lokalizatora może być przydatne, jeśli chcesz dodać pozycję 
       odniesienia w oknie Project i w edytorach.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Naciśnij Alt/Opt i kliknij w górnej części linijki, aby ustawić prawy lokalizator w tej pozycji.
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● Dostosuj wartość Right Locator Position (pozycja prawego lokalizatora). Jest to dostępne w 
sekcji Locators (Lokalizatory) paska narzędzi okna Project, paskach narzędzi edytora, panelu 
Transport i Transport Bar (Pasku transportu).
● Przeciągnij prawy uchwyt lokalizatora w górnej części linijki.
● Naciśnij Ctrl/Cmd, a na klawiaturze numerycznej naciśnij 2, aby ustawić prawy lokalizator na 
pozycję kursora projektu.
● Naciśnij Alt/Opt i kliknij Go to Right Locator Position (Przejdź do prawej pozycji lokalizatora)
w panelu Transport.

Konfigurowanie zakresów lokalizatora
Możesz ustawić zasięg lokalizatora, czyli obszar pomiędzy lewym a prawym lokalizatorem.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Naciśnij Shift - D, aby aktywować pole wartości Locator Range Duration (Czas trwania 
           zasięgu lokalizatora) w sekcji Locator Range Duration (Czas trwania zasięgu lokalizatora) 
           na pasku narzędzi i wprowadź wartość.
       ● Kliknij i przeciągnij w górnej części linijki.
       ● Wybierz zakres lub zdarzenie i naciśnij P, aby ustawić lokalizatory do wyboru.
       ● Kliknij dwukrotnie znacznik cyklu.
       ● Naciśnij klawisze Ctrl/Cmd -Alt/Opt i kliknij pozycję w górnej części linijki, aby ustawić 
          oba lokalizatory w najbliższej pozycji przyciągania.

WYNIK
Zasięg lokalizatora jest ustawiany i podświetlany na linijce i wyświetlaczu zdarzeń.

Przesuwanie zakresów lokalizatora
Na linijce możesz przesuwać zakres lokalizatora.

WARUNEK WSTĘPNY
Skonfigurowałeś zakres lokalizatora.

PROCEDURA
1. Przesuń wskaźnik myszy do górnej części linijki wewnątrz zakresu lokalizatora. Wyświetlany 
jest symbol dłoni.
2. Kliknij i przeciągnij w lewo lub w prawo, aby przesunąć zakres lokalizatora.

Ustawianie kursora projektu
Kursor projektu można ustawić w miejscu kliknięcia, w znacznikach lub innych predefiniowanych 
pozycjach.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Przytrzymaj klawisze Shift-Alt/Opt i kliknij w oknie Project.
       ● Kliknij Go to Previous Marker/Zero (Przejdź do poprzedniego znacznika/zera) lub Go to  
           Next Marker/Project End (Przejdź do następnego znacznika/końca projektu).
           Są one dostępne w sekcji Transport Controls (Sterowanie transportem) paska narzędzi 
           okna Project, paskach narzędzi edytora, panelu Transport i Transport Bar (Pasku 
           transportu).
       ● Kliknij w dolnej części linijki.
       ● Wybierz Transport > Set Project Cursor Position (Transport > Ustaw pozycję kursora   
           projektu) i wybierz wpis w podmenu.
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POWIĄZANE LINKI
Sekcje panelu transportowego na stronie 228
Linijka na stronie 57
Menu transportu na stronie 233
Transport na stronie 1179
Pasek transportu na stronie 238
Lewy i prawy lokalizator na stronie 245
Komendy klawiszowe na stronie 1123

Menu ustawień automatycznego przewijania
Auto-Scroll (Automatyczne przewijanie) umożliwia utrzymywanie kursora projektu widocznego w
oknie podczas odtwarzania.

Jeśli włączysz Auto-Scroll (automatyczne przewijanie) na pasku narzędzi okna Project lub w 
jednym z edytorów, w wyskakującym menu Select Auto-Scroll Settings (Wybierz ustawienia 
automatycznego przewijania) dostępne będą następujące tryby:

         Page Scroll (Przewijanie strony)

         

Kursor projektu przesuwa się z lewej strony na prawą stronę okna. Kiedy kursor projektu osiągnie 
prawą stronę okna, linijka i kursor projektu przeskakują na lewą stronę okna i zaczynają od nowa. 
To zachowanie można porównać do przewracania strony książki.

         Stationary Cursor (Stacjonarny kursor)

        

Kursor projektu jest utrzymywany na środku okna, a linijka przewija się w sposób ciągły w lewo.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Wstrzymaj automatyczne przewijanie podczas edycji
Jeśli nie chcesz, aby okno projektu zmieniało się podczas edycji podczas odtwarzania, włącz opcję 
Suspend Auto-Scroll when Editing (Zatrzymaj automatyczne przewijanie podczas edycji).

Suspend Auto-Scroll when Editing (Wstrzymaj automatyczne przewijanie gdy edytujesz) jest 
dostępne jako opcja w wyskakującym menu Select Auto-Scroll Settings (Wybierz ustawienia 
automatycznego przewijania) po prawej stronie przycisku Auto Scroll (automatyczne przewijanie).

Jeśli ta opcja jest włączona, automatyczne przewijanie jest zawieszane, gdy tylko klikniesz 
gdziekolwiek na ekranie wydarzenia podczas odtwarzania, aż do zatrzymania odtwarzania lub 
ponownego kliknięcia Auto Scroll (automatyczne przewijanie). 

W ramach wizualnej informacji zwrotnej przycisk automatycznego przewijania zmienia kolor.
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Time Formats (Formaty czasu)
       Możesz ustawić różne formaty czasu.

Wybór podstawowego formatu czasu
W panelu Transport możesz wybrać podstawowy format czasu. Jest to globalny format 
wyświetlania używany do wyświetlania wszystkich linijek i pozycji w programie, z wyjątkiem 
ścieżek linijek.

PROCEDURA
1. W głównej sekcji transportu w panelu Transport kliknij opcję Select Primary Time Format  
    (Wybierz podstawowy format czasu).
2. Wybierz format godziny z menu podręcznego.

               
Możesz także wybrać Project > Project Setup > Display (Projekt > Konfiguracja projektu > 
Format wyświetlania), aby wybrać podstawowy format czasu.

WYNIK
Zaktualizowany zostanie format czasu w panelu Transport oraz na wszystkich linijkach i 
pozycjach ekranów.

Niezależne wyświetlanie czasu
Możesz wyświetlać godziny, które są niezależne od globalnego formatu wyświetlania.

Aby wybrać niezależne wyświetlanie czasu, wykonaj jedną z następujących czynności:
● Na linijce okna Project lub w dowolnym edytorze kliknij przycisk strzałki po prawej stronie 
    linijki.
● Wybierz Project > Add Track > Ruler (Projekt > Dodaj ścieżkę > Linijka), aby dodać ścieżkę  
    linijki i kliknij linijkę prawym przyciskiem myszy.
● W sekcji Main Transport (Główny transport) panelu Transport kliknij Select Secondary Time 
    Format (Wybierz dodatkowy format czasu).

POWIĄZANE LINKI
Linijka na stronie 57
Ścieżka linijki na stronie 146

Pre-Roll i Post-Roll
Reklamy przed filmem i po nim można aktywować za pomocą odpowiednich przycisków w sekcji 
Pre-roll & Post-roll (Przed filmem i po filmie) w panelu Transport lub wybierając opcję 
Transport > Pre-roll & Post-roll > Use Pre-roll/Use Post-roll (Transport > Przed filmem i po 
filmie > Użyj filmu przed filmem/Użyj filmu po filmie).

UWAGA
Aby wyświetlić sekcję Pre-roll & Post-roll (Przed filmem i po filmie), kliknij prawym przyciskiem
myszy w dowolnym miejscu panelu Transport lub na Transport Bar (pasku transportu) i włącz 
Pre-roll & Post-roll (film przed filmem i po filmie).
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● Ustawiając wartość Pre-roll, instruujesz Cubase, aby cofał krótką sekcję za każdym razem, gdy 
    odtwarzanie jest włączone.

                                                  
● Ustawiając wartość Post-roll, instruujesz Cubase, aby odtworzył krótką sekcję po automatycznym
wycięciu przed zatrzymaniem.

                                                   
UWAGA
Działa to tylko wtedy, gdy w panelu Transport jest aktywna opcja Punch Out 
(Odstemplowywanie), a w oknie dialogowym Preferences (Preferencje) (strona Record 
(Nagrywanie)) włączona jest opcja Stop after Automatic Punch Out (Zatrzymaj po 
automatycznym odstemplowaniu).

Korzystanie z Pre-Roll i Post-Roll
Możesz ustawić wartość Pre-roll i Post-roll do nagrywania.

WARUNEK WSTĘPNY
W panelu Transport opcja Lock Punch Points to Locators (Zablokuj punkty przebijania) w 
lokalizatorach jest aktywna

PROCEDURA
1. Ustaw lokalizatory w miejscu, w którym chcesz rozpocząć i zakończyć nagrywanie.
2. W panelu Transport lub na pasku Transport Bar aktywuj Punch In i Punch Out.
3. W oknie dialogowym Preferences (Preferencje) wybierz opcję Record (Nagraj).
4. Aktywuj Stop after Automatic Punch Out (Stop po automatycznym wycięciu).
5. Kliknij prawym przyciskiem myszy w dowolnym miejscu panelu Transport lub Transport Bar 
    (paska transportu) i aktywuj opcję Pre-roll i Post-roll.
6. W sekcji Pre-roll & Post-roll (Reklama przed filmem i po filmie) aktywuj Pre-roll & Post-roll 
    (Reklamy przed filmem i Po filmie). .
7. W polach Pre-roll Amount i Post-roll Amount (Kwota przed filmem i Kwota po filmie) 
     wprowadź wartości pre-roll i post-roll.
8. Aktywuj Record (Nagrywanie).

WYNIK
Kursor projektu cofa się o określoną wartość przed filmem i rozpoczyna się odtwarzanie. Gdy 
kursor dotrze do lewego lokalizatora, nagrywanie jest automatycznie aktywowane. Gdy kursor 
dotrze do prawego lokalizatora, nagrywanie jest dezaktywowane, ale odtwarzanie jest 
kontynuowane przez określoną wartość po nagraniu przed zatrzymaniem

Punch In i Punch Out (Punkty wchodzenia i wychodzenia)
Punkty wejścia i wyjścia to para znaczników, których można użyć do wejścia i wyjścia z nagrań. 
Pozycja punch in (wejścia) określa pozycję początkową zapisu, a pozycja punch out (wyjścia) 
określa pozycję zatrzymania zapisu.

Punch in i Punch out można aktywować, aktywując odpowiednie przyciski na panelu Transport.
Pozycja punch in jest zablokowana w lewej pozycji lokalizatora, a pozycja punch out w prawej 
pozycji lokalizatora. Pola pozycji punch są niedostępne.

                                     
Możesz jednak odłączyć punkty przebicia od lokalizatorów, dezaktywując opcję Lock Punch 
Points to Locators (Zablokuj punkty wchodzenia i wychodzenia w lokalizatorach).
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Jeśli to zrobisz, pola wartości staną się dostępne i możesz ich użyć do ustawienia pozycji punktów 
wchodzenia i wychodzenia niezależnie od pozycji lokalizatora.

Możesz także przeciągać uchwyty wchodzenia i wychodzenia na linijce, aby ustawić pozycje 
charakterystyczne.

                                 

POWIĄZANE LINKI
Automatyczne włączanie nagrywania na stronie 264
Automatyczne zatrzymywanie nagrywania za pomocą opcji Punch Out na stronie 265

Kliknięcie metronomu
Możesz użyć kliknięcia metronomu jako odniesienia do synchronizacji podczas gry i nagrywania. 
Dwa parametry rządzące taktowaniem metronomu to tempo projektu i metrum, które można 
ustawić w panelu Transport.

● Aby aktywować kliknięcie metronomu, aktywuj Activate Metronome Click (Aktywuj 
Kliknięcie Metronomu) na panelu Transport. Możesz także wybrać Transport > Activate 
Metronome (Transport > Aktywuj metronom) lub użyć odpowiedniego polecenia klawiszowego.
● Aby określić, czy kliknięcie metronomu ma być odtwarzane podczas odtwarzania, nagrywania 
lub odliczania, wybierz Transport > Metronome Setup (Transport > Konfiguracja metronomu)
 i wprowadź zmiany na karcie General (Ogólne).
● Aby skonfigurować dźwięki kliknięcia metronomu, wybierz Transport > Metronome Setup 
(Transport > Konfiguracja metronomu) i wprowadź zmiany na karcie Click Sounds (Dźwięki 
kliknięcia).

POWIĄZANE LINKI
Sekcje panelu Transport na stronie 228
Tryby tempa projektu na stronie 1023

Click Patterns (Wzory kliknięć)
Wzory kliknięć umożliwiają tworzenie niestandardowych kliknięć metronomu

Domyślnie kliknięcie metronomu w Cubase ma wzór 4/4 ze stałą liczbą 4 kliknięć. Poziom 
kliknięcia pierwszego kliknięcia jest wysoki, podczas gdy poziom pozostałych uderzeń jest niski.

             
Domyślny wzór kliknięcia metronomu z 4 kliknięciami w metrum 4/4.

             
Wzór kliknięcia metronomu z 3 kliknięciami w metrum 3/4.
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Ustawiając wzorce kliknięć dla metronomu w bieżącym metrum, możesz utworzyć niestandardowe 
kliknięcie metronomu. Możesz określić liczbę kliknięć i poziom kliknięć według własnych 
upodobań.
Jeśli masz różne partie projektu z różnymi metrum lub tempem i chcesz ustawić różne wzorce 
kliknięć, aby pasowały do rytmu i klimatu tych partii, możesz ustawić wzorzec kliknięć metronomu
dla każdego charakterystycznego zdarzenia w projekcie.

Możesz także dodać to samo metrum dla różnych sekcji i ustawić dla nich różne wzorce.
UWAGA
● Jeśli chcesz zwizualizować bieżący wzorzec klikania w oknie Project, oknie zdarzeń Key Editor
(Edytora klawiszy) lub Drum Editor (Edytora perkusji), aktywuj opcję Use Metronome Click 
Pattern Level for Grid Line Emphasis (Użyj poziomu kliknięcia metronomu dla podkreślenia 
linii siatki) w odpowiednim menu kontekstowym linijki. Jest to przydatne, jeśli opcja Snap 
(Przyciąganie) jest aktywna, a Snap Type (Typ przyciągania) jest ustawiony na Grid (Siatka).
● Linie siatki są podkreślane tylko wtedy, gdy są pokazane. Jeśli chcesz zwizualizować wzór 
kliknięcia ustawiony na 6 Clicks (kliknięć) i Time Signature (metrum) 4/4, musisz ustawić Grid 
Type (Typ siatki) na wartość trypletową.

Zakładka Click Patterns (Wzory kliknięć) w oknie dialogowym Metronome Setup (Ustawienia 
metronomu) umożliwia zarządzanie dostępnymi wzorami klikania. Możesz je usuwać i zmieniać 
ich nazwy lub tworzyć nowe wzorce kliknięć dla określonych metrum.

POWIĄZANE LINKI
Edytor wzorów kliknięć na stronie 252
Konfigurowanie metronomu Kliknij schemat na stronie 253
Konfigurowanie wzorców kliknięć metronomu dla zdarzeń charakterystycznych na stronie 253
Pasek narzędzi okna projektu na stronie 46

POWIĄZANE LINKI
Edytor wzorów kliknięć na stronie 252
Konfigurowanie wzorów kliknięć metronomu na stronie 253
Konfigurowanie wzorców kliknięć metronomu dla zdarzeń metrum na stronie 253
Pasek narzędzi okna Project na stronie 46

Click Pattern Editor (Edytor wzorów kliknięć)
Click Pattern Editor (Edytor wzorców kliknięć) umożliwia skonfigurowanie wzorca kliknięć dla 
projektu w celu stworzenia nowych rowków i odczuć kliknięcia metronomu. Jest to przydatne, jeśli 
chcesz na przykład utworzyć wzór trójkowy dla metrum 4/4.

Click Pattern Editor jest dostępny na pasku transportu (Transport Bar). Jeśli dodasz ścieżkę 
sygnaturową, będzie ona dostępna w Inspector (Inspektorze) i w wierszu informacyjnym.
● Aby otworzyć Click Pattern Editor na pasku transportu, kliknij punkty po prawej stronie sekcji 
Click & Count-in & Click Pattern (Wzór kliknięć i naliczania i kliknięć), a następnie przeciągnij 
je do końca w prawo. Kliknij pole wzoru, aby otworzyć Click Pattern Editor.

                      
Clicks (Kliknięcia)
         Umożliwia zdefiniowanie liczby kliknięć używanych we wzorze.
Pattern (Wzór)
         Umożliwia wybór gotowego wzoru lub zapisanie własnych. To, które schematy są dostępne, 
         zależy od bieżącego metrum i ustawień w oknie dialogowym Metronome Setup  
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          (Konfiguracja metronomu) na karcie Click Patterns (Schematy klikania).
UWAGA
Aby przeglądać, edytować i zmieniać nazwy wzorców, otwórz kartę Click Patterns (Schematy 
klikania) w oknie dialogowym Metronome Setup (Ustawienia metronomu).

Event Display (Wyświetlacz zdarzeń)
Pokazuje zdefiniowaną liczbę uderzeń dla wybranego schematu.
Możesz zmienić poziom akcentu dla rytmu, zmieniając jego położenie w pionie na ekranie zdarzeń. 
Dostępne są 4 różne ustawienia. Odpowiadają one ustawieniom w oknie dialogowym Metronome 
Setup (Konfiguracja metronomu) na karcie Click Sounds (Dźwięki kliknięcia). Możesz wyciszyć 
uderzenie, klikając najniższą pionową pozycję.

POWIĄZANE LINKI
Sekcje paska transportu na stronie 238
Ścieżka sygnatura na stronie 156

Konfigurowanie wzorca klikania metronomu
Możesz ustawić inny wzorzec klikania metronomu dla swojego projektu.

PROCEDURA
1. Na pasku transportu (Transport Bar) kliknij punkty po prawej stronie sekcji Click & Count-in  
    & Click Pattern (Wzorzec klikania i odliczania i klikania) i przeciągnij do końca w prawo, aby  
     wyświetlić sekcję wzorca klikania.
2. Kliknij pole wzoru, aby otworzyć Click Pattern Editor (Edytor wzorców kliknięć).
3. Wykonaj jedną z następujących czynności:
       ● Otwórz wyskakujące menu Pattern (Wzór) i wybierz jedno z ustawień wstępnych.
       ● Użyj ustawienia Clicks (Kliknięcia), aby określić liczbę kliknięć, które chcesz usłyszeć,         
           i kliknij na wyświetlaczu zdarzenia, aby skonfigurować nowy wzorzec kliknięć.
4. Kiedy skończysz, kliknij poza Click Pattern Editor, aby go zamknąć.
5. Aktywuj kliknięcie metronomu.

WYNIK
Kliknięcie metronomu jest odtwarzane ze zdefiniowanym wzorcem kliknięć.

POWIĄZANE LINKI
Edytor wzorów kliknięć na stronie 252
Sekcje paska transportu na stronie 238

Konfigurowanie wzorców klikania metronomu dla zdarzeń 
charakterystycznych
Możesz ustawić wzór kliknięcia metronomu dla każdego charakterystycznego zdarzenia w swoim 
projekcie. Jest to przydatne, jeśli masz różne części projektu z różnymi metrum i chcesz dostosować
wzorce kliknięć do rytmu i stylu tych partii. Możesz także dodać to samo metrum dla różnych 
sekcji i ustawić dla nich różne wzorce.

PROCEDURA
1. Kliknij dwukrotnie znak plus, aby otworzyć Click Pattern Editor (Edytor wzorów kliknięć).
2. Wykonaj jedną z następujących czynności:
        ● Otwórz wyskakujące menu Pattern (Wzór) i wybierz jedno z ustawień wstępnych.
        ● Użyj ustawienia Clicks (Kliknięcia), aby określić liczbę kliknięć, które chcesz usłyszeć, i 
           kliknij na wyświetlaczu zdarzeń, aby skonfigurować nowy wzorzec kliknięć.
3. Kiedy skończysz, kliknij poza Click Pattern Editor, aby go zamknąć.
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4. Powtórz tę czynność dla każdego zdarzenia sygnatury, dla którego chcesz ustawić wzorzec   
     kliknięcia.

WYNIK
Jeśli odtworzysz projekt i aktywujesz kliknięcie metronomu, różne części projektu będą używać 
zdefiniowanych wzorców kliknięć. Click Pattern Editor (Edytor wzorów kliknięć) na Transport 
Bar (pasku transportu) pokazuje wzór w pozycji kursora projektu.

POWIĄZANE LINKI
Edytor wzorów kliknięć na stronie 252
Ścieżka Sygnatura na stronie 156
Zdarzenia metrum na stronie 1040

Okno dialogowe Metronome Setup (konfiguracji metronomu)
Okno dialogowe Metronome Setup umożliwia wprowadzanie ustawień metronomu.

Aby otworzyć okno dialogowe Metronome Setup, wykonaj jedną z następujących czynności:
       ● Wybierz Transport > Metronome Setup (Transport > Konfiguracja metronomu).
       ● Na pasku transportu (Transport Bar) otwórz sekcję Click & Count-in & Click Pattern  
          (Wzór kliknięć i odliczania i kliknięć), a następnie kliknij Open Metronome Setup (Otwórz 
          konfigurację metronomu).

             

POWIĄZANE LINKI
Zakładka Ogólne na stronie 255
Kliknij kartę Dźwięki na stronie 256
Kliknij kartę Wzory na stronie 258
Sekcje paska Transportu na stronie 238
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General (Zakładka Ogólne)
Zakładka General (Ogólne) umożliwia wprowadzanie podstawowych ustawień metronomu.

               

W najwyższej sekcji dostępne są następujące opcje:

Activate Metronome Click (Aktywuj kliknięcie metronomu)
Aktywuje/dezaktywuje kliknięcie metronomu.

W sekcji Click Destinations (Miejsca docelowe kliknięć) dostępne są następujące opcje:

Use MIDI Click (Użyj kliknięcia MIDI)
         Aktywuje kliknięcie MIDI dla metronomu.
Use Audio Click (Użyj kliknięcia Audio)
         Aktywuje kliknięcie Audio dla metronomu, które jest wysyłane przez sprzęt audio.
Audio Click Outputs (Wyjścia audio Click)
         Jeśli używasz wielu szyn wyjściowych, umożliwia to aktywację szyny wyjściowej, do której 
         chcesz skierować kliknięcie metronomu.

W sekcji Click Options (Opcje kliknięcia) dostępne są następujące opcje:

Click while Recording (Kliknij podczas nagrywania)
         Aktywuje kliknięcie metronomu podczas nagrywania.
Click while Playing (Kliknij podczas gry)
        Aktywuje kliknięcie metronomu podczas odtwarzania.
Click during Count-In (Kliknij podczas odliczania)
        Aktywuje muzyczne odliczanie, które jest odtwarzane po rozpoczęciu nagrywania z trybu 
        zatrzymania.
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W sekcji Count-In (Naliczanie) dostępne są następujące opcje:

● Number of Bars in Count-In (Liczba taktów w naliczaniu)
        Umożliwia ustawienie liczby taktów, które metronom odlicza przed rozpoczęciem nagrywania.
● Time Signature at Record Start Position (Sygnatura czasowa w miejscu rozpoczęcia 
     nagrywania)
       Włącz tę opcję, aby odliczanie automatycznie używało metrum i tempa ustawionych w 
       miejscu, w którym rozpoczyna się nagrywanie.
● Time Signature at Project Position (Sygnatura czasowa w pozycji projektu)
       Aktywuj to, aby odliczanie używało metrum w pozycji projektu.
● Use Custom Time Signature (Użyj niestandardowej sygnatury czasowej)
       Umożliwia ustawienie metrum dla odliczania. W tym trybie zmiany sygnatury w projekcie nie 
       mają wpływu na naliczanie.

Zakładka Click Sounds (Dźwięki kliknięć)
Zakładka Click Sounds umożliwia skonfigurowanie i odsłuchiwanie kliknięć MIDI i kliknięć 
audio. Możesz użyć domyślnego kliknięcia audio lub MIDI, wybrać z listy fabrycznie ustawionych 
dźwięków lub przypisać własne niestandardowe dźwięki.

                              

Sekcja MIDI Click Settings umożliwia skonfigurowanie kliknięcia MIDI, które będzie brzmiało 
po aktywacji
Use MIDI Click (Użyj opcji MIDI Click) w sekcji Click Destinations (Miejsca docelowe kliknięć)
na karcie General (Ogólne).

MIDI Output Port (Port wyjściowy MIDI)
       Umożliwia wybranie portu wyjściowego MIDI dla kliknięcia MIDI. Możesz także wybrać 
        instrument VST skonfigurowany wcześniej w oknie VST Instruments.
MIDI Output Port (Kanał wyjściowy MIDI)
      Umożliwia wybranie kanału wyjściowego MIDI dla kliknięcia MIDI.
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Note (Nuta)
       Umożliwia ustawienie numeru nuty MIDI, czyli wysokości od C-2 do G8. Ustaw numer nuty  
       dla pierwszej miary w takcie w górnym rzędzie i numery nut dla pozostałych miar w rzędach 
       poniżej.
Velocity (Prędkość)
       Umożliwia ustawienie szybkości dźwięku klikania MIDI. Ustaw prędkość pierwszego 
       uderzenia w takcie w górnym rzędzie, a prędkości pozostałych uderzeń w rzędach poniżej.

Sekcja Audio Click Settings (Ustawienia dźwięku kliknięcia Audio) umożliwia skonfigurowanie 
dźwięku kliknięcia, który będzie emitowany po aktywacji Use Audio Click (Użyj kliknięcia audio) 
w sekcji Click Destinations (Miejsca docelowe kliknięć) na karcie General (Ogólne).

Use Steinberg Click Sound (Użyj dźwięku kliknięcia Steinberga)
       Aktywuje domyślne dźwięki kliknięcia metronomu.
Pitch (Poziom)
       Umożliwia ustawienie wysokości dźwięków domyślnych. Ustaw wysokość pierwszego 
       uderzenia w takcie w górnym rzędzie, a wysokość pozostałych uderzeń w rzędach poniżej.
Level (Poziom)
       Umożliwia ustawienie poziomu dźwięków domyślnych. Ustaw poziom dla pierwszego 
       uderzenia w takcie w górnym rzędzie, a poziomy dla pozostałych uderzeń w rzędach poniżej.
Use Custom Sounds (Użyj niestandardowych dźwięków)
       Aktywuje niestandardowe dźwięki kliknięcia metronomu. Aby to zadziałało, musisz wybrać 
       plik audio dla niestandardowych dźwięków, klikając w kolumnie Sound (Dźwięk).
Sound (Dźwięk)
       Umożliwia wybranie pliku audio dla niestandardowych dźwięków. Wybierz plik audio dla 
       pierwszego uderzenia w takcie w górnym rzędzie i pliki audio dla pozostałych uderzeń w 
       rzędach poniżej.
Level (Poziom)
       Umożliwia ustawienie poziomu własnych dźwięków. Ustaw poziom dla pierwszego uderzenia 
       w takcie w górnym rzędzie, a poziomy dla pozostałych uderzeń w rzędach poniżej.
Audio Click Level (Poziom kliknięć audio)
       Umożliwia dostosowanie poziomu dźwięku kliknięcia.
Click Sound Presets (Ustawienia wstępne dźwięku kliknięcia)
       Umożliwia załadowanie jednego z ustawień dźwięku kliknięcia, który obsługuje do 4 
       akcentów. Wśród innych dźwięków kliknięcia, które są odpowiednie dla szerokiego zakresu 
       zastosowań, możesz także wybrać Steinberg Click Sound, domyślny dźwięk kliknięcia w 
        Cubase. Możesz także tworzyć własne ustawienia wstępne i zapisywać je.
Audition Click Sounds (Przesłuchanie dźwięków kliknięć)
       Kliknij Play (Odtwórz), aby odsłuchać aktywowane dźwięki kliknięcia.

Konfigurowanie niestandardowego dźwięku kliknięcia
Jeśli nie chcesz używać domyślnego dźwięku kliknięcia, możesz ustawić własny, niestandardowy 
dźwięk.

WARUNEK WSTĘPNY
W oknie dialogowym Metronome Setup (Ustawienia metronomu) na karcie General (Ogólne) 
opcja Activate Metronome Click (Aktywuj kliknięcie metronomu) jest aktywna. W sekcji Click 
Destinations (Miejsca docelowe kliknięcia) aktywna jest opcja Use Audio Click (Użyj kliknięcia 
Audio).
PROCEDURA
1. Otwórz kartę Click Sounds (Dźwięki kliknięcia) i w sekcji Audio Click Settings (Ustawienia 
dźwięku kliknięcia) aktywuj opcję Use Custom Sounds (Użyj niestandardowych dźwięków).
2. W kolumnie Sound (Dźwięk) kliknij górny wiersz.
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3. W oknie dialogowym pliku przejdź do pliku audio, którego chcesz użyć jako niestandardowego 
     dźwięku dla pierwszego uderzenia i wybierz go.
4. Kliknij Open (Otwórz).
5. Kliknij inne wiersze, aby wybrać pliki audio dla innych uderzeń.
6. Ustaw poziom dźwięków, klikając odpowiednie wiersze w kolumnie Level (Poziom),
    dopasowując wartość.
7. Opcjonalnie: Kliknij Play (Odtwórz), aby odsłuchać niestandardowe dźwięki.

WYNIK
Metronom używa zdefiniowanych niestandardowych dźwięków dla kliknięcia audio.

PO WYKONANIU TEGO ZADANIA
Otwórz menu podręczne Click Sound Presets (Wstępne Ustawienia dźwięku kliknięcia) i zapisz 
własne dźwięki jako ustawienie wstępne.

Zakładka Click Patterns (Wzory kliknięć)
Karta Click Patterns umożliwia zarządzanie wzorcami kliknięć. Wzory kliknięć umożliwiają 
edycję domyślnego kliknięcia metronomu.

           

Dostępne są następujące opcje:

1      Add New Signature (Dodaj nową sygnaturę)
        Kliknij i wprowadź wartość metrum, aby dodać nowe metrum.
2      Available Time Signatures (dostępne metrum)
        Pokazuje dostępne metrum.
3      Available Patterns (dostępne wzory)
        Pokazuje dostępne wzorce kliknięć.
4      Add New Pattern (Dodaj nowy wzór)
        Kliknij dwukrotnie, aby dodać nowy wzór kliknięcia dla metrum.
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5       Clicks (Kliknięcia)
         Umożliwia zmianę liczby kliknięć używanych we wzorcu kliknięć.
6       Click Pattern (Wzór kliknięcia)
         Pokazuje wzór kliknięcia. Możesz otworzyć Click Pattern Editor, klikając wzór.
7       Remove Click Pattern (Usuń wzór kliknięcia)
         Usuwa wzór kliknięcia z listy dostępnych wzorców.
8       Add New Pattern (Dodaj nowy wzór)
         Dodaje nowy domyślny wzorzec klikania dla metrum. 
UWAGA
Jeśli przewiniesz do końca, możesz zresetować wszystkie wzorce kliknięć do ustawień 
fabrycznych, klikając Reset to Factory Patterns (Resetuj do wzorców fabrycznych)

Możesz dwukrotnie kliknąć nazwę wzoru, aby zmienić jego nazwę.

Tworzenie ścieżki kliknięć
Możesz utworzyć ścieżkę audio lub MIDI zawierającą kliknięcia.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Wybierz Project > Signature Track > Render Audio Click between Locators (Projekt > 
            Ścieżka sygnatury > Renderuj Audio Kliknięcie pomiędzy Lokalizatorami).
         ● Wybierz Project > Signature Track > Render MIDI Click between Locators (Projekt > 
            Ścieżka sygnatury > Renderuj MIDI Kliknięcie między Lokalizatorami).

WYNIK
● Ścieżka dźwiękowa zawierająca zdarzenie dźwiękowe z kliknięciem jest dodawana do projektu. 
Poziom odpowiada ustawieniu Audio Click Level (Poziom kliknięć audio) na karcie Click Sounds
(Dźwięki kliknięć) w oknie dialogowym Metronome Setup (Ustawienia metronomu).
● Ścieżka MIDI zawierająca partię MIDI po kliknięciu zostanie dodana do projektu. Wyjście 
ścieżki MIDI jest kierowane do MIDI Output Port (portu wyjściowego MIDI), który ustawiłeś na 
karcie Click Sounds (Dźwięki kliknięcia) w oknie dialogowym Metronome Setup (Ustawienia 
metronomu).

Chase (Pościg)
Chase to funkcja, która zapewnia, że instrumenty MIDI brzmią tak, jak powinny, gdy ustawisz się 
w nowej pozycji i rozpoczniesz odtwarzanie. Osiąga się to poprzez przesyłanie przez program wielu
komunikatów MIDI do Twoich instrumentów za każdym razem, gdy przechodzisz do nowej 
pozycji w projekcie, upewniając się, że wszystkie urządzenia MIDI są prawidłowo skonfigurowane 
pod kątem zmian programu, komunikatów kontrolera (takich jak głośność MIDI ) itp.

PRZYKŁAD
Masz ścieżkę MIDI z wstawionym na początku zdarzeniem zmiany programu. To zdarzenie 
powoduje przełączenie syntezatora na dźwięk fortepianu.

Na początku pierwszego refrenu masz kolejną zmianę programu, która sprawia, że ten sam 
syntezator przełącza się na dźwięk smyczkowy.

Teraz odtwarzasz utwór. Rozpoczyna się dźwiękiem fortepianu, a następnie przechodzi do dźwięku 
smyczków. W połowie refrenu zatrzymujesz się i cofasz do jakiegoś punktu między początkiem a 
drugą zmianą programu. Syntezator nadal gra dźwięki smyczków, chociaż w tej sekcji powinien to 
być fortepian.
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Funkcja Chase dba o to. Jeśli zdarzenia zmiany programu są ustawione jako ścigane (chased), 
Cubase śledzi muzykę z powrotem do początku, znajduje pierwszą zmianę programu i przesyła ją 
do syntezatora, ustawiając właściwy dźwięk.

To samo może dotyczyć również innych typów zdarzeń. W oknie dialogowym Preferences 
(Preferencje) (strona MIDI) ustawienia Chase Events (Ścigaj zdarzenia) określają, które typy 
zdarzeń są ścigane, gdy znajdziesz się w nowej pozycji i rozpoczniesz odtwarzanie.

      

POWIĄZANE LINKI
Zdarzenia Chase (pościgowe) na stronie 1171
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Klawiatura ekranowa
Klawiatura ekranowa (On-Screen Keyboard) umożliwia odtwarzanie i nagrywanie nut MIDI za 
pomocą klawiatury komputera lub myszy. Jest to przydatne, jeśli nie masz pod ręką zewnętrznego 
instrumentu MIDI i nie chcesz rysować nut za pomocą narzędzia Draw (Rysuj).

Gdy wyświetlana jest klawiatura ekranowa, zwykłe skróty klawiaturowe są blokowane, ponieważ
są zarezerwowane dla klawiatury ekranowej. Jedynymi wyjątkami są:

● Zapisz: Ctrl/Cmd - S
● Rozpocznij/Zatrzymaj nagrywanie: Num *
● Rozpocznij/zatrzymaj odtwarzanie: Spacja
● Skok do lewego lokatora: Num 1
● Usuń: Delete lub Backspace
● Włącz/wyłącz cykl: Num /
● Pokaż/ukryj panel transportu: F2
● Pokaż/ukryj klawiaturę ekranową: Alt/Opt - K

Nagrywanie MIDI za pomocą klawiatury ekranowej
Możesz użyć klawiatury ekranowej do nagrywania MIDI w Cubase.

WARUNEK WSTĘPNY
Wybrałeś ścieżkę MIDI lub instrumentu i aktywowałeś funkcję Record Enable

PROCEDURA
1. Wybierz Studio > On-Screen Keyboard (Studio > Klawiatura ekranowa).
2. Aktywuj Nagrywanie.
3. Wykonaj jedną z poniższych czynności, aby wprowadzić notatki:
        ● Kliknij klawisze Klawiatury ekranowej.
        ● Naciśnij odpowiedni klawisz na klawiaturze komputera.
UWAGA
Naciśnij kilka klawiszy jednocześnie, aby wprowadzić partie polifoniczne. Maksymalna liczba nut, 
które można zagrać jednocześnie, różni się w zależności od różnych systemów operacyjnych i 
konfiguracji sprzętowych.

PO WYKONANIU TEGO ZADANIA
Zamknij klawiaturę ekranową, aby ponownie udostępnić wszystkie skróty klawiaturowe.

Opcje klawiatury ekranowej

Klawiatura ekranowa oferuje różne tryby wyświetlania oraz inne opcje.

● Aby otworzyć Klawiaturę ekranową, wybierz Studio > On-Screen Keyboard (Studio > 
Klawiatura ekranowa).
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1  Note Velocity Level (Poziom prędkości nuty)
          Ten suwak umożliwia dostosowanie głośności klawiatury ekranowej. W tym celu możesz  
           również użyć Strzałki w górę lub Strzałki w dół.
2  Change On-Screen Keyboard Type (Zmień typ klawiatury ekranowej)
          Ten przycisk umożliwia przełączanie między trybem wyświetlania klawiatury komputera i 
          klawiatury pianina.
          W trybie klawiatury komputera do wprowadzania nut można używać dwóch rzędów klawiszy
          wyświetlanych na klawiaturze ekranowej.
          Klawiatura fortepianu ma szerszy zakres klawiszy. Pozwala wprowadzić więcej niż jeden  
          głos jednocześnie. Możesz również użyć do tego Tab.
3  Octave Offset (Przesunięcie o oktawę)
         Przyciski te umożliwiają przełączanie zakresu klawiatury na niższą lub wyższą oktawę. Ty  
         masz siedem pełnych oktaw do Twojej dyspozycji. W tym celu możesz również użyć strzałki 
         w lewo lub strzałki w prawo.
4  Pitchbend/Modulation Sliders (suwaki Pitchbend/Modulacja)
        Te suwaki są dostępne tylko w trybie klawiatury fortepianu. Lewy suwak wyświetla pitchbend,
        prawy suwak pokazuje zmiany modulacji. Aby wprowadzić modulację, kliknij klawisz i  
        przeciągnij w górę lub w dół. Aby wprowadzić pitchbend, przeciągnij w lewo lub w prawo.
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Nagrywanie

W Cubase możesz nagrywać Audio i MIDI.

Wykonaj następujące wstępne przygotowania:
       ● Skonfiguruj, podłącz i skalibruj swój sprzęt audio.
       ● Otwórz projekt i skonfiguruj parametry w oknie dialogowym Project Setup (Ustawienia  
           projektu) zgodnie ze swoimi specyfikacjami.
           Parametry w oknie dialogowym Project Setup określają format pliku nagrania, 
           częstotliwość próbkowania, długość projektu itp., które mają wpływ na nagrania audio   
           dokonywane w trakcie trwania projektu.
       ● Jeśli planujesz nagrywać MIDI, skonfiguruj i podłącz swój sprzęt MIDI.

POWIĄZANE LINKI
Konfigurowanie Audio na stronie 15
Konfigurowanie MIDI na stronie 22
Konfigurowanie wzorców kliknięć metronomu na stronie 253

Podstawowe metody nagrywania
Podstawowe metody nagrywania dotyczą nagrań Audio i MIDI.

Ścieżki umożliwiające nagrywanie
Aby móc nagrywać, musisz włączyć nagrywanie na ścieżkach, na których chcesz nagrywać.

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Aktywuj funkcję Record Enable (Włącz nagrywanie) na liście utworów.
        ● Aktywuj funkcję Record Enable w MixConsole.
        ● Wybierz ścieżkę, na której chcesz włączyć nagrywanie, i aktywuj funkcję Record Enable 
           w Inspektorze.

WYNIK
Ścieżki są przystosowane do nagrywania.

UWAGA
Jeśli w kategorii Mixer w oknie dialogowym Key Commands (Polecenia klawiszowe) 
skonfigurujesz polecenie Activate Record Enable for all Audio Tracks (aktywowania nagrywania
dla wszystkich ścieżek audio), możesz jednocześnie włączyć nagrywanie dla wszystkich ścieżek 
audio. Dokładna liczba ścieżek audio, które można nagrywać jednocześnie, zależy od wydajności 
procesora komputera i dysku twardego. Aktywuj opcję Warn on Processing Overloads (Ostrzegaj 
o przeciążeniu procesora) w oknie dialogowym Preferences (Preferencje) (strona VST), aby 
wyświetlić komunikat ostrzegawczy, gdy tylko wskaźnik przeciążenia procesora zaświeci się 
podczas nagrywania.

POWIĄZANE LINKI
Edycja — Project & MixConsole na stronie 1164
VST na stronie 1181
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Nagrywanie włączanych ścieżek przy zaznaczeniu
Możesz ustawić preferencje, aby po wybraniu ścieżek można było je nagrywać.

PROCEDURA
1. Wybierz Edit > Preferences (Edytuj > Preferencje).
2. Otwórz stronę Editing—Project & MixConsole i aktywuj Enable Record on Selected Audio 
Track lub Enable Record on Selected MIDI Track.

WYNIK
Ścieżki są nagrywane po ich wybraniu.

Ręczna aktywacja nagrywania
Możesz aktywować nagrywanie ręcznie.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Kliknij Record (Nagraj) w panelu Transport, na pasku narzędzi lub na pasku Transport 
            (Transport Bar).
         ● Naciśnij Num * .

WYNIK
Nagrywanie rozpoczyna się od bieżącej pozycji kursora.

UWAGA
Gdy rozpoczniesz nagrywanie w trybie zatrzymania, możesz rozpocząć nagrywanie od lewego 
lokalizatora. Aby to zadziałało, musisz wybrać Transport > Common Record Modes (Transport >
Wspólne tryby nagrywania) i aktywować Start Record at Left Locator/Punch In Position 
(Rozpocznij nagrywanie w lewym lokalizatorze/Pozycji Punch In). Zostanie zastosowane 
ustawienie przed filmem lub odliczanie metronomu.

Automatyczna aktywacja nagrywania
Cubase może automatycznie przełączać się z odtwarzania na nagrywanie w danej pozycji. Jest to 
przydatne, jeśli musisz zastąpić fragment nagrania i chcesz odsłuchać to, co zostało już nagrane do 
pozycji początkowej nagrania.

PROCEDURA
1. Ustaw lewy lokalizator w miejscu, w którym chcesz rozpocząć nagrywanie.
Jeśli chcesz ustawić punkty przebicia (wchodzenia i wychodzenia) niezależnie od lokalizatorów, 
wyłącz opcję Lock Punch Points to Locators (Zablokuj punkty przebicia w lokalizatorach) na 
panelu Transport i ustaw pozycje wchodzenia i wychodzenia w polach wartości po prawej stronie.
2. Aktywuj opcję Punch In (Wejdź) w panelu Transport.
3. Włącz odtwarzanie z dowolnej pozycji przed lewym lokalizatorem.

WYNIK
Jeśli odblokowałeś pozycje Punch (Wchodzenia i wychodzenia) z pozycji lokalizatora, nagrywanie 
jest automatycznie aktywowane, gdy kursor projektu osiągnie pozycję Punch In.
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Jeśli włączony jest tryb cyklu, a punkt punch in odpowiada lewej pozycji lokalizatora, 
a punkt punch out znajdzie się przed prawym lokalizatorem, nagrywanie zostanie zatrzymane w 
miejscu punch out i wznowione w miejscu punch in.

Jeśli pozycje punch są zablokowane w lokalizatorach, nagrywanie jest automatycznie aktywowane, 
gdy kursor projektu dotrze do lewego lokalizatora.

POWIĄZANE LINKI
Punch In i Punch Out na stronie 250

Zatrzymywanie nagrywania
Możesz zatrzymać nagrywanie ręcznie.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Kliknij Stop (Zatrzymaj) w panelu Transport.
         ● Naciśnij Num * .

WYNIK
Nagrywanie zatrzymuje się, podczas gdy odtwarzanie jest kontynuowane.

Automatyczne zatrzymywanie nagrywania za pomocą funkcji Punch 
Out
Aktywacja funkcji Punch Out umożliwia automatyczne zatrzymanie nagrywania w określonym 
miejscu punch out.

PROCEDURA
● Aktywuj opcję Punch Out w panelu Transport.

WYNIK
Nagrywanie zatrzymuje się automatycznie, gdy kursor projektu osiągnie pozycję punch out. 
Odtwarzanie jest kontynuowane.

UWAGA
Jeśli odblokowałeś pozycje punch z pozycji lokalizatora, nagrywanie jest automatycznie 
zatrzymywane, gdy kursor projektu osiągnie pozycję punch out.

UWAGA
Jeśli włączony jest tryb cykliczny, punkt wejścia (punch in) zostanie ustawiony za lewym 
lokalizatorem, a punkt wyjścia (punch out) odpowiada prawemu lokalizatorowi, nagrywanie 
zostanie rozpoczęte w pozycji przebicia (punch in), zatrzymane w pozycji wybicia (punch out) 
i wznowione w miejscu pozycji wejścia (punch in).

POWIĄZANE LINKI
Punch In i Punch Out na stronie 250
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Zatrzymywanie nagrywania i odtwarzania
Możesz zatrzymać nagrywanie i odtwarzanie ręcznie.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Kliknij Stop (Zatrzymaj) w panelu Transport.
         ● Naciśnij Num 0 .

WYNIK
Zatrzymanie nagrywania i odtwarzania.

Nagrywanie w cyklu
Możesz nagrywać cyklicznie, czyli wielokrotnie i płynnie nagrywać wybraną sekcję.

WARUNEK WSTĘPNY
Cykl jest ustawiany z lewymi i prawymi pozycjonerami (lokalizatorami).

PROCEDURA
1. Kliknij opcję Activate Cycle (Aktywuj cykl) w panelu Transport, aby aktywować tryb cyklu.
2. Aktywuj nagrywanie z lewego lokalizatora, przed cyklem lub w jego trakcie.
Gdy tylko kursor projektu dotrze do prawego lokalizatora, przeskakuje z powrotem do lewego 
lokalizatora i kontynuuje rejestrowanie nowego okrążenia.

WYNIK
Wyniki rejestracji cyklicznej zależą od wybranego trybu rejestracji. Różnią się również dla Audio 
i MIDI.

POWIĄZANE LINKI
Lewy i prawy lokalizator na stronie 245
Nagrywanie MIDI na stronie 277
Nagrywanie Audio na stronie 272

Korzystanie z Pre-Roll (przed filmem) i Post-Roll (po filmie)
Możesz skonfigurować film przed filmem i film po filmie do nagrywania.

WARUNEK WSTĘPNY
Aktywuj opcję Stop (Zatrzymaj) po automatycznym wybiciu (Punch Out) w oknie dialogowym 
Preferences (Preferencje) (strona Record (Nagraj)).

PROCEDURA
1. Ustaw lokalizatory w miejscu, w którym chcesz rozpocząć i zakończyć nagrywanie.
2. W panelu Transport aktywuj opcje Punch In i Punch Out.
3. Aktywuj reklamy Pre-Roll (przed filmem) i Post-Roll (po filmie).
4. Określ Pre-Roll Amount (Kwotę przed filmem) i Post-Roll Amount (Kwotę po filmie).
5. Kliknij Record (Nagraj).
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WYNIK
Kursor projektu cofa się i rozpoczyna odtwarzanie w czasie ustawionym jako czas przed filmem 
(Pre-roll Amount). Gdy kursor dotrze do lewego lokalizatora, nagrywanie jest automatycznie 
aktywowane. Gdy kursor dotrze do prawego lokalizatora, nagrywanie zostanie wyłączone, a 
odtwarzanie będzie kontynuowane przez czas ustawiony jako czas odtwarzania po filmie (Post-roll 
Amount).

Menu wspólnych trybów nagrywania
Common Record Modes (Wspólne tryby nagrywania) określają, co się stanie, jeśli klikniesz 
Record (Nagrywaj) podczas nagrywania Audio lub MIDI.

● Aby uzyskać dostęp do trybów nagrywania, wybierz Transport > Common Record Modes 
(Transport > Typowe tryby nagrywania). Dostęp do Common Record Modes (Wspólnych trybów 
nagrywania) można również uzyskać, klikając górną część sekcji Record Modes (Tryby 
nagrywania) w panelu Transport.

Punch In/Out (Wbicie/Odbicie)
         W tym trybie nagrywanie jest zatrzymane.
Re-Record (Nagraj ponownie)
        W tym trybie nagrywanie jest ponownie inicjowane, zdarzenia są usuwane, a nagrywanie jest 
        uruchamiane ponownie od dokładnie tego samego miejsca.
Start Recording at Project Cursor Position (Rozpocznij nagrywanie w pozycji kursora projektu)
       W tym trybie nagrywanie rozpoczyna się od pozycji kursora.
Start Recording at Left Locator/Punch In Position (Rozpocznij nagrywanie od lewego 
Lokalizatora/Pozycji Punch In)
       W tym trybie nagrywanie rozpoczyna się od lewego lokalizatora.

POWIĄZANE LINKI
Menu transportu na stronie 233
Sekcje panelu Transport na stronie 228

Re-Recording  (Ponowne nagrywanie)
Jeśli aktywujesz tryb ponownego nagrywania (Re-Record), możesz ponownie rozpocząć 
nagrywanie, ponownie naciskając przycisk nagrywania (Record). Nagrywanie zostanie wznowione 
od pozycji początkowej.

PROCEDURA
1. Wybierz Transport > Common Record Modes (Transport > Wspólne tryby nagrywania) 
      i aktywuj Re-Record.
2. Włącz nagrywanie.
3. Kliknij przycisk Re-Record (Nagraj ponownie), aby wznowić nagrywanie.

WYNIK
Kursor projektu przeskakuje z powrotem do pozycji początkowej nagrywania i nagrywanie jest 
ponownie inicjowane. Uwzględniane są ustawienia pre-roll (przed filmem) i count-in (odliczania).

UWAGA
Poprzednie nagrania są usuwane z projektu i nie można ich odzyskać za pomocą funkcji Undo 
(Cofnij). Jednak pozostają w puli (Pool).
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Monitorowanie
W Cubase monitorowanie oznacza słuchanie sygnału wejściowego podczas przygotowywania do 
nagrywania lub podczas nagrywania.

Dostępne są następujące sposoby monitorowania.
● Przez Cubase.
● Zewnętrznie, słuchając sygnału, zanim dotrze on do Cubase.
● Za pomocą ASIO Direct Monitoring.
Jest to połączenie obu pozostałych metod.

Monitorowanie przez Cubase
Jeśli używasz monitorowania przez Cubase, sygnał wejściowy jest miksowany z odtwarzanym 
dźwiękiem. Wymaga to konfiguracji sprzętowej audio o niskim opóźnieniu.

PROCEDURA
1. Na liście ścieżek aktywuj Monitor.

              

2. W MixConsole dostosuj poziom monitorowania i panoramowanie. Możesz dodawać efekty i EQ 
do sygnału monitora za pomocą kanału ścieżki. Jeśli używasz efektów wtyczek z dużymi 
naturalnymi opóźnieniami, funkcja automatycznej kompensacji opóźnienia w Cubase zwiększy 
opóźnienie. Jeśli stanowi to problem, podczas nagrywania można użyć funkcji Constrain Delay 
Compensation.
3. W oknie dialogowym Preferences (Preferencje) wybierz VST.
4. Otwórz menu podręczne Auto Monitoring (Automatyczne monitorowanie) i wybierz tryb 
monitorowania.

WYNIK
Monitorowany sygnał będzie opóźniony zgodnie z wartością opóźnienia, która zależy od sprzętu 
audio i sterowników. Możesz sprawdzić opóźnienie swojego sprzętu w oknie dialogowym Studio 
Setup (Konfiguracja Studio) (strona Audio System (System audio)).

POWIĄZANE LINKI
VST na stronie 1181

Monitorowanie zewnętrzne
Monitorowanie zewnętrzne oznacza odsłuchiwanie sygnału wejściowego przed wysłaniem go do 
Cubase. Wymaga zewnętrznego miksera do miksowania odtwarzanego dźwięku z sygnałem 
wejściowym. Wartość opóźnienia konfiguracji sprzętu audio nie wpływa na sygnał monitora. 
Podczas korzystania z zewnętrznego monitoringu nie można kontrolować poziomu sygnału 
monitora z poziomu Cubase ani dodawać efektów VST lub EQ do sygnału monitora.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz VST.
2. Otwórz menu podręczne Auto Monitoring (Automatyczne monitorowanie) i wybierz opcję 
    Manual (Ręcznie).
3. Dezaktywuj Monitor w Cubase.
4. Na pulpicie do miksowania lub aplikacji miksera dla twojego sprzętu audio, aktywuj tryb Thru   
    lub Direct Thru, aby ponownie wysłać wejściowy dźwięk.
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Bezpośrednie monitorowanie ASIO
Jeśli twój sprzęt audio jest zgodny z ASIO 2.0, może obsługiwać ASIO Direct Monitoring. Ta 
funkcja może być również dostępna dla sprzętu audio ze sterownikami macOS. W trybie ASIO 
Direct Monitoring monitorowanie odbywa się w sprzęcie audio, a monitorowanie jest kontrolowane
z Cubase. Wartość opóźnienia konfiguracji sprzętu audio nie wpływa na sygnał monitora podczas 
korzystania z ASIO Direct Monitoring.

PROCEDURA
1. Na liście utworów aktywuj Monitor.

           
2. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
3. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio i aktywuj Direct Monitoring  
    (monitorowanie bezpośrednie). Jeśli pole wyboru jest wyszarzone, sprzęt audio (lub jego 
      sterownik) nie obsługuje ASIO Direct Monitoring. Szczegółowe informacje można uzyskać u 
      producenta sprzętu audio.
4. W oknie dialogowym Preferences (Preferencje) wybierz VST.
5. Otwórz menu podręczne Auto Monitoring (Automatyczne monitorowanie) i wybierz tryb 
    monitorowania.
6. W MixConsole dostosuj poziom monitorowania i panoramę. W zależności od sprzętu audio 
    może to nie być możliwe.

PO WYKONANIU TEGO ZADANIA
Możesz monitorować poziomy wejściowe ścieżek audio, to znaczy możesz mapować wpływ szyny 
wejściowej na ścieżki audio z włączoną funkcją monitorowania i obserwować poziomy wejściowe 
ścieżek audio podczas pracy w oknie Project. 
● Aktywuj Map Input Bus Metering to Audio Track (Mapowanie wpływu magistrali wejściowej 
na ścieżkę Audio) w trybie Direct Monitoring (monitorowania bezpośredniego)) w oknie 
dialogowym Preferences (Preferencje) (strona Metering (Pomiar)).

Ponieważ ścieżki odzwierciedlają sygnał magistrali wejściowej, zobaczysz ten sam sygnał w obu 
miejscach. Podczas korzystania z mapowanego pomiaru, wszelkie funkcje zastosowane do ścieżki 
audio nie są odzwierciedlane w jej miernikach. 
UWAGA
Przy aktywnym monitorowaniu bezpośrednim nie można używać funkcji Direct Routing 
(Bezpośrednie przesyłanie) dla miejsc docelowych ściezek 2-8.
Tylko pierwsza magistrala może być używana do monitorowania bezpośredniego.

POWIĄZANE LINKI
VST na stronie 1181

Monitorowanie ścieżek MIDI
Możesz monitorować wszystko, co grasz i nagrywasz przez wyjście i kanał MIDI, które są wybrane
dla ścieżki MIDI.
WARUNEK WSTĘPNY
Funkcja Local Off jest aktywna w instrumencie MIDI.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz MIDI.
2. Upewnij się, że funkcja MIDI Thru Active jest włączona.
3. Na liście utworów aktywuj Monitor.
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WYNIK
Przychodzące MIDI jest ponownie odbijane echem

POWIĄZANE LINKI
MIDI na stronie 1171

Specyfika nagrywania Audio
Do nagrywania Audio wymagane są specjalne przygotowania i ustawienia.

Przygotowania do nagrywania Audio.
Zanim zaczniesz nagrywać Audio, musisz wykonać pewne przygotowania.

Wybór formatu pliku nagrania
Możesz ustawić format pliku nagrania, czyli częstotliwość próbkowania, głębię bitową i typ pliku 
nagrania dla nowych plików audio.

PROCEDURA
1. Wybierz Project > Project Setup (Projekt > Konfiguracja projektu).
2. Skonfiguruj ustawienia dla Sample Rate (częstotliwości próbkowania), Bit Depth (głębia 
bitowa) i Record File Type (typ pliku nagrania).

WAŻNE
Głębię bitową i typ pliku można zmienić w dowolnym momencie, podczas gdy częstotliwość 
próbkowania projektu nie może zostać zmieniona na późniejszym etapie

POWIĄZANE LINKI
Tworzenie nowych projektów na stronie 98

Ustawianie folderu nagrań audio
Każdy projekt Cubase ma folder projektu zawierający folder Audio. Domyślnie jest to miejsce, w 
którym przechowywane są nagrane pliki audio. W razie potrzeby można jednak wybrać foldery 
nagrań niezależnie dla każdej ścieżki audio.

PROCEDURA
1. Na liście ścieżek zaznacz wszystkie ścieżki, do których chcesz przypisać ten sam folder nagrań.
2. Kliknij prawym przyciskiem myszy jedną ze ścieżek, aby otworzyć menu kontekstowe.
3. Wybierz Set Record Folder (Ustaw folder nagrań).
4. W oknie dialogowym plików przejdź do folderu, którego chcesz użyć jako folderu nagrań lub 
utwórz nowy folder, klikając New Folder (Nowy folder).

Jeśli chcesz mieć oddzielne foldery dla różnych typów materiałów (mowa, dźwięki otoczenia, 
muzyka itp.), możesz utworzyć podfoldery w folderze Audio projektu i przypisać różne ścieżki do 
różnych podfolderów. W ten sposób wszystkie pliki audio nadal znajdują się w folderze projektu, 
co ułatwia zarządzanie projektem.
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Przygotowanie ścieżki do nagrywania
Zanim zaczniesz nagrywać dźwięk, musisz dodać ścieżkę i ją skonfigurować

Dodawanie ścieżki i ustawianie konfiguracji kanału
Aby nagrać dźwięk, musisz dodać ścieżkę dźwiękową audio i skonfigurować jej kanał. 
Konfiguracja kanałów ścieżki określa konfigurację kanałów nagranego pliku audio.

PROCEDURA
1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij Add Track (Dodaj ścieżkę) .
2. Kliknij Audio.
3. W polu Count (Wartość) licznika wybierz liczbę ścieżek, które chcesz dodać.
4. Otwórz menu podręczne Configuration (Konfiguracja) i wybierz konfigurację kanału.
5. Opcjonalne: W polu Name (Nazwa) wprowadź nazwę ścieżki.
6. Kliknij Add Track (Dodaj ścieżkę).

POWIĄZANE LINKI
Okno dialogowe dodawania ścieżki – Audio na stronie 122

Wymagania dotyczące pamięci RAM do nagrywania
Każda ścieżka, na której nagrywasz, wymaga określonej ilości pamięci RAM, a zużycie pamięci 
wzrasta, im dłużej trwa nagrywanie. Dla każdego kanału audio wymagane jest 2,4 MB pamięci 
RAM na ustawienia MixConsole itp. Zużycie pamięci wzrasta wraz z długością nagrania, 
częstotliwością próbkowania i liczbą nagranych ścieżek. Podczas konfigurowania projektu do 
nagrywania weź pod uwagę ograniczenia pamięci RAM swojego systemu operacyjnego.

Wybór szyny wejściowej dla ścieżki
Zanim będziesz mógł nagrywać na swojej ścieżce, musisz dodać i skonfigurować wymagane szyny 
wejściowe oraz określić, z której magistrali wejściowej ścieżka będzie nagrywać.

PROCEDURA
1. W Inspektorze ścieżki audio otwórz menu podręczne Input Routing.

          

2. Wybierz magistralę wejściową.

POWIĄZANE LINKI
Konfigurowanie portów wejściowych i wyjściowych na stronie 21
Konfiguracja magistrali audio na stronie 22
Inspektor ścieżek audio na stronie 124
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Nagrywanie Audio
Możesz nagrywać dźwięk przy użyciu dowolnej z podstawowych metod nagrywania

Po zakończeniu nagrywania plik audio jest tworzony w folderze Audio w folderze projektu. 
W Pool (puli) tworzony jest klip audio dla pliku audio, a na ścieżce nagrywania pojawia się 
zdarzenie dźwiękowe, które odtwarza cały klip. Na koniec dla zdarzenia audio obliczany jest obraz 
fali. Jeśli nagranie było bardzo długie, może to chwilę potrwać
UWAGA
Obraz fali jest obliczany i wyświetlany podczas rzeczywistego procesu nagrywania. To obliczenie 
w czasie rzeczywistym wykorzystuje pewną moc obliczeniową. Jeśli Twój procesor jest wolny lub 
pracujesz nad projektem intensywnie wykorzystującym procesor, wyłącz opcję Create Audio 
Images during Record (Twórz obrazy audio podczas nagrywania) w oknie dialogowym 
Preferences (Preferencje) (strona Record – Audio (Nagrywanie — Audio))

POWIĄZANE LINKI
Podstawowe metody nagrywania na stronie 263
Zapis cyklu na stronie 266

Tryby nagrywania Audio
Wybierając Audio Record Mode (tryb nagrywania Audio), decydujesz, co stanie się z twoim 
nagraniem i wszelkimi istniejącymi zdarzeniami na ścieżce, na której nagrywasz. Jest to konieczne, 
ponieważ nie zawsze będziesz nagrywać na pustej ścieżce. Mogą wystąpić sytuacje, w których 
nagrywasz na istniejących zdarzeniach, zwłaszcza w trybie cyklicznym.
● Aby uzyskać dostęp do trybów nagrywania, wybierz Transport > Audio Record Mode 
(Transport > Tryb nagrywania Audio). Dostęp do trybów nagrywania dźwięku można również 
uzyskać, klikając po prawej stronie symbolu dźwięku w sekcji Record Modes (Tryby nagrywania) 
w panelu Transport.

Keep History (Zachowaj historię)
        Istniejące zdarzenia lub fragmenty zdarzeń, na które nakłada się nowe nagranie, są 
        zachowywane.
Cycle History + Replace (Historia cyklu + wymiana)
       Istniejące zdarzenia lub części zdarzeń, na które nakłada się nowe nagranie, są zastępowane 
       przez nowe nagranie. Jeśli jednak nagrywasz w trybie cyklicznym, wszystkie duble z bieżącego
       nagrania cyklicznego zostaną zachowane.
Replace (Zastąp)
       Istniejące zdarzenia lub fragmenty zdarzeń, na które nakłada się nowe nagranie, są 
       zastępowane ostatnim zarejestrowanym ujęciem.

POWIĄZANE LINKI
Menu transportu na stronie 233
Sekcje panelu Transport na stronie 228

Nagrywanie i efekty
Cubase umożliwia dodawanie efektów i/lub EQ bezpośrednio podczas nagrywania. Odbywa się to 
poprzez dodanie efektów insertowych i/lub dokonanie ustawień EQ dla kanału wejściowego 
w MixConsole.

WAŻNE
Jeśli nagrywasz z efektami, efekty stają się częścią samego pliku audio. Nie można zmienić 
ustawień efektów po nagraniu.
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Podczas nagrywania z efektami rozważ użycie 32-bitowego formatu zmiennoprzecinkowego lub 
64-bitowego zmiennoprzecinkowego. W ten sposób głębia bitowa nie zostanie zmniejszona, co 
oznacza, że na tym etapie nie ma ryzyka przesterowania. Ponadto doskonale zachowuje jakość 
sygnału. Jeśli nagrywasz w formacie 16-bitowym lub 24-bitowym, dostępny zapas jest mniejszy, co
oznacza, że przy zbyt głośnym sygnale mogą wystąpić przesterowania.

Nagrywanie miksu oddzielnych ścieżek
Możesz na przykład utworzyć miks oddzielnych ścieżek, bębna basowego, hi-hatów lub werbla. 
Odbywa się to poprzez wybranie szyny wyjściowej, szyny grupowej lub szyny kanału FX jako 
wejścia do nagrywania.

PROCEDURA
1. Skonfiguruj oddzielne ścieżki i dodaj ścieżkę grupową.
2. Dla każdej ścieżki perkusyjnej otwórz menu podręczne Output Routing i wybierz ścieżkę grupy
    jako wyjście.
3. Utwórz nową ścieżkę audio, otwórz menu podręczne Input Routing i wybierz ścieżkę grupową 
    jako wejście dla tej ścieżki audio.
4. Włącz nagrywanie tej ścieżki dźwiękowej i rozpocznij nagrywanie.

WYNIK
Wyjście ścieżki grupowej zostanie nagrane na nowej ścieżce i otrzymasz miks swoich oddzielnych 
ścieżek.

UWAGA
Możesz także wybrać kanał FX jako źródło nagrywania. W takim przypadku nagrywane będzie 
tylko wyjście kanału FX.

POWIĄZANE LINKI
Routing (Trasowanie) na stronie 382

Cofanie nagrań
Nagranie można cofnąć natychmiast po jego nagraniu.

PROCEDURA
● Wybierz polecenie Edit > Undo (Edytuj > Cofnij).

WYNIK
● Zdarzenia, które właśnie nagrałeś, zostaną usunięte z okna Project.
● Klipy audio w Pool (puli) są przenoszone do folderu kosza.

PO WYKONANIU TEGO ZADANIA
Aby usunąć nagrane pliki audio z dysku twardego, wybierz Media > Open Pool Window (Media >
Otwórz okno puli), kliknij prawym przyciskiem myszy ikonę Trash (Kosz) i wybierz Empty 
Trash (Opróżnij Kosz).

POWIĄZANE LINKI
Okno Pool (pula) na stronie 610

276



Odzyskiwanie nagrań audio
Cubase pozwala odzyskać nagrania audio.

Nagrania dźwiękowe można odzyskać w dwóch sytuacjach:
● Nacisnąłeś Record (Nagraj) za późno.
        Aby to zadziałało, musisz określić czas wstępnego nagrywania dźwięku.
● System uległ awarii podczas nagrywania.

Określanie czasu wstępnego nagrywania dźwięku
Możesz przechwycić do 1 minuty dowolnego przychodzącego dźwięku odtwarzanego w trybie 
zatrzymania lub podczas odtwarzania. Jest to możliwe, ponieważ Cubase może przechwytywać 
wejście audio w pamięci buforowej, nawet jeśli nie nagrywa.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz Record > Audio (Nagrywaj > Audio).
2. Określ czas (do 60 sekund) w polu Audio Pre-Record Seconds (Sekundy przed nagraniem   
     dźwięku). Aktywuje to buforowanie wejścia audio, umożliwiając wstępne nagrywanie.
3. Upewnij się, że ścieżka audio umożliwia nagrywanie i odbiera dźwięk ze źródła sygnału.
4. Po odtworzeniu materiału audio, który chcesz przechwycić (w trybie zatrzymania lub
podczas odtwarzania), kliknij Record (Nagraj).
5. Zatrzymaj nagrywanie po kilku sekundach.
Spowoduje to utworzenie zdarzenia dźwiękowego rozpoczynającego się w miejscu, w którym 
znajdowała się pozycja kursora w chwili aktywowania nagrywania. Jeśli byłeś w trybie 
zatrzymania, a kursor znajdował się na początku projektu, być może w następnym kroku będziesz 
musiał przesunąć wydarzenie w prawo. Jeśli grałeś razem z projektem, zostawiasz wydarzenie tam, 
gdzie jest.
6. Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i umieść kursor na dolnej lewej 
krawędzi zdarzenia, tak aby pojawiła się podwójna strzałka. Następnie kliknij i przeciągnij w lewo.

WYNIK
Zdarzenie jest teraz przedłużone, a dźwięk, który odtwarzałeś przed aktywacją nagrywania, jest
wstawiony. Oznacza to, że jeśli zagrałeś podczas odtwarzania, przechwycone nuty trafią dokładnie 
tam, gdzie je zagrałeś w odniesieniu do projektu.

POWIĄZANE LINKI
Nagrywanie — Audio na stronie 1175

Odzyskiwanie nagrań audio po awarii systemu
Cubase umożliwia odzyskanie nagrań audio po awarii systemu, na przykład z powodu przerwy w 
dostawie prądu lub innego zdarzenia losowego.

Jeśli podczas nagrywania wystąpi awaria komputera, uruchom ponownie system i sprawdź folder 
nagrań projektu. Domyślnie jest to podfolder Audio w folderze projektu. Powinien zawierać 
nagrany plik audio od momentu rozpoczęcia nagrywania do momentu awarii komputera.

UWAGA
● Ta funkcja nie stanowi ogólnej gwarancji firmy Steinberg. Chociaż sam program został 
udoskonalony w taki sposób, że nagrania dźwiękowe można odzyskać po awarii systemu, zawsze 
istnieje możliwość, że awaria komputera, przerwa w dostawie prądu itp. mogła uszkodzić inny 
element komputera, uniemożliwiając zapisanie lub odzyskanie jakichkolwiek danych.
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● Nie próbuj aktywnie doprowadzać do tego rodzaju sytuacji w celu przetestowania tej funkcji. 
Chociaż wewnętrzne procesy programu zostały ulepszone, aby radzić sobie z takimi sytuacjami, 
firma Steinberg nie może zagwarantować, że inne części komputera nie ulegną uszkodzeniu w 
wyniku tego.

Specyfika nagrywania MIDI
Do nagrań MIDI wymagane są specjalne przygotowania i ustawienia.

POWIĄZANE LINKI
Specyfika nagrywania MIDI na stronie 275
Nagrywanie w edytorach MIDI na stronie 277
Tryby nagrywania MIDI na stronie 279

Przygotowania do nagrywania MIDI
Przygotowania opisane w poniższych sekcjach koncentrują się głównie na zewnętrznych 
urządzeniach MIDI.

Instrumenty i kanały MIDI
Większość syntezatorów MIDI może odtwarzać kilka dźwięków jednocześnie, każdy na innym 
kanale MIDI. Umożliwia to odtwarzanie kilku dźwięków (bas, fortepian itp.) z tego samego 
instrumentu.

Niektóre urządzenia, takie jak moduły dźwiękowe kompatybilne z General MIDI, zawsze odbierają 
na wszystkich 16 kanałach MIDI. Jeśli masz taki instrument, nie ma żadnych specjalnych ustawień 
do wykonania w instrumencie.

W przypadku innych instrumentów należy użyć elementów sterujących na panelu przednim, aby 
ustawić liczbę partii, barw itp., tak aby wszystkie były odbierane na jednym kanale MIDI.

Więcej informacji można znaleźć w instrukcji dołączonej do instrumentu.

Nazewnictwo portów MIDI
Wejścia i wyjścia MIDI są często wyświetlane z długimi i skomplikowanymi nazwami. W Cubase 
możesz zmienić nazwy portów MIDI na bardziej opisowe.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz MIDI Port Setup (Konfiguracja portu MIDI).
Wyświetlana jest lista dostępnych wejść i wyjść MIDI. W systemie Windows wybór urządzenia 
zależy od systemu.
3. Kliknij kolumnę Show As (Pokaż jako) i wpisz nową nazwę.
4. Kliknij OK.

WYNIK
Nowe nazwy portów pojawią się w menu podręcznych Input Routing i Output Routing.

Ustawianie wejścia MIDI
W Inspektorze ustawiasz wejście MIDI dla ścieżki.

PROCEDURA
1. Na liście ścieżek wybierz ścieżkę, do której chcesz przypisać wejście MIDI.
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2. W najwyższej sekcji Inspektora otwórz menu podręczne Input Routing i wybierz wejście.
Dostępne wejścia zależą od typu używanego interfejsu MIDI. Jeśli przytrzymasz Shift-Alt/Opt , 
wybrane wejście MIDI będzie używane dla wszystkich wybranych ścieżek MIDI.

UWAGA
Jeśli wybierzesz All MIDI Inputs (Wszystkie wejścia MIDI), ścieżka będzie odbierać dane MIDI 
ze wszystkich dostępnych wejść MIDI.

Ustawianie kanału i wyjścia MIDI
Ustawienia kanału i wyjścia MIDI określają, gdzie nagrany MIDI jest kierowany podczas 
odtwarzania. Są one również przydatne do monitorowania MIDI w Cubase. Możesz wybrać kanał i 
wyjście na liście ścieżek lub w Inspektorze.

PROCEDURA
1. Na liście ścieżek wybierz ścieżkę, do której chcesz przypisać kanał i wyjście MIDI.
2. W najwyższej sekcji Inspectora otwórz menu podręczne Output Routing i wybierz wyjście.
    Dostępne wyjścia zależą od typu używanego interfejsu MIDI. Jeśli przytrzymasz Shift-Alt/Opt , 
    wybrane wyjście MIDI będzie używane dla wszystkich wybranych ścieżek MIDI.
3. Otwórz wyskakujące menu Channel (Kanał) i wybierz kanał MIDI.

UWAGA
Jeśli wybierzesz Any (dowolny) kanał MIDI, materiał MIDI zostanie przekierowany do kanałów 
używanych przez instrument MIDI.

Wybór dźwięku
Możesz wybierać dźwięki z poziomu Cubase, instruując program, aby wysyłał komunikaty 
Program Change i Bank Select do urządzenia MIDI.

PROCEDURA
1. Na liście ścieżek wybierz ścieżkę, do której chcesz przypisać dźwięk.
2. Na liście utworów lub w Inspektorze otwórz menu podręczne Program Selector i wybierz 
    program.
    Komunikaty zmiany programu dają dostęp do 128 różnych lokalizacji programów.
3. Jeśli instrumenty MIDI mają więcej niż 128 programów, możesz otworzyć Bank Selector
wyskakujące menu i wybrać różne banki, z których każdy zawiera 128 programów.

UWAGA
Komunikaty Bank Select są różnie rozpoznawane przez różne instrumenty MIDI. Struktura i 
numeracja banków i programów również mogą się różnić. Szczegółowe informacje można znaleźć 
w dokumentacji instrumentów MIDI. 

POWIĄZANE LINKI
MIDI Track Inspector (Inspektor ścieżek MIDI) na stronie 134
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Nagrywanie w edytorach MIDI
Dane MIDI można zapisywać w partii MIDI otwieranej w edytorze MIDI.

WARUNEK WSTĘPNY
Wybrałeś Merge (Scal) lub Replace (Zastąp) jako MIDI Record Mode (tryb nagrywania MIDI).  

PROCEDURA
1. Kliknij w edytorze MIDI, aby uzyskać fokus.
2. Na pasku narzędzi edytora MIDI aktywuj opcję Record in Editor (Nagrywaj w edytorze).
3. Wykonaj jedną z poniższych czynności, aby aktywować nagrywanie:
        ● Kliknij opcję Record (Nagraj) w panelu Transport.
        ● Kliknij Record na pasku narzędzi

WYNIK
Dane MIDI są zapisywane w partii MIDI otwieranej w edytorze MIDI. Jeśli nagrywasz poza 
granicami części, część jest automatycznie powiększana.

POWIĄZANE LINKI
Pasek narzędzi Key Editor na stronie 839

Nagrywanie MIDI
MIDI można nagrywać przy użyciu dowolnej z podstawowych metod nagrywania.
Po zakończeniu nagrywania w oknie projektu tworzona jest partia zawierająca zdarzenia MIDI.

UWAGA
Jeśli wykonujesz nagranie na żywo na instrumencie VST, zazwyczaj kompensujesz opóźnienie 
karty dźwiękowej grając wcześniej. W rezultacie znaczniki czasu są rejestrowane zbyt wcześnie. 
Jeśli aktywujesz ASIO Latency Compensation na liście utworów, wszystkie nagrane zdarzenia 
zostaną przesunięte zgodnie z bieżącym ustawieniem latencji (czas oczekiwania).

Następujące preferencje mają wpływ na nagrywanie MIDI:
● Regulacja długości
● Przyciągaj partie MIDI do taktów
● Zakres przechwytywania rekordu MIDI w ms
● Domyślnie aktywna kompensacja opóźnień ASIO

Można je znaleźć w oknie dialogowym Preferences (Preferencje) na stronie MIDI i na stronie 
Record—MIDI.

POWIĄZANE LINKI
Podstawowe metody nagrywania na stronie 263
MIDI na stronie 1171
Record - MIDI na stronie 1176

Rodzaje komunikatów MIDI
Możesz nagrywać różne rodzaje komunikatów MIDI.

● Aby określić, jakie typy zdarzeń mają być nagrywane, wyłącz opcje typu komunikatu MIDI, 
który chcesz nagrać w oknie dialogowym Preferences (Preferencje) (strona MIDI—MIDI Filter).
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POWIĄZANE LINKI
MIDI — Filtr MIDI na stronie 1174

Note Messages (Wiadomości Nut)
Cubase rejestruje komunikaty włączania (note on) i wyłączania nut (note off) oraz kanałów MIDI 
(Channel).

Jeśli naciśniesz i zwolnisz klawisz na syntezatorze lub innej klawiaturze MIDI, zostaną nagrane 
następujące komunikaty:
● Note On (klawisz wciśnięty)
● Uwaga wyłączona (klawisz w górę)
● Kanał MIDI

UWAGA
Zwykle informacje o kanale MIDI są nadpisywane przez ustawienie kanału MIDI dla ścieżki. Jeśli 
jednak ustawisz ścieżkę na kanał Any MIDI, nuty będą odtwarzane na ich oryginalnych kanałach.

Continuous Messages (Wiadomości ciągłe)
Pitchbend, aftertouch i kontrolery, takie jak pokrętło modulacji, pedał sustain, głośność itp. są
uważane za ciągłe zdarzenia MIDI, w przeciwieństwie do chwilowych komunikatów (key down 
i key up) klawisz  w dół i w górę.

Możesz nagrywać ciągłe wiadomości razem lub niezależnie od nut, to znaczy przed lub po.

Możesz nagrywać ciągłe wiadomości na własnych ścieżkach, niezależnie od nut, do których należą.
Tak długo, jak ustawisz dwie ścieżki na to samo wyjście i kanał MIDI, instrument MIDI będzie 
wyglądał tak, jakbyś dokonał dwóch nagrań w tym samym czasie.

Program Change Messages (Komunikaty o zmianie programu)
Kiedy przełączasz się z jednego programu na inny na swoim syntezatorze lub na innej klawiaturze 
MIDI, numer odpowiadający temu programowi jest wysyłany przez MIDI jako komunikat zmiany 
programu.

Możesz nagrywać Komunikaty Zmiany Programu (Program Change) razem lub niezależnie od 
notatek, to znaczy przed lub po.

Komunikaty zmiany programu można nagrywać na ich własnych ścieżkach, niezależnie od nut, do 
których należą. Tak długo, jak ustawisz dwie ścieżki na to samo wyjście i kanał MIDI, instrument 
MIDI będzie wyglądał tak, jakbyś dokonał dwóch nagrań w tym samym czasie.

System Exclusive Messages  (Wyłączne wiadomości systemowe)
Komunikaty System Exclusive (SysEx) to specjalne typy komunikatów MIDI, które są używane do 
wysyłania danych, które mają sens tylko do jednostki określonej marki i typu.

SysEx może być użyty do przesłania listy numerów składających się na ustawienia jednego lub 
więcej dźwięków w syntezatorze.

Reset Function  (Funkcja resetowania)
Funkcja Reset wysyła komunikaty o braku nuty i resetuje kontrolery na wszystkich kanałach MIDI.
Jest to czasem konieczne, jeśli doświadczasz zawieszania się nut, stałego vibrato itp. podczas 
wchodzenia i wycofywania nagrań MIDI z danymi Pitchbend lub kontrolera.
● Aby ręcznie zresetować MIDI, wybierz MIDI > Reset (MIDI > Resetuj).
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● Jeśli chcesz, aby Cubase wykonywał reset MIDI przy zatrzymaniu, aktywuj Reset on Stop  
(Resetuj przy zatrzymaniu) w oknie dialogowym Preferences (Preferencje) (strona MIDI).
● Jeśli chcesz, aby Cubase wstawił zdarzenie resetowania na końcu nagranej partii, aktywuj opcję  
Insert Reset Events after Record (Wstaw zdarzenia resetowania po nagraniu) w oknie 
dialogowym Preferences (Preferencje) (strona MIDI).

Spowoduje to zresetowanie danych kontrolera, takich jak sustain, aftertouch, pitchbend, modulacja i
kontrola breath (oddechu). Jest to przydatne, jeśli nagrywana jest partia MIDI, a pedał przedłużania 
dźwięku jest nadal wciśnięty po zatrzymaniu nagrywania. Zwykle powodowało to, że wszystkie 
kolejne części były odtwarzane z przedłużeniem, ponieważ polecenie wyłączenia pedału nie zostało
nagrane.

POWIĄZANE LINKI
MIDI na stronie 1171

MIDI Record Modes (Tryby nagrywania MIDI)
Wybierając tryb nagrywania MIDI, decydujesz, co stanie się z istniejącymi partiami na ścieżce, na 
której nagrywasz. Ścieżki MIDI mogą odtwarzać wszystkie zdarzenia w nakładających się 
częściach. Jeśli nagrasz kilka partii w tych samych lokalizacjach lub przesuniesz partie tak, aby 
nachodziły na siebie, usłyszysz zdarzenia we wszystkich partiach.
UWAGA
Jeśli aktywujesz opcję Record in Editor, aby nagrywać dane MIDI w edytorze, wszystkie nowe 
nagrania zostaną scalone z partią aktywną, a tryby nagrywania MIDI nie będą miały zastosowania.
● Aby uzyskać dostęp do trybów nagrywania, wybierz Transport > MIDI Record Mode.
Dostęp do MIDI Record Modes (trybów nagrywania MIDI) można również uzyskać, klikając po 
prawej stronie symbolu MIDI w sekcji MIDI Record Modes (Tryby nagrywania MIDI) w panelu 
Transport.

MIDI Record Mode  (Tryb nagrywania MIDI)
New Parts (Nowe części)
Istniejące partie, na które nakłada się nowe nagranie, zostają zachowane. Nowe nagranie zostanie 
zapisane jako nowa część.
Merge (Połącz)
Istniejące zdarzenia w częściach, na które nakłada się nowe nagranie, są zachowywane. Nowo 
nagrane zdarzenia są dodawane do istniejącej części.
Replace (Zastąp)
Istniejące zdarzenia w częściach, na które nakłada się nowe nagranie, są zastępowane.

MIDI Cycle Record Mode (Tryb nagrywania cyklu MIDI)
Gdy nagrywasz MIDI w trybie cyklicznym, wynik zależy nie tylko od trybu nagrywania MIDI, ale 
także od trybu nagrywania cyklicznego wybranego w sekcji Cycled MIDI Recording Only (Tylko 
cykliczne nagrywanie MIDI).

Mix (Mieszaj)
Dla każdego ukończonego okrążenia wszystko, co zarejestrujesz, zostanie dodane do tego, co 
zostało zarejestrowane wcześniej. Jest to przydatne do tworzenia schematów rytmicznych. Nagraj 
partię hi-hatu na pierwszym okrążeniu, partię bębna basowego na drugim okrążeniu itd.
Overwrite (Nadpisz)
Gdy tylko zagrasz nutę MIDI lub wyślesz dowolny komunikat MIDI, cały MIDI nagrany podczas 
poprzednich okrążeń zostanie nadpisany od tego momentu. Pamiętaj, aby zakończyć grę przed 
rozpoczęciem następnego okrążenia. W przeciwnym razie nadpiszesz całe ujęcie.
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Keep Last (Zachowaj ostatni)
Każde ukończone okrążenie zastępuje poprzednie zarejestrowane okrążenie. Jeśli wyłączysz 
nagrywanie lub naciśniesz Stop, zanim kursor dotrze do prawego lokatora, poprzednie ujęcie 
zostanie zachowane. Jeśli nie zagrasz ani nie wprowadzisz żadnego MIDI podczas okrążenia, nic 
się nie stanie, a poprzedni dubel zostanie zachowany.
Stacked (Ułożone)
Każde nagrane okrążenie cyklu jest przekształcane w oddzielną część MIDI, a ścieżka jest 
podzielona na tory, po jednym na każde okrążenie cyklu. Części są ułożone jedna na drugiej, każda 
na innym torze. Wszystkie ujęcia oprócz ostatniego są wyciszone.
Mix-Stacked (No Mute) (bez wyciszenia)
To samo co Ułożone, ale partie nie są wyciszone.

POWIĄZANE LINKI
Specyfikacje nagrywania MIDI na stronie 275
Nagrywanie w edytorach MIDI na stronie 277
Menu Transport na stronie 233
Sekcje panelu Transport na stronie 228

Automatic MIDI Record Quantize  (Automatyczna kwantyzacja nagrań MIDI)
Cubase może automatycznie kwantyzować nuty MIDI podczas nagrywania.

● Automatic MIDI Record Quantize    (Automatyczna kwantyzacja nagrań MIDI) jest 
dostępna w sekcji MIDI Auto Quantize na pasku Transport Bar.

Jeśli włączysz automatyczną kwantyzację, nagrywane nuty są automatycznie kwantyzowane 
zgodnie z ustawieniami kwantyzacji.

POWIĄZANE LINKI
Kwantyzacja MIDI i audio na stronie 293
Panel kwantyzacji na stronie 298

Odzyskiwanie nagrań MIDI
Cubase umożliwia odzyskanie danych MIDI, w tym danych kontrolera, które zostały przechwycone
w trybie zatrzymania Stop lub podczas odtwarzania.

Dane MIDI są przechowywane w buforze nagrań retrospektywnych i można je wstawić jako partię 
MIDI na wybranej ścieżce MIDI

Bufor przechwytuje do 10 000 zdarzeń MIDI. Może to odpowiadać nagraniu MIDI trwającemu 
około 2 minut i 30 sekund. Jeśli jednak używasz klawiatury, która generuje dużą liczbę zdarzeń 
kontrolera MIDI, takiej jak ROLI Seaboard, odpowiada to tylko około 20-sekundowemu nagraniu.
UWAGA
W oknie dialogowym Preferences (Preferencje) (strona Record – MIDI (Nagrywanie — MIDI)) 
możesz określić rozmiar bufora nagrań retrospektywnych.

Jeśli bufor jest pełny, zdarzenia MIDI, które zostały przechwycone jako pierwsze, zostaną 
zastąpione nowymi zdarzeniami. Zdarzenia MIDI w buforze są również zastępowane w 
następujących sytuacjach:

● Po wstawieniu nagrania retrospektywnego na ścieżce i odtwarzaniu nowych zdarzeń w trybie 
zatrzymania Stop lub podczas odtwarzania.
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● Kiedy grasz nuty MIDI w trybie zatrzymania Stop i nie grasz dłużej niż 30 sekund, przed 
odtworzeniem kolejnych zdarzeń MIDI w trybie zatrzymania.
UWAGA
Bufor można również opróżnić ręcznie

POWIĄZANE LINKI
Record - MIDI na stronie 1176
Opróżnianie bufora nagrań retrospektywnych na stronie 283

Wstawianie nagrania retrospektywnego ze wszystkich wejść MIDI na 
wybranej ścieżce
Możesz wstawić nagranie retrospektywne, czyli dane MIDI, które zostały wysłane do wszystkich 
wejść MIDI (All MIDI Inputs) w trybie zatrzymania (Stop) lub podczas odtwarzania, na wybranej 
ścieżce.

WARUNEK WSTĘPNY
Zagrałeś kilka nut MIDI w trybie zatrzymania Stop lub podczas odtwarzania i chcesz je odzyskać.

PROCEDURA
1. Wybierz ścieżkę MIDI, na której chcesz umieścić przechwycone dane MIDI.
2. Wybierz Transport > Retrospective Recording MIDI > Insert from All MIDI Inputs.

WYNIK
Dane MIDI, które zostały przechwycone na wszystkich wejściach MIDI (All MIDI Inputs), są 
umieszczane na wybranej ścieżce jako jedna, liniowa część MIDI.

UWAGA
Jeśli wstawisz dane z bufora z wielu wybranych ścieżek, zachowane zostaną przesunięcia czasowe 
między danymi odtwarzanymi na różnych ścieżkach.

UWAGA
Jeśli ścieżka MIDI korzysta z wkładek MIDI, a w sekcji MIDI Inserts (Wstawki MIDI) włączono 
funkcję Record Output to Track, dane w buforze zawierają zdarzenia utworzone przez wstawki 
MIDI.

POWIĄZANE LINKI
Nagrywanie efektu insertowego MIDI na stronie 779
Wstawki MIDI na stronie 778

Wstawianie retrospektywnego nagrania ścieżki
Na wybranej ścieżce można wstawić retrospektywne nagranie ścieżki, czyli dane MIDI, które 
zostały wysłane na wejście ścieżki w trybie zatrzymania Stop lub podczas odtwarzania.

WARUNEK WSTĘPNY
Zagrałeś kilka nut MIDI w trybie zatrzymania Stop lub podczas odtwarzania i chcesz je odzyskać.

PROCEDURA
1. Wybierz ścieżkę MIDI, na której chcesz umieścić przechwycone dane MIDI.
2. W górnej części Inspektora ścieżek MIDI kliknij Retrospective Recording.
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3. Z wyskakującego menu wybierz jedną z następujących opcji:
         ● Aby wstawić dane MIDI jako jedną, ciągłą partię MIDI, wybierz opcję Insert as Linear 
             Recording (Wstaw jako nagranie liniowe).
         ● Aby wstawić dane MIDI jako partie MIDI, wybierz Insert as Cycle Recording (Wstaw 
             jako nagranie w cyklu).

UWAGA
Jest to dostępne tylko wtedy, gdy dane MIDI zostały przechwycone podczas odtwarzania i aktywny
był tryb cyklu.

WYNIK
Dane MIDI przechwycone na wejściu ścieżki są umieszczane na ścieżce.

UWAGA
Jeśli dane zostały przechwycone podczas odtwarzania, zostaną wstawione w miejscu, w którym 
zostały odtworzone. Jeśli dane zostały przechwycone w trybie zatrzymania, są wstawiane w miejscu
kursora projektu.

Wstawianie retrospektywnego nagrania ścieżki do edytora
Do partii MIDI otwartej w edytorze MIDI można wstawić retrospektywne nagranie ścieżki, czyli 
dane MIDI, które zostały wysłane na wejście ścieżki w trybie zatrzymania Stop lub podczas 
odtwarzania.

WARUNEK WSTĘPNY
Zagrałeś kilka nut MIDI w trybie zatrzymania Stop lub podczas odtwarzania i chcesz je odzyskać.

PROCEDURA
1. Kliknij dwukrotnie partię MIDI, do której chcesz wstawić przechwycone dane MIDI, aby 
otworzyć ją w edytorze MIDI.
2. Na pasku narzędzi edytora MIDI kliknij opcję Insert MIDI Retrospective Recording in Editor 
(Wstaw retrospektywne nagranie MIDI w edytorze).

WYNIK
Dane MIDI przechwycone na wejściu ścieżki są wstawiane do partii MIDI.
● Jeśli dane zostały przechwycone podczas odtwarzania, są wstawiane do partii MIDI wzdłuż osi 
czasu.
● Jeśli dane zostały przechwycone w trybie zatrzymania Stop, są wstawiane w miejscu kursora 
projektu.
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Opróżnianie bufora nagrań retrospektywnych
Bufor zapisów retrospektywnych można opróżnić ręcznie.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● W górnej części Inspektora ścieżek MIDI otwórz menu podręczne Retrospective Recording 
          (Retrospektywne nagrywanie) i wybierz Empty Retrospective Record Buffer (Opróżnij 
           Bufor Retrospektywnego nagrania).
       ● Wybierz ścieżkę i wybierz opcję Transport > MIDI Retrospective Recording > Empty All
           Buffers (Transport > Retrospektywne Nagrywanie MIDI > Opróżnij wszystkie bufory).

Pozostały czas nagrywania
Wyświetlacz  Max. Record Time (maksymalnego czasu nagrywania) pozwala zobaczyć, ile czasu 
pozostało do nagrywania.

               

Dostępny czas zależy od bieżącej konfiguracji, na przykład od liczby ścieżek z możliwością 
nagrywania, częstotliwości próbkowania projektu i dostępnego miejsca na dysku twardym.

● Aby otworzyć wyświetlacz, wybierz Studio > More Options > Max. Record Time (Studio > 
Więcej opcji > Maksymalny czas do nagrywania).

UWAGA
Pozostały czas nagrywania jest również pokazany w wierszu stanu nad listą ścieżek.

Jeśli używasz poszczególnych folderów z nagraniami do przechowywania utworów na różnych 
dyskach, wyświetlanie czasu odnosi się do nośnika z najmniejszą dostępną przestrzenią.

Lock Record (Zablokuj nagrywanie)
Funkcja Lock Record zapobiega przypadkowemu wyłączeniu trybu nagrywania.

● Wybierz polecenie Edit > Key Commands (Edycja > Komendy klawiszowe) i w kategorii 
Transport przypisz komendy klawiszowe do poleceń Lock Record (Zablokuj nagrywanie) 
i Unlock Record (Odblokuj nagrywanie).

Jeśli opcja Lock Record (Zablokuj nagrywanie) jest włączona i chcesz przejść do trybu 
zatrzymania, otworzy się okno dialogowe, w którym musisz potwierdzić, że chcesz zatrzymać 
nagrywanie. Możesz także najpierw użyć polecenia Unlock Record (Odblokuj nagrywanie), a 
następnie jak zwykle wejść w tryb zatrzymania.

UWAGA
Automatyczne wyjście z nagrania (Punch out) w prawym położeniu lokalizatora zostanie 
zignorowane w trybie Lock Record.
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Importowanie plików audio i MIDI
Możesz dodać pliki audio i MIDI do swojego projektu, importując je.

Import plików audio
Możesz importować skompresowane i nieskompresowane pliki audio w różnych formatach. 
Możesz także importować audio z płyt audio CD lub wyodrębniać audio z plików wideo.

POWIĄZANE LINKI
Importowanie plików audio na stronie 286
Importowanie ścieżek Audio CD na stronie 287
Importowanie audio z plików wideo na stronie 290
Importowanie plików ReCycle na stronie 290
Importowanie multimediów na stronie 622

Konfigurowanie opcji importu plików audio
Możesz określić sposób obsługi plików audio podczas importu.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz Editing > Audio (Edycja > Audio).
2. Wybierz opcję z wyskakującego menu Import Audio Files (Importuj pliki audio).

         

3. Kliknij OK.

WYNIK
Ustawienia importu zostaną zapisane i zaczną obowiązywać po zaimportowaniu dźwięku. Jeśli 
wybrano opcję Open Options Dialog (Otwórz okno dialogowe opcji), przy każdym imporcie 
otwierane jest okno dialogowe e Import Options (Opcje importu), w którym można wprowadzić 
zmiany. Jeśli wybierzesz opcję d Use Settings (Użyj ustawień), zostaną użyte ustawienia określone 
w sekcji On Import Audio Files (Przy imporcie plików audio) w oknie dialogowym Preferences 
(Preferencje).

POWIĄZANE LINKI
Okno dialogowe opcji importu dla plików audio na stronie 284
O importowaniu ustawień plików audio na stronie 286

Okno dialogowe Import Options (Opcje importu) dla plików audio
Okno dialogowe Import Options umożliwia wprowadzenie określonych ustawień dla importu 
audio.

● Kiedy importujesz pliki audio i opcja Open Options Dialog (Otwórz okno dialogowe opcji) jest 
aktywna w sekcji On Import Audio Files (Podczas importowania plików audio) okna dialogowego
Preferences (Preferencje) (strona Editing—Audio (Edycja audio)), otwiera się okno dialogowe 
Import Options (Opcje importu).
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Okno dialogowe Import Options (Opcje importu) dla importu pojedynczego pliku

Okno dialogowe Import Options (Opcje importu) dla importu wielu plików.

Copy File to Project Folder/Copy All Files to Project Folder (Skopiuj plik do folderu 
projektu/Kopiuj wszystkie pliki do folderu projektu)
Kopiuje plik audio do folderu Audio projektu, a klip odnosi się do kopii.
Wyłącz tę opcję, aby klip odnosił się do oryginalnego pliku w oryginalnej lokalizacji. W takim 
przypadku jest on oznaczony w puli jako “external” (zewnętrzny).

Convert to Project Settings/Convert to Project Settings and Copy to Project Folder If Needed
(Konwertuj na ustawienia projektu/Konwertuj na ustawienia projektu i w razie potrzeby skopiuj do 
folderu projektu).
Konwertuje importowany plik, jeśli częstotliwość próbkowania lub głębia bitowa różnią się od 
ustawień w oknie dialogowym Project Setup (Ustawienia projektu). W przypadku importu 
pojedynczego pliku można wybrać, które właściwości mają zostać przekonwertowane.

Split Channels (Rozdzielone kanały)
Dzieli stereofoniczne lub wielokanałowe pliki audio na odpowiednią liczbę plików mono,
jeden dla każdego kanału i kopiuje zaimportowane pliki do folderu Audio projektu.
Podzielone pliki są wstawiane do projektu i do Pool (puli) jako osobne ścieżki mono.
Wyskakujące menu Name Format (Format nazwy) umożliwia określenie sposobu nazywania 
podzielonych plików.
Pozwala to na kompatybilność z innymi produktami podczas wymiany plików audio.

Do not ask again (Nie pytaj ponownie)
Zawsze importuje pliki zgodnie z ustawieniami bez ponownego otwierania okna dialogowego. 
Możesz zresetować tę opcję w oknie dialogowym Preferences (Preferencje) (Editing—Audio  
(Edycja — strona Audio)).
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POWIĄZANE LINKI
Konfigurowanie opcji importu plików audio na stronie 284

On Import Audio Files Settings (Ustawienia przy imporcie plików 
audio
Możesz skonfigurować standardowe ustawienia, które są wykonywane automatycznie za każdym 
razem, gdy importujesz pliki audio.
● Gdy importujesz pliki audio i opcja Use Settings (Użyj ustawień) jest aktywna w sekcji On 
Import Audio Files (Przy imporcie plików audio) okna dialogowego Preferences (Preferencje) 
(strona Editing—Audio (Edycja — Audio)), ustawienia są używane do importowania Audio.

                  

Copy File to Project Folder/Copy All Files to Project Folder (Skopiuj plik do folderu 
projektu/Kopiuj wszystkie pliki do folderu projektu)
       Kopiuje plik audio do folderu Audio projektu, a klip odnosi się do kopii. Wyłącz tę opcję, aby 
       klip odnosił się do oryginalnego pliku w oryginalnej lokalizacji. W takim przypadku jest on 
       oznaczony w Pool (puli) jako „external” (zewnętrzny).
Convert to Project Settings/Convert to Project Settings and Copy to Project Folder If Needed
(Konwertuj na ustawienia projektu/Konwertuj na ustawienia projektu i w razie potrzeby skopiuj do 
folderu Project).
       Konwertuje importowany plik, jeśli częstotliwość próbkowania lub głębia bitowa różnią się od 
       ustawień w oknie dialogowym Project Setup (Ustawienia projektu). W przypadku importu 
       pojedynczego pliku można wybrać, które właściwości mają zostać przekonwertowane.
Split Channels (Rozdzielone kanały)
       Dzieli stereofoniczne lub wielokanałowe pliki audio na odpowiednią liczbę plików mono, po 
       jednym dla każdego kanału, i kopiuje zaimportowane pliki do folderu Audio projektu.  
       Podzielone pliki są wstawiane do projektu i do Pool (pula) jako osobne ścieżki mono.  
       Wyskakujące menu Name Format (Format nazwy) umożliwia określenie sposobu nazywania 
       podzielonych plików. Pozwala to na kompatybilność z innymi produktami podczas wymiany 
       plików audio.

Importowanie plików audio
Możesz importować nieskompresowane audio i skompresowane audio w kilku formatach.
PROCEDURA
1. Wybierz File > Import > Audio File (Plik > Importuj > Plik audio).
2. W otwartym oknie dialogowym pliku znajdź i wybierz plik audio, a następnie kliknij Open.
3. Wprowadź zmiany w oknie dialogowym Import Options (Opcje importu)
UWAGA
Jeśli opcja Use Settings (Użyj ustawień) jest aktywna w oknie dialogowym Preferences 
(Preferencje) (Editing (Edycja) — strona Audio), zamiast tego używane są odpowiednie ustawienia
importu.

WYNIK
W oknie Projekt zdarzenie odnoszące się do pliku audio jest wstawiane na wybranej ścieżce w 
miejscu położenia kursora projektu. Jeśli nie wybrano żadnej ścieżki, zostanie utworzona nowa 
ścieżka. Tworzony jest nowy klip audio i dodawany do puli.
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Jeśli wybierzesz skompresowany plik audio inny niż FLAC, Cubase skopiuje oryginalny 
skompresowany plik i przekonwertuje go do formatu wave (Windows) lub AIFF (macOS).
UWAGA
Wynikowy plik Wave/AIFF jest znacznie większy niż oryginalny skompresowany plik.

Zaimportowany plik jest umieszczany w folderze Audio projektu.

POWIĄZANE LINKI
Konfigurowanie opcji importu plików audio na stronie 284

Obsługiwane skompresowane formaty plików audio
W Cubase możesz importować skompresowane pliki audio.

Obsługiwane są następujące formaty skompresowanych plików audio:
plik FLAC
       Jest to format typu open source, który zmniejsza rozmiar plików audio o 50 % do 60 % w 
       porównaniu ze zwykłymi plikami Wave. Pliki mają rozszerzenie .flac.
Plik MPEG 1 Layer 3
       Jest to rodzina standardów używanych do kodowania informacji audiowizualnych, takich jak 
       filmy, wideo i muzyka, w skompresowanym formacie cyfrowym. Cubase może odczytywać 
       MPEG Layer 2 i MPEG Layer 3. Pliki MP3 to wysoce skompresowane pliki, które nadal 
       zapewniają dobrą jakość dźwięku. Pliki mają rozszerzenie .mp3.
Plik Ogg Vorbis
       Jest to otwarta, wolna od patentów technologia kodowania i przesyłania strumieniowego 
       dźwięku. Koder Ogg Vorbis wykorzystuje kodowanie ze zmienną szybkością transmisji bitów. 
       Oferuje skompresowane pliki audio o niewielkich rozmiarach, ale o stosunkowo wysokiej 
       jakości dźwięku. Pliki mają rozszerzenie .ogg
Plik Windows Media Audio (tylko Windows)
       Jest to format plików audio zdefiniowany przez firmę Microsoft Inc. Pliki WMA można 
       zmniejszać bez utraty jakości dźwięku. WMA Pro oferuje możliwość miksowania dźwięku 
       przestrzennego do 5.1. Pliki mają rozszerzenie .wma.

Importowanie ścieżek Audio CD
Możesz importować audio z płyt audio CD do projektów Cubase.

PROCEDURA
1. Wybierz File > Import > Audio CD (Plik > Importuj > Audio CD), aby zaimportować ścieżki 
    CD do okna Project.
2. W kolumnie Copy (Kopiuj) aktywuj każdy plik audio, który chcesz zaimportować.
3. Opcjonalnie: Ustaw Default Name (domyślną nazwę) i Destination Folder (folder docelowy) 
    dla importowanych plików audio.
4. Kliknij przycisk Copy (Kopiuj), aby utworzyć lokalną kopię plików audio lub sekcji.
5. Kliknij OK.

WYNIK
Skopiowane pliki audio są importowane do okna projektu i wstawiane na nowe ścieżki w miejscu 
kursora projektu. Domyślnie zaimportowane ścieżki audio CD są zapisywane jako pliki wave 
(Windows) lub AIFF (macOS) w folderze Audio bieżącego projektu. Nowe klipy audio są 
tworzone i dodawane do puli (Pool).
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UWAGA
Możesz także importować pliki audio tylko do puli (Pool) bez importowania ich do okna Project.

POWIĄZANE LINKI
Importowanie multimediów na stronie 622

Okno dialogowe Import From Audio CD (Importuj z płyty audio CD)
Okno dialogowe Import From audio CD umożliwia określenie sposobu importowania ścieżek z 
płyty CD.

● Aby otworzyć okno dialogowe Import From Audio CD, wybierz File > Import > Audio CD 
(Plik > Importuj > Audio CD).

Drive (Prowadzić)
        Otwiera wyskakujące menu, które pozwala wybrać właściwy napęd CD.
Speed (Szybkość (tylko Windows))
        Umożliwia wybór szybkości przesyłania danych.

UWAGA
Chociaż zwykle chcesz użyć największej możliwej prędkości, być może będziesz musiał wybrać 
niższą prędkość, aby uzyskać bezbłędną ekstrakcję dźwięku.

Eject CD (Wysuń płytę CD)
        Otwiera napęd CD.
Secure Mode (Tryb bezpieczny (tylko Windows))
        Aktywuje sprawdzanie i poprawianie błędów podczas odczytu płyty CD.

Columns (Kolumny)
       Kolumny w oknie dialogowym mają następujące funkcje:

Copy (Kopiuj)
       Włącz tę opcję dla ścieżek, które chcesz skopiować/zaimportować.
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#
       Pokazuje numer ścieżki.
CD Track (Ścieżka CD)
       Nazwa ścieżki CD. Podczas importu jest to używane jako nazwa pliku. Jest dostarczany 
       automatycznie z CDDB, jeśli jest dostępny. Aby zmienić nazwę ścieżki, kliknij nazwę ścieżki i 
       wprowadź nową nazwę.
Length (Długość)
       Długość ścieżki audio CD w minutach i sekundach.
Size (Rozmiar)
       Rozmiar pliku ścieżki audio CD w MB.
Copy Start (Początek kopiowania)
       Początek importowanej sekcji. Na linijce przeciągnij lewy znacznik w prawo, aby go 
       dostosować.
Copy End (Koniec kopiowania)
       Koniec importowanej sekcji. Na linijce przeciągnij prawy znacznik w lewo aby go dostosować

Linijka
Linijka ma następujące funkcje:

       

1 Play Tracks (Odtwórz utwory)
        Odtwarza wybrany utwór od początku do końca lub od lewego znacznika do prawego 
        znacznika.
2 Stop Playback (Zatrzymaj odtwarzanie)
       Zatrzymuje odtwarzanie.
3 Play from Left Marker (Zagraj od lewego znacznika)
       Rozpoczyna odtwarzanie od lewego znacznika.
4 Play to Right Marker (Zagraj do prawego znacznika)
       Rozpoczyna odtwarzanie kilka chwil przed prawym znacznikiem i zatrzymuje się przy prawym
       znaczniku.
5 Left Marker (lewy znacznik)
       Umożliwia ręczne ustawienie początku kopiowania.
6 Right Marker (Prawy znacznik)
       Umożliwia ręczne ustawienie końca kopiowania.

Destination Folder (Folder docelowy)
      Umożliwia wybranie folderu dla importowanych plików.
Copy (Kopiuj)
      Kopiuje pliki.
Copied Files (Skopiowane pliki)
      Wyświetla listę plików skopiowanych do zaimportowania.

292



Importowanie dźwięku z plików wideo
Możesz zaimportować dźwięk z pliku wideo bez importowania samego wideo.

PROCEDURA
1. Wybierz File > Import > Audio from Video File (Plik > Importuj > Audio z pliku wideo).
2. W otwartym oknie dialogowym pliku zlokalizuj i wybierz plik wideo, a następnie kliknij Open   
    (Otwórz)

WYNIK
Dźwięk wybranego pliku wideo zostanie wyodrębniony i przekonwertowany na plik wave, który 
zostanie zapisany w folderze Audio.
Tworzony jest nowy klip audio i dodawany do puli (Pool). W oknie Project zdarzenie odnoszące 
się do pliku audio jest wstawiane na wybranej ścieżce w pozycji kursora projektu. Jeśli nie wybrano
żadnej ścieżki, zostanie utworzona nowa ścieżka.

POWIĄZANE LINKI
Wyodrębnianie Audio z wideo na stronie 1108
Importowanie plików wideo na stronie 1099

Importowanie plików ReCycle
Możesz importować pliki audio REX i REX2 utworzone przez ReCycle z Propellerhead Software. 
ReCycle dzieli pętlę na plasterki i tworzy osobne próbki każdego beatu, dzięki czemu można 
dopasować tempo i edytować pętlę tak, jakby była zbudowana z pojedynczych dźwięków.

WARUNEK WSTĘPNY
Biblioteka współdzielona REX jest zainstalowana w twoim systemie.

PROCEDURA
1. Wybierz ścieżkę audio i przesuń kursor projektu w miejsce, w którym chcesz rozpocząć 
importowany plik.
Jeśli ustawisz ścieżkę dźwiękową na muzyczną podstawę czasu, możesz później zmienić tempo, a 
zaimportowany plik REX dostosuje się automatycznie.
2. Wybierz File > Import > Audio File (Plik > Importuj > Plik audio).
3. W oknie dialogowym pliku otwórz wyskakujące menu typu pliku i wybierz Plik REX lub Plik 
REX 2.
4. Wybierz plik, który chcesz zaimportować, i kliknij Open (Otwórz).

WYNIK
Plik zostanie zaimportowany i automatycznie dostosowany do aktualnego tempa Cubase. 
Zaimportowany plik REX składa się z kilku zdarzeń, po jednym dla każdego wycinka w pętli. 
Zdarzenia są automatycznie umieszczane w części audio na wybranej ścieżce i umieszczane w taki 
sposób, aby zachowane zostało oryginalne wewnętrzne taktowanie pętli.

PO WYKONANIU TEGO ZADANIA
Otwórz partię w Audio Part Editor (Edytorze części audio), aby edytować każdy wycinek osobno, 
na przykład wyciszając, przesuwając i zmieniając rozmiar zdarzeń, dodając efekty i przetwarzając.
Możesz także dostosować tempo i automatycznie śledzić plik REX, pod warunkiem, że jego ścieżka
jest ustawiona na muzyczną podstawę czasu.

UWAGA
Możesz osiągnąć podobne wyniki, korzystając z własnych funkcji cięcia pętli Cubase.
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POWIĄZANE LINKI
Plasterki (Slices) na stronie 534

Import plików MIDI
Cubase może importować standardowe pliki MIDI. Pozwala to na przesyłanie materiału MIDI do 
i z praktycznie dowolnej aplikacji MIDI na dowolnej platformie.

Opcje importu plików MIDI
Import Options (Opcje importu) plików MIDI pozwalają określić, jakie dane mają być zawarte w 
importowanych plikach MIDI.

        

Extract First Patch (Wyodrębnij pierwszą poprawkę)
       Konwertuje pierwsze zdarzenia Program Change i Bank Select dla każdej ścieżki na 
       ustawienia Inspektora dla ścieżki.
Extract First Volume/Pan (Wyodrębnij pierwszą głośność/panoramę)
       Konwertuje pierwsze zdarzenia MIDI Volume i Pan dla każdej ścieżki na ustawienia 
       Inspektora dla ścieżki.
Import Controller as Automation Tracks (Importuj kontroler jako ścieżki automatyzacji)
       Konwertuje zdarzenia kontrolera MIDI (MIDI Controller) w pliku MIDI na dane 
       automatyzacji dla ścieżek MIDI.
Import to Left Locator (Importuj do lewego lokalizatora)
       Wyrównuje zaimportowany plik MIDI do pozycji lewego lokalizatora.
Import Markers (Importuj znaczniki)
       Importuje standardowe znaczniki plików MIDI do pliku i konwertuje je na znaczniki Cubase.
Import Dropped File as Single Part (Importuj usunięty plik jako pojedynczą część)
       Umieszcza plik na jednej ścieżce, jeśli przeciągniesz plik MIDI do projektu.
Ignore Master Track Events on Merge (Ignoruj zdarzenia ścieżki głównej przy scalaniu)
       Ignoruje dane ścieżki tempa, jeśli importujesz plik MIDI do bieżącego projektu.   
       Zaimportowany plik MIDI będzie odtwarzany zgodnie z bieżącym tempem ścieżki w projekcie.
Auto Dissolve Format 0 (Format automatycznego rozpuszczania 0)
       Automatycznie rozkłada importowane pliki MIDI typu 0. Każdy osadzony kanał MIDI w pliku 
       jest umieszczany na osobnej ścieżce w oknie Project.

Destination (Miejsce docelowe)
Umożliwia określenie, co się stanie, gdy przeciągniesz plik MIDI do projektu.
       ● MIDI Tracks (Ścieżki MIDI) tworzy ścieżki MIDI dla importowanego pliku.
       ● Instrument Tracks (Ścieżki instrumentów) tworzy ścieżki instrumentów dla każdego kanału
           MIDI w pliku MIDI i pozwala programowi automatycznie załadować odpowiednie  
           ustawienia wstępne.
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       ● HALion Sonic SE multi-timbral tworzy kilka ścieżek MIDI, z których każda jest kierowana
           do oddzielnej instancji HALion Sonic SE w oknie VST Instruments i ładuje odpowiednie 
           ustawienia wstępne.
Import Karaoke Lyrics as Text (Importuj teksty karaoke jako tekst)
        Konwertuje teksty karaoke w pliku MIDI na tekst, który można wyświetlić w Score Editor 
        (Edytor Partytur). Jeśli ta opcja jest wyłączona, teksty piosenek są wyświetlane tylko w List 
        Editor (Edytor list).

Importowanie plików MIDI
W Cubase możesz importować pliki MIDI.

PROCEDURA
1. Wybierz File > Import > MIDI File (Plik > Importuj > Plik MIDI).
2. Opcjonalne: Jeśli projekt jest otwarty, wybierz, czy chcesz utworzyć nowy projekt.
     Jeśli wybierzesz No (Nie), plik MIDI zostanie zaimportowany do bieżącego projektu.
3. W otwartym oknie dialogowym pliku zlokalizuj i wybierz plik MIDI, a następnie kliknij Open  
     (Otwórz).

WYNIK
Plik MIDI zostanie zaimportowany. Wynik zależy od zawartości pliku MIDI i ustawień 
dokonanych w sekcji Import Options (Opcje importu) w oknie dialogowym Preferences 
(Preferencje) (strona MIDI File — Plik MIDI). Możliwe jest również zaimportowanie pliku MIDI 
z dysku poprzez przeciągnięcie go z Eksploratora plików/wyszukiwarki macOS do okna Project. 
Obowiązują również Import Options (Opcje importu).

POWIĄZANE LINKI
Opcje importu plików MIDI na stronie 291
Znaczniki na stronie 336

Format Yamaha XF
Cubase obsługuje format Yamaha XF. XF jest rozszerzeniem standardowego formatu plików MIDI
umożliwia zapisywanie danych specyficznych dla utworu w pliku MIDI typu 0.

Podczas importowania pliku MIDI zawierającego dane XF dane te są umieszczane w częściach na 
osobnych ścieżkach o nazwie XF Data, Chord Data lub SysEx Data. Możesz edytować taką partię
w List Editor (Edytorze list), aby na przykład dodać lub zmienić tekst.

WAŻNE
Nie zmieniaj kolejności zdarzeń w danych XF ani samych danych zdarzeń, chyba że masz duże 
doświadczenie z danymi XF.

Cubase może również eksportować dane XF jako część pliku MIDI typu 0. Jeśli nie chcesz 
eksportować danych XF razem z danymi MIDI, wycisz lub usuń ścieżki zawierające dane XF.

Pętle MIDI
W Cubase możesz importować pętle MIDI

Aby zaimportować pętle MIDI, użyj MediaBay. Pętle MIDI mają rozszerzenie pliku .midiloop.

POWIĄZANE LINKI
Importowanie pętli MIDI na stronie 738
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Kwantyzacja MIDI i audio

Kwantyzacja oznacza przeniesienie nagranego audio lub MIDI i umieszczenie go na najbliższej 
pozycji siatki, która jest muzycznie istotna. Kwantyzacja służy do korygowania błędów, ale można 
jej również używać w kreatywny sposób.

Możesz kwantyzować audio i MIDI do siatki lub rytmu. Możesz także kwantyzować wiele ścieżek 
audio jednocześnie.

Audio i MIDI można kwantyzować w tym samym czasie. Jednak to, co dokładnie dzieje się 
podczas kwantyzacji, różni się w przypadku audio i MIDI:
        ● Kwantyzacja audio wpływa na rozpoczęcie zdarzenia dźwiękowego lub zawartość audio.
        ● Kwantyzacja MIDI może wpływać na początek zdarzeń MIDI w partii, długość zdarzenia 
            MIDI lub zakończenie zdarzenia MIDI.

UWAGA
Kwantyzacja opiera się na pierwotnym położeniu zdarzeń. Dlatego możesz swobodnie 
wypróbowywać różne ustawienia kwantyzacji bez ryzyka zniszczenia czegokolwiek.

POWIĄZANE LINKI
Kwantyzacja rozpoczęcia zdarzenia audio na stronie 295
Kwantyzacja długości zdarzeń audio (kwantyzacja AudioWarp) na stronie 296
Kwantyzacji rozpoczęcia zdarzenia MIDI na stronie 294
Kwantyzacja długości zdarzeń MIDI na stronie 295
Kwantyzacja zdarzeń zakończenia MIDI. na stronie 295

Funkcje kwantyzacji
Funkcje kwantyzacji są dostępne w menu Edit (Edycja) oraz w sekcjach Snap (Przyciąganie) 
i Quantize (Kwantyzacja) paska narzędzi okna Project.

Funkcje kwantyzacji w menu Edit (Edycja)
Quantize (Kwantyzuj)
       Kwantyzuje rozpoczęcie zdarzenia audio lub MIDI.
Reset Quantize (Zresetuj kwantyzację)
       Przywraca dźwięk lub MIDI do pierwotnego, niekwantyzowanego stanu i resetuje wszelkie  
       zmiany długości wprowadzone w panelu kwantyzacji (Quantize Panel).
Quantize Panel (Panel kwantyzacji)
       Otwiera panel kwantyzacji.
Advanced Quantize (Zaawansowana kwantyzacja)
       Z tego podmenu można wybrać następujące funkcje:
       ● Quantize MIDI Event Lengths (Kwantyzacja długości zdarzeń MIDI)
                Odcina końce wybranych zdarzeń MIDI, tak aby zdarzenia odpowiadały wartości   
                kwantyzacji długości. Pozycje startowe są zachowane.
       ● Quantize MIDI Event Ends (Kwantyzacja zakończeń zdarzeń MIDI)
               Przesuwa końce zdarzeń MIDI do najbliższej pozycji siatki.
       ● Freeze MIDI Quantize (Zatrzymaj kwantyzację MIDI)
              Utrwala pozycję początkową i końcową zdarzeń MIDI. Ta funkcja jest przydatna w  
              sytuacjach, gdy chcesz przeprowadzić kwantyzację po raz drugi, w oparciu o bieżące 
              skwantyzowane pozycje, a nie pozycje oryginalne.
       ● Create Groove Quantize Preset (Utwórz wstępne ustawienie kwantyzacji Groove)
              Tworzy mapę kwantyzacji groove na podstawie punktów hitowych, które utworzyłeś w  
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              edytorze sampli (Sample Editor).

Funkcje kwantyzacji na pasku narzędzi okna Project

Apply Quantize (Zastosuj kwantyzację)

        
        Stosuje ustawienia kwantyzacji.
Quantize Presets (Ustawienia kwantyzacji)

        
        Umożliwia wybranie ustawienia wstępnego kwantyzacji.
Soft Quantize On/Off (Włączanie/wyłączanie miękkiej kwantyzacji)

        
        Włącza/wyłącza miękką kwantyzację.
AudioWarp Quantize On/Off (Włącz/wyłącz kwantyzację AudioWarp)

        
       Włącza/wyłącza kwantyzację AudioWarp.
Open Quantize Panel (Otwórz panel kwantyzacji)

        
       Otwiera panel kwantyzacji.

Kwantyzacja rozpoczęcia zdarzenia MIDI
Pozycje początkowe zdarzeń MIDI można kwantyzować.

WARUNEK WSTĘPNY
Skonfigurowałeś siatkę kwantyzacji w wyskakującym menu Quantize Presets (Ustawienia 
wstępne kwantyzacji) na pasku narzędzi okna Project.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
        ● W Key Editor wybierz zdarzenia MIDI, które chcesz poddać kwantyzacji.
        ● W oknie Project wybierz partię MIDI.
2. Wybierz kolejno Edit > Quantize (Edycja > Kwantyzacja).

WYNIK
Początki wybranych zdarzeń MIDI lub wszystkie zdarzenia wybranej partii MIDI są 
kwantyzowane. Zdarzenia, które nie odpowiadają dokładnym pozycjom nut, są przenoszone do 
najbliższej pozycji siatki. Długości nut są zachowane.
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Kwantyzacja długości zdarzeń MIDI
Długość zdarzeń MIDI można kwantyzować.

WARUNEK WSTĘPNY
Ustawiłeś wartość kwantyzacji długości w wyskakującym menu Length Quantize (Kwantyzacja 
długości) na pasku narzędzi Key Editor.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
        ● W Key Editor wybierz zdarzenia MIDI, które chcesz poddać kwantyzacji.
        ● W oknie Project wybierz partię MIDI.
2. Wybierz polecenie Edit > Advanced Quantize > Quantize MIDI Event Lengths (Edycja > 
Zaawansowana kwantyzacja > Kwantyzacja długości zdarzeń MIDI).

WYNIK
Końce wybranych zdarzeń MIDI są obcinane, tak aby zdarzenia odpowiadały wartości kwantyzacji 
długości. Pozycje startowe są zachowane.
UWAGA
Jeśli wybrałeś Quantize Link (Łącze kwantyzacji) w wyskakującym menu Length Quantize 
(Kwantyzacja długości) na pasku narzędzi Key Editor, wielkość zdarzeń jest zmieniana zgodnie z 
siatką ustawioną w wyskakującym menu Quantize Presets (Wstępne ustawienia kwantyzacji). 
Uwzględniane są ustawienia Swing (huśtawka), Tuplet i Catch Range (Zasięg połowu) na panelu 
Quantize (Quantize Panel).

Kwantyzacja zakończeń zdarzeń MIDI
Pozycje końcowe zdarzeń MIDI można kwantyzować.

WARUNEK WSTĘPNY
Skonfigurowałeś siatkę kwantyzacji w wyskakującym menu Quantize Presets (Ustawienia 
wstępne kwantyzacji) na pasku narzędzi okna Project.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
       ● W Key Editor wybierz zdarzenia MIDI, które chcesz poddać kwantyzacji.
       ● W oknie Project wybierz partię MIDI.
2. Wybierz polecenie Edit > Advanced Quantize > Quantize MIDI Event Ends (Edycja > 
Zaawansowana kwantyzacja > Kwantyzacja zakończeń zdarzeń MIDI)

WYNIK
Końce zdarzeń MIDI są przesuwane do najbliższych pozycji siatki.

Kwantyzacja początków zdarzeń audio
Pozycje początkowe zdarzeń audio można kwantyzować.

WARUNEK WSTĘPNY
Skonfigurowałeś siatkę kwantyzacji w wyskakującym menu Quantize Prests (Ustawienia wstępne 
kwantyzacji) na pasku narzędzi okna Project.
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PROCEDURA
1. W oknie Project wybierz zdarzenie audio, wyciętą pętlę lub część audio.
2. Wybierz kolejno Edit > Quantize (Edycja > Kwantyzacja).

WYNIK
Punkt przyciągania zdarzenia lub, jeśli nie jest dostępny, początek zdarzenia audio jest 
kwantyzowany. Rozpoczęcia zdarzeń, które nie odpowiadają dokładnym pozycjom nut, są 
przenoszone do najbliższych pozycji siatki.

UWAGA
Jeśli używasz funkcji kwantyzacji w partii audio, kwantyzowane są początki zdarzeń w partii.

Kwantyzacja długości zdarzeń audio (kwantyzacja AudioWarp)
Możesz kwantyzować zdarzenie audio lub zakres wyboru audio, stosując rozciągnięcie czasowe do 
treści zdarzenia audio.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
       ● Wybierz zdarzenie audio, które chcesz poddać kwantyzacji.
       ● Wybierz zakres zdarzenia, które chcesz skwantyzować.
2. Na pasku narzędzi AudioWarp Quantize On/Off (włącz/wyłącz kwantyzację AudioWarp).
3. Wykonaj jedną z następujących czynności:
       ● Kliknij Quantize Presets (Ustawienia wstępne kwantyzacji) i wybierz ustawienie wstępne   
           siatki kwantyzacji z wyskakującego menu.
       ● Kliknij Open Quantize Panel (Otwórz panel kwantyzacji) i zdefiniuj siatkę kwantyzacji 
           z dostępnymi parametrami.
4. Wybierz kolejno Edit > Quantize (Edycja > Kwantyzacja).

WYNIK
Zdarzenie audio jest kwantyzowane, to znaczy jego znaczniki osnowy są wyrównywane z siatką 
kwantyzacji poprzez zastosowanie rozciągnięcia czasu, a sekcje audio między znacznikami osnowy 
są rozciągane lub kompresowane w celu dopasowania do przedziału czasu, który konfigurujesz w 
wyskakującym menu Quantize Presets (Zadane ustawienia kwantyzacji).

UWAGA
Jeśli użyjesz wartości kwantyzacji 1/4 dla dźwięku opartego na szesnastkach, znaczniki osnowy w 
pozycjach 1/4 nuty zostaną skwantyzowane do siatki, a pozostałe znaczniki osnowy zostaną 
przesunięte, zachowując względne odległości między znacznikami osnowy.

POWIĄZANE LINKI
Panel kwantyzacji na stronie 298
Plasterki na stronie 534

Kwantyzacja wielu ścieżek audio
Możesz kwantyzować wiele ścieżek audio jednocześnie.

PROCEDURA

1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij  Add Track (Dodaj 
ścieżkę).
2. Kliknij Folder.
3. Kliknij Add Track (Dodaj ślad).
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4. Przenieś wszystkie ścieżki audio, które chcesz poddać kwantyzacji, do ścieżki folderu.

UWAGA
Audio na wszystkich ścieżkach musi mieć tę samą pozycję początkową i końcową.

5. Wybierz ścieżkę folderu i aktywuj Group Editing (Edycję grupową) na liście ścieżek.
6. Na ekranie zdarzeń wybierz jedno ze zdarzeń. Zaznaczone zostaną wszystkie zdarzenia audio 
    zawarte w ścieżce folderu.
7. Na pasku narzędzi okna Project kliknij Open Quantize Panel (Otwórz panel kwantyzacji), aby 
    otworzyć Quantize Panel (panel kwantyzacji).
8. Wprowadź zmiany w sekcji Slice Rules panelu Quantize Panel i kliknij Slice (Rozdziel). 
    Zdarzenia audio w grupie edycji są podzielone.
9. Wprowadź zmiany w sekcji kwantyzacji Quantize Panel i kliknij przycisk Quantize 
    (Kwantyzacja). Pocięte zdarzenia są kwantyzowane.
10. Opcjonalnie: Aby skorygować nakładanie się lub przerwy w skwantyzowanym audio, 
    wprowadź zmiany w sekcji Crossfades (Przenikania) panelu Quantize Panel i kliknij Crossfade
    (Przenikanie).

WYNIK
Zdarzenia audio są kwantyzowane.

POWIĄZANE LINKI
Panel kwantyzacji na stronie 298
Tryb edycji grupy na stronie 220

AudioWarp Kwantyzacja wielu ścieżek audio
Możesz użyć znaczników osnowy do kwantyzacji wielu ścieżek audio. Jednak kwantyzacja 
AudioWarp nie zachowuje spójności fazowej.

PROCEDURA

1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij  Add Track (Dodaj 
ścieżkę).
2. Kliknij Folder.
3. Kliknij Add Track (Dodaj ścieżkę).
4. Przenieś wszystkie ścieżki audio, które chcesz poddać kwantyzacji, do ścieżki folderu.

UWAGA
Audio na wszystkich ścieżkach musi mieć tę samą pozycję początkową i końcową.

5. Wybierz ścieżkę folderu i aktywuj Group Editing (Edycję grupowa) na liście ścieżek.
6. Na ekranie zdarzeń wybierz jedno ze zdarzeń. Zaznaczone zostaną wszystkie zdarzenia audio  
    zawarte w ścieżce folderu.
7. Na pasku narzędzi okna Project aktywuj AudioWarp Quantize On/Off (włącz/wyłącz 
    AudioWarp kwantyzacja).
8. Kliknij Open Quantize Panel (Otwórz panel kwantyzacji), aby otworzyć Quantize Panel (Panel
    kwantyzacji).
9. Wprowadź zmiany w sekcji Warp Marker Creation Rules (Reguły tworzenia znaczników warp) 
    w Quantize Panel i kliknij Create (Utwórz).
10. Wprowadź zmiany w sekcji Quantize Settings (Ustawienia kwantyzacji) panelu kwantyzacji i 
      kliknij przycisk Quantize (Kwantyzacja).
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WYNIK
Kwantyzacja AudioWarp jest stosowana do wszystkich ścieżek w grupie edycyjnej.

POWIĄZANE LINKI
Panel kwantyzacji na stronie 298
Tryb edycji grupy na stronie 220

Quantize Panel (Panel kwantyzacji)
Panel kwantyzacji umożliwia zdefiniowanie sposobu kwantyzacji audio lub MIDI do siatki lub 
rytmu. W zależności od wybranej metody wyświetlane są różne parametry.

Aby otworzyć panel kwantyzacji, wykonaj jedną z następujących czynności:
       ● Kliknij Open Quantize Panel (Otwórz panel kwantyzacji) na pasku narzędzi.
       ● Wybierz polecenie Edit > Quantize Panel (Edycja > Panel kwantyzacji).
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Quantize Presets (Wstępne ustawienia kwantyzacji)
U góry panelu kwantyzacji (Quantize Panel) wyświetlane są wstępne ustawienia kwantyzacji. 
Tutaj możesz załadować i zapisać ustawienia wstępne, które zawierają wszystkie ustawienia 
kwantyzacji.

        

Select Preset (Wybierz ustawienie wstępne)
       Umożliwia wybranie ustawienia wstępnego.
Save Preset (Zapisz ustawienie wstępne)
       Umożliwia zapisanie bieżących ustawień jako ustawienia wstępnego, dzięki czemu staną się  
       one dostępne dla wszystkich wyskakujących menu ustawień wstępnych kwantyzacji (Quantize
       Presets).
Remove Preset (Usuń ustawienie wstępne)
       Umożliwia usunięcie wybranego ustawienia wstępnego.
Rename Preset (Zmień nazwę ustawienia wstępnego)
       Otwiera okno dialogowe, w którym można zmienić nazwę wybranego ustawienia wstępnego.
Restore Factory Presets (Przywróć ustawienia fabryczne)
       Umożliwia przywrócenie ustawień fabrycznych.

Tworzenie presetów kwantyzacji Groove (rytmicznej)
Możesz utworzyć mapę kwantyzacji groove (rytmicznej) na podstawie punktów hitowych 
utworzonych w edytorze sampli (Sample Editor).

PROCEDURA
1. W oknie Project kliknij dwukrotnie zdarzenie audio, z którego chcesz wyodrębnić taktowanie.
Otworzy się Sample Editor (Edytor próbek).
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2. Otwórz sekcję Hitpoints (Punkty hitowe).
       Punkty hitowe zdarzenia audio są wykrywane i wyświetlane automatycznie.
3. Kliknij opcję Create Groove (Utwórz rytmikę).
       Rytmika jest wydobywana

WYNIK
Rytmika jest wyodrębniana ze zdarzenia audio i udostępniana w wyskakującym menu Quantize 
Presets (Ustawienia wstępne kwantyzacji) na pasku narzędzi okna projektu

PO WYKONANIU TEGO ZADANIA
Otwórz Quantize Panel (panel kwantyzacji) i zapisz rytmikę jako ustawienie wstępne.

POWIĄZANE LINKI
Tworzenie mapy kwantyzacji Groove na stronie 537
Ustawienia wstępne kwantyzacji na stronie 299

Opcje kwantyzacji do siatki muzycznej
Możesz użyć siatki muzycznej do kwantyzacji nagranej muzyki.

● Aby uzyskać dostęp do opcji kwantyzacji siatki muzycznej, wybierz format czasu muzycznego z 
wyskakującego menu Select Preset (Wybierz ustawienie wstępne) w Quantize Panel (panelu 
kwantyzacji).

          

Dostępne są następujące opcje:
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Grid (Siatka)
        Umożliwia wybranie podstawowej wartości siatki kwantyzacji.
Swing (Huśtać się)
        Kompensuje co drugą pozycję w siatce, tworząc efekt swingu lub shuffle.

UWAGA
Swing jest dostępny tylko wtedy, gdy Grid jest ustawiony na wartość prostą, a Tuplet jest 
wyłączony.

Catch Range (Złapany zasięg)
       Umożliwia ustawienie wartości, która określa, że kwantyzacja ma wpływ tylko na audio lub 
       MIDI w określonej odległości od linii siatki. Znajduje to odzwierciedlenie w wyświetlaniu 
       siatki.
Safe Range (Bezpieczny zasięg)
       Tworzy bezpieczną strefę przed i po pozycjach kwantyzacji. Jeśli określisz odległość w 
       tyknięciach (120 tyknięć = jedna szesnastka), zdarzenia znajdujące się w tej strefie nie będą 
       kwantyzowane. W ten sposób zachowane są niewielkie różnice.
Grid Display (Wyświetlacz siatki)
       Wyświetla siatkę kwantyzacji. Kwantyzowany dźwięk lub MIDI jest przenoszony do pozycji 
       wskazanych przez pionowe linie siatki.
Tuplet (Krotka)
       Tworzy rytmicznie bardziej złożone siatki, dzieląc siatkę na mniejsze etapy, tworząc w ten 
       sposób n-tupletów.
Rough (Surowy)
       Umożliwia ustawienie odległości w taktach, dzięki czemu dźwięk lub MIDI są kwantyzowane 
       do losowych pozycji w określonej odległości od siatki kwantyzacji. Pozwala to na niewielkie 
       różnice, a jednocześnie zapobiega przedostawaniu się dźwięku lub MIDI zbyt daleko od siatki.
Soft Quantize Mode (Miękki tryb kwantyzacji)
       Stosuje luźną kwantyzację, dzięki czemu dźwięk lub MIDI przesuwa się tylko o część drogi do 
       najbliższej pozycji siatki kwantyzacji. Wartość Quantize Strength (siły kwantyzacji) po   
       prawej stronie określa, jak blisko przesuwa się audio lub MIDI w kierunku siatki.

UWAGA
Kwantyzacja miękka jest oparta na bieżących, skwantyzowanych pozycjach, a nie na oryginalnych 
pozycjach zdarzeń. Możesz wielokrotnie używać trybu miękkiej kwantyzacji, aby stopniowo 
przesuwać audio lub MIDI bliżej siatki kwantyzacji, aż znajdziesz właściwy czas.

 AudioWarp
        Kwantyzuje zawartość zdarzenia audio, stosując rozciągnięcie czasu. Znaczniki osnowy są 
        wyrównywane ze zdefiniowaną siatką kwantyzacji.
MIDI CC
        Automatycznie przesuwa kontrolery związane z nutami MIDI (wyginanie tonu itp.) wraz z 
        nutami, gdy są one kwantyzowane.
Reset Quantize (Zresetuj kwantyzację)
        Resetuje audio lub MIDI do pierwotnego, niekwantyzowanego stanu.

WAŻNE
Ta funkcja nie ma wpływu na zdarzenie, które zostało przeniesione ręcznie.
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Auto (Automatycznie)
Natychmiast stosuje wszelkie zmiany do wybranych części lub zdarzeń. Sposobem na skorzystanie 
z tej funkcji jest ustawienie pętli odtwarzania i dostosowywanie ustawień do uzyskania 
zadowalającego efektu.
Quantize (Kwantyzuj)
Stosuje twoje ustawienia.

Opcje kwantyzacji do Groove (do rytmiki)
Możesz wygenerować siatkę taktowania z partii MIDI lub pętli audio i użyć tej rytmiki (groove) do 
kwantyzacji nagranej muzyki. W ten sposób możesz odtworzyć rytmiczny charakter tego 
konkretnego zdarzenia lub części.

Aby uzyskać dostęp do opcji kwantyzacji rytmu, wybierz partię MIDI z pętli audio, zdarzenia audio
z punktami hitowymi lub pociętego audio i wykonaj jedną z następujących czynności:
       ● Przeciągnij część lub zdarzenie do siatki wyświetlanej na środku Quantize Panel (Panelu 
          kwantyzacji).
       ● Wybierz polecenie Edit > Advanced Quantize > Create Groove Quantize Preset (Edycja  
           > Zaawansowana kwantyzacja > Utwórz wstępne ustawienie kwantyzacji Groove).

                     

Dostępne stają się następujące opcje:

Position (Pozycja)
       Określa, w jakim stopniu taktowanie rytmu wpływa na muzykę.
Velocity (Szybkość (tylko MIDI))
       Określa, w jakim stopniu wartości dynamiki w rytmie wpływają na muzykę.

UWAGA
Nie wszystkie groove (rytmiki) zawierają informacje o velocity (prędkości).

Length (Długość (tylko MIDI))
        Pozwala określić, w jakim stopniu rytm ma wpływ na długość nut

UWAGA
W przypadku perkusji ustawienie Length jest ignorowane.
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Safe Range (Bezpieczny zasięg)
        Umożliwia utworzenie bezpiecznej strefy przed i po pozycjach kwantyzacji. Jeśli określisz 
        odległość w tyknięciach (120 tyknięć = jedna szesnastka), zdarzenia znajdujące się w tej 
        strefie nie będą kwantyzowane. W ten sposób zachowane są niewielkie różnice.
Grid Display (Wyświetlacz siatki)
        Wyświetla siatkę kwantyzacji. Kwantyzowane audio lub MIDI jest przenoszone do pozycji 
        wskazanych przez pionowe linie siatki.
Pre-Q
        Pozwala wybrać siatkę muzyczną, do której można najpierw kwantyzować audio lub MIDI. 
        To przybliża nuty do ich miejsca docelowego.

UWAGA
Jeśli na przykład zastosujesz sekwencję szesnastkową z rytmem losowym, ustaw wartość wstępnej 
kwantyzacji na 16, aby wyprostować taktowanie przed zastosowaniem kwantyzacji rytmicznej 
(groove).

Max. Move (Maks. Przemieszczenie)
        Umożliwia wybranie wartości nuty w celu określenia maksymalnej odległości, na jaką można 
        przenieść audio lub MIDI.
Orig. Position (oryg. Pozycja)
       Ustawia pierwotną pozycję początkową kwantyzowanego materiału jako punkt początkowy 
       kwantyzacji. Pozwala to zsynchronizować materiał, który nie zaczyna się od taktu 1 projektu.
Rough Quantize (Zgrubna kwantyzacja)
       Umożliwia ustawienie odległości w taktach, aby audio lub MIDI były kwantyzowane do 
       losowych pozycji w określonej odległości od siatki kwantyzacji. Pozwala to na niewielkie 
       różnice, a jednocześnie zapobiega przedostawaniu się audio lub MIDI zbyt daleko od siatki.
Soft Quantize Mode (Miękki tryb kwantyzacji)
       Stosuje luźną kwantyzację, dzięki czemu audio lub MIDI przesuwa się tylko o część drogi do 
       najbliższej pozycji siatki kwantyzacji. Wartość siły kwantyzacji po prawej stronie określa, jak 
       blisko przesuwa się dźwięk lub MIDI w kierunku siatki.

UWAGA
Kwantyzacja miękka jest oparta na bieżących, skwantyzowanych pozycjach, a nie na oryginalnych 
pozycjach zdarzeń. Możesz wielokrotnie używać trybu miękkiej kwantyzacji, aby stopniowo 
przesuwać audio lub MIDI bliżej siatki kwantyzacji, aż znajdziesz właściwy czas.

AudioWarp
Kwantyzuje zawartość zdarzenia audio, stosując rozciągnięcie czasu. Znaczniki osnowy „warp” są 
wyrównywane ze zdefiniowaną siatką kwantyzacji.
MIDI CC
Automatycznie przesuwa kontrolery związane z nutami MIDI (wyginanie tonu itp.) wraz z nutami, 
gdy są one kwantyzowane.
Reset Quantize (Zresetuj kwantyzację)
Resetuje audio lub MIDI do pierwotnego, niekwantyzowanego stanu.

WAŻNE
Ta funkcja nie ma wpływu na zdarzenie, które zostało przeniesione ręcznie.
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Auto (Automatyczny)
        Natychmiast stosuje wszelkie zmiany do wybranych części lub zdarzeń. Sposobem na 
        skorzystanie z tej funkcji jest ustawienie pętli odtwarzania i dostosowywanie ustawień do 
        uzyskania zadowalającego efektu.
Quantize (Kwantyzuj)
       Stosuje twoje ustawienia.

POWIĄZANE LINKI
Tworzenie ustawień wstępnych kwantyzacji Groove na stronie 299

Opcje kwantyzacji wielu ścieżek audio
W przypadku kwantyzacji wielu ścieżek audio sekcja Slice Rules (Reguły plasterków) staje się 
dostępna w Quantize Panel (panelu kwantyzacji). Tutaj określasz, w jaki sposób zdarzenia audio 
są dzielone w punktach hitowych.

          

● Aby uzyskać dostęp do sekcji Slice Rules (reguł plasterków), przenieś ścieżki audio do ścieżki 
folderu, aktywuj Group Editing (edycję grupową) i otwórz Quantize Panel (panel kwantyzacji).

Hitpoint Tracks (Ścieżki punktów hitowych)
         Wyświetla listę wszystkich ścieżek audio z twojej grupy edycyjnej, które mają punkty hitowe.
Priority (Priorytet)
        Kliknij i przeciągnij w prawo lub w lewo, aby określić priorytet. Punkty życia ścieżki o 
        najwyższym priorytecie określają pozycje fragmentów audio na wszystkich ścieżkach. Jeśli 
        współczynnik powiększenia jest wystarczająco wysoki, pozycje cięcia są zaznaczone w oknie 
        Project za pomocą pionowych linii.
Range (Zakres)
        Pozwala określić odległość, w której dwa punkty hitowe na różnych ścieżkach są uważane za 
        oznaczające ten sam rytm.
Offset (Przesunięcie)
        Umożliwia ustawienie przesunięcia, które określa, jak daleko przed rzeczywistą pozycją 
        punktu hitowego zdarzenie audio jest wycinane. Pozwala to na niewielkie zmiany pozycji 
        cięcia i jest przydatne, jeśli chcesz utworzyć przejścia w pozycjach plasterków. Co więcej, 
        pomaga to uniknąć odcinania sygnałów na ścieżkach, które nie zawierają żadnych punktów 
        hitowych.
AudioWarp Quantize On/Off (Włącz/wyłącz kwantyzację AudioWarp)
        Aktywuj ten przycisk, aby kwantyzować zawartość zdarzenia audio, stosując rozciągnięcie 
        czasu. Włącza to sekcję Reguły tworzenia znaczników osnowy (warp), która pozwala określić 
        priorytet. Punkty hitowe ścieżki o najwyższym priorytecie określają pozycje znaczników warp 
        dla audio na wszystkich ścieżkach.
Slice (Plasterek)
        Dzieli na plasterki wszystkie zdarzenia audio w grupie edycji i ustawia punkty przyciągania 
        zdarzenia na pozycji punktu hitowego o najwyższym priorytecie.
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Reset (Resetowanie)
         Cofa cięcie i przywraca pierwotny stan zdarzeń audio.

POWIĄZANE LINKI
Opcje kwantyzacji wielu ścieżek audio AudioWarp na stronie 305
Sekcja Crossfades (przenikania) na stronie 305
AudioWarp Kwantyzacja wielu ścieżek audio na stronie 297
Tryb edycji grupy na stronie 220

Sekcja Crossfades (przenikania)
Sekcja przenikania staje się dostępna po pocięciu zdarzeń audio. Funkcje w tej sekcji umożliwiają 
korygowanie nakładek lub przerw, które mogą pojawić się w wyniku zmiany położenia dźwięku.

           
Kliknięcie Crossfade (Przenikanie) powoduje obcięcie końca pierwszego zdarzenia w pozycji 
początkowej następnego zdarzenia (w przypadku nakładania się) i rozciągnięcie drugiego 
zdarzenia, aż rozpocznie się ono na końcu poprzedniego zdarzenia (w przypadku przerw).

W niektórych przypadkach możesz chcieć uzyskać płynne przejścia, stosując przenikanie po 
zamknięciu luk. W tym celu użyj następujących parametrów:

Open Crossfade Editor (Otwórz edytor przenikania)
        Otwiera edytor przenikania, w którym można określić typ krzywej, długość i inne parametry 
        przenikania.
Nudge Crossfade Left/Right (Przesuń przejście w lewo/w prawo)
        Przesuwa obszar zanikania w zdarzeniu audio w lewo lub w prawo w odstępach jednej 
        milisekundy. Jest to przydatne, jeśli wartość Offset w sekcji Slice Rules nie była wystarczająco
        wysoka, a chcesz uniknąć sytuacji, w której przenikanie przerywa atak.
Length (Długość)
       Określa długość obszaru przenikania.

POWIĄZANE LINKI
Edytor Crossfade (przenikania) na stronie 313

Opcje kwantyzacji wielu ścieżek audio AudioWarp
Sekcja Warp Marker Creation Rules (Reguły tworzenia znaczników osnowy warp) jest dostępna 
po włączeniu kwantyzacji AudioWarp dla wielu ścieżek audio.
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Priority (Priorytet)
         W tej kolumnie możesz zdefiniować priorytet dla każdej ścieżki. Ścieżka o najwyższym 
         priorytecie określa miejsce tworzenia znaczników osnowy (warp). Jeśli ustawisz ten sam 
         priorytet dla kilku ścieżek, pozycja znacznika osnowy jest określona przez ścieżkę, która 
         zawiera pierwszy punkt hitowy w określonym zakresie. Jest to ustalane na nowo dla każdej 
        pozycji znacznika osnowy.
        ● Aby określić priorytet, kliknij i przeciągnij w prawo lub w lewo.
           Jeśli nie jest wyświetlana żadna gwiazdka, punkty hitowe na odpowiedniej ścieżce nie są 
           brane pod uwagę.
Range (Zakres)
        Uznaje się, że dwa punkty hitowe na różnych ścieżkach wyznaczają ten sam rytm, jeśli 
        znajdują się w pewnej odległości od siebie. Parametr Range określa tę odległość. Obowiązują 
        następujące zasady:
       ● Jeśli jedna ze ścieżek ma wyższy priorytet, jej punkt hitowy jest używany do utworzenia 
          znacznika osnowy (warp).
       ● Jeśli ścieżki mają ten sam priorytet, używany jest pierwszy punkt hitowy w zakresie.
Reset (Resetowanie)
       Cofa tworzenie znaczników osnowy warp.
AudioWarp Quantize On/Off (Włącz/wyłącz kwantyzację AudioWarp)
       Włącza/wyłącza kwantyzację AudioWarp. Spowoduje to włączenie sekcji Slice Rules.
Create (Twórz)
       Tworzy znaczniki oasnowy (warp) dla wszystkich ścieżek.

POWIĄZANE LINKI
Opcje kwantyzacji wielu ścieżek audio na stronie 304
AudioWarp Kwantyzacja wielu ścieżek audio na stronie 297
Tryb edycji grupy na stronie 220
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Fades, Crossfades, and Envelopes (Zanikanie, przenikanie i 
obwiednie)

Zanikanie (Fades) umożliwia stopniowe zwiększanie lub zmniejszanie głośności na początku lub 
końcu zdarzeń audio lub klipów audio oraz tworzenie płynnych przejść.

Możesz utworzyć następujące przejścia:

● Fade ins/fade outs (Zanikanie/zanikanie)
Zwiększanie i zmniejszanie głośności umożliwia stopniowe zwiększanie lub zmniejszanie głośności
zdarzeń audio lub klipów audio. Wejścia i zanikania mogą być oparte na zdarzeniach lub klipach. 
Zanikanie oparte na zdarzeniach jest obliczane w czasie rzeczywistym podczas odtwarzania zdarzeń
audio. Możesz utworzyć różne krzywe zanikania dla kilku zdarzeń, nawet jeśli odnoszą się one do 
tego samego klipu audio.
UWAGA
Im więcej zastosujesz przejść opartych na zdarzeniach, tym więcej mocy obliczeniowej zostanie 
wykorzystane.
Zanikanie oparte na klipie jest stosowane do klipu audio. Zdarzenia odnoszące się do tego samego 
klipu będą miały takie same przejścia.

● Crossfades (Przejścia)
Przenikanie umożliwia tworzenie płynnych przejść dla kolejnych zdarzeń audio na tej samej 
ścieżce. Przejścia są zawsze oparte na zdarzeniach.
● Auto fades (Automatyczne zanikanie)
Automatyczne przejścia pozwalają na automatyczne stosowanie krótkich wejść i wyciszeń do 
wydarzeń na określonych ścieżkach audio. Możesz także zastosować je globalnie na wszystkich 
ścieżkach audio. Tworzy to płynne przejścia między zdarzeniami.
● Event envelopes (Obwiednia zdarzeń)
Obwiednie zdarzeń to krzywe głośności dla zdarzeń audio lub klipów audio. Pozwalają na zmianę 
głośności nie tylko na początku lub końcu, ale także w obrębie ścieżki dźwiękowej lub klipu. Mogą 
być oparte na zdarzeniach lub klipach.

POWIĄZANE LINKI
Zanikanie na podstawie zdarzeń na stronie 307
Tworzenie przejść opartych na klipach na stronie 311
Przenikanie na stronie 312
Automatyczne zanikanie i przenikanie na stronie 315
Obwiednia zdarzenia na stronie 317

Zanikanie oparte na zdarzeniach
Możesz tworzyć wejścia i wyjścia oparte na zdarzeniach. Są one obliczane w czasie rzeczywistym 
podczas odtwarzania zdarzeń audio. Możesz utworzyć różne krzywe zanikania dla kilku zdarzeń, 
nawet jeśli odnoszą się one do tego samego klipu audio.

Istnieje kilka sposobów tworzenia przejść opartych na zdarzeniach:

● Za pomocą uchwytów zdarzeń
● Za pomocą wyboru zakresu
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Zanikanie oparte na zdarzeniach można edytować w oknach dialogowych Fade (Zanikanie).

POWIĄZANE LINKI
Tworzenie i edycja przejść za pomocą uchwytów na stronie 308
Tworzenie i edycja przejść za pomocą narzędzia wyboru zakresu na stronie 309
Okno dialogowe Fade (zanikania) dla zanikania opartego na zdarzeniach na stronie 310

Tworzenie i edycja przejść za pomocą uchwytów
Za pomocą uchwytów zdarzeń można tworzyć i edytować wejścia i zanikania oparte na 
zdarzeniach. Daje to wizualną informację zwrotną i umożliwia zastosowanie tego samego typu 
zanikania do kilku wybranych zdarzeń.

PROCEDURA
1. Wybierz zdarzenia dźwiękowe, dla których chcesz utworzyć wyciszenia i wskaż jedno z nich 
     myszą. Trójkątne uchwyty zanikania staną się widoczne w lewym i prawym górnym rogu.

             
2. Wykonaj jedną z następujących czynności:
        ● Przeciągnij lewy uchwyt zanikania w prawo, aby utworzyć efekt zanikania.

             
       ● Przeciągnij prawy uchwyt zanikania w lewo, aby utworzyć efekt zanikania.

WYNIK
Zanikanie zostanie zastosowane i pokazane na przebiegu. Jeśli wybierzesz wiele zdarzeń, to samo 
zanikanie zostanie zastosowane do wszystkich wybranych zdarzeń.
UWAGA
W dowolnym momencie możesz zmienić długość przejść, przeciągając uchwyty.

Uchwyty zdarzeń
Zdarzenia audio mają uchwyt narastania (fade in) i zanikania (fade out), a także uchwyt głośności. 
Te uchwyty umożliwiają szybką zmianę długości zanikania lub głośności zdarzeń w oknie Project.

Uchwyty zdarzeń stają się widoczne, jeśli wskażesz je myszką lub wybierzesz zdarzenia.

UWAGA
Aby zawsze pokazywać uchwyty zdarzeń i krzywe zanikania, a nie tylko po wskazaniu zdarzeń, 
włącz opcję Show Event Volume Curves Always (Zawsze pokazuj krzywe głośności zdarzeń) w 
oknie dialogowym Preferences (Preferencje) (Event Display (Wyświetlanie zdarzeń) — strona 
Audio).

              

W lewym i prawym górnym rogu znajdują się trójkątne uchwyty zanikania, które umożliwiają 
zmianę długości narastania lub zanikania. W górnej środkowej części znajduje się kwadratowy 
uchwyt, który umożliwia zmianę głośności (volume).
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● Aby zmienić długość narastania, przeciągnij uchwyt w lewym górnym rogu w prawo lub w lewo.
● Aby zmienić długość zanikania, przeciągnij uchwyt zanikania w prawym górnym rogu w lewo 
lub w prawo.
● Aby zmienić głośność, przeciągnij w górę lub w dół uchwyt głośności w górnej środkowej części.

Zmiany zanikania i głośności są odzwierciedlane na przebiegu zdarzenia i na linii informacyjnej.

UWAGA
Aby zmienić głośność zdarzenia i zanikanie za pomocą kółka myszy, aktywuj opcję Use Mouse 
Wheel for Event Volume and Fades (Użyj kółka myszy do regulacji głośności i zanikania 
zdarzenia) w oknie dialogowym Preferences (Preferencje) (Editing (Edycja) — strona Audio). 
Kiedy naciśniesz Shift podczas poruszania kółkiem myszy i umieścisz wskaźnik myszy gdzieś w 
lewej połowie zdarzenia, punkt końcowy zanikania zostanie przesunięty. Kiedy wskaźnik myszy 
znajduje się w prawej połowie zdarzenia, punkt początkowy zanikania jest przesuwany.

                

Tworzenie i edycja przejść za pomocą narzędzia wyboru zakresu 
(Range Selection)
Możesz tworzyć i edytować przejścia oparte na zdarzeniach za pomocą narzędzia Range Selection 
(Zaznaczanie zakresu). Pozwala to na zastosowanie efektu narastania i zanikania w tym samym 
czasie. Korzystanie z narzędzia Range Selection (Zaznaczanie zakresu) jest również przydatne, 
jeśli chcesz utworzyć wyciszenia dla wielu zdarzeń audio na osobnych ścieżkach.

PROCEDURA
1. Na pasku narzędzi okna Project wybierz narzędzie Range Selection (Zaznaczanie zakresu).
2. Wykonaj jedną z następujących czynności:
● Aby utworzyć efekt narastania rozpoczynający się na początku zdarzenia, wybierz zakres 
rozpoczynający się na początku zdarzenia.
● Aby utworzyć zanikanie, które kończy się na końcu zdarzenia, wybierz zakres, który kończy się 
na końcu zdarzenia.
● Aby utworzyć efekt narastania i zanikania, wybierz zakres w środku zdarzenia.
● Aby utworzyć zanikanie na wielu ścieżkach, wybierz zakres obejmujący wiele zdarzeń audio na 
wielu ścieżkach audio.
3. Wybierz Audio > Adjust Fades to Range (Audio > Dostosuj zanikanie do zakresu).

Usuwanie zaników opartych na zdarzeniach
Zanikania oparte na zdarzeniach można usuwać dla całego zdarzenia lub dla zakresu.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
● Aby usunąć zanikanie dla zdarzenia, wybierz zdarzenie za pomocą narzędzia Object Selection 
(Zaznaczanie obiektów).
● Aby usunąć zanikanie dla zakresu, zaznacz obszar zanikania za pomocą narzędzia Range 
Selection (Zaznaczanie zakresu).
2. Wybierz Audio > Remove Fades (Audio > Usuń przenikanie).
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Okno dialogowe Fade (zanikanie) dla zanikania opartego na 
zdarzeniach
Okno dialogowe zanikania dla zanikania opartego na zdarzeniu umożliwia skonfigurowanie 
wybranych zanikań opartych na zdarzeniu.

● Aby otworzyć okno dialogowe zanikania opartego na zdarzeniach, utwórz zanik dla jednego lub 
więcej zdarzeń dźwiękowych, wybierz zdarzenia i wybierz Audio > Open Fade Editor(s) (Audio 
> Otwórz edytor(y) zanikania).
UWAGA
W przypadku wybrania kilku zdarzeń można jednocześnie dostosować krzywe zanikania dla 
wszystkich wybranych zdarzeń. Jest to przydatne, jeśli na przykład chcesz zastosować ten sam 
rodzaj przenikania do więcej niż jednego zdarzenia.

                                       
Dostępne są następujące opcje:

1  Presets pop-up menu (Menu podręczne ustawień wstępnych)
        Umożliwia skonfigurowanie ustawień wstępnych dla krzywych pojawiania się lub zanikania.
        ● Aby zastosować zapisane ustawienie wstępne, wybierz je z wyskakującego menu.
        ● Aby usunąć zapisane ustawienie wstępne, wybierz je z wyskakującego menu i kliknij  
           Remove (Usuń).
2  Curve Type buttons (przyciski typu krzywa)
        Zastosuj interpolację splajnu, interpolację splajnu tłumionego lub interpolację liniową do 
        krzywej.
3  Restore (Przywróć)
        Kliknij ten przycisk, aby anulować wszelkie zmiany wprowadzone od czasu otwarcia okna 
        dialogowego.
4  Fade Display (wyświetlacz zanikania)
        Pokazuje kształt krzywej zanikania. Otrzymany kształt fali jest ciemniejszy, a bieżący kształt 
        fali jest jaśniejszy.
        ● Aby dodać punkty, kliknij krzywą.
        ● Aby zmienić kształt krzywej, kliknij i przeciągnij istniejące punkty.
        ● Aby usunąć punkt z krzywej, przeciągnij go poza obszar wyświetlania.
5  Curve Shape buttons (Przyciski kształtu krzywej)
        Zapewniają szybki dostęp do niektórych typowych kształtów krzywych.

6  Length field (Pole długości)  
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        Umożliwia numeryczne wprowadzanie długości zanikania. Format wyświetlanych tutaj 
        wartości zależy od czasu wyświetlanego na panelu Transport.
        ● Jeśli aktywujesz Apply Length (Zastosuj długość), wartość wprowadzona w polu wartości 
           Fade Length (Długość zanikania) jest używana po kliknięciu Apply (Zastosuj) lub OK.
        ● Jeśli ustawisz bieżące zanikanie jako domyślne, wartość długości zostanie uwzględniona 
           jako część ustawień domyślnych.
7  As Default (Jako domyślne)
        Zapisuje bieżące ustawienia jako domyślne zanikanie.
8  Apply (Zastosuj)
        Stosuje bieżące ustawienia zanikania do wybranych zdarzeń.

Tworzenie przejść opartych na klipach
Możesz tworzyć i edytować narastania i zanikania oparte na klipach, korzystając z bezpośredniego 
przetwarzania offline. Te zanikania są stosowane do klipu audio. Zdarzenia odnoszące się do tego 
samego klipu mają takie same efekty zanikania.

PROCEDURA
1. W oknie Project wybierz jedno lub więcej zdarzeń audio lub zakres, dla którego chcesz   
    utworzyć przenikanie. Długość zaznaczenia określa długość obszaru przenikania.
2. Wykonaj jedną z następujących czynności:
        ● Aby utworzyć efekt narastania, wybierz Audio > Processes > Fade In (Audio > Procesy >  
           Narastanie).
        ● Aby utworzyć zanikanie, wybierz Audio > Processes > Fade Out (Audio > Procesy > 
           Zanikanie)
3. W oknie Direct Offline Processing (Bezpośrednie przetwarzanie offline) kliknij przyciski    
    Curve Type (typ krzywej), aby określić krzywą zanikania, lub kliknij i przeciągnij myszą na 
    ekranie krzywej, aby narysować krzywą.
4. Opcjonalnie: Włącz funkcję Audition (Przesłuchanie), aby usłyszeć efekt określonego zaniku w  
    wybranym zdarzeniu audio.

WYNIK
Zanikanie jest stosowane do audio. W dowolnym momencie możesz usunąć lub zmodyfikować 
przejścia, korzystając z okna Direct Offline Processing (Bezpośrednie przetwarzanie offline).

POWIĄZANE LINKI
Bezpośrednie przetwarzanie w trybie offline na stronie 475
Narastanie/Zanikanie na stronie 489
O przetwarzaniu udostępnionych klipów na stronie 311

O przetwarzaniu udostępnionych klipów
Jeśli kilka zdarzeń odnosi się do tego samego klipu audio, ten klip jest klipem udostępnionym. Jeśli 
edytujesz jedno ze zdarzeń odnoszących się do udostępnionego klipu, możesz zdecydować, czy 
chcesz zastosować przetwarzanie do wszystkich zdarzeń odnoszących się do tego klipu.

           

Continue (Kontynuuj)
         Kliknij Continue, aby zastosować przetwarzanie do wszystkich zdarzeń odnoszących się do 
         klipu audio.
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New Version (Nowa wersja)
          Kliknij opcję, New Version aby utworzyć osobną, nową wersję klipu audio dla wybranego 
          zdarzenia.

Crossfades (Przenikanie)
Przenikanie umożliwia tworzenie płynnych przejść dla kolejnych zdarzeń audio na tej samej 
ścieżce. Przejścia są zawsze oparte na zdarzeniach.

Przejścia można tworzyć tylko wtedy, gdy kolejne zdarzenia lub ich odpowiednie klipy zachodzą na
siebie.
● Jeśli zdarzenia audio zachodzą na siebie, w nakładającym się obszarze zostanie zastosowany 
efekt przenikania o domyślnym kształcie (liniowy, symetryczny).

                           

UWAGA
Możesz edytować domyślną długość i kształt przenikania w edytorze Crossfade (przenikanie).

● Jeśli odpowiednie klipy audio nakładają się na siebie, rozmiar dwóch zdarzeń jest zmieniany tak, 
aby zachodziły na siebie, a w nakładającym się obszarze stosowane jest przenikanie o domyślnej 
długości i kształcie.
● Jeśli ani zdarzenia audio, ani klipy nie zachodzą na siebie, nie można utworzyć efektu 
przenikania

POWIĄZANE LINKI
Edytor przenikania Crossfade na stronie 313

Tworzenie przenikania
Możesz tworzyć przejścia między dwoma następującymi po sobie zdarzeniami audio.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
       ● Aby utworzyć przejście między dwoma zdarzeniami, wybierz narzędzie Object Selection 
          (Zaznaczanie obiektów) i wybierz dwa następujące po sobie zdarzenia audio.
       ● Aby utworzyć przenikanie w wybranym zakresie między dwoma zdarzeniami, wybierz 
          narzędzie Range Selection (Zaznaczanie zakresu) i zaznacz zakres obejmujący obszar, 
          w którym chcesz zastosować przenikanie.
2. Wybierz Audio < Crossfade (Audio > Przenikanie) lub użyj klawisza polecenia X .

WYNIK
Zastosowano efekt przenikania.

Zmiana długości przenikania
Możesz zmienić długość przejścia

PROCEDURA
1. Wybierz narzędzie Range Selection (Zaznaczanie zakresów).
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2. Wybierz zakres między dwoma zdarzeniami, który obejmuje długość efektu przenikania, który  
     chcesz zastosować.
3. Wybierz Audio > Adjust Fades to Range (Audio > Dostosuj zanikanie do zakresu).

WYNIK
Długość przenikania jest dostosowywana do wybranego zakresu.

Crossfade Editor (Edytor przenikania)
Edytor przenikania umożliwia edycję przenikania. Zawiera ustawienia krzywych narastania i 
zanikania oraz wspólne ustawienia.

● Aby otworzyć Crossfade Editor, wybierz jedno lub oba zdarzenia z przenikaniem i wybierz 
Audio > Crossfade (Audio > Przenikanie) lub kliknij dwukrotnie strefę przenikania.

              

Curve Type buttons (Przyciski typu krzywej)

         Określ, czy odpowiednia krzywa zanikania wykorzystuje Spline Interpolation    

         (interpolację splajnu), Damped Spline Interpolation  (interpolację splajnu tłumionego) 

         lub Linear Interpolation   (interpolację liniową)
Curve Shape buttons (Przyciski kształtu krzywej)
         Zapewniają szybki dostęp do niektórych typowych kształtów krzywych.

               
Fade Curve displays (Wyświetla krzywą przenikania)
Pokaż odpowiednio kształt krzywej narastania (fade in) i zanikania (fade out).
        ● Aby dodać punkty, kliknij krzywą.
        ● Aby zmienić kształt zanikania, kliknij i przeciągnij istniejące punkty.
        ● Aby usunąć punkt, przeciągnij punkt poza obszar wyświetlania
Presets (Presety, wstępne ustawienia)
       Kliknij opcję Save Preset (Zapisz ustawienie wstępne) w wyskakującym menu Presets 
       (Ustawienia wstępne), aby zapisać ustawienia przenikania i zastosować je do innych wydarzeń.
● Aby usunąć ustawienie wstępne, zaznacz je w wyskakującym menu i kliknij Remove Preset 
(Usuń ustawienie wstępne).
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Default Buttons (Przyciski domyślne)
        Kliknij As Default (jako domyślne), aby zapisać bieżące ustawienia jako domyślne.  
        Ustawienia domyślne są używane za każdym razem, gdy tworzysz nowe przejścia. Kliknij 
        Recall Default (wywolaj domyślne), aby zastosować krzywe i ustawienia domyślnego 
        przenikania.
Length (Długość)
       Określa długość obszaru przenikania. Cubase próbuje wyśrodkować przejście, to znaczy 
       zmiana długości jest stosowana jednakowo po obu stronach. Aby móc zmienić rozmiar 
       przenikania, musi istnieć możliwość zmiany rozmiaru odpowiedniego wydarzenia. Na 
       przykład, jeśli zdarzenie zanikania odtworzy już swój klip audio do końca, jego punktu    
       końcowego nie można przesunąć dalej w prawo.
Equal Gain (Równy zysk)
       Dostosowuje krzywe zanikania tak, aby zsumowane amplitudy zanikania i narastania były takie
       same w całym obszarze przenikania. Jest to często odpowiednie dla krótkich przenikań.
Equal Power (Równa moc) 
       Dostosowuje krzywe przenikania tak, aby energia (moc) przenikania była stała w całym 
       regionie przenikania. Krzywe równej mocy mają tylko jeden edytowalny punkt krzywej. Nie 
       można zmienić kształtu krzywej, jeśli wybrany jest ten tryb.
Volume (Głośność)
      Umożliwia ustawienie poziomu odsłuchu.
Pre-roll and Post-roll (film przed filmem i film po filmie)
● Aby rozpocząć odtwarzanie przed obszarem zanikania, aktywuj opcję Use Pre-roll (Użyj przed 
filmem).
● Aby zatrzymać odtwarzanie po obszarze zanikania, włącz opcję  Use Post-roll (Użyj po filmie).
● Aby dostosować czas przed filmem, użyj pola wartości Pre-roll Amount (Kwota przed filmem).
● Aby dostosować czas po filmie, użyj pola wartości Post-roll Amount (Kwota po filmie).
Audition buttons (Przyciski przesłuchania)
        ● Aby odsłuchać wyciszoną część przejścia, kliknij Play Fade Out (Odtwórz wyciszenie).
        ● Aby odsłuchać całe przejście, kliknij Play Crossfade (Odtwórz przejście).
        ● Aby odsłuchać narastającą część przejścia, kliknij Play Fade In (Odtwórz narastanie).
        W tym celu możesz skonfigurować polecenia klawiszy w oknie dialogowym Key Commands 
        (Polecenia klawiszowe)

POWIĄZANE LINKI
Komendy klawiszowe na stronie 1123
Uchwyty zdarzeń na stronie 308
Menu ustawień automatycznego przewijania na stronie 248

Usuwanie przenikania
Możesz usunąć przenikanie.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
        ● Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i wybierz jedno z 
            przenikających się zdarzeń.
        ● Wybierz narzędzie Range Selection (Zaznaczanie zakresu) i zaznacz przejścia, które chcesz 
            usunąć.
2. Wybierz Audio > Remove Fades (Audio > Usuń przenikanie).

WYNIK
Wybrane przejścia zostaną usunięte.
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UWAGA
Możesz także usunąć przenikanie, klikając i przeciągając je poza ścieżkę.

Automatyczne zanikanie i przenikanie
Cubase posiada funkcję Auto Fade, którą można ustawić zarówno globalnie, jak i osobno dla 
każdej ścieżki audio. Automatyczne przejścia pozwalają na tworzenie płynniejszych przejść między
zdarzeniami poprzez stosowanie narastań i zanikań o długości od 1 do 500 ms.

WAŻNE
Ponieważ zanikanie oparte na zdarzeniach jest obliczane w czasie rzeczywistym podczas 
odtwarzania, zastosowanie automatycznego zanikania do większej liczby zdarzeń dźwiękowych 
powoduje większe obciążenie procesora.

UWAGA
Automatyczne zanikanie nie jest wskazywane przez linie zanikania.

Okno dialogowe automatycznego zanikania Auto Fades
Okno dialogowe Auto Fades umożliwia ustawienie automatycznego zanikania i przenikania dla 
całego projektu lub osobno dla każdej ścieżki audio.

● Aby otworzyć globalne okno dialogowe Auto Fades (Automatyczne zanikanie), wybierz Project
> Auto Fades Settings (Projekt > Ustawienia automatycznego zanikania).
● Aby otworzyć okno dialogowe Auto Fades dla ścieżki, kliknij prawym przyciskiem myszy na 
liście ścieżek i wybierz Auto Fades Settings (Ustawienia Auto Fades).
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1 Auto Fade In (Automatyczne narastanie)
         Aktywuje automatyczne narastanie.
2 Auto Fade Out (Automatyczne zanikanie)
         Aktywuje automatyczne wyciszanie.
3 Auto Crossfades (Automatyczne przenikanie)
         Aktywuje automatyczne przenikanie.
4 Use Project Settings (Użyj ustawień projektu)
         Jest to dostępne tylko wtedy, gdy dla poszczególnych ścieżek zostało otwarte okno dialogowe 
         Auto Fades (Automatyczne zanikanie). Dezaktywuj tę opcję, aby skonfigurować i zastosować
         ustawienia tylko do poszczególnych ścieżek. Jeśli chcesz, aby ścieżka z indywidualnymi 
         ustawieniami automatycznego zanikania ponownie korzystała z ustawień globalnych, aktywuj
         opcję Use Project Settings (Użyj ustawień projektu).
5 Length (Długość)
        Określa długość automatycznego zanikania lub przenikania.
6 As Default (Jako domyślne)
        Zapisuje bieżące ustawienia jako domyślne.
7 Fades Section (Sekcja zanikania)
        Zawiera ustawienia automatycznego zanikania. Przyciski Curve Type (typu krzywej)  
        pozwalają określić, czy używana jest odpowiednia krzywa zanikania Spline Interpolation 

        (Interpolacja splajnu)  , Damped Spline Interpolation (Interpolacja splajnu 

        z tłumieniem)  lub Linear Interpolation (Interpolacja liniowa)  . Przyciski Curve 
        Shape (Kształt krzywej) zapewniają szybki dostęp do typowych kształtów krzywych.
8 Crossfades Section (Sekcja przenikania)
        Zawiera ustawienia automatycznego przenikania.
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Equal Gain (Równy przyrost) umożliwia dostosowanie krzywych zanikania, tak aby zsumowane 
amplitudy narastania i zanikania były takie same w całym regionie przenikania.
Equal Power (Równa moc) umożliwia dostosowanie krzywych przenikania, tak aby energia (moc) 
przenikania była stała w całym regionie przenikania.

Dokonywanie globalnych ustawień automatycznego zanikania
Możesz ustawić automatyczne zanikanie i przenikanie dla całego projektu.

PROCEDURA
1. Wybierz Project > Auto Fades Setting (Projekt > Ustawienia automatycznego zanikania).
Spowoduje to otwarcie okna dialogowego Auto Fades (Automatyczne zanikanie) dla projektu.
2. Ustaw przejścia zgodnie z potrzebami.
3. Kliknij OK.

POWIĄZANE LINKI
Okno dialogowe Fade (zanikanie) dla zanikania opartego na zdarzeniach na stronie 310
Edytor przenikania na stronie 313

Dokonywanie ustawień automatycznego zanikania dla poszczególnych 
ścieżek
Ponieważ automatyczne przejścia wykorzystują moc obliczeniową, możesz rozważyć globalne 
wyłączenie automatycznych przejść i włączenie ich tylko dla poszczególnych ścieżek.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
         ● Kliknij prawym przyciskiem myszy ścieżkę na liście ścieżek i z menu kontekstowego  
            wybierz Auto Fades Settings (Ustawienia automatycznego zanikania).
         ● Wybierz ścieżkę i w Inspektorze kliknij Auto Fades Settings (Ustawienia automatycznego
             zanikania).
            Otworzy się okno dialogowe Auto Fades (Automatyczne zanikanie) dla ścieżki.
2. Dezaktywuj Use Project Settings (Użyj ustawień projektu).
            Wszystkie wprowadzone teraz ustawienia zostaną zastosowane tylko do ścieżki.
3. Ustaw automatyczne zanikanie.
4. Kliknij OK.

Obwiednie zdarzeń
Obwiednie zdarzeń to krzywe głośności dla zdarzeń audio. Pozwalają na tworzenie zmian głośności
w ramach wydarzenia, nie tylko na początku czy końcu.

Na obwiedniach zdarzeń można tworzyć zmiany głośności, dodając punkty krzywej za pomocą 
narzędzia Draw (Rysuj).

Krzywa obwiedni jest częścią zdarzenia audio. Jeśli przeniesiesz lub skopiujesz zdarzenie, 
obwiednia zdarzenia podąża za nim.
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Tworzenie zmian głośności opartych na zdarzeniach
Możesz tworzyć zmiany głośności dla zdarzenia audio.

PROCEDURA
1. Powiększ zdarzenie, aby prawidłowo wyświetlić jego przebieg.
2. Wybierz narzędzie Draw (Rysuj) i kliknij miejsce zdarzenia, w którym chcesz zmienić głośność.
3. Kliknij narzędziem Draw.

          
         Do krzywej obwiedni zostanie dodany punkt krzywej.
4. Przeciągnij punkt krzywej, aby dostosować krzywą głośności.

WYNIK
Zmiana głośności została utworzona. Obraz fali zdarzenia zmienia się w zależności od zmiany 
głośności.

Usuwanie obwiedni zdarzeń
Możesz usunąć całą obwiednię zdarzenia lub pojedyncze punkty krzywej.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● Aby usunąć punkt krzywej z obwiedni, kliknij go i przeciągnij poza wydarzenie.
       ● Aby usunąć krzywą obwiedni zdarzenia z wybranego zdarzenia, wybierz kolejno Audio >  
          Remove Volume Curve (Audio > Usuń krzywą głośności).

Tworzenie zmian głośności opartych na klipach
Możesz tworzyć zmiany głośności dla klipu audio. Zdarzenie dźwiękowe zmieni się odpowiednio.

PROCEDURA
1. W oknie Project wybierz zdarzenie.
2. Wybierz Audio > Processes > Envelope (Audio > Procesy > Obwiednia).
3. W oknie dialogowym Direct Offline Processing (Bezpośrednie przetwarzanie offline)  
    wprowadź zmiany i kliknij przycisk Apply (Zastosuj).

WYNIK
Zmiana głośności została utworzona. Obraz fali zdarzenia zmienia się w zależności od zmiany 
głośności.

POWIĄZANE LINKI
Obwiednia na stronie 488
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Arranger Track (Ścieżka aranżera)

Funkcje aranżacyjne w Cubase pozwalają na pracę w sposób nieliniowy. Użycie ścieżki aranżera 
pozwala określić, w jaki sposób i kiedy mają być odtwarzane określone sekcje, nawet podczas 
występów na żywo. W ten sposób nie musisz przenosić, kopiować i wklejać zdarzeń w oknie 
Project.

UWAGA
W projekcie może być tylko jedna ścieżka aranżera.

Aby korzystać z funkcji aranżera, musisz dodać ścieżkę aranżera i zdefiniować zdarzenia aranżera. 
Zdarzenia aranżera mogą mieć dowolną długość. Mogą się nakładać i nie są związane z początkiem
lub końcem istniejących zdarzeń i części. Możesz je uporządkować na liście i dodawać powtórzenia
według uznania.

         

Zdarzenia aranżera można edytować przy użyciu standardowych technik. Kopie ze zdarzeń 
aranżacyjnych są niezależne od oryginalnego zdarzenia.

Możesz utworzyć kilka łańcuchów aranżerów, które umożliwiają zapisywanie różnych wersji 
utworu w ramach projektu.

Możesz spłaszczyć łańcuchy aranżacji, aby przekształcić je w projekt liniowy.

POWIĄZANE LINKI
Dodawanie zdarzeń aranżera na ścieżce aranżera na stronie 319
Konfigurowanie łańcucha aranżera i dodawanie wydarzeń na stronie 323
Spłaszczanie łańcucha aranżera na stronie 324

Dodawanie zdarzeń aranżera na ścieżce aranżera
Na ścieżce aranżera możesz dodawać wydarzenia aranżera, które definiują określone sekcje 
projektu.

WARUNEK WSTĘPNY
Snap (Przyciąganie) jest włączone, a Snap Type (Typ przyciągania) jest ustawiony na Events 
(Zdarzenia).

PROCEDURA
1. Wybierz Project > Add Track > Arranger (Projekt > Dodaj ścieżkę > Aranżer).
     Zostanie dodana ścieżka aranżera.
2. Wybierz narzędzie Draw (Rysuj) i narysuj zdarzenie aranżera na ścieżce aranżera. Dodano    
    zdarzenie aranżera.
3. Narysuj tyle zdarzeń, ile potrzebujesz.

WYNIK
Zdarzenia aranżera zostaną dodane do twojego projektu.

PO WYKONANIU TEGO ZADANIA
Użyj funkcji Arranger Editor (Edytora aranżera), aby zaaranżować zdarzenia.

POWIĄZANE LINKI
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Ścieżka aranżera na stronie 152
Konfigurowanie łańcucha aranżera i dodawanie wydarzeń na stronie 323
Funkcja przyciągania na stronie 85
Menu typów przyciągania na stronie 86

Zmiana nazw zdarzeń aranżera
Kiedy dodajesz wydarzenia aranżera, są one automatycznie nazywane w porządku alfabetycznym. 
Możesz zmienić nazwy, aby odzwierciedlały strukturę twojego projektu, na przykład Intro, Chorus, 
Bridge.

PROCEDURA
1. Wybierz wydarzenie aranżera, którego nazwę chcesz zmienić.
2. Wykonaj jedną z następujących czynności:
        ● Wybierz nazwę zdarzenia w linii informacyjnej.
        ● Przytrzymaj klawisz Alt/Opt i kliknij dwukrotnie nazwę w łańcuchu aranżacji.
3. Wprowadź nową nazwę.

Arranger Editor  (Edytor aranżacji)
Arranger Editor (Edytor aranżerów) umożliwia konfigurowanie łańcuchów aranżerów.

● Aby otworzyć Arranger Editor (edytor aranżera), wybierz ścieżkę aranżera i kliknij Open 
Arranger Editor (Otwórz edytor aranżera) na liście ścieżek.

        

Arranger toolbar (Pasek narzędzi aranżera)
         Pokazuje przyciski transportu, przyciski transportu aranżera i narzędzia aranżera.
Current Arranger Chain (Obecny łańcuch aranżerów)
         Pokazuje kolejność odtwarzania zdarzeń, od góry do dołu, oraz liczbę powtórzeń.

UWAGA
Początkowo łańcuch aranżera jest pusty. Aby ją zapełnić, należy dodać zdarzenia z listy Arranger 
Events (Zdarzenia aranżera).

Arranger Events (Zdarzenia aranżerskie)
        Wyświetla listę dostępnych zdarzeń aranżera w kolejności, w jakiej pojawiają się na osi czasu.
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Pasek narzędzi edytora aranżacji (Arranger Editor)
Arranger Editor (Edytor aranżacji) zawiera narzędzia i skróty do ustawiania opcji spłaszczania.

● Aby otworzyć Arranger Editor, wybierz ścieżkę aranżera i kliknij  Open Arranger 
   Editor (Otwórz edytor aranżera) na liście ścieżek.

Activate Arranger Mode (Aktywuj tryb aranżera)

         
       Włącza odtwarzanie w trybie aranżera.
Previous Chain Step (Poprzedni krok łańcucha)

         
       Przechodzi do poprzedniego wpisu na bieżącej liście aranżerów.
Next Chain Step (Następny krok łańcucha)

         
       Przechodzi do następnego wpisu na bieżącej liście aranżerów.
First Repeat of Current Chain Step (Pierwsze powtórzenie bieżącego etapu łańcucha)

         
       Przechodzi do pierwszego powtórzenia bieżącego wpisu na bieżącej liście łańcuchów 
       aranżerów.
Last Repeat of Current Chain Step (Ostatnie powtórzenie bieżącego kroku łańcucha)

         
       Przechodzi do ostatniego powtórzenia bieżącego wpisu na bieżącej liście łańcuchów 
       aranżerów.
Select Active Chain (Wybierz Aktywny łańcuch)

         
       Umożliwia wybranie i aktywację łańcucha aranżerów.
Rename Current Chain (Zmień nazwę bieżącego łańcucha)

         
       Umożliwia zmianę nazwy bieżącego łańcucha aranżerów.
Create New Chain (Utwórz nowy łańcuch)

         
       Tworzy nowy, pusty łańcuch aranżacji.
Duplicate Current Chain (Zduplikuj bieżący łańcuch)

         
       Tworzy duplikat bieżącego łańcucha aranżerów, zawierający te same zdarzenia.
Remove Current Chain (Usuń bieżący łańcuch)

         
       Usuwa wybrany łańcuch aranżera. Jest to dostępne tylko wtedy, gdy utworzyłeś więcej
       niż jeden łańcuch aranżerów.
Flatten Chain (Spłaszcz łańcuch)

         
       Konwertuje bieżący łańcuch aranżera na projekt liniowy.
Flatten (with Options & Preferences) (Spłaszcz (z opcjami i preferencjami))

        
       Umożliwia skonfigurowanie opcji spłaszczania.
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Tryby powtarzania łańcucha aranżera
Arranger Editor (Edytor aranżera) zawiera funkcję, która umożliwia powtarzanie i zapętlanie 
wydarzeń aranżera. W ten sposób możesz stworzyć szkic struktury utworu.
● Aby otworzyć Arranger Editor, wybierz ścieżkę aranżera i kliknij Open Arranger Editor 
(Otwórz edytor aranżera) na liście ścieżek.

Aby wybrać jeden z trybów powtarzania, kliknij kolumnę Mode (Tryb) na liście Current 
Arranger Chain (Aktualny łańcuch aranżera).

1 Normal (Normalny)
       Odtwarza łańcuch aranżera dokładnie tak, jak go ustawiłeś.
2 Repeat Forever (Powtarzaj na zawsze)
       Powtarza bieżące zdarzenie aranżera w pętli, dopóki nie klikniesz innego zdarzenia w 
       Arranger Editor (aranżerze Edytora) lub do ponownego kliknięcia Play (Odtwórz).
3 Pause After Repeats (Pauza po powtórzeniach)
      Wstrzymuje odtwarzanie po odtworzeniu wszystkich powtórzeń bieżącego zdarzenia aranżera.

UWAGA
Podczas odtwarzania kolumna Counter (Licznik) wskazuje, które powtórzenie zdarzenia jest 
odtwarzane.

Opcje i preferencje spłaszczania
Opcje spłaszczania pozwalają określić, co się stanie, gdy spłaszczysz ścieżkę aranżera.

● Aby wyświetlić opcje spłaszczania, otwórz Arrange Editor (Edytor aranżacji) i kliknij opcję 
   Flatten (with Options & Preferences) (Spłaszcz (z opcjami i preferencjami)).

           

W sekcji Source (Źródło) możesz określić, które łańcuchy aranżerów mają być spłaszczone.

Current Chain (Obecny łańcuch)
        Spłaszcza tylko bieżący łańcuch.
Checked Chains (Sprawdzone łańcuchy)
        Otwiera listę dostępnych łańcuchów aranżerów, gdzie możesz aktywować ścieżki aranżerów, 
        które chcesz spłaszczyć.
All Chains (Wszystkie łańcuchy)
        Spłaszcza wszystkie łańcuchy aranżerów bieżącego projektu. Sekcja Destination (Miejsce  
        docelowe) umożliwia wybranie miejsca zapisania wyniku spłaszczania.
Current Project (Bieżący projekt)
        Jest to dostępne tylko wtedy, gdy Source (Źródło) jest ustawione na Current Chain (Bieżący 
        łańcuch). Aktywuj tę opcję, jeśli chcesz zapisać spłaszczony łańcuch w bieżącym projekcie.
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New Project (Nowy projekt)
          Pozwala spłaszczyć jeden lub więcej łańcuchów w nowym projekcie z następującymi 
          opcjami nazewnictwa:
         ●  Append Chain Name (Dołącz nazwę łańcucha)
                   Dołącza nazwy łańcuchów do nazwy projektu.
         ●  Use Chain Name (Użyj nazwy łańcucha)
                  Nazywa nowe projekty po bieżących łańcuchach aranżerów.
         ●  Add Number (Dodaj numer)
                  Nazywa nowe projekty po starych i dodaje liczbę.

Sekcja Options (Opcje) zawiera dalsze ustawienia.

Keep Arranger Track (Utrzymuj ścieżkę aranżer)
         Utrzymuje ścieżkę aranżera po spłaszczeniu. Aktywuj Rename Arranger Events, aby dodać 
         numery do zdarzeń.
Make Real Event Copies (Twórz kopie prawdziwych wydarzeń)
        Umożliwia tworzenie prawdziwych kopii ścieżki aranżera zamiast współdzielonych kopii.
Don‘t Split Events (Nie rozdzielaj zdarzeń)
        Nie obejmuje nut MIDI, które rozpoczynają się przed zdarzeniem aranżera lub są dłuższe niż   
        zdarzenie aranżera. Uwzględniane są tylko nuty MIDI, które zaczynają się i kończą 
        w zdarzeniu aranżera.
Open New Projects (Otwórz nowe projekty)
        Tworzy nowy projekt dla każdego spłaszczonego łańcucha aranżacji. Jeśli aktywujesz  
        Cascade New Projects (Kaskadowo nowe projekty), otwarte projekty są kaskadowane.

POWIĄZANE LINKI
Spłaszczanie łańcucha aranżera na stronie 324

Konfigurowanie łańcucha aranżerów i dodawanie zdarzeń
W Arrange Editor (Edytorze aranżerów) możesz konfigurować łańcuchy aranżerów i dodawać do 
nich zdarzenia.

PROCEDURA
1. Kliknij e, aby otworzyć Arrange Editor (Edytor aranżera).
2. Aktywuj Activate Arranger Mode (Aktywuj tryb aranżera).

                

3. Wykonaj jedną z poniższych czynności, aby dodać zdarzenia aranżera do łańcucha aranżerów:
        ● Kliknij dwukrotnie zdarzenie na liście Arranger Events (Zdarzenia aranżera).
        ● Wybierz jedno lub więcej wydarzeń z listy Arranger Events, kliknij prawym przyciskiem  
            myszy i wybierz opcję Append Selected In Arranger Chain (Dołącz wybrane w łańcuchu 
            aranżera).
        ● Przeciągnij zdarzenie aranżera z listy Arrange Events i upuść je na liście Current  
            Arranger Chain  (Obecny łańcuch aranżerów).
        ● Przeciągnij zdarzenie aranżera z okna Project i upuść je na liście Current Arranger Chain 
           (Obecny łańcuch aranżerów).
4. Kliknij Play (Odtwórz).

WYNIK
Zdarzenia aranżera są odtwarzane w kolejności określonej w łańcuchu aranżera.
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POWIĄZANE LINKI
Tryby powtarzania łańcucha aranżera na stronie 322

Dodawanie nowego łańcucha aranżera
Możesz utworzyć kilka łańcuchów aranżerów, aby ustawić alternatywne wersje do odtwarzania

WARUNEK WSTĘPNY
Tryb aranżera (Arranger Mode) jest włączony.

PROCEDURA
1. Otwórz Arrange Editor (Edytor aranżacji).
2. Kliknij opcję Create New Chain (Utwórz nowy łańcuch).

WYNIK
Aktywowany jest nowy, pusty łańcuch aranżerów. Znajduje to odzwierciedlenie w nowej nazwie w 
wyskakującym menu Select Active Chain (Wybierz aktywny łańcuch) i nowej, pustej liście 
Current Arranger Chain (Obecny łańcuch aranżerów).

Edytowanie zdarzeń aranżera w łańcuchu aranżera
Na liście Current Arranger Chain (Obecny łańcuch aranżerów) możesz edytować zdarzenia 
aranżera.

Możesz wykonać następujące czynności:
● Aby zaznaczyć wiele wydarzeń, naciśnij Ctrl/Cmd i kliknij je lub Shift.
● Aby przenieść zdarzenia na liście, przeciągnij je w górę lub w dół.
● Aby skopiować zdarzenia, zaznacz je, przytrzymaj Alt/Opt i przeciągnij.
● Aby powtórzyć zdarzenia, kliknij w kolumnie Repeats (Powtórzenia) i wprowadź liczbę   
    powtórzeń.
● Aby określić sposób powtarzania zdarzenia, kliknij kolumnę Mode (Tryb) i wybierz Repeat    
    Mode (Tryb powtarzania) z wyskakującego menu.
● Aby przenieść pozycję odtwarzania na początek zdarzenia, kliknij strzałkę po lewej stronie 
    zdarzenia.
● Aby usunąć zdarzenie z listy, kliknij je prawym przyciskiem myszy iz menu kontekstowego 
    wybierz Remove Touched (Usuń dotknięte).
● Aby usunąć kilka zdarzeń, zaznacz je, kliknij prawym przyciskiem myszy i z menu 
    kontekstowego wybierz Remove Selected (Usuń zaznaczone).

POWIĄZANE LINKI
Tryby powtarzania łańcucha aranżera na stronie 322

Spłaszczanie łańcucha aranżera
Kiedy masz skonfigurowany łańcuch aranżacji, który Ci się podoba i jesteś pewien, że nie chcesz 
go już edytować, możesz przekonwertować go na projekt liniowy.

WARUNEK WSTĘPNY
Zapisałeś kopię projektu przed spłaszczeniem łańcucha aranżera.

UWAGA
Spłaszczenie łańcucha aranżera może usunąć wydarzenia i części z projektu. Używaj Flatten tylko 
wtedy, gdy wiesz, że nie chcesz już edytować ścieżki/łańcuch aranżera. W razie wątpliwości zapisz 
kopię projektu przed spłaszczeniem łańcucha aranżera.
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PROCEDURA
1. Wybierz łańcuch aranżerów, który chcesz przekonwertować na projekt liniowy.
2. Opcjonalnie: kliknij Flatten (with Options & Preferences) (Spłaszcz (z opcjami i 
preferencjami)).

                          

3. Opcjonalnie: Aktywuj żądane opcje spłaszczania.

UWAGA
Jeśli zdasz sobie sprawę, że chcesz wprowadzić dalsze zmiany, kliknij Go Back (Wróć). 
Aktywowane opcje spłaszczania są zachowywane.

4. Kliknij Flatten (Spłaszcz).

WYNIK
Zdarzenia i części w projekcie są ponownie porządkowane, powtarzane, zmieniane rozmiary, 
przesuwane i/lub usuwane, tak aby dokładnie odpowiadały łańcuchowi aranżerów.

Jump Mode (Tryb skoku)
Jeśli skonfigurowałeś ścieżkę aranżera i odtworzyłeś ją, masz dostęp na żywo do kolejności 
odtwarzania. W ten sposób możesz zapętlać zdarzenia aranżera z większą elastycznością w 
odniesieniu do długości odtwarzania.

WARUNEK WSTĘPNY
Ustawiony zostaje łańcuch aranżerów i włączony jest tryb aranżera.

PROCEDURA
1. Odtwórz swój projekt.
2. W dolnej części Inspektora otwórz wyskakujące menu Jump Mode (Tryb skoku) i wybierz opcję
    z wyskakującego menu.

                  

Określa, jak długo aktywne zdarzenie aranżera jest odtwarzane przed przejściem do następnego.
3. Na liście Arranger Events (Zdarzenia aranżera) w Inspektorze kliknij strzałkę po lewej stronie 
zdarzenia aranżera, które chcesz wyzwolić.

WYNIK
Zdarzenie aranżera jest zapętlane zgodnie z Twoimi ustawieniami, dopóki nie klikniesz innego 
zdarzenia aranżera.

UWAGA
Możesz przypisać klawisze do wyzwalania zdarzeń aranżera w kategorii Arranger (Aranżer) w 
oknie dialogowym Key Commands (Polecenia klawiszy).

PO WYKONANIU TEGO ZADANIA
       ● Aby zatrzymać Jump Mode (Tryb skoku), kliknij Stop.
● Aby kontynuować odtwarzanie od określonego zdarzenia aranżera, kliknij zdarzenie aranżera na 
liście Current Arranger Chain (Aktualny łańcuch aranżerów).
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POWIĄZANE LINKI
Opcje trybu skoku na stronie 326

Opcje Jump Mode (trybu skoku)
Wyskakujące menu Jump Mode pozwala określić, jak długo aktywne wydarzenie aranżera ma być 
odtwarzane przed przejściem do następnego.

● Aby wyświetlić inspektora ścieżki aranżera, wybierz ścieżkę aranżera z listy ścieżek.

                

Dostępne są następujące opcje:

None (Nic)
        Natychmiastowe przejście do następnej sekcji.
4 Bars, 2 bars (4 takty, 2 takty)
        Przeskakuje do następnego zdarzenia aranżera po 2 lub 4 taktach. Jeśli bieżące zdarzenie 
        aranżera jest krótsze niż 2 lub 4 takty, odtwarzanie przeskakuje do następnego zdarzenia 
        aranżera na końcu zdarzenia.
1 Bar (1 takt)
        Przeskakuje do następnej sekcji na następnej kresce.
1 Beat (1 uderzenie)
        Przeskakuje do następnej sekcji w następnym uderzeniu.
End (Koniec)
       Odtwarza bieżącą sekcję do końca, a następnie przechodzi do następnej sekcji.

Aranżacja muzyki do wideo
Kiedy komponujesz muzykę do wideo, możesz użyć zdarzeń aranżacyjnych, aby wypełnić 
określoną sekcję wideo muzyką. Poniżej znajduje się przykład, jak można to zrobić.

WARUNEK WSTĘPNY
Podłączyłeś i skonfigurowałeś zewnętrzne urządzenie master synchronizacji z komputerem. 
Utworzyłeś nowy, pusty projekt i dodałeś ścieżkę MIDI.
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PROCEDURA
1. Utwórz partię MIDI, która zaczyna się na pozycji 00:00:00:00 i kończy na pozycji 00:01:00:00.
2. Utwórz partię MIDI, która zaczyna się na pozycji 00:01:00:00 i kończy na pozycji 00:02:00:00.
3. Utwórz partię MIDI, która zaczyna się na pozycji 00:02:00:00 i kończy na pozycji 00:03:00:00.
4. W panelu Transport aktywuj Sync. (Synchronizację).
5. Wybierz Project > Add Track > Arranger (Projekt > Dodaj ścieżkę > Aranżer).
     Zostanie dodana ścieżka aranżera.
6. Na ścieżce aranżera dodaj zdarzenia aranżera w pozycjach partii MIDI.
7. Ustaw łańcuch aranżacji A-A-B-B-C-C.
8. Włącz tryb Arranger (Aranżer) i rozpocznij odtwarzanie.
9. Na zewnętrznym urządzeniu master synchronizacji uruchom zewnętrzny kod czasowy na pozycji
    00:00:10:00.
    W projekcie znajduje się pozycja 00:00:10:00 i odtwarzana jest część aranżera A.
10. Uruchom zewnętrzne urządzenie master synchronizacji w miejscu, które nie odpowiada czasowi
      rozpoczęcia projektu, na przykład 00:01:10:00.
      W projekcie znajduje się pozycja 00:01:10:00 i odtwarzana jest część aranżera A.

WYNIK
Jeśli ustawisz zewnętrzne urządzenie synchronizujące w miejscu, które nie pasuje do czasu 
rozpoczęcia projektu, Cubase automatycznie przeskoczy do właściwej pozycji na ścieżce aranżera.

UWAGA
Odniesieniem dla zewnętrznego kodu czasowego może być MIDI lub dowolny inny kod czasowy, 
który może być interpretowany przez Cubase.

POWIĄZANE LINKI
Ścieżka aranżera na stronie 152.
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Funkcje transpozycji

Funkcje transpozycji dźwięku i MIDI w Cubase pozwalają na zmianę wysokości dźwięku audio 
i MIDI do odtwarzania bez zmiany rzeczywistych nut MIDI lub audio.

Możesz transponować:
● Cały projekt poprzez zmianę Project Root Key (klucza głównego projektu) na pasku narzędzi 
okna Project.
● Określone sekcje projektu, tworząc ścieżkę transpozycji i dodając zdarzenia transpozycji.
● Poszczególne części lub zdarzenia poprzez zmianę ich wartości transpozycji w wierszu 
informacyjnym okna Project.
WAŻNE
Ogólną zasadą jest zawsze ustawianie klucza głównego jako pierwszego podczas pracy z 
zawartością ze zdefiniowanym kluczem głównym.

UWAGA
Aby transponować nuty MIDI na wybranej ścieżce, możesz także użyć modyfikatorów MIDI. Jeśli 
chcesz zmienić rzeczywiste nuty, użyj funkcji transpozycji MIDI w oknie dialogowym Transpose 
Setup i w efektach MIDI (patrz oddzielny dokument Plug-in Reference (Opis wtyczek)).

POWIĄZANE LINKI
Transponowanie za pomocą klucza głównego projektu na stronie 329
Transponowanie sekcji projektu za pomocą transpozycji zdarzeń na stronie 332
Transponowanie poszczególnych partii lub wydarzeń za pomocą linii informacyjnej na stronie 334
Modyfikatory MIDI na stronie 773
Transpozycja i prędkość w linii informacyjnej na stronie 781
Okno dialogowe konfiguracji transpozycji na stronie 792

Klucz główny projektu
Project Root Key (Klucz główny projektu) umożliwia transpozycję projektu. Zdarzenia audio lub 
MIDI w twoim projekcie używają go jako odniesienia.

Aby zmienić Project Root Key (Klucz główny projektu), użyj wyskakującego menu Project Root 
Key (Klucz główny projektu) na pasku narzędzi okna Project.

Jeśli zmienisz klucz główny projektu, pętle, które już zawierają informacje o kluczu głównym, 
zostaną wykonane automatycznie.

POWIĄZANE LINKI
Transponowanie za pomocą klucza głównego projektu na stronie 329
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Transponowanie za pomocą klucza głównego projektu
Pętle zawarte w Cubase zawierają już informacje o kluczu głównym. Jeśli zmienisz klucz główny 
projektu, te pętle będą działać automatycznie.

WARUNEK WSTĘPNY
Otworzyłeś projekt zawierający pętle audio z różnymi kluczami głównymi.

PROCEDURA
1. Opcjonalnie: Wybierz pętle perkusyjne i perkusyjne w swoim projekcie i ustaw ustawienie 
Global Transpose (Transpozycja globalna) w wierszu informacyjnym na Independent 
(Niezależne). To ustawienie wyklucza transpozycję pętli.
2. Na pasku narzędzi okna Project otwórz menu podręczne Project Root Key (Klucz główny 
projektu) i ustaw klucz główny dla projektu.

         
Spowoduje to zmianę klucza głównego dla całego projektu i transpozycję pętli w celu dopasowania 
do tego klucza.

         
WYNIK
Pętle podążają za kluczem głównym projektu.

PO WYKONANIU TEGO ZADANIA
Nagrywaj audio lub MIDI. Nowo zarejestrowane zdarzenia otrzymują klucz główny projektu. 
Zmień klucz główny projektu. Następują zdarzenia z informacjami o kluczu głównym.

POWIĄZANE LINKI
Wykluczanie pojedynczych partii lub zdarzeń z globalnej transpozycji na stronie 335
Transpozycja ścieżki i nagrania na stronie 334

Przypisywanie klucza głównego projektu do części lub zdarzeń
Niektóre zdarzenia audio lub MIDI utworzone na przykład przez nagrywanie mogą nie zawierać 
informacji o kluczu głównym. Jeśli chcesz, aby podążały za zmianami transpozycji, musisz ustawić 
je na Project Root Key (klucz główny projektu).

PROCEDURA
1. Na pasku narzędzi okna Project otwórz menu podręczne Project Root Key (Klucz główny 
projektu) i ustaw klucz główny dla projektu.
2. Opcjonalnie: Wybierz pętle bębnowe i perkusyjne w swoim projekcie i ustaw ustawienie Global 
Transpose (Transpozycja globalna) w wierszu informacyjnym na Independent (Niezależne).
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To ustawienie wyklucza transpozycję pętli.
3. Wybierz Project > Add Track > Transpose (Projekt > Dodaj ścieżkę > Transponuj).
Ścieżka transponowana zostanie dodana do listy ścieżek. W projekcie można mieć tylko jedną 
ścieżkę transpozycji.
4. Na liście ścieżek kliknij prawym przyciskiem myszy ścieżkę transpozycji i z menu 
kontekstowego wybierz Set root key for unassigned events (Ustaw klucz główny dla 
nieprzypisanych zdarzeń).

         

WYNIK
Wszystkie części lub zdarzenia, które nie zawierają żadnych informacji o kluczu głównym, są 
ustawiane na klucz główny projektu.

POWIĄZANE LINKI
Wykluczanie pojedynczych partii lub zdarzeń z globalnej transpozycji na stronie 335.

Nagrywanie z kluczem głównym projektu
Jeśli nagrywasz za pomocą klucza głównego projektu, nagrane zdarzenia automatycznie podążają 
za tym kluczem głównym. Ta funkcja jest przydatna, jeśli chcesz później zmienić klucz główny i 
chcesz, aby zdarzenia następowały po nim.

PROCEDURA
1. Opcjonalnie: Wybierz pętle bębnowe i perkusyjne w swoim projekcie i ustaw ustawienie Global 
     Transpose (Transpozycja globalna) w wierszu informacyjnym na Independent (Niezależne).
     To ustawienie wyklucza transpozycję pętli.
2. Na pasku narzędzi okna Project otwórz menu podręczne e Project Root Key (Klucz główny 
    projektu) i ustaw klucz główny.
    Wszystkie części i zdarzenia są transponowane w celu dopasowania do klucza głównego.
3. Nagraj swoją muzykę.

WYNIK
Wszystkie nagrane zdarzenia audio i partie MIDI otrzymują informacje o kluczu głównym projektu.
W wierszu informacyjnym ustawienie Global Transpose dla nagranych zdarzeń jest ustawione na 
Follow (Podążaj).

PO WYKONANIU TEGO ZADANIA
Zmień klucz główny projektu. Twoje zdarzenia będą podążać.

Zmiana klucza głównego poszczególnych zdarzeń audio
Możesz zmienić lub ustawić informacje o kluczu głównym dla poszczególnych zdarzeń audio lub 
części w Pool (puli).

PROCEDURA
1. Wybierz Media > Open Pool Window (Media > Otwórz okno puli).
2. Otwórz menu podręczne View/Attributes (Widok/Atrybuty) i aktywuj opcję Root Key (Klucz 
    główny). Kolumna Key (Klucz) jest wyświetlana w oknie Pool (Pula).

333



3. Kliknij kolumnę Key (Klucz) dla zdarzenia audio lub partii, do której chcesz przypisać inny ton 
    główny i wybierz tonację z wyskakującego menu.

WYNIK
Klucz główny zdarzenia audio lub części został zmieniony. Odpowiedni plik audio pozostaje jednak
niezmieniony. Jeśli zmienisz klucz główny projektu, zdarzenia audio lub części zachowają swoje 
własne ustawienia klucza głównego i zostaną transponowane w celu dopasowania do klucza 
głównego projektu (Project Root Key).

UWAGA
Możesz także przypisać klucze główne w MediaBay.

UWAGA
Zapisz klucz główny w pliku audio, wybierając zdarzenie audio na ekranie zdarzenia i wybierając 
Audio > Bounce Selection (Audio > Wybór odbicia).

Zmiana tonacji podstawowej poszczególnych partii MIDI
Możesz zmienić informacje o tonacji głównej dla poszczególnych partii MIDI w wierszu 
informacyjnym okna Project.

PROCEDURA
1. W oknie zdarzeń wybierz partię MIDI.
2. W wierszu informacyjnym okna Project kliknij Root Key (Klucz główny) i wybierz klucz z 
wyskakującego menu.

WYNIK
Tonacja prymy partii MIDI zostanie zmieniona. Jeśli zmienisz tonację główną projektu, partie 
MIDI zachowają własne ustawienia tonacji głównej i zostaną transponowane w celu dopasowania 
do Project Root Key (tonacji głównej projektu).

Transponuj ścieżkę
Ścieżka transpozycji umożliwia transpozycję całego projektu lub jego części. Ta funkcja jest 
przydatna, jeśli chcesz tworzyć wariacje harmoniczne.

Aby ta funkcja działała, musisz dodać zdarzenia transpozycji. Te zdarzenia transpozycji 
umożliwiają transpozycję określonych fragmentów projektu w półtonach.

PRZYKŁAD
Jeśli twój wokalista nie osiągnie określonego tonu, możesz transponować cały projekt, dodając 
ścieżkę transpozycji i tworząc zdarzenie transpozycji o wartości -2 półtony. Po nagraniu ustaw 
zdarzenie transpozycji z powrotem na 0.

PRZYKŁAD
Jeśli chcesz rozjaśnić swoje pętle w tonacji C-dur, możesz je transponować, dodając ścieżkę 
transpozycji i tworząc zdarzenie transpozycji o wartości 5. Spowoduje to transpozycję ich o 5 
półtonów, dzięki czemu odtwarzana będzie subdominanta w tonacji F-dur.

PRZYKŁAD
Jeśli chcesz, aby Twoja piosenka była bardziej interesująca, możesz transponować ostatni refren 
swojego projektu, dodając ścieżkę transpozycji i tworząc zdarzenie transpozycji o wartości 1.
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Transponowanie sekcji projektu za pomocą zdarzeń transpozycji
Możesz transponować określone sekcje swojego projektu, tworząc zdarzenia transpozycji na 
ścieżce transpozycji.

PROCEDURA
1. Wybierz Project > Add Track > Transpose (Projekt > Dodaj ścieżkę > Transponuj).
     Ścieżka transponowana zostanie dodana do listy ścieżek. W projekcie można mieć tylko jedną    
     ścieżkę transpozycji.
2. Wybierz narzędzie Draw (Rysuj) i kliknij ścieżkę transpozycji. Zdarzenie transpozycji jest 
    tworzone od miejsca kliknięcia do końca projektu.

                 

3. Kliknij w nowej pozycji, aby dodać kolejne zdarzenie transpozycji.

                  

4. Kliknij wartość w lewym dolnym rogu zdarzenia i wprowadź wartość transpozycji z zakresu 
    od -24 do 24 półtonów.
5. Odtwórz swój projekt

WYNIK
Transponowane są sekcje projektu, które znajdują się w tym samym czasie co zdarzenia 
transpozycji.

POWIĄZANE LINKI
Wykluczanie pojedynczych partii lub zdarzeń z globalnej transpozycji na stronie 335.

Wyciszanie zdarzeń na ścieżce transpozycji
Możesz wyciszyć zdarzenia transpozycji na ścieżce transpozycji. Jest to przydatne, jeśli chcesz na 
przykład porównać efekt transpozycji z oryginalnym dźwiękiem.

PROCEDURA
● Na liście ścieżek transpozycji kliknij opcję Mute Transpose Events (Wycisz Transponowane 
    zdarzenia).

WYNIK
Zdarzenia transpozycji nie są brane pod uwagę podczas odtwarzania.

Blokada transpozycji
Funkcja blokady na ścieżce transpozycji pozwala zapobiegać przypadkowemu przeniesieniu lub 
zmianie transpozycji.

Aby zablokować ścieżkę transpozycji, aktywuj opcję Lock (Zablokuj) na liście ścieżek.
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Zachowaj transpozycję w zakresie oktaw
Keep Transpose in Octave Range (Zachowaj transpozycję w zakresie oktaw) na ścieżce 
transpozycji utrzymuje transpozycję w zakresie oktaw.

Gwarantuje to, że nic nie zostanie przetransponowane o więcej niż siedem półtonów, a Twoja 
muzyka nigdy nie zabrzmi nienaturalnie, ponieważ tonacja została podniesiona zbyt wysoko lub 
zbyt nisko. Zalecamy również włączenie tej funkcji podczas pracy z pętlami audio.

PRZYKŁAD

Otworzyłeś Key Editor i aktywowałeś Indicate Transpositions   (Wskaż transpozycje) . 

Dodałeś ścieżkę transpozycji i aktywowałeś Transpose in Octave Range    (Transpozycja w 
zakresie oktawy). Jeśli dodasz zdarzenie transpozycji o wartości 8 półtonów lub wyższej, akord 
zostanie przetransponowany do najbliższego interwału lub wysokości.

Indicate Transpositions (Wskaż transpozycje)
W przypadku partii MIDI można uzyskać wizualną informację zwrotną, która pozwala porównać 
oryginalne dźwięki i muzykę transponowaną do odtwarzania.
● Aby aktywować Indicate Transpositions (transpozycje wskazujące) dla partii MIDI, otwórz 
partię w Key Editor (Edytorze klawiszy) i kliknij opcję Indicate Transpositions (Wskaż 
transpozycje).

           
Jeśli włączona jest opcja Indicate Transpositions (Wskaż transpozycje), wyświetlane są 
transponowane tony nut.

           
Jeśli opcja Indicate Transpositions jest wyłączona, wyświetlane są oryginalne wysokości nut w 
partii MIDI
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Transponuj ścieżkę i nagrywanie
Ścieżka transpozycji wpływa na wynik nagranych partii lub zdarzeń.

Jeśli twój projekt zawiera ścieżkę transpozycji ze zdarzeniami transpozycji i nagrywasz audio lub 
MIDI, dzieje się tak: 
● Global Transpose (Transpozycja globalna) jest automatycznie ustawiana na Independent 
    (Niezależną) dla nagranych partii lub zdarzeń.
● Klucz główny projektu nie jest brany pod uwagę.

Jeśli twój projekt nie zawiera ścieżki transpozycji lub nie dodano żadnych zdarzeń transpozycji, 
dzieje się tak:
● Global Transpose (Transpozycja globalna) jest automatycznie ustawiana na Follow (Śledź) dla 
nagranych partii lub zdarzeń.
● Nagrane części lub zdarzenia otrzymują klucz główny projektu.

Transponuj w linii informacyjnej
W wierszu informacyjnym okna projektu możesz zmienić wartość transpozycji dla poszczególnych 
części lub zdarzeń.

Aby to zrobić, zmień wartość transpozycji w polu Transpose (Transpozycja) w linii informacyjnej.

            

Pole Transpose wskazuje również transpozycje wprowadzone przez zmianę Project Root Key 
(Klucza głównego projektu).

Transponowanie poszczególnych części lub zdarzeń za pomocą linii 
informacyjnej
Możesz transponować pojedyncze zdarzenia audio i partie MIDI w wierszu informacyjnym pola 
Transpose.

PROCEDURA
1. Wybierz zdarzenie lub partię, którą chcesz transponować.
2. W wierszu informacyjnym okna Project kliknij pole Transpose (Transponuj) i wprowadź  
     wartość transpozycji w półtonach.

UWAGA
Jeśli projekt zawiera już globalne zmiany transpozycji, przydatne może być włączenie opcji Keep 
Transpose in Octave Range (Zachowaj transpozycję w zakresie oktawy).

WYNIK
Zdarzenie jest odpowiednio transponowane. Wartość transpozycji jest dodawana do każdej 
globalnej zmiany transpozycji utworzonej za pomocą klucza głównego lub ścieżki transpozycji.

POWIĄZANE LINKI
Zachowaj transpozycję w zakresie oktaw na stronie 333
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Wykluczanie poszczególnych części lub wydarzeń z globalnej 
transpozycji
Jeśli dodasz transpozycję globalną, na przykład zmieniając klucz główny lub tworząc transpozycję
zdarzenia, możesz wykluczyć określone zdarzenia z transpozycji. Jest to przydatne dla bębnów i
pętle perkusyjne lub pętle efektów specjalnych (FX).

PROCEDURA
1. Wybierz zdarzenie lub partię, którą chcesz wykluczyć z transpozycji.
2. W wierszu informacyjnym kliknij pole Global Transpose (Transpozycja globalna), aby ustawić  
    wartość Independent (Niezależna).
    Zdarzenia wykluczone z globalnej transpozycji są oznaczone symbolem w prawym górnym rogu.

            

             

WYNIK
Jeśli zmienisz główny klucz projektu lub dodasz zdarzenia transpozycji, niezależne części lub 
zdarzenia nie zostaną naruszone.

UWAGA
Gotowe części lub zdarzenia, które są oznaczone jako perkusja lub FX, są automatycznie ustawiane 
na Independent (Niezależne).
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Markery
Znaczniki (markers) służą do szybkiego zlokalizowania określonych pozycji. Istnieją dwa rodzaje 
znaczników: znaczniki pozycji i znaczniki cyklu

Jeśli często przeskakujesz do określonej pozycji w projekcie, powinieneś wstawić znacznik w tym 
miejscu. Możesz także używać znaczników do wybierania zakresu lub powiększania.

Znaczniki znajdują się na ścieżce znaczników. Możesz dodać maksymalnie 10 znaczników ścieżek

Możesz pokazać pionowe linie znaczników, które wskazują pozycje znaczników na wszystkich 
ścieżkach w całym projekcie. Linie znaczników są pokazane w oknie Project i w sekcji Global 
Tracks (globalnych ścieżek) inspektora edytora kluczy (Key Editor Inspector).

POWIĄZANE LINKI
Znaczniki pozycji na stronie 336
Znaczniki cykli na stronie 336
Ścieżka znaczników na stronie 342
Nieprzezroczystość zdarzenia na stronie 1166
Wyświetlanie zdarzeń — znaczniki na stronie 1169
Pokazywanie/ukrywanie linii znaczników w oknie projektu na stronie 337
Wyświetlanie/ukrywanie linii znaczników w edytorze kluczy na stronie 338
Pokazywanie/ukrywanie poszczególnych ścieżek na stronie 66
Wyświetlanie/ukrywanie ścieżek globalnych w edytorze kluczy na stronie 854

Znaczniki pozycji
Znaczniki pozycji umożliwiają zapisanie określonej pozycji.

Znaczniki pozycji na ścieżce znaczników są pokazywane jako zdarzenia znaczników: pionowe linie
z opisem znacznika (jeśli jest przypisany) i numerem obok niego. Jeśli wybierzesz ścieżkę 
znacznika, wszystkie jej znaczniki zostaną pokazane w Inspektorze.

Znaczniki cyklu
Tworząc znaczniki cyklu, można zapisać dowolną liczbę pozycji lewego i prawego lokalizatora 
jako pozycję początkową i końcową zakresu i przywoływać je, klikając dwukrotnie odpowiedni 
znacznik.

Znaczniki cyklu są pokazywane na ścieżce znacznikowej jako dwa znaczniki połączone poziomą 
linią. Znaczniki cykli są idealne do zapisywania fragmentów projektu.

Na przykład definiując znaczniki cyklu dla wstępu, zwrotki i refrenu utworu, można szybko przejść 
do sekcji utworu i powtórzyć sekcję, aktywując opcję Activate Cycle (Aktywuj cykl) w panelu 
Transport.
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Ustawianie lokalizatorów za pomocą znaczników cykli
Znaczniki cykli reprezentują zakresy w twoim projekcie. Możesz ich użyć do przesunięcia lewego i 
prawego lokalizatora.

PROCEDURA
● Aby ustawić lewy lokalizator na początek znacznika cyklu, a prawy na koniec znacznika cyklu,  
   wykonaj jedną z następujących czynności:
         ● Kliknij dwukrotnie znacznik cyklu.
         ● Z wyskakującego menu Cycle (Cykl) na liście ścieżek wybierz znacznik cyklu.

WYNIK
Lewy i prawy lokalizator zostaną przesunięte, aby objąć znacznik cyklu.

PO WYKONANIU TEGO ZADANIA
Teraz możesz przesunąć pozycję kursora projektu na początek lub koniec znacznika cyklu, 
przesuwając go do odpowiedniego lokalizatora lub użyć znaczników cyklu do wyeksportowania 
określonych zakresów projektu za pomocą okna dialogowego Export Audio Mixdown (Eksportuj 
miks audio).

Edycja znaczników cykli

Podczas edycji znaczników cyklu na ścieżce znaczników uwzględniany jest skok.
● Aby dodać znacznik cyklu, naciśnij Ctrl/Cmd , kliknij i przeciągnij na ścieżce znacznika.
● Aby zmienić pozycję początkową/końcową znacznika cyklu, przeciągnij uchwyt 
początkowy/końcowy.
● Aby przesunąć znacznik cyklu w inne miejsce, przeciągnij górną granicę.
● Aby usunąć znacznik cyklu, kliknij narzędziem Erase (Wymaż). Jeśli podczas klikania 
przytrzymasz klawisz Alt/Opt, wszystkie kolejne znaczniki zostaną usunięte.
● Aby wyciąć zakres w znaczniku cyklu, zaznacz zakres w znaczniku cyklu i naciśnij Ctrl/Cmd -X
● Aby ustawić początek/koniec znacznika wybranego znacznika cyklu w pozycji kursora, wybierz 
Project > Markers (Projekt > Znaczniki), aby otworzyć okno Markers (Znaczniki), a następnie 
wybierz Functions > Set Marker Start/End to Cursor (Funkcje > Ustaw początek/koniec 
znacznika na kursor).
● Aby ustawić lewy i prawy lokalizator, kliknij dwukrotnie znacznik cyklu.
● Aby powiększyć znacznik cyklu, naciśnij klawisz Alt/Opt i kliknij dwukrotnie znacznik cyklu.

Pokazywanie/ukrywanie linii znaczników w oknie projektu
Możesz aktywować/dezaktywować pionowe linie znaczników, które wskazują pozycje znaczników 
na wszystkich ścieżkach w całym projekcie. Linie znaczników są wyświetlane na ekranie zdarzeń w
oknie Project. Domyślnie linie znaczników są wyświetlane dla aktywnej ścieżki znaczników.

WARUNEK WSTĘPNY
● Dodałeś do swojego projektu co najmniej jedną ścieżkę znacznika i jeden znacznik.
● Ścieżka znacznika jest widoczna i nie jest odfiltrowywana na karcie Visibility (Widoczność).

PROCEDURA
● Na liście ścieżek okna projektu kliknij prawym przyciskiem myszy ścieżkę znaczników i wybierz
opcję z menu Show Marker Lines (Pokaż linie znaczników). 
Możesz pokazać linie znaczników aktywnej ścieżki znaczników, wszystkich ścieżek znaczników 
lub możesz je ukryć.
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WYNIK
Na ekranie zdarzeń w oknie Project linie znaczników są wyświetlane zgodnie z wybranymi 
ustawieniami.

UWAGA
Opcje Show Marker Lines (Pokaż linie znaczników) są również dostępne w oknie dialogowym 
Preferences (Preferencje) (strona Event Display – Markers (Wyświetlanie zdarzeń — Znaczniki)).

Linie znaczników są wyświetlane za innymi zdarzeniami na innych ścieżkach. Jeśli potrzebujesz 
wyraźniejszego wskazania linii, rozważ obniżenie opcji Event Opacity (Krycie zdarzenia) w oknie 
dialogowym Preferences (Preferencje) (strona Event Display (Wyświetlanie zdarzenia)).

POWIĄZANE LINKI
Wyświetlanie zdarzeń — znaczniki na stronie 1169

Pokazywanie/ukrywanie linii znaczników w edytorze kluczy Key 
Editor
Możesz aktywować/dezaktywować pionowe linie znaczników, które wskazują pozycje znaczników 
na wszystkich ścieżkach w całym projekcie. Linie znaczników są wyświetlane na ekranie zdarzeń 
dla ścieżek globalnych w Key Editor (Edytor kluczy). Domyślnie linie znaczników są wyświetlane 
dla aktywnej ścieżki znaczników.

WARUNEK WSTĘPNY
● Dodałeś do swojego projektu co najmniej jedną ścieżkę znacznika i jeden znacznik.
● Ścieżka znacznika jest widoczna i nie jest odfiltrowywana na karcie Visibility (Widoczność).

PROCEDURA
1. W Key Editor Inspector (Inspektor edytora kluczy) aktywuj sekcję Global Tracks.
2. Na liście ścieżek w sekcji Global Tracks (Ścieżki globalne) aktywuj jedną lub więcej ścieżek 
    znaczników (marker tracks).
3. Na liście ścieżek okna projektu kliknij prawym przyciskiem myszy ścieżkę znaczników i wybierz
    opcję z menu Show Marker Lines (Pokaż linie znaczników).
    Możesz pokazać linie znaczników dla aktywnej ścieżki znaczników, dla wszystkich ścieżek 
    znaczników lub możesz je ukryć.

WYNIK
W widoku zdarzeń dla globalnych ścieżek w Key Editor (Edytorze kluczy) linie znaczników są 
wyświetlane zgodnie z Twoimi ustawieniami.

UWAGA
Opcje Show Marker Lines (Pokaż linie znaczników) są również dostępne w oknie dialogowym 
Preferences (Preferencje) (strona Event Display— Markers (Wyświetlanie zdarzeń — 
Znaczniki)).

Linie znaczników są wyświetlane za innymi zdarzeniami na innych ścieżkach. Jeśli potrzebujesz 
wyraźniejszego wskazania linii, rozważ obniżenie opcji Event Opacity (Krycie zdarzenia) w oknie 
dialogowym Preferences (Preferencje) (strona Event Display (Wyświetlanie zdarzenia)).

POWIĄZANE LINKI
Wyświetlanie zdarzeń — znaczniki na stronie 1169
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Okno znaczników
W oknie Markers (Znaczniki) możesz przeglądać i edytować znaczniki. Znaczniki na aktywnej 
ścieżce znaczników są wyświetlane na liście znaczników w kolejności, w jakiej występują w 
projekcie.

Aby otworzyć okno Markers (Znaczniki), masz następujące możliwości:
● Wybierz Project > Markers (Projekt > Znaczniki).
● W panelu Transport w sekcji znaczników kliknij Show (Pokaż).
● Użyj komendy klawiszowej (domyślnie Ctrl/Cmd - M).

Set focus to marker track (Ustaw ostrość na ścieżkę znacznika)
        Umożliwia wybranie ścieżki znacznika, na której znajduje się fokus.
Functions menu (Menu funkcji)
        Wyświetla listę wszystkich funkcji dostępnych w oknie Marker (Znacznik).
Filter Markers (Filtruj znaczniki)
        Umożliwia określenie, który typ znacznika ma być wyświetlany na liście znaczników.
Auto-Scroll with Project Cursor (Automatyczne przewijanie za pomocą kursora projektu)
        Umożliwia śledzenie strzałki lokalizacji, nawet jeśli projekt zawiera dużą liczbę znaczników.  
        Jeśli ta opcja jest włączona, okno Marker (Znacznik) jest automatycznie przewijane, aby    
        strzałka lokalizacji była widoczna.
Markers list (Lista znaczników)
        Wyświetla znaczniki w kolejności, w jakiej występują w projekcie.
Marker Settings (Ustawienia znacznika)
        Pokazuje ustawienia znacznika.

Edycja w oknie znaczników Markers Window
W oknie Markers (Znaczniki) możesz wybierać, edytować, dodawać, przenosić i usuwać 
znaczniki.
● Aby wybrać lub edytować znacznik, kliknij go. Zaznacz wiele znaczników, klikając je z 
klawiszem Shift — lub Ctrl/Cmd.
● Aby dodać znacznik pozycji w miejscu kursora, wybierz Functions > Insert Marker (Funkcje > 
Wstaw znacznik).
Znacznik pozycji jest dodawany w bieżącej pozycji kursora projektu na aktywnej ścieżce 
znaczników.
● Aby dodać znacznik cyklu w miejscu kursora, wybierz Functions > Insert Cycle Marker 
(Funkcje > Wstaw znacznik cyklu). Spowoduje to dodanie znacznika cyklu między lewym i 
prawym lokalizatorem na aktywnej ścieżce znaczników.
● Aby przesunąć znacznik do pozycji kursora, zaznacz go i wybierz  Functions > Move Markers 
to Cursor (Funkcje > Przenieś znaczniki do kursora).
Nową pozycję można również wprowadzić numerycznie w kolumnie Position (Pozycja). Jeśli 
wybrany jest znacznik cyklu, operacja przesuwania wpływa na pozycję początkową znacznika 
cyklu.
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● Aby przenieść znaczniki na inną ścieżkę, zaznacz znaczniki, wybierz kolejno Functions > Move 
Markers to Track (Funkcje > Przenieś znaczniki na ścieżkę), a następnie wybierz ścieżkę 
znacznika.
● Aby usunąć znacznik, zaznacz go i wybierz Functions > Remove Marker (Funkcje > Usuń 
znacznik)

Poruszanie się po liście znaczników
Możesz poruszać się po liście znaczników za pomocą klawiatury komputera i wybierać wpisy, 
naciskając klawisz Return. Jest to szybki i łatwy sposób na przeskakiwanie do znaczników podczas
odtwarzania lub nagrywania.

● Aby przejść do poprzedniego/następnego znacznika na liście, naciśnij klawisze Strzałka w górę /
   Strzałka w dół.
● Aby przejść do pierwszego/ostatniego znacznika, naciśnij klawisze Page Up / Page Down.

Sortowanie i zmiana kolejności na liście znaczników
Możesz dostosować sposób wyświetlania atrybutów znaczników na liście znaczników, sortując lub 
zmieniając kolejność kolumn.

● Aby posortować listę znaczników według określonego atrybutu, kliknij odpowiedni nagłówek 
kolumny.
● Aby zmienić kolejność atrybutów znaczników, przeciągnij i upuść odpowiednie nagłówki 
kolumn.
● Aby dostosować szerokość kolumny, umieść wskaźnik myszy między dwoma nagłówkami 
kolumn i przeciągnij w lewo lub w prawo.
UWAGA
Bez względu na to, według jakiego atrybutu sortujesz, drugim kryterium sortowania zawsze będzie 
atrybut pozycji.

Ustawienia znacznika
Możesz wprowadzić ogólne ustawienia znaczników dla swojego projektu.
● Aby otworzyć ustawienia znaczników, wybierz Project > Markers (Projekt > Znaczniki) 

   i kliknij Marker Settings    (Ustawienia znaczników).

Cycle follows when locating to Markers (Cykl następuje podczas lokalizowania znaczników)
         Spowoduje to automatyczne ustawienie lewego i prawego lokalizatora na znacznik pozycji lub
         cyklu podczas lokalizowania tego znacznika. Jest to przydatne, jeśli chcesz ustawić 
         lokalizatory w locie podczas nagrywania, na przykład w trybie Punch In/Punch Out.
Show marker IDs on marker track (Pokaż identyfikatory znaczników na ścieżce znaczników)
         Jeśli ta opcja jest aktywna, identyfikatory znaczników są wyświetlane na ścieżce znaczników.
Sync Selection (Wybór synchronizacji)
         Jeśli ta opcja jest aktywna, wybór okna Markers (Znaczniki) jest powiązany z wyborem w  
         oknie Project.

Atrybuty znaczników
Atrybuty znaczników są pokazane na liście znaczników w oknie Markers (Znaczniki).
● Aby otworzyć okno Markers (Znaczniki), wybierz Project > Markers (Projekt > Znaczniki).
Dostępne są następujące atrybuty:

Locate (Znajdź)
Strzałka wskazuje, który znacznik znajduje się w pozycji kursora projektu (lub najbliżej kursora 
projektu). Jeśli klikniesz w tej kolumnie, kursor projektu zostanie przeniesiony do odpowiedniej 
pozycji znacznika. Tej kolumny nie można ukryć.
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ID
        Ta kolumna zawiera numery identyfikacyjne znaczników.
Position (Pozycja)
        W tej kolumnie można przeglądać i edytować pozycje czasowe znaczników (lub pozycje 
        początkowe znaczników cykli). Tej kolumny nie można ukryć.
End (Koniec)
       W tej kolumnie można przeglądać i edytować pozycje końcowe znaczników cykli.
Length (Długość)
        W tej kolumnie można przeglądać i edytować długość znaczników cyklu.
Description (Opis)
        Tutaj możesz wprowadzić nazwy lub opisy znaczników.

POWIĄZANE LINKI
Identyfikatory znaczników na stronie 341
Znaczniki cykli na stronie 336

Edycja atrybutów
● Aby edytować atrybut znacznika, wybierz odpowiedni znacznik, kliknij żądaną kolumnę atrybutu
i wprowadź zmiany.
● Aby zmienić atrybuty kilku znaczników, wybierz znaczniki i zaznacz pole wyboru dla atrybutu.

Wszystkie wybrane znaczniki odpowiednio zmienią swoje atrybuty. Należy zauważyć, że nie działa
to po kliknięciu wartości kodu czasowego lub pola tekstowego.

UWAGA:
Aby poruszać się po liście atrybutów znaczników, możesz także użyć klawisza Tab oraz klawiszy 
Strzałka w górę , Strzałka w dół , Strzałka w lewo i Strzałka w prawo.

Sortowanie i zmiana kolejności kolumn
Możesz dostosować sposób wyświetlania atrybutów znaczników na liście znaczników, sortując lub 
zmieniając kolejność kolumn.

● Aby posortować listę znaczników według określonego atrybutu, kliknij odpowiedni nagłówek 
kolumny.

UWAGA:
Bez względu na to, według jakiego atrybutu sortujesz, drugim kryterium sortowania zawsze będzie 
atrybut pozycji.

● Aby zmienić kolejność atrybutów znaczników, przeciągnij i upuść odpowiednie nagłówki 
kolumn.
● Aby dostosować szerokość kolumny, umieść wskaźnik myszy między dwoma nagłówkami 
kolumn i przeciągnij w lewo lub w prawo.

Identyfikatory znaczników
Za każdym razem, gdy dodajesz znacznik, jest mu automatycznie i sekwencyjnie przypisywany 
numer identyfikacyjny, zaczynając od 1.

Identyfikatory znaczników cykli są pokazane w nawiasach i zaczynają się od 1 . Numery 
identyfikacyjne można zmienić w dowolnym momencie – pozwala to na przypisanie określonych 
znaczników do poleceń klawiaturowych.
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UWAGA
Jeśli przesuniesz znacznik z jednej ścieżki znacznika na drugą metodą przeciągnij i upuść w oknie 
Project, a identyfikator znacznika jest już używany na tej ścieżce, wstawiony znacznik 
automatycznie otrzyma nowy identyfikator.

Ponowne przypisywanie identyfikatorów znaczników
Czasami, zwłaszcza podczas ustawiania znaczników w locie, możesz zapomnieć lub przegapić 
ustawienie znacznika. Po dodaniu później identyfikator tego znacznika nie będzie odpowiadał jego 
pozycji na ścieżce znaczników. Dlatego możliwe jest ponowne przypisanie identyfikatorów dla 
wszystkich znaczników na ścieżce.

PROCEDURA
1. Otwórz okno Markers (Znaczniki).
2. Wybierz ślad znacznika, którego numery identyfikacyjne chcesz ponownie przypisać.
3. Otwórz wyskakujące menu Functions (Funkcje) i wybierz opcję Reassign Position Marker IDs 
(Przypisz ponownie identyfikatory znaczników pozycji) lub Reassign Cycle Marker IDs (Przypisz
ponownie identyfikatory znaczników cykli).

WYNIK
Identyfikatory znaczników wybranego typu są ponownie przypisywane, aby odpowiadały 
kolejności znaczników na ścieżce znaczników.

Ścieżka znaczników (Marker Track)
Ścieżka znaczników służy do dodawania i edytowania znaczników.

            

1  Add Marker (Dodaj znacznik)
         Dodaje znacznik pozycji w miejscu kursora.
2  Add Cycle Marker (Dodaj znacznik cyklu)
         Dodaje znacznik cyklu w miejscu kursora.
3  Locate pop-up menu (Zlokalizuj wyskakujące menu)
         Jeśli wybierzesz pozycję lub znacznik cyklu w tym wyskakującym menu, zostanie wybrany 
odpowiedni znacznik w widoku zdarzenia lub w oknie Markers (Znaczniki).
4  Activate this track (Aktywuj tą ścieżkę)
         Aktywuje ścieżkę znacznika.
5  Cycle pop-up menu (Cykliczne menu podręczne)
         Jeśli wybierzesz znacznik cyklu w tym wyskakującym menu, lewy i prawy lokalizator zostaną
         ustawione na odpowiedni znacznik cyklu.
6  Zoom pop-up menu (Wyskakujące menu powiększenia)
         Jeśli wybierzesz znacznik cyklu w tym menu podręcznym, widok powiększy się do 
         odpowiedniego znacznika cyklu.
7  Toggle Time Base (Przełącz podstawę czasu)
         Ustawia podstawę czasu ścieżki.
8  Lock (Blokada)
         Blokuje ścieżkę znacznika. Gdy ścieżka znaczników jest zablokowana, nie można edytować 
         ścieżki ani jej znaczników.
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9  Marker event (inactive) (Zdarzenie znacznika (nieaktywne))
         Pokazuje nieaktywne zdarzenie znacznika.
10  Marker event (active) (Zdarzenie znacznika (aktywne))
         Pokazuje aktywne zdarzenie znacznika.
11  Cycle marker event (inactive) (Zdarzenie znacznika cyklu (nieaktywne))
         Pokazuje nieaktywne zdarzenie znacznika cyklu.
12  Cycle marker event (active) (Zdarzenie znacznika cyklu (aktywne))
         Pokazuje aktywne zdarzenie znacznika cyklu.

Dodawanie, przesuwanie i usuwanie ścieżki znaczników
Możesz dodawać, przesuwać i usuwać ścieżkę znacznika.

● Aby dodać znacznik do projektu, wybierz kolejno Project > Add Track > Marker (Projekt > 
Dodaj ścieżkę > Znacznik).
● Aby przenieść znacznik ścieżki w inne miejsce na liście utworów, kliknij i przeciągnij go w górę 
lub w dół.
● Aby usunąć jedną lub więcej ścieżek-znaczników, kliknij je prawym przyciskiem myszy na liście 
ścieżek i wybierz Remove Selected Tracks (Usuń wybrane ścieżki).
● Aby usunąć pusty ślad znacznika, wybierz Project > Remove Empty Tracks (Projekt > Usuń 
puste ścieżki).
Spowoduje to również usunięcie wszystkich innych pustych ścieżek.

UWAGA
Gdy usuniesz wszystkie ścieżki znaczników, ostatnia usunięta ścieżka znaczników (wraz ze 
wszystkimi jej znacznikami) zostanie przeniesiona do schowka. Jeśli później wstawisz nową 
ścieżkę znacznika, ścieżka ta zostanie wklejona ze schowka do listy ścieżek.

Wiele ścieżek znaczników
Możesz utworzyć do 10 ścieżek znaczników.

Nazewnictwo ścieżek znaczników
Domyślnie pierwsza tworzona ścieżka znaczników nosi nazwę „Markers” („Znaczniki”), druga 
„Marker 01” („Znacznik 01”) i tak dalej.

Możesz nazwać ścieżki znaczników, klikając dwukrotnie nazwę ścieżki znacznika na liście ścieżek 
lub w Inspektorze i wprowadzając nową nazwę.

Aktywna ścieżka znaczników
Podczas pracy z wieloma ścieżkami znaczników aktywna jest tylko jedna ścieżka. Wszystkie 
funkcje edycyjne mają wpływ tylko na znaczniki na aktywnej ścieżce. Aby aktywować ścieżkę, 
kliknij opcję Activate this track (Aktywuj tę ścieżkę) na liście ścieżek.

Obowiązują następujące zasady:

● Po dodaniu nowej ścieżki znacznika, ścieżka ta jest automatycznie aktywna.
● Gdy usuniesz aktywny utwór, aktywowany zostanie najwyższy znacznik na liście utworów. 
Podczas używania znaczników cykli do powiększania, w wyskakującym menu Zoom 
(Powiększenie) wyświetlane są tylko znaczniki cykli aktywnej ścieżki.
● Podczas eksportowania miksu audio między znacznikami cykli, w oknie dialogowym Export 
Audio Mixdown (Eksportuj miks audio) wyświetlane są tylko znaczniki cykli aktywnej ścieżki.
● Większość poleceń klawiszowych znacznika wpływa na aktywną ścieżkę.

346



Blokowanie ścieżek znaczników

Możesz zablokować jedną lub więcej ścieżek znaczników, klikając odpowiedni przycisk blokady 
ścieżki. Gdy ścieżka znaczników jest zablokowana, nie można edytować ścieżki ani jej znaczników.
Jednak nadal możesz zmienić nazwę ścieżki lub zmienić jej status (aktywna/nieaktywna). W oknie 
Markers (Znaczniki) i Przeglądarce projektu niedostępne funkcje zablokowanej ścieżki są 
wyszarzone.

POWIĄZANE LINKI
Edycja znaczników cykli na stronie 337
Importowanie i eksportowanie znaczników na stronie 344

Edycja znaczników na ścieżce znaczników
Możesz edytować znaczniki na ścieżce znaczników.

● Aby dodać znacznik pozycji, kliknij Add Marker (Dodaj znacznik) lub użyj narzędzia Draw   
   (Rysuj).
● Aby dodać znacznik cyklu, kliknij Add Cycle Masrker (Dodaj znacznik cyklu) lub użyj 
   narzędzia Draw (Rysuj).
● Aby wybrać znacznik, użyj standardowych technik.
● Aby zmienić rozmiar znacznika cyklu, zaznacz go i przeciągnij uchwyty. Możesz to również 
   zrobić numerycznie w linii informacyjnej.
● Aby przesunąć znacznik, zaznacz go i przeciągnij. Możesz także edytować pozycje znaczników  
   w wierszu informacyjnym. Jeśli przesuniesz znaczniki z jednego toru na drugi, znacznik otrzyma 
   numerację pierwszego wolnego identyfikatora znacznika na torze, na który został upuszczony.
● Aby usunąć znacznik, zaznacz go i naciśnij klawisz Delete (Usuń) lub użyj narzędzia Erase 
   (Wymaż).

POWIĄZANE LINKI
Ścieżka znaczników na stronie 342

Używanie znaczników do wybierania zakresów
Markerów można używać w połączeniu z narzędziem Range Selection (Zaznaczanie zakresu), aby 
dokonywać wyborów zakresu w oknie Project. Jest to przydatne, jeśli chcesz szybko dokonać 
wyboru obejmującego wszystkie ścieżki w projekcie.

PROCEDURA
1. Ustaw znaczniki na początku i na końcu sekcji, którą chcesz przenieść lub skopiować.
2. Wybierz narzędzie Range Selection (Zaznaczanie zakresu) i kliknij dwukrotnie ścieżkę 
    znacznika między znacznikami. Wybrano wszystko w projekcie w granicach znacznika.   
    Wszelkie wykonywane funkcje lub przetwarzanie mają teraz wpływ tylko na zaznaczenie.
3. Kliknij ścieżkę znacznika w wybranym zakresie i przeciągnij zakres do nowej pozycji. Jeśli 
    przytrzymasz klawisz Alt/Opt podczas przeciągania zakresu, zamiast tego zostanie skopiowane 
    zaznaczenie w oknie Project.

Importowanie i eksportowanie znaczników
Znaczniki i ślady znaczników można importować i eksportować.

Następujące pliki mogą zawierać znaczniki:

● Pliki MIDI
● Ścieżki archiwalne
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Importowanie znaczników przez MIDI
Znaczniki pozycji można importować, importując pliki MIDI zawierające znaczniki. Jest to 
przydatne, jeśli chcesz użyć swoich znaczników w innych projektach lub jeśli chcesz podzielić się 
nimi z innymi użytkownikami Cubase. Wszelkie dodane znaczniki są uwzględniane w pliku MIDI 
jako standardowe zdarzenia znaczników pliku MIDI.

● Aktywuj Import Markers (Znaczniki importu) w oknie dialogowym Preferences (Preferencje) 
(strona MIDI — MIDI File (plik MIDI)).

Importowane są następujące ustawienia:
● Pozycja początkowa znaczników pozycji i znaczników cykli
● Przypisanie ścieżek znaczników
● Wszystkie ścieżki znaczników

UWAGA
Jeśli zaimportujesz standardowy plik MIDI utworzony w innych aplikacjach, wszystkie znaczniki 
zostaną scalone na jednej ścieżce znaczników.

POWIĄZANE LINKI
Importowanie plików MIDI na stronie 292

Eksport znaczników przez MIDI
Możesz wyeksportować swoje znaczniki jako część pliku MIDI.

● Aby dołączyć dowolne znaczniki do pliku MIDI, aktywuj Export Markers (Eksportuj znaczniki)
w oknie dialogowym Export Options (Opcje eksportu).

Eksportowane są następujące ustawienia:
● Pozycja początkowa znaczników pozycji i znaczników cykli
● Przypisanie ścieżek znaczników
● Wszystkie ścieżki znaczników

UWAGA
Aby móc eksportować znaczniki poprzez eksport MIDI, Twój projekt musi zawierać co najmniej 
jedną ścieżkę znaczników.

POWIĄZANE LINKI
Eksportowanie ścieżek MIDI jako standardowych plików MIDI na stronie 168

Importowanie znaczników jako części ścieżki archiwalnej (Track 
Archive)
Możesz importować znaczniki pozycji i znaczniki cykli, importując archiwa ścieżek zawierające 
ścieżki znaczników. Wybierz ścieżki, które chcesz zaimportować w oknie dialogowym Import 
Options (Opcje importu).

Importowane są następujące ustawienia:
● Początkowa i końcowa pozycja znaczników cyklu
● Przypisanie ścieżek znaczników
● Identyfikatory znaczników
● Wszystkie ścieżki znaczników
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POWIĄZANE LINKI
Importowanie ścieżek z archiwów ścieżek na stronie 164

Eksportowanie znaczników jako części archiwum ścieżek

Jeśli chcesz wykorzystać ścieżki znaczników w innych projektach, na przykład w celu 
udostępnienia ich innym użytkownikom, możesz je wyeksportować jako część archiwum ścieżek. 
W tym celu zaznacz ścieżki znaczników, które chcesz wyeksportować. Następnie wybierz File > 
Export > Selected Tracks (Plik > Eksportuj > Wybrane ścieżki).

Eksportowane są następujące ustawienia:
● Początkowa i końcowa pozycja znaczników cyklu.
● Przypisanie ścieżek znaczników.
● Identyfikatory znaczników.
● Wszystkie ścieżki znaczników.

POWIĄZANE LINKI
Eksport ścieżek na stronie 167
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MixConsole  (konsola mikserska)

MixConsole zapewnia wspólne środowisko do tworzenia miksów w trybie stereo lub surround. 
Pozwala kontrolować poziom, panoramę, status solo/mute itp. dla kanałów audio i MIDI. Co 
więcej, możesz skonfigurować routing wejścia i wyjścia dla wielu ścieżek lub kanałów 
jednocześnie. W każdej chwili możesz cofnąć/ponowić zmiany parametrów MixConsole dla 
otwartego projektu.

Możesz otworzyć MixConsole w osobnym oknie lub w dolnej strefie okna Project.

Podczas gdy MixConsole w dolnej strefie okna Project zawiera kluczowe funkcje do miksowania, 
oddzielne okno MixConsole daje dostęp do dodatkowych funkcji i ustawień.

POWIĄZANE LINKI
MixConsole w dolnej strefie na stronie 347
Okno MixConsole na stronie 349

MixConsole w dolnej strefie
Możesz pokazać MixConsole w dolnej strefie okna Project. Jest to przydatne, jeśli chcesz uzyskać 
dostęp do najważniejszych funkcji MixConsole z określonej strefy okna projektu. MixConsole 
w dolnej strefie okna Project jest oddzielną konsolą MixConsole, która nie śledzi żadnych zmian 
widoczności wprowadzanych w oknie MixConsole.

Aby otworzyć MixConsole w dolnej strefie okna Project, wykonaj jedną z poniższych czynności:
● Naciśnij Alt/Opt - F3 .
● Wybierz Studio > MixConsole in Project Window (Studio > MixConsole w oknie projektu).

MixConsole w dolnej strefie okna Project jest podzielona na następujące sekcje:

          

1  Page selector (Selektor stron)
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Pozwala wybrać, która strona ma być wyświetlana w sekcji suwaków: suwaki kanałów, efekty 
wstawiania dla kanału lub efekty wysyłania. Górny przycisk pozwala pokazać/ukryć pasek 
narzędzi.

2  Toolbar (Pasek narzędzi)
         Pasek narzędzi pokazuje narzędzia i skróty do ustawień i funkcji w MixConsole.
3  Fader section (Sekcja tłumików, suwaków)
         Sekcja tłumików jest zawsze widoczna i pokazuje wszystkie kanały w takiej samej kolejności,
         jak na liście ścieżek.

POWIĄZANE LINKI
Sekcja suwaków na stronie 375
Wstawki na stronie 386
Wysyłki na stronie 397
Filtrowanie typów kanałów na stronie 365
Cofanie/ponawianie zmian parametrów MixConsole na stronie 361
Łączenie kanałów na stronie 369
Menu funkcji na stronie 373

Pokazywanie/ukrywanie kanałów MixConsole w dolnej strefie
Aby określić, które kanały są widoczne w MixConsole w dolnej strefie okna Project, należy 
skorzystać z zakładki Visibility (Widoczność) w lewej strefie okna Project.

PROCEDURA
1. Kliknij (Pokaż/ukryj lewą strefę) na pasku narzędzi okna Project, aby aktywować lewą strefę.
2. W górnej części lewej strefy kliknij kartę Visibility (Widoczność).
3. W dolnej części lewej strefy kliknij kartę Track (Ścieżka).

                

4. Kliknij po lewej stronie nazwy ścieżki, aby włączyć/wyłączyć widoczność kanału.
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WYNIK
Ścieżka na liście ścieżek i odpowiadający jej kanał MixConsole są pokazywane/ukrywane w dolnej
strefie okna Project.

POWIĄZANE LINKI
Otwieranie widoczności na stronie 65
Pokazywanie/ukrywanie poszczególnych utworów na stronie 66
Widoczność na stronie 64

Określanie kolejności kanałów MixConsole w dolnej strefie
Możesz określić i zablokować pozycję kanałów MixConsole w dolnej strefie okna Project.

PROCEDURA
1. W górnej części lewej strefy kliknij kartę Visibility (Widoczność).
2. W dolnej części lewej strefy kliknij kartę Zones (Strefy).

          

3. Wykonaj jedną z następujących czynności:
● Aby zablokować kanał po lewej stronie sekcji suwaków, kliknij lewą kropkę obok nazwy kanału.
● Aby zablokować kanał po prawej stronie sekcji suwaków, kliknij prawą kropkę obok nazwy 
    kanału.

WYNIK
Kanał jest zablokowany. Zablokowane kanały są zawsze wyświetlane.

POWIĄZANE LINKI
Otwieranie stref na stronie 67

Okno MixConsole
Możesz otworzyć MixConsole w osobnym oknie.
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Aby otworzyć MixConsole, wykonaj jedną z następujących czynności:
● Naciśnij klawisz F3

● Wybierz Studio > MixConsole.
● Na pasku narzędzi okna Project kliknij Open MixConsole (Otwórz MixConsole).

UWAGA
Jest to widoczne na pasku narzędzi tylko wtedy, gdy aktywna jest sekcja e Media & MixConsole 
Windows (Windows Media & MixConsole).

MixConsole jest podzielony na następujące sekcje:

1  Toolbar (Pasek narzędzi)
         Pasek narzędzi pokazuje narzędzia i skróty do ustawień i funkcji w MixConsole.
2  Left Zone (Lewa strefa)
W lewej strefie znajdują się następujące zakładki:
● Zakładka Visibility (Widoczność) z następującymi zakładkami:
            ● Zakładka Channel (Kanał) umożliwia pokazywanie/ukrywanie poszczególnych kanałów 
               w MixConsole.
            ● Zakładka Zones (Strefy) umożliwia określenie i zablokowanie pozycji niektórych 
                kanałów MixConsole
● Zakładka History (Historia) zawiera listę wszystkich zmian parametrów MixConsole 
   i umożliwia cofnięcie/ponowne wykonanie określonych zmian.
● Zakładka Snapshots (Migawki) zawiera listę wszystkich migawek ustawień MixConsole 
   i umożliwia przywołanie ich później.
3  Fader Section (Sekcja tłumików, suwaków)
         Sekcja tłumików jest zawsze widoczna i pokazuje wszystkie kanały w takiej samej kolejności,
         jak na liście ścieżek

353



Oprócz głównych sekcji możesz również uzyskać dostęp do następujących sekcji z poziomu okna 
MixConsole:

1  Channel overview (Przegląd kanałów)
        Wyświetla wszystkie kanały jako ramki. Jeśli masz więcej kanałów, niż można wyświetlić w 
        oknie, możesz użyć przeglądu kanałów, aby przejść do innych kanałów i je wybrać.
2  Meter bridge (mostek pomiarowy)
        Umożliwia monitorowanie poziomów kanałów.
        Aby wybrać typ miernika, otwórz menu kontekstowe mostka pomiarowego i wybierz opcję   
        PPM lub Wave (Fala).
3  Equalizer curves (krzywe korektora)
        Umożliwia narysowanie krzywej EQ. Kliknij w widoku krzywej, aby otworzyć większy  
        widok, w którym możesz edytować punkty krzywej.
4  Channel racks (stojaki kanałowe)
        Umożliwia wyświetlenie dodatkowych elementów sterujących kanałem w razie potrzeby.
5  Pictures (Zdjęcia)
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        Umożliwia dodanie obrazu do wybranego kanału. Zdjęcia mogą pomóc w szybkiej 
        identyfikacji kanałów MixConsole.

6  Notepads (Notatniki)
         Umożliwia wprowadzanie uwag i komentarzy na temat kanału. Każdy kanał ma swój własny 
         notatnik.
7  Channel Latencies (Opóźnienia kanałów)
         Umożliwia pokazanie opóźnień spowodowanych efektami insertowymi lub modułami channel
         Strip (listwa kanałowa).
8  Control Room/Meter (Right Zone) (Pomieszczenie kontrolne/miernik (prawa strefa))
         Umożliwia podzielenie środowiska studyjnego na strefę wykonawczą (studio) i strefę  
         inżyniera/producenta (pomieszczenie kontrolne).

POWIĄZANE LINKI
MixConsole Lewa strefa na stronie 352
Pasek narzędzi MixConsole na stronie 355
Pasek narzędzi okna projektu na stronie 46
Sekcja suwaków na stronie 375
Selektor stojaków kanałowych na stronie 367
Ścieżkowa przeglądarka zdjęć na stronie 175
Dodawanie nut do kanału MixConsole na stronie 402
Przegląd opóźnienia kanału na stronie 403
Pomieszczenie kontrolne na stronie 425
Miernik główny na stronie 437
Miernik głośności na stronie 439
Paski kanałów na stronie 390

Lewa strefa MixConsole
Lewa strefa MixConsole zawiera kilka zakładek, które umożliwiają zmianę widoczności i pozycji 
określonych kanałów, cofanie zmian parametrów lub zapisywanie migawek MixConsole.

● Aby pokazać/ukryć lewą strefę MixConsole, kliknij Show/Hide Left Zone (Pokaż/Ukryj lewą 
strefę) na pasku narzędzi okna MixConsole.

                 

W górnej części lewej strefy dostępne są następujące zakładki:
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Visibility (Widoczność)
          Wyświetla listę wszystkich kanałów zawartych w projekcie i umożliwia 
           pokazywanie/ukrywanie określonych kanałów.

History (Historia)
         Wyświetla listę wszystkich zmian parametrów B i umożliwia cofanie/ponawianie  
         określonych zmian.
Snapshots (Migawki)
         Wyświetla listę wszystkich zapisanych migawek MixConsole i umożliwia przywoływanie 
         migawek.

W dolnej części lewej strefy dostępne są następujące zakładki:

Channel (Kanał)
          Wyświetla listę wszystkich kanałów zawartych w projekcie.
Zones (Strefy)
          Umożliwia zablokowanie pozycji określonych kanałów.

POWIĄZANE LINKI
Cofanie/ponawianie zmian parametrów MixConsole na stronie 361
Pasek narzędzi MixConsole na stronie 355

Widoczność MixConsole
Zakładka Visibility (Widoczność) w MixConsole zawiera listę wszystkich kanałów zawartych w 
twoim projekcie i pozwala pokazać/ukryć określone kanały.

             

● Aby pokazać/ukryć kanały, zaznacz je/odznacz klikając po lewej stronie nazwy kanału.
● Aby zwinąć/rozwinąć grupy i foldery, kliknij nazwę grupy lub folderu.

UWAGA
MixConsole w dolnej strefie okna Project nie śledzi żadnych zmian widoczności, które 
wykonujesz w oknie MixConsole i odwrotnie.

POWIĄZANE LINKI
Synchronizacja widoczności kanału i ścieżki na stronie 353

Synchronizacja widoczności kanału i ścieżki
Możesz zsynchronizować widoczność kanału w MixConsole z widocznością ścieżki w oknie 
Project.

PROCEDURA
1. W lewej strefie MixConsole otwórz zakładkę Visibility (Widoczność).
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2. Kliknij Sync Visibility of Project and MixConsole: On/Off   (Synchronizuj widoczność 
    projektu i MixConsole: Wł./Wył).
3. Wybierz Sync Project i MixConsole, aby zsynchronizować widoczność kanału z widocznością 
    ścieżki.

WYNIK
Widoczność ścieżki i kanału jest zsynchronizowana.

UWAGA
Kanały zablokowane na karcie Zones (Strefy) nie są synchronizowane.

POWIĄZANE LINKI
Widoczność MixConsole na stronie 353
Synchronizacja widoczności ścieżki i kanału na stronie 67

Strefy MixConsole
Karta Zones (Strefy) zawiera listę wszystkich kanałów zawartych w projekcie i umożliwia 
zablokowanie pozycji określonych kanałów.

                       

● Aby zablokować kanały po lewej/prawej stronie sekcji tłumika, kliknij lewą lub prawą kropkę 
    obok nazwy kanałów.
    Zablokowane kanały są wyłączone z przewijania. Zawsze są widoczne.

UWAGA
MixConsole w dolnej strefie okna Project nie śledzi żadnych zmian widoczności, które 
wykonujesz w oknie MixConsole i odwrotnie.

Historia MixConsole
Karta History (Historia) zawiera listę wszystkich zmian parametrów MixConsole i umożliwia 
cofnięcie/ponowne wykonanie określonych zmian.
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● Aby cofnąć działania parametrów MixConsole, kliknij pomarańczową linię na liście historii i 
przeciągnij ją w górę.
● Aby ponownie wykonać działania parametrów MixConsole, kliknij pomarańczową linię na liście 
historii i przeciągnij ją w dół

UWAGA
Możesz także cofać/ponawiać działania parametrów MixConsole, używając odpowiednich 
przycisków na pasku narzędzi MixConsole.

POWIĄZANE LINKI
Cofanie/ponawianie zmian parametrów MixConsole na stronie 361
Migawki MixConsole na stronie 355

Migawki MixConsole

Zakładka Snapshots (Migawki) zawiera listę wszystkich migawek ustawień MixConsole i 
umożliwia przywołanie ich później. Jest to przydatne, jeśli chcesz porównać różne wersje miksu.

W Cubase możesz zapisać do 10 migawek dla kanałów związanych z audio. Te ustawienia zapisują 
ustawienia wejścia/wyjścia, audio, instrumentu VST, ścieżki samplera, grupy, kanałów FX i 
suwaków VCA. Migawki są zapisywane wraz z projektem.

                        

● Aby przywołać konkretną migawkę MixConsole, zaznacz ją na liście i kliknij Recall Snapshot x

       (Wywołaj migawkę)
● Aby skonfigurować ustawienia przywracania, kliknij prawym przyciskiem myszy na liście i 
wybierz MixConsole Snapshot Recall Settings (Ustawienia wywołanej migawki MixConsole).

UWAGA
Przywoływanie migawki można cofnąć/ponownie wykonać w historii MixConsole

POWIĄZANE LINKI
Zmienianie nazw migawek MixConsole na stronie 362
Przywoływanie migawek MixConsole za pomocą karty Migawki na stronie 362
Ustawienia przywoływania migawki MixConsole na stronie 364

358



Historia MixConsole na stronie 354

Pasek narzędzi MixConsole
Pasek narzędzi zawiera narzędzia i skróty do ustawień i funkcji w MixConsole.
UWAGA
Pasek narzędzi MixConsole w dolnej strefie okna projektu zawiera ograniczony zestaw narzędzi

MixConsole History (Historia MixConsole) 
Undo/Redo (Cofnij/Powtórz)

          
       Te przyciski umożliwiają cofanie/ponawianie zmian parametrów MixConsole.

MixConsole Snapshots (Migawki MixConsole)
Save MixConsole Snapshot (Zapisz migawkę MixConsole)

            
        Zapisuje migawkę MixConsole.
MixConsole Snapshot Functions (Funkcje migawki MixConsole)

           
        Otwiera menu MixConsole Snapshot Functions menu (Funkcje migawki MixConsole)

Left Divider (Lewa przegroda)
Left Divider
         Pozwala na użycie lewej przegrody. Narzędzia umieszczone po lewej stronie separatora są 
         zawsze pokazane.
Search (Szukaj)

Find Track/Channel (Znajdź utwór/kanał)

             
         Otwiera selektor z listą wszystkich ścieżek/kanałów.

Channel Visibility Configuration (Konfiguracja widoczności kanału)
Channel Visibility Configurations (Konfiguracje widoczności kanału)

           
         Umożliwia tworzenie konfiguracji przydatnych do szybkiego przełączania między różnymi 
         konfiguracjami widoczności.
Channel Visibility Agents (Agenci widoczności kanału)

          
         Umożliwia ustawienie agenta widoczności do filtrowania kanałów.
Set Channel Type Filter (Ustaw filtr typu kanału)

          
         Otwiera filtr kanałów, który pozwala pokazać/ukryć wszystkie kanały określonego typu.

Racks (Regały, stojaki)
Select Rack Types (Wybierz typy stojaków)

           
         Otwiera selektor statywów, który pozwala pokazać/ukryć określone statywy.
Rack Settings (Ustawienia stojaka)
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         Otwiera wyskakujące menu z ustawieniami dla statywów.

Locators (Lokalizatory)
Go to Left Locator Position (Przejdź do lewej pozycji lokalizatora)

           
          Umożliwia przejście do lewej pozycji lokalizatora.

Left Locator Position (Lewa pozycja lokalizatora)

           
          Pokazuje lewą pozycję lokalizatora.
Go to Right Locator Position (Przejdź do pozycji prawego lokalizatora)

           
          Pozwala przejść do prawej pozycji lokalizatora.
Right Locator Position (Pozycja prawego lokalizatora)

           
         Pokazuje prawą pozycję lokalizatora.

Locator Range Duration (Czas trwania zasięgu lokalizatora)
Locators to Selection (Lokalizatory do zaznaczenia)

          
        Umożliwia ustawienie lokalizatorów do zaznaczenia.
Locator Range Duration (Czas trwania zasięgu lokalizatora)

          
        Pokazuje czas trwania zasięgu lokalizatora.

Transport Buttons (Przyciski transportu)
Go to Previous Marker/Zero (Przejdź do poprzedniego znacznika/zera)

         
        Przesuwa kursor projektu do poprzedniego znacznika/pozycji zerowej na osi czasu.
Go to Next Marker/Project End (Przejdź do następnego znacznika/końca projektu)

        
        Przesuwa kursor projektu do następnego znacznika/końca projektu.
Rewind (Przewijanie do tyłu)

        
        Przesuwa się do tyłu.
Forward (Przewijanie do przodu)

        
       Przesuwa się do przodu.
Activate Cycle (Aktywuj cykl)

        
       Aktywuje/dezaktywuje tryb cyklu.
Stop (Zatrzymaj się)
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       Zatrzymuje odtwarzanie.
Start (Początek)

       
       Rozpoczyna odtwarzanie.
Transport Record (Rekord transportu)

       
       Włącza/wyłącza tryb nagrywania.
Time Displays (Wyświetlacze czasu)
Primary Time Display (Główny wyświetlacz czasu)

           
          Pokazuje pozycję kursora projektu w wybranym formacie czasu.
Select Primary Time Format (Wybierz podstawowy format czasu)

           
         Umożliwia wybranie formatu czasu dla głównego wyświetlania czasu.
Secondary Time Display (Wyświetlacz czasu dodatkowego)

          
         Pokazuje pozycję kursora projektu w wybranym formacie czasu.
Select Secondary Time Format (Wybierz dodatkowy format czasu)

           
         Umożliwia wybranie formatu czasu dla dodatkowego wyświetlania czasu.

Markers (Markery,znaczniki)
Jump to Marker (Skok do znacznika)

         
        Umożliwia ustawianie i lokalizowanie pozycji znaczników.
Open Markers Window (Otwórz okno znaczników)

         
        Otwiera okno Markers (Znaczniki).

State Buttons (Przyciski stanu)
Deactivate All Mute States (Dezaktywuj wszystkie stany wyciszenia)

         
        Dezaktywuje wszystkie stany wyciszenia.
Deactivate All Solo States (Dezaktywuj wszystkie stany Solo)

         
        Dezaktywuje wszystkie stany solo.
Deactivate All Listen States (Dezaktywuj wszystkie stany nasłuchiwania)

         
        Dezaktywuje wszystkie stany nasłuchiwania.
Activate/Deactivate Read for All Tracks (Włącz/wyłącz opcję Read (Odczyt) dla wszystkich 
ścieżek)

         
       Włącza/wyłącza automatyzację odczytu dla wszystkich ścieżek.
Activate/Deactivate Write for All Tracks (Włącz/wyłącz zapis dla wszystkich ścieżek)
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       Włącza/wyłącza automatyzację zapisu dla wszystkich ścieżek.
Suspend All Read/Write Automation (Zawieś całą automatyzację odczytu/zapisu)

        
       Wstrzymuje całą automatyzację odczytu/zapisu.
Bypass Inserts (Wkładki obejściowe)

        
       Pomija wszystkie wkładki.

Bypass EQs (Obejście korektorów)

          
         Pomija wszystkie EQ.
Bypass Channel Strip (Obejście paska kanałów)

          
         Pomija wszystkie moduły kanałów.
Bypass Sends (Pomiń wysyłki)

          
         Pomija wszystkie wysyłki.

Link Group (Grupa linków)
Link/Unlink Selected Channels (Połącz/odłącz wybrane kanały)

          
         Łączy wybrane kanały/usuwa ich łącze.
Edit Link Group Settings (Edytuj ustawienia grupy łączy)

          
         Umożliwia zmianę ustawień grupy łączy.
Suspend All Channel Linking (Zawieś wszystkie łączenie kanałów)

          
         Wstrzymuje wszelkie łączenie kanałów.
Absolute Mode (Tryb absolutny)

          
         Umożliwia zmiany wartości bezwzględnych.
Temporary Link Mode (Tryb połączenia tymczasowego)

          
         Synchronizuje wszystkie zmienione parametry wybranych kanałów.

Zoom Palette (Paleta powiekszenia)
Reduce Channel Width (Zmniejsz szerokość kanału)

          
         Umożliwia zmniejszenie szerokości kanału.
Set Number of Channels (Ustaw liczbę kanałów)

          
         Wyświetla ustawioną liczbę kanałów.
Increase Channel Width (Zwiększ szerokość kanału)
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         Umożliwia zwiększenie szerokości kanału.
Reduce Rack Height (Zmniejsz wysokość regału (stojaka))

          
         Umożliwia zmniejszenie wysokości regału.
Increase Rack Height (Zwiększ wysokość stojaka)

          
         Umożliwia zwiększenie wysokości regału.

System Performance Meter (Miernik wydajności systemu)
System Performance Meter

            
           Pokazuje liczniki średniego obciążenia przetwarzania dźwięku i obciążenia pamięci 
           podręcznej dysku.

Right Divider (Prawy rozdzielacz,separator)
Right Divider
          Prawy rozdzielacz. Narzędzia umieszczone po prawej stronie separatora są zawsze pokazane.

Mixer Functions Menu (Menu funkcji miksera)
Functions Menu (Menu funkcji)

          
         Otwiera wyskakujące menu, w którym można wybrać funkcję MixConsole.

Window Zone Controls (Sterowanie strefą okna)
Show/Hide Left Zone (Pokaż/ukryj lewą strefę)

          
         Pokazuje/ukrywa lewą strefę okna.
Show/Hide Right Zone (Pokaż/ukryj prawą strefę)

          
         Pokazuje/ukrywa prawą strefę okna.
Set up Window Layout (Skonfiguruj układ okien)

          
         Umożliwia ustawienie układu okien.

Set up Toolbar (Skonfiguruj pasek narzędzi)
Set up Toolbar

          
         Otwiera wyskakujące menu, w którym można określić, które elementy paska narzędzi mają 
być widoczne.

Wyszukiwanie kanałów
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Funkcja Find Track/Channel (Znajdź ścieżkę/kanał) umożliwia odnalezienie określonych 
kanałów. Jest to przydatne, jeśli masz duży projekt z wieloma kanałami lub jeśli masz ukryte kanały
za pomocą funkcji widoczności.

PROCEDURA
1. Kliknij Find Track/Channel na pasku narzędzi MixConsole, aby otworzyć selektor z listą    
    wszystkich kanałów.
2. W polu wyszukiwania wprowadź nazwę kanału.
    Podczas pisania selektor filtruje automatycznie.
3. W selektorze wybierz kanał i naciśnij Return .

WYNIK
Kanał został wybrany na liście kanałów.

UWAGA
Jeśli kanał znajdował się poza widokiem lub był ukryty, jest teraz widoczny. Kanały ukryte za 
pomocą opcji Set Channel Type Filter (Ustaw filtr typu kanału) nie są wyświetlane.

Cofanie/ponawianie zmian parametrów MixConsole
Możesz cofnąć/przywrócić zmiany parametrów MixConsole i eksperymentować z różnymi 
ustawieniami MixConsole.

UWAGA
Parametry MixConsole, które zmieniają się w wyniku działań automatyzacji odczytu, nie są częścią
historii MixConsole.

Aby cofnąć/ponownie wykonać parametr MixConsole, wykonaj jedną z następujących czynności:
● Na pasku narzędzi MixConsole w oknie MixConsole lub w dolnej strefie Projektu kliknij 
przycisk Undo (Cofnij) lub Redo (Wykonaj ponownie, powtórz)
● Naciśnij Alt/Opt - Z, aby cofnąć zmiany parametrów MixConsole lub naciśnij Alt/Opt - Shift - 
Z, aby powtórzyć zmiany parametrów.

Następujące zmiany parametrów MixConsole można cofnąć/ponownie:
● Zmiany głośności (Volume)
● Zmiany panoramy (Pan)
● Zmiany na stojaku Routing
● Filtr, wzmocnienie (Gain) i zmiany fazy w regale (stojaku) wstępnym
● Zmiany wtyczek w stojaku insertów
● Zmiany EQ
● Zmiany w stojaku na paski kanałów (Channel Strip)
● Zmiany w regale wysyłek (Sends)
● Zmiany w regale Cue Sends
● Zmiany w regale Direct Routing

WAŻNE
Historia MixConsole nie jest zapisywana wraz z projektem.

POWIĄZANE LINKI
Historia MixConsole na stronie 354
Pasek narzędzi MixConsole na stronie 355

Zapisywanie migawek ustawień MixConsole
Możesz zapisać ustawienia MixConsole dla kanałów związanych z audio w migawce.
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PROCEDURA
● Na pasku narzędzi kliknij Save MixConsole Snapshot (Zapisz migawkę MixConsole).

WYNIK
Ustawienia MixConsole są zapisywane w migawce. Możesz zapisać do 10 migawek. Są one 
pokazane na karcie Snapshots (Migawki) w lewej strefie MixConsole.

UWAGA
Dane automatyzacji nie są zapisywane w migawkach MixConsole.

PO WYKONANIU TEGO ZADANIA
Możesz otworzyć okno dialogowe MixConsole Snapshot Recall Settings  (Migawki MixConsole, 
wywołanie ustawień i aktywowanie ustawienia, które chcesz przywołać.

POWIĄZANE LINKI
Ustawienia przywoływania migawki MixConsole na stronie 364

Zmiana nazwy migawek MixConsole
Możesz zmieniać nazwy migawek MixConsole.

PROCEDURA
1. W lewej strefie MixConsole otwórz zakładkę Snapshots (Migawki)
2. Kliknij dwukrotnie nazwę migawki i wpisz nową nazwę migawki.
3. Naciśnij Return (Powrót).

Aktualizowanie migawki MixConsole 
Możesz zaktualizować migawkę. Jest to przydatne, jeśli chcesz zastosować zmiany do istniejących 
ustawień lub jeśli masz już zapisane 10 migawek.

PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Na pasku narzędzi MixConsole, kliknij MixConsole Snapshot Functions (Funkcje  
             migawki MixConsole) i wybierz Update Selected Snapshot: Snapshot x.
         ● Na karcie Snapshots (Migawki) kliknij prawym przyciskiem migawkę, którą chcesz 
            zaktualizować i wybierz Update Selected Snapshot: Snapshot x (Aktualizuj wybraną 
            migawkę: Migawka x).

WYNIK
Migawka jest aktualizowana.

UWAGA
Dane automatyzacji nie są zapisywane w migawkach MixConsole.

PO WYKONANIU TEGO ZADANIA
Możesz otworzyć okno dialogowe MixConsole Snapshot Recall Settings (Wywołanie ustawień 
migawki MixConsole) i aktywować ustawienia, które chcesz przywołać.

POWIĄZANE LINKI
Wywoływanie ustawień migawki MixConsole na stronie 364
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Przywoływanie migawek MixConsole za pomocą karty Snapshots 
(migawki)
Możesz przywołać migawki MixConsole za pomocą karty Snapshots (Migawki).

WARUNEK WSTĘPNY
Zapisałeś co najmniej jedną migawkę MixConsole.

PROCEDURA
1. W lewej strefie MixConsole otwórz zakładkę Snapshots.
2. Opcjonalnie: Kliknij MixConsole Snapshot Functions i wybierz MixConsole Snapshot Recall 
Settings, aby otworzyć okno dialogowe, w którym możesz aktywować ustawienia, które chcesz 
przywołać, i kliknij OK.
3. Wybierz migawkę, którą chcesz przywołać, i kliknij Recall Snapshot x.

UWAGA
Dane automatyzacji nie są zapisywane w migawkach MixConsole. Jeśli przywołasz migawkę do 
kanału, który zawiera dane automatyzacji, pojawi się komunikat ostrzegawczy.

Komunikat informuje, że migawka została przywołana.

                 

WYNIK
Migawka zostanie przywołana, a ustawienia zostaną zastosowane. Jeśli przywołasz migawkę 
podczas odtwarzania, możesz usłyszeć krótką przerwę, w zależności od tego, jak różne są 
ustawienia od bieżącego stanu.

POWIĄZANE LINKI
Ustawienia przywoływania migawki MixConsole na stronie 364

Przywoływanie migawek MixConsole za pomocą paska narzędzi 
MixConsole
Możesz przywoływać migawki MixConsole za pomocą paska narzędzi MixConsole.

WARUNEK WSTĘPNY
Zapisałeś co najmniej jedną migawkę MixConsole.

PROCEDURA
1. Na pasku narzędzi kliknij MixConsole Snapshot Functions (Funkcje migawki MixConsole).
2. Z menu wybierz migawkę, którą chcesz przywołać.

UWAGA
Dane automatyzacji nie są zapisywane w migawkach MixConsole. Jeśli przywołasz migawkę do 
kanału, który zawiera dane automatyzacji, otrzymasz komunikat ostrzegawczy.

Komunikat informuje, że migawka została przywołana.
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WYNIK
Migawka zostanie przywołana, a ustawienia zostaną zastosowane. Jeśli przywołasz migawkę 
podczas odtwarzania, możesz usłyszeć krótką przerwę, w zależności od tego, jak różne są 
ustawienia od bieżącego stanu.

POWIĄZANE LINKI
Ustawienia przywoływania migawki MixConsole na stronie 364

Dodawanie notatek do migawek
Do migawki można dodawać notatki i komentarze.

WARUNEK WSTĘPNY
Zapisałeś co najmniej jedną migawkę MixConsole.

PROCEDURA
1. W lewej strefie MixConsole otwórz zakładkę Snapshots (Migawki).
2. Wybierz migawkę, do której chcesz dodać komentarze.
3. W sekcji Snapshot Notes (Notatki migawki) na karcie Snapshots wpisz swoje notatki

Ustawienia przywoływania migawki MixConsole
MixConsole Snapshot Recall Settings (Ustawienia przywoływania migawek w MixConsole) 
umożliwiają określenie ustawień kanału, które są przywoływane po załadowaniu zapisanej 
migawki.

Aby otworzyć MixConsole Snapshot Recall Settings (ustawienia przywoływania migawki 
MixConsole), wykonaj jedną z następujących czynności:

● Otwórz wyskakujące menu MixConsole Snapshot Functions na pasku narzędzi MixConsole 
     i wybierz MixConsole Snapshot Recall Settings.   
● W lewej strefie MixConsole kliknij prawym przyciskiem myszy zakładkę Snapshots i wybierz    
     MixConsole Snapshot Recall Settings. 
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Następujące opcje pozwalają określić, które ustawienia mają zostać przywołane:

Pre (Filters/Gain/Phase)  (Pre (filtry/wzmocnienie/faza))
        Aktywuj to, aby przywołać ustawienia filtrów, wzmocnienia i fazy.
Inserts (Wstawki)
        Aktywuj to, aby przywołać wkładki.
EQ  (Efekty)
        Aktywuj to, aby przywołać korektory.
Channel Strip (Pasek kanałów)
        Aktywuj to, aby przywołać moduły kanału.

Sends (Wysyłki)
        Aktywuj to, aby przywołać wysyłki.
Pan (Panorama)
        Aktywuj to, aby przywołać panoramę.
Volume (Głośność)
        Aktywuj to, aby przywołać głośność.
Selected Channels only (Tylko wybrane kanały)
        Aktywuj tę opcję, aby przywołać ustawienia tylko dla wybranych kanałów.
Warn Before Deleting Plug-in Automation (Ostrzegaj przed usunięciem automatyzacji wtyczek )
        Jeśli ta opcja jest włączona, zostanie wyświetlone ostrzeżenie, jeśli automatyzacja wtyczek 
         może zostać usunięta.

Filtrowanie typów kanałów
Filtr typów kanałów na pasku narzędzi MixConsole pozwala określić, które typy kanałów są 
wyświetlane.

PROCEDURA
1. Kliknij opcję Set Channel Type Filter (Ustaw filtr typu kanału).
   Spowoduje to otwarcie filtra typów kanałów.
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2. Kliknij po lewej stronie typu kanału, aby odznaczyć go i ukryć wszystkie kanały tego typu.

WYNIK
Kanały filtrowanego typu są usuwane z sekcji suwaków, a kolor przycisku Set Channel Type 
Filter (Ustaw filtr typu kanału) zmienia się, wskazując, że typ kanału jest ukryty.

Menu konfiguracji widoczności kanału
Przycisk Channel Visibility Configurations (Konfiguracje widoczności kanału) na pasku narzędzi
MixConsole umożliwia tworzenie konfiguracji przydatnych do szybkiego przełączania między 
różnymi konfiguracjami widoczności.

Przycisk wyświetla nazwę aktywnej konfiguracji. Lista konfiguracji jest wyświetlana natychmiast 
po utworzeniu co najmniej jednej konfiguracji. Aby załadować konfigurację, wybierz ją z menu. 
Konfiguracje widoczności kanału są zapisywane wraz z projektem.

Add Configuration (Dodaj konfigurację)
         Otwiera okno dialogowe Add Configuration, w którym można zapisać konfigurację i 
         wprowadzić jej nazwę.

Update Configuration (Zaktualizuj konfigurację)
         Zmiana aktywnej konfiguracji jest wskazywana gwiazdką po nazwie konfiguracji. Użyj tej 
         funkcji, aby zapisać zmiany w aktywnej konfiguracji.
Rename Configuration (Zmień nazwę konfiguracji)
         Otwiera okno dialogowe Rename Configuration, które umożliwia zmianę nazwy aktywnej 
         konfiguracji.
Delete Configuration (Usuń konfigurację)
         Umożliwia usunięcie aktywnej konfiguracji. 
Move Configuration to Position (Przenieś konfigurację na pozycję)
        Ta funkcja staje się dostępna, jeśli istnieją dwie lub więcej konfiguracji. Pozwala na zmianę 
        pozycji aktywnej konfiguracji w menu. Jest to przydatne, ponieważ możesz przypisać 
        polecenia klawiszowe do pierwszych 8 konfiguracji w kategorii Channel & Track Visibility 
       (Widoczność kanałów i ścieżek) w oknie dialogowym Key Commands (Polecenia 
        klawiszowe).

Zapisywanie konfiguracji
Aby szybko przełączać się między różnymi konfiguracjami kanałów, możesz zapisać konfiguracje. 
Konfiguracje zawierają ustawienia widoczności i stref, a także stan pokazywania/ukrywania typów 
kanałów i stojaków (regałów).

PROCEDURA

369



1. Skonfiguruj konfigurację, którą chcesz zapisać.
2. Na pasku narzędzi kliknij Channel Visibility Configurations (Konfiguracje widoczności  
     kanału).
3. Z wyskakującego menu wybierz Add Configuration (Dodaj konfigurację).
4. W oknie dialogowym Add Configuration wprowadź nazwę konfiguracji.
5. Kliknij OK

WYNIK
Konfiguracja zostaje zapisana i możesz do niej wrócić w dowolnym momencie.

Agenci widoczności kanału
Channel Visibility Agents (Agenty widoczności kanałów) umożliwiają pokazywanie lub 
ukrywanie wszystkich kanałów, wybranych kanałów lub kanałów o określonych właściwościach.

Aby otworzyć wyskakujące menu Channel Visibility Agents, wykonaj jedną z następujących 
czynności:
● Kliknij Channel Visibility Agents na pasku narzędzi.
● W lewej strefie MixConsole wybierz zakładkę Visibility (Widoczność) i kliknij prawym 
przyciskiem myszy pusty obszar, aby otworzyć menu kontekstowe.

Menu agentów widoczności kanału
Wyskakujące menu Channel Visibility Agents (Agenty widoczności kanałów) zawiera opcje, które
pozwalają pokazać lub ukryć wszystkie kanały, wybrane kanały lub kanały o określonych 
właściwościach.

● Aby otworzyć wyskakujące menu Channel Visibility Agents (Agenty widoczności kanału), 
kliknij opcję Channel Visibility Agents na pasku narzędzi.

Show All Channels (Pokaż wszystkie kanały)
        Pokazuje wszystkie kanały twojego projektu.
Show Only Selected Channels (Pokaż tylko wybrane kanały)
        Pokazuje tylko wybrane kanały.

Hide Selected Channels (Ukryj wybrane kanały)
        Ukrywa wszystkie wybrane kanały.
Show Channels for Tracks with Data (Pokaż kanały dla ścieżek z danymi)
        Pokazuje wszystkie kanały dla ścieżek ze zdarzeniami lub częściami.
Show Channels for Tracks with Data at the Cursor Position (Pokaż kanały dla ścieżek z danymi
w pozycji kursora)
        Pokazuje wszystkie kanały dla ścieżek ze zdarzeniami lub częściami w pozycji kursora.
Show Channels for Tracks with Data between the Locators (Pokaż kanały dla ścieżek z danymi 
między lokalizatorami)
        Pokazuje wszystkie kanały dla ścieżek ze zdarzeniami lub częściami między lokalizatorami.
Show Channels that are Connected to the First Selected Channel (Pokaż kanały, które są 
podłączone do pierwszego wybranego kanału)
        Pokazuje wszystkie kanały, które są podłączone do kanału, który wybrałeś jako pierwszy.
Undo Visibility Change (Cofnij zmianę widoczności)
        Cofa zmiany widoczności.
Redo Visibility Change (Ponów zmianę widoczności)
        Ponawia zmiany widoczności

UWAGA
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Możesz przypisać klawiszowe polecenia dla agentów widoczności kanału w kategorii Channel       
& Track Visibility (Widoczność kanału i toru) w oknie dialogowym Key Commands (Polecenia 
klawiszowe).

Cofanie/ponawianie zmian widoczności
Możesz cofnąć/przywrócić do 10 zmian widoczności.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Channel Visibility Agents
 (Agenty widoczności kanałów).
2. Wybierz opcję Undo Visibility Change (Cofnij zmianę widoczności) lub Redo Visibility 
Change (Ponów zmianę widoczności).

Selektor regałów
Selektor stojaków umożliwia aktywację określonych funkcji MixConsole, które są zorganizowane 
w stojakach, takich jak obsługa trasowania, wstawiania lub wysyłania.

Channel Racks Selector (Selektor stojaków kanałowych)
Możesz aktywować i dezaktywować różne racki kanałów w MixConsole.

● Aby otworzyć selektor stojaków, kliknij Select Rack Types (Wybierz typy stojaków) na pasku 
narzędzi MixConsole.
W zależności od typu kanału można aktywować/dezaktywować następujące stojaki:
Hardware (Sprzęt komputerowy)
          Pozwala kontrolować efekty sprzętowe audio. Ta szafa jest dostępna tylko wtedy, gdy jest 
          obsługiwana przez twój sprzęt.
Routing (Kierowanie)
         Umożliwia skonfigurowanie routingu wejściowego i wyjściowego. W przypadku MIDI 
         można również wybrać kanał MIDI.
Pre (Filters/Gain/Phase) (Pre (filtry/wzmocnienie/faza))
         W przypadku kanałów związanych z audio zawiera elementy sterujące filtrem 
         wejściowym i wzmocnieniem oraz elementy sterujące Phase (fazą) i Gain (wzmocnieniem). 
         W przypadku kanałów MIDI zawiera kontrolkę Input Transformer.

Inserts (Wstawki)
         Umożliwia wybranie efektów insertowych dla Twojego kanału.
Equalizers (Korektory (tylko kanały związane z audio))
         Umożliwia ustawienie korektora kanału.
Channel Strip (tylko kanały związane z audio)
         Umożliwia integrację modułów listwy kanałowej, takich jak Gate, Compressor, EQ, 
          Transformer, Saturator i Limiter, które pozwalają ulepszyć dźwięk.
Sends (Wysyłki)
         Umożliwia wybranie efektów wysyłania dla Twojego kanału.
Cue Sends (tylko kanały związane z audio)
         Pozwala aktywować i kontrolować poziom i panoramę dla maksymalnie 4 wysyłek cue.
Direct Routing (Kierowanie bezpośrednie)
         Pozwala ustawić i aktywować wyjścia dla wszystkich wybranych kanałów jednocześnie.
Track Quick Controls (Ścieżka szybkiego sterowania)
         Umożliwia dodanie szybkich elementów sterujących w celu uzyskania natychmiastowego   
         dostępu.
Device Panels (Panele urządzeń)
         Umożliwia przeglądanie dostępnych paneli urządzeń.
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POWIĄZANE LINKI
Pasek narzędzi MixConsole na stronie 355.

Menu ustawień stojaka (regału, statywu, stelaża)
Wyskakujące menu Rack Settings (Ustawienia statywów) umożliwia wprowadzanie ustawień dla 
statywów.

● Aby otworzyć wyskakujące menu Rack Settings, kliknij Rack Settings na pasku narzędzi 
MixConsole.

Exclusive Expanded Rack (Ekskluzywny rozszerzony stojak)
         Pokazuje wyłącznie wybrany stelaż i zwija pozostałe stelaże.
Fixed Number of Slots (Stała liczba slotów)
         Pokazuje wszystkie dostępne miejsca na racki insertów, wysyłek, pamięci i szybkich nastaw.
Link Racks to Configurations (Połącz stojaki z konfiguracjami)
         Jeśli ta opcja jest włączona, stan stojaka jest brany pod uwagę podczas zapisywania i 
         wczytywania konfiguracji.
Show Pre/Filters as <Combined Label & Setting>  (Pokaż filtry wstępne/filtry jako <Połączona 
etykieta i ustawienie>)
        Wybierz opcję Combined Label & Setting (Łączona etykieta i ustawienie), jeśli chcesz   
        wyświetlić etykietę i ustawienie w jednym wierszu.
        Wybierz opcję Separate Label & Setting (Oddzielna etykieta i ustawienie), jeśli chcesz 
        wyświetlić etykietę i ustawienie w osobnych wierszach.
Show Inserts as <Plug-in Names & Insert Controls> (Pokaż wstawki jako <Nazwy wtyczek i 
kontrolki wstawiania>)
        Wybierz Plug-in Names (Nazwy wtyczek), jeśli chcesz wyświetlić tylko nazwy wtyczek.
        Wybierz Plug-in Names & Insert Controls (Nazwy wtyczek i kontrolki wstawiania), jeśli  
        chcesz wyświetlić nazwy wtyczek i kontrolki wstawiania.
Show All Channel Strip Controls (Pokaż wszystkie kontrolki paska kanałów)
        Pokazuje wszystkie dostępne elementy sterujące na stojaku Channel Strip.
Show One Channel Strip Type (Pokaż jeden typ paska kanałów)
        Pokazuje tylko jeden typ kanału w danej chwili.

Show Sends as <Send Destination & Gain> (Pokaż wysyłki jako <Miejsce docelowe wysyłania 
i wzmocnienie>)
        Wybierz Send Destination & Gain (Wyślij miejsce docelowe i wzmocnienie), jeśli chcesz 
        wyświetlić miejsce docelowe i wzmocnienie w jednym wierszu.
        Wybierz Send Destination, Gain & Send Controls (Miejsce docelowe wysyłania, sterowanie
        wzmocnieniem i wysyłaniem), jeśli chcesz wyświetlić miejsce docelowe, wzmocnienie i 
        sterowanie wysyłaniem.
Show Quick Controls as <Combined Destination & Value> (Pokaż szybkie sterowanie jako 
<Połączone miejsce docelowe i wartość>)
        Wybierz Combined Destination & Value (Połączone miejsce docelowe i wartość), jeśli 
        chcesz wyświetlić miejsce docelowe i wartość w jednym wierszu.
        Wybierz Separate Destination & Value (Oddzielne miejsce docelowe i wartość), jeśli chcesz 
        wyświetlić miejsce docelowe i wartość w osobnych wierszach.

POWIĄZANE LINKI
Pasek narzędzi MixConsole na stronie 355

Łączenie kanałów
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Możesz połączyć wybrane kanały w MixConsole, aby utworzyć grupę linków. Każda zmiana 
zastosowana w jednym kanale jest odzwierciedlana we wszystkich połączonych kanałach, w 
zależności od tego, które ustawienia są aktywowane w ustawieniach grupy łączy.

Opcje Link Group (Grupa linków) na pasku narzędzi MixConsole umożliwiają łączenie kanałów 
oraz edytowanie łączy i konfiguracji łączenia.

                

Okno dialogowe ustawień grupy łączy
Okno dialogowe Link Group Settings (Ustawienia grupy łączy) umożliwia określenie ustawień 
kanału, który jest połączony.
● Aby otworzyć okno dialogowe Link Group Settings (Ustawienia grupy połączeń), kliknij Link 
(Łącze) na pasku narzędzi MixConsole.

           
Dostępne są następujące opcje:

New Link Group Name (Nowa nazwa grupy linków)
         Umożliwia wprowadzenie nazwy grupy łączy.
Use VCA Fader (Użyj suwaka VCA)
         Aktywuj tę opcję, aby przypisać grupę linków do tłumika VCA.
Select VCA Fader (Wybierz tłumik VCA)
         Umożliwia wybór kanału tłumika VCA.
Volume (Głośność)
         Aktywuj to, aby połączyć głośność połączonych kanałów.
Pan (Panorama)
         Aktywuj to, aby połączyć panoramę połączonych kanałów.
EQ (Efekty)
         Aktywuj to, aby połączyć korektory połączonych kanałów.
Dynamics (Compressor, Gate, etc.) (Dynamika (sprężarka, bramka itp.))
         Aktywuj to, aby połączyć dynamikę połączonych kanałów.
Sends (Wysyłki)
         Aktywuj to, aby połączyć wysyłki z połączonych kanałów.
Inserts (Wstawki)
        Aktywuj to, aby połączyć wstawki połączonych kanałów.
Mute/Solo/Listen (Wycisz/Solo/Słuchaj)
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        Aktywuj to, aby połączyć stany wyciszenia, solo i słuchania połączonych kanałów.
Automation Read/Write (Automatyzacja odczytu/zapisu)
        Aktywuj to, aby powiązać stany odczytu/zapisu automatyzacji połączonych kanałów.
Routing (Trasowanie)
        Aktywuj to, aby powiązać trasowanie połączonych kanałów.
Selection (Wybór)
        Aktywuj to, aby połączyć wybór połączonych kanałów.
Record Enable/Monitor (Włącz nagrywanie/monitoruj)
        Aktywuj to, aby połączyć stany włączania/monitorowania nagrywania połączonych kanałów.

UWAGA
Domyślnie włączone są ustawienia głośności, wysyłania, trasowania i wyboru. Jeśli przypiszesz 
grupę linków do tłumika VCA, aktywowane będą tylko wysyłki i parametry routingu.

Linia wyświetlacza

Za każdym razem, gdy tworzysz grupę łączy, linia wyświetlania jest dodawana na górze sekcji 
suwaków w MixConsole.

Linia wyświetlacza pokazuje numer i nazwę utworzonej grupy połączeń oraz udostępnia 
wyskakujące menu Link Settings (Ustawienia łączy), które umożliwia edycję ustawień grupy 
łączy.

W wierszu wyświetlania możesz zmienić nazwę grupy połączeń, klikając dwukrotnie i 
wprowadzając inną nazwę. Jeśli przytrzymasz klawisz modyfikujący i dwukrotnie klikniesz nazwę, 
otworzy się okno dialogowe Link Group Settings (Ustawienia grupy łączy).

UWAGA
Jeśli używasz suwaka VCA dla grupy połączeń, nazwa grupy połączeń wyświetlana na suwaku 
również zostanie zmieniona.

Wyskakujące menu zawiera następujące opcje:

Unlink Selected Channels (Odłącz wybrane kanały)
           Dostępne tylko dla wybranej grupy linków. Wybierz tę opcję, aby usunąć połączenie między 
           kanałami. Spowoduje to usunięcie grupy łączy. Jeśli używasz tłumika VCA, musisz określić,
           czy chcesz powrócić do pierwotnej automatyzacji połączonych kanałów. Suwak VCA 
           kontrolujący tę grupę łączy nie jest usuwany.
Edit Link Group Settings (Edytuj ustawienia grupy łączy)
          Umożliwia zmianę ustawień grupy łączy.
Included in Link Group: <name of link group> (Zawarte w grupie linków: <nazwa grupy 
linków>)
          Pokazuje grupę łączy, do której należy wybrany kanał. Możesz przypisać wybrany kanał do  
          innej grupy linków. Spowoduje to usunięcie kanału z bieżącej grupy. Jeśli chcesz tylko 
          usunąć wybrany kanał z grupy linków, wybierz None (Brak).
Linked Channels (Połączone kanały)

374



          Pokazuje, które kanały są połączone w grupie łączy.

POWIĄZANE LINKI
Zmiana ustawień grupy połączeń na stronie 372
Dodawanie kanałów do grup łączy na stronie 372
Usuwanie kanałów z grup łączy na stronie 372
Suwaki VCA na stronie 419

Tworzenie grup łączy
Możesz połączyć kilka kanałów, aby utworzyć grupę połączeń.

PROCEDURA
1. Wybierz kanały, które chcesz połączyć.
2. Na pasku narzędzi MixConsole kliknij Link (Połącz).
3. W oknie dialogowym Link Group Settings (Ustawienia grupy połączeń) aktywuj parametry, 
     które chcesz połączyć.
4. Kliknij OK.

WYNIK
Numer i nazwa grupy połączeń jest wskazana nad nazwą kanału w wierszu wyświetlacza.

UWAGA
● Jeśli łączysz grupy, łączenie modułów wstawiania i paska kanałów jest stosowane na poziomie 
gniazda. Na przykład, jeśli zmienisz ustawienia dla gniazda insertowego 3 na jednym kanale, 
zmiany te zostaną zastosowane również dla gniazda 3 na innych kanałach. Efekty wstawiania w 
innych gniazdach pozostają nienaruszone.
● Jeśli wybierzesz kanał należący do grupy połączeń, wszystkie kanały w tej grupie zostaną 
wybrane domyślnie. Aby zapobiec wielokrotnemu wyborowi wszystkich kanałów należących do 
grupy połączeń, wyłącz opcję Selection (Wybór) w oknie dialogowym Link Group Settings 
(Ustawienia grupy połączeń).

POWIĄZANE LINKI
Okno dialogowe ustawień grupy połączeń na stronie 369

Zmiana ustawień grupy łączy
Jeśli zmienisz ustawienie dla kanału grupy linków, zmiana zostanie zastosowana do całej grupy.

● Aby zmienić ustawienia łącza dla istniejącej grupy łączy, wybierz grupę, na pasku narzędzi 
MixConsole kliknij Edit Link Group Settings (Edytuj ustawienia grupy łączy) i zmień ustawienia 
w oknie dialogowym Link Group Settings (Ustawienia grupy łączy).
● Aby rozłączyć kanały, wybierz jeden z połączonych kanałów i kliknij Link (Połącz) na pasku 
narzędzi MixConsole.
● Aby zapobiec wielokrotnemu wyborowi wszystkich kanałów należących do grupy połączeń, 
wyłącz opcję Selection (Zaznaczanie) w oknie dialogowym Link Group Settings (Ustawienia 
grupy połączeń).
● Aby wprowadzić indywidualne ustawienia i zmiany dla kanału w grupie łączy, aktywuj Sus na 
pasku narzędzi MixConsole lub naciśnij Alt/Opt .
● Aby dokonać bezwzględnych zmian wartości zamiast względnych, aktywuj Abs na pasku 
narzędzi MixConsole

UWAGA
Funkcja Link nie ma wpływu na ścieżki automatyzacji dla połączonych kanałów.
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POWIĄZANE LINKI
Okno dialogowe ustawień grupy połączeń na stronie 369

Dodawanie kanałów do grup łączy
Możesz dodać kanał do istniejącej grupy linków.

PROCEDURA
1. W wierszu wyświetlania kanału, który chcesz dodać, otwórz okno podręczne menu Link 
     Settings (Ustawienia łącza).
2. Wybierz Included in Link Group: <None> (Zawarte w grupie łączy: <Brak>) i wybierz grupę 
     łączy.

WYNIK
Kanał zostanie dodany do grupy linków.

Usuwanie kanałów z grup łączy
Możesz usunąć kanał z istniejącej grupy linków.

PROCEDURA
1. W wierszu wyświetlania kanału, który chcesz usunąć, otwórz menu podręczne Link Settings  
    (Ustawienia łącza).
2. Wybierz Included in Link Group: <link group name> (Zawarte w grupie łączy: <nazwa grupy
łączy>) i z listy grup łączy wybierz None (Brak).
3. Jeśli kanał jest kontrolowany przez tłumik VCA, określ, czy kanał zachowuje połączoną 
automatyzację.

WYNIK
Kanał zostanie usunięty z grupy linków.

Korzystanie z szybkiego łącza
Możesz aktywować Temporary Link Mode (Tryb połączenia tymczasowego), aby 
zsynchronizować wszystkie dotknięte parametry wybranych kanałów.

PROCEDURA
1. Wybierz kanały, które chcesz połączyć.
2. Na pasku narzędzi MixConsole aktywuj Q-Link.

UWAGA
Możesz także nacisnąć klawisze Shift-Alt/Opt, aby tymczasowo połączyć kanały. W takim 
przypadku link jest aktywny tak długo, jak długo naciskasz klawisze.

3. Zmień parametry dla jednego z wybranych kanałów.

WYNIK
Zmiany zostaną zastosowane do wszystkich wybranych kanałów do momentu dezaktywacji 
Q-Link.
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Functions Menu (Menu funkcji)

Functions menu zawiera narzędzia i skróty do ustawień i funkcji w MixConsole.
● Aby otworzyć Functions menu, kliknij Functions menu na pasku narzędzi MixConsole.

Scroll to Selected Channel (Przewiń do wybranego kanału)
         Jeśli ta opcja jest włączona i wybierzesz kanał na zakładce Widoczność, wybrany kanał 
         zostanie automatycznie wyświetlony w sekcji suwaków.
Copy First Selected Channel’s Settings (Skopiuj ustawienia pierwszego wybranego kanału)
        Kopiuje ustawienia pierwszego wybranego kanału.
Paste Settings to Selected Channels (Wklej ustawienia do wybranych kanałów)
        Wkleja ustawienia do wybranych kanałów.
Zoom (Powiększenie)
        Otwiera podmenu, w którym można zwiększyć lub zmniejszyć szerokość kanału i wysokość 
        stojaka (rack).
Open Audio Connections (Otwórz Połączenia audio)
        Otwiera okno Audio Connections.
Control Room Cue Channels (Kanały Cue w pomieszczeniu kontrolnym)
        Otwiera podmenu, w którym można aktywować/dezaktywować kanały cue oraz zmieniać 
        ustawienia poziomu i panoramy.
Constrain Delay Compensation (Ograniczenie kompensacji opóźnienia)
        Umożliwia aktywację/dezaktywację funkcji Constrain Delay Compensation, która utrzymuje
        wszystkie kanały w idealnej synchronizacji i automatycznie kompensuje wszelkie opóźnienia 
        właściwe dla wtyczek VST podczas odtwarzania.
Direct Routing: Summing Mode On/Off (Kierowanie bezpośrednie: tryb sumowania 
włączony/wyłączony)
        Umożliwia jednoczesne przesyłanie sygnałów do kilku wyjść.
After Fader Listen Mode (Tryb odsłuchu po tłumiku)
        Umożliwia włączenie/wyłączenie kierowania sygnału kanału z włączonym słuchaniem do 
        kanału MixConsole po zastosowaniu ustawień suwaka i panoramy.
EQ/Filter Transition (Przejście EQ/filtra)
        Umożliwia zmianę trybu EQ/Filter Transition (EQ/Filtruj przejście) z Soft (Miękkie) na 
Quick (Szybkie).

Save Selected Channels (Zapisz wybrane kanały)
         Zapisuje ustawienia dla wybranych kanałów.
Load Selected Channels (Załaduj wybrane kanały)
         Ładuje ustawienia dla wybranych kanałów.
Global Meter Settings (Globalne ustawienia miernika)
         Otwiera podmenu, w którym można skonfigurować globalne ustawienia miernika.
Reset MixConsole Channels (Zresetuj kanały MixConsole)
         Umożliwia zresetowanie EQ, wstawianie i wysyłanie ustawień efektów dla wszystkich lub 
         wybranych kanałów. Przyciski Solo i Mute są nieaktywne, tłumik głośności jest ustawiony na 
         0 dB, a panorama jest ustawiona w pozycji środkowej.
Link MixConsoles (Połacz MixConsole)
        Możesz połączyć wiele okien MixConsole. Pozwala to na przykład wyświetlić wszystkie 
        kanały widoczne w sekcji suwaków w różnych oknach na różnych monitorach. Paski  
        przewijania, konfiguracje widoczności, filtry i funkcje paska narzędzi, które mają wpływ na 
        sekcję tłumików, są ze sobą połączone.

UWAGA
MixConsole w dolnej strefie okna Project jest wyłączona z funkcji łączenia.
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POWIĄZANE LINKI
Pasek narzędzi MixConsole na stronie 355

Zapisywanie ustawień MixConsole
Możesz zapisać ustawienia MixConsole dla wybranych kanałów związanych z audio i załadować je
do dowolnego projektu.

PROCEDURA
1. Wybierz kanały z ustawieniami, które chcesz zapisać.
2. Wybierz Functions Menu > Save Selected Channels (Menu Funkcje > Zapisz wybrane kanały).
3. W oknie dialogowym pliku określ nazwę pliku i lokalizację.
4. Kliknij Save (Zapisz).

WYNIK
Ustawienia dla wybranych kanałów są zapisywane z rozszerzeniem pliku .vmx. Routing 
wejścia/wyjścia nie jest zapisywany.

Ładowanie ustawień MixConsole
Możesz załadować ustawienia MixConsole, które zostały zapisane dla wybranych kanałów.

PROCEDURA
1. Wybierz taką samą liczbę kanałów, jaką wybrałeś podczas zapisywania ustawień MixConsole.
Załadowane ustawienia MixConsole są stosowane w tej samej kolejności, w jakiej zostały 
pierwotnie zapisane. Na przykład, jeśli zapisałeś ustawienia dla kanałów 4, 6 i 8 i zastosujesz te 
ustawienia do kanałów 1, 2 i 3, ustawienia zapisane dla kanału 4 zostaną zastosowane do kanału 1, 
ustawienia zapisane dla kanału 6 do kanału 2 i tak dalej.
2. Wybierz Functions Menu > Load Selected Channels (Menu Funkcje > Załaduj wybrane 
kanały).
3. W oknie dialogowym Load Selected Channels (Załaduj wybrane kanały) wybierz plik .vmx i 
kliknij Open (Otwórz).

WYNIK
Ustawienia kanałów zostaną zastosowane do wybranych kanałów.

UWAGA
Gdy zastosujesz załadowane ustawienia MixConsole do mniejszej liczby kanałów, niektóre 
zapisane ustawienia nie zostaną zastosowane. Ponieważ zapisane ustawienia są stosowane od lewej 
do prawej, jak pokazano w MixConsole, ustawienia kanałów najbardziej wysuniętych na prawo nie
są stosowane do żadnych kanałów.

Fader Section (Sekcja suwaków, tłumików)
Sekcja tłumików jest sercem MixConsole. Pokazuje kanały wejściowe i wyjściowe wraz z 
kanałami audio, instrumentalnymi, MIDI, grupowymi, FX, suwakami VCA i kanałami ReWire
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UWAGA
Jeśli kanał jest dezaktywowany na karcie Visibility (Widoczność) lub jeśli jego typ kanału jest 
dezaktywowany, nie jest pokazywany w sekcji suwaków. MixConsole w dolnej strefie okna 
Project nie śledzi żadnych zmian widoczności, które wykonujesz w oknie MixConsole i odwrotnie.
Jest to połączone z widocznością ścieżki w oknie Project.

Sekcja suwaka umożliwia wykonanie następujących czynności:

● Edycję ustawienia grupy linków
● Ustawienie panoramy
● Aktywację Mute (wyciszenie) i solo
● Włączenie trybu słuchania
● Otwieranie ustawienia kanału
● Ustawienie Volume (głośność)
● Włączenie automatyzacji
● Ustawienie poziomów wejściowych

UWAGA
Wszystkie funkcje i ustawienia sekcji suwaków są również dostępne w MixConsole w dolnej 
strefie okna Project

POWIĄZANE LINKI
Zmiana ustawień grupy połączeń na stronie 372
Ustawienia kanałów na stronie 404
Automatyzacja zapisu/odczytu na stronie 705
Wyświetlanie/ukrywanie kanałów MixConsole w dolnej strefie na stronie 348

Sterowanie panoramą
Dla każdego kanału związanego a audio, z co najmniej konfiguracją wyjścia stereo, w górnej części
sekcji suwaka można znaleźć element sterujący panoramą. W przypadku kanałów MIDI sterowanie 
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panoramą wysyła komunikaty panoramy MIDI. Wynik zależy od tego, jak instrument MIDI jest 
ustawiony na reagowanie na panoramę.

Sterowanie panoramą umożliwia ustawienie kanału w widmie stereo. Ta kontrolka jest inna dla 
konfiguracji stereo i surround. Kanały z wielokanałową konfiguracją wyjścia posiadają 
miniaturowe sterowanie VST MultiPanner.

● Aby dokonać precyzyjnych regulacji, przytrzymaj klawisz Shift podczas przesuwania elementu 
sterującego panoramą.
● Aby wybrać domyślną środkową pozycję panoramy, przytrzymaj Ctrl/Cmd i kliknij kontrolkę 
panoramy.
● Aby edytować wartość numerycznie, kliknij dwukrotnie kontrolkę panoramy.

POWIĄZANE LINKI
Tworzenie nowych projektów na stronie 98
Dźwięk przestrzenny na stronie 671

Panner balansu stereo

Panner balansu stereo pozwala kontrolować równowagę między lewym i prawym kanałem. Jest 
domyślnie aktywowany

                       

Panorama połączona stereo
W przypadku połączonego panoramowania stereo lewe i prawe elementy sterujące panoramą są 
połączone i zachowują względną odległość, jeśli je przesuniesz. Jest dostępny dla kanałów z 
konfiguracją wejścia i wyjścia stereo.
● Aby aktywować tę panoramę, otwórz menu kontekstowe kontrolki panoramy i wybierz 
Stereo Combined Panner.(Panorama połączona stereo)

                      
● Aby ustawić panoramę niezależnie dla lewego i prawego kanału, przytrzymaj klawisz Alt/Opt i 
przeciągnij w lewo lub w prawo.
● Aby odwrócić lewy i prawy kanał, przesuń lewy kanał w prawo, a prawy w lewo.
Obszar między kontrolkami panoramy zmienia kolor, wskazując, że kanały są odwrócone.

● Aby zsumować dwa kanały, ustaw je w tej samej pozycji panoramy (mono).
Należy pamiętać, że zwiększa to głośność sygnału.
● Aby określić domyślny tryb panoramy stereo dla nowych ścieżek audio, ustaw Default Stereo 
Panner Mode (Domyślny tryb panoramy stereo) w oknie dialogowym Preferences (Preferencje 
(strona VST)).

Pan Bypass (Obejście panoramy)
Możesz pominąć panoramowanie dla wszystkich kanałów związanych z audio.

● Aby włączyć pomijanie panoramy, kliknij przycisk po lewej stronie lub naciśnij Ctrl/Cmd -
Alt/Opt - Shift i kliknij kontrolkę panoramy.
● Aby wyłączyć pomijanie panoramowania, naciśnij Ctrl/Cmd - Alt/Opt - Shift i kliknij 
ponownie.
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Gdy panoramowanie jest pomijane dla kanału, dzieje się co następuje:

● Kanały mono są wyśrodkowane.
● Kanały stereo są mocno panoramowane w lewo i w prawo.
● Kanały surround są wyśrodkowane

Używanie Solo i Mute
Możesz wyciszyć jeden lub kilka kanałów za pomocą opcji Solo i Mute

● Aby wyciszyć kanał, kliknij Mute (Wycisz).
Kliknij ponownie, aby dezaktywować stan wyciszenia dla kanału.
● Aby wyciszyć wszystkie inne kanały, kliknij opcję Solo dla kanału.
Kliknij ponownie, aby dezaktywować stan solo.
● Aby dezaktywować stany wyciszenia lub solo dla wszystkich kanałów jednocześnie, kliknij 
Deactivate All Mute States (Dezaktywuj wszystkie stany wyciszenia) lub Deactivate All Solo 
States (Dezaktywuj wszystkie stany solo) na pasku narzędzi.
● Aby aktywować ekskluzywny tryb solo, przytrzymaj Ctrl/Cmd i kliknij Solo dla kanału.
Przyciski Solo na wszystkich pozostałych kanałach są nieaktywne.
● Aby aktywować solową partię dla kanału, naciśnij Alt/Opt i kliknij Solo.

    
Możesz także kliknąć i przytrzymać Solo, aby aktywować partię w pojedynkę. W tym trybie kanał 
nie jest wyciszony, gdy grasz solo na innym kanale. Alt/Opt – kliknij ponownie, aby wyłączyć 
pojedynczą partię.

Listen Mode (Tryb słuchania)
Tryb odsłuchu pozwala na szybkie sprawdzenie sygnału pochodzącego z wybranych kanałów bez 
przerywania i ingerencji w rzeczywisty miks. Na przykład podczas sesji nagraniowej inżynier 
dźwięku w reżyserce może wyciszyć sygnał pochodzący od jednego z muzyków, podczas gdy 
nagrywanie jest kontynuowane bez zakłóceń.

UWAGA
Aby włączyć tryb słuchania, musisz włączyć Control Room (Pomieszczenie kontrolne).

● Aby włączyć tryb słuchania, kliknij Listen (Słuchaj) dla kanału. To kieruje kanał do 
pomieszczenia kontrolnego bez przerywania przepływu sygnału.
● Aby wyłączyć tryb odsłuchu dla wszystkich kanałów jednocześnie, kliknij Deactivate All Listen 
States (Dezaktywuj wszystkie stany odsłuchu) na pasku narzędzi MixConsole.

Volume (Głośność)

Każdy kanał w sekcji suwaków MixConsole ma suwak głośności. Poziomy tłumików są 
wyświetlane poniżej tłumika, w dB dla kanałów związanych z audio i jako głośność MIDI (od 0 do 
127) dla kanałów MIDI.

● Aby zmienić głośność, przesuń suwak w górę lub w dół.
● Aby dokładnie wyregulować głośność, naciśnij klawisz Shift podczas przesuwania suwaków.
● Aby zresetować głośność do wartości domyślnej, naciśnij klawisze Ctrl/Cmd i kliknij suwak.

W przypadku kanałów audio suwak głośności kontroluje głośność kanału, zanim zostanie on 
skierowany do szyny wyjściowej, bezpośrednio lub przez kanał grupowy. W przypadku kanałów 
wyjściowych suwak głośności steruje głównym poziomem wyjściowym wszystkich kanałów audio,
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które są kierowane do szyny wyjściowej. W przypadku kanałów MIDI suwak głośności kontroluje 
zmiany głośności w MixConsole, wysyłając komunikaty głośności MIDI do podłączonych 
instrumentów, które są ustawione tak, aby odpowiadały na komunikaty MIDI.

Menu globalnych ustawień licznika
Charakterystykę miernika dla kanałów audio można zmienić za pomocą menu kontekstowego 
miernika kanału.
Kliknij prawym przyciskiem myszy miernik kanału i wybierz jedną z następujących opcji z menu 
Global Meter Settings (Globalne ustawienia miernika):

Meter Peak Options - Hold Peaks (Opcje pików miernika - Trzymaj piki)
        Najwyższe zarejestrowane poziomy są utrzymywane i wyświetlane jako statyczne poziome 
        linie na mierniku.
Meter Peak Options - Hold Forever (Opcje Meter Peak - Hold Forever)
        Jeśli ta opcja jest włączona, poziomy szczytowe są wyświetlane do momentu zresetowania 
        liczników. Jeśli ta opcja jest wyłączona, możesz użyć parametru Meters’ Peak Hold Time  
        (Miernik Maksymalnego czasu utrzymywania) w oknie dialogowym Preferences (Preferencje)
        (strona Metering (Pomiary)), aby określić, jak długo utrzymywane są poziomy szczytowe. 
        Czas utrzymywania piku może wynosić od 500 do 30000 ms.
Meter Position - Input (Pozycja miernika — wejście)
        Jeśli ta opcja jest włączona, mierniki pokazują poziomy wejściowe dla wszystkich kanałów 
        audio i kanałów wejścia/wyjścia. Mierniki wejściowe są po wzmocnieniu wejściowym.
Meter Position - Post-Fader (Pozycja miernika – Po suwaku)
        Jeśli ta opcja jest włączona, mierniki pokazują poziomy po suwaku.
Meter Position - Post-Panner (Pozycja miernika — Po panoramie)
        Jeśli ta opcja jest włączona, mierniki pokazują poziomy po tłumiku, a także odzwierciedlają 
        ustawienia panoramy.
Reset Meters (Zresetuj liczniki)
        Resetuje liczniki.

Konfigurowanie kolorów miernika

Ustawienie kolorów miernika może pomóc w utrzymaniu przeglądu osiąganych poziomów.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz Metering > Appearance (Pomiar > 
Wygląd).
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2. Wybierz skalę z wyskakującego menu Scale (Skala) do edycji.
UWAGA
+3 dB Digital Scale (Cyfrowa skala +3dB) jest używana w miernikach kanałowych.

3. Wykonaj jedną z poniższych czynności, aby ustawić pozycję poziomu dla zmiany koloru:
        ● Kliknij dwukrotnie pozycję poziomu po prawej stronie skali miernika i wprowadź wartość  
           poziomu (dB). Aby wprowadzić wartości dB mniejsze od zera, przed wprowadzoną liczbą 
           należy dodać znak minus.
        ● Kliknij pozycję poziomu i przeciągnij ją na określony poziom, a następnie naciśnij klawisz  
           Shift, aby uzyskać dokładniejsze pozycjonowanie.
        ● Kliknij poziomą pozycję i przesuń ją w górę lub w dół za pomocą klawiszy Strzałka w górę
           / Strzałka w dół, a następnie naciśnij klawisz Shift, aby przyspieszyć pozycjonowanie.
4. Kliknij górną lub dolną część uchwytu koloru, aby wyświetlić ramkę, a następnie w próbniku  
    kolorów wybierz kolor. 
    Dobranie tego samego koloru dla górnej i dolnej części rękojeści powoduje, że miernik 
    stopniowo zmienia kolory. Różne kolory jeszcze dokładniej wskazują zmiany poziomu.
UWAGA
● Aby dodać więcej kolorowych uchwytów, kliknij Add (Dodaj) lub Alt - kliknij poziomą pozycję 
po prawej stronie skali miernika. Każdy nowy uchwyt jest automatycznie kojarzony z domyślnym 
kolorem.
● Aby usunąć uchwyt, wybierz uchwyt i kliknij Remove (Usuń) lub Ctrl/Cmd – kliknij uchwyt.
5. Kliknij OK.

POWIĄZANE LINKI
Pomiar – wygląd na stronie 1175

Mierniki poziomu
Mierniki kanałów pokazują poziom podczas odtwarzania audio lub MIDI. Wskaźnik Meter Peak 
Level pokazuje najwyższy zarejestrowany poziom.
● Aby zresetować poziom szczytowy, Alt/Opt + kliknij wartość Meter Peak Level (Poziom 
szczytowy miernika).
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UWAGA
Kanały wejściowe i wyjściowe mają wskaźniki przesterowania. Kiedy się zaświecą, zmniejsz 
wzmocnienie lub poziomy, aż wskaźnik zgaśnie.

Poziomy wejściowe

Podczas nagrywania dźwięku cyfrowego ważne jest ustawienie wystarczająco wysokich poziomów 
wejściowych, aby zapewnić niski poziom szumów i wysoką jakość dźwięku. Jednocześnie należy 
unikać obcinania (zniekształceń cyfrowych).

Ustawianie poziomów wejściowych

W MixConsole możesz ustawić poziom wejściowy. Upewnij się, że sygnał jest wystarczająco 
głośny, ale nie przekracza 0 dB.

PROCEDURA
1. Wybierz Functions Menu > Global Meter Settings > Meter Position (Menu funkcji > 
Globalne ustawienia miernika > Pozycja miernika) i aktywuj Input (Wejście).
W tym trybie mierniki poziomu kanału wejściowego pokazują poziom sygnału na wejściu szyny, 
przed dokonaniem jakichkolwiek regulacji, takich jak wzmocnienie wejściowe, korektor, efekty, 
poziom lub panorama. Pozwala to sprawdzić poziom nieprzetworzonego sygnału wchodzącego do 
sprzętu audio.
2. Odtwórz dźwięk i sprawdź miernik poziomu dla kanału wejściowego. Sygnał powinien być jak 
najgłośniejszy nie przekraczając 0 dB, czyli wskaźnik przesterowania szyny wejściowej nie 
powinien się świecić.
3. W razie potrzeby dostosuj poziom wejściowy w jeden z następujących sposobów:
         ● Dostosuj poziom wyjściowy źródła dźwięku lub zewnętrznego miksera.
         ● Jeśli to możliwe, użyj własnego programu użytkowego sprzętu audio, aby ustawić poziomy 
             wejściowe. Zapoznaj się z dokumentacją sprzętu audio.
         ● Jeśli twój sprzęt audio obsługuje funkcję panelu sterowania ASIO, możliwe jest  
            skonfigurowanie ustawień poziomu sygnału wejściowego. Aby otworzyć panel sterowania 
            ASIO, wybierz Studio > Studio Setup (Studio > Konfiguracja Studio) i na liście Devices 
            (Urządzenia) wybierz swoją kartę dźwiękową. Po wybraniu tej opcji możesz otworzyć panel
            sterowania, klikając opcję Control Pannel (Panel sterowania) w sekcji ustawień po prawej 
            stronie.
4. Opcjonalnie: Wybierz Functions Menu > Global Meter Settings > Meter Position (Menu 
funkcji > Globalne ustawienia miernika > Pozycja miernika) i aktywuj Post-Fader.

UWAGA
Pozwala to sprawdzić poziom dźwięku zapisywanego do pliku na dysku twardym, co jest konieczne
tylko wtedy, gdy dokonujesz jakichkolwiek regulacji kanału wejściowego.

5. Opcjonalnie: W sekcji Channel Racks (Regały kanałów), w racku Inserts (insertów, wstawek) 
kliknij miejsce i wybierz efekt lub w racku Equalizers () wprowadź ustawienia EQ. W przypadku 
niektórych efektów możesz chcieć dostosować poziom sygnału wchodzącego do efektu. Użyj do 
tego funkcji wzmocnienia wejścia. Naciśnij Shift lub Alt/Opt, aby dostosować wzmocnienie 
wejścia.
6. Odtwórz dźwięk i sprawdź miernik poziomu kanału wejściowego.
Sygnał powinien być w miarę głośny, nie przekraczając 0 dB, czyli wskaźnik przesterowania szyny 
wejściowej nie powinien się świecić.
7. W razie potrzeby użyj suwaka kanału wejściowego, aby wyregulować poziom sygnału.
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Obcinanie
Obcinanie zwykle występuje w sprzęcie audio, gdy sygnał analogowy jest zbyt głośny i dlatego jest 
konwertowany na cyfrowy w sprzętowych przetwornikach A/D.

Obcinanie może również wystąpić, gdy sygnał z magistrali wejściowej jest zapisywany do pliku na 
dysku twardym. Dzieje się tak dlatego, że można dokonywać ustawień szyny wejściowej, dodawać 
korektor, efekty itp. do sygnału podczas jego nagrywania. Może to podnieść poziom sygnału, co 
spowoduje przesterowanie w nagranym pliku audio.

Regały (stojaki) kanałów
Sekcja Channel Racks (Stojaki kanałów) zawiera określone funkcje MixConsole, takie jak 
obsługa routingu, wstawiania lub wysyłania. Są one zorganizowane w stojakach.

             

UWAGA
MixConsole w dolnej strefie okna Project zawiera tylko stojak Inserts (Wstawek) i Sends
(Wysyłek).

POWIĄZANE LINKI
Trasowanie na stronie 382
Pre (filtry/wzmocnienie/faza) na stronie 384
Wstawki na stronie 386
Korektory (EQ) na stronie 387
Paski kanałów na stronie 390
Wysyłki na stronie 397
Cue Sends na stronie 398
Trasowanie bezpośrednie na stronie 399
Śledź szybkie sterowanie na stronie 401
Panele urządzeń na stronie 402

Kopiowanie i przenoszenie ustawień racka (regału, stojaka) i kanału
Możesz użyć funkcji przeciągnij i upuść, aby skopiować lub przenieść ustawienia regału i kanału.

UWAGA
Ta funkcja jest dostępna tylko w oknie MixConsole.
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Przeciągnij i upuść działa między różnymi kanałami lub różnymi gniazdami w szafie (regale, 
stojaku) na tym samym kanale. Podczas przeciągania wizualna informacja zwrotna wskazuje 
sekcje, w których można upuścić ustawienia.

Obowiązują następujące zasady:

● Aby przenieść ustawienia statywu z jednego statywu do drugiego, przeciągnij statyw i upuść go   
    na statywie, do którego chcesz przenieść ustawienia.
● Aby skopiować ustawienia statywu z jednego statywu do drugiego, naciśnij Alt/Opt , przeciągnij 
    statyw i upuść go na statywie, do którego chcesz skopiować ustawienia.
● Aby skopiować ustawienia kanału z jednego kanału do drugiego, przeciągnij kanał i upuść go na 
    kanale, do którego chcesz skopiować ustawienia.
● Aby skopiować ustawienia kanału z jednego kanału do drugiego, w tym ustawienia kierowania  
    bezpośredniego i kierowania wyjściowego, naciśnij klawisz Alt/Opt , przeciągnij kanał i upuść 
    go na kanale, do którego chcesz skopiować ustawienia.

Możesz kopiować ustawienia racka i kanału między różnymi typami kanałów, pod warunkiem, że 
kanały docelowe mają odpowiednie ustawienia.

● Na przykład kopiowanie z kanałów wejścia/wyjścia pozostawia niezmienione ustawienia 
wysyłania w kanale docelowym.
● W przypadku projektów z dźwiękiem przestrzennym wszelkie efekty insertowe kierowane do 
kanałów głośników przestrzennych zostają wyciszone po wklejeniu ustawień do kanału mono lub 
stereo.

Routing (Trasowanie, kierowanie)
Rack Routing (Regał stojak trasowania) umożliwia skonfigurowanie trasowania wejść i wyjść, 
czyli ustawienie szyn wejściowych i wyjściowych.

UWAGA
Ten rack kanałów jest dostępny tylko w oknie MixConsole.

Szyny wejściowe są używane podczas nagrywania na ścieżce audio. W takim przypadku musisz 
wybrać, z której magistrali wejściowej odbierany jest dźwięk.

UWAGA
Ustawienia wprowadzone dla kanału wejściowego będą stałą częścią nagranego pliku audio.

Szyny wyjściowe są używane podczas odtwarzania kanału audio, grupowego lub FX. W takim 
przypadku należy skierować kanał do szyny wyjściowej.

Konfigurowanie routingu
Możesz skonfigurować szyny wejściowe i wyjściowe w Routing Rack w MixConsole.

WARUNEK WSTĘPNY
Skonfiguruj szyny i kanały grupowe w oknie Audio Connections (Połączenia audio).

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks i aktywuj Routing, aby wyświetlić rack Routing 
nad sekcją tłumików.
2. Kliknij jedno z gniazd kasety Routing, aby otworzyć wyskakujące menu routingu wejściowego 
lub wyjściowego dla kanału.
3. W selektorze routingu wybierz wpis.

386



● Aby ustawić trasowanie dla wielu wybranych kanałów jednocześnie, naciśnij Shift - Alt/Opt i 
wybierz magistralę.
● Aby ustawić kilka wybranych kanałów na wzrastające szyny (drugi wybrany kanał do drugiej 
szyny, trzeci do trzeciej szyny itd.), naciśnij klawisz Shift i wybierz szynę.
● Aby rozłączyć przypisanie magistrali wejściowej lub wyjściowej, wybierz opcję No Bus (Brak 
magistrali).

Magistrale wejściowe
Selektor trasowania wejść wyświetla tylko te szyny, które odpowiadają konfiguracji kanałów.

UWAGA
Jeśli wybierzesz kanał grupowy jako wejście dla kanału audio, możesz nagrać downmix.

Konfiguracje trasowania wejść dla kanałów mono
Dla kanałów mono dostępne są następujące konfiguracje trasowania wejść:

● Szyny wejściowe mono lub pojedyncze kanały w obrębie szyny wejściowej stereo lub surround.
● Wejścia zewnętrzne skonfigurowane na karcie Control Room (Pomieszczenie kontrolne) 
   w oknie Audio Connections (Połączenia audio). Mogą to być kanały mono lub pojedyncze 
kanały w szynie stereo lub surround. Mogą być również kierowane do wejścia Talkback 
(Rozmowa).
● Szyny wyjściowe mono, szyny wyjściowe grup mono lub szyny wyjściowe kanału mono FX. Nie
powinny one prowadzić do sprzężenia zwrotnego.

POWIĄZANE LINKI
Trasowanie (Routing, kierowanie) na stronie 382

Konfiguracje routingu wejściowego dla kanałów stereo
W przypadku kanałów stereo dostępne są następujące konfiguracje kierowania sygnału 
wejściowego:

● Szyny wejściowe mono lub stereo lub szyny potomne stereo w szynie surround.
● Wejścia zewnętrzne skonfigurowane na karcie Control Room (Pomieszczenie kontrolne) w 
oknie Audio Connections (Połączenia audio). Mogą to być szyny wejściowe mono lub szyny 
wejściowe stereo. Mogą być również kierowane do wejścia Talkback (Rozmowa).
● Szyny wyjściowe mono lub stereo, szyny wyjść grupowych mono lub stereo oraz szyny wyjść 
kanałów mono lub stereo FX. Nie powinny one prowadzić do sprzężenia zwrotnego.
 
POWIĄZANE LINKI
Trasowanie (Routing, kierowanie) na stronie 382

Konfiguracje routingu wejściowego dla kanałów surround
W przypadku kanałów surround dostępne są następujące konfiguracje kierowania sygnału 
wejściowego:

● Szyny wejściowe surround.
● Wejścia zewnętrzne skonfigurowane na karcie Control Room (Pomieszczenie kontrolne) 
w oknie Audio Connections (Połączenia audio). Muszą one mieć taką samą konfigurację 
wejściową.
● Szyny wyjściowe.
Muszą one mieć taką samą konfigurację wejść i nie powinny powodować sprzężenia zwrotnego.
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POWIĄZANE LINKI
Trasowanie (Routing, kierowanie) na stronie 382

Szyny wyjściowe
Dla szyn wyjściowych możliwe jest dowolne przyporządkowanie.

Możesz przekierować wyjście kanałów audio, instrumentalnych, grupowych, FX i rewire do 
kanałów wyjściowych, grupowych, kanałów FX lub użyć go jako źródła łańcucha bocznego efektu.

Kierowanie wyjść z wielu kanałów audio do grupy pozwala kontrolować poziomy kanałów za 
pomocą jednego suwaka i stosować te same efekty i korekcję do wszystkich kanałów.

Korzystanie z kanałów grupowych

Możesz skierować wyjścia z wielu kanałów audio do grupy. Umożliwia to sterowanie poziomami 
kanałów za pomocą jednego suwaka, stosowanie tych samych efektów i korektora do wszystkich 
kanałów itp. Można również wybrać kanał grupowy jako wejście dla ścieżki audio, aby na przykład
nagrać miks oddzielnych ścieżek.

WARUNEK WSTĘPNY
Utworzyłeś i skonfigurowałeś ścieżkę kanału grupowego w stereo.

PROCEDURA
1. Poprowadź ścieżkę kanału grupowego do szyny wyjściowej.
2. Dodaj efekty do kanału grupowego jako efekty insertowe.
3. Skieruj monofoniczną ścieżkę audio do kanału grupowego.

WYNIK
Sygnał z monofonicznej ścieżki audio jest przesyłany bezpośrednio do grupy, gdzie przechodzi 
przez efekt insertowy w stereo. 

Pre (Filters/Gain/Phase) (Pre (filtry/wzmocnienie/faza)
Stojak wstępny dla kanałów związanych z dźwiękiem zawiera filtr górnoprzepustowy i 
dolnoprzepustowy, a także ustawienia wzmocnienia i fazy.

UWAGA
Ten rack kanałów jest dostępny tylko w oknie MixConsole.

W przypadku kanałów MIDI stojak Pre umożliwia otwarcie transformatora wejściowego

UWAGA
Nie można edytować ustawień Pre rack na ekranie krzywej EQ

POWIĄZANE LINKI
Okno transformatora wejściowego na stronie 772
Ustawienia korektora na stronie 388
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Dokonywanie ustawień filtra
Każdy kanał związany z audio ma oddzielne filtry górnoprzepustowe i dolnoprzepustowe, które 
umożliwiają tłumienie sygnałów o częstotliwościach wyższych lub niższych niż częstotliwość 
odcięcia.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks (Stojaki, regały) i aktywuj Pre 
(Filters/Gain/Phase) Pre(Filtry/wzmocnienie/Faza), aby wyświetlić Pre Rack nad sekcją suwaka.
2. Kliknij po lewej stronie filtra górnoprzepustowego, aby aktywować filtr górnoprzepustowy. Masz
następujące opcje:
        ● Przeciągnij suwak, aby dostosować częstotliwość odcięcia. Dostępny zakres obejmuje zakres
           od 20 kHz do 50 Hz.
        ● Kliknij opcję Select Filter Slope (Wybierz nachylenie filtra) po prawej stronie filtra 
           górnoprzepustowego, aby wybrać nachylenie filtra. Możesz wybrać pomiędzy 6, 12, 24, 36 
           i 48 dB. Wartość domyślna to 12 dB.
3. Kliknij po lewej stronie filtra dolnoprzepustowego, aby aktywować filtr dolnoprzepustowy. Masz
następujące opcje:
       ● Przeciągnij suwak, aby dostosować częstotliwość odcięcia.
           Dostępny zakres obejmuje zakres od 20 Hz do 20 kHz.
       ● Kliknij opcję Select Filter Slope (Wybierz nachylenie filtra) po prawej stronie filtra  
          dolnoprzepustowego, aby wybrać nachylenie filtra. Możesz wybrać pomiędzy 6, 12, 24, 36 
          i 48 dB. Wartość domyślna to 12 dB.

WYNIK
Zmienione ustawienia są widoczne na wyświetlaczu krzywej. Jeśli wyłączysz filtry 
górnoprzepustowy i dolnoprzepustowy, krzywe filtrów zostaną usunięte z wyświetlacza. Pominięte 
filtry górnoprzepustowe i dolnoprzepustowe są wyświetlane w innym kolorze.

Dokonywanie ustawień wzmocnienia sygnału wejściowego

Suwak Pre-Gain pozwala zmienić poziom sygnału zanim dotrze on do EQ i sekcji efektów. Jest to 
przydatne, ponieważ poziom wchodzący w określone efekty może zmienić sposób, w jaki wpływa 
na sygnał. Na przykład kompresor można napędzać mocniej, zwiększając wzmocnienie wejściowe. 
Wzmocnienie może być również użyte do podbicia poziomu słabo nagranych sygnałów.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks i aktywuj Pre (Filters/Gain/Phase), aby 
wyświetlić Pre Rack nad sekcją suwaka.
2. Przeciągnij suwak Gain (Wzmocnienie) w lewo lub w prawo, aby zmniejszyć lub zwiększyć 
wzmocnienie.

Dokonywanie ustawień fazy
Każdy kanał związany z audio i kanał wejścia/wyjścia ma przycisk Phase (Faza), który umożliwia 
korekcję fazy dla zbalansowanych linii i mikrofonów, które są podłączone odwrotnie lub które są 
przesunięte w fazie ze względu na ich położenie.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks i aktywuj Pre (Filters/Gain/Phase), aby 
wyświetlić Pre Rack nad sekcją suwaka.
2. Aktywuj opcję Phase (Faza), aby odwrócić polaryzację fazy sygnału.
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Wstawki , inserty (Inserts)
Stojak insertów dla kanałów związanych z audio zawiera gniazda efektów insertowych, które 
umożliwiają ładowanie efektów insertowych dla kanału. W przypadku kanałów MIDI można 
ładować wstawki MIDI.

Więcej informacji można znaleźć w osobnym dokumencie Informacje o wtyczkach (Plug-in 
Reference).

POWIĄZANE LINKI
Efekty audio na stronie 443

Dodawanie efektów insertowych
Możesz dodawać efekty insertowe do kanałów MixConsole.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks i aktywuj Inserts, aby pokazać Rack Inserts nad 
sekcją suwaka.
2. Kliknij jedno z gniazd wstawki, aby otworzyć selektor wstawki.
3. Kliknij efekt insertowy, aby go wybrać.

WYNIK
Wybrany efekt insertowy zostanie załadowany i automatycznie aktywowany. Zostanie otwarty 
panel wtyczek.

Zmiana liczby insertów przed i po tłumiku
Dla każdego kanału związanego z audio możesz dodać inserty przed i za tłumikiem oraz 
dostosować ich liczbę.

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Kliknij prawym przyciskiem myszy efekt insertowy w pozycji przed tłumikiem i z menu 
           kontekstowego wybierz Set as last Pre-Fader Slot (Ustaw jako ostatnie gniazdo) przed 
           tłumikiem.
        ● Kliknij i przeciągnij separator przed/po tłumiku w górę lub w dół.

WYNIK
Liczba gniazd przed i po tłumiku jest dostosowana. Kolor i linia oddzielająca pokazują, który efekt 
jest przed tłumikiem, a który po tłumiku.

                                 

Pomijanie efektów insertowych
Możesz ominąć wszystkie efekty insertowe.
● Aby pominąć wszystkie przekładki, kliknij opcję Bypass (Obejście) u góry stojaka na inserty.
● Aby ominąć pojedynczą wstawkę, kliknij przycisk po lewej stronie gniazda wstawki.
● Aby dezaktywować obejście, ponownie kliknij przycisk.
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Aktywacja łańcucha bocznego dla insertów

Niektóre inserty posiadają funkcję łańcucha bocznego (side-chain).

PROCEDURA
1. Kliknij prawym przyciskiem myszy efekt insertowy.
2. Z menu kontekstowego wybierz opcję Activate/Deactivate Side-Chaining (Włącz/wyłącz 
łańcuch boczny).

Zapisywanie/ładowanie presetów łańcucha efektów (FX Chain 
Presets)

Możesz zapisywać i ładować wszystkie ustawienia statywu insertowego za pomocą presetów 
łańcucha FX. Presety łańcucha efektów mają rozszerzenie nazwy pliku .fxchainpreset.

PROCEDURA
● W prawym górnym rogu stojaka na Inserts (Inserty) otwórz menu podręczne Presets 
(Ustawienia wstępne) i wykonaj jedną z następujących czynności:
          ● Aby zapisać bieżące ustawienia jako preset, wybierz Save FX Chain Preset (Zapisz preset 
             łańcucha efektów) i nazwij swój preset.
          ● Aby załadować preset, wybierz opcję Load FX Chain Preset (Załaduj preset łańcucha 
             efektów)  i wybierz preset.

UWAGA
Możesz także zastosować inserty wraz z ustawieniami EQ i channel strip (listwy kanałowej)      
 z presetów ścieżek. Możesz ładować, oznaczać i zapisywać presety łańcucha efektów w MediaBay

Korektory (EQ)
Stojak korektorów (Equalizers (EQ)) jest dostępny tylko dla kanałów związanych z audio. Posiada 
wbudowany korektor parametryczny z maksymalnie 4 pasmami dla każdego kanału audio.

UWAGA
Ten rack (stojak, regał, szafa) kanałów jest dostępny tylko w oknie MixConsole.

Aktywacja pasm korektora
Na stojaku EQ można aktywować do 4 pasm EQ dla każdego kanału audio.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks (stojaki, regały, szafy) i aktywuj Equalizers 
(korektory), aby pokazać rack EQ nad sekcją suwaków.
2. Kliknij Activate/Deactivate Band (Włącz/wyłącz pasmo), aby aktywować pasmo EQ.
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Ustawienia korektora
Możesz dokonać ustawień korektora dla 4 pasm. Mają one różne domyślne wartości częstotliwości i
różne nazwy Q. Jednak wszystkie mają ten sam zakres częstotliwości (20 Hz do 20 kHz). Możesz 
określić różne typy filtrów dla każdego modułu.

             

1    Bypass EQ (obejście korektora)
       Kliknij, aby ominąć wszystkie pasma EQ.
2   Curve Display (Wyświetlacz krzywej)
       Kliknij wyświetlacz w kanale, aby wyświetlić większą wersję. Wyświetlanie jest również  
       dostępne w sekcji Equalizers (Korektory) narzędzia Track Inspector (Inspektor ścieżki) w  
       oknie Project oraz w oknie Channel Settings (Ustawienia kanału).
Kliknięcie wyświetlanej krzywej powoduje powiększenie widoku i wyświetlenie kursora 
krzyżykowego. Bieżąca pozycja myszy pokazuje częstotliwość, wartość nuty, przesunięcie i 
poziom na górze lub na dole wyświetlacza.
● Kliknij, aby dodać punkt krzywej i aktywować odpowiednie pasmo EQ.
● Kliknij dwukrotnie punkt krzywej, aby go dezaktywować.
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● Przeciągnij punkt krzywej w górę lub w dół, aby dostosować wzmocnienie.
● Naciśnij Ctrl/Cmd, aby edytować tylko wzmocnienie (gain).
● Przeciągnij w lewo lub w prawo, aby dostosować częstotliwość.
● Naciśnij Alt/Opt, aby edytować tylko częstotliwość (frequency).
● Naciśnij klawisz Shift podczas przeciągania, aby ustawić współczynnik Q.
● Aby odwrócić krzywą EQ, otwórz menu kontekstowe i wybierz Invert EQ Settings (Odwróć 
ustawienia EQ)

Końcowa krzywa pokazuje ustawienia EQ, a także aktywne filtry górnoprzepustowe i 
dolnoprzepustowe ustawień Pre rack (statyw, regał wstępny). Pominięte ustawienia filtrów są 
wyświetlane innym kolorem niż aktywne ustawienia. Wyłączone ustawienia filtrów są ukryte na 
wyświetlaczu.
UWAGA
Filtrów górnoprzepustowych i dolnoprzepustowych nie można edytować na ekranie krzywej. Aby 
edytować filtry, otwórz Pre rack (statyw wstępny).
3    Select Preset (Wybierz ustawienie wstępne)
       Otwiera wyskakujące menu, w którym można załadować/zapisać ustawienie wstępne.
4    Activate/Deactivate Band (Włącz/wyłącz pasmo)
       Kliknij, aby aktywować/dezaktywować pasmo EQ.

Ustawienia pasma

             

1    Activate/Deactivate Band (Włącz/wyłącz pasmo)
      Włącza/wyłącza pasmo korektora.
2    Gain (Wzmocnienie)
      Ustawia wielkość odcięcia lub wzmocnienia. Zakres wynosi ±24 dB.
3    Frequency (Częstotliwość)
      Ustawia częstotliwość środkową zakresu częstotliwości, który ma być obcięty lub wzmocniony.
      Częstotliwość można ustawić w Hz lub jako wartość nuty. Jeśli wpiszesz wartość nuty, 
      częstotliwość zostanie automatycznie wyświetlona w Hz. Na przykład wartość nuty A3 ustawia 
      częstotliwość na 440 Hz. Podczas wprowadzania wartości nuty można również wprowadzić 
      przesunięcie centowe. Na przykład wprowadź A5 -23 lub C4 +49.
UWAGA
Upewnij się, że wprowadzono spację między nutą a przesunięciem centa. Tylko w tym przypadku 
brane są pod uwagę przesunięcia centów.
4   Q-Factor (Współczynnik Q)
      Określa szerokość dotkniętego zakresu częstotliwości. Wyższe wartości dają węższe zakresy  
      częstotliwości.
5    Select EQ Band Type (Wybierz typ pasma EQ)
Otwiera wyskakujące menu, w którym można wybrać typ EQ dla pasma. Pasma 1 i 4 mogą działać 
jako filtry parametryczne, półkowe lub dolnoprzepustowe. Pasma EQ 2 i 3 są zawsze filtrami 
parametrycznymi.

POWIĄZANE LINKI
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Wprowadzanie ustawień filtra na stronie 385

Zapisywanie/ładowanie ustawień EQ
Możesz zapisywać i ładować ustawienia EQ

PROCEDURA
● W prawym górnym rogu stojaka EQ otwórz menu podręczne ustawień wstępnych i wykonaj 
jedną z następujących czynności:
         ● Aby zapisać bieżące ustawienia jako ustawienie wstępne, wybierz opcję Save Preset 
            (Zapisz ustawienie wstępne) i nazwij swoje ustawienie wstępne.
         ● Aby załadować ustawienie wstępne, wybierz opcję Load Preset (Załaduj ustawienie 
            wstępne) i wybierz ustawienie wstępne.

UWAGA
Możesz także zastosować EQ razem z ustawieniami wstawiania i paska kanałów z ustawień 
wstępnych ścieżki. Możesz ładować, oznaczać i zapisywać ustawienia EQ w MediaBay.

Paski kanałowe
Stojak na Channel Strip (paski kanałów) jest dostępny tylko dla kanałów związanych z audio. 
Pozwala na załadowanie wbudowanych modułów przetwarzających dla osobnych kanałów. Możesz
zmienić położenie poszczególnych modułów w przepływie sygnału poprzez przeciąganie i 
upuszczanie.

UWAGA
Rack Channel Strip (Regał paska kanałowego) jest dostępny tylko w oknie MixConsole.

Noise Gate (Brama szumów)
        Umożliwia wyciszenie sygnałów dźwiękowych poniżej ustawionego poziomu progowego. 
        Gdy tylko poziom sygnału przekroczy ustawiony próg, bramka otwiera się, przepuszczając   
        sygnał.
Compressor (Kompresor)
        Umożliwia tworzenie płynnych efektów kompresji. Przeciągnij kompresor w górę lub w dół, 
        aby zmienić jego położenie w strumieniu sygnału.
EQ
        Umożliwia wprowadzanie ustawień EQ
Tools (Narzędzia)
        Zapewnia różne narzędzia.
Sat
        Pozwala dodać ciepła do dźwięku.
Limit
        Pozwala uniknąć przycinania nawet przy wysokich poziomach

Noise Gate (Brama szumów)
Bramkowanie szumów wycisza sygnały audio poniżej ustawionego progu. Gdy tylko poziom 
sygnału przekroczy próg, bramka otwiera się, przepuszczając sygnał.

Threshold (Próg)
         Określa poziom aktywacji Bramy. Poziomy sygnału powyżej ustawionego progu powodują 
         otwarcie bramki, a poziomy sygnału poniżej ustawionego progu zamykają bramę.
Range (Zakres)
         Reguluje tłumienie bramy, gdy jest zamknięta. Im wyższa wartość, tym wyższy poziom 
         sygnału przechodzącego przez zamkniętą bramkę.
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Attack (Atak)
         Ustawia czas, po którym brama otwiera się po uruchomieniu.
Release (Uwolnienie)
         Ustawia czas, po którym bramka się zamyka.
Listen Filter (Filtr nasłuchu)
         Umożliwia monitorowanie przefiltrowanego sygnału.
Activate Filter (Aktywuj filtr)
         Aktywuje/dezaktywuje wewnętrzny łańcuch boczny i umożliwia skonfigurowanie filtra w 
         celu modyfikacji wykrywania sygnału.
Auto Release (Automatyczne zwolnienie)
         Automatycznie wyszukuje najlepsze ustawienie zwolnienia dla materiału audio.
Filter Frequency (Częstotliwość filtra)
         Jeśli wewnętrzny łańcuch boczny jest aktywny, ten parametr ustawia częstotliwość filtra do  
         wykrywania sygnału.
Q-Factor (Współczynnik Q)
         Jeśli wewnętrzny łańcuch boczny jest aktywny, ten parametr ustawia rezonans filtra do 
         wykrywania sygnału.
State LED (Dioda stanu)
         Wskazuje, czy brama jest otwarta (dioda świeci na zielono), zamknięta (dioda świeci na 
         czerwono) lub w stanie pośrednim (dioda świeci na żółto).

Compressor (Kompresor)
Ten moduł listwy kanałowej zmniejsza zakres dynamiki audio, sprawiając, że cichsze dźwięki stają 
się głośniejsze, a głośniejsze są cichsze lub jedno i drugie.

Otwórz wyskakujące menu, aby wybrać między Standard Compressor (kompresorem 
standardowym, Tube Compressor (kompresorem rurowym) i VintageCompressor (kompresorem 
vintage (Zabytkowy kompresor)).

Standard Compressor (kompresor standardowy)

Kompresor standardowy umożliwia tworzenie płynnych efektów kompresji. Przeciągnij 
kompresor w górę lub w dół, aby zmienić jego położenie w strumieniu sygnału.

Threshold (Próg)
         Określa poziom, przy którym włącza się kompresor. Przetwarzane są tylko poziomy sygnału 
         powyżej ustawionego progu.
Ratio (Stosunek)
         Ustawia wielkość redukcji wzmocnienia, która jest stosowana do sygnałów powyżej 
         ustawionego progu. Stosunek 3:1 oznacza, że na każde 3 dB wzrostu poziomu wejściowego 
         poziom wyjściowy wzrasta o 1 dB.
Attack (Atak)
Określa, jak szybko kompresor reaguje na sygnały powyżej ustawionego progu. Jeśli czas ataku jest
długi, większa część wczesnej części sygnału przechodzi przez nieprzetworzoną.
Release (Uwolnienie)
         Ustawia czas, po którym wzmocnienie powróci do pierwotnego poziomu, gdy sygnał spadnie 
         poniżej progu.
Auto Make-up (Automatyczny makijaż)
         Automatycznie dostosowuje wyjście do utraty wzmocnienia.
Auto Release (Automatyczne zwolnienie)
         Automatycznie wyszukuje najlepsze ustawienie Release dla materiału audio.
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Make-Up Gain (Wzmocnienie makijażu) 
          Kompensuje utratę wzmocnienia wyjściowego spowodowaną kompresją.
Gain Reduction LED (Dioda redukcji wzmocnienia)
          Wskazuje stopień kompresji sygnału.

POWIĄZANE LINKI
Kompresor  standardowy — widok szczegółów na stronie 409

Tube Compressor (kompresor rurowy)

Tube Compressor ze zintegrowaną symulacją rury pozwala uzyskać płynne i ciepłe efekty 
kompresji. Miernik VU pokazuje wielkość redukcji wzmocnienia. Ten kompresor ma wewnętrzną 
sekcję łańcucha bocznego, która umożliwia filtrowanie sygnału wyzwalającego.

Input Gain (Wzmocnienie wejściowe)
          Określa stopień kompresji. Im wyższe wzmocnienie wejściowe, tym większa kompresja.
Output Gain (Wzmocnienie wyjściowe)
          Ustawia wzmocnienie wyjściowe.
Gain Reduction LED (Dioda redukcji wzmocnienia)
          Wskazuje stopień kompresji sygnału.
Attack (Atak)
          Określa szybkość reakcji kompresora. Jeśli czas ataku jest długi, większa część początkowej  
          części sygnału przechodzi przez nieprzetworzoną.
Release (Uwolnienie)
          Ustawia czas, po którym wzmocnienie powraca do pierwotnego poziomu.
Auto Release (Automatyczne zwolnienie)
          Automatycznie wyszukuje najlepsze ustawienie Release dla materiału audio.
Drive (Prowadź)
          Kontroluje stopień nasycenia rury.
Mix (Mieszać)
          Ustawia równowagę poziomu między sygnałem suchym i mokrym.

POWIĄZANE LINKI
Kompresor rurowy – Szczegóły na stronie 409

VintageCompressor (Kompresor zabytkowy)

VintageCompressor jest wzorowany na kompresorach typu vintage.

Input Gain (Wzmocnienie wejściowe)
         W połączeniu z ustawieniem Output Gain ten parametr określa stopień kompresji. Im wyższe 
         ustawienie wzmocnienia wejściowego i niższe ustawienie wzmocnienia wyjściowego, tym  
         większa kompresja.
Output Gain (Wzmocnienie wyjściowe)
         Ustawia wzmocnienie wyjściowe.
Attack (Atak)
        Określa szybkość reakcji sprężarki. Jeśli czas ataku jest długi, większa część wczesnej części 
        sygnału przechodzi przez nieprzetworzoną.
Release (Uwolnienie)
        Ustawia czas, po którym wzmocnienie powraca do pierwotnego poziomu.
Attack Mode (Punch) (Tryb ataku (uderzenie))
        Jeśli ta opcja jest włączona, wczesna faza ataku sygnału zostaje zachowana, zachowując
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        oryginalne uderzenie w materiale audio, nawet przy krótkich ustawieniach Attack (ataku).

Auto Release (Automatyczne zwolnienie)
          Automatycznie wyszukuje najlepsze ustawienie Release dla materiału audio.
Gain Reduction LED (Dioda redukcji wzmocnienia)
         Wskazuje stopień kompresji sygnału.

POWIĄZANE LINKI
VintageCompressor — szczegóły Zobacz na stronie 410

EQ (Korektor)
Możesz dokonać ustawień korektora dla 4 pasm. Mają one różne domyślne wartości częstotliwości i
różne nazwy Q. Jednak wszystkie mają ten sam zakres częstotliwości
(20 Hz do 20 kHz). Możesz określić różne typy filtrów dla każdego modułu.

        

1   Activate/Deactivate Band (Włącz/wyłącz pasmo)
         Włącza/wyłącza pasmo korektora.
2   Select EQ Band Type (Wybierz typ pasma EQ)
         Otwiera wyskakujące menu, w którym można wybrać typ EQ dla pasma. Pasma 1 i 4 mogą 
         działać jako filtry parametryczne, półkowe lub dolnoprzepustowe. Pasma EQ 2 i 3 są zawsze 
         filtrami parametrycznymi.
3    Gain (Wzmocnienie)
        Ustawia wielkość cięcia lub wzmocnienia. Zakres wynosi ±24 dB.
4    Q-Factor (Współczynnik Q)
        Określa szerokość dotkniętego zakresu częstotliwości. Wyższe wartości dają węższe zakresy 
        częstotliwości.
5    Frequency (Częstotliwość)
        Ustawia częstotliwość środkową zakresu częstotliwości, który ma być obcięty lub 
        wzmocniony.

Tools (Narzędzia)
 Zapewnia narzędzia, które pozwalają zredukować sybilanty i osłabić lub zwiększyć wzmocnienie 
fazy ataku i zwolnienia audio.

DeEsser
Ten moduł listwy kanałowej redukuje nadmierne sybilanty, głównie w przypadku nagrań 
wokalnych i mowy. Zasadniczo jest to specjalny typ kompresora, który jest dostrojony tak, aby był 
wrażliwy na częstotliwości. wyprodukowane przez s-sound. Umieszczenie i wyrównanie mikrofonu
w bliskiej odległości może prowadzić do sytuacji, w których ogólny dźwięk jest odpowiedni, ale 
występuje problem z sybilantami.
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Threshold (Próg)
         Ustawia próg poziomu sygnału przychodzącego, powyżej którego wtyczka zaczyna 
         redukować sybilanty.
Reduction (Zmniejszenie)
         Kontroluje intensywność efektu deessingu.
Auto Threshold (Próg automatyczny)
         Automatycznie i w sposób ciągły wybiera optymalne ustawienie progu niezależnie od sygnału
         wejściowego. Opcja Auto Threshold nie działa dla sygnałów o niskim poziomie (poziom 
         szczytowy <-30dB). Aby zredukować sybilanty w takim sygnale, ustaw próg ręcznie.
Release (Uwolnienie)
        Ustawia czas, po którym efekt odessania powraca do zera, gdy sygnał spada poniżej progu.
Solo
        Umożliwia solowe pasmo częstotliwości w celu znalezienia odpowiedniej pozycji i szerokości 
        tego pasma.
Diff (Różnica)
        Pozwala odsłuchać dźwięki, które de-esser usuwa z sygnału.
Low-Frequency (Niska częstotliwość)
       Umożliwia ustawienie pasma niskich częstotliwości.
High-Frequency (Wysoka częstotliwość)
       Umożliwia ustawienie pasma wysokich częstotliwości.
Gain Reduction LED (Dioda redukcji wzmocnienia)
       Wskazuje stopień kompresji sygnału.

EnvelopeShaper (Kształtowanie obwiedni)

Ten moduł listwy kanałowej może być używany do tłumienia lub wzmacniania wzmocnienia fazy 
ataku i zwolnienia materiału audio. Pokrętłami można zmieniać wartości parametrów. Zachowaj 
ostrożność podczas zwiększania wzmocnienia i w razie potrzeby zmniejsz poziom wyjściowy, aby 
uniknąć przesterowania.

Attack (Atak) 
        Zmienia wzmocnienie fazy ataku sygnału.
Release Z(UwolnienieZ)
        Zmienia wzmocnienie fazy zwolnienia sygnału.
Attack Length (Długość ataku)
        Określa długość fazy ataku.
Output Gain (Wzmocnienie wyjściowe)
        Ustawia poziom wyjściowy.

Sat 

Pozwala dodać ciepła do dźwięku. Otwórz wyskakujące menu, aby wybrać pomiędzy Magneto II, 
Tape Saturation i Tube Saturation.

398



Magneto II

Ten moduł channel strip symuluje nasycenie i kompresję nagrań na analogowych magnetofonach.

Saturation (Nasycenie)
        Określa stopień nasycenia i generowanie podtekstów. Prowadzi to do niewielkiego wzrostu 
        wzmocnienia wejściowego.
Low-Frequency (Niska częstotliwość)
        Ustawia zakres częstotliwości pasma widma, do którego stosowany jest efekt taśmy. Aby 
        uniknąć nasycenia niższych częstotliwości, ustaw wartość na 200 Hz lub 300 Hz.
HF-Adjust (Regulacja HF)
        Ustawia ilość zawartości wysokich częstotliwości sygnału nasyconego.
High-Frequency (Wysoka częstotliwość)
        Ustawia zakres częstotliwości pasma widma, do którego stosowany jest efekt taśmy. Aby 
        uniknąć nasycenia bardzo wysokich częstotliwości, ustaw ten parametr na wartości poniżej 
        10 kHz.
HF-Adjust On/Off (Włączanie/wyłączanie regulacji HF)
        Aktywuje/dezaktywuje filtr HF-Adjust.
Solo
       Umożliwia słuchanie tylko ustawionego zakresu częstotliwości, w tym efektu symulacji taśmy. 
       Pomaga to w określeniu odpowiedniego zakresu częstotliwości.
Output (Wyjście)
       Umożliwia regulację poziomu wyjściowego.
Saturation Amount LED (Dioda LED poziomu nasycenia)
       Wskazuje stopień nasycenia sygnału.

Tape Saturation (Nasycenie taśmy)

Ten moduł channel strip (listwa kanałowa) symuluje nasycenie i kompresję nagrań na analogowych
magnetofonach.

Drive (Prowadź)
         Kontroluje stopień nasycenia taśmy.
Low-Frequency (Niska częstotliwość)
         Jest to filtr dolnopółkowy o stałej częstotliwości.
High-Frequency (Wysoka częstotliwość)
         To jest filtr górnoprzepustowy. Użyj suwaka częstotliwości, aby zmniejszyć ostrość sygnału 
        wyjściowego.
Dual (Podwójny)
        Symuluje użycie dwóch maszyn taśmowych.
Auto Gain (Automatyczne wzmocnienie)
        Automatycznie reguluje wzmocnienie.
Output (Wyjście)
       Ustawia wzmocnienie wyjściowe.
Drive Amount LED (Dioda LED ilości napędu)
       Wskazuje wielkość przesterowania sygnału.
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Tube Saturation (nasycenie lampowe)

Ten moduł channel strip (listwa kanałowa) symuluje nasycenie i kompresję nagrań analogowych 
kompresorów lampowych.

Drive (Prowadź)
        Kontroluje stopień nasycenia urządzenia lampowego.
Low-Frequency (Niska częstotliwość)
        Jest to filtr dolnopółkowy o stałej częstotliwości.
High-Frequency (Wysoka częstotliwość)
        To jest filtr górnoprzepustowy. Użyj suwaka częstotliwości, aby zmniejszyć ostrość.
Output Gain (Wzmocnienie wyjściowe)
        Ustawia wzmocnienie wyjściowe.
Drive Amount LED (Dioda LED ilości napędu)
        Wskazuje wielkość przesterowania sygnału.

Limit (Granica)

Pozwala uniknąć przycinania nawet przy wysokich poziomach. Otwórz wyskakujące menu, aby 
wybrać między Brickwall Limiter (Ogranicznikiem muru), Maximizer (Maksymizerem) 
i Standard Limiter (Ogranicznikiem standardowym)

Brickwall Limiter (Ogranicznik muru)

Brickwall Limiter gwarantuje, że poziom wyjściowy nigdy nie przekroczy ustawionego limitu. 
Dzięki szybkiemu czasowi ataku Brickwall Limiter może zredukować nawet krótkie skoki 
poziomu dźwięku bez tworzenia słyszalnych artefaktów. Jednak ten moduł listwy kanałowej tworzy
opóźnienie 1 ms.

Threshold (Próg)
        Określa poziom, przy którym włącza się ogranicznik. Przetwarzane są tylko poziomy sygnału 
        powyżej ustawionego progu.
Release (Uwolnienie)
        Ustawia czas, po którym wzmocnienie powróci do pierwotnego poziomu, gdy sygnał spadnie 
        poniżej progu.
Auto Release (Automatyczne uwolnienie)
        Automatycznie wyszukuje najlepsze ustawienie Release dla materiału audio.
Gain Reduction LED (Dioda redukcji wzmocnienia)
        Wyświetla wielkość redukcji wzmocnienia.

Maximizer (Maksymizer)

Ten moduł listwy kanałowej zwiększa głośność materiału audio bez ryzyka przesterowania.

Optimize (Optymalizuj)
         Określa głośność sygnału.
Mix Amount (Zmieszaj ilość)
         Ustawia równowagę poziomu między sygnałem suchym i mokrym.
Output (Wyjście)
         Określa maksymalny poziom wyjściowy. Ustaw to na 0 dB, aby uniknąć przesterowania.
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Gain Reduction LED (Dioda redukcji wzmocnienia)
         Wyświetla wielkość redukcji wzmocnienia.

Standard Limiter (Standardowy ogranicznik)
Ten moduł listwy kanałowej został zaprojektowany tak, aby poziom wyjściowy nie przekraczał 
ustawionego poziomu wyjściowego, aby uniknąć przesterowania w kolejnych urządzeniach. 
Standardowy ogranicznik może automatycznie regulować i optymalizować parametr Release 
zgodnie z materiałem audio lub można go ustawić ręcznie.

Input (Wejście)
          Reguluje wzmocnienie wejścia.
Release (Uwolnienie)
          Ustawia czas potrzebny na powrót wzmocnienia do pierwotnego poziomu. Jeśli funkcja Auto
          Release jest włączona, Standard Limiter (Standardowy ogranicznik) automatycznie 
          wyszukuje najlepsze ustawienie uwolnienia dla materiału audio.
Output (Wyjście)
          Określa maksymalny poziom wyjściowy.
Gain Reduction LED (Dioda redukcji wzmocnienia)
          Wyświetla wielkość redukcji wzmocnienia.

Zapisywanie/ładowanie ustawień wstępnych pasków
Możesz zapisywać i ładować ustawienia wstępne pasków. Predefiniowane ustawienia pasków mają 
rozszerzenie nazwy pliku .strippreset.

PROCEDURA
● W prawym górnym rogu racka Channel Strip (Pasek kanału) otwórz menu podręczne Presets 
(Ustawienia wstępne) i wykonaj jedną z następujących czynności:
           ● Aby zapisać bieżące ustawienia jako ustawienie wstępne, wybierz opcję Save Strip Preset
              (Zapisz ustawienie wstępne paska) i nazwij swoje ustawienie wstępne.
           ● Aby załadować ustawienie wstępne, wybierz opcję Load Strip Preset (Załaduj ustawienie
              wstępne paska) i wybierz ustawienie wstępne.
UWAGA
Możesz także zastosować ustawienia kanału wraz z ustawieniami wstawiania i korektora z ustawień
wstępnych ścieżek. Możesz ładować, oznaczać i zapisywać ustawienia paska w MediaBay.

POWIĄZANE LINKI
Ładowanie ustawień wstępnych pasków na stronie 666

Sends (Wysyłki)
Stojak Sends dla kanałów związanych z audio zawiera gniazda efektów wysyłki, które umożliwiają 
ładowanie efektów wysyłki, oraz suwaki wartości, które służą do określania poziomu wysyłki dla 
kanału. W przypadku kanałów MIDI stojak (rack) Sends wyposażony jest w gniazda efektów 
wysyłkowych, które umożliwiają ładowanie efektów wysyłkowych.

Możesz użyć wysyłek do kierowania kanałów audio, instrumentalnych, grupowych, FX i rewire do 
kanałów wyjściowych, grupowych, FX lub użyć ich jako źródeł bocznego łańcucha (side-chain) 
efektów.

Dodawanie efektów wysyłkowych
Na stojaku (regale, szafie) Sends możesz dodawać efekty wysyłkowe.

PROCEDURA
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1. Na pasku narzędzi MixConsole kliknij Racks (Stojaki, regały, szafy) i aktywuj Sends, aby 
pokazać rack nad sekcją tłumików.
2. Kliknij jedno z okienek wysyłania, aby otworzyć selektor wysyłania.
3. Kliknij efekt wysyłania, aby go wybrać.
     Wybrany efekt wysyłkowy zostanie załadowany.
4. Kliknij po lewej stronie pola, aby aktywować wysyłanie.

Pomijanie efektów wysyłkowych

Możesz ominąć (bypass) wszystkie efekty wysyłkowe.

● Aby ominąć wszystkie wysyłki, kliknij przycisk pomijania na górze stojaka Sends (wysyłek).
● Aby dezaktywować obejście, ponownie kliknij przycisk.

Dodawanie kanałów FX do wysyłki

Możesz dodać ścieżkę kanału FX, która jest kierowana do wysyłki z poziomu MixConsole.

PROCEDURA
1. Kliknij prawym przyciskiem myszy pole wysyłania, aby otworzyć menu kontekstowe.
2. Wybierz Add FX Channel to <send name> (Dodaj kanał FX do <nazwa wysyłki>).
3. W oknie Add FX Channel Track (Dodaj ścieżkę kanału FX) wybierz efekt i konfigurację.
4. Kliknij OK.

WYNIK
Ścieżka kanału FX jest dodawana w oknie Project, a wysyłka jest do niej automatycznie 
kierowana.

Wysyłanie wskazówek (cue)

Wysyłki cue umożliwiają tworzenie dyskretnych miksów cue, których wykonawcy mogą słuchać 
podczas nagrywania. Zasadniczo wysyłki cue to stereofoniczne wysyłki aux, które są kierowane do 
wyjść kanałów cue w Control Room (pomieszczeniu kontrolnym).

UWAGA
Ten (rack) regał kanałów jest dostępny tylko w oknie MixConsole.

Dla każdego kanału cue zdefiniowanego w oknie Audio Connections (połączenia Audio), każdy 
kanał w MixConsole ma cue send, z wyborem poziomu, panoramy i przed/po tłumiku.

Dodawanie wysyłek Cue    

Możesz dodać wysyłki cue, które są kierowane do wyjść kanałów cue w Control Room 
(Pomieszczeniu kontrolnym).

PROCEDURA
1. Na pasku narzędzi MixConsole (Konsola mikserska) kliknij Racks (Stojaki, regały, szafy) i 
aktywuj Cue Sends (wszkazówki wysyłkowe), aby pokazać rack nad sekcją tłumików.
2. Kliknij jedno z pól, aby otworzyć selektor wysyłania. Wyświetlane są wysyłki cue.
3. Kliknij po lewej stronie slotu, aby aktywować wysyłanie cue.

WYNIK
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Możesz teraz zmienić ustawienia poziomu i panoramy.

Kierowanie bezpośrednie (Direct Routing)
Oprócz głównego wyjścia, rack Direct Routing umożliwia skonfigurowanie 7 miejsc docelowych 
routingu, które są umieszczone za tłumikiem i za panoramą na ścieżce sygnału. W ten sposób 
możesz przełączać miejsce docelowe kanałów i tworzyć różne wersje miksów za jednym razem.

W stojaku Direct Routing pierwsze gniazdo routingu odzwierciedla trasowanie głównego wyjścia.

Bezpośrednie kierowanie jest dostępne dla audio, instrumentów, samplerów, ścieżek kanałów FX, 
grup i szyn wyjściowych. Możesz także ustawić i aktywować wyjścia dla kilku wybranych kanałów
jednocześnie.

POWIĄZANE LINKI
Konfigurowanie bezpośredniego routingu na stronie 399
Automatyczne miksowanie w dół na stronie 400

Konfigurowanie bezpośredniego routingu
W szafie Direct Routing do każdego kanału można przypisać do 8 miejsc docelowych routingu.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks i aktywuj Direct Routing. Rack Direct Routing 
jest pokazany nad sekcją suwaków.
2. Wybierz wszystkie kanały, dla których chcesz ustawić te same miejsca docelowe, naciśnij 
klawisze Shift-Alt/Opt i kliknij w pierwszym gnieździe stojaka Direct Routing.
3. W selektorze tras wybierz główne wyjście dla wybranych kanałów.

UWAGA
Zalecamy wybranie tego samego zestawu miejsc docelowych dla wszystkich kanałów, które należą 
do siebie. Wyjście główne powinno mieć również najszerszą konfigurację kanałów, ponieważ jest 
używane jako odniesienie dla wszystkich dodatkowych miejsc docelowych wyjść.

WAŻNE
Routing głównego wyjścia w pierwszym gnieździe Direct Routing określa szerokość kanału. Aby 
kilka funkcji w Cubase, na przykład Export Audio Mixdown lub panoramowanie dźwięku 
przestrzennego, działało zgodnie z oczekiwaniami, główne wyjście musi być ustawione poprawnie.

4. Kliknij następne miejsce docelowe i wybierz inne wyjście.
5. Zrób to dla wymaganej liczby miejsc docelowych (do 8). Po skierowaniu ścieżek audio do grup   
    możesz skierować grupy do szyn wyjściowych.
6. Dla każdego kanału możesz teraz aktywować odpowiednie miejsce docelowe routingu, klikając 
    odpowiednie gniazdo. Aktywny cel trasy świeci się.

Automatyczne przełączanie miejsc docelowych

PROCEDURA
1. Odtwórz swój projekt i zanotuj miejsca, w których konieczne są zmiany tras.
2. Włącz zapis na odpowiedniej ścieżce.
3. W odpowiednim momencie kliknij miejsce docelowe trasy, do którego chcesz się przełączyć. 
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    Nowe miejsce docelowe jest teraz aktywne, a zmiana została zarejestrowana jako dane 
    automatyzacji.
4. Kontynuuj rejestrowanie zmian miejsca docelowego dla swojego projektu.

UWAGA
Aby przełączać miejsca docelowe dla wielu kanałów jednocześnie, wybierz te kanały i przytrzymaj 
wciśnięte klawisze Shift-Alt/Opt podczas aktywacji innego miejsca docelowego.

Dostarczanie sygnałów do wielu miejsc docelowych
Routing bezpośredni oferuje tryb sumowania, który umożliwia jednoczesne przesyłanie sygnałów 
do kilku wyjść. Jest to przydatne, jeśli chcesz na przykład zastosować efekt do kilku pni 
jednocześnie.

PROCEDURA
1. Skonfiguruj szyny wyjściowe jako miejsca docelowe routingu.
2. W stojaku Direct Routing otwórz menu kontekstowe i aktywuj Summing Mode (tryb 
     sumowania) dla wszystkich kanałów, które chcesz zsumować.

                

UWAGA
Aby aktywować to ustawienie dla wszystkich kanałów jednocześnie, użyj funkcji Link (Połącz).

3. Aktywuj wszystkie wyjścia, do których chcesz skierować wybrane kanały

POWIĄZANE LINKI
Konfiguracja wyznaczania trasy (Routingu) na stronie 382

Automatic Downmixing (Automatyczne miksowanie w dół)
Wyjście w pierwszym gnieździe Direct Routing określa szerokość kanału. Ponieważ inne miejsca 
docelowe są umieszczone za panoramą na ścieżce sygnału, mają na początku taką samą szerokość 
kanału, a sygnał musi zostać odpowiednio przekonwertowany przez downmix. Cubase robi to 
automatycznie.

UWAGA
Zawsze wybieraj wyjście z najszerszą konfiguracją kanałów w pierwszym gnieździe. Nie zaleca się 
używania konfiguracji, w której główne wyjście ma mniej kanałów niż bezpośrednie miejsce 
docelowe routingu, nawet jeśli jest to technicznie możliwe. Upmix może prowadzić do 
nieoczekiwanych skutków ubocznych.

Podczas wykonywania automatycznego downmixu z 5.1 do stereo, poziomy są regulowane w 
następujący sposób:

Automatyczne miksowanie w dół z 5.1 do stereo 
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Sygnały Center i Lfe są dzielone na kanały L i R, L i R są wysyłane odpowiednio do kanałów L i R,
ale ich głośność jest zmniejszona.

Podczas automatycznego miksowania z 7.1 Music (Dolby) do 5.1 poziomy są dostosowywane w 
następujący sposób:

Automatyczne miksowanie w dół z 7.1 Music (Dolby) do 5.1

Sygnały Sl i Sr są rozdzielane odpowiednio na L/R i Ls/Rs, ale ich głośność jest zmniejszona.

Track Quick Controls (Szybkie sterowanie ścieżką)
Track Quick Controls zapewniają natychmiastowy dostęp do 8 różnych parametrów, na przykład 
ścieżki, efektów lub elementów sterujących instrumentem.

Oszczędza to konieczności klikania w różne okna i sekcje dotyczące Twojej ścieżki.

UWAGA
Ten rack (regał, stojak, szafa) kanałów jest dostępny tylko w oknie MixConsole.

Dodawanie szybkich kontrolek ścieżki w MixConsole
Możesz dodać Track Quick Controls w MixConsole.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Racks i aktywuj Track Quick Controls (Szybkie 
sterowanie ścieżką), aby wyświetlić rack nad sekcją tłumików.
2. Kliknij jedno z gniazd, aby otworzyć selektor.
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3. Wybierz parametr z listy.

WYNIK
Wybrany parametr jest ładowany i automatycznie aktywowany jako Track Quick Control.

POWIĄZANE LINKI
Przypisanie parametrów na stronie 750

Device Panels (Panele urządzeń)

Możesz wyświetlać panele urządzeń, na przykład dla zewnętrznych urządzeń MIDI, paneli ścieżek 
audio lub paneli efektów insertowych VST.

UWAGA
Ten rack (stojak, regał, szafa) kanałów jest dostępny tylko w oknie MixConsole

Więcej informacji na temat tworzenia lub importowania paneli urządzeń MIDI można znaleźć w 
oddzielnym dokumencie MIDI Devices (Urządzenia MIDI).

POWIĄZANE LINKI
Panele urządzeń na stronie 788.

Dodawanie notatek do kanału MixConsole

Możesz dodawać adnotacje do kanałów MixConsole.

PROCEDURA
1. Na pasku narzędzi MixConsole kliknij Set up Window Layout (Skonfiguruj układ okna)  
    i aktywuj Notepads (Notatniki). Sekcja Notepads (Notatników) jest pokazana nad sekcją   
    tłumików.
2. Wybierz kanał, dla którego chcesz dodać notatki, kliknij sekcję notatnika i wprowadź swoje  
    notatki.
3. Aby zamknąć notatnik, naciśnij Esc lub kliknij inną sekcję MixConsole.

Stosowanie kolorów kanałów do kontrolek kanałów

Możesz również zastosować kolory kanałów do elementów sterujących kanału. Jest to przydatne, 
jeśli masz wiele kanałów w MixConsole i chcesz je rozróżnić po kolorze.

WARUNEK WSTĘPNY
Kolory ścieżek/kanałów zostały przypisane ręcznie lub automatycznie.

PROCEDURA
1. Wybierz Edit > Preferences (Edytuj > Preferencje).
2. Otwórz stronę User Interface (interfejsu użytkownika) i wybierz Track & MixConsole 
    Channel Colors (Kolory kanału Track & MixConsole).
3. W sekcji Colorize Tracks and MixConsole Channels (Koloruj ścieżki i kanały MixConsole) 
    aktywuj MixConsole Channels (kanały MixConsole).
4. Opcjonalnie: Aby dostosować jasność wybranego kanału, dostosuj suwak Selected Channel 
    Brightness (Jasność wybranego kanału). 

UWAGA
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Domyślnie wybrany kanał jest wyświetlany na szaro. Jeśli chcesz wyświetlić wybrany kanał w 
kolorze, aktywuj opcję Show Color for Selected Channel (Pokaż kolor dla wybranego kanału). 
Następnie można go odróżnić od innych kanałów dzięki wyraźnej sile koloru.

5. Kliknij OK.

WYNIK
Kolory kanału są stosowane do kontrolek kanału.

POWIĄZANE LINKI
Automatyczne przypisywanie kolorów do nowych ścieżek/kanałów na stronie 174
Kolorowanie pojedynczych utworów na stronie 91
Kolorowanie wybranych utworów na stronie 90
Interfejs użytkownika na stronie 1180
Interfejs użytkownika — Kolory kanałów Track & MixConsole na stronie 1181

Przegląd opóźnienia (Latency) kanału
Latencje kanałów wyświetlają opóźnienia spowodowane efektami insertowymi lub modułami 
channel strip dla kanałów związanych z audio w MixConsole.

● Aby pokazać wyświetlanie latencji kanału w sekcji suwaków MixConsole, kliknij Set up 
Window Layout (Skonfiguruj układ okien) na pasku narzędzi i aktywuj Channel Latencies 
(Latencje kanałów).
● Aby otworzyć przegląd opóźnień dla określonego kanału, kliknij Open Channel Latency 
Overview (Otwórz przegląd opóźnień kanału).

           

Channel Latency Overview (Przegląd latencji kanału) zawiera następujące informacje:

           

Name (Nazwa)
        Nazwa efektu powodującego opóźnienie.
Type (Typ)
        Wskazuje, czy opóźnienie jest spowodowane przez efekt insertowy, moduł channel strip czy 
        panner.
Latency (ms) (Opóźnienie (ms))
        Pokazuje opóźnienie w milisekundach.
Latency (Samples) (Opóźnienie (próbki))
        Pokazuje opóźnienie w próbkach.
Total Channel Latency (Całkowite opóźnienie kanału)
        Pokazuje całkowite opóźnienie dla tego kanału w milisekundach i próbkach.

UWAGA
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Jeśli chcesz, aby jakiekolwiek opóźnienie wtyczki było kompensowane podczas odtwarzania, 
upewnij się, że funkcja Constrain Delay Compensation jest wyłączona.

POWIĄZANE LINKI
Kompensacja opóźnienia wtyczki na stronie 445
Menu funkcji na stronie 373
Ogranicz kompensację opóźnienia na stronie 737
Okno MixConsole na stronie 349

Ustawienia kanału
Możesz otworzyć każdy kanał MixConsole w osobnym oknie Channel Settings (Ustawienia 
kanału). Pozwala to na lepszy przegląd i edycję poszczególnych kanałów oraz ich ustawień.

Wybór kanału w oknie Channel Settings jest zsynchronizowany z wyborem kanału w MixConsole
i wyborem ścieżki w oknie Project.

UWAGA
Aby oddzielić wybór kanału w oknie Channel Settings (Ustawienia kanału) od wyboru kanału w 
MixConsole, otwórz Functions Menu (Menu funkcji) na pasku narzędzi okna Channel Settings 
i dezaktywuj opcję Follow ‘e’ buttons or selection changes (Podążaj za przyciskami „e” lub 
zmianami wyboru).
Aby oddzielić wybór kanału w oknie Channel Settings od wyboru ścieżki w oknie Project, wyłącz
Sync Selection in Project Window and MixConsole (Wybór synchronizacji w oknie projektu i 
MixConsole) w oknie dialogowym Preferences (Preferencje) (Editing—Project & MixConsole 
page) (Edycja — strona Projekt i MixConsole).

Aby otworzyć Channel Settings (Ustawienia kanału) dla kanału związanego z audio, wykonaj 
jedną z następujących czynności:

● W sekcji tłumików MixConsole wybierz kanał i kliknij Edit Channel Settings (Edytuj 
ustawienia kanału).
● Na liście ścieżek wybierz ścieżkę i w górnej części Inspektora kliknij Edit Channel Settings.
● Na liście ścieżek wybierz ścieżkę, a na ścieżce kliknij Edit Channel Settings.

      Okno Channel Settings (Ustawienia kanału) jest podzielone na kilka sekcji:

1  Toolbar (Pasek narzędzi)
       Pasek narzędzi zawiera narzędzia i skróty do ustawień i funkcji w oknie Channel Settings.
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2  Inserts/Strip (Wstawki/Pasek)
       Sekcja Inserts (Wstawki) zawiera gniazda efektów insertowych, które umożliwiają ładowanie 
       efektów insertowych dla kanału. Sekcja Strip umożliwia załadowanie wbudowanych modułów 
       przetwarzających dla oddzielnych kanałów.
3  Channel Strip/Equalizer (Pasek kanałów/Korektor)
       Sekcja Channel Strip umożliwia załadowanie wbudowanych modułów przetwarzania dla 
       oddzielnych kanałów. Sekcja Equalizer (Korektor) zawiera wbudowany korektor 
       parametryczny z maksymalnie 4 pasmami dla każdego kanału audio.

4  Sends/Cue Sends (Wysyłki/Wysyłki Cue)
       Sekcja Sends zawiera miejsca na efekty wysyłkowe, które umożliwiają załadowanie efektów 
       wysyłkowych. Sekcja Cue Sends umożliwia tworzenie dyskretnych miksów cue, których 
       wykonawcy mogą słuchać podczas nagrywania.
5  Direct Routing (Kierowanie bezpośrednie)
       Sekcja Direct Routing umożliwia skonfigurowanie 7 miejsc docelowych trasowania, które są 
       umieszczone za tłumikiem i za panoramą na ścieżce sygnału. W ten sposób możesz przełączać 
       miejsce docelowe kanałów i tworzyć różne wersje miksów za jednym razem.
6  Fader (Suwak, tłumik)
       Sekcja suwaka pokazuje bieżący kanał.
7  Output Chain (Łańcuch wyjściowy)
       Łańcuch wyjściowy umożliwia śledzenie bardziej skomplikowanych tras wyjściowych.

Sekcje są rozmieszczone w strefach po lewej i prawej stronie okna Channel Settings (Ustawienia 
kanału)

POWIĄZANE LINKI
Ustawienia kanałów — wstawki insertowe na stronie 407
Ustawienia kanałów – Pasek kanałów na stronie 408
Ustawienia kanałów — Korektor na stronie 413
Ustawienia kanałów – Wysyłki kanałów na stronie 415
Ustawienia kanałów — Kierowanie bezpośrednie na stronie 416
Ustawienia kanałów – Suwaki kanałów na stronie 417
Ustawienia korektora na stronie 388
Edytor wyznaczania tras na stronie 451
Trasowanie bezpośrednie na stronie 399

Pasek narzędziowy ustawień kanału
Pasek narzędzi w oknie Channel Settings (Ustawienia kanału) zawiera narzędzia i skróty do 
ustawień i funkcji w oknie Channel Settings.

Nawigacja po kanałach

Go to Last Edited Channel (Przejdź do ostatnio edytowanego kanału)

        
       Pokazuje ostatnio edytowany kanał w oknie Channel Settings (Ustawienia kanału). Ta opcja   
       jest dostępna tylko wtedy, gdy edytowałeś co najmniej 2 kanały.
Go to Next Edited Channel (Przejdź do następnego edytowanego kanału)

         
       Pokazuje następny kanał w oknie Channel Settings. Ta opcja jest dostępna tylko wtedy, gdy 
       edytowałeś co najmniej 2 kanały.
Go to Previous MixConsole Channel (Przejdź do poprzedniego kanału MixConsole)
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       Pokazuje poprzedni kanał MixConsole w oknie Channel Settings.
Go to Next MixConsole Channel (Przejdź do następnego kanału MixConsole)

         
       Pokazuje następny kanał MixConsole w oknie Channel Settings.
Search Channels (Wyszukaj kanały)

        
       Umożliwia wyszukiwanie określonych kanałów i wyświetlanie ich w oknie Channel Settings  
       (Ustawienia Kanałów).

Left Divider (Lewy rozdzielacz)
Left Divider
Narzędzia umieszczone po lewej stronie separatora są zawsze pokazane.
        
Channel Sources (Źródła kanałów)
Input (Wejście)

           
         Otwiera nazwę kanału wejściowego.
Go to Input/Select an Input (Przejdź do wejścia/wybierz wejście)

           
         Pokazuje kanał wejściowy w oknie Channel Settings (Ustawienia kanału).

Channel Name (Nazwa kanału)
Channel Name

          
         Pokazuje nazwę kanału, która jest wyświetlana w oknie Channel Settings (Ustawienia 
         kanału).

Channel Destinations (Miejsca docelowe kanałów)
Go to Output/Select an Output (Przejdź do Wyjścia/Wybierz Wyjście)

         
        Otwiera kanał wyjściowy w oknie Ustawienia kanału.
Output (Wyjście)

         
        Pokazuje nazwę kanału wyjściowego.

Edit Instrument (Edytuj instrument)
Edit VST Instrument (Edytuj instrument VST)

         
        Umożliwia otwarcie panelu sterowania przyrządu VST. Jest to dostępne tylko dla kanałów  
        MIDI i kanałów instrumentów.

Output Chain (Łańcuch wyjściowy)
Show Output Chain (Pokaż łańcuch wyjściowy)

         
        Pokazuje łańcuch wyjściowy. Pozwala to na śledzenie bardziej skomplikowanych tras 
        wyjściowych.
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Track Templates (Szablony ścieżek)
Load/Save Track Preset (Załaduj/zapisz ustawienia wstępne ścieżki)

        
        Umożliwia ładowanie/zapisywanie ustawień wstępnych ścieżek.

Reload Track Preset (Załaduj ponownie ustawienie ścieżki)

         
        Umożliwia ponowne załadowanie presetów ścieżek.

Channel Functions (Funkcje kanałów)
Functions Menu (Menu funkcji)

         
        Otwiera wyskakujące menu, w którym można wybrać funkcję Channel Settings (Ustawienia  
        kanału).

Window Zone Controls (Sterowanie strefą okna)
Set up Window Layout (Skonfiguruj układ okien)

        
       Umożliwia ustawienie układu okien.
Set up Toolbar (Skonfiguruj pasek narzędzi)

       
       Otwiera wyskakujące menu, w którym można określić, które elementy paska narzędzi mają być
       widoczne.

Ustawienia kanałów – wstawki insertowe
Sekcja Channel Insets (Wstawki insertowe) jest wyświetlana w oknie Channel Settings 
(Ustawienia kanału).

              
Bypass Inserts (Wstawki obejściowe)
        Pomija efekty insertowe dla kanału.
Inserts (Wstawki)
        Umożliwia dodawanie efektów insertowych dla kanału.
Preset Management (Zarządzanie ustawieniami wstępnymi)
        Umożliwia ładowanie lub zapisywanie presetów FX Chain.
Move Channel Strip to Pre/Post-Inserts Position (Przesuń pasek kanałów do pozycji przed 
wstawkami/po wstawkach)
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        Umożliwia przesunięcie paska kanałów do pozycji przed tłumikiem lub do pozycji po tłumiku 
        w przepływie sygnału.
Strip (Pasek)
        Umożliwia aktywację i konfigurację modułów paska kanałów dla kanału.
Routing (Trasowanie)
        Umożliwia skonfigurowanie trasowania efektów insertowych.

POWIĄZANE LINKI
Ustawienia kanałów na stronie 404

Ustawienia kanałów – Pasek kanałów
Sekcja Channel Strip/Equalizer (Pasek kanałów/Korektor (Wyrównywacz)) jest wyświetlana w 
oknie Channel Settings (Ustawienia kanałów)

Bypass Channel Strip (Obejście paska kanałów)
        Pomija moduły paska kanałów dla kanału.
UWAGA
Możesz zresetować moduły paska kanałów dla kanału, klikając ten przycisk Alt/Opt.

Channel Strip (Pasek kanałów)
        Umożliwia aktywację i konfigurację modułów paska kanałów dla kanału.
Preset Management (Zarządzanie ustawieniami wstępnymi)
        Umożliwia ładowanie lub zapisywanie ustawień wstępnych pasków.

Moduły pasków kanałów
Pokazane są następujące moduły listew kanałowych:
●   Noise Gate (Bramka szumów)
●   Compressor (Kompresor)
●   EQ (Korektor)
●   Tools (Narzędzia)
●   Sat
●   Limit

Możesz zmienić położenie modułów paska kanałów w łańcuchu sygnałowym, przeciągając je
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POWIĄZANE LINKI
Noise Gate (Bramka szumów) na stronie 390
Compressor (Kompresor) na stronie 391
EQ (Korektor) na stronie 393
Narzędzia na stronie 393
Sat na stronie 394
Limit na stronie 396
Ustawienia kanałów na stronie 404

Kompresor standardowy — widok szczegółów
Standard Compressor (Standardowy kompresor) zawiera widok szczegółów z większą liczbą 
elementów sterujących i odczytów wartości dla liczników.

● Aby otworzyć widok szczegółów, kliknij Edit Module (Edytuj moduł)  .

        

W widoku szczegółowym dostępne są następujące dodatkowe parametry:

●   Soft Knee/High Ratio (Miękkie kolano/wysoki współczynnik)
●   Hold (Przytrzymaj)
●   Analysis (Analiza)
●   Dry Mix (Sucha mieszanka)
●   Input Gain meter (Miernik wzmocnienia wejścia)
●   Output Gain meter (Miernik wzmocnienia wyjścia)
●   Gain Reduction meter (Miernik redukcji wzmocnienia)

Możesz zamknąć widok szczegółów, klikając Close Module (Zamknij moduł)  .

POWIĄZANE LINKI
Kompresor standardowy na stronie 391
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Kompresor rurowy — widok szczegółów

Tube Compressor oferuje widok szczegółów z większą liczbą elementów sterujących i odczytów 
wartości dla mierników.

● Aby otworzyć widok szczegółów, kliknij Edit Module (Edytuj moduł)  .

W widoku szczegółowym dostępne są następujące dodatkowe parametry:

●   Charakter
●   (Przełącznik Low/High dla Ratio)
●   Sekcja łańcucha bocznego z Frequency, Filter Type, Q-Factor, and Monitor (częstotliwością, 
      typem filtra, współczynnikiem dobroci i monitorem)
●    Input Gain meter (Miernik wzmocnienia wejścia)
●    Output Gain meter (Miernik wzmocnienia wyjścia)

Możesz zamknąć widok szczegółów, klikając Close Module (Zamknij moduł)   .

POWIĄZANE LINKI
Kompresor rurowy na stronie 392

VintageCompressor (klasyczny kompresor) — widok szczegółów

VintageCompressor oferuje widok szczegółów z większą liczbą elementów sterujących i 
odczytów wartości dla liczników.

●   Aby otworzyć widok szczegółów, kliknij Edit Module (Edytuj moduł)  .
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W widoku szczegółowym dostępne są następujące dodatkowe parametry:

● Mix (Mieszaj)
● Ratio buttons (Przyciski proporcji)
● Input Gain meter (Miernik wzmocnienia wejścia)
● Output Gain meter (Miernik wzmocnienia wyjścia)
● Gain Reduction meter (Miernik redukcji wzmocnienia)

Możesz zamknąć widok szczegółów, klikając Close Module (Zamknij moduł)  .

POWIĄZANE LINKI
VintageCompressor na stronie 392

Maximizer — widok szczegółów

Maximizer oferuje widok szczegółów z większą liczbą elementów sterujących i odczytów wartości
dla liczników.

● Aby otworzyć widok szczegółów, kliknij Edit Module (Edytuj moduł)  .
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W widoku szczegółowym dostępne są następujące dodatkowe parametry:

●  Classic (Klasyczny)
Ten tryb jest odpowiedni dla wszystkich stylów muzycznych.
● Modern (Nowoczesny)
Ten tryb jest szczególnie odpowiedni dla współczesnych stylów muzycznych. Release (Zwolnij) 
pozwala ustawić całkowity czas zwolnienia, Recover (Odzyskaj) pozwala na szybsze odzyskanie 
sygnału na początku fazy zwolnienia.
● Soft Clip (Miękki klip)
Aktywuj to, aby zacząć delikatnie ograniczać lub obcinać sygnał i generować harmoniczne, które 
dodają ciepłej, lampowej charakterystyki materiałowi audio.
● Miernik wejść/wyjść o wysokiej rozdzielczości z redukcją wzmocnienia. 

Możesz zamknąć widok szczegółów, klikając Close Module (Zamknij moduł)  .

POWIĄZANE LINKI
Maksymizer na stronie 396.
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Ustawienia kanałów – Korektor (Equalizer)

Sekcja Channel Strip/Equalizer (Pasek kanału/Korektor) jest wyświetlana w oknie Channel 
Settings (Ustawienia kanałów).

             

Bypass Equalizers (Obejście korektorów)
        Pomija ustawienia korektora dla kanału.
UWAGA
Możesz zresetować korektory, klikając ten przycisk Alt/Opt.
Preset Management (Zarządzanie ustawieniami wstępnymi)
        Umożliwia ładowanie lub zapisywanie ustawień wstępnych korektora.
Activate Channel Comparison (Aktywuj porównanie kanałów)
        Aktywuje tryb porównywania kanałów, który umożliwia przeglądanie i edytowanie krzywych 
        widmowych i ustawień EQ dwóch kanałów jednocześnie.
Select Reference Channel (Wybierz kanał referencyjny)
        Umożliwia wybranie kanału referencyjnego do porównania kanałów. Kliknij Solo, aby   
        zapanowało solo na kanale.
Select Comparison Channel pop-up menu (Wybierz wyskakujące menu kanału porównawczego)
        Umożliwia wybranie kanału jako kanału porównawczego.
Equalizer Settings (Ustawienia korektora)
        Otwiera panel ustawień korektora.
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Equalizer display (Wyświetlacz korektora)
        Umożliwia ustawienie korektora dla 4 pasm na dużym wyświetlaczu krzywej EQ z kilkoma 
        trybami. Tutaj możesz również przeglądać i edytować kanał referencyjny i porównawczy.

UWAGA
Możesz modyfikować ustawienia kolorów dla EQ Reference Channel i EQ Comparison Channel
w oknie dialogowym Preferences (Preferencje) (User Interface (Interfejs użytkownika) — strona 
MixConsole Rack Colors).

Equalizer Controls (Sterowanie korektorem)
         Umożliwia ustawienie korektora dla 4 pasm na dużym wyświetlaczu krzywej EQ z kilkoma 
         trybami.

POWIĄZANE LINKI
Ustawienia kanałów na stronie 404

Panel ustawień korektora
Panel Equalizer Settings (ustawień korektora) umożliwia skonfigurowanie korektora.

● Aby otworzyć panel Equalizer Settings (Ustawienia korektora), kliknij opcję Equalizer Settings
w sekcji Equalizer (Korektor) w oknie Channel Settings (Ustawienia kanału).

             
Show Equalizer Controls (Pokaż elementy sterujące korektora)
         Pokazuje/ukrywa elementy sterujące korektora.
Show Controls as Sliders (Pokaż elementy sterujące jako suwaki)
         Pokazuje elementy sterujące korektora jako suwaki.
Show Controls as Knobs (Pokaż elementy sterujące jako pokrętła)
         Pokazuje elementy sterujące korektora jako pokrętła.
Show FFT Pre EQ Curve (Pokaż krzywą FFT Pre EQ)
         Pokazuje/ukrywa krzywą wejściową FFT (szybka transformata Fouriera) dla kanału 
         referencyjnego.
Hold FFT Post EQ Peak Curve (Przytrzymaj krzywą szczytową EQ Post FFT)
         Przechowuje wartości szczytowe krzywej wyjściowej FFT (szybka transformata Fouriera) dla 
         kanału referencyjnego.
Transparency for Reference/Comparison Channel Curve (Przejrzystość dla krzywej kanału 
odniesienia/porównania)
         Umożliwia dostosowanie przezroczystości wypełnionego obszaru dla krzywych widmowych. 
         Jest to przydatne, jeśli porównujesz krzywe widmowe dwóch kanałów i chcesz zobaczyć obie 
         krzywe widmowe jednocześnie, krzywą wybranego kanału z przodu i krzywą drugiego kanału
         z tyłu.

Porównanie kanałów
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Możesz porównać ustawienia korektora i krzywe widmowe dwóch kanałów na wyświetlaczu 
korektora w oknie ustawień kanału.

PROCEDURA
1. W MixConsole wybierz kanał, który chcesz porównać z innym i kliknij Edit Channel Settings 
    (Edytuj ustawienia kanału).
2. W oknie Channel Settings (Ustawienia kanału) otwórz sekcję Channel Strip/Equalizer (Pasek 
    kanału/Korektor) i aktywuj sekcję Equalizer (Korektor).

3. Kliknij Activate Channel Comparison (Aktywuj porównanie kanałów) i rozpocznij 
    odtwarzanie. Ustawienia EQ i krzywa widmowa wybranego kanału referencyjnego są pokazane 
    na wyświetlaczu EQ.
4. Otwórz menu podręczne Select Comparison Channel (Wybierz kanał porównania) i wybierz 
    kanał, który chcesz porównać z kanałem referencyjnym. Obie krzywe widmowe są pokazane na 
    wyświetlaczu korektora i można je porównywać i edytować.
5. Wykonaj jedną z następujących czynności:
          ● Dostosuj ustawienia dla wybranego kanału referencyjnego.
          ● Kliknij Select Comparison Channel (Wybierz kanał porównania) i dostosuj ustawienia 
             dla wybranego kanału porównania.

WYNIK
Porównałeś i edytowałeś ustawienia dla dwóch kanałów. Aby porównać kanał odniesienia z innym 
kanałem, ponownie otwórz menu podręczne Select Comparison Channel (Wybierz kanał 
porównania) i wybierz nowy kanał porównania.

POWIĄZANE LINKI
Panel ustawień korektora na stronie 414
Ustawienia kanału — Korektor na stronie 413
Interfejs użytkownika na stronie 1180

Channel Settings – Channel Sends (Ustawienia kanałów – Wysyłki 
kanałów)
Sekcja Channel Sends (Wysyłki kanałów) jest wyświetlana w oknie Channel Settings (Ustawienia
kanałów).
 

419



        

Bypass Sends (Pomiń wysyłanie)
         Pomija efekty wysyłania dla kanału.
Sends—Destinations (Wysyłki — miejsca docelowe)
        Umożliwia ustawienie miejsca docelowego dla efektów wysyłkowych dla kanału.
Sends—Panning (Wysyłki — przesuwanie)
        Umożliwia skonfigurowanie panoramowania dla efektów wysyłkowych.

Bypass Cue Sends (Pomiń wysyłki Cue)
         Pomija efekty cue send dla kanału.
Cue Sends (Wysyłanie wskazówek (replik))
         Umożliwia dodawanie efektów cue send dla kanału.

POWIĄZANE LINKI
Ustawienia kanałów na stronie 404

Channel Settings – Direct Routing (Ustawienia kanałów – Trasowanie 
bezpośrednie)
Możesz otworzyć sekcję Direct Routing w oknie Channel Settings (Ustawienia kanału).

● Aby otworzyć sekcję Direct Routing (Trasowanie bezpośrednie) w oknie Channel Settings 
(Ustawienia kanału), kliknij Window Layout (Ustaw układ okna) i aktywuj Direct Routing.

420



            

Sekcja Direct Routing umożliwia ustawienie miejsc docelowych trasowania, które są umieszczone 
za tłumikiem i za panoramą na ścieżce sygnału. W ten sposób możesz przełączać miejsce docelowe 
kanałów i tworzyć różne wersje miksów za jednym razem.

POWIĄZANE LINKI
Ustawienia kanałów na stronie 404
Trasowanie bezpośrednie na stronie 399

Channel Settings – Channel Faders (Ustawienia kanałów – Suwaki 
kanałów)
Sekcja Channel Faders (Suwaki kanałów) jest wyświetlana w oknie Channel Settings 
(Ustawienia kanałów).
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Elementy sterujące są takie same jak w sekcji tłumików MixConsole.

POWIĄZANE LINKI
Sekcja suwaków na stronie 375
Ustawienia kanałów na stronie 404

Fokus klawiatury w MixConsole
Lewą strefą, sekcją stojaka na kanały i sekcją tłumików można sterować za pomocą klawiatury 
komputera.

Aby to zadziałało, sekcja musi mieć fokus. Jeśli sekcja ma fokus klawiatury, otaczające ją 
obramowanie jest podświetlone określonym kolorem.

Aktywacja fokusa klawiatury
Aby móc sterować MixConsole za pomocą klawiatury, musisz aktywować fokus klawiatury.

PROCEDURA
1. Kliknij pusty obszar sekcji, aby aktywować fokus klawiatury.
2. Naciśnij Tab, aby aktywować następną sekcję. Pozwala to na przewijanie sekcji do przodu.
3. Naciśnij klawisze Shift - Tab, aby aktywować poprzednią sekcję.

Nawigacja w sekcji
Po aktywowaniu fokusu dla sekcji możesz sterować nią za pomocą klawiatury komputera. W sekcji 
racków (stojaków, regałów) kanałów i  w sekcji suwaków elementy sterujące wybrane do 
sterowania za pomocą klawiatury są oznaczone czerwoną obwódką.

● Aby poruszać się po elementach sterujących, użyj klawiszy Strzałka w górę , Strzałka w dół , 
Strzałka w lewo lub Strzałka w prawo.

● Aby aktywować lub dezaktywować przełącznik, naciśnij Return .
● Aby rozwinąć lub zwinąć aktywny statyw, otworzyć lub zamknąć pole wartości w gnieździe albo 
otworzyć panel wtyczek dla załadowanej wtyczki, naciśnij Return .
● Aby uzyskać dostęp do elementów sterujących w lewej strefie, naciśnij Ctrl/Cmd - Return .
● Aby uzyskać dostęp do elementów sterujących w środkowej strefie, naciśnij Return .
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● Aby uzyskać dostęp do kontrolek w prawej strefie, naciśnij Alt/Opt - Return .
● Aby zamknąć wyskakujące menu lub panel wtyczek, naciśnij Esc .
● Aby włączyć lub wyłączyć załadowaną wtyczkę, naciśnij Ctrl/Cmd -Alt/Opt - Return .

Suwaki VCA

Suwaki VCA służą jako zdalne sterowanie grupami suwaków kanałów w MixConsole.
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VCA oznacza wzmacniacz sterowany napięciem. Tłumiki VCA pierwotnie znajdowały się na 
stołach sprzętowych. Pozwoliły one użytkownikowi kontrolować poziomy głośności kilku kanałów 
miksera za pomocą tylko jednego suwaka. Aby przypisać tłumiki kanałów do tłumika VCA, 
odpowiednie kanały muszą być fizycznie połączone z tłumikiem VCA.

W Cubase funkcja suwaka VCA opiera się na tej samej koncepcji. Tłumiki VCA są przypisane do 
grupy połączonych kanałów, grupy połączeń. Tłumiki VCA sterują następującymi parametrami 
grupy łącza: głośność (volume), wyciszenie (mute), solo, odsłuch (listen), monitorowanie (monitor)
i nagrywanie (record).

Gdy przypiszesz suwaki VCA, staną się one częścią grupy połączeń.

WAŻNE
Jeśli suwak VCA kontroluje grupę łączy, nie może sterować inną grupą łączy. Jeśli przypiszesz 
tłumik VCA do innej grupy, tłumik VCA zostanie automatycznie usunięty z poprzedniej grupy.

Możesz utworzyć kilka suwaków VCA bez przypisywania ich od razu do grup połączeń.
Z technicznego punktu widzenia przesunięcie suwaka VCA na inny poziom dB dodaje lub 
odejmuje nową wartość do lub od oryginalnych wartości kanałów w grupie łączy.

PRZYKŁAD
Kanał w grupie łączy ma poziom -6 dB, tłumik VCA jest w pozycji 0. Jeśli przesuniesz suwak VCA
do poziomu +3 dB, wartość ta zostanie dodana do poziomu połączonego kanału. Powiązany kanał 
ma teraz poziom -3 dB.

Ustawienia suwaka VCA

Kanały tłumików VCA różnią się od domyślnych kanałów tłumików.

Zamiast pannera, suwaki VCA wyświetlają grupę linków, do której są przypisane. Tłumiki VCA 
udostępniają również wyskakujące menu, które umożliwia zmianę ustawień tłumików VCA.
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1 Numer grupy łączy
2 Nazwa grupy łączy
3 wyskakujące menu tłumika VCA
4 Miernik wartości szczytowych, który wyświetla zsumowany poziom wszystkich mierników    
   kanałów w grupie łączy
5 Uchwyt suwaka

Wyskakujące menu suwaka VCA zawiera następujące opcje:

Edit Link Group Settings (Edytuj ustawienia grupy łączy)
       Umożliwia zmianę ustawień grupy łączy.
VCA Fader Controls Link Group: <link group name> (VCA Fader Controls Link Group: 
<nazwa grupy linków>)
       Pokazuje grupę linków kontrolowaną przez tłumik VCA. Możesz przypisać tłumik VCA do 
       innej grupy połączeń. Spowoduje to usunięcie tłumika VCA z bieżącej grupy. Możesz także 
       całkowicie usunąć przypisanie tłumika VCA. W takim przypadku wybierz None (Brak). We 
       wszystkich przypadkach musisz określić, czy chcesz, aby połączone kanały powróciły do 
       pierwotnej automatyzacji.
Combine Automation of VCA and Linked Channels (Połącz automatyzację VCA i połączonych 
kanałów)
Łączy krzywe automatyzacji tłumika VCA i połączonych kanałów w oknie Project. Powoduje to, 
że oryginalne krzywe automatyzacji połączonych kanałów nie są już używane. W oknie Project 
automatyzacja tłumika VCA jest resetowana do statycznej linii wartości. W MixConsole suwak 
VCA jest resetowany do pozycji 0.
UWAGA
Jeśli użyjesz tej funkcji razem z krzywymi automatyzacji Béziera, połączona krzywa automatyzacji 
będzie składać się z liniowych ramp o różnej rozdzielczości. Te powinny jak najdokładniej 
naśladować krzywe Béziera.
Linked Channels (Połączone kanały)
         Pokazuje, które kanały są połączone w grupie łączy.

POWIĄZANE LINKI
Automatyzacja tłumików VCA na stronie 423
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Tworzenie płynnych przejść między zdarzeniami automatyzacji (krzywe automatyzacji Béziera) na 
stronie 738
Okno dialogowe ustawień grupy połączeń na stronie 369

Tworzenie suwaków VCA w MixConsole
Możesz tworzyć suwaki VCA w MixConsole

PROCEDURA
1. Wybierz Studio > MixConsole.
2. Kliknij prawym przyciskiem myszy w sekcji tłumików i wybierz Add VCA Fader (Dodaj 
    tłumik VCA)

WYNIK
Spowoduje to utworzenie nieprzypisanego tłumika VCA i umieszczenie go na prawym końcu sekcji
tłumika przed kanałami wyjściowymi.

POWIĄZANE LINKI
Przypisywanie suwaków VCA do grup połączeń na stronie 422
Ścieżka suwaka VCA na stronie 142
Okno dialogowe Dodaj ścieżkę – VCA na stronie 142

Tworzenie suwaków VCA dla wybranych kanałów
Możesz wybrać kilka kanałów i automatycznie połączyć kanały z nową grupą łączy, utworzyć 
tłumik VCA i przypisać tłumik VCA do tej grupy łączy.

PROCEDURA
1. Wybierz kilka kanałów w MixConsole.
2. Kliknij prawym przyciskiem jeden z wybranych kanałów.
3. W menu kontekstowym wybierz Add VCA Fader to Selected Channels (Dodaj tłumik VCA do
wybranych kanałów).

WYNIK
Kanały są połączone w grupę linków. Tłumik VCA jest tworzony, umieszczany na prawo od 
wybranych suwaków i przypisywany do grupy łączy. W oknie Project ścieżka VCA jest 
umieszczana pod wybranymi ścieżkami.

UWAGA
Jeśli tłumik VCA jest tworzony dla wybranych kanałów, opcja Selection (Wybór) jest domyślnie 
wyłączona dla grupy linków. Możesz zmienić to ustawienie w oknie dialogowym Link Group 
Settings (Ustawienia grupy łączy).

POWIĄZANE LINKI
Łączenie kanałów na stronie 369
Zmiana ustawień grupy połączeń na stronie 372
Okno dialogowe ustawień grupy połączeń na stronie 369
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Przypisywanie suwaków VCA do grup połączeń
Możesz łączyć kanały i przypisywać suwaki VCA do ich kontrolek.

WARUNEK WSTĘPNY
Wybrałeś kanały.

PROCEDURA
1. Kliknij Link na pasku narzędzi MixConsole.
2. W oknie dialogowym Link Group Settings (Ustawienia grupy łączy) kliknij pole Name 
    (Nazwa), aby wprowadzić nazwę grupy łączy.
3. Aktywuj Use VCA Fader (Użyj suwaka VCA).
    Parametr Volume (Głośność) jest automatycznie dezaktywowany.
4. Określ, czy chcesz utworzyć nowy tłumik VCA, czy wybrać istniejący tłumik VCA z  
    wyskakującego menu.
5. Kliknij OK.

WYNIK
Kanały są teraz połączone z tłumikiem VCA. W górnej części sekcji suwaków linia wyświetlacza 
pokazuje numer i nazwę grupy połączeń. Tłumik VCA wyświetla również nazwę grupy połączeń.

UWAGA
● Jeśli chcesz przypisać tłumik VCA do innej grupy łączy, możesz otworzyć wyskakujące menu 
tłumika VCA, wybrać VCA Fader Controls Link Group: <name of group> (Grupa łączników 
regulatorów VCA Fader: <nazwa grupy>) i wybrać inną grupę z listy dostępne grupy linków.
● Jeśli chcesz szybko dodać tłumik VCA, wybierz opcję Add VCA Fader to Selected Channels 
(Dodaj tłumik VCA do wybranych kanałów). Spowoduje to automatyczne utworzenie tłumika VCA
z domyślną nazwą.

POWIĄZANE LINKI
Okno dialogowe ustawień grupy połączeń na stronie 369

Usuwanie suwaków VCA z grup łączy
Możesz usuwać tłumiki VCA z grup łączy.

WARUNEK WSTĘPNY
Wybrałeś tłumik VCA, który chcesz usunąć.

PROCEDURA
1. Kliknij Edit Link Group Settings (Edytuj ustawienia grupy łączy) na pasku narzędzi 
MixConsole.
2. W oknie dialogowym Link Group Settings (Ustawienia grupy połączeń) wyłącz opcję Use 
VCA Fader (Użyj tłumika VCA).
    Parametr Volume (Głośność) jest automatycznie reaktywowany.
3. Kliknij OK.
4. Określ, czy kanały w grupie łączy zachowują połączoną automatyzację.

WYNIK
Tłumik VCA zostanie usunięty z grupy łączy i zostanie usunięty z listy kanałów.
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UWAGA
Suwak VCA można przechowywać w sekcji suwaków. W takim przypadku otwórz wyskakujące 
menu VCA Fader, wybierz VCA Fader Controls Link Group: <name of group> (Grupa 
dowiązań sterowania tłumikiem VCA <nazwa grupy>) i wybierz None (Brak). Spowoduje to 
usunięcie tylko przypisania tłumika VCA.

POWIĄZANE LINKI
Okno dialogowe ustawień grupy połączeń na stronie 369.

Zagnieżdżone suwaki VCA
Suwaki VCA mogą sterować innymi suwakami VCA.

Jeśli używasz kilku suwaków VCA, które kontrolują różne grupy łączy, możesz utworzyć inny 
suwak VCA, który kontroluje suwaki VCA. Pozwala to na jednoczesne sterowanie poziomem 
głośności kilku grup łączy.

Technicznie rzecz biorąc, suwak VCA, który kontroluje inne suwaki VCA, wpływa na poziom 
głośności wszystkich suwaków VCA i powiązanych kanałów.

PRZYKŁAD
Tłumik VCA (główny tłumik) steruje zagnieżdżonym tłumikiem VCA, który został ustawiony na -
10 dB. Ten ostatni suwak VCA steruje połączonym kanałem, który miał oryginalny poziom -3 dB i 
który jest ustawiony na -13 dB. Jeśli zmienisz poziom głównego tłumika z 0 na +4 dB, sterowany 
tłumik VCA zostanie ustawiony na poziom -6 dB, a powiązany kanał zostanie ustawiony na poziom
-9 dB.

Automatyzacja tłumików VCA
Automatyzacja tłumików VCA wpływa na automatyzację grup łączy.

Kiedy tworzysz tłumiki VCA, ich ścieżki w oknie Project zawierają statyczną linię wartości, która 
jest domyślna dla wszystkich ścieżek automatyzacji i która zmienia się w krzywą automatyzacji, 
gdy zaczniesz pisać automatyzację.

Za każdym razem, gdy piszesz automatyzację dla tłumika VCA grupy linków, wpływa to na 
automatyzację głośności połączonych kanałów. To ma różne skutki

● Jeśli połączony kanał nie ma automatyzacji, krzywa automatyzacji tłumika VCA jest 
automatycznie dodawana do ścieżek automatyzacji połączonych kanałów. Ścieżki automatyzacji 
połączonych kanałów pokazują automatyzację stosowaną przez tłumik VCA.

● Jeśli połączony kanał ma automatyzację głośności, automatyzacja suwaka VCA modyfikuje 
istniejącą automatyzację głośności połączonego kanału. Automatyzacja tłumika VCA i 
automatyzacja połączonego kanału są połączone. Ścieżki automatyzacji pokazują oryginalną 
automatyzację i połączoną automatyzację tłumika VCA i połączonych kanałów.  

PRZYKŁAD
Automatyzacja ścieżki suwaka VCA wpływa na wszystkie kanały w grupie łączy.
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W przypadku kanałów oryginalna automatyzacja jest regulowana przez poziom głośności ścieżki 
tłumika VCA.

PRZYKŁAD
Automatyzacja ścieżki tłumika VCA wpływa na istniejącą automatyzację głośności ścieżki audio.

Jaśniejsza linia wartości statycznej przedstawia automatyzację tłumików VCA, która nie została 
jeszcze napisana.

Ścieżka suwaka VCA ma inną krzywą automatyzacji, która wpływa na automatyzację ścieżki audio.

Znajdująca się pod spodem ciemniejsza krzywa automatyzacji przedstawia oryginalną 
automatyzację ścieżki audio. Nałożona jaśniejsza krzywa automatyzacji przedstawia połączoną 
automatyzację.

POWIĄZANE LINKI
Ustawienia suwaka VCA na stronie 419
Tworzenie płynnych przejść między zdarzeniami automatyzacji (krzywe automatyzacji Béziera) na 
stronie 738
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Control Room (Sterownia)

Control Room (Pomieszczenie kontrolne) pozwala podzielić środowisko studyjne na strefę 
wykonawczą (studio) i strefę inżyniera/producenta (sterownię).

Aby otworzyć sterownię, masz następujące opcje:
● Aby otworzyć Control Room w oddzielnym oknie, wybierz Studio > Control Room.
● Aby otworzyć sekcję Control Room w oknie MixConsole, kliknij Show/Hide Right Zone 
(Pokaż/ukryj prawą strefę) na pasku narzędzi MixConsole.
● Aby otworzyć sekcję Control Room w oknie Project, kliknij opcję Show/Hide Right Zone 
(Pokaż/ukryj prawą strefę) na pasku narzędzi okna Project.

Sterownia jest podzielona na 2 sekcje.
● Karta Main (Główna) zawiera wszystkie elementy sterujące, których regularnie używasz na 
przykład podczas nagrywania, miksowania i masteringu.
● Karta Inserts (Wstawki) zawiera ustawienia, których najprawdopodobniej używasz tylko raz w 
projekcie.

POWIĄZANE LINKI
Pasek narzędzi MixConsole na stronie 355
Pasek narzędzi okna projektu na stronie 46

Dodawanie kanałów do sterowni
Aby móc korzystać z Control Room (Sterownia), musisz najpierw dodać potrzebne kanały.

PROCEDURA
1. Wybierz Studio > Audio Connections (Studio > Połączenia audio).
2. Kliknij Control Room.
3. Kliknij Add Channel (Dodaj kanał).
     Wyskakujące menu zawiera listę wszystkich dostępnych typów kanałów i pokazuje liczbę 
     dostępnych wystąpień każdego typu.
4. Wybierz typ kanału.
    W przypadku większości typów kanałów otwierane jest okno dialogowe umożliwiające wybór 
     konfiguracji kanału.
5. Kliknij kolumnę Audio Device (Urządzenie audio), aby ustawić urządzenie audio dla typu 
     kanału.
6. Kliknij kolumnę Device Port (Port urządzenia), aby przypisać port dla kanału.

WAŻNE
Nie można jednocześnie przypisać tego samego portu urządzenia do magistrali lub kanału i kanału 
w sterowni (Control Room).
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Output Routing (Wyjście trasowania)
Aby Control Room działał poprawnie, musisz przypisać szynę Main Mix do zestawu wyjść 
zawierającego miks, którego chcesz słuchać.

Jeśli masz tylko jedną szynę wyjściową, automatycznie staje się ona Main Mix. Wszystkie inne 
wyjścia nie są kierowane przez Control Room (sterownię).

Wyłączne przypisanie kanałów monitora
Zasadniczo przypisanie portów do kanałów w Control Room jest wyłączne. Jednak przydatne 
może być utworzenie kanałów monitorów, które współdzielą ze sobą porty urządzeń, a także 
wejścia i wyjścia. Może to być przydatne, jeśli na przykład używasz tych samych głośników jako 
pary stereo, a także jako lewego i prawego kanału w konfiguracji głośników surround.

Przełączanie między monitorami, które współużytkują porty urządzeń, jest płynne, a dźwięk 
wielokanałowy jest miksowany do stereo w razie potrzeby. W danym momencie może być aktywny
tylko jeden zestaw monitorów.

Jeśli Twój scenariusz nie wymaga przypisania portów do kilku kanałów monitora, zaleca się 
aktywację opcji Exclusive Device Ports for Monitor Channels (Ekskluzywne porty urządzeń dla 
kanałów monitorujących) w oknie dialogowym Preferences (Preferencje) (strona VST — Control 
Room (VST – Sterownia)). W ten sposób masz pewność, że przypadkowo nie przypiszesz portów 
do wejść/wyjść i kanałów monitorujących w tym samym czasie.

WAŻNE
Stan preferencji Exclusive Device Ports for Monitor Channels jest zapisywany wraz z 
ustawieniami wstępnymi Control Room. Dlatego jeśli przywołasz ustawienie wstępne, bieżące 
ustawienie w oknie dialogowym Preferences (Preferencje) może zostać nadpisane.

Control Room Channels (kanały sterowni)
Każdy tworzony typ kanału Control Room definiuje wejście lub wyjście Control Room.

Monitor Chanels  (Kanały monitorujące, monitora)
Kanał monitora reprezentuje zestaw wyjść, które są podłączone do głośników monitora w sterowni 
(Control Room).

Możesz utworzyć do 4 kanałów monitora dla konfiguracji głośników mono, stereo lub surround. 
Każdy monitor może mieć własne niestandardowe ustawienia miksu, wzmocnienia wejściowego i 
ustawień fazy wejściowej.

UWAGA
Kanały monitorujące mogą współdzielić sprzętowe wejścia lub wyjścia z inną magistralą lub 
kanałem. Podczas tworzenia połączeń dla kanałów monitora porty urządzeń, które są już używane 
przez inne magistrale lub kanały, są wyświetlane na czerwono w wyskakującym menu Device Port 
(Port urządzenia). Jeśli wybierzesz używany port, jego poprzednie połączenie zostanie utracone.

Phones Channel (Kanał telefonów)
Możesz użyć kanału telefonicznego w Control Room (sterowni), aby słuchać miksów cue.

Możesz utworzyć 1 kanał telefonu dla konfiguracji stereo. Umożliwia słuchanie głównego miksu 
lub miksów cue lub zewnętrznych wejść na parze słuchawek. Możesz go również użyć do 
podglądu.
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Kanały cue
Możesz użyć kanałów cue do wysyłania miksów cue, zwanych również miksami słuchawkowymi, 
do wykonawców w studio podczas nagrywania.

Możesz utworzyć do 4 kanałów cue w trybie mono lub stereo dla 4 dyskretnych miksów cue. 
Kanały cue mają funkcje talkback i click. Pozwalają monitorować główny miks, zewnętrzne 
wejścia lub dedykowany miks cue.

PRZYKŁAD
Jeśli masz 2 dostępne wzmacniacze słuchawkowe dla wykonawców, możesz utworzyć 1 kanał cue 
dla każdego miksu cue i nazwać je zgodnie z ich funkcją: miks wokalisty, miks basisty itp.

Kanały cue i wysyłki cue 
Dla każdego kanału cue, który zdefiniujesz w oknie Audio Connections (Połączenia audio), każdy 
kanał w MixConsole ma cue send z wyborem poziomu, panoramy i przed/po tłumiku. Te wysyłki 
cue mogą być używane do tworzenia dyskretnych miksów cue, których wykonawcy mogą słuchać.

● Aby wyświetlić wysyłki cue, otwórz MixConsole i aktywuj Racks > Cue Sends (Regały > 
Wysyłki Cue).

Wejścia zewnętrzne
Wejść zewnętrznych można używać do monitorowania urządzeń zewnętrznych, takich jak 
odtwarzacze CD, nagrywarki wielokanałowe lub dowolne inne źródła dźwięku.

Możesz utworzyć do 6 zewnętrznych wejść dla konfiguracji głośników mono, stereo lub surround.

UWAGA
Jeśli jako źródło wejściowe kanału audio wybierzesz wejścia zewnętrzne, możesz je nagrać. 
W takim przypadku nie ma potrzeby przypisywania portów urządzeń do kanału wejściowego.

Talkback Channels  (Kanały rozmów zwrotnych)
Możesz użyć kanałów talkback do komunikacji między reżyserką (Control Room) a wykonawcami
w studiu.
Możesz utworzyć 1 kanał Talkback i przypisać kanał wejściowy mono do każdego z nich.

Możesz także używać kanałów Talkback jako źródła wejściowego dla ścieżek audio i nagrywać je. 
Możesz skierować je do każdego kanału cue i użyć różnych poziomów.
Możesz wstawić efekty, takie jak kompresor lub ogranicznik na kanałach talkback. Dzięki temu 
nieregularne poziomy nie przeszkadzają wykonawcom i możliwa jest wyraźna komunikacja ze 
wszystkimi.
UWAGA
Opcja Auto Disable Talkback Mode (Automatycznego wyłączania trybu rozmowy zwrotnej)
 w oknie dialogowym Preferences (Preferencje) (strona VST — Control Room (Reżyserka, 
sterownia)) umożliwia określenie sposobu działania funkcji rozmowy zwrotnej podczas 
odtwarzania i nagrywania.

Control Room - Main Tab (Reżyserka — zakładka główna)
Karta Main (Główna) reżyserki wyświetla informacje i elementy sterujące dla kanałów 
zdefiniowanych na karcie Control Room (Reżyserka) w oknie Audio Connwections (Połączenia 
audio).
Zakładka Main reżyserki jest podzielona na kilka sekcji, które otwiera się, klikając ich nagłówek. 
Aby otworzyć kilka sekcji jednocześnie, użyj kombinacji klawiszy Ctrl/Cmd i kliknij.
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External (Zewnętrzne)
Sekcja External umożliwia wykorzystanie wejść zewnętrznych do monitorowania urządzeń 
zewnętrznych. Jest widoczne tylko wtedy, gdy w oknie Audio Connections (Połączenia audio) 
dodano więcej niż jedno wejście zewnętrzne.

                    
Aby przełączyć się na inne wejście zewnętrzne, kliknij nazwę wejścia i wybierz nowe wejście 
zewnętrzne z wyskakującego menu.

Cue Channel  (Kanał podpowiedzi)
Sekcja Cue Channel umożliwia skonfigurowanie kanałów cue do wysyłania miksów cue.
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1   Activate Cue Channel (Aktywuj kanał Cue)
         Umożliwia aktywację/dezaktywację kanału cue.
2   Source selectors (Selektory źródła)
         Pozwala wybrać źródło dla kanału cue: miks monitorów (Mix), wejścia zewnętrzne (Ext) lub 
         wysyłki cue (Cues). Wskaźniki obecności sygnału w lewym górnym rogu zapalają się, gdy 
         kanał źródłowy wysyła dane do kanału cue.
3   Signal Level (Poziom sygnału)
         Umożliwia ustawienie poziomu sygnału
4   Enable Talkback to Cue Channel (Włącz funkcję Talkback to Cue Channel)
         Umożliwia aktywację funkcji talkback w celu komunikacji między reżyserką a wykonawcami 
         w studiu. Za pomocą suwaka możesz ustawić poziom sygnału rozmowy zwrotnej.
5   Activate Metronome Click (Aktywuj kliknięcie metronomu)
         Aktywuje kliknięcie metronomu. Użyj elementów sterujących Click Level i Click Pan, aby 
         ustawić głośność i pozycję w panoramie kliknięcia metronomu.

Channels (Kanały)
Sekcja Channels pokazuje rozmieszczenie głośników szyny Main Mix.

Funkcji solo można używać do słuchania poszczególnych kanałów Main Mix. Można go również 
użyć do przetestowania wielokanałowego systemu głośników i upewnienia się, że do głośników są 
kierowane odpowiednie kanały.

          

1   Solo Left and Right Channels (lewy i prawy kanał solo)
        Umożliwia solo lewego i prawego kanału.
2   Solo Front Channels (solowe kanały przednie)
        Umożliwia solo kanałów przednich.
3   Solo Surround Channels (kanały dźwięku przestrzennego Solo)
        Umożliwia solo kanałów surround.
4   Listen to Solo Channels on Center Channel (Słuchaj kanałów solo na kanale centralnym)
        Umożliwia słuchanie wszystkich głośników solo w kanale centralnym. Jeśli kanał środkowy 
        nie jest dostępny, kanały są rozdzielane równo po lewej i prawej stronie.
5   Listen to Surround Channels on Front Channels (Słuchaj kanałów surround na przednich 
     kanałach)
        Umożliwia solo kanałów surround i kierowanie ich do przednich głośników.
6   Solo LFE Channel (Solo kanału LFE)
        Umożliwia solo kanału LFE.

Aby otworzyć szynę Main Mix we wtyczce MixConvert V6, kliknij dwukrotnie wyświetlacz 
kanału.

POWIĄZANE LINKI
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MixConvert V6 na stronie 688

Monitors (Monitory)
Sekcja Monitors umożliwia wybór i konfigurację zestawów monitorów.

               

Downmix Presets (Ustawienia wstępne miksu)
Sekcja Downmix Presets umożliwia skonfigurowanie presetów downmixu

              

1   Assign Downmix Preset (Przypisz ustawienie wstępne miksu)
       Umożliwia skonfigurowanie ustawienia wstępnego miksu dla monitora wybranego w sekcji    
       Monitors (Monitory).
2   Select Output Configuration (Wybierz Konfiguracja wyjścia)
       Umożliwia wybranie konfiguracji kanału wyjściowego. Możesz także wybrać opcję    
       Open/Close MixConvert (Otwórz/Zamknij MixConvert), aby otworzyć wtyczkę MixConvert 
       V6.
POWIĄZANE LINKI
MixConvert V6 na stronie 688

Phones  (Telefony)
Sekcja Phones umożliwia korzystanie z kanału telefonicznego w Control Room (Reżyserka) do 
słuchania miksów cue.

           

1   Activate Phones Channel (Aktywuj kanał Telefony)
        Umożliwia aktywację/dezaktywację kanału telefonicznego.
2   Activate Metronome Click (Aktywuj kliknięcie metronomu)
        Aktywuje/dezaktywuje kliknięcie metronomu.
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3   Source selectors (Selektory źródła)
        Pozwala wybrać źródło dla kanału telefonu: miks monitorów (Mix), wejścia zewnętrzne (Ext) 
        lub wysyłki cue (Cues). Wskaźniki obecności sygnału w lewym górnym rogu zapalają się, gdy
        kanał źródłowy wysyła dane do kanału telefonicznego.
4   Phones Level (Poziom telefonów)
        Umożliwia ustawienie poziomu telefonów. Ctrl/Cmd — kliknij, aby ustawić poziom na 
        poziom odniesienia określony w oknie dialogowym Preferences (Preferencje) (strona VST — 
        Control Room (Reżyserka)).
5   Click Level and Click Panning (Kliknij opcję Poziom, a następnie opcję Panoramowanie)
        Użyj elementów sterujących Click Level i Click Panning, aby ustawić głośność i pozycję w 
        panoramie kliknięcia metronomu.
6   Enable Listen for Output (Włącz opcję Nasłuchuj wyjścia)
        Włącza funkcję słuchania magistrali.
7   Listen Level (Poziom słuchania)
        Umożliwia ustawienie poziomu odsłuchu.

Control Room Channel (Kanał reżyserki)
Kanał Control Room jest reprezentacją szyny ustawionej jako szyna Main Mix na zakładce 
Outputs (Wyjścia) w oknie Audio Connections (Połączenia audio).

          

         

1   Activate Control Room Channel (Aktywuj kanał reżyserki)
         Umożliwia aktywację/dezaktywację kanału Control Room.
2   Signal Level (Poziom sygnału)
         Umożliwia ustawienie głośności wyjścia Control Room. Nie ma to wpływu na poziom 
         wejściowy nagrywania ani poziom Main Mix do eksportowania miksów. Ctrl/Cmd — 
         kliknij, aby ustawić poziom na poziom odniesienia określony w oknie dialogowym 
         Preferences (Preferencje) (strona VST — Control Room (Reżyserka))
3   Signal meter (Miernik sygnału)
        Pokazuje głośność dla wyjścia Control Room.
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1   Source selectors (Selektory źródła)
        Pozwala wybrać źródło dla kanału Control Room. Dostępne źródła zależą od kanałów 
        dodanych do reżyserki. Wskaźniki obecności sygnału w lewym górnym rogu 
        zapalają się, gdy kanał źródłowy wysyła dane do kanału Control Room.
2   Dim Signal (Słaby sygnał)
        Aktywuj to, aby obniżyć poziom reżyserki (sterowni) o ustaloną wartość. Pozwala to na 
        szybkie zmniejszenie głośności monitora bez zakłócania bieżącego poziomu monitora. 
        Ponowne kliknięcie przycisku Dim (Osłab) powoduje powrót do poprzedniego ustawienia 
        monitora.
3   Use Reference Level (Użyj poziomu odniesienia)
        Włącz ten przycisk, aby ustawić poziom pokoju kontrolnego na poziom odniesienia określony 
        w oknie dialogowym Preferences (Preferencje) (strona VST — Control Room (Reżyserka).  
        Poziom odniesienia to poziom używany w skalibrowanych środowiskach miksowania, takich 
        jak sceny do kopiowania filmów.
4   Activate Metronome Click (Aktywuj kliknięcie metronomu)
        Aktywuje kliknięcie metronomu.

            

1   Monitor selectors (Selektory monitorów)
        Umożliwia wybranie innego źródła monitora.
2   Downmix Preset selectors (selektory presetów Downmix)
        Umożliwia wybranie innego ustawienia wstępnego downmixu.
3   Activate Talkback (Włącz Talkback)
        Umożliwia aktywację funkcji talkback w celu komunikacji między reżyserką (Control Room)
        a wykonawcami w studiu. Kliknij, aby aktywować, kliknij i przytrzymaj, aby włączyć tryb 
        chwilowy.

                          
1   Click Level/Click Pan (Kliknij Poziom/Kliknij Przesuń)
        Użyj elementów sterujących Click Level i Click Pan, aby ustawić głośność i pozycję w 
        panoramie kliknięcia metronomu dla kanału Control Room.
2   AFL/PFL
        Pozwala określić, czy sygnał kanału z możliwością odsłuchu jest kierowany do kanału 
        Control Room po zastosowaniu ustawień tłumika i panoramy AFL, czy przed zastosowaniem 
        ustawień tłumika i panoramy PFL
3   Enable Listen for Output (Włącz funkcję Nasłuchuj wyjścia)
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        Włącza funkcję magistrali nasłuchiwania dla wyjścia Control Room (Reżyserki).
4   Listen Level (Poziom słuchania)
        Umożliwia regulację głośności sygnałów szyny nasłuchowej, które są kierowane do wyjścia 
        Control Room.
5   Listen Dim (Słuchaj przyćmiony)
        Umożliwia regulację głośności Main Mix, gdy kanały są w trybie słuchania. Dzięki temu 
        kanały z możliwością słuchania pozostają w kontekście głównego miksu. Jeśli poziom Listen 
       Dim jest ustawiony na minimalną wartość, będziesz słyszeć tylko kanały z włączoną funkcją 
       słuchania.
6   Talk Dim (Rozmowa przyćmiona)
        Kiedy funkcja Talkback jest aktywna, ten suwak kontroluje, o ile moc wyjściowa wszystkich  
        kanałów w reżyserce jest zmniejszana, aby zapobiec niepożądanemu sprzężeniu zwrotnemu.  

 Control Room - Inserts Tab (Reżyserka — zakładka Wstawki)
Zakładka Control Room Inserts (Wstawki w reżyserce) zawiera dodatkowe ustawienia dla 
kanałów.
Karta wstawek w reżyserce jest podzielona na kilka sekcji, które otwiera się, klikając ich nagłówki.
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Input Gain (Wzmocnienie wejściowe)

           
Ustawienie wzmocnienia wejściowego może być przydatne w następujących sytuacjach:
● Aby zrównoważyć poziom wejść zewnętrznych, na przykład odtwarzaczy CD i innych źródeł, do 
poziomu Main Mix, dla porównań A/B.
● Aby zrównoważyć poziom systemów odsłuchowych, tak aby przełączanie między zestawami 
głośników nie zmieniało głośności odtwarzania.

Input Phase (Faza wejściowa)

           
Odwrócenie fazy wejściowej może być przydatne w przypadku wejść zewnętrznych i wyjść 
głośników monitorowych.

Insert Effects (efekty insertowe)

           
Każdy kanał Control Room (reżyserka) ma zestaw gniazd efektów insertowych.

Control Room Channel Inserts (Wstawki kanałów w reżyserce)
        Do wtyczek pomiarowych i analizy widmowej. Wszystkie solówki, w tym szyna Listen, będą 
        przechodzić przez kanał Control Room i pozwolą na analizę poszczególnych dźwięków.  
        Ogranicznik muru w ostatnim gnieździe kanału Control Room może zapobiec przypadkowym
        przeciążeniom i uszkodzeniom systemów głośnikowych.
Talkback Channel Inserts (Wstawki kanału rozmowy zwrotnej)
        Do sterowania dynamiką mikrofonu talkback (rozmowa zwrotna). Pomaga to chronić słuch 
        wykonawców i zapewnia, że wszyscy będą słyszani przez mikrofon Talkback.
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Monitor Inserts (Wstawki monitora)
        Do dekodowania dźwięku przestrzennego lub ograniczania sygnału typu brickwall (ściana z  
        cegieł) w celu ochrony wrażliwych głośników monitora. Każdy kanał monitora ma zestaw  
        ośmiu wstawek, z których wszystkie są tłumikami post Control Room.

UWAGA
Możesz zapisać gniazda insertów dla kanałów Cue, Monitor i Control Room, zapisując ustawienie
wstępne w zakładce Control Room (reżyserka) w oknie Audio Connections (Połączenia audio). 
Jest to przydatne, ponieważ nie są one zapisywane wraz z projektem.

POWIĄZANE LINKI
Okno połączeń audio na stronie 26

Konfigurowanie Cue Mix
Możesz stworzyć miks cue z poziomów suwaka i panoramy, które są używane w MixConsole 
i zmienić je, aby spełnić potrzeby poszczególnych wykonawców.

PROCEDURA
1. W MixConsole wybierz kanały, z których chcesz skopiować ustawienia.
2. W Control Room (rezyserce) wykonaj jedną z następujących czynności:
        ● Aby zastosować funkcję tylko do tego kanału cue, kliknij prawym przyciskiem myszy kanał 
           cue, aby otworzyć menu kontekstowe.
        ● Aby zastosować tę funkcję do wszystkich kanałów cue, kliknij gdziekolwiek poza kanałem 
          cue, aby otworzyć menu kontekstowe.
3. Wybierz From selected mixer channels (Z wybranych kanałów miksera) i wybierz jedną z 
funkcji.

                 

Cue Mix Context Menu (Menu kontekstowe Cue Mix)

Change Cue Sends Levels (Zmień poziomy wysyłania Cue)
         Umożliwia jednoczesne dostosowanie wielu poziomów wysyłania.
Use Current Mix Levels (Użyj aktualnych poziomów miksu)
         Umożliwia skopiowanie poziomów suwaków wybranych ścieżek do wysyłek cue. To ustawia 
         wszystkie poziomy wysyłania cue dla wybranych ścieżek na poziom tłumika głównego  
         kanału. Zmienia również stan wysyłania cue na pre-fader, dzięki czemu zmiany w głównym 
         miksie nie wpływają na wysyłanie cue.
Use Current Pan Settings (Użyj bieżących ustawień panoramy)
        Umożliwia skopiowanie informacji panoramy z głównego miksu do wysyłek cue wybranych 
        ścieżek. Jeśli cue send jest mono, ustawienie panoramy jest kopiowane, ale wyjście cue send 
        jest sumą lewego i prawego kanału.
Enable Cue Sends (Włącz wysyłanie Cue)
        Umożliwia aktywację wysyłek cue wybranych kanałów. Aby móc usłyszeć miks cue dla 
        kanału cue, wysyłanie cue musi być włączone.
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Disable Cue Sends (Wyłącz wysyłanie Cue)
         Umożliwia wyłączenie wysyłania cue wybranych kanałów.
Reset Cue Sends (Zresetuj wysyłki cue)
         Umożliwia dezaktywację wysyłek cue, zmianę poziomu wysyłania wszystkich wybranych  
         kanałów na 0 dB oraz ustawienie źródła sygnału na post-fader. W ten sposób wszelkie zmiany
         w głównym miksie zmieniają również miks cue. Aby podnieść poziom poszczególnych 
         kanałów cue, zwiększ poziom na tym kanale.

Regulacja ogólnego poziomu wysyłania Cue

Możesz dostosować wiele poziomów wysyłania w tym samym czasie dla miksu cue send, 
zachowując nienaruszony miks, jednocześnie obniżając ogólną głośność. Czasami jest to konieczne,
ponieważ poziomy w głównym miksie są często optymalizowane pod kątem możliwie 
najgłośniejszego poziomu sygnału bez przesterowania.

Oznacza to, że kiedy tworzysz miks „więcej mnie”, może się okazać, że w cue send nie ma 
wystarczającej ilości miejsca na podniesienie poziomów bez wprowadzania obcinania

PROCEDURA
1. W MixConsole wybierz kanały, które chcesz zmodyfikować.
2. W Control Room (Reżyserka) kliknij prawym przyciskiem myszy kanał cue, aby otworzyć menu 
    kontekstowe.
3. Wybierz From selected mixer channels > Change Cue Sends Levels (Z wybranych kanałów 
    miksera > Zmień poziomy wysyłania Cue).
4. Aktywuj Relative Mode (tryb względny).
    W ten sposób dostosujesz istniejące poziomy. Dezaktywując Relative Mode (tryb względny), 
    wszystkie wysyłki cue są ustawione na ten sam poziom bezwzględny.
5. W razie potrzeby dostosuj poziom.
    Poziom wszystkich wybranych wysyłek cue jest regulowany o ustawioną wartość.
6. Kliknij OK.

441



Metering and Loudness (Pomiar i głośność)

Cubase zapewnia miernik główny, który działa jako wielokanałowy miernik wartości szczytowej, 
oraz miernik głośności, który pozwala mierzyć głośność zgodnie z zaleceniami dotyczącymi 
głośności R 128 Europejskiej Unii Nadawców (EBU).

Metering (Pomiar)
Cubase zapewnia miernik główny i miernik głośności, które można wyświetlić w prawej strefie
okna Project i MixConsole lub w osobnym oknie w Control Room (reżyserka).

Master Meter (Miernik główny)
Miernik główny jest wielokanałowym miernikiem rzeczywistych wartości szczytowych.

● Aby otworzyć miernik główny, wybierz zakładkę Master na dole wyświetlacza miernika w 
MixConsole lub w Control Room.

             

Activate Control Room View (Aktywuj widok rezyserki)
        Pokazuje/ukrywa sekcję reżyserki..
Switch between different Peak Program Meter scale standards (Przełączaj między różnymi 
standardami skali miernika programu szczytowego)
        Umożliwia wybór skali zgodnie z różnymi standardami nadawania (Digital, DIN, EBU, 
        British, Nordic, K-20, K-14, K-12, +3dB Digital, +6dB Digital lub +12dB Digital) . Wysokość
        nadprogu jest wskazywana przez czerwone linie na skali licznika.
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UWAGA
Możesz dostosować wygląd miernika dla wszystkich wag indywidualnie w oknie dialogowym 
Preferences (Preferencje) Metering—Appearance page (Pomiary —  strona Wygląd).

Alignment level standards (Standardy poziomu wyrównania)
         Umożliwia wybranie poziomu wyrównania (przesunięcia) dla skali. Ta funkcja jest 
         niedostępna dla wag cyfrowych i K-System. Skale mierników emisji DIN, EBU, Nordic i  
         British mają domyślny poziom wyrównania -18 dBFS.
Configure Meter Settings (Skonfiguruj ustawienia miernika)
         Otwiera okienko ustawień miernika. Tutaj możesz zmienić ustawienia RMS dla miernika 
         głównego.
Reset RMS Max. and PPM Max (Zresetuj maks. RMS. i PPM maks).
         Resetuje pomiar.
RMS/Peak meter (Miernik wartości skutecznej/szczytowej)
         Pokazuje wartości RMS i wartości szczytowe jako niebieskie linie, a wartości szczytowe jako 
         szare linie.
RMS Max. (RMS maks).
         Pokazuje maksymalną wartość RMS.
Peak Max. (Szczyt Maks.)
         Pokazuje maksymalną wartość szczytową

POWIĄZANE LINKI
Reżyserka na stronie 425
Pomiar – wygląd na stronie 1175
Okienko ustawień licznika na stronie 441

Wyświetlanie liczników
Liczniki mogą być wyświetlane w prawej strefie okna Project i MixConsole lub w osobnym oknie 
w Control Room (reżyserce).

PROCEDURA
1. W oknie Project lub w MixConsole kliknij Show/Hide Right Zone (Pokaż/ukryj prawą strefę),  
    aby pokazać prawą strefę z Control Room/Meter (Reżyserka/Miernik).
2. Kliknij zakładkę Meter (Miernik) u góry sekcji Control Room/Meter (Sterownia/Miernik).
    Domyślnie wyświetlany jest licznik główny.

Loudness Measurement (Pomiar głośności)
Pomiary głośności zgodne z zaleceniami R 128 Europejskiej Unii Nadawców (EBU) uwzględniają 
głośność, zakres głośności i maksymalne rzeczywiste wartości szczytowe.

Loudness Measurement (Pomiar głośności)

Wykonuje się następujące pomiary:

●   Integrated Loudness (Zintegrowana głośność)
        Średnia głośność mierzona w całym programie w LUFS (jednostka głośności w odniesieniu do
        pełnej skali).
        Zgodnie z zaleceniem dotyczącym głośności R 128, dźwięk powinien być znormalizowany na 
        poziomie -23 LUFS (±1 LU).
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●   Short-Term Loudness (Krótkotrwała głośność)
        Głośność mierzona co sekundę w bloku audio trwającym 3 sekundy. Daje to informacje 
        o najgłośniejszych fragmentach audio.
●   Momentary Loudness (Chwilowa głośność)
        Maksymalna wartość wszystkich chwilowych wartości głośności mierzonych co 100 ms w 
        zakresie audio 400 ms.

Loudness Range (Zakres głośności)

Zakres głośności mierzy zakres dynamiczny w całym programie w LU (Loudness Units - 
jednostkach głośności). Podaje stosunek między najgłośniejszymi i najcichszymi sekcjami, które 
nie są ciche. Dźwięk jest podzielony na małe bloki. W każdej sekundzie pojawia się jeden blok 
dźwiękowy, a każdy blok trwa 3 sekundy, tak aby analizowane bloki zachodziły na siebie.

Górne 10 % cichych bloków i górne 5 % głośnych bloków jest wykluczonych z końcowej analizy. 
Obliczony zakres głośności to stosunek między najgłośniejszymi i najcichszymi pozostałymi 
blokami audio. Ten pomiar pomaga zdecydować, ile kompresji lub rozszerzenia należy zastosować 
do dźwięku.

True Peak (Prawdziwy szczyt)

Gdy sygnał cyfrowy jest konwertowany na sygnał analogowy, EBU R 128 zaleca raczej pomiar 
szacunkowych wartości szczytowych niż poleganie na wartościach szczytowych cyfrowych. 
Pozwala to uniknąć przycinania i zniekształceń.

Naming and Units (Nazewnictwo i jednostki)

EBU R 128 proponuje następujące konwencje nazewnictwa i jednostek:
● Względny pomiar, taki jak wartość odnosząca się do poziomu odniesienia, LU jako jednostka  
    głośności (1 LU to 1 dB).
● Pomiar bezwzględny, LUFS jako jednostka głośności w odniesieniu do pełnej skali. 1 LUFS  
    można rozumieć jako 1 dB w skalowaniu AES17.

Scales (Skale)

Miernik głośności oferuje dwie różne skale:
● Skala EBU +9 ma zakres od -18,0 LU do +9,0 LU (-41,0 LUFS do -14,0 LUFS).
● Skala EBU +18 ma zakres od -36,0 LU do +18 LU (-59,0 LUFS do -5,0 LUFS)

Loudness Meter (Miernik głośności)

Miernik głośności pozwala analizować, mierzyć i monitorować głośność projektu w czasie 
rzeczywistym podczas odtwarzania lub miksowania.

● Aby otworzyć miernik głośności, wybierz zakładkę Loudness (Głośność) na dole wyświetlacza 
miernika w prawej strefie okna Project lub MixConsole, lub w Control Room (reżyserka).
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Activate Control Room View (Aktywuj widok reżyserki)
        Pokazuje/ukrywa sekcję reżyserki (sterowni).
Loudness meter (Miernik głośności)
        Pokazuje wartość zintegrowaną jako trójkąt na lewej skali miernika, a wartość 
        krótkoterminową jako trójkąt na prawej skali miernika.
Measure Loudness (Zmierz głośność)
        Aktywuje pomiar głośności.
Switch between LU and LUFS (Przełączanie między LU a LUFS)
        Przełącza skalę miernika między LUFS (wartości bezwzględne) i LU (wartości względne).
Configure Loudness Settings (Skonfiguruj ustawienia głośności)
        Umożliwia określenie wartości progowej dla wskaźników obcinania Momentary Max.,  
        Short-Term, Integrated i True Peak. Jeśli zostaną wykryte wartości powyżej ustawionych 
        progów, odpowiednie wskaźniki zmienią kolor na czerwony.
        Miernik głośności można przełączać między skalą EBU +9 a skalą EBU +18.
        Aby zresetować wszystkie wartości przy rozpoczęciu odtwarzania, aktywuj opcję Reset 
        (Resetuj) przy starcie.
Reset Loudness (Zresetuj głośność)
        Resetuje wszystkie wartości głośności.
Momentary Max. (Chwilowy maks.)
        Pokazuje maksymalną wartość wszystkich chwilowych wartości głośności w oparciu o okno 
        czasowe 400 ms. Pomiar nie jest bramkowany.
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Short-Term (Krótkoterminowe)
         Pokazuje maksymalną wartość wszystkich krótkoterminowych wartości głośności w oparciu o
         okno czasowe 3 s. Pomiar nie jest bramkowany.
Integrated (Zintegrowany)
         Pokazuje średnią głośność mierzoną od początku do końca. Okres pomiaru jest pokazany na   
         wyświetlaczu czasu (Time). Zalecana wartość zintegrowanej głośności to -23 LUFS. Ta 
         wartość bezwzględna jest punktem odniesienia dla względnej skali LU, gdzie -23  LUFS  
         równa się 0 LU.
Range (Zakres)
        Pokazuje zakres dynamiczny dźwięku mierzony od początku do końca. Ta wartość pomaga 
        zdecydować, ile kompresji dynamicznej można zastosować. Zalecany zakres dla bardzo  
        dynamicznego dźwięku, takiego jak muzyka filmowa, to 20 LU.
True Peak (Prawdziwy szczyt)
        Pokazuje rzeczywisty szczytowy poziom dźwięku. Maksymalny dozwolony rzeczywisty 
        poziom szczytowy w produkcji wynosi -1 dB.
Time (Czas)
        Pokazuje czas trwania zintegrowanego pomiaru głośności.

POWIĄZANE LINKI
Wyświetlanie mierników na stronie 438
Reżyserka na stronie 425
Pomiar i głośność na stronie 437
Okienko ustawień miernika na stronie 441

Okienko ustawień miernika
● Aby otworzyć panel ustawień miernika, kliknij opcję Configure Meter Settings (Konfiguruj 
ustawienia miernika) na karcie Master (Główne) lub Configure Loudness Settings (Konfiguruj 
ustawienia głośności) na karcie Loudness (Głośność).

               

W sekcji Loudness Settings (Ustawienia głośności) dostępne są następujące parametry:

Save Preset/Remove Preset (Zapisz ustawienie wstępne/Usuń ustawienie wstępne)
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         Umożliwia tworzenie, ładowanie i usuwanie ustawień głośności.

Momentary Max. (Chwilowy maks.)
        Umożliwia określenie wartości odniesienia i wartości tolerancji dla maksymalnej chwilowej 
        głośności. W przypadku wykrycia wyższych wartości wskaźnik przesterowania na mierniku 
        głośności zmieni kolor na czerwony.
Short-Term (Krótkoterminowe)
        Umożliwia określenie wartości odniesienia i wartości tolerancji dla głośności krótkotrwałej. W
        przypadku wykrycia wyższych wartości wskaźnik przesterowania na mierniku głośności 
        zmieni kolor na czerwony.
Integrated (Zintegrowany)
        Umożliwia określenie wartości odniesienia i wartości tolerancji dla zintegrowanej głośności. 
        W przypadku wykrycia wyższych wartości wskaźnik przesterowania na mierniku głośności 
        zmieni kolor na czerwony.
True Peak (Prawdziwy szczyt)
        Umożliwia określenie wartości odniesienia i wartości tolerancji dla rzeczywistego poziomu 
        szczytowego. W przypadku wykrycia wyższych wartości wskaźnik przesterowania na 
        mierniku głośności zmieni kolor na czerwony.
Switch between LU and LUFS (Przełączanie między LU a LUFS)
        Umożliwia przełączanie skali miernika między LUFS (wartości bezwzględne) i LU (wartości 
        względne).
Switch between EBU +9 Scale and EBU +18 Scale (Przełączanie między skalą EBU +9 a skalą 
EBU +18)
         Umożliwia przełączanie miernika pomiędzy skalą EBU +9 i EBU +18.
         W sekcji RMS Settings (Ustawienia RMS) dostępne są następujące parametry:
AES 17
         Aktywuje standard AES17, który dodaje przesunięcie o 3 dB do wartości RMS.
Resolution (Rezolucja)
         Umożliwia ustawienie długości mierzonego i uśrednianego dźwięku w zakresie od 1 ms do 
         1000 ms. Obniżenie rozdzielczości zwiększa wpływ krótkich fragmentów głośnego/słabego 
         dźwięku na wartość RMS i odwrotnie.

POWIĄZANE LINKI
Miernik głośności na stronie 439
Miernik główny na stronie 437
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Audio Effects (Efekty dźwiękowe)

Cubase zawiera wiele wtyczek efektów, których można używać do przetwarzania kanałów audio, 
grupowych, instrumentalnych i ReWire.
Efekty i ich parametry są opisane w osobnym dokumencie Plug-in Reference (Opis wtyczek).

Insert Effects and Send Effects (Wstaw efekty i wyślij efekty)
Możesz zastosować efekty do kanałów audio, używając efektów wstawiania lub wysyłania efektów.

UWAGA
Aby zastosować efekty dźwiękowe do poszczególnych zdarzeń dźwiękowych, użyj Direct Offline 
Processing (Bezpośredniego przetwarzania offline).

Insert Effekts (Efekty insertowe)
Efekty insertowe są wstawiane do łańcucha sygnału kanału audio. W ten sposób cały sygnał kanału 
przechodzi przez efekt.

Możesz dodać do 16 różnych efektów insertowych na kanał.
Efektów insertowych można używać do takich efektów, jak przesterowanie, filtry lub inne efekty, 
które zmieniają charakterystykę tonalną lub dynamiczną dźwięku.

Aby dodawać i edytować efekty wstawiania, możesz skorzystać z następujących sekcji wstawiania:
● Inserts rack (Stojak insertów) w MixConsole. 

    

● Sekcja Inserts (Inserty) w oknie Channel Settings (Ustawienia kanału).

    

● Sekcja Inserts (wstawki) w Inspector (Inspektorze).

     

Send Effects (Efekty wysyłkowe)
Efekty wysyłania można dodawać do ścieżek kanałów FX, a przetwarzane dane audio można 
kierować do efektu. W ten sposób wysyłane efekty pozostają poza ścieżką sygnału kanału audio.

Każdy kanał audio ma 8 wysyłek, z których każdy może być dowolnie kierowany do efektu (lub do 
łańcucha efektów).
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Użyj efektów wysyłania w następujących przypadkach:

● Aby kontrolować równowagę między suchym i mokrym dźwiękiem indywidualnie dla każdego 
kanału.
● Aby użyć tego samego efektu dla kilku różnych kanałów audio.

Aby edytować efekty wysyłania, możesz użyć następujących sekcji wysyłania:
● Stojak Sends w MixConsole.

     

● Sekcja Sends (Wysyłania) w oknie Channel Settings (Ustawienia kanału).

     

● Sekcja Sends (Wysyłania) w Inspector (Inspektorze).

     

POWIĄZANE LINKI
Bezpośrednie przetwarzanie w trybie offline na stronie 475.

Standard VST
Efekty dźwiękowe można zintegrować z Cubase dzięki standardowi VST. W tej chwili obsługiwane
są standardy VST 3 i VST 2.
Standard wtyczek VST 3 oferuje ulepszenia, takie jak inteligentne przetwarzanie wtyczek i wejścia 
łańcucha bocznego. VST 3 zachowuje pełną kompatybilność wsteczną z VST 2.

Inteligentne przetwarzanie wtyczek
Inteligentne przetwarzanie wtyczek to technologia, która pozwala wyłączyć przetwarzanie wtyczek,
gdy nie ma sygnału. Zmniejsza to obciążenie procesora podczas cichych pasaży i pozwala 
załadować więcej efektów.

Aby aktywować inteligentne przetwarzanie wtyczek, aktywuj Suspend VST 3 plug-in processing 
when no audio signals are received (Przetwarzanie wtyczek Suspend VST 3, gdy nie są odbierane 
żadne sygnały audio) w oknie dialogowym Preferences (Preferencje) (strona VST—Plug-ins (VST
— wtyczki)).
UWAGA
Sprawdź procesor pod kątem przejścia z największą liczbą zdarzeń odtwarzanych jednocześnie, aby
upewnić się, że Twój system oferuje wymaganą wydajność w każdej pozycji czasowej.

Side-Chain Inputs (Wejścia łańcucha bocznego)
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Kilka efektów VST 3 posiada wejścia łańcucha bocznego. Pozwalają one kontrolować działanie 
efektu za pomocą zewnętrznych sygnałów, które są kierowane do wejścia łańcucha bocznego.
Przetwarzanie efektów jest nadal stosowane do głównego sygnału audio.

POWIĄZANE LINKI
Łańcuch boczny na stronie 459

Kompensacja opóźnienia (delay) wtyczki
Niektóre efekty dźwiękowe, zwłaszcza procesory dynamiki z funkcją wyprzedzania, mogą zająć 
trochę czasu, zanim przetworzą przekazany do nich dźwięk. W rezultacie wyjściowy dźwięk jest 
nieco opóźniony. Aby to zrekompensować, Cubase zapewnia kompensację opóźnień wtyczek.

Kompensacja opóźnienia wtyczek jest dostępna na całej ścieżce audio, zachowując synchronizację i
taktowanie wszystkich kanałów audio.

Wtyczki dynamiki VST 3 z funkcją podglądu w przód zawierają przycisk Live (Na żywo), który 
umożliwia wyłączenie podglądu w przód. Minimalizuje to opóźnienia podczas nagrywania w czasie
rzeczywistym. Aby uzyskać szczegółowe informacje, zobacz oddzielny dokument Informacje o 
wtyczkach (Plug-in Reference).

Aby uniknąć opóźnień podczas nagrywania w czasie rzeczywistym lub odtwarzania instrumentów 
VST w czasie rzeczywistym, można również użyć funkcji Constrain Delay Compensation 
(Ograniczenie kompensacji opóźnienia).

POWIĄZANE LINKI
Ograniczenie kompensacji opóźnienia na stronie 737
Okno MixConsole na stronie 349

Tempo Sync (Synchronizacja tempa)
Wtyczki mogą otrzymywać informacje o taktowaniu i tempie z Cubase. Jest to przydatne do 
synchronizacji parametrów wtyczek, takich jak współczynniki modulacji lub czasy opóźnienia, z 
tempem projektu.

Informacje o czasie i tempie są dostarczane do wtyczek standardowego VST 2.0 lub nowszego.

Aby ustawić synchronizację tempa, musisz określić wartość nuty bazowej. Obsługiwane są proste, 
trójkowe lub kropkowane wartości nut (od 1/1 do 1/32).
Szczegółowe informacje na temat dołączonych efektów można znaleźć w osobnym dokumencie 
Plug-in Reference (Informacje o wtyczkach)

Insert Effects (Efekty insertowe)
      Efekty insertowe można wstawiać do łańcucha sygnału kanału audio. W ten sposób cały sygnał 
kanału przechodzi przez efekt.
      Możesz dodać do 16 różnych efektów insertowych niezależnie dla każdego kanału związanego 
z dźwiękiem (ścieżka audio, ścieżka kanału grupy, ścieżka kanału FX, kanał instrumentu lub kanał 
ReWire) lub szyna wyjściowa.
      Sygnał przechodzi przez efekty insertowe odpowiadające ich pozycji w gnieździe od góry do 
dołu.
      Możesz zdefiniować gniazda insertów post-fader dla dowolnego kanału. Gniazda post-fader są 
zawsze post-EQ i post-fader.
UWAGA
Aby wyświetlić wszystkie sloty post-fader w MixConsole, otwórz Rack Settings (Ustawienia 
stojaka, regału, szafy) i aktywuj Fixed Number of Slots (Stała liczba slotów).
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Użyj gniazd post-fader dla efektów insertowych, w których chcesz, aby poziom pozostał 
niezmieniony po efekcie. Dithering i maksymalizacja są zwykle używane na przykład jako efekty 
wstawiania po tłumiku dla szyn wyjściowych.

UWAGA
Jeśli chcesz użyć efektu z identycznymi ustawieniami na kilku kanałach, skonfiguruj kanał 
grupowy i zastosuj efekt jako pojedynczą wstawkę dla tej grupy.

POWIĄZANE LINKI
Efekty ditheringu na stronie 463
Zmiana liczby gniazd przed/po tłumiku na stronie 386
Dodawanie efektów insertowych do kanałów grupowych na stronie 447
Menu ustawień stojaka na stronie 368

Dodawanie efektów insertowych
Jeśli do kanałów audio dodasz efekty insertowe, dźwięk będzie kierowany przez efekty insertowe.

PROCEDURA
1. Wybierz ścieżkę dźwiękową.
2. Na liście utworów kliknij opcję Edit Channel Settings (Edytuj ustawienia kanału).
    Zostanie otwarte okno Channel Settings (Ustawienia kanału) dla kanału audio.
3. W sekcji Inserts (Wstawki) kliknij pierwsze miejsce wkładki na karcie Inserts (Wstawki) 
    i wybierz efekt z selektora.

                   

WYNIK
Wybrany efekt insertowy jest ładowany i aktywowany, a dźwięk jest przez niego kierowany. 
Zostanie otwarty panel sterowania efektami.

POWIĄZANE LINKI
Panel sterowania efektami na stronie 464

Dodawanie efektów insertowych do szyn

Jeśli do szyn wejściowych dodasz efekty insertowe, staną się one stałą częścią nagranego pliku 
audio. Jeśli dodasz efekty insertowe do szyn wyjściowych, wpłynie to na cały dźwięk kierowany do
tej szyny. Efekty insertowe dodawane do szyn wyjściowych są czasami nazywane efektami 
głównymi.

PROCEDURA
1. Wybierz Studio > MixConsole, aby otworzyć MixConsole.
2. W sekcji suwaków wykonaj jedną z następujących czynności:
         ● Znajdź kanał wejściowy i kliknij Edit Channel Settings (Edytuj ustawienia kanału), aby 
            edytować szynę wejściową.
         ● Znajdź kanał wyjściowy i kliknij Edit Channel Settings (Edytuj ustawienia kanału), aby 
            edytować szynę wyjściową.
         Zostanie otwarte okno Channel Settings (Ustawienia kanału) dla wybranego kanału.
3. W sekcji Inserts (Wstawki) kliknij pierwszy slot na karcie Inserts (Wstawki) i wybierz efekt z 
    selektora.
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WYNIK
Wybrany efekt insertowy zostanie dodany do szyny i aktywowany. Zostanie otwarty panel 
sterowania efektami.

Dodawanie efektów insertowych do kanałów grupowych
Jeśli dodasz efekty insertowe do kanałów grupowych, możesz przetwarzać kilka ścieżek audio za 
pomocą tego samego efektu.

PROCEDURA
1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij Add Track (Dodaj ścieżkę)      

         .
2. Kliknij Group (Grupuj).
3. Otwórz wyskakujące menu Audio Outputs (Wyjścia audio) i wybierz żądaną szynę wyjściową.
4. Kliknij Add Track (Dodaj ścieżkę).
    Ścieżka grupowa zostanie dodana do listy utworów.
5. W Inspektorze ścieżki grupowej otwórz sekcję Inserts (Wstawki).
6. Kliknij pierwsze pole efektu i wybierz efekt z selektora.
7. W Inspektorze ścieżek audio otwórz menu podręczne Output Routing i wybierz grupę.

WYNIK
Sygnał ze ścieżki audio jest kierowany przez kanał grupowy i przechodzi przez efekt insertowy.

POWIĄZANE LINKI
Okno dialogowe dodawania ścieżki – kanał grupowy na stronie 136

Dodawanie kanałów grupowych do wybranych kanałów
Możesz dodać kanał grupowy do kilku wybranych kanałów.

WARUNEK WSTĘPNY
Twój projekt zawiera ścieżki, które chcesz skierować na kanał grupowy.

PROCEDURA
1. Na liście ścieżek kliknij prawym przyciskiem myszy ścieżki, które chcesz skierować do kanału 
    grupowego i wybierz Add Track > Group Channel to Selected Channels (Dodaj ścieżkę > 
    Kanał grupowy do wybranych kanałów).
2. W oknie dialogowym Add Track (Dodaj ścieżkę) otwórz menu podręczne Configuration 
    (Konfiguracja) i wybierz konfigurację kanału dla ścieżki kanału grupowego.
3. Otwórz menu podręczne Folder Setup (Konfiguracja folderu) i wybierz, czy chcesz utworzyć 
    grupowe ścieżki kanałów w dedykowanym folderze, czy poza nim.
4. Kliknij OK.

WYNIK
Ścieżka kanału grupowego zostanie dodana do listy ścieżek. Grupa jest zaznaczona w 
wyskakującym menu Output Routing (Wyjście trasowania) wybranych ścieżek. Ścieżki są 
kierowane do kanału grupowego.

POWIĄZANE LINKI
Okno dialogowe dodawania ścieżki – kanał grupowy na stronie 136
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Kopiowanie efektów insertowych
Możesz dodawać efekty insertowe do kanałów audio, kopiując je z innych kanałów audio lub 
z innych gniazd tego samego kanału audio.

WARUNEK WSTĘPNY
Dodałeś co najmniej jeden efekt insertowy do kanału audio.

PROCEDURA
1. Wybierz Studio > MixConsole.
2. W stojaku Inserts znajdź efekt insertowy, który chcesz skopiować.
3. Przytrzymaj klawisz Alt/Opt i przeciągnij efekt insertowy na miejsce wstawiania.

WYNIK
Efekt insertowy zostanie skopiowany. Jeśli miejsce docelowe zawiera już efekt insertowy, 
poprzednio istniejący efekt zostanie przesunięty o jedno miejsce w dół.

Zmiana kolejności efektów insertowych
Możesz zmienić pozycję efektu insertowego w łańcuchu sygnału kanału audio, przesuwając go do 
innego gniazda tego samego kanału. Możesz także przenieść efekt insertowy do innego kanału 
audio.

WARUNEK WSTĘPNY
Dodałeś co najmniej jeden efekt insertowy do kanału audio.

PROCEDURA
1. Wybierz Studio > MixConsole.
2. W racku (regale, szafie) insertów znajdź efekt insertowy, który chcesz zmienić.
3. Przeciągnij efekt insertowy do innego gniazda wstawiania.

WYNIK
Efekt insertowy jest usuwany z gniazda źródłowego i umieszczany w gnieździe docelowym. Jeśli 
miejsce docelowe zawiera już efekt insertowy, efekt ten jest przenoszony do następnego slotu 
insertowego.

Dezaktywacja efektów insertowych
Jeśli chcesz słuchać utworu bez przetwarzania go przez efekt, ale nie chcesz całkowicie usuwać 
tego efektu z gniazda insertowego, możesz go dezaktywować.

WARUNEK WSTĘPNY
Dodałeś efekt insertowy do kanału audio.

PROCEDURA
1. Na liście ścieżek wybierz ścieżkę audio z efektem insertowym, który chcesz dezaktywować.
2. W Inspector otwórz sekcję Inserts (Wstawki) i Alt/Opt kliknij opcję Bypass Insert (Pomiń 
    wstawienie).
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WYNIK
Efekt jest dezaktywowany i całe przetwarzanie zostaje zakończone, ale efekt jest nadal ładowany.

         

Pomijanie efektów insertowych
Jeśli chcesz słuchać utworu bez przetwarzania go przez określony efekt, ale nie chcesz całkowicie 
usunąć tego efektu z gniazda insertowego, możesz go ominąć. Pominięty efekt nadal jest 
przetwarzany w tle. Pozwala to na pozbawione trzasków porównanie sygnału oryginalnego i 
przetworzonego.

WARUNEK WSTĘPNY
Dodałeś efekt insertowy do kanału audio.

PROCEDURA
1. Na liście ścieżek wybierz ścieżkę audio z efektem insertowym, który chcesz pominąć.
2. W Inspector (Inspektorze) otwórz sekcję Inserts (Wstawki) i kliknij Bypass Insert (Pomiń  
    wstawkę).

           

WYNIK
Efekt jest pomijany, ale nadal przetwarzany w tle.

           

Usuwanie efektów insertowych

PROCEDURA
1. Na liście ścieżek wybierz ścieżkę audio z efektem insertowym, który chcesz usunąć.
2. W Inspector (Inspektorze) otwórz sekcję Inserts (Wstawki) i na efekcie, który chcesz usunąć, 
kliknij Select Insert (Wybierz wwstawkę).
3. W selektorze efektów wybierz No Effect (Brak efektu).

WYNIK
Efekt insertowy jest usuwany z kanału audio.

Zamrażanie efektów insertowych

Zamrożenie ścieżki dźwiękowej i jej efektów insertowych pozwala zmniejszyć moc procesora. 
Jednak zablokowane ścieżki są zablokowane do edycji. Nie możesz edytować, usuwać ani dodawać
efektów insertowych dla zamrożonej ścieżki.

WARUNEK WSTĘPNY
Dokonałeś wszystkich ustawień dla ścieżki i jesteś pewien, że nie musisz już jej edytować.
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PROCEDURA
1. W Inspektorze ścieżki audio, którą chcesz zamrozić, kliknij Freeze Audio Channel (Zamroź 
kanał audio).

              
2. W oknie dialogowym Freeze Channel Options (Opcje mrożenia kanału) określ rozmiar ogona 
w  
    sekundach. To dodaje czas na końcu renderowanego pliku. W ten sposób ogony pogłosu 
    i opóźnienia mogą całkowicie zniknąć.

WYNIK
Wyjście ścieżki, w tym wszystkie efekty wstawiania przed tłumikiem, jest renderowane do pliku 
audio. Zamrożona ścieżka dźwiękowa jest zapisywana w folderze Freeze, który można znaleźć w 
następującej lokalizacji:
         ● Windows: w folderze Project
         ● macOS: User/Documents (Użytkownik/Dokumenty)
W MixConsole zamrożony kanał audio jest oznaczony symbolem płatka śniegu nad nazwą kanału. 
Nadal możesz regulować poziom i panoramę, wprowadzać ustawienia EQ i dostosowywać efekty 
wysyłkowe.

PO WYKONANIU TEGO ZADANIA
Aby odblokować zamrożoną ścieżkę, kliknij ponownie Freeze (Zablokuj, zamroź)

Efekty insertowe w konfiguracjach wielokanałowych
Możesz wstawiać efekty VST 2 i VST 3 na ścieżkach z konfiguracją wielokanałową. Jednak nie 
wszystkie wtyczki efektów obsługują przetwarzanie wielokanałowe.

Efekty mono lub stereo mogą przetwarzać tylko 1 lub 2 kanały, podczas gdy wtyczki obsługujące 
dźwięk przestrzenny są stosowane do wszystkich kanałów głośników lub do ich podzbioru.

● Aby ustawić, do których kanałów głośnikowych ma być zastosowany efekt insertowy, użyj 
edytora routingu (Routing Editor).

POWIĄZANE LINKI
Routing Editor na stronie 451

Kierowanie efektów insertowych przez określone kanały audio

Jeśli wstawisz stereofoniczny efekt insertowy na ścieżce wielokanałowej, pierwsze kanały 
głośnikowe ścieżki zostaną przekierowane przez dostępne kanały efektów. Pozostałe kanały 
pozostają nieprzetworzone. Można jednak kierować efekt przez różne kanały głośnikowe.

PROCEDURA
1. Na liście ścieżek kliknij Edit Channel Settings (Edytuj ustawienia kanału), aby otworzyć okno  
    Channel Settings (Ustawienia kanału) dla ścieżki, na której wstawiony jest efekt.
2. W sekcji Inserts (Wstawki) kliknij Routing (Trasowanie), aby otworzyć kartę Routing 
    (Trasowanie).
3. Kliknij dwukrotnie schemat sygnału dla efektu insertowego, aby otworzyć Routing Editor  ‘  
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    (edytor tras).

         
Pierwsze kanały głośnikowe ścieżki są kierowane przez dostępne kanały FX.
4. Opcjonalnie: Aktywuj Link (Łącze), aby powiązać przypisanie kanału wejściowego i  
    wyjściowego.
5. Kliknij przyciski strzałek, aby poprowadzić różne kanały głośnikowe przez efekt.

         

WYNIK
Efekt jest kierowany przez różne kanały audio.
UWAGA
Aby skierować wtyczkę stereo przez wszystkie 6 kanałów ścieżki 5.1, dodaj jej 3 wystąpienia i użyj
różnych kanałów głośników dla każdego wystąpienia.

POWIĄZANE LINKI
Edytor wyznaczania tras na stronie 451

Routing Editor (Edytor wyznaczania tras)
Routing Editor umożliwia skonfigurowanie, do jakich kanałów głośnikowych ma być zastosowany
efekt.
● Aby otworzyć Routing Edytor, wybierz ścieżkę zawierającą efekt insertowy i kliknij Edit 
Channel Settings (Edytuj ustawienia kanału). W oknie Channel Settings (Ustawienia kanału) 
kliknij kartę Inserts (Wstawki), a następnie kartę Routing (Trasowanie). Kliknij dwukrotnie 
schemat sygnału dla efektu insertowego. 

              

Routing Editor (Edytor tras) pokazuje kanały w bieżącej konfiguracji, z sygnałami przechodzącymi 
od góry do dołu.

1   Outputs (Wyjścia)
         Dolne kwadraty reprezentują wyjścia wtyczki efektów.
2   Effect plug-in (Wtyczka efektów)
         Pole pośrodku reprezentuje wtyczkę efektu.
3   Inputs (Wejścia)
456



         Górne kwadraty reprezentują dane wejściowe wtyczki efektu.

4   Connections (Połączenia)
        Linie reprezentują połączenia.
5   Input channel assignment (Przypisanie kanału wejściowego)
       Przyciski te umożliwiają przypisanie kanałów wejściowych.
6   Link (Połączenie)
       Aktywuj to, aby powiązać przypisanie kanału wejściowego i wyjściowego.
7   Output channel assignment (Przypisanie kanału wyjściowego)
       Przyciski te umożliwiają przypisanie kanałów wyjściowych.
8   Reset (Resetuj)
       Ten przycisk umożliwia zresetowanie pierwotnej konfiguracji kanałów.

Połączenia routingu
W Routing Editor (Edytorze tras) możesz skonfigurować połączenia tras.

UWAGA
Ustawienia w edytorze routingu można wprowadzać tylko wtedy, gdy kierujesz dźwięk 
wielokanałowy przez efekt, który obsługuje mniej kanałów.

Możliwe są następujące połączenia:
Routing Connection (Połączenie routingu)

          
         Dźwięk w kanale głośnikowym jest kierowany przez kanał FX i przetwarzany przez efekt.
Bypass Connection (Obejście połączenia)

           
        Dźwięk w kanale głośnikowym przechodzi przez efekt bez przetwarzania.
Broken Connection (Zerwane połączenie)

           
        Dźwięk na kanale głośnikowym nie jest wysyłany do wyjścia.
Cross Connection (Połączenie krzyżowe)

           
        Dźwięk na określonych kanałach jest przetwarzany przez efekt i wyprowadzany na innych 
        kanałach.
        W tym przykładzie dźwięk na kanałach Ls-Rs jest odtwarzany na kanałach L-R. Ponieważ 
        kanały LR są pomijane, końcowe wyjście LR zawiera zarówno oryginalne sygnały LR, jak 
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        i przetworzone sygnały Ls-Rs.

Selektor efektów VST
Selektor efektów VST umożliwia wybór efektów VST z aktywnej kolekcji.

● Aby otworzyć selektor efektów VST, otwórz sekcję Inserts (Wstawki) Inspektora ścieżki audio 
i w polu wstawiania kliknij Select Insert (Wybierz wstawkę).

Dostępne są następujące kontrolki:

           

1   Expand Tree/Collapse Tree (Rozwiń drzewo/zwiń drzewo)
          Rozwija/zwija drzewo.
2   Search VST Effect (Wyszukaj efekt VST)
          Umożliwia wyszukiwanie efektów VST poprzez wpisanie nazwy lub części nazwy lub 
          kategorii.
3   Plug-in Collections and Options (Kolekcje i opcje wtyczek)
          Umożliwia wybranie kolekcji. Jeśli wybierzesz kolekcję Domyślna, opcje Sortuj według 
          kategorii i Sortuj według dostawcy staną się dostępne. Pozwalają one posortować domyślną 
          kolekcję.

Send Effects (Efekty wysyłkowe)
Efekty wysyłkowe znajdują się poza ścieżką sygnału kanału audio. Dane audio, które mają być 
przetwarzane, muszą zostać przesłane do efektu.

● Możesz wybrać ścieżkę kanału FX jako miejsce docelowe dla wysyłki.
● Możesz kierować różne wysyłki do różnych kanałów FX.
● Możesz kontrolować ilość sygnałów wysyłanych do kanału FX, dostosowując poziom wysyłania 
   efektu.

UWAGA
W oknie dialogowym Preferences (Preferencje) (strona VST) można ustawić domyślny poziom 
wysyłania. Użyj klawiszy Ctrl/Cmd i kliknij, aby ustawić poziom wysyłania na tę wartość 
domyślną.

Aby to zrobić, musisz utworzyć ścieżki kanałów FX.

POWIĄZANE LINKI
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Ścieżki kanałów FX na stronie 454
VST na stronie 1181

Ścieżki kanałów FX
Możesz użyć ścieżek kanałów FX jako miejsc docelowych dla wysyłek audio. Dźwięk jest 
przesyłany do kanału FX i przez skonfigurowane dla niego efekty insertowe.

● Możesz dodać kilka efektów insertowych do kanału FX. 
    Sygnał przechodzi przez efekty szeregowo, od góry do dołu.
● Możesz zmieniać nazwy ścieżek kanałów FX, tak jak inne ścieżki.
● Możesz dodawać ścieżki automatyzacji do ścieżek kanałów FX. 
   Pozwala to na automatyzację różnych parametrów efektów.
● Możesz skierować powrót efektu do dowolnej szyny wyjściowej.
● Możesz dostosować kanał FX w MixConsole. 
   Obejmuje to regulację poziomu powrotu efektu, balansu i korektora.

Gdy dodajesz ścieżkę kanału FX, możesz wybrać, czy ścieżki kanału FX mają być tworzone w 
dedykowanym folderze, czy poza nim. Jeśli wybierzesz opcję Create Inside Folder (Utwórz folder
wewnętrzny), ścieżki kanałów FX zostaną wyświetlone w dedykowanym folderze.

          

Pozwala to na lepszy przegląd i edycję ścieżek kanału FX.

UWAGA
Składając foldery kanałów FX, możesz zaoszczędzić miejsce na ekranie.

POWIĄZANE LINKI
Dodawanie ścieżek kanału FX na stronie 454

Dodawanie ścieżek kanałów FX

PROCEDURA
1. W globalnym obszarze kontroli ścieżek na liście ścieżek kliknij Add Track (Dodaj ścieżkę)    

           .
2. Kliknij Effect (Efekt).
3. Otwórz wyskakujące menu Effect i wybierz efekt dla ścieżki kanału FX.
4. Otwórz wyskakujące menu Configuration (Konfiguracja) i wybierz konfigurację kanału dla    
    ścieżki kanału FX.
5. Otwórz wyskakujące menu Folder Setup (Konfiguracja folderów) i wybierz, czy chcesz tworzyć
    ścieżki kanałów FX w dedykowanym folderze, czy poza nim.
6. Kliknij Add Track (Dodaj ścieżkę)  .

WYNIK
Ścieżka kanału FX zostanie dodana do listy ścieżek, a wybrany efekt zostanie załadowany do 
pierwszego dostępnego gniazda efektu insertowego kanału FX.
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POWIĄZANE LINKI
Okno dialogowe Dodaj ścieżkę – Efekt na stronie 139

Dodawanie kanałów FX do slotów wysyłania

PROCEDURA
1. Na liście ścieżek wybierz ścieżki, do których chcesz dodać kanał FX.
2. W Inspector otwórz sekcję Sends (Wysyłki).
3. Prawym przyciskiem myszy kliknij slot wysyłkowy, do którego chcesz dodać kanał FX i wybierz
    Add FX Channel to Send (Dodaj kanał FX do wysłania).
4. Otwórz menu podręczne Effect (Efekt) i wybierz efekt dla ścieżki kanału FX.
5. Otwórz wyskakujące menu Configuration (Konfiguracja) i wybierz konfigurację kanału dla 
    ścieżki kanału FX.
6. Otwórz wyskakujące menu Folder Setup (Konfiguracja folderów) i wybierz, czy chcesz tworzyć
    ścieżki kanałów FX w dedykowanym folderze, czy poza nim.
7. Kliknij Add Track (Dodaj ścieżke).

WYNIK
Ścieżka kanału FX jest dodawana do slotu wysyłania ścieżki.

Dodawanie kanałów FX do wybranych kanałów

WARUNEK WSTĘPNY
Twój projekt zawiera kilka ścieżek, do których chcesz dodać kanał FX.

PROCEDURA
1. Na liście ścieżek zaznacz wszystkie ścieżki, do których chcesz dodać kanał FX.
2. Kliknij prawym przyciskiem myszy jedną ze ścieżek i wybierz Add Track > FX Channel to 
    Selected Channels (Dodaj ścieżkę > Kanał FX do wybranych kanałów).
3. W oknie dialogowym Add Track (Dodaj ścieżkę) otwórz menu podręczne Effect (Efekt) 
    i wybierz efekt dla ścieżki kanału FX.
4. Otwórz wyskakujące menu Configuration (Konfiguracja) i wybierz konfigurację kanału dla 
    ścieżki kanału FX.
5. Otwórz wyskakujące menu Folder Setup (Konfiguracja folderów) i wybierz, czy chcesz tworzyć
    ścieżki kanałów FX w dedykowanym folderze, czy poza nim.
6. Kliknij OK.

WYNIK
Ścieżka kanału FX zostanie dodana do listy ścieżek. Wybrany efekt jest ładowany do pierwszego 
dostępnego gniazda efektów insertowych kanału FX oraz do pierwszego dostępnego gniazda 
efektów wysyłanych we wszystkich wybranych kanałach.

POWIĄZANE LINKI
Okno dialogowe Dodaj ścieżkę  – Efekt na stronie 139

Dodawanie efektów insertowych do ścieżek kanałów FX

Do ścieżek kanałów FX można dodawać efekty insertowe.

WARUNEK WSTĘPNY
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Dodałeś ścieżkę kanału FX i ustawiłeś poprawną szynę wyjściową w wyskakującym menu Output 
Routing (Wyjście trasowania).

PROCEDURA
1. Na liście ścieżek dla ścieżki kanału FX kliknij Edit Channel Settings (Edytuj ustawienia 
    kanału). Otworzy się okno Channel Settings (Ustawienia kanału) dla ścieżki kanału FX.
2. W sekcji Inserts (Wstawki) kliknij slot wstawki na karcie Inserts (Wstawki) i wybierz efekt 
    z selektora.

WYNIK
Wybrany efekt zostanie dodany jako efekt insertowy do ścieżki kanału FX.

Routing kanałów audio do kanałów FX.
Jeśli wysyłasz kanał audio do kanału FX, dźwięk jest kierowany przez efekty insertowe 
skonfigurowane dla kanału FX.

PROCEDURA
1. Wybierz ścieżkę dźwiękową.
2. Na liście ścieżek kliknij opcję Edit Channel Settings (Edytuj ustawienia kanału), aby otworzyć 
    okno Channel Settings (Ustawienia kanału).
3. W sekcji Sends (Wysyłki) kliknij Select Destination (Wybierz miejsce docelowe) dla slotu 
    efektu i wybierz ścieżkę kanału FX z selektora.

             
4. W gnieździe wysyłania kliknij opcję Activate/Deactivate Send (Aktywuj/dezaktywuj  
    wysyłanie).

                  
WYNIK
Dźwięk jest kierowany przez kanał FX.
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PO WYKONANIU TEGO ZADANIA
W oknie Channel Settings (Ustawienia kanału) dla kanału audio możesz przytrzymać klawisz 
Alt/Opt i kliknąć dwukrotnie, aby wyświetlić miejsce docelowe wysyłania. Jeśli skierowałeś 
wysyłkę do kanału FX, otworzy się panel sterowania efektami.

POWIĄZANE LINKI
Dodawanie ścieżek kanału FX na stronie 454

Wysyłanie przed/po tłumiku
Możesz wysłać sygnał z kanału audio do kanału FX przed lub za tłumikiem głośności kanału audio.

● Wysyłanie przed tłumikiem
   Sygnał kanału audio jest wysyłany do kanału FX przed tłumikiem głośności kanału audio.
● Wysyłanie po tłumiku
   Sygnał kanału audio jest wysyłany do kanału FX po wygaszeniu głośności kanału audio.
● Aby przenieść wysyłkę do pozycji przed tłumikiem, otwórz okno Channel Settings (Ustawienia  
   kanału) dla kanału audio, kliknij wysyłkę prawym przyciskiem myszy i wybierz opcję Move to  
   Pre-Fader (Przenieś do przed tłumikiem).

             

Przycisk Pre-/Post-Fader wskazuje, że wysyłka jest w pozycji pre-fader (przed tłumikiem).

              
● Aby przenieść wysyłkę do pozycji po tłumiku, otwórz okno Channel Settings (Ustawienia  
   kanału) dla kanału audio, kliknij wysyłkę prawym przyciskiem myszy i wybierz Move to Post- 
   Fader (Przenieś do Post-Fader).

Przycisk Pre-/Post-Fader wskazuje, że wysyłka jest w pozycji post-fader (po tłumiku).

              

UWAGA
Jeśli włączysz Mute Pre-Send when Mute (Wycisz Wyślij z wyprzedzeniem, gdy jest wyciszony) 
w oknie dialogowym Preferences (Preferencje) (strona VST), wysyłki w trybie przed tłumikiem 
zostaną wyciszone, jeśli wyciszysz ich kanały.

Ustawianie panoramy dla wysyłek

PROCEDURA
1. Wybierz ścieżkę audio.
2. Na liście ścieżek kliknij opcję Edit Channel Settings (Edytuj ustawienia kanału), aby otworzyć 
    okno Channel Settings (Ustawienia kanału).
3. Na karcie Sends (Wysyłki) kliknij opcję Panning (Panoramowanie).
    Dla każdej wysyłki wyświetlany jest suwak panoramy.
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UWAGA
W zależności od trasowania (routingu), dla wysyłek dostępne są różne kontrolki panoramy.

4. Opcjonalnie: otwórz Functions Menu (Menu funkcji) i aktywuj funkcję Link Panners.

          
Wysyłające panoramery będą następnie podążać za panoramą dla kanału, dzięki czemu 
obrazowanie stereo będzie tak wyraźne i prawdziwe, jak to tylko możliwe.
UWAGA
W oknie dialogowym Preferences (Preferencje) (strona VST) możesz ustawić to jako domyślne 
zachowanie dla wszystkich kanałów.
5. Kliknij i przeciągnij kontrolkę panoramy dla wysyłki.

           

UWAGA
Możesz zresetować kontrolkę panoramy do pozycji środkowej, klikając kontrolkę panoramy 
i Ctrl/Cmd.

POWIĄZANE LINKI
Dźwięk przestrzenny na stronie 671

Ustawianie poziomu dla wysyłek

PROCEDURA
1. Na liście ścieżek wybierz ścieżkę kanału FX zawierającą efekt, dla którego chcesz ustawić 
    poziom.
2. Otwórz sekcję Inserts (Wstawki) w Inspector i kliknij miejsce efektu, aby otworzyć panel  
    sterowania efektami.
3. W panelu sterowania efektami ustaw kontrolkę Mix na 100. Pozwala to na pełną kontrolę 
    poziomu efektu, gdy użyjesz wysyłek efektów do późniejszej kontroli balansu sygnału.
4. Na liście ścieżek wybierz ścieżkę audio, która jest kierowana przez efekt, dla którego chcesz  
    ustawić poziom.
5. Kliknij opcję Edit Channel Settings (Edytuj ustawienia kanału), aby otworzyć okno Channel 
    Settings (Ustawienia kanału) dla ścieżki audio.
6. W sekcji Sends (Wysyłki) znajdź pole efektu i przeciągnij w lewo lub w prawo, aby ustawić 
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    poziom wysyłania. Ctrl/Cmd — kliknij, aby ustawić poziom na domyślny poziom wysyłania 
    określony w oknie dialogowym Preferences (Preferencje) (strona VST)

                 

Określa, jaka część sygnału z kanału audio jest kierowana do kanału FX.

WYNIK
Poziom efektu jest dostosowywany zgodnie z Twoimi ustawieniami.

UWAGA
Aby określić, jaka część sygnału z kanału FX jest wysyłana do szyny wyjściowej, otwórz 
okno dialogowe Channel Settings (Ustawienia kanału) dla ścieżki kanału FX i dostosuj poziom 
powrotu efektu.

Side-Chaining (Łańcuch boczny)
Wiele efektów VST 3 obsługuje łańcuchy boczne. Łańcuch boczny umożliwia wykorzystanie 
wyjścia jednej ścieżki do sterowania działaniem efektu na innej ścieżce

Efekty z następujących kategorii charakteryzują się łańcuchem bocznym:
● Modulation (Modulacja)
● Delay (Opóźnienie)
● Filter (Filtr)

Aktywując łańcuch boczny, możesz wykonać następujące czynności:
● Użyć sygnału łańcucha bocznego jako źródła modulacji.
● Zastosować tłumienie do instrumentu, to znaczy zmniejszyć głośność ścieżki instrumentu, gdy na
ścieżce audio obecny jest sygnał.
● Skompresować sygnały na jednej ścieżce audio, gdy rozpoczyna się druga ścieżka audio.
Jest to zwykle używane w celu dodania kompresji dźwięku basu, gdy uderza się w perkusję.

UWAGA
Szczegółowe opisy wtyczek obsługujących łańcuchy boczne można znaleźć w osobnym 
dokumencie Plug-in Reference (Informacje o wtyczkach).

UWAGA
● Pewne kombinacje ścieżek i wejść łańcuchów bocznych mogą prowadzić do pętli sprzężenia 
zwrotnego i dodatkowych opóźnień. W takim przypadku opcje łańcucha bocznego nie są dostępne.
● Połączenia łańcucha bocznego są zachowywane tylko wtedy, gdy przenosisz efekt w obrębie 
kanału. Podczas przeciągania i upuszczania efektu między kanałami lub kopiowania efektu do 
innego gniazda efektu, połączenia łańcucha bocznego są tracone.

Łańcuch boczny i modulacja

Sygnały łańcucha bocznego omijają wbudowaną modulację LFO i stosują modulację zgodnie z 
obwiednią sygnału łańcucha bocznego. Ponieważ każdy kanał jest analizowany i modulowany 
oddzielnie, pozwala to na tworzenie zadziwiających efektów modulacji przestrzennej.

POWIĄZANE LINKI
Prowadzenie łańcucha bocznego na stronie 461
Wyzwalanie efektu opóźnienia za pomocą sygnałów z łańcuchem bocznym na stronie 460
Wyzwalanie kompresora sygnałami łańcuchów bocznych na stronie 461
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Tworzenie połączeń łańcucha bocznego z wielu wejść na stronie 462

Wyzwalanie efektu opóźnienia za pomocą sygnałów łańcucha 
bocznego
Możesz użyć sygnałów z łańcucha bocznego, aby stworzyć efekt opóźnienia z wyciszeniem. Jest to 
przydatne, jeśli chcesz zastosować efekt opóźnienia, który będzie słyszalny tylko wtedy, gdy na 
ścieżce nie ma sygnału.

PROCEDURA
1. Wybierz ścieżkę audio zawierającą dźwięk, który chcesz opóźnić.
2. Wybierz Project > Duplicate Tracks (Projekt > Powiel ścieżki).
    Zdarzenia na zduplikowanej ścieżce są używane tylko do zmniejszania głośności efektu 
    dodawanego do oryginalnej ścieżki.
3. Wybierz oryginalny utwór.
4. W Inspektorze otwórz sekcję Inserts (Wstawki) i wybierz na przykład Delay > PingPongDelay
    (Opóźnienie > PingPongDelay).
5. W panelu sterowania efektami wprowadź ustawienia efektu i kliknij opcję Activate/Deactivate 
    SideChaining (Aktywuj/dezaktywuj funkcję SideChaining (Łańcucha bocznego)).

6. Kliknij Set up Side-Chain Routing (Skonfiguruj routing łańcucha bocznego).
7. Kliknij Add Side-Chain Source (Dodaj źródło łańcucha bocznego) i wybierz duplikat ścieżki z 
    selektora.
8. Opcjonalnie: Dostosuj poziom wysyłania w polu wartość Level (poziomu).
9. W oknie Project wybierz zduplikowaną ścieżkę.
10. W Inspektorze kliknij Output Routing i wybierz węzeł łańcucha bocznego dla efektu 
      PingPongDelay.

WYNIK
Sygnały ze zduplikowanej ścieżki są kierowane do efektu. Za każdym razem, gdy na ścieżce 
pojawiają się sygnały audio, efekt opóźnienia jest dezaktywowany.
UWAGA
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Aby mieć pewność, że sygnały dźwiękowe o niskim lub średnim poziomie głośności również 
wyciszą efekt opóźnienia, można dostosować głośność powielonej ścieżki

POWIĄZANE LINKI
Łańcuch boczny na stronie 459
Prowadzenie łańcucha bocznego na stronie 461

Wyzwalanie kompresora sygnałami z łańcucha bocznego
Kompresja, ekspansja lub bramkowanie mogą być wyzwalane przez sygnały łańcucha bocznego 
przekraczające określony próg. Pozwala to obniżyć głośność jednego sygnału audio za każdym 
razem, gdy odbierany jest inny sygnał audio.

WARUNEK WSTĘPNY
Na przykład stworzyłeś projekt z gitarą basową i ścieżką perkusji basowej i chcesz zmniejszać 
głośność gitary basowej za każdym razem, gdy uderza bęben basowy.

PROCEDURA
1. Wybierz ścieżkę gitary basowej.
2. W Inspektorze otwórz sekcję Inserts (Wstawki).
3. Kliknij pierwszy slot efektu i z selektora wybierz Dynamics > Compressor (Dynamika > 
    Kompresor).
4. W panelu sterowania efektami wprowadź ustawienia efektu i kliknij opcję Activate/Deactivate 
    SideChaining (Aktywuj/dezaktywuj funkcję SideChaining (Bocznego łańcucha)).
5. W panelu sterowania efektami kliknij Set up Side-Chain Routing (Skonfiguruj kierowanie 
    łańcucha bocznego).
6. Kliknij Add Side-Chain Source (Dodaj źródło łańcucha bocznego) i wybierz ścieżkę bębna 
    basowego z selektora.
7. Opcjonalnie: Dostosuj poziom wysyłania w polu Level (Wartość poziomu).

WYNIK
Podłączyłeś łańcuch boczny ścieżki bębna basowego do Compressor (kompresora) na ścieżce 
docelowej. Sygnał bębna basowego uruchamia Compressor na ścieżce gitary basowej. Podczas 
odtwarzania projektu gitara basowa jest kompresowana, ilekroć sygnały na ścieżce bębna basowego
przekraczają ustawiony próg.

POWIĄZANE LINKI
Łańcuch boczny na stronie 459
Prowadzenie łańcucha bocznego na stronie 461

Routing (prowadzenie) łańcucha bocznego
Panel Side-Chain Routing (Trasowanie łańcucha bocznego) umożliwia skonfigurowanie routingu 
łańcucha bocznego dla wybranej wtyczki.

● Aby otworzyć panel Side-Chain Routing, kliknij Set up Side-Chain Routing (Skonfiguruj   
   Side-Chain Routing) na panelu sterowania wtyczki.

Dostępne są następujące kontrolki:
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Select the Plug-in Side-Chain Input (Wybierz wejście łańcucha bocznego wtyczki)
        To wyskakujące menu jest dostępne tylko wtedy, gdy wtyczka obsługuje kilka wejść 
        łańcuchów bocznych. Z wyskakującego menu wybierz wejście, dla którego chcesz dodać 
        źródło łańcucha bocznego. Wejścia wtyczek łańcucha bocznego, które są kierowane do źródeł 
        łańcucha bocznego, są oznaczone rombem obok nazwy wejścia. Liczba dostępnych wejść 
        łańcucha bocznego zależy od wtyczki.
Activate/Deactivate Side-Chaining (Włącz/wyłącz łańcuch boczny)
        Aktywuje/dezaktywuje funkcję łańcucha bocznego.
Activate/Deactivate Side-Chain Source (Aktywuj/dezaktywuj źródło łańcucha bocznego)
        Włącza/wyłącza źródło łańcucha bocznego.
Name (Nazwa)
        Pokazuje nazwę źródła łańcucha bocznego.
Type (Typ)
        Pokazuje typ źródła łańcucha bocznego.
Level (Poziom)
        Umożliwia dostosowanie poziomu wysyłania.
Meter (Miernik)
        Pokazuje poziom głośności ścieżki wejściowej.
Pre-/Po-Fader
        Umożliwia ustawienie insertu w pozycji przed tłumikiem (pre-fader) lub w pozycji po tłumiku 
        (post-fader).
Edit Channel Settings (Edytuj ustawienia kanału)
        Otwiera okno Channel Settings (Ustawienia kanału) dla wybranego źródła łańcucha  
        bocznego.
Remove Side-Chain Source (Usuń źródło łańcucha bocznego)
        Usuwa źródło łańcucha bocznego.
Remove Side-Chain Source (Dodaj źródło łańcucha bocznego)
        Otwiera selektor umożliwiający dodanie źródła łańcucha bocznego.

POWIĄZANE LINKI
Łańcuch boczny na stronie 459
Tworzenie połączeń łańcucha bocznego z wielu wejść na stronie 462

Tworzenie połączeń łańcucha bocznego z wielu wejść
W przypadku wtyczek obsługujących wiele wejść łańcuchów bocznych można tworzyć połączenia 
łańcuchów bocznych pochodzące z wielu wejść łańcuchów bocznych tej wtyczki.

WARUNEK WSTĘPNY
Twoja wtyczka efektów obsługuje kilka wejść łańcuchów bocznych. Możesz na przykład użyć 
wtyczki Squasher, która obsługuje do 3 wejść łańcucha bocznego.
Możesz także użyć Frequency 2 (częstotliwość 2), która obsługuje do 8 wejść łańcuchów 
bocznych.
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PROCEDURA
1. W oknie Project wybierz ścieżkę audio.
2. Na liście ścieżek kliknij opcję Edit Channel Settings (Edytuj ustawienia kanału).
    Zostanie otwarte okno Channel Settings (Ustawienia kanału) dla kanału audio.
3. W sekcji Inserts (Wstawki) kliknij pierwszy slot w zakładce Inserts (Wstawki) i z selektora  
    wybierz wtyczkę efektu, która obsługuje kilka wejść łańcuchów bocznych. 
    Wybrany efekt insertowy jest ładowany i aktywowany, a dźwięk jest przez niego kierowany.  
    Zostanie otwarty panel sterowania efektami.

4. W panelu sterowania efektami kliknij Set up Side-Chain Routing (Skonfiguruj kierowanie   
    łańcucha bocznego).
5. W panelu Side-Chain Routing (Trasowanie łańcucha bocznego) kliknij opcję Select the Plug-in
    Side-Chain Input (Wybierz wejście łańcucha bocznego wtyczki) i z wyskakującego menu   
    wybierz wejście typu plug-in, dla którego chcesz dodać źródło łańcucha bocznego. Liczba  
    dostępnych wejść łańcucha bocznego zależy od wtyczki.
6. Kliknij Add Side-Chain Source (Dodaj źródło łańcucha bocznego) i wybierz źródło z 
    wyskakującego menu.
7. Opcjonalnie: Powtórz powyższe kroki, aby aktywować więcej wejść wtyczek.
8. Dostosuj wtyczkę efektu zgodnie z wymaganiami i nie zapomnij aktywować odpowiednich wejść
    łańcucha bocznego.

WYNIK
Liczba możliwych wejść łańcucha bocznego określa liczbę pasm, które mogą być kontrolowane 
przez źródła łańcucha bocznego.

POWIĄZANE LINKI
Łańcuch boczny na stronie 459
Prowadzenie łańcucha bocznego na stronie 461

Efekty Dither (wahanie)
Efekty ditheringu pozwalają kontrolować szum generowany przez błędy kwantyzacji, które mogą 
wystąpić podczas miksowania do niższej głębi bitowej.

Dithering dodaje specjalny rodzaj szumu na bardzo niskim poziomie, aby zminimalizować efekt 
błędów kwantyzacji. Jest to prawie niezauważalne i lepsze niż zniekształcenie, które występuje w 
innym przypadku.

Stosowanie efektów Dither

PROCEDURA
1. Wybierz Studio > MixConsole.
2. Otwórz Rack Settings (Ustawienia szafy, regału, stojaka) i aktywuj opcję Fixed Number of   
    Slots (Stała liczba miejsc).
3. Kliknij opcję Edit Channel Settings (Edytuj ustawienia kanału) dla kanału wyjściowego.
4. W sekcji Inserts kliknij slot efektu post-fader i wybierz Mastering > UV22HR.
5. Na panelu wtyczek wybierz głębię bitową pliku miksu, który chcesz utworzyć.

POWIĄZANE LINKI
Eksport miksu audio na stronie 1053
Menu ustawień stojaka na stronie 368
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Efekty zewnętrzne
Możesz zintegrować zewnętrzne urządzenia efektowe z przepływem sygnału sekwencera, 
konfigurując zewnętrzne szyny FX.

Zewnętrzna szyna FX to kombinacja wyjść (sends) i wejść (returns) w sprzęcie audio wraz z 
kilkoma dodatkowymi ustawieniami.

Wszystkie zewnętrzne szyny FX, które utworzyłeś, są dostępne w wyskakujących menu efektów. 
Jeśli wybierzesz efekt zewnętrzny jako efekt insertowy dla ścieżki audio, dźwięk zostanie przesłany
do odpowiedniego wyjścia audio, przetworzony w efekcie sprzętowym i zwrócony przez określone 
wejście audio.

POWIĄZANE LINKI
Połączenia audio na stronie 26
Instrumenty zewnętrzne i efekty na stronie 35

Panel sterowania efektami
Panel sterowania efektami umożliwia ustawienie parametrów wybranego efektu. Zawartość, wygląd
i układ panelu sterowania zależą od wybranego efektu.

● Aby otworzyć panel sterowania dla wtyczki, kliknij slot efektu.

Dla wszystkich efektów dostępne są następujące elementy sterujące:

1   Activate Effect (Aktywuj efekt)
          Aktywuje/dezaktywuje efekt.
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2   Bypass Effect (Obejście efektu)
          Pozwala ominąć efekt.
3   Read Automation/Write Automation (Automatyzacja odczytu/automatyzacja zapisu)
          Umożliwia automatyzację odczytu/zapisu ustawień parametrów efektu.
4   Switch between A/B Settings (Przełącz między ustawieniami A/B)
          Przełącza na ustawienie B, gdy aktywne jest ustawienie A, i na ustawienie A, gdy aktywne 
          jest ustawienie B.
5   Apply current settings to A and B (Zastosuj bieżące ustawienia do A i B)
          Kopiuje parametry efektu ustawienia efektu A do ustawienia efektu B i odwrotnie.
6   Activate/Deactivate Side-Chaining (Włączanie/wyłączanie łańcuchów bocznych)
          Aktywuje/dezaktywuje funkcję łańcucha bocznego.

7   Set up Side-Chain Routing (Skonfiguruj trasowanie łańcucha bocznego)
          Umożliwia skonfigurowanie routingu łańcucha bocznego dla wybranej wtyczki.
8   Preset browser (Zaprogramowana przeglądarka)
          Otwiera przeglądarkę ustawień wstępnych, w której można wybrać inne ustawienie wstępne.
9   Load previous Program/Load next Program (Załaduj poprzedni program/Załaduj następny  
     program)
          Ładuje poprzedni/następny program do ustawionej przeglądarki.
10   Preset Management (Zarządzanie ustawieniami wstępnymi)
          Otwiera wyskakujące menu, które umożliwia zapisanie lub załadowanie ustawienia 
          wstępnego.
11   Add VST Plug-in Picture to Media Rack (Dodaj obraz wtyczki VST do stojaka na media)
          Dodaje obraz wtyczki VST do stojaka na media. Jest to dostępne tylko dla wtyczek innych 
          dostawców.
12   Functions menu (Menu funkcji)
          Otwiera wyskakujące menu z określonymi funkcjami i ustawieniami

UWAGA
Szczegółowe informacje o dołączonych efektach i ich parametrach można znaleźć w osobnym 
dokumencie Plug-in Reference (Informacje o wtyczkach).

POWIĄZANE LINKI
Ukrywanie/pokazywanie paneli sterowania efektami na stronie 467

Menu kontekstowe panelu sterowania efektami
Menu kontekstowe panelu sterowania efektami i menu Functions (Funkcje) w panelu sterowania 
efektami pokazują funkcje i ustawienia specyficzne dla efektu.

Wykonaj jedną z następujących czynności:
       ● Kliknij prawym przyciskiem myszy pusty obszar panelu sterowania efektami.
       ● Otwórz wyskakujące menu Functions (Funkcje) w panelu sterowania efektami.

Dostępne są następujące funkcje:
Copy <VST effect name> Setting/Paste <VST effect name> Setting (Kopiuj <Nazwa efektu 
VST> Ustawienie/Wklej <Nazwa efektu VST> Ustawienie)
         Umożliwia skopiowanie ustawień efektu i wklejenie ich do innego efektu.
Load Preset/Save Preset (Załaduj ustawienie wstępne/Zapisz ustawienie wstępne)
         Umożliwia załadowanie/zapisanie ustawienia wstępnego.
Default Preset (Domyślne ustawienie wstępne)
         Umożliwia zdefiniowanie i zapisanie domyślnego ustawienia wstępnego.
Switch to A Setting/Switch to B Setting (Przełącz na ustawienie A/Przełącz na ustawienie B)
         Przełącza na ustawienie B, gdy aktywne jest ustawienie A, i na ustawienie A, gdy aktywne 
         jest ustawienie B.
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Apply Current Settings to A/Apply Current Settings to B (Zastosuj bieżące ustawienia do 
A/Zastosuj bieżące ustawienia do B)
         Kopiuje parametry efektu ustawienia efektu A do ustawienia efektu B i odwrotnie.
Activate Outputs (Aktywuj wyjścia)
         Umożliwia aktywację jednego lub więcej wyjść dla efektu.
Activate/Deactivate Side-Chaining (Włącz/wyłącz łańcuch boczny)
         Aktywuje/dezaktywuje łańcuch boczny dla efektu. 

UWAGA
Ta opcja jest dostępna tylko dla efektu VST 3 obsługującego łączenie boczne (łańcuch boczny).

Remote Control Editor (Edytor zdalnego sterowania)
           Otwiera Edytor zdalnego sterowania.
Switch to Generic Editor (Przełącz na Edytor ogólny)
           Otwiera ogólny edytor efektu.
Allow Window to be Resized (Zezwól na zmianę rozmiaru okna)
           Umożliwia dynamiczną zmianę rozmiaru okien wtyczek innych firm w Cubase. Jest to  
           przydatne, jeśli aktywowałeś opcję Enable HiDPI (Włącz HiDPI) (tylko Windows) w oknie 
           dialogowym Preferences (Preferencje) (strona Ogólne), a wtyczka nie obsługuje ustawień 
           rozdzielczości.

POWIĄZANE LINKI
Ogólne na stronie 1169
Łańcuch boczny na stronie 459

Ustawienia efektu dostrajania (Fine-Tunung)
Możesz przyjąć ustawienia parametrów efektu jako punkt wyjścia do dalszego dostrajania, a 
następnie porównać nowe ustawienia z ustawieniami oryginalnymi.

WARUNEK WSTĘPNY
Dostosowałeś parametry efektu.

PROCEDURA
1. Na panelu sterowania efektu kliknij opcję Switch between A/B Settings (Przełącz między 
     ustawieniami A/B).
    Spowoduje to skopiowanie początkowego ustawienia parametru A do ustawienia B.
2. Dostosuj parametry efektu.
    Te ustawienia parametrów są teraz zapisywane jako ustawienie B.

WYNIK
Możesz teraz przełączać się między obydwoma ustawieniami, klikając Switch between A/B 
Settings (Przełącz między ustawieniami A/B). Możesz je porównać, dokonać dalszych korekt lub 
po prostu wrócić do ustawienia A. Ustawienia A i B są zapisywane wraz z projektem.

PO WYKONANIU TEGO ZADANIA
Możesz skopiować ustawienia między A i B, klikając Copy A to B (Kopiuj A do B). Możesz 
potraktować te ustawienia jako punkt wyjścia do dalszego dostrajania.
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Ukrywanie/pokazywanie paneli sterowania efektami
Po dodaniu efektu dźwiękowego automatycznie otwiera się panel sterowania odpowiednią wtyczką.
Panele kontrolne można ukryć. Jest to przydatne, aby uzyskać lepszy przegląd, jeśli do projektu 
dodano wiele wtyczek, których panele kontrolne zaśmiecają ekran.

PROCEDURA
● Wybierz Window > Hide Plug-in Windows (Okno > Ukryj okna wtyczki).

UWAGA
To również ukrywa panele kontrolne instrumentów VST.

WYNIK
Panele kontrolne są ukryte i wysyłane na tył aplikacji. Aby wyświetlić je ponownie, wybierz opcję  
Show Plug-in Windows (Pokaż okna z wtyczkami).

POWIĄZANE LINKI
Panel sterowania efektami na stronie 464

Zamykanie wszystkich paneli sterowania
Po dodaniu efektu dźwiękowego automatycznie otwiera się panel sterowania odpowiednią wtyczką.
Możesz zamknąć wszystkie panele kontrolne jednocześnie.

PROCEDURA
● Wybierz Window > Close All Plug-in Windows (Okno > Zamknij wszystkie okna z 
   wtyczkami).

UWAGA
Spowoduje to również zamknięcie paneli kontrolnych instrumentów VST.

WYNIK
Panele sterowania są zamknięte.

POWIĄZANE LINKI
Panel sterowania efektami na stronie 464

Presety (ustawienia wstępne) efektów
Presety efektów przechowują ustawienia parametrów efektu. Dołączone efekty zawierają wiele 
ustawień wstępnych, które można załadować, dostosować i zapisać.

Dostępne są następujące typy presetów efektów:
      ● Ustawienia VST dla wtyczki.
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          Są to ustawienia parametrów wtyczki dla określonego efektu.
      ● Insert (Wstaw) presety, które zawierają kombinacje efektów insertowych.
         Mogą one zawierać cały rack (stojak, regał) efektów insertowych z ustawieniami dla każdego 
         efektu.

Ustawienia wstępne efektów są zapisywane w następującej lokalizacji:
● Windows: \Users\<user name>\My Documents\VST 3 Presets\<company>\<plug-in name> (\
Users\<nazwa użytkownika>\Moje dokumenty\VST 3 Presets\<firma>\<nazwa wtyczki>)

● macOS: /Users/<user name>/Library/Audio/Presets/<company>/<plug-in name> 
(/Users/<nazwa użytkownika>/Library/Audio/Presets/<firma>/<nazwa wtyczki>)

POWIĄZANE LINKI
Ładowanie ustawień wstępnych dla efektów na stronie 468
Ładowanie ustawień wstępnych wstawiania na stronie 471

Przeglądarka presetów (ustawień wstępnych)
Przeglądarka ustawień wstępnych umożliwia wybranie ustawienia wstępnego VST dla 
załadowanego efektu.
● Aby otworzyć przeglądarkę ustawień domyślnych, kliknij pole przeglądarki ustawień 
    domyślnych w panelu sterowania efektami.

                 

Sekcja Results (Wyniki) przeglądarki ustawień wstępnych zawiera listę dostępnych ustawień 
wstępnych dla wybranego efektu.

Ładowanie presetów dla efektów

Większość wtyczek efektów VST zawiera wiele przydatnych ustawień wstępnych, które można 
natychmiast wybrać.

WARUNEK WSTĘPNY
Załadowałeś efekt jako wstawkę kanału lub do kanału FX, a panel sterowania efektami jest otwarty.

PROCEDURA
1. Kliknij wstępnie ustawione pole przeglądarki u góry panelu sterowania
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2. W sekcji Results (Wyniki) wybierz ustawienie wstępne z listy.
3. Kliknij dwukrotnie, aby załadować ustawienie wstępne, które chcesz zastosować.

WYNIK
Ustawienie wstępne zostało załadowane.

PO WYKONANIU TEGO ZADANIA
Możesz powrócić do ustawienia wstępnego wybranego podczas otwierania przeglądarki ustawień 
wstępnych, klikając opcję Revert to Last Setting (Przywróć ostatnie ustawienie).

Zapisywanie presetów efektów
Możesz zapisać swoje ustawienia efektów jako ustawienia wstępne do dalszego wykorzystania.

PROCEDURA
1. Otwórz wyskakujące menu Preset Management (Zarządzanie ustawieniami wstępnymi).
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2. Wybierz opcję Save Preset (Zapisz ustawienie wstępne).
    Zostanie otwarte okno dialogowe Save <plug-in name> Preset (Zapisz ustawienie wstępne  
   <nazwa wtyczki>).
3. W sekcji New Preset (Nowe ustawienie wstępne) wprowadź nazwę nowego ustawienia  
    wstępnego.
4. Opcjonalnie: Kliknij New Folder, aby dodać podfolder w folderze presetów efektów.
5. Opcjonalnie: Kliknij opcję Show Attribute Inspector (Pokaż inspektora atrybutów) w lewym 
dolnym rogu okna dialogowego i zdefiniuj atrybuty dla ustawienia wstępnego.
6. Kliknij OK.

WYNIK
Ustawienie wstępne efektu zostanie zapisane.

POWIĄZANE LINKI
Inspektor atrybutów na stronie 659

Zapisywanie domyślnych ustawień efektów
Możesz zapisać ustawienia parametrów efektu jako domyślne ustawienie efektu. Pozwala to na 
automatyczne ładowanie ustawień parametrów za każdym razem, gdy wybierasz efekt.

PROCEDURA
1. Otwórz wyskakujące menu Preset Management (Zarządzanie ustawieniami wstępnymi).

                     

2. Wybierz opcję Save as Default Preset (Zapisz jako domyślne ustawienie wstępne).
    Zostaniesz zapytany, czy chcesz zapisać bieżące ustawienia jako domyślne ustawienie wstępne.
3. Kliknij Yes (Tak).

WYNIK
Ustawienia efektów są zapisywane jako ustawienia domyślne. Za każdym razem, gdy ładujesz 
efekt, domyślne ustawienie wstępne jest ładowane automatycznie.

Kopiowanie i wklejanie presetów między efektami
Możesz kopiować i wklejać gotowe ustawienia efektów między różnymi instancjami tej samej 
wtyczki.
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PROCEDURA
1. Otwórz panel kontrolny efektu, który chcesz skopiować.
2. Prawym przyciskiem myszy kliknij panel sterowania i z menu kontekstowego wybierz opcję   
    Copy <plug-in name> Setting (Kopiuj ustawienie <nazwa wtyczki>).
3. Otwórz inną instancję tego samego efektu.
4. Kliknij prawym przyciskiem myszy panel sterowania iz menu kontekstowego wybierz Paste 
    <plug-in name> Setting (Wklej ustawienie <nazwa wtyczki>).

Zapisywanie ustawień wstępnych wstawek

Możesz zapisać inserty z racka efektów insertów dla kanału jako presety insertów wraz ze 
wszystkimi ustawieniami parametrów. Wstępne ustawienia wstawek można zastosować do ścieżek 
audio, instrumentów, kanałów FX lub ścieżek grupowych.

WARUNEK WSTĘPNY
Załadowałeś kombinację efektów insertowych, a parametry efektu są skonfigurowane dla każdego 
efektu.

PROCEDURA
1. Wybierz ścieżkę.
2. W Inspektorze otwórz sekcję Inserts (Wstawki).
3. Na karcie Inserts (Wstawki) kliknij opcję Preset Management (Zarządzanie ustawieniami)  
    i wybierz opcję Save FX Chain Preset (Zapisz ustawienie łańcucha efektów).

              
4. W okienku Save FX Chain Preset wprowadź nazwę nowego presetu w sekcji New Preset 
    (Nowe ustawienie wstępne).
5. Kliknij OK.

WYNIK
Efekty insertowe i ich parametry są zapisywane jako presety insertowe.

POWIĄZANE LINKI
Stosowanie presetów FX Chain na stronie 485

Ładowanie ustawień wstępnych wstawek
Możesz załadować wstępne ustawienia wstawek do kanałów audio, grup, instrumentów i FX.

WARUNEK WSTĘPNY
Zapisałeś kombinację efektów insertowych jako presety insertowe.

PROCEDURA
1. Wybierz ścieżkę, do której chcesz zastosować nowe ustawienie wstępne.
2. W Inspektorze otwórz sekcję Inserts (Wstawki).
3. W sekcji Inserts (Wstawki) kliknij opcję Preset Management (Zarządzanie ustawieniami) i 
wybierz opcję Load FX Chain Preset (Załaduj ustawienie łańcucha efektów).
4. Wybierz ustawienie wstępne wstawek.
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5. Kliknij dwukrotnie, aby zastosować ustawienie wstępne i zamknąć okienko

WYNIK
Efekty ustawienia wstępnego efektu insertowego zostaną załadowane, a wszelkie wtyczki, które 
zostały wcześniej załadowane dla ścieżki, zostaną usunięte.

Ładowanie ustawień efektu insertowego z ustawień wstępnych ścieżki
Możesz wyodrębnić efekty używane w presecie ścieżki i załadować je do racka (regału, stojaka) 
insertów.

PROCEDURA
1. Wybierz ścieżkę, do której chcesz zastosować nowe ustawienie wstępne.
2. W Inspektorze otwórz sekcję Inserts (Wstawki).
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3. Na karcie Inserts (Wstawki) kliknij opcję Preset Management (Zarządzanie ustawieniami 
wstępnymi) i wybierz opcję From Track Preset (Z ustawienia wstępnego ścieżki).
4. W panelu presetów ścieżek wybierz preset zawierający efekty insertowe, które chcesz załadować.
5. Kliknij dwukrotnie, aby załadować efekty i zamknąć okienko.

WYNIK
Zostaną załadowane efekty użyte w presecie ścieżki.

POWIĄZANE LINKI
Ustawienia ścieżki na stronie 192

Okno informacji o składnikach systemu
Okno System Component Information (Informacje o składnikach systemu) zawiera listę 
wszystkich dostępnych wtyczek MIDI, wtyczek kodeków audio, wtyczek programów, wtyczek 
importu i eksportu projektów oraz wtyczek wirtualnego systemu plików.

● Aby otworzyć okno System Component Information, wybierz Studio > More Options > 
System Component Information (Studio > Więcej opcji > Informacje o składnikach systemu).

Update (only available for MIDI Plug-ins) (Aktualizacja (dostępna tylko dla wtyczek MIDI))
         Ponownie skanuje wyznaczone foldery wtyczek w poszukiwaniu zaktualizowanych informacji
         o składnikach systemu.

Dostępne są następujące kolumny:

Active (Aktywuj)
           Umożliwia aktywację lub dezaktywację wtyczki.
Instances (Instancje)
           Liczba instancji wtyczek używanych w Cubase.
Name (Nazwa)
           Nazwa wtyczki.
Vendor (Sprzedawca)
           Producent wtyczki.
File (Plik)
           Nazwa wtyczki, w tym jej rozszerzenie nazwy pliku.
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Path (Ścieżka)
           Ścieżka, w której znajduje się plik wtyczki.
Category (Kategoria)
          Kategoria każdej wtyczki.
Version (Wersja)
          Wersja wtyczki.
SDK
         Wersja protokołu VST, z którą wtyczka jest kompatybilna.

Zarządzanie składnikami systemu w oknie System Component 
Information (Informacje o składnikach systemu)

● Aby udostępnić wtyczkę do wyboru, zaznacz pole wyboru w lewej kolumnie.
   W selektorach efektów pojawiają się tylko aktywowane wtyczki.
● Aby zobaczyć, gdzie używana jest wtyczka, kliknij kolumnę Instances (Instancje).

UWAGA
Wtyczka może być używana, nawet jeśli nie jest aktywna w lewej kolumnie. Lewa kolumna określa
tylko, czy wtyczka jest widoczna na selektorach efektów.

Eksportowanie plików informacji o składnikach systemu
Informacje o składnikach systemu można zapisać jako plik XML, na przykład do celów 
archiwizacji lub rozwiązywania problemów.

● Plik informacyjny o składnikach systemu zawiera informacje o zainstalowanych/dostępnych   
    wtyczkach, ich wersji, producencie itp.
● Plik XML można następnie otworzyć w dowolnym edytorze obsługującym format XML.

UWAGA
Funkcja eksportu nie jest dostępna dla wtyczek programów.

PROCEDURA
1. W oknie System Component Information (Informacje o składnikach systemu) kliknij prawym  
    przyciskiem myszy środek okna i wybierz opcję Export (Eksportuj).
2. W oknie dialogowym określ nazwę i lokalizację pliku eksportu informacji o składnikach 
    systemu.
3. Kliknij Save (Zapisz), aby wyeksportować plik.
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Bezpośrednie przetwarzanie offline

Direct Offline Processing (Bezpośrednie przetwarzanie offline) umożliwia natychmiastowe 
dodawanie efektów wtyczek i procesów audio do wybranych zdarzeń audio, klipów lub zakresów, 
bez niszczenia oryginalnego dźwięku.

Stosowanie efektów offline jest powszechną praktyką w edycji dialogów i projektowaniu dźwięku. 
Przetwarzanie offline ma kilka zalet w stosunku do stosowania efektów miksera w czasie 
rzeczywistym:

● Przepływ pracy jest oparty na klipach. Pozwala to na zastosowanie różnych efektów do zdarzeń 
    na tej samej ścieżce.
● MixConsole może być utrzymywany w czystości od efektów insertowych i zmian parametrów. 
    Ułatwia to późniejsze miksowanie przez inną osobę, na innym systemie.
● Mniejsze obciążenie procesora.

Direct Offline Processing (Bezpośrednie przetwarzanie offline) umożliwia cofnięcie wszelkich 
zmian dotyczących efektów wtyczek i procesów audio w dowolnym momencie i w dowolnej 
kolejności. Zawsze możesz wrócić do oryginalnej wersji. Jest to możliwe, ponieważ przetwarzanie 
nie wpływa na rzeczywiste pliki audio.

Jeśli przetwarzasz zdarzenie, klip lub zakres zaznaczenia, dzieje się tak:
● W folderze Edits w folderze projektu tworzony jest nowy plik audio.
   Ten plik zawiera przetworzony dźwięk i odnosi się do niego przetworzona sekcja klipu audio.
● Oryginalny plik pozostaje nienaruszony.
   Nieprzetworzone sekcje nadal się do niego odnoszą.

Całe zastosowane przetwarzanie offline jest zapisywane wraz z projektem i nadal można je 
modyfikować po ponownym otwarciu projektu. Operacje bezpośredniego przetwarzania offline na 
wybranym dźwięku są trwałe w archiwach ścieżek i kopiach zapasowych projektów.
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Przetwarzanie jest zawsze stosowane do zaznaczenia. Może to być jedno lub wiele zdarzeń w oknie 
projektu (Project) lub w edytorze części audio (Audio Part Editor), klip audio w puli (Pool) lub 
zakres wyboru w jednym lub wielu zdarzeniach w oknie projektu (Project) lub w edytorze próbek 
(Sample Editor). Jeśli zaznaczenie jest krótsze niż plik audio, przetwarzany jest tylko wybrany 
zakres.

Jeśli wybierzesz zdarzenie, które jest kopią udostępnioną, a zatem odnosi się do klipu używanego 
przez inne zdarzenia w projekcie, możesz zdecydować, jak postępować:
● Wybierz opcję Continue (Kontynuuj), aby przetworzyć wszystkie udostępnione kopie.
● Wybierz opcję New Version (Nowa wersja), aby przetworzyć tylko wybrane zdarzenie.
UWAGA
Działa to tylko wtedy, gdy wybrano opcję Open Options Dialog (Otwórz okno dialogowe opcji) 
dla ustawienia On Processing Shared Clips (Podczas przetwarzania udostępnionych klipów) w 
oknie dialogowym Preferences (Preferencje) (strona Editing – Audio (Edycja — Audio)).

POWIĄZANE LINKI
Modyfikowanie procesów na stronie 486
Trwałe stosowanie przetwarzania offline na stronie 488
Edycja — Audio na stronie 1162
Przepływ pracy bezpośredniego przetwarzania w trybie offline na stronie 476
Okno bezpośredniego przetwarzania w trybie offline na stronie 477

Przepływ pracy bezpośredniego przetwarzania w trybie offline
Operacje przetwarzania w trybie offline można wykonywać w oknie Direct Offline Processing 
(Bezpośrednie przetwarzanie w trybie offline). Okno zawsze pokazuje przetwarzanie wybranego 
dźwięku.

W przypadku dodawania lub modyfikowania przetwarzania w trybie offline obowiązują następujące
zasady:
● Możesz dodać przetwarzanie, dodając wtyczki lub procesy audio. Co więcej, możesz dodawać 
presety łańcuchów efektów, presety ścieżek lub ulubione efekty w oknie Direct Offline Processing
lub przeciągać wtyczki lub łańcuchy wtyczek z Inserts (insertów) lub z Media rack (stojak, regał).
● Jeśli dodasz efekt wtyczki lub proces, ładowane są ostatnio używane ustawienia parametrów. 
Możesz zresetować go do ustawień domyślnych, klikając Reset to Default Values (Resetuj do 
wartości domyślnych).
● Wszystkie zmiany są natychmiast stosowane do audio.
UWAGA
Można to zmienić, dezaktywując opcję Auto Apply (Automatyczne stosowanie) w oknie Direct 
Offline Processing (Bezpośrednie przetwarzanie offline). Może to być konieczne, jeśli pracujesz z 
długimi zdarzeniami lub używasz wtyczek z funkcją uczenia się.

● Jeśli zmodyfikujesz parametry lub usuniesz przetwarzanie, zmiany te zostaną natychmiast 
zastosowane do audio.
● Otrzymujesz wizualną informację zwrotną, gdy proces jest uruchomiony.
UWAGA
Możesz dodawać, modyfikować lub usuwać efekty wtyczek lub procesy audio w dowolnym 
momencie, nawet jeśli proces jest uruchomiony. Natychmiast rozpoczyna się nowy proces 
renderowania.

● Możesz cofnąć i ponownie wykonać wszystkie operacje bezpośredniego przetwarzania w trybie 
   offline, używając Ctrl/Cmd - Z lub Shift - Ctrl/Cmd - Z .
● Jeśli zdarzenie jest zablokowane, nie można go edytować w oknie Direct Offline Processing 
   (Bezpośrednie przetwarzanie offline).
● Możesz trwale zastosować przetwarzanie offline do dźwięku.
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● Jeśli załadujesz projekt z przetwarzaniem offline efektów wtyczek lub procesów audio, które nie  
   są dostępne na twoim komputerze, procesy te są wyświetlane jako Not available (Niedostępne) 
   w oknie Direct Offline Processing (Bezpośrednie przetwarzanie offline).

POWIĄZANE LINKI
Okno bezpośredniego przetwarzania w trybie offline na stronie 477
Automatyczne stosowanie na stronie 476
Komendy klawiszowe do bezpośredniego przetwarzania w trybie offline na stronie 497
Blokowanie zdarzeń na stronie 221
Trwałe stosowanie przetwarzania offline na stronie 488

Auto Apply (Automatyczne stosowanie)
Gdy dodajesz lub modyfikujesz efekty wtyczek lub procesy dźwiękowe, przetwarzanie jest 
domyślnie automatycznie stosowane do dźwięku. Jeśli pracujesz z długimi zdarzeniami lub 
używasz wtyczek z funkcją uczenia się, możesz dezaktywować Auto Apply (Automatyczne 
stosowanie).

Jeśli opcja Auto Apply (Automatyczne stosowanie) jest wyłączona, obowiązują następujące 
zasady:
● Musisz kliknąć Apply (Zastosuj) lub użyć odpowiedniego polecenia klawisza, aby zastosować 
przetwarzanie do audio.

UWAGA
Jeśli aktywne jest okno Direct Offline Processing (Bezpośrednie przetwarzanie w trybie offline), 
możesz również nacisnąć klawisz Return, aby zastosować przetwarzanie.
● Aby anulować przetwarzanie, należy kliknąć przycisk Discard (Odrzuć) lub użyć odpowiedniego
polecenia klawiszowego.

WAŻNE
Procesy audio bez regulowanych parametrów, na przykład Reverse (Odwróć) lub Silence (Wycisz),
są natychmiast stosowane do dźwięku, nawet jeśli Auto Apply (Automatyczne stosowanie) jest 
wyłączone.

POWIĄZANE LINKI
Stosowanie efektów wtyczek z funkcją uczenia się na stronie 482
Komendy klawiszowe na stronie 1123
Wbudowane procesy audio na stronie 488

Okno Direct Offline Processing (Bezpośredniego przetwarzania w 
trybie offline)
Okno Direct Offline Processing umożliwia dodawanie, modyfikowanie lub usuwanie 
przetwarzania audio natychmiast dla jednego lub wielu zdarzeń, klipów lub zakresów zaznaczenia 
w jednym oknie. Co więcej, możesz cofnąć dowolne przetwarzanie dźwięku w dowolnym 
momencie i w dowolnej kolejności.

Aby otworzyć okno Direct Offline Processing, wykonaj jedną z następujących czynności:
● Wybierz Audio > Direct Offline Processing (Audio > Bezpośrednie przetwarzanie offline).
● Naciśnij klawisz F7 .
● Na pasku narzędzi okna Project kliknij opcję Open Direct Offline Processing Window (Otwórz
okno bezpośredniego przetwarzania w trybie offline).
● Wybierz Audio > Processes (Audio > Procesy) i z podmenu wybierz proces.
UWAGA
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Procesy bez regulowanych ustawień parametrów, takie jak Silence (Cisza), nie otwierają okna 
Direct Offline Processing (Bezpośrednie przetwarzanie w trybie offline), gdy są stosowane z menu
lub przy użyciu polecenia klawiszowego.

W oknie Bezpośrednie przetwarzanie offline dostępne są następujące opcje i ustawienia:

Toolbar (pasek narzędzi)
       Umożliwia dodawanie przetwarzania dźwięku, odsłuchiwanie dźwięku z bieżącymi zmianami 
       oraz wprowadzanie globalnych ustawień przetwarzania offline.
Process list (Lista procesów)
       Wyświetla listę wszystkich efektów wtyczek i wbudowanych procesów audio dodanych do 
       wybranego zdarzenia, klipu lub zakresu. Pozycje na tej liście można pominąć. Ikona po prawej 
       stronie każdego procesu pokazuje stan. Jeśli przetwarzany jest tylko zakres wybranego 
       zdarzenia, jest to sygnalizowane ikoną przebiegu w kolumnie Range (Zakres).
       Jeśli zaznaczono więcej niż jedno przetworzone zdarzenie lub klip, kolumna Count (Liczba) 
       pokazuje, ile wystąpień każdego procesu jest używanych w całym zaznaczeniu. Możesz 
       kopiować lub wycinać procesy ze wszystkimi ustawieniami i wklejać je do innych zdarzeń, 
       klipów lub zakresów, usuwać je i trwale przetwarzać w trybie offline, korzystając z menu 
       kontekstowego.
    Jeśli proces nie jest dostępny na komputerze, jest wyświetlany jako Not available (Niedostępny).
Process panel (Panel procesu)
       Umożliwia modyfikowanie, resetowanie lub usuwanie wybranego efektu wtyczki lub procesu 
       audio. Apply (Zastosuj) i Discard (Odrzuć) pozwalają na ręczne zastosowanie nowego efektu 
       wtyczki lub procesu audio albo zmianę parametru do dźwięku lub odrzucenie go.

UWAGA
● Jeśli opcja Auto Apply (Automatyczne stosowanie) jest włączona, przyciski Apply (Zastosuj) i 
   Discard (Odrzuć) nie są dostępne.
● Parametry efektów dla wtyczek są opisane w osobnym dokumencie Plug-in Reference (Opis 
   wtyczek).

Favorites (Ulubione)
       Umożliwiają dodawanie i zarządzanie pojedynczymi procesami lub partiami procesów za 
       pomocą dedykowanych ustawień parametrów. Możesz utworzyć do 36 ulubionych, które są 
       dostępne w 4 bankach.

POWIĄZANE LINKI
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Stosowanie przetwarzania na stronie 480
Obejście procesów na stronie 487
Procesy kopiowania i wklejania na stronie 487
Ulubione na stronie 483
Przetwarzanie wsadowe na stronie 484
Trwałe stosowanie przetwarzania offline na stronie 488
Stosowanie przetwarzania do wielu zdarzeń na stronie 481
Automatyczne stosowanie na stronie 476
Pasek narzędzi bezpośredniego przetwarzania w trybie offline na stronie 478

Pasek narzędzi bezpośredniego przetwarzania w trybie offline
Pasek narzędzi Direct Offline Processing umożliwia dodawanie przetwarzania dźwięku, 
odsłuchiwanie dźwięku z bieżącymi zmianami oraz wprowadzanie globalnych ustawień 
przetwarzania offline.
Na pasku narzędzi dostępne są następujące opcje i ustawienia:

Add Processes (Dodaj procesy)
Add Plug-in (Dodaj wtyczkę)

         
        Umożliwia dodanie efektu wtyczki do wybranego zdarzenia lub klipu.

Select Preset (Wybierz ustawienie wstępne)

           
       Umożliwia wybranie ustawienia wstępnego wtyczki.
Add Process (Dodaj proces)

        
       Umożliwia dodanie wbudowanego procesu audio do wybranego zdarzenia lub klipu.

Apply Options (Zastosuj opcje)
Auto Apply (Zastosuj automatycznie)

        
       Jeśli ta opcja jest aktywna i dodasz lub zmodyfikujesz efekt wtyczki lub proces audio, zostanie 
       on natychmiast przetworzony na dźwięk i dodany do listy procesów w lewej strefie okna 
       Direct Offline Processing (Bezpośrednie przetwarzanie offline).
Jeśli ta opcja jest wyłączona, możesz wprowadzać zmiany w panelu przetwarzania bez 
natychmiastowego renderowania zmian w dźwięku. Aby dodać efekt wtyczki lub proces audio do 
listy procesów albo zastosować zmiany parametrów już dodanego procesu, kliknij Apply 
(Zastosuj). Aby odrzucić efekt wtyczki, proces audio lub zmianę parametru, kliknij Discard 
(Odrzuć).
UWAGA
● Funkcja Auto Apply (automatycznego stosowania) do natychmiastowego renderowania jest 
odpowiednia dla większości przepływów pracy. Jeśli jednak pracujesz z długimi zdarzeniami, 
możesz chcieć ją dezaktywować.

Left Divider (Lewy rozdzielacz)
Left Divider
       Narzędzia umieszczone po lewej stronie separatora są zawsze pokazane.

Audition (Przesłuchanie)
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Audition

        
       Umożliwia przesłuchanie wybranego dźwięku z całym przetwarzaniem od góry listy procesów 
       do wybranego procesu na liście. Wszystkie poniższe procesy są ignorowane podczas 
       odtwarzania.
Audition Loop (Pętla przesłuchania)

        
       Zapętla odtwarzanie do momentu dezaktywacji przycisku Audition.
Audition Volume (Głośność przesłuchania)

        
       Umożliwia regulację głośności.

Extend Process Range (Rozszerz zakres procesu)
Extend Process Range in ms (Rozszerz zakres procesu w ms)

        
       Umożliwia rozszerzenie zakresu procesu na lewą i prawą stronę granic zdarzenia. Pozwala to 
       na powiększenie wydarzenia na późniejszym etapie z całą zastosowaną obróbką.

Tail (Ogon)
Tail in ms (Ogon w ms)

        
       Umożliwia dodanie czasu na końcu renderowanych plików. W ten sposób efekty pogłosu i 
       opóźnienia mogą całkowicie zniknąć.

Right Divider (Prawy rozdzielacz)
Right Divider
Narzędzia umieszczone po prawej stronie separatora są zawsze pokazane.

Window Zone Controls (Sterowanie strefą okna)
Show/Hide Left Zone (Pokaż/ukryj lewą strefę)

        
       Pokazuje/ukrywa lewą strefę okna Direct Offline Processing (bezpośredniego przetwarzania w
       trybie offline), która zawiera listę procesów.

UWAGA
To ustawienie jest zapisywane globalnie.

POWIĄZANE LINKI
Automatyczne stosowanie na stronie 476
Rozszerzenie zakresu procesów na stronie 485
Ogon na stronie 485

Stosowanie przetwarzania
Możesz dodać przetwarzanie do jednego lub wielu wydarzeń, klipów lub zakresów w oknie Direct 
Offline Processing (Bezpośrednie przetwarzanie offline). Obejmuje to efekty wtyczek, procesy 
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audio i operacje Sample Editor (Edytora sampli), takie jak Cut (wycinanie), Paste (wklejanie), 
Delete (usuwanie) i używanie narzędzia Draw (rysowania).

Funkcja Auto Apply (Automatycznego stosowania) do natychmiastowego renderowania jest 
odpowiednia dla większości przepływów pracy. Jeśli jednak pracujesz z długimi zdarzeniami lub 
używasz wtyczek z funkcją uczenia się, możesz chcieć ją dezaktywować.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
       ● Wybierz zdarzenie lub zakres w oknie projektu.
       ● Wybierz klip z Pool (puli).
       ● Wybierz zakres w Sample Editor (Edytorze próbek).
       ● Wybierz zdarzenie lub zakres w Audio Part Editor (Edytorze części audio).
2. Wybierz Audio > Direct Offline Processing (Audio > Bezpośrednie przetwarzanie offline).
3. Wykonaj jedną z następujących czynności:
       ● Na pasku narzędzi Direct Offline Processing (Bezpośrednie przetwarzanie offline) kliknij   
          Add Process (Dodaj proces) i wybierz proces audio.
       ● Na pasku narzędzi Bezpośrednie przetwarzanie w trybie offline kliknij Add Plug-in (Dodaj 
          wtyczkę) i wybierz efekt wtyczki.
       ● W Media rack (stojak, regał, szafa) kliknij kafelek VST Effects, wybierz efekt wtyczki i   
          przeciągnij go na listę procesów w lewej strefie.

WAŻNE
● Możesz wybrać wszystkie zainstalowane wtyczki VST do przetwarzania w trybie offline. Jednak 
   nie każda wtyczka nadaje się do przetwarzania w trybie offline.
● Jeśli zastosujesz efekt stereo do monofonicznego materiału dźwiękowego, używana będzie lewa 
   strona wyjścia stereo efektu.

Wybrany efekt wtyczki lub proces audio zostanie dodany do listy procesów.
4. Aktywuj Audition (Przesłuchanie) i wprowadź zmiany w panelu procesu. Otrzymujesz wizualną 
    informację zwrotną, gdy proces jest uruchomiony. Jednak nawet jeśli przetwarzanie nie zostało 
    zakończone, możesz aktywować Audition w dowolnym momencie.
5. Opcjonalne: Jeśli opcja Auto Apply (Automatyczne stosowanie) jest wyłączona, wybierz, czy 
    chcesz zastosować przetwarzanie do dźwięku, czy je odrzucić.
● Kliknij Apply (Zastosuj) aby dodać efekt wtyczki lub proces dźwiękowy do listy procesów 
    i wyrenderować go do postaci audio.
● Kliknij Discard (Odrzuć), aby odrzucić efekt wtyczki lub proces audio. Panel procesu jest pusty.

WYNIK
Efekt wtyczki lub proces audio jest renderowany do audio. W oknie Project, w Pool (puli) lub 
w Audio Part Editor (Edytorze części audio) przetwarzane zdarzenia mają symbol fali.

Stosowanie przetwarzania do wielu zdarzeń
Direct Offline Processing (Bezpośrednie przetwarzanie offline) umożliwia dodawanie efektów 
wtyczek lub wbudowanych procesów audio do wielu zdarzeń jednocześnie. Możesz także 
modyfikować lub usuwać przetwarzanie wielu zdarzeń jednocześnie.

● Aby zastosować wtyczki lub procesy dźwiękowe do wielu zdarzeń jednocześnie, wybierz dźwięk 
i dodaj, zmodyfikuj lub usuń przetwarzanie.
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Jeśli wybierzesz wiele zdarzeń, kolumna Count (Liczba) na liście procesów pokazuje, ile wystąpień
każdego procesu jest używanych w całym zaznaczeniu audio. Procesy na liście procesów są 
uporządkowane alfabetycznie.

UWAGA
Stosowanie efektów wtyczek do wielu zdarzeń, które mają różne konfiguracje kanałów, może 
prowadzić do niepożądanych rezultatów w zależności od używanej wtyczki.

UWAGA
W oknie Direct Offline Processing (Bezpośrednie przetwarzanie offline) można również edytować
przetwarzanie dźwięku wielu klipów w Pool (puli) jednocześnie.

POWIĄZANE LINKI
Wbudowane procesy audio na stronie 488
Okno bezpośredniego przetwarzania w trybie offline na stronie 477

Stosowanie efektów insertowych jako przetwarzanie offline
Możesz zastosować efekty dźwiękowe z gniazd MixConsole lub Inspector lub całych łańcuchów 
wtyczek z ich bieżącymi ustawieniami parametrów jako przetwarzanie offline.

WARUNEK WSTĘPNY
Twój projekt zawiera ścieżki z efektami wtyczek dźwiękowych.

PROCEDURA
1. Wybierz zdarzenie dźwiękowe, klip lub zakres.
2. Wybierz Audio > Direct Offline Processing (Audio > Bezpośrednie przetwarzanie offline).
3. Wykonaj jedną z następujących czynności:
● W MixConsole lub Inspector kliknij gniazdo Inserts (Wstawki) z załadowaną wtyczką 
    i przeciągnij wtyczkę na listę procesów Direct Offline Processing.
● W MixConsole kliknij nagłówek Inserts rack (stopjak, regał, szafa) i przeciągnij cały rack ze  
    wszystkimi załadowanymi wtyczkami na listę procesów Direct Offline Processing.

UWAGA
Efekt wtyczki lub cały łańcuch wtyczek jest natychmiast dodawany do listy procesów, nawet jeśli 
Auto Apply (Automatyczne stosowanie) jest wyłączone.

WYNIK
Efekt wtyczki lub cały łańcuch wtyczek jest odtwarzany w audio z jego aktualnymi ustawieniami 
parametrów.

Stosowanie efektów wtyczek z funkcją uczenia się
Możesz trenować efekt wtyczki, który ma funkcję uczenia się, na przykład wtyczkę do redukcji 
szumów.

487



PROCEDURA
1. Wybierz zakres audio, którego chcesz użyć do nauczenia wtyczki o spektrum szumów. Na  
    przykład możesz użyć pauzy, która zawiera tylko szum i nie zawiera innych treści.
2. W oknie Direct Offline Processing (Bezpośrednie przetwarzanie w trybie offline) wyłącz opcję 
    Auto Apply (Automatyczne stosowanie).
3. Dodaj wtyczkę redukcji szumów i aktywuj jej tryb nauki.
4. Na pasku narzędzi okna Direct Offline Processing aktywuj Audition Loop (Pętla   
    przesłuchania).
5. Aktywuj Audition (Przesłuchanie).
6. Po przeszkoleniu wtyczki wyłącz jej tryb uczenia się.
7. Dezaktywuj przesłuchanie.
8. Kliknij Discard (Odrzuć).
Redukcja szumów nie jest w tym momencie stosowana, ale wtyczka zachowuje ustawienia 
parametrów dla wyuczonego widma szumów.
9. Wybierz całe zdarzenie.
10. W oknie Direct Offline Processing (Bezpośrednie przetwarzanie offline) dodaj wtyczkę 
redukcji szumów i kliknij Apply (Zastosuj) lub użyj odpowiedniego polecenia klawiszowego.

WYNIK
Redukcja szumów jest stosowana do całego zdarzenia z bieżącymi ustawieniami parametrów.

Favorites (Ulubione)
W przypadku wtyczek lub procesów audio, których często używasz, możesz utworzyć ulubione w 
oknie Direct Offline Processing (Bezpośrednie przetwarzanie offline).

Ulubione umożliwiają natychmiastowe zastosowanie jednej lub wielu wtyczek i procesów audio z 
dedykowanymi ustawieniami parametrów dla wybranego dźwięku. Możesz utworzyć do 36 
ulubionych w 4 bankach, przeciągając wtyczki i procesy audio do sekcji ulubionych pod listą 
procesów.

POWIĄZANE LINKI
Tworzenie Ulubionych na stronie 483
Stosowanie przetwarzania przez Ulubione na stronie 484
Przetwarzanie wsadowe na stronie 484

Tworzenie ulubionych
W oknie Direct Offline Processing możesz tworzyć ulubione dla często używanych wtyczek lub 
procesów z dedykowanymi ustawieniami parametrów.

WARUNEK WSTĘPNY
Lista procesów zawiera wtyczki lub procesy audio z ustawieniami parametrów, które chcesz 
zapisać jako ulubione.

PROCEDURA
1. Opcjonalnie: w sekcji favorites (ulubionych) wybierz bank.
2. Wykonaj jedną z następujących czynności:
     ● Na liście procesów wybierz jeden lub wiele procesów i przeciągnij je do sekcji ulubionych.
UWAGA
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Jeśli przeciągasz wiele procesów, musisz wprowadzić nazwę partii w oknie New Batch (Nowa 
partia).
     ● W stojaku na Media (multimedia) kliknij kafelek VST Effects (Efekty VST), wybierz efekt 
         wtyczki i przeciągnij go do sekcji ulubionych.

WYNIK
W wybranym banku w sekcji ulubionych tworzona jest pojedyncza pozycja lub grupa ulubionych.

PO WYKONANIU TEGO ZADANIA
Możesz zmienić nazwę lub usunąć ulubione lub grupę, korzystając z menu kontekstowego.

POWIĄZANE LINKI
Przetwarzanie wsadowe na stronie 484

Tworzenie ulubionych z efektów insertowych
Możesz użyć efektów dźwiękowych z gniazd MixConsole lub Inspector lub całych łańcuchów 
wtyczek z ich bieżącymi ustawieniami parametrów, aby utworzyć ulubione w oknie Direct Offline 
Processing.

WARUNEK WSTĘPNY
Twój projekt zawiera ścieżki z efektami wtyczek dźwiękowych

PROCEDURA
1. Wybierz zdarzenie dźwiękowe, klip lub zakres.
2. Wybierz Audio > Direct Offline Processing (Audio > Bezpośrednie przetwarzanie offline).

3. Wykonaj jedną z następujących czynności:
● W MixConsole lub Inspector kliknij gniazdo Inserts (insertów) z załadowaną wtyczką 
    i przeciągnij wtyczkę do sekcji ulubionych Direct Offline Processing (Bezpośredniego 
    przetwarzania offline).
● W MixConsole kliknij nagłówek Inserts rack i przeciągnij cały rack ze wszystkimi  
   załadowanymi wtyczkami do sekcji ulubionych Direct Offline Processing. Jeśli przeciągasz 
   wiele procesów, musisz wprowadzić nazwę partii w oknie New Batch (Nowa partia).

WYNIK
W wybranym banku w sekcji ulubionych tworzona jest pojedyncza pozycja lub grupa ulubionych.

PO WYKONANIU TEGO ZADANIA
Możesz zmienić nazwę lub usunąć ulubione lub grupę, korzystając z menu kontekstowego.

Stosowanie przetwarzania przez Ulubione
Ulubione umożliwiają natychmiastowe zastosowanie przetwarzania do jednego lub wielu zdarzeń, 
klipów lub zakresów.
UWAGA
Jeśli zastosujesz efekty wtyczek lub procesy audio, klikając Ulubione, przetwarzanie jest 
natychmiast odtwarzane w dźwięku, nawet jeśli Auto Apply (Automatyczne stosowanie) jest 
wyłączone.

PROCEDURA
1. Wybierz jedno lub wiele zdarzeń.
2. W oknie Direct Offline Processing (Bezpośrednie przetwarzanie w trybie offline) kliknij 
    Favorites (ulubione).
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WYNIK
Odpowiednia wtyczka, proces audio lub partia procesów jest natychmiast stosowana do dźwięku.

POWIĄZANE LINKI
Ulubione na stronie 483
Automatyczne stosowanie na stronie 476
Przetwarzanie wsadowe na stronie 484

Batch Processing (Przetwarzanie wsadowe)
Direct Offline Processing (Bezpośrednie przetwarzanie offline) umożliwia zapisywanie wielu 
efektów wtyczek lub procesów audio z dedykowanymi ustawieniami jako zestawy w sekcji 
Favorites (Ulubione) i stosowanie tych zestawów jednym kliknięciem. Możesz także zastosować 
wstępne ustawienia łańcucha efektów (FX) lub wstawić efekty ustawień wstępnych ścieżek jako 
partie.
● Możesz tworzyć partie, przeciągając wiele procesów z listy procesów do sekcji ulubionych.
● Możesz zastosować partię do dźwięku, klikając odpowiedni ulubiony.
● Możesz zastosować presety łańcuchów efektów lub wstawić efekty presetów ścieżek jako  
   pakiety, klikając Select Preset (Wybierz ustawienie wstępne) na pasku narzędzi Direct Offline 
   Processing.

UWAGA
● Partie są natychmiast stosowane do dźwięku, nawet jeśli Auto Apply (automatyczne stosowanie) 
jest wyłączone.
● Partie są zapisywane globalnie.
● Jeśli pakiety zawierają efekty wtyczek, które nie są dostępne na Twoim komputerze, są one 
stosowane bez wtyczek.

POWIĄZANE LINKI
Tworzenie Ulubionych na stronie 483
Stosowanie przetwarzania przez Ulubione na stronie 484
Stosowanie presetów FX Chain (łańcucha efektów) na stronie 485
Automatyczne stosowanie na stronie 476

Stosowanie presetów łańcucha efektów
Możesz importować presety łańcuchów efektów lub wstawiać efekty presetów ścieżek i stosować je
jako procesy wsadowe.

UWAGA
Partie są natychmiast stosowane do dźwięku, nawet jeśli Auto Apply (automatyczne stosowanie) 
jest wyłączone.

PROCEDURA
1. Na pasku narzędzi Direct Offline Processing (Bezpośrednie przetwarzanie offline) kliknij Select
    Preset (Wybierz ustawienie wstępne) i wybierz załadowanie presetu łańcucha efektów lub efektu
    insertowego z presetu ścieżki.
2. Z selektora wybierz preset łańcucha efektów lub preset ścieżki.

WYNIK
Efekty presetu łańcucha FX lub presetu ścieżki są natychmiast stosowane do audio.

POWIĄZANE LINKI
Automatyczne stosowanie na stronie 476
Zapisywanie ustawień wstępnych wstawiania na stronie 470
Ustawienia ścieżki na stronie 192
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Rozszerzenie zakresu procesu
Zakres przetwarzania można rozszerzyć na lewą i prawą granicę zdarzenia audio. 
To ustawienie umożliwia powiększenie zdarzenia nawet po zastosowaniu obróbki.

● Aby rozszerzyć zakres przetwarzania, kliknij opcję Extend Process Range (Rozszerz zakres 
przetwarzania) w ms na pasku narzędzi Direct Offline Processing (Bezpośrednie przetwarzanie w 
trybie offline) i podaj wartość w milisekundach.

UWAGA
● Aby to zadziałało, dźwięk musi być dostępny poza granicami zdarzenia.
● To ustawienie działa globalnie dla wszystkich zdarzeń.

Tail (Ogon)
Możesz dodać czas na końcu renderowanego dźwięku podczas stosowania efektów wtyczek.

Dodanie ogona pozwala uniknąć obcięcia ogona pogłosu lub efektu opóźnienia. Ogon jest 
dodawany na końcu zdarzenia, a rozmiar zdarzenia jest automatycznie zmieniany.

● Aby dodać ogon podczas stosowania efektu wtyczki, kliknij opcję Tail in ms (Ogon w ms) na 
pasku narzędzi Direct Offline Processing (Bezpośrednie przetwarzanie offline) i podaj wartość w 
milisekundach.

UWAGA
● To ustawienie działa globalnie dla wszystkich zdarzeń.

● Ogon jest dodawany tylko wtedy, gdy dodajesz efekty wtyczek. Jeśli dodasz procesy audio, na 
przykład Gain (Wzmocnienie), nie zostanie dodany ogon.
● Jeśli dodasz zakończenie do zdarzenia, którego rozmiar został wcześniej ręcznie zmieniony, 
zakończenie zostanie dodane, ale długość zdarzenia nie zostanie dostosowana automatycznie. 
Dlatego musisz dostosować zdarzenie ręcznie. W tym przypadku ogon jest miksowany z leżącym 
poniżej klipem audio.

POWIĄZANE LINKI
Opcje zmiany rozmiaru zdarzenia na stronie 213

Modyfikowanie procesów
Możesz usunąć lub zmodyfikować część lub całość przetwarzania klipu w oknie Direct Offline 
Processing (Bezpośrednie przetwarzanie offline). Obejmuje to procesy audio w wyskakującym 
menu Processes (Procesy), wszelkie zastosowane efekty wtyczek oraz operacje Sample Editor 
(Edytora sampli), takie jak Cut (wycinanie), Paste (wklejanie), Delete (usuwanie) i rysowanie za 
pomocą narzędzia Draw (Rysuj).

Funkcja Auto Apply (Automatycznego stosowania) do natychmiastowego renderowania jest 
odpowiednia dla większości przepływów pracy. Jeśli jednak pracujesz z długimi zdarzeniami lub 
używasz wtyczek z funkcją uczenia się, możesz chcieć ją dezaktywować.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
       ● Wybierz przetworzone zdarzenie w oknie Project lub w Audio Part Editor (Edytorze części
           audio).
UWAGA
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W oknie Project lub w Audio Part Editor (Edytorze części audio) przetworzone zdarzenia są 
oznaczone symbolem fali w prawym górnym rogu.
       ● Wybierz przetworzony klip w Pool (puli)
UWAGA
W Pool (puli) przetworzone klipy są oznaczone symbolem fali w kolumnie Status (Stan).
       ● Wybierz przetworzony zakres w Sample Editor (Edytorze próbek).
2. Wybierz Audio > Direct Offline Processing (Audio > Bezpośrednie przetwarzanie offline).
3. Na liście procesów wybierz proces, który chcesz edytować, klikając go.
4. Wykonaj jedną z następujących czynności:
       ● Aktywuj Audition (Przesłuchanie) i zmodyfikuj ustawienia procesu.
       ● Zresetuj proces do ustawień domyślnych, klikając Reset to Default Values (Resetuj do 
          wartości domyślnych).

       ● Usuń proces, klikając Delete   (Usuń) na panelu procesu. 
UWAGA
Alternatywnie możesz kliknąć listę procesów prawym przyciskiem myszy i wybrać Delete (Usuń).
       ● Aby usunąć całe przetwarzanie zastosowane do zdarzenia, kliknij prawym przyciskiem 
          myszy listę procesów i wybierz opcję Delete All (Usuń wszystko).
5. Opcjonalne: Jeśli opcja Auto Apply (Automatyczne stosowanie) jest wyłączona, wybierz, czy 
chcesz zastosować zmiany parametrów do audio, czy je odrzucić.
       ● Kliknij Apply (Zastosuj), aby zastosować zmiany parametrów do audio.
       ● Kliknij Discard (Odrzuć), aby odrzucić zmiany parametrów.

POWIĄZANE LINKI
Okno bezpośredniego przetwarzania w trybie offline na stronie 477
Kolumny okna puli na stronie 612

Zmiana kolejności na liście procesów
Możesz zmienić kolejność operacji na liście Direct Offline Processing (procesów bezpośredniego 
przetwarzania w trybie offline), przeciągając je.

PROCEDURA
● Kliknij efekt wtyczki lub proces audio i przeciągnij go.

WYNIK
Operacje przetwarzania w trybie offline są renderowane do audio w określonej kolejności.

Obejście procesów
W oknie Direct Offline Processing (Bezpośrednie przetwarzanie w trybie offline) możesz ominąć 
procesy. Pozwala to usłyszeć dźwięk bez procesów.

● Aby włączyć/wyłączyć obejście procesu, kliknij przycisk Bypass Process (Obejście procesu) po 
lewej stronie procesu.

UWAGA
● Jeśli włączysz/wyłączysz Bypass Process, cały łańcuch procesów jest obliczany od nowa. W 
zależności od długości dźwięku i liczby procesów może to zająć trochę czasu. Na liście procesów 
otrzymujesz wizualną informację zwrotną, gdy proces jest uruchomiony.
● Stan obejścia jest zapisywany wraz z projektem.

Procesy kopiowania i wklejania
Możesz kopiować i wklejać efekty wtyczek i procesy dźwiękowe wraz z ich ustawieniami 
parametrów między zdarzeniami, klipami i zakresami.
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PROCEDURA
1. Wybierz przetworzone zdarzenie audio, klip lub zakres.

UWAGA
Nie można skopiować przetwarzania na wybranych wielu zdarzeniach.

2. W oknie Direct Offline Processing (Bezpośrednie przetwarzanie w trybie offline) wybierz jedną
    lub wiele pozycji z listy procesów.
3. Kliknij prawym przyciskiem myszy proces na liście procesów i wybierz Copy (Kopiuj) z menu 
    kontekstowego.
4. Wybierz zdarzenia lub klipy, do których chcesz wkleić proces.
5. W oknie Direct Offline Processing kliknij prawym przyciskiem myszy proces na liście 
    procesów i wybierz opcję Paste (Wklej).

WYNIK
Skopiowane procesy i wszystkie ustawienia parametrów są dodawane do listy procesów wybranego
audio.

Stosowanie przetwarzania offline na stałe
Możesz trwale zastosować przetwarzanie offline do audio.

WARUNEK WSTĘPNY
Zastosowano efekty wtyczek lub procesy dźwiękowe do zdarzenia, klipu lub zakresu i masz 
pewność, że nie musisz już edytować przetwarzania.

WAŻNE
Trwałe przetwarzanie offline nie może zostać cofnięte.

PROCEDURA
1. Wybierz przetworzone zdarzenie, klip lub zakres.
2. Wybierz Audio > Make Direct Offline Processing Permanent (Audio > Ustaw bezpośrednie 
    przetwarzanie offline na stałe).

UWAGA
Alternatywnie wybierz opcję Make All Permanent (Ustaw wszystko na stałe) w menu 
kontekstowym listy procesów Direct Offline Processing (bezpośredniego przetwarzania w trybie 
offline).

3. Kliknij OK.

WYNIK
● Wszystkie przetwarzanie i stosowane efekty są trwale dodawane do wybranego zdarzenia, klipu 
    lub zakresu.
● Lista procesów jest pusta.
● Zdarzenie lub klip nie są już oznaczane jako przetworzone w trybie offline za pomocą symbolu 
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    przebiegu (fali).

Wbudowane procesy audio
Cubase zapewnia kilka wbudowanych procesów audio, których można użyć do Direct Offline 
Processing (bezpośredniego przetwarzania offline).

WAŻNE
Procesy audio bez regulowanych parametrów, na przykład Reverse (Odwróć) lub Silence (Wycisz),
są natychmiast stosowane do dźwięku, nawet jeśli Auto Apply (automatyczne stosowanie) jest 
wyłączone.

Envelope (Obwiednia)
Obwiednia umożliwia zastosowanie obwiedni głośności do wybranego audio.
          

          

Curve Type buttons (Przyciski typu krzywej)
        Określ, czy odpowiednia obwiednia wykorzystuje Spline Interpolation (interpolację splajnu), 
        Damped Spline Interpolation (interpolację splajnu z tłumieniem) lub Linear Interpolation 
        (interpolację liniową).
Envelope display (Wyświetlacz obwiedni)
        Pokazuje kształt obwiedni. Otrzymany kształt fali jest pokazany ciemnym tonem, a bieżący 
        kształt fali jasnym tonem.
           ● Aby dodać punkt krzywej, kliknij krzywą.
           ● Aby przesunąć punkt krzywej, kliknij i przeciągnij.
           ● Aby usunąć punkt krzywej, kliknij go i przeciągnij poza obszar wyświetlania
Presets pop-up menu (Menu podręczne ustawień wstępnych)
       Umożliwia zarządzanie ustawieniami wstępnymi.
           ● Aby zapisać ustawienie wstępne, wybierz opcję Save Preset (Zapisz ustawienie wstępne)  
              z menu podręcznego, wprowadź nazwę i kliknij przycisk OK.
           ● Aby zastosować ustawienie wstępne, wybierz je z menu podręcznego.
           ● Aby usunąć ustawienie wstępne, wybierz je z wyskakującego menu i kliknij Remove 
              Preset (Usuń ustawienie wstępne).

Fade In/Fade Out (Narastanie/Zanikanie)
Fade In i Fade Out pozwalają zastosować wyciszenie do wybranego audio.
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Curve Type buttons (Przyciski typu krzywej)
        Określ, czy odpowiednia obwiednia wykorzystuje Spline Interpolation (interpolację splajnu), 
        Damped Spline Interpolation (interpolację splajnu z tłumieniem) lub Linear Interpolation 
        (interpolację liniową).
Envelope display (Wyświetlacz obwiedni)
        Pokazuje kształt obwiedni. Otrzymany kształt fali jest pokazany ciemnym tonem, a bieżący 
        kształt fali jasnym tonem.
           ● Aby dodać punkt krzywej, kliknij krzywą.
           ● Aby przesunąć punkt krzywej, kliknij i przeciągnij.
           ● Aby usunąć punkt krzywej, kliknij go i przeciągnij poza obszar wyświetlania
Presets pop-up menu (Menu podręczne ustawień wstępnych)
       Umożliwia zarządzanie ustawieniami wstępnymi.
           ● Aby zapisać ustawienie wstępne, wybierz opcję Save Preset (Zapisz ustawienie wstępne)  
              z menu podręcznego, wprowadź nazwę i kliknij przycisk OK.
           ● Aby zastosować ustawienie wstępne, wybierz je z menu podręcznego.
           ● Aby usunąć ustawienie wstępne, wybierz je z wyskakującego menu i kliknij Remove 
              Preset (Usuń ustawienie wstępne).
Curve Shape buttons (Przyciski kształtu krzywej)
       Te przyciski zapewniają szybki dostęp do niektórych typowych kształtów krzywych.

Gain (Wzmocnienie)
Gain umożliwia zmianę wzmocnienia, czyli poziomu wybranego dźwięku.

                
Gain (Wzmocnienie)
         Umożliwia ustawienie wartości wzmocnienia w zakresie od -50 dB do +20 dB.
Clipping Detection text (Tekst wykrywania obcinania)
         Ten tekst jest wyświetlany, jeśli korzystasz z Audition (Przesłuchanie), a ustawienie  
         wzmocnienia daje poziomy dźwięku powyżej 0 dB.

UWAGA
W przypadku przesterowania zmniejsz wartość wzmocnienia i zamiast tego użyj procesu 
Normalize (normalizacji) audio. Pozwala to maksymalnie zwiększyć poziom dźwięku bez 
powodowania obcinania.

POWIĄZANE LINKI
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Normalizuj na stronie 490

Invert Phase (Odwróć fazę)
Invert Phase umożliwia odwrócenie fazy wybranego audio.

               
W przypadku stereofonicznych plików audio dostępne jest wyskakujące menu. Pozwala określić, 
które kanały mają odwróconą fazę: lewy kanał, prawy kanał lub oba.

Normalize (Normalizuj)
Normalize pozwala podnieść lub obniżyć poziom dźwięku, który został nagrany przy 
nieodpowiednim poziomie wejściowym. Możesz użyć maksymalnego poziomu szczytowego lub 
głośności dźwięku jako odniesienia do normalizacji.

               

Peak Normalization (Szczytowa normalizacja)
       Umożliwia normalizację dźwięku w oparciu o maksymalny poziom szczytowy. Maximum 
       Peak Level in dBFS (Maksymalny poziom szczytowy w dBFS) ustawia maksymalny poziom 
       szczytowy dźwięku, pomiędzy -50dB a 0dB. Od tego maksymalnego poziomu odejmowany 
       jest bieżący maksymalny poziom wybranego dźwięku, a wzmocnienie jest zwiększane lub 
       zmniejszane o wynikową wartość.

Loudness Normalization (Normalizacja głośności)
        Umożliwia normalizację dźwięku w oparciu o zintegrowaną głośność, zgodnie z zaleceniem 
        R128 Europejskiej Unii Nadawców (EBU). Integrated Loudness in LUFS (Zintegrowana  
        głośność w LUFS) ustawia wartość głośności dla dźwięku między -34LUFS a 0LUFS.

UWAGA
● W przypadku dźwięku krótszego niż 0,4 s normalizacja głośności nie jest stosowana, aby uniknąć
nieoczekiwanie dużych zmian wzmocnienia.
● Normalizowanie wysoce dynamicznego sygnału w oparciu o zintegrowaną głośność może 
powodować piki powyżej 0dB. Aby tego uniknąć, zalecamy dodanie wtyczki Brickwall Limiter po
procesie normalizacji  (Normalize).

POWIĄZANE LINKI
Pomiar głośności na stronie 438

Pitch Shift (Przesunięcie tonu)
Pitch Shift umożliwia zmianę wysokości dźwięku z lub bez wpływu na jego długość. Możesz także
tworzyć harmonie, określając kilka tonacji lub stosując przesunięcie tonu na podstawie krzywej 
obwiedni.
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Na karcie Transpose (Transpozycja) dostępne są następujące opcje:

Keyboard display (Wyświetlacz klawiatury)
       Przedstawia graficzny przegląd transpozycji, w którym pryma jest zaznaczona na czerwono, 
       a transponowana tonacja na niebiesko.

UWAGA
Wskazana pryma nie ma nic wspólnego z tonacją ani wysokością oryginalnego dźwięku, po prostu 
zapewnia sposób wyświetlania interwałów transpozycji.

● Aby zmienić prymę, użyj ustawień w sekcji Pitch Shift Base lub przytrzymaj Alt i kliknij na 
klawiaturze.
● Aby określić interwał transpozycji, kliknij jeden z klawiszy.
● Aby określić akord, aktywuj Multi Shift i kliknij kilka klawiszy. Aby usunąć interwał 
transpozycji, kliknij niebieski przycisk.

Pitch Shift Settings (Ustawienia przesunięcia tonu)

Transpose (Transponować)
       Umożliwia określenie wielkości przesunięcia wysokości tonu w półtonach.
Fine-Tune (Dostroić)
       Umożliwia określenie wielkości przesunięcia tonu w centach.

Preview Settings (Ustawienia podglądu)

Volume (Głośność)
       Umożliwia zmniejszenie głośności dźwięku z przesunięciem tonacji. Ta funkcja jest   
       niedostępna, jeśli włączona jest Time Correction (korekcja czasu).
Listen Key Level (Słuchaj poziomu klawisza)
       Umożliwia regulację poziomu dźwięku o przesuniętej tonacji. Kliknij opcję Listen Key/Listen 
       Chord (Słuchaj klawisza/Słuchaj akordu) aby odtworzyć dźwięk testowy dźwięku o 
       przesuniętej tonacji.

Pitch Shift Base (Podstawa zmiany wysokości tonu)
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Root Note/Pitch (Nuta podstawowa/ton)
      Umożliwia ustawienie prymy.

UWAGA
Wskazana pryma nie ma nic wspólnego z tonacją ani wysokością oryginalnego dźwięku, po prostu 
zapewnia sposób wyświetlania interwałów transpozycji.

Multi Shift (Wiele zmian)
       Aktywuj to, aby określić kilka klawiszy transpozycji i stworzyć wieloczęściowe harmonie. Jeśli
       dodane interwały składają się na akord standardowy, akord ten jest wyświetlany po prawej 
       stronie.
          ● Aby dołączyć oryginalny, nieprzetransponowany dźwięk, kliknij klawisz główny na     
             wyświetlaczu klawiatury, aby był wyświetlany na niebiesko.

Algorithm Settings (Ustawienia algorytmu)

Time Correction (Korekta czasu)
       Aktywuj tę opcję, aby zmienić tonację bez wpływu na długość dźwięku. Jeśli to jest
       wyłączone i podniesiesz tonację, sekcja audio zostanie skrócona.
MPEX 4 Preset (Ustawienie wstępne MPEX 4)
       Umożliwia wybór algorytmu MPEX 4.

POWIĄZANE LINKI
Algorytmy Time Stretch i Pitch Shift na stronie 499

Zmiana wysokości dźwięku oparta na obwiedniach
Na karcie Envelope (Obwiednia) możesz określić krzywą obwiedni jako podstawę przesunięcia 
tonu.
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Curve Type buttons (Przyciski typu krzywej)
        Określ, czy odpowiednia obwiednia wykorzystuje Spline Interpolation (interpolację splajnu), 
        Damped Spline Interpolation (interpolację splajnu z tłumieniem) lub Linear Interpolation 
        (interpolację liniową).
Envelope display (Wyświetlacz obwiedni)
        Pokazuje kształt krzywej obwiedni na obrazie fali dźwięku wybranego do przetworzenia. 
        Punkty krzywej obwiedni powyżej linii środkowej wskazują dodatnie przesunięcie tonu, 
        punkty krzywej poniżej linii środkowej wskazują ujemne przesunięcie tonu. Początkowo 
        krzywa obwiedni jest poziomą, środkową linią, wskazującą na zerowe przesunięcie tonu.
         ● Aby dodać punkt krzywej, kliknij krzywą.
         ● Aby przesunąć punkt krzywej, kliknij i przeciągnij.
         ● Aby usunąć punkt krzywej, kliknij go i przeciągnij poza obszar wyświetlania.
         ● Aby usunąć wszystkie punkty krzywej, kliknij Reset (Resetuj) nad wyświetlaczem 
            obwiedni.
Pitch Shift Settings (Ustawienia przesunięcia tonu)
Range (Zakres)
        Umożliwia określenie pionowego zakresu wysokości obwiedni. Przesunięcie punktu krzywej  
        na górę ekranu powoduje przesunięcie tonu o tę wartość.
Transpose (Transponować)
        Umożliwia określenie wielkości przesunięcia wysokości tonu w półtonach.
Fine-Tune (Dostroić)
        Umożliwia określenie wielkości przesunięcia tonu w centach.

Algorithm Settings (Ustawienia algorytmu)
Time Correction (Korekta czasu)
        Aktywuj tę opcję, aby zmienić tonację bez wpływu na długość dźwięku. Jeśli ta funkcja jest 
        wyłączona, podniesienie tonu skraca sekcję audio i odwrotnie, podobnie jak zmiana prędkości 
        odtwarzania w magnetofonie.
MPEX 4 Preset (Ustawienie wstępne MPEX 4)
        Umożliwia wybór algorytmu MPEX 4.

POWIĄZANE LINKI
MPEX na stronie 499

Usuń opcję przesunięcia DC
Remove DC Offset (Usuń przesunięcie DC) umożliwia usunięcie dowolnego przesunięcia DC w 
wyborze audio.

Jeśli twój sygnał audio zawiera zbyt dużą składową prądu stałego, możesz zauważyć, że nie jest ona
wyśrodkowana wokół osi poziomu zerowego. Nazywa się to przesunięciem DC.

       ● Aby sprawdzić, czy dźwięk zawiera przesunięcia DC, wybierz dźwięk i wybierz Audio >  
           Statistics (Audio > Statystyka).

WAŻNE
Przesunięcie DC jest zwykle obecne w całym nagraniu. Dlatego zawsze stosuj opcję Remove DC 
Offset (Usuń przesunięcie DC), aby zakończyć klipy audio.

Nie ma regulowanych parametrów dla tego procesu audio.

POWIĄZANE LINKI
Okno statystyk na stronie 507
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Resample (Ponowne próbkowanie)
Resample pozwala na zmianę długości, tempa i tonu zdarzenia.

W przypadku ponownego próbkowania do wyższej częstotliwości próbkowania zdarzenie wydłuża 
się, a dźwięk jest odtwarzany z mniejszą szybkością i niższym tonem. Jeśli ponownie spróbujesz z 
niższą częstotliwością próbkowania, zdarzenie będzie krótsze, a dźwięk będzie odtwarzany z 
większą szybkością i wyższym tonem.

              

File Sample Rate (Częstotliwość próbkowania pliku)
        Pokazuje oryginalną częstotliwość próbkowania zdarzenia.
New Sample Rate (Nowa częstotliwość próbkowania)
        Umożliwia ponowne próbkowanie zdarzenia przez określenie częstotliwości próbkowania.
Difference (Różnica)
        Umożliwia ponowne próbkowanie zdarzenia przez określenie różnicy między oryginalną 
        częstotliwością próbkowania a nową częstotliwością próbkowania.

Reverse (Odwróć)
Reverse umożliwia odwrócenie wyboru dźwięku, tak aby brzmiało tak, jakbyś odtwarzał taśmę od 
tyłu. Nie ma regulowanych parametrów dla tego procesu audio.

Silence (Cisza)
Silence umożliwia zastąpienie zaznaczenia ciszą. Nie ma regulowanych parametrów dla tego 
procesu audio.

Stereo Flip (Odwróć stereo)
Stereo Flip umożliwia manipulowanie lewym i prawym kanałem wyboru audio stereo.

W wyskakującym menu Tryb dostępne są następujące opcje:
Flip Left-Right (Odwróć w lewo-w prawo)
        Zamienia lewy i prawy kanał.
Left to Stereo (W lewo do stereo)
        Kopiuje dźwięk lewego kanału do prawego kanału.
Right to Stereo (Prawo do stereo)
        Kopiuje dźwięk prawego kanału do lewego kanału.
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Merge (Łącz)
        Łączy oba kanały z każdej strony w celu uzyskania dźwięku mono.
Subtract (Odejmij)
        Odejmuje informacje lewego kanału od prawego. Ta funkcja jest zwykle używana w tle 
        karaoke, ponieważ usuwa wyśrodkowany materiał mono z sygnału stereo.

Time Stretch (Rozciągnięcie czasu)
Time Stretch umożliwia zmianę długości i tempa wybranego dźwięku bez wpływu na wysokość 
(pitch).

Define Bars (Zdefiniuj takty)
         W tej sekcji możesz ustawić długość wybranego audio i metrum.
Bars (Takty)
         Umożliwia ustawienie długości wybranego audio w taktach
Beats (Uderzenia)
         Umożliwia ustawienie długości wybranego audio w uderzeniach.
Signature (Metrum)
         Umożliwia ustawienie metrum..

Original Length (Oryginalna długość)
Ta sekcja zawiera informacje i ustawienia dotyczące audio wybranego do przetworzenia.

Length in Samples (Długość w próbkach)
        Pokazuje długość wybranego audio w próbkach.
Length in Seconds (Długość w sekundach)
        Pokazuje długość wybranego audio w sekundach.
Tempo in BPM (Tempo w BPM)
        Umożliwia wprowadzenie rzeczywistego tempa dźwięku w uderzeniach na minutę. Ta opcja 
        pozwala na rozciągnięcie w czasie dźwięku do innego tempa, bez konieczności obliczania 
        rzeczywistej długości rozciągnięcia w czasie.

Resulting Length (Wynikowa długość)
Wartości te zmieniają się automatycznie, jeśli dostosujesz Time Stretch Ratio (Współczynnik 
rozciągnięcia czasu) w celu rozciągnięcia audio tak, aby pasowało do określonego przedziału 
czasowego lub tempa.

Samples (Próbki)
        Pokazuje wynikową długość w próbkach.
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Seconds (Sekundy)
        Pokazuje wynikową długość w sekundach.
BPM
        Pokazuje wynikowe tempo w uderzeniach na minutę. Aby to zadziałało, należy określić   
        wartość Original Length (Oryginalna długość).

Range (Zakres)
Te ustawienia umożliwiają ustawienie zakresu dla odcinka czasu.

Arbitrary Range Start Time (Czas rozpoczęcia dowolnego zakresu)
        Umożliwia ustawienie pozycji początkowej zakresu.
Arbitrary Range End Time (Arbitralny czas zakończenia zakresu)
        Umożliwia ustawienie pozycji końcowej zakresu.
Use Locators (Użyj lokalizatorów)
        Umożliwia ustawienie wartości zakresu odpowiednio dla lewej i prawej pozycji lokalizatora.

Algorithm (Algorytm)
       Umożliwia wybranie algorytmu rozciągania czasu.

Time Stretch Ratio (Współczynnik rozciągania czasu)
Umożliwia ustawienie czasu rozciągnięcia jako wartości procentowej oryginalnej długości. Jeśli 
użyjesz ustawień w sekcji Resulting Length (Wynikowa długość) do określenia długości 
rozciągnięcia czasu, ta wartość zmieni się automatycznie.

POWIĄZANE LINKI
Algorytmy Time Stretch i Pitch Shift na stronie 499

Klawiaturowe polecenia do bezpośredniego przetwarzania w 
trybie offline
Przetwarzanie w trybie offline można zastosować za pomocą poleceń klawiszowych.

W przypadku dodawania efektów wtyczek lub procesów dźwiękowych za pomocą poleceń 
klawiszy obowiązują następujące zasady:
● W przypadku bezpośredniego dodawania wtyczek lub procesów audio, używane są ich bieżące 
   ustawienia.
● W przypadku dodawania wtyczek lub procesów audio za pośrednictwem ulubionych lub grup, 
   używane są dedykowane ustawienia ulubionych lub grup.
● Otworzy się okno Direct Offline Processing (Bezpośrednie przetwarzanie w trybie offline). Nie 
   dotyczy to sytuacji, gdy wybrany proces nie posiada żadnych regulowanych parametrów lub gdy 
   okno działa w tle lub jest zminimalizowane.
● Możesz zastosować przetwarzanie w trybie offline za pomocą poleceń klawiszowych, nawet jeśli 
   Auto Apply (automatyczne stosowanie) jest wyłączone.

Jeśli aktywna jest odpowiednia sekcja w oknie Direct Offline Processing (Bezpośrednie 
przetwarzanie w trybie offline), stosowane są następujące domyślne polecenia klawiszowe:
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OPCJA          POLECENIE KLAWISZOWE

Otwórz/zamknij okno bezpośredniego
przetwarzania w trybie offline

   F7

Ustaw fokus w oknie Bezpośrednie
przetwarzanie offline

   Tab

Poruszaj się po liście procesów    Strzałka w górę/Strzałka w dół

Aktywuj/dezaktywuj przesłuchanie (Playback
Toggle triggers Local Preview (wyzwala

przełączanie odtwarzania Podgląd lokalny) musi
być aktywowany w oknie dialogowym

Preferences (Preferencje) 

   Spacja

Zastosuj proces w panelu procesów (dostępne
tylko, jeśli opcja Auto Apply (Automatyczne

stosowanie) jest wyłączona)
   Enter

Discard (Odrzuć) proces w panelu
procesów(tylko dostępne, jeśli automatyczne

stosowanie jest wyłączone)
   Delete

Usuń wybraną pozycję z listy procesów    Delete

Wybierz wszystkie elementy z listy procesów    Ctrl/ Cmd -A

Wytnij wybrane elementy z listy procesów    Ctrl/ Cmd -X

Skopiuj wybrane elementy z listy procesów    Ctrl/ Cmd - C

Wklej elementy do listy procesów    Ctrl/ Cmd - V

Undo (Cofnij)    Ctrl/ Cmd - Z

Aby zdefiniować klawiszowe polecenia dla dalszych operacji Direct Offline Processing 
(bezpośredniego przetwarzania offline) oraz bezpośredniego dodawania określonych efektów 
wtyczek i procesów audio, użyj okna dialogowego Key Commands (Polecenia klawiszowe).

POWIĄZANE LINKI
Ulubione na stronie 483
Przetwarzanie wsadowe na stronie 484
Okno bezpośredniego przetwarzania w trybie offline na stronie 477
Transport na stronie 1179
Automatyczne stosowanie na stronie 476
Komendy klawiszowe na stronie 1123
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Time Stretch i Pitch Shift Algorytmy

W Cubase algorytmy rozciągania czasu i zmiany tonacji są używane w procesach offline, 
w Sample Editor (Edytorze próbek) lub w funkcji Flattening Realtime Processing (Spłaszczania 
przetwarzania w czasie rzeczywistym). W zależności od funkcji dostępne są wstępne ustawienia 
algorytmu élastique, MPEX lub Standard.

POWIĄZANE LINKI
Rozciągnięcie czasu na stronie 495
Pitch Shift na stronie 491
Edytor próbek na stronie 509
élastique na stronie 499
MPEX na stronie 499
Norma na stronie 500
Ograniczenia na stronie 501
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Élastique (elastyczny)
Algorytm élastique jest odpowiedni dla materiałów polifonicznych i monofonicznych.

Dostępne są następujące tryby:
elastique Pro
        Najlepsza jakość dźwięku bez zachowania formatantu.
Elastique Pro Formant
        Aby uzyskać najlepszą jakość dźwięku, ale z zachowaniem formatantu.
élastique efficient (elastyczno wydajny)
        Wymaga mniejszej mocy obliczeniowej, ale ma niższą jakość dźwięku niż tryby Pro.
Tryby obsługują następujące warianty:
Time (Czas)
        Preferuje dokładność pomiaru czasu nad dokładnością tonu.
Pitch (Poziom)
        Przedkłada dokładność tonu nad dokładność pomiaru czasu.
Tape (Taśma)
        Blokuje przesunięcie wysokości tonu do odcinka czasu, tak jak przy odtwarzaniu taśmy ze  
        zmienną prędkością. Jeśli rozciągniesz materiał dźwiękowy, tonacja automatycznie się 
        zmniejszy. Ten wariant nie ma żadnego efektu, jeśli używasz go z transpozycją zdarzenia lub 
        ścieżką transpozycji.

MPEX

MPEX to alternatywny algorytm wysokiej jakości.
        Możesz wybrać pomiędzy następującymi ustawieniami jakości:

MPEX – Preview Quality (MPEX — jakość podglądu)
       Do celów podglądu.
MPEX – Mix Fast (MPEX — szybkie miksowanie)
       Bardzo szybki tryb podglądu. Ten tryb działa najlepiej z kompozytowymi sygnałami 
       muzycznymi (materiał mono lub stereo).
MPEX – Solo Fast (MPEX – solo szybko)
       Na pojedyncze instrumenty (materiał monofoniczny) i głos.

MPEX – Solo Musical (MPEX – Solo Musical)
        Wyższa jakość dla pojedynczych instrumentów (materiał monofoniczny) i głosu.
MPEX – Poly Fast (MPEX – Poly Fast)
        Do materiałów monofonicznych i polifonicznych. Jest to najszybsze ustawienie, które wciąż 
        daje bardzo dobre rezultaty. Możesz go używać do pętli perkusyjnych, miksów i akordów.
MPEX – Poly Musical (MPEX – Poly Musical)
        Do materiałów monofonicznych i polifonicznych. Jest to zalecane ustawienie jakości MPEX.  
        Możesz użyć tego do pętli perkusyjnych, miksów lub akordów.
MPEX – Poly Complex (MPEX – kompleks poli)
        Do złożonych materiałów lub do wyższych współczynników rozciągliwości. To ustawienie 
        wysokiej jakości mocno obciąża procesor.

UWAGA
Jeśli zastosujesz Pitch Shift (Zmiana poziomu) jako proces offline, możesz wybrać między 
zwykłym ustawieniem a ustawieniem, w którym formanty są zachowywane dla każdego ustawienia 
jakości
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Standard
Algorytm Standard jest zoptymalizowany pod kątem wydajnego procesora przetwarzania w czasie 
rzeczywistym.

Dostępne są następujące ustawienia wstępne:

Standard – Drums (Standardowo – perkusja)
         Dla dźwięków perkusyjnych. Ten tryb nie zmienia taktowania dźwięku. Jeśli użyjesz
         z niektórymi dostrojonymi instrumentami perkusyjnymi, mogą wystąpić słyszalne artefakty.   
         W takim przypadku wypróbuj tryb Mix jako alternatywę.
Standard – Plucked (Standardowe – oskubane)
        Dla dźwięku z transjentami i stosunkowo stabilnym widmowym charakterem dźwięku, jak 
        instrumenty szarpane.
Standard – Pads (Standardowe – Klocki)
        Dla dźwięku o tonacji z wolniejszym rytmem i stabilnym widmowym charakterem dźwięku.  
        Ten minimalizuje artefakty dźwiękowe, ale dokładność rytmiczna nie jest zachowana.
Standard – Vocals (Standardowy – wokal)
        Dla wolniejszych sygnałów z transjentami i wyraźnym charakterem tonalnym, takim jak 
        wokale.
Standard – Mix (Standardowy – mieszany)
       Do materiału o tonacji i mniej jednorodnym brzmieniu. Ten tryb zachowuje rytm 
        i minimalizuje artefakty.
Standard – Custom (Standardowy – Niestandardowy)
        Umożliwia ręczne ustawienie parametrów rozciągania w czasie.
Standard – Solo (Standardowy – Solo)
        W przypadku materiałów monofonicznych, takich jak solowe instrumenty dęte drewniane/dęte
        blaszane lub solowe wokale, monofoniczne syntezatory lub instrumenty smyczkowe, które nie 
        grają harmonii. Ten tryb zachowuje barwę dźwięku.

Niestandardowe ustawienia Warp (zniekształcenie)
Jeśli wybierzesz tryb Standard – Custom (Standardowy – Niestandardowy), otworzy się okno 
dialogowe, w którym możesz ręcznie dostosować parametry rządzące jakością dźwięku rozciągania 
czasu:

Grain Size (Wielkość ziarna)
        Umożliwia określenie wielkości ziaren, w których standardowy algorytm rozciągania w czasie 
        dzieli audio. Niskie wartości wielkości ziarna prowadzą do dobrych wyników w przypadku 
        materiału, który ma wiele stanów nieustalonych.
Overlap (Zachodzić na siebie)
        Jest to procent pełnego ziarna, który będzie się pokrywał z innymi ziarnami. Użyj wyższej
        wartości dla materiału o stabilnym charakterze dźwięku.  
Variance (Zmienność)
        Jest to procent całej długości ziaren i określa zmianę położenia, tak aby obszar nakładania się 
        był gładki. Ustawienie zmienności na 0 daje dźwięk podobny do rozciągania w czasie  
        stosowanego we wczesnych samplerach, podczas gdy wyższe ustawienia dają więcej  
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        rytmicznych efektów rozmycia, ale mniej artefaktów dźwiękowych.

Ograniczenia

Stosowanie rozciągania w czasie lub przesuwania tonacji do materiału audio może prowadzić do 
pogorszenia jakości dźwięku i słyszalnych artefaktów. Wynik zależy od materiału źródłowego, 
zastosowanych operacji rozciągania i wysokości oraz wybranego ustawienia wstępnego algorytmu 
audio.

Z reguły mniejsze zmiany wysokości lub czasu trwania powodują mniejszą degradację. Istnieją 
jednak dodatkowe kwestie, o których należy pamiętać podczas pracy z algorytmami rozciągania 
czasu i przesunięcia tonu.

UWAGA
W rzadkich przypadkach edytowanie zniekształconych zdarzeń audio może powodować 
nieciągłości w punktach edycji. Następnie możesz spróbować przesunąć punkt edycji w inne 
miejsce lub odrzucić zdarzenie audio przed edycją.

Reverse Playback and Scrubbing (Odtwarzanie do tyłu i przewijanie)
Większość algorytmów używanych do rozciągania czasu i zmiany tonacji obsługuje tylko 
odtwarzanie do przodu. Odtwarzanie wsteczne lub przewijanie zniekształconych zdarzeń audio 
może prowadzić do powtarzających się artefaktów podczas odtwarzania.

Pitch and Stretch Factor (Współczynnik skoku i rozciągnięcia)
Niektóre algorytmy mogą nakładać ograniczenia na maksymalny obsługiwany stopień rozciągania 
czasu lub zmiany tonacji. Jednak z élastique nie ma ograniczeń.

Funkcje audio

Cubase oferuje specjalne funkcje do analizy audio w Twoim projekcie.

POWIĄZANE LINKI
Okno dialogowe Wykryj ciszę na stronie 502
Okno analizatora widma na stronie 505
Okno statystyk na stronie 507

Okno dialogowe Wykryj ciszę (Detect Silence)
Okno dialogowe Detect Silence (Wykryj ciszę) umożliwia wyszukiwanie cichych sekcji w 
zdarzeniach. Możesz dzielić zdarzenia i usuwać ciche części z projektu lub tworzyć regiony 
odpowiadające niecichym sekcjom.
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● Aby otworzyć okno dialogowe Detect Silence (Wykryj ciszę) dla wybranego zdarzenia audio, 
klipu lub zakresu zaznaczenia, wybierz opcję Audio > Advanced > Detect Silence (Audio > 
Zaawansowane > Wykryj ciszę).

UWAGA
Jeśli wybierzesz wiele zdarzeń, możesz kolejno przetwarzać wybrane zdarzenia z indywidualnymi 
ustawieniami lub zastosować te same ustawienia do wszystkich wybranych zdarzeń jednocześnie.

           

Dostępne są następujące opcje:

Waveform display (Wyświetlacz przebiegu)
Umożliwia powiększanie i pomniejszanie przebiegu za pomocą suwaka powiększenia po prawej 
stronie lub poprzez kliknięcie przebiegu i przesuwanie myszy w górę lub w dół. Przebieg można 
przewijać za pomocą paska przewijania lub kółka myszy. Możesz dostosować wartości Open 
Threshold (Próg otwarcia) i Close Threshold (Próg zamknięcia), przesuwając kwadraty na 
początku i na końcu pliku audio.

Sekcja Detection (Wykrywanie) zawiera następujące opcje:

Open Threshold (Próg otwarcia)
       Gdy poziom dźwięku przekroczy tę wartość, funkcja otwiera się i przepuszcza dźwięk.  
       Materiał dźwiękowy poniżej ustawionego poziomu jest wykrywany jako cisza.
Close Threshold (Próg zamknięcia)
       Gdy poziom dźwięku spadnie poniżej tej wartości, funkcja zamyka się i wykrywa dźwięki 
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       poniżej tego poziomu jako ciszę. Ta wartość nie może być wyższa niż wartość progu otwarcia.
Linked (Połączony)
       Aktywuj tę opcję, aby ustawić te same wartości dla Open Threshold i Close Threshold.
Minimum Time Open (Minimalny czas otwarcia)
       Określa minimalny czas, przez jaki funkcja pozostaje otwarta po przekroczeniu przez poziom 
       dźwięku wartości Open Threshold (progu otwarcia).

UWAGA
Jeśli audio zawiera powtarzające się krótkie dźwięki, co skutkuje zbyt dużą liczbą krótkich 
otwartych sekcji, spróbuj zwiększyć tę wartość.

Minimum Time Closed (Minimalny czas zamknięcia)
       Określa minimalny czas, przez jaki funkcja pozostaje zamknięta po spadku poziomu dźwięku 
       poniżej wartości Close Threshold (progu zamknięcia). Ustaw to na niską wartość, aby mieć 
       pewność, że nie usuniesz dźwięków.
Pre-roll (Przed filmem)
       Powoduje, że funkcja otwiera się nieznacznie, zanim poziom dźwięku przekroczy wartość  
       Open Threshold (Progu otwarcia). Użyj tej opcji, aby uniknąć usunięcia ataku dźwięków.
Post-roll (Po filmie)
       Powoduje nieznaczne zamknięcie funkcji po spadku poziomu dźwięku poniżej wartości Close 
       Threshold (Próg zamknięcia). Użyj tej opcji, aby uniknąć usuwania naturalnego 
       wybrzmiewania dźwięków.

Sekcja Output (Dane wyjściowe) zawiera następujące opcje:

Non-silent Sections (Nie-ciche sekcje)
       Pokazuje liczbę zdarzeń tworzonych po kliknięciu przycisku Process (Przetwarzaj).
Add as Regions (Dodaj jako regiony)
       Tworzy regiony nie-wyciszonych sekcji.
Region Name (Nazwa regionu)
       Umożliwia określenie nazwy sekcji, które nie są wyciszone.
Auto Number Start (Automatyczne rozpoczęcie numeru)
       Umożliwia określenie numeru początkowego dla numerów, które są automatycznie dołączane 
       do nazw regionów.

Strip Silence (Rozbierz Ciszę)
       Dzieli zdarzenie na początku i na końcu każdej cichej sekcji i usuwa ciche sekcje pomiędzy 
       nimi.
Process all selected Events (Przetwórz wszystkie wybrane zdarzenia)
       Stosuje te same ustawienia do wszystkich wybranych zdarzeń. Ta opcja jest dostępna tylko 
       wtedy, gdy wybrałeś więcej niż jedno zdarzenie.
Auto (Automatyczny)
       Aktywuj tę opcję, aby analizować zdarzenie audio i automatycznie aktualizować wyświetlacz 
       przy każdej zmianie ustawień.

UWAGA
Jeśli pracujesz z bardzo długimi plikami, rozważ wyłączenie opcji Auto, ponieważ może to 
spowolnić proces.

Compute (Oblicz)
        Analizuje zdarzenie dźwiękowe i ponownie rysuje przebieg, aby wskazać, które sekcje są 

509



        uważane za ciche.
Preview (Zapowiedź)
       Umożliwia odsłuchanie wyniku przed jego przetworzeniem.
Process (Przetwórz)
       Przetwarza audio zgodnie z Twoimi ustawieniami.

POWIĄZANE LINKI
Usuwanie cichych sekcji na stronie 504

Usuwanie cichych sekcji
Okno dialogowe Detect Silence (Wykryj ciszę) umożliwia wykrywanie i usuwanie cichych 
fragmentów audio.

PROCEDURA
1. Wybierz jedno lub wiele zdarzeń audio z cichymi sekcjami w oknie Project.
2. Wybierz kolejno Audio > Advanced > Detect Silence (Audio > Zaawansowane > Wykryj 
    ciszę).
3. W oknie dialogowym Detect Silence (Wykryj ciszę) wprowadź zmiany.
4. Kliknij Compute (Oblicz), aby przeanalizować audio.
    Dźwięk jest analizowany, a kształt fali jest ponownie rysowany, aby wskazać, które sekcje są 
    uważane za ciche zgodnie z twoimi ustawieniami. Wyświetlana jest liczba wykrytych regionów.
5. Opcjonalnie: Kliknij opcję Preview (Podgląd), aby odsłuchać wynik.
    Wydarzenie zostanie odtworzone, a sekcje zostaną wyciszone zgodnie z ustawieniami.
6. Opcjonalnie: W sekcji Detection (Wykrywanie) dostosuj ustawienia, aż będziesz zadowolony z 
    rezultatu.
7. Opcjonalnie: w sekcji Output aktywuj opcję Add as Regions (Dodaj jako regiony).
8. W sekcji Output (Wyjście) aktywuj Strip Silence (Rozbierz ciszę).
9. Kliknij opcję Process (Przetwarzaj).

WYNIK
Zdarzenie zostanie podzielone, a wyciszone sekcje zostaną usunięte.

                

PO WYKONANIU TEGO ZADANIA
Jeśli wybrałeś więcej niż jedno zdarzenie i nie aktywowałeś opcji Process all selected Events 
(Przetwarzaj wszystkie wybrane zdarzenia), okno dialogowe Detect Silence (Wykryj ciszę) 
otworzy się ponownie po przetworzeniu, umożliwiając wprowadzenie oddzielnych ustawień dla 
następnego zdarzenia.

POWIĄZANE LINKI
Okno dialogowe Wykryj ciszę na stronie 502

Spectrum Analyzer Window (Okno analizatora widma)
Okno Spectrum Analyzer (analizatora widma) wyświetla widmo audio zdarzenia, klipu lub 
zakresu zaznaczenia jako dwuwymiarowy wykres, z zakresem częstotliwości na osi x i rozkładem 
poziomów na osi y.
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● Aby otworzyć okno Spectrum Analyzer (Analizator widma) dla wybranego zdarzenia 
dźwiękowego, klipu lub zakresu wyboru, wybierz Audio > Spectrum Analyzer (Audio > 
Analizator widma).

          

Frequency display (Wyświetlacz częstotliwości)
        Pokazuje wykresy częstotliwości dla analizowanego dźwięku. Jeśli przesuniesz wskaźnik 
        myszy nad określoną pozycję, kanał, częstotliwość, nuta i poziom w tej pozycji zostaną 
        pokazane w polu wartości u góry ekranu.
Channel selector (Przełącznik kanałów)
        W przypadku dźwięku wielokanałowego to menu podręczne umożliwia wybór kanałów 
        wyświetlanych na wyświetlaczu częstotliwości.
Zoom slider (Suwak powiększenia)
        Umożliwia powiększanie i pomniejszanie w poziomie.

POWIĄZANE LINKI
Analiza widma audio na stronie 506

Analiza widma audio
Spectrum Analyzer (Analizator widma) umożliwia analizę dźwięku wybranego zdarzenia, klipu 
lub zakresu wyboru.

PROCEDURA
1. Wybierz zdarzenie audio, klip lub zakres wyboru.
2. Wybierz Audio > Spectrum Analyzer (Audio > Analizator widma).

WYNIK
Widmo audio wybranego zdarzenia, klipu lub zaznaczonego zakresu jest wyświetlane jako 
dwuwymiarowy wykres w oknie Spectrum Analyzer (analizatora widma).

PO WYKONANIU TEGO ZADANIA
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Możesz wyświetlić różnicę poziomów między dwiema pozycjami na tych samych lub różnych 
wykresach.

POWIĄZANE LINKI
Porównanie wartości poziomów na stronie 506

Porównanie wartości poziomów
W oknie Spectrum Analyzer (analizatora widma) można wyświetlić różnicę poziomów między 
dwiema pozycjami na tych samych lub różnych wykresach.

PROCEDURA
1. Przesuń wskaźnik myszy do pierwszej pozycji i kliknij prawym przyciskiem myszy, aby go 
     zaznaczyć.
2. Przesuń wskaźnik myszy na drugą pozycję częstotliwości.

WYNIK
Różnica poziomów między pozycjami jest wyświetlana jako wartość D w polu wartości.

           

PO WYKONANIU TEGO ZADANIA
Kliknij wyświetlacz częstotliwości, aby zresetować wybór pierwszej pozycji

POWIĄZANE LINKI
Okno analizatora widma na stronie 505

Statistics Window (Okno statystyki)
Funkcja Statistics (Statystyki) analizuje wybrane zdarzenia audio, klipy lub zakresy wyboru.

● Aby otworzyć okno Statistics (Statystyki) dla wybranego zdarzenia dźwiękowego, klipu lub 
zakresu zaznaczenia, wybierz Audio > Statistics (Audio > Statystyki).
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W oknie Statistics (Statystyki) wyświetlane są następujące informacje:

Channel (Kanał)
         Pokazuje nazwę analizowanego kanału.
Min. Sample Value (min. Wartość próbki)
         Pokazuje najniższą wartość próbki w dB.
Max. Sample Value (maks. Wartość próbki)
         Pokazuje najwyższą wartość próbki w dB.
Peak Amplitude (Szczytowa amplituda)
         Pokazuje największą amplitudę w dB.
True Peak (Prawdziwy szczyt)
         Pokazuje maksymalny poziom bezwzględny kształtu fali sygnału audio w dziedzinie czasu 
          ciągłego.
DC Offset (Przesunięcie DC)
         Pokazuje wielkość przesunięcia DC w procentach i w dB.
Bit Depth (Głębia bitowa)
         Pokazuje aktualnie obliczoną głębię bitową.
Estimated Pitch (Szacowany poziom)
         Pokazuje szacowany poziom.
Sample Rate (Częstotliwość próbkowania)
        Pokazuje częstotliwość próbkowania.

Average RMS (AES17) (Średnia RMS (AES17))
         Pokazuje średnią głośność zgodnie ze standardem AES17.
Max. RMS (Maks. RMS)
         Pokazuje najwyższą wartość RMS.
Max. RMS All Channels (Maks. RMS Wszystkie kanały)
        Pokazuje najwyższą wartość RMS ze wszystkich kanałów.

Loudness (EBU R 128) (Głośność (EBU R 128))

Max. Momentary Loudness (Maks. Chwilowa głośność)
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        Pokazuje maksymalną wartość wszystkich chwilowych wartości głośności w oparciu o okno 
        czasowe 400 ms. Pomiar nie jest bramkowany.
Max. Short-Term Loudness (Maks. Głośność krótkotrwała)
        Pokazuje maksymalną wartość wszystkich krótkoterminowych wartości głośności w oparciu o 
        okno czasowe 3 s. Pomiar nie jest bramkowany.
Integrated Loudness (Zintegrowana głośność)
        Pokazuje średnią głośność całego tytułu w LUFS (jednostkach głośności w odniesieniu do 
        pełnej skali) zgodnie z normą EBU R 128, która zaleca normalizację dźwięku na poziomie -23 
        LUFS.
Loudness Range (Zakres głośności)
       Pokazuje zakres dynamiczny w całym tytule w jednostkach LU (Loudness Units). Ta wartość 
       pozwala sprawdzić, czy potrzebne jest przetwarzanie dynamiczne.
Max. True Peak Level (Maks. Prawdziwy poziom szczytowy)
       Pokazuje maksymalną wartość kształtu fali sygnału audio w dziedzinie czasu ciągłego.

POWIĄZANE LINKI
Usuń opcję DC Offset na stronie 494

Sample Editor (Edytor próbek)

Edytor próbek zawiera przegląd wybranego zdarzenia audio. Pozwala przeglądać i
edytować audio, wycinając i wklejając, usuwając lub rysując dane audio oraz przetwarzając dźwięk.
Edycja jest nieniszcząca, dzięki czemu można cofnąć modyfikacje w dowolnym momencie.

Możesz otworzyć Sample Editor w osobnym oknie lub w dolnej strefie okna Project. Jest to 
przydatne, jeśli chcesz uzyskać dostęp do funkcji edytora sampli z określonej strefy okna Project.
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Aby otworzyć zdarzenie audio w Sample Editor (edytorze próbek), wykonaj jedną z następujących
czynności:
● Kliknij dwukrotnie zdarzenie w oknie Project.
● Wybierz zdarzenie w oknie Project i naciśnij Return lub Ctrl/Cmd - E.
● Wybierz zdarzenie w oknie Project i wybierz Audio > Open Sample Editor (Audio > Otwórz 
    edytor sampli).
● W oknie dialogowym Key Commands (Polecenia klawiszowe) w kategorii Editors (Edytory) 
przypisz polecenie klawiszowe dla Open Sample Editor (Otwórz edytor sampli). Wybierz 
zdarzenie w oknie Project i użyj polecenia klawiszowego.

UWAGA
Jeśli wybierzesz Audio > Set up Editor Preferences (Audio > Skonfiguruj preferencje edytora), na
stronie Editors (Edytory) otworzy się okno dialogowe Prederences (Preferencje). Wprowadź 
zmiany, aby określić, czy chcesz, aby Sample Editor (Edytor próbek) otwierał się w osobnym 
oknie, czy w dolnej strefie okna Project.

Okno Sample Editor (edytora sampli):

                        Sample Editor (Edytor próbek) w dolnej strefie okna Project:
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Edytor sampli jest podzielony na kilka sekcji:

1   Toolbar (Pasek narzędzi)
     Zawiera narzędzia do wybierania, manipulowania i odtwarzania dźwięku.
2   Info Line (Linia informacyjna)
     Wyświetla informacje o dźwięku.
3   Overview (Przegląd)
     Pokazuje przegląd całego klipu audio i wskazuje, która część klipu jest pokazana na 
     wyświetlaczu kształtu fali.
4   Sample Editor Inspector (Inspektor edytora próbek)
     Zawiera narzędzia i funkcje do edycji dźwięku.

UWAGA
Inspector edytora dolnej strefy jest pokazany w lewej strefie okna Project.

5   Ruler (Linijka)
     Pokazuje oś czasu i format wyświetlania projektu.
6   Waveform display (Wyświetlanie przebiegu)
     Pokazuje obraz fali edytowanego klipu audio.
7   Regions (Regiony)
     Umożliwia dodawanie i edytowanie regionów.

UWAGA
Linię informacyjną, linię przeglądu i regiony można aktywować/dezaktywować, klikając opcję Set 
up Window Layout (Ustaw układ okna) na pasku narzędzi i aktywując/dezaktywując odpowiednie
opcje.
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POWIĄZANE LINKI
Otwieranie Edytora w Strefie Dolnej na stronie 71
Otwieranie Inspektora edytora na stronie 62
Pasek narzędzi edytora próbek na stronie 511
Linia informacyjna na stronie 515
Przegląd linii na stronie 516
Inspektor edytora próbek na stronie 516
Linijka na stronie 519
Wyświetlanie krzywych na stronie 520
Lista regionów na stronie 526

Sample Editor Toolbar (Pasek narzędzi edytora próbek)
Pasek narzędzi zawiera narzędzia do wybierania, edytowania i odtwarzania audio.

● Aby pokazać lub ukryć elementy paska narzędzi, kliknij prawym przyciskiem myszy pasek 
narzędzi i aktywuj lub dezaktywuj elementy.

Dostępne są następujące opcje:

Static Buttons (Przyciski statyczne)
Solo Editor

           
         Soluje wybrany dźwięk podczas odtwarzania.

Left Divider (Lewy rozdzielacz)
Left Divider 
        Narzędzia umieszczone po lewej stronie separatora są zawsze pokazane.

View Options (Wyświetl opcje)
Show Audio Event (Pokaż wydarzenie audio)

          
        Podświetla sekcję odpowiadającą edytowanemu zdarzeniu na ekranie przebiegu i linii 
        przeglądu.

UWAGA
Ten przycisk nie jest dostępny, jeśli zdarzenie audio zostało otwarte z Pool (puli). Możesz 
dostosować początek i koniec zdarzenia w klipie, przeciągając uchwyty zdarzenia na ekranie 
przebiegu

Edit Active Audio Event Only (Edytuj tylko aktywne zdarzenie audio)

           
        Ogranicza operacje edycji do aktywnego zdarzenia audio.

Show All Selected Audio Events (Pokaż wszystkie wybrane zdarzenia audio)

          
        Pokazuje obrazy fal wszystkich zdarzeń dźwiękowych wybranych w oknie projektu.
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UWAGA
Użyj wyskakującego menu Currently Edited Audio Event (Aktualnie edytowane zdarzenie 
audio), aby wybrać zdarzenie audio, które chcesz edytować.

Currently Edited Audio Event (Aktualnie edytowane wydarzenie audio)

          
        Wyświetla listę wszystkich zdarzeń audio otwartych w edytorze próbek i umożliwia 
        aktywację zdarzenia audio do edycji.

Auto Scroll (automatyczne przewijanie)
Auto Scroll

          
        Pozostawia widoczny kursor projektu podczas odtwarzania.
Select Auto-Scroll Settings (Wybierz Ustawienia automatycznego przewijania)

          
        Umożliwia aktywację Page Scroll (przewijania strony) lub Stationary Cursor (stacjonarnego 
        kursora) oraz aktywację Suspend AutoScroll When Editing (wstrzymania automatycznego 
        przewijania podczas edycji).

Preview (Zapowiedź)
Audition (Przesłuchanie)

          
        Odtwarza wybrany dźwięk.
Audition Loop (Pętla przesłuchania)

          
        Zapętla odtwarzanie do momentu wyłączenia Audition.
Audition Volume (Głośność przesłuchania)

          
       Umożliwia regulację głośności.

Tool Buttons (Przyciski narzędziowe)
Range Selection (Wybór zakresu)

         
        Wybiera zakresy.
Zoom (Powiększenie)

         
        Powiększa. Przytrzymaj Alt/Opt i kliknij, aby pomniejszyć.
Draw (Rysuj)

         
        Rysuje krzywą głośności.
Play (Graj)

         
        Umożliwia odtwarzanie klipu od miejsca kliknięcia do momentu zwolnienia przycisku myszy.
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Scrub (Szoruj)

         
        Pozwala zlokalizować pozycje.
Time Warp (Zniekształcenie czasu)

         
        Dopasowuje pozycje muzyczne zdarzeń do pozycji czasowych.

Acoustic Feedback (Sprzężenie akustyczne)
Acoustic Feedback 

         
        Automatycznie odtwarza segment VariAudio podczas modyfikowania poziomu (pitch).

Snap (Przyciąganie)
Snap to Zero Crossing (Przyciągnij do przejścia przez zero)

         
        Ogranicza edycję do przejść przez zero, czyli pozycji, w których amplituda wynosi zero.
Snap On/Off (Włączanie/wyłączanie przyciągania)

         
        Ogranicza ruch poziomy i pozycjonowanie do określonych pozycji.

Musical Information (Informacje muzyczne)
Musical Mode (Tryb muzyczny)

         
        Blokuje klipy audio do tempa projektu za pomocą rozciągania w czasie rzeczywistym.
Number of Bars Defined in Audio File (Liczba taktów zdefiniowana w pliku audio)

         
        Wyświetla szacunkowe takty pliku audio.
Remaining Number of Beats Defined in Audio File (Pozostała liczba uderzeń zdefiniowana w 
pliku audio)

        
       Wyświetla pozostałą liczbę uderzeń pliku audio.
Defined Tempo of Audio File (Zdefiniowane tempo pliku audio)

        
       Wyświetla szacowane tempo pliku audio.
Defined Time Signature of Audio File (Zdefiniowana sygnatura czasowa pliku audio)

        
       Wyświetla szacowane metrum pliku audio.
Warping Algorithm for Audio Clip (Algorytm zniekształcania dla klipu audio)

        
       Umożliwia wybranie algorytmu warp.

VariAudio Segment Colors (Kolory segmentu VariAudio)
VariAudio Segment Colors
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Umożliwia wybranie schematu kolorów dla segmentów VariAudio. Ułatwia to sprawdzenie, które 
segmenty należą do którego zdarzenia podczas pracy z kilkoma zdarzeniami audio.

Right Divider (Prawy separator)
Right Divider 
         Narzędzia umieszczone po prawej stronie separatora są zawsze pokazane

Window Zone Controls (Sterowanie strefą okna)
Open in Separate Window (Otwórz w osobnym oknie)

          
         Przycisk ten jest dostępny w edytorze dolnych stref. Otwiera edytor w osobnym oknie.
Open in Lower Zone (Otwórz w dolnej strefie)

          
         Przycisk ten jest dostępny w oknie edytora. Otwiera edytor w dolnej strefie okna Projektu.
Set up Window Layout (Skonfiguruj układ okien)

          
        Umożliwia ustawienie układu okien.
Show/Hide Left Zone (Pokaż/ukryj lewą strefę)

          
        Umożliwia aktywację/dezaktywację lewej strefy.
Show/Hide Regions (Pokaż/ukryj regiony)

          
       Umożliwia aktywację/dezaktywację regionów.
Set up Toolbar (Skonfiguruj pasek narzędzi)

          
       Otwiera wyskakujące menu, w którym można określić, które elementy paska narzędzi mają być
       widoczne.

POWIĄZANE LINKI
Menu ustawień automatycznego przewijania na stronie 248
Wstrzymaj automatyczne przewijanie podczas edycji na stronie 248

Lokalizowanie pozycji za pomocą narzędzia Scrub (szoruj)
Narzędzie Scrub umożliwia zlokalizowanie pozycji w audio.

PROCEDURA
1. Na pasku narzędzi aktywuj narzędzie Scrub.
2. Kliknij na wyświetlaczu krzywej i przytrzymaj wciśnięty przycisk myszy. Kursor projektu 
    przesunie się do miejsca, w którym kliknąłeś.
3. Przeciągnij w lewo lub w prawo.

WYNIK
Dźwięk jest odtwarzany i można usłyszeć, w której pozycji znajduje się kursor.

UWAGA
Szybkość i ton odtwarzania można określić, przeciągając szybciej lub wolniej.
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Edycja próbek audio za pomocą narzędzia rysowania Draw
Możesz edytować klip audio na poziomie próbki za pomocą narzędzia Draw (Rysuj) W ten sposób 
możesz na przykład ręcznie usunąć kliknięcia audio.

PROCEDURA
1. Na przebiegu audio znajdź pozycję próbki, którą chcesz edytować, i powiększ do największego 
    poziomu powiększenia.
2. Wybierz narzędzie Draw (Rysuj).

            

3. Kliknij początek sekcji, którą chcesz poprawić, i narysuj nową krzywą.

WYNIK
Wybór zakresu obejmujący edytowaną sekcję jest stosowany automatycznie.

UWAGA
Narzędzia Draw (Rysuj) nie można używać, gdy sekcja VariAudio jest otwarta.

Info Line (Linia informacyjna)
Linia informacji zawiera informacje o klipie audio, takie jak format audio i zakres wyboru.

● Aby pokazać lub ukryć linię informacyjną, kliknij Set up Window Layout (Ustaw układ okna) 
na pasku narzędzi i włącz lub wyłącz Info Line (linię informacyjną).

Stan włączenia/wyłączenia linii informacyjnej w oknie Sample Editor i w edytorze dolnej strefy są
od siebie niezależne.
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UWAGA
Początkowo wartości długości i położenia są wyświetlane w formacie określonym w oknie 
dialogowym Project Setup (Ustawienia projektu).

Overview Line (Linia przeglądu)
Linia przeglądu wyświetla cały klip i wskazuje, która część klipu jest pokazana na ekranie 
przebiegu.

         

● Aby wyświetlić lub ukryć linię przeglądu, kliknij Set up Window Layout (Ustaw układ okna) na
pasku narzędzi i włącz lub wyłącz opcję Overview (Przegląd).
Stan włączenia/wyłączenia linii przeglądu w oknie Sample Editor i w edytorze dolnej strefy są od 
siebie niezależne.

1   Event Start (Rozpoczęcie zdarzenia)
     Pokazuje początek zdarzenia audio, jeśli na pasku narzędzi aktywowano opcję Show Audio 
     Event (Pokaż zdarzenie audio).
2   Selection (Wybór)
     Pokazuje, która sekcja jest wybrana na ekranie przebiegu.
3   Event End (Koniec zdarzenia)
     Pokazuje koniec zdarzenia dźwiękowego, jeśli na pasku narzędzi aktywowano opcję Show  
     Audio Event (Pokaż zdarzenie audio).
4   Waveform display (Wyświetlacz przebiegu)
     Pokazuje sekcję audio, która jest wyświetlana na wyświetlaczu kształtu fali.
     ● Możesz określić, która część dźwięku ma być wyświetlana, klikając w dolnej połowie tego 
        ekranu i przeciągając w lewo lub w prawo.
     ● Możesz powiększyć lub pomniejszyć obraz w poziomie, przeciągając lewą lub prawą krawędź
        tego ekranu.
     ● Możesz wyświetlić inną sekcję audio, klikając górną połowę tego ekranu i przeciągając 
        prostokąt.
5   Snap Point (Punkt przyciągania)
     Pokazuje początek zdarzenia dźwiękowego, jeśli na pasku narzędzi aktywowano opcję Show 
     Audio Event (Pokaż zdarzenie audio).

Sample Editor Inspector (Inspektor edytora próbek)
Inspector pokazuje elementy sterujące i parametry umożliwiające edycję zdarzenia audio 
otwartego w Sample Editor (Edytorze próbek).

● W oknie Sample Editor (Edytora próbek) możesz pokazać lub ukryć Inspektora, klikając 
   Set up Window Layout (Ustaw układ okna) na pasku narzędzi i aktywując lub dezaktywując 
   Inspektora.

UWAGA
W dolnym edytorze stref Inspector jest zawsze pokazywany w lewej strefie okna Project.

● Aby otworzyć lub zamknąć sekcje Inspektora, kliknij ich nazwy.
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POWIĄZANE LINKI
Otwieranie Inspektora edytora na stronie 62

Definition Section (Sekcja definicja)
Sekcja Definition (Definicja) umożliwia dostosowanie siatki audio i zdefiniowanie kontekstu 
muzycznego dźwięku. Możesz użyć dostępnych funkcji, aby dopasować plik audio lub pętlę audio 
do tempa projektu.
● Aby otworzyć sekcję Definition, kliknij jej zakładkę w Sample Editor Inspector (Inspektorze 
edytora próbek).

         

AudioWarp Section (Sekcja zniekształcenia audio)
Sekcja AudioWarp umożliwia wprowadzanie ustawień taktowania dla audio. Obejmuje to 
zastosowanie funkcji Swing i ręczną zmianę rytmu dźwięku poprzez przeciąganie uderzeń do 
pozycji czasowych na siatce.

● Aby otworzyć sekcję AudioWarp, kliknij jej zakładkę w z (Inspektorze edytora próbek).

         

VariAudio Section (Sekcja VariAudio)
Sekcja VariAudio umożliwia edytowanie pojedynczych dźwięków pliku audio i zmianę ich 
wysokości lub taktowania. Ponadto możesz wyodrębnić MIDI z audio.

● Aby otworzyć sekcję VariAudio, kliknij jej zakładkę w Sample Editor Inspector (Inspektorze 
edytora próbek).
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POWIĄZANE LINKI
Sekcja VariAudio Inspector na stronie 550

Hitpoints Section (Sekcja punktów hitowych)
Sekcja Hitpoints (punktów hitowych) umożliwia edycję punktów hitowych w celu pocięcia 
dźwięku. Tutaj możesz tworzyć mapy kwantyzacji rowków, znaczniki, regiony, zdarzenia i 
znaczniki wypaczania na podstawie punktów hitowych.
● Aby otworzyć sekcję Hitpoints (Punkty hitowe), kliknij jej zakładkę w Sample Editor Inspector
(Inspektorze edytora próbek).

            .

Range Section (Sekcja zasięgu )
Sekcja Zakres umożliwia edytowanie zakresów i selekcji lub tworzenie ścieżki samplera z 
wybranego zakresu.
● Aby otworzyć sekcję Range (Zakres), kliknij jej zakładkę w Sample Editor Inspector 
(Inspektorze edytora próbek).
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Se;lect (Wybierz)
         Otwiera wyskakujące menu z funkcjami wyboru zakresów.
Start (Początek)
         Pokazuje pozycję początkową zakresu wyboru.
End (Koniec)
         Pokazuje pozycję końcową zakresu wyboru.
Length (Długość)
         Pokazuje długość zakresu wyboru.
Zoom (Powiększenie)
         Otwiera wyskakujące menu z funkcjami powiększania dla zakresów.
Create Sampler Track (Utwórz ścieżkę samplera)
         Umożliwia utworzenie ścieżki samplera z wybranego zakresu.

Process Section (Sekcja Przetwarzaj)
Sekcja Preocess (Przetwarzanie) grupuje najważniejsze polecenia edycji dźwięku z menu Audio
i Edit (Edycja).

● Aby otworzyć sekcję Process, kliknij jej zakładkę w Sample Editor Inspector (Inspektorze 
edytora próbek).

            

Ruler (Linijka)
Linijka pokazuje oś czasu i format wyświetlania projektu, siatkę tempa projektu.

Linijka znajduje się nad wyświetlaczem przebiegu. Zawsze jest pokazana.

Gdy sekcja Defionition (Definicja) jest otwarta, pod siatką tempa projektu wyświetlana jest 
dodatkowa linijka. Wyświetla muzyczną strukturę pliku audio, siatkę tempa audio.
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Waveform Display (Wyświetlacz przebiegów)
Wyświetlacz kształtu fali pokazuje obraz fali edytowanego klipu audio

              

1   Level Scale menu (Menu skali poziomu)
         Umożliwia pokazanie poziomu w procentach lub w dB. Tutaj możesz również aktywować 
         wyświetlanie osi połowy poziomu.
2   Ruler (Władca)
         Pokazuje siatkę tempa projektu.
3   Audio waveform (Przebieg audio)
         Pokazuje obraz fali wybranego dźwięku.
UWAGA
Możesz wyświetlić obrazy fal wielu wybranych zdarzeń audio jednocześnie, aktywując opcję Show
All Selected Audio Events (Pokaż wszystkie wybrane zdarzenia audio) na pasku narzędzi Sample 
Editor (Edytora próbek).
4   Half Level Axis (Oś półpoziomowa)
     Aby wyświetlić oś połowy poziomu, otwórz menu skali poziomu i wybierz opcję Show Half 
     Level Axis (Pokaż oś połowy poziomu)
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UWAGA
Możesz ustawić styl obrazu Wave (fali) w oknie dialogowym Preferences (Preferencje) (Event 
Display (Wyświetlacz zdarzenia) — strona Audio).

Powiększanie w pionie
Możesz powiększyć przebieg w pionie. Pozwala to zobaczyć określony szczegół przebiegu.

PROCEDURA
● Przeciągnij suwak powiększenia pionowego w dół, aby powiększyć lub w górę, aby pomniejszyć.

               

UWAGA
Jeśli sekcja VariAudio jest otwarta, możesz także powiększać w pionie, jeśli dezaktywujesz 
narzędzie Zoom Tool Standard Mode: Horizontal Zooming only (Powiększenie Tryb 
standardowy: Tylko powiększanie w poziomie) w oknie dialogowym Preferences (Preferencje) 
(Editing (Edycja) — strona Tools (Narzędzia)) i przeciągnij prostokąt za pomocą narzędzia Zoom 
(Powiększenie).

WYNIK
Skala pionowa zmienia się w zależności od wysokości Sample Editor (edytora sampli).

Powiększanie w poziomie
Możesz powiększyć przebieg w poziomie. Pozwala to na powiększanie lub pomniejszanie skali 
czasu.

PROCEDURA
● Przeciągnij suwak powiększenia w poziomie w prawo, aby powiększyć lub w lewo, aby 
pomniejszyć.

              

WYNIK
Poziome ustawienie powiększenia jest pokazane w linii informacyjnej jako próbki na piksel. 
Możesz powiększyć poziomo do skali mniejszej niż jedna próbka na piksel. Jest to wymagane do 
korzystania z narzędzia Draw (Rysuj).

UWAGA
● Jeśli powiększyłeś do jednej próbki na piksel lub mniej, wygląd próbek zależy od opcji 
Interpolate Audio Waveforms (Interpoluj przebiegi audio) w oknie dialogowym Preferences 
(Preferencje) (Event Display (Wyświetlanie zdarzeń) — strona Audio).

Podmenu Zoom (Powiększenia)
Podmenu Zoom w menu Edit zawiera opcje powiększania w Sample Editor (edytorze sampli).

● Aby otworzyć podmenu Zoom (Powiększenie), wybierz kolejno Edit > Zoom (Edycja > 
Powiększenie).
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Dostępne są następujące opcje:
Zoom In (Zbliżenie)
          Powiększa o jeden krok, wyśrodkowując kursor projektu
Zoom Out (Pomniejsz)
          Pomniejsza o jeden krok, wyśrodkowując kursor projektu.
Zoom Full (Zoom pełny)
          Pomniejsza, aby cały klip był widoczny na ekranie przebiegu
Zoom to Selection (Powiększ do zaznaczenia)
          Pomniejsza, aby cały klip był widoczny na ekranie przebiegu. Jeśli sekcja VariAudio jest 
          otwarta, powoduje to powiększenie w poziomie i w pionie, tak aby bieżący wybór wypełnił 
          wyświetlany przebieg.
Zoom to Selection (Horiz.) (Powiększ do zaznaczenia (w poziomie))
          Powiększa w poziomie, tak aby bieżący wybór wypełnił wyświetlany przebieg.
Zoom to Event (Powiększ do zdarzenia)
          Powiększa, aby na wyświetlaczu kształtu fali był widoczny fragment klipu odpowiadający 
          edytowanemu zdarzeniu audio. Nie jest to dostępne, jeśli otworzyłeś Sample Editor 
          z Pool (puli).
Zoom In Vertically (Powiększ w pionie)
          Powiększa o jeden krok w pionie.
Zoom Out Vertically (Pomniejsz w pionie)
          Pomniejsza o jeden krok w pionie.
Undo/Redo Zoom (Cofnij/Powtórz powiększenie)
          Umożliwia cofnięcie/ponowne wykonanie ostatniej operacji powiększenia.

Edycja zakresu
W Sample Editor (Edytorze próbek) możesz edytować zakresy wyboru. Ta opcja jest przydatna, 
jeśli chcesz szybko edytować lub przetworzyć określoną sekcję fali dźwiękowej albo jeśli chcesz 
utworzyć nowe wydarzenie lub klip

Możesz wybrać tylko jeden zakres naraz. Wybór jest wskazany w polu Selection (Wybór) w 
wierszu informacyjnym.

Sekcja Range (Zakres) w Sample Editor Inspector (Inspektor edytora próbek) zawiera funkcje do 
pracy z regionami.

POWIĄZANE LINKI
Sekcja dotycząca zasięgu na stronie 518
Udostępnione kopie na stronie 219

Wybór zakresu

WARUNEK WSTĘPNY
Snap to Zero Crossing (Przyciągaj do przejścia przez zero) jest aktywna na pasku narzędzi. Ta 
opcja gwarantuje, że początek i koniec zaznaczenia zawsze będą przebiegać przez zero.

PROCEDURA
1. Na pasku narzędzi aktywuj narzędzie Range Selection (Wybór zakresu).
2. Kliknij pozycję na ekranie krzywej, w której chcesz rozpocząć zakres, i przeciągnij do niej
    pozycję, w której chcesz zakończyć zakres.
3. Opcjonalnie: Wykonaj jedną z poniższych czynności, aby zmienić rozmiar zakresu zaznaczenia:
         ● Przeciągnij lewą lub prawą krawędź zaznaczenia w nowe miejsce.
         ● Przytrzymaj klawisz Shift i kliknij w nowym miejscu.
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WYNIK
Wybrany zakres jest podświetlony na wyświetlaczu przebiegu.

UWAGA
Możesz także użyć funkcji w wyskakującym menu Select (Wybierz), aby wybrać zakresy.

POWIĄZANE LINKI
Menu Wybierz na stronie 523

Select Menu (Menu Wybierz)
Menu podręczne Select (Wybierz) w sekcji Range (Zakres)
W wyskakującym menu Select w sekcji Range w Sample Editor Inspector dostępne są 
następujące funkcje:

Select All (Zaznacz wszystko)
         Zaznacza cały klip.
Select None (Wybierz Brak)
         Odznacza wszystko.
Select in Loop (Wybierz w pętli)
         Wybiera audio między lewym a prawym lokalizatorem.
Select Event (Wybierz Zdarzenie)
        Wybiera tylko audio zawarte w edytowanym zdarzeniu. Jeśli sekcja VariAudio jest otwarta, 
        a audio zostało podzielone na segmenty, wybrane zostaną wszystkie segmenty, które zaczynają
        się lub kończą w granicach zdarzenia.
Set Locators to Selection Range (Ustaw Lokalizatory na Zakres wyboru)
        Ustawia lokalizatory tak, aby obejmowały bieżące zaznaczenie. Ta opcja jest dostępna, jeśli 
        wybrałeś jedno lub kilka zdarzeń lub dokonałeś wyboru zakresu
Locate Selection (Zlokalizuj zaznaczenie)
        Przesuwa kursor projektu na początek lub koniec bieżącego zaznaczenia. Ta opcja
        jest dostępna, jeśli wybrałeś jedno lub kilka zdarzeń albo dokonałeś wyboru zakresu.
Loop Selection (Wybór pętli)
       Włącza odtwarzanie od początku zaznaczenia i kontynuuje odtwarzanie od końca zaznaczenia.

Podmenu Select (Wybierz) w menu Edit (Edycja).

Jeśli wybierzesz Edit > Select (Edytuj > Wybierz), dostępne będą następujące funkcje:

All (Wszystko)
         Zaznacza cały klip.
None (Nic)
        Odznacza wszystko.
In Loop (W pętli)
        Wybiera audio między lewym a prawym lokalizatorem.
From Start to Cursor (Od początku do kursora)
        Wybiera dźwięk między początkiem klipu a kursorem projektu.
From Cursor to End (Od kursora do końca)
        Zaznacza dźwięk między kursorem projektu a końcem klipu. Ta opcja jest dostępna, jeśli 
        kursor projektu znajduje się między granicami przycięcia.
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Equal Pitch - all Octaves/same Octave (Równy poziom - wszystkie oktawy/ta sama oktawa)
         Zaznacza wszystkie nuty o tej samej wysokości co wybrana nuta, w dowolnej oktawie lub 
         w bieżącej oktawie. Ta opcja jest dostępna, jeśli otwarta jest sekcja VariAudio i włączona jest
         opcja Edit VariAudio (Edytuj VariAudio).
Events under Cursor (Zdarzenia pod kursorem)
         Zaznacza wszystkie zdarzenia dotknięte kursorem projektu. Ta opcja jest dostępna, jeśli 
         otwarta jest sekcja VariAudio i włączona jest opcja Edit VariAudio (Edytuj VariAudio).
Select Event (Wybierz Zdarzenie)
        Wybiera zdarzenie.
Left Selection Side to Cursor (Lewa strona zaznaczenia do kursora)
        Przesuwa lewą stronę zakresu zaznaczenia do pozycji kursora projektu. Ta opcja jest dostępna,
        jeśli kursor projektu znajduje się między granicami przycięcia.
Right Selection Side to Cursor (Prawa strona zaznaczenia do kursora)
        Przesuwa prawą stronę zakresu zaznaczenia do pozycji kursora projektu lub do końca klipu,  
        jeśli kursor projektu znajduje się na prawo od klipu.

Tworzenie zdarzeń z zakresów wyboru
Możesz utworzyć nowe zdarzenie zawierające tylko wybrany zakres.

PROCEDURA
1. Wybierz zakres.
2. Przeciągnij zakres zaznaczenia do ścieżki audio w oknie Project. 

POWIĄZANE LINKI
Wybór zakresu na stronie 522.

Tworzenie klipów z zakresów wyboru
Możesz utworzyć nowy klip zawierający tylko wybrany zakres.

PROCEDURA
1. Wybierz zakres.
2. Kliknij wybrany zakres i wybierz Audio > Bounce Selection (Audio > Wybór odbicia).
3. Wykonaj jedną z następujących czynności:
         ● Kliknij Replace (Zastąp), jeśli chcesz zastąpić oryginał.
         ● Kliknij No (Nie), jeśli chcesz zachować oryginał.

WYNIK
Otworzy się nowe okno Sample Editor (Edytora sampli) z nowym klipem. Odnosi się do tego 
samego pliku audio, co oryginalny klip, ale zawiera dźwięk odpowiadający tylko wybranemu 
zakresowi
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Tworzenie ścieżek samplera z zakresów wyboru
Możesz utworzyć ścieżkę samplera zawierającą tylko wybrany zakres.

PROCEDURA
1. Wybierz zakres.
    Jeśli nie wybierzesz żadnego zakresu, używany będzie początek/koniec zdarzenia.
2. Otwórz sekcję Range (Zakres) w Sample Editor Inspector (Inspektorze edytora próbek).
3. Kliknij opcję Create Sampler Track (Utwórz ścieżkę samplera).

WYNIK
Zostanie utworzona nowa ścieżka samplera i dodana do listy ścieżek. Nowa ścieżka samplera 
zawiera wybór zakresu.

Menu edycji dla zakresów wyboru
Możesz edytować zakresy wyboru.

● Aby edytować zakres wyboru, otwórz sekcję Process (Przetwarzaj) w Sample Editor Inspector  
(Inspektorze edytora próbek) i wybierz jedną z funkcji menu podręcznego Basic Commands. 
(Polecenia podstawowe).

UWAGA
Jeśli edytujesz zakresy zdarzeń, które są kopiami udostępnionymi, pojawi się pytanie, czy chcesz 
utworzyć nową wersję klipu. Wybierz New Version (Nowa wersja), jeśli chcesz edytować 
zdarzenie, wybierz Continue (Kontynuuj), jeśli wszystkie udostępnione kopie mają być edytowane.

Dostępne są następujące opcje:

Cut (Wytnij)
         Wycina wybrany zakres z klipu i zapisuje go w schowku. Sekcja po prawej stronie zakresu 
         jest przesuwana w lewo, aby wypełnić lukę.
Copy (Kopiuj)
         Kopiuje wybrany zakres do schowka.
Paste (Wklej)
         Zastępuje wybrany zakres danymi ze schowka.
Delete (Usuń)
        Usuwa wybrany zakres z klipu. Sekcja po prawej stronie zakresu jest przesuwana w lewo, aby 
        wypełnić lukę.
Insert Silence (Wstaw Ciszę)
        Wstawia cichą sekcję o tej samej długości co bieżący wybór zakresu na początku zaznaczenia. 
        Wybrany zakres nie jest zastępowany, ale przesuwany w prawo.
Event or Range as Region (Zdarzenie lub zakres jako region)
        Tworzy region z wybranego zakresu.
Make Direct Offline Processing Permanent (Ustaw bezpośrednie przetwarzanie offline na stałe)
        Umożliwia trwałe zastosowanie całego przetwarzania offline do audio.

POWIĄZANE LINKI
Udostępnione kopie na stronie 219
Trwałe stosowanie przetwarzania offline na stronie 488
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Bezpośrednie przetwarzanie offline dla zakresów
Do zakresów zaznaczenia można zastosować efekty wtyczek i procesy dźwiękowe.

● Aby zastosować efekt wtyczki lub proces audio do zaznaczonego zakresu, otwórz sekcję Process 
(Przetwarzaj) w Sample Editor Inspector (Inspektorze edytora próbek) i wybierz jedną z opcji w 
wyskakującym menu Add Plug-in (Dodaj wtyczkę) lub w wyskakującym okienku Add Process 
(Dodaj proces).

UWAGA
Jeśli zastosujesz przetwarzanie offline do zakresów zdarzeń, które są kopiami udostępnionymi, 
pojawi się pytanie, czy chcesz utworzyć nową wersję klipu. Wybierz New Version (Nowa wersja), 
jeśli chcesz edytować zdarzenie, wybierz Continue (Kontynuuj), jeśli wszystkie udostępnione 
kopie mają być edytowane.

POWIĄZANE LINKI
Bezpośrednie przetwarzanie w trybie offline na stronie 475
Stosowanie przetwarzania na stronie 480
Udostępnione kopie na stronie 219

Lista regionów
Regiony to sekcje w klipie audio, które umożliwiają zaznaczenie ważnych sekcji w pliku audio. 
Możesz dodawać i edytować regiony dla wybranego klipu audio w strefie regionów.

● Aby pokazać lub ukryć Regions (Regiony), kliknij Set up Window Layout (Ustaw układ okien) 
na pasku narzędzi i aktywuj lub dezaktywuj Regions (Regiony). .

       

Dostępne są następujące kontrolki:
1   Region Start/Region End (Początek regionu/Koniec regionu)
          Pokazuje początek i koniec regionu w przebiegu audio.
2   Add Region (Dodaj region)
          Umożliwia utworzenie regionu z bieżącego zaznaczenia zakresu.
3   Remove Region (Usuń region)
          Umożliwia usunięcie wybranego regionu.
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4   Select Region (Wybierz Region)
          Jeśli wybierzesz region na liście i klikniesz ten przycisk powyżej, odpowiednia sekcja klipu 
          audio zostanie zaznaczona (tak jakbyś wybrał ją za pomocą narzędzia Range Selection 
          (Zaznaczanie zakresu)) i powiększona. Jest to przydatne, jeśli chcesz zastosować 
          przetwarzanie tylko do regionu.
5   Play Region (Graj Region)
          Odtwarza wybrany region.
6   Regions list (Lista regionów)
          Umożliwia wybieranie i wyświetlanie regionów w przebiegu audio.

Tworzenie regionów

WARUNEK WSTĘPNY
Kliknąłeś Set up Window Layout (Ustaw układ okien) na pasku narzędzi i aktywowałeś Regions 
(Regiony).

PROCEDURA
1. Na pasku narzędzi Sample Editor (Edytor sampli) aktywuj narzędzie Range Selection (Wybór  
    zakresu) i na ekranie przebiegu wybierz zakres, który chcesz przekonwertować na region.
2. Wykonaj jedną z następujących czynności:
         ● Nad listą regionów kliknij Add Region (Dodaj region).
         ● Wybierz Audio > Advanced > Event or Range as Region (Audio > Zaawansowane > 
Zdarzenie lub Zakres jako Region). Tworzony jest region odpowiadający wybranemu zakresowi.
3. Opcjonalne: Kliknij dwukrotnie nazwę regionu na liście i wprowadź nową nazwę.
 
WYNIK
Region zostanie dodany do listy regionów.

PO WYKONANIU TEGO ZADANIA
Kliknij region na liście regionów, aby natychmiast wyświetlić go w Sample Editor (Edytorze 
próbek).

POWIĄZANE LINKI
Tworzenie regionów na stronie 537

Tworzenie regionów z punktów hitowych
Możesz tworzyć regiony z punktów hitowych. Jest to przydatne do izolowania określonych 
dźwięków.

WARUNEK WSTĘPNY
Zdarzenie dźwiękowe, z którego chcesz utworzyć regiony, jest otwierane w Samplee Editor 
(Edytorze próbek), a punkty hitowe są ustawiane we właściwych miejscach

PROCEDURA
● W sekcji Hitpoints (Punkty hitowe) Sample Editor Inspector (Inspektora Edytora Próbek) 
kliknij Create Regions (Utwórz Regiony)
WYNIK
Regiony są tworzone między dwoma punktami hitowymi i wyświetlane w Sample Editor.

Dostosowywanie pozycji początkowej i końcowej regionów
WARUNEK WSTĘPNY
Kliknąłeś Set up Window Layout (Ustaw układ okien) na pasku narzędzi i aktywowałeś Regions. 
Utworzyłeś regiony. 
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PROCEDURA
● Wykonaj jedną z następujących czynności:
         ● Przeciągnij uchwyt Region Start (początku regionu) lub Region End (końca regionu) w 
            inne miejsce na ekranie przebiegu.
         ● Kliknij dwukrotnie pole Start (Początek) lub End (Koniec) na liście regionów i wprowadź 
            nową wartość.

UWAGA
Pozycje są wyświetlane w formacie wyświetlania wybranym dla linijki i linii informacyjnej, ale 
odnoszą się do początku klipu audio.

Usuwanie regionów

WARUNEK WSTĘPNY
Kliknąłeś Set up Window Layout (Ustaw układ okien) na pasku narzędzi i aktywowałeś Regions 
(Regiony). Utworzyłeś regiony.

PROCEDURA
1. Na liście regionów wybierz region, który chcesz usunąć.
2. Nad listą regionów kliknij opcję Remove Region (Usuń region).

WYNIK
Region zostanie usunięty z listy regionów. 

Tworzenie zdarzeń audio z regionów
Możesz tworzyć nowe wydarzenia audio z regionów za pomocą przeciągania i upuszczania.

WARUNEK WSTĘPNY
Kliknąłeś Set up Window Layout (Ustaw układ okien) na pasku narzędzi i aktywowałeś Regions 
(Regiony). Utworzyłeś regiony.

PROCEDURA
1. Wybierz region z listy regionów.
2. Przeciągnij region do żądanej pozycji w oknie Project.

WYNIK
Zdarzenie jest tworzone z regionu.

Snap Point (Punkt przyciągania)
Punkt przyciągania to znacznik w zdarzeniu dźwiękowym, którego można użyć jako punktu 
odniesienia.

● Aby wyświetlić punkt przyciągania, aktywuj opcję Show Audio Event (Pokaż zdarzenie audio) 
na pasku narzędzi.

Punkt przyciągania jest ustawiany na początku zdarzenia dźwiękowego, ale można go przenieść w 
inne odpowiednie miejsce w audio.
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Punkt przyciągania jest używany, gdy funkcja Snap (Przyciąganie) jest aktywna i wstawiasz klip 
z Samp[le Editor (Edytora sampli) do ekranu zdarzenia. Jest również używany podczas 
przenoszenia lub kopiowania zdarzeń na ekranie zdarzeń.

W Sample Editor (Edytorze próbek) można edytować następujące punkty przyciągania:

●   Event Snap Point (Punkt przyciągania zdarzenia)
     Jest to widoczne w edytorze próbek, jeśli otworzysz klip z poziomu okna Project.
●   Clip Snap Point (Punkt przyciągania klipu)
     Jest to widoczne w edytorze próbek, jeśli otworzysz klip z Pool (puli).

UWAGA
Punkt przyciągania klipu służy jako szablon punktu przyciągania zdarzenia. Jednak to punkt 
przyciągania jest brany pod uwagę podczas przyciągania.

WAŻNE
Gdy ustawisz początek siatki w sekcji Definition (Definicja), punkt przyciągania zostanie 
przesunięty na początek siatki.

POWIĄZANE LINKI
Pasek narzędzi edytora próbek na stronie 511

Regulacja punktu przyciągania

WARUNEK WSTĘPNY
Zdarzenie audio jest otwierane w Sample Editor (Edytorze próbek), a na pasku narzędzi 
aktywowana jest opcja Show Audio Event (Pokaż zdarzenie audio).

PROCEDURA
1. Opcjonalnie: Na pasku narzędzi Sample Editor wybierz narzędzie Scrub (Szoruj). Pozwala to 
na odsłuchiwanie dźwięku podczas ustawiania punktu przyciągania.
2. Przesuń wskaźnik myszy nad punkt przyciągania i przeciągnij go do żądanej pozycji w zdarzeniu
audio.
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Wskaźnik myszy zmieni się w symbol dłoni, a podpowiedź wskazuje, że można ustawić punkt 
przyciągania.

WYNIK
Punkt przyciągania zdarzenia zostanie dostosowany do pozycji, w której został przeciągnięty.          

                             

UWAGA
Możesz także dostosować punkt przyciągania, ustawiając kursor projektu w żądanej pozycji 
I wybierając Audio > Snap Point to Cursor (Audio > Przyciągnij punkt do kursora).
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Hitpoints (punkty hitowe)

Punkty hitowe oznaczają muzycznie istotne pozycje w plikach audio. Cubase może wykrywać te 
pozycje i automatycznie tworzyć punkty hitowe, analizując początki i zmiany melodyczne dźwięku.

UWAGA
Wszystkie operacje na punkcie hitowym można wykonać w oknie Sample Editor (Edytora próbek)
oraz w edytorze dolnej strefy.

Gdy dodasz plik audio do swojego projektu poprzez nagranie lub import, Cubase automatycznie 
wykryje punkty hitowe. W oknie projektu pokazane są punkty hitowe dla wybranego zdarzenia, pod
warunkiem, że współczynnik powiększenia jest wystarczająco wysoki.

Funkcje punktów hitowych są dostępne w sekcji Hitpoints (punkty hitowe) w Sample Editor 
(Edytorze próbek).

Możesz użyć punktów hitowych do następujących celów:

● Tworzenia wycinków audio
    Plasterki umożliwiają zmianę tempa i synchronizacji dźwięku bez wpływu na jego wysokość i 
    jakość, a także zastąpienie lub wyodrębnienie poszczególnych dźwięków z pętli.
● Kwantyzacji dźwięku
● Wyodrębnienia rowka z dźwięku 
    Taktowanie jest wyodrębniane z dźwięku i tworzona jest mapa rowków. Możesz użyć tej mapy  
    rowków do kwantyzacji innych zdarzeń.
● Tworzenia znaczników z materiału audio
● Tworzenia regionów z audio
● Tworzenia zdarzenia z audio
● Tworzenia znaczników zniekształcenia z audio
● Tworzenia nut MIDI z audio

UWAGA
Punkty hitowe działają najlepiej w przypadku bębnów, nagrań rytmicznych lub pętli.

Obliczanie punktów hitowych
Gdy dodasz plik audio do swojego projektu poprzez nagranie lub import, Cubase automatycznie 
wykryje punkty hitowe.

PROCEDURA
1. Zaimportuj lub nagraj plik audio.
    Cubase automatycznie wykrywa punkty hitowe.

UWAGA
Jeśli plik audio jest bardzo długi, może to chwilę potrwać.

2. Wybierz zdarzenie audio w oknie Project i upewnij się, że współczynnik powiększenia jest 
wystarczająco wysoki.

WYNIK
Obliczone punkty życia dla wybranego zdarzenia są pokazane w oknie Project.
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UWAGA
Możesz wyłączyć automatyczne wykrywanie punktów hitowych, dezaktywując opcję Enable 
Automatic Hitpoint Detection (Włącz automatyczne wykrywanie punktów hitowych) w oknie 
dialogowym Preferences (Preferencje) ( Editing (Edycja) — strona Audio).

Filtry punktów hitowych w sekcji Hitpoints (punkty hitowe)
Cubase automatycznie wykrywa i filtruje punkty hitowe. Jeśli jednak wynik nie spełnia Twoich 
oczekiwań, możesz ręcznie filtrować punkty hitowe.

● Aby filtrować punkty hitowe, otwórz zdarzenie dźwiękowe w Sample Editor (Edytorze próbek) 
   i otwórz sekcję Hitpoints (Punkty hitowe).

          

Threshold (Próg)
Filtruje punkty hitowe według ich wartości szczytowych. Przeciągnij suwak w prawo, aby na 
przykład odrzucić punkty trafień cichszych sygnałów przesłuchowych.
Intensity (Intensywność)
Filtruje punkty hitowe według ich intensywności. Przeciągnij suwak w prawo, aby odrzucić mniej 
intensywne punkty hitowe.
Minimum Length (Minimalna długość)
Filtruje punkty hitowe według odległości między dwoma punktami hitowymi. Ta opcja pozwala 
uniknąć tworzenia zbyt krótkich plasterków. 
Beats (Uderzenia)
Filtruje punkty hitowe według ich muzycznej pozycji. Ta opcja pozwala odrzucić punkty hitowe, 
które nie mieszczą się w określonym zakresie określonej wartości rytmu.

Ręczna edycja punktów hitowych

Kluczowe dla dalszej edycji jest ustawienie punktów hitowych we właściwych miejscach. Dlatego 
jeśli automatyczne wykrywanie punktów hitowych nie spełnia Twoich oczekiwań, możesz ręcznie 
edytować punkty hitowe.

WARUNEK WSTĘPNY
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Zdarzenie audio jest otwierane w Sample Editor (Edytorze próbek), a w sekcji Hitpoints (Punkty 
hitowe) punkty hitowe są filtrowane według szczytu i/lub intensywności, odległości lub pozycji 
muzycznej.

PROCEDURA
1. W sekcji Hitpoints (Punkty hitowe) w Sample Editor Inspector aktywuj narzędzie Edit 
Hitpoints (Edytuj punkty hitowe).

            
2. Przesuń mysz do ekranu krzywej i kliknij pomiędzy dwoma punktami hitowymi.
Wskaźnik myszy zmieni się w ikonę głośnika i zostanie wyświetlona podpowiedź Play back Slice 
(Odtwórz plasterek). Odcinek jest odtwarzany od początku do końca.

         
3. Aby wyłączyć punkt hitowy, którego nie potrzebujesz, naciśnij klawisz Shift i kliknij linię 
reprezentującą punkt hitowy.
Wskaźnik myszy zmieni się w ikonę krzyżyka i pojawi się podpowiedź Disable Hitpoints (Wyłącz 
punkty hitowe). Wyłączone punkty hitowe nie są brane pod uwagę w dalszych operacjach.

        
4. Naciśnij Tab, aby przejść do następnego wycinka. Plasterek jest odtwarzany automatycznie.
5. Aby wstawić punkt hitowy, naciśnij Alt/Opt i kliknij miejsce, w którym chcesz go wstawić
   punkt hitowy. Wskaźnik myszy zmieni się w ikonę rysowania i pojawi się podpowiedź Insert  
   Hitpoint (Wstaw punkt hitowy).
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6. Aby przesunąć punkt hitowy, przesuń wskaźnik myszy na pionową linię reprezentującą punkt   
   hitowy i przeciągnij w lewo lub w prawo.

    Wskaźnik myszy zmieni się w podwójną strzałkę i pojawi się podpowiedź Move Hitpoint 
    (Przenieś punkt hitowy). Przeniesione punkty hitowe są domyślnie zablokowane.
7. Aby upewnić się, że punkt hitowy nie zostanie przypadkowo odfiltrowany, zablokuj go,  
   wskazując go i klikając.
   Wyświetlana jest etykieta narzędzia Lock Hitpoint (Zablokuj punkt hitowy).

WYNIK
Punkty hitowe są edytowane zgodnie z twoimi ustawieniami.

UWAGA
Aby zresetować punkt hitowy do pierwotnego stanu, naciskaj Ctrl/Cmd -Alt/Opt, aż pojawi się 
etykieta Enable/Unlock Hitpoints (Włącz/Odblokuj punkty hitowe), a następnie kliknij.

POWIĄZANE LINKI
Filtry punktów hitowych w sekcji Hitpoints (punktów hitowych) na stronie 532

Lokalizowanie punktów hitowych w oknie Project.
Możesz przeglądać punkty hitowe zdarzenia audio w oknie Project.

WARUNEK WSTĘPNY
Opcja Enable Automatic Hitpoint Detection (Włącz automatyczne wykrywanie punktów 
hitowych) jest aktywowana w oknie dialogowym Preferences (Preferencje) (Editing (Edycja) — 
strona Audio).

PROCEDURA
1. Wybierz ścieżkę dźwiękową zawierającą zdarzenie audio, dla którego chcesz zlokalizować 
    punkty hitowe.
2. Wykonaj jedną z następujących czynności:
         ● Naciśnij Alt/Opt - N, aby przejść do następnego punktu hitowego.
         ● Naciśnij Alt/Opt -B, aby przejść do poprzedniego punktu hitowego.

WYNIK
Kursor projektu przeskakuje do odpowiedniego punktu hitowego.

Slices (Plastry)
Możesz tworzyć plasterki z punktów hitowych, gdzie każdy plaster idealnie reprezentuje 
indywidualny dźwięk lub rytm audio.

Możesz użyć tych plasterków, aby zmienić tempo i synchronizację dźwięku bez wpływu na jego 
wysokość i jakość.

UWAGA
Plasterki są tworzone w Sample Editor (Edytorze sampli) i edytowane w Audio Part Editor 
(Edytorze części audio).

Odpowiedni jest dźwięk, który spełnia następujące cechy:
   
● Poszczególne dźwięki mają zauważalny atak.
● Jakość nagrania jest dobra.
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● Nagranie jest wolne od przesłuchów.
● Dźwięk jest wolny od efektów smużenia, takich jak na przykład opóźnienia.

Slicing Audio (Krojenie audio)
Dzielenie dźwięku jest przydatne, jeśli chcesz zmienić tempo i synchronizację dźwięku bez wpływu
na jego wysokość i jakość.

WARUNEK WSTĘPNY
Zdarzenie audio jest otwierane w Sample Editor (Edytorze próbek), a punkty hitowe są ustawiane 
we właściwych miejscach.

UWAGA
Podczas dzielenia dźwięku wszystkie zdarzenia odnoszące się do edytowanego klipu są również 
zastępowane.

PROCEDURA
● Wykonaj jedną z następujących czynności:
       ● W sekcji Hitpoints (Punkty hitowe) w Sample Editor Inspector (Inspektor edytora próbek),
          kliknij Create Slices (Utwórz wycinki).
       ● Wybierz Audio > Hitpoints > Create Audio Slices from Hitpoints (Audio > Punkty hitowe
           > Utwórz wycinki audio z punktów hitowych).

WYNIK
Obszary między punktami hitowymi są dzielone i stają się oddzielnymi zdarzeniami. Oryginalne 
zdarzenie audio jest zastępowane przez część audio zawierającą wycinki.

                             
Podczas odtwarzania, audio jest odtwarzane płynnie w tempie projektu.

PO WYKONANIU TEGO ZADANIA
Zmień tempo projektu. Plasterki (wycinki) są odpowiednio przesuwane, zachowując ich względne 
pozycje w części.
Kliknij dwukrotnie wyciętą część audio i zastąp lub wyodrębnij poszczególne plasterki w Audio 
Part Editor (Edytorze części audio).

POWIĄZANE LINKI
Plasterki i tempo projektu na stronie 536
Edytor części audio na stronie 574

Krojenie wielościeżkowych nagrań perkusyjnych
Możesz podzielić wszystkie ścieżki wielościeżkowego nagrania perkusyjnego jednocześnie.
WARUNEK WSTĘPNY
Utworzyłeś wielościeżkowe nagranie perkusyjne i skonfigurowałeś grupę edycyjną dla wszystkich 
ścieżek.

PROCEDURA
● Wybierz ścieżkę folderu i wybierz Audio > Hitpoints > Divide Audio Events at Hitpoints 
(Audio > Punkty hitowe > Podziel wydarzenia audio w punktach życia).

WYNIK
Audio wszystkich ścieżek w ścieżce folderu jest dzielone.

541



POWIĄZANE LINKI
Kwantyzacja wielu ścieżek audio na stronie 296
Tryb edycji grupy na stronie 220

Plasterki i tempo projektu
Tempo projektu wpływa na sposób odtwarzania pokrojonego dźwięku.

POWIĄZANE LINKI
Wypełnianie luk na stronie 536
Usuwanie nakładek na stronie 536
Tryb muzyczny na stronie 541
Dokonywanie globalnych ustawień automatycznego zanikania na stronie 317
Konfigurowanie ustawień automatycznego przenikania dla poszczególnych ścieżek na stronie 317

Zamykanie luk
Jeśli tempo projektu jest wolniejsze niż tempo oryginalnego zdarzenia audio, między zdarzeniami 
plasterków w części mogą być słyszalne przerwy. Możesz zamknąć te luki, aby dźwięk był 
odtwarzany bez żadnych przerw.

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Wybierz Audio > Advanced > Close Gaps (Time Stretch) (Audio > Zaawansowane >  
            Zamknij luki (rozciągnięcie czasu)), aby zastosować rozciągnięcie czasu do każdego 
           wycinka i zamknąć luki. Rozważ włączenie automatycznego wyciszania dla odpowiedniej 
           ścieżki audio i ustawienie wyciszenia na 10 s, aby wyeliminować kliknięcia.
        ● Wybierz Audio > Advanced > Close Gaps (Crossfade) (Audio > Zaawansowane > 
            Zamknij luki (przenikanie)), aby zastosować przenikanie do plasterków i zamknąć luki.

PO WYKONANIU TEGO ZADANIA

UWAGA
Jeśli zdecydujesz się ponownie zmienić tempo, cofnij swoje działania i użyj oryginalnego, 
nierozciągniętego pliku.

Usuwanie nakładek
Jeśli tempo projektu jest wyższe niż tempo oryginalnego zdarzenia audio, zdarzenia wycinka w 
części mogą się nakładać. Możesz usunąć te nakładki.

PROCEDURA
1. Kliknij prawym przyciskiem myszy ścieżkę na liście ścieżek i z menu kontekstowego wybierz    
    Auto Fades Settings (Ustawienia automatycznego przenikania).
2. W oknie dialogowym Auto Fades (Automatyczne zanikanie) aktywuj Auto Crossfades 
    (Automatyczne przenikanie).
3. Kliknij OK.
4. Wybierz nakładające się zdarzenia w części i wybierz Audio > Advanced > Delete Overlaps 
    (Audio > Zaawansowane > Usuń nakładki).

WYNIK
Dźwięk jest wygładzony.
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Tworzenie mapy kwantyzacji Groove
Punktów hitowych można użyć do stworzenia mapy kwantyzacji groove.

WARUNEK WSTĘPNY
Zdarzenie audio, z którego chcesz wyodrębnić taktowanie, jest otwierane w Sample Editor 
(Edytorze próbek), a punkty hitowe są ustawiane we właściwych miejscach.

PROCEDURA
● W sekcji Hitpoints (Punkty hitowe) w Sample Editor Inspector (Inspektorze edytora próbek) 
kliknij Create Groove (Utwórz groove („takt”)).

WYNIK
Groove („takt”) jest wyodrębniany ze zdarzenia audio i automatycznie wybierany w wyskakującym 
menu Quantize Presets (Zadane ustawienia kwantyzacji) na pasku narzędzi okna Project.

PO WYKONANIU TEGO ZADANIA
Otwórz Quantize Panel (panel kwantyzacji) i zapisz groove („takt”) jako ustawienie wstępne.

Tworzenie znaczników
Możesz tworzyć znaczniki na pozycjach punktów hitowych. Pozwala to na przyciąganie do pozycji 
punktów hitowych.

WARUNEK WSTĘPNY
Zdarzenie audio, z którego chcesz utworzyć znaczniki, jest otwierane w edytorze próbek, a punkty 
hitowe są ustawiane we właściwych miejscach.

PROCEDURA
● W sekcji Hitpoints (punkty hitowe) w Sample Editor Inspector (Inspektor Edytora Sampli), 
kliknij Create Markers (Utwórz znaczniki).

WYNIK
Jeśli twój projekt nie ma ścieżki znacznika, ścieżka znacznika jest dodawana i aktywowana 
automatycznie, a znacznik jest tworzony w każdej pozycji punktu hitowego.

POWIĄZANE LINKI
Znaczniki na stronie 336

Tworzenie regionów
Możesz tworzyć regiony na pozycjach punktów hitowych. Pozwala to na izolowanie nagranych 
dźwięków.

WARUNEK WSTĘPNY
Zdarzenie audio, z którego chcesz utworzyć regiony, jest otwierane w Sample Editor (Edytorze 
próbek), a punkty hitowe są ustawiane we właściwych miejscach.

PROCEDURA
● W sekcji Hitpoints (Punkty hitowe) w Sample Editor Inspector (Inspektor edytora próbek) 
kliknij Create Regions (Twórz regiony).
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WYNIK
Regiony są tworzone między dwoma punktami hitowymi i wyświetlane w Sample Editor 
(Edytorze próbek).

POWIĄZANE LINKI
Tworzenie regionów na stronie 527

Tworzenie zdarzeń
Możesz tworzyć zdarzenia na pozycjach punktów hitowych.

WARUNEK WSTĘPNY
Zdarzenie audio, z którego chcesz utworzyć zdarzenia, jest otwierane w edytorze próbek, a punkty 
hitowe są ustawiane we właściwych miejscach.

PROCEDURA
● W sekcji Hitpoints (Punkty hitowe) w Sample Editor Inspector (Inspektor edytora próbek), 
kliknij Create Events (Twórz zdarzenia).

WYNIK
Zdarzenia są tworzone między dwoma punktami hitowymi.

Tworzenie znaczników zniekształcenia
Możesz tworzyć znaczniki warp (zniekształcenia) na pozycjach punktów hitowych. Pozwala to na 
kwantyzację audio na podstawie pozycji punktów hitowych.

WARUNEK WSTĘPNY
Zdarzenie audio, z którego chcesz utworzyć znaczniki warp (zniekształcenia), jest otwierane w 
Sample Editor (Edytorze próbek), a punkty hitowe są ustawiane we właściwych miejscach.

PROCEDURA
● W sekcji Hitpoints (Punkty hitowe) w Inspector (Inspektorze) kliknij Create Warp Markers 
(Utwórz znaczniki zniekształcenia).

WYNIK
Znaczniki Warp są tworzone w każdej pozycji punktów hitowych.

PO WYKONANIU TEGO ZADANIA
Otwórz sekcję AudioWarp, aby wyświetlić i edytować znaczniki zniekształcenia.

POWIĄZANE LINKI
Tempo Matching Audio na stronie 540

Tworzenie nut MIDI
Możesz tworzyć nuty MIDI z punktów hitowych. Pozwala to na zdublowanie, zastąpienie lub 
wzbogacenie uderzeń perkusji poprzez wyzwalanie dźwięków instrumentu VST.

WARUNEK WSTĘPNY
Zdarzenie audio, z którego chcesz utworzyć nuty MIDI, jest otwierane w Sample Editor (Edytorze 
próbek), a punkty hitowe są ustawiane we właściwych miejscach.

PROCEDURA
1. W sekcji Hitpoints (Punkty hitowe) w Sample Editor Inspector (Inspektor edytora próbek) 
    kliknij Create MIDI Notes (Utwórz nuty MIDI).
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2. W oknie dialogowym Convert Hitpoints to MIDI Notes (konwertuj punkty hitowe do nut 
    MIDI) skonfiguruj parametry.
3. Kliknij OK.

WYNIK
Ścieżka MIDI jest dodawana do Twojego projektu, a nuty MIDI są tworzone w każdej pozycji 
punktów hitowych.

PO WYKONANIU TEGO ZADANIA
Przypisz instrument VST do ścieżki MIDI i wybierz dźwięk, aby wzbogacić audio.

Okno dialogowe Convert Hitpoints to MIDI Notes (Konwertuj punkty
hitowe na nuty MIDI)
Okno dialogowe Konwertuj punkty hitowe na nuty MIDI umożliwia określenie sposobu konwersji 
punktów hitowych podczas tworzenia nut MIDI z punktów hitowych.

             

Dostępne są następujące opcje:

Velocity Mode (Tryb prędkości)
       Umożliwia wybór trybu dynamiki:
           ● Jeśli chcesz, aby wartości dynamiki tworzonych nut MIDI zmieniały się w zależności od 
              szczytowych poziomów odpowiadających im punktów życia, wybierz Dynamic Velocity 
              (Dynamiczna prędkość).
           ● Jeśli chcesz przypisać tę samą wartość dynamiki wszystkim utworzonym nutom MIDI,  
              wybierz opcję Fixed Velocity (Stała prędkość).

Velocity (Prędkość)
         Ustawia stałą prędkość.
Pitch (Poziom)
         Ustawia wysokość nuty dla wszystkich utworzonych nut MIDI.
Length (Długość)
         Ustawia długość nuty dla wszystkich utworzonych nut MIDI.
Destination (Miejsce docelowe)
        Umożliwia wybór miejsca docelowego:
        ● Aby umieścić partię MIDI na pierwszej wybranej ścieżce MIDI lub instrumentu, wybierz    
           opcję First Selected Track (Pierwsza wybrana ścieżka).

UWAGA
Wszelkie partie MIDI z poprzednich konwersji na tej ścieżce zostaną usunięte.

● Aby utworzyć nową ścieżkę MIDI dla partii MIDI, wybierz New MIDI Track (Nowa ścieżka 
MIDI).
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● Aby skopiować partię MIDI do schowka, wybierz Project Clipboard (Schowek projektu)

Dopasowanie tempa audio

Cubase oferuje kilka funkcji, które pozwalają dopasować tempo audio w projekcie.

W oknie Sample Editor (Edytor sampli) i w edytorze dolnej strefy możesz wykonywać następujące
operacje dopasowywania tempa:

●   Stretch to Project Tempo (Rozciągnij do tempa projektu)
           Rozciąga wybrane wydarzenie, aby dopasować je do tempa projektu.
●   Musical Mode (Tryb muzyczny)
           Stosuje rozciąganie w czasie rzeczywistym do klipów audio, aby dopasować je do tempa     
           projektu.
●   Auto Adjust (Automatyczna regulacja)
          Wyodrębnia zdefiniowaną siatkę z dźwięku. Następnie możesz dopasować dźwięk do
          tempa projektu za pomocą Musical Mode (Trybu muzycznego). 
●   Manual Adjust (Ręczna regulacja)
         Umożliwia ręczną modyfikację siatki i tempa pliku audio. Następnie możesz dopasować  
         dźwięk do tempa projektu, korzystając z Musical Mode (Trybu muzycznego).
●   Free Warp (Swobodne zniekształcenie)
         Umożliwia zmianę taktowania poszczególnych pozycji w audio.

UWAGA
W oknie Project możesz dopasować tempo różnych zdarzeń dźwiękowych za pomocą narzędzia 
Audio Alignment (Wyrównanie audio). Pozwala to na dopasowanie czasu zdarzeń audio na 
różnych ścieżkach.

POWIĄZANE LINKI
Rozciąganie zdarzeń audio do tempa projektu na stronie 541
Tryb muzyczny na stronie 541
Autodopasowanie na stronie 543
Regulacja ręczna na stronie 544
Free Warp na stronie 545
Wyrównywanie audio na stronie 210

Presety algorytmu

Możesz wybrać ustawienie wstępne algorytmu, które jest stosowane do odtwarzania w czasie 
rzeczywistym i rozciągania czasu.

Wyskakujące menu Warping Algorithm for Audio Clip (Algorytm zniekształcania dla klipu 
audio) na pasku narzędzi Sample Editor (Edytor sampli) zawiera różne ustawienia wstępne, które 
określają jakość dźwięku rozciąganego w czasie rzeczywistym.

Te ustawienia wstępne są podzielone na kategorie élastique i Standard zgodnie z zastosowaną 
technologią.
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Ustawienie wstępne algorytmu wpływa na zmiany warp (zniekształceniowe) w Musical Mode 
(Trybie muzycznym), FreeWarp i Swing. W przypadku funkcji Warping i Pitch VariAudio, 
Standard – Solo jest stosowany automatycznie.

POWIĄZANE LINKI
Wstępne ustawienia algorytmu na stronie 540
Algorytmy Time Stretch i Pitch Shift na stronie 499
Wyrównywanie audio na stronie 210

Rozciąganie zdarzeń audio do tempa projektu
Możesz rozciągnąć pętle audio do tempa projektu.

PROCEDURA
1. Wybierz File > Import > Audio File (Plik > Importuj > Plik audio), wybierz pętlę audio, którą 
chcesz zaimportować, i kliknij OK.
2. Wybierz pętlę audio w projekcie.
3. Wybierz kolejno Audio > Advanced > Stretch to Project Tempo (Audio > Zaawansowane > 
Rozciągnij do tempa projektu).

WYNIK
Pętla audio jest rozciągana w celu dopasowania do tempa projektu.

Musical Mode (Tryb muzyczny)
Tryb muzyczny umożliwia dopasowanie tempa pętli audio do tempa projektu.

Jeśli dla klipu audio włączysz Musical Mode (Tryb muzyczny), klip zostanie rozciągnięty w czasie
rzeczywistym, tak aby dopasować go do tempa projektu. Zdarzenia audio dostosowują się do 
wszelkich zmian tempa w Cubase, podobnie jak zdarzenia MIDI.

W Sample Editor (Edytorze próbek) możesz aktywować Musical Mode w sekcji AudioWarp, 
sekcji Definition (Definicja) i na pasku narzędzi.

UWAGA
● Możesz także włączyć/wyłączyć tryb muzyczny z poziomu Pool (puli), klikając
odpowiednie pole wyboru w kolumnie Musical Mode (Tryb muzyczny).
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● Cubase obsługuje pętle ACID®. Te pętle to standardowe pliki audio, ale z osadzoną informacją o 
tempie/długości. Kiedy pliki ACID® zostaną zaimportowane do Cubase, tryb muzyczny zostanie 
automatycznie aktywowany, a pętle dostosują się do tempa projektu.

Dopasowywanie audio do tempa projektu
Możesz użyć Musical Mode (trybu muzycznego), aby dostosować pętle audio do tempa projektu. 
Pętle to krótkie pliki audio posiadające określoną liczbę taktów.

PROCEDURA
1. Wybierz opcję File > Import > Audio File (Plik > Importuj > Plik audio) i wybierz pętlę audio  
    w oknie dialogowym pliku.
2. W oknie Project kliknij dwukrotnie zaimportowaną pętlę audio, aby otworzyć ją w Sample 
    Editor (Edytorze próbek).
3. Otwórz sekcję Definition (Definicja) i sprawdź linijki.
    Siatka tempa projektu pokazana na górnej linijce i siatka dźwięku pokazana na dolnej linijce nie 
    pasują do siebie.

             
4. Na pasku narzędzi sprawdź, czy długość w taktach odpowiada długości importowanego
    plik audio. Jeśli to konieczne, posłuchaj dźwięku i wprowadź odpowiednią długość w taktach i 
    uderzeniach.
5. Na pasku narzędzi otwórz wyskakujące menu Algorithm (Algorytm) i wybierz ustawienie 
    wstępne.
6. Posłuchaj pętli i jeśli to konieczne, popraw wartości bars (taktów) i beats (uderzeń) na pasku  
    narzędzi.
7. Aktywuj Musical Mode (Tryb muzyczny).

WYNIK
Pętla jest zniekształcana i rozciągana do tempa projektu. Linijki odzwierciedlają tę zmianę. W 
oknie Project zdarzenie audio wyświetla symbol nuty i symbol zniekształcenia. Oznacza to, że 
zastosowano rozciąganie czasu.

POWIĄZANE LINKI
Wstępne ustawienia algorytmu na stronie 540

Stosowanie Swing (swingu)
Funkcja Swing umożliwia dodanie swingu do dźwięku, który brzmi zbyt prosto.

WARUNEK WSTĘPNY
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Otworzyłeś plik audio w Sample Editor (Edytorze próbek) i aktywowano Musical Mode (Tryb 
muzyczny).

PROCEDURA
1. Na pasku narzędzi otwórz wyskakujące menu Algorithm i wybierz ustawienie wstępne.
2. Otwórz sekcję AudioWarp (Automatyczne zniekształcenie) i z wyskakującego menu Resolution
(Rozdzielczość) wybierz rozdzielczość siatki.
Określa pozycje, do których stosuje się (swing) wahanie. Jeśli wybierzesz 1/2, swing będzie 
stosowany na przykład w krokach półnutowych.

             

3. Przesuń suwak Swing w prawo.

WYNIK
To przesuwa pozycje siatki i tworzy wrażenie swingu lub shuffle. Jeśli wybrałeś 1/2, co
druga pozycja w siatce jest przesunięta.

Auto Adjust (Automatyczne dopasowanie)
Funkcja Auto Adjust (Automatycznej regulacji) jest przydatna, jeśli nie znasz tempa pliku audio 
lub jeśli rytm nie jest prosty. Pozwala wyodrębnić siatkę definicji z audio. Następnie możesz 
dostosować tempo pliku do tempa projektu za pomocą Musical Mode (Trybu muzycznego).

Funkcja Auto Adjust wyodrębnia lokalną siatkę definicji, którą można dopasować do tempa 
projektu w Musical Mode (Trybie muzycznym).

POWIĄZANE LINKI
Musical Mode (Tryb muzyczny) na stronie 541

Wyodrębnianie siatki definicji tempa z audio
Jeśli masz plik audio o nieznanym tempie lub rytmie, który nie jest prosty i chcesz dopasować go 
do tempa projektu, musisz najpierw wyodrębnić siatkę definicji tempa. Odbywa się to za pomocą 
funkcji Auto Adjust (automatycznej regulacji) w sekcji Definition (Definicja) Sample Editor 
(Edytora próbek).

WARUNEK WSTĘPNY
Zdefiniowałeś zakres w klipie audio lub zdarzeniu, który zaczyna się i kończy na linii taktowej.

PROCEDURA
1. Kliknij dwukrotnie klip audio lub zdarzenie w oknie Project, aby otworzyć je w Sample Editor 
    (Edytorze próbek).
2. Otwórz sekcję Definition (Definicja) i wybierz wartość z wyskakującego menu Grid (Siatka).   
    Określa to rozdzielczość siatki dla Twojego audio.
3. Za pomocą narzędzia Range Selection (Zaznaczanie zakresu) wybierz sekcję, którą chcesz 
    wykorzystać w swoim projekcie i która obejmuje jeden lub kilka taktów.
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UWAGA
Jeśli nie wybierzesz zakresu, siatka zostanie obliczona dla zdarzenia audio. Jeśli nie zdefiniowano 
żadnego zdarzenia audio, dla klipu obliczana jest siatka. Upewnij się, że zdarzenie lub klip zaczyna 
się i kończy na linii taktowej.

4. Kliknij opcję Auto Adjust (Automatyczna regulacja).

WYNIK
Siatka definicji jest obliczana dla wybranego przekroju. Punkt przyciągania przesuwa się na 
początek wybranego zakresu. Linijka definicji tempa dźwięku zmienia się, aby odzwierciedlić 
wprowadzone zmiany, a pozycje taktów i uderzeń są oznaczone pionowymi liniami.

Manual Adjust (Ręczna regulacja)
Funkcja Manual Adjust jest przydatna, jeśli chcesz ręcznie zmodyfikować siatkę i tempo pliku 
audio. Dzieje się tak w przypadku, gdy np. wydobycie siatki definicji za pomocą funkcji Auto 
Adjust (Automatyczne Dopasowanie) nie przyniosło zadowalających rezultatów.

Funkcja Manual Adjust umożliwia korektę lokalnej siatki definicji. Następnie możesz dopasować 
je do tempa projektu, korzystając z Musical Mode (Trybu muzycznego).

POWIĄZANE LINKI
Musical Mode (Tryb muzyczny) na stronie 541

Poprawianie siatki definicji audio
Jeśli wyodrębnienie siatki definicji za pomocą funkcji Auto Adjust (Automatyczne Dopasowanie) 
nie przyniosło zadowalających rezultatów, możesz skorygować siatkę i tempo pliku audio za 
pomocą funkcji Manual Adjust (Dopasowania ręcznego).

PROCEDURA
1. Kliknij dwukrotnie klip audio lub zdarzenie w oknie Project, aby otworzyć je w Sample Editor 
    (Edytorze próbek).
2. Otwórz sekcję Definition (Definicja) i aktywuj Manual Adjust (Dopasowanie ręczne).
3. Przesuń wskaźnik myszy na początek klipu audio. Zostanie wyświetlona podpowiedź Set Grid  
    Start (Ustaw początek siatki), a wskaźnik myszy zmieni się w podwójną strzałkę

                    
4. Kliknij i przeciągnij w prawo aż do pierwszego uderzenia, a następnie zwolnij przycisk myszy. 
    Odpowiada to początkowi siatki i punktowi przyciągania z pierwszym głównym rytmem. Linijka
    definicji tempa dźwięku zmienia się, odzwierciedlając wprowadzone zmiany.
5. W górnej części przebiegu przesuń wskaźnik myszy do pionowej linii najbliższej drugiej kreski. 
    Wyświetlona zostanie podpowiedź Stretch Grid (Rozciągnij siatkę) i niebieską pionową linię.
6. Kliknij i przeciągnij do pozycji pierwszego taktu w drugim takcie i zwolnij przycisk myszy.
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    Ustawia to początek następnego taktu. Wszystkie kolejne pozycje taktów w siatce są rozciągane 
    lub ściskane, tak aby wszystkie takty miały tę samą długość.

             

7. W dolnej części przebiegu przesuń wskaźnik myszy nad liniami siatki.
    Wyświetlana jest podpowiedź Set Bar Position (Move Following Bars) (Ustaw pozycję taktu   
    (Przesuń kolejne takty)) i zielona pionowa linia.
8. W przypadku nieprawidłowej pozycji taktu kliknij i przeciągnij zieloną pionową linię do pozycji 
    pierwszego taktu kolejnego taktu i zwolnij przycisk myszy.
    Spowoduje to również przesunięcie taktów w prawo. Obszar po lewej stronie pozostaje  
    nienaruszony.

             

9. Przesuń wskaźnik myszy nad liniami siatki dla pojedynczych uderzeń.
    Wyświetlona zostanie podpowiedź Set Beat Position (Ustaw pozycję rytmu) i niebieska pionowa
    linia.
10. Kliknij i przeciągnij linię siatki, aby wyrównać pojedyncze, nieprawidłowe pozycje uderzeń, a 
      następnie zwolnij przycisk myszy.

              

UWAGA
Możesz usunąć źle umieszczone edycje rytmu, naciskając dowolny klawisz modyfikujący i klikając
narzędzie Erase (Usuń).

WYNIK
Siatka definicji została poprawiona, linijka definicji tempa dźwięku odzwierciedla wprowadzone 
zmiany.

PO WYKOŃCZENIU TEGO ZADANIA
Aktywuj Musical Mode (Tryb muzyczny).

Free Warp (Wolne zniekształcenie)
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Narzędzie Free Warp umożliwia korektę taktowania poszczególnych pozycji w materiale audio.
Możesz tworzyć i edytować znaczniki zniekształcenia oraz przeciągać je do odpowiednich 
muzycznie pozycji czasowych w zdarzeniu audio. W ten sposób dźwięk przed i po znaczniku 
zniekształcenia zostanie rozciągnięty. Stopień rozciągnięcia jest pokazany obok uchwytu znacznika 
zniekształcenia.

               

Współczynnik rozciągnięcia większy niż 1,0 wskazuje, że dźwięk poprzedzający znacznik 
zniekształcenia jest rozciągnięty, współczynnik rozciągnięcia mniejszy niż 1,0 oznacza, że dźwięk 
jest skompresowany.

UWAGA
Narzędzie Free Warp (Wolne zniekształcenie) przyciąga do pozycji punktów hitowych 
i znaczników zniekształcenia.

Korygowanie synchronizacji za pomocą narzędzia Free Warp

PROCEDURA
1. Kliknij dwukrotnie klip audio lub zdarzenie w oknie Project, aby otworzyć je w Sample Editor 
    (Edytorze próbek).
2. Na pasku narzędzi aktywuj Snap to Zero Crossing (Przyciągaj do przejścia przez zero).
    Jeśli ten przycisk jest aktywny, znaczniki zniekształcenia przyciągają się do przejść przez zero.
3. Opcjonalnie: Jeśli chcesz skorygować synchronizację poszczególnych pozycji w audio, zdefiniuj 
    lokalną definicję za pomocą funkcji Auto Adjust (automatycznej regulacji) lub Manual Adjust 
    (ręcznej regulacji) i aktywuj Musical Mode (tryb muzyczny).
4. Na panelu Transport aktywuj opcję Click (Kliknij) i odtwórz dźwięk, aby określić pozycje
    gdzie rytm nie jest zgodny z kliknięciem.
5. W sekcji AudioWarp aktywuj Free Warp, umieść wskaźnik myszy w miejscu rytmu, który   
    chcesz dostosować, kliknij i przytrzymaj. Wskaźnik myszy zmieni się w zegar ze strzałkami i  
    zostanie wstawiony znacznik zniekształcenia.
6. Przeciągnij znacznik zniekształcenia do nowej pozycji i zwolnij przycisk myszy.

WYNIK
Rytm jest teraz wyrównany z odpowiednią pozycją w projekcie.

POWIĄZANE LINKI
Auto Adjust (Autodopasowanie) na stronie 543
Manual Adjust (Regulacja ręczna) na stronie 544
Tryb muzyczny na stronie 541
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Korygowanie pozycji znaczników zniekształcenia

PROCEDURA
1. W sekcji AudioWarp aktywuj Free Warp.
2. W Sample Editor (Edytorze próbek) kliknij uchwyt znacznika wypaczenia i przeciągnij go w 
nowe położenie.

             

Wyświetlana jest podpowiedź wskazująca, że można przeciągnąć, aby skorygować położenie 
znacznika zniekształcenia.

WYNIK
Znacznik wypaczenia zostanie przesunięty do nowej pozycji, a dźwięk zostanie odpowiednio 
rozciągnięty lub skompresowany.

Usuwanie znaczników zniekształcenia

PROCEDURA
1. W sekcji AudioWarp aktywuj Free Warp.
2. Przytrzymaj klawisz Alt/Opt i kliknij znacznik wypaczenia, który chcesz usunąć.

UWAGA
Aby usunąć kilka znaczników, narysuj prostokąt zaznaczenia.

WYNIK
Znacznik zniekształcenia zostanie usunięty z przebiegu.

Resetowanie znaczników zniekształcenia

PROCEDURA
● W sekcji AudioWarp kliknij Reset Warp Changes (Resetuj zmiany zniekształcenia).

WYNIK
Znaczniki zniekształcenia zostaną usunięte z przebiegu, a zmiany wprowadzone w przebiegu 
zniekształcenia zostaną zresetowane.

UWAGA
Jeśli Musical Mode (Tryb muzyczny) jest aktywowany, resetowane są tylko modyfikacje Free 
Warp (wolne zniekształcenie).

Spłaszczanie (Flattening) przetwarzania w czasie 
rzeczywistym
Możesz spłaszczyć modyfikacje zniekształcenia. Jest to przydatne, jeśli chcesz zmniejszyć 
obciążenie procesora, zoptymalizować jakość dźwięku podczas przetwarzania lub zastosować 
przetwarzanie offline.
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PROCEDURA
1. Wybierz zdarzenia audio, które chcesz przetworzyć.
2. Wykonaj jedną z następujących czynności:
      ● Wybierz opcję Audio > Realtime Processing > Flatten Realtime Processing (Audio >  
         Przetwarzanie w czasie rzeczywistym > Spłaszcz przetwarzanie w czasie rzeczywistym).
     ● W sekcji Process (Przetwarzanie) Sample Editor (Edytora próbek) kliknij Flatten (Spłaszcz).

3. W oknie dialogowym Flatten Realtime Processing (Spłaszcz przetwarzanie w czasie 
    rzeczywistym) wybierz ustawienie wstępne algorytmu.
4. Kliknij OK

WYNIK
Każda pętla, która została wcześniej rozciągnięta w czasie rzeczywistym, jest odtwarzana dokładnie
w ten sam sposób, ale znaczniki zniekształcenia są odrzucane.

POWIĄZANE LINKI
MPEX na stronie 499

Okno dialogowe Flatten Realtime Processing (Spłaszcz przetwarzanie 
w czasie rzeczywistym)
Okno dialogowe Flatten Realtime Processing umożliwia wybranie algorytmu.

● Aby otworzyć okno dialogowe Flatten Realtime Processing, wybierz jedno lub więcej zdarzeń 
audio w oknie Project i wybierz Audio > Realtime Processing > Flatten Realtime Processing.

UWAGA
Ta opcja jest dostępna tylko, jeśli wykonałeś modyfikacje zniekształcenia (warp).

                

Dostępne są następujące opcje:
Algorithm Preset (Wstępnie ustawiony algorytm)
         Umożliwia wybranie ustawienia wstępnego algorytmu.

Rozciąganie plików audio
Możesz usunąć rozciąganie w czasie rzeczywistym ze zdarzeń audio.

WARUNEK WSTĘPNY
Rozciągnięto zdarzenie audio w Sample Editor (Edytorze próbek) za pomocą narzędzia Free 
Warp lub w oknie Project za pomocą narzędzia Object Selection (Zaznaczanie obiektu) w trybie 
Sizing Applies Time Stretch (Rozciąganie w czasie z zastosowaniem rozmiaru).

PROCEDURA
1. Wybierz zdarzenie audio, które chcesz rozciągnąć.
2. Wybierz opcję Audio > Realtime Processing > Unstretch Audio (Audio > Przetwarzanie 
    w czasie rzeczywistym > Rozciągnij audio).

WYNIK
Usunięto całe rozciąganie w czasie rzeczywistym.
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Edycja wysokości tonu (Pitch) i korekta 
czasu za pomocą VariAudio

Funkcje VariAudio w Cubase umożliwiają edycję wysokości dźwięku oraz korygowanie 
synchronizacji i intonacji poszczególnych nut w monofonicznych nagraniach wokalnych.

Wszystkie operacje VariAudio można wykonać w oknie Sample Editor (Edytor próbek) oraz 
w edytorze dolnej strefy. Wszelkie modyfikacje materiału audio można cofnąć

UWAGA
Funkcje VariAudio są zoptymalizowane pod kątem monofonicznych nagrań wokalu. Może to 
również działać dobrze w przypadku innych nagrań monofonicznych, takich jak saksofon. Jednak 
jakość wyniku zależy w dużej mierze od nagrania.

Zanim będzie można edytować wysokość dźwięku i skorygować synchronizację nagrań 
monofonicznych, Cubase musi przeanalizować dźwięk i podzielić go na segmenty. Segmenty te 
stanowią graficzną reprezentację poszczególnych nut.

UWAGA
Ze względu na dane uzyskane podczas segmentacji, dźwięk, a tym samym rozmiar Twojego 
projektu, może wzrosnąć.

POWIĄZANE LINKI
Segmentacja dźwięku monofonicznego na stronie 553
Segmenty i przerwy na stronie 554

Procesy VariAudio i offline
Jeśli zastosujesz procesy i zmiany w trybie offline, które wpływają na długość plików audio 
zawierających dane VariAudio, istniejące dane VariAudio stracą ważność. Dlatego zalecamy, aby 
przed użyciem funkcji VariAudio zastosować przetwarzanie lub edycję w trybie offline.

Następujące procesy i edycje mogą prowadzić do ponownej analizy materiału audio:

● Wszystkie procesy offline w podmenu Processes (Procesy) menu Audio, z wyjątkiem Envelope 
(Obwiedni), Fade In (Przyrastania), Fade Out (Zanikania), Normalize (Normalizacji) 
i Silence (Wyciszenia).
● Procesy efektów w podmenu Audio > Plug-ins (Audio > Wtyczki).
● Wycinanie, wklejanie, usuwanie lub rysowanie w Sample Editor (Edytorze próbek).
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Sekcja inspektora VariAudio
Sekcja VariAudio umożliwia edycję poszczególnych nut pliku audio, zmianę ich wysokości lub 
taktowania oraz wyodrębnianie MIDI z audio.

            

Bypass VariAudio Changes (Pomiń zmiany VariAudio)
          Pomija zmiany wysokości, przesunięcia formantów i głośności, dzięki czemu można 
          porównać zmiany z oryginalnym dźwiękiem.
Edit VariAudio (Edytuj VariAudio)
          Aktywuje analizę dźwięku, dzieli audio na segmenty pokazane na obrazie fali i umożliwia 
          edycję VariAudio.
Smart Controls (Inteligentne sterowanie)
          Umożliwia wybór liczby inteligentnych elementów sterujących wyświetlanych w 
          segmentach. Opcja Default (Domyślne) pokazuje często używane inteligentne elementy 
          sterujące, natomiast opcję All (Wszystkie) wyświetla wszystkie inteligentne elementy 
          sterujące.
Pitch Snap Mode (Tryb lokalizacji skoku)
          Umożliwia wybranie sposobu przyciągania segmentu do określonego skoku podczas 
          przesuwania go za pomocą myszy lub klawiszy Strzałka w górę / Strzałka w dół.
MIDI Input (Wejście MIDI)
          Umożliwia zmianę wysokości tonu segmentu poprzez wejście MIDI.
Quantize Pitch (Kwantyzacja tonu)
          Umożliwia kwantyzację wysokości (pitch) segmentu.
Straighten Curve (Wyprostuj krzywą)
          Umożliwia wyprostowanie krzywej nachylenia segmentu.
Shift Formant (Formant zmiany)
          Umożliwia przesuwanie formantów segmentu bez wpływu na wysokość tonu i 
          synchronizację.
Volume (Głośność)
          Umożliwia edycję głośności segmentu.
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Show MIDI Reference Track (Pokaż ścieżkę referencyjną MIDI)
          Umożliwia pokazanie ścieżki referencyjnej MIDI na wyświetlaczu zdarzeń.
Functions (Funkcje)
          Otwiera wyskakujące menu z innymi funkcjami.

POWIĄZANE LINKI
Sekcja VariAudio na stronie 517
Inteligentne sterowanie na stronie 551

Tryb lokalizacji skoku na stronie 559
Tryby wejścia MIDI na stronie 561
Kwantyzacja wysokości tonów na stronie 561
Prostowanie krzywych nachylenia na stronie 564
Przesunięcie formanta na stronie 567
Pokazywanie ścieżek referencyjnych MIDI na stronie 566
Edycja głośności na stronie 568
Menu funkcji na stronie 568

Smart Controls (Inteligentne sterowanie)
Każdy segment posiada inteligentne elementy sterujące, które umożliwiają zmianę punktu 
początkowego i końcowego segmentu oraz wykonywanie zmian wysokości tonu, edycję głośności, 
przesuwanie formantów i modyfikacje synchronizacji powiązanego audio.

● Aby wyświetlić inteligentne elementy sterujące w segmencie, powiększ segment i przesuń nad 
niego wskaźnik myszy.
UWAGA
W wyskakującym menu Smart Controls (Inteligentne sterowanie) w Inspector Sample Editor 
(Inspektor edytora próbek) możesz wybrać tryb All (Wszystko), aby wyświetlić wszystkie 
inteligentne kontrolki, lub opcję Default (Domyślny), aby wyświetlić często używane inteligentne 
kontrolki.

               
Dostępne są następujące inteligentne elementy sterujące:
1   Tilt (Nachylenie)
Ta inteligentna kontrolka jest wyświetlana tylko wtedy, gdy wybierzesz opcję All (Wszystko) w 
wyskakującym menu Smart Controls (Inteligentne kontrolki) w Inspector Sample Editor 
(Inspektor edytora próbek). Umożliwia przechylenie krzywej wysokości dźwięku w górę lub w dół. 
Inteligentne sterowanie po lewej stronie umożliwia przechylenie początku krzywej, inteligentne 
sterowanie po prawej stronie umożliwia przechylenie końca krzywej. Naciśnij klawisz Alt/Opt, aby
obrócić krzywą wokół kotwicy pochylenia/obrócenia.
2   Set Tilt/Rotate Anchor (Ustaw kotwicę pochylenia/obrócenia)
Ta inteligentna kontrola jest wyświetlana tylko wtedy, gdy wybierzesz opcję Wszystko w 
wyskakującym menu Smart Controls w Inspector Sample Editor. Domyślnie krzywa nachylenia 
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jest pochylana lub obracana wokół środka segmentu. To inteligentne sterowanie umożliwia 
przesuwanie kotwicy w lewo lub w prawo. 
3   Straighten Pitch Curve (Wyprostuj krzywą nachylenia)
Ta inteligentna kontrolka jest wyświetlana domyślnie. Umożliwia wyprostowanie krzywej 
wysokości dźwięku. Działa to również w przypadku wybranych segmentów.
4   Set Range for Straighten Pitch Curve (Ustaw zakres dla wyprostowania krzywej nachylenia)
Ta inteligentna kontrolka jest wyświetlana tylko wtedy, gdy wybierzesz opcję All (Wszystko) w 
wyskakującym menu Smart Controls w Inspector Sample Editor.

Domyślnie cała krzywa nachylenia jest wyprostowana. Te inteligentne elementy sterujące 
umożliwiają ustawienie zakresu Straighten Pitch Curve (Wyprostuj krzywą nachylenia). Użyj 
tego inteligentnego sterowania dla kilku wybranych segmentów, aby ustawić ten sam zakres dla 
wszystkich wybranych segmentów.
5   Warp Start/Correct Segment Start (Początek zniekształcenia/prawidłowy początek segmentu)
Ta inteligentna kontrolka jest wyświetlana domyślnie. Umożliwia zniekształcenie początku 
segmentu. Naciśnij klawisz Alt/Opt, aby skorygować początek segmentu.
6   Warp End/Correct Segment End (Zniekształcenie końca/prawidłowy koniec segmentu)
Ta inteligentna kontrolka jest wyświetlana domyślnie. Umożliwia zniekształcenie końca segmentu. 
Naciśnij klawisz Alt/Opt, aby skorygować koniec segmentu.
7   Volume (Głośność)
Ta inteligentna kontrolka jest wyświetlana tylko wtedy, gdy wybierzesz opcję All (Wszystko) w 
wyskakującym menu Smart Controls (Inteligentne kontrolki) w Inspector Sample Editor 
(Inspektor Edytora Próbek). Umożliwia edycję głośności segmentu. Aby wyciszyć segment, 
zmniejsz głośność. Działa to również w przypadku wybranych segmentów.
8   Glue Segments (Klejenie segmentów)
Ta inteligentna kontrolka jest wyświetlana domyślnie. Umożliwia przyklejenie segmentu do 
segmentu sąsiedniego. Działa to również w przypadku wybranych segmentów.
9   Split Segment (Podziel segment)
Ta inteligentna kontrolka jest wyświetlana domyślnie. Umożliwia podzielenie segmentu. Działa to 
również w przypadku wybranych segmentów.
10   Quantize Pitch (Kwantyzacja wysokości dźwięku)
Ta inteligentna kontrola jest wyświetlana domyślnie. Umożliwia kwantyzację wysokości segmentu 
z dokładnością do najbliższego półtonu. Działa to również w przypadku wybranych segmentów.
11   Shift Formant (Formant zmianowy)
Ta inteligentna kontrolka jest wyświetlana tylko wtedy, gdy wybierzesz opcję All (Wszystko)
 w wyskakującym menu Smart Controls (Inteligentne kontrolki) w Inspector Sample Editor. 
Umożliwia przesuwanie formantów segmentu. Działa to również w przypadku wybranych 
segmentów.

POWIĄZANE LINKI
Nawigacja i powiększanie na stronie 555
Pochylanie krzywej nachylenia na stronie 563
Prostowanie krzywych nachylenia na stronie 564
Tryb lokalizacji skoku na stronie 559
Zniekształcanie segmentów na stronie 565
Zmiana punktu początkowego i końcowego segmentów na stronie 558
Dzielenie segmentów na stronie 556
Klejenie segmentów na stronie 557
Kwantyzacja wysokości tonów na stronie 561
Przesunięcie formanta na stronie 567
Edycja Głośności na stronie 568
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Segmenting Monophonic Audio (Segmentacja dźwięku 
monofonicznego)
Aby móc edytować wysokość dźwięku i korygować synchronizację nagrań monofonicznych, 
Cubase musi przeanalizować dźwięk i podzielić go na segmenty.

PROCEDURA
1. W oknie Project kliknij dwukrotnie nagranie monofonicznego wokalu, aby otworzyć Sample  
    Editor (Edytor próbek).
2. W Inspector Sample Editor kliknij VariAudio, aby otworzyć sekcję B. Wyświetlany jest obraz 
     fali audio.
3. Aktywuj opcję Edit VariAudio (Edytuj VariAudio).

           

WYNIK
Cubase automatycznie analizuje dźwięk i dzieli go na segmenty pokazane na obrazie fali. Segmenty
umożliwiają powiązanie poszczególnych nut z ich tonacją wyświetlaną na klawiaturze fortepianu 
po lewej stronie oraz czasem trwania wyświetlanym na osi czasu. Jeśli przesuniesz wskaźnik myszy
nad segment, wysokość (pitch) tego segmentu zostanie wyświetlona w segmencie.

UWAGA
Analiza długich plików audio może zająć trochę czasu.
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POWIĄZANE LINKI
Segmenty i przerwy na stronie 554

Segmenty i przerwy
Cubase automatycznie analizuje dźwięk i dzieli go na segmenty.

           

           Do zrozumienia segmentacji kluczowe są następujące pojęcia:
1   Pitch Position (pozycja wysokości tonu)
Pozycja wysokości segmentów jest wyświetlana na klawiaturze fortepianu po lewej stronie 
przebiegu. Jeśli przesuniesz wskaźnik myszy nad segment, wysokość tego segmentu będzie również
pokazana w segmencie. Wysokość dźwięku reprezentuje postrzeganą częstotliwość podstawową 
nuty. Średni skok segmentu jest obliczany na podstawie jego krzywej nachylenia.
2   Time Position (Pozycja czasowa)
Położenie czasowe i długości segmentów są wskazane na osi czasu.
3   Audio Waveform (Przebieg audio)
Przebieg audio jest zawsze wyświetlany jako mono, nawet jeśli otworzyłeś plik stereo lub 
wielokanałowy.
4   Gap (Luka)
Przerwy pomiędzy segmentami reprezentują nietonalne części analizowanego dźwięku.
Mogą one być spowodowane na przykład szmerami oddechowymi lub przerwami.

UWAGA
Luki spowodowane słabymi sygnałami audio lub fragmentami audio z niejasnymi informacjami o 
wysokości dźwięku, takimi jak spółgłoski lub dźwięki efektowe, należy uwzględnić w segmentach 
ręcznie. Aby to zrobić, musisz zmienić punkt początkowy i końcowy segmentu. W przeciwnym 
razie późniejsze modyfikacje wysokości dźwięku wpływają tylko na partie tonalne.

5   Segment
Segmenty reprezentują fragmenty tonalne analizowanego dźwięku. Wysokość tonu i pozycja 
czasowa segmentów umożliwiają powiązanie segmentów z oryginalnym dźwiękiem.
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6   Pitch Curve (Krzywa nachylenia)
Krzywe wysokości dźwięku pokazane w segmentach przedstawiają postęp wysokości dźwięku.

POWIĄZANE LINKI
Zmiana punktu początkowego i końcowego segmentów na stronie 558

Menu kolorów segmentu VariAudio
Możesz wybrać schemat kolorów dla segmentów VariAudio. Jeśli pracujesz z kilkoma zdarzeniami 
audio, łatwiej jest zobaczyć, które segmenty należą do danego zdarzenia.

               

Dostępne są następujące opcje:
Auto (Automatyczny)
Segmenty należące do tego samego głosu otrzymują ten sam kolor.
Event (Zdarzenie)
Segmenty otrzymują ten sam kolor, co odpowiadające im zdarzenie w oknie Project.
Pitch (Poziom)
Segmenty uzyskują kolory w zależności od wysokości tonu.
Chord Track (Ścieżka akordów)
Segmenty pasujące do odpowiednich zdarzeń akordów lub skali na ścieżce akordów otrzymują 
określony kolor.

Auditioning (Przesłuchanie)
Możesz odsłuchiwać segmenty jeden po drugim, w pętli lub odtwarzać je od początku do końca.

PROCEDURA
● Wykonaj jedną z następujących czynności:
          ● Wybierz segmenty i aktywuj Audition (Przesłuchanie).

UWAGA
Aby odtwarzać wybrane segmenty w pętli, aktywuj Audition Loop (Pętla przesłuchań)

         ● Wybierz narzędzie Play (Odtwórz) i kliknij pozycję, od której chcesz rozpocząć 
             odtwarzanie.

POWIĄZANE LINKI
Pasek narzędzi edytora próbek na stronie 511

Nawigacja i Zoom (Powiększenie)

Można poruszać się po segmentach i powiększać je.
● Aby poruszać się po segmentach, użyj klawisza Strzałka w lewo lub Strzałka w prawo na 
klawiaturze komputera.
● Aby powiększyć segmenty, przytrzymaj klawisz Alt/Opt i narysuj prostokąt zaznaczenia.
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● Aby pomniejszyć, przytrzymaj klawisz Alt/Opt i kliknij pusty obszar przebiegu.
● Aby pomniejszyć i wyświetlić wszystkie segmenty, przytrzymaj klawisz Alt/Opt i kliknij 
dwukrotnie pusty obszar przebiegu.

Edycja segmentu
Edycja segmentów może być konieczna, jeśli oryginalny dźwięk zawiera nietonalne fragmenty 
analizowanego dźwięku, to znaczy sygnały lub sekcje z niejasnymi informacjami o wysokości 
dźwięku, takimi jak spółgłoski lub dźwięki efektowe.

Nietonalne fragmenty analizowanego dźwięku mogą nie zostać uwzględnione w segmencie. W 
takim przypadku zmiany wysokości tonu, przesunięcie formantu przy edycji głośności lub 
modyfikacje taktowania wpływają tylko na partie tonalne. Z drugiej strony segmenty mogą 
zawierać niepożądane nuty lub fragmenty tonalne.
Aby temu zapobiec, możesz ręcznie edytować segmenty za pomocą inteligentnych elementów 
sterujących.

Edycja segmentów obejmuje:
● Skracanie segmentów poprzez ich dzielenie lub zmianę ich punktu początkowego lub  
    końcowego.
● Powiększanie segmentów poprzez doklejanie ich do następnego segmentu lub zmianę ich punktu 
   początkowego lub końcowego.
● Usuwanie segmentów.
UWAGA
Zmiana długości segmentu może prowadzić do innej średniej wysokości tonu, a tym samym do 
zmiany wysokości tonu.

POWIĄZANE LINKI
Zmiana punktu początkowego i końcowego segmentów na stronie 558
Dzielenie segmentów na stronie 556
Klejenie segmentów na stronie 557
Usuwanie segmentów na stronie 557
Segmenty i przerwy na stronie 554
Inteligentne sterowanie na stronie 551

Dzielenie segmentów
Jeśli segment zawiera więcej niż jedną nutę, możesz go podzielić.

WARUNEK WSTĘPNY
Otworzyłeś dźwięk w Sample Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio  
(Edytuj VariAudio) w sekcji VariAudio.

PROCEDURA
1. Wybierz jeden lub kilka segmentów.
2. Na pasku narzędzi Sample Editor aktywuj Audition (Przesłuchanie), aby przesłuchać segmenty.
3. Porównaj segmenty z krzywą wysokości dźwięku dla każdej nuty.
4. Jeśli segment zawiera więcej niż jedną nutę, wykonaj jedną z następujących czynności:
      ● Użyj inteligentnego elementu sterującego Split Segment (Podziel segment) na dolnej 
          krawędzi segmentu i kliknij.
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      ● Przytrzymaj klawisz Alt/Opt i kliknij w dowolnym miejscu nad inteligentnym elementem   
          sterującym, aby wybrać opcję Split Segment.

WYNIK
Segment jest dzielony i ponownie obliczany jest średni ton.

UWAGA
Podział segmentu może prowadzić do innej średniej wysokości tonu, a tym samym do zmiany 
wysokości tonu.

PO WYKOŃCZENIU TEGO ZADANIA
Jeżeli podział segmentu skutkuje nieprawidłowym tonem, przesuń segment w pionie.

POWIĄZANE LINKI
Segmentacja dźwięku monofonicznego na stronie 553
Inteligentne sterowanie na stronie 551

Klejenie segmentów
Jeśli pojedynczy dźwięk jest rozłożony na wiele segmentów, można je skleić.

WARUNEK WSTĘPNY
Otworzyłeś dźwięk w Sample Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio 
(Edytuj VariAudio) w sekcji VariAudio.

PROCEDURA
1. Na pasku narzędzi Sample Editor aktywuj Audition (Przesłuchanie), aby przesłuchać segmenty.
2. Porównaj segmenty z krzywą wysokości dźwięku dla każdej nuty.
3. Wykonaj jedną z następujących czynności:
● Użyj inteligentnego sterowania dla opcji Glue Segments (Klej segmenty) na dolnej lewej 
krawędzi segmentu i kliknij, aby przykleić go do poprzedniego segmentu.
● Użyj inteligentnego sterowania dla opcji Glue Segments w prawym dolnym rogu segmentu i 
kliknij, aby przykleić go do następnego segmentu.
● Wybierz kilka sąsiadujących ze sobą segmentów, użyj inteligentnej opcji Glue Segments na 
dolnej lewej lub prawej krawędzi jednego z segmentów i kliknij, aby skleić wybrane segmenty.

WYNIK
Segmenty są ze sobą sklejone. Średni skok segmentu jest ponownie obliczany

POWIĄZANE LINKI
Segmentacja dźwięku monofonicznego na stronie 553
Inteligentne sterowanie na stronie 551

Usuwanie segmentów
Możesz usuwać segmenty. Jest to przydatne, jeśli segment zawiera tylko nietonalne fragmenty 
dźwięku i dlatego nie wymaga edycji wysokości tonu (pitch).

WARUNEK WSTĘPNY
Otworzyłeś dźwięk w Sample Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio 
(Edytuj VariAudio) w sekcji VariAudio

PROCEDURA
1. Wybierz jeden lub kilka segmentów.
2. Na pasku narzędzi Sample Editor aktywuj Audition (Przesłuchanie), aby przesłuchać segmenty.
3. Porównaj segmenty z krzywą wysokości dźwięku dla każdej nuty.
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4. Wybierz segment, który chcesz usunąć i naciśnij klawisz Backspace.

WYNIK
Segment został usunięty.

POWIĄZANE LINKI
Segmentacja dźwięku monofonicznego na stronie 553

Zmiana punktu początkowego i końcowego segmentów
Jeśli punkt początkowy lub końcowy segmentu nie pasuje do powiązanego audio, możesz to 
zmienić.

WARUNEK WSTĘPNY
Otworzyłeś dźwięk w Sample Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio 
(Edytuj VariAudio) w sekcji VariAudio.

PROCEDURA
1. Wybierz jeden lub kilka segmentów.
2. Na pasku narzędzi Sample Editor aktywuj Audition (Przesłuchanie), aby przesłuchać segmenty.
3. Porównaj położenie początkowe i końcowe segmentów z krzywą nachylenia.
4. Wykonaj jedną z następujących czynności:
      ● Jeśli segment zaczyna się za wcześnie lub za późno, przytrzymaj klawisz Alt/Opt, przesuń    
         wskaźnik myszy nad inteligentny element sterujący w lewym środkowym rogu segmentu, a 
         następnie kliknij i przeciągnij w prawo lub w lewo.
      ● Jeśli segment kończy się za wcześnie lub za późno, przytrzymaj klawisz Alt/Opt, przesuń 
         wskaźnik myszy nad inteligentny element sterujący w prawym środkowym rogu segmentu, a 
         następnie kliknij i przeciągnij w prawo lub w lewo.

UWAGA
Możesz przeciągnąć początek lub koniec segmentu jedynie do granic następnego segmentu. 
Segmenty nie mogą się nakładać.

WYNIK
Pozycje początkowe i końcowe segmentów zostaną zmienione zgodnie z wprowadzonymi przez 
Ciebie zmianami. Średni skok (pitch) segmentu jest ponownie obliczany.

UWAGA
Zmiana długości segmentu może prowadzić do innej średniej wysokości tonu, a tym samym do 
zmiany wysokości tonu.

POWIĄZANE LINKI
Segmentacja dźwięku monofonicznego na stronie 553
Inteligentne sterowanie na stronie 551

Pitch Changes (Zmiany wysokości tonu)
Możesz zmienić wysokość segmentów audio w celach korekcyjnych lub kreatywnych. Zmieniając 
wysokość nut, możesz zmienić melodię oryginalnego dźwięku.

Zmiany wysokości tonu obejmują:
● Podnoszenie lub obniżanie wysokości
● Kwantyzację tonów
● Zmianę krzywej wysokości dźwięku
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● Prostowanie skoków

Aby zmienić wysokość tonu segmentów audio, możesz użyć sekcji VariAudio w Inspector 
Sample Editor (Inspektorze edytora próbek) lub inteligentnych elementów sterujących.

  

POWIĄZANE LINKI
Sekcja Inspektora VariAudio na stronie 550
Inteligentne sterowanie na stronie 551

Pitch Snap Mode (Tryb przyciągania wysokości tonu)
Pitch Snap Mode definiuje sposób przyciągania segmentu do określonej wysokości tonu.

● Możesz ustawić tryb Pitch Snap w sekcji VariAudio Inspektora Sample Editor.

              

Dostępne są następujące tryby:
Absolute (Absolutny)
       Segmenty są przyciągane do następnego półtonu.
Relative (Względny)
       Segmenty przechodzą do następnego półtonu, ale zachowują oryginalne odchylenie w centach, 
       jeśli jest dostępne.
Off (Wyłączony)
      Segmenty nie przyciągają się i można dowolnie edytować wysokość.

UWAGA
Można także przypisać polecenie klawiszowe, aby przełączyć tryb Pitch Snap Mode.

Podnoszenie lub obniżanie wysokości tonów
Możesz podnieść lub obniżyć wysokość jednego lub kilku segmentów.

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. Opcjonalnie: Aktywuj funkcję Acoustic Feedback (Sprzężenia akustycznego), aby podczas 
edycji modyfikować wysokość dźwięku.
2. Wybierz jeden lub kilka segmentów i przesuń nad nim wskaźnik myszy. Wskaźnik myszy staje 
się symbolem dłoni.

UWAGA
Jeśli przytrzymasz klawisz Shift i dwukrotnie klikniesz segment, zaznaczone zostaną wszystkie 
kolejne segmenty o tej samej wysokości.
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3. Wykonaj jedną z następujących czynności:
      ● Przeciągnij segment w górę lub w dół i zwolnij mysz, lub użyj klawiszy Strzałka w górę / 
         Strzałka w dół, aby uwzględnić ustawienie trybu Pitch Snap Mode.
      ● Przytrzymaj Shift podczas używania klawiszy Strzałka w górę / Strzałka w dół, aby 
         zmienić wysokość dźwięku w krokach centowych i zignoruj tryb Pitch Snap Mode.

UWAGA
Tryb Pitch Snap Mode możesz zmieniać na bieżąco. Użyj Shift, aby przejść do trybu wyłączenia 
(Off), Ctrl/Cmd, aby przejść do trybu bezwzględnego (Absolute) i Alt, aby przejść do trybu 
względnego (Relative).

WYNIK
Algorytm Solo jest wybierany automatycznie, a wysokość segmentu jest zwiększana lub 
zmniejszana w zależności od ustawień.

UWAGA
Im bardziej wysokość dźwięku odbiega od oryginalnej, tym mniejsze jest prawdopodobieństwo, że 
Twój dźwięk będzie brzmiał naturalnie.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby porównać zmiany wysokości dźwięku z oryginalną wysokością dźwięku, aktywuj opcję 
Bypass VariAudio Changes (Pomiń zmiany VariAudio) w sekcji VariAudio.
        

              

POWIĄZANE LINKI
Wybierz podmenu na stronie 206

Zmiana wysokości dźwięków za pomocą wejścia MIDI
Możesz zmienić wysokość jednego lub kilku wybranych segmentów, naciskając klawisz na 
klawiaturze MIDI lub używając klawiatury ekranowej.

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio. Podłączyłeś i skonfigurowałeś klawiaturę MIDI.

PROCEDURA
1. Wybierz jeden lub kilka segmentów.
UWAGA
Jeśli przytrzymasz klawisz Shift i dwukrotnie klikniesz segment, zaznaczone zostaną wszystkie 
kolejne segmenty o tej samej wysokości
2. W sekcji VariAudio aktywuj opcję Change Note Pitch via MIDI Input (Zmień wysokość nuty 
   poprzez wejście MIDI).

566



                
3. Wykonaj jedną z poniższych czynności, aby zmienić wysokość dźwięku:
         ● Naciśnij klawisz na klawiaturze MIDI.
         ● Użyj klawiatury ekranowej, aby zmienić tonację.

UWAGA
Im bardziej wysokość dźwięku odbiega od oryginalnej, tym mniejsze jest prawdopodobieństwo, że 
Twój dźwięk będzie brzmiał naturalnie. Nie można wybrać wysokości powyżej C5 i poniżej E0.

WYNIK
Algorytm Solo jest wybierany automatycznie, a wysokość segmentu jest zwiększana lub obniżana 
w zależności od granej nuty. Jeśli wybierzesz kilka segmentów, wysokość stroju pierwszego 
wybranego segmentu zostanie zmieniona na wysokość granej nuty MIDI, a wysokość pozostałych 
segmentów zostanie zmieniona o tę samą wartość.

UWAGA
Wejście MIDI wpływa tylko na wysokość segmentów. Dane kontrolera MIDI są ignorowane.

PO ZAKOŃCZENIU TEGO ZADANIA
Dezaktywuj MIDI Input (wejście MIDI).

POWIĄZANE LINKI
Klawiatura ekranowa na stronie 261
Tryb lokalizacji skoku przyciągania na stronie 559

Tryby wejścia MIDI
Funkcja MIDI Input (wejścia MIDI) umożliwia przypisywanie nut MIDI w trybie Still lub Step.

● Aby przełączyć się pomiędzy trybem Still a trybem Step, kliknij z wciśniętym klawiszem Alt 
   MIDI Input (Wejście MIDI).

Still Mode (Tryb nieruchomy) 
Użyj tego trybu, jeśli chcesz zmienić wysokość (pitch) poszczególnych segmentów lub zaznaczeń.

Step Mode (Tryb krokowy)  
Użyj tego trybu, jeśli chcesz przechodzić przez segmenty, zmieniając ich wysokość. Pozwala to na 
bardziej kreatywną pracę, na przykład opracowywanie zupełnie nowych linii melodycznych za 
pośrednictwem MIDI.
Po przypisaniu nuty MIDI do segmentu, automatycznie wybierany jest następny segment.

POWIĄZANE LINKI
Wprowadzanie kroków na stronie 869

Kwantyzacja wysokości tonów
Możesz kwantyzować wysokość dźwięku z dokładnością do najbliższego półtonu.

567



WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś dźwięk w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. Wybierz jeden lub kilka segmentów

UWAGA
Jeśli przytrzymasz klawisz Shift i dwukrotnie klikniesz segment, zaznaczone zostaną wszystkie 
kolejne segmenty o tej samej wysokości (pitch).

2. W sekcji VariAudio Inspektora Sample Editor przesuń suwak Quantize Pitch (Kwantyzacja 
    wysokości tonu) w prawo.

                     

UWAGA
Wysokość tonu można także kwantyzować, przeciągając inteligentny element sterujący Quantize 
Pitch pośrodku dolnej krawędzi segmentu w górę lub w dół.

WYNIK
Algorytm Solo jest wybierany automatycznie, a wysokość segmentu jest delikatnie kwantyzowana.

UWAGA
W kategorii Sample Editor (Edytor próbek) w oknie dialogowym Key Commands (Polecenia 
klawiszowe) możesz skonfigurować polecenie klawiszowe dla Quantize Pitch (Kwantyzacja 
wysokości tonu). Jeśli użyjesz polecenia klawiszowego, segmenty zostaną natychmiast 
skwantyzowane do następnej pozycji półtonu.

POWIĄZANE LINKI
Polecenia klawiszowe na stronie 1123
Inteligentne sterowanie na stronie 551

Zmiany krzywej nachylenia
Możesz przeprowadzić bardziej szczegółową edycję dźwięku, modyfikując krzywe wysokości 
dźwięku wewnątrz segmentów.
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WAŻNE
Krzywa wysokości dźwięku przedstawia progresję wysokości tonalnej części segmentu audio. 
W przypadku nietonalnych fragmentów dźwięku nie można wyświetlić krzywych wysokości 
dźwięku (pitch curves).

Zmiany krzywej pitch obejmują następujące zadania:
● Pochylanie krzywej wysokości dźwięku
Pozwala to skorygować odchylenia wysokości dźwięku dla poszczególnych segmentów. Należą do 
nich odchylenia od środka tonalnego.
● Obracanie krzywej wysokości dźwięku

Pozwala to skorygować odchylenia wysokości dźwięku dla poszczególnych segmentów. Należą do 
nich odchylenia od środka tonalnego.
● Prostowanie krzywej wysokości dźwięku
Pozwala to na zmniejszenie stopnia fluktuacji czy wibracji dla poszczególnych segmentów.

POWIĄZANE LINKI
Ustawianie kotwic pochylania/obrócenia na stronie 563
Pochylanie krzywej nachylenia na stronie 563
Obracanie krzywej nachylenia na stronie 564
Prostowanie krzywych nachylenia na stronie 564
Prostowanie zakresów krzywych nachylenia na stronie 565

Ustawianie kotwic pochylania/obracania
Domyślnie punkt odniesienia lub punkt kontrolny dla krzywych nachylenia i obrotu jest ustawiony 
na środek segmentu. Możesz przesunąć ten punkt odniesienia w lewo lub w prawo, aby uzyskać 
inny wynik.

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. W inspektorze Sample Editor Inspector ustaw opcję Smart Controls (inteligentne sterowanie) 
na All (Wszystko).
2. Przeciągnij inteligentny element sterujący Set Tilt/Rotate Anchor (Ustaw kotwicę 
pochylenia/obrócenia) na środku górnej krawędzi segmentu w lewo lub w prawo.

WYNIK
Kotwica jest ustawiona w miejscu, w którym zwolniłeś przycisk myszy i służy jako
punkt odniesienia podczas pochylania lub obracania krzywej nachylenia.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby zresetować kotwicę, przytrzymaj klawisz Alt/Opt i kliknij inteligentną opcję Set Tilt/Rotate 
Anchor (Ustaw kotwicę pochylenia/obrótu).

POWIĄZANE LINKI
Inteligentne sterowanie na stronie 551
Pochylanie krzywej nachylenia na stronie 563
Obracanie krzywej nachylenia na stronie 564

Tilting a Pitch Curve (Pochylanie krzywej nachylenia)
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Można przechylić początek lub koniec krzywej nachylenia. Umożliwia to skorygowanie odchyleń 
wysokości dźwięku dla segmentu.

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. W inspektorze Sample Editor ustaw opcję Smart Controls na All.
2. Opcjonalnie: Przesuń Set Tilt/Rotate Anchor (kotwicę ustawiania pochylenia/obrócenia) w 
lewo lub w prawo, aby dostosować punkt odniesienia dla pochylenia.
3. Wykonaj jedną z następujących czynności:
        ● Aby przechylić początek krzywej, przeciągnij inteligentny element sterujący Tilt (Pochyl) w
           lewym górnym rogu segmentu w górę lub w dół.
        ● Aby przechylić koniec krzywej, przeciągnij inteligentny element sterujący Tilt (Pochyl) w 
           prawym górnym rogu segmentu w górę lub w dół.

WYNIK
Algorytm Solo jest wybierany automatycznie, a krzywa wysokości dźwięku jest nachylana zgodnie 
z ustawieniami.

POWIĄZANE LINKI
Inteligentne sterowanie na stronie 551
Ustawianie kotwic pochylania/obrócenia na stronie 563

Rotating a Pitch Curve (Obracanie krzywej nachylenia)
Można obracać krzywą wysokości dźwięku, aby skorygować odchylenia wysokości 
poszczególnych segmentów.

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. W inspektorze Sample Editor Inspector ustaw opcję Smart Controls na All.
2. Opcjonalnie: Przesuń Set Tilt/Rotate Anchor (kotwicę ustawiania pochylenia/obrótu) w lewo 
lub w prawo, aby dostosować punkt odniesienia dla obrotu. Jeśli kotwica nie zostanie przesunięta, 
krzywa nachylenia zostanie obrócona wokół środka segmentu.
3. Naciśnij klawisz Alt/Opt i przeciągnij inteligentny element sterujący pochyleniem w lewym 
górnym lub prawym górnym rogu segmentu w górę lub w dół.

WYNIK
Algorytm Solo jest wybierany automatycznie, a krzywa nachylenia jest obracana wokół kotwicy.

POWIĄZANE LINKI
Ustawianie kotwic pochylania/obrócenia na stronie 563

Straightening Pitch Curves (Prostowanie krzywych nachylenia)
Możesz wyprostować krzywe wysokości dźwięku, aby skompensować wzrost i spadek wysokości 
dźwięku, czyli odchylenie od reprezentatywnej wysokości dźwięku.

WARUNEK WSTĘPNY
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Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. Wybierz jeden lub kilka segmentów.
UWAGA
Jeśli przytrzymasz klawisz Shift i dwukrotnie klikniesz segment, zaznaczone zostaną wszystkie 
kolejne segmenty o tej samej wysokości.

2. Wykonaj jedną z następujących czynności:

● Przeciągnij inteligentny element sterujący Straighten Pitch Curve (Wyprostuj krzywą 
wysokości tonu) na środku górnej krawędzi segmentu w górę lub w dół.
● W inspektorze Sample Editor przesuń suwak Straighten Curve w prawo.

WYNIK
Algorytm Solo jest wybierany automatycznie, a krzywe wysokości dźwięku są prostowane.

POWIĄZANE LINKI
Inteligentne sterowanie na stronie 551
Prostowanie zakresów krzywych nachylenia na stronie 565

Prostowanie zakresów krzywych nachylenia
Można ograniczyć prostowanie krzywych nachylenia do określonych zakresów segmentów. 
Pozwala to na wyprostowanie podziałki segmentów przy jednoczesnym zachowaniu naturalnego 
przejścia pomiędzy segmentami.

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. W inspektorze Sample Editor ustaw opcję Smart Controls (Inteligentne elementy sterujące) na
    All (Wszystkie).
2. Przeciągnij inteligentny element sterujący Set Range for Straighten Pitch Curve (Ustaw zakres
    dla wyprostowanej krzywej wysokości) w lewym górnym rogu segmentu w prawo, aby ustawić 
    początek zakresu.
3. Przeciągnij inteligentny element sterujący Set Range for Straighten Pitch Curve w prawym 
    górnym rogu segmentu w lewo, aby ustawić koniec zakresu.
4. Przeciągnij inteligentny element sterujący Straighten Pitch Curve (Wyprostuj krzywą 
    nachylenia) pośrodku górnej krawędzi segmentu w górę lub w dół.

WYNIK
Wyprostowywany jest tylko zdefiniowany zakres krzywej skoku. Algorytm Solo jest wybierany 
automatycznie.

Modyfikacje taktowania
Modyfikowanie taktowania segmentów lub zniekształcanie jest przydatne, jeśli chcesz dopasować 
akcent muzyczny do określonej pozycji czasowej lub zmienić synchronizację segmentów w 
nagraniach monofonicznych.
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Jeśli zniekształcasz segmenty audio, tworzone są znaczniki zniekształceń. Są one pokazane w 
sekcjach VariAudio i AudioWarp w Sample Editor Inspector (Inspektorze Edytora Sampli).
Aby zmodyfikować taktowanie segmentów audio, możesz użyć sekcji VariAudio w Sample 
Editor Inspector (inspektorze edytora próbek) lub inteligentnych elementów sterujących.

POWIĄZANE LINKI
Sekcja Inspektora VariAudio na stronie 550
Inteligentne sterowanie na stronie 551

Warping Segments (Segmenty zniekształcające)

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś audio w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Przeciągnij inteligentny element sterujący Warp Start (Poczatek zniekształcenia) w lewo  
            lub w prawo.
        ● Przeciągnij inteligentny element sterujący Warp End (Koniec zniekształcenia) w lewo lub 
           w prawo.

WYNIK
Algorytm Solo jest wybierany automatycznie. Czas segmentu i sąsiednich segmentów zmienia się 
zgodnie z Twoimi ustawieniami. Pod linijką pokazane są znaczniki wypaczenia, które wskazują, 
które fragmenty dźwięku są rozciągnięte.

UWAGA
Wprowadzone w ten sposób modyfikacje czasowe nie dostosowują się do tempa projektu. Jeśli tego
właśnie chcesz, użyj Musical Mode (trybu muzycznego).

PO ZAKOŃCZENIU TEGO ZADANIA
Aby porównać zmiany wypaczenia z oryginalnym taktowaniem dźwięku, aktywuj opcję Disable 
Warp Changes (Wyłącz zmiany zniekształcenia) w sekcji AudioWarp.

                                

POWIĄZANE LINKI
Inteligentne sterowanie na stronie 551
Korygowanie pozycji znaczników zniekształcenia na stronie 546
Usuwanie znaczników zniekształcenia na stronie 547

Wyświetlanie ścieżek referencyjnych MIDI
Ścieżkę MIDI można wykorzystać jako odniesienie do korekcji wysokości tonu (pitch) 
i taktowania.

WARUNEK WSTĘPNY
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● Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś dźwięk w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.
● Ścieżka MIDI zawiera część MIDI ze zdarzeniami MIDI odtwarzającymi melodię, której chcesz 
użyć jako odniesienia dla swojego audio.

PROCEDURA
● W sekcji VariAudio Inspektora Sample Editor Inspector otwórz menu podręczne Select MIDI 
Reference Track (Wybierz ścieżkę referencyjną MIDI) i wybierz ścieżkę MIDI, której chcesz użyć
jako odniesienia dla swojego audio.

                 

WYNIK
Zdarzenia wybranej ścieżki MIDI są pokazane na ekranie zdarzeń Sample Editor (Edytora próbek)
w postaci linii. Ich kolor dopasowuje się do ustawienia kolorów segmentów VariAudio Segment 
Colors. Możesz na przykład użyć opcji Pitch (Wysokość tonu) lub Chord Track (Ścieżka 
akordowa), aby powiązać wysokość audio i MIDI.
Wybór ścieżki referencyjnej MIDI dotyczy wszystkich edytorów sampli w projekcie. Jest 
zapisywany razem z projektem.

UWAGA
● Nie można edytować danych MIDI wyświetlanych w Sample Editor (Edytorze próbek).
● Nie możesz wyświetlić ścieżek referencyjnych MIDI, jeśli otworzyłeś edytor sampli z Pool 
   (puli).

PO ZAKOŃCZENIU TEGO ZADANIA
Aby ukryć ścieżkę referencyjną MIDI w oknie zdarzeń Sample Editor, wyłącz opcję Show MIDI 
Reference Track (Pokaż ścieżkę referencyjną MIDI).

POWIĄZANE LINKI
Menu kolorów segmentu VariAudio na stronie 555
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Formant Shifting (Przesunięcie Formanta)
Formanty to częstotliwości harmoniczne występujące w ludzkim głosie. Definiują barwę i 
zmieniają postrzeganie sposobu wykonania wokalu (na przykład bardziej z membrany niż z gardła).
Przesunięcie formantu nie wpływa na wysokość ani synchronizację segmentu.

WARUNEK WSTĘPNY
● Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś dźwięk w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.

PROCEDURA
1. Wybierz jeden lub kilka segmentów.
2. W sekcji VariAudio Inspektora Sample Editor przesuń suwak Shift Formant (Przesuń 
formant) w lewo lub w prawo.

Można ustawić dodatnie i ujemne wartości procentowe. 0 pozostawia oryginał nienaruszony.

UWAGA
Jeśli opcja Smart Controls (Inteligentne sterowanie, inteligentne kontrolki) jest ustawiona na All 
(Wszystko), możesz także przesunąć formant, przeciągając inteligentną kontrolkę w lewym dolnym
rogu segmentu w górę lub w dół.

WYNIK
Algorytm Solo jest wybierany automatycznie i formant zostaje przesunięty.

POWIĄZANE LINKI
Inteligentne sterowanie na stronie 551

Editing Volume (Edycja głośności)
Możesz zwiększyć lub zmniejszyć głośność dźwięku segmentu lub go wyciszyć (mute).

WARUNEK WSTĘPNY
● Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Otworzyłeś dźwięk w Sample 
Editor (Edytorze próbek) i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji 
VariAudio.
● Wybrałeś opcję All (Wszystko) z wyskakującego menu Smart Controls w inspektorze Sample 
Editor Inspector.

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● Przeciągnij inteligentny element sterujący Volume (Głośnością) w prawym dolnym rogu 
           segmentu w górę lub w dół.
        ● W sekcji VariAudio Inspektora Edytora Sampli przeciągnij suwak Volume (Głośność) w 
            lewo lub w prawo. 

UWAGA
Aby wyciszyć segment, zmniejsz głośność lub zaznacz segment i wybierz Edit > Mute (Edycja > 
Wycisz).

WYNIK
Głośność segmentu została zmieniona.

Menu funkcji
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Extract MIDI (Wyodrębnij MIDI)
        Otwiera okno dialogowe Extract MIDI, które pozwala określić, które dane audio zostaną 
        użyte do utworzenia partii MIDI. Pod uwagę brane jest całe zdarzenie audio.
Flatten Realtime Processing (Spłaszcz przetwarzanie w czasie rzeczywistym)
        Otwiera okno dialogowe Flatten Realtime Processing, które umożliwia wybranie wstępnie 
        ustawionego algorytmu spłaszczania VariAudio i modyfikacji zniekształcenia. Pod uwagę   
        brane jest całe zdarzenie audio.
Reset Pitch Changes/Reset Pitch Changes for Selection (Resetuj zmiany tonu/Resetuj zmiany 
tonu dla zaznaczenia)
        Resetuje wszystkie podziałki segmentów. Jeśli wybierzesz określone segmenty, resetowane 
        będą tylko ich wysokości tonu.
Reset Pitch Curve Changes/Reset Pitch Curve Changes for Selection (Zresetuj zmiany krzywej 
wysokości tonu/Zresetuj zmiany krzywej wysokości tonu dla wyboru)
         Resetuje wszystkie krzywe nachylenia. Jeśli wybierzesz określone segmenty, resetowane będą
         tylko ich krzywe nachylenia (pitch curves).
Reset Formant Shift Changes/Reset Formant Shift Changes for Selection (Resetuj zmiany 
przesunięcia formanta/Resetuj zmiany przesunięcia formanta dla zaznaczenia)
        Resetuje wszystkie zmiany przesunięcia formantów. Jeśli wybierzesz określone segmenty, 
        resetowane będą tylko zmiany przesunięć ich formantów.
Reset Volume Changes/Reset Volume Changes for Selection (Resetuj zmiany głośności/Resetuj 
zmiany głośności dla wyboru)
       Resetuje wszystkie zmiany głośności. Jeśli wybierzesz określone segmenty, resetowane będą 
       jedynie zmiany w ich głośności.
Reset Warp Changes/Reset Warp Changes for Selection (Resetuj zmiany 
zniekształcenia/Resetuj zmiany zniekształcenia dla zaznaczenia)
       Resetuje wszystkie zmiany w warpach. Jeśli wybierzesz określone segmenty, resetowane będą 
       tylko zmiany w ich zniekształceniu.
Reset All Changes/Reset All Changes for Selection (Resetuj wszystkie zmiany/Resetuj wszystkie 
zmiany dla wyboru)
       Resetuje wszystkie zmiany. Jeśli wybierzesz określone segmenty, resetowane będą tylko ich 
       zmiany.
Reanalyze Audio (Przeanalizuj ponownie audio)
       Resetuje segmentację i ponownie analizuje całe zdarzenie audio.

POWIĄZANE LINKI
Wyodrębnij okno dialogowe MIDI na stronie 570
Generowanie brzmień harmonii dla dźwięku monofonicznego na stronie 572
Spłaszczanie przetwarzania w czasie rzeczywistym na stronie 572
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Wyodrębnianie MIDI z audio
Możesz utworzyć część MIDI z określonych danych audio. Jest to przydatne, jeśli chcesz 
skopiować melodię i dźwięk swojego audio za pomocą instrumentu MIDI lub instrumentu VST.

WARUNEK WSTĘPNY
Plik audio jest podzielony na segmenty i segmenty są prawidłowe. Wszystkie zmiany wysokości 
tonu i czasu zostały zakończone. Otworzyłeś dźwięk w Sample Editor (Edytorze próbek) 
i aktywowałeś opcję Edit VariAudio (Edytuj VariAudio) w sekcji VariAudio.

PROCEDURA
1. W sekcji VariAudio otwórz menu Functions (Funkcje) i wybierz opcję Extract MIDI 
(Wyodrębnij MIDI).
2. W otwartym oknie dialogowym Extract MIDI wprowadź zmiany i kliknij OK.

WYNIK
Partia MIDI zostanie utworzona zgodnie z Twoimi ustawieniami.
POWIĄZANE LINKI
Segmentacja dźwięku monofonicznego na stronie 553
Okno dialogowe Wyodrębnij MIDI na stronie 570

Okno dialogowe Extract MIDI (Wyodrębnij MIDI)
Okno dialogowe Extract MIDI umożliwia określenie, które dane audio będą używane podczas 
tworzenia partii MIDI za pomocą funkcji Extract MIDI.

● Aby otworzyć okno dialogowe Extract MIDI, otwórz sekcję VariAudio Inspektora Sample 
Editor Inspector, aktywuj Edit VariAudio w sekcji VariAudio i w menu Functions kliknij 
Extract MIDI.

                         

Dostępne są następujące menu podręczne:

Pitch Extraction Mode (Tryb ekstrakcji tonu)
Umożliwia określenie, które dane zostaną uwzględnione podczas wyodrębniania MIDI. Dostępne są
następujące opcje:

Just Notes and No Pitchbend Data (Tylko nuty i bez danych Pitchbend)
Wyodrębnia tylko nuty MIDI
Notes and Static Pitchbend Data (Nuty i statyczne dane Pitchbend)
Wyodrębnia zdarzenia pitchbend dla każdego segmentu. W polu Pitchbend Range możesz określić 
wartość pitchbend od 1 do 24.
UWAGA
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Jeśli pracujesz z zewnętrznym urządzeniem MIDI, ustaw dla niego tę samą wartość Pitchbend 
Range.
Notes and Continuous Pitchbend Data (Nuty i ciągłe dane Pitchbend)
Wyodrębnia zdarzenia pitchbend, które odpowiadają krzywej wysokości tonu. W polu Pitchbend 
Range możesz określić wartość pitchbend od 1 do 24.
UWAGA
Jeśli pracujesz z zewnętrznym urządzeniem MIDI, ustaw dla niego tę samą wartość Pitchbend 
Range.
Notes and NoteExp Pitchbend Curve (Nuty i krzywa Pitchbend NoteExp)
Wyodrębnia zdarzenia pitchbend, które odpowiadają krzywej wysokości tonu. Są one zapisywane 
jako Note Expression data (dane wyrażeń nutowych) dla powstałych nut MIDI.

Notes and NoteExp VST 3 Tuning Curve (Nuty i krzywa strojenia NoteExp VST 3)
Wyodrębnia zdarzenia VST 3 dla parametru Tuning. Są one tworzone jako dane Note Expression 
(wyrażenia nutowego) dla powstałych nut MIDI.

UWAGA
Działa to tylko z podłączonym instrumentem VST zgodnym z Note Expression.

Volume Mode (Tryb głośności)
Umożliwia określenie sposobu wyodrębniania informacji o głośności z dźwięku. Dostępne są 
następujące opcje:

Fixed Velocity (Stała prędkość)
Przypisuje tę samą dynamikę wszystkim utworzonym nutom MIDI. W polu Velocity  (Prędkość) 
możesz określić wartość prędkości.

Dynamic Velocity (Prędkość dynamiczna)
Przypisuje indywidualną wartość dynamiki do każdej utworzonej nuty MIDI zgodnie z amplitudą 
sygnału audio.

Volume Controller Curve (Krzywa kontrolera głośności)
Tworzy ciągłą krzywą kontrolera głośności w partii MIDI. W polu Kontroler MIDI możesz określić
kontroler MIDI

NoteExp Volume Controller Curve (NoteExp Krzywa kontrolera głośności)
Wyodrębnia zdarzenia kontrolera głośności MIDI. Są one tworzone jako dane wyrażenia nutowego 
dla powstałych nut MIDI.

NoteExp VST 3 Volume Curve (NoteExp Krzywa głośności VST 3)
Wyodrębnia krzywą głośności VST 3. Jest on tworzony jako dane wyrażenia nutowego dla 
powstałych nut MIDI.
UWAGA
Ta opcja działa tylko z podłączonym instrumentem VST zgodnym z funkcją Note Expression.

Destination (Miejsce docelowe)
Umożliwia określenie miejsca umieszczenia partii MIDI. Dostępne są następujące opcje:

First Selected Track (Pierwsza wybrana ścieżka)
Umieszcza partię MIDI na pierwszej wybranej ścieżce MIDI lub instrumentu. Wszelkie partie 
MIDI z poprzednich ekstrakcji na tej ścieżce zostaną usunięte.

New MIDI Track (Nowa ścieżka MIDI)
Tworzy nową ścieżkę MIDI dla partii MIDI.
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Project Clipboard (Schowek projektu)
Kopiuje partię MIDI do schowka. Ta opcja umożliwia wstawienie go w żądanym miejscu na 
ścieżce MIDI lub ścieżce instrumentu w oknie Project.
UWAGA
Jeśli otworzyłeś Sample Editor (edytor próbek) z Pool (puli) i plik audio nie jest częścią twojego 
projektu, część MIDI zostanie wstawiona na początku projektu.

Spłaszczanie przetwarzania w czasie rzeczywistym
Można spłaszczyć modyfikacje VariAudio i AudioWarp. Jest to przydatne, jeśli chcesz zmniejszyć 
obciążenie procesora, zoptymalizować jakość dźwięku podczas przetwarzania lub zastosować 
przetwarzanie offline.

PROCEDURA
1. Opcjonalnie: Wybierz segmenty, które chcesz spłaszczyć. Jeżeli niczego nie zaznaczysz, 
wszystkie segmenty zostaną spłaszczone.
2. W sekcji VariAudio otwórz menu Functions (Funkcje) i wybierz opcję Flatten Realtime 
Processing (Spłaszcz przetwarzanie w czasie rzeczywistym).
3. W oknie dialogowym Flatten Realtime Processing wybierz ustawienie wstępne algorytmu.

                         
UWAGA
W przypadku współczynników rozciągnięcia czasu w zakresie od 0,5 do 2 można wybrać opcję 
Realtime lub MPEX jako ustawienie wstępne algorytmu. W przypadku innych współczynników 
rozciągnięcia czasu opcja Realtime (Czas rzeczywisty) jest ustawiana automatycznie.
4. Kliknij OK.

WYNIK
Każda pętla, w której wcześniej zmieniono wysokość tonu, odtwarzana jest dokładnie w ten sam 
sposób, ale Musical Mode (Tryb muzyczny) jest dezaktywowany, a dane VariAudio, takie jak 
zmiany wysokości tonu, edycja głośności i przesunięcie formantu, zostają utracone

Harmonia głosów dla Audio
Cubase umożliwia szybkie tworzenie harmonii dla monofonicznego materiału audio.

Masz następujące opcje:
● Możesz ustawić Cubase na utworzenie domyślnych głosów harmonicznych dla Twojego audio.
● Możesz najpierw utworzyć ścieżkę akordów z kilkoma akordami, a następnie na tej ścieżce 
utworzyć głosy harmoniczne dla swojego audio.

W obu przypadkach dla wybranego zdarzenia audio przeprowadzana jest analiza VariAudio 
i tworzone są maksymalnie 4 kopie odpowiedniego utworu. Te nowe ścieżki o nazwach Soprano, 
Alto, Tenor i Bass zawierają niezależne kopie wybranego zdarzenia audio.
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Jeśli użyjesz tej funkcji bez ścieżki akordów, głosy zostaną rozłożone domyślnie. Jeśli utworzysz 
ścieżkę akordów z kilkoma akordami i ustawisz oryginalną ścieżkę tak, aby podążała za ścieżką 
akordów w trybie pojedynczego brzmienia, głosy harmoniczne zostaną rozłożone zgodnie 
z brzmieniem akordów.

Generowanie głosów harmonicznych dla dźwięku monofonicznego
Można automatycznie generować głosy harmoniczne dla dźwięku monofonicznego.

PROCEDURA
1. Opcjonalnie: Dodaj ścieżkę akordów do swojego projektu i skonfiguruj ją.
2. Wybierz opcję File > Import > Audio File (Plik > Importuj > Plik audio) i zaimportuj   
     monofoniczny plik audio.
3. W oknie Project wybierz zdarzenie audio.
4. Wybierz opcję Audio > Generate Harmony Voices (Audio > Generuj głosy harmoniczne).

5. Określ liczbę głosów, które chcesz utworzyć, wprowadź wartość redukcji wibracji i kliknij OK.

                

WYNIK
Zdarzenie audio jest analizowane, a segmenty VariAudio tworzone są automatycznie. Dla każdego 
głosu tworzona jest kopia zdarzenia ze zmienioną wysokością dźwięku i umieszczana na nowo 
utworzonej ścieżce.

UWAGA
● Jeśli dodano ścieżkę akordów, wysokość powstałych głosów będzie zgodna z głosami sopranu, 
altowego, tenorowego i basowego z brzmienia ścieżki akordowej.
● Jeśli pracujesz bez ścieżki akordów, wygenerowane segmenty VariAudio głosu numer 1 (sopran) 
są transponowane o 3 półtony w górę w stosunku do oryginalnego dźwięku. Segmenty głosów o 
numerach 2, 3 i 4 (alt, tenor i bas) są transponowane o 3, 6 i 9 półtonów w dół.

POWIĄZANE LINKI
Dodawanie ścieżki akordów na stronie 943 

Generate Harmony Voices Dialog (Okno dialogowe Generuj głosy 
harmoniczne)
Okno dialogowe Generate Harmony Voices umożliwia szybkie tworzenie harmonii dla 
monofonicznego materiału audio.
● Aby otworzyć okno dialogowe Generate Harmony Voises, wybierz zdarzenie audio w oknie 
Project i wybierz opcję Audio > Generate Harmony Voices (Audio > Generuj głosy 
harmoniczne).
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 Dostępne są następujące opcje:
Number of Voices (Liczba głosów)
Umożliwia wybór liczby generowanych głosów. Można wygenerować maksymalnie 4 głosy.
Reduce Vibrato Strength (Zmniejsz siłę wibracji)
Umożliwia ustawienie wartości redukcji wibracji. 
Open Sample Editor after Completion (Po zakończeniu otwórz edytor próbek)
Otwiera wygenerowane głosy wraz z oryginalnym zdarzeniem audio w Sample Editor (Edytorze 
próbek).

Audio Part Editor (Edytor części audio)

Edytor części audio zapewnia przegląd wybranych części audio. Umożliwia przeglądanie, 
odsłuchiwanie i edytowanie części poprzez wycinanie i wklejanie, przenikanie, rysowanie 
krzywych poziomów lub przetwarzanie części. Edycja nie ma charakteru destrukcyjnego, więc 
zmiany można cofnąć w dowolnym momencie.

Edytor części audio możesz otworzyć w oddzielnym oknie lub w dolnej strefie okna Project. 
Otwarcie Audio Part Editor w dolnej strefie okna projektu jest przydatne, jeśli chcesz uzyskać 
dostęp do funkcji edytora części audio ze stałej strefy okna Project.

Aby otworzyć część audio w Edytorze części audio, wykonaj jedną z następujących czynności:
● Kliknij dwukrotnie część audio w oknie Project.
● Wybierz część audio w oknie Project i naciśnij Return lub Ctrl/Cmd - E .
● Wybierz część audio w oknie projektu i wybierz opcję Audio > Open Audio Part Editor 
    (Audio > Otwórz edytor części audio).
● W oknie dialogowym Key Commands (Polecenia klawiszowe) w kategorii Editors (Edytory) 
   przypisz polecenie klawiszowe do narzędzia Open Audio Part Editor (Otwórz edytor części 
   audio). Wybierz część audio w oknie Project i użyj polecenia klawiszowego.

UWAGA
Jeśli wybierzesz opcję Audio > Set up Editor Preferences (Audio > Skonfiguruj preferencje 
edytora), na stronie Editors (Edytory) otworzy się okno dialogowe Preferences (Preferencje). 
Wprowadź zmiany, aby określić, czy chcesz, aby Edytor części audio otwierał się w oddzielnym 
oknie, czy w dolnej strefie okna Project.

Okno Audio Part Editor (Edytor części Audio):
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Audio Part Editor (Edytor części audio) w dolnej strefie okna projektu:

       

1   Toolbar (Pasek narzędzi)
             Zawiera narzędzia do wybierania, edytowania i odtwarzania części audio.
2   Info Line (Infolinia)
             Wyświetla informacje o częściach audio.
3   Ruler (Linijka)
             Wyświetla oś czasu i format wyświetlania projektu.

POWIĄZANE LINKI
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Otwieranie Edytora w dolnej strefie na stronie 71
Otwieranie Inspektora Edytora na stronie 62
Linijka na stronie 57
Linia informacyjna na stronie 59
Pasek narzędzi edytora części audio na stronie 575

Pasek narzędzi edytora części audio
Pasek narzędzi zawiera narzędzia do wybierania, edycji i odtwarzania części audio.

● Aby pokazać lub ukryć elementy paska narzędzi, kliknij pasek narzędzi prawym przyciskiem 
myszy i aktywuj lub dezaktywuj elementy.

Dostępne są następujące opcje:

Info/Solo (Informacje/Solo)
Solo Editor (Edytor solowy)

           
         Solo wybranego dźwięku podczas odtwarzania.

Left Divider (Lewy rozdzielacz)
Left Divider
Narzędzia umieszczone po lewej stronie rozdzielacza są zawsze pokazane.

Auto-Scroll
Link Project and Lower Zone Editor Cursors (Połącz kursory projektu i edytora dolnej strefy)

           
         Łączy osie czasu, kursory i współczynniki powiększenia dolnego edytora stref i okna 
         Project.

UWAGA
Nie można aktywować kursorów Link Project and Lower Zone Editor, jeśli aktywna jest 
Independent Track Loop (niezależna pętla ścieżki).

Auto Scroll

           
         Utrzymuje kursor projektu widoczny podczas odtwarzania.
Select Auto-Scroll Settings (Wybierz Ustawienia automatycznego przewijania)

            
          Umożliwia aktywację przewijania strony lub nieruchomego kursora oraz aktywację 
          wstrzymania automatycznego przewijania podczas edycji.

Preview (Zapowiedź)
Audition (Przesłuchanie)

          
         Odtwarza wybrany plik audio.
Audition Loop (Pętla przesłuchań)
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         Zapętla odtwarzanie do momentu dezaktywacji Audition.
Audition Volume (Głośność przesłuchania)

           
         Umożliwia regulację głośności.

Tool Buttons (Przyciski narzędzi)
Object Selection (Wybór obiektu)

          
         Wybiera części audio.
Range Selection (Wybór zakresu)

          
         Wybiera zakresy
Zoom (Powiększenie)

          
         Powiększa. Przytrzymaj Alt/Opt i kliknij, aby pomniejszyć.
Erase (Usuń)

         
        Usuwa części audio.
Split (Rozdziel)

         
       Dzieli części audio.

Mute (Wycisz)

         
        Wycisza części audio.
Comp

         
        Montaż trwa.
Draw (Rysuj)

         
        Rysuje krzywą głóśności.
Play (Graj)

         
        Umożliwia odtworzenie klipu od miejsca kliknięcia do momentu zwolnienia przycisku myszy.
Scrub (Szoruj)

         
        Umożliwia lokalizację pozycji.
Time Warp (Zniekształcenie czasu)

         
        Dopasowuje pozycje muzyczne zdarzeń do pozycji czasowych.

Multiple Part Controls (Sterowanie wieloma częściami)
Show Part Borders (Pokaż granice części)
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        Pokazuje/ukrywa obramowania części aktywnej części audio w lewym i prawym lokalizatorze
Edit Active Part Only (Edytuj tylko część aktywną)

         
        Ogranicza operacje edycyjne do aktywnej części.
Currently Edited Part (Aktualnie edytowana część)

         
       Wyświetla listę wszystkich części wybranych po otwarciu edytora i umożliwia aktywację 
       części.

Nudge Palette (Paleta szturchać)
Trim Start Left (Początek przycinania w lewo)

        
       Zwiększa długość wybranego elementu przesuwając jego początek w lewo.
Trim Start Right (Przycinanie rozpoczyna się w prawo)

        
       Zmniejsza długość wybranego elementu przesuwając jego początek w prawo.
Move Left (Przesuń w lewo)

        
       Przesuwa wybrany element w lewo.

Move Right (Przesuń w prawo)

         
        Przesuwa wybrany element w prawo.
Trim End Left (Przytnij koniec w lewo)

         
        Zmniejsza długość wybranego elementu przesuwając jego koniec w lewo.
Trim End Right (Przytnij koniec w prawo)

         
       Zwiększa długość wybranego elementu przesuwając jego koniec w prawo.

Snap (Przyciąganie)
Snap to Zero Crossing (Przyciągaj do przejścia przez zero)

         
       Ogranicza edycję do przejść przez zero, czyli pozycji, w których amplituda wynosi zero.
Snap On/Off (Włączanie/wyłączanie przyciągania)

          
       Ogranicza ruch poziomy i pozycjonowanie do określonych pozycji.
Snap Type (Typ przyciągania)

         
       Umożliwia określenie pozycji, do których mają być przyciągane zdarzenia.
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Grid Type (Typ siatki)
Grid Type

        
       Umożliwia wybór typu siatki. Opcje zależą od formatu wyświetlania wybranego dla linijki. 
       Jeśli jako format linijki wybierzesz sekundy, dostępne będą opcje siatki opartej na czasie. Jeśli  
       jako format linijki wybierzesz takty i uderzenia, dostępne będą opcje siatki muzycznej.

Quantize (Kwantyzacja)
Soft Quantize On/Off (Włączanie/wyłączanie miękkiej kwantyzacji)

        
       Aktywuje/dezaktywuje miękką kwantyzację.
AudioWarp Quantize On/Off (Włączanie/wyłączanie kwantyzacji AudioWarp)

        
       Aktywuje/dezaktywuje kwantyzację AudioWarp.
Quantize Presets (Ustawienia wstępne kwantyzacji)

        
       Umożliwia wybór ustawienia wstępnego kwantyzacji.
Apply Quantize (Zastosuj kwantyzację)

        
       Stosuje ustawienia kwantyzacji.
Open Quantize Panel (Otwórz panel kwantyzacji)

        
       Otwiera panel Kwantyzacji.

Event Colors (Kolory zdarzeń)
Select Color for Selected Tracks or Events (Wybierz kolor dla wybranych utworów lub zdarzeń)

        
       Umożliwia zdefiniowanie kolorów części audio.

Independent Track Loop (Niezależna pętla ścieżki)
Independent Track Loop

        
       Aktywuje/dezaktywuje niezależną pętlę ścieżki dla edytowanej części.
UWAGA
Jeśli aktywujesz Independent Track Loop, funkcja Link Project and Lower Zone Editor 
Cursors zostanie automatycznie wyłączona w dolnej strefie edytora.

Right Divider (Prawy rozdzielacz)
Right Divider
        Narzędzia umieszczone po prawej stronie rozdzielacza są zawsze pokazane.

Sterowanie strefą okienną (Sterowanie strefą okienną)
Open in Separate Window (Otwórz w osobnym oknie)

        
       Przycisk ten dostępny jest w dolnej strefie edytora. Otwiera edytor w osobnym oknie.
Open in Lower Zone (Otwórz w dolnej strefie)

585



        
       Przycisk ten dostępny jest w oknie edytora. Otwiera edytor w dolnej strefie okna Project.
Show/Hide Info (Pokaż/ukryj informacje)

        
       Umożliwia włączenie/wyłączenie linii informacyjnej.
Set up Toolbar (Skonfiguruj pasek narzędzi)

        
       Otwiera wyskakujące menu, w którym możesz ustawić, które elementy paska narzędzi mają 
       być widoczne.

POWIĄZANE LINKI
Połącz kursory projektu i edytora dolnych stref na stronie 73
Menu ustawień automatycznego przewijania na stronie 248
Wstrzymaj automatyczne przewijanie podczas edycji na stronie 248

Info Line (Linia informacyjna)
Linia informacyjna wyświetla informacje o części audio, takie jak początek, koniec, długość lub 
algorytm rozciągania czasu.

       

● Aby pokazać lub ukryć linię informacyjną, aktywuj opcję Show/Hide Info (Pokaż/Ukryj 
informacje) na pasku narzędzi. Stan włączenia/wyłączenia linii informacyjnej w oknie Audio Part 
Editor (Edytora części audio) i w edytorze dolnej strefy jest od siebie niezależny.

POWIĄZANE LINKI
Pasek narzędzi edytora części audio na stronie 575

Ruler (Linijka)
Linijka pokazuje oś czasu i format wyświetlania projektu.

Możesz wybrać osobny format wyświetlania, klikając przycisk strzałki po prawej stronie. Wybierz 
opcję z wyskakującego menu.

586



Lanes (Pasy)
Pasy mogą ułatwić pracę z kilkoma zdarzeniami audio w części. Przeniesienie niektórych zdarzeń 
na inną ścieżkę może znacznie ułatwić wybieranie i edycję.

Jeśli Snap (przyciąganie) jest wyłączone i chcesz przenieść zdarzenie na inny pas bez 
przypadkowego przesuwania go w poziomie, naciśnij klawisz Ctrl/Cmd podczas przeciągania go w
górę lub w dół.

POWIĄZANE LINKI
Obsługa ścieżek na stronie 161.

Operacje
Wszystkie operacje można wykonać w oknie Audio Part Editor (Edytora części audio) oraz 
w dolnej strefie edytora.
Powiększanie, zaznaczanie i edycja w Edytorze części audio odbywa się tak samo, jak w oknie 
Project.

UWAGA
Jeśli część jest kopią udostępnioną, wszelkie zmiany, które wykonasz, będą miały wpływ na 
wszystkie udostępnione kopie tej części.

POWIĄZANE LINKI
Okno projektu na stronie 44
Udostępnione kopie na stronie 219

Audition (Przesłuchanie)

Podczas odsłuchu za pomocą narzędzia Play  lub narzędzia Audition  dźwięk będzie 
kierowany bezpośrednio do Control Room (pokoju reżyserskiego) lub do głównego miksu 
(domyślna szyna wyjściowa), jeśli Control Room (reżyserka) jest wyłączona.
 
Przesłuchanie za pomocą narzędzia Audition (Przesłuchanie)
Możesz użyć narzędzia Audition (Przesłuchanie), aby bezpośrednio rozpocząć pojedyncze 
przesłuchanie wybranego fragmentu lub zapętlić przesłuchanie za pomocą funkcji Audition Loop 
(Pętla przesłuchania).
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PROCEDURA
1. Wykonaj jedną z następujących czynności:
      ● Aby odtworzyć fragment pomiędzy pierwszym i ostatnim wybranym zdarzeniem, wybierz 
          zdarzenia za pomocą narzędzia Object Selection (Zaznaczanie obiektów).
      ● Aby odtworzyć zakres, wybierz zakres za pomocą narzędzia Range Selection (Zaznaczanie 
         zakresu).
      ● Aby rozpocząć odtwarzanie od bieżącej pozycji kursora, ustaw kursor projektu w tej pozycji.
2. Na pasku narzędzi kliknij Audition (Przesłuchanie).
UWAGA
Jeśli aktywujesz Audition Loop, odtwarzanie będzie kontynuowane do momentu wyłączenia 
Audition.

POWIĄZANE LINKI
Pasek narzędzi edytora części audio na stronie 575

Przesłuchanie za pomocą narzędzia Play

PROCEDURA
1. Wybierz opcję Play (Odtwórz) na pasku narzędzi.
2. W części audio kliknij i przytrzymaj pozycję, od której chcesz rozpocząć przesłuchanie.

WYNIK
Przesłuchujesz część audio. Przesłuchanie zakończy się na końcu klikniętej części.

POWIĄZANE LINKI
Pasek narzędzi edytora części audio na stronie 575

Odsłuch przy użyciu zwykłego odtwarzania

PROCEDURA
1. Ustaw kursor projektu w pozycji, od której chcesz rozpocząć odtwarzanie.
2. Opcjonalnie: na pasku narzędzi Audio Part Editor (Edytora części audio) aktywuj Solo Editor  

    (Edytor Solo). W ten sposób odtwarzane będą tylko zdarzenia z edytowanej części.
3. Na panelu Transport aktywuj Start.

Konfigurowanie Independent Track Loop (niezależnej pętli ścieżki)

Niezależna pętla ścieżki jest rodzajem minicyklu, wpływającego tylko na edytowaną część. Po 
włączeniu pętli zdarzenia w częściach znajdujących się w pętli będą powtarzane w sposób ciągły i 
całkowicie niezależny – inne zdarzenia (na innych ścieżkach) będą odtwarzane w zwykły sposób. 
Jedyna interakcja między pętlą a zwykłym odtwarzaniem polega na tym, że pętla rozpoczyna się za 
każdym razem, gdy cykl zaczyna się od nowa.

PROCEDURA
1. Aktywuj  Independent Track Loop (niezależną pętlę ścieżki) na pasku narzędzi.
UWAGA
Jeśli aktywujesz Independent Track Loop, funkcja Link Project i  Lower Zone Editor Cursors 
(kursory dolnej strefy edytora) zostaną automatycznie wyłączone w edytorze dolnej strefy.

Jeśli nie jest widoczna, kliknij pasek narzędzi prawym przyciskiem myszy i dodaj sekcję 
Independent Track Loop.
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2. Ctrl/Cmd – kliknij linijkę, aby ustawić początek i Alt/Opt – kliknij, aby ustawić koniec pętli.
UWAGA
Możesz także edytować numerycznie pozycje początku i końca pętli w polach obok przycisku Loop
(Pętla).

WYNIK
Pętla jest oznaczona na linijce kolorem niebieskim.

UWAGA
Zdarzenia są zapętlane, dopóki przycisk Loop jest aktywny i otwarty jest Audio Part Editor 
(Edytor części audio).

POWIĄZANE LINKI
Opcje konfiguracji na stronie 1145
Pasek narzędzi edytora części audio na stronie 575

Scrub (Szoruj)

W Audio Part Editor (Edytorze części audio) narzędzie Scrub ma osobną ikonę na pasku 
narzędzi. Oprócz tego, szorowanie działa dokładnie tak, jak w oknie Project.

POWIĄZANE LINKI
Szorowanie na stronie 205

Obsługa kilku części
Gdy otworzysz Audio Part Editor (Edytor części audio) z wybranymi kilkoma częściami – 
wszystkie na tej samej ścieżce lub na różnych ścieżkach – mogą one nie zmieścić się w oknie 
edytora, co może utrudniać uzyskanie przeglądu różnych części podczas edycji.

Dlatego na pasku narzędzi znajdują się funkcje, dzięki którym praca z wieloma częściami staje się 
łatwiejsza i bardziej wszechstronna:

● Wyskakujące menu Currently Edited Part (Aktualnie edytowana część) zawiera listę 
wszystkich części wybranych podczas otwierania edytora i pozwala wybrać, która część jest 
aktywna do edycji. Po wybraniu części z listy jest ona automatycznie aktywowana i wyśrodkowana 
na wyświetlaczu.
UWAGA
Możesz także aktywować część, klikając ją za pomocą narzędzia Object Selection (Zaznaczanie 
obiektów).
●  Edit Active Part Only (Edytuj tylko aktywną część) pozwala ograniczyć operacje edycji tylko 
    do aktywnej części. Jeśli wybierzesz Edit > Select > All (Edycja > Zaznacz > Wszystko) przy 
    włączonej tej opcji, wybrane zostaną wszystkie zdarzenia w aktywnej części, ale nie zdarzenia w 
    innych częściach.
● Możesz powiększyć aktywną część tak, aby była wyświetlona w całości w oknie, wybierając   
   Edit > Zoom > Zoom to Event (Edycja > Powiększ > Powiększ do zdarzenia)
● Opcja Show Part Borders (Pokaż granice części) może być użyta, jeśli chcesz zobaczyć 
   wyraźnie określone granice aktywnej części. Jeśli ta opcja jest włączona, wszystkie części oprócz 
   aktywnej są wyszarzone, dzięki czemu krawędzie są łatwo widoczne. Na linijce znajdują się także
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   dwa znaczniki z nazwą aktywnej części, wyznaczające jej początek i koniec. Można je swobodnie
   przesuwać, aby zmienić granice części.
● Możliwe jest przełączanie pomiędzy częściami, aktywowanie ich za pomocą poleceń 
   klawiszowych. W oknie dialogowym Key Commands (Polecenia klawiszowe) w kategorii Edit 
   (Edycja) dostępne są dwie funkcje: Activate Next Part (Aktywuj następną część) i Activate 
   Previous Part (Aktywuj poprzednią część). Jeśli przypiszesz do nich polecenia klawiszowe,  
   możesz ich używać do przełączania się między częściami.

POWIĄZANE LINKI
Kluczowe polecenia na stronie 1123
Pasek narzędzi edytora części audio na stronie 575

Rozszerzenia w Cubase

Cubase obsługuje rozszerzenia takie jak Audio Random Access (ARA). ARA umożliwia integrację 
kompatybilnych programów w postaci wtyczek z DAW. Integracja ta pozwala na losowy dostęp do 
zdarzeń audio w kontekście muzycznym Twojego projektu.

Aby móc używać programu jako rozszerzenia, należy najpierw zainstalować i zarejestrować ten 
program. Następnie Cubase automatycznie ładuje rozszerzenie i możesz je aktywować z poziomu 
programu.

Wszystkie rozszerzenia zainstalowane w systemie są wymienione w oknie System Component 
Information (Informacje o składnikach systemu) (strona Extensions (Rozszerzenia)). 
Rozszerzenia, które mogą powodować problemy ze stabilnością lub nawet powodować awarię 
programu, są dezaktywowane. Jeśli nadal chcesz z nich korzystać, musisz je aktywować ręcznie w 
oknie System Component Information (Informacje o komponencie systemu).

W Cubase rozszerzenia są zintegrowane z Editor (Edytorem). Informacje takie jak oś czasu i tempo
projektu są udostępniane pomiędzy oknem Projektu i Edytorem.

POWIĄZANE LINKI
Aktywacja rozszerzenia w Cubase na stronie 584
Okno Informacje o składnikach systemu na stronie 472
Edytor rozszerzeń na stronie 585
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Aktywacja rozszerzenia w Cubase
Aby móc korzystać z rozszerzenia w Cubase należy je aktywować.

WARUNEK WSTĘPNY
Zainstalowałeś i zarejestrowałeś rozszerzenie.

PROCEDURA
1. W oknie Project wybierz zdarzenie audio, które chcesz edytować.
2. Wykonaj jedną z następujących czynności:
     ● Wybierz opcję Audio > Extensions (Audio > Rozszerzenia) i wybierz żądane rozszerzenie.
     ● Kliknij prawym przyciskiem myszy zdarzenie audio, wybierz Extensions (Rozszerzenia) i    
        wybierz żądane rozszerzenie.
     ● Kliknij pole Extension (Rozszerzenie) w wierszu informacyjnym i wybierz żądane   
        rozszerzenie.

UWAGA
Jeśli pole Extension (Rozszerzenie) nie jest wyświetlane, kliknij prawym przyciskiem myszy 
wiersz informacyjny, aby otworzyć menu kontekstowe, które pozwala skonfigurować widoczne 
elementy i ich kolejność.

WYNIK
Rozszerzenie zostanie aktywowane, a jego interfejs zostanie wyświetlony w Editor (Edytorze). W 
tym miejscu możesz edytować zdarzenie audio.
W oknie Project zdarzenie audio jest oznaczone symbolem w prawym górnym rogu. To wskazuje
że rozszerzenie jest aktywne.
Więcej informacji na temat funkcji rozszerzenia można znaleźć w jego dokumentacji.

POWIĄZANE LINKI
Konfiguracja menu kontekstowych na stronie 1145

Edytor rozszerzeń
W Cubase rozszerzenia są zintegrowane z edytorem. Stamtąd masz dostęp do wszystkich funkcji 
edycyjnych.

Aby edytować zdarzenie audio z rozszerzeniem w Edytorze, wybierz zdarzenie audio w oknie 
Project i wykonaj jedną z następujących czynności:
      ● Wybierz opcję Audio > Extensions (Audio > Rozszerzenia) i wybierz rozszerzenie.
      ● Kliknij pole Extension (Rozszerzenie) w linii informacyjnej okna Project i wybierz 
         rozszerzenie.
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Edytor Melodyne w dolnej strefie okna Projektu.

1   Project window event display (Wyświetlanie zdarzeń w oknie projektu)
     Umożliwia obejrzenie edytowanego zdarzenia audio w jego kontekście muzycznym.
2   Audio event (Zdarzenie audio)
     Jeśli dla zdarzenia audio zostało włączone rozszerzenie, zdarzenie w oknie Projektu jest  
     oznaczone symbolem w prawym górnym rogu.

                      
3   Extension editor (Edytor rozszerzeń)
     Pokazuje interfejs użytkownika aktywowanego rozszerzenia i umożliwia dostęp do jego funkcji. 
     Cubase zapewnia akustyczną informację zwrotną o zmianach podczas edycji. Zmiany dokonane 
     za pomocą rozszerzenia są zapisywane w projekcie.
     Więcej informacji na temat funkcji wybranego rozszerzenia można znaleźć w jego 
     dokumentacji.
4   Add Events/Remove Events (Dodaj zdarzenia/Usuń zdarzenia)
     Automatycznie włącza/wyłącza rozszerzenie dla wszystkich zdarzeń wybranych w oknie 
     Project.

5   Extension field on the info line (Pole rozszerzenia w linii informacyjnej)
     Pole Rozszerzenie w linii informacyjnej umożliwia aktywację/dezaktywację rozszerzenia.
6   Open in Separate Window (Otwórz w osobnym oknie)
     Otwiera rozszerzenie w osobnym oknie. Aby wyświetlić rozszerzenie w edytorze dolnej strefy, 
     kliknij Open in Lower Zone (Otwórz w dolnej strefie).

UWAGA
Rozszerzenia nie mogą być otwierane w dolnej strefie Edytora i jednocześnie w osobnym oknie.

Aktywacja rozszerzenia dla dalszych zdarzeń audio
Możesz aktywować rozszerzenie dla więcej niż jednego zdarzenia audio za pomocą Edytora 
rozszerzeń.
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WARUNEK WSTĘPNY
● Twój projekt zawiera co najmniej dwa zdarzenia audio i dla jednego z nich aktywowałeś   
   rozszerzenie.
● Rozszerzenie Editor (Edytor) jest otwarte w dolnej strefie okna Project

PROCEDURA
1. W rozszerzeniu Editor (Edytor) aktywuj Add Events (Dodaj zdarzenia).
2. W oknie Project wybierz zdarzenie audio, dla którego chcesz aktywować rozszerzenie.

UWAGA
Aby aktywować rozszerzenie dla kilku zdarzeń, przeciągnij prostokąt zaznaczenia, aby wybrać 
zdarzenia i kliknij jedno z nich.

WYNIK
Rozszerzenie zostanie aktywowane dla tego zdarzenia audio, a zdarzenie audio zostanie pokazane 
w edytorze rozszerzenia

PO WYKONANIU TEGO ZADANIA
Dezaktywuj opcję Add Events (Dodaj zdarzenia), aby uniknąć przypadkowej aktywacji 
rozszerzenia dla zdarzeń audio wybranych w oknie Project.

Dezaktywacja rozszerzenia dla zdarzeń audio
Możesz dezaktywować rozszerzenie dla wydarzeń audio za pomocą Editor (Edytora) rozszerzeń.

WARUNEK WSTĘPNY
● Rozszerzenie Editor (Edytor) jest otwarte w dolnej strefie okna Project.

PROCEDURA
1. W rozszerzeniu Editor aktywuj Remove Events (Usuń zdarzenia).
2. W oknie Project wybierz zdarzenie audio, dla którego chcesz dezaktywować rozszerzenie.

UWAGA
Aby dezaktywować rozszerzenie dla kilku zdarzeń, przeciągnij prostokąt zaznaczenia, aby wybrać 
zdarzenia i kliknij jedno z nich

WYNIK
Rozszerzenie jest dezaktywowane dla tego zdarzenia audio, a w dolnej strefie okna projektu 
zdarzenie audio jest wyświetlane w Sample Editor (Edytorze próbek).

PO ZAKOŃCZENIU TEGO ZADANIA
Dezaktywuj Remove Events (Usuń zdarzenia), aby uniknąć przypadkowej dezaktywacji 
rozszerzenia dla zdarzeń audio wybranych w oknie Project.

Edycja zdarzeń audio
Zdarzenia audio możesz edytować w rozszerzeniu Editor oraz w oknie Project.
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Jeśli aktywujesz rozszerzenie dla zdarzenia audio, możesz od razu nad nim pracować w 
rozszerzeniu Editor. Cała edycja dokonana w rozszerzeniu Editor jest automatycznie renderowana 
do oryginalnego pliku i nie ma potrzeby trwałego stosowania zmian poprzez odbijanie zdarzenia 
audio. W rezultacie możesz zastosować zanikanie i obwiednie zdarzeń, a także edycję 
zniekształcenia (warp) edytowanych zdarzeń. Ponadto wejście audio dla zdarzeń audio pozostaje w 
pamięci buforowej.

W oknie Project możesz dzielić, kopiować, wklejać i zmieniać rozmiar zdarzeń audio edytowanych
za pomocą rozszerzenia, a także możesz cofać zmiany za pomocą opcji Undo (Cofnij).

Ograniczenia

Jeżeli rozszerzenie jest aktywowane, możesz je edytować jedynie za pomocą narzędzi dostępnych 
w rozszerzeniu Editor. Nie można uzyskać dostępu do żadnej opcji Sample Editor (Edytora 
próbek). Nie można zniekształcać tego zdarzenia, aktywować Musical Mode (trybu muzycznego), 
wykonywać edycji Hitpoint (punktów hitowych), kwantyzacji AudioWarp, bezpośredniego 
przetwarzania offline, rozciągania czasu z zastosowaniem rozmiaru, generować głosów 
harmonicznych ani wyrównywania dźwięku.

Nie można transponować zdarzenia za pomocą linii informacyjnej, dostrajać go ani odwracać jego 
fazy.

UWAGA
Wszystkie procesy offline, które zastosowałeś do zdarzenia audio przed aktywacją rozszerzenia dla 
niego, zostaną zachowane i staną się ponownie dostępne po dezaktywacji rozszerzenia dla 
zdarzenia.

UWAGA
Jeśli edytujesz wiele wybranych zdarzeń w oknie Project, pamiętaj, że wspomniane funkcje nie 
mają wpływu na wydarzenia, dla których aktywowałeś rozszerzenie.

POWIĄZANE LINKI
Opcje zmiany rozmiaru zdarzenia na stronie 213
Dzielenie zdarzeń na stronie 215
Powielanie zdarzeń na stronie 217
Wklejanie zdarzeń na stronie 217
O przetwarzaniu udostępnionych klipów na stronie 1162
Określanie czasu wstępnego nagrywania audio na stronie 274

Sampler Tracks (Ścieżki próbkowe, 
samplera)

Funkcja ścieżki samplera umożliwia chromatyczne odtwarzanie dowolnego dźwięku z biblioteki 
próbek audio za pośrednictwem MIDI. Możesz tworzyć i edytować nowe dźwięki w oparciu o 
określone próbki i integrować je z istniejącym projektem.

Funkcja ścieżki samplera obejmuje:
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● Sekcję Sampler Control w dolnej strefie okna Project. Tutaj możesz ładować i edytować próbki 
   audio, wybierać pomiędzy różnymi trybami odtwarzania lub przesyłać próbki do instrumentów 
   Steinberg VST.
● Ścieżkę samplera w projekcie, która umożliwia sterowanie odtwarzaniem sampla załadowanego  
   do Sampler Control (sterowania próbnikiem) poprzez MIDI.

POWIĄZANE LINKI
Sterowanie próbnikiem na stronie 589
Ścieżki samplera na stronie 129
Tworzenie ścieżek samplera na stronie 589

Ładowanie próbek audio do Sampler Control (Próbnika sterowanego)
Możesz załadować próbki audio do Sampler Control (Próbnika sterowanego), przeciągając.

Cubase umożliwia ładowanie próbek mono lub stereo w formacie pliku .wav lub .aiff lub plików 
audio REX i REX2 utworzonych przez ReCycle z oprogramowania Propellerhead do Sampler 
Control.

● Aby załadować próbkę audio, przeciągnij ją z wnęki MediaBay, okna Project lub Eksploratora 
plików/macOS Finder i upuść ją w Sampler Control.

WAŻNE
Jeśli Sampler Control zawiera już próbkę audio, ta próbka i wszystkie jej ustawienia zostaną 
nadpisane.

UWAGA
● Próbki audio ładowane do Sampler Control (Próbnika sterowanego) nie są kopiowane do 
folderu audio projektu. Jeśli chcesz zarchiwizować lub udostępnić swój projekt, zawierający 
wszystkie próbki audio załadowane do Sampler Control, musisz utworzyć samodzielny projekt.
● W puli wszystkie próbki audio, które załadowałeś do Sampler Control, są wymienione w 
dedykowanym podfolderze ścieżki samplera w głównym folderze audio.
● Zaimportowane pliki REX i REX2 są konwertowane do plików w formacie .wav. Pliki te są 
przechowywane w folderze wav, utworzonym oprócz oryginalnego pliku.
W Sampler Control tryb odtwarzania jest automatycznie ustawiany na Slice (Plasterek) ze 
znacznikami plasterków ustawionymi zgodnie z definicją w zaimportowanym pliku REX

POWIĄZANE LINKI
Projekty samodzielne na stronie 110
Pula (Pool) na stronie 610

Ładowanie partii MIDI do Sampler Control (Próbnika sterowanego)
Możesz załadować partie MIDI ze ścieżek instrumentów lub ścieżek MIDI do sterowania 
próbnikiem, przeciągając.

UWAGA
Aby to zadziałało, ścieżka instrumentu lub ścieżka MIDI musi zostać skierowana do instrumentu 
VST.

● Aby załadować partię MIDI, przeciągnij ją z wnęki MediaBay, okna projektu lub okna 
eksploratora plików/macOS Finder i upuść ją w Sampler Control.
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WAŻNE
Jeśli Sampler Control zawiera już komunikat MIDI, zostanie on nadpisany.

Cubase tworzy plik audio z partii MIDI. Obejmuje to dźwięk instrumentu i ustawienia kanałów z 
instrumentu VST lub kanału zwrotnego. Plik audio zostanie skopiowany do folderu audio projektu.

POWIĄZANE LINKI
Instrumenty VST na stronie 726
Inspektor ścieżki instrumentu na stronie 127
Inspektor ścieżek MIDI na stronie 134

Tworzenie ścieżek samplera (próbnych)

Aby utworzyć ścieżkę samplera, wykonaj jedną z następujących czynności:
● W oknie Project wybierz zdarzenie audio i wybierz opcję Audio > Create Sampler Track   
   (Audio > Utwórz ścieżkę samplera).
● We wnęce MediaBay kliknij plik audio prawym przyciskiem myszy i wybierz opcję Create 
   Sampler Track (Utwórz ścieżkę próbną).
● W inspektorze Sample Editor otwórz sekcję Range (Zakres) i kliknij opcję Create Sampler  
   Track. Spowoduje to utworzenie ścieżki próbnej z wybranego zakresu. Jeśli nie zostanie wybrany
   żaden zakres, użyte zostanie całe zdarzenie.
● Z menu kontekstowego listy utworów wybierz opcję Add Sampler Track (Dodaj ścieżkę  
   próbną). W tym przypadku Sampler Control (Próbnik sterowany) jest pusty i należy załadować 
   próbkę audio poprzez przeciągnięcie.

Sampler Control (Próbnik sterowany)
Jeśli wybrana jest ścieżka samplera, w dolnej strefie okna Project dostępny jest Sampler Control. 
Funkcja Sampler Control umożliwia przeglądanie, edycję i odtwarzanie sampli lub określonych 
ich sekcji.

    

1   Toolbar (Pasek narzędzi)
     Zawiera narzędzia umożliwiające wybór i edycję próbki audio, organizowanie presetów ścieżek  
     i przesyłanie próbki wraz z jej ustawieniami do instrumentu.
2   Waveform display/Envelope editor (Wyświetlanie przebiegu/edytor obwiedni)
     Pokazuje obraz fali próbki i umożliwia zdefiniowanie zakresu odtwarzania próbki oraz 
     ustawienie pętli. Jeśli widoczne są edytory obwiedni dla tonu (pitch), filtra lub sekcji 
     wzmacniacza, możesz tutaj dostosować ich ustawienia krzywej obwiedni.
3   Playback and Sound Parameter section (Sekcja parametrów odtwarzania i dźwięku)
     Umożliwia dokonanie ustawień dla różnych trybów odtwarzania (Normal, AudioWarp i Slice),
     strojenia i modulacji wysokości dźwięku (sekcja Pitch), filtrowania (sekcja Filter) oraz poziomu
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     i panoramy (sekcja Amp)
4   Keyboard section (Sekcja klawiatury)
     Umożliwia ustawienie zakresu tonacji próbki, jej tonacji głównej i zakresu modulacji koła  
     Pitchbend. Te ustawienia są używane podczas pracy z zewnętrznym urządzeniem MIDI.

POWIĄZANE LINKI
Tworzenie ścieżek samplera na stronie 589
Wyświetlanie przebiegu na stronie 594
Edytory obwiedni na stronie 599
Parametry odtwarzania i dźwięku na stronie 595
Sekcja dotycząca klawiatury na stronie 603

Pasek narzędzi Sampler Control (Próbnika sterowanego)
Pasek narzędzi Sampler Control zawiera różne ustawienia i funkcje.

Read Automation (Przeczytaj Automatyzację)

        
       Umożliwia odczyt automatyzacji torów.
Write Automation (Napisz automatyzację)

        
       Umożliwia pisanie automatyzacji ścieżek.
Switch between A/B Settings (Przełącz między ustawieniami A/B)

        
       Umożliwia przełączanie pomiędzy różnymi ustawieniami parametrów
Event Received Indicator (Wskaźnik odebrania zdarzenia)

        
       Ta dioda LED wskazuje przychodzące komunikaty MIDI przez wybrane wejście MIDI. Dioda 
       LED zapala się po otrzymaniu komunikatu o nucie i kontrolerze. W ten sposób możesz 
       sprawdzić, czy Cubase i klawiatura MIDI są podłączone do tego samego wejścia urządzenia 
       MIDI.
Snap to Zero Crossing (Przyciągaj do przejścia przez zero)

        
       Ogranicza edycję próbek do przejść przez zero, to znaczy do pozycji, w których amplituda 
       wynosi zero.
Auto-Scroll (Automatyczne przewijanie)

        
       Utrzymuje kursor projektu widoczny podczas odtwarzania.

Preset section (Sekcja wstępnego ustawienia)

        
       Pokazuje nazwę presetu ścieżki, załadowanego dla ścieżki samplera. Można także zapisywać i 
       ładować gotowe ustawienia.
Import Audio File (Importuj plik audio)

       
      Otwiera okno dialogowe Import Audio (Importuj audio), które umożliwia załadowanie pliku 
      audio do Sampler Control (Próbnika sterowanego).
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UWAGA
Jeśli Sampler Control zawiera już plik audio, oryginalny plik zostanie zastąpiony nowym.

File Name (Nazwa pliku)

        
       Pokazuje nazwę pliku próbki.
Tempo

        
       Pokazuje tempo pętli odczytane z pliku próbki lub obliczone na podstawie długości próbki. W 
       trybie odtwarzania plasterków (Slice) tę wartość można dostosować ręcznie.
Root Key (Klucz główny)

        
       Pokazuje klucz główny, który określa wysokość próbki. Możesz zmienić klucz główny, 
       wprowadzając nową wartość w polu wartości lub przeciągając uchwyt klawisza głównego na 
       klawiaturze Sampler Control.
Fixed Pitch (Naprawiona wysokość)

        
       Jeśli próbka jest wyzwalana nutą MIDI inną niż ta zdefiniowana w ustawieniu Root Key, 
       próbka jest odpowiednio tonowana. Jeśli włączona jest opcja Fix Pitch, związek między graną 
       nutą a tonacją główną jest pomijany i wszystkie klawisze odtwarzają próbkę tak, jak została 
       nagrana.
UWAGA
To ustawienie jest dostępne tylko w trybie odtwarzania Normal i AudioWarp.

Loop Mode (Tryb pętli)

        
       Umożliwia wybór trybu pętli do odtwarzania poprzez MIDI.

● Jeśli ta opcja jest ustawiona na No Loop (Bez pętli), próbka zostanie odtworzona raz.
● Jeśli ta opcja jest ustawiona na Continuous (Ciągle), próbka jest odtwarzana w ciągłej pętli.
● Jeśli ta opcja jest ustawiona na Alternate (Przemiennie), próbka jest odtwarzana w pętli  
   naprzemiennie do przodu i do tyłu.
● Jeśli ta opcja jest ustawiona na Once (Raz), próbka zostanie zapętlona jednokrotnie.
● Jeśli ta opcja jest ustawiona na Until Release (Aż do zwolnienia), próbka będzie powtarzana w 
   pętli aż do zwolnienia klawisza na klawiaturze.
● Jeśli ta opcja jest ustawiona na Alternate Until Release (Przemiennie, aż do zwolnienia), pętla   
   będzie naprzemiennie przewijać do przodu i do tyłu tak długo, jak długo będziesz przytrzymywał 
   klawisz. 
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UWAGA
To ustawienie jest dostępne tylko w trybie odtwarzania Normal i AudioWarp.

Signature (Metrum)

        
       Pokazuje wykryte metrum próbki. Możesz dostosować tę wartość ręcznie

UWAGA
To ustawienie jest dostępne tylko w trybie odtwarzania Slice (Plasterek).

Bars/Beats (Takty/Uderzenia)

        
       Te pola wartości pokazują wykrytą długość próbki w taktach i uderzeniach. Możesz 
       dostosować te wartości ręcznie, co wpływa na siatkę i tempo.

UWAGA
To ustawienie jest dostępne tylko w trybie odtwarzania Slice.

Grid (Siatka)

        
       Ustawia siatkę.

UWAGA
To ustawienie jest dostępne tylko w trybie odtwarzania Slice.

One Shot (Jeden strzał)

        
       Próbka jest odtwarzana jednokrotnie od początku do końca, niezależnie od ustawień pętli.

Normalize Sample (Normalizuj próbkę)

        
       Normalizuje próbkę, wykrywając najwyższy poziom szczytowy w próbce i dostosowując 
       wzmocnienie, aby osiągnąć ustawioną wartość Normalization Level (Poziomu normalizacji). 
       Sample Gain umożliwia późniejszą ręczną modyfikację wartości wzmocnienia.

Trim Sample (Przytnij próbkę)

        
       Przycina próbkę do wybranego zakresu. Jeśli nie zostanie wybrany żaden zakres, próbka 
       zostanie przycięta do zakresu ustawionego za pomocą znaczników początku/końca próbki. 
       Revert to Full Sample (Przywróć pełną próbkę) resetuje próbkę do pierwotnego zakresu.
UWAGA
To ustawienie jest dostępne tylko w trybie odtwarzania Normal i AudioWarp.

Reverse Sample (Odwrotna próbka)

       
      Odwraca próbkę. Umożliwia to odtworzenie próbki od tyłu.
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Monophonic Mode (Tryb monofoniczny)

        
       Aktywuje odtwarzanie monofoniczne. W przypadku instrumentów solowych zwykle skutkuje 
       to bardziej naturalnie brzmiącym wykonaniem. Jeśli włączone jest odtwarzanie monofoniczne, 
       nuta skradziona przez inną nutę zostanie uruchomiona ponownie jeśli nadal będziesz trzymać 
       skradzioną nutę, gdy wypuścisz nową. W ten sposób możesz grać tryle, na przykład 
       przytrzymując jedną nutę i szybko i wielokrotnie naciskając i zwalniając inną nutę.

UWAGA
Jeśli tryb monofoniczny jest wyłączony, możesz grać jednocześnie do 128 nut.

Jeśli Legato Mode (Tryb Legato) jest również aktywny i grasz nuty legato, tylko wysokość próbki 
jest ustawiana na nową nutę, ale sampel nie zostanie ponownie wyzwolony, a obwiednie będą dalej 
działać.
Lock Parameter Settings (Zablokuj ustawienia parametrów)

        
       Jeśli ta opcja jest aktywna, bieżące ustawienia parametrów Sampler Control (Próbnik 
       sterowany) zostaną zachowane, jeśli załadujesz kolejną próbkę do Sampler Control.
UWAGA
Parametry bezpośrednio powiązane z próbką, na przykład początek/koniec próbki, początek/koniec 
pętli, tonacja główna lub tempo, nie są zachowywane i zamiast tego pobierane są z nowej próbki.

MIDI Reset (Reset MIDI)

        
       Zatrzymuje odtwarzanie i resetuje wszystkie kontrolery MIDI do wartości domyślnych. Jest to  
       przydatne, jeśli chcesz zatrzymać odtwarzanie długiej próbki audio w trybie One Shot (Jeden  
       strzał).
Transfer to New Instrument (Przeniesienie na nowy instrument)

        
       Umożliwia przesłanie próbki audio wraz ze wszystkimi ustawieniami Sampler Control do 
       instrumentu, który jest załadowany na nową ścieżkę instrumentu.
Open in Separate Window (Otwórz w osobnym oknie)

        
       Otwiera Sampler Control w oddzielnym oknie.
Open in Lower Zone (Otwórz w dolnej strefie)

        
       Otwiera Sampler Control w dolnej strefie.

POWIĄZANE LINKI
Ręczne ustawianie klucza głównego na stronie 605
Konfigurowanie pętli dla próbek audio na stronie 605
Normalizowanie próbek na stronie 607
Przesyłanie próbek ze sterownika samplera do instrumentów VST na stronie 608
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Wyświetlanie przebiegu
Wyświetlacz przebiegu pokazuje przebieg próbki audio. Umożliwia zdefiniowanie początku i końca
próbki audio, pętli oraz narastania/zanikania (fade in/fade out) sygnału.

      

Set Sample Start (Ustaw początek próbki)
       Określa początek próbki. Podczas odtwarzania cały dźwięk przed rozpoczęciem próbki jest 
       ignorowany.
Set Sample End (Ustaw koniec próbki)
       Definiuje koniec próbki. Podczas odtwarzania cały dźwięk po zakończeniu próbki jest 
       ignorowany.
Set Sample Start and End Markers Simultaneously (Ustaw jednocześnie znaczniki początku i 
końca próbki)
       Kiedy przesuwasz kursor myszy pomiędzy znacznikiem początku i końca próbki, na wysokości
       flag znacznika pojawia się pasek łączący. Przeciągnięcie tego paska przesuwa oba znaczniki 
       jednocześnie, zachowując ich względną odległość.
Set Sustain Loop Start (Ustaw początek pętli podtrzymującej)
       Określa, gdzie zaczyna się pętla podtrzymania.
Set Sustain Loop End (Ustaw koniec pętli podtrzymania)
       Określa, gdzie kończy się pętla podtrzymania. Po osiągnięciu tego znacznika odtwarzanie 
       powraca do początku pętli podtrzymania.
Set Sustain Loop Start and End Markers Simultaneously (Ustaw jednocześnie znaczniki 
początku i końca pętli podtrzymania)
       Kiedy przesuwasz kursor myszy pomiędzy znacznikiem początku i końca pętli podtrzymania, 
       na wysokości flag znaczników pojawia się pasek łączący. Przeciągnięcie tego paska przesuwa 
       oba znaczniki jednocześnie, zachowując ich względną odległość.
Set Fade In Length (Ustaw długość narastania)
       Określa długość narastania.
Set Fade Out Length (Ustaw długość zanikania)
       Określa długość zanikania.
Set Sustain Loop Crossfade Length (Ustaw długość przenikania pętli Sustain)
       Przenikanie pętli umożliwia uzyskanie płynniejszych pętli. Ten znacznik określa długość 
       przejścia pętli.

Ruler (Linijka)
Linijka pokazuje oś czasu w określonym formacie wyświetlania.

● Aby wybrać format, kliknij przycisk strzałki po prawej stronie linijki i wybierz opcję z 
wyskakującego menu.
Możesz wyświetlać takty i uderzenia, sekundy lub próbki.

Zooming (Powiększanie)

● Aby powiększyć/pomniejszyć oś czasu i poziomu, użyj suwaków powiększenia w poziomie i 
pionie lub odpowiednich poleceń klawiszowych.
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POWIĄZANE LINKI
Polecenia klawiszowe na stronie 1123

Parametry odtwarzania i dźwięku
W sekcjach poniżej wyświetlania przebiegu można dokonać ustawień dla różnych trybów 
odtwarzania (Normal (Normalny), AudioWarp (Automatyczne zniekształcanie) i Slice 
(Plasterek)), strojenia i modulacji wysokości dźwięku (sekcja Pitch), filtrowania (sekcja Filter) 
oraz poziomu i panoramy (sekcja Amp (Wzmacniacz)).

POWIĄZANE LINKI
Sekcja odtwarzania na stronie 595
Sekcja Pitch na stronie 598
Sekcja Filter na stronie 598
Sekcja Amp (wzmacniacza) na stronie 599

Playback Section (Sekcja odtwarzania)
W sekcji odtwarzania możesz wybierać pomiędzy różnymi sposobami odtwarzania próbek

Normal Playback (Normalne odtwarzanie)
W tym trybie odtwarzania możesz wybrać jakość odtwarzania próbki. Kiedy próbki są odtwarzane 
w innej tonacji niż oryginalna, możesz wybierać pomiędzy różnymi algorytmami ich transpozycji  
w czasie rzeczywistym.

              
● Aby aktywować ten tryb, wybierz opcję Normal (Normalny) w sekcji odtwarzania.

Quality (Jakość)
Ustawia jakość odtwarzania.
●   Standard (Standardowa), High (Wysoka), Best (Najlepsza) i Extreme (Ekstremalna) 
zapewniają różne algorytmy transpozycji próbek w czasie rzeczywistym. Im wyższe ustawienie 
jakości, tym lepsze tłumienie artefaktów, szczególnie przy wyższych częstotliwościach, i tym 
większe obciążenie procesora. W przypadku próbek o niewielkiej zawartości wysokich 
częstotliwości zalecamy jakość Standard.
●   Vintage (Klasyczna) pozwala na celowe obniżenie jakości odtwarzania poprzez obniżenie bitów
i częstotliwości próbkowania w celu emulacji artefaktów wczesnych samplerów. Turntable 
(Gramofon) emuluje zoptymalizowany pod kątem pamięci proces próbkowania z przeszłości, kiedy 
gramofony były próbkowane z większą prędkością w celu nagrania krótkich sampli, a następnie 
ponownie strojone w celu skorygowania zmiany wysokości tonu. Wartość 45 rpm prowadzi do 
typowych artefaktów vintage. Wartość 78 rpm pozwala jeszcze bardziej zwiększyć efekt.

AudioWarp Playback (Odtwarzanie AudioWarp (automatyczne zniekształcanie))
Ten tryb odtwarzania umożliwia zastosowanie rozciągania czasu i przesuwania formantu do próbek.
Możesz wybierać pomiędzy różnymi trybami zniekształcania i synchronizacji.
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● Aby aktywować ten tryb, wybierz opcję AudioWarp w sekcji odtwarzania.

AudioWarp Mode (Tryb automatycznego zniekształcania, odkształcania)
●   Music Mode (Tryb muzyczny) oferuje parametry rozciągania czasu. Ten tryb jest odpowiedni  
     do odtwarzania złożonego materiału, takiego jak pętle perkusyjne i próbki muzyki mieszanej.  
     Zużywa znacznie więcej czasu procesora niż tryb Solo.

UWAGA
Im bardziej próbka jest rozciągnięta, tym większe jest obciążenie procesora.

●   Tryb Solo oferuje parametry rozciągania czasu i przesuwania formantu. Ten tryb jest  
     odpowiedni do pętli i sampli instrumentów solowych lub wokalu.

AudioWarp Sync Mode (Tryb synchronizacji AudioWarp (automatycznego odkształcania))
Umożliwia dopasowanie prędkości odtwarzania próbki do tempa projektu
● Jeżeli wybrano opcję Off (Wyłączone), prędkość odtwarzania jest określana ręcznie, w 
procentach.
● Jeśli wybrano Tempo, prędkość odtwarzania jest obliczana na podstawie stosunku pierwotnego 
tempa próbki do tempa hosta.

Legato
Jeśli ta opcja jest wyłączona, każda nuta odtwarzana poprzez MIDI rozpoczyna odtwarzanie od 
kursora pozycji Sampler Control (Próbnika sterowanego). Jeżeli ta opcja jest włączona, 
odtwarzanie pierwszej nuty rozpoczyna się od kursora pozycji, a wszelkie kolejne nuty 
rozpoczynają się od bieżącej pozycji odtwarzania tak długo, jak długo przytrzymana jest pierwsza 
nuta.
Speed (Prędkość)
Jeśli AudioWarp Sync Mode (Tryb synchronizacji AudioWarp) jest ustawiony na Off 
(Wyłączony), możesz dostosować prędkość odtwarzania próbki. W Music Mode (trybie 
muzycznym) minimalna regulacja prędkości odtwarzania wynosi 12,5%. Wartości poniżej tego 
limitu nie mają żadnego wpływu.
Original BPM (Oryginalne BPM)
Jeśli AudioWarp Sync Mode (Tryb synchronizacji AudioWarp) jest ustawiony na Tempo, możesz
wprowadzić oryginalne tempo próbki w uderzeniach na minutę. Szybkość odtwarzania próbki jest 
dostosowywana do tempa aplikacji głównej.
UWAGA
Ten parametr jest dostępny tylko w trybie Solo i Music. W Music Mode (Trybie muzycznym) 
dolna granica regulacji prędkości odtwarzania wynosi 12,5%. Wartości poniżej tego limitu nie mają
większego znaczenia.

Formant
Umożliwia regulację przesunięcia formantu. Przesunięcie formantu pozwala uniknąć tak zwanych 
efektów Myszki Miki podczas zmiany wysokości próbki. Jest to szczególnie przydatne w 
przypadku próbek głosów ludzkich lub instrumentów akustycznych. Ten parametr jest dostępny 
tylko w trybie Solo.

Slice Playback (Odtwarzanie fragmentów)
W tym trybie odtwarzania możesz podzielić próbkę na kilka części, które następnie są mapowane 
na klawiaturze, dzięki czemu każdy fragment można odtwarzać indywidualnie. Dodatkowo 
tworzony jest odpowiedni plik MIDI, który można przeciągnąć do projektu, aby odtworzyć 
fragmenty w ich oryginalnej kolejności lub całkowicie je zmienić.
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Wybranie trybu Slice (Plasterek, fragment) powoduje automatyczne pocięcie próbki. Możesz 
wybierać pomiędzy różnymi trybami wykrywania plasterków lub łączyć je. Możesz ręcznie 
dostosować położenie znaczników plasterków, przeciągając i dodając lub usuwając plasterki, 
używając klawisza Alt i kliknięcia.

UWAGA
Odtwarzanie fragmentów korzysta z ustawień jakości odtwarzania normalnego.

                

● Aby aktywować ten tryb, wybierz opcję Slice w sekcji odtwarzania.

Mode (Tryb)
       Ustawia tryb wykrywania plasterków.
● Tryb Transient (Przejściowy) umożliwia określenie Threshold (progu), który określa minimalny
    poziom szczytowy, jakiego potrzebuje stan przejściowy, aby stał się znacznikiem plasterka.
● Tryb Grid (Siatka) ustawia znaczniki plasterków zgodnie z Grid Resolution (rozdzielczością 
    siatki) ustawioną na pasku narzędzi Sampler Control (Próbnik sterowany).
● Tryb Transient + Grid łączy w sobie warunki trybu Transient i Grid.
● Tryb Manual (ręczny) umożliwia ręczne dodawanie i usuwanie plasterków poprzez kliknięcie z 
    wciśniętym klawiszem Alt na przebiegu. W tym trybie nie jest wykonywane automatyczne 
    wykrywanie plasterków.
Threshold (Próg)
       Określa minimalny poziom, na którym musi zostać wykryty stan przejściowy jako początek 
       nowego wycinka.
Minimal Length (Minimalna długość)
       Ustawia minimalną długość plasterka.
Grid Catch (Zaczep siatki)
       W trybie Transient + Grid (Wykrywania wycinka stanu przejściowego + siatki) parametr ten 
       określa, jak blisko siatki musi znajdować się znacznik stanu przejściowego.
Fade In (Narastanie)
       Ustawia czas pojawiania się wszystkich fragmentów pętli.
Fade Out (Zanikanie)
       Ustawia czas zanikania dla wszystkich fragmentów pętli.
Drag MIDI Phrase to Project (Przeciągnij frazę MIDI do projektu)
       Kliknij ten przycisk i przeciągnij go na ekran zdarzeń, aby utworzyć odpowiednie zdarzenie 
       MIDI w swoim projekcie.

POWIĄZANE LINKI
Krojenie próbek na stronie 607
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Pitch Section (Sekcja Pitch)
W sekcji Pitch (Wysokość dźwięku) możesz dostosować strojenie i wysokość próbki audio. 
Obwiednia wysokości dźwięku umożliwia modulację wysokości dźwięku w czasie.

                 

Show/Hide Pitch Modulators (Pokaż/ukryj modulatory wysokości dźwięku)
       Pokazuje/ukrywa obwiednię wysokości dźwięku i edytor LFO w oknie przebiegu.
Octave (Oktawa)
       Ustawia wysokość próbki w krokach oktawowych.
Coarse (Gruboziarnisty)
       Ustawia wysokość próbki w krokach półtonowych.
Fine (Cienki)
       Dostraja wysokość próbki w centach (setnych półtonu).
LFO
       Umożliwia wybór LFO i ustawienie głębokości modulacji LFO.
Glide (Poślizg)
       Określa czas potrzebny do zagięcia wysokości próbki od jednej nuty do następnej. Jeśli 
       przesuniesz tę kontrolkę maksymalnie w lewo, funkcja Glide zostanie wyłączona. Jeśli 
       włączona jest funkcja Fingered (Palcowaty), wysokość dźwięku zmienia się tylko pomiędzy 
       nutami granymi legato.

POWIĄZANE LINKI
Edytory obwiedni na stronie 599

Filter Section (Sekcja filtrów)
W sekcji Filter możesz dostosować kolor tonu próbki dźwięku. Obwiednia filtra umożliwia 
kontrolowanie częstotliwości odcięcia w celu kształtowania zawartości harmonicznych w czasie.

                  

Activate/Deactivate Filter (Aktywuj/dezaktywuj filtr)
       Aktywuje/dezaktywuje efekt filtrowania.
Show/Hide Filter Modulators (Pokaż/ukryj modulatory filtrów)
       Pokazuje/ukrywa obwiednię filtra i edytor LFO w oknie przebiegu.
Type (Typ)
       Ustawia typ filtra.
Shape (Kształt)
       Ustawia kształt filtra.
Cutoff (Odetnij)
       Kontroluje częstotliwość odcięcia filtra.
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Resonance (Rezonans)
       Ustawia rezonans filtra.
Drive (Prowadzić)
       Określa poziom sygnału wejściowego, a tym samym stopień nasycenia.
Cutoff Key Follow (Postępuj zgodnie z kluczem odcięcia)
       Ustawia modulację odcięcia na podstawie numeru nuty. Zwiększ ten parametr, aby podnieść 
       odcięcie przy wyższych dźwiękach. Przy wartości 100% częstotliwość odcięcia dokładnie 
       odpowiada odtwarzanej wysokości dźwięku.
LFO
       Umożliwia wybór LFO i ustawienie głębokości modulacji LFO.

POWIĄZANE LINKI
Edytory obwiedni na stronie 599

Amp Section (Sekcja wzmacniacza)
W sekcji Amp możesz ustawić głośność i panoramę próbki. Obwiednia wzmacniacza pozwala na 
kształtowanie głośności w czasie.

               

Show/Hide Amp Modulators (Pokaż/ukryj modulatory wzmacniacza)
       Pokazuje/ukrywa obwiednię wzmacniacza i edytor LFO w oknie przebiegu.
Volume (Głośność)
       Ustawia poziom próbki.
Volume LFO (Głośność LFO)
       Umożliwia wybór głośności LFO i ustawienie głębokości modulacji głośności LFO.
Pan (Panorama)
       Ustawia pozycję próbki w panoramie stereo.
Pan LFO (Panorama LFO)
       Umożliwia wybór panoramy LFO i ustawienie głębokości modulacji panoramy LFO.

POWIĄZANE LINKI
Edytory obwiedni na stronie 599

Envelope Editors (Edytory obwiedni)
Można dostosować krzywe obwiedni Pitch, Filter i Amp. Każda z tych obwiedni może zawierać 
do 128 węzłów.

● Kliknij Show/Hide Pitch Modulators (Pokaż/Ukryj modulatory wysokości dźwięku), 
Show/Hide Filter Modulators (Pokaż/ukryj modulatory filtrów) lub Show/Hide Amp 
Modulators (Pokaż/ukryj modulatory wzmacniacza) w nagłówku sekcji, aby pokazać/ukryć 
odpowiedni edytor obwiedni i sekcję LFO.
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Obwiednia wysokości dźwięku (Pitch)

          
Obwiednia filtrów

          
Obwiednia wzmacniacza

Envelope Amount (Ilość obwiedni)
Określa, jak bardzo wybrana obwiednia wpływa na dźwięk. Parametr ten pozwala na wartości 
dodatnie i ujemne. Jeśli Envelope Amount (wartość obwiedni) jest ustawiona na 0, obwiednia nie 
daje żadnego efektu.
UWAGA
Ten parametr jest dostępny tylko dla Pitch i Filter.
Envelope display (Wyświetlacz obwiedni)
Pokazuje krzywą wysokości dźwięku, filtra lub obwiedni wzmacniacza. Można to dostosować, 
dodając, przenosząc i usuwając węzły. Węzły (attack) ataku (A), (sustain) utrzymania (S) 
i (release) uwolnienia (R) są zawsze widoczne i nie można ich usunąć. Obok węzła uwolnienia 
pokazany jest czas uwolnienia obwiedni.

Mode (Tryb)
Określa sposób odtwarzania odpowiedniej obwiedni po jej uruchomieniu.
● Wybierz opcję Sustain, aby odtworzyć obwiednię od pierwszego węzła do węzła podtrzymania.  
   Poziom podtrzymania jest utrzymywany tak długo, jak długo grasz nutę. Kiedy zwolnisz nutę, 
   obwiednia będzie kontynuować etapy następujące po podtrzymaniu. Ten mod jest odpowiedni dla
   zapętlonych sampli.
● Wybierz opcję Loop (Pętla), aby odtworzyć obwiednię od pierwszego węzła do węzłów pętli.   
   Następnie pętla jest powtarzana tak długo, jak długo trzymany jest klawisz. Kiedy zwolnisz nutę, 
   obwiednia będzie kontynuować odtwarzanie etapów następujących po przedłużeniu. Ten tryb 
   nadaje się do dodawania ruchu do podtrzymania obwiedni.
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● Wybierz One Shot (Jeden strzał), aby odtworzyć obwiednię od pierwszego do ostatniego węzła,  
   nawet jeśli zwolnisz klawisz. Obwiednia nie ma stopnia podtrzymania. Ten tryb jest odpowiedni 
   dla sampli perkusyjnych.
● Wybierz opcję Sample Loop (pętla próbki), aby zachować naturalny atak próbki. Zanik obwiedni
   nie rozpoczyna się, dopóki próbka nie osiągnie początku pętli próbki. Jeśli ustawisz drugi węzeł   
   na maksymalny poziom i użyjesz kolejnych węzłów do kształtowania zaniku podczas fazy pętli 
   próbki, obwiednia wpłynie tylko na fazę pętli. Atak obwiedni jest nadal wykonywany.

Velocity (Prędkość)
       Określa, jak prędkość wpływa na poziom odpowiedniej obwiedni. Poziom obwiedni zależy od 
       ustawienia dynamiki i siły uderzenia w klawisz. Wyższe wartości zwiększają poziom obwiedni,
       im mocniej naciśniesz klawisz.
Time (Czas)
       Ustawia wartość czasu dla wybranego węzła.
Sync (Synchronizuj)
       Aktywuje/dezaktywuje synchronizację tempa dla odpowiedniej obwiedni. Grid ustawia 
       podstawową wartość nuty dla synchronizacji tempa obwiedni. Trpl pozwala ustawić nuty 
       bazowe trioli.

POWIĄZANE LINKI
Wybieranie węzłów na stronie 601
Dodawanie i usuwanie węzłów na stronie 601
Dostosowywanie krzywej obwiedni na stronie 602
Funkcje powiększania w edytorach obwiedni na stronie 602
Synchronizowanie obwiedni z tempem projektu na stronie 607

Wybieranie węzłów
Można wybrać pojedyncze węzły lub wiele węzłów. Wybrane węzły są edytowane razem.

● Aby wybrać węzeł, kliknij go w edytorze graficznym. Pole Time (Czas) w górnej części  
   graficznego edytora obwiedni pokazuje parametry wybranego węzła.
● Aby dodać węzeł do zaznaczenia, Shift – kliknij węzeł.
● Aby wybrać wiele węzłów, narysuj wokół nich prostokąt za pomocą myszy. Jeśli wybrano wiele 
   węzłów, w polu Time (Czas) wyświetlane są parametry węzła oznaczonego białą ramką.
● Aby wybrać wszystkie węzły obwiedni, naciśnij Ctrl/Cmd -A.
● Jeśli edytor obwiedni ma fokusa na klawiaturze, możesz wybrać następny lub poprzedni węzeł 
   za pomocą strzałki w lewo i strzałki w prawo.

POWIĄZANE LINKI
Fokus klawiatury w oknie projektu na stronie 80

Dodawanie i usuwanie węzłów
Do krzywej obwiedni można dodać maksymalnie 128 węzłów.

● Aby dodać węzeł, kliknij dwukrotnie miejsce, w którym chcesz dodać węzeł.
● Aby usunąć węzeł, kliknij go dwukrotnie.
● Aby usunąć kilka wybranych węzłów, naciśnij klawisz Delete lub Backspace.

UWAGA
● Nie możesz usunąć ataku (A), podtrzymania (S) ani węzła uwolnienia (R).
● Wszystkie węzły dodane po węźle podtrzymującym zawsze wpływają na fazę uwalniania 
   obwiedni.

608



Dopasowywanie krzywej obwiedni
Edytor obwiedni umożliwia dostosowanie krzywej obwiedni poprzez przeciąganie.

● Aby przesunąć węzeł w poziomie lub w pionie, kliknij go i przeciągnij.
● Aby przesunąć krzywą obwiedni w pionie pomiędzy dwoma węzłami, kliknij ją i przeciągnij.

Funkcje powiększania w edytorach obwiedni
Oś pionowa edytora obwiedni wyświetla poziom. Oś pozioma wyświetla czas.

● Aby powiększyć lub pomniejszyć, kliknij przyciski + lub - po prawej stronie paska przewijania 
   pod edytorem obwiedni lub użyj odpowiednich poleceń klawiszowych.
● Aby powiększyć lub pomniejszyć bieżącą pozycję, kliknij oś czasu i przeciągnij w górę lub w 
   dół.
● Aby powiększyć określony region, przytrzymaj Alt/Opt, kliknij i przeciągnij myszką nad 
   regionem.

POWIĄZANE LINKI
Polecenia klawiszowe na stronie 1123

Edytor LFO

Sampler Control (próbnik sterowany)zapewnia dwa monofoniczne LFO. Te LFO są obliczane 
tylko raz i zasilają wszystkie głosy w tym samym czasie.

               

LFO
       Umożliwia wybór LFO 1 lub 2 do edycji.
Sync (Synchronizacja)
       Definiuje sposób ustawiania prędkości odpowiedniego LFO.
       ●   Off (Wył.) umożliwia ustawienie prędkości LFO w Hz.
       ●   Tempo + Retrig umożliwia ustawienie szybkości LFO w wartościach nut. Wynikowa   
             stawka zależy od tempa Twojego projektu.
       ●   Tempo + Beat umożliwia ustawienie szybkości LFO w wartościach nut. Wynikowa stawka
            zależy od tempa Twojego projektu. Dodatkowo na podstawie aktualnej pozycji obliczana   
            jest aktualna faza startowa.
Retrigger (Uruchom ponownie)
       Określa, czy LFO jest uruchamiane ponownie w określonej fazie początkowej, gdy zostanie 
       wyzwolona nowa nuta. Ten parametr jest dostępny dla trybów synchronizacji Off i Tempo + 
       Retrig (Powtórz).
       ●   Jeśli wybrano Off, LFO nie zostanie zrestartowane.
       ●   First Note (Pierwsza nuta) restartuje LFO, kiedy nuta zostanie wyzwolona i nie będzie 
            przytrzymywana żadna inna nuta.
       ●   Each Note (Każda nuta) uruchamia LFO za każdym razem, gdy zostanie wyzwolona nuta.
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MW
       Umożliwia skalowanie poziomu wyjściowego LFO za pomocą pokrętła modulacji na 
       klawiaturze. Umożliwia to na przykład kontrolowanie wibracji dźwięku za pomocą pokrętła 
       modulacji.
Waveform (Przebieg)
       Ustawia kształt fali dla wybranego LFO. Możesz dostosować wybrany kształt fali za pomocą   
       kontrolki Shape (Kształt) po prawej stronie.

●   Sine (Sinus) zapewnia płynną modulację, odpowiednią dla vibrato lub tremolo. Shape (Kształt) 
      dodaje dodatkowe harmoniczne do kształtu fali.
●   Triangle (Trójkąt) jest podobny do Sine. Shape w sposób ciągły zmienia kształt fali trójkątnej   
      na trapezoidalną.
●   Saw (Piła) wykonuje cykl rampowy. Shape w sposób ciągły zmienia kształt fali od rampy w dół
     do trójkąta i w górę.
●   Pulse (Impuls) wytwarza modulację stopniową, podczas której modulacja przełącza się  
     gwałtownie pomiędzy dwiema wartościami. Shape stale zmienia stosunek pomiędzy wysokim i  
     niskim stanem fali. Jeśli  Shape jest ustawiony na 50%, generowana jest równa fala prostokątna.
●   Ramp (Rampa) jest podobna do przebiegu Saw (piły). Shape coraz częściej milczy, zanim 
     rozpocznie się wzrost liczby zębów piłokształtnych.
●   Log generuje modulację logarytmiczną. Shape w sposób ciągły zmienia krzywiznę 
     logarytmiczną z ujemnej na dodatnią.
●   S & H 1 wytwarza losowo stopniowaną modulację, gdzie każdy krok jest inny. Shape 
     umieszcza rampy pomiędzy stopniami i zmienia sygnał próbki i zatrzymania na płynny sygnał 
     losowy po całkowitym skręceniu w prawo.
●   S & H 2 jest podobne do S & H 1. Kroki zmieniają się pomiędzy losowo wysokimi i niskimi   
    wartościami. Shape umieszcza rampy pomiędzy stopniami i zmienia sygnał próbki i zatrzymania
    na płynny sygnał losowy po całkowitym skręceniu w prawo.

Freq (Częstotliwość)
       Kontroluje częstotliwość modulacji, czyli prędkość LFO. Jeśli Sync jest aktywowany dla 
       odpowiedniego LFO, prędkość jest określona w ułamkach uderzeń. Jeśli Sync (synchronizacja)
       jest wyłączona, możesz ustawić częstotliwość w Hz.
Phase (Faza)
       Ustawia początkową fazę przebiegu po ponownym uruchomieniu LFO. Jeśli RND jest 
       aktywowane, każda nuta zaczyna się od losowej fazy początkowej.

Sekcja Klawiatury
W sekcji klawiatury Sampler Control (Próbnik sterowany) możesz ustawić tonację główną i zakres
tonacji sampla, a także zakres modulacji pokrętła Pitchbend na klawiaturze MIDI.

Pitchbend

         
        Określa maksymalną modulację stosowaną podczas przesuwania pokrętła Pitchbend na 
        klawiaturze MIDI. Można ustawić zakres pitchbend w krokach półtonowych do 24 półtonów.
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Key range handles (Zakres uchwytów klawiszowych)

        
       Określa zakres tonacji próbki.

UWAGA
Ustawiony zakres tonacji jest używany w trybie Normal i AudioWarp.

Uchwyt klawisza głównego

        
       Określa klawisz główny próbki.

POWIĄZANE LINKI
Ręczne ustawianie klucza głównego na stronie 605
Ustawianie zakresu klawiszy na stronie 606

Przykładowe funkcje edycji i odtwarzania
Cała edycja sampli w Sampler Control (Próbnik sterowany) nie ma charakteru destrukcyjnego.

Ustawianie początku i końca próbki
Ustawiając początek i koniec próbki, możesz określić, jaki zakres próbki będzie odtwarzany po 
naciśnięciu klawisza na klawiaturze MIDI.

WARUNEK WSTĘPNY
Załadowałeś próbkę do Sampler Control (Próbnik sterowany).

PROCEDURA
1. Na ekranie przebiegu przeciągnij uchwyt Set Sample Start (Ustaw początek próbki) w prawo,   
    aby dostosować punkt początkowy próbki.
2. Przeciągnij uchwyt Set Sample End (Ustaw koniec próbki) w lewo, aby dostosować punkt  
    końcowy próbki.

WYNIK
Po uruchomieniu próbki odtwarzany jest tylko zdefiniowany zakres pomiędzy uchwytem 
początkowym i końcowym.

PO ZAKOŃCZENIU TEGO ZADANIA
● Można przesuwać jednocześnie znaczniki początku i końca próbki, zachowując ich względną  
   odległość, przesuwając kursor myszy pomiędzy obydwoma znacznikami i przeciągając pasek 
   łączący.
UWAGA
Działa to tylko wtedy, gdy nie wybrano trybu Loop (pętli).
● Możesz przyciąć długość próbki do zdefiniowanego zakresu odtwarzania, klikając Trim Sample 
   (Przytnij próbkę) na pasku narzędzi Sampler Control.

POWIĄZANE LINKI
Wyświetlanie przebiegu na stronie 594
Pasek narzędzi próbnika sterowanego (Sampler Control) na stronie 590
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Konfigurowanie pętli dla próbek audio
Można ustawić pętlę odtwarzaną po wywołaniu próbki.

WARUNEK WSTĘPNY
Załadowałeś próbkę do Sampler Control (Próbnik sterowany).

PROCEDURA
1. Na pasku narzędzi kliknij Loop Mode (Tryb pętli) i wybierz tryb pętli z wyskakującego menu.  
    Pokazane zostaną uchwyty Set Sustain Loop Start (Ustaw początek pętli podtrzymującej) i Set 
    Sustain Loop End (Ustaw koniec pętli podtrzymującej oraz zielona nakładka zakresu pętli.
2. Przeciągnij uchwyty Set Sustain Loop Start i Set Sustain Loop End, aby dostosować punkty   
    początkowe i końcowe pętli. Aby uzyskać płynne przejście pętli, spróbuj dopasować kształt 
    zielonej nakładki zakresu pętli do kształtu szarej próbki.

UWAGA
Nie można przeciągnąć punktów początkowych i końcowych pętli poza zdefiniowany zakres 
próbki.

WYNIK
Kiedy wywołujesz próbkę w trybie pętli, używany jest zdefiniowany zakres pętli.

PO ZAKOŃCZENIU TEGO ZADANIA
● Można jednocześnie przesuwać znaczniki początku i końca pętli, przeciągając obszar pomiędzy 
znacznikami pętli.

POWIĄZANE LINKI
Ustawianie początku i końca próbki na stronie 604.

Ręczne ustawienie klawisza głównego

Root Key (Klawisz główny) pokazuje oryginalną wysokość próbki. Czasami, jeśli próbka nie 
zawiera żadnych informacji o tonacji głównej lub jeśli chcesz, aby próbka była odtwarzana w innej 
wysokości, musisz ręcznie ustawić tonację główną. W trybie Slice (Plasterek) obniżenie klawisza 
głównego pozwala zwiększyć liczbę plasterków, które można zamapować na klawiaturze.

UWAGA
Jeśli załadujesz próbkę, która nie zawiera żadnych informacji o klawiszu głównym, klawisz główny
zostanie automatycznie ustawiony na C3.

PROCEDURA
● Wykonaj jedną z następujących czynności:
        ● W sekcji klawiatury funkcji Sampler Control kliknij i przeciągnij uchwyt klawisza 
           głównego.
        ● Na pasku narzędzi Sampler Control kliknij dwukrotnie pole Root Key i wprowadź nowy 
           klawisz główny za pomocą klawiatury komputera, kółka myszy lub klawiatury MIDI.

POWIĄZANE LINKI
Sekcja dotycząca klawiatur na stronie 603
Ustawianie zakresu klawiszy na stronie 606
Krojenie próbek na stronie 607
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Ustawianie zakresu klawiszy
Można określić zakres klawiszy dla próbki. Jest to przydatne w przypadku próbek, które brzmią 
dobrze tylko w określonym zakresie tonacji.

WARUNEK WSTĘPNY
Załadowałeś próbkę do Sampler Control (Próbnika sterowanego).

PROCEDURA
●   W sekcji klawiatury dostosuj zakres klawiszy, przeciągając uchwyty zakresu nad   
     wyświetlaczem klawiatury.

WYNIK
Tylko klawisze w określonym zakresie klawiszy odtwarzają dźwięk po uruchomieniu.

POWIĄZANE LINKI
Sekcja dotycząca klawiatur na stronie 603

Odtwarzanie próbek
Po załadowaniu próbki audio do narzędzia Sampler Control możesz ją odtworzyć za pomocą 
zewnętrznej klawiatury MIDI lub On Screen Keyboard (klawiatury ekranowej).

WARUNEK WSTĘPNY
Załadowałeś próbkę do Sampler Control i dokonałeś edycji wszystkich próbek oraz dokonałeś 
ustawień. Zainstalowałeś i skonfigurowałeś klawiaturę MIDI.

PROCEDURA
1. Na liście utworów aktywuj opcję Monitor dla ścieżki samplera.
2. Opcjonalnie: Na pasku narzędzi Sampler Control (próbnika sterowanego) aktywuj opcję Fixed 
    Pitch (Stała wysokość tonu). Umożliwia to odtwarzanie próbki w jej oryginalnej wysokości 
    i szybkości.
3. Uderz kilka nut na klawiaturze lub użyj On-Screen Keyboard (klawiatury ekranowej), aby 
    odtworzyć próbkę.

WYNIK
Jeśli opcja Fixed Pitch (Stała wysokość tonu) jest wyłączona, odtwarzana jest próbka, a wysokość 
dźwięku jest definiowana na podstawie granych nut. Jeśli naciśniesz niższe klawisze, próbka 
zostanie odtworzona z niskim tonem. Jeśli naciśniesz wyższe klawisze, próbka zostanie odtworzona
z wyższą tonacją.
Jeśli włączona jest opcja Fixed Pitch, próbka jest odtwarzana w oryginalnej wysokości.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby użyć dźwięku edytowanej próbki w swoim projekcie, utwórz lub nagraj zdarzenie MIDI na 
ścieżce samplera.

POWIĄZANE LINKI
Monitorowanie poprzez Cubase na stronie 268
Klawiatura ekranowa na stronie 261
Pasek narzędzi Sampler Control (próbnika sterowanego) na stronie 590
Zdarzenia MIDI na stronie 202
Podstawowe metody nagrywania na stronie 263
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Synchronizowanie obwiedni z tempem projektu
Możesz zsynchronizować Pitch Envelope (Obwiednia wysokości tonu), Filter Envelope 
(Obwiednia filtra)i Amp Envelope (Obwiednia wzmacniacza) z tempem swojego projektu. 
Umożliwia to ustawienie czasów obwiedni odnoszących się do muzycznych przedziałów 
czasowych, niezależnie od zmian tempa.

WARUNEK WSTĘPNY
Załadowałeś próbkę do Sampler Control (Próbnika sterowanego)

PROCEDURA
1. W odpowiedniej sekcji obwiedni ustaw opcję Sync (Synchronizacja) na On (Wł).
2. Użyj Grid i Trpl, aby ustawić wartość nuty. Ustawia to rozdzielczość nuty, do której  
    przyciągane są węzły obwiedni, gdy zbliżają się wystarczająco blisko.

UWAGA
● Pole Time (Czas) węzła obwiedni wyświetla czasy w ułamkach całej nuty. Ułamek jest zawsze  
   redukowany do najmniejszej możliwej wartości, na przykład 2/16 jest wyświetlane jako 1/8.
● Możesz także ręcznie wprowadzić wartości nut w polu Time. Węzły obwiedni, które nie 
   odpowiadają dokładnie wartości nuty, wyświetlają najbliższą wartość nuty.

Normalizowanie próbek
Można normalizować próbki do wartości docelowej. Dodatkowa kontrola wzmocnienia umożliwia 
późniejsze dostrojenie wartości wzmocnienia.

WARUNEK WSTĘPNY
Załadowałeś próbkę do Sampler Control.

PROCEDURA
1. Na pasku narzędzi Sampler Control ustaw Normalization Level (Poziom normalizacji) jako 
   wartość docelową.
2. Kliknij opcję Normalize Sample (Normalizuj próbkę). Próbkę normalizuje się do wartości 
   docelowej.
3. Użyj opcji Sample Gain (Wzmocnienie próbki), aby dostroić wynik normalizacji.

POWIĄZANE LINKI
Pasek narzędzi Sampler Control (Próbnika sterowanego) na stronie 590.

Krojenie próbek
Próbki można podzielić na kilka części, które są mapowane na klawiaturze, dzięki czemu można 
odtwarzać każdy plasterek osobno.

WARUNEK WSTĘPNY
Załadowałeś próbkę do Sampler Control.

PROCEDURA
1. W sekcji odtwarzania kliknij Slice (Kawałek, fragment).
2. Opcjonalnie: Zmień Slice Mode (Tryb krojenia), dostosuj parametry krojenia i dodaj lub usuń 
    znaczniki krojenia.
3. Opcjonalnie: Jeśli chcesz zwiększyć liczbę plasterków, które można zamapować na klawiaturze, 
    obniż klawisz główny w sekcji klawiatury.
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WYNIK
Plasterki są automatycznie mapowane na klawiaturę, zaczynając od ustawionego klawisza 
głównego. Kawałek możesz odtworzyć, naciskając odpowiedni klawisz na klawiaturze MIDI.

PO ZAKOŃCZENIU TEGO ZADANIA
Możesz utworzyć odpowiednią frazę MIDI w swoim projekcie, przeciągając przycisk Drag MIDI 
Phrase to Project (Przeciągnij frazę MIDI do projektu) na ekran zdarzeń. Dzięki temu możesz 
zmienić kolejność plasterków.

POWIĄZANE LINKI
Sekcja odtwarzania na stronie 595
Ręczne ustawianie klawisza głównego na stronie 605
Ustawianie zakresu klawiszy na stronie 606

Przesyłanie próbek z Sampler Control (próbnika sterowanego) do 
VST Instruments
Możesz przesyłać próbki audio ze wszystkimi ustawieniami, które dokonałeś w Sampler Control 
do określonych instrumentów Steinberg VST.

Przesyłanie próbek audio z modułu Sampler Control do instrumentu VST powoduje utworzenie 
nowej ścieżki instrumentu na liście ścieżek. Ten nowy utwór zostanie dodany poniżej ścieżki 
samplera. Próbka audio i wszystkie jej ustawienia są ładowane do instrumentu VST.

Możesz przesyłać próbki audio z Sampler Control do następujących instrumentów Steinberg VST:

● Groove Agent 
● Groove Agent SE 
● HALion 
● Padshop 
● Backbone (Szkielet)

Przesyłanie próbki

WARUNEK WSTĘPNY
Zainstalowałeś Groove Agent, Groove Agent SE, HALion, Padshop lub Backbone. Załadowałeś 
próbkę audio do Sampler Control (próbnika sterowanego).

PROCEDURA
1. Na pasku narzędzi Sampler Control kliknij Transfer to New Instrument (Prześlij do nowego 
    instrumentu.
2. W wyskakującym menu wybierz instrument, do którego chcesz przenieść próbkę.

WYNIK
Na liście ścieżek pod ścieżką samplera tworzona jest nowa ścieżka instrumentu. Ścieżka 
instrumentu ma taką samą nazwę jak ścieżka samplera. Próbka audio i jej ustawienia zostaną 
załadowane do wybranego instrumentu VST
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UWAGA
Jeżeli parametr nie jest dostępny dla instrumentu VST wybranego jako docelowego, to albo nie 
zostanie przesłany, albo zostanie dostosowany do podobnego parametru w instrumencie VST. 
Obowiązuje co następuje:

● Groove Agent/Groove Agent SE: Ustawienia LFO i filtrów nie są używane.
● Padshop: Nie stosuje się przycinania próbek. Transfer w trybie odtwarzania AudioWarp ustawia 
   ustawienia ziarna na Number (liczbę) 2 ziaren i odpowiednio wartość Speed (prędkości). 
   Przesyłanie w trybie odtwarzania plasterków wykorzystuje tylko wybrany Slice (plasterek).
● Backbone (Szkielet): Przycinanie próbek nie jest używane. Transfer w trybie odtwarzania 
   AudioWarp aktywuje tryb Resynth i odpowiednio ustawia wartość Speed. Przesyłanie w trybie 
   Slice Mode (odtwarzania plasterków) wykorzystuje tylko wybrany plasterek.

POWIĄZANE LINKI
Przesyłanie próbki na stronie 608
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Pool (Pula)

Za każdym razem, gdy nagrywasz ścieżkę audio, na dysku twardym tworzony jest plik. Do puli 
dodawane jest odniesienie do tego pliku w postaci klipu. Za każdym razem, gdy nagrywasz na 
ścieżce audio, na dysku twardym tworzony jest plik. Odniesienie do tego pliku w postaci klipu 
zostanie dodane do puli.

W Puli obowiązują następujące zasady:
● Wszystkie klipy audio i wideo należące do projektu są wymienione w Pool (Puli).
● Każdy projekt ma oddzielną Pool (Pulę).

Sposób, w jaki Pool (Pula) wyświetla foldery i ich zawartość, jest podobny do sposobu, w jaki 
Eksplorator plików/macOS Finder wyświetla foldery i listy plików. W Pool (Puli) możesz 
wykonywać operacje wpływające na pliki na dysku oraz operacje wpływające tylko na klipy.

Operacje mające wpływ na pliki
●   Importowanie klipów (pliki audio mogą być automatycznie kopiowane i/lub konwertowane)
●   Konwersja formatów plików
●   Zmiana nazw klipów (zmienia to również nazwy plików, do których istnieją odnośniki na 
     dysku) i regionów
●   Usuwanie klipów
●   Przygotowanie archiwów plików do tworzenia kopii zapasowych
●   Minimalizowanie plików

Operacje wpływające na klipy
●   Kopiowanie klipów
●   Przesłuchanie klipów
●   Organizowanie klipów
●   Stosowanie przetwarzania dźwięku do klipów
●   Zapisywanie lub importowanie kompletnych plików puli

Pool Window (Okno pula)
Okno Pula umożliwia zarządzanie plikami multimedialnymi aktywnego projektu.

Aby otworzyć Pool (Pulę), wykonaj jedną z następujących czynności:

● Na pasku narzędzi okna Project kliknij Open Pool Window (Otwórz okno puli). Jeśli ta ikona 
nie jest widoczna, musisz aktywować opcję Media & MixConsole Windows w menu 
kontekstowym paska narzędzi.
● Wybierz opcję Project > Pool (Projekt > Pula).
● Wybierz opcję Media > Open Pool Window (Media > Otwórz okno puli).
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Zawartość Pool (Puli) jest podzielona na następujące foldery:

Audio Folder (Folder Audio)
Zawiera wszystkie klipy audio i regiony znajdujące się w projekcie.
Jeśli projekt zawiera jedną lub więcej ścieżek samplera, w folderze Audio tworzony jest 
dedykowany podfolder Sampler Track (ścieżki samplera). Ten podfolder zawiera wszystkie klipy 
sampli, które załadowałeś do Sampler Control (Próbnik sterowany).

Video folder (Folder wideo)
Zawiera wszystkie klipy wideo znajdujące się w projekcie.

Trash folder (Folder śmieci)
Zawiera nieużywane klipy, które zostały przeniesione tutaj w celu późniejszego trwałego usunięcia 
z dysku twardego.
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Kolumny okna Pool (Puli)
Kolumny okna Pool wyświetlają informacje o klipach i regionach.

  

Dostępne są następujące kolumny:

Media
Zawiera foldery Audio, Video i Trash (Kosz). Jeśli foldery zostaną otwarte, zostaną wyświetlone 
nazwy klipów lub regionów, które można edytować.
Used (Używane)
Wyświetla liczbę przypadków użycia klipu w projekcie. Jeśli w tej kolumnie nie ma wpisu, 
odpowiedni klip nie jest używany.
Status
Wyświetla różne ikony powiązane z bieżącym stanem Pool (puli) i klipu. Mogą być wyświetlane 
następujące symbole:

●   Record folder (Folder nagrań)  
     Wskazuje folder nagrań.

●   Proces (Przetwarzaj)  
     Wskazuje, że klip został przetworzony.

●   Missing (Brak)   
     Wskazuje, że projekt zawiera odwołanie do klipu, ale brakuje go w puli.

●   External (Zewnętrzne)   
     Wskazuje, że plik, do którego odnosi się klip, jest plik zewnętrzny, na przykład znajduje się poza
     bieżącym folderem Audio projektu.

●   Recorded (Nagrano)   
     Wskazuje, że klip został nagrany w otwartej wersji projektu. Jest to przydatne do szybkiego 
     wyszukiwania ostatnio nagranych klipów.

Musical Mode (Tryb muzyczny)
Możesz użyć trybu muzycznego, aby dopasować tempo pętli audio do tempa projektu. Pole wyboru 
w tej kolumnie umożliwia włączenie lub wyłączenie trybu muzycznego. Jeśli w kolumnie Tempo 
wyświetla się „???”, przed aktywacją trybu muzycznego należy wprowadzić prawidłowe tempo.
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Tempo
Wyświetla tempo plików audio, jeśli są dostępne. Jeżeli nie określono tempa, w kolumnie wyświetli
się „???”.
Sign. (Podpis).
Wyświetla metrum, na przykład „4/4”.
Key (Klawisz)
Wyświetla klawisz główny, jeśli został określony dla pliku.
Algorithm (Algorytm)
Wyświetla wstępnie ustawiony algorytm używany podczas przetwarzania pliku audio.
●   Aby zmienić domyślne ustawienie wstępne, kliknij nazwę ustawienia wstępnego i wybierz inne 
ustawienie wstępne z wyskakującego menu.
Info (Informacje)
W przypadku klipów audio w tej kolumnie wyświetlana jest częstotliwość próbkowania, głębia 
bitowa, liczba kanałów i długość.
W przypadku regionów wyświetla czas rozpoczęcia i zakończenia w ramkach.
W przypadku klipów wideo wyświetla liczbę klatek na sekundę, rozdzielczość, liczbę klatek i 
długość.
Type (Typ)
Wyświetla format pliku klipu.
Date (Data)
Wyświetla datę ostatniej zmiany pliku audio.
Origin Time (Czas powstania)
Wyświetla pierwotną pozycję początkową, w której klip został nagrany w projekcie. Ponieważ ta 
wartość może służyć jako podstawa dla opcji Insert into Project (Wstaw do projektu) w Media 
(Mediach) lub menu kontekstowym, możesz ją zmienić, jeśli wartość Origin Time (Czas 
powstania) jest niezależna (na przykład nie dla regionów).
W puli możesz zmienić wartość, edytując Origin Time. W oknie Project możesz zmienić wartość, 
przesuwając zdarzenie w nowe miejsce i wybierając Audio > Update Origin (Audio > Aktualizuj 
początek).
Image (Obraz)
Wyświetla obrazy przebiegów klipów audio lub regionów.
Path (Ścieżka)
Wyświetla ścieżkę do lokalizacji klipu na dysku twardym.
Reel Name (Nazwa rolki filmu)
Jeśli zaimportowałeś plik OMF, może on zawierać ten atrybut, który będzie następnie pokazany w 
tej kolumnie. Opisuje szpulę lub taśmę, z której pierwotnie przechwycono nośnik.

UWAGA
Możesz zmienić kolejność kolumn, klikając nagłówek i przeciągając w lewo lub w prawo.

Pasek narzędzi okna Pool (puli).
Pasek narzędzi zawiera narzędzia i ustawienia do pracy w Pool.

Show Info (Pokaż informacje)

         
        Pokazuje/ukrywa linię informacyjną.
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Audition (Przesłuchanie)

         
        Odtwarza wybrany plik audio.
Audition Loop (Pętla przesłuchań)

         
        Zapętla odtwarzanie do momentu dezaktywacji Audition
Audition Volume (Głośność przesłuchania)

         
       Umożliwia regulację głośności.
View/Attributes (Widok/atrybuty)
       Umożliwia włączenie/wyłączenie atrybutów wyświetlanych w oknie Pool (Pula).
+/- All (+/- Wszystko)
       Otwiera/zamyka wszystkie foldery.
Import
       Umożliwia importowanie plików multimedialnych do puli.
Search (Szukaj)
       Umożliwia przeszukiwanie puli i podłączonych dysków w poszukiwaniu plików 
       multimedialnych.
Project Folder (Folder projektu)
       Wyświetla ścieżkę do folderu aktywnego projektu.
Pool Record Folder (Folder rekordów puli)
       Wyświetla ścieżkę do folderu Record aktywnego projektu. Domyślnie jest to folder Audio.    
       Możesz jednak utworzyć nowy podfolder Audio i wyznaczyć go jako folder nagrań w Pool  
       (puli).

Info Line (Linia informacyjna)
Linia informacyjna pokazuje informacje o wydarzeniu lub części wybranej w Pool (Puli).

● Aby aktywować linię informacyjną, kliknij Show Info (Pokaż informacje) po lewej stronie paska 
   narzędzi.

Wiersz informacyjny zawiera następujące informacje:

Audio Files (Pliki audio)
       Liczba plików audio w puli.
Used (Używane)
       Liczba używanych plików audio.
Total Size (Całkowity rozmiar)
       Całkowity rozmiar wszystkich plików audio w puli.
External Files (Pliki zewnętrzne)
       Liczba plików w puli, które nie znajdują się w folderze projektu (na przykład pliki wideo).

Praca z Pool (Pulą)

UWAGA
Większość funkcji menu głównego związanych z pulą jest także dostępna w menu kontekstowym 
Pool.
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Zmiana nazw klipów lub regionów w puli

WAŻNE
Zmiana nazw klipów lub regionów w Pool (puli) powoduje również zmianę nazw plików 
odniesienia na dysku. Zaleca się zmianę nazw klipów lub regionów w Pool. W przeciwnym razie 
odniesienie z klipu do pliku może zostać utracone.

PROCEDURA
1. W oknie Pool (Pula) wybierz klip lub region i kliknij istniejącą nazwę.
2. Wprowadź nową nazwę i naciśnij Return.

POWIĄZANE LINKI
Brakujące pliki na stronie 620

Powielanie klipów w Puli
Możesz tworzyć duplikaty klipów i stosować do nich różne metody przetwarzania.

UWAGA
Powielenie klipu nie powoduje utworzenia nowego pliku na dysku, ale nową wersję klipu do edycji,
która odnosi się do tego samego pliku audio.

PROCEDURA
1. W oknie Pool (Pula) wybierz klip, który chcesz zduplikować.
2. Wybierz opcję Media > New Version (Multimedia > Nowa wersja).

WYNIK
Nowa wersja klipu pojawi się w tym samym folderze Pool. Zduplikowany klip ma taką samą nazwę
jak oryginał, ale po nim znajduje się numer wersji. Regiony w klipie są również kopiowane, ale 
zachowują swoją nazwę.

Wstawianie klipów do projektu
Aby wstawić klip do projektu, możesz użyć poleceń wstawiania z menu Media lub przeciągnąć i 
upuścić.

Wstawianie klipów do projektu za pomocą poleceń menu

PROCEDURA
1. W oknie Pool (Pula) wybierz klipy, które chcesz wstawić do projektu.
2. Wybierz opcję Media > Insert into Project (Media > Wstaw do projektu) i wybierz jedną z 
opcji wstawiania. Jeśli wybranych jest kilka klipów, zdecyduj, czy chcesz je wstawić na jednej 
ścieżce, czy każdy na innej ścieżce.

UWAGA
Klipy są ustawione w taki sposób, że ich punkty przyciągania są wyrównane z wybraną pozycją 
wstawiania. Jeśli chcesz dostosować punkt przyciągania przed wstawieniem klipu, kliknij 
dwukrotnie klip, aby otworzyć Sample Editor (Edytor próbek). Tutaj możesz dostosować pozycję 
przyciągania, a następnie wykonać opcje wstawiania.
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WYNIK
Klip zostanie wstawiony na wybranej ścieżce lub na nowej ścieżce audio. W przypadku wybrania 
kilku ścieżek klip zostanie wstawiony na pierwszej wybranej ścieżce.

POWIĄZANE LINKI
Dostosowywanie punktu przyciągania na stronie 529

Wstawianie klipów do projektu metodą przeciągnij i upuść
Możesz przeciągnąć klip z Pool (puli) do okna Project (projektu).

Przyciąganie jest brane pod uwagę, jeśli Snap (przyciąganie) jest włączone

Jeśli przeciągniesz klip do okna Project, pojawi się kursor krzyżowy i podpowiedź. Etykietka 
wskazuje położenie na osi czasu, w którym znajduje się punkt przyciągania klipu.

Jeśli umieścisz klip w pustym obszarze listy ścieżek, czyli tam, gdzie nie istnieje żadna ścieżka, dla 
wstawionego zdarzenia zostanie utworzona nowa ścieżka.

UWAGA
Jeśli naciśniesz i przytrzymasz Shift podczas przeciągania klipu z puli na wydarzenie, klip w tym 
zdarzeniu zostanie zastąpiony.

POWIĄZANE LINKI
Dostosowywanie punktu przyciągania na stronie 529
Zastępowanie klipów w zdarzeniach na stronie 201
Kursor krzyżowy na stronie 88

Usuwanie klipów z puli

Możesz usuwać klipy z Pool (puli), usuwając lub nie usuwając odpowiednich plików z dysku 
twardego.

Usuwanie klipów z puli
Możesz usuwać klipy z Pool (puli) bez usuwania odpowiednich plików z dysku twardego

PROCEDURA
1. W oknie Pool (Pula) wybierz klipy, które chcesz usunąć, i wybierz Edit > Delete (Edycja > 
Usuń). Możesz także nacisnąć Backspace lub Delete.
2. W zależności od tego, czy klipy są wykorzystywane przez wydarzenie, dostępne są następujące 
    opcje:
●   Jeśli klipy są wykorzystywane przez zdarzenie, kliknij Remove (Usuń), a następnie kliknij    
     Remove from Pool (Usuń z puli).
●   Jeśli klipy nie zostaną wykorzystane w zdarzeniu, kliknij Remove from Pool.

WYNIK
Klipy nie są już dostępne w puli tego projektu, ale pliki nadal istnieją na dysku twardym i można 
ich używać w innych projektach itp. Tę operację można cofnąć.
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Usuwanie plików z dysku twardego
Możesz usunąć klipy z Pool (puli), usuwając odpowiedni plik z dysku twardego. Aby trwale usunąć
plik z dysku twardego, należy najpierw przenieść odpowiednie klipy do folderu Trash (Kosz) 
w Pool.

WAŻNE
Upewnij się, że pliki audio, które chcesz usunąć, nie są używane w innych projektach.

PROCEDURA
1. W oknie Pool (Pula) wybierz klipy, które chcesz usunąć z dysku twardego i wybierz Edit > 
Delete (Edycja > Usuń). Możesz także nacisnąć Backspace lub Delete albo przeciągnąć klipy do 
folderu Trash (Kosz).

UWAGA
Możesz odzyskać klip lub region z folderu Trash (Kosz), przeciągając go z powrotem do folderu 
Audio lub Video.

2. W zależności od tego, czy klipy są wykorzystywane przez zdarzenie, dostępne są następujące 
    opcje:
●   Jeśli klipy są używane w ramach zdarzenia, kliknij Remove (Usuń), a następnie kliknij Trash 
     (Kosz).
●   Jeśli klipy nie są używane w ramach zdarzenia, kliknij Trash (Kosz).
3. Wybierz opcję Media > Empty Trash (Multimedia > Opróżnij kosz).
4. Kliknij opcję Erase (Wymaż).

WYNIK
Pliki zostaną usunięte z dysku twardego.

Usuwanie nieużywanych klipów z puli
Wszystkie klipy, które nie są użyte w projekcie, znajdziesz w Pool (Puli). Dzięki temu możesz 
szybko usunąć wszystkie nieużywane klipy.

WARUNEK WSTĘPNY
Okno Pool jest otwarte.

PROCEDURA
1. Wybierz opcję Media > Remove Unused Media (Multimedia > Usuń nieużywane multimedia)
2. Wykonaj jedną z następujących czynności:
●   Aby przenieść pliki do folderu Trash (Kosz), wybierz Trash.
●   Aby usunąć klipy z puli, wybierz opcję Remove from Pool (Usuń z puli).

Usuwanie regionów z puli

PROCEDURA
●   W Pool (Puli) wybierz region i wybierz Edit > Delete (Edytuj > Usuń).
   Możesz także nacisnąć Backspace lub Delete

WAŻNE
Nie zostaniesz ostrzeżony, jeśli region jest nadal używany.
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Lokalizowanie zdarzeń i klipów
Możesz szybko wyświetlić, do których klipów należą wybrane zdarzenia i do jakich zdarzeń należą 
wybrane klipy.

Lokalizowanie zdarzeń za pomocą klipów w Pool (Puli).
Które zdarzenia w projekcie odnoszą się do konkretnego klipu, możesz dowiedzieć się w Puli.

PROCEDURA
1. W oknie Pool (Pula) wybierz jeden lub więcej klipów.
2. Wybierz opcję Media > Select in Project (Media > Wybierz w projekcie).

WYNIK
Wszystkie zdarzenia odnoszące się do wybranych klipów są teraz zaznaczone w oknie Project.

Lokalizowanie klipów poprzez zdarzenia w oknie projektu
W oknie Project możesz dowiedzieć się, który klip należy do konkretnego zdarzenia.

PROCEDURA
1. W oknie Project wybierz jedno lub więcej zdarzeń.
2. Wybierz opcję Audio > Find Selected in Pool (Audio > Znajdź wybrane w puli).

WYNIK
Odpowiednie klipy zostaną umieszczone i wyróżnione w Pool (Puli).

Wyszukiwanie plików audio
Funkcje wyszukiwania pomagają zlokalizować pliki audio w Pool (Puli), na dysku twardym lub na 
innych nośnikach. Działa to podobnie do zwykłego wyszukiwania plików, ale z dodatkowymi 
funkcjami.

PROCEDURA

1. W oknie Pool (Pula) kliknij Search (Szukaj) na pasku narzędzi.
    W dolnej części okna pojawi się okienko wyszukiwania zawierające funkcje wyszukiwania.

                        

2. W polu Name (Nazwa) określ wyszukiwane pliki.
    Możesz użyć częściowych nazw lub symboli wieloznacznych (*)

UWAGA
Znaleziono tylko pliki audio w obsługiwanych formatach.
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3. Użyj wyskakującego menu Location (Lokalizacja), aby określić, gdzie szukać. W wyskakującym
    menu znajdują się wszystkie dyski lokalne i nośniki wymienne.
●   Aby ograniczyć wyszukiwanie do określonych folderów, wybierz opcję Select Search Path 
     (Wybierz ścieżkę wyszukiwania) i w otwartym oknie dialogowym wybierz folder, w którym 
     chcesz przeszukiwać.
Wyszukiwanie obejmuje wybrany folder i wszystkie podfoldery.
UWAGA
Foldery wybrane ostatnio za pomocą funkcji Select Search Path (Wybierz ścieżkę wyszukiwania) 
pojawiają się w wyskakującym menu, dzięki czemu można je szybko wybrać ponownie.
4. Kliknij Search (Szukaj).
    Rozpocznie się wyszukiwanie, a Search (Wyszukiwanie) zostanie oznaczone etykietą Stop 
    (Zatrzymaj)
●   Aby anulować wyszukiwanie, kliknij Stop.
Po zakończeniu wyszukiwania znalezione pliki zostaną wyświetlone po prawej stronie.
●   Aby odsłuchać plik, zaznacz go na liście i użyj elementów sterujących odtwarzaniem po lewej   
     stronie (Play (Odtwórz), Stop (Zatrzymaj), Pause (Wstrzymaj) i Loop (Pętla)). Jeśli włączone 
     jest automatyczne odtwarzanie, wybrane pliki będą odtwarzane automatycznie.
●   Aby zaimportować plik do Pool (Puli), kliknij dwukrotnie plik na liście lub zaznacz go i kliknij  
     Import (Importuj).
5. Aby zamknąć okienko wyszukiwania, kliknij ponownie Search (Szukaj) na pasku narzędzi.

Korzystanie z funkcji wyszukiwania rozszerzonego
Oprócz kryterium wyszukiwania Name (Nazwa) dostępne są dodatkowe filtry wyszukiwania. 
Rozszerzone opcje wyszukiwania pozwalają na szczegółowe wyszukiwanie, pomagając opanować 
nawet największą bazę danych dźwiękowych.

PROCEDURA
1.   W oknie Pool (Pula) kliknij Search (Szukaj) na pasku narzędzi. Panel wyszukiwania 
      wyświetlany jest w dolnej części okna Pool.
2.   Kliknij opcję Name (Nazwa), aby otworzyć wyskakujące menu wyszukiwania rozszerzonego,  
      w którym możesz wybrać i zdefiniować kryterium wyszukiwania.

               
Menu zawiera także podmenu Add Filter (Dodaj filtr) i Presets (Ustawienia wstępne).
Kryteria wyszukiwania posiadają następujące parametry:
●   Name (Nazwa): częściowe nazwy lub symbole wieloznaczne (*)
●   Size (Rozmiar): mniejszy niż, większy niż, równy, pomiędzy (dwiema wartościami), w 
     sekundach, minutach, godzinach i bajtach
●   Bit Depth (Głębia bitowa): 8 bitów, 16 bitów, 24 bity, 32 bity, 32 bity float, 64 bity float
●   Channels (Kanały): mono, stereo i od 3 do 16
●   Sample Rate (Częstotliwość próbkowania): różne wartości, wybierz opcję Other (Inne), aby 
     uzyskać dowolne ustawienie
●   Date (Data): różne zakresy wyszukiwania.
3.  Wybierz jedno z kryteriów wyszukiwania w wyskakującym menu. Kryterium wyszukiwania 
zmieni się na wybrane kryterium.
4. Opcjonalnie: Aby wyświetlić więcej opcji wyszukiwania, otwórz wyskakujące menu 
wyszukiwania rozszerzonego, wybierz podmenu Add Filter (Dodaj filtr) i wybierz element.
5. Opcjonalnie: Aby zapisać ustawienia filtra wyszukiwania jako ustawienie wstępne, otwórz 
wyskakujące menu wyszukiwania rozszerzonego, wybierz Presets > Save Preset (Ustawienia 
wstępne > Zapisz ustawienie wstępne) i wprowadź nazwę ustawienia wstępnego. Zapisane 
ustawienia wstępne zostaną dodane do podmenu Presets (Ustawienia wstępne).
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6. Opcjonalnie: Aby usunąć gotowe ustawienia filtra wyszukiwania, otwórz wyskakujące menu 
    wyszukiwania rozszerzonego, wybierz ustawienie wstępne, a następnie wybierz opcję Remove 
    Preset (Usuń ustawienie wstępne).

Brakujące pliki
Kiedy po otwarciu projektu brakuje jednego lub więcej plików, otwiera się okno dialogowe   
Resolve Missing Files (Rozwiąż brakujące pliki). Jeśli klikniesz Close (Zamknij), projekt zostanie 
otwarty bez brakujących plików.
W Pool (Puli) możesz sprawdzić, które pliki uznaje się za brakujące. Jest to sygnalizowane znakiem
zapytania w kolumnie Status.

Plik uznaje się za brakujący, jeśli spełniony jest jeden z następujących warunków:
● Plik został przeniesiony lub zmieniono jego nazwę poza program od czasu ostatniej pracy nad 
projektem i zignorowałeś okno dialogowe Resolve Missing Files (Rozwiąż brakujące pliki) 
podczas otwierania projektu w bieżącej sesji.
● Podczas bieżącej sesji przeniosłeś plik lub zmieniłeś jego nazwę poza program.
● Przeniosłeś lub zmieniłeś nazwę folderu, w którym znajdują się brakujące pliki.

Lokalizowanie brakujących plików

PROCEDURA
1. Wybierz opcję Media > Find Missing Files (Multimedia > Znajdź brakujące pliki).
2. W oknie dialogowym Resolve Missing Files zdecyduj, czy chcesz, aby program znalazł plik za   
    Ciebie (Search (Szukaj)), czy chcesz go znaleźć samodzielnie (Locate (Zlokalizuj)), czy też 
    chcesz określić, w którym katalogu program będzie szukać pliku (Folder).
● Jeśli wybierzesz opcję Search (Szukaj), otworzy się okno dialogowe umożliwiające określenie 
   folderu lub dysku, który program będzie skanował. Kliknij opcję Search Folder (Wyszukaj 
   folder), wybierz katalog lub dysk i kliknij przycisk Start. Jeśli zostanie znaleziony, wybierz plik z
   listy i kliknij Accept (Akceptuj). Następnie Cubase próbuje automatycznie zmapować wszystkie 
   pozostałe brakujące pliki.
● Jeżeli wybierzesz opcję Locate (Znajdź), otworzy się okno dialogowe umożliwiające ręczne 
   zlokalizowanie pliku. Wybierz plik i kliknij Open (Otwórz).
● Jeśli wybierzesz Folder, otworzy się okno dialogowe umożliwiające określenie katalogu, w 
   którym można znaleźć brakujący plik. Może to być preferowana metoda, jeśli zmieniłeś nazwę 
   folderu zawierającego brakujący plik lub go przeniosłeś, ale plik nadal ma tę samą nazwę. Po 
   wybraniu odpowiedniego folderu program znajdzie plik i będzie można zamknąć okno dialogowe.

Rekonstrukcja brakujących plików edycji
Jeśli nie można znaleźć brakującego pliku, jest to zwykle sygnalizowane znakiem zapytania w 
kolumnie Status w Pool (Puli). Jeśli jednak brakujący plik jest plikiem edycji (plikiem tworzonym 
podczas przetwarzania dźwięku i przechowywanym w folderze Edits w folderze projektu), program
może go zrekonstruować, odtwarzając edycję w formacie oryginalnego pliku dźwiękowego.

PROCEDURA
1. W oknie Pool (Pula) zlokalizuj klipy, dla których brakuje plików.
2. Sprawdź kolumnę Status (Stan). Jeśli status plików to “Reconstructible” („Można do  
    rekonstrukcji”), Cubase może je zrekonstruować.
3. Wybierz klipy, które można zrekonstruować i wybierz opcję Media > Reconstruct (Media > 
    Rekonstruuj).

WYNIK
Następuje edycja i odtwarzane są pliki edycji.
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Usuwanie brakujących plików z Pool (puli)
Jeśli Pula zawiera pliki audio, których nie można znaleźć ani zrekonstruować, warto je usunąć.

PROCEDURA
● W oknie Pool (Pula) wybierz Media > Remove Missing Files (Multimedia > Usuń brakujące 
   pliki).

WYNIK
Wszystkie brakujące pliki z Pool i odpowiadające im zdarzenia z okna Project zostaną usunięte.

Przesłuchiwanie klipów w Pool (Puli)
Możesz odsłuchiwać klipy w puli za pomocą poleceń klawiszowych, przycisku Audition 
(Przesłuchanie) lub klikając obraz przebiegu klipu.

●   Używaj poleceń klawiszowych.
Jeśli w oknie dialogowym Preferences (Preferencje) (strona Transport) aktywujesz opcję 
Playback Toggle Triggers Local Preview (Przełączanie odtwarzania wyzwala lokalny podgląd), 
możesz użyć Space (Spacja) do odsłuchania. Działa to tak samo, jak aktywacja Audition na pasku 
narzędzi.
● Wybierz klip i aktywuj Audition (Przesłuchanie).
Odtworzony zostanie cały klip. Aby zatrzymać odtwarzanie, kliknij ponownie Audition.
● Kliknij obraz przebiegu, aby wyświetlić klip.
Klip będzie odtwarzany od wybranego miejsca na fali do końca. Aby zatrzymać odtwarzanie, 
kliknij opcję Audition lub gdziekolwiek indziej w oknie Pool (Pula).

Jeśli audio jest aktywowane, kierowane jest bezpośrednio do Control Room (Reżyserki). Kiedy 
Control Room jest wyłączony, dźwięk jest kierowany do szyny Main Mix (domyślne wyjście), z 
pominięciem ustawień kanału audio, efektów i korektora dźwięku (EQ).

UWAGA
Możesz dostosować poziom odsłuchu za pomocą miniaturowego suwaka poziomu na pasku 
narzędzi. Nie ma to wpływu na normalny poziom odtwarzania.

Jeśli aktywowałeś Audition Loop (Pętla przesłuchania) przed przesłuchaniem, dzieje się co 
następuje:
● Kiedy klikniesz Audition (Przesłuchanie), aby odsłuchać klip, klip będzie powtarzany w  
   nieskończoność, aż do zatrzymania odtwarzania poprzez ponowne kliknięcie Audition lub 
   Audition Loop.
● Po kliknięciu obrazu fali w celu odsłuchania fragmentu, od wybranego punktu do końca klipu, 
   klip będzie powtarzany w nieskończoność, aż do zatrzymania odtwarzania.

Otwieranie klipów w Sample Editor (edytorze próbek)
Edytor próbek umożliwia szczegółową edycję klipu.

● Aby otworzyć klip w Sample Editor, kliknij dwukrotnie ikonę przebiegu klipu lub nazwę klipu 
w kolumnie Media.
● Aby otworzyć określony region klipu w Sample Editor, kliknij dwukrotnie region w Pool (Puli). 
Można tego użyć na przykład do ustawienia punktu przyciągania klipu. Kiedy później wstawisz klip
z puli do projektu, zdefiniowany punkt przyciągania umożliwi jego odpowiednie wyrównanie.

POWIĄZANE LINKI
Dostosowywanie punktu przyciągania na stronie 529
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Sample Editor (Edytor próbek) na stronie 509

Importowanie multimediów
Okno dialogowe Import Medium (Importuj nośnik) umożliwia importowanie plików bezpośrednio
do Pool (puli).
Aby otworzyć okno dialogowe, wybierz opcję Media > Import Medium (Multimedia > Importuj 
nośnik) lub kliknij opcję Import (Importuj) na pasku narzędzi Pool (Pula).

Spowoduje to otwarcie standardowego okna dialogowego pliku, w którym możesz przejść do 
innych folderów, plików odsłuchu itp. Można importować następujące formaty plików audio:
● Wave (Fala) (normalna lub nadawana)
● AIFF i AIFC (skompresowany AIFF)
● REX lub REX 2
● FLAC (darmowy bezstratny kodek audio)
● MPEG Layer 2 i Layer 3 (pliki MP2 i MP3)
● Ogg Vorbis (pliki OGG)
● Windows Media Audio (tylko Windows)
● Wave 64 (Fala 64) (pliki W64)

Możliwe są następujące cechy:
● Stereo lub mono
● Dowolna częstotliwość próbkowania

UWAGA
Pliki, które mają inną częstotliwość próbkowania niż częstotliwość próbkowania projektu, są 
odtwarzane z niewłaściwą szybkością i wysokością.

● 8 bit, 16 bit, 24 bit, 32 bit, 32 bit float lub 64 bit float
● Różne formaty wideo

UWAGA
Możesz także użyć poleceń z podmenu Import (Importuj) w menu File (Plik), aby zaimportować 
pliki audio lub wideo do Pool (puli).

POWIĄZANE LINKI
Pliki Wave na stronie 1068
Importowanie plików ReCycle na stronie 290
Obsługiwane formaty skompresowanych plików audio na stronie 287
Zgodność plików wideo na stronie 1097

Importowanie płyt audio CD do Pool (puli)
Możesz importować ścieżki lub fragmenty ścieżek z płyty audio CD bezpośrednio do Pool. 
Spowoduje to otwarcie okna dialogowego, w którym możesz określić, które ścieżki mają zostać 
skopiowane z płyty CD, przekonwertowane na pliki audio i dodane do Pool.

● Aby zaimportować płytę audio CD do puli, wybierz opcję Media > Import Audio CD (Media > 
   Importuj płytę audio CD).

POWIĄZANE LINKI
Importowanie ścieżek audio CD na stronie 287
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Okno dialogowe Import Options (Opcje importu)
Okno dialogowe Import Options pozwala określić sposób importowania plików audio do Pool 
(puli).
● Jeśli wybierzesz plik w oknie dialogowym Import Medium (Nośnik importu) i klikniesz Open 
(Otwórz), otworzy się okno dialogowe Import Options (Opcje importu).

              
Okno dialogowe Import Options umożliwiające import pojedynczego pliku

              
Okno dialogowe Import Options umożliwiające import wielu plików

Copy File to Project Folder/Copy All Files to Project Folder (Skopiuj plik do folderu 
projektu/Kopiuj wszystkie pliki do folderu projektu)
        Kopiuje plik audio do folderu Audio projektu, a klip odnosi się do kopii. Dezaktywuj tę opcję, 
        aby klip odnosił się do oryginalnego pliku w oryginalnej lokalizacji. W tym przypadku jest on 
        oznaczony w Pool (Puli) jako „external (zewnętrzny)”.
Convert to Project Settings/Convert to Project Settings and Copy to Project Folder If Needed 
(Konwertuj na ustawienia projektu/Konwertuj na ustawienia projektu i w razie potrzeby skopiuj do 
folderu projektu)
       Konwertuje zaimportowany plik, jeśli częstotliwość próbkowania lub głębia bitowa różnią się 
       od ustawień w oknie dialogowym Ustawienia projektu. W przypadku importu pojedynczego 
       pliku możesz wybrać, które właściwości mają być konwertowane.
Split Channels (Rozdzielone kanały)
       Dzieli pliki audio stereo lub wielokanałowe na odpowiednią liczbę plików mono, po jednym 
       dla każdego kanału, i kopiuje zaimportowane pliki do folderu Audio projektu. Rozdzielone 
       pliki są wstawiane do projektu i do Pool (puli) jako osobne ścieżki mono. Wyskakujące menu 
       Name Format (Format nazwy) pozwala określić sposób nazywania rozdzielonych plików. 
       Zapewnia to kompatybilność z innymi produktami podczas wymiany plików audio.
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Do not ask again (Nie pytaj ponownie)
       Zawsze importuje pliki zgodnie z ustawieniami bez ponownego otwierania okna dialogowego.  
       Możesz zresetować tę opcję w oknie dialogowym Preferences (Preferencje) (Editing (Edycja) 
       – strona Audio).

POWIĄZANE LINKI
Kolumny okna Pool (Puli) na stronie 612
Konwertowanie plików na stronie 627

Eksportowanie regionów jako plików audio
Jeśli w klipie audio utworzyłeś regiony, można je wyeksportować jako osobne pliki audio. Jeśli 
masz dwa klipy odnoszące się do tego samego pliku audio, możesz utworzyć osobny plik audio dla 
każdego klipu.

PROCEDURA
1. W oknie Pool (Pula) wybierz region, który chcesz wyeksportować.
2. Wybierz opcję Audio > Bounce Selection (Audio > Wybór odbicia).
3. Wybierz folder, w którym chcesz utworzyć nowy plik i kliknij OK.
4. Opcjonalnie: Jeśli używasz opcji Bounce Selection (Zaznaczanie odbicia), aby utworzyć 
    oddzielny plik audio dla klipu, który odnosi się do tego samego pliku audio co inny klip, 
    wprowadź nazwę nowego pliku audio.

WYNIK
W określonym folderze zostanie utworzony nowy plik audio. Plik ma nazwę regionu i jest 
automatycznie dodawany do Pool (Puli)

POWIĄZANE LINKI
Tworzenie zdarzeń audio z regionów na stronie 528

Zmiana folderu rekordów puli
Wszystkie klipy audio nagrane w projekcie są zapisywane w folderze Pool Record. Folder Pool 
Record jest oznaczony tekstem Record w kolumnie Status i kropką na samym folderze.

Domyślnie jest to główny folder Audio. Możesz jednak utworzyć nowy podfolder Audio 
i wyznaczyć go jako folder Pool Record.

UWAGA
Foldery utworzone w Pool (Puli) służą wyłącznie do porządkowania plików w Puli. Wszystkie pliki
są nagrywane w folderze określonym jako folder Pool Record.

PROCEDURA
1. W Pool (puli) wybierz folder Audio lub dowolny klip audio.

UWAGA
Nie możesz wyznaczyć folderu Video ani żadnego z jego podfolderów jako folderu Pool Record.

2. Wybierz opcję Media > Create Folder (Multimedia > Utwórz folder).
3. Zmień nazwę nowego folderu.
4. Wybierz nowy folder i wybierz opcję t Media > Set Pool Record Folder (Media > Ustaw folder 
    nagrań puli) lub kliknij kolumnę Status (Stan) nowego folderu..
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WYNIK
Nowy folder stanie się folderem Pool Record. Każdy dźwięk nagrany w projekcie jest zapisywany 
w tym folderze.

Porządkowanie klipów i folderów
Jeśli zgromadzisz dużą liczbę klipów w Puli, szybkie znalezienie konkretnych przedmiotów może 
być trudne. Rozwiązaniem może być organizowanie klipów w nowych podfolderach o nazwach 
odzwierciedlających treść. Na przykład możesz umieścić wszystkie efekty dźwiękowe w jednym 
folderze, wszystkie główne wokale w innym itp.

PROCEDURA
1. W oknie Pool (Pula) wybierz folder, dla którego chcesz utworzyć podfolder.
 
UWAGA
Nie można umieszczać klipów audio w folderze wideo i odwrotnie.

2. Wybierz opcję Media > Create Folder (Multimedia > Utwórz folder).
3. Zmień nazwę folderu.
4. Przeciągnij klipy do nowego folderu.

Stosowanie przetwarzania do klipów w Pool (puli)
Możesz zastosować przetwarzanie dźwięku do klipów z Pool w taki sam sposób, jak do zdarzeń w 
oknie Project.

PROCEDURA
1. W oknie Pool (Pula) wybierz klipy, które chcesz przetworzyć.
2. Wybierz opcję Audio > Direct Offline Processing (Audio > Bezpośrednie przetwarzanie 
    offline) i wybierz metodę przetwarzania.

WYNIK
Symbol fali wskazuje, że klipy zostały przetworzone.

POWIĄZANE LINKI
Bezpośrednie przetwarzanie offline na stronie 475

Cofanie przetwarzania
Możesz cofnąć przetwarzanie zastosowane do klipów.

PROCEDURA
1. W oknie Pool (Pula) wybierz klip, z którego chcesz usunąć obróbkę.
2. Wybierz opcję Audio > Direct Offline Processing (Audio > Bezpośrednie przetwarzanie 
    offline).
3. Wybierz akcję, którą chcesz usunąć i kliknij Delete (Usuń).
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Minimalizowanie plików
Możesz zminimalizować pliki audio zgodnie z rozmiarem klipów audio, do których odwołuje się 
projekt. Pliki utworzone przy użyciu tej opcji zawierają tylko te fragmenty plików audio, które są 
faktycznie użyte w projekcie.

Może to znacznie zmniejszyć rozmiar projektu, jeśli duże fragmenty plików audio nie są 
wykorzystywane. Dlatego opcja jest przydatna do celów archiwizacji po zakończeniu projektu.

WAŻNE
Ta operacja trwale zmienia wybrane pliki audio w Pool (Puli). Tego nie da się cofnąć. Jeśli chcesz 
utworzyć jedynie zminimalizowane pliki audio jako kopię, pozostawiając oryginalny projekt 
nienaruszony, możesz skorzystać z opcji Back up Project (Utwórz kopię zapasową projektu).

UWAGA
Minimalizowanie plików usuwa całą historię edycji.

PROCEDURA
1. W oknie Pool (Pula) wybierz pliki, które chcesz zminimalizować.
2. Wybierz opcję Media > Minimize File (Multimedia > Minimalizuj plik).
3. Kliknij Minimize (Minimalizuj).
    Po zakończeniu minimalizacji odniesienia do plików w zapisanym projekcie tracą ważność.
4. Wykonaj jedną z następujących czynności:
    ● Aby zapisać zaktualizowany projekt, kliknij Save Now (Zapisz teraz).
    ● Aby kontynuować niezapisany projekt, kliknij Later (Później).

WYNIK
W odpowiednich plikach audio w folderze Pool Record pozostają tylko te fragmenty audio, które 
są faktycznie użyte w projekcie.

POWIĄZANE LINKI
Tworzenie kopii zapasowych projektów na stronie 110

Importowanie i eksportowanie plików puli
Możesz importować lub eksportować Pool (pulę) jako oddzielny plik. Rozszerzenie pliku to „.npl”.

● Aby zaimportować plik Pool (pula), wybierz Media > Import Pool (Media > Importuj pulę).
   Kiedy importujesz plik Pool, jego odniesienia do plików są dodawane do bieżącej puli.

UWAGA
Ponieważ pliki audio i wideo są jedynie odniesieniami, ale nie są zapisywane w pliku Pool, import 
puli jest użyteczny tylko wtedy, gdy masz dostęp do wszystkich plików odniesienia. Pliki te mają 
najlepiej te same ścieżki plików, co podczas zapisywania Pool.

● Aby wyeksportować plik Pool (puli), wybierz Media > Export Pool (Media > Eksportuj pulę).
Można także zapisywać i otwierać biblioteki, czyli samodzielne pliki puli, które nie są powiązane z 
projektem.

POWIĄZANE LINKI
Waspółpraca z bibliotekami na stronie 627
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Współpraca z bibliotekami
Możesz używać bibliotek do zapisywania efektów dźwiękowych, pętli, klipów wideo itp. oraz 
przesyłania multimediów z biblioteki do projektu za pomocą przeciągania i upuszczania.

● Aby utworzyć nową bibliotekę, wybierz File > New Library (Plik > Nowa biblioteka).
Musisz określić folder projektu dla nowej biblioteki, w którym będą przechowywane pliki 
multimedialne. Biblioteka pojawia się jako osobne okno puli.
● Aby otworzyć bibliotekę, wybierz File > Open Library (Plik > Otwórz bibliotekę).
● Aby zapisać bibliotekę, wybierz File > Save Library (Plik > Zapisz bibliotekę).

Konwersja plików
W Pool (Puli) możesz konwertować pliki do innego formatu.

PROCEDURA
1. W oknie Pool (Pula) wybierz pliki, które chcesz skonwertować.
2. Wybierz opcję Media > Convert Files (Multimedia > Konwertuj pliki).
3. W oknie dialogowym Convert Options (Opcje konwersji) wprowadź zmiany i kliknij OK.

Okno dialogowe Convert Options (Opcji konwersji)
W tym oknie dialogowym możesz konwertować pliki audio w Pool (puli)

● Aby otworzyć okno dialogowe Convert Options (Opcje konwersji), wybierz klip w oknie Pool 
(Pula) i wybierz Media > Convert Files (Media > Konwertuj pliki).

                

Sample Rate (Częstotliwość próbkowania)
       Umożliwia konwersję na inną częstotliwość próbkowania.
Bit Depth (Głębia bitowa)
       Umożliwia konwersję do wersji 16-bitowej, 24-bitowej, 32-bitowej, 32-bitowej typu float lub   
       64-bitowej wersji float.
Channels (Kanały)
       Umożliwia konwersję do formatu mono lub stereo z przeplotem.
File Format (Format pliku)
       Umożliwia konwersję do formatu Wav, AIFF, FLAC, Wav 64 lub Broadcast Wave.
Options (Opcje)
       W wyskakującym menu Options możesz ustawić jedną z następujących opcji:
●   New Files (Nowe Pliki)
Tworzy kopię pliku w folderze audio i konwertuje ten nowy plik zgodnie z wybranymi atrybutami. 
Nowy plik zostanie dodany do puli, ale wszystkie odniesienia do klipów nadal wskazują 
oryginalny, nieprzekonwertowany plik.
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●   Replace Files (Zamień pliki)
Konwertuje oryginalny plik bez zmiany odniesień do klipów. Jednakże odniesienia zostaną 
zapisane przy następnej akcji zapisu.
●   New + Replace in Pool (Nowy + Wymień w puli)
Tworzy nową kopię z wybranymi atrybutami, zastępuje oryginalny plik nowym w puli i 
przekierowuje bieżące odniesienia do klipów z oryginalnego pliku do nowego pliku. Wybierz tę 
opcję, jeśli chcesz, aby Twoje klipy audio nawiązywały do przekonwertowanego pliku, ale chcesz 
zachować oryginalny plik na dysku, na przykład jeśli plik jest używany w innych projektach.

Wyodrębnianie dźwięku z pliku wideo
Możesz wyodrębnić dźwięk z plików wideo. Spowoduje to automatyczne wygenerowanie nowego 
klipu audio, który pojawi się w folderze Pool Record.

UWAGA
Ta funkcja nie jest dostępna w przypadku plików wideo MPEG-1.

PROCEDURA
1. W oknie Pool (Pula) wybierz Media > Extract Audio from Video File (Multimedia > 
   Wyodrębnij audio z pliku wideo).
2. Wybierz plik wideo, z którego chcesz wyodrębnić dźwięk i kliknij Open (Otwórz).

WYNIK
Dźwięk jest wyodrębniany z pliku wideo. Plik audio otrzymuje ten sam format i częstotliwość 
próbkowania/szerokość jak w bieżącym projekcie oraz taką samą nazwę jak plik wideo.
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MediaBay i Media Rack

Możesz zarządzać plikami multimedialnymi na komputerze, a także ustawieniami wstępnymi z 
wielu źródeł z poziomu MediaBay (zatokI multimediów) lub Media Rack (stojaka na nośniki).

Okno MediaBay oferuje zaawansowane funkcje do pracy z plikami multimedialnymi i zarządzania 
elementami bazy danych. Aby wyświetlić pliki multimedialne znajdujące się na komputerze w 
wnęce MediaBay, należy przeskanować foldery lub woluminy zawierające pliki, aby zostały one 
dodane do bazy danych

Mwedia Rack (Stojak na nośniki) w prawej strefie okna Project umożliwia dostęp do niektórych 
najważniejszych funkcji MediaBay ze stałej strefy okna Project. Aby uzyskać szybki dostęp do 
określonych plików multimedialnych, Media Rack umożliwia dodanie określonych folderów na 
komputerze jako ulubionych. Pliki multimedialne w ulubionych folderach dodanych do Media 
Rack są automatycznie skanowane i dodawane do bazy danych.

POWIĄZANE LINKI
Okno MediaBay na stronie 640
Skanowanie folderów na stronie 643
Media Rack (Stojak na nośniki) w prawej strefie na stronie 629
Dodawanie ulubionych za pomocą strony Ulubione na stronie 638
Dodawanie ulubionych przy użyciu strony przeglądarki plików na stronie 638

Media Rack in Right Zone (Stojak na media w prawej strefie)

Media Rack (Stojak na nośniki) w prawej strefie okna Project umożliwia dostęp do funkcji 
MediaBay ze stałej strefy okna Project.

● Aby otworzyć Media Rack (stojak na multimedia) w prawej strefie, kliknij opcję Show/Hide 
Right Zone (Pokaż/ukryj prawą strefę) na pasku narzędzi okna Project i na górze prawej strefy 
kliknij zakładkę Media.

Media Rack (Stojak na multimedia) otwiera się na stronie Home (głównej) zawierającej różne 
kafelki. Te kafelki odpowiadają dostępnym typom mediów.

POWIĄZANE LINKI
Pokazywanie/ukrywanie stref na stronie 45
Strona główna na stronie 629
Pasek narzędzi okna projektu na stronie 46

Home Page (Strona główna)

Home Page (Strona główna) umożliwia dostęp do kafelków odpowiadających dostępnym typom 
multimediów, do Favorites (Ulubione) i do File Browser (Przeglądarki plików).

●   Aby otworzyć stronę główną, kliknij element sterujący nawigacją po stronie głównej na stojaku 
     na nośniki.
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Dostępne są następujące płytki:
VST Instruments (Instrumenty VST)
       Pokazuje instrumenty VST i presety (wstępne ustawienia) instrumentów.
VST Effects (Efekty VST)
       Pokazuje efekty VST i gotowe ustawienia efektów.
Loops & Samples (Pętle i próbki)
       Pokazuje pętle audio, pętle MIDI lub dźwięki instrumentów uporządkowane według zestawu 
       treści.
Presets (Ustawienia wstępne)
       Pokazuje presety ścieżek, presety pasków, banki paternów, presety łańcucha FX i presety VST 
       FX.
User Presets (Ustawienia użytkownika)
       Pokazuje presety ścieżek, presety pasków, banki paternów, presety łańcucha FX, presety VST 
       FX i presety instrumentów wymienione w folderze User Content (treści użytkownika).
Favorites (Ulubione)
       Pokazuje Twoje ulubione foldery i umożliwia dodawanie nowych ulubionych. Zawartość 
       folderu jest automatycznie dodawana do bazy danych MediaBay.
File Browser (Przeglądarka plików)
       Pokazuje system plików i wstępnie zdefiniowane foldery Favorites (Ulubione), This 
       Computer (Ten komputer), VST Sound (Dźwięk VST, Factory Content (Zawartość 
       Fabryczna) i User Content (Zawartość użytkownika), w których można wyszukiwać pliki  
       multimedialne i uzyskać do nich natychmiastowy dostęp.

POWIĄZANE LINKI
Ładowanie presetów instrumentów na stronie 665
Ładowanie pętli i sampli na stronie 664
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Ładowanie presetów utworów na stronie 664
Ładowanie gotowych ustawień wtyczek efektów na stronie 665
Ładowanie presetów łańcucha efektów na stronie 666
Ładowanie gotowych ustawień pasków na stronie 666
Ładowanie banków wzorów na stronie 666
Dodawanie ulubionych za pomocą strony Ulubione na stronie 638
Dodawanie Ulubionych przy użyciu strony przeglądarki plików na stronie 638

Strona Favorites (Ulubione)
Strona Ulubione umożliwia dodawanie własnych ulubionych folderów do Media Rack (stojaka na 
nośniki).

                

1    Add Favorite (Dodaj Ulubione)
      Otwiera okno dialogowe pliku, w którym można przejść do lokalizacji folderu i dodać go jako 
      folder ulubiony.
2    Favorite folders (Ulubione foldery)
      Foldery dodane jako ulubione są wyświetlane w formie kafelków na stronie Ulubione.
        ● Aby wyświetlić zawartość folderu, kliknij go.
        ● Aby usunąć folder ze strony Ulubione, kliknij jego przycisk zamykania

POWIĄZANE LINKI
Dodawanie ulubionych za pomocą strony Ulubione na stronie 638

Results Page (Strona wyników)

Strona Results (Wyniki) pokazuje wszystkie pliki multimedialne znalezione w zdefiniowanym 
folderze ulubionych.

● Aby otworzyć stronę Results, kliknij element nawigacyjny Show All Results (Pokaż wszystkie 
wyniki) na Media Rack (stojaku na nośniki).
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1   Media Rack navigation controls (Elementy sterujące nawigacją w stojaku na nośniki)
     Umożliwiają nawigację do określonych folderów i filtrowanie listy wyników.
2   Attribute filter (Filtr atrybutów)
     Umożliwia przeglądanie i edytowanie niektórych standardowych atrybutów plików znajdujących
     się w plikach multimedialnych.
3   Results list (Lista wyników)
     Pokazuje wszystkie pliki multimedialne znalezione w wybranym folderze i umożliwia wybranie 
     pliku multimedialnego.
4   Previewer (Podgląd)
     Umożliwia podgląd wybranego pliku multimedialnego.

POWIĄZANE LINKI
Elementy sterujące nawigacją w Media Rack (stojaku na nośniki) na stronie 636
Konfigurowanie kolumn listy wyników na stronie 645
Inspektor atrybutów na stronie 659
Sekcja wyników na stronie 645
Sekcja podglądu na stronie 650

File Browser Page (Strona przeglądarki plików)

Strona File Browser (Przeglądarka plików) pokazuje wszystkie pliki multimedialne znalezione 
w File Browser.

● Aby otworzyć stronę File Browser (Przeglądarki plików), przejdź do Home (strony głównej) 
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   Media Rack (stojaka na nośniki) i kliknij File Browser (Przeglądarka plików).

              

Dostępne są następujące opcje:
1   Media Rack navigation controls (Elementy sterujące nawigacją w stojaku na nośniki)
     Umożliwiają nawigację do określonych folderów i filtrowanie listy wyników.
2   Add Favorite (Dodaj Ulubione)
     Umożliwia dodanie wybranego folderu jako ulubionego.
3   Back/Forward/Up (Wstecz/Do przodu/W górę)
     Up (W górę) przechodzi do folderu nadrzędnego. Back (Wstecz) powoduje przejście do  
     poprzednio używanego folderu. Forward (Do przodu) powoduje przejście do najnowszego  
     folderu.
4   File browser (Przeglądarka plików)
     Umożliwia przeglądanie wybranych folderów.
5   Results list (Lista wyników)
     Pokazuje wszystkie obsługiwane pliki multimedialne znalezione w wybranym folderze i 
     umożliwia wybranie pliku multimedialnego.
6   Previewer (Podgląd)
     Umożliwia podgląd wybranego pliku multimedialnego.

POWIĄZANE LINKI
Elementy sterujące nawigacją w Media Rack (stojaku na nośniki) na stronie 636
Sekcja File Browser (Przeglądarka plików) na stronie 643
Sekcja wyników na stronie 645
Sekcja podglądu na stronie 650
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VST Instruments Page (Strona Instrumenty VST)
Strona VST Instruments (Instrumenty VST) pokazuje wszystkie instrumenty VST z wybranej 
kolekcji.

● Aby otworzyć stronę VST Instruments, przejdź do Home (strony głównej) Media Rack (stojaka
na nośniki) i kliknij VST Instruments.

               
Dostępne są następujące opcje:
1   Media Rack navigation controls (Elementy sterujące nawigacją w stojaku na nośniki)
     Umożliwiają nawigację do określonych folderów i filtrowanie listy wyników.
2   Expand All (Rozwiń wszystko)
     Rozwija wszystkie wyniki.
3   Collapse All (Zwiń wszystko)
     Zwija wszystkie wyniki.
4   Show/Hide VST Plug-in Pictures (Pokaż/ukryj obrazy wtyczek VST)
     Pokazuje/ukrywa obrazy paneli sterowania przyrządów VST.
5   Plug-in Collections and Options (Kolekcja wtyczek i opcji)
     ●   Default (Domyślne) aktywuje kolekcję domyślną.
     ●   Sort By Category (Sortuj według kategorii) sortuje kolekcję według kategorii. Ta opcja jest  
          dostępna tylko w przypadku kolekcji Default.
     ●   Sort By Vendor (Sortuj według dostawcy) sortuje kolekcję według dostawcy. Ta opcja jest 
          dostępna tylko w przypadku kolekcji Default.
     ●   Plug-in Manager (Menedżer wtyczek) otwiera Plug-in Manager (Menedżera wtyczek),  
          który umożliwia tworzenie nowych kolekcji wtyczek. Zostaną one wyświetlone w menu e  
          Plug-in Collections and Options (Kolekcje i opcje wtyczek), poniżej kolekcji Default 
          (Domyślna).
6   Plug-in list (Lista wtyczek)
     Pokazuje wtyczki wybranej kolekcji.
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POWIĄZANE LINKI
Okno Menedżera wtyczek VST na stronie 744
Dodawanie zdjęć instrumentów VST do Media Rack (stojaka na media) na stronie 639

VST Effects Page (Strona Efektów VST)
Strona VST Effects pokazuje wszystkie efekty VST z wybranej kolekcji.

● Aby otworzyć stronę VST Effects (Efekty VST), przejdź do Home (strony głównej) Media Rack 
(stojaka na Media) i kliknij VST Effects.

             

Dostępne są następujące opcje:
1   Media Rack navigation controls (Elementy sterujące nawigacją w stojaku na nośniki)
     Umożliwiają nawigację do określonych folderów i filtrowanie listy wyników.
2   Expand All (Rozwiń wszystko)
     Rozwija wszystkie wyniki.
3   Collapse All (Zwiń wszystko)
     Zwija wszystkie wyniki.
4   Show/Hide VST Plug-in Pictures (Pokaż/ukryj obrazy wtyczek VST)
     Pokazuje/ukrywa obrazy paneli sterowania efektem VST.
5   Plug-in Collections and Options (Kolekcja wtyczek i opcji)
     ●   Default (Domyślne) aktywuje kolekcję domyślną.
     ●   Sort By Category (Sortuj według kategorii) sortuje kolekcję według kategorii. Ta opcja jest  
          dostępna tylko w przypadku kolekcji Default.
     ●   Sort By Vendor (Sortuj według dostawcy) sortuje kolekcję według dostawcy. Ta opcja jest 
          dostępna tylko w przypadku kolekcji Default.
     ●   Plug-in Manager (Menedżer wtyczek) otwiera Plug-in Manager (Menedżera wtyczek), 
          który umożliwia tworzenie nowych kolekcji wtyczek. Zostaną one wyświetlone w menu 
          Plug-in Collections and Options (Kolekcje i opcje wtyczek), poniżej kolekcji Default.
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6   Plug-in list (Lista wtyczek)
     Pokazuje wtyczki wybranej kolekcji.

POWIĄZANE LINKI
Okno Menedżera wtyczek VST na stronie 744
Dodawanie zdjęć efektów VST do Media Rack (stojaka na media) na stronie 639

Media Rack Navigation Controls (Elementy sterujące nawigacją w 
stojaku na media)
Elementy sterujące nawigacją umożliwiają nawigację do plików i folderów w Media rack (stojaku 
na nośniki).
Poniższe elementy sterujące umożliwiają wyszukiwanie tekstu i wyświetlanie wszystkich wyników 
na bieżącej stronie.

     
1   Search (Szukaj)
     Umożliwia wyszukiwanie plików multimedialnych według nazwy lub atrybutu.
2   Reset Search (Zresetuj wyszukiwanie)
     Umożliwia zresetowanie wyszukiwania.
3   Show All Results (Pokaż wszystkie wyniki)
     Wyświetla stronę Results (Wyniki) dla wybranego kafelka. Jeżeli nie wybrano żadnego kafelka, 
     pokazane zostaną wszystkie pliki multimedialne.

Poniższe elementy sterujące umożliwiają nawigację z bieżącej strony do innych stron.

     
1   Back (Powrót)
     Umożliwia powrót do poprzedniej strony.
2   Home (Strona główna)
     Umożliwia powrót do strony głównej.
3   Breadcrumb path (Ścieżka nawigacyjna)
     Pokazuje ścieżkę do bieżącej strony i umożliwia powrót do poprzedniej strony.
Poniższe elementy sterujące umożliwiają konfigurowanie i modyfikowanie strony Results 
(Wyniki).

      
1   Select Media Types (Wybierz Typy multimediów)
     Umożliwia wybranie typów multimediów wyświetlanych na stronie Wyniki.
2   Shuffle Results (Pomieszaj wyniki)
     Przetasowuje stronę wyników.
3   Reset Attribute Filter (Zresetuj filtr atrybutów)
     Świeci się, jeśli ustawiono filtr atrybutów. Kliknij ten przycisk, aby zresetować filtr atrybutów.
4   Set up Result Columns (Skonfiguruj kolumny wyników)
     Umożliwia określenie, które kolumny atrybutów będą wyświetlane na stronie Results (Wyniki).
5   Show/Hide Attribute Filters (Pokaż/ukryj filtry atrybutów)
     Pokazuje/ukrywa sekcję Filtry atrybutów.

POWIĄZANE LINKI
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Strona główna Home na stronie 629
Strona wyników na stronie 631
Atrybuty plików multimedialnych na stronie 657

Praca z Media Rack (stojakiem na media)
Stojak na media w prawej strefie okna Project umożliwia wyszukiwanie obsługiwanych plików 
multimedialnych i dołączonych instrumentów VST oraz dodawanie ich do projektu.

Elementy sterujące na różnych stronach Media Rack umożliwiają przeglądanie, filtrowanie, 
wybieranie i podgląd plików multimedialnych.

Strony Favorites (Ulubione) i File Browser (Przeglądarka plików) umożliwiają dodanie folderów, 
w których znajdują się pliki multimedialne, jako Favorites. Pomaga to szybko przejść do tych 
plików multimedialnych.

Kafelki i elementy sterujące na różnych stronach Media Rack (stojaka na multimedia) umożliwiają
przeglądanie, filtrowanie, wybieranie i podgląd zawartości.

Po zlokalizowaniu pliku multimedialnego, instrumentu lub presetu, którego chcesz użyć, i wybraniu
go na liście Results (Wyniki), możesz wstawić go do swojego projektu metodą przeciągania i 
upuszczania, korzystając z opcji menu kontekstowego lub podwójnego kliknięcia.

POWIĄZANE LINKI
Media Rack (Stojak na nośniki) w prawej strefie na stronie 629
Strona Results (wyników) na stronie 631.

Dodawanie instrumentów VST do projektów
Możesz użyć Media Rack (stojaka na Media), aby dodać instrumenty VST do swojego projektu.

PROCEDURA
1. W Media Rack (stojaku na Media) kliknij kafelek VST Instruments.
2. Przeciągnij instrument na listę utworów lub na ekran zdarzenia.

UWAGA
Aby zamienić instrument VST ścieżki instrumentu, przeciągnij instrument z Media Rack (stojaka 
na Media) i upuść go w górnej części Inspektora ścieżki instrumentu. Pamiętaj, że w razie 
potrzeby musisz ręcznie zaktualizować nazwę ścieżki.

POWIĄZANE LINKI
Ładowanie presetów instrumentów na stronie 665

Dodawanie efektów VST do projektów
Możesz użyć Media Rack (stojaka na Media), aby dodać efekty VST do swojego projektu.

PROCEDURA
1. W Media Rack (stojaku na Media) kliknij kafelek VST Effects (Efekty VST).
2. Wykonaj jedną z następujących czynności:
     ● Przeciągnij efekt na listę ścieżek, aby utworzyć ścieżkę kanału FX.
     ● Aby dodać efekt do ścieżki związanej z dźwiękiem, przeciągnij efekt z Media Rack (stojaka 
        na Media) i upuść go w sekcji Inserts (Wstawki) lub Sends (Wysyłki) w Inspektorze ścieżki.
     ● Aby dodać efekt do kanału związanego z audio, przeciągnij efekt z Media Rack i upuść go w 
        sekcji Inserts lub Sends w MixConsole w dolnej strefie okna Project lub okna Channel 
        Settings (Ustawienia kanałów).
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POWIĄZANE LINKI
Ładowanie gotowych ustawień wtyczek efektów na stronie 665

Stosowanie presetów ścieżek
Możesz użyć Media Rack (stojaka na media), aby dodać gotowe ścieżki do swojego projektu.

PROCEDURA
1. W Media Rack kliknij kafelek Presets (Ustawienia wstępne).
2. Kliknij opcję Track Presets (Ustawienia wstępne ścieżki).
3. Kliknij opcję Audio, VST Instruments, MIDI, Multi lub Sampler, w zależności od typu 
ścieżki.
4. Wykonaj jedną z następujących czynności:
      ● Przeciągnij wstępnie ustawiony utwór do Inspektora lub na listę utworów dla odpowiedniego
          typu ścieżki.
      ● Przeciągnij wstępnie ustawiony utwór poniżej listy utworów, aby dodać nowy utwór z 
         załadowanym wstępnie ustawionym utworem.

UWAGA
Aby zamienić ustawienie wstępne utworu, przeciągnij ustawienie wstępne z Media rack (stojaka na
nośniki) i upuść je na ścieżkę na liście ścieżek. Pamiętaj, że w razie potrzeby musisz ręcznie 
zaktualizować nazwę ścieżki.

WYNIK
Zastosowano wstępnie ustawioną ścieżkę.

Dodawanie ulubionych za pomocą strony Favorites (Ulubione)
Możesz dodać ulubione foldery do strony Favorites (Ulubione). Umożliwia to bezpośredni dostęp 
do plików multimedialnych w określonych folderach.

PROCEDURA
1. W Media Rack (stojaku na nośniki) kliknij kafelek Favorites (Ulubione).
2. W lewym górnym rogu strony kliknij Add Favorite (Dodaj ulubione).
3. Wybierz folder, który chcesz dodać do Favorite (Ulubionych).
4. Kliknij OK

WYNIK
● Ulubiony folder zostanie dodany do bazy danych.
● Na stronie Favorites (Ulubione) dodawany jest nowy kafelek o podanej nazwie.
● W File Browser (Przeglądarce plików) nowy folder o określonej nazwie zostanie dodany do  
   folderu Favorites (Ulubione).

POWIĄZANE LINKI
Strona Favorites (Ulubione) na stronie 631

Dodawanie ulubionych za pomocą strony File Browser (przeglądarki plików)
Możesz dodać ulubione foldery za pomocą strony File Browser (Przeglądarki plików). Umożliwia 
to bezpośredni dostęp do plików multimedialnych w określonych folderach.

PROCEDURA
1. W Media Rack (stojaku na nośniki) kliknij kafelek File Browser (Przeglądarka plików).
2. W przeglądarce plików przejdź do folderu, który chcesz dodać jako ulubiony, i wybierz go.
3. Wykonaj jedną z następujących czynności:
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     ● W lewym górnym rogu strony kliknij Add Favorite (Dodaj ulubione).
     ● Kliknij folder prawym przyciskiem myszy i z menu kontekstowego wybierz opcję Add  
        Favorite (Dodaj ulubione).

4. W otwartym oknie dialogowym Set Name (Ustaw nazwę) wprowadź nazwę folderu.
5. Kliknij OK

WYNIK
● Ulubiony folder zostanie dodany do bazy danych.
● W File Browser (Przeglądarce plików) nowy folder o określonej nazwie zostanie dodany do 
    folderu Favorites (Ulubione).
● Na stronie Favorites (Ulubione) dodawany jest nowy kafelek o podanej nazwie.

POWIĄZANE LINKI
Strona File Browser (przeglądarki plików) na stronie 632

Dodawanie zdjęć instrumentów VST do Media Rack (stojaka na 
media)
Zdjęcia instrumentów VST innych dostawców nie są domyślnie ładowane. Można je jednak dodać 
ręcznie do Media Rack (stojaka na nośniki).

WARUNEK WSTĘPNY
Dodałeś instrument VST innego dostawcy jako stojak lub instrument ścieżkowy.

PROCEDURA
1. Otwórz panel sterowania VST Instrument.
2. Na panelu sterowania kliknij opcję Add VST Plug-in Picture to Media Rack (Dodaj obraz 
    wtyczki VST do stojaka na nośniki).

WYNIK
Zdjęcie instrumentu VST jest pokazane w Media Rack (stojaku na nośniki).

POWIĄZANE LINKI
Dodawanie instrumentów VST na stronie 726
Panel sterowania instrumentu VST na stronie 726

Dodawanie zdjęć efektów VST do Media Rack (stojaka na media)
Zdjęcia efektów VST od innych dostawców nie są domyślnie ładowane. Można je jednak dodać 
ręcznie do Media Rack (stojaka na nośniki).

WARUNEK WSTĘPNY
Dodałeś efekt VST od innego dostawcy.

PROCEDURA
1. Otwórz panel sterowania efektem VST.
2. Na panelu sterowania kliknij opcję Add VST Plug-in Picture to Media Rack (Dodaj obraz 
wtyczki VST do stojaka na nośniki).

WYNIK
Obraz efektu VST jest pokazany w stojaku Media Rack.

POWIĄZANE LINKI
Dodawanie efektów wstawiania Insert Effects na stronie 446
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Panel sterowania efektami na stronie 464

MediaBay Window (Okno wnęki na multimedia)

Aby otworzyć wnękę MediaBay w oddzielnym oknie, wykonaj jedną z następujących czynności:
     ● Wybierz opcję Media > MediaBay (Multimedia > MediaBay).
     ● Naciśnij klawisz F5.

   

Zatoka MediaBay jest podzielona na następujące sekcje:

1   File Browser (Przeglądarka plików)
     Umożliwia skanowanie określonych folderów w systemie plików i dodawanie ulubionych.
2   Toolbar (Pasek narzędzi)
     Zawiera narzędzia i skróty do ustawień i funkcji w MediaBay oraz umożliwia przełączanie 
     pomiędzy wcześniej zdefiniowanymi ulubionymi lokalizacjami. Ulubione w oknie MediaBay 
     nie są skanowane automatycznie.
3   Filters (Filtry)
     Umożliwia filtrowanie listy wyników przy użyciu filtra logicznego lub atrybutowego.
4   Results (Wyniki)
     Wyświetla wszystkie obsługiwane pliki multimedialne. Możesz filtrować listę i wyszukiwać 
     tekst.
5   Previewer (Podgląd)
     Umożliwia podgląd plików pokazanych na liście Results (Wyniki).
6   Attribute Inspector (Inspektor atrybutów)
     Umożliwia przeglądanie, edytowanie i dodawanie atrybutów lub znaczników plików 
     multimedialnych.

POWIĄZANE LINKI
Sekcja File Browser (Przeglądarka plików) na stronie 643
Pasek narzędzi MediaBay na stronie 641
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Dodawanie ulubionych na stronie 644

Skanowanie folderów na stronie 643
Sekcja Filtry na stronie 655
Sekcja wyników na stronie 645
Sekcja podglądu na stronie 650
Inspektor atrybutów na stronie 659
Konfigurowanie wnęki MediaBay na stronie 643

Pasek narzędzi MediaBay
Pasek narzędzi zawiera narzędzia i skróty do ustawień i funkcji we wnęce MediaBay.

Nacigation (Nawigacja)
Back (Z powrotem)

        
       Przechodzi do poprzednio używanego folderu.
Forward (Do przodu)

        
       Przechodzi do najnowszego folderu.
Up (W górę)

        
       Przechodzi do folderu nadrzędnego.

Favorites (Ulubione)
Add Favorite (Dodaj ulubione)

        
       Umożliwia dodanie wybranego folderu jako ulubionego.
Select Defined Favorite (Wybierz opcję Zdefiniowany ulubiony)

        
       Umożliwia wybranie Ulubionego w celu szybkiego przeglądania plików, których szukasz.
Include Folders and Subfolders (Uwzględnij foldery i podfoldery)

        
       Aktywuj tę opcję, aby wyświetlić zawartość folderów i podfolderów.

Left Divider (Lewy rozdzielacz)
Left Divider
       Narzędzia umieszczone po lewej stronie rozdzielacza są zawsze pokazane.

Text Search (Wyszukiwanie tekstu)
Search (Szukaj)

        
       Umożliwia wyszukiwanie plików multimedialnych według nazwy lub atrybutu.

Media Types Filter (Filtr typów multimediów)
Select Media Types (Wybierz Typy multimediów)
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       Umożliwia wybranie typów multimediów wyświetlanych na stronie Results (Wyniki).

Rating Filter (Filtr ocen)
Rating Filter

        
       Filtruje pliki według ich oceny.

Reset Result Filters (Zresetuj filtry wyników)
Reset Filters (Zresetuj filtry)

        
       Umożliwia zresetowanie filtrów.

Results (Wyniki)
Update Results (Aktualizuj wyniki)

        
       Aktualizuje wyniki.
Shuffle Results (Pomieszaj wyniki)

        
       Przetasowuje stronę wyników.

Attribute Counter (Licznik atrybutów)
Attribute Counter

        
       Pokazuje liczbę aktualizowanych atrybutów.

Right Divider (Prawy rozdzielacz)
Right Divider 
       Narzędzia umieszczone po prawej stronie rozdzielacza są zawsze pokazane.

MediaBay Settings (Ustawienia MediaBay)
MediaBay Settings

        
       Otwiera ustawienia MediaBay

Window Zone Controls (Sterowanie strefą okienną)
Show/Hide Left Zone (Pokaż/ukryj lewą strefę)

        
       Pokazuje/ukrywa lewą strefę okna.
Show/Hide Lower Zone (Pokaż/ukryj dolną strefę)

        
       Pokazuje/Ukrywa dolną strefę okna.
Show/Hide Right Zone (Pokaż/Ukryj prawą strefę)

        
       Pokazuje/ukrywa prawą strefę okna.
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Set up Window Layout (Skonfiguruj układ okna)

        
       Umożliwia ustawienie układu okna.

Set up Toolbar (Skonfiguruj pasek narzędzi)

        
       Otwiera wyskakujące menu, w którym możesz ustawić, które elementy paska narzędzi mają 
       być widoczne.

Konfigurowanie MediaBay
Możesz pokazywać i ukrywać różne sekcje MediaBay. Oszczędza to miejsce na ekranie i pozwala 
wyświetlić tylko te informacje, które są potrzebne.

PROCEDURA
1. Kliknij opcję Set up Window Layout (Skonfiguruj układ okna).
2. Aktywuj/dezaktywuj pola wyboru sekcji, które chcesz pokazać/ukryć.
3. Kliknij poza okienkiem, aby wyjść z trybu konfiguracji.

Sekcja File Browser (Przeglądarki plików)
Sekcja File Browser (Przeglądarka plików) pokazuje system plików ze wstępnie zdefiniowanymi 
folderami Favorites (Ulubione), This Computer (Ten komputer), VST Sound (Dźwięk VST),  
Factory Content (Zawartość fabryczna) i User Content (Zawartość użytkownika).

● Aby otworzyć sekcję File Browser we wnęce MediaBay, kliknij opcję Set up Window Layout 
   (Skonfiguruj układ okna) i aktywuj File Browser.

             

Aby wyświetlić obsługiwane pliki multimedialne w sekcji Results (Wyniki) w MediaBay, musisz 
przeskanować wszystkie foldery, które chcesz uwzględnić w wyszukiwaniu.

Możesz także dodać ulubione foldery. Wszystkie pliki multimedialne zawarte w Favorite 
(Ulubionych) są automatycznie skanowane.

POWIĄZANE LINKI
Skanowanie folderów na stronie 643
Dodawanie ulubionych na stronie 644

Skanowanie folderów
Aby uwzględnić określone foldery w wyszukiwaniu MediaBay, należy je przeskanować.

PROCEDURA
1. W sekcji File Browser (Przeglądarka plików) na wnęce MediaBay przejdź do folderu, który 
chcesz uwzględnić w skanowaniu.
2. Aktywuj pole wyboru folderu, aby aktywować skanowanie.
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WYNIK
Wszystkie pliki znalezione w przeskanowanym folderze zostaną pokazane na liście Results 
(Wyniki). Wynik skanowania zapisywany jest w pliku bazy danych.
Kolor znacznika wyboru pomaga określić, które foldery i podfoldery są skanowane:
● Kolor biały wskazuje, że skanowanie obejmuje wszystkie podfoldery.
● Pomarańczowy oznacza, że co najmniej jeden podfolder został wykluczony ze skanowania.
Kolor folderu wskazuje stan skanowania:
● Kolor czerwony oznacza, że folder jest aktualnie skanowany.
● Kolor biały wskazuje, że wszystkie podfoldery zostały przeskanowane.
● Kolor żółty oznacza, że co najmniej jeden podfolder nie został jeszcze przeskanowany.

UWAGA
Aby kontynuować pracę, poczekaj, aż MediaBay zakończy skanowanie.

Dodawanie Favorites (Ulubionych)
Możesz dodać ulubione foldery, korzystając z sekcji File Browser (Przeglądarka plików).

PROCEDURA
1. W sekcji File Browser (Przeglądarka plików) przejdź do folderu, który chcesz dodać jako 
    ulubiony, i wybierz go.
2. Kliknij prawym przyciskiem myszy folder lub wolumin i z menu kontekstowego wybierz opcję 
    Add Favorite (Dodaj ulubione).
3. W otwartym oknie dialogowym Set Name (Ustaw nazwę) wprowadź nazwę folderu.
4. Kliknij OK.

WYNIK
● W sekcji File Browser (Przeglądarka plików) do folderu Favorites (Ulubione) dodawany jest 
nowy folder o określonej nazwie.
● W sekcji Favorites (Ulubione) dodany ulubiony jest dostępny w wyskakującym menu Select 
Defined Favorite (Wybierz zdefiniowany ulubiony).
● W stojaku Media Rack, w prawej strefie okna Project, na stronie Favorites (Ulubione) 
dodawany jest nowy kafelek o określonej nazwie.

UWAGA
Favorites (Ulubione) w oknie MediaBay nie są skanowane automatycznie.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby usunąć Favorite (Ulubione), wybierz je w drzewie Favorites (Ulubione) w sekcji File 
Browser (Przeglądarki plików), otwórz menu kontekstowe i wybierz Remove Favorite (Usuń 
ulubione).
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POWIĄZANE LINKI
Skanowanie folderów na stronie 643

Refresh Views (Odśwież Widoki)
Jeśli zmienisz już przeskanowane foldery, dodając lub usuwając pliki, gdy Cubase jest zamknięty, 
musisz ponownie przeskanować odpowiednie foldery multimedialne. Dotyczy to również sytuacji, 
gdy zmodyfikowałeś atrybuty treści użytkownika za pomocą innego programu.

Jeśli dokonałeś zmian w swojej zawartości i chcesz, aby zmiany były wyświetlane w MediaBay, 
musisz odświeżyć widoki odpowiednich folderów multimediów.

● Aby odświeżyć folder, w sekcji File Browser (Przeglądarka plików) na wnęce MediaBay kliknij 
   folder prawym przyciskiem myszy i wybierz opcję Refresh Views (Odśwież widoki).
● Aby wyświetlić nowy dysk, w sekcji File Browser wnęki MediaBay kliknij prawym przyciskiem
   myszy węzeł nadrzędny i wybierz opcję Refresh Views (Odśwież widoki). Następnie możesz 
   przeskanować dysk w poszukiwaniu plików multimedialnych.
● Aby zaktualizować stan skanowania folderów po modyfikacji bazy danych woluminów za 
   pomocą innego programu, kliknij prawym przyciskiem myszy bazę danych woluminów i wybierz 
   Refresh Views (Odśwież widoki).

Results Section (Sekcja wyników)
Lista Results (Wyniki) pokazuje wszystkie pliki multimedialne znalezione w wybranym folderze 
w File Browser (Przeglądarce plików).

● Aby wyświetlić pliki multimedialne w sekcji Results (Wyniki), musisz wybrać zeskanowany 
folder w sekcji File Browser (Przeglądarka plików) na wnęce MediaBay

UWAGA
Możesz ustawić maksymalną liczbę plików wyświetlanych na liście Results (Wyniki) w MediaBay
Settings (Ustawieniach MediaBay).

Konfigurowanie kolumn listy wyników
Dla każdego typu multimediów lub kombinacji typów multimediów można określić kolumny 
atrybutów wyświetlane na liście Results (Wyniki).

PROCEDURA
1. W sekcji Results (Wyniki) wybierz typy multimediów, dla których chcesz dokonać ustawień.
2. Kliknij opcję Skonfiguruj kolumny wyników i wykonaj jedną z następujących czynności:
● Aby wyświetlić określone kolumny, włącz lub wyłącz odpowiednie opcje w podmenu.
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● Aby usunąć wszystkie kolumny z wyjątkiem Name (Nazwy), wybierz opcję Select None     
   (Wybierz brak).
● Aby wyświetlić kolumny domyślne, wybierz opcję Use Defaults (Użyj domyślnych).
● Aby wyświetlić wszystkie kolumny z ustawionymi atrybutami, wybierz opcję All Available 
   (Wszystkie dostępne).

    

UWAGA
Jeśli w MediaBay Settings (Ustawieniach MediaBay) włączono opcję Allow Editing in Results 
List (Zezwalaj na edycję na liście wyników), można także edytować atrybuty na Results List 
(liście wyników). W przeciwnym razie jest to możliwe tylko w Attribute Inspector (Inspektorze 
atrybutów).

POWIĄZANE LINKI
Konfigurowanie wnęki MediaBay na stronie 643
Inspektor atrybutów na stronie 659

Zarządzanie plikami multimedialnymi na Results List (liście 
wyników)
● Aby przenieść lub skopiować plik z listy Results (Wyniki) do innej lokalizacji, przeciągnij go do 
innego folderu w sekcji File Browser (Przeglądarki plików).
● Aby zmienić kolejność kolumn na liście Results (Wyniki), kliknij nagłówek kolumny i 
przeciągnij ten nagłówek w inne miejsce.
● Aby usunąć plik, kliknij go prawym przyciskiem myszy na liście i wybierz Delete (Usuń). Plik 
zostanie trwale usunięty z Twojego komputera.
WAŻNE
Jeśli usuniesz plik za pomocą Eksploratora plików/Findera macOS, będzie on nadal wyświetlany na
liście Resulta (Wyniki), chociaż nie będzie już dostępny dla programu. Aby temu zaradzić, 
przeskanuj ponownie odpowiedni folder.

Tasowanie Results List (listy wyników)
Pozycje listy wyników można wyświetlać w losowej kolejności.

● Aby przetasować listę Results (wyników), kliknij opcję Shuffle Results (Pomieszaj wyniki) na 
pasku narzędzi MediaBay.

Znajdowanie lokalizacji pliku
Możesz pokazać lokalizację pliku w swoim systemie w Eksploratorze plików/wyszukiwarce 
macOS.
UWAGA
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Ta funkcja nie jest dostępna w przypadku plików będących częścią archiwum VST Sound.

PROCEDURA
● Na liście Results (Wyniki) kliknij plik prawym przyciskiem myszy i wybierz opcję Show in 
Explorer/Reveal in Finder (Pokaż w Eksploratorze/Odkryj w Finderze).

WYNIK
Otworzy się Eksplorator plików/wyszukiwarka macOS i odpowiedni plik zostanie podświetlony.

Filtrowanie według typu nośnika
Listę Results (wyników) można skonfigurować tak, aby wyświetlała tylko określony typ 
multimediów lub kombinację typów multimediów.

PROCEDURA
1. Na pasku narzędzi MediaBay otwórz selektor Show Media Types (Pokaż typy multimediów).

                     
2. Aktywuj typy multimediów, które mają być wyświetlane na liście Results (Wyniki).

WYNIK
Pliki są filtrowane według wybranego typu multimediów.

Show Media Types Selector (Pokaż selektor typów multimediów)
Możesz aktywować typy multimediów, które mają być wyświetlane na liście Results (Wyniki)

                  
Dostępne są następujące typy nośników:
Audio Files (Pliki audio)
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     Pokazuje wszystkie pliki audio. Obsługiwane formaty
     to .wav, .w64, .aiff, .aifc, .rex, .rx2, .mp3, .mp2, .ogg, .wma (tylko Windows)
MIDI Files (Pliki MIDI)
     Pokazuje wszystkie pliki MIDI (rozszerzenie nazwy pliku .mid).

MIDI Loops (Pętle MIDI)
      Pokazuje wszystkie pętle MIDI (rozszerzenie nazwy pliku .midiloop).
Pattern Banks (Banki wzorów)
      Pokazuje wszystkie banki wzorców (rozszerzenie nazwy pliku .patternbank). Banki wzorów są 
      generowane za pomocą wtyczki MIDI Beat Designer. Więcej informacji można znaleźć w 
      oddzielnym dokumencie Plug-in Reference (Informacje o wtyczkach).
Track Presets (Ustawienia wstępne ścieżki)
      Pokazuje wszystkie presety ścieżek audio, MIDI i ścieżek instrumentów (rozszerzenie nazwy 
      pliku .trackpreset). Wstępne ustawienia ścieżek to kombinacja ustawień ścieżek, efektów i 
      ustawień MixConsole, które można zastosować do nowych ścieżek różnego typu.
Plug-in Presets (Presety wtyczek)
      Pokazuje wszystkie presety VST dla wtyczek instrumentów i efektów. Ponadto na liście 
      znajdują się ustawienia wstępne EQ zapisane w MixConsole. Te ustawienia wstępne zawierają 
      wszystkie ustawienia parametrów dla konkretnej wtyczki. Można ich używać do stosowania 
      dźwięków do ścieżek instrumentów i efektów do ścieżek audio.
Strip Presets (Ustawienia wstępne paska)
      Pokazuje wszystkie ustawienia wstępne pasków (rozszerzenie nazwy pliku .strippreset). Te  
      presety zawierają łańcuchy efektów pasków kanałów.
FX Chain Presets (Presety łańcucha efektów)
      Pokazuje wszystkie presety łańcucha efektów (rozszerzenie nazwy pliku .fxchainpreset). Te 
      presety zawierają łańcuchy efektów wstawek.
Video Files (Pliki wideo)
      Pokazuje wszystkie pliki wideo.
Projects (Projektowanie)
      Pokazuje wszystkie pliki projektu (z Cubase, Nuendo): .cpr, .npr.

POWIĄZANE LINKI
Podgląd banków wzorców na stronie 654
Zaprogramowane ścieżki na stronie 192
Zapisywanie/ładowanie ustawień pasków na stronie 397
Zapisywanie/ładowanie ustawień korektora na stronie 390
Zapisywanie/wczytywanie presetów łańcucha efektów na stronie 387
Zgodność plików wideo na stronie 1097

Filtrowanie według oceny
Dzięki Rating Filter (filtrowi ocen) możesz filtrować pliki według ich oceny.

UWAGA
Rating Filter (Filtr ocen) nie jest dostępny w Media Rack (stojaku na nośniki) w prawej strefie.

PROCEDURA
● W sekcji Rating Filter (Filtr oceny) na pasku narzędzi MediaBay wybierz wartość 
   z wyskakującego menu Rating Filter.

Wykonywanie wyszukiwania tekstowego
Można przeszukiwać tekst na Results List (liście Wyniki). Jeśli wpiszesz tekst w polu 
wyszukiwania tekstu na pasku narzędzi MediaBay, zostaną wyświetlone tylko pliki multimedialne, 
których atrybuty odpowiadają wprowadzonemu tekstowi.
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UWAGA
Pole Search MediaBay pełni tę samą funkcję, co operator matches (dopasowania) filtra 
logicznego. Jednak wyszukiwanie dotyczy wszystkich atrybutów plików.

● Kliknij pole i wpisz tekst, który chcesz znaleźć.
Na przykład, jeśli szukasz wszystkich pętli audio związanych z dźwiękami perkusji, wpisz „drum” 
(bęben) w polu wyszukiwania. Wyniki wyszukiwania będą zawierać pętle o nazwach „Drums 01”, 
„Drumloop”, „Snare Drum” itp. Ponadto zostaną znalezione wszystkie pliki multimedialne z 
atrybutem kategorii Drum&Percussion lub jakimkolwiek innym atrybutem zawierającym „drum”. 
Możesz także dodać apostrofy, aby znaleźć dokładne dopasowania wprowadzonych słów i użyć 
operatorów boolowskich.

           

● Aby zresetować wyszukiwanie tekstu, usuń tekst lub kliknij Reset Filters (Resetuj filtry).

POWIĄZANE LINKI
Filtr logiczny na stronie 655

Wyszukiwanie tekstu logicznego
Możesz wykonywać zaawansowane wyszukiwania, używając operatorów boolowskich lub symboli 
wieloznacznych.

Możesz wykorzystać następujące elementy:
And [+] (I [+])
[aib]
Podczas wprowadzania ciągów znaków oddzielonych „and” (lub znakiem plus) zostaną znalezione 
wszystkie pliki zawierające zarówno a, jak i b. [And] jest ustawieniem domyślnym, gdy nie jest 
używany żaden operator boolowski, na przykład można również wprowadzić [a b].
Or [,] (Lub [,])
[a lub B]
Podczas wprowadzania ciągów znaków rozdzielonych znakiem „lub” (lub przecinkiem) zostaną 
znalezione pliki zawierające a lub b, albo oba.
Not [-] (Nie [-])
[nie b]
Po wpisaniu tekstu poprzedzonego „nie” (lub znakiem minus) zostaną znalezione wszystkie pliki 
niezawierające b.
Parentheses [()] (Nawiasy [()])
[(a lub b) + c]
Za pomocą nawiasów możesz grupować ciągi tekstowe. W tym przykładzie znaleziono pliki 
zawierające c oraz a lub b.
Quotation marks [“”] (Cudzysłów [""])
[„Twój wyszukiwany tekst”]
Za pomocą cudzysłowów można zdefiniować sekwencje kilku słów. Pliki zostaną znalezione, jeśli 
zawierają wprowadzoną sekwencję słów.
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WAŻNE
Jeśli szukasz plików, których nazwy zawierają łącznik, umieść szukany tekst w cudzysłowie. W 
przeciwnym razie program traktuje łącznik jako operator logiczny „not” (nie).

UWAGA
Operatorów tych można również używać do filtrowania logicznego.

POWIĄZANE LINKI
Stosowanie filtru logicznego na stronie 656

Resetowanie Results List (Listy wyników)
Możesz zresetować wszystkie ustawienia filtrów i wyniki filtrów.

● Na pasku narzędzi MediaBay kliknij opcję Reset Filter (Resetuj filtr).

Sekcja Previewer (Podglądu)
Możesz wyświetlić podgląd poszczególnych plików w sekcji Previewer (Podgląd), aby dowiedzieć 
się, którego użyć w swoim projekcie.

Elementy widoczne w tej sekcji i ich funkcje zależą od rodzaju nośnika.

WAŻNE
Sekcja Previewer (Podgląd) nie jest dostępna dla plików wideo, plików projektów i gotowych 
ustawień ścieżek audio.

POWIĄZANE LINKI
Ustawienia MediaBay na stronie 669

Podgląd plików audio
Podgląd plików audio umożliwia odsłuchanie plików audio przed ich wykorzystaniem w projekcie.

          

1   Transport controls (Kontrola transportu)
      (Start) Uruchamiaj, (Stop) zatrzymuj, (Pause) wstrzymuj i (Cycle) przełączaj podgląd.
2   Preview Level fader (Suwak poziomu podglądu)
      Określa poziom podglądu.
3   Auto Play New Results Selection (Automatyczne odtwarzanie Wybór nowych wyników)
      Automatycznie odtwarza wybrany plik.
4   Align Beats to Project (Dopasuj uderzenia do projektu)
      Odtwarza wybrany plik synchronicznie z projektem, zaczynając od pozycji kursora projektu.
      Pamiętaj, że może to dotyczyć rozciągania pliku audio w czasie rzeczywistym.

UWAGA
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Jeśli zaimportujesz plik audio do swojego projektu, dla którego w Previewer (przeglądarce 
podglądu) włączono opcję Align Beats to Project, Musical Mode (Tryb muzyczny) zostanie 
automatycznie aktywowany dla odpowiedniego zdarzenia.

5   Wait for Project Play (Poczekaj na odtworzenie projektu)
Synchronizuje funkcje odtwarzania i zatrzymywania z panelu Transport z przyciskami 
odtwarzania i zatrzymywania w sekcji Previewer (Podgląd).
Aby w pełni wykorzystać tę opcję, należy ustawić lewy lokalizator na początku taktu, a następnie 
rozpocząć odtwarzanie projektu za pomocą panelu Transport. Pętle wybrane teraz na liście 
Results (Wyniki) rozpoczynają się wraz z projektem w doskonałej synchronizacji.

POWIĄZANE LINKI
Tryb muzyczny na stronie 541

Korzystanie z zakresów wyboru
Możesz określić zakresy wyboru, aby wyświetlić podgląd określonej sekcji pliku audio i wstawić ją
do projektu.

UWAGA
Zakresów wyboru nie można używać, gdy w Previewer (Przeglądarce podglądu) włączona jest 
opcja Align Beats to Project (Wyrównaj uderzenia do projektu).

● Aby wybrać zakres, najedź myszką na górną część przebiegu tak, aby zmienił się w ołówek, 
kliknij i przeciągnij.

                       
● Aby dostosować granice zakresu zaznaczenia, przeciągnij uchwyty.

                       
● Aby odznaczyć zakres, przeciągnij oba uchwyty maksymalnie w lewo.

MIDI Files Previewer (Przeglądarka plików MIDI)
Previewer (Przeglądarka) plików MIDI umożliwia odsłuchiwanie plików MIDI przed użyciem ich 
w projekcie.

● Aby wyświetlić podgląd pliku MIDI, załaduj instrument VST i wybierz go jako urządzenie 
wyjściowe z wyskakującego menu Select MIDI Output (Wybierz wyjście MIDI).
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1   Transport controls (Kontrola transportu)
     Rozpocznij i zatrzymaj podgląd.

2   Preview Level fader (Suwak poziomu podglądu)
     Określa poziom podglądu.
3   Output (Wyjście)
     Umożliwia wybór urządzenia wyjściowego.
4   Align Beats to Project (Dopasuj uderzenia do projektu)
     Odtwarza wybrany plik synchronicznie z projektem, zaczynając od pozycji kursora projektu.
     Pamiętaj, że może to dotyczyć rozciągania pliku MIDI w czasie rzeczywistym.
5   Auto Play New Results Selection (Automatyczne odtwarzanie Wybór nowych wyników)
     Automatycznie odtwarza wybrany plik.

POWIĄZANE LINKI
Instrumenty VST na stronie 726

Podgląd pętli MIDI
Previewer (Przeglądarka) pętli MIDI umożliwia słuchanie pętli MIDI przed użyciem ich w 
projekcie.

UWAGA
Pętle MIDI są zawsze odtwarzane w synchronizacji z projektem.

                 

1   Transport controls (Kontrola transportu)
     Rozpocznij i zatrzymaj podgląd.
2   Preview Level fader (Suwak poziomu podglądu)
     Określa poziom podglądu.
3   Auto Play New Results Selection (Automatyczne odtwarzanie Wybór nowych wyników)
     Automatycznie odtwarza wybrany plik.
4   Link Playback to Chord Track (Połącz odtwarzanie ze ścieżką akordów)
     Transponuje zdarzenia pętli MIDI, aby odtwarzać je w kontekście ścieżki akordów. Pamiętaj, że 
     potrzebujesz do tego ścieżki akordów ze zdarzeniami akordowymi. Jeśli ta opcja jest aktywna i 
     do projektu wstawisz pętlę MIDI, funkcja Follow Chord Track (Podążaj za ścieżką akordów) 
     zostanie automatycznie aktywowana dla ścieżki.

POWIĄZANE LINKI
Korzystanie z funkcji Follow Chord Track na stronie 959

Presety VST i podgląd presetów ścieżek dla ścieżek MIDI i ścieżek 
instrumentów
Previewer (Przeglądarka) presetów VST i presetów ścieżek umożliwia odsłuchanie presetów przed 
użyciem ich w projekcie.
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● Aby uzyskać podgląd presetów ścieżek dla MIDI lub ścieżek instrumentów i presetów VST, 
musisz wysłać notatki MIDI do presetu ścieżki poprzez wejście MIDI, używając pliku MIDI, trybu 
Memo Recorder lub za pomocą klawiatury komputera.

             

1   Transport controls (Kontrola transportu)
     Rozpocznij i zatrzymaj podgląd.
2   Previewer Sequence Mode (Tryb sekwencji podglądu)
     Umożliwia załadowanie pliku MIDI w celu zastosowania wybranego ustawienia wstępnego do 
     pliku MIDI. Możesz także wybrać tryb Memo Recorder, który stale powtarza daną sekwencję 
     nut w pętli.
3   MIDI Activity (Aktywność MIDI)
     Umożliwia monitorowanie przychodzących komunikatów MIDI.
4   Preview Level fader (Suwak poziomu podglądu)
     Określa poziom podglądu.
5   Keyboard (Klawiatura)
     Klawiaturę można wyświetlić w trybie wyświetlania klawiatury lub w trybie wyświetlania 
     fortepianu.
6   Computer Keyboard Input (Wejście z klawiatury komputera)
     Umożliwia korzystanie z klawiatury komputera w celu podglądu ustawień wstępnych.

POWIĄZANE LINKI
Przeglądanie ustawień wstępnych w trybie rejestratora nut na stronie 654
Klawiatura ekranowa na stronie 261

Podgląd presetów (ustawień wstępnych) poprzez wejście MIDI

Wejście MIDI jest zawsze aktywne. Na przykład, gdy klawiatura MIDI jest podłączona do 
komputera i prawidłowo skonfigurowana, możesz bezpośrednio rozpocząć odtwarzanie nut, aby 
wyświetlić podgląd wybranego ustawienia wstępnego.

Podgląd presetów przy użyciu pliku MIDI

PROCEDURA
1. W wyskakującym menu Previewer Sequence Mode (trybu sekwencji podglądu) wybierz opcję  
    Load MIDI File (Załaduj plik MIDI).
2. W otwartym oknie dialogowym wybierz plik MIDI i kliknij Open (Otwórz).
    Nazwa pliku MIDI zostanie wyświetlona w wyskakującym menu.
3. Kliknij opcję Play (Odtwórz) po lewej stronie wyskakującego menu.

WYNIK
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Nuty otrzymane z pliku MIDI są odtwarzane z zastosowaniem ustawień presetu ścieżki.

UWAGA
Ostatnio używane pliki MIDI są przechowywane w menu, co umożliwia szybki dostęp. Aby usunąć
wpis z tej listy, zaznacz go w menu, a następnie wybierz opcję Remove MIDI File (Usuń plik 
MIDI).

Podgląd ustawień wstępnych w trybie Memo Recorder Mode  
(rejestratora nut)
Tryb Memo Recorder stale powtarza daną sekwencję nut w pętli.

UWAGA
Nie można używać trybu Memo Recorder podczas przeglądania presetów przy użyciu pliku MIDI.

PROCEDURA
1. W wyskakującym menu Previewer Sequence Mode (Tryb sekwencji podglądu) wybierz opcję 
    Memo Recorder (Rejestrator nut).
2. Aktywuj Play (Graj).
3. Zagraj kilka nut na klawiaturze MIDI lub na klawiaturze komputera.

WYNIK
Nuty są odtwarzane przy użyciu ustawień instrumentu wybranych w sekcji Results (Wyniki). 
Kiedy przestaniesz grać nuty i odczekasz 2 sekundy, sekwencja nut, którą grałeś do tego momentu, 
będzie odtwarzana w ciągłej pętli.
Aby użyć innej sekwencji, rozpocznij ponownie wprowadzanie nut.

Podgląd ustawień wstępnych za pomocą klawiatury komputera

UWAGA
Jeśli aktywujesz opcję Computer Keyboard Input (Wprowadzanie z klawiatury komputera), 
klawiatura komputera będzie używana wyłącznie w sekcji podglądu. Jednakże nadal możesz 
używać następujących poleceń klawiszowych: Ctrl/Cmd - S (Zapisz), Num * 
(Rozpocznij/Zatrzymaj nagrywanie), Spacja (Rozpocznij/Zatrzymaj odtwarzanie), Num 1 
(Przeskocz do lewego lokalizatora), Delete lub Backspace, Num / (włączanie/wyłączanie cyklu) i 
F2 (pokazywanie/ukrywanie panelu Transport).

PROCEDURA
1. Aktywuj Computer-Keyboard Input (Wprowadzanie z klawiatury komputera).
2. Zagraj kilka nut na klawiaturze komputera.

Pattern Banks Previewer (Podgląd banków wzorców)
Previewer (Przeglądarka) banków wzorów umożliwia przesłuchanie banków wzorów przed 
użyciem ich w projekcie. 

                

661



1   Transport controls (Kontrola transportu)
     Rozpocznij i zatrzymaj podgląd.
2   Preview Level fader (Suwak poziomu podglądu)
     Określa poziom podglądu.
3   Keyboard (Klawiatura)
     Klawiatura umożliwia podgląd wybranego banku wzorów. W sekcji Previewer (Podgląd)  
     wybierz podbank (liczba na górze) i wzór (klawisz) i kliknij Play (Odtwórz). Jeden bank 
     wzorów zawiera 4 podbanki, z których każdy zawiera po 12 wzorów.

      Podbanki mogą zawierać puste wzorce. Wybranie pustego wzorca w sekcji Previewer 
      (Podgląd) nie da żadnego efektu. Wzory zawierające dane są oznaczone kółkiem w górnej 
      części klawisza na wyświetlaczu.
4   Auto Play New Results Selection (Automatyczne odtwarzanie Wybór nowych wyników)
     Automatycznie odtwarza wybrany plik.
5   Link Playback to Chord Track (Połącz odtwarzanie ze ścieżką akordów)
     Transponuje zdarzenia z banku wzorców, aby odtwarzać je w kontekście ścieżki akordów.   
     Pamiętaj, że potrzebujesz do tego ścieżki akordów ze zdarzeniami akordowymi.

UWAGA
Za pomocą wtyczki MIDI Beat Designer (Uderzenie projektanta) możesz tworzyć wzory 
perkusyjne. Szczegółowe informacje na temat Beat Designera i jego funkcji można znaleźć w 
oddzielnym dokumencie Plug-in Reference (Poradnik wtyczek) w rozdziale MIDI Effects (Efekty 
MIDI)

Filters Section (Sekcja filtrów)

MediaBay pozwala zawęzić wyszukiwanie plików. Masz dwie możliwości: filtrowanie Logical 
(logiczne) lub Attribute (filtrowanie według atrybutów).

Filtr logiczny
Filtr logiczny umożliwia ustawienie złożonych warunków wyszukiwania, które należy spełnić, aby 
znaleźć pliki.

UWAGA
Logical Filter (Filtr logiczny) nie jest dostępny w Media Rack (stojaku na nośniki) w prawej 
strefie.

contains (zawiera)
Wynik wyszukiwania musi zawierać tekst lub liczbę określoną w polu tekstowym po prawej 
stronie.
matches words (pasuje do słów)
Wynik wyszukiwania musi odpowiadać słowom określonym w polu tekstowym po prawej stronie.
omits (pomija)
Wynik wyszukiwania nie może zawierać tekstu ani liczby określonej w polu tekstowym po prawej 
stronie.
equals (równa się)
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Wynik wyszukiwania musi dokładnie odpowiadać tekstowi lub liczbie podanej w polu tekstowym 
po prawej stronie, łącznie z rozszerzeniem pliku. W wyszukiwaniu tekstowym nie jest rozróżniana 
wielkość liter.
>=
Wynik wyszukiwania musi być większy lub równy liczbie podanej w polu po prawej stronie.
<=
Wynik wyszukiwania musi być mniejszy lub równy liczbie podanej w polu po prawej stronie.
Is empty (jest pusty)
Użyj tej opcji, aby znaleźć pliki, dla których nie określono jeszcze niektórych atrybutów.

matches (dopasowuje)
Wynik wyszukiwania musi zawierać tekst lub liczbę wpisaną w polu tekstowym po prawej stronie. 
Można także używać operatorów boolowskich. Dodaj apostrofy, aby znaleźć dokładne dopasowania
do wprowadzonych słów, na przykład „bęben” ORAZ „funky”. Opcja ta pozwala na bardzo 
zaawansowane wyszukiwanie tekstu.
in range (w zakresie)
Jeżeli ta opcja jest zaznaczona, w polach po prawej stronie możesz określić dolną i górną granicę 
wyniku wyszukiwania.

Stosowanie filtru logicznego
Aby szybko znaleźć określone pliki audio, możesz na przykład wyszukać określoną wartość 
atrybutu pliku.

WARUNEK WSTĘPNY
Wybrany jest folder, w którym chcesz szukać plików.

PROCEDURA
1. W sekcji Filters (Filtry) aktywuj Logical (Logiczne).
2. Kliknij opcję Search in these Attributes (Wyszukaj w tych atrybutach), aby otworzyć okno 
    dialogowe Select Filter Attributes (Wybierz atrybuty filtra).
3. Wybierz atrybuty, których chcesz użyć.
    Jeśli wybierzesz więcej niż jeden atrybut, znalezione pliki będą odpowiadać jednemu lub 
    drugiemu atrybutowi.
4. Kliknij OK.
5. Z wyskakującego menu warunku wybierz jeden z operatorów wyszukiwania.

                                 

6. Wpisz tekst lub liczbę, którą chcesz znaleźć, w polu po prawej stronie.

UWAGA
Jeśli wprowadzisz 2 lub więcej ciągów lub linii filtrów, znalezione pliki będą pasować do 
wszystkich ciągów lub linii filtrów
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● Aby dodać więcej niż jeden ciąg znaków w polu tekstowym, wprowadź pomiędzy nimi Space  
   (spację).

● Aby dodać kolejną linię filtra, kliknij + po prawej stronie pola tekstowego. Możesz dodać 
maksymalnie siedem linii filtrów, w których możesz zdefiniować dalsze warunki wyszukiwania.

● Aby usunąć linię filtra, kliknij -.
● Aby zresetować wszystkie pola wyszukiwania do ustawień domyślnych, kliknij opcję Reset   
   Filter (Resetuj filtr) u góry sekcji Filters (Filtry).

WYNIK
Lista Results (wyników) jest automatycznie aktualizowana i wyświetla tylko pliki odpowiadające 
warunkom wyszukiwania.

Zaawansowane wyszukiwanie tekstu
Zaawansowane wyszukiwanie tekstowe można wykonywać przy użyciu operatorów boolowskich.

WARUNEK WSTĘPNY
Wybrany jest folder, w którym chcesz szukać plików.

PROCEDURA
1. W sekcji Filters (Filtry) aktywuj Logical (Logiczne).
2. Wybierz atrybut w wyskakującym menu Search in these Attributes (Szukaj w tych atrybutach) 
lub pozostaw włączone ustawienie Any Attribute (Dowolny atrybut).
3. Ustaw warunek na matches (zgodny).
4. W polu po prawej stronie określ tekst, który chcesz wyszukać, używając operatorów 
boolowskich.

POWIĄZANE LINKI
Wykonywanie wyszukiwania tekstu na stronie 648

Atrybuty plików multimedialnych
Atrybuty plików multimedialnych to zestawy metadanych dostarczających dodatkowych informacji
o pliku.
Różne typy plików multimedialnych mają różne atrybuty. Na przykład pliki audio .wav mają 
atrybuty, takie jak nazwa, długość, rozmiar, częstotliwość próbkowania, zestaw treści itp., 
natomiast pliki .mp3 mają dodatkowe atrybuty, takie jak wykonawca lub gatunek.

POWIĄZANE LINKI
Inspektor atrybutów na stronie 659

Filtr atrybutów
Przypisywanie wartości atrybutów do plików ułatwia organizowanie plików multimedialnych. Filtr 
atrybutów umożliwia przeglądanie i edycję niektórych standardowych atrybutów plików 
znajdujących się w plikach multimedialnych.

Jeśli klikniesz Attribute Atrybut, w sekcji Filters (Filtry) zostaną wyświetlone wszystkie wartości, 
które zostały określone dla wyświetlanych kategorii atrybutów. Wybranie jednej z tych wartości 
powoduje filtrowanie wyników w celu wyświetlenia tylko plików, do których przypisano tę wartość
atrybutu.
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1   Attribute column titles (Tytuły kolumn atrybutów)
Umożliwia wybranie różnych kategorii atrybutów. Jeśli kolumny są wystarczająco szerokie, po 
prawej stronie wartości zostanie wyświetlona liczba plików spełniających te kryteria.
2    Attribute values (Wartości atrybutów)
Wyświetla wartości atrybutów oraz częstotliwość dostępności określonej wartości atrybutu w 
plikach multimedialnych.

UWAGA
● Niektóre atrybuty są ze sobą bezpośrednio powiązane. Na przykład dla każdej wartości kategorii 
dostępne są pewne wartości podkategorii. Zmiana wartości w jednej z tych kolumn atrybutów 
powoduje wyświetlenie innych wartości w drugiej kolumnie.
● Każda kolumna atrybutów wyświetla tylko znalezione wartości atrybutów.

POWIĄZANE LINKI
Inspektor atrybutów na stronie 659

Stosowanie filtra atrybutów
Dzięki filtrowi Attribute (atrybutów) możesz szybko znaleźć oznaczone pliki multimedialne z 
określonymi atrybutami.

● Aby zastosować filtr Attribute (atrybutu), wybierz wartość atrybutu. Lista Results (Wyniki) 
   zostanie odpowiednio przefiltrowana. Zastosuj więcej filtrów atrybutów, aby jeszcze bardziej 
   zawęzić wynik.
● Aby znaleźć pliki pasujące do jednego lub drugiego atrybutu, naciśnij klawisz Ctrl/Cmd i kliknij 
   różne wartości atrybutów w tej samej kolumnie.
● Aby zmienić wyświetlane wartości atrybutów kolumny, kliknij tytuł kolumny atrybutów i 
   wybierz inny atrybut.

UWAGA
Atrybuty znaku zawsze tworzą warunek AND.

Wykonywanie wyszukiwania w menu kontekstowym
Możesz wyszukiwać inne pliki, które mają ten sam atrybut co wybrany plik. Dzięki temu możesz 
znaleźć wszystkie pliki, które mają wspólną wartość, na przykład jeśli chcesz wyświetlić wszystkie 
pliki utworzone tego samego dnia.

● Na liście Results (Wyniki) lub w Attribute Inspector (Inspektorze atrybutów) kliknij plik 
prawym przyciskiem myszy i wybierz wartość atrybutu, którą chcesz wyszukać, z podmenu Search
(Szukaj).
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Sekcja Filters (Filtry) automatycznie przełącza się na Filtrowanie Logical (Logiczne) i wyświetla 
się odpowiednia linia warunku filtra.
● Aby zresetować filtr, kliknij przycisk Go Back (Wróć).

Resetowanie filtra

PROCEDURA
● Aby zresetować filtr, kliknij opcję Reset FIlter (Resetuj filtr) u góry sekcji Filters (Filtry).

               

Spowoduje to również zresetowanie Results List (listy wyników).

Attribute Inspector (Inspektor atrybutów)
Po wybraniu jednego lub większej liczby plików na liście Results List (Lista Wyników) Attribute 
Inspector (Inspektor atrybutów) wyświetli listę atrybutów i ich wartości.

UWAGA
Attribute Inspector (Inspektor atrybutów) nie jest dostępny w Media Rack (stojaku na nośniki) 
w prawej strefie.

W Inspektorze atrybutów możesz także edytować i dodawać nowe wartości atrybutów.

Dostępne atrybuty są podzielone na kilka grup (Media, Musical, Preset itp.), aby ułatwić 
zarządzanie listą i ułatwić wyszukiwanie elementów.
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Dynamic (Dynamiczny)
        Wyświetla wszystkie dostępne wartości dla wybranych plików.
Defined (Zdefiniowane)
       Wyświetla skonfigurowany zestaw atrybutów dla wybranego typu multimediów, niezależnie od
       tego, czy dla wybranych plików dostępne są odpowiednie wartości.
Configure Defined Attributes (Skonfiguruj zdefiniowane atrybuty)
       Aktywuje tryb konfiguracji, w którym możesz skonfigurować atrybuty wyświetlane 
       w Attribute Inspector (Inspektorze atrybutów).

Configuration Mode (Tryb konfiguracji)
Kliknięcie przycisku Configure Defined Attributes (Konfiguruj zdefiniowane atrybuty) powoduje 
włączenie trybu konfiguracji.

               

Select Media Types (Wybierz Typy multimediów)
       Umożliwia wybranie typów multimediów wyświetlanych na stronie Results (Wyniki).
Add User Attribute (Dodaj atrybut użytkownika)
       Otwiera okno dialogowe Add User Attribute (Dodaj atrybut użytkownika), w którym możesz 
       dodać niestandardowe atrybuty użytkownika. Można wybrać Attribute Type (typ atrybutu) 
       i Display Name (nazwę wyświetlaną).
Reset to Default (Przywróć ustawienia domyślne)
       Resetuje listę atrybutów do ustawień domyślnych.
Attribute (Atrybut)
       Pokazuje nazwę atrybutu.
Select (Wybierz)
       Pokazuje, czy atrybut jest aktywowany, czy dezaktywowany.
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Type (Typ)
       Pokazuje, czy wartość atrybutu jest liczbą, tekstem, czy przełącznikiem Tak/Nie.
Precision (Precyzja)
       Pokazuje liczbę miejsc dziesiętnych wyświetlaną dla atrybutów liczbowych.

POWIĄZANE LINKI
Atrybuty plików multimedialnych na stronie 657
Zarządzanie listami atrybutów na stronie 662

Edycja atrybutów

Funkcje wyszukiwania, zwłaszcza filtr atrybutów, stanowią potężne narzędzie do zarządzania 
multimediami w przypadku szerokiego wykorzystania tagowania, czyli dodawania i edytowania 
atrybutów.

Pliki multimedialne są zwykle zorganizowane w złożone struktury folderów, aby zapewnić logiczny
sposób prowadzenia użytkownika do określonych plików, przy czym nazwy folderów i/lub plików 
wskazują instrument, styl, tempo itp.
Tagi pomagają znaleźć konkretny dźwięk lub pętlę w takiej strukturze folderów.

Edycja atrybutów w Attribute Inspector (Inspektorze atrybutów)
W Inspektorze atrybutów możesz edytować wartości atrybutów różnych plików multimedialnych. 
Wartości atrybutów można wybierać z wyskakujących list, wprowadzać jako tekst lub liczby albo 
ustawiać je na Tak lub Nie.
UWAGA
● Zmiana wartości atrybutu w Attribute Inspector (Inspektorze atrybutów) trwale powoduje 
zmianę odpowiedniego pliku, chyba że plik jest chroniony przed zapisem lub stanowi część 
archiwum VST Sound.

● Niektórych atrybutów nie można edytować. W takim przypadku format pliku nie pozwala na 
zmianę tej wartości lub zmiana konkretnej wartości nie ma sensu. Na przykład nie można zmienić 
rozmiaru pliku we wnęce MediaBay.

PROCEDURA
1. Na liście Results (Wyniki) wybierz plik, dla którego chcesz dokonać ustawień. Odpowiednie  
    wartości atrybutów są wyświetlane w Attribute Inspector.(Inspektorze atrybutów). Możesz  
    także wybrać kilka plików i wprowadzić dla nich ustawienia jednocześnie. Jedynym wyjątkiem 
    jest atrybut name, który musi być unikalny dla każdego pliku.
2. W Attribute Inspector kliknij kolumnę Value (Wartość) dla atrybutu. W zależności od   
    wybranego atrybutu dzieje się co następuje:
     ● W przypadku większości atrybutów otwiera się wyskakujące menu, z którego możesz wybrać 
        wartość. Niektóre wyskakujące menu zawierają także pozycję more (więcej) umożliwiającą 
        otwarcie okna z większą liczbą wartości atrybutów.
     ● W przypadku atrybutu Rating (Ocena) możesz kliknąć kolumnę Value (Wartość) i 
        przeciągnąć w lewo lub w prawo, aby zmodyfikować ustawienie.
     ● Dla atrybutu Character (Postać) (grupa Muzyczna) otwiera się okno dialogowe Edit 
        Character (Edytuj postać). Aby zdefiniować wartości, kliknij przycisk opcji po lewej lub 
        prawej stronie, a następnie kliknij OK.
3. Ustaw wartość atrybutu.
    Aby usunąć wartość atrybutu z wybranych plików, kliknij prawym przyciskiem myszy 
    odpowiednią kolumnę Value i wybierz Remove Attribute (Usuń atrybut) z menu 
    kontekstowego.

Edycja atrybutów na Results List (liście wyników)
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Możesz edytować atrybuty bezpośrednio na liście Results (Wyniki). Umożliwia to na przykład 
przypisanie atrybutów do wielu plików pętli.

WARUNEK WSTĘPNY
Opcja Allow Editing in Results List (Zezwalaj na edycję na liście wyników) jest aktywowana 
w MediaBay Settings (ustawieniach MediaBay (zatoki multimediów)).

PROCEDURA
1. Na liście Results (Wyniki) wybierz pliki, dla których chcesz dokonać ustawień. Możesz dokonać
    ustawień dla kilku plików jednocześnie, z wyjątkiem nazwy atrybutu, która musi być unikalna 
    dla każdego pliku.
2. Kliknij kolumnę wartości, którą chcesz zmienić, i dokonaj ustawień.

POWIĄZANE LINKI
Ustawienia MediaBay na stronie 669

Jednoczesna edycja atrybutów wielu plików
Możesz edytować atrybuty wielu plików jednocześnie.

UWAGA
Jeśli edytujesz jednocześnie dużą liczbę plików, przetwarzanie zmian może zająć trochę czasu.

Edycja atrybutów odbywa się w tle, dzięki czemu możesz kontynuować swoją pracę jak zwykle. 
Attribute Counter (Licznik atrybutów) na pasku narzędzi MediaBay wyświetla liczbę plików, 
które są nadal aktualizowane.

POWIĄZANE LINKI
Pasek narzędzi MediaBay na stronie 641

Edycja atrybutów plików chronionych przed zapisem
Pliki multimedialne mogą być chronione przed zapisem z wielu powodów: zawartość mogła zostać 
dostarczona przez osobę, która zabezpieczyła pliki przed zapisem, format pliku może ograniczać 
operacje zapisu przez wnękę MediaBay (Zatoka multimediów) itp.

W MediaBay stan ochrony plików przed zapisem jest pokazywany jako atrybut w Attribute 
Inspector (Inspektorze atrybutów) oraz w kolumnie Write Protection (Ochrona przed zapisem) na 
liście Results (Wyniki)

                                          
WAŻNE
Możesz zdefiniować wartości atrybutów plików chronionych przed zapisem w MediaBay. Zmiany 
te zapisywane są jedynie w pliku bazy danych MediaBay, nie są zapisywane na dysku. Oznacza to, 
że jeśli usuniesz preferencje, zmiany te zostaną utracone.

UWAGA
Jeśli kolumny Write Protection (Ochrona przed zapisem) i/lub Pending Tags (Oczekujące 
znaczniki) nie są widoczne, aktywuj odpowiednie atrybuty dla typu pliku w Attribute Inspector 
(Inspektorze atrybutów).
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● Aby ustawić lub usunąć atrybut ochrony przed zapisem dla pliku, kliknij plik prawym  
   przyciskiem myszy na liście Results (Wyniki) i wybierz  Set Write Protection/Remove Write 
   Protection (Ustaw ochronę przed zapisem/Usuń ochronę przed zapisem). Jest to możliwe tylko 
   wtedy, gdy typ pliku pozwala na operacje zapisu i jeśli posiadasz niezbędne uprawnienia systemu 
   operacyjnego.
● Jeśli określisz wartości atrybutów dla pliku chronionego przed zapisem, zostanie to 
   odzwierciedlone w kolumnie Pending Tags (Oczekujące znaczniki) obok kolumny Write 
   Protection (Ochrona przed zapisem) na liście Results (Wyniki). Jeśli ponownie przeskanujesz 
   zawartość wnęki MediaBay i plik multimedialny na dysku twardym ulegnie zmianie od czasu 
   ostatniego skanowania, oczekujące znaczniki tego pliku zostaną utracone.
● Jeśli plik ma oczekujące znaczniki i chcesz zapisać w pliku odpowiednie atrybuty, musisz usunąć 
   zabezpieczenie przed zapisem, następnie kliknąć plik prawym przyciskiem myszy i wybrać opcję 
   Write Tags to File (Zapisz znaczniki do pliku).
UWAGA
Jeśli do zmiany stanu ochrony plików przed zapisem używasz programów innych niż Cubase, 
musisz ponownie przeskanować pliki w wnęce MediaBay, aby odzwierciedlić te zmiany.

POWIĄZANE LINKI
Wyłączanie preferencji na stronie 1153
Edycja atrybutów na stronie 660

Zarządzanie listami atrybutów
W Attribute Inspector (Inspektorze atrybutów) możesz zdefiniować, które atrybuty będą 
wyświetlane na liście Results (Wyniki) oraz w samym Inspektorze atrybutów. Dla różnych typów 
multimediów można skonfigurować indywidualne zestawy atrybutów.

PROCEDURA
1. W Attribute Inspector (Inspektorze atrybutów) kliknij Defined (Zdefiniowane).
2. Kliknij opcję Configure Defined Attributes (Konfiguruj zdefiniowane atrybuty), aby przejść do
    trybu konfiguracji.

                                

3. Otwórz wyskakujące menu Select Media Types (Wybierz typy multimediów), aktywuj typy   
    multimediów, które chcesz wyświetlić, i kliknij w dowolnym miejscu wnęki MediaBay.
    Attribute Inspector (Inspektor atrybutów) wyświetla teraz listę wszystkich atrybutów  
   dostępnych dla tych typów multimediów.
     ● Jeśli aktywowałeś więcej niż jeden typ multimediów, Twoje ustawienia dotyczą wszystkich 
        wybranych typów. Pomarańczowy znacznik wyboru wskazuje, że bieżące ustawienia 
        wyświetlania atrybutu różnią się w przypadku wybranych typów multimediów.
     ● Ustawienia wyświetlania wybrane dla opcji Mixed Media Types (Mieszane typy 
        multimediów) zostaną zastosowane, jeśli wybierzesz pliki różnych typów multimediów na 
        liście Results (Wyniki) lub w Attribute Inspector (Inspektorze atrybutów)
4. Aktywuj atrybuty, które chcesz wyświetlić. Możesz edytować kilka atrybutów jednocześnie.
5. Kliknij ponownie opcję Konfiguruj zdefiniowane atrybuty, aby wyjść z trybu konfiguracji.

Definiowanie atrybutów użytkownika
Możesz zdefiniować własne atrybuty i zapisać je w bazie danych MediaBay oraz odpowiednich 
plikach multimedialnych. Cubase rozpoznaje wszystkie atrybuty użytkownika zawarte w plikach 
multimedialnych.

PROCEDURA
1. W Attribute Inspector (Inspektorze atrybutów) kliknij Defined (Zdefiniowane).
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2. Kliknij opcję Configure Defined Attributes (Konfiguruj zdefiniowane atrybuty), aby przejść do
    trybu konfiguracji

                            
3. Kliknij +.
4. W oknie dialogowym Add User Attribute (Dodaj atrybut użytkownika) określ Attribute Type  
    (typ atrybutu) i  nazwę wyświetlaną. Display Name (Nazwa wyświetlana) musi być unikalna na  
    liście atrybutów. Pole Database Name (Nazwa bazy danych) wskazuje, czy dana nazwa jest   
    prawidłowa, czy nie.
5. Kliknij OK.

WYNIK
Nowy atrybut zostanie dodany do listy dostępnych atrybutów i wyświetlony w Attribute Inspector
(Inspektorze atrybutów) oraz na liście Results (Wyniki).

Współpraca z MediaBay (Zatoka multimediów)
Kiedy pracujesz z wieloma plikami muzycznymi, MediaBay pomoże Ci znaleźć i uporządkować 
zawartość. Po przeskanowaniu folderów wszystkie znalezione pliki multimedialne w 
obsługiwanych formatach zostaną wyświetlone w sekcji Results (Wyniki).
Możesz skonfigurować Favorites (Ulubione), czyli foldery lub katalogi w systemie zawierające 
pliki multimedialne. Zwykle pliki na komputerze są zorganizowane w określony sposób. Możesz 
mieć foldery zarezerwowane na zawartość audio, foldery na efekty specjalne, foldery na 
kombinacje dźwięków tworzących szum otoczenia potrzebny do kręcenia konkretnego filmu itp. 
Wszystkie te foldery można ustawić jako różne Favorites w wnęce MediaBay, co pozwala na 
ogranicz pliki dostępne na liście Results (Wyniki) w zależności od kontekstu.
Korzystając z opcji wyszukiwania i filtrowania, możesz zawęzić wyniki.
Możesz wstawić pliki do projektu metodą przeciągania i upuszczania, podwójnym kliknięciem lub 
korzystając z opcji menu kontekstowego.

Korzystanie z plików multimedialnych

Okno MediaBay i Media Rack (stojak, regał, szafa na media) w prawej strefie okna projektu 
oferują wiele możliwości wyszukiwania określonych plików, pętli, sampli, ustawień wstępnych 
i wzorców, które możesz wykorzystać w swoim projekcie.

Po znalezieniu plików multimedialnych, których szukasz, możesz załadować je do swojego 
projektu.

Ładowanie pętli (Loops) i próbek (Samples)

PROCEDURA
1. Wykonaj jedną z następujących czynności:
     ● W wnęce MediaBay otwórz selektor typów multimediów, kliknij opcję MIDI Files (Pliki  
        MIDI), Audio Files (Pliki audio) lub MIDI Loops (Pętle MIDI) i wybierz plik multimedialny.
     ● W stojaku Media w prawej strefie kliknij kafelek Loops & Samples i klikaj kolejne kafelki, 
        aż będziesz mógł wybrać pliki multimedialne na liście Results (Wyniki).
2. Wykonaj jedną z następujących czynności:
     ● Kliknij dwukrotnie plik multimedialny, aby utworzyć nowy instrument lub ścieżkę audio z 
        załadowanego pliku.
     ● Przeciągnij plik multimedialny na ścieżkę na ekranie zdarzenia.
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WYNIK
Plik multimedialny zostanie wstawiony na nowej ścieżce lub w miejscu wstawiania.

POWIĄZANE LINKI
Pokaż selektor typów multimediów na stronie 647

Ładowanie ustawień wstępnych ścieżek

PROCEDURA
1. Wykonaj jedną z następujących czynności:
     ● W wnęce MediaBay otwórz selektor typów multimediów, kliknij opcję Track Presets 
        (Ustawienia wstępne ścieżki) i wybierz ustawienie wstępne.
     ● W Media rack (stojaku na nośniki) w prawej strefie kliknij Presets > Track Presets 
        (Ustawienia wstępne > Ustawienia wstępne ścieżki) i klikaj kolejne kafelki, aż będziesz mógł 
        wybrać ustawienie wstępne z listy Results (Wyniki).
2. Wykonaj jedną z następujących czynności:
     ● Kliknij dwukrotnie ustawienie wstępne ścieżki, aby utworzyć nową ścieżkę z załadowanym 
        ustawieniem wstępnym.
     ● Przeciągnij ustawienie wstępne ścieżki na ścieżkę, aby zastosować ustawienie wstępne do 
        ścieżki.

WYNIK
Ustawienie wstępne zostanie zastosowane do ścieżki i załadowane zostaną wszystkie ustawienia 
ustawienia wstępnego.

POWIĄZANE LINKI
Pokaż selektor typów multimediów na stronie 647

Ładowanie presetów (ustawień wstępnych) instrumentów

PROCEDURA
1. Wykonaj jedną z następujących czynności:
     ● We wnęce MediaBay otwórz selektor typów nośników, kliknij opcję Plug-in Presets 
        (Ustawienia wstępne wtyczek) i wybierz ustawienie wstępne dla wtyczki instrumentu.
     ● W stojaku Media rack w prawej strefie kliknij kafelek VST Instruments i klikaj kolejne 
        kafelki, aż będziesz mógł wybrać ustawienie wstępne z listy Results (Wyniki).
2. Wykonaj jedną z następujących czynności:
     ● Kliknij dwukrotnie preset instrumentu, aby utworzyć nową ścieżkę instrumentu z 
        załadowanym presetem instrumentu.
     ● Przeciągnij preset instrumentu na listę ścieżek, aby utworzyć nową ścieżkę instrumentu z 
        załadowanym presetem instrumentu.
     ● Przeciągnij preset instrumentu na ekran zdarzeń, aby utworzyć nową ścieżkę instrumentu z 
        załadowanym presetem instrumentu.
     ● Przeciągnij ustawienie wstępne instrumentu na ścieżkę instrumentu, aby zastosować 
        ustawienie wstępne do ścieżki.

WYNIK
Instrument zostanie załadowany jako instrument ścieżki, a ustawienie wstępne zostanie 
zastosowane do ścieżki instrumentu.

POWIĄZANE LINKI
Dodawanie instrumentów VST do projektów na stronie 637
Pokaż selektor typów multimediów na stronie 647
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Ładowanie gotowych ustawień wtyczek efektów

PROCEDURA
1. Wykonaj jedną z następujących czynności:
     ● W wnęce MediaBay (Zatoka multimediów) otwórz selektor typów multimediów, kliknij opcję
        Plug-in Presets (Ustawienia wstępne wtyczek) i wybierz ustawienie wstępne.
     ● W Media rack (stojaku na nośniki)w prawej strefie kliknij Presets > VST FX Presets 
        (Presety > Presety VST FX) i klikaj kolejne kafelki, aż będziesz mógł wybrać ustawienie 
        wstępne z listy Results (Wyniki).
2. Wykonaj jedną z następujących czynności:
     ● Przeciągnij gotowe ustawienie wtyczki do ścieżki audio lub jej sekcji Inserts (Wstawki) 
        w Inspector (Inspektorze).
     ● Przeciągnij gotowe ustawienie wtyczki do pustego obszaru listy ścieżek.

WYNIK
Jeśli przeciągnąłeś preset wtyczki na ścieżkę audio, pierwsze wolne miejsca na wtyczki zostaną 
wypełnione odpowiednią wtyczką. Jeżeli nie ma już wolnych miejsc, wyświetli się ostrzeżenie.

Jeśli przeciągnąłeś preset wtyczki do pustego obszaru listy ścieżek, utworzona zostanie nowa 
ścieżka kanału FX i zapełnione zostaną pierwsze miejsca na wstawienia tej nowej ścieżki.

POWIĄZANE LINKI
Pokaż selektor typów multimediów na stronie 647
Dodawanie efektów VST do projektów na stronie 637

Ładowanie presetów łańcucha efektów (FX Chain)
PROCEDURA
1. Wykonaj jedną z następujących czynności:
     ● W wnęce MediaBay (Zatoka multimediów) otwórz selektor typów nośników, kliknij opcję 
         FX Chain Presets (Ustawienia wstępne łańcucha efektów) i wybierz ustawienie wstępne.
     ● W Media rack (stojaku na nośniki) w prawej strefie kliknij Presets > FX Chain Presets 
         (Ustawienia wstępne > Ustawienia wstępne łańcucha FX) i klikaj kolejne kafelki, aż będziesz 
         mógł wybrać ustawienie wstępne na liście Results (Wyniki).
2. W oknie Project wybierz ścieżkę audio.
3. Przeciągnij ustawienie wstępne z wnęki MediaBay lub Media rack (stojaka na nośniki) i upuść 
    je w otwartej sekcji Inserts (Wstawki) w Inspector (Inspektorze).

WYNIK
FX Chain Preset (Preset FX Chain) zostanie zastosowany do ścieżki i zostaną załadowane 
wszystkie ustawienia presetu. Wszelkie wstawki, które zostały wcześniej załadowane, zostaną 
nadpisane.

POWIĄZANE LINKI
Pokaż selektor typów multimediów na stronie 647

Ładowanie ustawień pasków
PROCEDURA
1. Wykonaj jedną z następujących czynności:
     ● W wnęce MediaBay otwórz selektor typów nośników, kliknij opcję Strip Presets (wstępne 
         ustawienia paska) i wybierz ustawienie wstępne.
     ● W Media rack (stojaku na nośniki) w prawej strefie kliknij Presets > Strip Presets 
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         (Ustawienia wstępne > Ustawienia wstępne paska) i klikaj następujące kafelki, aż będziesz 
         mógł wybrać ustawienie wstępne na liście Results (Wyniki).
2. W oknie Project wybierz ścieżkę audio.
3. Przeciągnij ustawienie wstępne z wnęki MediaBay lub Media rack (stojaka na nośniki) i upuść 
    je w otwartej sekcji Strip (Pasek) w Inspector (Inspektorze).

WYNIK
Ustawienie wstępne paska zostanie zastosowane do ścieżki i załadowane zostaną wszystkie 
ustawienia tego ustawienia.

POWIĄZANE LINKI
Pokaż selektor typów multimediów na stronie 647
Zapisywanie/ładowanie ustawień pasków na stronie 397

Ładowanie banków wzorów
PROCEDURA
1. Wykonaj jedną z następujących czynności:
     ● W wnęce MediaBay otwórz selektor typów nośników, kliknij Pattern Banks (Banki wzorów)
        i wybierz ustawienie wstępne.
     ● W Media rack (stojaku na nośniki) w prawej strefie kliknij Presets > Pattern Banks 
        (Ustawienia wstępne > Banki wzorców) i klikaj następujące kafelki, aż będziesz mógł wybrać 
        ustawienie wstępne z listy Results (Wyniki).
2. Wykonaj jedną z następujących czynności:
     ● Kliknij dwukrotnie bank paternów (wzorców), aby utworzyć nową ścieżkę instrumentu z   
        załadowanym presetem (wstępnym ustawieniem).

     ● Przeciągnij bank paternów (wzorców) i upuść go na ścieżce instrumentu, aby zastosować bank
        paternów do ścieżki.
     ● Przeciągnij bank wzorów i upuść go na listę ścieżek, aby utworzyć nową ścieżkę instrumentu 
        z załadowanym bankiem wzorów.

WYNIK
Groove Agent jest ładowany jako instrument ścieżki. Mapa perkusji jest ładowana dla ścieżki 
instrumentu, a instancja Beat Designera (Projektant uderzeń) jest ładowana jako efekt wstawiania.

POWIĄZANE LINKI
Pokaż selektor typów multimediów na stronie 647

Praca z bazami danych Volume (Głośności)
Cubase zapisuje wszystkie informacje o plikach multimedialnych używane w MediaBay (Zatoka 
multimediów), takie jak ścieżki i atrybuty, w lokalnym pliku bazy danych na Twoim komputerze. 
Jednak w niektórych przypadkach może być konieczne przeglądanie i zarządzanie tego rodzaju 
metadanymi na woluminie zewnętrznym.

Na przykład montażysta dźwięku może pracować zarówno w domu, jak i w studiu, na dwóch 
różnych komputerach. Dlatego efekty dźwiękowe są przechowywane na zewnętrznym nośniku 
danych. Aby móc podłączyć urządzenie zewnętrzne i bezpośrednio przeglądać jego zawartość w 
MediaBay bez konieczności skanowania urządzenia, należy utworzyć bazę danych głośności dla 
urządzenia zewnętrznego.
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Można tworzyć bazy danych głośności dla dysków komputera lub zewnętrznych nośników pamięci.
Zawierają one ten sam rodzaj informacji o plikach multimedialnych na tych dyskach, co zwykła 
baza danych MediaBay

UWAGA
Po uruchomieniu Cubase wszystkie dostępne bazy danych głośności zostaną automatycznie 
zamontowane. Bazy danych udostępniane w trakcie działania programu należy montować ręcznie.

Rescanning Volume Databases (Ponowne skanowanie baz danych głośności)

Jeśli zmodyfikowałeś dane na woluminie zewnętrznym w innym systemie, musisz ponownie 
przeskanować wnękę MediaBay.

POWIĄZANE LINKI
Odśwież widoki (Refrash Views) na stronie 645

Tworzenie baz danych głośnosci

PROCEDURA
● W sekcji File Browser (Przeglądarka plików) kliknij prawym przyciskiem myszy zewnętrzny 
nośnik pamięci, dysk lub partycję systemu komputerowego, dla której chcesz utworzyć bazę 
danych, i wybierz opcję Create Volume Database (Utwórz bazę danych głośności).

                      
WAŻNE
W tym celu należy wybrać najwyższy poziom katalogu. Nie można utworzyć pliku bazy danych dla
folderu niższego poziomu.

UWAGA
Jeśli utworzysz bazę danych głośności na dysku sieciowym, dostęp do niej będzie miało wielu 
użytkowników. Może to jednak prowadzić do konfliktów zapisu, ponieważ w danym momencie 
tylko jeden użytkownik może zapisywać w bazie danych.
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WYNIK
Informacje o pliku dla tego napędu są zapisywane w nowym pliku bazy danych. Bazy danych 

głośności są oznaczone symbolem  po lewej stronie nazwy dysku.
UWAGA
Jeśli dysk zawiera dużą ilość danych, proces ten może zająć trochę czasu.

Bazy danych głosności są automatycznie montowane po uruchomieniu Cubase. Są one pokazane 
w sekcji File Browser (Przeglądarka plików), a ich dane można przeglądać i edytować na liście 
Results (Wyniki).

POWIĄZANE LINKI
Zablokowane bazy danych głośności na dyskach sieciowych na stronie 668

Zablokowane bazy danych Volume (głośności) na dyskach sieciowych
Możesz odblokować bazy danych Volume na dyskach sieciowych. Może to być konieczne, jeśli 
system innego użytkownika, który również korzystał z bazy danych Volume na dysku sieciowym, 
uległ awarii lub nie został prawidłowo odłączony. W tym przypadku Cubase tworzy plik w ukrytym
folderze, który wskazuje, że baza danych jest nadal używana.
Jeśli tak się stanie, po uruchomieniu programu pojawi się komunikat ostrzegawczy. Pokazuje nazwę
użytkownika lub systemu.

Wykonaj jedną z następujących czynności:
● Poproś innego użytkownika o ponowne uruchomienie Cubase, aby blokada została automatycznie
zwolniona.
● Jeśli nie możesz skontaktować się z drugim użytkownikiem i nie potrzebujesz dostępu do bazy 
danych, kliknij Ignore Database (Ignoruj bazę danych).
● Jeśli nie możesz nawiązać połączenia z drugim użytkownikiem, a chcesz skorzystać z bazy 
danych, kliknij Force unlock (Wymuś odblokowanie), aby zdjąć blokadę.

Usuwanie baz danych Volume (Głośności)
Jeśli pracowałeś na innym komputerze, korzystając z zewnętrznego dysku twardego, a następnie 
wróciłeś do własnego komputera i ponownie podłączyłeś urządzenie zewnętrzne w ramach 
konfiguracji systemu, nie potrzebujesz już dla niego osobnej bazy danych Volume. Wszelkie dane 
na tym dysku można ponownie uwzględnić w lokalnym pliku bazy danych, usuwając dodatkowy 
plik bazy danych.

PROCEDURA
● W sekcji File Browser (Przeglądarka plików) kliknij prawym przyciskiem myszy bazę danych 
woluminów i wybierz Remove Volume Database (Usuń bazę danych Volume).

WYNIK
Metadane są integrowane w lokalnym pliku MediaBay bazy danych, a plik bazy danych Volume 
jest usuwany.

UWAGA
Jeśli dysk zawiera dużą ilość danych, proces ten może zająć trochę czasu.

Montowanie i odmontowywanie baz danych Volume
Bazy danych Volume udostępniane podczas działania Cubase muszą być montowane ręcznie.
● Aby ręcznie zamontować bazę danych Volume, kliknij prawym przyciskiem myszy zewnętrzny 
   nośnik pamięci, dysk lub partycję systemu komputerowego, którą chcesz zamontować, i wybierz 
  opcję Mount Volume Database (Zamontuj Bazę Danych Volume).
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● Aby odmontować bazę danych Volume, kliknij ją prawym przyciskiem myszy i wybierz  
   Unmount Volume Database (Odmontuj bazę danych głośności).

Ustawienia MediaBay (zatoki multimediów)
● Aby otworzyć panel z ustawieniami wnęki MediaBay, kliknij MediaBay Settings (Ustawienia 
wnęki MediaBay).

Dostępne są następujące opcje:

Hide Folders That Are Not Scanned (Ukryj foldery, które nie są skanowane)
     Ukrywa wszystkie foldery, które nie są skanowane w poszukiwaniu plików. Dzięki temu widok 
     drzewa w File Browser (Przeglądarce plików) jest mniej zaśmiecony.
Show Only Selected Folder (Pokaż tylko wybrany folder)
     Pokazuje tylko wybrany folder i jego podfoldery.
Scan Folders Only When MediaBay Is Open (Skanuj foldery tylko wtedy, gdy otwarta jest   
     wnęka MediaBay)
     Skanuje foldery w poszukiwaniu plików multimedialnych, gdy okno MediaBay jest otwarte.  
     Jeśli ta opcja jest wyłączona, foldery będą skanowane w tle nawet wtedy, gdy okno MediaBay 
     jest zamknięte. Jednak Cubase nigdy nie skanuje folderów podczas odtwarzania lub nagrywania.
Maximum Items in Results List (Maksymalna liczba elementów na liście wyników)
     Umożliwia określenie maksymalnej liczby plików wyświetlanych na liście Results (Wyniki). 
     Pozwala to uniknąć niemożliwie długich list plików.

UWAGA
MediaBay nie wyświetli ostrzeżenia, jeśli osiągnięta zostanie maksymalna liczba plików. Mogą 
wystąpić sytuacje, w których nie można znaleźć określonego pliku, ponieważ osiągnięto 
maksymalną liczbę plików.

Allow Editing in Results List (Zezwalaj na edycję na liście wyników)
     Umożliwia edycję atrybutów na liście Results (Wyniki). Jeśli ta opcja jest wyłączona, atrybuty 
     można edytować wyłącznie w Attribute Inspector (Inspektorze atrybutów).
Show File Extensions in Results List (Pokaż rozszerzenia plików na liście wyników)
     Pokazuje rozszerzenia nazw plików na liście Wyniki.
Scan Unknown File Types (Skanuj nieznane typy plików)
     Podczas skanowania w poszukiwaniu plików multimedialnych MediaBay ignoruje pliki 
     o nieznanym rozszerzeniu. Jeśli ta opcja jest aktywna, MediaBay próbuje otworzyć i    
     przeskanować dowolny plik w lokalizacji wyszukiwania, ignorując te pliki, których nie można 
     rozpoznać.
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Surround Sound (Dźwięk przestrzenny)

Cubase zapewnia zintegrowane funkcje dźwięku przestrzennego z obsługą kilku formatów. 
Wszystkie kanały i szyny związane z dźwiękiem obsługują konfiguracje głośników 
wielokanałowych. Kanał w MixConsole może zawierać kompletne miksy surround lub pojedynczy 
kanał głośnikowy będący częścią konfiguracji surround.

Cubase oferuje następujące funkcje związane z dźwiękiem surround:

● Można kierować ścieżki związane z dźwiękiem, to znaczy ścieżki audio, instrumenty i samplery,  
   do kanałów surround.
● Wtyczka VST MultiPanner jest automatycznie stosowana do ścieżek związanych z audio 
   w konfiguracji mono lub stereo, które są kierowane do kanałów wyjściowych z dowolną 
   konfiguracją wielokanałową inną niż stereo. Wtyczka VST MultiPanner jest dostępna 
   w Inspector i MixConsole i może być używana do pozycjonowania kanałów w polu surround
● W przypadku produkcji w rzeczywistości wirtualnej (VR) lub rzeczywistości rozszerzonej (AR) 
   możesz tworzyć miksy w formacie Ambisonics pierwszego, drugiego i trzeciego rzędu. Cubase \  
   umożliwia monitorowanie miksów Ambisonics na słuchawkach lub systemach głośnikowych oraz
   obsługuje kontrolery VR i wyświetlacze montowane na głowie podczas pracy z wideo 360°.
● Obsługiwane są wtyczki Panner innych firm.
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● Wtyczka MixConvert V6 służy do konwersji kanału surround na inny format, jeśli odpowiednia  
   konfiguracja wejścia/wyjścia nie jest obsługiwana przez VST MultiPanner. Cubase 
   automatycznie umieszcza MixConvert V6 tam, gdzie jest to potrzebne.
● Obsługiwane są wtyczki z obsługą wielokanałową, zaprojektowane specjalnie do zadań 
   miksowania dźwięku przestrzennego, na przykład wtyczka Mix6to2. Co więcej, każda wtyczka 
   VST 3 obsługuje wielokanałowość i dlatego może być używana w konfiguracji surround, nawet 
   jeśli nie została specjalnie zaprojektowana dla surround. Szczegółowe informacje na temat 
   wszystkich dołączonych wtyczek można znaleźć w oddzielnym dokumencie Plug-in Reference 
   (Informacje o wtyczkach).
● Możesz eksportować miksy surround w różnych formatach, korzystając z funkcji Export Audio 
Mixdown (Eksportuj miks audio).

POWIĄZANE LINKI
Przygotowania do tworzenia miksów surround na stronie 673
VST MultiPanner na stronie 676
Mieszanki Ambisonics na stronie 692
MixConvert V6 na stronie 688
Wstawianie efektów w konfiguracjach wielokanałowych na stronie 450
Eksport miksu surround na stronie 692

Elementy dostarczane

Miks surround w Cubase można przesłać jako dźwięk wielokanałowy z szyny wyjściowej surround 
do rejestratora lub można go wyeksportować do plików audio na dysku twardym.

Wyeksportowane miksy surround można podzielić do jednego pliku mono na kanał głośnika lub 
przeplatać do jednego pliku zawierającego wszystkie kanały surround.

POWIĄZANE LINKI
Eksportuj miks audio na stronie 1053

Dostępne konfiguracje kanałów surround

Cubase obsługuje kilka konfiguracji kanałów surround.
Obsługiwane są następujące konfiguracje kanałów surround:

LRC
     W tym formacie wykorzystywane są kanały lewy, prawy i środkowy.
Quadro
     Jest to oryginalny kwadrofoniczny format muzyki, z jednym głośnikiem w każdym rogu.
     Format ten był przeznaczony dla odtwarzaczy płyt winylowych.
5.1
     Format ten, nazywany także Dolby Digital, AC-3, DTS i MPEG-2 Multichannel, wykorzystuje 
     kanały przednie lewy, środkowy i prawy, kanały surround lewy i prawy oraz dodatkowy kanał 
     LFE (Low Frequency Effects).
     Kanał centralny jest używany głównie do transmisji mowy, kanały przedni i surround lewy i 
     prawy do muzyki i efektów dźwiękowych, a kanał LFE do wzmacniania treści o niskiej 
     częstotliwości.
5,0
     W tym formacie używane są kanały przednie lewy, środkowy i prawy oraz kanały surround lewy
     i prawy.
6.0 Cine (Kino)
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     W tym formacie używane są kanały przednie lewy, środkowy i prawy oraz kanały surround 
     lewy, środkowy i prawy.
6.0 Music (Muzyka)
     W tym formacie wykorzystywane są kanały przednie lewy i prawy, kanały surround lewy i 
     prawy oraz kanały boczne lewy i prawy.
1st Order Ambisonics/2nd Order Ambisonics/3rd Order Ambisonics (Ambisonika pierwszego 
rzędu/Ambisonika drugiego rzędu/Ambisonika trzeciego rzędu)
     Te formaty 3D pozwalają na stworzenie sferycznego pola dźwiękowego. Wykorzystują 
     zakodowaną wiązkę sygnałów audio do umieszczania źródeł dźwięku w dowolnym miejscu 
     sfery dźwiękowej.
     Dostępne formaty Ambisonics różnią się liczbą wykorzystywanych sygnałów audio.
     Ambisoniki wyższego rzędu dostarczają więcej sygnałów i pozwalają na większą precyzję   
     pozycjonowania
LRC
     W tym formacie wykorzystywane są kanały lewy, prawy, środkowy i surround. Kanał surround 
     jest umieszczony centralnie z tyłu. Jest to oryginalny format surround, który po raz pierwszy 
     pojawił się w kinie jako Dolby Stereo, a później jako format kina domowego Dolby ProLogic.
LRCS+LFE
     Jest to ten sam format co LRCS, ale z dodatkowym kanałem LFE.
Quadro+LFE
     Jest to ten sam format co Quadro, ale z dodatkowym kanałem LFE.
LRS
     W tym formacie wykorzystywane są kanały lewy, prawy i surround. Kanał surround jest 
     umieszczony centralnie z tyłu.
LRC+LFE
     Jest to ten sam format co LRC, ale z dodatkowym kanałem LFE.
LRS+LFE
     Jest to ten sam format co LRS, ale z dodatkowym kanałem LFE.

WAŻNE
W Cubase kolejność kanałów surround i kanałów bocznych jest zgodna ze specyfikacją Microsoft 
Inc. Aby spełnić specyfikację Dolby dla bocznych kanałów surround i tylnych kanałów surround, 
zamień porty urządzeń kanałów surround i kanałów bocznych.

Przygotowania do tworzenia miksów surround

Należy przygotować Cubase na dźwięk przestrzenny, definiując szyny wejściowe i wyjściowe w 
formacie surround oraz określając, które wejścia i wyjścia audio są używane dla różnych kanałów 
w szynach.

Konfiguracja magistrali wyjściowej
Przed rozpoczęciem pracy z dźwiękiem surround należy skonfigurować szynę wyjściową surround, 
przez którą kierowane są wszystkie kanały głośników wybranego formatu surround.
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                        Magistrala wyjściowa w konfiguracji 5.1-kanałowej

POWIĄZANE LINKI
Dodawanie magistrali wejściowych i wyjściowych na stronie 33.

Szyny Child (dziecko)

Szyny Child (podrzędne, dziecko) umożliwiają kierowanie utworów do określonych kanałów 
w ramach szyny surround. Tworzenie szyn stereo w ramach szyny surround umożliwia kierowanie 
ścieżek stereo bezpośrednio do pary głośników stereo. Można także dodać szyny podrzędne w 
innych formatach surround z mniejszą liczbą kanałów niż szyna nadrzędna.

● Po utworzeniu szyny surround (przestrzennej) możesz dodać do niej jedną lub kilka szyn 
podrzędnych, klikając szynę prawym przyciskiem myszy i wybierając opcję Add Child Bus (Dodaj
szynę podrzędą).

      
       Magistrala wyjściowa w konfiguracji 5.1-kanałowej z szyną podrzędną stereo
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POWIĄZANE LINKI
Dodawanie szyn podrzędnych Child na stronie 33

Routing surround
Format przetwarzania VST MultiPanner zależy od routingu kanałów. Możesz użyć stojaków 
Routing i Direct Routing w MixConsole, aby skierować ścieżki audio do szyn wyjściowych lub 
kanałów grupowych w konfiguracji surround.

                         

Na przykład, jeśli monofoniczny kanał źródłowy jest kierowany na szynę 5.1, panorama działa w 
trybie 5.1.

POWIĄZANE LINKI
VST MultiPanner na stronie 676
Routing (Trasowanie) na stronie 382
Konfigurowanie routingu bezpośredniego na stronie 399

Kierowanie kanałów do indywidualnych kanałów surround
Jeśli chcesz umieścić źródło dźwięku w jednym oddzielnym kanale głośnikowym, możesz 
skierować je bezpośrednio do tego kanału głośnikowego. Jest to przydatne w przypadku wstępnie 
zmiksowanych materiałów lub nagrań wielokanałowych, które nie wymagają panoramowania.

● Aby skierować kanał do pojedynczego kanału surround, wybierz odpowiednią szynę wyjściową 
tego kanału głośnikowego w Routing rack (szafie,stojaku, regale routingu).

            
UWAGA
Jeśli stereofoniczny kanał audio jest kierowany bezpośrednio do kanału głośnikowego, lewy i 
prawy kanał są miksowane do postaci monofonicznej. Sterowanie panoramą kanału audio określa 
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równowagę pomiędzy lewym i prawym kanałem w wynikowym miksie monofonicznym. Środkowa
panorama wytwarza mieszankę o równych proporcjach.

Kanały trasujące do szyn podrzędnych
Jeśli dodasz magistralę podrzędną do magistrali surround, pojawi się ona jako podpozycja 
magistrali surround w selektorze tras. Wybierz tę opcję, aby skierować stereofoniczny kanał audio 
bezpośrednio do pary głośników stereofonicznych szyny surround, na przykład aby skierować 
ścieżkę muzyczną bezpośrednio do lewego i prawego przedniego głośnika w kanale surround.

       

POWIĄZANE LINKI
Szyny Child (dziecko, podrzędne) na stronie 673

Konfiguracja magistrali wejściowej
W większości przypadków nie ma potrzeby konfigurowania magistrali wejściowej w formacie 
surround, aby pracować z dźwiękiem surround w Cubase. Możesz nagrywać pliki audio poprzez 
standardowe wejścia i łatwo kierować powstałe kanały audio do wyjść surround na dowolnym 
etapie. Można także bezpośrednio importować pliki wielokanałowe w określonym formacie 
surround do ścieżek audio w tym samym formacie.

Jednakże w następujących przypadkach należy dodać szynę wejściową surround:

● Masz już materiał audio w określonym formacie surround i chcesz przenieść go do Cubase jako   
   pojedynczy, wielokanałowy plik.

● Chcesz dokonać nagrania na żywo w konfiguracji surround.
● Przygotowałeś premiksy surround, np. stemy, które chcesz nagrać na nowej ścieżce audio w 
   konfiguracji surround.

POWIĄZANE LINKI
Import pliku audio na stronie 284
Dodawanie magistrali wejściowych i wyjściowych na stronie 33

VST MultiPanner
Wtyczka VST MultiPanner umożliwia umiejscowienie źródła dźwięku w polu surround lub 
modyfikację istniejących premiksów. Wtyczka rozdziela przychodzący dźwięk w różnych 
proporcjach na wyjściowe kanały surround.

W obszarze panoramowania, źródła dźwięku są pokazane w postaci niebieskich uchwytów 
panoramowania. W konfiguracji stereo lewy i prawy przedni kanał są pokazane jako żółty i 
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czerwony uchwyt. Źródła dźwięku można ustawić w pomieszczeniu, przeciągając uchwyty 
przesuwania.

Aby wykonać ruchy obrotowe, których nie można uzyskać za pomocą przeciągania, możesz użyć 
elementów sterujących obrotem i orbitą znajdujących się poniżej obszaru panoramowania. Aby 
dostosować wielkość źródła dźwięku, użyj elementów sterujących do dystrybucji sygnału do 
różnych kanałów głośników i zaawansowanego skalowania.

UWAGA
To, czy można użyć VST MultiPanner dla określonej konfiguracji wejścia/wyjścia, zależy od tego, 
czy ta konfiguracja może zostać odwzorowana przez panoramę.

POWIĄZANE LINKI
Panel wtykowy VST MultiPanner na stronie 676
Pozycja źródła dźwięku na stronie 681
MixConvert V6 na stronie 688

Panoramowanie ze stałą mocą
Wtyczka VST MultiPanner wykorzystuje zasady panoramowania o stałej mocy. Oznacza to, że 
moc kanału źródłowego jest identyczna z mocą odpowiedniego sygnału wyjściowego.

Prawa stałej mocy zapewniają, że ogólna głośność odbierana przez słuchacza jest zawsze taka 
sama, niezależnie od panoramy sygnału. Umożliwia to przesuwanie źródła dźwięku w obszarze 
panoramy, wyłączanie określonych kanałów głośników lub korzystanie z kontroli rozbieżności bez 
żadnych zmian głośności.

POWIĄZANE LINKI
Panel wtykowy VST MultiPanner na stronie 676

Panel wtykowy VST MultiPanner

Panel wtykowy VST MultiPanner umożliwia ustawienie źródła dźwięku mono lub stereo.

● Aby otworzyć panel wtyczek VST MultiPanner w oddzielnym oknie, kliknij dwukrotnie 
miniaturowy widok VST MultiPanner w Inspector (Inspektorze) lub MixConsole.
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Dostępne są następujące ustawienia i opcje:

Movement restriction buttons (Przyciski ograniczające ruch)

       
      Umożliwia ograniczenie ruchu do jednej osi podczas przesuwania źródła dźwięku za pomocą 
      myszy.
UWAGA
● Przyciski ograniczenia ruchu nie mają wpływu na elementy sterujące w sekcji pozycjonowania 
poniżej obszaru panoramowania.

Reset Parameters (Zresetuj parametry)
     Alt/Opt – kliknij ten przycisk, aby zresetować wszystkie parametry panoramy do wartości 
     domyślnych.
Input level meter (Miernik poziomu wejściowego)
     Pokazuje poziom wejściowy dla wszystkich kanałów głośnikowych. Wartości liczbowe nad 
     licznikami wskazują poziomy szczytowe zarejestrowane dla kanałów.
Position Left/Right Channels Independently (Niezależnie ustawiaj lewy/prawy kanał)
     Aktywuj tę opcję, aby niezależnie regulować przedni lewy i prawy kanał wejściowy poprzez 
     przeciąganie.
Pan area (Obszar panoramowania)
     Pokazuje pomieszczenie z góry i umożliwia ustawienie źródła dźwięku poprzez przeciągnięcie 
     uchwytów panoramowania.
     Aby pomniejszyć obszar panoramowania, aktywuj Overview Mode (tryb przeglądu).
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Speaker channel buttons (Przyciski kanałów głośnikowych)
     Przyciski głośników wokół obszaru panoramy reprezentują konfigurację wyjściową. Przyciski 
     umożliwiają solo, wyciszenie (mute) i wyłączenie odpowiednich kanałów.
UWAGA
Nie można zautomatyzować solowania kanałów wyjściowych.

Output level meter (Miernik poziomu wyjściowego)
     Pokazuje poziom wyjściowy dla wszystkich kanałów głośnikowych. Wartości liczbowe nad 
     licznikami wskazują poziomy szczytowe zarejestrowane dla kanałów.
Left-Right Pan (Lewa-prawa panorama)
     Ustawia położenie sygnału na osi x.
Rear-Front Pan (Tył-Przednia panorama)
     Ustawia położenie sygnału na osi Y.
Rotate Signal around Z-Axis (Obróć sygnał wokół osi Z)
     Obraca źródło dźwięku wokół uchwytu pozycjonującego. Ta opcja jest dostępna tylko dla 
     sygnałów stereo.
Orbit Center (Centrum Orbity)
     Obraca źródło dźwięku, włączając wszystkie kanały wejściowe i sygnał uchwytu 
     pozycjonującego wokół środka pomieszczenia. Kliknij Counter Shot (Kontrastrzał), aby 
     obrócić źródło dźwięku dokładnie o 180 stopni.
Radius (Promień)
     Ustawia odległość źródła dźwięku od środka pomieszczenia podczas korzystania z Orbit Center
     (Centralna orbita).
Center Distribution (Dystrybucja centralna)
     Rozdziela część lub całość sygnału centralnego do lewego i prawego przedniego głośnika.
UWAGA
Jeśli Front Divergence (rozbieżność przednia) jest ustawiona na 100 %, Center Distribution 
(rozkład środkowy) nie ma żadnego wpływu.

Front Divergence (Rozbieżność frontu)
     Określa krzywą tłumienia stosowaną podczas umieszczania źródła dźwięku na przedniej osi X.
Front/Rear Divergence (Rozbieżność przód/tył)
     Określa krzywą tłumienia stosowaną przy ustawianiu źródła dźwięku na osi Y.
Rear Divergence (Rozbieżność tylna)
     Określa krzywą tłumienia stosowaną podczas umieszczania źródła dźwięku na tylnej osi X.
Signal Width (Szerokość sygnału)
     Ustawia ekspansję źródła dźwięku na osi x. Ten parametr jest dostępny tylko dla kanałów 
     Z konfiguracją wyjścia stereo lub wielokanałowego.
Signal Depth (Głębokość sygnału)
     Ustawia ekspansję źródła dźwięku na osi Y. Ten parametr jest dostępny tylko dla kanałów 
     z wielokanałową konfiguracją wyjścia.
LFE Level (Poziom LFE)
     Ustawia ilość sygnału wysyłanego do kanału LFE (efekty niskiej częstotliwości).

UWAGA
Kanał LFE jest używany jako kanał pełnozakresowy, nie ma zastosowania filtracja 
dolnoprzepustowa.
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POWIĄZANE LINKI
Tryby ograniczeń ruchu na stronie 682
Tryb przeglądu na stronie 683
Kanały głośnikowe solo, wyciszone i wyłączone na stronie 687
Sterowanie panoramą na stronie 684
Obróć sterowanie na stronie 684
Sterowanie orbitą na stronie 685
Centralna kontrola dystrybucji na stronie 685
Kontrole rozbieżności na stronie 686
Elementy sterujące skalą na stronie 686

Miniaturowe widoki
W MixConsole, w oknie Channel Settings (Ustawienia kanałów) i w Inspector (Inspektorze) 
miniaturowe widoki VST MultiPanner umożliwiają podstawowe operacje panoramowania.

Chociaż, aby uzyskać dostęp do wszystkich funkcji panoramowania, musisz otworzyć panel 
wtyczek, podstawowe operacje panoramowania możesz wykonywać także w następujących 
obszarach:

● W MixConsole i w oknie Channel Settings, na górze sekcji tłumików wyświetlany jest 
   miniaturowy widok panoramy.

          
● W Inspektorze wyświetlany jest miniaturowy widok panoramy w sekcji Surround Pan  
   (Panoramy surround).

           
W widokach miniaturowych obowiązują następujące zasady:
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● Aby przesunąć źródło sygnału w polu surround, kliknij i przeciągnij.
● W miniaturowym widoku Inspektora możesz także solować, wyciszać i wyłączać kanały.
UWAGA
We wszystkich miniaturowych widokach panoramicznych możesz przytrzymać Shift podczas 
przesuwania źródła dźwięku, aby umożliwić dokładniejsze pozycjonowanie.

POWIĄZANE LINKI
Kanały głośnikowe solo, wyciszone i wyłączone na stronie 687
Tryby ograniczeń ruchu na stronie 682

Ogólne sterowanie wtyczkami

Bypass Effect (Efekt obejścia)

     Bypass Effect  w górnej części panelu wtyczek umożliwia ominięcie VST MultiPanner. 

Obowiązuje co następuje:
● Jeśli konfiguracje wejścia i wyjścia są identyczne, sygnały wejściowe są kierowane bezpośrednio 
   do kanałów wyjściowych.
● Jeśli konfiguracje wejścia i wyjścia różnią się, panorama próbuje skierować sygnały wejściowe 
   do odpowiednich kanałów wyjściowych. Na przykład, jeśli przesuniesz sygnał stereo do 
   konfiguracji 5.1, używane będą lewy i prawy głośnik przedni.

Mute/Solo (Wyciszenie/Solo)

     Mute  i Solo w górnej części panelu wtyczek są identyczne z odpowiednimi elementami
     sterującymi kanałów.
Read/Write (Czytaj/Pisz)

     Read (Odczyt)  i Write (zapis)  w górnej części okna VST MultiPanner umożliwiają 
     zastosowanie i zapisanie danych automatyki.

POWIĄZANE LINKI
Omijanie efektów wstawiania na stronie 449
Korzystanie z funkcji Solo i wyciszenia na stronie 377
Parametry automatyzacji w VST MultiPanner na stronie 680

Parametry automatyzacji w VST MultiPanner
Większość parametrów wtyczki VST MultiPanner można zautomatyzować, tak jak każdy inny 
kanał lub parametr wstawiania.

Automatyzacja nagrywania dla kontroli orbity i trybu niezależnego pozycjonowania jest jednak 
obsługiwana inaczej. Dane automatyzacji dla tych parametrów są zapisywane jako kombinacja 
parametrów panoramowania przód-tył, panoramowania lewo-prawo i parametrów Rotate Signal 
(sygnału obrotu). Dla trybu pozycjonowania niezależnego dodawane jest skalowanie. Dlatego 
modyfikowanie istniejących danych automatyki jest dość kłopotliwe, gdyż wiąże się ze zmianą 
wielu różnych parametrów. Jeśli przepustka automatyzacyjna nie spełnia Twoich oczekiwań, 
zalecamy zacząć od początku.

POWIĄZANE LINKI
Sterowanie orbitą na stronie 685
Tryby ograniczeń ruchu na stronie 682
Zapisywanie danych automatyki na stronie 706
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Położenie źródła dźwięku
Obszar panoramy wtyczki VST MultiPanner pokazuje położenie źródła dźwięku i umożliwia jego 
przesuwanie.

W obszarze panoramy wirtualna pozycja źródła dźwięku jest pokazana jako okrąg. Lewy i prawy 
kanał stereo są pokazane w kolorze żółtym i czerwonym. Kanały mono są pokazane na niebiesko.

            
        Obszar panoramy przedstawiający źródło dźwięku stereo.

1 Lewy i prawy kanał przedni
2 Wirtualna pozycja źródła dźwięku 

Możesz umieścić źródło dźwięku w dowolnym miejscu w pomieszczeniu, a nawet przenieść je poza
obszar panoramowania. Może to być przydatne w przypadku ekstremalnych pozycji 
panoramowania, takich jak panoramowanie wszystkich kanałów maksymalnie w prawo. Aby 
wyświetlić pozycję poza obszarem panoramy, aktywuj Overview Mode (tryb przeglądu).

UWAGA
Jeśli pracujesz z kanałami monofonicznymi, źródło dźwięku odpowiada kanałowi 
monofonicznemu.

POWIĄZANE LINKI
Umiejscowienie źródła dźwięku w obszarze panoramy na stronie 681
Tryb przeglądu na stronie 683

Umiejscowienie źródła dźwięku w obszarze panoramowania
Obszar panoramy wtyczki VST MultiPanner umożliwia użycie myszy do pozycjonowania źródła 
dźwięku.

PROCEDURA
● Aby ustawić źródło dźwięku, wykonaj jedną z następujących czynności:
         ● Kliknij dokładnie w miejscu, w którym chcesz umieścić źródło dźwięku.
         ● Kliknij i przeciągnij uchwyt pozycjonowania dokładnie tam, gdzie chcesz umieścić źródło 
            dźwięku.

POWIĄZANE LINKI
Pozycja źródła dźwięku na stronie 681
Tryby ograniczeń ruchu na stronie 682
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Tryby ograniczenia ruchu
VST MultiPanner pozwala na ograniczenie ruchu w obszarze panoramy. W ten sposób można 
przesuwać źródło dźwięku wzdłuż określonej osi, np. od lewego dolnego rogu do prawego górnego 
rogu.

Dostępne są następujące tryby pozycjonowania i klawisze modyfikujące:
Standard Positioning Mode (Standardowy tryb pozycjonowania)

       
      Ruchy myszy nie są ograniczone.
Fine-Scaled Positioning Mode (Tryb precyzyjnego pozycjonowania)

       
      Ruchy myszy są skalowane, aby umożliwić bardzo precyzyjne ruchy. Jest to przydatne na 
      przykład podczas przesuwania obrazu na jednym z miniaturowych wyświetlaczy.
      Klawisz modyfikujący: Shift.
Horizontal Movements Only (Tylko ruchy poziome)

       
      Ruchy myszy są ograniczone do poziomu. Klawisz modyfikujący: Ctrl/Cmd
Vertical Movements Only (Tylko ruchy pionowe)

       
      Ruchy myszy są ograniczone do pionu. Klawisz modyfikujący: Ctrl/Cmd – Shift
Diagonal Movements - Bottom Left to Top Right (Ruchy ukośne – od lewego dolnego rogu do 
prawego górnego rogu)

       
      Ruchy myszy są ograniczone do przekątnej od lewego dolnego rogu do prawego górnego rogu.
      Klawisz modyfikujący: Alt/Opt
Diagonal Movements - Bottom Right to Top Left (Ruchy ukośne – od prawego dolnego rogu do 
lewego górnego rogu)

       
      Ruchy myszy są ograniczone do przekątnej od prawego dolnego rogu do lewego górnego rogu.
      Klawisz modyfikujący: Alt/Opt – Shift
Jump to Positioning Handle (Przejdź do uchwytu pozycjonującego)

       
      W tym trybie wskaźnik myszy przeskakuje natychmiast do uchwytu pozycjonowania, nawet 
      jeśli znajduje się on poza obszarem panoramowania.
      Klawisz modyfikujący: Ctrl/Cmd -Alt/Opt - Shift

UWAGA
Jeżeli włączona jest opcja Position Left/Right Channels Independently (Pozycjonuj niezależnie 
lewy/prawy kanał), kliknięcie w dowolnym miejscu obszaru panoramowania zawsze powoduje 
przeniesienie wskaźnika myszy do najbliższego uchwytu panoramowania.

Position Left/Right Channels Independently (Niezależnie ustawiaj lewy/prawy kanał)

       
      Ruchy myszy są ograniczone tylko do lewego lub prawego kanału.
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WAŻNE
● Jeżeli włączona jest opcja Position Left/Right Channels Independently (Pozycjonuj niezależnie
   kanały lewy/prawy), dane automatyki są zapisywane dla kilku parametrów. Z tego powodu 
   obowiązują określone zasady automatyzacji.
● Dane automatyki dla trybu pozycjonowania niezależnego zapisywane są zawsze dla całego źródła
   dźwięku, a nie dla poszczególnych kanałów. Oznacza to, że nie jest możliwe na przykład nagranie
   automatyzacji dla jednego kanału stereo, a następnie dodanie automatyzacji dla drugiego kanału 
   stereo za drugim razem.

UWAGA
Przyciski ograniczenia ruchu nie mają wpływu na elementy sterujące w sekcji pozycjonowania w 
dolnej części okna.

POWIĄZANE LINKI
Ograniczanie ruchu podczas przeciągania źródła dźwięku na stronie 683

Ograniczanie ruchów podczas przeciągania źródła dźwięku
Podczas przeciągania źródła dźwięku w obszarze panoramowania różne tryby ograniczenia ruchu 
pozwalają ograniczyć ruch do określonej osi, umożliwiając bardzo dokładne pozycjonowanie.

PROCEDURA
● Aby ograniczyć ruch w obszarze panoramowania, wykonaj jedną z następujących czynności:
       ● Naciśnij odpowiedni klawisz modyfikujący. Podświetlony zostanie odpowiedni przycisk 
          ograniczenia ruchu, wskazując, że ten tryb jest aktywny. Gdy tylko zwolnisz klawisz 
          modyfikujący, powrócisz do Standard Positioning Mode (standardowego trybu 
          pozycjonowania).
      ● Kliknij odpowiedni przycisk, aby trwale aktywować tryb pozycjonowania. Aby 
         dezaktywować wybrany tryb pozycjonowania, kliknij Standard Positioning Mode 
         (Standardowy tryb pozycjonowania) lub inny przycisk ograniczenia ruchu.

POWIĄZANE LINKI
Tryby ograniczeń ruchu na stronie 682

Overview Mode (Tryb przeglądu)

Overview Mode (Tryb przeglądu) wizualizuje ruchy panoramowania poza obszarem panoramy. 
Jednak faktyczne przesuwanie odbywa się w widoku standardowym.

Jeżeli źródło dźwięku zostało przeniesione poza obszar panoramy, Overview Mode umożliwia 
sprawdzenie, gdzie znajdują się uchwyty pozycjonujące i uchwyty panoramowania. Cienka linia 
łączy te teoretyczne pozycje z ich pozycjami skutecznymi akustycznie.

● Aby włączyć/wyłączyć tryb przeglądu, kliknij Overview Mode  poniżej obszaru    
   panoramowania.
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1 Akustycznie efektywne pozycje lewego i prawego kanału w obszarze panoramowania.
2 Teoretyczne położenie lewego i prawego uchwytu panoramowania poza obszarem 
   panoramowania
3 Umieścić uchwyt poza obszarem panoramowania

Sterowanie panoramowaniem
Panoramowanie lewy-prawy i tylny-przedni umożliwiają panoramowanie źródła dźwięku w osi x i 
osi y.

             

UWAGA
Przyciski ograniczające ruch nie mają wpływu na elementy sterujące przesuwaniem.

POWIĄZANE LINKI
Tryby ograniczeń ruchu na stronie 682

Sterowanie obrotem
Rotate Signal around Z-Axis (Obróć sygnał wokół osi Z) umożliwia obrót źródła dźwięku.
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Sterowanie orbitą
Elementy sterujące orbitą umożliwiają obracanie źródła dźwięku, w tym wszystkich kanałów 
wejściowych, wokół środka pola przestrzennego.

           
1   Orbit Center (Centrum orbity)
     Jest to główna kontrolka umożliwiająca wykonanie rotacji.
2   Radius (Promień)
     Jeśli korzystasz z Orbit Center, Radius pozwala kontrolować odległość źródła dźwięku od  
     środka pola przestrzennego bez zmiany kąta.

WAŻNE
Pod względem automatyzacji Orbit Center i Radius jako takie nie są niezależnymi parametrami. 
Zamiast tego stosowana jest kombinacja różnych parametrów automatyzacji.

POWIĄZANE LINKI
Parametry automatyzacji w VST MultiPanner na stronie 680

Kontrolka centralnej dystrybucji
Center Distribution (Dystrybucja centralna) rozdziela część lub całość sygnału centralnego do 
lewego i prawego przedniego głośnika.

             

Jeśli przesuniesz sygnał centralny bezpośrednio do głośnika centralnego i ustawisz Center 
Distribution (Rozkład centralny) na 0%, możesz otrzymać sygnał, który będzie zbyt dyskretny. W 
takim przypadku możesz dodać część sygnału do lewego i prawego przedniego głośnika, aby go 
poszerzyć. Zwiększając wartość Center Distribution (Rozkładu centralnego), możesz rozdzielić 
sygnał na 3 głośniki. Przy ustawieniu 100 % źródło centralne jest w całości dostarczane przez obraz
fantomowy tworzony przez lewy i prawy głośnik.

Linia na górze pola surround wskazuje odległość, do której dodawany jest sygnał fantomowy:

           

Jeśli umieścisz sygnał źródłowy w tym zakresie, sygnał zostanie wysłany do wszystkich 3 kanałów
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Kontrolki Divergence (rozbieżności)
Front Divergence (Rozbieżność przednia), Front/Rear Divergence (Rozbieżność przód/tył)   
i Rear Divergence (Rozbieżność tylna) określają krzywe tłumienia używane podczas 
pozycjonowania źródeł dźwięku dla osi X z przodu, osi Y z przodu/tyłu i osi X z tyłu

            
Jeśli wszystkie elementy sterujące rozbieżnością są ustawione na 0 %, umieszczenie źródła dźwięku
na głośniku ustawia poziom zerowy wszystkich pozostałych głośników. Przy wyższych wartościach
pozostałe głośniki otrzymują procent źródła dźwięku.

Linie poziome i pionowe pokazują efekt zmiany ustawień rozbieżności:

             
● Przy 0 % poruszające się źródło dźwięku jest skoncentrowane w jednym miejscu.
● Przy wartości 100 % poruszające się źródło dźwięku jest bardzo rozproszone i trudne do 
zlokalizowania.
UWAGA
●  Center Distribution (Rozkład centralny) i Front Divergence (Rozbieżność przednia) są 
połączone. Jeśli rozbieżność przednia jest ustawiona na 100 %, rozkład centralny nie ma żadnego 
wpływu.

Kontrolki skali
Elementy sterujące skalą pozwalają kontrolować poziomą (Width (szerokość)) i pionową (Depth 
(głębokość)) ekspansję źródła dźwięku.

             
Elementy sterujące skalą wpływają na postrzeganie przestrzenności i atmosfery, a także na 
identyfikowalność sygnałów.

● 100 % odpowiada całkowitej szerokości lub głębokości pola przestrzennego.
● Jeśli zmniejszysz wszystkie wartości do 0 %, odległość zostanie zmniejszona do zera, a wszystkie
   kanały źródłowe zostaną wyśrodkowane w jednym miejscu.
UWAGA
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Głębokość jest dostępna tylko w konfiguracjach z kanałami przednimi i tylnymi.

Kanały głośnikowe solo, wyciszone i wyłączone
Przyciski głośników wokół obszaru panoramowania reprezentują konfigurację wyjściową i 
umożliwiają wyłączenie, solo lub wyciszenie kanałów. Przyciski głośników wokół Top View 
(widoku z góry) i Rear View (widoku z tyłu) przedstawiają konfigurację wyjściową i umożliwiają 
wyłączenie, solo lub wyciszenie kanałów.

Enabled speaker (Włączony głośnik)

       
      Ten kanał jest włączony.
Disabled speaker (Wyłączony głośnik)

       
      Ten kanał jest wyłączony. Zamiast tego jego sygnał jest rozprowadzany do innych kanałów.
Soloed speaker (Głośnik solo)

        
      Ten kanał jest solowy.
Muted speaker (Wyciszony głośnik)

        
      Ten kanał jest wyciszony.
Disabled and muted speaker (Wyłączony i wyciszony głośnik)

       
     Ten kanał jest wyłączony i wyciszony.

● Aby wyłączyć kanał, naciśnij klawisz Alt/Opt i kliknij odpowiedni przycisk głośnika. W ten  
   sposób żaden dźwięk nie będzie kierowany do tego kanału. Sygnał, który w przeciwnym razie 
   zostałby wysłany do tego kanału, jest zamiast tego rozprowadzany do innych kanałów.
UWAGA
Jeśli sygnał wyłączonego kanału zostanie rozdzielony na inne kanały, poziom mocy pozostanie 
stały.
● Aby wybrać kanał solo, kliknij odpowiedni przycisk głośnika. Dzięki temu usłyszysz tylko sygnał
wysyłany do tego kanału, podczas gdy wszystkie pozostałe kanały będą wyciszone. Może to być 
przydatne do celów testowych, na przykład aby upewnić się, że sygnał jest wysyłany do 
określonego kanału zgodnie z zamierzeniami.
UWAGA
Możesz solować kilka kanałów jednocześnie, klikając kolejno odpowiednie przyciski głośników. 
Jeśli naciśniesz klawisz Ctrl/Cmd i klikniesz przycisk głośnika, ten kanał będzie odtwarzany 
wyłącznie solo, a wszystkie inne kanały zostaną wyciszone.

WAŻNE
Trybu solo i mute (wyciszenia) nie można zautomatyzować.

POWIĄZANE LINKI
Panoramowanie ze stałą mocą na stronie 676

Zdalne sterowanie VST MultiPanner
Wtyczką VST MultiPanner można sterować zdalnie za pomocą kilku urządzeń sterujących. Aby 
kontrolować wszystkie funkcje pannera, może być konieczna aktualizacja oprogramowania 
Twojego urządzenia.

695



Yamaha Nuage

Avid

Parametry VST MultiPanner mapowane są na następujących urządzeniach:
● System 5-MC
● S6
● Seria artystów

Panoramowanie za pomocą joysticka
Za pomocą joysticka można zdalnie sterować panoramą Rear-Front Pan (z przodu z tyłu) i Left-
Right Pan (z lewej i prawej) strony w VST MultiPanner

WARUNEK WSTĘPNY
Podłączyłeś joystick do komputera i ponownie uruchomiłeś Cubase.

PROCEDURA
● Aby ustawić źródło dźwięku w pomieszczeniu, pociągnij spust joysticka i przesuń joystick.

POWIĄZANE LINKI
Joysticki na stronie 770

Przełączanie panoramy kanałów
VST MultiPanner to domyślna wtyczka do panoramowania kanałów audio w Cubase. W 
zależności od konfiguracji kanału możesz także użyć innych wtyczek Panner.

PROCEDURA
● W MixConsole, w oknie Channel Settings (Ustawienia kanału) lub w Inspector (Inspektorze) 
   kliknij prawym przyciskiem myszy miniaturowy widok wtyczki panoramującej VST 
   MultiPanner i z menu kontekstowego wybierz wtyczkę panoramującą.

POWIĄZANE LINKI
Widoki miniaturowe na stronie 679

MixConvert V6
MixConvert V6 to wtyczka, która konwertuje jedno wielokanałowe źródło dźwięku na inne 
wielokanałowe miejsce docelowe. Najczęściej używa się go do miksowania wielokanałowego 
miksu surround do formatu z mniejszą liczbą kanałów, na przykład miksu surround 5.1 do miksu 
stereo.

MixConvert V6 może być używany jako efekt wstawiania w MixConsole, podobnie jak inne 
wtyczki, ale ma także funkcje specjalne.

Cubase automatycznie wstawia MixConvert V6 zamiast VST MultiPanner, jeśli kanał, na 
przykład ścieżka audio lub kanał grupowy, jest kierowany do miejsca docelowego z mniejszą liczbą
kanałów audio. MixConvert V6 jest również wstawiany zamiast dowolnego panelu wysyłania cue, 
jeśli miejsce docelowe ma inną konfigurację kanałów niż źródło.

UWAGA
Jest jeden wyjątek od tego zachowania. Jeśli kanał stereo jest kierowany do miejsca docelowego 
mono przez routing kanału lub routing wysyłania cue, wstawiana jest normalna panorama stereo. 
Jednakże ta panorama stereo kontroluje równowagę lewego i prawego kanału, gdy są one łączone z 
docelowym dźwiękiem monofonicznym. Pozycja środkowa łączy oba kanały w równych ilościach. 
Gdy panorama jest ustawiona maksymalnie w lewo, słychać tylko lewy kanał i odwrotnie.
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Poniższa tabela zawiera przegląd tego, która wtyczka jest używana w określonej konfiguracji:

Ścieżki monofoniczne

   Miejsce docelowe trasy    Opcja panoramy surround

   Mono    ● nie dotyczy

   Stereo    ● Mono – Standard Panner

   Surround
   ● MultiPanner VST
   ● MixConvert V6

Ścieżki stereofoniczne

   Miejsce docelowe trasy    Opcja panoramy surround

   Mono    ● Stereo - Standard Panner

   Stereo
   ● Stereo - Balance Panner 
   ● Stereo - Combined Panner

   Surround
   ● VST MultiPanner 
   ● MixConvert V6

Ścieżki surround

   Miejsce docelowe trasy    Opcja panoramy surround

   Mono    ● MixConvert V6

   Stereo    ● MixConvert V6

   Surround
   ● VST MultiPanner 
   ● MixConvert V6

   Surround z większą szerokością kanału
   ● VST MultiPanner 
   ● MixConvert V6

   Surround z mniejszą szerokością kanału    ● MixConvert V6   

Możesz wybrać opcję panoramy surround w menu kontekstowym miniaturowych widoków 
panoramy w MixConsole, w oknie Channel Settings (Ustawienia kanału) i w Inspektorze.

POWIĄZANE LINKI
Panel wtyczek MixConvert V6 na stronie 690
VST MultiPanner na stronie 676
Konfiguracje kanałów wejściowych i wyjściowych na stronie 691
Widoki miniaturowe na stronie 679
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Panel wtyczek MixConvert V6
Panel wtyczek MixConvert V6 umożliwia ustawienie poziomów kanałów surround oraz solo lub 
mute (wyciszenia) kanałów dla kanałów wejściowych i wyjściowych.

● Aby pokazać/ukryć sekcje Input (Wejście) lub Output (Wyjście), kliknij odpowiedni przycisk 
   strzałki.

                  

         

Panel wtyczek jest podzielony na trzy sekcje: sekcję Input (wejściową), sekcję Output 
(wyjściową) i sekcję środkową. Sekcje Input i Output są domyślnie ukryte.

Input section (Sekcja wejściowa)
      Pokazuje wszystkie kanały wejściowe i pozwala na solo lub mute (wyciszenie) kanałów.
Output section (Sekcja wyjściowa)
     Pokazuje wszystkie kanały wyjściowe i pozwala na solo lub mute (wyciszenie) kanałów.

W środkowej części znajdują się główne parametry wtyczki, a także przyciski umożliwiające 
solowanie kilku kanałów głośnikowych za jednym razem.
Input Channel Configuration (Konfiguracja kanału wejściowego)
     Pokazuje konfigurację kanału wejściowego.
Output Channel Configuration/Select Output Channel Configuration (Konfiguracja kanału 
wyjściowego/Wybierz konfigurację kanału wyjściowego)
     Pokazuje konfigurację kanału wyjściowego.
     Jeśli jako efekt INSERT używany jest MixConvert V6, wyskakujące menu umożliwia 
     ustawienie konfiguracji kanału wyjściowego.
Solo Channel Buttons (Przyciski solo kanału)
     Solo wszystkich kanałów przednich, kanału LFE lub wszystkich kanałów surround na 
     wyświetlaczu wejściowym lub wyjściowym. Wszystkie pozostałe kanały są wyciszone.
Listen to Solo Channels on Center Channel (Słuchaj kanałów solowych na kanale centralnym)
     Kieruje wszystkie kanały solo do kanału centralnego. Jeśli nie ma kanału centralnego, sygnał z 
     kanałów solo jest rozdzielany równomiernie do lewego i prawego głośnika.
Listen to Surround Channels on Front Channels (Słuchaj kanałów surround na kanałach 
przednich)
Solo wszystkich kanałów surround, w tym kanałów bocznych, i kieruje je lub miksuje do głośników
przednich.
Center Level (Poziom centralny)
Ustawia poziom przedniego kanału centralnego.
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LFE Fader Level (Poziom tłumika LFE)
     Ustawia poziom kanału LFE.
Surround Level (Poziom surround)
     Ustawia poziom kanałów surround. Poziomu kanałów surround nie można regulować 
     indywidualnie.
Global Gain Level (Globalny poziom wzmocnienia)
     Ustawia poziom wszystkich kanałów wyjściowych.
Activate/Deactivate Low-Pass Filter (Aktywuj/dezaktywuj filtr dolnoprzepustowy)
     Aktywuje/dezaktywuje filtr dolnoprzepustowy stosowany do kanału LFE.
Reset Parameters (Zresetuj parametry)
     Alt/Opt – kliknij ten przycisk, aby zresetować wszystkie parametry panoramy do wartości 
     domyślnych.

POWIĄZANE LINKI
Konfiguracje kanałów wejściowych i wyjściowych na stronie 691.

Konfiguracje kanałów wejściowych i wyjściowych
Konfiguracja kanału wejściowego jest określana przez szerokość kanału ścieżki, grupy lub szyny 
wyjściowej, do której wstawiony jest MixConvert V6. Konfiguracja kanału wyjściowego zależy od
tego, czy używany jest MixConvert V6.

● Jeśli MixConvert V6 zastępuje panoramę, konfiguracja wyjściowa jest określana przez miejsce 
   docelowe kanału lub wysyłanie pamięci.
● Jeśli jako efekt Insert używany jest MixConvert V6, konfigurację wyjściową można  
   modyfikować za pomocą wyskakującego menu Select Output Channel Configuration (Wybierz
   konfigurację kanału wyjściowego). Można wybrać dowolną konfigurację ze specyfikacji VST 3, 
   która zawiera głośniki obecne również w konfiguracji wejściowej.

               

UWAGA
Możesz także zmodyfikować konfigurację wyjściową, ładując ustawienie wstępne.

Solowanie kanałów
Możesz kliknąć ikony głośników na wyświetlaczach kanałów wejściowych i wyjściowych lub 
przyciski kanałów solo w środkowej części, aby włączyć kanały solo lub wyciszyć je.

Solowanie kanału wejściowego pozwala usłyszeć wpływ kanału solo na downmiks.
Solowanie kanału wyjściowego pozwala słyszeć w miksie tylko ten kanał solo.

Aby utworzyć kanały solo, wykonaj jedną z następujących czynności:

● Aby solować kanał, kliknij odpowiednią ikonę głośnika.
Można solować kilka kanałów jednocześnie. Wszystkie pozostałe kanały są wyciszone. Aby 
dezaktywować tryb solo kanału, kliknij ponownie odpowiednią ikonę głośnika.
● Aby wybrać kanał wyłącznie solo, naciśnij klawisz Ctrl/Cmd i kliknij odpowiednią ikonę 
głośnika.
● Aby solować wszystkie kanały przednie lub wszystkie kanały surround, kliknij odpowiedni 
przycisk w środkowej części.
● Aby włączyć kanał LFE w trybie solo, kliknij odpowiednią ikonę celownika na środku 
wyświetlacza kanału.
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UWAGA
Alternatywnie kliknij przycisk Solo Input/Output LFE Channel (Solo kanału wejścia/wyjścia 
LFE) w środkowej części.
● Aby wyciszyć kanał, naciśnij klawisz Shift i kliknij odpowiednią ikonę głośnika.

POWIĄZANE LINKI
Panel wtyczek MixConvert V6 na stronie 690

Eksport miksu surround
Cubase umożliwia eksport miksu surround za pomocą funkcji Export Audio Mixdown.

Podczas pracy z konfiguracją surround dostępne są następujące opcje eksportu:
● Podziel kanały, co daje jeden plik audio mono dla każdego kanału surround.
● Eksportuj do formatu z przeplotem, w wyniku czego powstaje pojedynczy wielokanałowy plik 
   audio, na przykład plik 5.1 zawierający wszystkie 6 kanałów surround.

POWIĄZANE LINKI
Eksportuj miks audio na stronie 1053
Pliki Wave na stronie 1068

Miksy ambisoniczne
Cubase umożliwia tworzenie miksów 3D w formacie Ambisonics dla treści rzeczywistości 
wirtualnej (VR) lub rzeczywistości rozszerzonej (AR). Możesz używać zintegrowanych funkcji i 
wtyczek do miksowania przestrzennego lub monitorowania śledzenia głowy lub używać 
dedykowanych wtyczek innych firm.

Ambisonics to technologia, która tworzy sferyczne pole dźwiękowe. W przeciwieństwie do 
tradycyjnych formatów dźwięku immersyjnego, nie jest on oparty na kanałach, ale wykorzystuje 
zakodowaną wiązkę wielu sygnałów audio, co pozwala na umieszczenie źródeł dźwięku w 
dowolnym miejscu w sferze dźwiękowej.

Cubase obsługuje Ambisonics pierwszego, drugiego i trzeciego rzędu. Formaty te różnią się liczbą 
wykorzystywanych sygnałów audio. Ambisoniki wyższego rzędu zapewniają więcej sygnałów i 
pozwalają na większą precyzję pozycjonowania.

Aby odtworzyć sferę dźwiękową, należy zdekodować sygnały pliku Ambisonics. Sferę dźwiękową 
można odtwarzać w następujący sposób:

● Korzystanie ze słuchawek i dekodowanie binauralne.
   Użycie odpowiednio dopasowanej konfiguracji funkcji transferu związanej z głową (HRTF) 
   pozwala uzyskać realistyczne, w pełni sferyczne pole dźwiękowe 360°. Dźwięk jest odbierany  
   jeszcze bardziej realistycznie, jeśli kodowanie binauralne uwzględnia ruchy głowy słuchacza za 
   pomocą technologii śledzenia głowy.
● Korzystanie z konfiguracji głośników stereo lub wielokanałowych.

Podczas pracy z dźwiękiem Ambisonics w Cubase obowiązują następujące zasady:

● Można nagrywać za pomocą systemu mikrofonowego obsługującego technologię Ambisonics.
● Możesz importować gotowe pliki Ambisonics w formacie WAV.
● Możesz edytować zdarzenia Ambisonics, jak każdy inny dźwięk, na przykład w oknie Project,    
   Sample Editor (Edytorze Sampli) lub oknie Direct Offline Processing (Bezpośredniego 
Przetwarzania Offline). Wszystkie sygnały pliku Ambisonics są edytowane jednocześnie.
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UWAGA
Nie każda operacja edycji jest odpowiednia dla dźwięku Ambisonics. Na przykład należy unikać 
operacji zmieniających względem siebie fazę i poziom sygnałów audio.

● Wtyczka VST AmbiDecoder dekoduje dźwięk Ambisonics w celu monitorowania na 
   słuchawkach lub systemie głośnikowym. Podczas monitorowania za pośrednictwem kanału 
   Phones dźwięk Ambisonics jest automatycznie dekodowany w celu uzyskania binauralnego 
   dźwięku stereo.
● Jeśli VST AmbiDecoder jest używany jako panorama kanałów dla kanałów Ambisonics, możesz
   dostosować kąty obrotu i ustawienia ostrości podczas miksowania dźwięku Ambisonics. 
   Umożliwia to na przykład uwydatnienie dźwięku dochodzącego z kierunku patrzenia podczas 
   korzystania z kontrolera VR z funkcją śledzenia głowy lub ponowne zrównoważenie pola 
   dźwiękowego wstępnie zmiksowanego dźwięku Ambisonics.
● Możesz używać VST MultiPanner do tworzenia miksów Ambisonics ze źródeł mono, stereo lub
   wielokanałowych. Aby używać VST MultiPanner w trybie Ambisonics, należy skierować sygnał
   do ścieżki grupowej lub szyny wyjściowej w formacie Ambisonics.
● Wysyłanie wskazówek (cue) nie działa w przypadku kanałów Ambisonics
● Cubase może wykorzystywać dane śledzenia z zewnętrznych urządzeń kontrolerów VR, takich 
   jak wyświetlacze montowane na głowie lub myszy 3D, aby zmieniać kierunek słuchania. Pozwala
   to na realistyczne monitorowanie miksów 360°.
   W przypadku utworów muzycznych w tle, na które nie mogą mieć wpływu ruchy głowy, można 
   ominąć śledzenie, wysyłając sygnał zablokowania głowy za pośrednictwem łańcucha bocznego.
● Cubase obsługuje tylko format AmbiX. Do konwersji pomiędzy formatem Furse-Malham (FuMa)
   i AmbiX można użyć wtyczki VST AmbiConverter.
● Możesz wyświetlić podgląd dźwięku Ambisonics w MediaBay, w Pool (puli), w oknie Direct 
   Offline Processing (Bezpośrednie przetwarzanie offline) lub w oknie dialogowym importu pliku, 
   jeśli Twój projekt jest skonfigurowany do odtwarzania dźwięku Ambisonics.
● Możesz używać dedykowanych wtyczek Ambisonics innych firm do miksowania, 
   konwertowania, śledzenia głowy lub binauralizacji.

UWAGA
● Zalecamy używanie wyłącznie wtyczek VST 3 Ambisonics, aby zapewnić prawidłowe 
   przekierowanie kanałów.
● Jeśli używasz Pannera Ambisonics, który nadaje się tylko jako wtyczka wstawiania, wszystkie 
   kanały audio w miksie muszą być w formacie Ambisonics, nawet jeśli zawierają tylko dźwięk 
   mono lub stereo.
● Szczegółowe informacje na temat korzystania z wtyczki innej firmy można znaleźć w dołączonej 
   do niej dokumentacji.

POWIĄZANE LINKI
Routing kanałów dla miksów Ambisonics na stronie 693
Odtwarzanie Ambisonics Audio na stronie 695
Panel VST AmbiDecoder na stronie 695
Monitorowanie sygnału head-locked w VST AmbiDecoder na stronie 701
Panel VST AmbiConverter na stronie 704

Routing kanałów dla miksów Ambisonics
Można skierować dowolny kanał do kanału Ambisonics.

To, które konfiguracje kanałów są dozwolone w miksie Ambisonics, zależy od położenia wtyczki 
Panner Ambisonics w ścieżce sygnału:
● Jeśli używasz wtyczki Panner jako panoramy kanałów w MixConsole, możesz używać 
   dowolnego formatu kanału audio.
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● Jeśli używasz Pannera jako wtyczki do wstawiania, wszystkie kanały audio w miksie muszą być 
   w formacie Ambisonics, nawet jeśli zawierają tylko dźwięk mono lub stereo.

UWAGA
Wysyłanie wskazówek (cue) nie działa w przypadku kanałów Ambisonics.

POWIĄZANE LINKI
Dostępne konfiguracje kanałów surround na stronie 672
Przełączanie panoramy kanałów na stronie 688

Panel wtyczek VST MultiPanner w trybie Ambisonics
Panel wtyczek VST MultiPanner oferuje dodatkowe ustawienia i parametry miksowania 
Ambisonics.

● Aby używać VST MultiPanner w trybie Ambisonics dla kanału audio, należy skierować kanał do 
   magistrali wyjściowej w formacie Ambisonics.

Show/Hide Extended Display (Pokaż/Ukryj rozszerzony wyświetlacz)
     Pokazuje/ukrywa widok z tyłu obszaru panoramy.
Top View/Rear View (Widok z góry/widok z tyłu)
     Pokazuje pole dźwiękowe od góry i od tyłu oraz umożliwia ustawienie źródła dźwięku poprzez 
     przeciągnięcie uchwytów panoramowania. Orientacja jest powiązana z kątem widzenia śledzenia
     głowy. Oznacza to, że to, co widzisz przed sobą podczas korzystania z wyświetlacza VR, 
     znajduje się również przed symbolem głowy w obu widokach.
Field Size (Rozmiar pola)
     Ustawia postrzeganą wielkość pola dźwiękowego. Wskazuje na to rozmiar symbolu głowy w 
     widoku z góry i w widoku z tyłu. Im mniejszy rozmiar, tym większa odległość między 
     słuchaczem a źródłem dźwięku. Głośność dźwięku jest odpowiednio tłumiona. Przesunięcie 
     wskaźnika myszy nad pokrętło skali wyświetla symulowaną odległość w metrach w obu 
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     widokach panoramicznych.

Source Size (Rozmiar źródła)
     Rozprzestrzenia dźwięk źródłowy w polu dźwiękowym, czyniąc go bardziej rozproszonym.

POWIĄZANE LINKI
Panel wtykowy VST MultiPanner na stronie 676

Odtwarzanie Ambisonics Audio
Cubase umożliwia dekodowanie dźwięku Ambisonics w celu monitorowania przez słuchawki lub 
głośniki. Do dekodowania można użyć VST AmbiDecoder lub odpowiednich wtyczek dekodera 
innych firm.

Podczas pracy z VST AmbiDecoder obowiązują następujące zasady:
● W kanale Control Room Phones do dekodowania dźwięku Ambisonics jest automatycznie 
   używany VST AmbiDecoder. Alternatywnie możesz użyć odpowiednich wtyczek dekodera 
   innych firm.
● W głównym kanale Control Room Main, VST AmbiDecoder jest automatycznie używany do 
   dekodowania dźwięku Ambisonics.
● Można używać dekoderów Ambisonics innych firm jako wtyczek w głównym kanale Control 
   Room Main.
● VST AmbiDecoder umożliwia wysyłanie sygnału typu head-locked do miksu monitorowego 
   poprzez łańcuch boczny.

UWAGA
Aby monitorować projekt Ambisonics, szyna wyjściowa w formacie Ambisonics musi być 
ustawiona jako Main Mix.

VST AmbiDecoder obsługuje następujące konfiguracje kanałów wyjściowych:

● Mono 
● Stereo 
● 5.0 
● 5.1

POWIĄZANE LINKI
Ustawianie domyślnej szyny wyjściowej (Main Mix) na stronie 33
Obuuszne monitorowanie dźwięku Ambisonics za pośrednictwem kanału Phones na stronie 699
Obuuszne monitorowanie dźwięku Ambisonics za pomocą wtyczek innych firm na stronie 700
Monitorowanie dźwięku Ambisonics za pomocą konfiguracji głośników stereo lub 
wielokanałowych na stronie 700
Monitorowanie sygnału head-locked w VST AmbiDecoder na stronie 701
Dostępne konfiguracje kanałów surround na stronie 672

Panel VST AmbiDecoder

Wtyczka VST AmbiDecoder konwertuje dźwięk Ambisonics do odtwarzania na słuchawkach lub 
w konfiguracjach głośników stereo i wielokanałowych. Jest używana automatycznie w Control 
Room Phones i głównych kanałach Control Room Main, a także może być używana jako wtyczka
typu INSERT do miksowania kanałów Ambisonics.
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Input Format > Output Format (Format wejściowy > Format wyjściowy)
       Pokazuje formaty audio sygnałów wejściowych i wyjściowych.
Output (Wyjście)
      Umożliwia wybór pomiędzy trybem Headphones (Słuchawek) do odtwarzania binauralnego 
      przez słuchawki lub trybem Speakers (Głośników) do odtwarzania poprzez konfigurację 
      głośników stereo.
HRTF Mode (Tryb HRTF)
      Umożliwia ustawienie trybu funkcji transferu zależnego od głowy (HRTF) dla odtwarzania 
      binauralnego. Ta opcja jest dostępna tylko w trybie  Headphones (Słuchawek).

Dostępne są następujące tryby HRTF:
● Tryb Standard (standardowy) wykorzystuje standardowy algorytm HRTF Cubase.
● Tryb Facebook wykorzystuje algorytm HRTF używany do odtwarzania wideo VR na 
   facebook.com. Dostępność tego trybu zależy od kolejności Ambisonics szyny Main Mix.
● Tryb YouTube wykorzystuje algorytm HRTF używany do odtwarzania wideo VR na 
   youtube.com.
   Dostępność tego trybu zależy od kolejności Ambisonics szyny Main Mix.
● Tryb SOFA umożliwia użycie HRTF zapisanego w formacie pliku SOFA.
   Ten tryb jest dostępny tylko wtedy, gdy załadowałeś plik SOFA. Aby wybrać plik SOFA, kliknij 
   trójkąt po prawej stronie przycisku SOFA.
● Tryb IMMERSE umożliwia korzystanie z profili HRTF w aplikacji IMMERSE with VST 
   AmbiDecoder.
   Aby wybrać profil IMMERSE lub sprawdzić dostępność aktualizacji profilu, kliknij trójkąt po 
   prawej stronie przycisku IMMERSE.
   Ten tryb wymaga ważnej licencji IMMERSE with VST AmbiDecoder. Szczegółowe informacje
   na temat sposobu uzyskania licencji i korzystania z aplikacji można znaleźć na stronie 
   steinberg.net.
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UWAGA
Ustawienia HRTF są dostępne tylko wtedy, gdy na kanale Phones (Telefony) w Control Room 
(Reżyserce) używany jest VST AmbiDecoder i jeśli wybrany jest tryb wyjścia Headphones 
słuchawek binauralnych.

Head Tracking (Śledzenie głowy)
      Jeśli ten przycisk jest aktywny, VST AmbiDecoder odbiera dane dotyczące śledzenia głowy z  
      okna Head Tracking (Śledzenie głowy). Jeśli ten przycisk jest nieaktywny, możesz używać  
      elementów sterujących Yaw, Pitch i Roll na panelu VST AmbiDecoder do ustawiania kątów 
      obrotu.
Yaw (Myszkować)
      Ustawia kąt obrotu odchylenia.
Pitch (Poziom)
      Ustawia kąt obrotu nachylenia.
Roll (Rolka)
      Ustawia kąt obrotu rolki.
Head-Locked Signal (Sygnał zablokowania głowy)
      Ustawia wzmocnienie sygnału head-lock, który jest wysyłany na wejście side-chain w VST  
      AmbiDecoder.
Front Focus (Przednie skupienie)
      Aktywuje/dezaktywuje nacisk określonego sektora sfery Ambisonics.
Off-Focus (Brak ostrości)
      Ustawia tłumienie dźwięku znajdującego się poza sektorem Front Focus.
Size (Rozmiar)
      Ustawia kąt Front Focus, czyli sektor sfery Ambisonics, który nie jest tłumiony przez wielkość
      wartości Off-Focus.
Follow Head (Podążaj za Głową)
      Jeśli ta opcja jest aktywna, Front Focus będzie podążać za ustawieniami podanymi w 
      powyższej sekcji Head Tracking (Śledzenie głowy). Pozwala to na przykład na uwydatnienie 
      dźwięku dochodzącego z kierunku patrzenia podczas korzystania z kontrolera VR z funkcją 
      śledzenia głowy.
      Jeśli ta opcja jest wyłączona, możesz ręcznie kontrolować Azimuth (azymut) i Elevation 
      (wysokość). Umożliwia to na przykład ponowne zrównoważenie pola dźwiękowego wstępnie 
      zmiksowanego dźwięku Ambisonics.
Azimuth (Azymut)
      Ustawia kąt azymutu zakresu Front Focus. Ten parametr jest dostępny tylko wtedy, gdy 
      funkcja Follow Head jest wyłączona.
Elevation (Podniesienie)
      Ustawia kąt elewacji zakresu Front Focus. Ten parametr jest dostępny tylko wtedy, gdy 
      funkcja Follow Head jest wyłączona.

POWIĄZANE LINKI
Okno śledzenia głowy na stronie 698
Monitorowanie sygnału head-locked w VST AmbiDecoder na stronie 701

705



Dane śledzenia głowy z urządzeń kontrolerów VR
Cubase może odbierać dane śledzenia z zewnętrznych urządzeń kontrolerów VR, takich jak 
wyświetlacze montowane na głowie lub myszy 3D.

W przypadku korzystania z danych śledzenia głowy podczas monitorowania miksu Ambisonics 
obowiązują następujące zasady:

● Ruchy głowy lub myszy 3D są odtwarzane akustycznie w czasie rzeczywistym.
● W VST MultiPanner panorama w trybie Ambisonics obraca się synchronicznie z słyszalnym 
   przodem.
● Dane śledzenia są przesyłane do odtwarzacza wideo VR, a wideo 360° jest odpowiednio      
   obracane.
UWAGA
Aby to zadziałało, musisz podłączyć odtwarzacz VR do Cubase i aktywować opcję Send 
HeadTracking Data (Wyślij dane śledzenia głowy) w oknie GoPro VR Player Remote (Zdalny 
odtwarzacz GoPro VR).

POWIĄZANE LINKI
Okno Śledzenie głowy na stronie 698
Panel wtyczek VST MultiPanner w trybie Ambisonics na stronie 694
Odtwarzanie wideo 360° na stronie 701
Okno zdalnego odtwarzacza GoPro VR na stronie 702

Okno Head Tracking (Śledzenie głowy)
W oknie Head Tracking możesz skonfigurować Cubase do odbierania danych o pozycji 
z zewnętrznego urządzenia-kontrolera VR. Alternatywnie możesz ręcznie kontrolować kąty obrotu.

                                

● Aby otworzyć okno Head Tracking (Śledzenie głowy), wybierz Project > Head Tracking   
   (Projekt > Śledzenie głowy).

Yaw (Odchylenie)
      Ustawia kąt obrotu odchylenia.
Pitch (Poziom)
      Ustawia kąt obrotu nachylenia.
Roll (Rolka)
      Ustawia kąt obrotu rolki.
Reset (Resetowanie)
      Resetuje wszystkie kąty obrotu.
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Tracking Source (Źródło śledzenia)
      Umożliwia wybór źródła danych pozycjonujących. Wybierz opcję Manual (Ręcznie), aby 
      sterować śledzeniem głowy za pomocą elementów sterujących Yaw, Pitch i Roll. Wybierz VR 
      Controller (Kontroler VR), aby odbierać dane z zewnętrznego urządzenia VR.
VR Controller Type (Typ kontrolera VR)
      Umożliwia wybór typu podłączonego urządzenia kontrolera VR.
VR controller device information (Informacje o urządzeniu kontrolera VR)

        
      Najechanie wskaźnikiem myszy na to pole pozwala uzyskać informacje o podłączonym 
      urządzeniu kontrolera VR.
Tracking (Śledzenie)
      Włącza/wyłącza przesyłanie danych dotyczących śledzenia głowy do odtwarzacza VR.
Calibrate Yaw (Kalibracja odchylenia)
      Określa bieżący kąt obrotu odchylenia jako środek.

Obuuszne monitorowanie dźwięku Ambisonics za pośrednictwem 
kanału telefonicznego
Kanał Control Room Phones (Telefony reżyserki) umożliwia dwuuszne słuchanie dźwięku 
Ambisonics przez słuchawki, automatycznie przy użyciu dekodera VST AmbiDecoder.

WARUNEK WSTĘPNY
● W oknie Audio Connections (Połączenia audio) ustawiłeś szynę wyjściową Ambisonics jako  
   główny miks i włączyłeś Control Room (Reżyserka).
● Aby funkcja podglądu dźwięku działała, musisz aktywować opcję Use Phones Channel (Użyj 
   kanału telefonu) jako kanału podglądu w oknie dialogowym Preferences (Preferencje) na stronie 
   VST – Control Room.

PROCEDURA
1. W MixConsole skieruj ścieżki audio do magistrali wyjściowej Ambisonics.
2. Kliknij opcję Open/Close Ambisonics Decoder (Otwórz/zamknij dekoder Ambisonics)

        

3. Na panelu VST AmbiDecoder wybierz opcję Headphones (Słuchawki) jako wyjście.
4. Wprowadź zmiany w HRTF Mode (trybie HRTF).

WYNIK
Dźwięk Ambisonics można odtwarzać obuusznie przez słuchawki

UWAGA
Zamiast VST AmbiDecoder można także używać wtyczek do dekodowania binauralnego innych 
firm, które nadają się do użytku w kanale Control Room Phones. Wybierz dekoder 
z wyskakującego menu w sekcji Control Room Phones (Telefony w sterowni).

POWIĄZANE LINKI
Zakładka Wejścia/Wyjścia na stronie 26
Ustawianie domyślnej szyny wyjściowej (Main Mix) na stronie 33
Zakładka Control Room na stronie 30
VST – Control Room na stronie 1184
Panel VST AmbiDecoder na stronie 695
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Obuuszne monitorowanie dźwięku Ambisonics za pomocą wtyczek 
innych firm
Wtyczek Ambisonics innych firm do dekodowania binauralnego (obuusznego), które nie nadają się 
do użycia w kanale Control Room Phones (Telefony w sterowni), można zamiast tego używać 
jako wtyczki wstawiania w kanale Main (głównym).

WARUNEK WSTĘPNY
W oknie Audio Connections (Połączenia audio) wykonałeś następujące czynności:
● Jako główny miks ustawiłeś szynę wyjściową Ambisonics.
● Włączyłeś Control Room (Reżyserka).
● Dla kanału  Control Room Monitor (Monitor w sterowni) wybrałeś właściwy port urządzenia do
   wysyłania sygnału do słuchawek.
UWAGA
Szczegółowe informacje na temat korzystania z wtyczki dekodera Ambisonics innej firmy można 
znaleźć w dołączonej do niej dokumentacji.

PROCEDURA
1. W MixConsole skieruj ścieżki audio do magistrali wyjściowej Ambisonics.
2. W sekcji Downmix Presets (Ustawienia wstępne downmiksu) w Control Room wybierz  
    ustawienie wstępne w tym samym formacie Ambisonics, co miks główny.
3. W sekcji Channels (Kanały) wyłącz Head Tracking (Śledzenie głowy) w miniaturowym 
widoku VST AmbiDecoder.
4. W kanale Main (głównym) Control Room (Sterowni) włóż wtyczkę dekodera Ambisonics.

WYNIK
Dźwięk Ambisonics można odtwarzać binauralnie (dwuusznie) za pośrednictwem kanału Control 
Room Main (głównego kanału sterowni).

POWIĄZANE LINKI
Dostępne konfiguracje kanałów surround na stronie 672
Zakładka Control Room na stronie 30
Zakładka Wejścia/Wyjścia na stronie 26
Ustawianie domyślnej szyny wyjściowej (Main Mix) na stronie 33
Wstaw Efekty na stronie 434

Monitorowanie dźwięku Ambisonics poprzez konfigurację głośników 
stereo lub wielokanałowych
Control Room Main (Główny kanał sterowni) umożliwia słuchanie dźwięku Ambisonics poprzez 
konfigurację głośników stereo lub wielokanałowych. Do dekodowania dźwięku Ambisonics do 
formatu stereo lub wielokanałowego, kanał Main (główny) automatycznie wykorzystuje VST 
AmbiDecoder.

WARUNEK WSTĘPNY
● Używasz stereofonicznego lub wielokanałowego systemu monitorów studyjnych.
● W oknie Audio Connections (Połączenia audio) ustawiłeś szynę wyjściową Ambisonics jako 
główny miks i włączyłeś Control Room (Sterownia).

PROCEDURA
1. W MixConsole skieruj ścieżki audio do magistrali wyjściowej Ambisonics.
2. W sekcji Downmix Presets (Presety downmiksu) w Control Room wybierz ustawienie pasujące
    do konfiguracji głośników.
3. W sekcji Channels (Kanały) dokonaj zmian w miniaturowym widoku VST AmbiDecoder lub 
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   kliknij go dwukrotnie, aby otworzyć panel wtyczek.     

4. W przypadku odtwarzania stereo wybierz opcję Speakers (Głośniki) jako wyjście.

WYNIK
Możesz słuchać dźwięku Ambisonics poprzez konfigurację głośników stereo lub wielokanałowych.

POWIĄZANE LINKI
Zakładka Wejścia/Wyjścia na stronie 26
Ustawianie domyślnej szyny wyjściowej (Main Mix) na stronie 33
Zakładka Control Room na stronie 30
Wstępne ustawienia miksowania na stronie 430
Odtwarzanie Ambisonics Audio na stronie 695
Kanał sterowni na stronie 431

Monitorowanie sygnału head-locked (głowa zablokowana) w VST 
AmbiDecoder
Możesz nie chcieć, aby na niektóre dźwięki, na przykład na utwory muzyczne w tle, nie wpływały 
ruchy głowy. VST AmbiDecoder umożliwia ominięcie śledzenia poprzez wysłanie sygnału typu 
head-locked za pośrednictwem łańcucha bocznego.

WARUNEK WSTĘPNY
W oknie Audio Connections (Połączenia audio) ustawiłeś szynę wyjściową Ambisonics jako 
główny miks i włączyłeś Control Room (sterownia, reżyserka).

PROCEDURA
1. W swoim projekcie utwórz ścieżkę grupową stereo lub wielokanałową i skieruj ścieżki muzyczne
    w tle do tej grupy.
2. Skieruj wyjście ścieżki grupowej do wejścia bocznego łańcucha VST AmbiDecoder.
3. Na panelu VST AmbiDecoder kliknij prawym przyciskiem myszy i wybierz opcję  
    Activate/Deactivate Side-Chain Inputs (Aktywuj/Dezaktywuj wejścia boczne).
4. Ustaw sygnał Head-Locked Signal na wymagane wzmocnienie.

WYNIK
Możesz słuchać zdekodowanego dźwięku Ambisonics i utworów muzycznych za pośrednictwem 
Control Room (Reżyserka). Dane śledzenia głowy, które Cubase otrzymuje z kontrolera VR, nie 
mają wpływu na utwory muzyczne

UWAGA
Podczas słuchania dźwięku Ambisonics przez głośniki, sygnał head-lock jest dodawany po regulacji
głośności w Control Room. Użyj Control Room Level (Poziom w pomieszczeniu kontrolnym) 
i sygnału Head-Locked Signal, aby zachować odpowiednią równowagę pomiędzy miksem 
Ambisonics i sygnałem Head-Locked.

POWIĄZANE LINKI
Okno Head Tracking (Śledzenie głowy) na stronie 698
Panel VST AmbiDecoder na stronie 695

Odtwarzanie wideo 360°
Do odtwarzania filmów 360° Cubase może wykorzystać odtwarzacz Kolor GoPro VR. Odtwarzacz 
może działać lokalnie lub na innym komputerze podłączonym poprzez sieć.
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Możesz zdalnie sterować odtwarzaczem GoPro VR Player za pomocą Cubase, korzystając z funkcji
GoPro VR Player Remote. Umożliwia kontrolę transportu odtwarzacza GoPro VR oraz 
przesyłanie do odtwarzacza danych dotyczących śledzenia głowy.

UWAGA
● Minimalna wymagana wersja GoPro VR Player to wersja 3.0. Najnowszą wersję możesz pobrać  
   pod adresem http://www.kolor.com/gopro-vr-player/download/.
● Szczegółowe informacje na temat korzystania z odtwarzacza GoPro VR Player można znaleźć w 
   dołączonej do niego dokumentacji.

POWIĄZANE LINKI
Okno GoPro VR Player Remote (zdalnego odtwarzacza GoPro VR) na stronie 702
Podłączanie Cubase do odtwarzacza GoPro VR na stronie 702

Okno GoPro VR Player Remote (Zdalnego odtwarzacza GoPro VR)
GoPro VR Player Remote pozwala Cubase kontrolować transport i kąt widzenia odtwarzacza 
GoPro VR

                       

● Aby otworzyć okno GoPro VR Player Remote, wybierz Project > GoPro VR Player Remote.

Video File (Plik wideo)
      Pokazuje wybrany plik wideo do odtwarzania w GoPro VR Player.
Select Video File (Wybierz Plik wideo)
     Umożliwia wybranie pliku wideo znajdującego się na komputerze lokalnym lub komputerze 
     zdalnym w sieci.
Video Stereoscopy (Stereoskopia wideo)
     Umożliwia wybór formatu stereoskopowego wybranego pliku wideo.
IP Address/Port (Adres IP/Port)
     Umożliwia wprowadzenie adresu IP komputera-hosta, na którym działa GoPro VR Player i portu
     UDP, którego nasłuchuje GoPro VR Player.
Send Head-Tracking Data (Wyślij dane śledzenia głowy)
     Umożliwia Cubase przesyłanie danych śledzenia głowy z zewnętrznego urządzenia sterującego 
     VR do odtwarzacza GoPro VR.
Connect (Połącz)
     Łączy Cubase z odtwarzaczem GoPro VR.

Podłączanie Cubase do odtwarzacza GoPro VR

Ten przykład pokazuje, jak podłączyć Cubase do GoPro VR Player w wersji 3.0.5.

WARUNEK WSTĘPNY
Pobrałeś wersję 3.0.5 GoPro VR Player ze strony http://www.kolor.com/gopro-vr-player/download/
i zainstalowałeś na swoim komputerze lokalnym lub innym komputerze w Twojej sieci.

710



PROCEDURA
1. W GoPro VR Player wybierz File > Preferences (Plik > Preferencje).
2. Na stronie Video Decoding (Dekodowanie wideo) wybierz Windows Media Foundation as 
    Backend (zaplecze.
3. Na stronie Primary/Secondary (Podstawowy/Dodatkowy) wybierz opcję Secondary as 
    Communication Mode (Dodatkowy jako Tryb komunikacji).
4. Na stronie Controllers (Kontrolery) zmień ustawienia Head-Mounted Display SDK 
   (Wyświetlacz montowany na głowie) zgodnie z wymaganiami. W większości przypadków 
   odpowiedni jest tryb Auto (automatyczny)
5. Zamknij menu preferencji odtwarzacza GoPro VR.
6. W Cubase wybierz Project > GoPro VR Player Remote.
7. W oknie GoPro VR Player Remote kliknij Select Video File (Wybierz plik wideo) i wybierz  
    plik wideo w oknie dialogowym pliku.
    Dzięki temu Cubase może zdalnie sterować odtwarzaczem GoPro VR. Wybór pliku zostanie 
    zapisany w projekcie Cubase.

UWAGA
Jeśli plik wideo znajduje się na zdalnym komputerze w Twojej sieci, do którego nie możesz 
uzyskać dostępu za pośrednictwem okna dialogowego pliku, możesz kliknąć pole pliku wideo i 
ręcznie wprowadzić pełną ścieżkę pliku

8. Wybierz format Video Stereoscopy (Stereoskopia wideo) dla wybranego pliku wideo.
9. Wprowadź IP Address/Port (Adres IP/port) komputera, na którym działa GoPro VR Player.
    Domyślnie IP Address/Port jest ustawiony na komputer lokalny.
10. Opcjonalnie: Jeśli nie jest używany wyświetlacz montowany na głowie, aktywuj opcję Send 
      Head-Tracking Data (Wyślij dane śledzenia głowy).
      Umożliwia to wysyłanie informacji o śledzeniu z okna Head Tracking (Śledzenie głowy) do 
      odtwarzacza GoPro VR Player.
11. Aktywuj Connect (Połącz), aby zsynchronizować transport GoPro VR Player z Cubase.

WYNIK
Odtwarzacz GoPro VR Player jest kontrolowany poprzez transport danych Cubase i śledzenia 
głowy wysyłanych z kontrolera VR podłączonego do Twojego systemu.

Eksport dźwięku Ambisonics
Możesz tworzyć pliki Ambisonics ze ścieżek Ambisonics, korzystając z funkcji Export Audio 
Mixdown (Eksportuj miks audio).

Obowiązuje co następuje:
● Używaj wyłącznie formatów plików odpowiednich dla dźwięku Ambisonics. Zalecamy tworzenie
   plików Ambisonics wyłącznie w formacie WAV.
● Przed eksportem upewnij się, że używasz wtyczek dekodujących Ambisonics tylko w Control   
   Room (reżyserka), ale nie we wstawkach kanałowych
● Nawet jeśli powstałe pliki wyglądają jak wielokanałowe pliki WAV, należy je odtworzyć za 
   pomocą dedykowanego odtwarzacza Ambisonics lub przekonwertować na inny format 
   specyficzny dla platformy przy użyciu zewnętrznej aplikacji.
● Sygnały typu head-locked muszą być eksportowane z oddzielnej magistrali wyjściowej. Możesz 
   eksportować z wielu szyn jednocześnie.

POWIĄZANE LINKI
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Eksportuj miks audio na stronie 1053
Miksowanie do plików audio na stronie 1062
Monitorowanie sygnału head-locked w VST AmbiDecoder na stronie 701

Panel VST AmbiConverter
Podczas pracy z dźwiękiem Ambisonics Cubase obsługuje tylko format AmbiX. Wtyczka 
VST AmbiConverter umożliwia konwersję dźwięku Ambisonics pomiędzy formatem Furse-
Malham (FuMa) i AmbiX

                        

Input level meter (Miernik poziomu wejściowego)
       Pokazuje poziom wejściowy dla wszystkich kanałów głośnikowych.
Ambisonics format display (Wyświetlacz w formacie Ambisonics)
       Pokazuje kolejność formatu audio Ambisonics.
Output level meter (Miernik poziomu wyjściowego)
      Pokazuje poziom wyjściowy dla wszystkich kanałów głośnikowych.
FuMa > AmbiX
      Konwertuje dźwięk z formatu FuMa na AmbiX.
AmbiX > FuMA
      Konwertuje dźwięk z formatu AmbiX na FuMa.

712



Automatyzacja

Zasadniczo automatyzacja oznacza rejestrowanie wartości dla konkretnego MixConsole lub 
parametru efektu. Kiedy tworzysz ostateczny miks, Cubase może dostosować ten konkretny 
parametr.

Krzywe automatyzacji
W projekcie Cubase zmiany wartości parametru w czasie są odzwierciedlane w postaci krzywych 
na ścieżkach automatyzacji.

Istnieją różne rodzaje krzywych automatyzacji:

        

1   Ramp curves (Krzywe rampowe)
       Krzywe rampy są tworzone dla dowolnego parametru, który generuje ciągłe wartości 
       wielokrotne, takie jak ruchy tłumika lub enkodera.
2   Step curves (Krzywe schodkowe)
      Krzywe schodkowe są tworzone dla parametrów włączania/wyłączania, takich jak wyciszenie.

Statyczna linia wartości
Kiedy otwierasz ścieżkę automatyzacji po raz pierwszy, nie zawiera ona żadnych zdarzeń 
automatyzacji. Jest to odzwierciedlone na wyświetlaczu zdarzeń w postaci poziomej linii 
przerywanej, czyli linii wartości statycznej. Ta linia przedstawia bieżące ustawienie parametrów.

Jeśli ręcznie dodałeś jakieś zdarzenia automatyzacji lub użyłeś automatyzacji zapisu dla 
odpowiedniego parametru, a następnie wyłączyłeś odczyt danych automatyki, krzywa 
automatyzacji zostanie wyszarzona na wyświetlaczu zdarzeń i zamiast tego zostanie użyta statyczna
linia wartości.

Po włączeniu opcji Read (Odczyt) używana jest krzywa automatyzacji.

Automatyzacja zapisu/odczytu
Możesz włączyć automatyzację ścieżek i kanałów MixConsole, aktywując ich automatyczne 
przyciski zapisu W i odczytu R.

● Jeśli aktywujesz W dla kanału, praktycznie wszystkie parametry MixConsole, które regulujesz 
podczas odtwarzania dla tego konkretnego kanału, są rejestrowane jako zdarzenia automatyczne.
● Jeżeli R jest aktywowane dla kanału, wszystkie nagrane przez Ciebie akcje MixConsole dla tego 
kanału zostaną wykonane podczas odtwarzania.

Przyciski R i W ścieżki na liście ścieżek są takie same, jak przyciski R i W w MixConsole.
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UWAGA
R jest automatycznie włączane po włączeniu W. Dzięki temu Cubase może w dowolnym momencie
odczytać istniejące dane automatyki. Możesz osobno dezaktywować W, jeśli chcesz tylko czytać 
istniejące dane.

Istnieją również globalne przyciski wskaźników odczytu i zapisu Activate/Deactivate Read/Write 
for All Tracks (Aktywuj/Dezaktywuj odczyt/zapis dla wszystkich ścieżek) na pasku narzędzi okna 
Project i pasku narzędzi MixConsole. Przyciski te podświetlają się, gdy na dowolnym 
kanale/ścieżce w projekcie zostanie włączony przycisk R lub W. Co więcej, można je kliknąć, aby 
włączyć lub wyłączyć R/W (odczyt/zapis) wszystkich ścieżek jednocześnie.

UWAGA
R/W są również dostępne w Automation Panel (Panelu Automatyki).

POWIĄZANE LINKI
Przyciski Read/Write/Suspend (odczytu/zapisu/zatrzymania) na stronie 716

Zapisywanie danych automatyzacji
Możesz tworzyć krzywe automatyzacji ręcznie lub automatycznie.

● Ręczny zapis ułatwia szybką zmianę wartości parametrów w określonych punktach, bez 
konieczności włączania odtwarzania.
● Automatyczne pisanie pozwala pracować niemal tak, jakbyś korzystał z prawdziwego miksera.

W przypadku obu metod wszelkie zastosowane dane automatyzacji są odzwierciedlane zarówno w 
konsoli MixConsole, na przykład za pomocą przesuniętego tłumika, jak i na odpowiedniej krzywej 
ścieżki automatyzacji.

POWIĄZANE LINKI
Ręczny zapis danych automatyki na stronie 707

Automatyczny zapis danych automatyki
Każda wykonana przez Ciebie akcja jest automatycznie rejestrowana na ścieżkach automatyzacji, 
które możesz później otworzyć do przeglądania i edycji

PROCEDURA
1. Na liście ścieżek kliknij Show/Hide Automation (Pokaż/Ukryj automatyzację) ścieżki, aby 
    otworzyć jej ścieżkę automatyzacji.

               
2. Kliknij W, aby włączyć zapis danych automatyki na tej ścieżce.
3. Rozpocznij odtwarzanie.
4. Dostosuj parametry w MixConsole, w oknie Channel Settings (Ustawienia kanałów) lub na  
    panelu sterowania efektami.
    Ustawienia wartości są rejestrowane i wyświetlane w postaci krzywej na ścieżkach 
    automatyzacji. Podczas zapisywania danych automatyzacji zmienia się kolor ścieżki 
    automatyzacji, a wskaźnik delta na ścieżce automatyzacji pokazuje względną wielkość, o jaką 
    nowe ustawienie parametru odbiega od dowolnej wcześniej zautomatyzowanej wartości.
5. Zatrzymaj odtwarzanie i wróć do miejsca, w którym zacząłeś odtwarzanie.
6. Kliknij W, aby wyłączyć zapis danych automatyki.
7. Rozpocznij odtwarzanie.
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WYNIK
Wszystkie zarejestrowane działania są dokładnie odtwarzane. Gdy przeciągniesz wtyczkę do innego
gniazda na tym samym kanale, wszelkie istniejące dane automatyzacji zostaną przeniesione wraz z 
wtyczką. Kiedy przeciągniesz ją do gniazda wstawiania na innym kanale, żadne istniejące dane 
automatyzacji nie zostaną przeniesione do nowego kanału.

Ręczny zapis danych automatyki
Możesz dodawać zdarzenia automatyzacji ręcznie, rysując krzywe automatyzacji na ścieżce 
automatyzacji.

PROCEDURA
1. Na liście ścieżek kliknij Show/Hide Automation (Pokaż/Ukryj automatyzację) ścieżki, aby 
    otworzyć jej ścieżkę automatyzacji

       
2. Kliknij nazwę parametru automatyzacji i wybierz parametr z wyskakującego menu.
3. Wybierz narzędzie Draw (Rysuj).
4. Kliknij linię wartości statycznej.
    Dodane zostanie zdarzenie automatyzacji, tryb automatyzacji odczytu zostanie automatycznie 
    aktywowany, a linia wartości statycznej zmieni się w kolorową krzywą automatyzacji
5. Kliknij i przytrzymaj, aby narysować krzywą poprzez dodanie wielu zdarzeń automatyzacji. Po 
zwolnieniu przycisku myszy liczba zdarzeń automatyzacji zostanie zmniejszona.
UWAGA
Aby dostosować zmniejszanie liczby zdarzeń, otwórz Automation Panel (Panel Automatyzacji), 
otwórz stronę Settings (Ustawienia) i wprowadź wartość w polu Reduction Level (Poziom 
redukcji).
6. Rozpocznij odtwarzanie.

WYNIK
Zautomatyzowany parametr zmienia się wraz z krzywą automatyzacji, a odpowiedni suwak w 
MixConsole porusza się odpowiednio.

PO ZAKOŃCZENIU TEGO ZADANIA
Powtórz procedurę, jeśli nie jesteś zadowolony z wyniku. Jeśli narysujesz istniejące zdarzenia, 
utworzona zostanie nowa krzywa.

Narzędzia do rysowania danych automatyzacji
Oprócz narzędzia Draw (Rysuj) do rysowania zdarzeń automatyzacji można używać narzędzi 
Object Selection (Zaznaczanie obiektów) i Line (Linia). Jeśli klikniesz którymkolwiek z tych 
narzędzi na ścieżce automatyzacji, R zostanie aktywowany automatycznie.
● Obiect Selection (Wybór obiektu)
   Kliknięcie ścieżki automatyzacji za pomocą narzędzia Obiect Selection powoduje dodanie 
   zdarzenia automatyzacji. Jeśli przytrzymasz klawisz Alt/Opt, możesz narysować kilka zdarzeń 
   automatyzacji.
UWAGA
Zdarzenia, które zostaną wprowadzone pomiędzy zdarzeniami istniejącymi i nie odbiegają od 
istniejącej krzywej, zostaną usunięte po zwolnieniu przycisku myszy.

Aby aktywować narzędzie Line (Linia) w dowolnym innym dostępnym trybie, kliknij narzędzie 
Line, a następnie kliknij ponownie, aby otworzyć wyskakujące menu, w którym możesz wybrać 
tryb narzędzia Line.
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Dostępne są następujące tryby narzędzia Linia:

Line (Linia)
Jeśli klikniesz ścieżkę automatyzacji i przeciągniesz narzędziem Line w trybie Line, możesz 
utworzyć zdarzenia automatyzacji w linii. Jest to szybki sposób na tworzenie liniowych zaników 
itp.
Parabola
Jeśli klikniesz i przeciągniesz ścieżkę automatyzacji za pomocą narzędzia Line w trybie Parabola, 
możesz utworzyć bardziej naturalne krzywe i zaniki.
UWAGA
Wynik zależy od kierunku, z którego rysujesz krzywą paraboliczną.

Sine/Triangle/Square (Sinus/Trójkąt/Kwadrat)
Jeśli klikniesz i przeciągniesz ścieżkę automatyzacji za pomocą narzędzia Line w trybie Sine 
(Sinus), Ttriangle (Trójkąt) lub Square (Kwadrat), a Typ przyciągania jest ustawiony na Grid 
(Siatka), okres krzywej, czyli długość jednego cyklu krzywej, jest określony przez ustawienie siatki.
Jeśli naciśniesz Shift i przeciągniesz, możesz ustawić długość okresu ręcznie, jako wielokrotność 
wartości siatki.
UWAGA
Narzędzia Line można używać wyłącznie w przypadku krzywych automatyzacji typu rampowego.

Edycja zdarzeń automatyzacji
Zdarzenia automatyzacji można edytować podobnie jak inne zdarzenia.

UWAGA
Jeśli przenosisz zdarzenie lub część na ścieżce i chcesz, aby zdarzenia automatyzacji następowały 
automatycznie, wybierz Edit > Automation Follows Events (Edycja > Automatyzacja podąża za 
zdarzeniami). Wszelkie zdarzenia automatyzacji na nowym stanowisku zostaną nadpisane.

● Możesz używać narzędzi na pasku narzędzi okna Project do edycji zdarzeń automatyzacji.
● Możesz użyć edytora zdarzeń automatyzacji do edycji wybranych zdarzeń automatyzacji na 
   krzywych automatyzacji rampy.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46
Edytor zdarzeń Automation na stronie 710

Tworzenie płynnych przejść pomiędzy zdarzeniami automatyzacji 
(krzywe automatyzacji Béziera)
Cubase obsługuje krzywe automatyzacji Béziera, które umożliwiają tworzenie płynnych przejść 
pomiędzy zdarzeniami automatyzacji. W ten sposób możesz edytować liniowe krzywe rampowe ze 
znacznie większą precyzją, elastycznością i intuicyjnością.

WARUNEK WSTĘPNY
Narzędzie Object Selection (Zaznaczanie obiektów) jest aktywne.

PROCEDURA
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1. Przesuń wskaźnik myszy na segment krzywej liniowej, który chcesz edytować. Na segmencie 
krzywej pokazany jest uchwyt.

UWAGA
Jeśli zdarzenia automatyzacji znajdują się obok siebie na linii prawie poziomej lub pionowej, lub są 
zbyt blisko siebie, uchwyt nie jest dostępny.
2. Kliknij i przeciągnij z wciśniętym przyciskiem myszy, aby zmodyfikować kształt segmentu 
krzywej.

3. Gdy będziesz zadowolony z wyniku, zwolnij przycisk myszy.

WYNIK
Tworzona jest gładka krzywa przejściowa zgodnie z wprowadzonymi zmianami.
Jeśli nie jesteś zadowolony z wyniku i chcesz zacząć od nowa od oryginalnego segmentu krzywej 
liniowej, kliknij dwukrotnie uchwyt.
Możesz używać krzywych automatyzacji Béziera ze ścieżkami podłączonymi do tłumików VCA.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby uzyskać jeszcze bardziej precyzyjną edycję, dodaj nowe zdarzenia automatyzacji do segmentu 
krzywej Béziera.

Spowoduje to utworzenie nowych segmentów, które można wygładzić.

POWIĄZANE LINKI
Ustawienia tłumika VCA na stronie 419
Automatyka tłumików VCA na stronie 423

Wybieranie zdarzeń automatyzacji
● Aby wybrać zdarzenie automatyzacji, kliknij je narzędziem Object Selection (Zaznaczanie 
   obiektów).
● Aby wybrać wiele zdarzeń, przeciągnij prostokąt zaznaczenia za pomocą narzędzia Object   
   Selection lub klawisza Shift i kliknij zdarzenia.
● Aby wybrać wiele zdarzeń, wybierz zakres za pomocą narzędzia Range Selection (Zaznaczanie 
   zakresu) lub kliknij zdarzenia z wciśniętym klawiszem Shift.
● Aby wybrać wszystkie zdarzenia automatyzacji na ścieżce automatyzacji, kliknij ścieżkę 
   automatyzacji prawym przyciskiem myszy i wybierz opcję Select All Events (Wybierz wszystkie
   zdarzenia) z menu kontekstowego.
Wybrane zdarzenia są oznaczone ciemnym kolorem
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UWAGA
Jeżeli wybierzesz kilka zdarzeń z krzywej automatyzacji rampy, dostępny stanie się edytor zdarzeń 
automatyzacji 

POWIĄZANE LINKI
Edytor zdarzeń Automation na stronie 710

Edytor zdarzeń związanych z automatyzacją
Edytor zdarzeń automatyzacji umożliwia edycję wybranych zdarzeń na ścieżce automatyzacji. 
Edytor zdarzeń automatyzacji jest dostępny tylko dla krzywych rampy automatyzacji.

UWAGA
Cała edycja w edytorze zdarzeń automatyzacji wpływa tylko na zdarzenia automatyzacji, które są 
częścią wyboru.

Aby otworzyć edytor zdarzeń automatyzacji, wykonaj jedną z następujących czynności:
● Aktywuj narzędzie Object Selection (Zaznaczanie obiektów) i przeciągnij prostokąt zaznaczenia 
    na ścieżce automatyzacji typu rampa.
● Aktywuj narzędzie Range Selection (Wybór zakresu) i wybierz zakres na ścieżce automatyzacji 
    typu rampa.
UWAGA
Jeśli pracujesz z narzędziem Range Selection (Zaznaczanie zakresu), inteligentne sterowanie 
Stretch (Rozciągnięciem) nie jest dostępne. 
Edytor zdarzeń automatyzacji zawiera następujące inteligentne elementy sterujące dla określonych 
trybów edycji:

                         
1   Tilt Left (Przechyl w lewo)
     Klikając w lewy górny róg edytora, możesz przechylić lewą część krzywej. Umożliwia to 
     przechylenie wartości zdarzeń na początku krzywej w górę lub w dół.
2   Compress Left (Kompresuj w lewo)
     Jeśli klikniesz Alt/Opt w lewym górnym rogu edytora, możesz skompresować lub rozszerzyć 
     lewą część krzywej. Umożliwia to kompresję lub rozszerzenie wartości zdarzeń na początku 
     krzywej.
3   Scale Vertically (Skaluj w pionie)
     Jeśli klikniesz na środku górnej krawędzi edytora, możesz przeskalować krzywą w pionie. 
     Umożliwia to zwiększenie lub zmniejszenie wartości zdarzeń na krzywej w procentach.
4   Move Vertically (Przesuń w pionie)
     Klikając górną granicę edytora, możesz przesunąć całą krzywą w pionie. Umożliwia to 
     zwiększenie lub zmniejszenie wartości zdarzeń na krzywej.
5   Compress Right (Kompresuj w prawo)
     Jeśli klikniesz Alt/Opt w prawym górnym rogu edytora, możesz skompresować lub rozszerzyć 
     prawą część krzywej. Umożliwia to kompresję lub rozszerzenie wartości zdarzeń na końcu 
     krzywej.
6   Tilt Right (Przechyl w prawo)
     Klikając w prawy górny róg edytora, możesz przechylić prawą część krzywej. Umożliwia to 
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     przechylenie wartości zdarzeń na końcu krzywej w górę lub w dół.
7   Scale Around Relative Center (Skala wokół względnego środka)
Kliknięcie klawiszem Alt/Opt w prawym środkowym obramowaniu edytora umożliwia skalowanie 
krzywej względem jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w poziomie wokół
środka edytora.

8   Scale Around Absolute Center (Skala wokół absolutnego środka)
     Jeśli klikniesz w prawym środkowym rogu edytora, możesz przeskalować krzywą bezwzględnie 
     do jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w poziomie wokół środka 
     edytora.
9   Stretch (Rozciągnij)
     Kliknięcie dolnej krawędzi edytora umożliwia rozciągnięcie krzywej w poziomie. Umożliwia to 
     przesuwanie wartości zdarzeń na krzywej w lewo lub w prawo.

UWAGA
Aby edytować krzywe automatyzacji na kilku ścieżkach jednocześnie, wybierz zdarzenia 
automatyzacji za pomocą narzędzia Object Selection (Zaznaczanie obiektów) lub narzędzia Range
Selection (Zaznaczanie zakresu) na odpowiednich ścieżkach automatyzacji i przytrzymaj klawisz 
Ctrl/Cmd podczas korzystania z inteligentnych elementów sterujących.

UWAGA
Jeśli wybierzesz zdarzenia automatyzacji za pomocą narzędzia Range Selection (Wybór zakresu), 
na początku i na końcu wyboru zostaną automatycznie utworzone dodatkowe zdarzenia 
automatyzacji. Dzięki temu cały wybór zostanie edytowany.

POWIĄZANE LINKI
Krzywe automatyki na stronie 705

Szybkie pionowe skalowanie zdarzeń automatyki
Możesz skalować segment krzywej pomiędzy dwoma zdarzeniami automatyzacji w pionie, bez 
konieczności wcześniejszego wybierania zdarzeń.

PROCEDURA
1. Przesuń wskaźnik myszy na górną granicę ścieżki automatyzacji powyżej segmentu liniowej 
    krzywej rampy, który chcesz skalować.
             Pokazano uchwyt.

          
2. Kliknij i przeciągnij w górę lub w dół, trzymając wciśnięty przycisk myszy.
3. Gdy będziesz zadowolony z wyniku, zwolnij przycisk myszy.

WYNIK
Segment krzywej pomiędzy dwoma zdarzeniami automatyzacji jest skalowany.

Przenoszenie zdarzeń związanych z automatyzacją

Przenoszenie pojedynczych zdarzeń automatyzacji
● Aby przenieść wybrane zdarzenie automatyzacji, kliknij je i przeciągnij w lewo lub w prawo.
● Aby ograniczyć kierunek ruchu, naciśnij klawisz Ctrl/Cmd i przeciągnij.

UWAGA
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Przyciąganie jest brane pod uwagę podczas poziomego przesuwania krzywych automatyzacji. Aby 
tymczasowo wyłączyć tę funkcję, przytrzymaj klawisz Ctrl/Cmd i dowolny inny modyfikator, a 
następnie przeciągnij.

Przenoszenie wielu zdarzeń automatyzacji
● Aby przenieść wybrane zdarzenia automatyzacji, kliknij wewnątrz prostokąta wyboru 
   i przeciągnij w lewo lub w prawo. Jeśli dokonałeś ciągłego wyboru zdarzeń automatyzacji, 
   zdarzenia w zakresie docelowym zostaną nadpisane. Jeśli jednak przesuniesz ten sam zakres 
   wyboru poza już istniejące zdarzenia, pojawią się one ponownie. Jeśli zakres wyboru zawiera 
   zdarzenia automatyzacji, które nie są zaznaczone, przeciąganie jest ograniczone. Nie możesz 
   przenieść tego wyboru poza istniejące zdarzenia.
● Aby skopiować ciągły wybór zdarzeń automatyzacji, kliknij wewnątrz prostokąta zaznaczenia, 
   przytrzymaj klawisz Alt/Opt i przeciągnij w lewo lub w prawo.

UWAGA
Jeśli podczas przeciągania prostokąta zaznaczenia naciśniesz klawisz Esc, zaznaczenie powróci do 
pierwotnej pozycji.

POWIĄZANE LINKI
Wybieranie zdarzeń automatycznych na stronie 709

Usuwanie zdarzeń automatyzacji
● Aby usunąć zdarzenie automatyzacji, kliknij je narzędziem Erase (Usuń).
● Aby usunąć wiele zdarzeń automatyzacji, zaznacz je i naciśnij Backspace lub Delete (Usuń) albo
   wybierz Edit > Delete (Edytuj > Usuń).
● Jeśli włączona jest opcja Use Virgin Territory (Użyj terytorium dziewiczego), tworzy to lukę. 
   Gdy opcja jest wyłączona, zdarzenia w zakresie są usuwane.
● Aby usunąć wszystkie zdarzenia automatyzacji ze ścieżki automatyzacji i zamknąć ścieżkę 
   automatyzacji, kliknij nazwę parametru automatyzacji na liście ścieżek i wybierz Remove 
   Parameter (Usuń parametr) z wyskakującego menu.

UWAGA
Podczas usuwania zdarzeń automatyzacji krzywa jest rysowana na nowo, aby połączyć pozostałe 
zdarzenia.

POWIĄZANE LINKI
Terytorium Dziewicze a wartość początkowa na stronie 713

Ścieżki automatyzacji
Większość ścieżek w Twoim projekcie zawiera ścieżki automatyzacji, po jednej dla każdego 
zautomatyzowanego parametru.

Aby wyświetlić ścieżki automatyzacji, musisz je otworzyć.

Pokazywanie/ukrywanie ścieżek automatyki

● Umieść wskaźnik myszy nad lewym dolnym rogiem ścieżki i kliknij ikonę strzałki (Show/Hide   
   Automation (Pokaż/Ukryj automatyzację)), która się pojawi.
● Kliknij prawym przyciskiem myszy utwór na liście utworów i wybierz opcję Show/Hide 
   Automation (Pokaż/Ukryj automatyzację) z menu kontekstowego.
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● Aby otworzyć kolejną ścieżkę automatyzacji, umieść wskaźnik myszy nad lewym dolnym rogiem
   ścieżki automatyzacji i kliknij + (Append Automation Track (Dołącz ścieżkę automatyzacji)).
● Aby wyświetlić wszystkie używane ścieżki automatyzacji na liście ścieżek, kliknij dowolną 
   ścieżkę prawym przyciskiem myszy i wybierz opcję Show All Used Automation (Pokaż całą 
   używaną automatyzację) z menu kontekstowego.

● Aby otworzyć odpowiednią ścieżkę automatyzacji w celu zapisania parametrów automatyzacji, 
wybierz Project > Automation Panel (Projekt > Panel Automatyzacji) i na stronie Settings 
(Ustawienia) aktywuj opcję Reveal Parameter on Write (Pokaż parametr przy zapisie).

Usuwanie ścieżek automatyki
● Aby usunąć ścieżkę automatyzacji wraz ze wszystkimi zdarzeniami automatyzacji, kliknij nazwę 
parametru i z wyskakującego menu wybierz Remove Parameter (Usuń parametr).
● Aby usunąć wszystkie ścieżki automatyzacji ze ścieżki niezawierającej zdarzeń automatyzacji, 
wybierz opcję Remove Unused Parameters (Usuń nieużywane parametry) z dowolnego 
wyskakującego menu z nazwami parametrów automatyzacji.
● Aby usunąć ścieżki automatyzacji, możesz także otworzyć wyskakujące menu Automation 
Functions (Funkcje automatyzacji) w Automation Panel (Panelu automatyzacji) i wybrać jedną z 
opcji usunięcia automatyzacji.

Przypisywanie parametru do ścieżki automatyki
Parametry są już przypisane do ścieżek automatyzacji w momencie ich otwarcia, zgodnie z ich 
kolejnością na liście parametrów.

PROCEDURA
1. Otwórz ścieżkę automatyzacji i kliknij nazwę parametru automatyzacji. Wyświetlona zostanie 
    lista parametrów. Treść zależy od typu ścieżki.
2. Z wyskakującego menu wybierz parametr lub wybierz opcję More (Więcej), aby otworzyć okno 
    dialogowe Add Parameter (Dodaj parametr) zawierające listę wszystkich parametrów, które 
    można zautomatyzować, i wybierz tam parametr.

WYNIK
Parametr zastępuje bieżący parametr w ścieżce automatyzacji.

UWAGA
Wymiana parametru automatyki ma charakter nieniszczący. Jeśli ścieżka automatyzacji zawiera 
jakiekolwiek dane automatyzacji dla parametru, który właśnie wymieniłeś, dane te tam są, choć nie 
są widoczne. Klikając nazwę parametru automatyzacji na liście ścieżek, możesz wrócić do 
zastąpionego parametru. W wyskakującym menu po nazwie parametru ukrytych ścieżek 
automatyzacji wyświetlana jest gwiazdka (*).

Wyciszanie ścieżek automatyki
Wyciszając ścieżkę automatyzacji, wyłączasz automatyzację dla pojedynczego parametru.

● Aby wyciszyć poszczególne ścieżki automatyzacji, kliknij Mute Automation (Wycisz 
automatyzację) na liście ścieżek.

Terytorium Dziewicze a wartość początkowa
W przypadku automatyzacji parametrów Cubase działa albo z wartością początkową, albo z 
dziewiczym terytorium.
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Gdy włączysz opcję Use Virgin Territory (Użyj terytorium dziewiczego), na ścieżce 
automatyzacji nie będzie wyświetlana żadna krzywa automatyzacji, a dane automatyzacji 
znajdziesz tylko tam, gdzie faktycznie wykonasz przejście automatyzacji. Po przejściu 
automatyzacji dziewicze terytorium znajdziesz dopiero na prawo od ostatniego zdarzenia 
automatyzacji.

Tworzenie luk
Luki to puste odcinki pomiędzy krzywymi automatyzacji. Możesz tworzyć luki w sekcji za pomocą 
automatycznych wartości.

PROCEDURA
1. Wybierz Project > Automation Panel (Projekt > Panel Automatyzacji).
2. Otwórz stronę Settings (Ustawienia) i aktywuj opcję Use Virgin Territory (Użyj terytorium 
    dziewiczego).
3. Za pomocą narzędzia Range Selection (Wybór zakresu) wybierz zakres na ścieżce automatyzacji
    z istniejącymi danymi automatyzacji i naciśnij klawisz Delete lub Backspace.

WYNIK
Tworzona jest luka i nowe zdarzenia na początku i na końcu zakresu selekcji. Oznaczają one punkt 
końcowy krzywej automatyzacji po lewej stronie i początek następnej krzywej automatyzacji po 
prawej stronie luki.

Definiowanie punktu terminatora
Można zdefiniować dowolne zdarzenie automatyzacji na krzywej automatyzacji jako punkt 
końcowy tej części krzywej. Spowoduje to automatyczne usunięcie linii pomiędzy tym zdarzeniem 
a następnym, tworząc lukę.

PROCEDURA
1. Na krzywej automatyzacji kliknij zdarzenie, które chcesz zdefiniować jako ostatni punkt, aby je 
    wybrać.
2. W wierszu informacyjnym okna projektu ustaw Terminator na Yes (Tak). Linia między tym 
    zdarzeniem a następnym zostanie usunięta i utworzona zostanie przerwa.

UWAGA
Jeśli zdefiniujesz ostatnie zdarzenie automatyzacji krzywej automatyzacji jako punkt końcowy, 
wszelkie dane automatyzacji po prawej stronie tego zdarzenia (zdefiniowane przez wartość 
początkową) zostaną usunięte.

Panel Automatyki
Automation Panel (Panel Automatyzacji) to pływające okno, które można pozostawić otwarte 
podczas pracy.

Aby otworzyć Automation Panel (Panel Automatyzacji, wykonaj jedną z poniższych czynności:

● Wybierz Project > Automation Panel (Projekt > Panel Automatyzacji).
● Na pasku narzędzi okna Project kliknij Open Automation Panel (Otwórz Panel Automatyzacji).

         
● Naciśnij klawisz F6.
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POWIĄZANE LINKI
Zakładka Operacje na stronie 715

Zakładka Operations (Operacje)
Zakładka Operations (Operacje) zawiera wszystkie funkcje potrzebne do wykonywania operacji 
automatyzacji.

             

W najwyższej sekcji dostępne są następujące opcje:
Read/Write/Suspend (Odczyt/zapis/zawieszenie)
      Aktywuj/Dezaktywuj odczyt/zapis dla wszystkich ścieżek lub zawiesza odczyt/zapis dla 
      wszystkich ścieżek.
Touch (Dotknij)
      Zapisuje dane automatyki po dotknięciu kontrolki parametru, wypisuje po zwolnieniu kontrolki,
      a następnie ustawia kontrolkę na poprzednio ustawioną wartość.
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Auto-Latch (Automatyczne zatrzaskiwanie)
      Kontynuuje zapisywanie danych automatyzacji tak długo, jak długo trwa odtwarzanie lub  
      włączony jest Write (zapis) i zachowuje ostatnią wartość po zwolnieniu przycisku.
Cross-Over (Krzyżowanie)
      Kontynuuje zapisywanie danych automatyzacji tak długo, jak długo trwa odtwarzanie lub 
      włączony jest Write (zapis) i kontynuuje z tą samą wartością po zwolnieniu przycisku. Kiedy 
      ponownie dotkniesz tłumika i przesuniesz go w kierunku oryginalnej wartości, efekt 
      wykruszania nastąpi automatycznie, gdy tylko przekroczysz pierwotną krzywą.

Trim (Przytnij)
      Umożliwia modyfikację krzywej automatyzacji z poprzedniego przejścia.
Automation Functions (Funkcje automatyzacji)
      Zapewnia dostęp do szeregu ogólnych funkcji automatyzacji.

W sekcji głównej dostępne są następujące opcje:
Fill (Wypełnij)
      Opcje te definiują, co stanie się w określonej sekcji projektu, gdy wyrzucisz działający przebieg 
      automatyzacji.
Suspend Read (Wstrzymaj czytanie)
      Wstrzymuje odczyt aktywowanego parametru podczas automatyzacji, dzięki czemu możesz 
      uzyskać nad nim pełną ręczną kontrolę.
Suspend Write (Wstrzymaj pisanie)
      Wstrzymuje zapis aktywowanego parametru podczas automatyzacji, tak że parametr ten zostaje 
      usunięty z przejścia automatyzacji.
Show (Pokaż)
      Pokazuje wszystkie ścieżki automatyzacji dla aktywowanego parametru, dzięki czemu masz 
      przegląd zautomatyzowanego parametru.

POWIĄZANE LINKI
Przyciski Read/Write/Suspend (odczytu/zapisu/zawieszenia) na stronie 716
Touch (Dotknij) na stronie 717
Auto=-Latch (Automatyczne zatrzaskiwanie) na stronie 718
Cross-Over na stronie 718
Trim (Przycięcie) na stronie 719
Menu Automation Functions (Funkcje automatyki) na stronie 720
Opcje Fill (wypełnienia) na stronie 721
Opcje Suspend (zawieszenia) na stronie 723
Opcje Show (Pokaż) na stronie 724

Przyciski Read/Write/Suspend (odczytu/zapisu/zawieszenia)
Przyciski Read (Odczyt) i Write (Zapis) w górnej części Automation Panel (Panelu 
Automatyzacji) są globalne dla wszystkich ścieżek.

● Aby otworzyć Automation Panel (Panel Automatyzacji) wybierz Project > Automation Panel.

Activate/Deactivate Read for All Tracks (Włącz/wyłącz czytanie wszystkich ściezek)
      Aktywuje/dezaktywuje wszystkie przyciski Czytaj dla wszystkich ścieżek.
Activate/Deactivate Write for All Tracks (Aktywuj/dezaktywuj zapis dla wszystkich ścieżek)
      Aktywuje/dezaktywuje wszystkie przyciski zapisu dla wszystkich ścieżek.
Suspend All Read/Write Automation (Zawieś całą automatyzację odczytu/zapisu)
      Zawiesza odczyt/zapis danych automatyki dla wszystkich parametrów/grup parametrów.  

Tryby automatyzacji
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Cubase zapewnia różne tryby wybijania dla automatyzacji: Touch (Dotknij), Auto-Latch 
(Automatyczne zatrzaskiwanie) i CrossOver (Krzyżowanie). We wszystkich trybach dane 
automatyki są zapisywane natychmiast po dotknięciu elementu sterującego parametrem w trybie 
odtwarzania. Różnią się zachowaniem podczas wybijania.

Tryby automatyzacji dostępne są w górnej części Automation Panel (Panelu Automatyzacji) oraz 
na pasku narzędzi okna Project w wyskakującym menu Global Automation Mode (Globalny tryb 
automatyzacji).

Tryb automatyzacji możesz zmienić w dowolnym momencie, na przykład w trybie odtwarzania, 
zatrzymania lub podczas obejścia automatyzacji. Możesz także przypisać polecenia klawiszowe do 
trybów automatyki.

Bieżąca przepustka automatyzacji jest zawsze wydawana, gdy spełniony zostanie jeden z 
poniższych warunków, niezależnie od wybranego trybu automatyzacji:
● Jeśli wyłączysz opcję Write (Zapis).
● Jeśli zatrzymasz odtwarzanie.
● Jeśli włączysz funkcję Fast Forward/Rewind (szybkiego przewijania do przodu/do tyłu).
● Jeśli kursor projektu osiągnie prawy lokalizator w trybie Cycle (cyklicznym).
● Kliknięcie linijki powoduje przesunięcie kursora projektu. Jest to definiowane przez użytkownika
   i można nim sterować za pomocą Automation Panel (Panelu Automatyki).

UWAGA
W trybie Auto-Latch można wykrawać za pomocą polecenia klawiszowego Punch Out of Latch 
Automation w kategorii Automation (Automatyka).

POWIĄZANE LINKI
Zakładka Settings (Ustawienia) na stronie 724

Touch (Dotknij)
Tryb Touch przydaje się w sytuacjach, gdy chcemy dokonać kilkusekundowej zmiany już 
ustawionego parametru.

● Touch zapisuje dane automatyzacji tylko tak długo, jak długo dotykasz kontrolki parametru.
Wybicie następuje natychmiast po zwolnieniu przycisku sterowania.
● Po wybiciu sterowanie powraca do wcześniej ustawionej wartości.
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UWAGA
Możesz ustawić czas potrzebny parametrowi na osiągnięcie wcześniej ustawionej wartości za 
pomocą ustawienia Return Time (Czas powrotu) na stronie Settings (Ustawienia) w Automation 
Panel (Panelu Automatyki).

POWIĄZANE LINKI
Zakładka Settings (Ustawienia) na stronie 724

Auto-Latch (Automatyczne zatrzaskiwanie)

Funkcja Auto-Latch przydaje się w sytuacjach, gdy chcesz zachować wartość przez dłuższy czas – 
na przykład podczas dokonywania ustawień korektora dla konkretnej sceny.

  
● Po rozpoczęciu przebiegu zapisywanie danych automatycznych będzie kontynuowane tak długo, 
jak długo trwa odtwarzanie lub włączona jest opcja Write (Zapis).
● Po zwolnieniu przycisku ostatnia wartość zostanie zachowana do momentu wybicia przycisku.

UWAGA
Można także wykrawać (Punch Out) za pomocą polecenia klawiszowego Punch Out of Latch 
Automation (Automatyzacja wykrawania z zatrzaskiem) w kategorii Automation (Automatyka).

Wylrawanie następuje również, jeśli spełniony jest jeden z ogólnych warunków wykrawania.
   
UWAGA
Tryb automatyzacji włączników/wyłączników to zawsze Auto-Latch, nawet jeśli globalnie lub dla 
ścieżki wybrano inny tryb.

POWIĄZANE LINKI
Tryby automatyki na stronie 716

Cross-Over (Krzyżowanie)

Tryb Cross-Over umożliwia wykonanie ręcznego powrotu w celu zapewnienia płynnego przejścia 
pomiędzy nowymi i istniejącymi ustawieniami automatyki. W przypadku Cross-Over warunek 
wybicia polega na przekroczeniu już istniejącej krzywej automatyzacji po drugim dotknięciu 
parametru. Tryb CrossOver można zastosować w sytuacjach, gdy nie jesteś zadowolony z krzywej 
automatyzacji lub z automatycznie zastosowanych ustawień powrotu.
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● Po rozpoczęciu przebiegu zapisywanie danych automatycznych będzie kontynuowane tak długo, 
    jak długo trwa odtwarzanie lub włączona jest opcja Write (Zapis).
● Po zwolnieniu przycisku przejście automatyczne będzie kontynuowane, a ustawienie wartości   
    pozostanie niezmienione.
● Kiedy ponownie dotkniesz suwaka i przesuniesz go w kierunku oryginalnej wartości, wykrój 
    nastąpi automatycznie, gdy tylko przekroczysz pierwotną krzywą.

POWIĄZANE LINKI
Zakładka Settings (Ustawienia) na stronie 724

Trim (Przytnij)
Trim umożliwia modyfikację krzywej automatyzacji z poprzedniego przejścia. Jeśli aktywujesz 
Trim, krzywa przycinania zostanie umieszczona na środku ścieżki automatyzacji.

   
UWAGA
Trim działa w przypadku regulacji głośności kanału i poziomu wysyłania cue.
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Jeśli aktywujesz Trim (Przytnij), cała edycja i nagrywanie będą miały wpływ na krzywą 
przycinania. Jeśli dezaktywujesz Trim, zamiast tego wpłynie to na oryginalną krzywą 
automatyzacji.
Możesz edytować dane przycinania, tak jak inne dane automatyzacji. Są przechowywane razem z 
projektem.
● Przeciągnij krzywą przycinania w górę lub w dół i dodaj do niej zdarzenia automatyczne.
Zwiększają one lub zmniejszają wartości oryginalnej krzywej automatyzacji, ale pozwalają 
zachować oryginalne dane.

Możesz używać Trim zarówno w trybie zatrzymania, jak i odtwarzania:
● W trybie zatrzymania możesz wybrać jedną z opcji Fill (Wypełnienia) i ręcznie edytować krzywą
    przycinania, klikając ją i przesuwając w górę lub w dół. Oryginalna krzywa automatyzacji jest  
    wyświetlana w formacie a jaśniejszy kolor i jego wartości są łączone z krzywą przycinania. 
    Powstała krzywa automatyzacji jest wyświetlana w ciemniejszym kolorze.
● W trybie odtwarzania zdarzenia z oryginalnej krzywej automatyzacji są przycinane, gdy kursor 
    projektu przesuwa się nad nimi.
UWAGA
Trim współpracuje również z krzywymi automatyzacji Béziera.

POWIĄZANE LINKI
Tworzenie płynnych przejść pomiędzy zdarzeniami automatyzacji (krzywe automatyzacji Béziera) 
na stronie 708

Freeze Trim (Zamroź przycinanie)
Możesz zamrozić krzywą przycinania automatycznie lub ręcznie. To renderuje wszystkie dane 
przycinania w jedną krzywą automatyzacji.
● Aby automatycznie zamrozić krzywą przycinania po zakończeniu operacji zapisu, otwórz stronę  
   Settings (Ustawienia) w Automation Panel (Panelu Automatyki) i wybierz opcję On Pass End  
   (Po zakończeniu przejścia) w wyskakującym menu Freeze Trim (Zamroź przycinanie)
● Aby automatycznie zamrozić krzywą przycinania, gdy tryb przycinania jest wyłączony, otwórz 
   stronę Settings (Ustawienia) w Automation Panel (Panelu automatyki) i wybierz opcję On 
   Leaving Trim Mode (Po wyjściu z trybu przycinania) w wyskakującym menu Freeze Trim 
   (Zablokuj przycinanie).
● Aby ręcznie zamrozić krzywą przycinania, otwórz stronę Settings (Ustawienia) w Automation  
   Panel (Panelu Automatyki) i wybierz opcję Manually (Ręcznie) z wyskakującego menu Freeze 
   Trim (Zamroź przycinanie). Aby zamrozić określony parametr ścieżki, kliknij nazwę parametru i 
   z menu podręcznego wybierz opcję Freeze Trim (Zablokuj przycinanie).
● Aby zamrozić automatyzację przycinania wszystkich ścieżek w projekcie, otwórz wyskakujące 
   menu Functions (Funkcje) w Automaion Panel (Panelu Automatyzacja) i wybierz opcję Freeze 
   All Trim Automation in Project (Zablokuj całą automatyzację przycinania w projekcie). Aby 
   zamrozić automatyzację przycinania wszystkich zaznaczonych ścieżek, otwórz wyskakujące 
   menu Functions w Automation Panel i wybierz opcję Freeze Trim Automation of Selected 
   Tracks (Zablokuj automatyzację przycinania wybranych ścieżek).

Menu Automation Functions (Funkcji automatyki)
Dostępnych jest wiele ogólnych funkcji automatyzacji.
● Aby otworzyć menu Automation Functions, wybierz Project > Automation Panel (Projekt > 
   Panel automatyzacji) i kliknij Automation Functions.
Delete All Automation in Project (Usuń całą automatyzację w projekcie)
      Usuwa wszystkie dane automatyzacji z projektu.
Delete Automation of Selected Tracks (Usuń automatyzację wybranych utworów)
      Usuwa wszystkie dane automatyzacji na wybranych ścieżkach.
Delete Automation in Range (Usuń automatyzację w zakresie)
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      Usuwa wszystkie dane automatyzacji pomiędzy lewym i prawym lokalizatorem na wszystkich 
      ścieżkach.
Fill Gaps on Selected Tracks (Wypełnij luki na wybranych ścieżkach)
Ta opcja jest używana w przypadku terytoriów dziewiczych. Wybierz tę opcję, aby wypełnić 
wartością ciągłą wszelkie luki w krzywych automatyzacji wybranych ścieżek. Do wypełnienia luki 
wykorzystywana jest wartość ostatniego zdarzenia (punktu końcowego) przekroju. Wartość ta jest 
zapisywana w odstępie do jednej milisekundy przed pierwszym zdarzeniem następnej sekcji 
automatycznej. W tym miejscu wstawiane jest nowe zdarzenie; wartość zostanie przeniesiona do 
następnej automatycznej sekcji.

Fill Gaps with Current Value (Selected Tracks) (Wypełnij luki bieżącą wartością (wybrane 
ścieżki))
      Ta opcja jest używana w przypadku terytoriów dziewiczych. Wybierz tę opcję, aby wypełnić 
      wszelkie luki w krzywych automatyzacji wybranych ścieżek. Luki są wypełniane bieżącą 
      wartością odpowiedniego elementu sterującego.
Freeze All Trim Automation in Project (Zamroź całą automatyzację przycinania w projekcie)
      Blokuje całą automatyzację przycinania wszystkich ścieżek w projekcie.
Freeze Trim Automation of Selected Tracks (Zamroź automatyzację przycinania wybranych 
utworów)
      Blokuje całą automatyzację przycinania wybranych ścieżek.

Fill Options (Opcje wypełnienia)
Opcje Fill (Wypełnienia) definiują, co stanie się w określonej sekcji projektu, gdy wytniesz 
uruchomiony przebieg automatyzacji.
Opcje FiIl zapisują jedną konkretną wartość w określonej sekcji ścieżki automatyzacji. Wszelkie 
wcześniej utworzone dane w tej sekcji zostaną nadpisane.
Można także łączyć różne opcje Fill.

Activating To Punch (Aktywacja Do Uderzenia)

PROCEDURA
1. Na Automation Panel (Panelu Automatyki) aktywuj Touch (Dotyk) i aktywuj opcję To Punch 
    (Do uderzenia) jako Fill (wypełnienie).
2. Rozpocznij odtwarzanie.
3. Poruszaj suwakiem, aż znajdziesz żądane ustawienie głośności, a następnie zwolnij tłumik, aby 
    wyzwolić dźwięk.
    Krzywa głośności jest ustawiana od punktu uderzenia z powrotem do miejsca uderzenia. 
    Wartości zapisane podczas przesuwania tłumika w celu znalezienia właściwej wartości są 
    usuwane, a głośność przeskakuje dokładnie w odpowiednim momencie od wartości ustawionej w
    pierwszej scenie do wartości znalezionej dla drugiej sceny.

Activating To Start (Aktywacja Do Początku)

PROCEDURA
1. Na Automation Panel aktywuj Touch i aktywuj opcję To Start (Rozpocznij) jako Fill.
2. Rozpocznij odtwarzanie.
3. Poruszaj suwakiem, aż znajdziesz żądane ustawienie głośności, a następnie zwolnij tłumik, aby  
    wyzwolić dźwięk.
    Ścieżka automatyzacji jest wypełniona od miejsca, w którym wybiłeś, do początku projektu.

Activating To End (Aktywacja Do Końca)

PROCEDURA
1. Na Automation Panel aktywuj Touch i aktywuj opcję To End (Do Końca) jako Fill.
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2. Rozpocznij odtwarzanie i dotknij przycisku parametru, aby wprowadzić przejście automatyczne.
3. Poruszaj suwakiem, aż znajdziesz żądane ustawienie, a następnie zwolnij go.
    Spowoduje to przerwanie zapisu danych automatyki. Gdy puścisz tłumik, krzywa automatyzacji 
    przyjmuje ustaloną wartość, od której przebiłeś, aż do końca projektu.

Activating Loop (Aktywacja pętli)

WARUNEK WSTĘPNY
Skonfigurowałeś zakres pętli z lewym i prawym lokalizatorem.

PROCEDURA
1. Na Automation Panel (Panelu Automatyki) aktywuj Touch (Dotyk) i aktywuj opcję Loop  
    (Zapętl) jako Fill (wypełnienie).
2. Rozpocznij odtwarzanie.
3. Poruszaj suwakiem, aż znajdziesz żądane ustawienie głośności, a następnie zwolnij tłumik, aby    
    wyzwolić dźwięk.
    Znaleziona wartość jest ustawiana w zakresie określonym przez lewy i prawy lokalizator.

Activating Gaps (Aktywacja Luk)

WARUNEK WSTĘPNY
Ustanowiłeś dziewicze terytoria.

NOTATKA
Gdy Trim (UtnIj) jest aktywne, Gap (Luka) nie da żadnego efektu. Dzieje się tak, ponieważ Trim 
modyfikuje tylko już istniejące dane.

PROCEDURA
1. Na Automation Panel aktywuj Touch i aktywuj opcję Gaps (Luki) jako Fill.
2. Rozpocznij odtwarzanie.
3. Poruszaj suwakiem, aż znajdziesz żądane ustawienie głośności, a następnie zwolnij tłumik, aby  
    wyzwolić dźwięk.
    Wszelkie luki pomiędzy wcześniej zapisanymi zdarzeniami automatyzacji są wypełniane ostatnią
    wartością znalezioną podczas ostatniego przebiegu automatyzacji.

POWIĄZANE LINKI
Virgin Territory (Terytorium Dziewicze) a Initial Value (wartość początkowa) na stronie 713

One Shot vs Continuous Fill (Jeden strzał kontra ciągłe napełnianie)

Opcji Fill (Wypełnienie) można używać na różne sposoby:
● One Shot (Jeden strzał)
    Po kliknięciu jednego z przycisków Fill (Wypełnij) zostanie on podświetlony i zostanie włączony
    podczas następnego przebiegu automatyzacji. Następnie opcja jest ponownie wyłączana.
● Continuous fill (Ciągłe wypełnianie)
Jeśli klikniesz przycisk Fill po raz drugi, na podświetlonym przycisku wyświetli się symbol kłódki, 
wskazując, że znajdujesz się w trybie ciągłego wypełniania i że operację można powtarzać dowolną
liczbę razy. Kliknij przycisk trzeci raz, aby wyłączyć odpowiednią opcję Fill (Wypełniania).
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Drawing Fill Manually (Rysowanie wypełnienia ręcznie)
Opcji Fill w Automation Panel można używać w połączeniu z narzędziem Draw (Rysuj). 
Zapewnia to skuteczną metodę ręcznego zapisywania danych automatyzacji.

PROCEDURA
1. Otwórz ścieżkę automatyzacji i wybierz narzędzie Draw (Rysuj).
2. W Automation Panel (Panelu Automatyka) wybierz opcję To End (Do zakończenia) jako Fill  
    (Wypełnienie)

3. Kliknij i narysuj, aby utworzyć krzywą automatyzacji.
4. Zwolnij przycisk myszy.
W momencie wydania tworzone jest końcowe zdarzenie automatyzacji. Krzywa automatyzacji jest 
zapisywana od tego ostatniego zdarzenia aż do końca projektu.

UWAGA
Procedurę tę można zastosować ze wszystkimi opcjami Fill (Wypełnienie).

Opcje Suspend (Zatrzymania)

Ta sekcja Automation Panel (Panelu Automatyki) umożliwia wykluczenie określonych 
parametrów z odczytu lub zapisu danych automatyki. Dzięki temu masz pełną ręczną kontrolę nad 
tymi parametrami.

Suspend Read (Wstrzymaj czytanie)
Zawieszenie odczytu konkretnego parametru w trakcie automatyzacji daje pełną, ręczną kontrolę 
nad nim.

● Aby zawiesić odczyt danych automatyki dla konkretnego parametru, kliknij odpowiedni 
   parametr.
● Aby zawiesić odczyt danych automatyki dla wszystkich parametrów/grup parametrów, kliknij Set
   All (Ustaw wszystko).

UWAGA
Gdy włączona jest dowolna opcja w kategorii Suspend Read (Wstrzymaj odczyt), kliknięcie opcji 
Set All powoduje wyłączenie wszystkich przycisków.

PRZYKŁAD
Wyobraź sobie, że zautomatyzowałeś już kilka ścieżek. Pracując nad bieżącą ścieżką, chcesz, aby 
jedna z pozostałych ścieżek była głośniejsza, aby lepiej identyfikować konkretną pozycję w 
materiale audio.
Zawieszając Odczyt dla parametru głośności, odzyskujesz pełną kontrolę ręczną i możesz ustawić 
głośność na wymaganym poziomie.

Suspend Write (Wstrzymaj zapis)
Wstrzymanie zapisu określonego parametru podczas automatyzacji powoduje wyrzucenie tego 
parametru z przebiegu automatyzacji.

● Aby wstrzymać zapis danych automatyki dla konkretnego parametru, kliknij odpowiedni 
   parametr.
● Aby zawiesić zapis danych automatyki dla wszystkich parametrów/grup parametrów, kliknij Set 
   All (Ustaw wszystko).

UWAGA
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Jeśli dowolna opcja w kategorii Suspend Write jest włączona, kliknięcie opcji Set All powoduje 
wyłączenie wszystkich przycisków.

PRZYKŁAD
Wyobraź sobie następującą sytuację: Aby pomóc Ci skoncentrować się podczas pracy nad 
konkretną ścieżką, wyciszasz kilka innych ścieżek. Jednakże, ponieważ na tych ścieżkach aktywna 
jest automatyzacja zapisu, ten stan wyciszenia jest również automatyczny podczas następnego 
przebiegu automatyzacji – klasyczna sytuacja w miksowaniu.
Aby uniknąć przypadkowego wykluczenia w ten sposób całych ścieżek z miksu, możesz wyłączyć 
opcję Mute (Wyciszenie) ze wszystkich zapisów automatycznych, klikając opcję Mute (Wycisz) 
w kategorii Suspend Write (Wstrzymaj zapis) w Automation Panel (panelu Automatyka).

Show Options (Pokaż Opcje)
Opcje Show (Pokaż) umożliwiają otwarcie wszystkich ścieżek automatyzacji dla określonego 
parametru. Daje to przegląd zautomatyzowanego parametru.

● Aby otworzyć głośność, panoramę, korektor, wysyłanie lub wstawianie ścieżek automatyzacji dla
wszystkich ścieżek, kliknij odpowiedni parametr. 
Ścieżki automatyzacji są otwierane nawet jeśli nie zostały na nich zapisane żadne dane 
automatyzacji.
● Aby przeglądać poszczególne zestawy parametrów grup parametrów, na przykład panoramę, 
korektor, wysyłki i wstawki, kliknij kilkakrotnie odpowiedni przycisk.
● Aby wyświetlić tylko ścieżki automatyzacji, dla których zapisano już dane automatyzacji, 
aktywuj opcję Used Only (Tylko używane) i kliknij jedną z opcji.
● Aby wyświetlić wszystkie ścieżki automatyzacji zawierające dane automatyzacji, aktywuj opcję 
Show Used (Pokaż używane).
● Aby ukryć wszystkie otwarte ścieżki automatyzacji, aktywuj Hide All (Ukryj wszystko).

UWAGA
Opcje Show (Pokaż) w Automation Panel (Panelu Automatyka) wpływają na wszystkie ścieżki.

Zakładka Settings (Ustawienia)
Możesz wprowadzić ogólne ustawienia automatyzacji dla swojego projektu.

● Aby otworzyć ustawienia automatyzacji, wybierz Project > Automation Panel (Projekt > Panel 
Automatyzacji) i otwórz stronę Settings (Ustawienia).

Show Data on Tracks (Pokaż dane na ścieżkach)
     Aktywuj to, aby wyświetlać przebiegi audio lub zdarzenia MIDI na ścieżkach automatyzacji
     Zdarzenia są wyświetlane tylko wtedy, gdy w oknie dialogowym Preferences (Preferencje) 
    włączona jest opcja Show Waveforms (Pokaż przebiegi) (Event Display (Wyświetlanie 
    zdarzeń) — strona Audio) i jeśli Part Data Mode (Tryb danych partii) jest ustawiony na opcję 
    inną niż No Data (Brak danych), Event Display (Wyświetlanie zdarzeń) — strona MIDI.
Use Virgin Territory (Użyj Dziewiczego Terytorium)
     Aktywuj tę opcję, jeśli chcesz korzystać z dziewiczych terytoriów.
Continue Writing on Transport Jump (Kontynuuj pisanie na temat Transport Jump)
     Jeżeli aktywujesz tę opcję, zapis automatyki nie zostanie zablokowany podczas lokalizacji na 
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     nową pozycję. Można tego używać do wykonywania wielu przejść automatyzacji w trybie 
     cyklicznym lub jeśli używasz funkcji aranżera.
     Jeśli ta opcja jest wyłączona i zapiszesz dane automatyki i zlokalizujesz je w innym miejscu w 
     projekcie, zapis zostanie zatrzymany do momentu zwolnienia przycisku myszy lub otrzymania 
     polecenia stop.
Reveal Parameter on Write (Ujawnij parametr przy zapisie)
     Jeśli aktywujesz tę opcję, po zapisaniu parametrów automatyzacji wyświetli się odpowiednia 
     ścieżka automatyzacji. Jest to przydatne, jeśli chcesz mieć wizualną kontrolę wszystkich 
     parametrów zmienianych podczas zapisu.

Return Time (Czas powrotu)
     Określa, jak szybko zautomatyzowany parametr powraca do dowolnej wcześniej 
     zautomatyzowanej wartości po zwolnieniu przycisku myszy. Ustaw tę wartość na wartość    
     wyższą niż 0, aby zapobiec nagłym skokom ustawień parametrów, które mogą prowadzić do 
     trzasków.
Reduction Level (Poziom redukcji)
     Wybicie (punch out) usuwa wszystkie zbędne zdarzenia automatyzacji. W rezultacie powstaje 
     krzywa automatyzacji, która zawiera tylko zdarzenia niezbędne do odtworzenia Twoich działań. 
     Wartość poziomu redukcji 0 % usuwa tylko powtarzające się punkty automatyzacji. Wartość 
     poziomu redukcji od 1 do 100 % wygładza krzywą automatyzacji. Domyślna wartość 50 % 
     powinna znacznie zmniejszyć ilość danych automatyzacji bez wpływu na dźwiękowy wynik 
     istniejącej automatyzacji.
Spike Detection Range (Zasięg wykrywania skoków)
     Określa okres czasu, w którym nagłe zmiany automatycznego parametru są uznawane za 
     niepożądane skoki. Można ustawić wartości od 0 do 200 ms.
Freeze Trim (Zamroź przycinanie)
     W tym wyskakującym menu możesz określić sposób zamrożenia krzywej przycinania.
● Manually (Ręcznie)
     Ręczne blokowanie krzywej przycinania.
● On Pass End (Na końcu przejścia)
     Zatrzymuje się po zakończeniu operacji zapisu.
● On Leaving Trim Mode (Po wyjściu z trybu przycinania)
     Zamraża dane przycinania automatycznie, gdy tryb przycinania jest wyłączony (globalnie lub 
     indywidualnie dla ścieżki).

POWIĄZANE LINKI
Terytorium Dziewicze a wartość początkowa na stronie 713
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VST Instruments (Instrumenty VST)

Instrumenty VST to syntezatory programowe lub inne źródła dźwięku zawarte w Cubase. Są one 
odtwarzane wewnętrznie poprzez MIDI. Do instrumentów VST można dodawać efekty lub 
korektor.

Cubase umożliwia wykorzystanie instrumentów VST w następujący sposób:
●   Dodając instrument VST i przypisując do niego jedną lub kilka ścieżek MIDI.
●   Tworząc ścieżkę instrumentu.
     Jest to połączenie instrumentu VST, kanału instrumentu i ścieżki MIDI. Odtwarzasz i nagrywasz
     dane nutowe MIDI bezpośrednio dla tej ścieżki.

UWAGA
Niektóre instrumenty VST są dołączone do Cubase. Zostały one opisane w oddzielnym dokumencie
Plug-in Reference (Informacje o wtyczkach).

POWIĄZANE LINKI
Ścieżki instrumentów na stronie 125.

Dodawanie instrumentów VST

PROCEDURA
1. W menu Studio wybierz VST Instruments (Instrumenty VST).
2. Kliknij prawym przyciskiem myszy pusty obszar okna VST Instruments.
3. Z menu kontekstowego wybierz opcję Add Rack Instrument (Dodaj instrument w stojaku).
4. Z selektora instrumentów wybierz instrument.
5. Kliknij Create (Utwórz).

WYNIK
Otworzy się panel sterowania instrumentem, a do listy utworów zostaną dodane następujące 
ścieżki:
● Ścieżka MIDI z nazwą instrumentu. Sygnał wyjściowy ścieżki MIDI jest kierowany do 
   instrumentu.

UWAGA
W oknie dialogowym Preferences (Preferencje) (strona VST—Plug-ins (VST — wtyczki)) możesz
określić, co się stanie, gdy załadujesz VST Instrument.

● Folder z nazwą instrumentu dodany do folderu VST Instruments. Folder instrumentów zawiera  
   dwie ścieżki automatyzacji: jedną dla parametrów wtyczek i jedną dla kanału syntezatora w  
   MixConsole

734



Panel VST Instrument Control (Panel sterowania instrumentu VST)

Panel sterowania instrumentu VST pozwala na ustawienie parametrów wybranego instrumentu.
Zawartość, wygląd i układ panelu sterowania zależą od wybranego instrumentu.

Dostępne są następujące elementy sterujące:

   

1 Activate Instrument (Aktywuj instrument)
   Aktywuje/dezaktywuje instrument.
2 Read Automation/Write Automation (Odczyt automatyzacji/zapis automatyzacji)
   Umożliwia automatyczny odczyt/zapis ustawień parametrów instrumentu.
3 Switch between A/B Settings (Przełączaj pomiędzy ustawieniami A/B)
   Przełącza na ustawienie B, gdy ustawienie A jest aktywne, i na ustawienie A, gdy ustawienie B 
   jest aktywne.
4 Apply current settings to A and B (Zastosuj bieżące ustawienia do A i B)
   Kopiuje parametry instrumentu z ustawienia instrumentu A do ustawienia instrumentu B i 
   odwrotnie.
5 Activate/Deactivate Side-Chaining (Włącz/wyłącz łączenie boczne)
   Aktywuje funkcję side-chain dla instrumentów VST 3 obsługujących side-chaining.
6 Set up Side-Chain Routing (Skonfiguruj routing boczny)
   Umożliwia skonfigurowanie routingu bocznego dla wybranej wtyczki.
7 Event Received Indicator (Wskaźnik odebrania zdarzenia)
   Zapala się po otrzymaniu notatki i komunikatów kontrolera.
8 Preset Browser (Wstępnie ustawiona przeglądarka)
   Otwiera przeglądarkę ustawień wstępnych, w której można wybrać inne ustawienie wstępne.
9 Load previous Program/Load next Program (Załaduj poprzedni program/Załaduj następny 
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   program)
   Ładuje poprzedni/następny program we wstępnie ustawionej przeglądarce.
10 Preset Management (Zarządzanie ustawieniami wstępnymi)
     Otwiera wyskakujące menu, które umożliwia zapisanie, zmianę nazwy lub usunięcie ustawienia 

     wstępnego.
11 Add VST Plug-in Picture to Media Rack (Dodaj obraz wtyczki VST do stojaka na nośniki)
     Dodaje obraz wtyczki VST do stojaka Media. Opcja ta jest dostępna tylko dla wtyczek innych 
     dostawców.

12 VST Instrument context menu (Menu kontekstowe instrumentu VST)
     Otwiera menu kontekstowe z określonymi funkcjami i ustawieniami.

POWIĄZANE LINKI
Dodawanie zdjęć instrumentów VST do stojaka na media na stronie 639
Menu kontekstowe instrumentu VST na stronie 732
Ukrywanie/pokazywanie paneli sterowania instrumentu VST na stronie 728
Łańcuch boczny dla instrumentów VST na stronie 741

Ukrywanie/pokazywanie paneli sterowania instrumentem VST
Po dodaniu instrumentu VST odpowiedni panel sterowania wtykowy otworzy się automatycznie. 
Panele sterowania można ukryć. Jest to przydatne, aby uzyskać lepszy przegląd, jeśli do projektu 
dodano wiele wtyczek, których panele sterowania zaśmiecają ekran.

PROCEDURA
● Wybierz opcję Window > Hide Plug-in Windows (Okno > Ukryj wtyczkę Windows).
UWAGA
Spowoduje to również ukrycie paneli sterowania efektem VST.

WYNIK
Okna wtyczek są ukryte i przesyłane na tył aplikacji. Aby wyświetlić je ponownie, wybierz opcję 
Show Plug-in Windows (Pokaż wtyczkę Windows).

POWIĄZANE LINKI
Panel sterowania instrumentu VST na stronie 726

Zamykanie wszystkich paneli sterowania
Po dodaniu instrumentu VST odpowiedni panel sterowania wtykowy otworzy się automatycznie. 
Możesz zamknąć wszystkie panele sterowania na raz.

PROCEDURA
● Wybierz opcję Window > Close All Plug-in Windows (Okno > Zamknij wszystkie okna 
   dodatków).
UWAGA
Spowoduje to również zamknięcie paneli sterowania efektem VST.

WYNIK
Panele sterujące są zamknięte.

POWIĄZANE LINKI
Panel sterowania Instrumentu VST na stronie 726
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Selektor instrumentów VST
Selektor instrumentów VST umożliwia wybór instrumentów VST z aktywnej kolekcji.

Aby otworzyć selektor instrumentów VST, wykonaj jedną z następujących czynności:

● Wybierz Studio > VST Instruments (Studio > Instrumenty VST) i kliknij Add Rack 
   Instrument (Dodaj instrument do stojaka).
● Wybierz Studio > VST Instruments, kliknij Add Track Instrument (Dodaj ścieżkę  
   instrumentu) i otwórz wyskakujące menu Instrument.

Dostępne są następujące elementy sterujące:

                  

1 Expand Tree/Collapse Tree (Rozwiń drzewo/Zwiń drzewo)
   Rozwija/zwija drzewo.
2 Search VST Instrument (Wyszukaj instrument VST)
   Umożliwia wyszukiwanie instrumentów VST poprzez wpisanie nazwy lub części nazwy lub 
   kategorii.
3 Plug-in Collections and Options (Kolekcje i opcje wtyczek)
   Umożliwia wybranie kolekcji.
   Jeśli wybierzesz kolekcję Default (Domyślna), dostępne staną się opcje Sort By Category 
   (Sortuj według kategorii) i Sort by Vendor (Sortuj według dostawcy). Umożliwiają one 
   sortowanie kolekcji domyślnej.

Tworzenie ścieżek instrumentów
Można tworzyć ścieżki instrumentów zawierające dedykowane instrumenty VST.

PROCEDURA
1. W obszarze globalnego sterowania utworami na liście ścieżek kliknij opcję Add Track (Dodaj  
    Ścieżkę) .
2. Kliknij Instrument.
3. Otwórz menu podręczne Instrument i wybierz VST Instrument.
4. Kliknij opcję Add Track.

WYNIK
Wybrany instrument VST zostanie załadowany na ścieżkę instrumentu. W MixConsole dodany 
zostanie kanał instrumentu.

Instrumenty VST w prawej strefie

VST Instruments (Instrumenty VST) w prawej strefie okna Project umożliwiają dodawanie 
instrumentów VST do ścieżek MIDI i instrumentów.
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Pokazane zostaną wszystkie instrumenty użyte w Twoim projekcie. Dla każdego dodanego 
instrumentu można uzyskać dostęp do maksymalnie 8 szybkich elementów sterujących.

Aby otworzyć VST Instruments w prawej strefie, kliknij opcję Show/Hide Right Zone 
(Pokaż/ukryj prawą strefę) na pasku narzędzi okna Project, a następnie na górze prawej strefy 
kliknij zakładkę VSTi.

                 

UWAGA
VST Instruments (Instrumenty VST) w prawej strefie to kolejna reprezentacja okna VST 
Instruments. Wszystkie funkcje są takie same.

POWIĄZANE LINKI
Pokazywanie/ukrywanie stref na stronie 45
Pasek narzędzi okna Project na stronie 46

Okno VST Instruments (Instrumenty VST)
Okno VST Instruments umożliwia dodawanie instrumentów VST do ścieżek MIDI i scieżek 
instrumentów.
Pokazane zostaną wszystkie instrumenty użyte w Twoim projekcie. Dla każdego dodanego 
instrumentu można uzyskać dostęp do maksymalnie 8 szybkich elementów sterujących.

Aby otworzyć okno VST Instruments, wybierz Studio > VST Instruments (Studio > Instrumenty
VST).
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POWIĄZANE LINKI
Ścieżki instrumentów na stronie 125

Pasek narzędzi okna VST Instruments (instrumentów VST)
Pasek narzędzi okna VST Instruments (Instrumenty VST) zawiera elementy sterujące, które 
umożliwiają dodawanie i konfigurowanie instrumentów VST oraz szybkich kontrolek VST.
Add Track Instrument (Dodaj ścieżkę instrument)  

         
       Otwiera okno dialogowe Add Track (Dodaj ścieżkę), które pozwala wybrać instrument i dodać
       ścieżkę instrumentu powiązaną z tym instrumentem

Find Instruments (Znajdź instrumenty)

        
       Otwiera selektor pozwalający znaleźć załadowany instrument.
Set Remote-Control Focus for VST Quick Controls to Previous Instrument (Ustaw ostrość 
zdalnego sterowania dla szybkich kontrolek VST na poprzedni instrument)

        
       Umożliwia zdalne ustawienie ostrości na poprzedni instrument.
Set Remote-Control Focus for VST Quick Controls to Next Instrument (Ustaw ostrość 
zdalnego sterowania dla szybkich kontroli VST na Następny instrument)

        
       Umożliwia zdalne ustawienie ostrości na następny instrument.
Show/Hide all VST Quick Controls (Pokaż/ukryj wszystkie szybkie kontrolki VST)

        
       Pokazuje/ukrywa domyślne szybkie kontrolki dla wszystkich załadowanych instrumentów.
Settings (Ustawienia)

        
       Otwiera wyskakujące menu Settings, w którym można włączyć/wyłączyć następujące tryby:
● Show VST Quick Controls for One Slot Only (Pokaż szybkie kontrolki VST tylko dla jednego 
gniazda) pokazuje VST Quick Controls (Szybkie kontrolki VST) wyłącznie dla wybranego 
instrumentu.
● MIDI Channel follows track selection (Kanał MIDI podąża za wyborem ścieżki), co 
gwarantuje, że selektor Channel (kanału) podąża za wyborem ścieżki MIDI w oknie Project. Użyj 
tego trybu, jeśli pracujesz z instrumentami wielobrzmieniowymi.
● Remote-Control Focus for VST Quick Controls follows track selection (Funkcja zdalnego 
sterowania funkcji VST Quick Control podąża za wyborem ścieżki), co gwarantuje, że funkcja 
zdalnego sterowania funkcji VST Quick Controls podąża za wyborem ścieżki.

Sterowanie instrumentem VST
Elementy sterujące instrumentu VST umożliwiają dokonywanie ustawień dla załadowanego 
instrumentu VST.

W każdym instrumencie dostępne są następujące elementy sterujące:

             
1 Activate Instrument (Aktywuj instrument)
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      Aktywuje/dezaktywuje instrument.
2 Edit Instrument (Edytuj instrument)
      Otwiera tablicę przyrządów.
3 Freeze Instrument (Zamroź instrument)
      Zamraża instrument. Pozwala to zaoszczędzić energię procesora.
4 Instrument selector (Selektor instrumentów)
     Umożliwia wybór innego instrumentu. Kliknij dwukrotnie, aby zmienić nazwę instrumentu. 
     Nazwa jest wyświetlana w oknie w wyskakującym menu Output Routing dla ścieżek MIDI. Jest 
     to przydatne podczas pracy z kilkoma instancjami tego samego instrumentu.
5 Preset Browser (Wstępnie ustawiona przeglądarka)
     Umożliwia załadowanie lub zapisanie presetu instrumentu.

6 Input Options (Opcje wprowadzania)
      Zapala się, gdy instrument odbiera dane MIDI. Kliknij ten przycisk, aby otworzyć menu 
      podręczne, które umożliwia wybór, wyciszenie/wyłączenie wyciszenia oraz solo/włączenie solo
      dla ścieżek wysyłających MIDI do instrumentu (wejścia).
UWAGA
Jeśli zmienisz rozmiar okna VST Instruments (Instrumenty VST), będziesz mieć dostęp do tej 
opcji za pomocą wyskakującego menu Input/Output Options (Opcje wejścia/wyjścia).

7 Activate Outputs (Aktywuj wyjścia)
      To sterowanie jest dostępne tylko wtedy, gdy przyrząd zapewnia więcej niż jedno wyjście.  
      Umożliwia aktywację jednego lub większej liczby wyjść dla instrumentu.
UWAGA
Jeśli zmienisz rozmiar okna VST Instruments, będziesz mieć dostęp do tej opcji za pomocą 
wyskakującego menu Input/Output Options (Opcje wejścia/wyjścia).

8 Read Automation/Write Automation (Odczyt automatyzacji/zapis automatyzacji)
      Umożliwia automatyczny odczyt/zapis ustawień parametrów instrumentu.
9 Select Quick Control Layer (Wybierz warstwę szybkiej kontroli)
      Umożliwia wybór programu.

POWIĄZANE LINKI
Zamrażanie instrumentów na stronie 736

Menu kontekstowe instrumentu VST
Menu kontekstowe panelu sterowania instrumentu VST i menu Functions (Funkcje) na panelu 
sterowania instrumentu VST pokazują funkcje i ustawienia specyficzne dla instrumentu.

Wykonaj jedną z następujących czynności:

● Kliknij prawym przyciskiem myszy pusty obszar panelu sterowania instrumentu VST.
● Otwórz wyskakujące menu Functions (Funkcje) na panelu sterowania instrumentu VST.

Dostępne są następujące funkcje:

Copy <VST instrument name> Setting/Paste <VST instrument name> Setting (Skopiuj 
ustawienie <nazwa instrumentu VST>/wklej ustawienie <nazwa instrumentu VST>)
      Umożliwia skopiowanie ustawień instrumentu i wklejenie ich do innego instrumentu.
Load Preset/Save Preset (Załaduj ustawienie wstępne/zapisz ustawienie wstępne)
      Umożliwia załadowanie/zapisanie ustawienia wstępnego.
Default Preset (Domyślne ustawienie wstępne)
      Umożliwia zdefiniowanie i zapisanie domyślnego ustawienia wstępnego.
Switch to A Setting/Switch to B Setting (Przełącz na ustawienie A/Przełącz na ustawienie B)
      Przełącza na ustawienie B, gdy ustawienie A jest aktywne, i na ustawienie A, gdy ustawienie B 
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      jest aktywne.
Apply Current Settings to A/Apply Current Settings to B (Zastosuj bieżące ustawienia do A  
/Zastosuj bieżące ustawienia do B)
      Kopiuje parametry instrumentu z ustawienia instrumentu A do ustawienia instrumentu B i 
      odwrotnie.
Activate Outputs (Aktywuj wyjścia)
      Umożliwia aktywację jednego lub większej liczby wyjść instrumentu.
Activate/Deactivate Side-Chaining (Aktywuj/dezaktywuj łączenie boczne)
      Aktywuje/dezaktywuje łączenie boczne dla instrumentu.
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UWAGA
Ta opcja jest dostępna tylko dla instrumentów VST 3 obsługujących side-chaining.

Remote Control Editor (Edytor zdalnego sterowania)
      Otwiera Edytor zdalnego sterowania.
Switch to Generic Editor (Przejdź do edytora ogólnego)
      Otwiera ogólny edytor instrumentu.
Allow Window to be Resized (Zezwalaj na zmianę rozmiaru okna)
      Umożliwia dynamiczną zmianę rozmiaru okien wtyczek innych firm w Cubase. Jest to  
      przydatne, jeśli w oknie dialogowym Preferences (Preferencje) (strona General (Ogólne)) 
      aktywowałeś opcję Enable HiDPI (Włącz HiDPI) (tylko Windows), a wtyczka nie obsługuje 
      ustawień rozdzielczości.

UWAGA
Zezwalaj na zmianę rozmiaru okna to ustawienie specyficzne dla wtyczki. Musisz ją 
włączyć/wyłączyć dla każdej wtyczki, która tego wymaga.

POWIĄZANE LINKI
General (Ogólne) na stronie 1169
Side-chaining (Łańcuch boczny) dla instrumentów VST na stronie 741

Presety dla instrumentów
Możesz ładować i zapisywać presety dla instrumentów. Zawierają one wszystkie ustawienia 
wymagane do uzyskania pożądanego dźwięku.

Dostępne są następujące ustawienia wstępne dla instrumentów:
● VST Presets (Ustawienia wstępne VST)
   Presety VST obejmują ustawienia parametrów instrumentu VST. Są one dostępne z okna VST  
   Instruments (Instrumenty VST), z paneli kontrolnych przyrządów, oraz z pola Programs 
   (Programy) w Inspector (Inspektorze).
● Track Presets (Ustawienia wstępne ścieżki)
   Zaprogramowane ścieżki obejmują ustawienia ścieżek instrumentu i ustawienia odpowiedniego 
   instrumentu VST.
   Są one dostępne w Inspector lub menu kontekstowym listy ścieżek.

Ładowanie ustawień wstępnych VST
Możesz załadować VST Presets (presety VST) z okna VST Instruments, z panelu sterowania lub 
z Inspector (Inspektora).

PROCEDURA
1. Wykonaj jedną z następujących czynności:
● Wybierz ścieżkę zawierającą instrument VST i w Inspector kliknij pole Programs (Programy).
● W oknie VST Instruments kliknij Preset Browser (Przeglądarka presetów) dla instrumentu 
   i wybierz Load Preset (Załaduj preset).
● W panelu sterowania instrumentu VST kliknij Preset Browser i wybierz opcję Load Preset.

2. W przeglądarce presetów wybierz preset z listy i kliknij go dwukrotnie, aby go załadować

WYNIK
Ustawienie wstępne zostało zastosowane. Aby powrócić do poprzednio załadowanego ustawienia 
wstępnego, otwórz ponownie przeglądarkę ustawień wstępnych i kliknij opcję Revert to Last 
Setting (Przywróć ostatnie ustawienie).
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Zapisywanie ustawień VST
Możesz zapisać swoje ustawienia instrumentów VST jako presety VST do dalszego wykorzystania.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
      ● W oknie VST Instruments kliknij Preset Browser dla instrumentu i wybierz Save Preset  
          (Zapisz Preset).
      ● W panelu sterowania instrumentu VST kliknij Preset Browser i wybierz Save Preset.
2. W oknie dialogowym Save <nazwa instrumentu VST> Preset wprowadź nazwę presetu.
3. Opcjonalnie: Kliknij opcję Show Attribute Inspector (Pokaż inspektora atrybutów) i zdefiniuj 
    atrybuty ustawienia wstępnego.
4. Kliknij OK, aby zapisać ustawienie wstępne i zamknąć okno dialogowe.

Ładowanie wstępnych ustawień ścieżek
Możesz załadować gotowe ustawienia ścieżek instrumentów z poziomu Inspektora

PROCEDURA
1. Wykonaj jedną z następujących czynności:
      ● Wybierz ścieżkę instrumentu i w Inspektorze kliknij pole Load Track Preset (Załaduj 
         ustawienie wstępne ścieżki).
      ● Kliknij prawym przyciskiem myszy ścieżkę instrumentu i z menu kontekstowego wybierz 
         opcję Load Track Preset.
2. W przeglądarce presetów wybierz preset z listy i kliknij go dwukrotnie, aby go załadować.

WYNIK
Zastosowano wstępnie ustawiony utwór. Aby powrócić do poprzednio załadowanego ustawienia 
wstępnego, otwórz ponownie przeglądarkę ustawień wstępnych i kliknij opcję Revert to Last 
Setting (Przywróć ostatnie ustawienie).

Przeglądarka wyników ustawień wstępnych instrumentu

Przeglądarka Results (Wyników) dla presetów ścieżek instrumentów umożliwia podgląd presetów 
VST i zastosowanie ich do ścieżki instrumentu.

● Aby otworzyć przeglądarkę wyników Results, kliknij prawym przyciskiem myszy ścieżkę 
   instrumentu i wybierz opcję Load Track Preset (Załaduj ustawienie wstępne ścieżki).
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Presety VST dla instrumentów można podzielić na następujące grupy:

Presets (Ustawienia wstępne)
Presety zawierają ustawienia całej wtyczki. W przypadku instrumentów wielobrzmieniowych 
obejmuje to ustawienia wszystkich brzmień, a także ustawienia globalne.
Programs (Programy)
Programy zawierają ustawienia tylko dla jednego programu. W przypadku instrumentów 
wielobrzmieniowych obejmuje to tylko ustawienia dla jednego gniazda dźwiękowego.

Zapisywanie ustawień wstępnych ścieżek
Możesz zapisać swoje ustawienia ścieżek instrumentów jako presety ścieżek do dalszego 
wykorzystania.

PROCEDURA
1. Kliknij prawym przyciskiem myszy ścieżkę instrumentu i z menu kontekstowego wybierz Save 
Track Preset (Zapisz ustawienie wstępne ścieżki).
2. W oknie dialogowym Save Track Preset wprowadź nazwę ustawienia wstępnego.
3. Opcjonalnie: Kliknij opcję Show Attribute Inspector (Pokaż inspektora atrybutów) i zdefiniuj 
atrybuty ustawienia wstępnego.
4. Kliknij OK, aby zapisać ustawienie wstępne i zamknąć okno dialogowe.

Gra na instrumentach VST
Po dodaniu instrumentu VST i wybraniu brzmienia można odtwarzać instrument VST
instrumentu, korzystając z instrumentu lub ścieżki MIDI w projekcie.

PROCEDURA
1. Na liście utworów aktywuj opcję Monitor dla ścieżki, do której załadowany jest instrument 
    VST.
2. Naciśnij jeden lub więcej klawiszy na klawiaturze MIDI lub użyj On-Screen Keyboard  
    (klawiatury ekranowej).
    Odpowiednie dźwięki są wyzwalane na instrumencie VST.
3. Wybierz Studio > MixConsole, aby otworzyć MixConsole i dostosować dźwięk, dodać EQ   
    (korektor) lub efekty, przypisać inną trasę wyjściową itp.
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Instrumenty VST i obciążenie procesora
Instrumenty VST mogą zużywać dużo mocy procesora. Im więcej instrumentów dodasz, tym 
większe prawdopodobieństwo, że podczas odtwarzania zabraknie mocy procesora.

Jeśli wskaźnik przeciążenia procesora w oknie Audio Performance (Wydajność dźwięku) zaświeci
się lub usłyszysz trzeszczące dźwięki, masz następujące możliwości:

● Activate Freeze Instrument Channel (Aktywuj kanał Freeze Instrument).
   Spowoduje to renderowanie instrumentu w pliku audio i wyładowanie go.
● Aktywuj opcję Suspend VST 3 plug-in processing when no audio signals are received 
(Wstrzymaj przetwarzanie wtyczki VST 3, gdy nie są odbierane żadne sygnały audio dla 
instrumentów VST 3).
Dzięki temu instrumenty nie zużywają mocy procesora podczas cichych pasaży.

POWIĄZANE LINKI
Zamrażanie instrumentów na stronie 736
Wstrzymaj przetwarzanie wtyczki VST 3, gdy nie są odbierane żadne sygnały audio na stronie 1183

Zamrażanie instrumentów
Jeśli używasz komputera o średniej mocy lub dużej liczby instrumentów VST, Twój komputer 
może nie być w stanie odtwarzać wszystkich instrumentów w czasie rzeczywistym. W tym 
momencie możesz zamrozić instrumenty.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
      ● Wybierz Studio > VST Instruments (Studio > Instrumenty VST).
      ● Wybierz ścieżkę instrumentu i otwórz górną sekcję Inspektora.
2. Kliknij opcję Freeze (Zablokuj).
3. W oknie dialogowym Freeze Instrument Options (Opcje zamrażania instrumentu) wprowadź 
    zmiany.
4. Kliknij OK.

WYNIK
● Instrument jest renderowany do pliku audio, a podczas odtwarzania słychać ten sam dźwięk, co 
przed zamrożeniem.
● Używane jest mniejsze obciążenie procesora.
● Zaświeci się przycisk Freeze (Zamrażanie).
● Elementy sterujące MIDI/ścieżki instrumentu są wyszarzone.
● Partie MIDI są zablokowane.

UWAGA
Aby ponownie edytować ścieżki, parametry lub kanały syntezatora i usunąć wyrenderowany plik, 
odmroź instrument, ponownie klikając Freeze (Zamroź).

Okno dialogowe Freeze Instrument Options (Opcje 
zamrazania instrumentu)
Okno dialogowe Freeze Instrument Options otwiera się po kliknięciu przycisku Freeze (Zamroź).
Pozwala dokładnie określić, co powinno się stać w przypadku zamrożenia instrumentu.

W oknie dialogowym Freeze Instrument Options (Opcje zamrażania instrumentu) można znaleźć 
następujące elementy sterujące:
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Freeze Instrument Only (Zamroź tylko instrument)
     Aktywuj tę opcję, jeśli po zamrożeniu instrumentu nadal chcesz móc edytować efekty wstawek 
     na kanale syntezatora
Freeze Instrument and Channels (Zamroź instrument i kanały)
     Aktywuj tę opcję, jeśli nie musisz edytować efektów wstawek na kanałach syntezatorowych.
UWAGA
Nadal możesz regulować level (poziom), pan (panoramę), sends (wysyłki) i EQ (korektor).

Tail Size (Rozmiar ogona)
     Umożliwia ustawienie czasu trwania ogona, aby dźwięki zakończyły swój normalny cykl 
     Release (uwalniania).
Unload Instrument when Frozen (Rozładuj zamrożony instrument)
     Aktywuj tę opcję, aby rozładować instrument po zamrożeniu. Spowoduje to ponowne 
     udostępnienie pamięci RAM.

Latency (Opóźnienie)
Termin latencja oznacza czas potrzebny instrumentowi na wytworzenie dźwięku po naciśnięciu 
klawisza kontrolera MIDI. Może to stanowić problem w przypadku korzystania z instrumentów 
VST w czasie rzeczywistym. Opóźnienie zależy od sprzętu audio i jego sterownika ASIO.
W oknie dialogowym Studio Setup (Ustawienia studia) (strona Audio System (System audio)) 
wartości opóźnienia wejściowego i wyjściowego powinny w idealnym przypadku wynosić kilka 
milisekund.
Jeśli opóźnienie jest zbyt duże, aby umożliwić wygodne odtwarzanie instrumentu VST w czasie 
rzeczywistym za pomocą klawiatury, możesz użyć innego źródła dźwięku MIDI do odtwarzania na 
żywo i nagrywania, a następnie przełączyć się na instrument VST do odtwarzania.

POWIĄZANE LINKI
Wybieranie sterownika audio na stronie 16.

Delay Compensation (Kompensacja opóźnienia)
Podczas odtwarzania Cubase automatycznie kompensuje wszelkie opóźnienia związane z 
używanymi wtyczkami VST.

Możesz określić Delay Compensation Threshold (Próg kompensacji opóźnienia) w oknie 
dialogowym Preferences (Preferencje) (strona VST), tak aby miało to wpływ tylko na wtyczki z 
opóźnieniem większym niż to ustawienie progu.

Ograniczenie kompensacji opóźnienia
Aby uniknąć dodania przez Cubase opóźnienia podczas gry na instrumencie VST w czasie 
rzeczywistym lub nagrywania dźwięku na żywo, możesz aktywować funkcję Constrain Delay 
Compensation (Ograniczenie kompensacji opóźnienia). Minimalizuje to skutki opóźnień 
wynikające z kompensacji opóźnienia, przy jednoczesnym zachowaniu brzmienia miksu tak dalece,
jak to możliwe.
Constrain Delay Compensation jest dostępne na pasku narzędzi okna Project oraz w strefie 
Transport. Można je również znaleźć jako element menu w MixConsole w menu Functions 
(Funkcje).

Aktywacja funkcji Constrain Delay Compensation powoduje wyłączenie wtyczek VST 
aktywowanych dla kanałów instrumentów VST, kanałów ścieżek audio z możliwością nagrywania, 
kanałów grupowych i kanałów wyjściowych. Wtyczki VST aktywowane dla kanałów FX są 
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pomijane. Po nagraniu lub użyciu instrumentu VST należy ponownie wyłączyć funkcję Constrain 
Delay Compensation, aby przywrócić pełną kompensację opóźnienia.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46

Opcje importu i eksportu

Importowanie pętli MIDI
Możesz importować pętle MIDI (rozszerzenie pliku .midiloop) w Cubase. Pliki te zawierają 
informacje o partiach MIDI (nuty MIDI, kontrolery itp.) oraz wszystkie ustawienia zapisane w 
ustawieniach ścieżek instrumentu. W ten sposób możesz na przykład ponownie wykorzystać wzory 
instrumentów w innych projektach lub aplikacjach.

PROCEDURA
1. Wybierz opcję Media > MediaBay (Multimedia > Wnęka na nośniki).
2. Opcjonalnie: Na pasku narzędzi otwórz menu Select Media Types (Wybierz typy multimediów) 
i aktywuj MIDI Loops (Pętle MIDI) oraz Plug-in Presets (Wstępne ustawienia wtyczek).

                    

3. Na liście Results (Wyniki) wybierz pętlę MIDI i przeciągnij ją do pustej sekcji w oknie Project.

WYNIK
Utworzona zostanie ścieżka instrumentu, a partia instrumentu zostanie wstawiona w miejscu, w 
którym przeciągnąłeś plik. Inspektor odzwierciedla wszystkie ustawienia zapisane w pętli MIDI, 
na przykład użyty instrument VST, zastosowane efekty Insert, parametry ścieżki itp.

UWAGA
Możesz także przeciągać pętle MIDI na istniejący instrument lub ścieżki MIDI. Jednak importuje to
tylko informacje o części. Oznacza to, że ta partia zawiera tylko dane MIDI (nuty, kontrolery) 
zapisane w pętli MIDI, ale nie zawiera ustawień Inspektora ani parametrów instrumentu.

POWIĄZANE LINKI
Wstępne ustawienia instrumentów na stronie 733
Filtrowanie według typu nośnika na stronie 647
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Eksportowanie pętli MIDI
Możesz eksportować pętle MIDI, aby zapisać partię MIDI wraz z ustawieniami instrumentu i 
efektów. Umożliwia to reprodukcję utworzonych wzorów bez konieczności poszukiwania 
odpowiedniego brzmienia, stylu lub efektu. Pętle MIDI mają rozszerzenie pliku .midiloop.

PROCEDURA
1. Wybierz partię instrumentu.
2. Wybierz opcję File > Export > MIDI Loop (Plik > Eksportuj > Pętla MIDI).
3. W oknie dialogowym Save MIDI Loop (Zapisz pętlę MIDI) wprowadź nazwę pętli MIDI.
4. Opcjonalnie: Aby zapisać atrybuty pętli MIDI, kliknij przycisk pod sekcją New MIDI Loop     
    (Nowa pętla MIDI) w lewym dolnym rogu. Otworzy się sekcja Attribute Inspector (Inspektor 
    atrybutów), umożliwiająca zdefiniowanie atrybutów pętli MIDI.
5. Kliknij OK.

WYNIK
Pliki pętli MIDI są zapisywane w następującym folderze:
Windows: \Users\<nazwa użytkownika>\AppData\Roaming\Steinberg\MIDI Loops
macOS: /Users/<nazwa użytkownika>/Library/Application Support/Steinberg/MIDI Loops/
Domyślnego folderu nie można zmienić. Możesz jednak utworzyć w tym folderze podfoldery, aby 
uporządkować pętle MIDI. Aby utworzyć podfolder, kliknij opcję New Folder (Nowy folder) w 
oknie dialogowym Save MIDI Loop (Zapisz pętlę MIDI).

Eksportowanie ścieżek instrumentów jako plików MIDI
Ścieżki instrumentów można eksportować jako standardowe pliki MIDI.

PROCEDURA
1. Wybierz ścieżkę instrumentu.
2. Wybierz opcję File > Export > MIDI File (Plik > Eksportuj > Plik MIDI).
3. W oknie dialogowym Export MIDI File (Eksportuj plik MIDI) wybierz lokalizację i wprowadź 
    nazwę pliku MIDI.
4. Kliknij Save (Zapisz).
5. W oknie dialogowym Export Options (Opcje eksportu) wprowadź zmiany.
    Jeśli aktywujesz opcję Export Inspector Volume/Pan, informacje o głośności i panoramie 
    instrumentu VST zostaną przekonwertowane i zapisane w pliku MIDI jako dane kontrolera.
6. Kliknij OK.

WYNIK
Ścieżka instrumentu jest eksportowana jako standardowy plik MIDI. Ponieważ na ścieżce 
instrumentu nie ma informacji o zestawie MIDI, w wynikowym pliku MIDI brakuje tych 
informacji.

POWIĄZANE LINKI
Eksportowanie ścieżek MIDI jako standardowych plików MIDI na stronie 168

VST Quick Controls (Szybkie kontrolery VST)
VST Quick Controls (Szybkie sterowanie VST) umożliwia zdalne sterowanie instrumentem VST z
poziomu okna VST Instruments (Instrumenty VST).
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Aby wyświetlić VST Quick Controls w oknie VST Instruments, aktywuj opcję Show/Hide all 
VST Quick Controls (Pokaż/Ukryj wszystkie szybkie kontrolery VST).

Na każdym stojaku dostępne są następujące elementy sterujące:

        

1   Show/Hide VST Quick Controls (Pokaż/ukryj szybkie kontrolery VST)
     Umożliwia pokazanie/ukrycie szybkich kontrolerów VST dla instrumentu.
2   VST Quick Controls (Szybkie kontrolery VST)
     Umożliwiają zdalne sterowanie parametrami instrumentu.
UWAGA
Liczba wyświetlanych szybkich kontrolerów VST zależy od rozmiaru okna VST Instruments.

3   Set Remote-Control Focus for VST Quick Controls (Ustaw fokus zdalnego sterowania dla   
     szybkich kontrolerów VST)
     Umożliwia aktywację szybkiego sterowania VST w celu zdalnego sterowania instrumentem.

POWIĄZANE LINKI
Zdalne sterowanie Cubase na stronie 756
Podłączanie szybkiego sterowania VST do pilotów zdalnego sterowania na stronie 740
Aktywacja trybu odbioru dla elementów sterujących sprzętem na stronie 755

Podłączanie szybkiego sterowania VST do pilotów zdalnego 
sterowania
VST Quick Controls (Szybkie kontrolery VST) stają się potężne, jeśli używasz ich razem z 
pilotem zdalnego sterowania.

WARUNEK WSTĘPNY
Wyjście MIDI na urządzeniu zdalnym jest połączone z wejściem MIDI w interfejsie MIDI.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz VST Quick Controls (Szybkie kontrolery VST).
3. Otwórz menu podręczne MIDI Input (Wejście MIDI) i wybierz wejście MIDI.
4. Opcjonalnie: Otwórz menu podręczne MIDI Output (Wyjście MIDI) i wybierz wyjście MIDI.
5. Kliknij Apply (Zastosuj).
6. Aktywuj Learn (Ucz się).
7. W kolumnie Control Name (Nazwa kontrolera) wybierz opcję QuickControl 1.
8. Na urządzeniu MIDI przesuń element sterujący, który chcesz połączyć z pierwszym szybkim 
    sterowaniem.
9. Wybierz następny slot w kolumnie Control Name (Nazwa kontrolera) i powtórz poprzednie 
     kroki.
10. Kliknij OK.

WYNIK
VST Quick Control (Szybkie sterowanie VST) jest teraz połączone z elementami sterującymi 

749



w urządzeniu MIDI. Jeśli przesuniesz element sterujący, wartość parametru przypisanego do 
odpowiedniego VST Quick Control (Szybkiego kontrolera VST) odpowiednio się zmieni.

UWAGA
Konfiguracja pilota dla VST Quick Controls jest zapisywana globalnie, to znaczy jest niezależna 
od jakichkolwiek projektów.

POWIĄZANE LINKI
Generic Remote Page (Strona generalna zdalnego sterowania) na stronie 760

Łańcuch boczny dla instrumentów VST
Możesz wysyłać dźwięk do instrumentów VST 3 obsługujących side-chaining (łańcuch boczny). 
Side-chaining umożliwia wykorzystanie wyjścia jednej ścieżki do sterowania działaniem 
instrumentu na innej ścieżce.

W zależności od instrumentu aktywacja side-chainingu umożliwia:
● Użycie instrumentu jako wtyczki efektów podczas zdarzeń audio.
● Użycie sygnału łańcucha bocznego jako źródła modulacji.
● Zastosowania wyciszanie instrumentu, czyli zmniejszenia głośność ścieżki instrumentu, gdy na 
   ścieżce audio występuje sygnał.

Sygnał audio można skierować do wejścia bocznego instrumentu na różne sposoby:
● Aby całkowicie przetworzyć sygnał audio przez instrument, skieruj wyjście ścieżki audio do 
wejścia bocznego instrumentu.
● Aby wykorzystać zarówno czysty sygnał audio, jak i sygnał przetworzony przez instrument, 
skieruj wysyłkę do łańcucha bocznego instrumentu.

UWAGA
Aby usłyszeć dźwięk odtwarzany przez instrument, musisz wyzwolić nutę, odtwarzając zdarzenia 
MIDI lub grając nuty na zewnętrznej klawiaturze MIDI.

POWIĄZANE LINKI
Używanie instrumentów jako efektów na ścieżkach audio na stronie 741

Używanie instrumentów jako efektów na ścieżkach audio
Do modyfikowania dźwięku na ścieżkach audio można używać instrumentów obsługujących 
łączenie boczne. Poniższy przykład pokazuje, jak zastosować parametry Retrologue do pętli 
perkusyjnej.

WARUNEK WSTĘPNY
Masz pętlę perkusyjną na ścieżce audio. Utworzyłeś ścieżkę instrumentu z załadowanym 
Retrologue.

PROCEDURA
1. Na panelu sterowania Retrologue kliknij opcję Activate/Deactivate Side-Chaining  
    (Aktywuj/Dezaktywuj łączenie boczne).
2. Na panelu sterowania kliknij opcję Set up Side-Chain Routing (Skonfiguruj routing boczny).
3. Kliknij opcję Add Side-Chain Source (Dodaj źródło łańcucha bocznego) i wybierz ścieżkę  
    audio z selektora.
4. W oknie Project wybierz ścieżkę audio.
5. W Inspektorze ścieżki audio otwórz menu podręczne Output Routing (Routing wyjściowy) 
    i wybierz Retrolog jako sygnał wejściowy łańcucha bocznego.
6. Na panelu Retrologue w sekcji Oscillator Mix dostosuj Input Level (poziom sygnału 
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    wejściowego).
7. Opcjonalnie: Dezaktywuj oscylatory OSC 1, OSC 2 i OSC 3.

8. Wykonaj jedną z następujących czynności:
      ● Na ścieżce instrumentu utwórz zdarzenie MIDI, ustaw cykl za pomocą lewego i prawego 
         lokalizatora i aktywuj tryb cyklu.
      ● Graj nuty na klawiaturze MIDI.

UWAGA
Aby to zadziałało, należy zainstalować i skonfigurować klawiaturę MIDI.

WYNIK
Kiedy grana jest nuta, pętla perkusyjna jest odtwarzana w Retrologue.

PO ZAKOŃCZENIU TEGO ZADANIA
Użyj Retrologue, aby zmodyfikować dźwięk pętli perkusyjnej. Możesz na przykład wykonać 
następujące czynności:
      ● Użyj ustawień filtrów i zniekształceń na stronie Synth.
      ● Modulacja sygnału wejściowego. W tym celu wybierz Modulation Matrix > Destination >
         Oscillator > Audio Input (Matryca modulacyjna > Miejsce docelowe  > Oscylator > Wejście
         audio).
      ● Ustaw modulację rytmiczną na stronie Arp.
      ● Użyj efektów na stronie FX, na przykład Resonator (Rezonatora).

UWAGA
Szczegółowe informacje o Retrologue i jego parametrach znajdziesz w osobnym dokumencie 
Retrologue.

Instrumenty zewnętrzne
Zewnętrzna magistrala instrumentalna stanowi wejście (powrót) do sprzętu audio, wraz z 
połączeniem MIDI poprzez Cubase i dodatkowymi ustawieniami.

Zewnętrzne szyny instrumentów tworzone są w oknie Audio Connections (Połączenia audio). 
Wszystkie utworzone zewnętrzne szyny instrumentów pojawiają się w wyskakujących menu     
VST Instrument i można je wybierać w taki sam sposób, jak dowolną wtyczkę instrumentu VST.

Jeśli wybierzesz instrument zewnętrzny, musisz utworzyć urządzenie MIDI, aby odtwarzać go za 
pośrednictwem MIDI. Dźwięk wyprowadzany przez syntezatorowe wyjście audio będzie trafiał do 
środowiska VST, gdzie można zastosować przetwarzanie itp.

POWIĄZANE LINKI
Konfigurowanie instrumentów zewnętrznych na stronie 39
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Instalowanie i zarządzanie wtyczkami VST

Cubase obsługuje standardy wtyczek VST 2 i VST 3. Można instalować efekty i instrumenty 
zgodne z tymi formatami.

UWAGA
Cubase obsługuje tylko wtyczki 64-bitowe.

Wtyczka to oprogramowanie, które dodaje określoną funkcjonalność do Cubase. Efekty dźwiękowe
i instrumenty używane w Cubase to wtyczki VST.

Wtyczki efektów VST lub instrumentów VST mają zwykle własną aplikację instalacyjną. Przed 
instalacją nowych wtyczek przeczytaj dokumentację lub pliki Readme.

Kiedy skanujesz w poszukiwaniu nowo zainstalowanych wtyczek lub ponownie uruchamiasz 
Cubase, nowe wtyczki są wyświetlane odpowiednio w selektorach efektu VST lub instrumentu 
VST
Cubase zawiera wiele wtyczek z efektami. Te efekty i ich parametry opisano w osobnym 
dokumencie Plug-in Reference (Poradnik wtyczek).

Wtyczki i kolekcje
VST Plug-in Manager (Menedżer wtyczek VST) pokazuje efekty VST i instrumenty VST 
zainstalowane na komputerze.

W Cubase wtyczki są ułożone w kolekcje. Jednocześnie może być aktywna tylko jedna kolekcja. 
Wtyczki zawarte w aktywnej kolekcji są wyświetlane w selektorach w całym programie.

Po uruchomieniu Cubase wszystkie znalezione wtyczki zostaną automatycznie umieszczone w 
kolekcji Default (Domyślna). Jest to domyślnie aktywna kolekcja wtyczek.

Kolekcja Default jest tworzona za każdym razem, gdy uruchamiasz Cubase lub inicjujesz ponowne 
skanowanie.

Możesz jednak dodać własne kolekcje efektów VST lub instrumentów VST. Jest to przydatne, jeśli 
chcesz na przykład zobaczyć tylko określone wtyczki używane w konkretnym projekcie. Po 
aktywowaniu tej kolekcji wszystkie efekty VST i instrumenty VST z tej kolekcji zostaną pokazane 
w selektorach efektów VST lub instrumentów VST.

UWAGA
Jeśli zainstalowany efekt VST lub instrument VST nie mógł zostać załadowany przez Cubase, nie 
jest on wyświetlany na karcie VST Effects (Efekty VST) ani VST Instruments (Instrumenty VST)
i jest wyszarzony w żadnej kolekcji. W takim przypadku sprawdź, czy wtyczka jest zabezpieczona 
przed kopiowaniem.

POWIĄZANE LINKI
Okno Menedżera wtyczek VST na stronie 744
Dodawanie nowych kolekcji wtyczek na stronie 746
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Okno VST Plug-in Manager (menedżera wtyczek VST)
Możesz zarządzać efektami VST i instrumentami VST w oknie Menedżera wtyczek VST.

● Aby otworzyć okno Menedżera wtyczek VST, wybierz Studio > VST Plug-in Manager (Studio 
> Menedżer wtyczek VST)

       

VST Plug-in Manager (Menedżer wtyczek VST) jest podzielony na następujące sekcje:

VST Effects (Efekty VST)
Wyświetla listę wszystkich efektów VST załadowanych do Cubase. Aby posortować listę według 
określonego atrybutu, kliknij odpowiedni nagłówek kolumny.

VST Instruments (Instrumenty VST)
Wyświetla listę wszystkich instrumentów VST załadowanych do Cubase. Aby posortować listę 
według określonego atrybutu, kliknij odpowiedni nagłówek kolumny.

Blocklist (Lista zablokowanych)
Wyświetla listę wszystkich efektów VST i instrumentów VST zainstalowanych w systemie, ale nie 
załadowanych do Cubase, ponieważ mogą one prowadzić do problemów ze stabilnością lub nawet 
powodować awarię programu.

Toolbar (Pasek narzędzi)
Pokazuje narzędzia i skróty do funkcji w VST Plug-in Manager (Menedżerze wtyczek VST).

Active Collection (Aktywna kolekcja)
Pokazuje aktywną kolekcję. Wtyczki aktywnej kolekcji są pokazane w selektorach efektów VST i 
instrumentów VST.

Show VST Plug-in Information (Pokaż informacje o wtyczce VST)
Wyświetla informacje o wybranej wtyczce.
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VST 2 Plug-in Path Settings (Ustawienia ścieżki wtyczki VST 2)
Pokazuje ścieżkę wybranej wtyczki VST 2.

Plug-in Report (Raport wtyczki)
Otwiera Eksplorator plików/wyszukiwarkę macOS, która umożliwia zapisanie pliku tekstowego 
zawierającego informacje o systemie oraz informacje o wtyczkach. Jest to przydatne na przykład 
przy rozwiązywaniu problemów

POWIĄZANE LINKI
Wtyczki i kolekcje na stronie 743
Strona systemu audio na stronie 17
Pasek narzędzi Menedżera wtyczek VST na stronie 745
Ustawienia ścieżki wtyczki VST 2 na stronie 746
Ukrywanie wtyczek na stronie 747
Ponowna aktywacja wtyczek z listy zablokowanych na stronie 748

Pasek narzędzi VST Plug-in Manager (Menedżera wtyczek VST)
Pokazuje narzędzia i skróty do funkcji w VST Plug-in Manager.

● Aby otworzyć okno VST Plug-in Manager, wybierz Studio > VST Plug-in Manager (Studio > 
Menedżer wtyczek VST).

Search field (Pole wyszukiwania)

       
      Umożliwia wyszukiwanie określonych wtyczek w zakładce VST Effects (Efekty VST) lub w   
      VST Instruments (Instrumenty VST), wpisując ich nazwę.
Rescan All (Przeskanuj ponownie wszystko)
      Ponownie skanuje listę wtyczek.
Display Options (Opcje wyświetlania)

       
      Umożliwia wybór, które wtyczki mają być wyświetlane:
● Show All Plug-ins (Pokaż wszystkie wtyczki) pokazuje wszystkie załadowane wtyczki.
● Hide Plug-ins That Are in Active Collection (Ukryj wtyczki znajdujące się w aktywnej 
   kolekcji) ukrywa wszystkie wtyczki będące częścią aktywnej kolekcji.
● Show Plug-ins That Support 64-Bit Float Processing (Pokaż wtyczki obsługujące 64-bitowe  
   przetwarzanie Float) pokazuje wszystkie wtyczki VST 3, które to obsługują 64-bitowe 
   przetwarzanie float.
New Folder (Nowy folder)

              
      Tworzy nowy folder w bieżącej kolekcji.
Delete (Usuń)

       
      Usuwa wybrany element w bieżącej kolekcji.
New Collection (Nowa kolekcja)

       
      Tworzy nową kolekcję.
● Empty (Puste) tworzy nową, pustą kolekcję.
● Add All Plug-ins (Dodaj wszystkie wtyczki) tworzy nową kolekcję zawierającą odpowiednio 
   wszystkie efekty VST lub instrumenty VST.
● Copy Current Collection (Kopiuj bieżącą kolekcję) tworzy nową kolekcję zawierającą bieżącą   
   kolekcję.
Plug-in Collections and Options (Kolekcje wtyczek i opcje)
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● Default (Domyślne) aktywuje kolekcję domyślną.

● New Collection (Nowa kolekcja) umożliwia utworzenie nowej kolekcji.
● Remove Unavailable Plug-ins from All Collections (Usuń niedostępne wtyczki ze wszystkich 
kolekcji) usuwa wszystkie wtyczki, które nie są dostępne ze wszystkich kolekcji utworzonych przez
użytkowników.
● Sort By Category (Sortuj według kategorii) sortuje kolekcję według kategorii.
UWAGA
Ta opcja jest dostępna tylko dla kolekcji Default (Domyślna).

● Sort By Vendor (Sortuj według dostawcy) sortuje kolekcję według dostawcy.
UWAGA
Ta opcja jest dostępna tylko dla kolekcji Default (Domyślna).

Ustawienia ścieżki wtyczki VST 2
Wyświetla informacje o wybranej ścieżce wtyczki VST 2.

● Aby otworzyć VST 2 Plug-in Path Settings (Ustawienia ścieżki wtyczek VST 2), wybierz  
   Studio > VST Plug-in Manager (Studio > Menedżer wtyczek VST) i kliknij VST 2 Plug-in
   Path Settings (Ustawienia ścieżki wtyczek VST 2).

       

VST 2 Plug-in path list (Lista ścieżek wtyczek VST 2)
      Pokazuje wszystkie ścieżki wtyczek VST 2.
Add Path (Dodaj ścieżkę)
     Umożliwia dodanie nowej ścieżki wtyczki VST 2.
Delete Path (Usuń ścieżkę)
     Usuwa wybraną ścieżkę wtyczki VST 2.
Reset (Zresetuj)
     Resetuje listę do ustawień domyślnych.

Dodawanie nowych kolekcji wtyczek
Możesz dodawać nowe kolekcje efektów VST lub instrumentów VST.

WARUNEK WSTĘPNY
Na komputerze zainstalowano wiele wtyczek z efektami, które są wymienione w VST Plug-in 
Manager (Menedżerze wtyczek VST) na zakładkach VST Effects (Efekty VST) i VST 
Instruments (Instrumenty VST).

PROCEDURA
1. Na pasku narzędzi VST Plug-in Manager (Menedżera wtyczek VST) kliknij opcję New   
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    Collection (Nowa kolekcja) i wybierz opcję.

       
2. W oknie dialogowym New Collection (Nowa kolekcja) wprowadź nazwę nowej kolekcji i kliknij
    OK.
3. Opcjonalnie: Kliknij New Folder (Nowy folder).
    Następnie możesz przenieść wtyczki do tych folderów, aby na przykład uporządkować je według 
    kategorii.
4. Wprowadź nazwę nowego folderu i kliknij OK.
5. Na karcie VST Effects (Efekty VST) lub VST Instruments (Instrumenty VST) wybierz  
    wtyczki, które chcesz dodać do kolekcji, i przeciągnij je do nowej kolekcji. Jeśli utworzyłeś 
    foldery, możesz przeciągnąć wtyczki bezpośrednio do folderów.

WYNIK
Nowa kolekcja została zapisana. Jeśli ją wybierzesz, jej wtyczki zostaną pokazane w selektorach 
wtyczek.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby usunąć wtyczkę z kolekcji, wybierz ją i kliknij Remove (Usuń).

POWIĄZANE LINKI
Wtyczki i kolekcje na stronie 743
Okno Menedżera wtyczek VST na stronie 744

Ukrywanie wtyczek
Możesz ukryć wtyczki ze wszystkich kolekcji. Jest to przydatne, jeśli na komputerze są 
zainstalowane wtyczki, których nie chcesz używać w Cubase.

PROCEDURA
1. Wybierz Studio > VST Plug-in Manager (Studio > Menedżer wtyczek VST).
2. Na karcie VST Effects lub VST Instruments wybierz wtyczki, które chcesz ukryć przed 
    wzrokiem.
3. Kliknij opcję Show VST Plug-in Information (Pokaż informacje o wtyczce VST), aby 
    wyświetlić informacje o wybranej wtyczce.
4. Aktywuj Hide (Ukryj).

          
    
WYNIK
Wybrana wtyczka jest ukryta.
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POWIĄZANE LINKI
ASIO-Guard na stronie 1157

Ponowna aktywacja wtyczek z listy zablokowanych
Możesz ponownie aktywować wtyczki 64-bitowe, które znajdują się na liście zablokowanych.

PROCEDURA
1. Na karcie Blocklist (Lista zablokowanych) wybierz wtyczki, które chcesz ponownie aktywować.
UWAGA
Nie można ponownie aktywować wtyczek 32-bitowych, ponieważ nie są one obsługiwane.

2. Kliknij opcję Reactivate (Aktywuj ponownie).

WYNIK
Cubase ponownie przeskanuje wtyczkę i usunie ją z listy zablokowanych.

PO ZAKOŃCZENIU TEGO ZADANIA
Jeśli chcesz przenieść wtyczkę z powrotem na listę zablokowanych, kliknij opcję Rescan All  
(Przeskanuj ponownie wszystko) w VST 2 Plug-in Path Settings (Ustawieniach ścieżki wtyczki 
VST 2) i uruchom ponownie Cubase.

POWIĄZANE LINKI
Okno Menedżera wtyczek VST na stronie 744
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Track Quick Controls (Szybkie kontrolery 
ścieżki)
Cubase umożliwia skonfigurowanie 8 różnych parametrów lub ustawień ścieżki jako Track Quick 
Controls (Szybkich kontrolerów ścieżki) w celu szybkiego dostępu.

Track Quick Controls są dostępne dla następujących typów ścieżek:
● Audio (Dźwięk)
● MIDI
● Instrument
● Sampler (Próbnik)
● FX Channel (Kanał FX)
● Group Channel (Kanał grupowy)
● VCA Fader (Tłumik VCA)

W przypadku ścieżek instrumentów i ścieżek MIDI, do których podczas tworzenia przypisano 
instrument VST, to znaczy utworzonych poprzez załadowanie instrumentu ze stojaka, Track Quick
Controls są automatycznie przypisywane do Quick Controls (szybkich elementów sterujących) 
instrumentu VST.

W przypadku ścieżek samplera przyciski Track Quick Controls są automatycznie przypisywane 
do parametrów dźwiękowych funkcji Sampler Control.

UWAGA
Możesz zmienić domyślne przypisanie, przypisując inne parametry ścieżki lub ładując ustawienie 
wstępne.

Przypisywanie parametrów do Quick Controls (Szybkich Kontrolerów) odbywa się w Inspector 
lub MixConsole.

       

758



Sekcja Quick Controls (Szybkie kontrolery) w Inspektorze

         
Stojak Track Quick Controls (Szybkich kontrolerów ścieżki) w MixConsole (konsoli mikserskiej)

Przypisania funkcji Quick Controls (Szybkich kontrolerów) są zapisywane wraz z projektem.
Track Quick Controls (Szybkie sterowanie ścieżką) można przypisać do zewnętrznego urządzenia
zdalnego sterowania. Aby to zadziałało, musisz połączyć Track Quick Controls z pilotem.

Możesz zautomatyzować ustawienia parametrów w sekcji Quick Controls (Szybkie sterowanie) za 
pomocą przycisków Read/Write (Odczyt/Zapis) (R i W).

POWIĄZANE LINKI
Zaprogramowane ścieżki na stronie 192
Automatyka na stronie 705
Selektor stojaków kanałowych na stronie 367

Przypisanie parametrów
Do przycisków szybkiego sterowania można przypisywać parametry ścieżki, efektu i instrumentu.

Do przypisania parametrów można użyć Inspektora lub MixConsole. Można przypisać parametry 
ręcznie, skorzystać z trybu QC Learn Mode (Uczenia się szybkiego kontrolera) lub załadować 
ustawienie wstępne przypisania.

POWIĄZANE LINKI
Przypisywanie parametrów ścieżki do szybkich elementów sterujących na stronie 750
Przypisywanie parametrów efektów do szybkich ustawień na stronie 751
Korzystanie z trybu uczenia się QC (kontroli jakości) na stronie 751
Dodawanie szybkich elementów sterujących ścieżką w MixConsole na stronie 401
Ustawianie domyślnych przypisań parametrów instrumentu na stronie 752
Usuwanie przypisań parametrów na stronie 752
Ładowanie przypisań szybkiego sterowania ścieżkami jako ustawień wstępnych na stronie 753

Przypisywanie parametrów ścieżki do szybkich elementów sterujących
Możesz ręcznie przypisać parametry ścieżki.
UWAGA
W przypadku ścieżek instrumentów i ścieżek MIDI, do których przy tworzeniu przypisano 
instrument VST, główne parametry instrumentu są automatycznie przypisywane do miejsc w sekcji 
Quick Controls (Szybkie sterowanie) w Inspektorze.

PROCEDURA
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1. W Inspektorze ścieżki otwórz sekcję Quick Controls (Szybkie sterowanie).
2. W sekcji Quick Controls kliknij pierwsze miejsce, aby otworzyć selektor zawierający listę 
    wszystkich parametrów ścieżki.

3. Wybierz parametr, który chcesz przypisać do pierwszego Quick Control (szybkiego kontrolera).
    Nazwa parametru i jego wartość są wyświetlane w slocie. Możesz zmienić wartość, przeciągając 
    suwak.

                    

4. Powtórz te kroki dla wszystkich slotów, do których chcesz przypisać parametry ścieżki.

WYNIK
Możesz teraz kontrolować parametry ścieżki poprzez sekcję Quick Controls w Inspektorze lub 
poprzez stojak Track Quick Controls w MixConsole.

PO ZAKOŃCZENIU TEGO ZADANIA
Możesz zmienić nazwę Quick Control (Szybkiego kontrolera), klikając dwukrotnie nazwę i 
wprowadzając nową. Jest to przydatne, jeśli nazwa parametru jest na przykład bardzo długa.

Przypisywanie parametrów efektów do szybkich kontrolerów
Możesz przypisać parametry efektów do gniazd Quick Control bezpośrednio z paneli wtyczek.

UWAGA
Jest to dostępne tylko dla wtyczek VST 3 obsługujących tę funkcję.

PROCEDURA
● W panelu wtyczek efektów kliknij parametr prawym przyciskiem myszy.
      ● Wybierz opcję Add “x” to Quick Controls (Dodaj „x” do szybkich kontrolerów (gdzie x to  
         nazwa parametru), aby przypisać parametr do następnego pustego miejsca.
      ● Wybierz opcję Add “x” to Quick Controls (gdzie x to nazwa parametru) i wybierz gniazdo z
         podmenu, aby przypisać parametr do określonego poziomu

WYNIK
Możesz teraz kontrolować parametry efektu poprzez sekcję Quick Controls (Szybkie kontrolery)  
w Inspektorze lub poprzez stojak Track Quick Controls (Szybkie kontrolery ścieżki) w 
MixConsole.

Korzystanie z trybu QC Learn Mode (uczenia szybkiego kontrolera)
Tryb uczenia się QC Learn Mode umożliwia przypisanie parametru poprzez przesuwanie 
elementów sterujących. Dotyczy to wszystkich sterowań automatycznych.

PROCEDURA
1. W Inspektorze ścieżki otwórz sekcję Quick Controls (Szybkie sterowanie).
2. Aktywuj QC Learn Mode (Tryb nauki szybkiego kontrolera).
3. Wybierz slot, do którego chcesz przypisać parametr.
4. Przesuń element sterujący.

WYNIK
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Parametr ścieżki jest przypisany do odpowiedniego elementu sterującego.

POWIĄZANE LINKI
Kontrolowanie parametrów automatycznych na stronie 753

Ustawianie domyślnych przypisań parametrów instrumentu
Jeśli zmieniłeś przypisanie parametrów lub ręcznie przekierowałeś ścieżkę MIDI do instrumentu 
VST, możesz przywrócić przypisania domyślne.

PROCEDURA
1. W Inspektorze instrumentu lub ścieżki MIDI otwórz sekcję Quick Controls (Szybkie 
sterowanie).
2. Kliknij opcję Get Default QCs from Plug-in (Uzyskaj domyślne szybkie kontrolery z wtyczki).

WYNIK
Przypisania parametrów przyrządu są ustawione domyślnie.

Usuwanie przypisań parametrów
Możesz usunąć przypisania parametrów do poszczególnych Quick Controls (Szybkich 
kontrolerów) lub do wszystkich Quick Controls jednocześnie.

PROCEDURA
● Wykonaj jedną z następujących czynności:
      ● Aby usunąć parametr ze slotu, kliknij odpowiedni slot i wybierz No parameter (Brak   
         parametru) z wyskakującego menu.
UWAGA
Można także kliknąć dwukrotnie nazwę parametru, nacisnąć klawisz Delete lub Backspace 
i potwierdzić klawiszem Return.

      ● Aby usunąć przypisania Quick Control (Szybkiego kontrolera) dla wszystkich gniazd, kliknij
         Remove All QC Assignments (Usuń wszystkie przypisania szybkich kontrolerów).

                     

Zapisywanie przypisań szybkiego sterowania ścieżki jako ustawień 
wstępnych
Możesz zapisać przypisania Quick Control jako gotowe ścieżki.

WARUNEK WSTĘPNY
Przypisałeś parametry ścieżki do Quick Controls (Szybkich ustawień).

PROCEDURA
1. W Inspektorze ścieżki otwórz sekcję Quick Controls (Szybkie sterowanie).
2. W sekcji Quick Controls kliknij Preset Management (Zarządzanie ustawieniami wstępnymi).
3. Kliknij opcję Save Preset (Zapisz ustawienie wstępne).
4. Wprowadź nazwę w oknie dialogowym Type in Preset Name (Wpisz nazwę ustawienia 
    wstępnego).
5. Kliknij OK.
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WYNIK
Przypisanie funkcji Quick Control (Szybkie sterowanie) zostaje zapisane jako ustawienie wstępne.

POWIĄZANE LINKI
Przypisywanie parametrów ścieżki do szybkich elementów sterujących na stronie 750

Ładowanie przypisań szybkiego sterowania ścieżki jako ustawień 
wstępnych
Możesz załadować ustawienia wstępne dla przypisań Quick Control (Szybkiego sterowania).

PROCEDURA
1. W Inspektorze ścieżki otwórz sekcję Quick Controls.
2. W sekcji Quick Controls kliknij Preset Management (Zarządzanie ustawieniami wstępnymi).
3. Wybierz jedno z ustawień wstępnych na górnej liście menu.

WYNIK
Ustawienie wstępne zostanie załadowane i umożliwi dostęp do parametrów kanału.

Kontrolowanie parametrów automatycznych
Za pomocą Quick Controls (Szybkich kontrolerów) można kontrolować wszystkie parametry, 
które można zautomatyzować. Umożliwia to kontrolowanie parametrów innych ścieżek za pomocą 
Quick Controls.

WAŻNE
Używaj tej funkcji ostrożnie, ponieważ możesz przypadkowo zmodyfikować parametry innych 
ścieżek.

PROCEDURA
1. Utwórz nową, pustą ścieżkę audio i otwórz sekcję Quick Controls (Szybkie sterowanie).
2. Przytrzymaj klawisz Ctrl/Cmd i kliknij pierwszy slot Quick Control (Szybkiego kontrolera).
    Selektor wyświetla wszystkie parametry, które można zautomatyzować.
3. Otwórz folder VST Mixer (Mikser VST).
    Selektor wyświetla listę wszystkich kanałów dostępnych w MixConsole Twojego projektu.

         

4. Przypisz parametr jednego konkretnego kanału do Quick Control 1, a inny parametr innego  
    kanału do Quick Control 2.

WYNIK
Sekcja Quick Controls (Szybkie sterowanie) umożliwia teraz kontrolowanie zautomatyzowanych 
parametrów na różnych ścieżkach.
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WAŻNE
Nie można zapisać przypisań Quick Controls (Szybkich kontrolerów) dla parametrów 
zautomatyzowanych na różnych ścieżkach jako ustawień wstępnych ścieżek.

Wyświetlanie zautomatyzowanych przypisań szybkiego kontrolera
Możesz wyświetlić wszystkie przypisania Quick Control (Szybkiego kontrolera), które zostały 
zautomatyzowane dla jednej ścieżki.

PROCEDURA
1. Kliknij ścieżkę, dla której chcesz wyświetlić automatyczne przypisania Quick Control   
    (Szybkiego kontrolera).
2. W Inspektorze ścieżki otwórz sekcję Quick Controls (Szybkie sterowanie).
3. W sekcji Quick Controls kliknij Preset Management (Zarządzanie ustawieniami wstępnymi).
4. Wybierz opcję Show Automated QC Assignments (Pokaż automatyczne przypisania szybkiego 
    kontrolera).

WYNIK
Ścieżki automatyzacji zautomatyzowanych parametrów Quick Control otwierają się dla wybranej 
ścieżki.

UWAGA
● Jeśli jako parametr Quick Control przypisano Volume (głośność), zawsze jest ona wyświetlana 
   jako zautomatyzowana, niezależnie od tego, czy jest zautomatyzowana, czy nie.
● Możesz także wyświetlić zautomatyzowane przypisania Quick Control poprzez stojak Track   
   Quick Controls (Szybkie kontrolery ścieżki) w MixConsole.

Łączenie szybkich elementów sterujących ścieżki z pilotami
Track Quick Controls (Szybkie sterowanie ścieżki) staje się potężne, jeśli używasz ich razem z 
pilotem zdalnego sterowania.

WARUNEK WSTĘPNY
Wyjście MIDI na urządzeniu zdalnym jest połączone z wejściem MIDI w interfejsie MIDI.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz opcję Track Quick Controls (Szybkie kontrolery 
    ścieżki).
3. Otwórz menu podręczne MIDI Input (Wejście MIDI) i wybierz wejście MIDI.
4. Opcjonalnie: Otwórz menu podręczne MIDI Output (Wyjście MIDI) i wybierz wyjście MIDI.
5. Kliknij Apply (Zastosuj).
6. Aktywuj Learn (Ucz się).
7. W kolumnie Control Name (Nazwa kontrolera) wybierz opcję QuickControl 1.
8. Na urządzeniu MIDI przesuń element sterujący, który chcesz połączyć z pierwszym szybkim 
    kontrolerem.
9. Wybierz następny slot w kolumnie Control Name i powtórz poprzednie kroki.
10. Kliknij OK.

WYNIK
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Track Quick Controls (Szybkie sterowanie ścieżką) jest teraz połączone z elementami sterującymi
w urządzeniu MIDI. Jeśli przesuniesz element sterujący, wartość parametru przypisanego do 
odpowiedniego Track Quick Controls ulegnie odpowiedniej zmianie.

UWAGA
Konfiguracja pilota dla Track Quick Controls (Szybkich kontrolerów ścieżki) jest zapisywana 
globalnie, to znaczy jest niezależna od jakichkolwiek projektów.

POWIĄZANE LINKI
Strona Ogólne zdalne sterowanie na stronie 760

Aktywacja trybu Pick-up (odbioru) dla kontrolerów sprzętu
Tryb Pick-up Mode umożliwia zmianę skonfigurowanych parametrów Quick Control  (Szybkiego
kontrolera) bez przypadkowej modyfikacji poprzednich wartości. Jest to przydatne, jeśli chcesz, aby
sterowanie pobierało parametr o wartości, na którą był ostatnio ustawiony. Jeśli przesuniesz 
element sterujący sprzętem, parametr zmieni się dopiero wtedy, gdy element sterujący osiągnie 
poprzednią wartość.

UWAGA
Dotyczy to tylko kontrolerów sprzętowych, których sterowanie wykorzystuje określone zakresy.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz Track Quick Controls (Szybkie sterowanie ścieżką) lub
    VST Quick Controls (Szybkie sterowanie VST).
3. Aktywuj Pick-up Mode (Tryb odbioru).
4. Kliknij OK.
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Zdalne sterowanie Cubase
Możesz sterować Cubase poprzez MIDI za pomocą podłączonego urządzenia MIDI.

Obsługiwane urządzenia opisano w osobnym dokumencie Remote Control Devices (Urządzenia 
do zdalnego sterowania). Możesz także użyć ogólnego kontrolera MIDI do zdalnego sterowania 
Cubase.

UWAGA
Większość urządzeń zdalnego sterowania jest w stanie sterować zarówno kanałami MIDI, jak 
i audio w Cubase, ale konfiguracja parametrów może być inna. Kontrolery specyficzne dla audio, 
takie jak EQ, są pomijane podczas kontrolowania kanałów MIDI.

POWIĄZANE LINKI
Ogólna strona zdalnego sterowania na stronie 760

Podłączanie urządzeń zdalnych
Możesz podłączyć swoje urządzenie zdalne przez USB lub MIDI.

PROCEDURA
● Wykonaj jedną z następujących czynności:
      ● Jeśli urządzenie zdalne posiada port USB MIDI, użyj kabla USB, aby podłączyć je do portu   
         USB komputera.
      ● Jeśli urządzenie zdalne zapewnia wyjście MIDI, użyj kabla MIDI, aby podłączyć je do 
         wejścia MIDI w interfejsie MIDI.

UWAGA
Jeśli jednostka zdalna jest wyposażona w urządzenia sprzężenia zwrotnego, takie jak wskaźniki, 
zmotoryzowane tłumiki itp., podłącz wyjście MIDI Out w interfejsie do wejścia MIDI In w 
jednostce zdalnej.

POWIĄZANE LINKI
Połączenia MIDI na stronie 23

Usuwanie wejścia zdalnego ze wszystkich wejść MIDI
Aby uniknąć przypadkowego nagrania danych ze zdalnego urządzenia podczas nagrywania MIDI, 
należy usunąć zdalne wejście z All MIDI Outputs (Wszystkich wyjść MIDI).

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz opcję MIDI Port Setup (Konfiguracja portu MIDI).
3. W tabeli po prawej stronie dezaktywuj opcję All MIDI Inputs (Wszystkie wejścia MIDI) dla   
    wejścia MIDI, do którego podłączyłeś zdalne urządzenie MIDI.
    Kolumna Stste (Stan) ma odczyt Unactive (Nieaktywny).
4. Kliknij OK.

WYNIK
Wejście urządzenia zdalnego zostało usunięte z grupy All MIDI Inputs (Wszystkie wejścia MIDI).
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POWIĄZANE LINKI
Strona konfiguracji portu MIDI na stronie 23

Konfigurowanie urządzeń zdalnych

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Kliknij Add (Dodaj) w lewym górnym rogu i wybierz zdalne urządzenie z wyskakującego menu,
    aby dodać je do listy Devices (Urządzenia).
UWAGA
Jeśli Twoje urządzenie nie jest dostępne w wyskakującym menu, wybierz opcję Generic Remote 
(Ogólnie zdalne).

3. Na liście Devices (Urządzenia) wybierz urządzenie.
    W zależności od wybranego urządzenia, w prawej połowie okna dialogowego wyświetlana jest 
    lista programowalnych poleceń funkcji lub pusty panel.

      

4. Otwórz menu podręczne MIDI Input (Wejście MIDI) i wybierz wejście MIDI.
5. Opcjonalnie: Otwórz menu podręczne MIDI Output (Wyjście MIDI) i wybierz wyjście MIDI.
6. Kliknij OK.

WYNIK
Możesz teraz używać urządzenia MIDI do sterowania funkcjami Cubase.
Jasny pasek w oknie Project i w MixConsole wskazuje, które kanały są połączone z urządzeniem 
zdalnego sterowania.
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Możesz otworzyć panel dodanego urządzenia, wybierając Studio > More Options (Studio > 
Więcej opcji).

PO ZAKOŃCZENIU TEGO ZADANIA
W zależności od zewnętrznego urządzenia sterującego MIDI może być konieczne skonfigurowanie 
parametrów.

Resetowanie urządzeń zdalnych
Czasami trzeba zresetować urządzenia zdalne, ponieważ komunikacja pomiędzy Cubase 
a urządzeniem zdalnym została przerwana lub protokół uzgadniania nie utworzył połączenia.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz urządzenie zdalne.
3. Kliknij Reset (Resetuj) w dolnej części okna dialogowego Studio Setup, aby zresetować  
    wybrane urządzenie zdalne.
UWAGA
Aby zresetować wszystkie urządzenia na liście Devices (Urządzenia), kliknij Reset (Resetuj) w 
lewym górnym rogu okna dialogowego

Globalne opcje dla kontrolerów zdalnego sterowania
Na stronie Twojego urządzenia zdalnego mogą być dostępne funkcje globalne.
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MIDI Input (Wejście MIDI)
      Umożliwia wybór wejścia MIDI.

MIDI Output (Wyjście MIDI)
      Umożliwia wybór wyjścia MIDI.
User Commands (Polecenia użytkownika)
      Wyświetla listę elementów sterujących lub przycisków urządzenia zdalnego.
Smart Switch Delay (Opóźnienie inteligentnego przełącznika)
      Umożliwia określenie opóźnienia dla funkcji inteligentnego przełącznika. Funkcje obsługujące 
      zachowanie inteligentnego przełącznika są aktywne tak długo, jak długo przycisk jest wciśnięty.
Enable Auto Select (Włącz wybór automatyczny)
      W przypadku urządzeń do zdalnego sterowania wrażliwych na dotyk funkcja ta automatycznie 
      wybiera kanał po dotknięciu tłumika. Na urządzeniach bez tłumików dotykowych kanał 
      zostanie wybrany natychmiast po przesunięciu tłumika.

Urządzenia zdalne i automatyzacja
Możesz pisać automatyzację za pomocą urządzeń zdalnych.

Jeśli Twoje urządzenie zdalne nie jest wyposażone w elementy sterujące dotykowe i chcesz zastąpić
istniejące dane automatyki w trybie Write (zapisu), rozważ następujące kwestie:
● Upewnij się, że przenosisz tylko kontroler, który chcesz wymienić.
● Zatrzymaj odtwarzanie, aby wyłączyć tryb Write (zapisu)

W ten sposób wszystkie dane odpowiedniego parametru zostaną zastąpione od miejsca, w którym 
przesunięto element sterujący, aż do miejsca, w którym zatrzymano odtwarzanie.

Przypisywanie poleceń do urządzeń zdalnych
Możesz przypisać dowolne polecenie Cubase, do którego można przypisać polecenie klawiszowe 
do zdalnych urządzeń

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
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2. Na liście Devices (Urządzenia) wybierz urządzenie zdalne.
    W sekcji User Commands (Polecenia użytkownika) elementy sterujące lub przyciski urządzenia 
    zdalnego są wymienione w kolumnie Button (Przycisk)

           

3. Kliknij kolumnę Category (Kategoria) dla kontrolera, do którego chcesz przypisać polecenie 
    Cubase, i wybierz kategorię z wyskakującego menu.
    Kategorie odpowiadają kategoriom w oknie dialogowym Key Commands (Komendy 
    klawiszowe).
4. Kliknij kolumnę Command (Polecenie) i wybierz polecenie Cubase z wyskakującego menu.
    Dostępne pozycje w wyskakującym menu zależą od wybranej kategorii.
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5. Kliknij Apply (Zastosuj).

WYNIK
Wybrana funkcja jest przypisana do przycisku lub kontrolera na zdalnym urządzeniu.

POWIĄZANE LINKI
Polecenia klawiszowe na stronie 1123

Strona Generic Remote (Ogólnego zdalnego sterowania)
Możesz użyć ogólnego kontrolera MIDI do zdalnego sterowania prawie każdą funkcją Cubase. Po 
skonfigurowaniu urządzenia Generic Remote (Ogólnego zdalnego sterowania) możesz sterować 
określonymi parametrami za pomocą zdalnego urządzenia MIDI.

● Aby otworzyć stronę Generic Remote, wybierz Studio > Studio Setup (Studio > Konfiguracja   
   Studio) i z listy Devices (Urządzenia) wybierz Generic Remote.

          

Dostępne są następujące opcje:

MIDI Input (Wejście MIDI)
      Umożliwia wybór portu wejściowego MIDI, do którego podłączone jest urządzenie zdalne.
MIDI Output (Wyjście MIDI)
      Umożliwia wybór portu wyjściowego MIDI, do którego podłączone jest urządzenie zdalne.
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MIDI Remote Control Configuration (Konfiguracja zdalnego sterowania MIDI)
      Górna tabela przedstawia konfigurację zdalnego sterowania MIDI Twojego urządzenia 
      zdalnego.
Cubase Control Assignment (Przypisanie kontrolera Cubase)
      Dolna tabela umożliwia przypisanie elementów sterujących Cubase do zdalnego urządzenia.

POWIĄZANE LINKI
Sekcja dotycząca konfiguracji zdalnego sterowania MIDI na stronie 761
Sekcja przypisywania kontrolera Cubase na stronie 763

Sekcja konfiguracji zdalnego sterowania MIDI

Sekcja konfiguracji zdalnego sterowania MIDI jest pokazana w górnej tabeli strony konfiguracji 
Generic Remote (Ogólne zdalne).

● Aby otworzyć ustawienia Generic Remote, wybierz Studio > Studio Setup (Studio > 
Konfiguracja Studio) i z listy Devices (Urządzenia) wybierz Generic Remote

              

W górnej tabeli dostępne są następujące opcje:

Control Name (Nazwa kontrolera)
       Kliknij dwukrotnie to pole, aby zmienić nazwę kontrolki i wprowadź tę, która jest na przykład 
      zapisana w konsoli. Nazwa ta jest automatycznie odzwierciedlana w dolnej tabeli.
MIDI Status (Stan MIDI)
      Umożliwia określenie typu komunikatu MIDI wysyłanego przez element sterujący.
MIDI Channel (Kanał MIDI)
      Umożliwia wybór kanału MIDI, którym transmitowany jest kontroler.
Address (Adres)
      Umożliwia określenie numeru kontrolera ciągłego, wysokości nuty lub adresu kontrolera 
      ciągłego NRPN/RPN.
Max. Value (Maks. Wartość)
      Umożliwia określenie maksymalnej wartości przesyłanej przez sterowanie. Wartość ta jest 
      używana przez program do skalowania zakresu wartości kontrolera MIDI do zakresu wartości 
      parametru programu.
Flags (Flagi)
Umożliwia wybranie jednej z następujących flag:
      ●   Receive (Odbierz)
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           Aktywuj tę opcję, jeśli komunikat MIDI ma być przetwarzany podczas odbioru.
      ●   Transmit (Transmisja)
            Aktywuj tę opcję, jeśli po zmianie odpowiedniej wartości w programie ma być przesyłany 
            komunikat MIDI.
      ●   Relative (Względny)
            Aktywuj tę opcję, jeśli sterowanie jest nieskończonym enkoderem obrotowym, który podaje 
            liczbę obrotów zamiast wartości bezwzględnej.
      ●   Pick-up (Odbiór)
           Aktywuj tę opcję, jeśli chcesz, aby sterowanie pobierało parametr z wartością, na którą był 
           ostatnio ustawiony.

Przyciski i opcje po prawej stronie tabeli mają następujące funkcje:

Import
      Umożliwia importowanie zapisanych plików zdalnej konfiguracji.
Eksport
      Umożliwia eksport bieżącej konfiguracji z rozszerzeniem pliku .xml.
Add (Dodaj)
      Dodaje kontrolki na dole tabeli.
Delete (Usuń)
      Usuwa wybrany kontroler z tabeli.
Learn (Ucz się)
      Umożliwia przypisywanie komunikatów MIDI poprzez naukę.

Sekcja przypisania kontrolera Cubase
Możesz określić sekcję przypisania sterowania Cubase w dolnej tabeli strony konfiguracji Generic 
Remote (Ogólny zdalny). Każdy wiersz tabeli jest przypisany do kontrolera w odpowiednim 
wierszu tabeli konfiguracji zdalnego sterowania MIDI.

● Aby otworzyć ustawienia Generic Remote, wybierz Studio > Studio Setup (Studio > 
Konfiguracja Studio) i z listy Devices (Urządzenia) wybierz Generic Remote.

       

Dostępne są następujące opcje:

Control Name (Nazwa kontrolera)
       Odzwierciedla nazwę kontrolki wybraną w górnej tabeli.
Device (Urządzenie)
      Umożliwia wybór urządzenia Cubase, którym chcesz sterować.
Channel/Category (Kanał/kategoria)
      Umożliwia wybór kanału lub kategorii poleceń, którymi chcesz sterować.
Value/Action (Wartość/działanie)
      Umożliwia wybór parametru kanału, którym chcesz sterować. Jeśli wybrano urządzenie   
      Command (Komenda), w tym miejscu określa się działanie kategorii.
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Flags (Flagi)
      Umożliwia wybranie jednej z następujących flag:
      ●   Push Button (Naciśnij przycisk)
           Aktywuj tę opcję, jeśli parametr powinien być zmieniany tylko wtedy, gdy odebrany 
           komunikat MIDI ma wartość różną od 0.
      ●   Toggle (Przełącz)
           Aktywuj tę opcję, jeśli wartość parametru ma być przełączana pomiędzy wartością 
           minimalną i maksymalną po każdym odebraniu komunikatu MIDI.

           Można łączyć Push Button i Toggle w przypadku kontrolerów zdalnych, które nie blokują  
          stanu przycisku. Jest to przydatne, jeśli chcesz kontrolować stan wyciszenia za pomocą 
          urządzenia, na którym naciśnięcie przycisku wyciszenia włącza je, a zwolnienie przycisku 
          wyciszenia wyłącza.

      ●   Not Automated (Niezautomatyzowane)
          Aktywuj tę opcję, jeśli wartość parametru nie powinna być automatyzowana.

Przyciski po prawej stronie tabeli mają następującą funkcję:

Bank pop-up menu (Wyskakujące menu banku)
      Umożliwia zmianę banku. Jest to konieczne, jeśli na przykład Twoje urządzenie sterujące MIDI
      ma 16 tłumików głośności i używasz 32 kanałów MixConsole w Cubase.

Rename (Przemianuj)
      Umożliwia zmianę nazwy wybranego banku.
Add (Dodaj)
      Dodaje banki do wyskakującego menu.
Delete (Usuń)
      Usuwa wybrany bank z wyskakującego menu.

POWIĄZANE LINKI
Przypisywane urządzenia i funkcje na stronie 764

Przypisywane urządzenia i funkcje
Kolumna Device (Urządzenie) w sekcji Przypisanie kontrolera Cubase zawiera listę urządzeń 
Cubase, którymi możesz sterować.

Command (Komenda, polecenie)
   Umożliwia przypisanie poleceń Cubase, do których można przypisać polecenie klawiszowe.
   Jeśli wybierzesz opcję Add Track (Dodaj ścieżkę) w kolumnie Channel/Category   
   (Kanał/kategoria) i opcję Audio w kolumnie Value/Action (Wartość/działanie), możesz dodać 
   ścieżki audio na przykład za pomocą urządzenia MIDI.
VST Quick Controls Manager (Menedżer szybkich kontrolerów VST)
   Umożliwia przypisanie szybkich kontrolerów VST. Jeśli wybierzesz opcję Device (Urządzenie) w
   kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji Quick Control (Szybkie 
   sterowanie) w kolumnie Value/Action (Wartość/Działanie), możesz sterować szybkim 
   sterowaniem VST za pomocą urządzenia MIDI.
Midi Mixer (Mikser Midi)
   Umożliwia sterowanie funkcjami panelu Midi Mixer. Jeśli wybierzesz opcję Device (Urządzenie)
   w kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji w kolumnie Value/Action    
   (Wartość/Działanie), możesz sterować tą funkcją za pomocą urządzenia MIDI.
MMC Master (Mistrz MMC)
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   Umożliwia sterowanie funkcjami panelu MMC Master. Jeśli wybierzesz opcję Device 
   (Urządzenie) w kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji w kolumnie 
   Value/Action (Wartość/Działanie), możesz sterować tą funkcją za pomocą urządzenia MIDI.
Mixer (Mikser)
   Umożliwia kontrolowanie funkcji MixConsole. Jeśli wybierzesz jeden z dostępnych kanałów lub 
   opcję Selected (Wybrany) w kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji w 
   kolumnie Value/Action (Wartość/Działanie), możesz sterować funkcją tego konkretnego kanału 
   lub wybranego kanału za pomocą urządzenia MIDI.
Transport
   Umożliwia sterowanie funkcjami transportowymi. Jeśli wybierzesz opcję Device (Urządzenie)      
   w kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji w kolumnie Value/Action 
   (Wartość/Działanie), możesz sterować tą funkcją za pomocą urządzenia MIDI.
Metronome (Metronom)
   Umożliwia kontrolowanie funkcji metronomu. Jeśli wybierzesz opcję Device (Urządzenie)       
   w kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji w kolumnie Value/Action 
   (Wartość/Działanie), możesz sterować tą funkcją za pomocą urządzenia MIDI. 
VST Mixer (Mikser VST)
   Umożliwia kontrolowanie funkcji MixConsole. Jeśli wybierzesz jeden z dostępnych kanałów lub 
   Selected (Wybrany) w kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji w kolumnie
   Value/Action (Wartość/Działanie), możesz sterować funkcją tego konkretnego kanału lub    
   wybranego kanału za pomocą urządzenia MIDI.

VST Control Room (Reżyserka VST)
   Umożliwia sterowanie funkcjami Control Room. Jeśli wybierzesz opcję Device (Urządzenie)      
   w kolumnie Channel/Category (Kanał/kategoria) i jedną z opcji w kolumnie Value/Action 
   (Wartość/Działanie), możesz sterować tą funkcją za pomocą urządzenia MIDI.

UWAGA
Możesz także kontrolować wszystkie VST Instruments (Instrumenty VST), które dodałeś w oknie 
Project i które są wymienione w kolumnie Device (Urządzenie).

Przypisywanie komunikatów MIDI w trybie Learn (uczenia się)
W trybie Learn (nauki) możesz przypisywać komunikaty MIDI.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz opcję Generic Remote (Ogólne zdalne).
3. Aktywuj Learn (Ucz się).
4. Wybierz element sterujący w górnej tabeli i przesuń odpowiedni element sterujący na urządzeniu
    MIDI.

WYNIK
Wartości MIDI Status (statusu MIDI), MIDI Channel (kanału MIDI) i Address (Adresu) są 
automatycznie ustawiane na wartości przeniesionego elementu sterującego.

UWAGA
Jeśli używasz funkcji uczenia się dla elementu sterującego, który wysyła wartość zmiany programu,
Opcja Prog. Change Trigger (Zmień wyzwalacz) jest automatycznie wybierana w wyskakującym 
menu MIDI Status (Stan MIDI). Pozwala to na użycie różnych wartości parametru zmiany 
programu do sterowania różnymi parametrami w Cubase.
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Jeśli to nie daje oczekiwanego rezultatu, spróbuj zamiast tego użyć Prog. Change (Zmień program)
i zmień wartość.

Edytor zdalnego sterowania

Remote Control Editor (Edytor zdalnego sterowania) umożliwia zdefiniowanie własnego 
mapowania parametrów wtyczki VST na elementy sterujące obsługiwanych kontrolerów 
sprzętowych. Jest to przydatne, jeśli uważasz, że automatyczne mapowanie parametrów wtyczek do
urządzeń zdalnego sterowania nie jest zbyt intuicyjne.

● Aby otworzyć Remote Control Editor (Edytor zdalnego sterowania), kliknij prawym 
przyciskiem myszy panel wtyczki, którą chcesz zdalnie sterować, i wybierz Remote Control 
Editor.

 

1 Inspector (Inspektor)
      Zawiera ustawienia i przypisanie parametrów dla wybranej komórki. Górna część zawiera 
      ustawienia etykiety tekstowej. W dolnej części znajdują się ustawienia pokrętła i przełączników.
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2 Layout Selection (Wybór układu)
      Pokazuje nazwę układu. Kliknij, aby wybrać inny układ.
3 Set up Cell Layout (Skonfiguruj układ komórek)
      Otwiera Cell Layout Configuration (Konfigurację układu komórek), w której można określić 
      liczbę komórek na stronie i wybrać układ przełączników, którego chcesz użyć dla stron. Aby 
      określić liczbę przełączników dla komórki, włącz je/wyłącz.
4 Add New Hardware Layout (Dodaj nowy układ sprzętu)
      Dodaje nowy układ dla określonego typu sprzętu. Aby usunąć układ sprzętowy, kliknij przycisk
      Close (Zamknij).
5 Layout Section (Sekcja układu)
      Pokazuje układy reprezentujące urządzenia sprzętowe używane do zdalnego sterowania 
      parametrami wtyczki. Tutaj możesz zmienić przypisania parametrów, nazwę na etykiecie 
      tekstowej, konfigurację komórek oraz kolejność komórek i stron.
6 Toolbar (Pasek narzędzi)
      Pokazuje narzędzia do konfigurowania układu.
7 Status Bar (Pasek stanu)
      Wyświetla informacje o elemencie po umieszczeniu nad nim wskaźnika myszy w oknie edytora.

POWIĄZANE LINKI
Pasek narzędzi edytora zdalnego sterowania na stronie 767

Pasek narzędzi edytora zdalnego sterowania
Pokazuje narzędzia do konfigurowania układu.

Remove All Assignments (Usuń wszystkie przypisania)

        
       Usuwa wszystkie przypisania parametrów.
Get Default Factory Layout/Copy Layout from Other Tab (Uzyskaj domyślny układ 
fabryczny/skopiuj układ z innej karty)

        
       Przywraca domyślne ustawienia bieżącego układu lub kopiuje ustawienia z jednej strony 
      układu na inną.
Activate/Deactivate Learn Mode (Aktywuj/dezaktywuj tryb nauki)

        
       Aktywuje/dezaktywuje tryb nauki dla Edytora zdalnego sterowania.
Activate/Deactivate Assignment Inspection View (Aktywuj/dezaktywuj widok inspekcji 
przydziału)

        
       Pokazuje bieżące przypisanie wszystkich komórek w układzie.
Apply Current Layout (Zastosuj bieżący układ)

        
       Zapisuje ustawienia. Jeśli sprzęt obsługuje tę funkcję, zmiany są natychmiast odzwierciedlane 
       w kontrolerach sprzętowych.

Ustawienia sterowania
Możesz zdefiniować styl sterowania przełącznikami lub pokrętłami, do których przypisano funkcję.
Obejmuje to zmianę pierścienia LED lub zmianę jego zachowania, na przykład z ciągłego 
przedstawiania wartości na włączanie/wyłączanie.
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Aby otworzyć panel Control Settings (Ustawienia sterowania), kliknij element sterujący prawym 
przyciskiem myszy.
UWAGA
Nie wszystkie urządzenia sprzętowe obsługują wszystkie ustawienia typów sterowania.

Ustawienia typu sterowania dla pokręteł

             
Dla pokręteł dostępne są następujące typy sterowania:
Standard
   Standardowe pokrętło o niezdefiniowanym stylu LED.
Toggle Switch (Przełącznik)
   Pokrętło z 2 stanami.

LED Ring (Pierścień LED)
   Pierścień LED wokół pokrętła. Ustawienie zwiększa się w kierunku zgodnym z ruchem 
   wskazówek zegara.
LED Ring (counter-clockwise) (Pierścień LED (w kierunku przeciwnym do ruchu wskazówek 
zegara))
   Pierścień LED wokół pokrętła. Ustawienie zwiększa się w kierunku przeciwnym do ruchu 
   wskazówek zegara.
Center Width (Szerokość środka)
   Pierścień LED zaczynający się od górnej, środkowej pozycji, a gdy ustawienia się zwiększają,  
   dioda LED rośnie w obu kierunkach.
Center Neutral (Środkowy neutralny)
   Pokrętło rozpoczynające się w górnym środkowym położeniu i można je przesuwać w lewo lub w
   prawo, jak na przykład element sterujący panoramą.
Single Dot (Pojedyncza kropka)
   Pierścień LED wokół pokrętła. Ustawienie zwiększa się zgodnie z ruchem wskazówek zegara z 
   kropką wskazującą aktualną wartość.

Ustawienia typu sterowania dla przełączników
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Dla przełączników dostępne są następujące opcje:

Momentary (Chwilowo)
   Aktywuje przypisaną funkcję tak długo, jak długo trzymasz przełącznik.
Increasing Stepwise (Zwiększanie stopniowo)
   Przechodzi przez dostępne ustawienia, aż do osiągnięcia maksimum.
Decreasing Stepwise (Zmniejszanie stopniowo)
   Przechodzi przez dostępne ustawienia w odwrotnej kolejności, aż do osiągnięcia minimum.
Increasing Stepwise (cycle) (Zwiększanie krokowe (cykl))
   Przechodzi przez dostępne ustawienia, zaczynając od wartości minimalnej po osiągnięciu 
   wartości maksymalnej.
Decreasing Stepwise (cycle) (Zmniejszanie krokowe (cykl))
   Przechodzi przez dostępne ustawienia w odwrotnej kolejności, zaczynając od wartości 
   maksymalnej po osiągnięciu wartości minimalnej.
Smart Switch (Mądry przełącznik)
   Przełącza pomiędzy 2 stanami za każdym naciśnięciem przełącznika. Wejście w tryb Momentary
   (chwilowy), jeśli przytrzymasz przełącznik.

Invert Control Value (Odwróć wartość kontrolera)
   Odwraca stan/wartość sterowania.
Hide When Inactive (Ukryj, gdy jest nieaktywny)
   Ukrywa parametry wtyczki, gdy są nieaktywne lub wyłączone.

Przypisywanie parametrów do kontrolerów

PROCEDURA
1. Na pasku narzędzi Remote Control Editor (Edytora zdalnego sterowania) kliknij opcję     
    Activate/Deactivate Learn Mode (Aktywuj/Dezaktywuj tryb nauki).
2. Wybierz sterowanie, które chcesz przypisać do parametru wtyczki.
3. Wykonaj jedną z następujących czynności:
      ● Kliknij parametr na panelu wtyczek.
      ● Kliknij dwukrotnie element sterujący w Remote Control Editor (Edytorze zdalnego 
         sterowania) i wybierz parametr z listy dostępnych parametrów wtyczki.
4. Naciśnij Esc, aby zakończyć tryb Learn (nauki).

WYNIK
Parametr jest przypisany do kontrolera.

UWAGA
Aby usunąć przypisanie parametrów do komórki, aktywuj tryb Learn (uczenia się), wybierz 
komórkę i naciśnij klawisz Delete lub Backspace.

POWIĄZANE LINKI
Pasek narzędzi edytora zdalnego sterowania na stronie 767

Edycja Layout (układu)

W sekcji układu możesz wykonać szereg operacji edycyjnych i uporządkować strony według 
własnych upodobań.
● Aby nawigować między komórkami, użyj klawiszy kursora.
● Aby przeglądać elementy sterujące w komórkach w trybie Learn (nauki), naciśnij klawisz Shift i 
   użyj klawiszy kursora.
● Aby przeglądać różne układy, użyj Tab i Shift - Tab .
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● Aby skopiować ustawienia z jednej komórki do drugiej, wybierz komórkę, naciśnij klawisz Alt i 
   przeciągnij ją do innej komórki.
● Aby przenieść komórkę, przeciągnij ją do pustej komórki.
● Aby zamienić zawartość 2 komórek, naciśnij klawisz Ctrl/Cmd i przeciągnij jedną komórkę do 
   drugiej.
UWAGA
Przeciąganie i upuszczanie działa także pomiędzy różnymi stronami.

● Aby dodać stronę do układu, kliknij Add New Page (Dodaj nową stronę).

        

● Aby usunąć stronę, kliknij Remove Current Page (Usuń bieżącą stronę).
● Aby określić etykietę komórki, użyj 3 górnych pól tekstowych w Inspector (Inspektorze).
Pierwsze pole tekstowe pokazuje długą nazwę, tak jak jest ona pokazana w komórce. W drugim 
polu możesz wpisać nazwę, która może zawierać maksymalnie 8 znaków, a w trzecim maksymalnie
4 znaki.

UWAGA
Jest to przydatne, jeśli na przykład urządzenia sprzętowe mają pola wartości wyświetlające tylko 
ograniczoną liczbę znaków.

Joysticki
Możesz użyć joysticka do zdalnego sterowania operacjami panoramowania w Cubase. Może to być 
przydatne na przykład do tworzenia gładkich krzywych automatyzacji.

● Aby użyć joysticka do zdalnego sterowania, podłącz go do komputera i uruchom ponownie 
   Cubase. Po ponownym uruchomieniu aplikacji joystick zostaje automatycznie aktywowany.

POWIĄZANE LINKI
Przesuwanie za pomocą joysticka na stronie 688
Dezaktywacja joysticków na stronie 770

Dezaktywacja joysticków
Jeśli masz joystick podłączony do swojego systemu, ale nie chcesz go używać z Cubase, możesz go
dezaktywować.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz urządzenie z joystickiem.
    Dostępne ustawienia urządzenia są pokazane po prawej stronie.
3. Dezaktywuj odpowiednią opcję.

Szybkie kontrolery ścieżki

Jeśli posiadasz zewnętrzne urządzenie do zdalnego sterowania, możesz je skonfigurować tak, aby 
kontrolowało maksymalnie 8 parametrów każdej ścieżki audio, ścieżki MIDI lub ścieżki 
instrumentu, korzystając z funkcji Track Quick Controls (Szybkie kontrolery ścieżki) w Cubase.
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POWIĄZANE LINKI
Podłączanie szybkich elementów sterujących ścieżki do pilotów zdalnego sterowania na stronie 754

Szybkie kontrolery VST

Jeśli posiadasz zewnętrzne urządzenie zdalnego sterowania, możesz kontrolować maksymalnie 8 
parametrów instrumentu VST, korzystając z funkcji VST Quick Controls (Szybkie kontrolery 
VST) w Cubase.

POWIĄZANE LINKI
Podłączanie szybkich elementów sterujących ścieżki do pilotów zdalnego sterowania na stronie 754
Szybkie sterowanie VST na stronie 739

Parametry MIDI w czasie rzeczywistym i Efekty MIDI

Czas rzeczywisty MIDI oznacza, że możesz zmieniać lub przekształcać zdarzenia MIDI na 
ścieżkach MIDI lub Instrument, zanim zostaną wysłane do wyjść MIDI. Umożliwia to zmianę 
sposobu odtwarzania danych MIDI.

Nie ma to wpływu na rzeczywiste zdarzenia MIDI na ścieżce. Dlatego zmiany MIDI w czasie 
rzeczywistym nie są odzwierciedlane w żadnym edytorze MIDI.

Następujące funkcje umożliwiają zmianę zdarzeń MIDI w czasie rzeczywistym:
● Parametry ścieżki MIDI
● Modyfikatory MIDI
● Efekty MIDI
● Transpose (Transpozycja) i Velocity (Prędkość) w linii informacyjnej

UWAGA
Jeśli chcesz przekonwertować ustawienia ścieżki na rzeczywiste zdarzenia MIDI, wybierz opcję 
MIDI > Freeze MIDI Modifiers (MIDI > Zamroź modyfikatory MIDI) lub MIDI > Merge MIDI 
in Loop (MIDI > Scal MIDI w pętli).

POWIĄZANE LINKI
Łączenie zdarzeń MIDI w nową część na stronie 793

Parametry ścieżki MIDI
Parametry ścieżek MIDI znajdują się w najwyższej sekcji Inspektora dla ścieżek MIDI 
i ścieżek Instrument.

Ustawienia te albo wpływają na podstawową funkcjonalność ścieżki (wyciszenie, solo, włączenie 
nagrywania itp.), albo wysyłają dodatkowe dane MIDI do podłączonych urządzeń (zmiana 
programu, głośność itp.).
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Następujące parametry ścieżki umożliwiają zmianę zdarzeń MIDI w czasie rzeczywistym:
● Głośność (Volume) MIDI
● Panorama (Pan) MIDI
● Opóźnienie (Delay) ścieżki
● Transformator wejściowy (Input Transformer)

POWIĄZANE LINKI
Inspektor ścieżek MIDI na stronie 134
Transformator wejściowy na stronie 771

Transformator wejściowy (Input Transformer)

Input Transformer (Transformator wejściowy) umożliwia filtrowanie i zmianę danych MIDI 
przychodzących na ścieżkę MIDI przed jej nagraniem.

Użyj Input Transformer do następujących celów:
● Skonfiguruj kombinacje rozdzielonych klawiatur do nagrywania oddzielnie lewej i prawej ręki.
● Konwertuj kontroler, taki jak pedał nożny, na nuty MIDI (w celu prawidłowego grania na bębnie 
   basowym).
● Odfiltruj określony typ danych MIDI tylko na jednym kanale MIDI.
● Zamień aftertouch w dowolny kontroler i odwrotnie.
● Odwróć prędkość lub wysokość dźwięku.

Okno Input Transformer (Transformatora wejściowego)

Aby otworzyć okno Input Transformer, wykonaj jedną z poniższych czynności:
● Wybierz ścieżkę MIDI lub Instrument, kliknij Input Transformer i wybierz Global (Globalny).
   Umożliwia to dokonanie ustawień wpływających na wszystkie wejścia MIDI i wszystkie ścieżki 
   MIDI.
● Wybierz ścieżkę MIDI lub ścieżkę Instrument, kliknij Input Transformer i wybierz opcję   
   Local (Lokalny). Umożliwia to dokonanie ustawień tylko dla wybranej ścieżki.
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Okno Input Transformer zawiera następujące parametry:
Select Preset (Wybierz ustawienie wstępne)
      Umożliwia wybór ustawienia wstępnego transformatora wejściowego.
Module selector (Selektor modułów)
      Umożliwia przeglądanie i edycję modułu.
Filter conditions list (Lista warunków filtra)
      Umożliwia ustawienie warunków filtrowania, określających, które elementy mają zostać 
      znalezione. Lista może zawierać jeden lub kilka warunków, każdy w osobnej linii.
Action list (Lista czynności)
      Umożliwia określenie wszelkich zmian dokonanych w znalezionych zdarzeniach.

Function pop-up menu (Wyskakujące menu funkcji)
      Umożliwia wybór pomiędzy Filter (Filtrowaniem) i Transform (Przekształcaniem) jako  
      podstawowym rodzajem edycji.

Określanie warunków filtra

PROCEDURA
1. Wybierz ścieżkę MIDI lub ścieżkę instrumentu.
2. Wykonaj jedną z następujących czynności:
      ● Aby dokonać ustawień mających wpływ na wszystkie ścieżki MIDI, otwórz Inspektora, 
         kliknij Input Transformer (Transformator wejściowy) i wybierz Global (Globalne) 
         z wyskakującego menu.
      ● Aby dokonać ustawień wpływających na wybraną ścieżkę MIDI, otwórz Inspektora, kliknij 
         Input Transformer i wybierz Local (Lokalny) z wyskakującego menu.
3. Otwórz menu podręczne Function (Funkcja) i wykonaj jedną z następujących czynności:
     ● Wybierz opcję Filter (Filtruj), jeśli chcesz filtrować znalezione zdarzenia.
     ● Wybierz opcję Transform (Przekształć), jeśli chcesz przekształcić znalezione zdarzenia.
4. Kliknij +, aby dodać linię do listy warunków filtra.
5. Na liście warunków filtra określ warunki do dopasowania, klikając kolumny Filter Target (Cel 
    filtru), Condition (Warunek) i Parameter (Parametr) i wybierając opcje z wyskakującego menu.
6. Na liście akcji określ sposób przekształcania lub filtrowania znalezionych zdarzeń, klikając 
    kolumny Action Target (Cel akcji), Operation (Operacja) i Parameter (Parametr) i wybierając 
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    opcje z wyskakującego menu.

UWAGA
Możesz także wybrać ustawienie wstępne z wyskakującego menu Select Preset (Wybierz 
ustawienie wstępne), aby określić warunki i działania.

WYNIK
Ustawienia mają wpływ na wszystkie zdarzenia MIDI nagrywane na ścieżce.

PO ZAKOŃCZENIU TEGO ZADANIA
W Inspektorze kliknij Input Transformer (Transformator wejściowy) i wybierz Off (Wyłącz). 
W przeciwnym razie transformator wejściowy będzie nadal aktywny.

Modyfikatory MIDI
Modyfikatory MIDI umożliwiają modyfikowanie zdarzeń MIDI podczas odtwarzania.

Możesz ich używać do następujących celów:
      ● Aby zmodyfikować już istniejące zdarzenia MIDI na ścieżkach MIDI lub instrumentach.
      ● Aby modyfikować zdarzenia MIDI odtwarzane na żywo.

UWAGA
Aby grać na żywo, wybierz i włącz nagrywanie ścieżki, a następnie aktywuj MIDI Thru Active 
w oknie dialogowym Preferences (Preferencje) (strona MIDI).

Sekcja MIDI Modifiers (modyfikatorów MIDI)

● Aby otworzyć sekcję MIDI Modifiers, wybierz ścieżkę MIDI i w Inspektorze kliknij MIDI 
   Modifiers.

                          

783



UWAGA
Jeśli chcesz porównać wynik ustawień modyfikatora z nieprzetworzonym MIDI, możesz użyć 
przycisku obejścia (bypass) w sekcji modyfikatorów MIDI. Jeśli ten przycisk jest aktywny, 
ustawienia modyfikatorów MIDI są tymczasowo wyłączone.

               

Transpose (Transponuj)
   Umożliwia transpozycję wszystkich nut na ścieżce w półtonach. Ekstremalne transpozycje mogą 
   dać dość dziwne i niepożądane rezultaty.
Velocity Shift (Zmiana prędkości)
   Umożliwia dodanie wartości dynamiki do wszystkich nut na ścieżce. Wartości dodatnie 
   zwiększają prędkość, a wartości ujemne zmniejszają prędkość
Length Compression (Kompresja długości)
   Umożliwia dodanie mnożnika do długości wszystkich nut na ścieżce. Wartość jest ustawiana za    
   pomocą licznika i mianownika
Velocity Compression (Kompresja prędkości)
   Umożliwia dodanie mnożnika do dynamiki wszystkich nut na ścieżce. Wartość jest ustawiana za 
   pomocą licznika i mianownika. Parametr ten wpływa również na różnice dynamiki pomiędzy 
   nutami, kompresując lub rozszerzając w ten sposób skalę dynamiki. Wartości mniejsze niż 1/1 
   kompresują zakres prędkości. Wartości większe niż 1/1 wraz z ujemnymi wartościami 
   przesunięcia prędkości rozszerzają zakres prędkości.

WAŻNE
Maksymalna prędkość velocity wynosi zawsze 127, niezależnie od tego, jak bardzo próbujesz się 
rozwinąć.

UWAGA
Połącz to ustawienie z parametrem Velocity Shift.

Random 1/Random 2 (Losowe 1/Losowe 2)
   Umożliwia wprowadzenie losowych odmian różnych właściwości nut MIDI.
Range 1/Range 2 (Zakres 1/Zakres 2)
   Umożliwia określenie zakresu wysokości lub dynamiki i wymuszenie dopasowania wszystkich 
   nut do tego zakresu lub wykluczenie z odtwarzania wszystkich nut spoza tego zakresu.

HMT: Apply Tuning (HMT: Zastosuj strojenie)
   Aktywuj tę opcję, aby zastosować strojenie Hermode do nut granych na tej ścieżce.
HMT: Use for Analysis (HMT: Użyj do analizy)
   Aktywuj tę opcję, aby użyć nut zagranych na tej ścieżce do obliczenia ponownego dostrojenia.

POWIĄZANE LINKI
Okno dialogowe konfiguracji skali muzycznej na stronie 952

Konfigurowanie losowych odmian
Możesz ustawić losowe warianty pozycji, wysokości (pitch), prędkości (velocity) i długości zdarzeń
MIDI za pomocą jednego lub dwóch generatorów losowych.

PROCEDURA
1. Wybierz ścieżkę MIDI lub ścieżkę instrumentu.
2. W Inspektorze otwórz sekcję MIDI Modifiers (Modyfikatory MIDI).
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3. Otwórz jedną z sekcji Random (Losowe) i w wyskakującym menu Random Target (Losowy 
    cel) wybierz właściwość notatki, którą chcesz losować.
4. Określ granice randomizacji w polach wartości.
    Wartości będą się różnić pomiędzy wartością minimalną i maksymalną. Nie można ustawić 
    wartości minimalnej wyższej niż wartość maksymalna.
5. Opcjonalnie: Powtórz dla innych wartości losowych.
6. Odtwórz utwór, aby usłyszeć losowe zdarzenia.

WYNIK
Odpowiednie właściwości są losowe.

UWAGA
W zależności od zawartości utworu niektóre zmiany mogą nie być od razu zauważalne lub mogą 
nie mieć żadnego efektu.

PO ZAKOŃCZENIU TEGO ZADANIA
Dezaktywuj funkcję losową, otwierając menu podręczne Random Target (Losowy cel) 
i wybierając opcję Off (Wyłączone).

Konfigurowanie zakresów
Można odfiltrować wysokości lub prędkości, które nie mieszczą się w określonym zakresie, lub 
wymusić ich dopasowanie do określonego zakresu.

PROCEDURA
1. Wybierz ścieżkę MIDI lub ścieżkę instrumentu.
2. W Inspektorze otwórz sekcję MIDI Modifiers (Modyfikatory MIDI).
3. Otwórz jedną z sekcji Range (Zakres) i w wyskakującym menu Range Target (Cel zakresu) 
    wybierz tryb.
4. Ustaw wartości minimalne i maksymalne w dwóch polach po prawej stronie.

UWAGA
Możesz dokonać niezależnych ustawień dla dwóch sekcji Range (Zakres).

PO ZAKOŃCZENIU TEGO ZADANIA
Aby dezaktywować tę funkcję, otwórz menu podręczne Range Target (Cel zakresu) i wybierz Off 
(Wyłączone).

Tryby zasięgu

W wyskakującym menu Range Target (Cel zasięgu) możesz wybrać różne tryby zasięgu. Wartości
są pokazane jako liczby od 0 do 127 dla trybów dynamiki i jako numery nut od C-2 do G8 dla 
trybów wysokości dźwięku.

Vel. Limit
Umożliwia wymuszenie dopasowania wszystkich wartości prędkości (velocity) do zakresu 
określonego za pomocą wartości minimalnej i maksymalnej. Wartości poniżej dolnego limitu są 
ustawiane na wartość minimalną, wartości prędkości powyżej wyższego ustawienia są ustawiane na
wartość maksymalną.
Vel. Filter (Velocity Filtr)
Umożliwia odfiltrowanie nut o wartościach dynamiki poniżej wartości minimalnej lub powyżej 
wartości maksymalnej.
Note Limit (Nuta Limit)
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Umożliwia transpozycję wszystkich nut poniżej wartości min. minimalnej w górę i wszystkich nut 
max. powyżej wartości maksymalnej w dół w krokach oktawowych.
Note Filter (Nuta Filtr)
Umożliwia odfiltrowanie nut niższych niż wartość min minimalna lub wyższych niż wartość max  
maksymalna

Stosowanie strojenia Hermode
Strojenie Hermode zmienia strojenie granych nut. Tworzy na przykład wyraźne częstotliwości dla 
co piątego i trzeciego interwału. Ponowne strojenie wpływa tylko na poszczególne nuty i utrzymuje
relację wysokości między tonacjami i nutami. Ponowne strojenie jest procesem ciągłym i 
uwzględnia kontekst muzyczny.

PROCEDURA
1. Wybierz ścieżkę MIDI lub ścieżkę instrumentu.
2. W Inspektorze otwórz sekcję MIDI Modifiers (Modyfikatory MIDI).
3. Aktywuj HMT: Apply Tuning (HMT: Zastosuj strojenie).
4. Aktywuj HMT: Use for Analysis (HMT: Użyj opcji Analiza), aby wykorzystać grane nuty do 
    obliczenia ponownego dostrojenia.

UWAGA
Jeśli używasz utworów z pianinem akustycznym, aktywuj HMT: Use for Analysis (HMT: Użyj do 
analizy) i dezaktywuj HMT: Apply Tuning (HMT: Zastosuj strojenie). Wyklucza to możliwość 
strojenia fortepianu, które brzmiałoby nienaturalnie.

5. Wybierz opcję Project > Priject Setup (Projekt > Ustawienia projektu), aby otworzyć okno 
    dialogowe Project Setup (Ustawienia projektu).
6. Otwórz menu podręczne HMT Type (Typ HMT) i wybierz jedną z opcji.
7. Zagraj kilka nut. 
   Przeliczenie wszystkich nut i usłyszenie wyników ponownego dostrojenia może zająć chwilę.

UWAGA
Nuty generowane przez wtyczki MIDI nie są brane pod uwagę.

WYNIK
Jeśli używasz instrumentu VST 3 obsługującego technologię Micro Tuning i Note Expression, nuty 
są dostrajane dynamicznie podczas ich gry. W przypadku instrumentów VST obsługujących funkcję
Note Expression działa to również w trybie MIDI Thru.

Jeśli używasz ścieżki, na której jest załadowany instrument VST 2, grane nuty są dostrajane po 
każdym naciśnięciu klawisza.

POWIĄZANE LINKI
Strojenie Hermode’a na stronie 777

Strojenie Hermode'a
Możesz wybrać różne typy strojenia Hermode.

● Aby wybrać typ strojenia Hermode, wybierz Project > Project Setup (Projekt > Ustawienia  
   projektu) i wybierz opcję z wyskakującego menu HMT Type (Typ HMT). 
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Dostępne są następujące opcje:
None (Nic)
      Nie stosuje się strojenia.
Reference (pure 3/5) (Odniesienie (czyste 3/5))
      Stroi czyste tercje i kwinty.
Classic (pure 3/5 equalized) (Klasyczny (czysty, wyrównany 3/5))
      Stroi czyste tercje i kwinty. W sytuacjach konfliktowych stosuje się lekkie wyrównanie. Ten typ
      strojenia jest odpowiedni dla każdego rodzaju muzyki.
Pop-Jazz (3/5/7)
      Stroi czyste tercje i kwinty oraz naturalne septymy. Tego typu strojenia nie należy stosować do 
      muzyki polifonicznej. Spróbuj tego z popem lub jazzem.
Baroque (3/5 adaptive) (Barok (3/5 adaptacyjny))
      Stroi czyste tercje i kwinty. Stopień czystości zmienia się w zależności od kolejności harmonii. 
      Ten typ strojenia jest odpowiedni do odtwarzania organów kościelnych i muzyki polifonicznej.

Zamrażanie modyfikatorów MIDI
Możesz trwale zastosować wszystkie ustawienia filtra do wybranej ścieżki. Ustawienia zostaną 
zastosowane do zdarzeń na ścieżce, a wszystkie modyfikatory zostaną wyzerowane.

PROCEDURA
1. Wybierz ścieżkę MIDI.
2. Wybierz opcję MIDI > Freeze MIDI Modifiers (MIDI > Zablokuj modyfikatory MIDI).

WYNIK
Następujące ustawienia zostały zamrożone:  
● Kilka ustawień w górnej części Inspektora, takich jak Delay (Opóźnienie), Program Selector   
   (Selektor Programów) i Bank Selector (Selektor Banków).
● Ustawienia w sekcji MIDI Modifiers (Modyfikatory MIDI), takie jak Transpose    
   (Transpozycja), Vel. Shift (Vel. Przesunięcie), Vel. Comp. (Vel. Komp.) i Len. Comp. (Len. 
   komp.).
● Ustawienia w sekcji MIDI Inserts (Wstawki MIDI), takie jak arpeggiatory.
● Ustawienia linii informacyjnej Transpose (Transpozycja) i Velocity (Prędkość).

POWIĄZANE LINKI
Inspektor ścieżek MIDI na stronie 134

Efekty MIDI
Efekty MIDI umożliwiają transformację danych MIDI odtwarzanych ze ścieżki w czasie 
rzeczywistym.

Możesz dodawać nowe zdarzenia, używając efektów MIDI lub zmieniać właściwości zdarzeń 
MIDI, na przykład tonację
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UWAGA
Dołączone wtyczki efektów MIDI są opisane w oddzielnym dokumencie Plug-in Reference 
(Informacje o wtyczkach).

MIDI Inserts (Wstawki MIDI)
Efekty wstawek MIDI są wstawiane do łańcucha sygnałowego kanałów MIDI. Jeśli do ścieżki 
MIDI dodasz efekt INSERT, zdarzenia MIDI na ścieżce zostaną przesłane do efektu i przez niego 
przetworzone. Cały sygnał przechodzi przez efekt.

● Aby otworzyć sekcję MIDI Inserts, wybierz ścieżkę MIDI i w Inspektorze kliknij opcję MIDI 
   Inserts.

                       

Można dodać maksymalnie cztery efekty MIDI. Dostępne są następujące parametry:

Bypass (Obejście)
      Umożliwia ominięcie wszystkich efektów wstawiania ścieżki.
Activate Insert (Aktywuj Wstaw)
      Umożliwia włączenie/wyłączenie wybranego efektu.
Open/Close Insert Effect Editor (Otwórz/zamknij edytor efektów wstawiania)
      Umożliwia otwarcie/zamknięcie panelu sterowania dla wybranego efektu. W zależności od 
      efektu może się to pojawić w oddzielnym oknie lub pod szczeliną wstawiania w Inspektorze

Select Effect Type (Wybierz typ efektu)
      Umożliwia wybranie i aktywację efektu oraz otwarcie jego panelu sterowania. Aby usunąć 
      efekt, wybierz opcję No Effect (Brak efektu).
Record Output to Track (Nagraj wyjście na ścieżkę)
      Umożliwia nagranie wyjścia efektu MIDI na ścieżce MIDI lub ścieżce instrument.
UWAGA
Aby otworzyć oddzielny panel sterowania dla efektów, które wyświetlają swoje elementy sterujące 
w Inspektorze, naciśnij klawisz Alt i kliknij opcję Open/Close Insert Effect Editor 
(Otwórz/zamknij Edytor efektów wstawiania).

Stosowanie efektu MIDI Insert
Do ścieżki MIDI można zastosować efekty MIDI.

PROCEDURA
1. Wybierz ścieżkę MIDI.
2. W Inspektorze otwórz sekcję MIDI Inserts (Wstawki MIDI).
3. Kliknij opcję Select Effect Type (Wybierz typ efektu), aby otworzyć wyskakujące menu efektów
    MIDI.
4. Wybierz efekt MIDI z wyskakującego menu.

WYNIK

788



Efekt zostanie automatycznie aktywowany i otworzy się jego panel sterowania, umożliwiający 
dokonanie ustawień efektu. Całe MIDI ze ścieżki jest kierowane przez efekt.
UWAGA
Dołączone efekty MIDI opisano w osobnym dokumencie Plug-in Reference (Informacje o 
wtyczkach).

Nagrywanie efektu insertowego MIDI
Można nagrywać wyjście efektu MIDI, co oznacza, że zdarzenia są tworzone bezpośrednio na 
ścieżce MIDI lub instrumentu.

PROCEDURA
1. W obszarze globalnego sterowania utworami na liście utworów kliknij opcję Add Track (Dodaj 

ścieżkę)  .
2. Kliknij Instrument.
3. Otwórz menu podręczne Instrument i wybierz VST Instrument (Instrument VST).
4. Kliknij opcję Add Track (Dodaj ścieżkę).
    Ścieżka instrumentu zostanie dodana do listy ścieżek i otworzy się panel sterowania wybranego 
    instrumentu VST.
5. Na ścieżce instrumentu aktywuj opcję Record Enable (Włącz nagrywanie).
6. W Inspektorze otwórz sekcję MIDI Inserts (Wstawki MIDI).
7. Kliknij pierwsze miejsce na efekt wstawiania i wybierz efekt wstawiania MIDI.
8. Aktywuj Record Output to Track (Wyjście nagrywania na ścieżkę).

             
9. Na panelu Transport aktywuj opcję Record (Nagrywaj) i użyj klawiatury MIDI lub On-Screen 
    Keyboard (klawiatury ekranowej), aby zagrać nuty.

WYNIK
Grane nuty są modyfikowane za pomocą efektu MIDI i nagrywane bezpośrednio na ścieżce.

PO ZAKOŃCZENIU TEGO ZADANIA
Możesz na przykład edytować nagrane zdarzenia MIDI w Key Editor.

MIDI Sends (Wysyłki MIDI)
Jeśli używasz efektu wysyłania, zdarzenia MIDI są wysyłane zarówno na wyjście ścieżki MIDI, jak
i do efektu wysyłającego. W ten sposób otrzymujesz zarówno nieprzetworzone zdarzenia MIDI, jak
i wyjście efektu MIDI. Należy pamiętać, że efekt może wysyłać przetworzone dane MIDI do 
dowolnego wyjścia MIDI, niekoniecznie do tego używanego przez ścieżkę.

● Aby otworzyć sekcję MIDI Sends, wybierz ścieżkę MIDI i w Inspektorze kliknij opcję MIDI 
   Sends.
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Można dodać maksymalnie cztery efekty wysyłkowe MIDI.

Bypass (Obejście)
      Umożliwia ominięcie wszystkich efektów wysyłkowych dla ścieżki.
Activate Send (Aktywuj Wysyłkę)
      Umożliwia włączenie/wyłączenie wybranego efektu.
Pre/Post (Przed/Po)
      Aktywuj tę opcję, aby wysyłać sygnały MIDI do efektów wysyłkowych przed modyfikatorami 
      MIDI i efektami wstawiania.
Open/Close Send Effect Editor (Otwórz/zamknij edytor efektów wysyłkowych)
      Umożliwia otwarcie/zamknięcie panelu sterowania dla wybranego efektu. W zależności od 
      efektu może się to pojawić w oddzielnym oknie lub poniżej pola wysyłania w Inspektorze.
Select Effect Type (Wybierz typ efektu)
      Umożliwia wybranie i aktywację efektu oraz otwarcie jego panelu sterowania. Aby usunąć 
      efekt, wybierz opcję No Effect (Brak efektu).
MIDI Send Destination (Miejsce docelowe wysyłki MIDI)
      Pozwala określić, do którego wyjścia MIDI wysyłane są przetworzone zdarzenia MIDI.
MIDI Send Channel (Kanał wysyłający MIDI)
      Umożliwia określenie, którym kanałem MIDI przesyłane są przetworzone zdarzenia MIDI.

UWAGA
Aby otworzyć oddzielny panel sterowania dla efektów, które wyświetlają swoje elementy sterujące 
w Inspektorze, naciśnij klawisz Alt i kliknij opcję Open/Close Send Effect Editor 
(Otwórz/zamknij edytor efektów wysyłania).

Presets (Ustawienia wstępne)
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Niektóre efekty MIDI są dostarczane z wieloma ustawieniami wstępnymi do natychmiastowego 
użycia.

                    

1   MIDI In/MIDI Out Activity (Działanie MIDI In/MIDI Out)
     Wskazuje, czy wtyczka odbiera lub przesyła dane MIDI.
2   Save Preset/Remove Preset (Zapisz ustawienie wstępne/Usuń ustawienie wstępne)
     Umożliwia zapisanie ustawień jako ustawienie wstępne lub usunięcie zapisanych ustawień 
     wstępnych. Zapisane ustawienia wstępne są dostępne w wyskakującym menu Wybierz 
     ustawienie wstępne dla wszystkich wystąpień danej wtyczki MIDI i we wszystkich projektach.

Transpose (Transpozycja) i Velocity (prędkość) w linii 
informacyjnej
W wierszu informacyjnym możesz edytować transpozycję i dynamikę wybranych partii MIDI. Ma 
to wpływ tylko na odtwarzane nuty.

● Użyj pola Transpose (Transpozycja), aby dokonać transpozycji wybranych partii w krokach  
    półtonowych.
    Wartość zostanie dodana do zestawu transpozycji dla całej ścieżki.
● Użyj pola Velocity (Prędkość), aby przesunąć prędkość dla wybranych części.
   Wartość jest dodawana do prędkości nut w partiach.

POWIĄZANE LINKI
Funkcje transpozycji na stronie 328
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Korzystanie z urządzeń MIDI

MIDI Device Manager (Menedżer urządzeń MIDI) umożliwia pracę z urządzeniami MIDI, czyli 
reprezentacjami zewnętrznego sprzętu MIDI.

Możesz zainstalować gotowe urządzenia MIDI lub zdefiniować nowe. Jest to przydatne do 
globalnej kontroli i wyboru brzmień. 
Możesz tworzyć panele urządzeń MIDI i tworzyć mapy urządzeń, w których każdy parametr 
urządzenia zewnętrznego lub instrumentu VST może być kontrolowany i automatyzowany z 
poziomu Cubase.

POWIĄZANE LINKI
Panele urządzeń na stronie 788

Program Change Messages and Bank Select Messages (Komunikaty o 
zmianie programu i komunikaty o wyborze banku)
Aby wybrać zestaw, czyli dźwięk w urządzeniu MIDI, musisz wysłać do tego urządzenia 
komunikat o zmianie programu (program change).

Program Change Messages (Komunikaty o zmianie programu)
Można nagrywać komunikaty o zmianie programu lub wprowadzać je w partii MIDI. Możesz 
otworzyć Inspektora ścieżki MIDI i wybrać wartość w polu Program Selector (Wybór programu).

Komunikaty o zmianie programu umożliwiają wybór pomiędzy 128 różnymi zestawami w 
urządzeniu MIDI.

Bank Select Messages (Wiadomości wyboru banku)
Wiele instrumentów MIDI zawiera jednak większą liczbę lokalizacji brzmień. Aby udostępnić je z 
poziomu Cubase, musisz wysłać wiadomości dotyczące wyboru banku.
Komunikaty wyboru banku umożliwiają wybór pomiędzy 128 różnymi programami w urządzeniu 
MIDI.
Jeśli Twoje urządzenie obsługuje wybór banku MIDI, możesz otworzyć Inspektora ścieżki MIDI 
i wybrać wartość w polu Bank Selector (Selektor banku), aby wybrać bank, a następnie użyć pola  
Program Selector (Selektor programów), aby wybrać program w tym banku.

              
Niestety, różni producenci instrumentów stosują różne schematy konstruowania komunikatów 
wyboru banku, co może prowadzić do pewnych nieporozumień i utrudniać wybór prawidłowego 
brzmienia. Ponadto wybieranie brzmień według numerów wydaje się niepotrzebnie kłopotliwe, 
ponieważ większość instrumentów używa obecnie nazw swoich brzmień.

MIDI Device Manager (Menedżer urządzeń MIDI) pozwala określić, jakich urządzeń MIDI 
używasz i wybrać, do którego urządzenia będzie kierowana każda ścieżka MIDI. Umożliwia to 
wybieranie brzmień według nazwy na liście utworów lub w Inspektorze.

POWIĄZANE LINKI
Menedżer urządzeń MIDI na stronie 783
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Patch Banks (Banki brzmień)
Lista Patch Banks może zawierać dwa lub więcej banków głównych, w zależności od wybranego 
urządzenia.
Wynika to z faktu, że w instrumentach różne rodzaje brzmień są obsługiwane w różny sposób. Na 
przykład brzmienia to zazwyczaj zwykłe programy, które można grać pojedynczo. Jednakże 
wykonania mogą być kombinacją programów, które można podzielić na klawiaturę, nałożyć na 
siebie lub wykorzystać do odtwarzania wielodźwiękowego i tak dalej.

W przypadku urządzeń z kilkoma bankami możesz wybrać opcję Bank Assignment (Przypisanie 
Banku), aby określić, którego banku powinien używać konkretny kanał MIDI.

            

Bank Assignment (Przypisanie banku) wpływa na to, który bank będzie wyświetlany po wybraniu 
programów według nazwy dla urządzenia na liście utworów lub w Inspektorze.

Wiele instrumentów wykorzystuje na przykład kanał MIDI 10 jako ekskluzywny kanał perkusyjny. 
W takim przypadku wybierz Drums (zestaw perkusyjny), Rhythm Set (zestaw rytmiczny) lub 
Percussion bank (bank perkusyjny) dla kanału 10 z tej listy. Umożliwia to wybór pomiędzy 
różnymi zestawami perkusyjnymi na liście utworów lub w Inspektorze.

Ograniczenia

Nie ma łatwego sposobu zaimportowania skryptu nazwy poprawki do istniejącego urządzenia 
MIDI. Aby zapoznać się ze złożonym obejściem opartym na edycji XML, zobacz oddzielny 
dokument MIDI Devices (Urządzenia MIDI).

MIDI Device Manager (Menedżer urządzeń MIDI)
Menedżer urządzeń MIDI umożliwia instalację gotowych urządzeń MIDI lub zdefiniowanie 
nowych.

● Aby otworzyć MIDI DevIce Manager (Menedżera urządzeń MIDI), wybierz Studio > More 
Options > MIDI Device Manager (Studio > Więcej opcji > Menedżer urządzeń MIDI).
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Installed Devices list (Lista zainstalowanych urządzeń)
   Wyświetla listę podłączonych urządzeń MIDI i zaimportowanych konfiguracji urządzeń.
Install Device (Zainstaluj urządzenie)
   Umożliwia zainstalowanie wstępnie ustawionego urządzenia. Te ustawienia wstępne to proste    
   skrypty nazw brzmień, które nie zawierają żadnego mapowania parametrów i elementów   
   sterujących urządzenia ani paneli graficznych. Więcej informacji na temat skryptów nazw 
   brzmień można znaleźć w oddzielnym dokumencie MIDI Devices (Urządzenia MIDI).
Remove Device (Odłącz urządzenie)
   Usuwa wybrane urządzenie.
Export Setup (Eksportuj konfigurację)
   Eksportuje konfigurację urządzenia MIDI jako plik XML.
Import Setup (Importuj konfigurację)
   Umożliwia importowanie pliku XML z konfiguracją urządzenia MIDI. Konfiguracje urządzeń 
   mogą obejmować mapowanie urządzeń, panele i/lub informacje o poprawkach.
Open Device (Otwórz urządzenie)
   Otwiera wybrane urządzenie.
Output (Wyjście)
   Umożliwia wybór wyjścia MIDI dla wybranego urządzenia.

POWIĄZANE LINKI
Panele urządzeń na stronie 788
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Polecenia dla brzmień (patches)
W MIDI Device Manager (Menedżerze urządzeń MIDI) zestawy brzmień można porządkować w 
bankach, folderach i ustawieniach wstępnych.

Aktywuj opcję Enable Edit (Włącz edycję), aby korzystać z wyskakującego menu poleceń dla 
wybranego urządzenia.

Wyskakujące menu poleceń zawiera następujące elementy:
Create Bank (Utwórz Bank)
   Tworzy nowy bank na liście banków brzmień. Możesz zmienić tę nazwę, klikając ją i wpisując 
    nową nazwę.

                       
Jeśli określisz więcej niż jeden bank, do wyskakującego menu w górnej części okna zostanie 
dodana opcja Bank Assignment (Przypisanie banku). Użyj tej opcji, aby przypisać banki do 
różnych kanałów MIDI.
                       
New Folder (Nowy folder)
   Tworzy nowy podfolder w wybranym banku lub folderze. Może to odpowiadać grupie zestawów 
   ustawień w urządzeniu MIDI lub po prostu służyć do kategoryzowania dźwięków.

                        
New Preset (Nowe ustawienie wstępne)
   Dodaje nowe ustawienie wstępne w wybranym banku lub folderze. Jeśli ją wybierzesz, po prawej 
   stronie zostaną wyświetlone odpowiednie zdarzenia MIDI. Domyślna wartość zmiany programu 
   dla nowego ustawienia wstępnego wynosi 0, ale można dostosować tę liczbę w kolumnie Value 
   (Wartość).

   
Możesz przenosić presety pomiędzy bankami i folderami poprzez przeciąganie i upuszczanie.

Add Multiple Presets (Dodaj wiele ustawień wstępnych)
Umożliwia skonfigurowanie szeregu ustawień wstępnych i dodanie ich do wybranego banku lub 
folderu.
UWAGA
Możesz usunąć banki, foldery i ustawienia wstępne, zaznaczając je i naciskając Backspace.
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WAŻNE
Szczegółowe informacje na temat tego, które zdarzenia MIDI są używane do wybierania zestawów 
w urządzeniu MIDI, można znaleźć w jego dokumentacji.

POWIĄZANE LINKI
Dodaj zaprogramowane funkcje na stronie 786
Banki brzmień na stronie 783

Add Preset Functions (Dodaj zaprogramowane funkcje)
Jeśli dodasz lub wybierzesz ustawienie wstępne dla wybranego banku lub folderu, po prawej stronie
staną się dostępne dalsze funkcje. Jeśli dodasz wiele ustawień wstępnych, otworzy się okno 
dialogowe Add Multiple Presets (Dodaj wiele ustawień wstępnych) z dalszymi funkcjami.

Dostępne są następujące kolumny:

MIDI Message Name (Nazwa komunikatu MIDI)
   Nazwa komunikatu MIDI.
      ● Aby zmienić zdarzenie, kliknij je i wybierz inną opcję z wyskakującego menu.
      ● Aby dodać kolejne zdarzenie, kliknij poniżej ostatniego zdarzenia i wybierz opcję 
         z wyskakującego menu.
      ● Aby usunąć zdarzenie, zaznacz je i naciśnij klawisz Delete lub Backspace .

WAŻNE
Jeśli wstawisz zdarzenie Bank Select, pamiętaj, że w zależności od urządzenia musisz wybrać CC: 
BankSelect MSB, Bank Select 14 Bit, Bank Select 14 Bit MSB-LSB Swapped lub inną opcję.

Value (Wartość)
   Wartość wydarzenia.
MIDI Message Bytes (Bajty komunikatów MIDI)
   Bajty komunikatu zdarzenia.
Valid Range (Prawidłowy zakres)
   Prawidłowy zakres zdarzenia.
Default Name (Nazwa domyślna)
   W przypadku wielu ustawień wstępnych możesz określić nazwę domyślną. Dodane zdarzenia 
   otrzymają tę nazwę, po której następuje numer.

Instalowanie wstępnie ustawionych urządzeń MIDI
Można zainstalować wstępnie ustawione urządzenia MIDI, czyli skrypty nazw brzmień (patch name
scripts), które nie obejmują mapowania urządzeń.

PROCEDURA
1. Wybierz Studio > More Options > MIDI Device Manager (Studio > Więcej opcji > Menedżer 
    urządzeń MIDI).
2. Kliknij opcję Install Device (Zainstaluj urządzenie).
3. W oknie dialogowym Install Device (Dodaj urządzenie MIDI) wykonaj jedną z następujących 
    czynności:
      ● Wybierz skrypt urządzenia z listy.
      ● Wybierz GM Device (Urządzenie GM) lub XG Device (Urządzenie XG), jeśli Twojego  
         urządzenia nie ma na liście, ale jest ono zgodne z tymi standardami, a następnie wpisz nazwę 
         swojego instrumentu w następnym oknie dialogowym.
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4. Kliknij OK.
5. Wybierz urządzenie na liście Installed Devices (Zainstalowane urządzenia) i otwórz   
    wyskakujące menu Output (Wyjście).
6. Wybierz wyjście MIDI, do którego podłączone jest urządzenie.
7. Kliknij opcję Open Device (Otwórz urządzenie).
    Otworzy się okno pokazujące strukturę węzłów dla wybranego urządzenia. Więcej informacji 
    można znaleźć w oddzielnym dokumencie PDF MIDI Devices (Urządzenia MIDI).
8. Otwórz menu podręczne w górnej części okna i wybierz Patch Banks (Banki brzmień).

        

WYNIK
Pokazano strukturę skryptu nazwy brzmienia (patch). Zwykle ma jedną lub kilka warstw banków 
lub grup z brzmieniami.

      

Wybieranie brzmień dla zainstalowanych urządzeń
Jeśli zainstalowałeś urządzenie i wybierzesz je z wyskakującego menu Output Routing (Wyjście 
przesyłania) dla ścieżki MIDI, możesz wybierać brzmienia według nazwy.

PROCEDURA
1. Wybierz ścieżkę MIDI, którą chcesz powiązać z zainstalowanym urządzeniem i otwórz górną 
    część Inspektora.
2. Otwórz menu podręczne Output Routing i wybierz zainstalowane urządzenie.
    Spowoduje to skierowanie ścieżki MIDI do wyjścia MIDI określonego dla urządzenia w MIDI   
    Device Manager (Menedżerze urządzeń MIDI). Pola Bank Selector (Selektor banku) i 
    Program Selector (Selektor programów) zostały zastąpione pojedynczym polem Program 
    Selector (Selektor programów) o treści Off.
3. Otwórz selektor programów. Zostanie wyświetlona lista programów podobna do tej w MIDI  
    Device Manager (Menedżerze urządzeń MIDI).

             
4. Wybierz wpis na liście.
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WYNIK
Odpowiedni komunikat MIDI jest wysyłany do urządzenia.

Zmiana nazw brzmień w urządzeniach
Jeśli zastąpiłeś niektóre ustawienia fabryczne własnymi brzmieniami, możesz zmodyfikować 
urządzenie tak, aby lista nazw brzmień odpowiadała rzeczywistemu urządzeniu.

PROCEDURA
1. Wybierz Studio > More Options > MIDI Device Manager (Studio > Więcej opcji > Menedżer  
    urządzeń MIDI).
2. Wybierz urządzenie z listy Installed Devices (Zainstalowane urządzenia).
3. Kliknij opcję Open Device (Otwórz urządzenie).
4. W wyskakującym menu u góry okna wybierz Patch Banks (Banki brzmień).
5. Aktywuj opcję Enable Edit (Włącz edycję).
6. Na liście Patch Banks (Banki brzmień) znajdź brzmienie, którego nazwę chcesz zmienić, i   
    kliknij jego nazwę.
7. Wpisz nową nazwę i naciśnij Return.

WYNIK
Nazwa brzmienia została zmieniona.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby uniknąć przypadkowej modyfikacji urządzenia, wyłącz opcję Enable Edit (Włącz edycję).

Definiowanie nowych urządzeń MIDI
Można definiować nowe urządzenia MIDI.

PROCEDURA
1. Wybierz Studio > More Options > MIDI Device Manager (Studio > Więcej opcji > Menedżer 
    urządzeń MIDI).
2. Kliknij opcję Install Device (Zainstaluj urządzenie).
3. W oknie dialogowym Add MIDI Device (Dodaj urządzenie MIDI) wybierz opcję Define New   
    (Zdefiniuj nowe).
4. Kliknij OK.
5. W oknie dialogowym Create New MIDI Device (Utwórz nowe urządzenie MIDI) wprowadź 
    nazwę urządzenia.
6. W sekcji Identical Channels (Identyczne kanały) aktywuj kanały MIDI, których chcesz używać.
    Opis Identical Channels (kanałów identycznych) i Individual Channels (kanałów 
    indywidualnych) można znaleźć w oddzielnym dokumencie MIDI Devices (Urządzenia MIDI).
7. Kliknij OK.
8. Wybierz urządzenie z listy Installed Devices (Zainstalowane urządzenia).
9. Z wyskakującego menu u góry okna wybierz Patch Banks (Banki brzmień).
10. Aktywuj opcję Enable Edit (Włącz edycję) i użyj wyskakującego menu poleceń, aby    
      uporządkować strukturę brzmień nowego urządzenia.

Panele urządzeń
MIDI Device Manager (Menedżer urządzeń MIDI) umożliwia tworzenie map urządzeń wraz z 
panelami sterowania, w tym wszystkimi parametrami, którymi można sterować z poziomu Cubase.

Można tworzyć proste panele urządzeń, przypisując komunikaty MIDI Control Change do obiektów
sterujących.
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Jeśli chcesz budować bardziej złożone mapy urządzeń, musisz zapoznać się z programowaniem 
SysEx (patrz osobny dokument MIDI Devices (Urządzenia MIDI)).

Panele urządzeń zapisywane są w formacie XML. Więcej informacji można znaleźć w osobnym 
dokumencie MIDI Devices.

Importowanie konfiguracji urządzeń
PROCEDURA
1. Wybierz Studio > More Options > MIDI Device Manager (Studio > Więcej opcji > Menedżer 
urządzeń MIDI).
2. Kliknij opcję Import Setup (Importuj konfigurację).
3. W oknie dialogowym pliku wybierz plik instalacyjny.
    Pliki instalacyjne zapisywane są w formacie XML, więcej informacji można znaleźć w osobnym 
    dokumencie MIDI Devices (Urządzenia MIDI).
4. Kliknij Open (Otwórz).
5. W oknie dialogowym Import MIDI Devices (Importuj urządzenia MIDI) wybierz jedno lub  
    kilka urządzeń do zaimportowania i kliknij OK.

WYNIK
Urządzenie zostanie dodane do listy Installed Devices (zainstalowanych urządzeń) w MIDI Device
Manager (Menedżerze urządzeń MIDI).

Otwieranie paneli urządzeń
PROCEDURA
1. Wybierz Studio > More Options > MIDI Device Manager (Studio > Więcej opcji > Menedżer  
    urządzeń MIDI).
2. Na liście Installed Devices (Zainstalowane urządzenia) wybierz urządzenie.
3. Z wyskakującego menu Output (Wyjście) wybierz odpowiednie wyjście MIDI.
4. Kliknij opcję Open Device (Otwórz urządzenie).

WYNIK
Panel urządzenia otwiera się w osobnym oknie.
Aby edytować panel, kliknij przycisk Edit (Edytuj), patrz osobny dokument MIDI Devices  
(Urządzenia MIDI).

Wyświetlanie paneli urządzeń w Inspektorze
PROCEDURA
1. W oknie Project wybierz ścieżkę MIDI i z wyskakującego menu Output Routing wybierz 
    urządzenie.
2. Opcjonalnie: Ustaw kanał MIDI na Any (Dowolny).
    Jest to wymagane w przypadku niektórych urządzeń.
3. W Inspektorze otwórz sekcję Device Panel (Panel urządzeń) i kliknij strzałkę po prawej stronie.
    Wyświetlony zostanie folder Panels z wybranym urządzeniem w strukturze węzłów poniżej.
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UWAGA
Jeśli nie widzisz żadnych paneli w folderze Panels (Panele), mimo że pomyślnie skonfigurowałeś 
urządzenie MIDI z kilkoma panelami, upewnij się, że wybrałeś właściwy kanał z wyskakującego 
menu Channel (Kanał), najlepiej Any (Dowolny), aby wyświetlić wszystkie panele urządzeń. 
Upewnij się także, że panele mieszczą się w przestrzeni, w przeciwnym razie nie będą dostępne w 
folderze Panels (Panele).

4. Wybierz panel z listy.
    Panel otwiera się w Inspektorze.

               
WYNIK
Teraz możesz otworzyć panel urządzeń, klikając Open Device Panels (Otwórz panele urządzeń) w 
Inspektorze lub na kanale odpowiedniej ścieżki w MixConsole.

UWAGA
Należy pamiętać, że kliknięcie klawisza Ctrl/Cmd i przycisku Open Device Panels umożliwia 
otwarcie podpanelu poprzez wyskakujące menu przeglądarki paneli.

Wyświetlanie Device Panels (paneli urządzeń) w MixConsole
PROCEDURA
1. Wybierz Studio > MixConsole.
2. Kliknij opcję Racks (Stojaki), aby otworzyć selektor stojaków i aktywować Device Panels 
    (Panele urządzeń).
3. Kliknij przycisk strzałki po prawej stronie nagłówka Panel.
    Wyświetlony zostanie folder Panels z wybranym urządzeniem w strukturze węzłów poniżej.
4. Wybierz panel z listy.
    Panel jest pokazany w sekcji Channel Racks (Stojaki kanałów) w MixConsole.

Automatyzacja parametrów urządzenia
Możesz zautomatyzować panele urządzeń tak samo, jak zwykłe ścieżki audio i MIDI.

PROCEDURA
1. W Inspektorze kliknij Open Device Panels (Otwórz panele urządzeń), aby otworzyć panel 
urządzeń.
2. Na panelu urządzenia aktywuj opcję Write Automation (Pisz automatyzację).
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3. Poruszaj pokrętłami i suwakami na panelu urządzenia.

WYNIK
W oknie Project do listy ścieżek dodawana jest ścieżka MIDI Device Automation (Urządzenie 
automatyzacji MIDI).

UWAGA
Jeśli ścieżka jest ukryta, wybierz opcję Project > Track Folding (Projekt > Składanie ścieżki) i 
wybierz opcję Show All Used Automation (Pokaż całą używaną automatyzację).

Jeśli otworzysz pole nazwy, zostaną pokazane wszystkie parametry automatyki w urządzeniu i 
będzie można je wybrać.

UWAGA
Jeśli napisałeś automatyzację, ale Twoje urządzenie MIDI nie jest jeszcze podłączone, panel nie 
wyświetli żadnych zmian parametrów podczas odtwarzania ścieżki z włączonym przyciskiem Read
(Czytaj).
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Funkcje MIDI

Funkcje MIDI umożliwiają trwałą edycję zdarzeń MIDI lub partii MIDI w oknie Project lub z 
poziomu edytora MIDI.

To, na które zdarzenia ma wpływ użycie funkcji MIDI, zależy od funkcji, aktywnego okna i 
bieżącego wyboru:
   ● W oknie Project funkcje MIDI dotyczą wszystkich wybranych partii, wpływając na wszystkie 
      znajdujące się w nich zdarzenia odpowiedniego typu.
   ● W edytorach MIDI funkcje MIDI dotyczą wszystkich wybranych zdarzeń. Jeśli nie zostaną 
      wybrane żadne zdarzenia, będzie to miało wpływ na wszystkie zdarzenia w edytowanych 
      częściach.

UWAGA
Niektóre funkcje MIDI dotyczą tylko zdarzeń MIDI określonego typu. Na przykład polecenie 
Delete Controlers (Usuń kontrolery) dotyczy tylko zdarzeń kontrolera MIDI.

POWIĄZANE LINKI
Parametry MIDI w czasie rzeczywistym i efekty MIDI na stronie 771

Okno dialogowe Transpose Setup (ustawień transpozycji)
Okno dialogowe Transpose Setup zawiera ustawienia transpozycji wybranych zdarzeń.

● Aby otworzyć okno dialogowe Transpose Setup (Konfiguracja transpozycji), wybierz nuty 
MIDI, które chcesz transponować i wybierz MIDI > Transpose Setup (MIDI > Konfiguracja 
transpozycji).

                            

Dostępne są następujące ustawienia:

Transpose in Semitones (Transpozycja w półtonach)
      Ustawia stopień transpozycji.
Scale Correction (Korekcja skali)
      Transponuje wybrane nuty do najbliższej nuty określonego typu skali. Umożliwia to zmianę 
      tonacji i tonacji.
● Wybierz nutę podstawową i rodzaj skali dla bieżącej skali w wyskakujących menu Current Scale
    (Bieżąca skala).
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● Wybierz nutę podstawową i rodzaj skali dla nowej skali w wyskakujących menu  New Scale   
   (Nowa skala).

UWAGA
Jeżeli nowa nuta prymy różni się od nuty bieżącej, prowadzi to do zupełnie innej tonacji.

Keep Notes in Range (Trzymaj nuty w zakresie)
      Ogranicza transpozycję nut do wartości nut określonych w ustawieniach Highest Note     
      (Najwyższa nuta) i Lowest Note (Najniższa nuta).

UWAGA
Nuty, które po transpozycji byłyby poza zakresem, są przesuwane o inną oktawę, zachowując, jeśli 
to możliwe, prawidłową transponowaną wysokość. Jeżeli zakres pomiędzy górną i dolną granicą 
jest bardzo wąski, nuta jest transponowana tak daleko, jak to możliwe, czyli do nut określonych 
wartościami Highest Note (Najwyższa nuta) i Lowest Note (Najniższa nuta). Jeśli ustawisz tę samą
wartość dla Highest Note i Lowest Note, wszystkie nuty zostaną transponowane do tej wysokości.

UWAGA
Do transpozycji możesz także użyć ścieżki transpozycji.

POWIĄZANE LINKI
Funkcje transpozycji na stronie 328
Okno dialogowe konfiguracji skali muzycznej na stronie 952

Łączenie zdarzeń MIDI w nową część 
Możesz scalić wszystkie zdarzenia MIDI, zastosować modyfikatory i efekty MIDI oraz 
wygenerować nową część.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
      ● Mute (wycisz) ścieżki lub części, których nie chcesz łączyć.
      ● Solo (wysoluj) ścieżkę zawierająca zdarzenia, które chcesz uwzględnić w łączeniu.
2. Ustaw lewy i prawy lokalizator tak, aby obejmował obszar, który chcesz scalić.
UWAGA
Uwzględnione zostaną tylko zdarzenia rozpoczynające się w tym obszarze

3. Opcjonalnie: wybierz ścieżkę dla nowej części.
    Jeśli nie wybierzesz ścieżki, utworzona zostanie nowa ścieżka MIDI. Jeśli wybranych jest kilka 
    ścieżek MIDI, nowa część zostanie wstawiona na pierwszej wybranej ścieżce.
4. Wybierz opcję MIDI > Merge MIDI in Loop (MIDI > Scal MIDI w pętli).
5. W oknie dialogowym MIDI Merge Options (Opcje scalania MIDI) wprowadź zmiany.
6. Kliknij OK.

WYNIK
Pomiędzy lokalizatorami na ścieżce docelowej tworzona jest nowa część zawierająca przetworzone 
zdarzenia MIDI.

POWIĄZANE LINKI
Okno dialogowe Opcje scalania MIDI na stronie 794
Zamrażanie modyfikatorów MIDI na stronie 777
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Okno dialogowe MIDI Merge Options (Opcji scalania MIDI)

● Aby otworzyć okno dialogowe MIDI Merge Options, wybierz partię MIDI i wybierz MIDI >   
   Merge MIDI in Loop (MIDI > Scal MIDI w pętli).

Dostępne są następujące opcje:

Include Inserts (Dołącz wstawki)
   Stosuje efekty wstawiania MIDI i modyfikatory MIDI.
Include Sends (Uwzględnij wysyłki)
   Stosuje efekty wysyłania MIDI.
Erase Destination (Usuń miejsce docelowe)
   Usuwa dane MIDI pomiędzy lewym i prawym lokalizatorem na ścieżce docelowej.
Include Chase (Uwzględnij pościg)
   Obejmuje zdarzenia umieszczone poza wybraną częścią, ale powiązane z nią w przetwarzaniu, np.
   zmiana programu tuż przed lewym lokalizatorem.
Convert VST 3 (Konwertuj VST 3)
   Konwertuje wszystkie dane VST 3 w wybranym obszarze na dane MIDI.

POWIĄZANE LINKI
Chase (Pościg) na stronie 259

Stosowanie efektów do pojedynczej części
Do pojedynczej partii można zastosować modyfikatory i efekty MIDI.

PROCEDURA
1. Skonfiguruj modyfikatory MIDI i efekty MIDI tak, jak chcesz dla danej partii.
2. Ustaw lokalizatory tak, aby obejmowały część.
3. Na liście utworów wybierz utwór zawierający partię.
4. Wybierz opcję MIDI > Merge MIDI in Loop (MIDI > Scal MIDI w pętli).
5. W oknie dialogowym MIDI Merge Options (Opcje scalania MIDI) aktywuj opcję Erase 
    Destination (Usuń miejsce docelowe).
6. Kliknij OK.

WYNIK
Na tej samej ścieżce tworzona jest nowa część zawierająca przetworzone zdarzenia. Oryginalna 
część została usunięta.

PO ZAKOŃCZENIU TEGO ZADANIA
Wyłącz lub zresetuj wszystkie modyfikatory i efekty MIDI, aby ścieżka odtwarzała się jak 
poprzednio.
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Okno dialogowe Dissolve Part (Rozpuść część)
Możesz rozdzielić zdarzenia MIDI na części według kanałów lub wysokości dźwięku i rozdzielić 
część na różne ścieżki lub pasy.

● Aby otworzyć okno dialogowe Dissolve Part (Rozpuść część), wybierz partię MIDI, którą chcesz
rozpuścić, i wybierz MIDI > Dissolve Part (MIDI > Rozpuść część).

Dostępne są następujące ustawienia:

Separate Channels (Oddzielne kanały)
   Oddziela zdarzenia MIDI według ich kanału. Jest to przydatne w przypadku partii MIDI na kanale
   MIDI Any, które zawierają zdarzenia na różnych kanałach MIDI.
Separate Pitches (Oddzielne wysokości)
   Oddziela zdarzenia MIDI według ich wysokości. Jest to przydatne w przypadku ścieżek 
   perkusyjnych i perkusji, gdzie różne wysokości dźwięku zwykle odpowiadają oddzielnym 
   dźwiękom perkusji.
Optimized Display (Zoptymalizowany wyświetlacz)
   Automatycznie usuwa ciche obszary powstałych części.
UWAGA
Ta opcja nie jest dostępna, gdy włączona jest opcja Dissolve to Lanes (Rozpuść na pasy).

Dissolve to Lanes (Rozpuść na pasy)
   Rozkłada część na pasy.

Rozpuszczanie części w oddzielnych kanałach
Możesz rozdzielić partie MIDI zawierające zdarzenia w różnych kanałach MIDI i rozdzielić 
zdarzenia na nowe części na nowych ścieżkach, po jednej dla każdego znalezionego kanału MIDI.

PROCEDURA
1. Wybierz partie zawierające zdarzenia MIDI na różnych kanałach.
2. Wybierz opcję MIDI > Dissolve Part (MIDI > Rozpuść część).
3. Aktywuj Separate Channels (Oddzielne kanały).
4. Kliknij OK.

WYNIK
Dla każdego kanału MIDI używanego w wybranych partiach tworzona jest nowa ścieżka MIDI i 
ustawiana na odpowiedni kanał MIDI. Każde zdarzenie jest kopiowane do partii na ścieżce z 
odpowiednim kanałem MIDI, a oryginalne partie są wyciszane.

Ustawienie kanału MIDI
Ustawienie ścieżki na kanał MIDI Any (dowolny) powoduje, że każde zdarzenie MIDI będzie 
odtwarzane na oryginalnym kanale MIDI, a nie na kanale ustawionym dla całej ścieżki.

Istnieją dwie główne sytuacje, w których przydatne są ścieżki Any (dowolnego) kanału:

● Podczas jednoczesnego nagrywania kilku kanałów MIDI. Możesz na przykład mieć klawiaturę 
MIDI z kilkoma strefami klawiatury, przy czym każda strefa wysyła komunikaty MIDI na 
oddzielnym kanale. Ustawienie kanału na Any umożliwia odtwarzanie nagrania z różnymi 
dźwiękami dla każdej strefy (ponieważ różne nuty MIDI są odtwarzane na oddzielnych kanałach 
MIDI).
● Jeśli zaimportowałeś plik MIDI typu 0.
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Pliki MIDI typu 0 zawierają tylko jedną ścieżkę i nuty w maksymalnie 16 różnych kanałach MIDI. 
Jeśli ustawisz tę ścieżkę na określony kanał MIDI, wszystkie nuty w pliku MIDI będą odtwarzane z
tym samym dźwiękiem. Ustawienie ścieżki na Any (Dowolny) powoduje, że zaimportowany plik 
będzie odtwarzany zgodnie z oczekiwaniami.

Rozpuszczanie części w oddzielne wysokości (pitches)
Możesz rozdzielić partie MIDI zawierające zdarzenia o różnych wysokościach i rozdzielić je na 
nowe części na nowych ścieżkach, po jednej dla każdej znalezionej tonacji MIDI. Jest to przydatne, 
jeśli do oddzielenia różnych dźwięków, takich jak ścieżki perkusyjne MIDI lub ścieżki FX z 
dźwiękiem próbnika, używane są różne wysokości. Rozpuszczając takie części, możesz pracować z 
każdym dźwiękiem indywidualnie, na osobnej ścieżce.

PROCEDURA
1. Wybierz partie zawierające zdarzenia MIDI o różnych wysokościach.
2. Wybierz opcję Dissolve Part (MIDI > Rozpuść część).
3. Aktywuj Separate Pitches (Oddzielne wysokości).
4. Kliknij OK.

WYNIK
Dla każdej wysokości MIDI użytej w wybranych partiach tworzona jest nowa ścieżka MIDI. Każde
zdarzenie jest kopiowane do części ścieżki o odpowiedniej wysokości, a oryginalne partie są 
wyciszane.

Opcja Dissolve To Lanes (Rozpuść w Pasach)
Możesz rozdzielić partie MIDI zawierające zdarzenia na różnych kanałach MIDI o różnych 
wysokościach i rozdzielić zdarzenia na nowe części na nowych pasach oryginalnej ścieżki

Rozpuszczanie się w pasach ma następujące zalety:

● Uzyskasz lepszy przegląd tego, jakie materiały MIDI są ze sobą powiązane.
● Umożliwia podzielenie partii na różne brzmienia perkusyjne i ich niezależną edycję.
● Umożliwia dzielenie części instrumentu i nadal kierowanie ich do tej samej instancji instrumentu 
   VST.

UWAGA
Aby ponownie złożyć wszystkie wydarzenia w jedną część, użyj Bounce MIDI (Odskocz MIDI).

POWIĄZANE LINKI
Odskakiwanie partii MIDI na stronie 796

Odskakiwanie partii MIDI
Możesz łączyć partie MIDI na różnych ścieżkach w jedną partię MIDI. Jest to przydatne, jeśli 
chcesz na przykład ponownie złożyć część perkusji, którą rozłożyłeś na ścieżki.

PROCEDURA
1. Wybierz partie MIDI na różnych ścieżkach, które chcesz połączyć.
2. Wybierz opcję MIDI > Bounce MIDI.

WYNIK
Wybrane partie MIDI zostaną połączone w jedną partię. Wszelkie wyciszone fragmenty zostaną 
usunięte. Uwzględniane są wartości transpozycji i prędkości (velocity) ustawione dla partii.
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Powtarzanie zdarzeń MIDI niezależnych pętli ścieżek
Możesz powtarzać zdarzenia MIDI w niezależnej pętli ścieżki, aby wypełnić część MIDI. To jest
przydatne, jeśli chcesz przekonwertować zdarzenia niezależnej pętli ścieżki na rzeczywiste 
zdarzenia MIDI.

WARUNEK WSTĘPNY
Skonfigurowałeś niezależną pętlę ścieżek i Key Edytor jest otwarty. Część kończy się po 
zakończeniu niezależnej pętli ścieżki.

PROCEDURA
● Wybierz opcję MIDI > Repeat Loop (MIDI > Powtarzaj pętlę)

WYNIK
Zdarzenia niezależnej pętli ścieżki powtarzają się do końca części. Zdarzenia znajdujące się na 
prawo od niezależnej pętli ścieżki w części zostaną zastąpione.

POWIĄZANE LINKI
Konfigurowanie niezależnej pętli ścieżek na stronie 582

Rozszerzanie nut MIDI
Możesz przedłużać nuty MIDI tak, aby sięgały do kolejnych nut.

WARUNEK WSTĘPNY
Partia MIDI z pewnymi zdarzeniami nutowymi jest otwarta w Key Editor.

PROCEDURA
1. Wybierz zdarzenia nut, które chcesz rozszerzyć na kolejne nuty.
2. Wybierz MIDI > Functions > Legato (MIDI > Funkcje > Legato).

WYNIK
Wybrane zdarzenia nutowe zostaną przedłużone do początku kolejnych nut.

UWAGA
Aby określić odstęp lub nakładanie się, dostosuj ustawienie Legato Overlap w oknie dialogowym 
Ptreferences (Preferencje) (Editing (Edycja) – strona MIDI).

POWIĄZANE LINKI
Inspektor Key Editor (Edytora klawiszy) na stronie 846

Naprawianie długości nut MIDI
Długość wybranych nut MIDI można ustawić na wartość Length Quantize (Kwantyzacji długości).

WARUNEK WSTĘPNY
Partia MIDI z pewnymi zdarzeniami nutowymi jest otwarta w Key Editor (Edytorze klawiszy).

PROCEDURA
1. Na pasku narzędzi Key Editor otwórz wyskakujące menu Length Quantize (Kwantyzacja  
    długości) i wybierz żądane długości nut.
2. Wybierz zdarzenia nut, które chcesz naprawić.
3. Wybierz MIDI > Functions > Fixed Lengths (MIDI > Funkcje > Stałe długości).
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WYNIK
Wybrane zdarzenia nutowe mają ustawioną określoną wartość Length Quantize (kwantyzacji 
długości).

POWIĄZANE LINKI
Pasek narzędzi Key Editor na stronie 839

Naprawianie prędkości (velocities) nut MIDI
Możesz ustawić dynamikę wybranych nut MIDI na wartość Note Insert Velocity (Wstaw prędkość
nuty)

WARUNEK WSTĘPNY
Partia MIDI z pewnymi zdarzeniami nutowymi jest otwarta w Key Editor (edytorze klawiszy)

PROCEDURA
1. Na pasku narzędzi Key Editor otwórz wyskakujące menu Set up Insert Velocity i wybierz 
    wartość prędkości.
2. Wybierz zdarzenia nut, które chcesz naprawić.
3. Wybierz MIDI > Functions > Fixed Velocity (MIDI > Funkcje > Stała prędkość).

WYNIK
Wybrane zdarzenia nutowe są ustawione na określoną wartość Note Insert Velocity (Prędkości 
wstawiania nuty).

POWIĄZANE LINKI
Pasek narzędzi Key Editor na stronie 839

Renderowanie danych pedału Sustain na długości nut
Możesz renderować dane pedału podtrzymania do długości nut. Jest to przydatne, jeśli nagrałeś 
dane MIDI za pomocą klawiatury MIDI i pedału podtrzymania, a chcesz przedłużyć rzeczywiste 
nuty MIDI tak długo, jak trzymasz pedał, aby móc je później edytować.

WARUNEK WSTĘPNY
Nagrałeś komunikat MIDI przy użyciu klawiatury MIDI i pedału podtrzymania. Partia MIDI jest 
otwarta w Key Editor.

PROCEDURA
1. Wybierz zdarzenia nut.
2. Wybierz opcję MIDI > Functions > Pedals to Note Length (MIDI > Funkcje > Pedały, aby 
    ustawić długość nuty).

WYNIK
Wybrane nuty zostaną wydłużone w celu dopasowania do pozycji wyłączonego pedału 
podtrzymania, a zdarzenia włączenia/wyłączenia kontrolera podtrzymania zostaną usunięte.
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Usuwanie nakładania się
Można usuwać nakładające się nuty o tej samej lub różnej wysokości. Jest to przydatne, jeśli 
instrumenty MIDI nie obsługują nakładających się zdarzeń.

PROCEDURA
1. Wybierz zdarzenia nut.
2. Wykonaj jedną z następujących czynności:
      ● Wybierz MIDI > Functions > Delete Overlaps (mono) (MIDI > Funkcje > Usuń nakładki 
         (mono)).
      ● Wybierz MIDI > Functions > Delete Overlaps (poly) (MIDI > Funkcje > Usuń nakładki 
         (poly)).

WYNIK
Nakładające się nuty MIDI są skracane, tak że żadna nuta nie zaczyna się przed końcem innej.

Edycja Velocity (prędkości)
Można manipulować szybkością nut.

PROCEDURA
1. Wybierz zdarzenia nut.
2. Wybierz MIDI > Functions > Velocity (MIDI > Funkcje > Prędkość).
3. Otwórz wyskakujące menu Type (Typ) i wybierz opcję.
4. W zależności od Type (typu) wprowadź Ratio (współczynnik), Amount (kwotę) lub wartość 
    Upper (górną) i Lower (dolną).
5. Kliknij OK.

WYNIK
Szybkość nut zmienia się zgodnie z ustawieniami.

POWIĄZANE LINKI
Okno dialogowe Velocity (prędkości) na stronie 799

Okno dialogowe Velocity (prędkość)

● Aby otworzyć okno dialogowe Velocity, wybierz partię MIDI i wybierz MIDI > Functions >  
   Velocity.

                          

Add/Subtract (Dodaj/odejmij)
   Dodaje wartość Amount (Kwota) do wartości prędkości. Można wprowadzić wartości dodatnie 
lub ujemne.
Compress/Expand (Kompresuj/Rozwiń)
   Używa ustawienia Ratio (0 do 300 %) do kompresji lub rozszerzania zakresu dynamiki nut MIDI.

   Współczynnik większy od 1 (ponad 100 %) zwiększa różnice pomiędzy wartościami prędkości, 
   natomiast współczynnik mniejszy niż 1 (poniżej 100 %) je kompresuje.
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● Aby skompresować zakres dynamiczny, użyj wartości współczynnika poniżej 100 %.
   Po kompresji możesz dodać wartość dynamiki, aby utrzymać średni poziom prędkości.
● Aby rozszerzyć zakres dynamiczny, użyj wartości współczynnika powyżej 100 %.
   Przed rozszerzeniem można dostosować prędkość do środka zakresu.
Limit
   Ogranicza wartości prędkości, tak aby pozostawały pomiędzy wartościami Lower (Dolną) 
   i Upper (Górną).

Usuwanie podwójnych nut
Możesz usunąć podwójne nuty o tej samej wysokości i dokładnie w tym samym miejscu z 
wybranych partii MIDI. Podwójne nuty mogą wystąpić podczas nagrywania w trybie cyklicznym, 
na przykład po kwantyzacji.

PROCEDURA
1. Wybierz partię MIDI zawierającą podwójne nuty.
2. Wybierz MIDI > Functions > Delete Doubles (MIDI > Funkcje > Usuń dublety).

WYNIK
Podwójne nuty są automatycznie usuwane.

Usuwanie danych kontrolera
Możesz usunąć dane kontrolera z wybranych partii MIDI.

PROCEDURA
1. Wybierz partie MIDI zawierające dane kontrolera.
2. Wybierz MIDI > Functions > Delete Controllers (MIDI > Funkcje > Usuń kontrolery).

WYNIK
Dane kontrolera są automatycznie usuwane.

Usuwanie ciągłych danych kontrolera
Można usuwać ciągłe dane kontrolera z wybranych partii MIDI.

PROCEDURA
1. Wybierz partie MIDI zawierające dane kontrolera.
2. Wybierz opcję MIDI > Functions > Delete Continuous Controllers (MIDI > Funkcje > Usuń 
    kontrolery ciągłe).

WYNIK
Ciągłe dane sterownika są automatycznie usuwane. Jednakże zdarzenia włączenia/wyłączenia, takie
jak zdarzenia pedału podtrzymania, zostaną zachowane.
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Ograniczanie głosów polifonicznych
Możesz ograniczyć głosy polifoniczne w wybranych nutach lub partiach MIDI. Jest to przydatne, 
jeśli masz instrument z ograniczoną polifonią i chcesz mieć pewność, że wszystkie nuty zostaną 
zagrane.

PROCEDURA
1. Wybierz nuty lub partie MIDI zawierające głosy.
2. Wybierz opcję MIDI > Functions > Restrict Polyphony (MIDI > Funkcje > Ogranicz 
    polifonię).
3. Określ liczbę głosów, których chcesz używać.
4. Kliknij OK.

WYNIK
Nuty są skracane w miarę potrzeb, tak aby kończyły się przed rozpoczęciem następnej nuty.

Rozrzedzanie danych kontrolera
Możesz rozrzedzić dane kontrolera w wybranych partiach MIDI. Użyj tej opcji, aby zmniejszyć 
obciążenie zewnętrznych urządzeń MIDI, jeśli nagrałeś bardzo gęste krzywe kontrolera.

PROCEDURA
1. Wybierz partie MIDI zawierające kontrolery, które chcesz odchudzić.
2. Wybierz opcję MIDI > Functions > Thin Out Data (MIDI > Funkcje > Rozrzedzanie danych).

WYNIK
Dane kontrolera są rozrzedzone.

UWAGA
Zmniejsza to również liczbę zdarzeń kontrolera MIDI i VST 3, które stanowią część danych Note 
Expression.

Wyodrębnianie automatyzacji MIDI
Możesz konwertować ciągłe kontrolery nagranych partii MIDI na dane automatyzacji ścieżki MIDI,
abyś mógł je edytować w oknie Project.

PROCEDURA
1. Wybierz partię MIDI zawierającą ciągłe dane kontrolera.
2. Wybierz opcję MIDI > Functions > Extract MIDI Automation (MIDI > Funkcje > 
    Wyodrębnij automatyzację MIDI).
3. Kliknij prawym przyciskiem myszy ścieżkę MIDI lub instrumentu w oknie Project i wybierz 
    opcję Show All Used Automation (Selected Tracks) (Pokaż całą używaną automatyzację 
    (wybrane ścieżki)).
    To pokazuje dane kontrolera MIDI na ścieżce automatyzacji.

WYNIK
W oknie Project tworzona jest ścieżka automatyzacji dla każdego kontrolera ciągłego w partii 
MIDI.
W edytorach MIDI dane kontrolera są usuwane ze ścieżki kontrolera.
UWAGA
Działa to tylko w przypadku kontrolerów ciągłych. Danych takich jak aftertouch, pitchbend lub 
SysEx nie można konwertować na dane automatyzacji ścieżki MIDI.
Na automatyzację kontrolera MIDI wpływa także Automation Merge Mode (Tryb łączenia 
automatyzacji).

811



POWIĄZANE LINKI
Automatyzacja kontrolera MIDI na stronie 831
Tworzenie ścieżki tempa poprzez stukanie (tapping) na stronie 802

Odwracanie kolejności odtwarzania zdarzeń MIDI
Możesz rytmicznie odwrócić kolejność wybranych zdarzeń lub wszystkich zdarzeń w wybranej 
części. Powoduje to odtwarzanie MIDI do tyłu. Różni się to jednak od odwracania nagrania audio. 
Poszczególne nuty MIDI są nadal odtwarzane jak zwykle, ale zmienia się kolejność odtwarzania.

PROCEDURA
1. Wybierz zdarzenia MIDI lub partię MIDI.
2. Wybierz MIDI > Functions > Reverse (MIDI > Funkcje > Odwróć).

WYNIK
Kolejność odtwarzania zdarzeń zostanie odwrócona, a poszczególne nuty będą nadal odtwarzane w 
instrumencie MIDI w zwykły sposób. Technicznie rzecz biorąc, ta funkcja odwraca komunikat 
Note On w części lub zaznaczeniu.

Odwracanie kolejności wybranych zdarzeń MIDI
Funkcja ta odwraca graficznie kolejność wybranych zdarzeń lub wszystkich zdarzeń w wybranych 
częściach. Technicznie rzecz biorąc, funkcja ta zmienia komunikat Note On w komunikat Note Off 
i odwrotnie, co może prowadzić do niedokładności rytmicznych, jeśli pozycja Note Off w nucie nie 
została skwantowana.

PROCEDURA
1. Wybierz zdarzenia MIDI lub partię MIDI.
2. Wybierz MIDI > Functions > Mirror (MIDI > Funkcje > Lustro).

WYNIK
Kolejność zdarzeń zostaje odwrócona, a poszczególne nuty w instrumencie MIDI nadal grają 
normalnie. Technicznie rzecz biorąc, funkcja ta zamienia komunikat Note On w komunikat Note 
Off i odwrotnie, co może prowadzić do niedokładności rytmicznych, jeśli pozycja Note Off w nucie
nie została skwantowana.

Tworzenie ścieżki tempa poprzez stukanie (tapping)
Możesz utworzyć pełną ścieżkę tempa na podstawie stukania.

WARUNEK WSTĘPNY
Nagrałeś kilka nut MIDI, wystukując tempo na klawiaturze MIDI.

PROCEDURA
1. Wybierz nagrane zdarzenia MIDI lub całą partię.
2. Wybierz MIDI > Functions > Merge Tempo from Tapping (MIDI > Funkcje > Połącz tempo  
    ze stukaniem).

WYNIK
Obliczane jest wystukane tempo, a w Tempo Track Editor (Edytorze tempa ścieżki) tworzona jest 
krzywa tempa.

POWIĄZANE LINKI
Edytor tempa ścieżek na stronie 1024
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Edytory MIDI
Istnieje kilka sposobów edycji MIDI w Cubase. Możesz używać narzędzi i funkcji w oknie Project 
do edycji na dużą skalę lub funkcji w menu MIDI do przetwarzania partii MIDI na różne sposoby. 
Aby ręcznie edytować dane MIDI w interfejsie graficznym, możesz skorzystać z edytorów MIDI.

● Key Editor (Edytor klawiszy) prezentuje nuty graficznie w siatce przypominającej rolkę 
   fortepianu. Key Editor umożliwia także szczegółową edycję zdarzeń innych niż nuty, takich jak 
   kontrolery MIDI.
● Score Editor (Edytor partytury) wyświetla nuty MIDI jako partyturę muzyczną i udostępnia 
    zaawansowane narzędzia i funkcje do notacji, układu i drukowania.
● Drum Editor (Edytor bębnów) jest podobny do edytora klawiszy, ale każdy klawisz odpowiada 
   osobnemu brzmieniu perkusyjnemu. Za pomocą edytora bębnów możesz edytować partie 
   perkusyjne.
● List Editor (Edytor listy) pokazuje wszystkie zdarzenia w wybranych partiach MIDI w formie  
   listy i umożliwia numeryczne przeglądanie i edycję ich właściwości. Umożliwia także edycję 
   wiadomości SysEx.
● In-Place Editor (Edytor lokalny) umożliwia edycję partii MIDI bezpośrednio w oknie projektu, 
   dzięki czemu można edytować MIDI w kontekście innych typów ścieżek.
   Możesz także edytować MIDI w Project Browser (Przeglądarce Projektu).

POWIĄZANE LINKI
Edytor klawiszy na stronie 836
Edytor bębnów na stronie 870
Edytor listy na stronie 889
Przeglądarka projektów na stronie 1043
Edytor lokalny na stronie 903

Typowe funkcje edytora MIDI

Za pomocą narzędzi i funkcji edytorów MIDI można przetwarzać partie MIDI na różne sposoby.

Zmiana formatu wyświetlania linijki
Można zmienić format wyświetlania linijki. Domyślnie linijka pokazuje oś czasu w formacie 
wyświetlania wybranym w panelu Transport.

PROCEDURA
● Kliknij przycisk strzałki po prawej stronie linijki i wybierz opcję z wyskakującego menu.

POWIĄZANE LINKI
Menu Format wyświetlania linijki na stronie 57

Powiększanie (zoom) w edytorach MIDI

Edytory MIDI udostępniają kilka opcji powiększania:
● Suwaki zoomu.
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● Narzędzie Zoom.
● Podmenu Zoom w menu Edit (Edycja).

Używając narzędzia Zoom do powiększania, możesz określić, czy chcesz powiększać tylko w 
poziomie, czy jednocześnie w poziomie i pionie.

● Aby aktywować/dezaktywować odpowiednią opcję, włącz/wyłącz Zoom Tool Standard Mode 
(Tryb standardowy narzędzia Zoom): Horizontal Zooming Only (Tylko powiększanie poziome) 
w oknie dialogowym Preferences (Preferencje) (Editing (Edycja) – strona Tools (Narzędzia)).

Korzystanie z funkcji wycinania (cut) i wklejania (paste)
Możesz użyć opcji Cut (Wytnij), Copy (Kopiuj) i Paste (Wklej) z menu Edit (Edycja), aby 
przenosić lub kopiować materiał w obrębie części lub pomiędzy różnymi częściami.

● Aby wstawić zdarzenia nutowe w pozycji kursora projektu bez wpływu na istniejące nuty, 
wybierz Edit > Paste (Edytuj > Wklej).
● Aby wstawić nuty w miejscu kursora projektu, przesuń i jeśli to konieczne, podziel istniejące 
zdarzenia nut, aby zrobić miejsce na wklejone nuty, wybierz Edit > Range > Paste Time (Edycja >
Zakres > Wklej Czas).

     
1 Dane w schowku
2 Pozycja kursora
3 Wklejone dane w pozycji kursora

Obsługa zdarzeń nut

Menu Event Colors (kolorów zdarzenia)
W edytorze MIDI możesz wybrać różne schematy kolorów dla zdarzeń nutowych.
● Aby otworzyć wyskakujące menu Event Colors (Kolory zdarzeń), kliknij Event Colors na pasku
   narzędzi.
Dostępne są następujące opcje:
Velocity (Prędkość, dynamika)
   Zdarzenia nutowe otrzymują różne kolory w zależności od ich wartości dynamiki.
Pitch (Poziom)
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   Zdarzenia nutowe otrzymują różne kolory w zależności od ich wysokości.

Channel (Kanał)
   Zdarzenia nutowe otrzymują różne kolory w zależności od wartości kanału MIDI.
Part (Część)
   Zdarzenia nutowe otrzymują ten sam kolor, co odpowiadająca im część w oknie Projektu. Użyj tej
   opcji, jeśli pracujesz z dwiema lub większą liczbą ścieżek w edytorze, aby zobaczyć, które 
   zdarzenia nutowe należą do której ścieżki.
Grid Match (Dopasuj siatkę)
   Zdarzenia nutowe otrzymują różne kolory w zależności od ich położenia czasowego. Na przykład 
   ten tryb pozwala sprawdzić, czy nuty akordu zaczynają się dokładnie w tym samym rytmie.
Sound Slot (Gniazdo dźwiękowe)
   Zdarzenia nutowe otrzymują różne kolory w zależności od artykulacji przypisanej do nuty w 
   oknie dialogowym Expression Map Setup (Ustawienia mapy wyrażeń).
Voice (Głos)
   Zdarzenia nutowe uzyskują różne kolory w zależności od ich głosu (sopran, alt, tenor itp.).
Scale/Chords (Skala/akordy)
   Zdarzenia nutowe otrzymują różne kolory w zależności od tego, czy pasują do bieżącego akordu, 
   skali, czy obu.

W przypadku wszystkich opcji z wyjątkiem Part i Sound Slot, menu podręczne zawiera również 
opcję Setup (Ustawienia). Ta opcja otwiera okno dialogowe, w którym możesz określić kolory 
powiązane z prędkościami (velocities), wysokościami (pitches) lub kanałami (channels).

POWIĄZANE LINKI
Wybieranie zdarzeń nut na stronie 807
Expression Map (Mapy wyrażeń) na stronie 906
Próbnik kolorów na stronie 96
Okno dialogowe konfiguracji kolorów zdarzeń na stronie 806

Okno dialogowe konfiguracji kolorów zdarzeń
Okno dialogowe Colors Setup (Ustawienia kolorów) zdarzenia umożliwia ustawienie kolorów 
właściwości zdarzenia, takich jak prędkość, wysokość, kanały, akordy i skale.

● Aby otworzyć okno dialogowe Colors Setup (Ustawienia kolorów) zdarzenia dla wybranej opcji 
   schematu kolorów, otwórz wyskakujące menu Event Colors  (Kolory zdarzenia) na pasku 
   narzędzi Key Editor, Drum Editor, List Editor lub In-Place Editor i wybierz opcję Setup.
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Okno dialogowe Pitch Color Setup (Ustawienia koloru poziomu)

Dostępne są następujące opcje:
Color fields (Pola kolorów)
   Kliknij pole, aby otworzyć Próbnik kolorów, który umożliwia określenie nowego koloru.
Description (Opis)
   Wyświetla dalsze informacje na temat użycia koloru.
OK
   Zastosowuje zmiany i zamyka okno dialogowe.

POWIĄZANE LINKI
Menu kolorów zdarzeń na stronie 805
Próbnik kolorów na stronie 96

Wybieranie zdarzeń nut
Wybrany edytor MIDI określa, która z poniższych metod ma zastosowanie.

Wykonaj jedną z następujących czynności:

● Użyj narzędzia Object Selection (Zaznaczanie obiektów), aby przeciągnąć prostokąt zaznaczenia
   wokół zdarzeń nutowych, które chcesz zaznaczyć. Możesz także klikać poszczególne zdarzenia.
● Wybierz Edit > Select (Edytuj > Wybierz) i wybierz jedną z opcji.
● Aby wybrać poprzednie lub następne zdarzenie nutowe, użyj klawiszy Strzałka w lewo/Strzałka
w prawo.
● Aby wybrać kilka nut, naciśnij klawisz Shift i użyj klawisza Strzałka w lewo/Strzałka w 
   prawo.
● Aby zaznaczyć wszystkie nuty o określonej wysokości, naciśnij klawisz Ctrl/Cmd i kliknij 
   klawisz na wyświetlaczu klawiatury po lewej stronie.
● Aby zaznaczyć wszystkie następujące zdarzenia nutowe o tej samej wysokości/pięciolinie, 
   naciśnij klawisz Shift i kliknij dwukrotnie zdarzenie nutowe

UWAGA
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Jeśli wybierzesz nuty na ekranie zdarzeń, zdarzenie nutowe zostanie wyświetlone w kolorze 
czarnym, a jedynie jego kontur będzie pokazany w kolorze. Na wyświetlaczu klawiatury klawisze 
odpowiadające wysokościom wybranych nut są również pokazane w kolorze.

POWIĄZANE LINKI
Menu kolorów zdarzeń na stronie 805
Wybierz podmenu dla zdarzeń nut na stronie 808
Edycja na stronie 1161

Wybierz podmenu dla zdarzeń nut
Podmenu Select (Wybierz) oferuje kilka opcji wyboru zdarzeń nutowych.

● Aby otworzyć podmenu Select (Wybierz) dla notatki, wybierz notatkę i wybierz Edit > Select 
   (Edytuj > Wybierz).

All (Wszystko)
   Zaznacza wszystkie zdarzenia nutowe w edytowanej części.
None (Nic)
   Odznacza wszystkie zdarzenia nutowe.
Invert (Odwróć)
   Odwraca zaznaczenie. Wszystkie wybrane zdarzenia związane z nutami zostaną odznaczone, a 
   zamiast nich zostaną zaznaczone wszystkie nuty, które nie zostały wybrane.
In Loop (W pętli)
   Wybiera wszystkie zdarzenia nutowe, które częściowo lub całkowicie mieszczą się w granicach 
   lewego i prawego lokalizatora (widoczne tylko wtedy, gdy ustawione są lokalizatory).
From Start to Cursor (Od początku do kursora)
   Wybiera wszystkie zdarzenia nutowe rozpoczynające się na lewo od kursora projektu.
From Cursor to End (Od kursora do końca)
   Wybiera wszystkie zdarzenia nutowe kończące się na prawo od kursora projektu
Equal Pitch - all Octaves (Równa wysokość – wszystkie oktawy)
   Wybiera wszystkie zdarzenia nutowe podświetlonej części, które mają tę samą wysokość (w 
   dowolnej oktawie) co wybrane zdarzenie nutowe.
UWAGA
Ta funkcja wymaga wybrania pojedynczego zdarzenia nutowego.

Equal Pitch - same Octave (Równa wysokość – ta sama oktawa)
   Wybiera wszystkie zdarzenia nutowe podświetlonej części, które mają tę samą wysokość (tą samą
   oktawę) co wybrane zdarzenie nutowe.
UWAGA
Ta funkcja wymaga wybrania pojedynczego zdarzenia nutowego.

Select Controllers in Note Range (Wybierz Kontrolery w zakresie nut)
   Wybiera dane kontrolera MIDI w zakresie wybranych zdarzeń nutowych.

POWIĄZANE LINKI
Usuwanie zdarzeń nutowych na stronie 809

Wyciszanie (muting) zdarzeń nutowych
Możesz wyciszyć poszczególne zdarzenia nutowe w edytorze MIDI. Wyciszanie poszczególnych 
nut umożliwia wykluczenie zdarzeń nutowych z odtwarzania.

Wykonaj jedną z następujących czynności:

● Kliknij zdarzenie nutowe za pomocą narzędzia Mute (Wycisz).
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● Przeciągnij prostokąt za pomocą narzędzia Mute, obejmujący wszystkie zdarzenia nutowe, które 
   chcesz wyciszyć.

● Wybierz zdarzenia nutowe i wybierz Edit > Mute (Edytuj > Wycisz).
● Aby wyłączyć wyciszenie zdarzenia nutowego, kliknij je lub uwzględnij za pomocą narzędzia 
   Mute. Możesz także wybrać zdarzenie nutowe i wybrać Edit > Unmute (Edycja > Wyłącz 
   wyciszenie).

Wyciszone nuty są przyciemnione na wyświetlaczu nut.

Toggle Selections (Przełącz wybór)
● Aby przełączać wybrane elementy w prostokącie zaznaczenia, naciśnij klawisz Ctrl/Cmd 
   i umieść te same elementy w nowym prostokącie zaznaczenia.

Po zwolnieniu przycisku myszy poprzedni wybór zostanie odznaczony i odwrotnie.

Usuwanie zdarzeń nutowych
● Aby usunąć zdarzenia z notatek, kliknij je narzędziem Erase (Usuń) lub zaznacz je i naciśnij 
klawisz Backspace.

Okno dialogowe Delete Notes (Usuń nuty)
Okno dialogowe Delete Notes umożliwia usuwanie zdarzeń nutowych, które nie pasują do 
określonej długości lub dynamiki (velocity).

● Aby otworzyć okno dialogowe Delete Notes, wybierz partię MIDI w oknie Project i wybierz  
MIDI > Functions > Delete Notes (MIDI > Funkcje > Usuń nuty).

            

Dostępne są następujące opcje:

Minimum Length (Minimalna długość)
   Umożliwia ustawienie minimalnej długości nuty w taktach. Nuty krótsze niż ustawiona wartość są
   usuwane. Można skorzystać z pola wartości lub graficznego wyświetlania długości. Kliknięcie 
   pola po prawej stronie długości graficznej powoduje zmianę skali wyświetlania. Można ustawić 
   na 1/4 taktu, jeden takt, dwa takty lub cztery takty.
Minimum Velocity (Minimalna prędkość, dynamika)
   Umożliwia ustawienie minimalnej dynamiki nuty. Nuty o niższej dynamice niż ustawiona wartość
   są usuwane.
Remove when under (Usuń, gdy jest pod)
Ta opcja jest dostępna tylko wtedy, gdy aktywowane są zarówno Minimum Velicity, jak 
i Minimum Length. Pozwala wybrać, czy aby nuty zostały usunięte, muszą zostać spełnione oba 
kryteria, czy tylko jedno.
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Przycinanie zdarzeń nutowych
Narzędzie Trim (Przytnij) umożliwia odcięcie końca lub początku zdarzeń nutowych.

PROCEDURA
1. Wybierz narzędzie Trim na pasku narzędzi.
2. Wykonaj jedną z następujących czynności:
      ● Aby przyciąć koniec pojedynczego zdarzenia nutowego, kliknij zdarzenie nutowe.
      ● Aby przyciąć początek pojedynczego zdarzenia nutowego, naciśnij klawisz Alt i kliknij 
         zdarzenie nutowe.
      ● Aby przyciąć kilka zdarzeń nutowych, kliknij i przeciągnij po zdarzeniach nutowych.
      ● Aby ustawić tę samą godzinę rozpoczęcia i zakończenia dla wszystkich edytowanych nut, 
         naciśnij klawisz Ctrl/Cmd i przeciągnij pionowo wzdłuż nut.

Edycja zdarzeń nutowych w linii informacyjnej
Możesz przenosić, zmieniać rozmiar lub prędkość (velocity) zdarzeń nutowych w linii 
informacyjnej, korzystając ze zwykłej edycji wartości.
      ● Aby zastosować zmianę wartości do wszystkich wybranych zdarzeń nutowych, naciśnij 
         klawisz Ctrl/Cmd i zmień wartość w wierszu informacyjnym.
      ● Aby dostosować wysokość lub dynamikę nut za pomocą klawiatury MIDI, kliknij pola Pitch 
         lub Velocity w wierszu informacyjnym i zagraj nutę na klawiaturze MIDI.
         Jeśli masz wybranych kilka zdarzeń nutowych i zmienisz wartość, wszystkie wybrane 
         zdarzenia zostaną zmienione o ustawioną kwotę.

Powielanie i powtarzanie zdarzeń nutowych
Możesz powielać i powtarzać zdarzenia nutowe w taki sam sposób, jak zdarzenia w oknie Project.
      ● Aby zduplikować wybrane zdarzenia nutowe, przytrzymaj klawisz Alt/Opt i przeciągnij 
         zdarzenia nutowe w nowe miejsce.
         Jeśli funkcja Snap (Przyciąganie) jest aktywna, określa, do jakich pozycji można kopiować 
         nuty.
      ● Aby skopiować wybrane nuty i umieścić je bezpośrednio za oryginałem, wybierz Edit > 
         Functions > Duplicate (Edycja > Funkcje > Duplikuj).
         Jeśli wybranych zostanie kilka zdarzeń nutowych, wszystkie zostaną skopiowane jako jedna 
         jednostka, przy zachowaniu względnej odległości pomiędzy zdarzeniami nutowymi.
      ● Aby utworzyć pewną liczbę kopii wybranych zdarzeń notatek, wybierz Edit > Functions > 
         Repeat (Edycja > Funkcje > Powtórz), określ liczbę i kliknij OK.
         Możesz także nacisnąć klawisz Alt/Opt i przeciągnąć prawą krawędź zdarzeń nutowych w 
         prawo, aby utworzyć kopie zdarzeń nutowych.

                   

Znajdowanie dokładnych pozycji za pomocą przyciągania (Snap)
Funkcja Snap (Przyciągania) ogranicza ruch w poziomie i pozycjonowanie do określonych pozycji.
Pomaga to znaleźć dokładne pozycje na ekranie nut podczas edycji zdarzeń nutowych w edytorze 
MIDI. Dotknięte operacje obejmują przenoszenie, powielanie, rysowanie, zmianę rozmiaru itp.
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● Aby włączyć/wyłączyć przyciąganie, kliknij Snap.

Jeżeli wybierzesz format wyświetlania Bars+Beats (Takty+Uderzenia), siatka przyciągania jest 
ustawiana na podstawie wartości kwantyzacji na pasku narzędzi. Umożliwia to przyciąganie do 
prostych wartości nut i przesuwanie siatek ustawionych w panelu Quantize Panel.

● Jeżeli wybierzesz którykolwiek z pozostałych formatów wyświetlania, pozycjonowanie będzie 
ograniczone do wyświetlanej siatki.

Ustawianie wartości Velocity (prędkości, dynamiki)
Kiedy rysujesz zdarzenia nutowe w edytorze MIDI, zdarzenia nutowe uzyskują wartość dynamiki 
ustawioną w polu Note Insert Velocity (Szybkość wstawiania nuty) na pasku narzędzi. Istnieją 
różne metody ustawiania prędkości.

● Użyj modyfikatora narzędzia Edit Velocity (Edytuj prędkość). Kursor zmieni się w głośnik, 
    a obok nuty, pole z suwakiem Note Velocity pokaże wartość. Przesuń wskaźnik myszy w górę 
    lub w dół, aby zmienić wartość.

             
Zmiany wartości zostaną zastosowane do wszystkich wybranych nut.

W tym celu należy przypisać modyfikator narzędzia do akcji Edit Velocity (Edytuj prędkość). 
Modyfikator narzędzia można edytować w oknie dialogowym Preferences (Preferencje) (strona  
Tool Modifiers (Modyfikatory narzędzi)).

● Otwórz wyskakujące menu Note Insert Velocity i wybierz wartość dynamiki.
   W tym menu możesz także wybrać opcję Setup (Ustawienia) i określić niestandardowe wartości 
   prędkości w menu podręcznym.
● Kliknij dwukrotnie pole Note Insert Velocity na pasku narzędzi i wprowadź wartość prędkości.
● Przypisz polecenia klawiszowe do opcji Insert Velocity 1-5 i używaj ich.
   Pozwala to na szybkie przełączanie pomiędzy różnymi wartościami dynamiki podczas 
   wprowadzania zdarzeń nutowych.

Obsługa kilku partii MIDI

● Aby aktywować część do edycji, otwórz wyskakujące menu Currently Edited Part (Aktualnie 
   edytowana część) i wybierz część.
   Po wybraniu części z listy jest ona automatycznie aktywna i wyśrodkowana na ekranie nut.
● Aby powiększyć aktywną część, wybierz Edit > Zoom > Zoom to Event (Edycja > Zoom >    
   Zoom do zdarzenia).
● Aby wyświetlić zdefiniowane obramowania aktywnej części, aktywuj opcję Show Part Borders  
   (Pokaż obramowania części).
   Jeśli ta opcja jest włączona, wszystkie części, z wyjątkiem części aktywnej, są wyszarzone.
● Aby ograniczyć operacje edycji do aktywnej części, aktywuj opcję Edit Active Part Only   
   (Edytuj tylko aktywną część).
● Aby zmienić rozmiar części, przeciągnij krawędzie części.
   Na obramowaniach części wyświetlana jest nazwa aktywnej części.
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UWAGA
Jeśli część otwierana do edycji jest kopią udostępnioną, wszelkie wprowadzone zmiany wpływają 
na wszystkie udostępnione kopie tej części. W oknie Project udostępnione kopie są oznaczone 
znakiem równości w prawym górnym rogu części.

Zapętlanie partii MIDI
Funkcja Independent Track Loop (Niezależna pętla ścieżki) umożliwia zapętlenie partii MIDI 
niezależnie od odtwarzania projektu.

Po włączeniu pętli zdarzenia MIDI w pętli będą powtarzane w sposób ciągły, podczas gdy inne 
zdarzenia na innych ścieżkach będą odtwarzane w zwykły sposób. Za każdym razem, gdy cykl 
rozpoczyna się od nowa, rozpoczyna się także niezależna pętla ścieżki.

PROCEDURA
1. Aktywuj Independent Track Loop na pasku narzędzi.

UWAGA
Jeśli aktywujesz Independent Track Loop, funkcja Link Project and Lower Zone Editor 
Cursors (Połącz kursory projektu i dolnej strefy edytora) zostanie automatycznie wyłączona w 
zakładce Editor (Edytor) w dolnej strefie okna Project.

Jeśli przycisk nie jest widoczny, kliknij pasek narzędzi prawym przyciskiem myszy i wybierz opcję 
Independent Track Loop (Niezależna pętla ścieżki) z menu kontekstowego.
Jeśli w oknie projektu ustawiłeś zakres pętli, jest on ukryty przed linijką w edytorze MIDI.

2. Ctrl/Cmd – kliknij linijkę, aby określić początek niezależnej pętli ścieżki.
3. Alt/Opt – kliknij linijkę, aby określić koniec niezależnej pętli ścieżki.

WYNIK
Niezależny zakres pętli jest oznaczony innym kolorem.
Początek i koniec zakresu pętli są wyświetlane w wierszu stanu.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby powtórzyć zdarzenia z zakresu pętli i wypełnić aktywną partię MIDI, wybierz MIDI > Repeat
Loop (MIDI > Powtórz pętlę).

Wyświetlacz kontrolera

Wyświetlacz kontrolera to obszar na dole Key Editor (edytora klawiszy), Drum Editor (edytora 
bębnów) i edytora InPlace Editor (edytora lokalnego).

Aby wyświetlić wyświetlacz kontrolera, wykonaj jedną z następujących czynności:

● Otwórz wyskakujące menu Controller Lane Setup (Konfiguracja linii kontrolera) w Key 
Editor, Drum Editor lub InPlace Editor i wybierz opcję Show/Hide Controller Lanes 
(Pokaż/ukryj ścieżki kontrolera).
● Na pasku narzędzi Key Editor lub Drum Editor kliknij Set up Window Layout (Skonfiguruj 
układ okna) i aktywuj Controller Lanes (Pasy kontrolerów).
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Dostępne są następujące opcje:
1   Note display (Wyświetlacz nut)
     Zawiera siatkę, w której nuty MIDI są wyświetlane w postaci ramek.
2   Controller display (Wyświetlacz sterownika)
     Pokazuje jeden lub wiele pasów kontrolera.
3   Divider (Rozdzielacz)
     Przeciągnij granicę między ekranem nut a wyświetlaczem kontrolera, aby zmienić rozmiar 
     wyświetlanych obszarów.
4   Controller Selection and Functions menu (Menu Wybór sterownika i funkcje)
     Umożliwia wybór typu wyświetlanego kontrolera i zawiera funkcje edycji linii kontrolerów 
     i zdarzeń.
5   Controller events (Zdarzenia kontrolera)
     Na wyświetlaczu sterownika widoczne są dodane zdarzenia sterownika wybranego typu 
     sterownika oraz ich aktualne wartości. Zdarzenia kontrolera nie mają długości. Ich wartości 
     obowiązują do rozpoczęcia kolejnego zdarzenia.
     Wartości prędkości są pokazane jako pionowe słupki, przy czym wyższe słupki odpowiadają 
     wyższym wartościom prędkości. Każdy pasek dynamiki (velocity) odpowiada nucie na ekranie 
     nut. Wszystkie pozostałe zdarzenia kontrolera są pokazane jako kroki, z wysokościami 
     odpowiadającymi wartościom zdarzeń.
6   Create Controller Lane (Utwórz linię kontrolerów)
     Umożliwia dodawanie pasów kontrolerów, dzięki czemu można przeglądać i edytować różne 
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     kontrolery w tym samym czasie. Każdy pas kontrolera może pokazywać jedną z następujących  
     właściwości lub typów zdarzeń:

     ● Velocity (Prędkość, dynamika)
     ● Pitchbend
     ● Aftertouch (Dotyk)
     ● Poly Pressure (Nacisk Poly)
     ● Program Change (Zmiana programu)
     ● System Exclusive (zdarzenia systemowe)
     ● Continuous Controllers (Kontrolery ciągłe)
     ● Articulations/Dynamics (Artykulacje/Dynamika)
7   Controller Lane Setup (Konfiguracja linii kontrolera)
     Zawiera funkcje konfiguracyjne dla pasów kontrolerów oraz umożliwia dodawanie 
     i organizowanie ustawień wstępnych.

Menu konfiguracji pasa kontrolera
Wyskakujące menu Controller Lane Setup (Konfiguracja pasa kontrolera) umożliwia dodanie 
pasów i wybranie typu wyświetlanego zdarzenia.
● Aby otworzyć wyskakujące menu Controller Lane Setup, kliknij Controller Lane Setup 
   w lewym dolnym rogu wyświetlacza kontrolera.

              
Dostępne są następujące opcje:

Add Preset (Dodaj ustawienie wstępne)
   Otwiera okno dialogowe Wpisz nazwę ustawienia wstępnego, które umożliwia zapisanie  
   ustawienia wstępnego i wprowadzenie jego nazwy.
Organize Presets (Organizuj ustawienia wstępne)
   Otwiera okno dialogowe Organize Presets (Organizuj ustawienia wstępne), w którym można 
   zmieniać nazwy i usuwać ustawienia wstępne.
Show Velocity Lane Only (Pokaż tylko pas prędkości)_
   Resetuje wyświetlacz kontrolera, aby wyświetlał tylko pas prędkości.
Type of New Controller Events (Typ nowych zdarzeń kontrolera)
   Pozwala określić, czy nowe zdarzenia kontrolera powinny zmieniać się stopniowo (Ramp), czy 
   natychmiast (Step) od poprzedniego punktu krzywej do nowego.
UWAGA
Dotyczy to tylko nowych zdarzeń, które utworzysz ręcznie. Nagrane zdarzenia MIDI CC są zawsze 
dodawane jako kroki. To ustawienie jest zapisywane razem z programem.

Set up Available Controllers (Skonfiguruj dostępne kontrolery)
   Otwiera okno dialogowe Konfiguracja kontrolera MIDI, które pozwala określić, które kontrolery  
   MIDI mają być widoczne/ukryte w wyskakującym menu.
Set up Dynamic Mapping (Skonfiguruj mapowanie dynamiczne)
   Otwiera okno dialogowe Dynamics Mapping Setup (Konfiguracja mapowania dynamiki), które 
   umożliwia mapowanie symboli dynamiki na kontrolery MIDI.
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Show/Hide Controller Lanes (Pokaż/ukryj pasy kontrolerów)
   Pokazuje/ukrywa ostatnio wyświetlane linie kontrolerów.

Menu kontekstowe linii kontrolera
● Aby otworzyć menu kontekstowe paska kontrolera, kliknij prawym przyciskiem myszy w lewym 
obszarze wyświetlacza kontrolera.

                
Dostępne są następujące opcje:
Create Controller Lane (Utwórz pas kontrolera)
      Tworzy pas kontrolera.
Remove This Lane (Usuń ten pas)
      Usuwa bieżący pas kontrolera.
Select All Events on Lane (Wybierz opcję Wszystkie zdarzenia na pasie)
      Wybiera wszystkie zdarzenia kontrolera na bieżącym pasie.
Cut (Wytnij) 
      Wycina wybrane zdarzenia
Copy (Kopiuj)
      Kopiuje wybrane zdarzenia do schowka.
Paste (Wklej)
      Wkleja dane ze schowka w miejscu kursora.
Paste at Origin (Wklej w miejscu pochodzenia)
      Wkleja dane ze schowka z powrotem do pierwotnej pozycji. Istniejące zdarzenia zostaną 
      zastąpione.
UWAGA
Możesz kopiować dane pomiędzy różnymi pasami CC.

POWIĄZANE LINKI
Wyświetlacz kontrolera na stronie 812

Menu wyboru sterownika i funkcji
Wyskakujące menu Controller Selection and Functions (Wybór i funkcje kontrolera) wyświetlane
po lewej stronie paska kontrolera umożliwia wybór wyświetlanego typu kontrolera. To menu 
podręczne jest dostępne tylko wtedy, gdy pokazany jest co najmniej jeden pas kontrolera. Zawiera 
także funkcje edycji pasów kontrolerów i zdarzeń.
● Aby otworzyć wyskakujące menu Controller Selection and Functions, kliknij Controller 
Selection and Functions po lewej stronie paska kontrolerów.
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Dostępne są następujące opcje:

Controller event types (Typy zdarzeń kontrolera)
      Wyświetla listę typów zdarzeń, które można wyświetlić na ścieżkach kontrolera. Jeżeli dane 
      automatyki dla sterownika już istnieją, jest to sygnalizowane rombem wyświetlanym po lewej 
      stronie nazwy sterownika.
Select All Events on Lane (Wybierz opcję Wszystkie zdarzenia na pasie)
      Wybiera wszystkie zdarzenia kontrolera na bieżącym pasie.
Remove This Lane (Usuń ten pas)
      Ukrywa bieżący pas kontrolera z widoku.

POWIĄZANE LINKI
Okno dialogowe konfiguracji kontrolera MIDI na stronie 819

Menu Create Controller Lane (Utwórz pas kontrolera)
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Wyskakujące menu Create Controller Lane (Utwórz linię kontrolerów) umożliwia utworzenie 
nowej linii kontrolerów i wybranie typu kontrolera, który ma być wyświetlany.

● Aby otworzyć wyskakujące menu Create Controller Lane, kliknij opcję Create Controller 

   Lane (Utwórz pas kontrolera)  po lewej stronie wyświetlacza kontrolera.

                   
Dostępne są następujące opcje:
Controller event types (Typy zdarzeń kontrolera)
      Wyświetla listę typów zdarzeń, które można wyświetlić na ścieżkach kontrolera. Jeżeli dane 
      automatyki dla sterownika już istnieją, jest to sygnalizowane rombem wyświetlanym po lewej 
      stronie nazwy sterownika.
      Wybierz typ zdarzenia, aby dodać odpowiedni pas kontrolera do wyświetlacza kontrolera.
Show Used Controllers (Pokaż używane sterowniki)
      Otwiera wszystkie ścieżki kontrolera, które zawierają zdarzenia kontrolera.

Dodawanie pasów kontrolerów
Możesz dodać pasy kontrolera do wyświetlacza kontrolera. Paski kontrolerów umożliwiają 
wybranie określonego typu kontrolera do wyświetlenia, dzięki czemu można dodawać i edytować 
zdarzenia kontrolera tego typu.

PROCEDURA

1. Kliknij opcję Create Controller Lane (Utwórz pas kontrolera)  .
2. Z wyskakującego menu wybierz typ zdarzenia kontrolera.
UWAGA
Jeśli typ zdarzenia kontrolera, który chcesz wyświetlić, nie jest dostępny, otwórz wyskakujące 
menu Controller Lane Setup (Konfiguracja pasa kontrolera) i wybierz opcję Set up Available 
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Controllers (Skonfiguruj dostępne kontrolery). Następnie możesz skonfigurować dostępne typy 
zdarzeń kontrolera w oknie dialogowym MIDI Controller Setup (Konfiguracja kontrolera MIDI).

WYNIK
Tworzony jest nowy pas kontrolera.

UWAGA
● Aby ukryć linię kontrolera, otwórz wyskakujące menu Controller Selection and Functions 
(Wybór kontrolera i funkcje) i wybierz opcję Remove This Lane (Usuń tę linię). Nie ma to 
żadnego wpływu na zdarzenia.

● Jeśli ukryjesz wszystkie pasy, wyświetlacz kontrolera zostanie ukryty. Możesz go przywrócić, 
klikając opcję Create Controller Lane (Utwórz pas kontrolera) lub otwierając wyskakujące menu 
Controller Lane Setup (Konfiguracja pasa kontrolera) i wybierając opcję Show/Hide Controller 
Lanes (Pokaż/ukryj pasy kontrolera).

POWIĄZANE LINKI
Menu wyboru sterownika i funkcji na stronie 815
Konfigurowanie dostępnych kontrolerów ciągłych na stronie 819

Wyświetlanie zdarzenia kontrolera innego typu
Możesz wybrać typ zdarzenia, który ma być wyświetlany na pasku kontrolera. Każda linia 
kontrolera pokazuje w danym momencie jeden typ zdarzenia.

PROCEDURA
● Otwórz wyskakujące menu Controller Selection and Functions (Wybór kontrolera i funkcje) i  
   wybierz inny typ zdarzenia.
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POWIĄZANE LINKI
Menu wyboru sterownika i funkcji na stronie 815

Konfigurowanie dostępnych kontrolerów ciągłych
W oknie dialogowym MIDI Controller Setup (Konfiguracja kontrolera MIDI) możesz określić, 
które kontrolery ciągłe są dostępne do wyboru.

PROCEDURA
1. Wybierz opcję Controller Lane Setup > Set up Available Controllers (Konfiguracja linii 
kontrolerów > Skonfiguruj dostępne kontrolery).
2. W oknie dialogowym MIDI Controller Setup (Konfiguracja kontrolera MIDI) wykonaj jedną z 
    następujących czynności:
   ● W kolumnie Hidden (Ukryte) wybierz wszystkie kontrolery, które chcesz pokazać i kliknij 
      Add (Dodaj).
   ● W kolumnie Visible (Widoczne) zaznacz wszystkie kontrolery, które chcesz ukryć i kliknij 
      Remove (Usuń).
3. Kliknij OK.

WYNIK
Można teraz wybrać odpowiednie kontrolery ciągłe
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UWAGA
Okno dialogowe MIDI Controller Setup (Konfiguracji kontrolera MIDI) jest dostępne w różnych 
obszarach programu. Ustawienia mają charakter globalny, co oznacza, że wybrana tutaj 
konfiguracja wpływa na wszystkie obszary programu, w których można wybrać kontrolery MIDI.

POWIĄZANE LINKI
Konfigurowanie dostępnych kontrolerów ciągłych na stronie 819

Okno dialogowe MIDI Controller Setup (konfiguracji kontrolera 
MIDI)
Okno dialogowe MIDI Controller Setup umożliwia określenie, które kontrolery MIDI mają być 
widoczne/ukryte.
● Aby otworzyć okno dialogowe MIDI Controller Setup, kliknij opcję Controller Lane Setup 
   (Konfiguracja linii kontrolera) po lewej stronie wyświetlacza kontrolera i wybierz opcję Set up 
   Available Controllers (Skonfiguruj dostępne kontrolery).

         
Visible (Widoczny)
      Wyświetla listę widocznych kontrolerów MIDI.
Hidden (Ukryty)
      Wyświetla listę ukrytych kontrolerów MIDI.

Add (Dodaj) >>>
      Wybierz element na liście Hidden (Ukryty) i kliknij Add >>>, aby był widoczny.
Remove (Usuń) <<<
      Wybierz element na liście Visible (Widoczne) i kliknij Remowe <<<, aby go ukryć.

Zapisywanie ustawień pasa kontrolera
Możesz zapisać konfigurację kontrolera pasa jako ustawienie wstępne kontrolera pasa (linii). W ten 
sposób możesz mieć preset z jedną ścieżką dynamiki (velocity) i inny preset z kombinacją kilku 
ścieżek kontrolera, takich jak prędkość (velocity), zagięcie wysokości (pitchbend) lub modulacja 
(modulation).

PRZYGOTOWANIE
Dodałeś co najmniej jeden pas kontrolera i wybrałeś typ zdarzenia kontrolera do wyświetlenia.

PROCEDURA
1. Kliknij opcję Controller Lane Setup (Konfiguracja linii kontrolera).
2. Wybierz opcję Add Preset (Dodaj ustawienie wstępne).
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3. W oknie dialogowym Type in Preset Name (Wpisz nazwę ustawienia wstępnego) wprowadź 
    nazwę ustawienia wstępnego.
4. Kliknij OK.

WYNIK
Konfiguracja toru kontrolera jest teraz dostępna jako ustawienie wstępne toru kontrolera. Liczba 
pasów i wyświetlane typy zdarzeń są zapisywane w presecie.
Aby załadować, usunąć ustawienia wstępne lub zmienić ich nazwę, otwórz menu Controller Lane 
Setup (Ustawienia kontrolera Lane) i wybierz Organize Presets (Organizuj ustawienia wstępne).

POWIĄZANE LINKI
Menu Controller Lane Setup (konfiguracji linii kontrolera) na stronie 814

Edycja zdarzeń związanych z velocity (prędkością)
Każde zdarzenie nutowe automatycznie otrzymuje zdarzenie dotyczące velocity. Możesz edytować 
wartości prędkości tych zdarzeń.

PRZYGOTOWANIE
Dodałeś pas kontrolera i skonfigurowałeś go tak, aby wyświetlał zdarzenia dotyczące prędkości. 
Dodano zdarzenia związane z szybkością dla kilku nut.

PROCEDURA
1. Opcjonalnie: na pasku narzędzi aktywuj Acoustic Feedback (Sprzężenie akustyczne).
    Odtwarza nuty po dostosowaniu dynamiki, dzięki czemu można odsłuchać wprowadzone 
    zmiany.
2. Wykonaj jedną z następujących czynności:
      ● Na pasku narzędzi wybierz narzędzie Object Selection (Zaznaczanie obiektów) lub Draw 
         (Rysuj) i kliknij pasek prędkości na wyświetlaczu kontrolera.
      ● Na pasku narzędzi wybierz narzędzie Object Selection, naciśnij klawisz Alt i kliknij pasek 
         prędkości na wyświetlaczu kontrolera, aby go zaznaczyć. Zmień wartość Velocity (prędkości)
         w wierszu informacyjnym.
      ● Na pasku narzędzi wybierz narzędzie Line (Linia) i przeciągnij po ekranie dynamiki, aby 
         zmienić wartości dynamiki kilku nut.

Wartość prędkości (velocity) w pozycji kursora projektu jest wyświetlana poniżej wyskakującego 
menu Controller Selection and Functions (Wybór kontrolera i funkcje)

           

UWAGA
Jeśli w tym samym miejscu znajduje się więcej niż jedna nuta, ich paski dynamiki nakładają się na 
siebie. Aby edytować dynamikę tylko jednej z tych nut, wybierz nutę na ekranie nut. Jeśli nie 
zostanie wybrana żadna nuta, wszystkie zdarzenia dotyczące prędkości otrzymają tę samą wartość 
dynamiki.
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WYNIK
Wartości velocity zmieniają się w zależności od wprowadzonych zmian.

POWIĄZANE LINKI
Dodawanie zdarzeń velocity (prędkości) na stronie 821
Menu wyboru sterownika i funkcji na stronie 815

Dodawanie zdarzeń velocity (prędkości)
Możesz dodać zdarzenia dotyczące prędkości, dodając zdarzenia nutowe.

WARUNEK WSTĘPNY
Dodałeś pas kontrolera.

PROCEDURA
1. Otwórz menu podręczne Controller Selection and Functions (Wybór kontrolera i funkcje) i  
    wybierz Velocity (Prędkość).
2. Wybierz narzędzie Draw (Rysuj) lub Line (Linia).
3. Kliknij ekran nuty, aby dodać zdarzenie nutowe.
    Spowoduje to dodanie zdarzenia nutowego i zdarzenia kontrolera prędkości, które można 
    edytować.

WYNIK
Wartości velocity (prędkości) są pokazane w postaci pionowych pasków na wyświetlaczu 
sterownika. Każdy pasek dynamiki odpowiada zdarzeniu nutowemu na ekranie nut. Wyższe słupki 
odpowiadają wyższym wartościom prędkości. Wartość obowiązuje do początku kolejnego 
zdarzenia.

                       

POWIĄZANE LINKI
Dodawanie pasów kontrolerów na stronie 817
Tryby narzędzia Linia na stronie 833
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Menu wyboru sterownika i funkcji na stronie 815

Pasy kontrolera Pitchbend
Paski kontrolera Pitchbend umożliwiają dodawanie i edycję zdarzeń kontrolera Pitchbend.
● Aby dodać ścieżkę kontrolera Pitchbend, otwórz menu Controller Selection and Functions 
(Wybór kontrolera i funkcje) i wybierz Pitchbend.

                       

1   Wartość przy kursorze projektu

Wyświetla wartość pitchbend w pozycji kursora projektu. To, co dokładnie jest wyświetlane, zależy
od ustawienia Show Semitones Grid (Pokaż siatkę półtonów) w panelu Grid Settings (Ustawienia 
siatki):
● Jeśli włączona jest opcja Show Semitones Grid, ta wartość pokazuje wartość półtonów w 
   pozycji kursora projektu. Zakres wynosi od +96 półtonów do -96 półtonów. Wartość jest 
   wyświetlana w półtonach i centach.
● Jeśli opcja Show Semitones Grid jest wyłączona, wartość ta pokazuje wartość MIDI Pitchbend   
   w pozycji kursora projektu. Zakres wynosi od +8191 kroków do -8192 kroków.
2  Zdarzenia Snap Pitchbend
   Ogranicza ruch w pionie i pozycjonowanie zdarzeń kontrolera do siatki półtonów. Domyślnie 
   aktywowanie Snap Pitchbend Events (Zdarzeń Snap Pitchbend) powoduje również aktywację 
   opcji Show Semitones Grid, aby pokazać siatkę, do której przyciągane są zdarzenia.

UWAGA
Funkcja Snap Pitchbend Events nie działa w edytorze zdarzeń kontrolera.

3 Skonfiguruj siatkę
   Otwiera panel Grid Settings (Ustawienia siatki), który umożliwia ustawienie siatki półtonów dla 
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   ścieżki kontrolera Pitchbend.
4 Wartość kontrolera z urządzenia MIDI
   Ta wartość pojawia się, jeśli wprowadzisz dane MIDI dla tego pasa kontrolera ze swojego 
   urządzenia MIDI.
5 Siatka półtonów
   Siatka półtonów pokazuje wartości półtonów. Ilość linii siatki i ich szerokość zależy od ustawień 
   Pitchbend Range: Down i Pitchbend Range: Up. Domyślnie zakres jest ustawiony na +/- 2 
   półtony, czyli sekundę wielką.

UWAGA
Możesz wyświetlić siatkę, nawet jeśli zdarzenia Snap Pitchbend są wyłączone.

6 Krzywa kontrolera
   Krzywa kontrolera pitchbend.
7 Pole Typ krzywej
   Pokazuje typ krzywej sterownika. Można to ustawić na Step (Krok) lub Ramp/Curve 
   (Nachylenie/Krzywa).

POWIĄZANE LINKI
Edytor zdarzeń kontrolera na stronie 835
Ustawienia siatki na stronie 823

Ustawienia siatki
Panel Grid Settings (Ustawienia siatki) umożliwia ustawienie siatki półtonów dla ścieżki 
kontrolera Pitchbend. Ponieważ ustawienia siatki wpływają tylko na odpowiednią ścieżkę, możesz 
skonfigurować różne ustawienia siatki dla różnych ścieżek MIDI lub instrumentów. Wszystkie 
ustawienia siatki są zapisywane z projektem.

● Aby wyświetlić Grid Settings (Ustawienia siatki) dla pasów kontrolera Pitchbend, dodaj pas 
kontrolera Pitchbend i kliknij Set up Grid (Skonfiguruj siatkę).

            

Show Semitones Grid (Pokaż siatkę półtonów)
   Siatka półtonów pokazuje wartości półtonów, do których przyciągane są zdarzenia. Ilość linii  
   siatki i ich szerokość zależy od ustawień Pitchbend Range: Down i Pitchbend Range: Up.
UWAGA
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Siatka to pomoc wizualna, która pozwala łatwiej znaleźć dokładne pozycje półtonów dla 
pitchbendów. Zmiana siatki nie powoduje zmiany wartości zdarzeń pitchbend.

Pitchbend Range: Up (Zakres Pitchbendu: W górę)
   Umożliwia określenie wartości górnej siatki w zakresie od 1 do 96 półtonów. Domyślnie górny 
   zakres zagięcia siatki jest ustawiony na 2 półtony, co pozwala określić zagięcie w górę od 1 do  
   maksymalnie 2 półtonów.
Pitchbend Range: Down (Zakres Pitchbendu: W dół)
   Umożliwia określenie wartości dolnej siatki w zakresie od 1 do -96 półtonów. Domyślnie dolny 
   zakres nachylenia siatki jest ustawiony na -2 półtony, co pozwala określić zagięcie w dół od 1 do 
   -2 półtonów.
Link (Połącz)
   Umożliwia łączenie zakresów pitchbend. Można tę funkcję dezaktywować, jeśli na przykład 
   chcesz ustawić wyższą wartość dla górnego zakresu niż dla dolnego zakresu.

UWAGA
Rzeczywisty zakres pitchbend zależy od ustawień instrumentu VST lub MIDI oraz używanego 
brzmienia lub presetu. Aby w pełni wykorzystać tę funkcję, pamiętaj o dostosowaniu ustawień 
zakresu pitchbend swojego instrumentu do ustawień ścieżki kontrolera pitchbend i odwrotnie.

POWIĄZANE LINKI
Pasy kontrolera Pitchbend na stronie 822

Dodawanie zdarzeń Pitchbend
Do zdarzeń nutowych możesz dodawać zdarzenia pitchbend.

PROCEDURA
1. Otwórz wyskakujące menu Create Controller Lane (Utwórz ścieżkę kontrolera) i wybierz opcję
    Pitchbend.
2. Opcjonalnie: Kliknij opcję Set up Grid (Ustaw siatkę), aby otworzyć panel Grid Settings  
    (Ustawienia siatki) i skonfiguruj siatkę zgodnie ze swoimi potrzebami.
3. Opcjonalnie: Aktywuj opcję Snap Pitchbend Events (Przyciągnij zdarzenia pitchbend), aby 
    przyciągnąć zdarzenia kontrolera Pitchbend do ustawionej siatki.
4. Wybierz narzędzie Draw (Rysuj) i kliknij na wyświetlaczu kontrolera, aby wprowadzić dowolną 
    liczbę zdarzeń pitchbend.

WYNIK
Dodano zdarzenia kontrolera pitchbend

POWIĄZANE LINKI
Pasy kontrolera Pitchbend na stronie 822
Utwórz menu pasa kontrolera na stronie 816
Ustawienia siatki na stronie 823
Tworzenie płynnych przejść pomiędzy ciągłymi zdarzeniami kontrolera na stronie 830
Edycja zdarzeń Pitchbend na stronie 825

Edycja zdarzeń Pitchbend

WARUNEK WSTĘPNY
Dodałeś ścieżkę (pas) kontrolera Pitchbend i dodałeś zdarzenia Pitchbend.

PROCEDURA
1. Na pasku narzędzi wybierz narzędzie Object Selection (Zaznaczanie obiektów).
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2. Opcjonalnie: Kliknij opcję Set up Grid (Ustaw siatkę), aby otworzyć panel Grid Settings  
    (Ustawienia siatki) i skonfiguruj siatkę zgodnie ze swoimi potrzebami.
3. Na ekranie kontrolera przesuń wskaźnik myszy nad zdarzeniem kontrolera Pitchbend.
    Wskaźnik myszy staje się symbolem wskazującej dłoni.

UWAGA
Możesz tworzyć płynne przejścia między zdarzeniami kontrolera Pitchbend, wybierając zdarzenie 
kontrolera Pitchbend i przełączając Curve Type (Typ krzywej) w linii informacyjnej na 
Ramp/Curve (Rampa/Krzywa) i edytując uchwyty krzywych.

4. Kliknij zdarzenie kontrolera Pitchbend, aby je zaznaczyć i przeciągnij w inne miejsce.

POWIĄZANE LINKI
Ustawienia siatki na stronie 823
Dodawanie zdarzeń Pitchbend na stronie 824
Ścieżki (pasy) kontrolera Pitchbend na stronie 822

Dodawanie artykulacji
Na pasku kontrolera możesz dodawać i edytować wyrażenia muzyczne i artykulacje.

POWIĄZANE LINKI
Wstawianie artykulacji na pasach kontrolera na stronie 915

Dodawanie dynamiki
Możesz dodać dynamikę do swoich nut.

WARUNEK WSTĘPNY
Skonfigurowałeś mapowanie dynamiki i aktywowałeś je dla ścieżki.

PROCEDURA
1. Otwórz menu podręczne Controller Selection and Functions (Wybór kontrolera i funkcje) i  
    wybierz opcję Articulations/Dynamics (Artykulacje/Dynamika).
2. Wybierz narzędzie Draw (Rysuj) i kliknij wyświetlacz kontrolera.
    Wstawiany jest symbol mezzo forte.
3. Kliknij trójkąt w lewym górnym rogu zdarzenia i wybierz inny symbol dynamiki 
    z wyskakującego menu.
UWAGA
Jeśli do edycji wybierzesz kilka dynamik, wszystkie zdarzenia będą się zmieniać stopniowo, czyli 
w stosunku do wartości oryginalnych.

836



           

UWAGA
Możesz przeglądać dostępne symbole dynamiki za pomocą kółka myszy lub poleceń klawiszowych 
Jeden w dół i Jeden w górę.

WYNIK
Wstawiony zostanie wybrany symbol dynamiki.

POWIĄZANE LINKI
Okno dialogowe konfiguracji mapowania dynamiki na stronie 826
Przenoszenie zdarzeń na wyświetlaczu sterownika na stronie 836

Okno dialogowe ustawień mapowania dynamiki
Okno dialogowe Dynamics Mapping Setup (Konfiguracji mapowania dynamiki) umożliwia 
mapowanie symboli dynamiki na kontrolery MIDI.

Aby otworzyć okno dialogowe Dynamics Mapping Setup, wykonaj jedną z następujących 
czynności:
● Na wyświetlaczu sterownika otwórz wyskakujące menu Controller Selection and Functions  
   (Wybór i funkcje kontrolera), wybierz Articulations/Dynamics (Artykulacja/Dynamika), otwórz 
   wyskakujące menu Controller Lane Setup (Konfiguracja pasa kontrolera) i wybierz opcję Set 
   up Dynamic Mapping (Konfiguracja mapowania dynamiki).
● W Score Editor (Edytorze partytury) otwórz sekcję Dynamics Mapping (Mapowanie 
   dynamiki), kliknij prawym przyciskiem myszy symbol dynamiki i wybierz Dynamics Mapping.
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Initialize Dynamic Mapping (Zainicjuj mapowanie dynamiczne)
   Umożliwia określenie zakresu dynamiki pracy z mapowanymi symbolami dynamicznymi. Otwórz
   menu podręczne po prawej stronie i aktywuj pp-ff, jeśli nie chcesz, aby ekstremalnie dynamiczne 
   symbole (pppp, ppp, ffff i fff) miały wpływ. Aktywuj pppp-ffff, aby wykorzystać cały zakres 
   dynamiki.
Symbol
      Zawiera listę różnych symboli dynamicznych.
Velocity (Prędkość)
      Umożliwia ustawienie zmiany prędkości dla wybranego symbolu dynamicznego.
Volume (Głośność)
      Umożliwia ustawienie zmiany głośności dla wybranego symbolu dynamicznego.
Controller (Kontroler)
      Umożliwia ustawienie zmiany kontrolera dla wybranego symbolu dynamicznego. Aby wybrać 
      wysyłany kontroler MIDI, aktywuj opcję Send Controller (Wyślij kontroler) i wybierz 
      kontroler z wyskakującego menu.
Change Velocities (Zmień prędkości)
      Aktywuj tę opcję, aby modyfikować prędkości o wartość procentową ustawioną w kolumnie 
      Velocity (Prędkość).
Send Volume (Wyślij głośność)
      Aktywuj tę opcję, aby wybrać, które zdarzenia woluminu mają być wysyłane: CC 11 
      (Expression) (Wyrażenie), CC 7 (Main Volume) (Główna głośność). Jeśli ścieżka MIDI jest 
      kierowana do instrumentu VST, możesz także wybrać głośność VST 3 Volume.
Send Controller (Wyślij kontroler)
      Umożliwia wybór wysyłanego kontrolera MIDI.
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Dodawanie zdarzeń Poly Pressure
Możesz dodać zdarzenia poly pressure do swoich nut. Zdarzenia poly pressure to zdarzenia 
należące do określonego numeru nuty, czyli klucza. Dla każdego zdarzenia poly pressure możesz 
edytować numer nuty i wielkość nacisku (pressure).

PROCEDURA

1. Kliknij opcję Create Controller Lane   (Utwórz pas kontrolera).
2. Wybierz z menu opcję Poly Pressure.
    Dodano pas kontrolera Poly Pressure. Pokazuje pole wartości numeru nuty po lewej stronie
    wyświetlacza kontrolera.
3. Wykonaj jedną z następujących czynności:
      ● Wybierz zdarzenie nutowe na ekranie nut, aby ustawić numer nuty dla odpowiedniej 
         wysokości. Działa to tylko w przypadku najwyższej z kilku linii kontrolera poly pressure.
      ● Jeśli pracujesz z kilkoma ścieżkami (pasami) kontrolera nacisku poly pressure, użyj menu 
         podręcznego w polu wartości numeru nuty po lewej stronie wyświetlacza kontrolera, aby 
         wybrać wysokość nuty dla tej linii kontrolera.
Wybrany numer nuty wyświetlany jest w górnym polu wartości po lewej stronie wyświetlacza 
sterownika (kontrolera).

4. Na pasku narzędzi wybierz narzędzie Draw (Rysuj) i dodaj nowe zdarzenie poly pressure.
    Wartość można określić przesuwając mysz w górę lub w dół na wyświetlaczu kontrolera.

PO ZAKOŃCZENIU TEGO ZADANIA
Wybierz inny numer nuty i dodaj do niej zdarzenia poly pressure.

POWIĄZANE LINKI
Menu wyboru sterownika i funkcji na stronie 815

Edytowanie zdarzeń Poly Pressure

WARUNEK WSTĘPNY
Dodałeś pas kontrolera i skonfigurowałeś go do wyświetlania zdarzeń związanych z poly pressure. 
Dodano zdarzenia poly pressure dla kilku numerów nut.

PROCEDURA
1. Kliknij przycisk strzałki obok numeru nuty po lewej stronie paska kontrolera.
    Otworzy się wyskakujące menu z listą wszystkich numerów nut, dla których wstawiono 
    zdarzenia poly pressure.
2. Wybierz numer nuty z wyskakującego menu.
    Zdarzenia poly pressure dla wybranego numeru nuty są pokazane na pasku kontrolera.
3. Na pasku narzędzi wybierz narzędzie Draw (Rysuj).
4. Przytrzymaj Ctrl/Cmd -Alt/Opt i edytuj zdarzenia na wyświetlaczu kontrolera.

POWIĄZANE LINKI
Dodawanie zdarzeń Poly Pressure na stronie 828
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Dodawanie kontrolerów ciągłych
Możesz dodawać ciągłe kontrolery do swoich zdarzeń nutowych.

WARUNEK WSTĘPNY
Dodałeś pas kontrolera.

PROCEDURA
1. Otwórz menu podręczne Controller Selection and Functions (Wybór kontrolera i funkcje) 
    i wybierz kontroler ciągły.
2. Wybierz narzędzie Draw (Rysuj) lub Line (Linia).
3. Wykonaj jedną z następujących czynności:
      ● Aby dodać pojedyncze zdarzenie, kliknij na wyświetlaczu kontrolera.
      ● Aby dodać wiele zdarzeń, kliknij i przeciągnij na wyświetlaczu kontrolera.
      ● Aby dodać zdarzenie modulacji Modulation (CC1), skopiuj zdarzenia nutowe z ekranu nut 
         Key Editor i wklej je na pasku kontrolera na wyświetlaczu kontrolera.
Kiedy przesuwasz narzędzie Draw (Rysuj) na pasku kontrolera, podpowiedź pokazuje położenie i 
wartość kontrolera w pozycji myszy.

WYNIK
Dodane zdarzenia są dodawane jako kroki odpowiadające wartościom zdarzeń. Początek zdarzenia 
jest oznaczony punktem krzywej. Zdarzenia kontrolera nie mają długości. Wartość zdarzenia 
kontrolera na wyświetlaczu obowiązuje do początku kolejnego zdarzenia kontrolera.

POWIĄZANE LINKI
Dodawanie pasów kontrolerów na stronie 817
Tryby narzędzia Linia na stronie 833
Menu wyboru sterownika i funkcji na stronie 815

Edycja kontrolerów ciągłych
Możesz edytować wartości dodanych lub zarejestrowanych ciągłych zdarzeń kontrolera.

WARUNEK WSTĘPNY
Dodałeś linię kontrolera i skonfigurowałeś ją tak, aby wyświetlała zdarzenia kontrolera. Dodałeś 
zdarzenia kontrolera dla kilku nut.

PROCEDURA
1. Na pasku narzędzi wybierz narzędzie Object Selection (Zaznaczanie obiektów), Draw (Rysuj)  
    lub Line (Linia).
2. Wykonaj jedną z następujących czynności:
      ● Jeśli wybrałeś narzędzie Draw (Rysuj) lub Line (Linia), przeciągnij na wyświetlaczu 
         kontrolera.
      ● Jeśli wybrałeś narzędzie Object Selection (Zaznaczanie obiektów), naciśnij Alt i przeciągnij 
         na wyświetlaczu kontrolera.

WYNIK
Zdarzenie kontrolera jest edytowane.

POWIĄZANE LINKI
Tryby narzędzia Linia na stronie 833
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Tworzenie płynnych przejść pomiędzy ciągłymi zdarzeniami 
kontrolera
Domyślnie podczas nagrywania lub rysowania ciągłych zdarzeń kontrolera MIDI są one wstawiane 
jako kroki. Jeśli nie tego chcesz, możesz stworzyć płynne przejścia między zdarzeniami.

WARUNEK WSTĘPNY
Nagrałeś dane MIDI z ciągłymi zdarzeniami kontrolera.

PROCEDURA
1. W oknie Project kliknij dwukrotnie partię MIDI.
2. W Key Editor (Edytorze klawiszy) otwórz menu Create Controller Lane (Utwórz linię  
    kontrolerów) i wybierz opcję Show Used Controllers (Pokaż używane kontrolery).
    Paski kontrolera dla wszystkich zarejestrowanych zdarzeń kontrolera są wyświetlane na 
    wyświetlaczu kontrolera.
3. Znajdź linię kontrolera ciągłego, którą chcesz edytować, i wybierz zdarzenie kontrolera.
    Linia informacyjna Key Editor (Edytora klawiszy) wyświetla informacje o wybranym zdarzeniu 
    sterownika, takie jak Type (Typ), pozycja Start (początkowa), Value (wartość), Channel 
    (kanał) i Curve Type (Typ krzywej).

                    

4. Wykonaj jedną z następujących czynności:
      ● W wierszu informacyjnym zmień opcję w polu Curve Type (Typ krzywej) z Step (Krok) na  
         Ramp/Curve (Rampa/Krzywa).
UWAGA
Możesz zmienić typ krzywej dla kilku zdarzeń kontrolera, zaznaczając je, a następnie zmieniając 
wartość w polu Curve Type.
      ● Na ekranie kontrolera przesuń wskaźnik myszy pomiędzy dwoma zdarzeniami kontrolera i 
         kliknij dwukrotnie uchwyt, który się pojawi, aby zmienić typ krzywej ze Step na 
         Ramp/Curve.
5. Przesuń wskaźnik myszy nad rampę, kliknij uchwyt i przesuń go w górę lub w dół, aby zmienić 
    kształt rampy w krzywą.

                     

WYNIK
Rampa zmienia się w krzywą.
Kiedy odtwarzasz rampy/krzywe, dane pomiędzy dwoma zdarzeniami ciągłego kontrolera MIDI są
interpolowane do odpowiedniej rozdzielczości danych MIDI. Można to sobie wyobrazić, 
wybierając opcję MIDI > Merge MIDI in Loop (MIDI > Scal MIDI w pętli) lub MIDI > Freeze 
MIDI Modifiers (MIDI > Zamroź modyfikatory MIDI) albo eksportując część jako plik MIDI.
UWAGA
Krzywe kontrolera Ramp/Curve (rampy/krzywej) są bardziej wymagające pod względem 
wydajności aplikacji.

PO ZAKOŃCZENIU TEGO ZADANIA
Za pomocą menu kontekstowego ścieżki kontrolera można wycinać, kopiować i wklejać zdarzenia 
kontrolera.

POWIĄZANE LINKI
Menu kontekstowe linii kontrolera na stronie 815
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Kontrolery ciągłe i automatyzacja MIDI
Możesz nie tylko nagrywać lub wprowadzać dane kontrolera MIDI dla partii MIDI na ścieżce 
kontrolera, ale także dla ścieżki automatyzacji w oknie Project.
Aby wyświetlić i edytować dane kontrolera MIDI na ścieżce automatyzacji, należy wyodrębnić 
automatyzację MIDI z partii MIDI
Dane kontrolera MIDI ze ścieżki automatyzacji są również wyświetlane na pasku kontrolera. Nie 
można jednak edytować tych danych na linii kontrolera.

Jeśli istnieją sprzeczne dane kontrolera, musisz określić, co powinno się dziać podczas odtwarzania,
wybierając opcję z Automation Merge Modes (Trybów łączenia automatyzacji) w oknie 
dialogowym MIDI Controller Automation Setup (Konfiguracja automatyzacji kontrolera MIDI).

             
1 Krzywa kontrolera przed rozpoczęciem części. Krzywa ta zależy od istniejących danych 
   sterownika i wybranego trybu scalania.
2 Krzywa kontrolera wprowadzona na pasie kontrolera.
3 Wynikowa krzywa kontrolera, jeśli na ścieżce zarejestrowano również automatyzację kontrolera. 
   Wartości te zależą od wybranego trybu scalania automatyzacji.

Na pasku kontrolera można także zobaczyć krzywą kontrolera zastosowaną przed rozpoczęciem 
części. Dzięki temu dowiesz się, która wartość kontrolera jest używana w punkcie początkowym 
części, dzięki czemu będziesz mógł odpowiednio wybrać wartość początkową.

Wartość początkowa zależy również od trybu scalania automatyzacji

POWIĄZANE LINKI
Wyodrębnianie automatyzacji MIDI na stronie 801
Tryby łączenia automatyzacji na stronie 833
Automatyzacja kontrolera MIDI na stronie 831

Automatyzacja kontrolera MIDI
Podczas pracy z Cubase możliwe jest nagrywanie danych automatyzacji dla kontrolerów MIDI jako
dane partii MIDI i jako dane na ścieżce automatyzacji.

Jeśli masz takie sprzeczne dane automatyzacji, możesz określić oddzielnie dla każdego parametru, 
w jaki sposób są one łączone podczas odtwarzania. Odbywa się to poprzez wybranie Automation 
Merge Mode (Trybu łączenia automatyzacji) na liście ścieżek ścieżki automatyzacji.

Okno dialogowe MIDI Controller Automation Setup (Konfiguracji 
automatyzacji kontrolera MIDI)
W oknie dialogowym MIDI Controller Automation Setup możesz określić, w jaki sposób 
istniejąca automatyzacja MIDI będzie obsługiwana podczas odtwarzania, a nowe dane 
automatyzacji będą rejestrowane w partii MIDI lub jako automatyzacja ścieżki. Wszystkie 
ustawienia dokonane w tym oknie dialogowym zostaną zapisane w projekcie.

● Aby otworzyć okno dialogowe MIDI Controller Automation Setup, wybierz opcję MIDI > CC
   Automation Setup (MIDI > Konfiguracja automatyzacji CC).
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Record Destination on Conflict (global) (Zapisz miejsce docelowe w konflikcie (globalne))
   Pozwala określić, które miejsce docelowe będzie używane, jeśli dane kontrolera MIDI zostaną 
   odebrane przez Cubase i włączone są przyciski Record (Nagraj) i Write Automation (Pisz 
   automatyzację). Wybierz Partię MIDI, aby nagrać automatyzację partii MIDI. Wybierz opcję   
   Automation Track (Ścieżka automatyzacji), aby zapisać dane sterownika na ścieżce automatyki 
   w oknie Project.
Automation Merge Mode (global) (Tryb łączenia automatyzacji (globalny))
   Umożliwia określenie globalnego trybu scalania dla automatyzacji.
Controller list (Lista kontrolerów)
   Wyświetla listę wszystkich kontrolerów MIDI, dla których można osobno określić miejsce 
   docelowe nagrywania i tryb scalania dla automatyzacji. Daje to pełną kontrolę nad automatyzacją 
   MIDI (docelową i trybem scalania) w Twoim projekcie.
Record Destination (Zapisz miejsce docelowe)
   Kliknij kolumnę Record Destination (Miejsce docelowe zapisu dla kontrolera MIDI, aby 
   otworzyć menu podręczne, w którym możesz wybrać, gdzie mają być zapisywane dane nagrane 
   dla tego konkretnego kontrolera MIDI.
Automation Merge Mode (Tryb łączenia automatyzacji)
   Kliknij kolumnę Automation Merge Mode (Tryb łączenia automatyzacji) dla kontrolera MIDI,   
   aby określić, co dzieje się z danymi tego konkretnego kontrolera podczas odtwarzania.
Save As Default (Zapisz jako domyślny)
   Umożliwia zapisanie bieżących ustawień jako ustawień domyślnych. Kiedy tworzysz nowy 
   projekt, używane są ustawienia domyślne.
Load Default (Załaduj domyślnie)
   Umożliwia załadowanie ustawień domyślnych.

843



Tryby łączenia automatyzacji
Automation Merge Modes (Tryby łączenia automatyzacji) w oknie dialogowym MIDI Controller
Automation Setup (Konfiguracja automatyzacji kontrolera MIDI) są dostępne tylko dla 
kontrolerów, które mogą nagrywać zarówno partię, jak i ścieżkę. 

● Aby otworzyć okno dialogowe MIDI Controller Automation Setup, wybierz opcję MIDI > CC
Automation Setup (MIDI > Konfiguracja automatyzacji CC).

Use Global Settings (Użyj ustawień globalnych)
   Po wybraniu tej opcji ścieżka automatyzacji korzysta z Merge Mode (Trybu scalania) globalnej 
   automatyzacji, który jest określony w oknie dialogowym MIDI Controller Automation Setup 
   (Konfiguracji automatyzacji kontrolera MIDI).
Replace 1 - Part Range (Zamień 1 – zakres części)
   Po wybraniu tej opcji dane części mają priorytet odtwarzania w stosunku do danych ścieżki 
   automatyzacji. Na przykład na lewej i prawej granicy części tryb automatyzacji przełącza się 
   gwałtownie z automatyzacji części na automatyzację toru i odwrotnie.
Replace 2 - Last Value Continues (Zastąp 2 — ostatnia wartość jest kontynuowana)
   Podobnie jak Replace 1 - Part Range, ale automatyzacja części rozpoczyna się dopiero po 
   osiągnięciu pierwszego zdarzenia kontrolera w części. Na końcu części ostatnia wartość 
   kontrolera jest zachowywana do momentu osiągnięcia zdarzenia automatyzacji na ścieżce 
   automatyzacji.
Average (Przeciętny)
   Po wybraniu tej opcji używane są średnie wartości pomiędzy automatyzacją części i toru.
Modulation (Modulacja)
   W tym trybie krzywa ścieżki automatyzacji moduluje istniejącą automatyzację części, przy czym 
   wyższe punkty krzywej podkreślają wartości automatyzacji, a niższe punkty krzywej jeszcze 
   bardziej zmniejszają wartości automatyzacji.

UWAGA
Ustawienia wprowadzone dla kontrolera zostaną zastosowane do wszystkich ścieżek MIDI 
korzystających z tego kontrolera.

Tryby narzędzia Line (linia)
Do edycji zdarzeń kontrolera można używać różnych trybów narzędzia Line (Linia).

● Aby wybrać tryb linii, kliknij narzędzie Line w pasku narzędzi Key Editor (Edytor klawiszy) lub
   Drum Editor (Edytor bębnów), a następnie kliknij ponownie, aby otworzyć wyskakujące menu z 
   dostępnymi trybami.

Dostępne są następujące tryby:
Line (Linia)
   W tym trybie możesz rysować zdarzenia w linii prostej, klikając na wyświetlaczu kontrolera i 
   przeciągając kursor do miejsca, w którym chcesz zakończyć rampę.

               
UWAGA
Jeśli opcja Snap (Przyciąganie) jest aktywna, wartość Length Quantize (Kwantyzacji długości) 
określa gęstość utworzonych krzywych kontrolera. W przypadku bardzo gładkich krzywych użyj 
małej wartości Length Quantize lub wyłącz Snap. Uważaj, ponieważ bardzo gęste krzywe 
kontrolera mogą powodować zacinanie się odtwarzania MIDI.
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Parabola
   W tym trybie możesz rysować zdarzenia na krzywej paraboli. Daje to bardziej naturalne 
   krzywizny i zaniki (fades).

                

Możesz użyć klawiszy modyfikujących, aby określić kształt krzywej paraboli.
      ● Aby odwrócić krzywą paraboli, naciśnij klawisz Ctrl/Cmd .
      ● Aby zmienić położenie całej krzywej, naciśnij klawisz Alt/Opt.
      ● Aby zwiększyć lub zmniejszyć wykładnik, naciśnij Shift .

UWAGA
Jeśli opcja Snap (Przyciąganie) jest aktywna, wartość Length Quantize (Kwantyzacji długości) 
określa gęstość utworzonych krzywych kontrolera. W przypadku bardzo gładkich krzywych użyj 
małej wartości Length Quantize lub wyłącz Snap. Uważaj, ponieważ bardzo gęste krzywe 
kontrolera mogą powodować zacinanie się odtwarzania MIDI.

Sine, Triangle, and Square (Sinus, trójkąt i kwadrat)
   Tryby te tworzą różne okresowe krzywe przebiegu. 

               

Wartość kwantyzacji określa okres krzywej, czyli długość jednego cyklu krzywej. Wartość Length 
Quantize (Długość kwantyzacji) określa gęstość zdarzeń.

UWAGA
Jeśli ustawisz Length Quantize na Quantize Link i wprowadzisz dane w trybie Sine (sinus), 
Triangle (trójkąt) lub Square (kwadrat), gęstość zdarzeń zależy od współczynnika powiększenia 
(zoom).

Możesz użyć klawiszy modyfikujących, aby określić kształt krzywej.

● Aby zmienić fazę początku krzywej, naciśnij klawisz Ctrl/Cmd .
● Aby zmienić położenie całej krzywej, naciśnij Alt/Opt - Ctrl/Cmd.
● Aby zmienić maksymalne położenie krzywej trójkątnej lub puls krzywej kwadratowej w trybie 
   Triangle (Trójkąt) i Square (Kwadrat), naciśnij Shift - Ctrl/Cmd. Tworzy to krzywe 
   piłokształtne.
● Możesz także dowolnie ustawić okres krzywej, przytrzymując klawisz Shift podczas wstawiania  
   zdarzeń w trybie Sine (sinus), Triangle lub Square. Aktywuj Snap (przyciąganie), Shift - kliknij
   i przeciągnij, aby ustawić długość jednego okresu. Długość okresu będzie wielokrotnością 
   wartości kwantyzacji.
Paint (Maluj)
      W tym trybie możesz rysować wiele nut.

UWAGA
Jeśli opcja Snap (Przyciąganie) jest aktywna, wartość Length Quantize (Kwantyzacji długości) 
określa gęstość utworzonych krzywych kontrolera. W przypadku bardzo gładkich krzywych użyj 
małej wartości Length Quantize lub wyłącz Snap. Uważaj, ponieważ bardzo gęste krzywe 
kontrolera mogą powodować zacinanie się odtwarzania MIDI.
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Edytor zdarzeń kontrolera
Edytor zdarzeń sterownika umożliwia wykonanie dodatkowych operacji skalowania dla zakresów 
wyboru na istniejących krzywych sterownika.
● Aby otworzyć edytor zdarzeń kontrolera, aktywuj narzędzie Object Selection (Zaznaczanie 
   obiektów) i przeciągnij prostokąt zaznaczenia na pasmo kontrolera.
● Aby otworzyć edytor zdarzeń kontrolera dla pasów prędkości, zaznacz wiele nut MIDI na ekranie
   nut lub aktywuj narzędzie Object Selection, naciśnij klawisz Alt i przeciągnij prostokąt 
   zaznaczenia na pasmo kontrolera lub aby uzyskać narzędzie Object Selection.
UWAGA
Edytor zdarzeń kontrolera nie jest dostępny dla pasów Articulation (Artykulacji) i Dynamics 
(Dynamiki).

Edytor zdarzeń kontrolera zawiera następujące inteligentne elementy sterujące dla określonych 
trybów edycji:

                          
1   Tilt Left (Przechyl w lewo)
     Klikając w lewy górny róg edytora, możesz przechylić lewą część krzywej. Umożliwia to 
     przechylenie wartości zdarzeń na początku krzywej w górę lub w dół.
2   Compress Left (Kompresuj w lewo)
     Jeśli klikniesz Alt/Opt w lewym górnym rogu edytora, możesz skompresować lub rozszerzyć 
     lewą część krzywej. Umożliwia to kompresję lub rozszerzenie wartości zdarzeń na początku 
     krzywej.
3   Scale Vertically (Skaluj w pionie)
     Jeśli klikniesz na środku górnej krawędzi edytora, możesz przeskalować krzywą w pionie. 
     Umożliwia to zwiększenie lub zmniejszenie wartości zdarzeń na krzywej w procentach.
4   Move Vertically (Przesuń w pionie)
     Klikając górną granicę edytora, możesz przesunąć całą krzywą w pionie. Umożliwia to 
     zwiększenie lub zmniejszenie wartości zdarzeń na krzywej.
5   Compress Right (Kompresuj w prawo)
     Jeśli klikniesz Alt/Opt w prawym górnym rogu edytora, możesz skompresować lub rozszerzyć  
     prawą część krzywej. Umożliwia to kompresję lub rozszerzenie wartości zdarzeń na końcu 
     krzywej.
6   Tilt Right (Przechyl w prawo)
     Klikając w prawy górny róg edytora, możesz przechylić prawą część krzywej. Umożliwia to 
     przechylenie wartości zdarzeń na końcu krzywej w górę lub w dół.
7   Scale Around Relative Center (Skala wokół względnego środka)
     Kliknięcie klawiszem Alt/Opt w prawym środkowym obramowaniu edytora umożliwia 
     skalowanie krzywej względem jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w 
     poziomie wokół środka edytora.
8   Scale Around Absolute Center (Skala wokół absolutnego środka)
     Jeśli klikniesz w prawym środkowym rogu edytora, możesz przeskalować krzywą bezwzględnie 
     do jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w poziomie wokół środka 
     edytora.
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9   Stretch (Rozciągnij)
     Kliknięcie dolnej krawędzi edytora umożliwia rozciągnięcie krzywej w poziomie. Umożliwia to 
     przesuwanie wartości zdarzeń na krzywej w lewo lub w prawo.

Kontrolery automatycznego wyboru
Auto Select Controllers (Kontrolery automatycznego wyboru) automatycznie wybiera dane 
kontrolera wybranych nut MIDI. Jest to przydatne, ponieważ wybrane kontrolery nut zostaną 
przesunięte, gdy przesuniesz odpowiednie nuty.

● Aby wyświetlić Auto Select Controllers (Kontrolery automatycznego wyboru), kliknij prawym 
   przyciskiem myszy Key Editor (Edytor klawiszowy) lub pasek narzędzi Drum Editor (Edytor 
   bębnów) i wybierz opcję Auto Select Controllers.

            
Jeżeli aktywujesz opcję Auto Select Controllers (Automatyczny wybór kontrolerów), kontrolery 
należące do zdarzenia nutowego zostaną automatycznie wybrane po wybraniu zdarzenia nutowego.

POWIĄZANE LINKI
Pasek narzędzi Key Editor na stronie 839

Przenoszenie zdarzeń na wyświetlaczu kontrolera
Możesz przesuwać zdarzenia krzywej kontrolera na wyświetlaczu kontrolera. Działa to tylko w 
przypadku zdarzeń kontrolera typu krzywej, takich jak kontrolery ciągłe, pitchbend, aftertouch, poli
pressure i program change.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
    ● Za pomocą narzędzia Object Selection (Zaznaczanie obiektów) przeciągnij, aby utworzyć 
       prostokąt zaznaczenia obejmujący zdarzenia, które chcesz przenieść.
    ● Na pasku narzędzi aktywuj Auto Select Controllers. Na ekranie nut wybierz nuty, których   
       kontrolery chcesz przenieść.
    ● Na ekranie notatek wybierz nuty, których kontrolery chcesz przenieść, i wybierz Edit > Select 
       > Select Controllers (Edycja > Wybierz > Wybierz kontrolery) w zakresie nut, aby wybrać 
       kontrolery w zakresie wybranych notatek.
2. Przesuń zdarzenia nutowe/kontrolera.

WYNIK
Zdarzenia kontrolera zostaną przeniesione na nową pozycję. Przyciąganie jest brane pod uwagę.

POWIĄZANE LINKI
Wybierz kontrolery w zakresie nut: Użyj rozszerzonego kontekstu nut na stronie 1164

Key Editor (Edytor klawiszowy)
Key Editor jest domyślnym edytorem MIDI. Wyświetla nuty graficznie w siatce przypominającej 
rolkę fortepianu. Key Editor umożliwia szczegółową edycję nut i zdarzeń niebędących nutami, 
takich jak kontrolery MIDI.

Key Editor możesz otworzyć w osobnym oknie lub w zakładce w dolnej strefie okna Project. 
Otwarcie Key Editor w dolnej strefie okna Project jest przydatne, jeśli chcesz uzyskać dostęp do 
funkcji Key Editor ze stałej strefy okna Project.
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Aby otworzyć partię MIDI w Key Editor (Edytorze klawiszy), wykonaj jedną z następujących 
czynności:

● Kliknij dwukrotnie partię MIDI w oknie Project.
● Wybierz partię MIDI w oknie projektu i naciśnij klawisz Return lub Ctrl/Cmd - E.
● Wybierz partię MIDI w oknie projektu i wybierz MIDI > Open Key Editor (MIDI > Otwórz  
   edytor klawiszy).
● W oknie dialogowym Key Commands (Polecenia klawiszowe) w kategorii Editors (Edytory) 
przypisz polecenie klawiszowe do Open Key Editor. Wybierz partię MIDI w oknie Project i użyj 
polecenia klawiszowego.

UWAGA
Jeśli wybierzesz opcję MIDI > Set up Editor Preferences (MIDI > Ustaw preferencje edytora), na
stronie Editors (Edytory) otworzy się okno dialogowe Preferences (Preferencje). Wprowadź 
zmiany, aby określić, czy chcesz, aby edytory otwierały się w osobnym oknie, czy w dolnej strefie 
okna Project.

Okno Key Editor (Edytora klawiszy):

       

Key Editor widoczny jest w zakładce Editor w dolnej strefie okna Project:
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Edytor kluczy jest podzielony na kilka sekcji:
1   Toolbar (Pasek narzędzi)
      Zawiera narzędzia i ustawienia.
2   Status line (Linia stanu)
      Informuje o pozycji czasu myszy, wartości myszy i bieżącym akordzie.
3   Info line (Linia informacyjna)
      Wyświetla informacje o zdarzeniu nutowym dla wybranej nuty MIDI.
4   Ruler (Linijka)
      Wyświetla oś czasu.
5   Key Editor Inspector (Inspektor edytora klawiszowego)
      Zawiera narzędzia i funkcje do pracy z danymi MIDI.
6   Note display (Wyświetlacz nut)
      Zawiera siatkę, w której nuty MIDI są wyświetlane w postaci ramek.
7   Piano keyboard display (Wyświetlacz klawiatury fortepianu)
      Pomaga znaleźć właściwy numer nuty.
8   Controller display (Wyświetlacz kontrolera, sterownika)
      Obszar pod wyświetlaczem nut składa się z jednego lub wielu pasów kontrolera.

UWAGA
Możesz aktywować/dezaktywować linię stanu, linię informacyjną i pasy kontrolera, klikając Set up
Window Layout (Skonfiguruj układ okna) na pasku narzędzi i aktywując/dezaktywując 
odpowiednie opcje.

POWIĄZANE LINKI
Pasek narzędzi Key Editor na stronie 839
Wiersz stanu na stronie 845
Inspektor edytora klawiszy na stronie 846
Wyświetlacz nut na stronie 850
Wyświetlacz klawiatury fortepianu na stronie 851
Wyświetlacz kontrolera na stronie 812
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Pasek narzędzi Key Editor (Edytora klawiszowego)
Pasek narzędzi zawiera narzędzia i ustawienia Key Editor.
● Aby pokazać lub ukryć elementy paska narzędzi, kliknij pasek narzędzi prawym przyciskiem 
myszy i aktywuj lub dezaktywuj elementy.

Default Items (Domyślne elementy)
Solo Editor (Edytor solowy)

       
      Solo edytora podczas odtwarzania, jeśli edytor ma fokus.
Record in Editor (Nagraj w Edytorze)

       
      Włącza nagrywanie danych MIDI w edytorze, jeśli edytor ma fokus.
UWAGA
Działa to tylko wtedy, gdy MIDI Record Mode (Tryb nagrywania MIDI) jest ustawiony na Merge 
(Scal) lub Replace (Zamień).

Retrospective Record (Zapis retrospektywny)
Insert MIDI Retrospective Recording in Editor (Wstaw retrospektywne nagranie MIDI w 
edytorze)

       
      Umożliwia odzyskanie nut MIDI zagranych w trybie zatrzymania lub podczas odtwarzania.

Left Divider (Lewy rozdzielacz)
Left Divider
      Umożliwia wykorzystanie lewego rozdzielacza. Narzędzia umieszczone po lewej stronie 
      rozdzielacza są zawsze pokazane.

Pitch Visibility (Widoczność poziomu)
Pitch Visibility On/Off (Włączanie/wyłączanie widoczności poziomu)

       
      Dezaktywuj tę opcję, aby wyświetlić wszystkie dźwięki na wyświetlaczu nut. Aktywuj tę opcję, 
      aby zmniejszyć wysokość tonu na wyświetlaczu nut zgodnie z wybraną opcją widoczności tonu.

Select Pitch Visibility Options (Wybierz Opcje widoczności poziomu)

       
      Umożliwia określenie, które wysokości dźwięku będą wyświetlane na wyświetlaczu nut:
        ● Show Pitches with Events (Pokaż tony ze zdarzeniami) pokazuje tylko tony, dla których 
           dostępne są zdarzenia na ekranie nut.
        ● Show Pitches from Scale Assistant (Pokaż tony z Asystenta Skali) pokazuje tylko tony, 
           które odpowiadają skali muzycznej wybranej w sekcji Scale Assistant (Asystenta 
           Skalowania) w Inspektorze.
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Auto Scroll (Automatyczne przewijanie)
Link Project and Lower Zone Editor Cursors (Połącz kursory projektu i edytora dolnej strefy)

        
       Łączy osie czasu, kursory i współczynniki powiększenia karty Editor (Edytor) w dolnej strefie 
       i okna Project.
UWAGA
Nie można aktywować Link Project and Lower Zone Editor Cursors, jeśli aktywna jest 
Independent Track Loop (Niezależna pętla ścieżki).
Auto Scroll

        
       Utrzymuje kursor projektu widoczny podczas odtwarzania.
Select Auto-Scroll Settings (Wybierz Ustawienia automatycznego przewijania)

        
       Umożliwia aktywację Page Scroll (Przewijania strony) lub Stationary Cursor (Nieruchomego
       kursora) oraz aktywację Suspend AutoScroll When Editing (Wstrzymania automatycznego 
       przewijania podczas edycji).

Acoustic Feedback (Sprzężenie akustyczne)
Acoustic Feedback

        
       Automatycznie odtwarza zdarzenia, gdy je przesuwasz, transponujesz lub gdy tworzysz je 
       poprzez rysowanie.

Tool Buttons (Przyciski narzędzi)
Object Selection (Wybór obiektu)

        
       Wybiera zdarzenia i części.
Draw (Rysuj)

        
       Rysuje zdarzenia.
Erase (Usuń)

        
       Usuwa zdarzenia.
Trim (Przytnij)

        
       Przycina zdarzenia.
Split (Podziel)

        
       Dzieli zdarzenia.
Glue (Sklej)

        
       Skleja zdarzenia o tej samej wysokości (pitch).
Mute (Wycisz)

        
       Wycisza zdarzenia.
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Zoom (Powiększenie)

        
       Powiększa. Przytrzymaj Alt/Opt i kliknij, aby pomniejszyć.
Time Warp (Zakrzywienie czasoprzestrzeni)

        
       Dopasowuje pozycje muzyczne wydarzeń do pozycji czasowych.
Line (Linia)

        
       Tworzy serię sąsiadujących ze sobą zdarzeń.

Auto Select Controllers (Automatyczny wybór kontrolerów)
Auto Select Controllers

        
       Automatycznie wybiera dane kontrolera wybranych nut MIDI.

Independent Track Loop (Niezależna pętla ścieżki)
Independent Track Loop

        
       Aktywuje/dezaktywuje niezależną pętlę ścieżek.
UWAGA
Jeżeli aktywujesz Independent Track Loop, funkcja Link Project and Lower Zone Editor 
Cursors (Połącz kursory projektu i edytora dolnej strefy) zostanie automatycznie wyłączona w 
zakładce Editor w dolnej strefie.

Indicate Transpositions (Wskaż transpozycje)
Indicate Transpositions

       
      Umożliwia wyświetlenie transponowanych wysokości nut MIDI.

Insert Velocity (Wstaw prędkość)
Note Insert Velocity (Wstaw prędkość nuty)

       
      Umożliwia określenie wartości dynamiki nowych nut.

Nudge Palette (Paleta Nudge (Szturchać))
Trim Start Left (Początek przycinania w lewo)

       
      Zwiększa długość wybranego zdarzenia przesuwając jego początek w lewo.
Trim Start Right (Przycinanie rozpoczyna się w prawo)

       
      Zmniejsza długość wybranego zdarzenia przesuwając jego początek w prawo.
Move Left (Przesuń w lewo)

       
      Przesuwa wybrane zdarzenie w lewo.
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Move Right (Przesuń w prawo)

       
      Przesuwa wybrane zdarzenie w prawo.
Trim End Left (Przytnij koniec w lewo)

       
      Zmniejsza długość wybranego zdarzenia przesuwając jego koniec w lewo.
Trim End Right (Przytnij koniec w prawo)

       
      Zwiększa długość wybranego zdarzenia przesuwając jego koniec w prawo.

Transpose Palette (Paleta transpozycji)
Move Up (Podnieś)

       
      Transponuje wybrane zdarzenie w górę o półnutę.
Move Down (Opuść)

       
      Transponuje wybrane zdarzenie w dół o półnutę.
Move Up More (Podnieś więcej)

       
      Transponuje wybrane zdarzenie o oktawę w górę.
Move Down More (Opuść więcej)

       
      Transponuje wybrane zdarzenie o oktawę w dół.

Snap (Przyciąganie)
Snap On/Off (Włączanie/wyłączanie przyciągania)

       
      Aktywuje/dezaktywuje funkcję przyciągania.
Snap Type (Typ przyciągania)

      
     Umożliwia wybranie jednego z następujących typów przyciągania:
● Grid (Siatka) przyciąga zdarzenia do siatki wybranej w wyskakującym menu Quantize Presets 
   (Ustawienia wstępne kwantyzacji).
● Grid Relative (Względna siatka) zachowuje względne pozycje podczas przyciągania zdarzeń do 
   siatki.
● Events (Zdarzenia) przyciąga zdarzenia do początku lub końca innych wydarzeń.
● Shuffle (Losowo) zmienia kolejność zdarzeń, jeśli przeciągniesz jedno zdarzenie na lewo lub na 
   prawo od innych zdarzeń.
● Cursor (Kursor) przyciąga zdarzenia do pozycji kursora.
● Grid + Cursor (Siatka + Kursor) przyciąga zdarzenia do siatki kwantyzacji wybranej 
   w wyskakującym menu Quantize Presets lub do pozycji kursora.
● Events + Cursor (Zdarzenia + Kursor) przyciąga zdarzenia do początku lub końca innych 
   zdarzeń lub do pozycji kursora.
● Grid + Events + Cursor (Siatka + Zdarzenia + Kursor) przyciąga zdarzenia do siatki   
   kwantyzacji wybranej w wyskakującym menu Quantize Presets, do początku lub końca innych 
   zdarzeń lub do pozycji kursora.
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Grid Type (Typ siatki)

       
      Umożliwia wybór jednego z następujących typów siatki:
●   Use Quantize (Użyj kwantyzacji) aktywuje siatkę, w której zdarzenia są przyciągane do 
     wartości wybranej w wyskakującym menu Quantize Presets (Ustawienia wstępne kwantyzacji).
●   Adapt to Zoom (Dostosuj do powiększenia) aktywuje siatkę, w której zdarzenia są przyciągane 
     do poziomu powiększenia.

Quantize (Kwantyzacja)
Apply Quantize (Zastosuj kwantyzację)

       
      Stosuje ustawienia kwantyzacji.
Quantize Presets (Ustawienia wstępne kwantyzacji)

       
      Umożliwia wybór ustawienia wstępnego kwantyzacji lub rytmu.
Soft Quantize On/Off (Włączanie/wyłączanie miękkiej kwantyzacji)

       
      Aktywuje/dezaktywuje miękką kwantyzację.
Open Quantize Panel (Otwórz panel kwantyzacji)

       
      Otwiera Quantize Panel (panel Kwantyzacji).

Length Quantize (Kwantyzacja długości)
Length Quantize

       
      Umożliwia ustawienie wartości kwantyzacji długości zdarzeń.

Multiple Part Controls (Sterowanie wieloma częściami)
Show Part Borders (Pokaż granice części)

       
      Pokazuje/ukrywa granice części aktywnej partii MIDI w lewym i prawym lokalizatorze.
Edit Active Part Only (Edytuj tylko część aktywną)

       
      Ogranicza operacje edycyjne do aktywnej części.
Currently Edited Part (Aktualnie edytowana część)

       
      Wyświetla listę wszystkich części wybranych po otwarciu edytora i umożliwia aktywację 
      części.

Step/MIDI Input (Krok/Wejście MIDI)
Step Input (Wejście krokowe)

       
      Aktywuje/dezaktywuje wejście krokowe MIDI.
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MIDI Input/Note Expression MIDI Input (Wejście MIDI/wyrażenie nutowe Wejście MIDI)

       
      Aktywuje/dezaktywuje wejście MIDI i wejście MIDI wyrażające nuty.
Move Insert Mode (Przenieś tryb wstawiania)

       
      Przesuwa wszystkie zdarzenia nutowe na prawo od pozycji wprowadzania kroku w prawo, aby 
      zrobić miejsce na wstawione zdarzenie podczas wstawiania nut.
UWAGA
Działa to tylko wtedy, gdy aktywowane jest Step Input wejście krokowe.

Record Pitch (Nagraj wysokość dźwięku)

       
      Uwzględnia wysokość dźwięku podczas wstawiania nut.
Record NoteOn Velocity (Nagraj NoteOn Velocity)

       
      Uwzględnia dynamikę NoteOn podczas wstawiania nut.
Record NoteOff Velocity (Nagraj NoteOff Velocity)

       
      Uwzględnia dynamikę NoteOff podczas wstawiania nut.

Event Colors (Kolory zdarzeń)
Event Colors

       
      Umożliwia wybór kolorów zdarzeń.

Edit VST Instrument (Edytuj instrument VST)
Edit VST Instrument

       
      Otwiera instrument VST, do którego kierowana jest ścieżka.

Right Divider (Prawy rozdzielacz)
Right Divider
      Umożliwia użycie prawego rozdzielacza. Narzędzia umieszczone po prawej stronie 
      rozdzielacza są zawsze pokazane.

Window Zone Controls (Sterowanie strefą okienną)
Open in Separate Window (Otwórz w osobnym oknie)

       
      Przycisk ten dostępny jest w zakładce Edytor w dolnej strefie. Otwiera edytor w osobnym 
      oknie.
Open in Lower Zone (Otwórz w dolnej strefie)

       
      Przycisk ten dostępny jest w oknie edytora. Otwiera zakładkę Editor (Edytor) znajdującą się w 
      dolnej strefie okna Project.
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Set up Window Layout (Skonfiguruj układ okna)

       
      Umożliwia ustawienie układu okna.
Set up Toolbar (Skonfiguruj pasek narzędzi)

       
      Otwiera wyskakujące menu, w którym możesz ustawić, które elementy paska narzędzi mają być
      widoczne.

POWIĄZANE LINKI
Powiększanie edytorów MIDI na stronie 804

Status Line (linia stanu)
Linia stanu pokazuje informacje o pozycji czasu myszy, wartości myszy i bieżącym akordzie.

● Aby wyświetlić linię stanu, kliknij opcję Set up Window Layout (Ustaw układ okna) na pasku 
   narzędzi i aktywuj Status Line (linię stanu).

            

Stan włączenia/wyłączenia linii stanu w oknie Key Editor (Edytor klawiszowy) oraz w zakładce 
Editor w dolnej strefie okna Project są od siebie niezależne

Mouse Time Position (Pozycja czasu myszy)
   Wyświetla dokładną pozycję czasową wskaźnika myszy, w zależności od wybranego formatu 
   wyświetlania linijki. Umożliwia to edycję lub wstawianie notatek w dokładnych pozycjach.
Mouse Value (Wartość myszy)
   Wyświetla dokładne nachylenie pozycji wskaźnika myszy na ekranie zdarzeń. Ułatwia to   
   znalezienie właściwej wysokości podczas wprowadzania lub transpozycji nut.
   Jeśli poruszysz myszą na wyświetlaczu kontrolera, zostanie wyświetlona wartość zdarzenia 
   kontrolera w pozycji kursora myszy.
Current Chord Display (Wyświetlanie bieżącego akordu)
   Kiedy kursor projektu znajduje się nad nutami tworzącymi akord, akord jest tutaj wyświetlany.

POWIĄZANE LINKI
Zapętlanie partii MIDI na stronie 812

Info Line (Linia informacyjna)
Linia informacyjna pokazuje wartości i właściwości wybranych zdarzeń. Jeśli wybranych zostanie 
kilka nut, wartości pierwszej nuty zostaną wyświetlone w kolorze.

● Aby wyświetlić linię informacyjną, kliknij opcję Set up Window Layout (Ustaw układ okna) na 
pasku narzędzi i aktywuj Info Line (Linię informacyjną) 

Wartości długości i pozycji są wyświetlane w wybranym formacie wyświetlania linijki.
Stan włączenia/wyłączenia linii informacyjnej w oknie Key Editor oraz w zakładce Editor w 
dolnej strefie okna Project jest od siebie niezależny.

POWIĄZANE LINKI
Edytowanie zdarzeń notatek w wierszu informacyjnym na stronie 810
Zmiana formatu wyświetlania linijki na stronie 804
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Key Editor Inspector (Inspektor edytora klawiszowego)
W edytorze MIDI Inspektor znajduje się po lewej stronie ekranu nut. Inspektor Key Editor 
zawiera narzędzia i funkcje do pracy z danymi MIDI.
       

              

Global Tracks (Globalne ścieżki)
   Umożliwia pokazywanie/ukrywanie globalnych ścieżek w Key Editor (Edytorze klawiszy). 
   Pozwala to na lepszy ogląd kontekstu projektu, nad którym pracujesz.
Expression Map (Mapa wyrażeń)
   Umożliwia załadowanie mapy wyrażeń. Mapy wyrażeń są przydatne do pracy z artykulacjami.
Note Expression (Wyrażenie nutowe)
   Zawiera funkcje i ustawienia związane z wyrażeniem nutowym.
Chord Editing (Edycja akordów)
   Umożliwia wprowadzanie akordów zamiast pojedynczych nut.
Quantize (Kwantyzacja)
   Umożliwia dostęp do głównych parametrów kwantyzacji. Są one identyczne z funkcjami panelu 
   Quantize.
Transpose (Transponuj)
   Umożliwia dostęp do głównych parametrów transpozycji zdarzeń MIDI.
Length (Długość)
   Zawiera opcje związane z długością, podobne do podmenu Functions (Funkcje) w menu MIDI.
   ● Aby zmienić długość wybranych zdarzeń MIDI lub wszystkich zdarzeń aktywnej części, jeśli 
      nie są wybrane żadne zdarzenia, użyj suwaka Scale Length/Scale Legato (Skala Długość/Skala
      Legato). Przy maksymalnej wartości nuty dochodzą do początku następnej nuty.
   ● Aby nowe ustawienia długości były trwałe, kliknij opcję Freeze MIDI Lengths (Zablokuj 
      długości MIDI).
● Aby dostosować odległość pomiędzy kolejnymi nutami, użyj suwaka Overlap (Nakładanie się).  
   Przy wartości 0 ticks (0 tyknięć) suwak Scale Length/Scale Legato (Skala Długość/Skala 
   Legato) wydłuża każdą nutę tak, aby dokładnie sięgała do następnej nuty. Wartości dodatnie 
   powodują nakładanie się nut, a wartości ujemne umożliwiają zdefiniowanie małej przerwy 
   pomiędzy nutami.
● Aby użyć funkcji Legato lub suwaka do przedłużenia nuty do następnej wybranej nuty, aktywuj   
   opcję Extend to Next Selected (Przedłuż do następnej zaznaczonej).
   Jest to identyczne z aktywacją opcji Legato Mode: Between Selected Notes Only (Tryb Legato: 
   tylko pomiędzy wybranymi nutami) w oknie dialogowym Preferences (Preferencje).

Scale Assistant (Asystent skali)
   Umożliwia wybranie skali muzycznej, która podświetla wszystkie zdarzenia nutowe, których 
   wysokość należy do tej skali.
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Set up Inspector (Skonfiguruj Inspektora)
   Umożliwia otwarcie okna dialogowego umożliwiającego edycję ustawień Inspektora dla edytora.
   Kliknij opcję Set up Inspector (Skonfiguruj Inspektora) i z wyskakującego menu wybierz opcję 
   Setup (Konfiguracja).

UWAGA
Jeśli otworzysz Key Editor (Edytor klawiszy) w dolnej strefie, te sekcje zostaną pokazane 
w Editor Inspector (Inspektorze edytora) w lewej strefie.

POWIĄZANE LINKI
Mapy wyrażeń na stronie 906
Sekcja Inspektor wyrażeń nut na stronie 924
Panel kwantyzacji na stronie 298
Funkcje transpozycji na stronie 328
Otwieranie Inspektora Edytora na stronie 62
Globalne ścieżki w edytorze klawiszy na stronie 847
Asystent skalowania w edytorze klawiszy na stronie 849

Globalne ścieżki w edytorze klawiszy 
Sekcja Global Tracks (Ścieżki globalne) w Key Editor Inspector (Inspektorze edytora klawiszy) 
umożliwia pokazywanie zdarzeń na ścieżkach globalnych w Key Editor (Edytorze klawiszy), 
dzięki czemu można je zobaczyć razem ze zdarzeniami MIDI.

W Key Editor (Edytorze klawiszy) możesz wyświetlać zdarzenia ze ścieżek globalnych, takie jak 
tempo, sygnatura (signature), akord (chord), linijka (ruler), aranżer (arranger), wideo, znacznik 
(marker) i ścieżka transpozycji (transpose track). W ten sposób możesz edytować zdarzenia MIDI i 
jednocześnie przeglądać kontekst projektu, bez konieczności przełączania się do okna Project.

UWAGA
Sekcja Global Tracks (Ścieżki globalne) w Inspektorze jest dostępna tylko po otwarciu Key 
Editor (Edytora klawiszy) jako osobnego okna. Nie jest dostępna w dolnej strefie edytora.
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1   Global Tracks section (Sekcja Ścieżki globalne)
     Sekcja Global Tracks w Key Editor Inspector (Inspektorze edytora klawiszy) zawiera listę 
     wszystkich ścieżek globalnych dodanych do projektu. Aby wyświetlić ścieżkę globalną w 
     dedykowanej strefie Key Editor, musisz ją aktywować w sekcji Global Tracks (Ścieżki 
     globalne).
2   Show/Hide Global Tracks (Pokaż/Ukryj ścieżki globalne)
     Umożliwia pokazanie/ukrycie listy ścieżek i wyświetlania zdarzeń dla utworów globalnych w   
     Key Editor (Edytorze klawiszowym).
3   Track list for global tracks (Lista ścieżek dla ścieżek globalnych)
     Pokazuje nazwy ścieżek i kolory ścieżek przypisane do ścieżek globalnych. Ścieżki globalne są 
     pokazane w tej samej kolejności, co w oknie Project. Dotyczy to również pracy z podzieloną 
     listą ścieżek.
4   Event display for global tracks (Wyświetlanie zdarzeń dla ścieżek globalnych)
     Górna strefa Key Editora pokazuje wyświetlanie zdarzeń dla ścieżek globalnych.
5   Event display with keyboard focus (Wyświetlanie zdarzeń z fokusem klawiatury)
     Ekran zdarzenia, na którym znajduje się fokus klawiatury, w tym przypadku ekran zdarzenia 
     śledzenia globalnego, jest oznaczony podświetloną i pełną ramką.
6   Non-active event display (Nieaktywne wyświetlanie zdarzeń)
     Nieaktywne wyświetlanie zdarzeń, w tym przypadku wyświetlanie nut Key Editor (Edytora  
     klawiszy), jest wyświetlane w ramce przerywanej.

POWIĄZANE LINKI
Pokazywanie/ukrywanie ścieżek globalnych w Edytorze klawiszy na stronie 854
Dzielenie listy ścieżek na stronie 54
Fokus klawiatury w Edytorze klawiszy na stronie 856
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Scale Assistant in the Key Editor (Asystent skali w edytorze klawiszy)
Sekcja Scale Assistant (Asystenta skali) w Key Editor Inspector (Inspektorze edytora kluczy) 
pomaga dopasować zdarzenia nutowe do skali muzycznej.

            

Scale Assistant Status Indicator (Wskaźnik stanu asystenta skali)
   Pokazuje stan włączenia/wyłączenia Scale Assistant (Asystenta Skali)
Use Editor Scale (Użyj edytora skali)
   Umożliwia wybór skali nut na ekranie nut Key Editor.
     ● Editor Scale (Edytor skali)
         Umożliwia wybór skali.
     ● Scale Suggestions (Sugestie dotyczące skali)
        Pokazuje liczbę sugestii skali. Otwórz menu podręczne, aby wybrać sugestię skali. Aby   
        uzyskać sugestie skali dla konkretnych nut, musisz je wybrać. Jeżeli nie wybrano żadnej nuty, 
        sugestie skali zostaną zastosowane dla wszystkich nut.
Use Chord Track (Użyj ścieżki akordów)
   Umożliwia wybór skali na podstawie ścieżki akordów.
    ● Chord Track Mode (Tryb ścieżki akordów)
       Umożliwia wybranie, czy do znalezienia skali mają być używane zdarzenia skali ścieżki 
       akordów, zdarzenia akordów, czy oba.
Show Scale Note Guides (Pokaż wskazówki dotyczące skali nut)
   Zmienia tło wyświetlania zdarzeń nutowych zgodnie z wybraną skalą. Tony nie należące do 
   wybranej skali są wyświetlane na ciemniejszym tle.
Snap Pitch Editing (Edycja przyciągania wysokości dźwięku)
   Przyciąga tonację lub nuty do wybranej skali podczas ich dodawania, edytowania lub 
   przenoszenia.
UWAGA
Funkcja Snap Pitch Editing nie ma zastosowania, gdy zmieniasz wysokość dźwięku za pomocą 
pola wartość Pitch w wierszu informacyjnym lub gdy nagrywasz nuty poprzez wejście MIDI.

Snap Live Input (Przyciągaj dane wejściowe na żywo)
   Automatycznie koryguje wysokość przychodzących nut zgodnie z wybraną skalą.
UWAGA
Działa to tylko wtedy, gdy włączona jest opcja Record in Editor (Nagraj w edytorze).

Quantize Pitches (Kwantyzacja wysokości)
   Kwantyzuje wysokość wybranych nut do najbliższej wysokości wybranej skali
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POWIĄZANE LINKI
Wyświetlacz nut na stronie 850
Korzystanie z funkcji wprowadzania na żywo na stronie 959
Menu kolorów zdarzeń na stronie 805
Okno dialogowe konfiguracji skali muzycznej na stronie 952
Dopasowywanie zdarzeń nutowych do skali muzycznej na stronie 857
Używanie ścieżki akordów do dopasowywania zdarzeń nutowych do skali muzycznej 
   na stronie 858
Kwantyzacja wysokości nut MIDI do skal muzycznych na stronie 859
Ścieżka akordów na stronie 943
Mapowanie wysokości dźwięków przychodzących nut MIDI na skale muzyczne na stronie 859
Przyciąganie wysokości nut MIDI do skal muzycznych podczas edycji na stronie 860

Note Display (Wyświetlacz nut)
Wyświetlacz nut jest główną strefą w Key Editor (Edytorze klawiszy). Zawiera siatkę, w której 
zdarzenia nut są pokazywane w postaci ramek.

            

Szerokość pudełka odpowiada długości nuty. Pionowe położenie pola odpowiada numerowi nuty 
(wysokości), przy czym wyższe nuty znajdują się wyżej w siatce.

W zależności od współczynnika powiększenia zdarzenia nutowe pokazują nazwy nut.

UWAGA
Możesz zmienić format nazewnictwa i nazwy nut wysokości dźwięków w sekcji Pitch Notation 
(Notacja wysokości dźwięków) w oknie dialogowym Preferences (Preferencje) Event Display 
Chords&Pitches page (strona Wysokość akordów wyświetlania zdarzenia).

Możesz Pitch Visibility On/Off (włączyć/wyłączyć widoczność tonu) na pasku narzędzi Key 
Editor, aby wyświetlić tylko nachylenie ze zdarzeniami lub nachylenie sugerowane przez Scale 
Assistant (Asystenta Skalowania). Spowoduje to ukrycie klawiszy klawiatury, których wysokość 
nie jest używana, i wyświetlenie nazw nut na pozostałych klawiszach
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POWIĄZANE LINKI
Wyświetlacz klawiatury fortepianu na stronie 851
Powiększanie edytorów MIDI na stronie 804
Notacja wysokości tonu na stronie 1167
Opcje widoczności wysokości tonu na stronie 853

Piano Keyboard Display (Wyświetlacz klawiatury fortepianu)
Ekran klawiatury fortepianu jest pokazany po lewej stronie ekranu nut w Key Editor.

            

Klawiatura fortepianu zapewnia wizualną orientację w pozycjach wysokości nut na wyświetlaczu 
nut, pomagając znaleźć określone wysokości nut.

Możesz kliknąć klawisz, aby posłuchać wysokości dźwięku i dźwięku podłączonego instrumentu.

Jeśli przesuniesz mysz maksymalnie na lewo od ekranu klawiatury fortepianu, wskaźnik myszy 
zmieni się, umożliwiając przewijanie w górę i w dół oraz powiększanie i pomniejszanie ekranu 
klawiatury:
● Przeciągnij w górę/w dół, aby przewijać w górę/w dół na wyświetlaczu klawiatury fortepianu.
● Przeciągnij w prawo/w lewo, aby powiększyć/pomniejszyć ekran klawiatury fortepianu.

Klawisze C pokazują nazwy nut odpowiednich wysokości.

Możesz Pitch Visibility On/Off (włączyć/wyłączyć widoczność tonu) na pasku narzędzi Key 
Editor, aby wyświetlić tylko poziom (pitch) ze zdarzeniami lub pitch sugerowany przez Scale 
Assistant (Asystenta Skalowania). Spowoduje to ukrycie klawiszy klawiatury, których wysokość 
nie jest używana, i wyświetlenie nazw nut na pozostałych klawiszach.
UWAGA
Możesz zmienić format nazewnictwa i nazwy nut wysokości dźwięków w sekcji Pitch Notation 
(Notacja wysokości dźwięku) w oknie dialogowym Preferences (Preferencje) (Event Display—
Chords&Pitches page)  ((Wyświetlanie zdarzeń — strona Wysokości akordów)).

Jeśli wybierzesz zdarzenia nutowe na ekranie zdarzeń, odpowiednie klawisze na ekranie klawiatury 
fortepianu zostaną pokazane w tym samym kolorze, co zdarzenie nutowe.

862



Jeśli przesuniesz wskaźnik myszy na ekranie zdarzeń, podświetlona zostanie odpowiednia pozycja 
tonu na ekranie klawiatury fortepianu.

POWIĄZANE LINKI
Wyświetlacz nut na stronie 850
Edytor klawiszowy na stronie 836
Notacja wysokości tonu na stronie 1167
Opcje widoczności wysokości tonu na stronie 853

Wyświetlanie określonych poziomów (pitch) w edytorze klawiszy
Możesz zdefiniować, które tony będą widoczne na ekranie zdarzeń i klawiaturze fortepianu w Key 
Editorze. Ukrywając niepotrzebne poziomy tonów (pitch), możesz zaoszczędzić miejsce na 
ekranie. Jest to przydatne, jeśli dodajesz zdarzenia nutowe obejmujące więcej niż jedną oktawę i 
chcesz na przykład wyświetlić je wszystkie.

PROCEDURA
1. Na pasku narzędzi Key Editor otwórz wyskakujące menu Select Pitch Visibility Options  
    (Wybierz opcje widoczności poziomów).
2. Wykonaj jedną z następujących czynności:
     ● Aby na ekranie nut wyświetlić tylko poziomy, dla których dostępne są zdarzenia, wybierz 
        opcję Show Pitches with Events (Pokaż poziomy ze zdarzeniami).

UWAGA
Jeśli edytujesz wiele partii MIDI, pod uwagę brane są wysokości wszystkich nut w różnych partiach
MIDI. Widoczne poziomy są aktualizowane zgodnie z wyborem partii MIDI w oknie Project.

     ● Aby wyświetlić tylko poziomy pasujące do skali muzycznej wybranej w sekcji Scale 
        Assistant (Asystent skali) w Key Editor Inspector (Inspektorze edytora kluczy), wybierz 
        opcję Show Pitches from Scale Assistant (Pokaż poziomy z Asystenta skali)

WYNIK
Wyświetlanie nut i wyświetlanie klawiatury fortepianu zmienia się zgodnie z ustawieniami.

PRZYKŁAD
Jeśli w wyskakującym menu Select Pitch Visibility Options (Wybierz opcje widoczności 
poziomów) wybrałeś opcję Show Pitches from Scale Assistant (Pokaż poziomy z Asystenta skali),
a Scale Assistant (Asystent skalowania) używa określonej skali, ale niektóre nuty na ekranie nuty 
nie odpowiadają tej skali, jest to sygnalizowane kolorem zdarzenia nut oraz wykrzyknikiem na 
odpowiednich klawiszach na wyświetlaczu klawiatury.
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POWIĄZANE LINKI
Opcje widoczności poziomów (pitch) na stronie 853
Pasek narzędzi Key Editor na stronie 839
Wyświetlacz nut na stronie 850
Wyświetlacz klawiatury fortepianu na stronie 851

Pitch Visibility Options (Opcje widoczności poziomów)
Opcje widoczności wysokości tonu umożliwiają pokazywanie lub ukrywanie określonych tonów na
ekranie zdarzeń Key Editor i na ekranie klawiatury fortepianu. Opcje widoczności poziomów są 
zapisywane w programie. Jeśli ustawienie prowadzi do sytuacji, w której nie będą wyświetlane 
żadne poziomy, zamiast tego pokazane zostaną wszystkie poziomy.

● Aby otworzyć opcje widoczności poziomów, kliknij Select Pitch Visibility Options (Wybierz 
opcje widoczności poziomów) na pasku narzędzi Key Editor (Edytora kluczy).

             
Dostępne są następujące opcje:
Show Pitches with Events (Pokaż poziomy ze zdarzeniami)
   Umożliwia pokazanie na ekranie nut tylko tych dźwięków, dla których dostępne są zdarzenia

UWAGA
Jeśli edytujesz wiele partii MIDI, pod uwagę brane są wysokości wszystkich nut w różnych partiach
MIDI. Widoczne tony są aktualizowane zgodnie z wyborem partii MIDI w oknie Project.

Show Pitches from Scale Assistant (Pokaż poziomy z Asystenta Skali)
   Umożliwia pokazanie tylko poziomów odpowiadających skali muzycznej wybranej w sekcji 
   Scale Assistant (Asystent skali) w Key Editor Inspector (Inspektorze edytora klawiszy).
      ● Use Editor Scale (Użyj skali edytora)
         Pokazuje tylko nuty pasujące do skali edytora.
UWAGA
Jeśli wyświetlacz nut zawiera zdarzenia nutowe o wysokościach, które nie odpowiadają wybranej 
skali, odpowiednie klawisze na wyświetlaczu klawiatury zostaną pokazane z wykrzyknikiem. Jeśli 
włączysz opcję Scale/Chords (Skala/Akordy) w wyskakującym menu Event Colors (Kolory 
zdarzeń) na pasku narzędzi Key Editor, niepasujące zdarzenia nutowe zostaną pokazane w innym 
kolorze.
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     ● Use Chord Track (Użyj ścieżki akordów)
        Pokazuje tylko nuty pasujące do ścieżki akordów. Chord Track Mode (Tryb ścieżki 
        akordów) wybrany dla Scale Assistant (Asystenta skali) określa, czy widoczne są wysokości 
        tonów skali, akordu, czy obu.

POWIĄZANE LINKI
Menu kolorów zdarzeń na stronie 805
Wyświetlacz klawiatury fortepianu na stronie 851
Wyświetlacz nut na stronie 850
Pokazywanie określonych poziomów w edytorze klawiszy na stronie 852

Edycja wysokości tonu ze zmniejszoną widocznością wysokości tonu
Jeśli edytujesz wysokość tonu i zmniejszysz jej widoczność za pomocą jednej z opcji Select Pitch 
Visibility Options (Wybierz opcje widoczność wysokości tonu), musisz wziąć pod uwagę pewne 
ogólne zachowanie programu.

Ogólną zasadą jest to, że zdarzenia nutowe można przenosić tylko do widocznych pozycji. Dotyczy 
to przesuwania zdarzeń nutowych w górę/w dół za pomocą myszki, za pomocą odpowiedniego 
polecenia klawiszowego lub za pomocą klawiszy kursora.

Wyjątki
Jeśli chcesz uzyskać dostęp do określonych pozycji wysokości tonu, które nie są wyświetlane, masz
następujące możliwości:
   ● Aby przenieść zdarzenia nutowe do pozycji, które nie są widoczne, użyj pola Pitch (Wartość 
      wysokości dźwięku) w wierszu informacyjnym.
   ● Aby przesuwać zdarzenia nutowe o oktawy, wybierz zdarzenie nutowe i naciśnij Shift –   
      Strzałka w górę, aby przesunąć je o oktawę w górę lub Shift – Strzałka w dół, aby przesunąć 
      je o oktawę w dół.
   ● Aby przenieść nuty akordów, otwórz sekcję Chord Editing (Edycja akordów) i aktywuj opcję 
      w sekcji Inversions (Inwersje) lub Drop Notes (Upuść nuty).

We wszystkich tych przypadkach wyświetlacz nut i ekran klawiatury fortepianu rozszerzają się, aby
pokazać nowe wysokości (pitches).

POWIĄZANE LINKI
Opcje widoczności wysokości tonu na stronie 853
Wyświetlacz nut na stronie 850
Wyświetlacz klawiatury fortepianu na stronie 851

Operacje edytora klawiszy (Key Editor)
W tej sekcji opisano główne operacje edycyjne w Key Editor (Edytorze klawiszy).

Wyświetlanie/ukrywanie ścieżek globalnych w edytorze klawiszy

W Key Editor (Edytorze klawiszowym) możesz wyświetlać globalne ścieżki i związane z nimi 
zdarzenia.

WARUNEK WSTĘPNY
● W oknie projektu dodałeś co najmniej jedną ścieżkę globalną, taką jak tempo, klucz (signature), 
akord (chord), linijka (ruler), aranżer (arranger), wideo, znacznik (marker) lub ścieżka transpozycji.
● Na liście ścieżek ustawiłeś kolejność ścieżek, jaką chcesz, aby były wyświetlane w Key Editor.
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● Opcjonalnie: W oknie Project aktywowałeś opcję Show Scales (Pokaż skale) ścieżki akordów.
● Opcjonalnie: W oknie Project zdefiniowałeś Visible Tempo Upper Limit (widoczny górny limit
   tempa) i Visible Tempo Lower Limit (widoczny dolny limit tempa) dla ścieżki tempa.

PROCEDURA
1. Wybierz partię MIDI w oknie Project.
2. Wybierz opcję MIDI > Open Key Editor (MIDI > Otwórz edytor klawiszy), aby otworzyć Key 
   Editor (Edytor klawiszy) w oddzielnym oknie.
   Sekcja Global Tracks (Globalne ścieżki) jest wyświetlana w Inspektorze. Lista ścieżek zawiera 
   listę dostępnych globalnych ścieżek Twojego projektu.
UWAGA
Sekcja Global Tracks w Inspektorze nie jest dostępna w dolnej strefie edytora.

3. Na liście ścieżek w sekcji Global Tracks (Ścieżki globalne) aktywuj ścieżki, które chcesz 
    wyświetlić w Key Editor.

WYNIK
Aktywowane ścieżki globalne zostaną pokazane nad wyświetlaczem nut.
Globalna konfiguracja ścieżki w Key Editor jest zapisywana wraz z projektem.

UWAGA
Jeśli Twój projekt zawiera ścieżki globalne, możesz je także aktywować i wyświetlić wraz ze 
zdarzeniami w Key Editor, klikając opcję Set up Window Layout (Ustaw układ okna) na pasku 
narzędzi i aktywując Global Tracks.

POWIĄZANE LINKI
Inspektor edytora klawiszy na stronie 846
Globalne ścieżki w edytorze klawiszy na stronie 847
Sterowanie ścieżką akordów na stronie 155
Sterowanie ścieżką tempa na stronie 158
Edytowanie zdarzeń na ścieżkach globalnych na stronie 855

Edytowanie zdarzeń na ścieżkach globalnych
Możesz wybierać, dodawać i edytować zdarzenia na globalnym ekranie zdarzeń ścieżek w Key 
Editor (Edytorze klawiszy). Wszystkie wprowadzone zmiany są synchronizowane z wyświetlaniem
zdarzeń w oknie Project.

PROCEDURA
1. Opcjonalnie: Upewnij się, że wyświetlanie zdarzeń globalnych ścieżek jest skupione na 
    klawiaturze i Zoom in/out (przybliżaj/oddalaj) globalne ścieżki za pomocą Shift - H lub 
    Shift - G .
2. Opcjonalnie: Zmień wysokość ścieżki globalnej, klikając jej dolną granicę na liście ścieżek i 
    przeciągając w górę lub w dół.

UWAGA
Ścieżki wyświetlane na globalnym ekranie zdarzeń ścieżek mają domyślną wysokość ścieżki 
wynoszącą 1 wiersz, z wyjątkiem ścieżki tempa i ścieżki akordów, które mają wysokość 2 rzędów 
oraz ścieżki wideo, która ma wysokość 3 rzędów. Możesz dostosować te wysokości do swoich 
potrzeb. Nie można zmienić wysokości linijki ścieżki.

3. Wykonaj jedną z następujących czynności:
     ● Zastosuj zwykłe metody edycji dla jednego lub kilku zdarzeń na globalnym ekranie ścieżek 
        zdarzeń 
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     ● Użyj przycisków narzędzi na pasku narzędzi Key Editor (Edytor klawiszy).
     ● Wybierz wydarzenie na globalnym ekranie zdarzeń śledzenia i użyj linii informacyjnej, aby 
        edytować określone parametry zdarzenia.

WYNIK
Wszystkie dokonane zmiany, w tym wybór ścieżki, są synchronizowane z wyświetlaniem zdarzeń 
w oknie Project.

POWIĄZANE LINKI
Fokus klawiatury w Edytorze klawiszy na stronie 856
Przyciski narzędzi na stronie 840
Ustawianie wysokości ścieżki na stronie 176
Obsługa ścieżek na stronie 161

Fokus klawiatury w Key Editor (edytorze klawiszy)
Różne strefy w oknie Key Editor można kontrolować za pomocą poleceń klawiszowych. Aby mieć
pewność, że polecenie klawisza będzie miało wpływ na określoną strefę, należy upewnić się, że ta 
strefa ma fokus klawiatury.

Następujące strefy Key Editor mogą mieć fokus klawiatury:
● Wyświetlacz zdarzeń globalnych ścieżek
● Wyświetlacz nut Key Editor

Globalny ekran zdarzeń ścieżek ma fokus klawiatury.

Jeśli strefa ma fokus klawiatury, jest to oznaczone podświetloną i ciągłą ramką fokusu. Strefa 
nieaktywna jest oznaczona przerywaną ramką

UWAGA
Kolor fokusu można zmienić w oknie dialogowym Preferences (Preferencje) (User Interface—
Color Schemes page) ((Interfejs użytkownika — strona Schematy kolorów)).
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POWIĄZANE LINKI
Edytowanie zdarzeń na ścieżkach globalnych na stronie 855
Pokazywanie/ukrywanie ścieżek globalnych w edytorze klawiszy na stronie 854
Globalne ścieżki w edytorze klawiszy na stronie 847
Fokus klawiatury w oknie projektu na stronie 80
Aktywowanie fokusu klawiatury dla strefy na stronie 81

Dopasowywanie zdarzeń nutowych do skali muzycznej
Możesz wybrać skalę muzyczną opartą na wszystkich lub wybranych zdarzeniach nutowych 
w Key Editor (Edytorze klawiszy) i dopasować do niej zdarzenia nutowe.

PROCEDURA
1. Otwórz partię MIDI w Key Editor.
2. Otwórz sekcję Scale Assistant (Asystent skalowania) w Inspektorze i aktywuj opcję Use Editor
    Scale (Użyj skali edytora).
3. Wykonaj jedną z następujących czynności:
     ● Wybierz zdarzenia nutowe na ekranie nut, jeśli chcesz otrzymać sugestie dotyczące skal 
        muzycznych pasujących do tych nut.
     ● Usuń zaznaczenie wszystkich zdarzeń nutowych na ekranie nut, jeśli chcesz otrzymać sugestie
        dotyczące skal muzycznych pasujących do wszystkich nut partii MIDI.
4. Aktywuj opcję Activate Show Scale Note Guides (Pokaż wskazówki dotyczące nut w skali).
    Spowoduje to zmianę tła wyświetlania zdarzeń zgodnie z wybraną skalą, tak że tony nie należące
    do skali będą wyświetlane z ciemniejszym tłem.
5. Na pasku narzędzi Key Editor ustaw Event Colors (Kolory zdarzeń) na Scale/Chords 
    (Skala/Akordy).
    Zmienia to kolory zdarzeń nutowych na ekranie zdarzeń w zależności od tego, czy wysokość 
    dźwięku odpowiada wybranej skali muzycznej.

UWAGA
Aby wyświetlić schemat kolorów wybranego trybu kolorów, otwórz menu podręczne Event Colors
(Kolory zdarzeń) i wybierz Setup (Ustawienia).

6. Otwórz wyskakujące menu Scale Suggestions (Sugestie skali) i wybierz jedną z opcji.
7. Opcjonalnie: Na pasku narzędzi Key Editor otwórz wyskakujące menu Select Pitch Visibility 
Options (Wybierz opcje widoczności wysokości tonu) i wybierz opcję Show Pitches from Scale 
Assistant (Pokaż wysokości tonów z Asystenta skalowania).
Filtruje to wyświetlanie nut i klawiaturę fortepianu, tak aby pokazywały tylko tony (pitches) 
pasujące do wybranej skali muzycznej.

WYNIK
Kolorystyka tła wyświetlania zdarzeń i zdarzeń nutowych stanowi wizualny przewodnik po edycji 
wysokości nut.

PO ZAKOŃCZENIU TEGO ZADANIA
Jeśli potrzebujesz dodatkowej pomocy w dopasowaniu zdarzeń nutowych do najbliższych 
wysokości wybranej skali muzycznej, możesz kliknąć opcję Quantize Pitches (Kwantyzacja 
wysokości), aby skwantyzować wysokość już istniejących nut MIDI, aktywować opcję Snap Pitch 
Editing (Edycja skoku przyciągania), aby podczas edycji przyciągać wysokości nut MIDI, lub 
opcję Snap Live Input (Przyciąganie Wejście na żywo) do mapowania wysokości nut 
przychodzących MIDI.

868



POWIĄZANE LINKI
Używanie ścieżki akordów do dopasowywania zdarzeń nutowych do skali muzycznej na stronie 
858
Asystent skalowania w Edytorze klawiszy na stronie 849
Pokazywanie określonych tonów w Edytorze klawiszy na stronie 852
Przyciąganie wysokości nut MIDI do skal muzycznych podczas edycji na stronie 860
Mapowanie wysokości dźwięków przychodzących nut MIDI na skale muzyczne na stronie 859
Kwantyzacja wysokości nut MIDI do skal muzycznych na stronie 859

Korzystanie ze ścieżki akordów w celu dopasowania zdarzeń 
nutowych do skali muzycznej
Możesz wybrać skalę muzyczną zdefiniowaną przez akordy lub skale na ścieżce akordów i 
dopasować do niej zdarzenia nutowe.

WARUNEK WSTĘPNY
Dodałeś do swojego projektu ścieżkę akordową ze zdarzeniami akordowymi.

PROCEDURA
1. Otwórz partię MIDI w Key Editor (Edytorze klawiszy).
2. Opcjonalnie: Otwórz sekcję Global Tracks (Globalne ścieżki) i aktywuj ścieżkę akordów jako 
    ścieżkę globalną. Dzięki temu możesz zobaczyć zdarzenia akordów i skali w Key Editor 
    (Edytorze klawiszy).
3. Otwórz sekcję Scale Assistant (Asystenta Skali) w Inspektorze i aktywuj opcję Use Chord 
    Track (Użyj ścieżki akordów).
4. Otwórz wyskakujące menu Chord Track Mode (Tryb ścieżki akordów) i wykonaj jedną z 
    następujących czynności:
     ● Wybierz opcję Scales (Skale), jeśli chcesz dopasować zdarzenia nutowe do zdarzeń skali na 
        ścieżce akordów.
     ● Wybierz opcję Chords (Akordy), jeśli chcesz dopasować zdarzenia nutowe do zdarzeń 
        akordowych na ścieżce akordów.
     ● Wybierz opcję Chords & Scales (Akordy i skale), jeśli chcesz dopasować zdarzenia nutowe   
        zarówno do zdarzeń skali, jak i akordów na ścieżce akordów.
5. Aktywuj opcję Show Scale Note Guides (Pokaż wskazówki dotyczące nut w skali).
    Spowoduje to zmianę tła wyświetlania zdarzeń zgodnie z wybraną skalą, tak że wysokości tonów
    (pitches) nie należące do skali będą wyświetlane z ciemniejszym tłem.
6. Na pasku narzędzi Key Editor ustaw Event Colors (Kolory zdarzeń) na Scale/Chords 
    (Skala/Akordy).
    Zmienia to kolory zdarzeń nutowych na ekranie zdarzeń w zależności od tego, czy wysokość 
    dźwięku odpowiada wybranej skali muzycznej.
UWAGA
Aby wyświetlić schemat kolorów wybranego trybu kolorów, otwórz menu podręczne Event Colors
(Kolory zdarzeń) i wybierz Setup (Ustawienia).
7. Opcjonalnie: Na pasku narzędzi Key Editor otwórz wyskakujące menu. Wybierz Pitch   
    Visibility Options (Opcje widoczności wysokości tonu) i wybierz opcję Show Pitches from 
    Scale Assistant (Pokaż wysokości tonów z Asystenta skalowania).
    Filtruje to wyświetlanie nut i klawiaturę fortepianu, tak aby pokazywały tylko wysokości tonów 
    pasujących do wybranej skali muzycznej.
WYNIK
Kolorystyka tła wyświetlania zdarzeń i zdarzeń nutowych stanowi wizualny przewodnik po edycji 
wysokości nut.
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UWAGA
Ponieważ mogłeś dodać różne zdarzenia skali/akordu w określonych pozycjach czasowych, 
wskazania skali w tle wyświetlania zdarzeń i na zdarzeniach nutowych zmieniają się wzdłuż osi 
czasu.

PO ZAKOŃCZENIU TEGO ZADANIA
Jeśli potrzebujesz dodatkowej pomocy w dopasowaniu zdarzeń nutowych do najbliższych 
wysokości wybranej skali muzycznej, możesz kliknąć opcję Quantize Pitches (Kwantyzacja 
wysokości), aby skwantyzować wysokości już istniejących nut MIDI, aktywować opcję Snap Pitch
Editing, aby podczas edycji przyciągać wysokości nut MIDI, lub aktywować Snap Live Input 
(Przyciągaj dane wejściowe na żywo), aby mapować wysokość nut przychodzących MIDI.

POWIĄZANE LINKI
Menu kolorów zdarzeń na stronie 805
Dopasowywanie zdarzeń nutowych do skali muzycznej na stronie 857
Asystent skalowania w Edytorze klawiszy na stronie 849
Pokazywanie określonych tonów w edytorze klawiszy na stronie 852
Ścieżka akordów na stronie 943
Pokazywanie/ukrywanie ścieżek globalnych w edytorze klawiszy na stronie 854

Kwantyzacja wysokości nut MIDI do skal muzycznych
Możesz kwantyzować wysokość nut MIDI do najbliższej wysokości wybranej skali.

WARUNEK WSTĘPNY
W Key Editor (Edytorze klawiszy) wybrałeś skalę dla nut MIDI lub wybrałeś Chord Track Mode
(Tryb ścieżki akordów)

PROCEDURA
1. Otwórz sekcję Scale Assistant (Asystent Skalowania) w Inspektorze.
2. Opcjonalnie: Aktywuj opcję Show Scale Note Guides (Pokaż wskazówki dotyczące nut w skali).
3. Wykonaj jedną z następujących czynności:
     ● Wybierz nuty na ekranie zdarzeń nutowych, których wysokość chcesz skwantyzować.
     ● Usuń zaznaczenie wszystkich nut na ekranie zdarzeń nutowych, aby kwantyzować wszystkie 
        wysokości nut partii MIDI.
4. Kliknij opcję Quantize Pitches (Kwantyzacja wysokości tonów).

WYNIK
Wszystkie wysokości nut, które nie pasują do wybranej skali, są kwantowane do najbliższych 
wysokości w skali.

POWIĄZANE LINKI
Dopasowywanie zdarzeń nutowych do skali muzycznej na stronie 857
Używanie ścieżki akordów do dopasowywania zdarzeń nutowych do skali muzycznej na stronie 
858
Asystent skalowania w Edytorze klawiszy na stronie 849
Przyciąganie wysokości nut MIDI do skal muzycznych podczas edycji na stronie 860
Mapowanie wysokości dźwięków przychodzących nut MIDI na skale muzyczne na stronie 859
Kwantyzacja wysokości nut MIDI do skal muzycznych na stronie 859

Mapowanie wysokości przychodzących nut MIDI na skale muzyczne
Podczas monitorowania lub nagrywania w Key Editor możesz mapować wysokość nut 
przychodzącego sygnału MIDI na najbliższe wysokości wybranej skali.

WARUNEK WSTĘPNY
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W Key Editor (Edytorze klawiszy) wybrałeś skalę nut MIDI lub wybrałeś Chord Track Mode 
(Tryb ścieżki akordów)

PROCEDURA
1. Otwórz sekcję Scale Assistant (Asystent Skalowania) w Inspektorze.
2. Aktywuj opcję Show Scale Note Guides (Pokaż wskazówki dotyczące nut w skali).
3. Na pasku narzędzi Key Editor aktywuj opcję Record in Editor (Nagraj w edytorze).
4. Kliknij przycisk Start na panelu Transport lub na pasku Transport Bar, aby rozpocząć 
    odtwarzanie.
5. Aktywuj Snap Live Input (Przyciąganie wejścia na żywo).
6. Zagraj lub nagraj nuty na klawiaturze MIDI.

WYNIK
Wysokość odtwarzanych lub nagranych nut jest automatycznie odwzorowywana na wybraną skalę.

POWIĄZANE LINKI
Dopasowywanie zdarzeń nutowych do skali muzycznej na stronie 857
Używanie ścieżki akordów do dopasowywania zdarzeń nutowych do skali muzycznej na stronie 
858
Asystent skalowania w Edytorze klawiszy na stronie 849
Korzystanie z funkcji wprowadzania na żywo na stronie 959

Przyciąganie wysokości nut MIDI do skal muzycznych podczas edycji
Podczas edycji w Key Editor możesz przyciągać wysokości nut MIDI do najbliższych wysokości 
wybranej skali
WARUNEK WSTĘPNY
W Key Editor wybrałeś skalę dla nut MIDI lub wybrałeś Chord Track Mode (Tryb ścieżki 
akordów).

PROCEDURA
1. Otwórz sekcję Scale Assistant (Asystent Skalowania) w Inspektorze.
2. Aktywuj opcję Show Scale Note Guides (Pokaż wskazówki dotyczące nut w skali).
3. Aktywuj Snap Pitch Editing (Edycję skoku przyciągania).
4. Wykonaj jedną z następujących czynności:
     ● Wstaw zdarzenie nuty za pomocą narzędzia Draw (Rysuj), narzędzia Object Selection 
        (Zaznaczanie obiektów) lub narzędzia Line (Linia).
     ● Przeciągnij myszką zdarzenie nuty w górę lub w dół.
     ● Wybierz zdarzenie nuty i użyj klawiszy Strzałka w górę / Strzałka w dół.

WYNIK
Nuty są przyciągane do wysokości wybranej skali. Nie można umieszczać nut na wysokościach 
poza skalą. Jeśli wybierzesz wiele nut i przeniesiesz je do różnych wysokości, wszystkie wybrane 
nuty zostaną przyciągnięte do wysokości wybranej skali.
UWAGA
Funkcja Snap Pitch Editing nie ma zastosowania, gdy zmieniasz wysokość dźwięku za pomocą 
pola Wartość Pitch w wierszu informacyjnym lub gdy nagrywasz nuty poprzez wejście MIDI.

POWIĄZANE LINKI
Dopasowywanie zdarzeń nutowych do skali muzycznej na stronie 857
Używanie ścieżki akordów do dopasowywania zdarzeń nutowych do skali muzycznej na stronie 
858
Asystent skalowania w Edytorze klawiszy na stronie 849
Rysowanie zdarzeń nut za pomocą narzędzia Draw (Rysuj) na stronie 861
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Wstawianie zdarzeń nutowych za pomocą narzędzia Object Selection (Zaznaczanie obiektów) na 
stronie 861
Rysowanie zdarzeń nutowych za pomocą narzędzia Line (Linia) na stronie 862
Przenoszenie i transpozycja zdarzeń nutowych na stronie 863
Modyfikowanie wartości nut podczas wstawiania nut na stronie 862

Wstawianie nut za pomocą narzędzia Object Selection (Zaznaczanie 
obiektów)
Możesz wstawić notatki za pomocą narzędzia Object Selection (Zaznaczanie obiektów).

WARUNEK WSTĘPNY
Ustawiłeś długość wartości kwantyzacji zdarzeń nutowych w wyskakującym menu Length 
Quantize (Długość kwantyzacji) na pasku narzędzi.

PROCEDURA
● W wyświetlaczu nut kliknij dwukrotnie narzędziem Object Selection (Zaznaczanie obiektów) w 
miejscu, w którym chcesz wstawić nutę.

WYNIK
Nuta zostanie wstawiona w miejscu, w którym dwukrotnie kliknąłeś, z długością ustawioną w 
wyskakującym menu Length Quantize.

Usuwanie zdarzeń nutowych

PROCEDURA
● Wykonaj jedną z następujących czynności:
      ● Wybierz narzędzie Erase (Usuń) i kliknij zdarzenie.
      ● Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i kliknij dwukrotnie zdarzenie.

UWAGA
Jeżeli na pasku narzędzi Key Editor (Edytor klawiszy) aktywowano opcję Double-click Opens 
Note Expression Editor (Dwukrotne kliknięcie otwiera edytor wyrażeń nutowych), dwukrotne 
kliknięcie zdarzenia nutowego powoduje otwarcie edytora wyrażeń nutowych.

WYNIK
Zdarzenie notowe zostało usunięte.

POWIĄZANE LINKI
Pasek narzędzi Key Editor na stronie 839
Edytor zdarzeń nutowych wyrażeń na stronie 933

Rysowanie zdarzeń nutowych za pomocą narzędzia Draw (Rysuj)
Narzędzie Draw (Rysuj) umożliwia wstawianie pojedynczych zdarzeń nutowych na wyświetlaczu 
nut.

Kiedy przesuwasz kursor wewnątrz wyświetlacza nut, jego pozycja jest wskazywana w linii stanu. 
Jego wysokość jest wskazywana zarówno na pasku stanu, jak i na klawiaturze fortepianu po lewej 
stronie.
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● Aby narysować nutę, kliknij wyświetlacz nutowy.
   Zdarzenie nutowe ma długość ustawioną w wyskakującym menu Length Quantize (Długość 
   kwantyzacji).
● Aby narysować dłuższe nuty, kliknij i przeciągnij na ekranie nut.
   Długość zdarzenia nutowego jest wielokrotnością wartości długości kwantyzacji. Jeśli Length 
   Quantize jest ustawione na Quantize Link (Kwantyzacja łącza), wartość nuty jest określana 
   przez siatkę kwantyzacji. Uwzględniana jest funkcja Snap (Przyciąganie).

UWAGA
Aby tymczasowo przełączyć się z narzędzia Object Selection (Zaznaczanie obiektów) na narzędzie
Draw (Rysuj), przytrzymaj klawisz Alt/Opt .

Modyfikowanie wartości nut podczas wstawiania nut
Podczas wstawiania zdarzeń nutowych możesz na bieżąco modyfikować określone wartości nut.

● Aby edytować dynamikę nuty, przeciągnij w górę lub w dół.
● Aby edytować wysokość nuty, przytrzymaj klawisz Alt/Opt i przeciągnij w górę lub w dół.
● Aby edytować długość nuty, przeciągnij w lewo lub w prawo.
● Aby edytować pozycję czasu, przytrzymaj klawisz Shift i przeciągnij w lewo lub w prawo.

UWAGA
Możesz tymczasowo włączyć/wyłączyć Snap (przyciąganie), przytrzymując klawisz Ctrl/Cmd.

Rysowanie zdarzeń nutowych za pomocą narzędzia Line (Linia)
Na wyświetlaczu nut narzędzie Line umożliwia narysowanie serii sąsiadujących zdarzeń nutowych 
wzdłuż różnych kształtów linii.

● Aby utworzyć ciągłe nuty, kliknij i przeciągnij na wyświetlaczu nut.
● Aby ograniczyć ruch do poziomu, naciśnij klawisz Ctrl/Cmd i przeciągnij. Nuty mają tę samą 
   wysokość tonu (pitch).

Jeśli funkcja Snap (Przyciąganie) jest aktywna, zdarzenia nutowe i zdarzenia kontrolera są 
rozmieszczane i sortowane zgodnie z wartościami Quantize (Kwantyzacja) i Length Quantize 
(Długość Kwantyzacji).

POWIĄZANE LINKI
Tryby narzędzia Line (Linia) na stronie 863
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Tryby narzędzia Line (Linia)
Narzędzie Line umożliwia utworzenie serii sąsiadujących zdarzeń nutowych wzdłuż różnych 
kształtów linii. Można także edytować wiele zdarzeń kontrolera jednocześnie.
● Aby otworzyć tryby narzędzia Line, kliknij Line.

           
Dostępne są następujące tryby linii:
Line (Linia)
   Jeśli ta opcja jest aktywna, możesz kliknąć i przeciągnąć, aby wstawić zdarzenia nutowe do    
   wyświetlacza nut po linii prostej pod dowolnym kątem. Użyj tej opcji, aby edytować dane 
   sterownika wzdłuż linii prostej na wyświetlaczu sterownika.
Parabola, Sine, Triangle, Square (Parabola, sinus, trójkąt, kwadrat)
   Te tryby wstawiają zdarzenia nutowe wzdłuż różnych kształtów krzywych.
Paint (Farba)
   Ten tryb umożliwia wstawianie zdarzeń nutowych poprzez malowanie na ekranie nut.

Przenoszenie i transpozycja zdarzeń nutowych
Istnieje kilka opcji przenoszenia i transpozycji zdarzeń nutowych.
● Aby przenieść zdarzenia nut w edytorze, wybierz narzędzie Object Selection (Zaznaczanie    
   obiektów) i przeciągnij je w nowe miejsce.
   Wszystkie wybrane zdarzenia nutowe zostaną przesunięte, zachowując swoje względne 
   położenie. Snap (Przyciąganie) jest brane pod uwagę.
● Aby umożliwić ruch tylko w poziomie lub tylko w pionie, podczas przeciągania przytrzymaj 
   klawisz Ctrl/Cmd.
● Aby przenosić zdarzenia nutowe za pomocą przycisków Nudge Palette (Palety przesuwania) na 
   pasku narzędzi, wybierz zdarzenia nut i kliknij przycisk Nudge Palette.
   Spowoduje to przeniesienie wybranych zdarzeń nutowych o wartość Snap na liście dźwięków 
   perkusyjnych.
● Aby przenieść zdarzenia nutowe do pozycji kursora projektu, zaznacz zdarzenia nutowe i wybierz
   Edit > Move to > Cursor (Edycja > Przenieś do > Kursor).
● Aby przenieść zdarzenie nutowe za pomocą linii informacyjnej, wybierz zdarzenie nutowe i  
   edytuj Position (Pozycję) lub Pitch (Wysokość tonu) w linii informacyjnej.
● Aby transponować zdarzenia nutowe, wybierz zdarzenia nutowe i użyj przycisków Transpose 
   Palette (Palety transpozycji) na pasku narzędzi lub klawiszy Strzałka w górę / Strzałka w dół.
   Na transpozycję wpływa także globalne ustawienie transpozycji.
● Aby transponować zdarzenia nutowe w oknie dialogowym Transpose Setup (Ustawienia 
   transpozycji), wybierz zdarzenia nutowe i wybierz MIDI > Transpose Setup (MIDI > 
   Konfiguracja transpozycji).
● Aby transponować zdarzenia nutowe w krokach co jedną oktawę, naciśnij Shift i użyj klawiszy 
   Strzałka w górę / Strzałka w dół.

UWAGA
● Gdy przeniesiesz wybrane zdarzenia nutowe w inne miejsce, wszystkie wybrane kontrolery tych 
zdarzeń nutowych zostaną odpowiednio przesunięte.
● Możesz także dostosować pozycję zdarzeń nutowych poprzez kwantyzację.
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POWIĄZANE LINKI
Okno dialogowe ustawień transpozycji na stronie 792

Zmiana rozmiaru zdarzeń nutowych

Wykonaj jedną z następujących czynności:
● Aby zmienić rozmiar nuty, umieść narzędzie Object Selection (Zaznaczanie obiektów) na 
   początku lub na końcu nuty i przeciągnij kursor myszy w lewo lub w prawo.
● Aby zastosować rozciąganie w czasie i dane wyrażeń nutowych do kontrolera powiązanego ze   
   zdarzeniem nutowym, którego rozmiar zmieniasz, przed zmianą rozmiaru nuty aktywuj opcję 
   Sizing Applies Time Stretch (Rozmiar stosuje rozciągnięcie czasu) dla narzędzia Object 
   Selection.
● Aby przesuwać pozycje początkową lub końcową wybranych nut w krokach zgodnie z wartością 
   Length Quqntize (Długość Kwantyzacji) na pasku narzędzi, użyj przycisków Trim Start/End 
   (Przytnij początek/koniec) na Nudge Palette (Palecie przesuwania).
● Wybierz nutę i dostosuj jej długość w linii informacyjnej.
● Wybierz opcję Draw (Rysuj) i przeciągnij w lewo lub w prawo na ekranie notatki, aby narysować
   nutę.
   Wynikowa długość zdarzenia nutowego jest wielokrotnością wartości Length Quqntize na pasku
   narzędzi.
● Wybierz opcję Trim (Przytnij) i odetnij koniec lub początek zdarzeń nutowych.

POWIĄZANE LINKI
Setup Options (Opcje konfiguracji) na stronie 1145
Zasady edycji wartości w wierszu informacyjnym na stronie 59
Korzystanie z narzędzia Trim (Przycinanie) na stronie 864
Zmiana rozmiaru wydarzeń za pomocą narzędzia Object Selection (Zaznaczanie obiektów) — 
Zmiana rozmiaru dotyczy rozciągnięcia czasu na stronie 214

Korzystanie z narzędzia Trim (Przycinanie)
Narzędzie Trim umożliwia zmianę długości zdarzeń nutowych poprzez obcięcie końca lub 
początku nut. Użycie narzędzia Trim oznacza przesunięcie zdarzenia włączenia lub wyłączenia 
nuty dla jednej lub kilku nut do pozycji określonej za pomocą myszki.

PROCEDURA
1. Wybierz Trim na pasku narzędzi.
    Wskaźnik myszy zmieni się w symbol noża.
2. Aby edytować pojedynczą nutę, kliknij ją.
    Zakres pomiędzy wskaźnikiem myszy a końcem nuty zostanie usunięty. Użyj informacji o 
    wskazówce myszy na linii stanu, aby znaleźć dokładną pozycję operacji przycinania.
3. Aby edytować kilka nut, kliknij i przeciągnij myszą po nutach.

             
Domyślnie narzędzie Trim odcina koniec nut. Aby przyciąć początek nut, podczas przeciągania 
naciśnij klawisz Alt. Po przeciągnięciu przez kilka nut zostanie wyświetlona linia. Nuty są 
przycinane wzdłuż tej linii. Jeśli podczas przeciągania naciśniesz klawisz Ctrl/Cmd, pojawi się 
pionowa linia przycięcia, umożliwiająca ustawienie tego samego czasu rozpoczęcia i zakończenia 
dla wszystkich edytowanych nut. Polecenia klawiszowe narzędzia Trim można zmienić w oknie 
dialogowym Preferences (Preferencje) (Editing (Edycja) — strona Tool Modifiers (Modyfikatory 
narzędzi)).
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Rozdzielanie zdarzeń nutowych

● Aby podzielić nutę we wskazanym miejscu, wybierz opcję Split (Podziel) i kliknij nutę.
   Jeśli zaznaczonych zostanie kilka nut, wszystkie zostaną podzielone w tym samym miejscu. 
   Uwzględniane jest ustawienie przyciągania.
● Aby podzielić wszystkie nuty przecinane przez położenie kursora projektu, wybierz Edit >    
   Functions > Split at Cursor (Edycja > Funkcje > Podziel przy kursorze).
● Aby podzielić wszystkie nuty przecinane przez lewy lub prawy lokalizator w pozycjach  
   lokalizatora, wybierz Edit > Functions > Split Loop (Edycja > Funkcje > Podziel pętlę).

Klejenie zdarzeń nutowych
Możesz sklejać ze sobą zdarzenia nutowe o tej samej wysokości (pitch).

● Aby skleić zdarzenia z nutami, wybierz opcję Glue (Przyklej) i kliknij zdarzenie z nutą.
   Zdarzenie nutowe jest sklejane z kolejnym zdarzeniem nutowym o tej samej wysokości. 
   Rezultatem jest zdarzenie o długiej nucie, które rozciąga się od początku pierwszej nuty do końca 
   drugiej nuty. Obowiązują właściwości (velocity (prędkość), pitch (wysokość) itp.) zdarzenia 
   pierwszej nuty.

Zmiana wysokości akordów
Do zmiany wysokości akordów można używać przycisków typu akordów

PROCEDURA
1. W Key Editor Inspector (Inspektor Edytora klawiszy) otwórz sekcję Chord Editing (Edycja 
    akordów).
2. Na ekranie nut wybierz nuty, które chcesz edytować.
    Jeśli akord zostanie rozpoznany, w polu Chord Type (Typ akordu) zostaną wskazane nuta 
    prymy, typ akordu i napięcie (tensions). Działa to również z nutami arpeggiowymi.
3. W sekcji Chord Editing aktywuj jeden z przycisków 3-Note Chords/Triads (3-nutowe 
    akordy/triady) lub 4-Note Chords (4-nutowe akordy).
    Wybrane nuty zostaną transponowane tak, aby pasowały do wybranego typu akordu.
4. Użyj klawiszy Strzałka w górę / Strzałka w dół, aby zmienić wysokość akordu.

Zmiana brzmienia akordów

PROCEDURA
1. W Key Editor Inspector (Inspektorze edytora klawiszy) otwórz sekcję Chord Editing (Edycja  
    akordów).
2. Na ekranie notatek wybierz notatki, które chcesz edytować.
3. W sekcji Chord Editing użyj przycisków Inversions (Inwersje) i Drop Notes (Upuść nuty), aby
    zmienić brzmienie.

WYNIK
Wybrane nuty zostaną transponowane tak, aby pasowały do wybranego typu akordu
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Sekcja Chord Editing (Edycji akordów)
Sekcja Chord Editing w Key Editor Inspector (Inspektorze edytora klawiszy) umożliwia 
wstawianie i edycję akordów oraz zmianę brzmień.

               

Chord type of selected notes (Typ akordu wybranych nut)
   Pokazuje typ wybranych akordów.
Add to Chord Track (Dodaj do ścieżki akordów)
   Dodaje akord wskazany w polu Chord type of selected notes do ścieżki akordów. Zdarzenie 
   akordowe jest wstawiane w miejscu na ścieżce akordów, które odpowiada położeniu nut MIDI. 
   Wszelkie istniejące zdarzenia akordów w tej pozycji zostaną nadpisane.
Match with Chord Track (Dopasuj do ścieżki akordów)
   Stosuje zdarzenia akordów ze ścieżki akordów do wybranych nut w edytorze MIDI. Zdarzenie 
   akordowe obowiązujące w pozycji pierwszej wybranej nuty jest stosowane do wybranych nut, 
   które następnie podlegają transpozycji. Stosowany jest tylko podstawowy typ akordu. Napięcia 
   (tensions) nie są brane pod uwagę.
   Stosowane jest tylko pierwsze efektywne zdarzenie akordowe.
3-Note Chords/Triads (3-nutowe akordy/triady)
   Umożliwia wstawianie triad do wyświetlania nut. Możesz także kliknąć jeden z przycisków 3-
   Note Chords/Triads, aby transponować wybrane nuty tak, aby pasowały do wybranego typu 
   akordu.

877



4-Note Chords (Akordy 4-nutowe)
   Umożliwia wstawianie 4-dźwiękowych akordów do wyświetlacza nut. Możesz także kliknąć 
   jeden z przycisków 4-Note Chords, aby transponować wybrane nuty tak, aby pasowały do 
   wybranego typu akordu.

Inversions - Move Up    (Inwersje – ruch w górę)
   Odwraca najniższą nutę akordu. Odpowiednie nuty są transponowane o tyle oktaw, ile potrzeba.

Inversions - Move Down    (Inwersje – ruch w dół)
   Odwraca najwyższą nutę akordu. Odpowiednie nuty są transponowane o tyle oktaw, ile potrzeba.

Drop Notes - Drop 2    (Upuść nuty - Upuść 2)
   Przesuwa drugą najwyższą nutę akordu w dół o jedną oktawę.

Drop Notes - Drop 3    (Upuść nuty - Upuść 3)
Przesuwa trzecią najwyższą nutę akordu w dół o jedną oktawę.

Drop Notes - Drop 2 + 4    (Upuść nuty - Upuść 2 + 4)
   Przesuwa drugą i czwartą najwyższą nutę akordu w dół o jedną oktawę.
Create Chord Symbols (Utwórz symbole akordów)
   Wykonuje analizę akordów wybranych nut. Jeżeli nic nie jest zaznaczone, analizowana jest cała 
   partia MIDI.

Wstawianie akordów
Do wstawiania i edytowania akordów możesz używać narzędzi w sekcji Chord Editing (Edycja 
akordów) w Key Editor Inspector (Inspektorze edytora klawiszy).

PROCEDURA
1. W Inspektorze Key Editor otwórz sekcję Chord Editing.

2. Wybierz narzędzie Insert    (Wstaw) po prawej stronie rodzaju akordu, który chcesz 
wstawić.
3. Kliknij wyświetlacz nut i przeciągnij w lewo lub w prawo, aby określić długość akordu. 
    Przeciągnij w górę lub w dół, aby określić jego wysokość.
    Aby zmienić typ akordu podczas wstawiania akordów, przytrzymaj klawisz Alt i przeciągnij w 
    górę lub w dół.
    Jeśli włączone jest Acoustic Feedback (Sprzężenie akustyczne), podczas przeciągania słychać 
    akord. Etykietka wskazuje prymę i typ wstawionego akordu. Uwzględniane jest Snap 
    (Przyciąganie) i Length Quantize (Kwantyzacja długości).

Stosowanie zdarzeń akordów do zdarzeń nutowych
Możesz zastosować zdarzenia akordów ze ścieżki akordów do nut w edytorze MIDI.

WARUNEK WSTĘPNY
Utwórz ścieżkę akordów i dodaj zdarzenia akordów.

PROCEDURA
1. Otwórz edytor MIDI.
2. W Key Editor Inspector (inspektorze edytora klawiszy) otwórz sekcję Chord Editing (Edycja 
    akordów).
3. Wybierz opcję Match with Chord Track (Dopasuj do ścieżki akordów).
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WYNIK
Do wybranych nut zostanie zastosowane pierwsze zdarzenie akordu ścieżki akordów. Stosowany 
jest tylko podstawowy typ akordu. Napięcia (tensions) nie są brane pod uwagę.

Obsługa mapy perkusji
Kiedy mapa perkusyjna jest przypisana do ścieżki MIDI lub instrumentu, Key Editor (Edytor 
klawiszy) wyświetla nazwy brzmień perkusyjnych zdefiniowane w mapie perkusyjnej. Umożliwia 
to użycie Key Editora do edycji perkusji, na przykład podczas edycji długości nut perkusyjnych 
lub podczas edycji kilku partii w celu identyfikacji zdarzeń perkusyjnych.

Nazwa brzmienia perkusyjnego jest wyświetlana w następujących lokalizacjach:
      ● W wierszu informacyjnym w polu Pitch.
      ● Na linii stanu w polu Mouse Value (Wartość myszy).
      ● W przypadku nuty, jeśli współczynnik powiększenia jest wystarczająco wysoki.
      ● Podczas przeciągania nuty.

Obsługa mapy wyrażeń
Kiedy mapa ekspresji jest przypisana do ścieżki MIDI, artykulacje muzyczne zdefiniowane dla tej 
mapy są wyświetlane w następujących lokalizacjach Key Editora:

      ● W wierszu informacyjnym w polu Articulations (Artykulacje).
      ● Na linii kontrolera.
      ● W przypadku nuty, jeśli współczynnik powiększenia w pionie jest wystarczająco wysoki.

Dane ekspresji nut
Key Editor to główny edytor do pracy z Note Expression (Ekspresją nut).

POWIĄZANE LINKI
Mapy wyrażeń (ekspresji) na stronie 906

Edycja zdarzeń nutowych poprzez wejście MIDI
Możesz bezpośrednio usłyszeć wyniki edycji. Edycja właściwości zdarzeń nutowych za pomocą 
interfejsu MIDI może być szybkim sposobem na na przykład ustawienie wartości dynamiki 
(velocity) zdarzenia nutowego.

PROCEDURA
1. W Key Editor wybierz zdarzenie notatki, które chcesz edytować.
2. Kliknij opcję MIDI Input (Wejście MIDI) na pasku narzędzi.
    Edycja poprzez MIDI jest włączona.
3. Użyj przycisków nut na pasku narzędzi, aby zdecydować, które właściwości mają być zmieniane 
    przez wejście MIDI.
    Można włączyć edycję wysokości dźwięku, szybkości włączania i/lub wyłączania nuty. Na  
    przykład, możesz uzyskać wartości wysokości tonu (pitch) i dynamiki (velocity) nut 
    wejściowych poprzez MIDI, ale dynamika nut pozostaje niezmieniona.
4. Zagraj nutę na instrumencie MIDI.

WYNIK
Wybrana nuta otrzymuje wysokość tonu, prędkość nuty i/lub prędkość nuty granej nuty. Kolejna 
nuta w edytowanej części jest wybierana automatycznie, co pozwala na szybką edycję serii nut.

PO ZAKOŃCZENIU TEGO ZADANIA
Aby wypróbować inne ustawienie, wybierz ponownie nutę i zagraj ją na instrumencie MIDI.

879



Step Input (Wejście krokowe)
Wejście krokowe lub nagrywanie krokowe umożliwia wprowadzanie zdarzeń nutowych lub 
akordów pojedynczo, bez martwienia się o dokładny czas. Jest to przydatne, gdy na przykład znasz 
partię, którą chcesz nagrać, ale nie możesz jej odtworzyć dokładnie tak, jak chcesz.

PROCEDURA
1. Na pasku narzędzi aktywuj Step Input (Wejście krokowe).
2. Użyj przycisków nut po prawej stronie, aby określić, które właściwości zostaną uwzględnione  
    podczas wstawiania zdarzeń nutowych.
    Na przykład możesz uwzględnić dynamikę (note-on velocity) i/lub prędkość (note-off velocity)  
    nuty granych nut. Możesz także dezaktywować właściwość wysokości tonu (pitch), w takim 
    przypadku wszystkie nuty otrzymają wysokość C3, niezależnie od tego, co zagrasz.
3. Kliknij w dowolnym miejscu okna nutowego, aby ustawić pozycję początkową pierwszego    
    zdarzenia nutowego lub akordu.
    Pozycja wejściowa kroku jest pokazana jako pionowa linia na wyświetlaczu nut.

              
 
4. Określ odstępy i długość zdarzeń nutowych za pomocą wyskakujących menu Quantize  
    (Kwantyzacja) i Length Quantize (Kwantyzacja długości).
    Wstawiane zdarzenia nutowe są umieszczane zgodnie z wartością Quantize i mają długość 
    odpowiadającą wartości Length Quantize.

UWAGA
Jeśli Length Quantize jest ustawione na Quantize Link (Kwantyzacja łącza), długość nuty jest 
również określana na podstawie wartości Quantize.

5. Zagraj pierwszą nutę lub akord na swoim instrumencie MIDI.
    Zdarzenie nutowe lub akord pojawi się w edytorze, a pozycja wejściowa kroku zostanie 
    przesunięta o jeden krok wartości kwantyzacji.

UWAGA
Jeśli aktywny jest Move Insert Mode (Tryb Przenieś wstawkę), wszystkie zdarzenia nutowe na 
prawo od pozycji wprowadzania kroku zostaną przesunięte, aby zrobić miejsce na wstawione 
zdarzenie nutowe lub akord.

6. Kontynuuj w ten sam sposób z pozostałymi zdarzeniami nutowymi lub akordami.
    Możesz dostosować wartości Quantize (Kwantyzacji) lub Length Quantize (Kwantyzacji 
    długości), aby zmienić długość zdarzeń lub taktowania. Możesz także ręcznie przesunąć pozycję 
    wprowadzania kroku, klikając w dowolnym miejscu na ekranie nut.
    Aby wstawić pauzę, naciśnij klawisz Strzałka w prawo. Spowoduje to przesunięcie pozycji 
    wejściowej kroku o jeden krok.
7. Po zakończeniu kliknij ponownie opcję Step Input (Wprowadzanie krokowe), aby 
    dezaktywować wprowadzanie krokowe.
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Drum Editor (Edytor perkusji)
Drum Editor (Edytor bębnów) to edytor, którego można używać podczas edycji partii perkusji lub 
bębnów.

Możesz otworzyć Drum Editor w oddzielnym oknie lub w dolnej strefie okna Project. Otwarcie 
edytora Drum Editor w dolnej strefie okna Project jest przydatne, jeśli chcesz uzyskać dostęp do 
funkcji Edytora Drum Editor ze stałej strefy okna Project.

Aby otworzyć partię MIDI w Drum Editor, wykonaj jedną z następujących czynności:
● Wybierz partię MIDI w oknie Project i wybierz MIDI > Open Drum Editor.

Jeśli do ścieżki MIDI przypisano mapę perkusji, a w oknie dialogowym Preferences (Preferencje) 
(strona Editors (Edytory)) aktywowano opcję Editor Content Follows Event Selection 
(Zawartość edytora podąża za wyborem zdarzenia) i Use Drum Editor (Użyj edytora perkusji), gdy
mapa perkusji jest przypisana, możesz wykonać następujące czynności, aby otworzyć partię MIDI 
w Drum Editor:
● Kliknij dwukrotnie partię MIDI w oknie Project.
● Wybierz partię MIDI w oknie Project i naciśnij klawisz Return lub Ctrl/Cmd - E .
● Wybierz partię MIDI w oknie Project i wybierz MIDI > Open Drum Editor (MIDI > Otwórz 
   edytor perkusji)
● W oknie dialogowym Key Commands (Polecenia klawiszowe) w kategorii Editors (Edytory)   
   przypisz polecenie klawiszowe do Open Drum Editor. Wybierz partię MIDI w oknie Project 
   i użyj polecenia klawiszowego.

UWAGA
Jeśli wybierzesz opcję MIDI > Set up Editor Preferences (MIDI > Ustaw preferencje edytora), na
stronie Editors (Edytory) otworzy się okno dialogowe Preferences (Preferencje). Wprowadź 
zmiany, aby określić, czy chcesz, aby Drum Editor (Edytor perkusji) otwierał się w oddzielnym 
oknie, czy w dolnej strefie okna Project.

 Drum Editor widoczny jest w zakładce Editor (Edytor) w dolnej strefie okna Project:
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Drum Editor (Edytor perkusji) jest podzielony na kilka sekcji:
1   Toolbar (Pasek narzędzi)
     Zawiera narzędzia i ustawienia.
2   Status line (Linia stanu)
     Informuje o położeniu czasu myszy i wartości myszy.
3   Info line (Linia informacyjna)
     Wyświetla informacje o wybranym zdarzeniu.
4   Drum Editor Inspector (Inspektor edytora bębnów)
     Zawiera narzędzia i funkcje do pracy z danymi MIDI.
5   Drum sound list (Lista dźwięków perkusyjnych)
     Wyświetla listę wszystkich dźwięków perkusyjnych.
6   Drum map (Mapa perkusji)
     Umożliwia wybranie mapy perkusyjnej dla edytowanej ścieżki lub listy nazw dźwięków 
     perkusyjnych.
7   Ruler (Linijka)
     Wyświetla oś czasu.
8   Note display (Wyświetlacz nut)
     Zawiera siatkę, w której wyświetlane są nuty.
9   Controller display (Wyświetlacz sterownika)
     Obszar pod wyświetlaczem nut składa się z jednego lub wielu pasów kontrolera.

UWAGA
Możesz aktywować/dezaktywować linię stanu, linię informacyjną i paski kontrolera, klikając opcję 
Set up Window Layout (Skonfiguruj układ okna) na pasku narzędzi i aktywując/dezaktywując 
odpowiednie opcje.
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Pasek narzędzi Drum Editor (Edytora bębnów)
Pasek narzędzi zawiera narzędzia i różne ustawienia edytora bębnów.
● Aby pokazać lub ukryć elementy paska narzędzi, kliknij pasek narzędzi prawym przyciskiem 
myszy i aktywuj lub dezaktywuj elementy.

Retrospective Record (Zapis retrospektywny)
Insert MIDI Retrospective Recording in Editor (Wstaw retrospektywne nagranie MIDI w 
edytorze)

       
      Umożliwia odzyskanie nut MIDI zagranych w trybie zatrzymania lub podczas odtwarzania.

Left Divider (Lewy rozdzielacz)
Left Divider
      Umożliwia wykorzystanie lewej przegrody. Narzędzia umieszczone po lewej stronie 
      rozdzielacza są zawsze pokazywane.

Pitch Visibility (Widoczność poziomów tonu)
Pitch Visibility On/Off (Włączanie/wyłączanie widoczności poziomów)

       
      Aktywuje wybraną opcję widoczności poziomów.
Select Pitch Visibility Options (Wybierz Opcje widoczności poziomów)

       
      Dezaktywuj tę opcję, aby wyświetlić wszystkie dźwięki perkusyjne na wyświetlaczu nut. 
      Aktywuj tę opcję, aby zredukować dźwięki perkusji na wyświetlaczu nut, zgodnie z wybraną 
      opcją widoczności wysokości tonu (pitch).
      ● Show Drum Sounds with Events (Pokaż dźwięki perkusji ze zdarzeniami) pokazuje tylko 
         dźwięki perkusji, dla których zdarzenia są dostępne na ekranie nut.
      ● Show Drum Sounds in Use by Instruments (Pokaż brzmienia perkusji w użyciu przez 
         instrumenty) pokazuje dźwięki perkusji, w przypadku których używany jest pad itp. w 
         instrumencie. Ta opcja jest dostępna tylko wtedy, gdy przyrząd może dostarczyć tę 
         informację.
      ● Reverse Drum Sound List (Odwróć listę dźwięków perkusyjnych) odwraca kolejność 
         dźwięków wyświetlanych na liście dźwięków perkusyjnych.

Auto Scroll (Automatyczne przewijanie)
Link Project and Lower Zone Editor Cursors (Połącz kursory projektu i dolnej strefy edytora)

       
      Łączy osie czasu, kursory i współczynniki powiększenia karty Editor w dolnej strefie i okna 
      Project.
UWAGA
Nie można aktywować kursorów Link Project and Lower Zone Editor, jeśli aktywna jest 
Independent Track Loop (Niezależna pętla ścieżki).
Auto Scroll

       
      Utrzymuje kursor projektu widoczny podczas odtwarzania.
Select Auto-Scroll Settings (Wybierz Ustawienia automatycznego przewijania)

        
Umożliwia aktywację Page Scroll (Przewijania strony) lub Stationary Cursor (Nieruchomego 
kursora) oraz aktywację Suspend AutoScroll When Editing.(Wstrzymania automatycznego 
przewijania podczas edycji).
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Acoustic Feedback (Sprzężenie akustyczne)
Acoustic Feedback

       
      Automatycznie odtwarza zdarzenia, gdy je przesuwasz, transponujesz lub gdy tworzysz je 
      poprzez rysowanie.

Tool Buttons (Przyciski narzędzi)
Object Selection (Wybór obiektu)

       
      Wybiera zdarzenia i części.
Drumstick (Pałeczka do gry na bębnie)

       
      Rysuje zdarzenia perkusyjne.
Erase (Usuń)

       
      Usuwa zdarzenia.
Mute (Wycisz)

       
      Wycisza zdarzenia
Zoom (Powiększenie)

       
      Powiększa. Przytrzymaj Alt/Opt i kliknij, aby pomniejszyć.
Time Warp (Zniekształcenie czasoprzestrzeni)

       
      Dopasowuje pozycje muzycznych zdarzeń do pozycji czasowych.
Line (Linia)

       
      Tworzy serię sąsiadujących ze sobą zdarzeń.

Auto Select Controllers (Automatyczny wybór kontrolerów)
Auto Select Controllers

       
      Automatycznie wybiera dane kontrolera wybranych nut MIDI.

Independent Track Loop (Niezależna pętla ścieżki)
Independent Track Loop

       
      Aktywuje/dezaktywuje niezależną pętlę ścieżek.

UWAGA
Jeżeli aktywujesz Independent Track Loop, funkcja Link Project and Lower Zone Editor 
Cursors zostanie automatycznie wyłączona w zakładce Editor w dolnej strefie.
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Nudge Palette (Paleta Szturchanie)
Trim Start Left (Początek przycinania w lewo)

       
      Zwiększa długość wybranego zdarzenia przesuwając jego początek w lewo.
Trim Start Right (Przycinanie rozpoczyna się w prawo)

       
      Zmniejsza długość wybranego zdarzenia przesuwając jego początek w prawo.
Move Left (Przesuń w lewo)

       
      Przesuwa wybrane zdarzenie w lewo.
Move Right (Ruch w prawo)

       
      Przesuwa wybrane zdarzenie w prawo.
Trim End Left (Przytnij koniec w lewo)

       
      Zmniejsza długość wybranego zdarzenia przesuwając jego koniec w lewo.
Trim End Right (Przytnij koniec w prawo)

       
      Zwiększa długość wybranego zdarzenia przesuwając jego koniec w prawo.

Transpose Palette (Paleta Transpozycja)
Move Up (Podnieś)

       
      Transponuje wybrane zdarzenie w górę o pół nuty.
Move Down (Obniż)

       
      Transponuje wybrane zdarzenie w dół o pół nuty.
Move Up More (Podnieś więcej)

       
      Transponuje wybrane zdarzenie o oktawę w górę.
Move Down More (Obniż więcej)

       
      Transponuje wybrane zdarzenie o oktawę w dół.

Insert Velocity (Wstaw prędkość uderzenia w klawisz)
Note Insert Velocity (Wstaw prędkość nuty)

       
      Umożliwia określenie wartości dynamiki nowych nut.
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Notes Length (Długość nut)
Insert Length (Długość wkładki)

       
      Umożliwia określenie długości nowo tworzonych nut.
Show Note Length On/Off (Włącz/wyłącz wyświetlanie długości nuty)

       
      Pokazuje nuty perkusyjne w postaci pól wyświetlających długość nuty.

Snap (Przyciąganie)
Snap On/Off (Włączanie/wyłączanie przyciągania)

       
      Aktywuje/dezaktywuje funkcję przyciągania.
Snap Type (Typ przyciągania)

       
      Umożliwia wybranie jednego z następujących typów przyciągania:
● Grid (Siatka) przyciąga zdarzenia do siatki wybranej w wyskakującym menu Quantize Presets 
   (Ustawienia wstępne kwantyzacji)
● Grid Relative (Względna siatka) zachowuje względne pozycje podczas przyciągania zdarzeń do 
   siatki.
● Events (Zdarzenia) przyciąga zdarzenia do początku lub końca innych zdarzeń.
● Shuffle (Losowo) zmienia kolejność zdarzeń, jeśli przeciągniesz jedno zdarzenie na lewo lub na 
   prawo od innych zdarzeń.
● Cursor (Kursor) przyciąga zdarzenia do pozycji kursora.
● Grid + Cursor (Siatka + Kursor) przyciąga zdarzenia do siatki kwantyzacji wybranej w  
   wyskakującym menu Quantize Presets (Ustawienia wstępne kwantyzacji) lub do pozycji kursora.
● Events + Cursor (Zdarzenia + Kursor) przyciąga zdarzenia do początku lub końca innych 
   zdarzeń lub do pozycji kursora.
● Grid + Events + Cursor (Siatka + Zdarzenia + Kursor) przyciąga zdarzenia do siatki  
   kwantyzacji wybranej w wyskakującym menu Quantize Presets, do początku lub końca innych 
   zdarzeń lub do pozycji kursora.
Grid Type (Typ siatki)

       
      Umożliwia wybór jednego z następujących typów siatki:
● Use Quantize (Użyj kwantyzacji) aktywuje siatkę, w której zdarzenia są przyciągane do wartości
wybranej w wyskakującym menu Quantize Presets (Ustawienia wstępne kwantyzacji).
● Adapt to Zoom (Dostosuj do powiększenia) aktywuje siatkę, w której zdarzenia są przyciągane 
   do poziomu powiększenia.
● Use Snap from Drum Map (Użyj przyciągania z mapy perkusji) aktywuje siatkę, w której 
   zdarzenia są przyciągane do wartości przyciągania wybranej na mapie perkusji.

Quantize (Kwantyzacja)
Apply Quantize (Zastosuj kwantyzację)

       
      Stosuje ustawienia kwantyzacji.
Quantize Presets (Ustawienia wstępne kwantyzacji)

       
      Umożliwia wybór ustawienia wstępnego kwantyzacji lub rytmu.
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Soft Quantize On/Off (Włączanie/wyłączanie miękkiej kwantyzacji)

       
      Aktywuje/dezaktywuje miękką kwantyzację.
Open Quantize Panel (Otwórz panel kwantyzacji)

       
      Otwiera Quantize Panel (panel Kwantyzacji).

Multiple Part Controls (Sterowanie wieloma częściami)
Show Part Borders (Pokaż granice części)

       
      Pokazuje/ukrywa granice części aktywnej partii MIDI w lewym i prawym lokalizatorze.
Edit Active Part Only (Edytuj tylko część aktywną)

       
      Ogranicza operacje edycyjne do aktywnej części.
Currently Edited Part (Aktualnie edytowana część)

       
      Wyświetla listę wszystkich części wybranych po otwarciu edytora i umożliwia aktywację 
      części.

Event Colors (Kolory zdarzeń)
Event Colors

       
      Umożliwia wybór kolorów zdarzeń.

Step/MIDI Input (Wejście krokowe/MIDI)
Step Input (Wejście krokowe)

       
      Aktywuje/dezaktywuje wejście krokowe MIDI.
MIDI Input/Note Expression MIDI Input (Wejście MIDI/wyrażenie nutowe Wejście MIDI)

       
      Aktywuje/dezaktywuje wejście MIDI i wejście MIDI wyrażające nuty.
Move Insert Mode (Przenieś tryb wstawiania)

       
      Przesuwa wszystkie zdarzenia nutowe na prawo od pozycji wprowadzania kroku w prawo, aby 
      zrobić miejsce na wstawione zdarzenie podczas wstawiania nut.
UWAGA
Działa to tylko wtedy, gdy aktywowane jest Step Input (wejście krokowe)

Record Pitch (Nagraj wysokość tonu)

       
      Uwzględnia wysokość dźwięku podczas wstawiania nut.
Record NoteOn Velocity (Nagraj prędkość NoteOn)

       
      Uwzględnia dynamikę NoteOn podczas wstawiania nut.
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Record NoteOff Velocity (Nagraj prędkość NoteOff)

      
     Uwzględnia dynamikę NoteOff podczas wstawiania nut.

Edit VST Instrument (Edytuj instrument VST)
Edit VST Instrument

       
      Otwiera instrument VST, do którego kierowana jest ścieżka.

Right Divider (Prawy rozdzielacz)
Right Divider
      Umożliwia użycie odpowiedniego rozdzielacza. Narzędzia umieszczone po prawej stronie 
      rozdzielacza są zawsze pokazane

Window Zone Controls (Sterowanie strefą okienną)
Open in Separate Window (Otwórz w osobnym oknie)

       
      Przycisk ten dostępny jest w zakładce Editor (Edytor) w dolnej strefie. Otwiera edytor w  
      osobnym oknie.
Open in Lower Zone (Otwórz w dolnej strefie)

       
      Przycisk ten dostępny jest w oknie edytora. Otwiera zakładkę Editor znajdującą się w dolnej 
      strefie okna Project.
Show/Hide Left Zone (Pokaż/ukryj lewą strefę)

       
      Pokazuje/ukrywa lewą strefę.
Show/Hide Controller Lanes (Pokaż/ukryj pasy kontrolerów)

       
      Pokazuje/ukrywa pasy kontrolerów.
Set up Window Layout (Skonfiguruj układ okna)

       
      Umożliwia ustawienie układu okna.
Set up Toolbar (Skonfiguruj pasek narzędzi)

       
      Otwiera wyskakujące menu, w którym możesz ustawić, które elementy paska narzędzi mają być
      widoczne.
POWIĄZANE LINKI
Powiększanie edytorów MIDI na stronie 804

Linia stanu
Linia stanu jest wyświetlana poniżej paska narzędzi. Wyświetla ważne informacje o myszy.
● Aby wyświetlić linię stanu, kliknij opcję Set up Window Layout (Ustaw układ okna) na pasku 
narzędzi i aktywuj Status Line (linię stanu).
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Stan włączenia/wyłączenia linii statusu w oknie Drum Editor (Edytora perkusji) oraz w zakładce 
Editor w dolnej strefie okna Project jest od siebie niezależny.

Mouse Time Position (Pozycja czasu myszy)
      Wyświetla dokładną pozycję czasową wskaźnika myszy, w zależności od wybranego formatu 
      wyświetlania linijki. Umożliwia to edycję lub wstawianie nut w dokładnych pozycjach.
Mouse Value (Wartość myszy)
      Wyświetla dokładne nachylenie pozycji (pitch) wskaźnika myszy na ekranie zdarzeń. Ułatwia to
      znalezienie właściwej wysokości podczas wprowadzania lub transpozycji nut. Jeśli poruszysz 
      myszą na wyświetlaczu kontrolera, zostanie wyświetlona wartość zdarzenia kontrolera 
      w pozycji kursora myszy.
Track Loop Start/Track Loop End (Początek pętli ścieżki/koniec pętli ścieżki)
      Jeśli na pasku narzędzi jest włączona opcja Independent Track Loop (Niezalezna pętla  
      ścieżki) i skonfigurujesz pętlę, wyświetlona zostanie pozycja początkowa/końcowa.

POWIĄZANE LINKI
Pasek narzędzi edytora bębnów (perkusyjnego) na stronie 872

Linia informacyjna
Linia informacyjna pokazuje wartości i właściwości wybranych zdarzeń. Jeśli wybranych zostanie 
kilka nut, wartości pierwszej nuty zostaną wyświetlone w kolorze.
● Aby wyświetlić linię informacyjną, kliknij opcję Set up Window Layout (Ustaw układ okna) na 
   pasku narzędzi i aktywuj Info Line (linię informacyjną).

        
Wartości długości i pozycji są wyświetlane w wybranym formacie wyświetlania linijki.

Stan włączenia/wyłączenia linii informacyjnej w oknie Drum Editor (Edytor bębnów, perkusyjny) 
oraz w zakładce Editor w dolnej strefie okna Project jest od siebie niezależny.

POWIĄZANE LINKI
Edytowanie zdarzeń nutowych w linii informacyjnej na stronie 810

Drum Editor Inspector (Inspektor edytora perkusyjnego)
Drum Editor Inspector znajduje się po lewej stronie wyświetlacza nut. Zawiera narzędzia i 
funkcje do pracy z danymi MIDI.

            

Expression Map (Mapa wyrażeń)
      Umożliwia załadowanie mapy wyrażeń. Mapy wyrażeń są przydatne do pracy z artykulacjami.
Quantize (Kwantyzacja)
Umożliwia dostęp do głównych parametrów kwantyzacji. Są one identyczne z funkcjami panelu 
Quantize (Quantize Panel)
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Length (Długość)
Zawiera opcje związane z długością, podobne do podmenu Functions (Funkcje) w menu MIDI.
● Aby zmienić długość wybranych zdarzeń MIDI lub wszystkich zdarzeń aktywnej części, jeśli nie 
   są wybrane żadne zdarzenia, użyj suwaka Scale Length/Scale Legato (Skala Długość/Skala 
   Legato). Przy maksymalnej wartości nuty dochodzą do początku następnej nuty.
● Aby nowe ustawienia długości były trwałe, kliknij opcję Freeze MIDI Lengths (Zablokuj 
   długości MIDI).
● Aby dostosować odległość pomiędzy kolejnymi nutami, użyj suwaka Overlap (Nakładanie się).
   Przy wartości 0 Ticks (podziałek) suwak Scale Length/Scale Legato wydłuża każdą nutę tak, 
   aby dokładnie sięgała do następnej nuty. Wartości dodatnie powodują nakładanie się nut, a 
   wartości ujemne umożliwiają zdefiniowanie małej przerwy pomiędzy nutami.
● Aby użyć funkcji Legato lub suwaka do przedłużenia nuty do następnej wybranej nuty, aktywuj 
   opcję Extend to Next Selected (Przedłuż do następnej zaznaczonej).
   Jest to identyczne z aktywacją opcji Legato Mode: Between Selected Notes Only (Tryb Legato: 
   Tylko pomiędzy wybranymi nutami) w oknie dialogowym Preferences (Preferencje).
Setup (Ustawienie)
   Umożliwia otwarcie okna dialogowego umożliwiającego edycję ustawień Drum Editor 
   Inspector (Inspektora edytora bębnów). Kliknij opcję Setup Inspector (Inspektor ustawień) i z 
   wyskakującego menu wybierz opcję Setup (Konfiguracja).

UWAGA
Jeśli otworzysz Drum Editor (Edytor perkusyjny) w dolnej strefie, te sekcje zostaną pokazane 
W Editor Inspector (Inspektorze Edytora) w lewej strefie.

POWIĄZANE LINKI
Expression Maps (Mapy wyrażeń) na stronie 906
Note Expression Inspector Section (Sekcja Inspektor wyrażeń nut) na stronie 924
Panel kwantyzacji na stronie 298
Funkcje transpozycji na stronie 328
Otwieranie Inspektora Edytora na stronie 62

Wyświetlacz nut
Wyświetlacz nut w Drum Editor (edytorze perkusyjnym) zawiera siatkę, w której pokazane są 
zdarzenia nutowe.

                  
Nuty są wyświetlane jako symbole rombu. Jeżeli na pasku narzędzi włączysz/wyłączysz opcję 
Show Note Length On/Off (Pokaż długość nuty), nuty będą wyświetlane w formie ramek i będą 
wyświetlać długość nuty.

                  

Pionowe położenie nut odpowiada liście dźwięków perkusji po lewej stronie, natomiast poziome 
położenie odpowiada położeniu nuty w czasie.
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POWIĄZANE LINKI
Pasek narzędzi edytora bębnów (perkusji) na stronie 872

Lista dźwięków perkusji
Lista dźwięków perkusyjnych zawiera listę wszystkich dźwięków perkusyjnych według nazw i 
umożliwia dostosowywanie ustawień brzmień perkusyjnych oraz manipulowanie nimi na różne 
sposoby.

                 

UWAGA
Liczba kolumn na liście zależy od tego, czy dla ścieżki została wybrana mapa perkusji, czy nie.

Pitch (Poziom)
      Numer nutowy brzmienia bębna.
Instrument
      Nazwa brzmienia bębna.
Snap (Przyciąganie)
      Używa się tego podczas wprowadzania i edytowania nut.
Mute (Wycisz) 
      Umożliwia wyciszenie dźwięków perkusyjnych.
I-Note (I-Nuta)   
      Nuta wejściowa dla dźwięku perkusyjnego. Kiedy zagrasz tę nutę, zostanie ona przypisana do 
      odpowiedniego brzmienia perkusyjnego i automatycznie transponowana zgodnie z Pitch 
      wysokością ustawienia dźwięku.
O-Note (O-Nuta)
      Nuta wyjściowa MIDI wysyłana za każdym razem, gdy odtwarzany jest dźwięk perkusji.
Channel (Kanał)
      Kanał MIDI, na którym odtwarzany jest dźwięk perkusji.
Output (Wyjście)
      Wyjście MIDI, na którym odtwarzany jest dźwięk perkusji.

POWIĄZANE LINKI
Wyciszanie dźwięków i dźwięków perkusyjnych na stronie 884
Mapy bębnów na stronie 884
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Select Pitch Visibility Options Menu (Menu wybierz opcje widoczności
poziomów)
Wyskakujące menu Select Pitch Visibility Options (Wybierz opcje widoczności wysokości tonu) 
na pasku narzędzi edytora perkusyjnego pozwala określić, które dźwięki perkusyjne będą 
wyświetlane na liście dźwięków perkusyjnych.

● Aktywuj opcję Pitch Visibility On/Off (Wł./Wył. widoczności poziomów) i kliknij opcję Select 
Pitch Visibility Options na pasku narzędzi.

UWAGA
Jeśli opcja Pitch Visibility On/Off jest wyłączona, pokazane zostaną wszystkie dźwięki perkusyjne
wybranej mapy perkusyjnej i można ręcznie edytować kolejność na liście dźwięków perkusyjnych.

Show Drum Sounds with Events (Pokaż dźwięki perkusji ze zdarzeniami)
   Pokazuje tylko brzmienia perkusyjne, dla których dostępne są zdarzenia w wybranej partii MIDI.
Show Drum Sounds in use by Instrument (Pokaż dźwięki perkusji używane przez instrument)
   Pokazuje wszystkie brzmienia perkusyjne, dla których w instrumencie używany jest pad itp. Ta 
   opcja jest dostępna tylko wtedy, gdy instrument może dostarczyć tę informację.
Reverse Drum Sound List (Lista dźwięków odwróconej perkusji)
   Odwraca kolejność dźwięków wyświetlanych na liście dźwięków perkusyjnych.

Menu mapy bębnów i nazw
Poniżej listy brzmień perkusyjnych znajdują się wyskakujące menu, które służą do wyboru mapy 
perkusyjnej dla edytowanej ścieżki lub, jeśli nie jest wybrana żadna mapa perkusyjna, listy nazw 
brzmień perkusyjnych.

                   

POWIĄZANE LINKI
Mapy bębnów na stronie 884

Operacje Drum Editor (edytora bębnów)
W tej sekcji opisano ogólne operacje edycyjne w edytorze Drum Editor.

Wstawianie zdarzeń nut perkusyjnych
Możesz wstawiać zdarzenia nutowe za pomocą narzędzia Object Selection (Zaznaczanie obiektów)
lub narzędzia Drumstick (pałeczka do gry na bębnie).

WARUNEK WSTĘPNY
Ustawiłeś Insert Length (Długość wstawienia) na pasku narzędzi, aby określić długość wstawionej
notatki. Jeśli Insert Length jest ustawiona na opcję Drum-Map Link, nuta otrzyma długość 
wartości Snap (Przyciąganie) ustawionej dla dźwięku na liście dźwięków perkusyjnych. 
Aktywowałeś Snap.

UWAGA
Jeżeli chcesz przyciągać pozycje zgodnie z ustawieniem Quantize Presets (Ustawień wstępnych 
kwantyzacji) na pasku narzędzi, aktywuj opcję Use Quantize (Użyj kwantyzacji).
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PROCEDURA
● Wykonaj jedną z następujących czynności:
      ● Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i kliknij dwukrotnie  
         wyświetlacz zdarzenia.
      ● Wybierz narzędzie Drumstick (pałeczka do gry na bębnie) i kliknij wyświetlacz zdarzenia.

UWAGA
Aby tymczasowo przełączyć się z narzędzia Object Selection na narzędzie Drumstick, 
przytrzymaj klawisz Alt/Opt.

WYNIK
Wstawiono zdarzenie nuty.

Wstawianie wielu zdarzeń nut perkusyjnych
Za pomocą narzędzia Object Selection lub narzędzia Drumstick możesz wstawić wiele nut o tej 
samej wysokości.

WARUNEK WSTĘPNY
Ustawiłeś Insert Length (Długość wstawienia) na pasku narzędzi, aby określić długość wstawionej
nuty. Jeśli długość wstawiania jest ustawiona na opcję Drum-Map Link, nuta otrzyma długość 
wartości Snap (Przyciąganie) ustawionej dla dźwięku na liście dźwięków perkusyjnych. 
Aktywowałeś Snap.

UWAGA
Jeżeli chcesz przyciągać pozycje zgodnie z ustawieniem Quantize Presets (Presetów kwantyzacji) 
na pasku narzędzi, aktywuj opcję Use Quantize (Użyj kwantyzacji).

PROCEDURA
● Wykonaj jedną z następujących czynności:
      ● Na pasku narzędzi wybierz narzędzie Object Selection, kliknij dwukrotnie na wyświetlaczu 
         zdarzeń i przeciągnij w prawo.
      ● Na pasku narzędzi wybierz narzędzie Drumstick, kliknij na ekranie zdarzenia i przeciągnij 
         w prawo.

WYNIK
Zostaną wstawione zdarzenia nutowe.

POWIĄZANE LINKI
Pasek narzędzi edytora bębnów na stronie 872

Modyfikowanie wartości nut podczas wstawiania nut.
Podczas wstawiania zdarzeń nutowych możesz na bieżąco modyfikować określone wartości nut.

● Aby edytować dynamikę (velocity) nuty, przeciągnij w górę lub w dół.
● Aby edytować wysokość nuty (pitch), przytrzymaj klawisz Alt/Opt i przeciągnij w górę lub w 
   dół.
● Aby edytować długość nuty, przeciągnij w lewo lub w prawo.

UWAGA
Jeśli chcesz edytować długość nuty w Drum Editor (edytorze perkusyjnym), musisz 
dezaktywować Snap (przyciąganie) i Show Note Length On/Off (włączyć/wyłączyć wyświetlanie 
długości nuty). W przeciwnym razie nuta jest powtarzana.
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● Aby edytować pozycję czasu, przytrzymaj klawisz Shift i przeciągnij w lewo lub w prawo

UWAGA
Możesz tymczasowo włączyć/wyłączyć Snap (przyciąganie), przytrzymując klawisz Ctrl/Cmd.

Zmiana długości nuty
Możesz zmienić długość nuty w edytorze bębnów za pomocą narzędzia Object Selection 
(Zaznaczanie obiektów) lub narzędzia Drumstick (pałeczka do gry na bębnie).

WARUNEK WSTĘPNY
Aktywowałeś opcję Show Note Length On/Off (Włącz/wyłącz wyświetlanie długości nuty) na 
pasku narzędzi edytora perkusyjnego.

PROCEDURA
1. Przesuń wskaźnik myszy na początek lub koniec nuty, którą chcesz edytować.
    Wskaźnik myszy zmieni się w podwójną strzałkę.
2. Przeciągnij w lewo lub w prawo, aby dostosować długość.
    Wyświetlone zostanie okno informacyjne z aktualną wartością długości.
3. Zwolnij przycisk myszy.

WYNIK
Długość nuty została zmieniona. Snap (Przyciąganie) jest brane pod uwagę.

Usuwanie zdarzeń nut perkusyjnych

PROCEDURA
● Wykonaj jedną z następujących czynności:
      ● Wybierz narzędzie Erase (Usuń) i kliknij zdarzenie.
      ● Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i kliknij dwukrotnie zdarzenie.
      ● Wybierz narzędzie Drumstick (pałeczka do gry na bębnie) i kliknij zdarzenie.

WYNIK
Zdarzenie nutowe zostało usunięte.

Usuwanie wielu zdarzeń nut perkusyjnych
Za pomocą narzędzia Object Selection lub narzędzia Drumstick możesz usunąć wiele nut o tej 
samej wysokości (pitch).

WARUNEK WSTĘPNY
Aby usunąć wiele nut za pomocą narzędzia Object Selection (Zaznaczanie obiektów), należy 
włączyć Snap (przyciąganie).

PROCEDURA
● Wykonaj jedną z następujących czynności:
● Na pasku narzędzi wybierz narzędzie Object Selection, kliknij dwukrotnie pierwsze zdarzenie,  
   które chcesz usunąć i przeciągnij w prawo.
● Na pasku narzędzi wybierz narzędzie Drumstick, kliknij pierwsze zdarzenie, które chcesz usunąć
   i przeciągnij w prawo.

WYNIK
Zdarzenia nutowe zostaną usunięte.
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Wyciszanie nut i dźwięków perkusji

WAŻNE
Stan wyciszenia dźwięków perkusyjnych jest częścią mapy perkusyjnej. Ma to wpływ na wszystkie 
inne trasy korzystające z tej mapy.

● Aby wyciszyć poszczególne nuty, kliknij je lub załącz je za pomocą narzędzia Mute (Wycisz), 
   albo wybierz Edit > Mute (Edycja > Wycisz).
● Aby wyciszyć dźwięk perkusji na mapie perkusji, kliknij kolumnę Mute (Wycisz) dla dźwięku 
   perkusji.

                            

● Aby wyciszyć wszystkie inne dźwięki perkusji, kliknij Solo Instrument (Requires Drum Map) 
   (Instrument solo (wymaga mapy perkusji)) na pasku narzędzi.

POWIĄZANE LINKI
Wybieranie mapy perkusyjnej dla ścieżki na stronie 887

Drum Maps (Mapy perkusyjne)
Zestaw perkusyjny w instrumencie MIDI to najczęściej zestaw różnych dźwięków perkusyjnych, z 
których każdy jest umieszczony na osobnym klawiszu. Na przykład różne dźwięki są przypisane do
różnych numerów nut MIDI. Jeden klawisz odtwarza dźwięk bębna basowego, drugi werbel i tak 
dalej.

Różne instrumenty MIDI często korzystają z różnych przypisań klawiszy. Może to być kłopotliwe, 
jeśli utworzyłeś motyw perkusyjny przy użyciu jednego urządzenia MIDI, a następnie chcesz go 
wypróbować na innym. Kiedy zmieniasz urządzenia, jest bardzo prawdopodobne, że werbel stanie 
się talerzem ridem, a hi-hat tomem itp., ponieważ dźwięki perkusji są inaczej rozmieszczone w 
instrumentach.

Aby rozwiązać ten problem i uprościć kilka aspektów zestawów perkusyjnych MIDI, takich jak 
używanie dźwięków perkusyjnych z różnych instrumentów w tym samym zestawie perkusyjnym, 
Cubase zawiera mapy perkusyjne. Mapa perkusyjna to lista dźwięków perkusyjnych z różnymi 
ustawieniami dla każdego dźwięku. Podczas odtwarzania ścieżki MIDI, dla której wybrano mapę 
perkusyjną, nuty MIDI są filtrowane przez mapę perkusyjną przed wysłaniem do instrumentu 
MIDI. Mapa określa, który numer nuty MIDI jest wysyłany dla każdego dźwięku perkusyjnego i 
który dźwięk jest odtwarzany na odbierającym urządzeniu MIDI.

Jeśli chcesz wypróbować swój wzór perkusyjny na innym instrumencie, po prostu przełącz się na 
odpowiednią mapę perkusyjną, a dźwięk werbla pozostanie dźwiękiem werbla.

Jeśli chcesz mieć te same mapy perkusyjne zawarte w swoich projektach, możesz załadować je do 
szablonu.
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UWAGA
Mapy perkusyjne są zapisywane z plikami projektu. Jeśli utworzyłeś lub zmodyfikowałeś mapę 
bębnów, użyj funkcji Save (Zapisz), aby zapisać ją jako oddzielny plik XML i udostępnić do 
wczytania do innych projektów.

POWIĄZANE LINKI
Zapisywanie pliku szablonu projektu na stronie 103

Okno dialogowe Drum Map Setup (Konfiguracja mapy bębna)
To okno dialogowe umożliwia ładowanie, tworzenie, modyfikowanie i zapisywanie map bębnów.

● Aby otworzyć okno dialogowe Drum Map Setup, wybierz opcję Drum Map Setup 
   z wyskakującego menu Map lub menu MIDI.

Lista po lewej stronie pokazuje załadowane mapy perkusyjne. Dźwięki i ustawienia wybranej mapy
perkusyjnej zostaną wyświetlone po prawej stronie.

UWAGA
Ustawienia dźwięków perkusyjnych są takie same jak w Drum Editor (Edytorze bębnów).

Use Head Pairs (Użyj par głów)
   Jeśli ta opcja jest włączona, na liście dźwięków perkusyjnych wyświetlane są 2 symbole głowy 
   dla każdego brzmienia perkusyjnego.
Edit in Scores (Edytuj w partyturach)
   Jeśli ta opcja jest aktywna, możesz zmienić ustawienia mapy bębna partytury bezpośrednio w 
   partyturze.
Output (Wyjście)
   Umożliwia wybór wyjścia dla dźwięków mapy perkusyjnej.
Drum Sound list (Lista dźwięków perkusyjnych)
   Wyświetla listę wszystkich dźwięków perkusyjnych i ich ustawień. Aby odsłuchać dźwięk 
   perkusji, kliknij kolumnę znajdującą się najbardziej po lewej stronie.

UWAGA
Jeśli odsłuchujesz dźwięk w oknie dialogowym Drum Map Setup i dźwięk jest ustawiony na 
Default (Domyślne) wyjście MIDI, używane będzie wyjście wybrane w wyskakującym menu 
Output (Wyjście) w lewym dolnym rogu. Podczas odsłuchiwania domyślnego dźwięku 
wyjściowego w programie Drum Editor używane jest wyjście MIDI wybrane dla ścieżki.
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Wyskakujące menu Functions (Funkcje) zawiera następujące opcje:

New Map (Nowa mapa)
   Dodaje nową mapę perkusji do projektu. Dźwięki perkusji nazywane są „Sound 1, Sound 2, etc.” 
   („Dźwięk 1, Dźwięk 2 itd.”) i ustaw wszystkie parametry na wartości domyślne. Mapa nosi nazwę
   „Empty Map” („Pusta mapa”).
   Aby zmienić nazwę mapy bębnów, kliknij nazwę na liście i wpisz nową nazwę.
New Copy (Nowa kopia)
   Dodaje kopię wybranej mapy perkusyjnej, aby utworzyć nową mapę perkusyjną. Następnie 
   możesz zmienić ustawienia dźwięku perkusyjnego kopii i zmienić nazwę mapy perkusyjnej na 
   liście.
Remove (Usuń)
   Usuwa wybraną mapę perkusyjną z projektu.
Load (Ładuj)
   Umożliwia załadowanie map perkusyjnych do projektu.
Save (Zapisz)
   Umożliwia zapisanie na dysku mapy bębna wybranej z listy. Pliki map bębnów mają rozszerzenie
   .drm.
Edit head pairs (Edytuj pary głów)
   Umożliwia dostosowanie par nut

POWIĄZANE LINKI
Ustawienia mapy bębnów na stronie 886
Ustawienia kanałów i wyjść na stronie 887

Ustawienia mapy bębnów
Mapa perkusyjna składa się z ustawień dla 128 dźwięków perkusyjnych, po jednym dla każdego 
numeru nuty MIDI.

● Aby uzyskać przegląd ustawień mapy perkusyjnej, otwórz Drum Editor (Edytor bębnów) i użyj  
   menu podręcznego Map (Mapa) znajdującego się poniżej listy dźwięków perkusyjnych, aby 
   wybrać mapę perkusyjną GM Map.

    

Mapa GM jest skonfigurowana zgodnie ze standardem General MIDI.

Możesz zmienić wszystkie ustawienia mapy perkusyjnej z wyjątkiem wysokości dźwięku (pitch) 
bezpośrednio na liście dźwięków perkusyjnych lub w oknie dialogowym Drum Map Setup 
(Konfiguracji mapy perkusyjnej). Zmiany te dotyczą wszystkich utworów korzystających z mapy 
perkusyjnej.

POWIĄZANE LINKI
Lista brzmień perkusyjnych na stronie 880
Okno dialogowe konfiguracji mapy bębna na stronie 885
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Importowanie map perkusyjnych z instrumentów wirtualnych
Możesz zaimportować ustawienia mapy perkusji do ścieżki instrumentu, która jest kierowana do 
Groove Agent SE.

WARUNEK WSTĘPNY
Aby zaimportować ustawienia mapy perkusyjnej do ścieżki instrumentu, ścieżka musi zostać 
skierowana do Groove Agent SE lub innego instrumentu perkusyjnego obsługującego mapy 
perkusyjne.

PROCEDURA
1. Załaduj zestaw perkusyjny do programu Groove Agent SE.
2. W Inspector ścieżki otwórz wyskakujące menu Drum Maps (Mapy perkusji) i wybierz opcję 
    Create Drum Map from Instrument (Utwórz mapę perkusji z instrumentu).
    Mapa perkusji tworzona jest dla zestawu przypisanego do portu i kanału MIDI wybranego w 
    Inspektorze.
3. Otwórz ponownie menu podręczne Drum Maps (Mapy bębnów) i wybierz opcję Drum Map  
    Setup (Konfiguracja mapy bębnów).
4. Z listy po lewej stronie wybierz zestaw, który załadowałeś do instrumentu.

WYNIK
Dźwięki i ustawienia instrumentu są wyświetlane w ustawieniach mapy perkusyjnej.

UWAGA
Pady instrumentu i paternu są eksportowane do mapy perkusyjnej. Jeśli klawisze są wspólne, pady 
paternów mają pierwszeństwo, co oznacza, że ich ustawienia są uwzględniane w mapie perkusyjnej.

Ustawienia kanałów i wyjść
Możesz ustawić oddzielne kanały MIDI i/lub wyjścia MIDI dla każdego dźwięku w mapie 
perkusyjnej. Jeśli dla ścieżki zostanie wybrana mapa perkusyjna, ustawienia kanału MIDI w mapie 
perkusyjnej zastępują ustawienia kanału MIDI dla ścieżki.

Można wybrać różne kanały i/lub wyjścia dla różnych dźwięków. Pozwala to na konstruowanie 
zestawów perkusyjnych z dźwiękami z kilku różnych urządzeń MIDI itp.

● Aby dźwięk perkusji korzystał z kanału ścieżki, ustaw kanał w mapie perkusyjnej na Any 
   (Dowolny).
● Aby dźwięk korzystał z wyjścia MIDI wybranego dla ścieżki, ustaw wyjście MIDI dla dźwięku w
   mapie perkusyjnej na Default (Domyślne).
● Aby wysłać dźwięk do określonego wyjścia MIDI, wybierz dowolną inną opcję.
● Aby wybrać ten sam kanał MIDI lub urządzenie MIDI dla wszystkich dźwięków w mapie  
   perkusyjnej, kliknij kolumnę Channel (Kanał), naciśnij Ctrl/Cmd i wybierz kanał lub wyjście.
● Jeśli dokonasz określonych ustawień kanału MIDI i wyjścia dla wszystkich dźwięków w mapie 
   perkusyjnej, możesz przełączać się pomiędzy mapami perkusyjnymi, aby wysyłać ścieżki 
   perkusyjne do innego instrumentu MIDI.

Wybieranie mapy perkusyjnej dla ścieżki
● Aby wybrać mapę perkusji dla ścieżki MIDI, otwórz wyskakujące menu Map (Mapa) 
   w Inspektorze lub w Drum Editor (Edytorze perkusji) i wybierz mapę perkusji.
● Aby dezaktywować funkcję mapy perkusji w Drum Editor, otwórz wyskakujące menu Map 
   (Mapa) w Inspector lub Drum Editor i wybierz opcję No Drum Map (Bez mapy bębnów).
   Nawet jeśli nie używasz mapy perkusyjnej, nadal możesz oddzielać dźwięki według nazw, 
   korzystając z listy nazw.
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UWAGA
Początkowo wyskakujące menu Map (Mapa) zawiera tylko Map GM (mapę GM).

I-Notes, O-Notes, and Pitches (I-Nuty, O-Nuty i wysokości tonów)
Przeanalizowanie poniższej teorii pomoże Ci w pełni wykorzystać koncepcję mapy perkusyjnej – 
szczególnie jeśli chcesz tworzyć własne mapy perkusyjne.

Mapa perkusyjna to rodzaj filtra, który przekształca nuty zgodnie z ustawieniami na mapie. 
Dokonuje tej transformacji dwukrotnie; raz, gdy odbierze przychodzącą nutę, to znaczy, gdy 
zagrasz nutę na kontrolerze MIDI i raz, gdy nuta zostanie wysłana z programu do urządzenia 
dźwiękowego MIDI.

Poniższy przykład pokazuje zmodyfikowaną mapę perkusji z dźwiękiem bębna basowego o 
różnych wartościach wysokości tonu (pitch), I-nuty i O-nuty.

            
I-Nuty (nuty wejściowe)
Kiedy grasz nutę na instrumencie MIDI, program szuka numeru tej nuty wśród I-nut na mapie 
perkusyjnej. Jeśli zagrasz nutę A1, program uzna, że jest to nuta I dźwięku bębna basowego.

Tutaj następuje pierwsza transformacja: nuta otrzymuje nowy numer zgodnie z ustawieniem 
wysokości dźwięku perkusji. W naszym przypadku nuta jest przekształcana na nutę C1, ponieważ 
taka jest wysokość dźwięku bębna basowego. Jeśli nagrasz nutę, zostanie ona zarejestrowana jako 
nuta C1.

Można na przykład umieścić brzmienia perkusyjne na klawiaturze blisko siebie, aby można było je 
łatwo grać razem, przenieść dźwięki tak, aby najważniejsze brzmienia można było zagrać z krótkiej
klawiatury, odtwarzać dźwięk z czarnego klawisza zamiast białego . Jeśli nigdy nie grasz partii 
perkusyjnych za pomocą kontrolera MIDI, ale rysujesz je w edytorze, nie potrzebujesz ustawienia I-
note.

O-Nuty (Nuty wyjściowe)
Następnym krokiem jest wyjście. Oto, co się dzieje, gdy odtwarzasz nagraną nutę lub gdy grana 
nuta jest wysyłana z powrotem do instrumentu MIDI w czasie rzeczywistym (MIDI Thru):

Program sprawdza mapę perkusji i znajduje dźwięk perkusji wraz z wysokością nuty. W naszym 
przypadku jest to nuta C1, a brzmieniem perkusji jest bęben basowy. Zanim nuta zostanie wysłana 
na wyjście MIDI, następuje druga transformacja: numer nuty zostaje zmieniony na numer nuty O 
dla dźwięku. W naszym przykładzie nuta wysyłana do instrumentu MIDI jest nutą B0.

Ustawienia O-note pozwalają skonfigurować wszystko tak, aby dźwięk bębna basowego naprawdę 
grał bęben basowy. Jeśli używasz instrumentu MIDI, w którym dźwięk bębna basowego znajduje 
się na klawiszu C2, ustaw O-note dla dźwięku bębna basowego na C2. Kiedy przełączasz się na 
inny instrument (w którym bęben basowy jest na C1), chcesz, aby nuta O bębna basowego była 
ustawiona na C1. Po skonfigurowaniu map perkusyjnych dla wszystkich instrumentów MIDI 
możesz wybrać inną mapę perkusyjną, jeśli chcesz używać innego instrumentu MIDI do brzmień 
perkusyjnych.
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Ustawianie wysokości nut (pitch) zgodnie z ich ustawieniami O-Note
Możesz ustawić wysokość nut zgodnie z ich ustawieniami O-note. Jest to przydatne, jeśli chcesz 
przekonwertować ścieżkę na zwykłą ścieżkę MIDI bez mapy perkusji, a nuty nadal odtwarzają 
prawidłowe brzmienie perkusji.

Eksportowanie nagrania MIDI jako standardowego pliku MIDI jest typowym przypadkiem użycia. 
Jeśli po raz pierwszy wykonasz konwersję nut O, upewnij się, że ścieżki perkusyjne są odtwarzane 
zgodnie z oczekiwaniami po wyeksportowaniu.
● Aby przeprowadzić konwersję O-nut, wybierz MIDI > O-Note Conversion (MIDI > Konwersja  
   O-Nuta)

POWIĄZANE LINKI
Eksportowanie ścieżek MIDI jako standardowych plików MIDI na stronie 168.

List Editor (Edytor listy)
List Editor wyświetla wszystkie zdarzenia w wybranych partiach MIDI w formie listy, 
umożliwiając numeryczne przeglądanie i edycję ich właściwości. Umożliwia także edycję 
wiadomości SysEx.

● Aby otworzyć partię MIDI w List Editor, wybierz partię MIDI w oknie Project i wybierz MIDI 
   > Open List Editor (MIDI > Otwórz Edytor Listy).

Edytor listy jest podzielony na kilka sekcji:
1 Toolbar (Pasek narzędzi)
2 Status Line (Linia stanu)
3 Event List (Lista zdarzeń)
4 Filters bar (Pasek filtrów)
5 Ruler (Linijka)
6 Event Display (Wyświetlacz zdarzeń)
7 Value Display (Wyświetlacz wartości)
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UWAGA
Filtry, linię stanu i wyświetlanie wartości można włączyć/wyłączyć, klikając opcję Set up Window
Layout (Ustaw układ okna) na pasku narzędzi i aktywując/dezaktywując odpowiednie opcje

Pasek narzędzi edytora listy
Pasek narzędzi zawiera narzędzia i różne ustawienia List Editor (Edytora list).

● Aby pokazać lub ukryć elementy paska narzędzi, kliknij pasek narzędzi prawym przyciskiem 
   myszy i aktywuj lub dezaktywuj elementy.

Default Items (Domyślne elementy)
Solo Editor (Soluj edytor)

       
      Solo edytora podczas odtwarzania, jeśli edytor ma fokus.
Record in Editor (Nagraj w Edytorze)

       
      Włącza nagrywanie danych MIDI w edytorze, jeśli edytor ma fokus.
UWAGA
Działa to tylko wtedy, gdy MIDI Record Mode (Tryb nagrywania MIDI) jest ustawiony na Merge 
(Scal) lub Replace (Zamień).

Retrospective Record (Zapis retrospektywny)
Insert MIDI Retrospective Recording in Editor (Wstaw retrospektywne nagranie MIDI w 
edytorze )

       
      Umożliwia odzyskanie nut MIDI granych w trybie zatrzymania lub podczas odtwarzania.

Auto Scroll (Automatyczne przewijanie)
Auto Scroll

       
      Utrzymuje kursor projektu widoczny podczas odtwarzania.
Select Auto-Scroll Settings (Wybierz Ustawienia automatycznego przewijania)

       
      Umożliwia aktywację Page Scroll (Przewijania strony) lub Stationary Cursor (Nieruchomego 
      kursora) oraz aktywację Suspend AutoScroll When Editing (Wstrzymania automatycznego 
      przewijania podczas edycji).

Acoustic Feedback (Sprzężenie akustyczne)
Acoustic Feedback

       
      Automatycznie odtwarza zdarzenia, gdy je przesuwasz, transponujesz lub gdy tworzysz je 
      poprzez rysowanie.

Tool Buttons (Przyciski narzędzi)
Object Selection (Wybór obiektu)

       
      Wybiera zdarzenia i części.
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Draw (Rysuj)

       
      Rysuje zdarzenia.
Erase (Usuń)

       
      Usuwa zdarzenia.
Trim (Przytnij)

       
      Przycina zdarzenia.
Mute (Wycisz)

       
      Wycisza zdarzenia.
Zoom (Powiększenie)

       
      Powiększa. Przytrzymaj Alt/Opt i kliknij, aby pomniejszyć.

Independent Track Loop (Niezależna pętla ścieżki)
Independent Track Loop

       
      Aktywuje/dezaktywuje niezależną pętlę ścieżki.

Insert Type (Typ wstawki)
Insert Event Type (Wstaw typ zdarzenia)

       
      Umożliwia określenie typu zdarzenia dla nowo tworzonych zdarzeń.

Insert Velocity (Wstaw prędkość uderzenia w klawisz)
Note Insert Velocity (Wstaw prędkość nuty)

       
      Umożliwia określenie wartości dynamiki nowych nut.

Nudge Palette (Paleta szturchać)
Trim Start Left (Początek przycinania w lewo)

       
      Zwiększa długość wybranego zdarzenia przesuwając jego początek w lewo.
Trim Start Right (Przycinanie rozpoczyna się w prawo)

       
      Zmniejsza długość wybranego zdarzenia przesuwając jego początek w prawo.
Move Left (Przesuń w lewo)

       
      Przesuwa wybrane zdarzenie w lewo.
Move Right (Przesuń w prawo)

       
      Przesuwa wybrane zdarzenie w prawo.
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Trim End Left (Przytnij koniec w lewo)

       
      Zmniejsza długość wybranego zdarzenia przesuwając jego koniec w lewo.
Trim End Right (Przytnij koniec w prawo)

       
      Zwiększa długość wybranego zdarzenia przesuwając jego koniec w prawo.

Snap (Przyciaganie)
Snap On/Off (Włączanie/wyłączanie przyciągania)

       
      Aktywuje/dezaktywuje funkcję przyciągania.
Snap Type (Typ przyciągania)

       
      Umożliwia wybranie jednego z następujących typów przyciągania:
● Grid (Siatka) przyciąga zdarzenia do siatki wybranej w wyskakującym menu z    
   (Ustawienia wstępne kwantyzacji).
● Grid Relative (Względna siatka) zachowuje względne pozycje podczas przyciągania zdarzeń do 
   siatki.
● Events (Zdarzenia) przyciąga zdarzenia do początku lub końca innych zdarzeń.
● Shuffle (Losowo) zmienia kolejność zdarzeń, jeśli przeciągniesz jedno zdarzenie na lewo lub na 
   prawo od innych zdarzeń.
● Cursor (Kursor) przyciąga zdarzenia do pozycji kursora.
● Grid + Cursor (Siatka + Kursor) przyciąga zdarzenia do siatki kwantyzacji wybranej w 
   wyskakującym menu Quantize Presets lub do pozycji kursora.
● Events + Cursor (Zdarzenia + Kursor) przyciąga zdarzenia do początku lub końca innych 
   zdarzeń lub do pozycji kursora.
● Grid + Events + Cursor (Siatka + Zdarzenia + Kursor) przyciąga zdarzenia do siatki 
   kwantyzacji wybranej w wyskakującym menu Quantize Presets, do początku lub końca innych 
   zdarzeń lub do pozycji kursora.

Quantize (Kwantyzacja)
Apply Quantize (Zastosuj kwantyzację)

       
      Stosuje ustawienia kwantyzacji.
Quantize Presets (Ustawienia wstępne kwantyzacji)

       
      Umożliwia wybór ustawienia wstępnego kwantyzacji lub rytmu.
Soft Quantize On/Off (Włączanie/wyłączanie miękkiej kwantyzacji)

       
      Aktywuje/dezaktywuje miękką kwantyzację.
Open Quantize Panel (Otwórz panel kwantyzacji)

       
      Otwiera panel Kwantyzacji.
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Length Quantize (Kwantyzacja długości)
Length Quantize

       
      Umożliwia ustawienie wartości kwantyzacji długości zdarzeń.

Multiple Part Controls (Sterowanie wieloma częściami)
Show Part Borders (Pokaż granice części)

       
      Pokazuje/ukrywa granice części aktywnej partii MIDI w lewym i prawym lokalizatorze.
Edit Active Part Only (Edytuj tylko część aktywną)

       
      Ogranicza operacje edycyjne do aktywnej części.
Currently Edited Part (Aktualnie edytowana część)

       
      Wyświetla listę wszystkich części wybranych po otwarciu edytora i umożliwia aktywację 
      części.

Step/MIDI Input (Wejście krokowe/MIDI)
Step Input (Wejście krokowe)

       
      Aktywuje/dezaktywuje wejście krokowe MIDI.
MIDI Input/Note Expression MIDI Input (Wejście MIDI/wyrażenie nutowe Wejście MIDI)

       
      Aktywuje/dezaktywuje wejście MIDI i wejście MIDI wyrażające nuty.
Move Insert Mode (Przenieś tryb wstawiania)

       
      Przesuwa wszystkie zdarzenia nutowe na prawo od pozycji wprowadzania kroku w prawo, aby 
      zrobić miejsce na wstawione zdarzenie podczas wstawiania nut.
UWAGA
Działa to tylko wtedy, gdy aktywowane jest Step Input (wejście krokowe).

Record Pitch (Nagraj wysokość tonu)

       
      Uwzględnia wysokość dźwięku podczas wstawiania nut.
Record NoteOn Velocity (Nagraj prędkość NoteOn) 

       
      Uwzględnia dynamikę NoteOn podczas wstawiania nut.
Record NoteOff Velocity (Nagraj prędkość NoteOff)

       
      Uwzględnia prędkość NoteOff podczas wstawiania nut.

Event Colors (Kolory zdarzeń)
Event Colors

       
      Umożliwia wybór kolorów zdarzeń.
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Right Divider (Prawy rozdzielacz)
Right Divider
      Umożliwia użycie odpowiedniego rozdzielacza. Narzędzia umieszczone po prawej stronie 
      rozdzielacza są zawsze pokazane.

Edit VST Instrument (Edytuj instrument VST)
Edit VST Instrument

       
      Otwiera instrument VST, do którego kierowana jest ścieżka.

Window Zone Controls (Sterowanie strefą okienną)
Show/Hide Left Zone (Pokaż/ukryj lewą strefę

       
      Pokazuje/ukrywa lewą strefę.
Show/Hide Right Zone (Pokaż/Ukryj prawą strefę)

       
      Pokazuje/ukrywa prawą strefę.
Set up Window Layout (Skonfiguruj układ okna)

       
      Umożliwia ustawienie układu okna.
Set up Toolbar (Skonfiguruj pasek narzędzi)

       
      Otwiera wyskakujące menu, w którym możesz ustawić, które elementy paska narzędzi mają być
      widoczne.

POWIĄZANE LINKI
Opcje konfiguracji na stronie 1145

Status Line (Linia stanu)
Linia stanu jest wyświetlana poniżej paska narzędzi. Wyświetla ważne informacje o pozycji myszy.

● Aby wyświetlić linię stanu, kliknij opcję Set up Window Layout (Ustaw układ okna) na pasku 
   narzędzi i aktywuj Status Line.

  

Stan włączenia/wyłączenia linii statusu w oknie List Editor (Edytora Listy) oraz w zakładce 
Editor w dolnej strefie okna Project jest od siebie niezależny.

Mouse Time Position (Pozycja czasu myszy)
      Wyświetla dokładną pozycję czasową wskaźnika myszy, w zależności od wybranego formatu 
      wyświetlania linijki. Umożliwia to edycję lub wstawianie nut w dokładnych pozycjach.

Current Chord Display (Wyświetlanie bieżącego akordu)
      Kiedy kursor projektu znajduje się nad nutami tworzącymi akord, ten akord jest tutaj 
      wyświetlany.
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Track Loop Start/End (Początek/koniec pętli ścieżki)
Jeżeli na pasku narzędzi włączona jest opcja Independent Track Loop (Niezależna pętla ścieżki), 
wyświetlana jest jej pozycja początkowa/końcowa.

POWIĄZANE LINKI
Pasek narzędzi edytora bębnów na stronie 872

Filters Bar (Pasek filtrów)
Pasek filtrów pozwala ukryć zdarzenia na podstawie ich typu i innych właściwości.

● Aby wyświetlić pasek filtrów, kliknij opcję Set up Window Layout (Ustaw układ okna) na 
   pasku narzędzi i aktywuj Filters (Filtry).

Show Section (Sekcja Pokaż)
Sekcja Show (Pokaż) umożliwia ustawienie filtrów.

No Focus (Brak fokusa)
      Nie zastosowano żadnego filtra.
Event Types (Typy zdarzeń)
      Wyświetlone zostaną tylko zdarzenia tego samego typu co wybrany typ. Działa to tak samo, jak 
      aktywowanie typów zdarzeń w sekcji Hide (Ukryj).
Event Types and Data 1 (Typy zdarzeń i dane 1)
      Wyświetlane są tylko zdarzenia tego samego typu co wybrany typ i z tą samą wartością Data 1 
      (Danych 1). Na przykład, jeśli wybrane zostanie zdarzenie nutowe, pokazane zostaną tylko nuty
      o tej samej wysokości. Jeśli wybrane zostanie zdarzenie kontrolera, pokazane zostaną tylko 
      kontrolery tego samego typu.
Event Channels (Kanały zdarzeń)
      Wyświetlane są tylko zdarzenia z tą samą wartością kanału MIDI, co wybrane zdarzenie.
Presets (Ustawienia wstępne)
      Umożliwia użycie ustawienia wstępnego.
Setup (Ustaw)
      Otwiera Logical Editor (Edytor logiczny). Tutaj możesz tworzyć złożone ustawienia filtrów. 
      Jeśli zastosujesz dowolne ustawienia wstępne Logical Editor lub użyjesz Logical Editor do 
      samodzielnego utworzenia ustawień filtrów, widoczne będą tylko zdarzenia spełniające 
      określone kryteria.

Hide Section (Sekcja Ukryj)
Sekcja Hide (Ukryj) umożliwia ukrycie określonych typów zdarzeń

POWIĄZANE LINKI
Filtrowanie listy zdarzeń na stronie 899
Edytor logiczny na stronie 992
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Event List (Lista zdarzeń)
Event List zawiera listę wszystkich zdarzeń w wybranych partiach MIDI, w kolejności ich 
odtwarzania od góry do dołu. Lista umożliwia szczegółową edycję numeryczną właściwości 
zdarzeń.

Dostępne są następujące opcje:
>
      Strzałka w tej kolumnie wskazuje zdarzenie, które rozpoczyna się najbliżej pozycji kursora 
      projektu. Możesz użyć tej kolumny do odsłuchania podczas edycji listy.
      ● Aby przesunąć kursor na początek zdarzenia, kliknij kolumnę przesłuchania zdarzenia.
      ● Aby przesunąć pozycję kursora i rozpocząć/zatrzymać odtwarzanie, kliknij dwukrotnie 
         kolumnę zdarzenia.
Type (Typ)
      Typ zdarzenia. Nie może zostać zmieniony.
Start (Początek)
      Pozycja początkowa zdarzenia, wyświetlana w formacie wybranym dla linijki. Zmiana daje taki 
      sam efekt jak przesunięcie zdarzenia.
UWAGA
Jeśli przesuniesz zdarzenie poza inne zdarzenie na liście, lista zostanie przeniesiona. Lista zawsze 
przedstawia zdarzenia w kolejności ich odtwarzania.

End (Koniec)
      Umożliwia przeglądanie i edytowanie pozycji końcowej zdarzenia nutowego. Edycja zmienia 
      rozmiar zdarzenia nuty.
Length (Długość)
      Wyświetla długość zdarzenia nutowego. Zmiana tej opcji powoduje zmianę rozmiaru zdarzenia 
      nutowego i automatyczną zmianę wartości End.
Data 1 (Dane 1)
      Właściwość Data 1 lub Value 1 (Wartość 1) zdarzenia. Jego treść zależy od rodzaju zdarzenia.  
      W przypadku nut jest to na przykład wysokość tonu (pitch). Tam, gdzie ma to zastosowanie, 
      wartości są wyświetlane w najbardziej odpowiedniej formie. Na przykład wartość Data 1 
      (Dane 1) dla nut jest wyświetlana jako numer nuty w formacie wybranym w oknie dialogowym 
      Preferences (Preferencje).
Data 2 (Dane 2)
      Właściwość Data 2 lub Value 2 zdarzenia. Treść tego zależy od typu zdarzenia. W przypadku 
      nut jest to na przykład wartość dynamiki (note-on velocity) nuty.
Data 3 (Dane 3)
      Właściwość Data 3 lub Value 3 zdarzenia. Ta wartość jest używana tylko w przypadku zdarzeń
      nutowych, gdzie odpowiada ona szybkości nut (note-off velocity).
Channel (Kanał)
      Kanał MIDI zdarzenia. To ustawienie jest zwykle zastępowane przez ustawienie kanału dla 
      ścieżki. Aby zdarzenie MIDI było odtwarzane na własnym kanale, ustaw jego ścieżkę na Any 
      (Dowolny) kanał w oknie Project.
Comment (Komentarz)
      Użyj tej opcji w przypadku Text (tekstu), Lyrics (Tekstów piosenek), zdarzeń SMF lub SysEx, 
      które wymagają wpisu tekstowego lub szesnastkowego.
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Event Display (Wyświetlacz zdarzeń)
Event Display wyświetla zdarzenia w formie graficznej.

● Ekran zdarzeń jest zawsze pokazywany.

            

Pionowa pozycja zdarzenia na wyświetlaczu odpowiada jego wpisowi na liście, czyli kolejności 
odtwarzania. Pozycja pozioma odpowiada rzeczywistej pozycji zdarzenia w projekcie. Na ekranie 
zdarzeń możesz dodawać nowe części lub zdarzenia i przeciągać zdarzenia w inne miejsce.

Value Display (Wyświetlanie wartości)
Wyświetlanie wartości po prawej stronie wyświetlania zdarzeń to narzędzie do szybkiego 
przeglądania i edycji wielu wartości, na przykład prędkości (velocities) lub wielkości kontrolera 
(controller amounts). Wartości są pokazywane jako poziome paski, których długość odpowiada 
wartości.
● Aby wyświetlić wyświetlaną wartość, kliknij opcję Set up Window Layout (Ustaw układ okna) 
   na pasku narzędzi i aktywuj Value Display (wyświetlanie wartości).

       

Wartość wyświetlana dla zdarzenia zależy od typu zdarzenia. Poniższa tabela pokazuje, co jest 
wyświetlane i edytowane w kolumnach Data (Dane) oraz przy wyświetlaniu wartości:

   Typ zdarzenia    Data 1    Data 2 Wyświetlana wartość

   Note  Pitch (numer nuty)  Note-on velocity    Velocity

   Controller  Controller type  Controller amount  Controller amount

  Program change  Program number   Nieużywane   Program number

  Aftertouch   Aftertouch amount   Nieużywane   Aftertouch amount

  Pitchbend   Bend amound   Nieużywane   Bend amound
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   Typ zdarzenia    Data 1    Data 2 Wyświetlana wartość

   Typ zdarzenia    Data 1    Data 2 Wyświetlana wartość

   SysEx   Nieużywane    Nieużywane    Nieużywane

UWAGA
W przypadku zdarzeń nutowych w kolumnie Data 3 (Dane 3) znajduje się również wartość, która 
służy do określenia szybkości (velocity) Note-off.

UWAGA
W przypadku zdarzeń SMF i tekstowych nie są wyświetlane żadne wartości.

Operacje edytora listy (List Editor)
W tej sekcji opisano główne operacje edycyjne w List Editor.

Zdarzenia rysunkowe
Narzędzie Draw (Rysuj) umożliwia wstawianie pojedynczych zdarzeń na ekranie zdarzeń.

Po przesunięciu kursora wewnątrz ekranu zdarzenia jego pozycja jest wskazywana w linii stanu. 
Uwzględniana jest funkcja Snap (Przyciąganie).

   

● Aby zmienić typ zdarzenia, które chcesz narysować, wybierz go z wyskakującego menu Insert 
   Event Type (Wstaw typ zdarzenia).

                       

● Aby narysować zdarzenie, kliknij na ekranie zdarzenia. Zdarzenie nutowe otrzymuje długość 
ustawioną w wyskakującym menu Length Quantize (Kwantyzacja długości). Nuty otrzymują 
wartość prędkości wstawiania ustawioną w polu Note Insert Velocity (Szybkość wstawiania nuty) 
na pasku narzędzi.
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● Aby narysować dłuższe nuty, kliknij i przeciągnij na ekranie zdarzeń. Długość zdarzenia jest 
wielokrotnością wartości Length Quantize. Jeśli Length Quantize jest ustawione na Quantize 
Link, wartość zdarzenia jest określana przez siatkę kwantyzacji.

Filtrowanie listy zdarzeń (Event List)
Listę zdarzeń można filtrować za pomocą paska Filters (Filtry) wyświetlanego pod paskiem 
narzędzi w Event List (Edytorze listy).

● Aby filtrować listę zdarzeń w oparciu o złożone kryteria, otwórz wyskakujące menu Show 
   (Pokaż) i wybierz filtr.
● Aby ukryć typ zdarzenia, aktywuj odpowiednie pole wyboru na pasku Filters (Filtry).
● Aby ukryć wszystkie typy zdarzeń z wyjątkiem jednego, naciśnij klawisz Ctrl/Cmd i kliknij pole
   wyboru typu zdarzenia, które chcesz wyświetlić.
   Jeśli ponownie klikniesz klawiszem Ctrl/Cmd, wszystkie pola wyboru zostaną wyczyszczone.

Edycja na Liście Zdarzeń (Event List)

● Aby edytować wartości kilku zdarzeń, wybierz zdarzenia i edytuj wartość jednego zdarzenia.   
   Zmieniają się także wartości pozostałych wybranych zdarzeń. Wszelkie różnice wartości 
   początkowych pomiędzy zdarzeniami zostają zachowane.
● Aby ustawić tę samą wartość dla wszystkich wybranych zdarzeń, naciśnij klawisz Ctrl/Cmd 
   i edytuj wartość jednego zdarzenia.
● W przypadku zdarzeń SysEx można edytować jedynie pozycję Start (początkową) na liście.    
   Jednak po kliknięciu kolumny Comment (Komentarz) otwiera się MIDI SysEx Editor (Edytor 
   MIDI SysEx), w którym można przeprowadzić szczegółową edycję wyłącznych zdarzeń 
   systemowych.

UWAGA
Kiedy przytniesz początek nuty w Editor List (Edytorze listy), nuta może zostać przeniesiona na 
inną pozycję na liście, ponieważ inne zdarzenia mogą rozpocząć się wcześniej niż edytowane 
zdarzenie.

POWIĄZANE LINKI
Komunikaty SysEx na stronie 900

Edycja na ekranie zdarzeń (Event Display)
Wyświetlanie zdarzeń umożliwia graficzną edycję zdarzeń za pomocą narzędzi na pasku narzędzi. 
Możesz edytować pojedyncze zdarzenia, jak i kilka wybranych zdarzeń jednocześnie.

● Aby przenieść zdarzenie, przeciągnij je w nowe miejsce.
   Przesunięcie zdarzenia poza inne zdarzenie na wyświetlaczu powoduje zmianę listy. Lista zawsze 
   przedstawia zdarzenia w kolejności ich odtwarzania. W rezultacie zmienia się także pionowe 
   położenie zdarzenia na wyświetlaczu.
● Aby utworzyć kopię zdarzenia, naciśnij Alt/Opt i przeciągnij je w nowe miejsce.
● Aby zmienić rozmiar notatki, zaznacz ją i przeciągnij jej punkt końcowy za pomocą narzędzia   
   Object Selection (Zaznaczanie obiektów).
● Aby wyciszyć lub wyłączyć wyciszenie wydarzenia, kliknij je narzędziem Mute (Wycisz).
   Możesz wyciszyć lub wyłączyć wyciszenie kilku zdarzeń jednocześnie, umieszczając je w 
   prostokącie zaznaczenia za pomocą narzędzia Mute (Wycisz).
● Możesz wybrać schemat kolorów dla zdarzeń za pomocą wyskakującego menu Event Colors 
   (Kolory zdarzeń) na pasku narzędzi.
● Aby usunąć zdarzenie, wybierz je i naciśnij Backspace lub Delete, albo kliknij je za pomocą  
   narzędzia Erase (Usuń).
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POWIĄZANE LINKI
Menu kolorów zdarzeń na stronie 805

Edycja na wyświetlaczu wartości (Value Display)
● Aby edytować wyświetlane wartości, kliknij i przeciągnij.
   Wskaźnik myszy automatycznie przyjmuje kształt narzędzia Draw (Rysuj), gdy przesuwasz go 
   nad wyświetlaną wartością.

Wiadomości SysEx
Komunikaty SysEx (System Exclusive) to komunikaty specyficzne dla modelu, służące do 
ustawiania różnych parametrów urządzenia MIDI. Umożliwia to adresowanie parametrów 
urządzenia, które nie byłyby dostępne w normalnej składni MIDI.

Każdy większy producent MIDI ma swój własny kod identyfikacyjny SysEx. Komunikaty SysEx są
zwykle używane do przesyłania danych brzmień, na przykład liczb tworzących ustawienia jednego 
lub większej liczby dźwięków w instrumencie MIDI.

Cubase umożliwia nagrywanie i manipulowanie danymi SysEx na różne sposoby.

POWIĄZANE LINKI
Korzystanie z urządzeń MIDI na stronie 782

Bulk Dumps (Zrzuty zbiorcze)
W każdym programowalnym urządzeniu ustawienia zapisywane są w formie liczbowej w pamięci 
komputera. Zmiana tych liczb spowoduje zmianę ustawień. Zwykle urządzenia MIDI umożliwiają 
zrzut (przesyłanie) wszystkich lub niektórych ustawień do pamięci urządzenia w postaci 
komunikatów MIDI SysEx.

Zrzut jest więc między innymi sposobem na utworzenie kopii zapasowej ustawień instrumentu: 
wysłanie takiego zrzutu z powrotem do urządzenia MIDI przywraca ustawienia.

Jeśli Twój instrument umożliwia zrzut kilku lub wszystkich ustawień poprzez MIDI poprzez 
aktywację jakiejś funkcji na panelu przednim, zrzut ten prawdopodobnie będzie możliwy do 
nagrania w Cubase.

Nagrywanie zrzutu zbiorczego

WAŻNE
Jeśli Twój instrument MIDI nie oferuje możliwości zainicjowania zrzutu, musisz wysłać 
wiadomość żądania zrzutu z Cubase, aby rozpocząć zrzut. W takim przypadku użyj MIDI SysEx 
Editor (Edytora MIDI SysEx), aby wstawić określony komunikat żądania zrzutu (zajrzyj do 
dokumentacji instrumentu) na początku ścieżki MIDI. Po włączeniu nagrywania komunikat żądania
zrzutu zostanie odtworzony (wysłany do instrumentu), rozpocznie się zrzut i zostanie nagrany.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz opcję MIDI > MIDI Filter (MIDI > 
    Filtr MIDI).
2. W sekcji Record (Rejestruj) dezaktywuj pole wyboru SysEx, aby mieć pewność, że rejestracja  
    danych SysEx nie będzie filtrowana.
    W ten sposób komunikaty SysEx są nagrywane, ale nie są odbijane echem do instrumentu. Może 
    to prowadzić do nieprzewidywalnych rezultatów.
3. Aktywuj nagrywanie na ścieżce MIDI i zainicjuj zrzut z panelu przedniego instrumentu.
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4. Po zakończeniu nagrywania wybierz nową część i wybierz MIDI > List Editor.
    Dzięki temu możesz sprawdzić, czy zrzut SysEx został zarejestrowany. Na liście części/zdarzeń 
    powinno znajdować się jedno lub kilka zdarzeń SysEx.

Przesyłanie zrzutu zbiorczego z powrotem do urządzenia

WARUNEK WSTĘPNY
Skieruj ścieżkę MIDI z danymi System Exclusive (SysEx) do urządzenia. Sprawdź dokumentację 
swojego urządzenia, aby znaleźć szczegółowe informacje na temat tego, który kanał MIDI 
powinien być używany itp.

PROCEDURA
1. „Wysoluj” utwór.
2. Upewnij się, że urządzenie jest skonfigurowane do odbierania wiadomości SysEx.
3. Jeśli to konieczne, przełącz urządzenie w tryb Standby to Receive System Exclusive 
    (Gotowości do odbioru wyłącznie w systemie).
4. Odtwórz dane.

Nagrywanie i przesyłanie zrzutów zbiorczych
● Nie przesyłaj więcej danych, niż potrzebujesz. Jeśli potrzebujesz tylko jednego programu, nie 
wysyłaj wszystkich. W przeciwnym razie znalezienie uznanego programu może okazać się zbyt 
trudne. Zwykle możesz dokładnie określić, jakie dane chcesz wysłać.
● Jeśli chcesz, aby sekwencer zrzucał odpowiednie dźwięki do Twojego instrumentu za każdym 
razem, gdy ładujesz projekt, umieść dane SysEx w cichym odliczaniu przed rozpoczęciem samego 
projektu.
● Jeśli zrzut jest bardzo krótki, na przykład pojedynczy dźwięk, możesz umieścić zrzut w środku 
projektu, aby szybko przeprogramować urządzenie. Ten sam efekt można jednak osiągnąć, 
korzystając z opcji Program Change (Zmiana programu). Jest to lepsze rozwiązanie, ponieważ 
wysyłanych i nagrywanych jest mniej danych MIDI. Niektóre urządzenia mogą być 
skonfigurowane tak, aby zrzucać ustawienia dźwięku zaraz po wybraniu go na panelu przednim.
● Jeśli tworzysz części z przydatnymi zrzutami SysEx, możesz umieścić je na specjalnej 
wyciszonej ścieżce. Aby skorzystać z tych partii, przeciągnij je na pustą, niewyciszoną ścieżkę i 
odtwórz je.
● Nie przesyłaj kilku zrzutów SysEx do kilku instrumentów jednocześnie.
● Zanotuj bieżące ustawienie identyfikatora urządzenia w instrumencie. Jeśli to zmienisz, 
instrument może później odmówić załadowania zrzutu.

Rejestrowanie zmian parametrów SysEx
Często za pomocą SysEx można zdalnie zmienić indywidualne ustawienia w urządzeniu, np. 
otworzyć filtr, wybrać kształt fali, zmienić zanik pogłosu itp. Wiele urządzeń ma również 
możliwość przesyłania zmian dokonanych na panelu przednim jako wiadomości SysEx. Można je 
nagrać w Cubase i w ten sposób włączyć do zwykłego nagrania MIDI.

Na przykład otwierasz filtr podczas grania nut. W takim przypadku nagrywasz zarówno nuty, jak i 
komunikaty SysEx generowane po otwarciu filtra. Podczas odtwarzania nagrania dźwięk zmienia 
się dokładnie tak samo, jak podczas nagrywania.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz opcję MIDI > Filter MIDI i upewnij 
się, że w sekcji Record (Nagrywanie) opcja SysEx jest wyłączona.
2. Upewnij się, że przyrząd jest ustawiony na przesyłanie zmian elementów sterujących panelu 
przedniego jako komunikaty SysEx.
3. Nagraj.
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PO ZAKOŃCZENIU TEGO ZADANIA
Sprawdź w List Editor (Edytorze Listy), czy zdarzenia zostały poprawnie zarejestrowane.

MIDI SysEx Editor (Edytor MIDI SysEx)

● Aby otworzyć MIDI SysEx Editor dla zdarzenia SysEx, kliknij kolumnę Comments 
(Komentarze) dla zdarzenia w List Editor (Edytorze listy) lub Project Browser (Przeglądarce 
projektu).

          

W MIDI SysEx Editor bajty są wyświetlane w następujący sposób:

Address (Adres)
      Pokazuje, w którym miejscu wiadomości znajduje się dana wartość.
0-7
      Wyświetla całą wiadomość w formacie szesnastkowym.
      Komunikaty SysEx zawsze zaczynają się od F0 i kończą na F7 oraz pewną liczbę dowolnych 
      bajtów pomiędzy nimi. Jeżeli wiadomość zawiera więcej bajtów i nie mieszczą się one 
      w całości w jednym wierszu, jest ona kontynuowana w kolejnym wierszu. Możesz edytować 
      wszystkie wartości z wyjątkiem pierwszej (F0) i ostatniej (F7).
ASCII
      Pokazuje wybraną wartość w formacie ASCII.

Dodawanie i usuwanie bajtów
● Aby dodać bajt, otwórz MIDI SysEx Editor i kliknij Insert (Wstaw). Bajt jest dodawany przed 
   wybranym bajtem.
● Aby usunąć bajt, otwórz MIDI SysEx Editor, wybierz bajt i kliknij Delete (Usuń).
● Aby usunąć całą wiadomość SysEx, wybierz ją w List Editor (Edytorze Listy) i naciśnij klawisz 
   Delete lub Backspace.

Edycja wartości bajtów
Możesz edytować wybraną wartość bajtu na głównym ekranie MIDI SysEx Editor lub na 
wyświetlaczach ASCII, dziesiętnych i binarnych.
● Aby edytować wybraną wartość, otwórz MIDI SysEx Editor, kliknij bajt i wpisz wartość.

Importowanie i eksportowanie danych SysEx
Możesz importować dane SysEx z dysku i eksportować edytowane dane do pliku.
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Plik musi być w formacie binarnym MIDI SysEx (.syx). Załadowany zostanie tylko pierwszy zrzut 
w pliku SYX.
● Aby zaimportować dane SysEx, otwórz edytor MIDI SysEx Editor i kliknij Import (Importuj).

● Aby wyeksportować dane SysEx, otwórz edytor MIDI SysEx Editor i kliknij Export 
   (Eksportuj).
UWAGA
Nie należy mylić tego formatu z plikami MIDI, które mają rozszerzenie .mid.

In-Place Editor (Edytor lokalny)
In-Place Editor umożliwia edycję nut i kontrolerów MIDI bezpośrednio w oknie Project, co 
pozwala na szybką i wydajną edycję w kontekście innych ścieżek.

   

In-Place Editor rozwija ścieżkę MIDI, aby wyświetlić miniaturowy Key Editor (edytor klawiszy).
Po wybraniu nuty MIDI w wierszu informacji w oknie Project wyświetlane są te same informacje o
nucie, co w wierszu informacji w Key Editor. Można tu przeprowadzić tę samą edycję, co w Key 
Editor.

POWIĄZANE LINKI
Edytowanie zdarzeń nutowych w wierszu informacyjnym na stronie 810

Otwieranie In-Place Editor (Edytora lokalnego)
● Aby otworzyć In-Place Editor dla wybranych ścieżek, wybierz MIDI > Open In-Place Editor  
   (MIDI > Otwórz edytor lokalny).
● Aby otworzyć In-Place Editor dla pojedynczej ścieżki MIDI, kliknij opcję Edit In-Place (Edytuj
   lokalnie) na liście ścieżek.

            
Pasek narzędzi edytora lokalnego
Pasek narzędzi zawiera narzędzia i ustawienia In-Place Editor (Edytora lokalnego).
● Aby otworzyć pasek narzędzi, kliknij trójkąt w prawym górnym rogu listy ścieżek dla 
   edytowanego utworu.
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Acoustic Feedback (Sprzężenie akustyczne)
Acoustic Feedback 

       
      Automatycznie odtwarza zdarzenia, gdy je przesuwasz, transponujesz lub gdy tworzysz je 
      poprzez rysowanie.

Multiple Part Controls (Sterowanie wieloma częściami)
Edit Active Part Only (Edytuj tylko część aktywną)

       
      Ogranicza operacje edycyjne do aktywnej części.
List of Parts in Editor (Lista części w edytorze)

       
      Wyświetla listę wszystkich części wybranych po otwarciu edytora i umożliwia aktywację 
      części.

Indicate Transpositions (Wskaż transpozycje)
Indicate Transpositions

       
      Umożliwia wyświetlenie transponowanych wysokości nut MIDI.

Auto Select Controllers (Automatyczny wybór kontrolerów)
Auto Select Controllers 

       
      Automatycznie wybiera dane kontrolera wybranych nut MIDI.

Insert Velocity (Wstaw prędkość)
Note Insert Velocity (Wstaw prędkość nuty)

       
      Umożliwia określenie wartości dynamiki nowych nut.

Length Quantize (Kwantyzacja długości)
Length Quantize

       
      Umożliwia ustawienie wartości kwantyzacji długości zdarzeń.

Event Colors (Kolory zdarzeń)

915



Event Colors

       
      Umożliwia wybór kolorów zdarzeń.

Praca z edytorem lokalnym

● Aby powiększyć lub przewinąć In-Place Editor (Edytor lokalny), wskaż lewą część ekranu 
klawiatury fortepianu, tak aby wskaźnik zmienił się w dłoń. Następnie przeciągnij w prawo lub w 
lewo, aby powiększyć lub pomniejszyć w pionie, i przeciągnij w górę lub w dół, aby przewinąć 
edytor.

● Aby dodać lub usunąć ścieżki kontrolerów, kliknij prawym przyciskiem myszy poniżej pola 
   nazwy kontrolera i wybierz opcję z menu kontekstowego.
● Aby zamknąć In-Place Editor (Edytor lokalny) dla jednej ścieżki, kliknij opcję Edit In-Place  
   (Edytuj lokalnie) na liście ścieżek lub kliknij dwukrotnie poniżej wyświetlacza kontrolera w In-
   Place Editor.
● Aby otworzyć/zamknąć In-Place Editor dla jednej lub kilku wybranych ścieżek, użyj klawisza  
   Edit In-Place.
● Możesz przeciągać nuty z jednego In-Place Editor (edytora lokalnego) do drugiego.

UWAGA
Przycisk Snap (Przyciągania) i wyskakujące menu Snap Type (Typ przyciągania) na pasku 
narzędzi okna Project sterują przyciąganiem w In-Place Editor, ale siatka przyciągania jest 
ustawiana za pomocą wyskakującego menu Quantize (Kwantyzacja).
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Expression Maps (Mapy ekspresji)

Mapy ekspresji umożliwiają skonfigurowanie mapy dla wszystkich artykulacji. Umożliwia to 
odsłuchanie projektu łącznie z artykulacjami.

W Inspektorze możesz wybrać mapy ekspresji dla ścieżek MIDI lub ścieżek instrumentów oraz 
określić mapowanie dźwięku i charakterystykę wszystkich artykulacji.

Jeśli wybierzesz mapę ekspresji dla ścieżki MIDI lub ścieżki instrumentu, artykulacje zdefiniowane
na mapie zostaną automatycznie zastosowane podczas odtwarzania. Cubase rozpoznaje wyrażenia 
obliczone dla partii MIDI i przeszukuje sloty dźwiękowe na mapie ekspresji w poszukiwaniu 
brzmienia spełniającego zdefiniowane kryteria.

Po znalezieniu pasującego gniazda dźwiękowego bieżąca nuta jest modyfikowana albo informacje o
kanale MIDI, zmianie programu lub przełączeniu tonacji są wysyłane do instrumentu wybranego w 
wyskakującym menu Output Routing dla ścieżki, dzięki czemu można uzyskać inny dźwięk jest 
grany. Jeśli nie zostanie znaleziona żadne gniazdo dźwiękowe pasujące do artykulacji użytej w 
części, używane jest najbliższe dopasowanie.

Kiedy wprowadzasz artykulacje w partii MIDI, musisz skonfigurować mapę ekspresji w taki 
sposób, aby wyzwalane były odpowiednie dźwięki w podłączonym instrumencie VST lub MIDI.

Mapy ekspresji umożliwiają także łączenie artykulacji z klawiszami zdalnymi na urządzeniu 
wejściowym MIDI i mapowanie ich na dźwięki, które mogą być odtwarzane przez urządzenie MIDI
lub instrument VST. W ten sposób możesz wprowadzać nuty i artykulacje za pomocą zdalnego 
urządzenia MIDI i mieć je automatycznie nagrywane i poprawnie odtwarzane przez Cubase.

Mapy ekspresji są przydatne w następujących sytuacjach:

● Gdy chcesz wprowadzić artykulację muzyczną bezpośrednio w Key Editor (Edytor klawiszy),    
   Drum Editor (Edytor bębnów, perkusji), Score Editor (Edytor partytury) lub In-Place Editor 
   (Edytor lokalny), bez konieczności wcześniejszego nagrywania danych MIDI.
● Gdy chcesz odtwarzać/nagrywać muzykę w czasie rzeczywistym i kontrolować zmiany 
   artykulacji podczas odtwarzania.
● Kiedy otwierasz i edytujesz projekty innych użytkowników. Korzystając z map ekspresji, możesz
   szybko i łatwo mapować informacje o artykulacji do innego zestawu instrumentów lub zawartości
   biblioteki.
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Mapy ekspresji są dostępne dla ścieżek MIDI i instrumentów. Możesz tworzyć własne mapy 
ekspresji lub pobierać mapy ekspresji dla bibliotek orkiestrowych i instrumentów wirtualnych ze 
strony steinberg.net.

UWAGA
Możesz także użyć funkcji Note Expression (Ekspresja nuty), aby dodać artykulacje muzyczne 
bezpośrednio do nut MIDI w Key Editor.

POWIĄZANE LINKI
Artykulacje na stronie 907
Tworzenie i edytowanie map ekspresji na stronie 909
Grupy na stronie 911
Ekspresja nut na stronie 918

Artykulacje
Artykulacje muzyczne określają, w jaki sposób określone nuty są śpiewane lub wykonywane na 
danym instrumencie. Mogą także definiować względną głośność nut lub zmiany wysokości 
dźwięku pitch.

Dostępne są następujące typy artykulacji:
● Directions (Wskazówki)
   Wskazówki, takie jak pizzicato, obowiązują dla wszystkich nut, począwszy od pozycji 
   wstawienia, aż do pozycji wstawienia następnej wskazówki. Stosuje się je do ciągłego zakresu nut
   lub nawet całego utworu muzycznego.
● Attributes (Atrybuty)
   Atrybuty, takie jak akcenty lub staccato, obowiązują w przypadku pojedynczych nut.

Okno konfiguracji mapy ekspresji
Okno Expression Map Setup (Konfiguracja mapy ekspresji) umożliwia ładowanie, tworzenie i 
konfigurowanie map ekspresji.

Aby otworzyć okno Expression Map Setup, wykonaj jedną z następujących czynności:

● Wybierz opcję MIDI > Expression Map Setup (MIDI > Konfiguracja mapy ekspresji).
● W Inspektorze ścieżki MIDI lub instrumentu otwórz sekcję Expression Map i kliknij 
   Expression Map Setup.
UWAGA
Możesz także otworzyć sekcję Expression Map (Mapa ekspresji) w Inspektorze Key Editor 
Edytorze klawiszy), Drum Editor (Edytorze bębnów, perkusji) lub Score Editor (Edytorze 
partytury). 
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Dostępne są następujące sekcje:

Expression Maps (Mapy ekspresji)
   Umożliwia ładowanie, zapisywanie, dodawanie i usuwanie map wyrażeń. Załadowane lub dodane
   mapy wyrażeń są wyświetlane na liście Expression Maps (Mapy ekspresji).

Sound Slots (Gniazda dźwiękowe)
   Pokazuje gniazda dźwiękowe odpowiadające mapie ekspresji wybranej w sekcji Expression   
   Maps (Mapy ekspresji).
Output Mapping (Mapowanie wyjściowe)
   Pokazuje mapowanie wyjściowe odpowiadające gniazdu dźwiękowemu wybranemu w sekcji  
   Sound Slots (Gniazda dźwiękowe).
Articulations (Artykulacje)
   Umożliwia organizowanie artykulacji w grupy.
Remote Settings (Ustawienia zdalne)
   Umożliwia skonfigurowanie zdalnych klawiszy do wyzwalania artykulacji za pośrednictwem 
   urządzenia wejściowego MIDI. Tutaj możesz także określić, czy chcesz używać przełączników 
   klawiszowych lub komunikatów o zmianie programu do odtwarzania określonego gniazda 
   dźwiękowego.

POWIĄZANE LINKI
Mapy ekspresji na stronie 906
Dodawanie gniazd dźwiękowych na stronie 909
Sekcja Mapowanie wyjścia na stronie 911
Artykulacje na stronie 907
Sekcja Zdalne ustawienia na stronie 912

Mapy ekspresji w oknie projektu
Mapy ekspresji są dostępne w oknie Project, w Inspektorze ścieżek MIDI i instrumentów.
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1   Wskazuje, że w ścieżce używana jest mapa ekspresji.
2   Pokazuje, który klawisz pilota (zdalnego sterowania) jest wciśnięty.
3   Oznacza miejsce, które będzie odtwarzane. Pozwala to sprawdzić, czy podczas nagrywania 
     artykulacji za pomocą urządzenia zewnętrznego, takiego jak klawiatura MIDI, używane jest 
     właściwe gniazdo dźwiękowe.

Tworzenie i edytowanie map ekspresji

Tworzenie map ekspresji
Mapy ekspresji można tworzyć od podstaw

PROCEDURA
1. W Inspektorze ścieżki MIDI lub instrumentu otwórz sekcję Expression Map (Mapa ekspresji).
2. Kliknij opcję Expression Map Setup (Konfiguracja mapy ekspresji)

                
Zostanie otwarte okno Expression Map Setup.

3. W sekcji Expression Maps (Mapy ekspresji) kliknij opcję Add Map (Dodaj mapę), aby  
    utworzyć nową mapę.
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4. Opcjonalnie: Kliknij nazwę, aby wprowadzić niestandardową nazwę mapy ekspresji.

Dodawanie gniazd dźwiękowych
Musisz utworzyć gniazda dźwiękowe dla każdej artykulacji, którą chcesz dodać.

WARUNEK WSTĘPNY
Okno Expression Map Setup (Ustawienia mapy ekspresji) jest otwarte i w sekcji Expression 
Maps (Mapy ekspresji) wybrana jest mapa ekspresji.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
      ● W sekcji Sound Slots (Gniazda dźwiękowe) użyj pierwszego domyślnego gniazda 
         dźwiękowego, które jest dodawane automatycznie podczas tworzenia nowej mapy.

      ● Kliknij opcję Add Sound Slot (Dodaj gniazdo dźwiękowe), aby dodać nowe gniazdo 
         dźwiękowe.
2. Kliknij kolumnę artykulacyjną Art. 1 dla gniazda dźwiękowego i wybierz artykulację z menu.

UWAGA
Jeśli określona artykulacja nie jest dostępna w wyskakującym menu, wybierz opcję Add Custom 
Articulation (Dodaj niestandardową artykulację), aby zdefiniować własne artykulacje. Spowoduje 
to dodanie domyślnej artykulacji, którą możesz zdefiniować w sekcji Articulations (Artykulacje).

3. Opcjonalnie: Kliknij kolumnę Name (Nazwa) i wprowadź nazwę gniazda dźwiękowego.
    Nazwy gniazd dźwiękowych zostaną wyświetlone w Inspektorze ścieżki.
4. Opcjonalnie: Kliknij kolumny artykulacyjne Art. 2, art. 3 lub art. 4 dla gniazda dźwiękowego i 
    wybierz artykulację z menu.
    Pozwala to na utworzenie złożonej artykulacji, składającej się z kilku różnych pojedynczych 
    artykulacji dla gniazda dźwiękowego. Dla każdej nowej artykulacji dodawany jest dodatkowy 
    wpis w sekcji Articulations (Artykulacje).
5. Kliknij kolumnę Remote (Zdalne) dla gniazda dźwiękowego i określ klucz na urządzeniu 
    zewnętrznym, który uruchamia to gniazdo dźwiękowe.
6. Opcjonalnie: Kliknij kolumnę Col, aby przypisać kolor do gniazda dźwiękowego.
    Pracując w edytorach MIDI, możesz pokolorować swoje zdarzenia zgodnie z kolorem gniazd 
    dźwiękowych.
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WYNIK
Dodano gniazda dźwiękowe i dostępne są artykulacje. Możesz utworzyć tyle gniazd dźwiękowych, 
ile potrzebujesz.
Jeśli Cubase znajdzie gniazdo dźwiękowe, bieżąca nuta zostanie zmodyfikowana, na przykład 
zmniejszona o długość lub zagrana głośniej, albo też informacja o kanale MIDI, zmianie programu 
lub przełączeniu tonacji zostanie wysłana do podłączonego instrumentu (instrument wybrany w 
opcji Output Routing wyskakującego menu utworu), dzięki czemu odtwarzany jest inny dźwięk.
Jeśli nie zostanie znaleziona żadne gniazdo dźwiękowe pasujące do artykulacji użytej w części, 
zostanie użyte najbliższe dopasowanie.

POWIĄZANE LINKI
Mapy ekspresji w oknie projektu na stronie 908
Sekcja Ustawienia (pilota) zdalnego sterowania na stronie 912

Articulations Section (Sekcja artykulacji)
Możesz edytować artykulacje dodane do gniazd dźwiękowych w sekcji Articulations (Artykulacje)
w oknie Expression Map Setup (Ustawienia mapy ekspresji).

Dostępne są następujące ustawienia:

Art. (Artykulacja)
      Kliknij tę kolumnę, aby wybrać, czy chcesz wstawić artykulację jako symbol, czy ciąg 
      tekstowy. Jeśli wybierzesz Symbol, otworzy się okno dialogowe z dostępnymi symbolami. Jeśli
      wybierzesz opcję Text (Tekst), możesz bezpośrednio wprowadzić tekst.

Type (Typ)
      Kliknij tę kolumnę, aby określić, czy chcesz dodać atrybut, czy kierunek. Jeśli wybierzesz opcję
      Attribute (Atrybut), symbol artykulacji będzie miał wpływ tylko na pojedyncze nuty. Jeśli 
      wybierzesz Direction (Kierunek), symbol artykulacji będzie obowiązywać od pozycji 
      wstawienia aż do następnego rozpoczęcia artykulacji.

Description (Opis)
      Kliknij tę kolumnę, aby wprowadzić tekst, np. nazwę symbolu lub długą nazwę kierunku.

Group (Grupa)
      Kliknij tę kolumnę, aby posortować artykulacje w grupy i nadać im priorytet.

POWIĄZANE LINKI
Grupy na stronie 911

Groups (Grupy)
Grupy umożliwiają sortowanie artykulacji w celu ustalenia ich priorytetów i połączenia.

Same grupy są ekskluzywne. Artykuły należące do tej samej grupy nie mogą być używane razem. 
W tej samej grupie można umieszczać artykulacje, których nie można łączyć, np. arco (smyczek) i 
pizzicato ( szarpanie).

Grupy reprezentują znaczenie muzyczne, przy czym grupa 1 ma najwyższy priorytet. Jest to 
przydatne, jeśli mapa ekspresji nie znajdzie dokładnego dopasowania do danych i próbuje 
zidentyfikować dźwięk spełniający większość kryteriów. Jeśli w grupie 1 zostaną znalezione dwa 
dźwięki o tej samej artykulacji, preferowany będzie dźwięk, który również pasuje do grupy 2 itd.
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Sekcja Output Maping (mapowanie wyjścia)
Sekcja Outpuyt Maping umożliwia mapowanie gniazd dźwiękowych do określonych cech 
dźwiękowych instrumentu. Dostępne dźwięki zależą od instrumentu wybranego dla ścieżki MIDI 
lub instrumentu.
UWAGA
Niektóre instrumenty wirtualne wymagają wielu przełączników klawiszowych lub kombinacji 
przełączników klawiszowych i kontrolerów, aby wybrać konkretną artykulację. W takim przypadku
kliknij Add Slot (Dodaj miejsce), aby dodać wiele zdarzeń wyjściowych do jednego gniazda 
dźwiękowego. 

          
Możesz dokonać następujących ustawień dla gniazd:

Status
      Umożliwia określenie nuty, zmiany programu lub komunikatu kontrolera dla wybranego 
      gniazda dźwiękowego.
Data 1/Data 2 (Dane 1/Dane 2)
      Umożliwia określenie przełączników kluczowych dla wybranego gniazda dźwiękowego. 
      Umożliwia to przełączanie pomiędzy skrzypcami smyczkowymi a skrzypcami pizzicato lub 
      przełączanie na inny program zawierający inną artykulację.

Możesz także tworzyć ekspresje, edytując przychodzące dane MIDI:

Channel (Kanał)
      Umożliwia określenie kanału MIDI dla wybranego gniazda dźwiękowego. Dzięki temu możesz 
      przełączyć się na inny program.
Length (Długość)
      Umożliwia określenie długości nuty dla wybranego gniazda dźwiękowego. W ten sposób   
      możesz tworzyć dźwięki staccato lub tenuto.
Transpose (Transponuj)
      Umożliwia określenie wartości transpozycji dla wybranego gniazda dźwiękowego. W ten 
      sposób możesz wybrać różne artykulacje w niektórych bibliotekach sampli, w których różne 
      artykulacje znajdują się w różnych oktawach.
Velocity (Prędkość)
      Umożliwia określenie prędkości dla wybranego gniazda dźwiękowego. W ten sposób możesz 
      tworzyć akcenty.
Min. Pitch/Max. Pitch (Min. Poziom/maks. Poziom)
      Umożliwia określenie minimalnej i maksymalnej wysokości dźwięku dla wybranego gniazda 
      dźwiękowego.
Min. Velocity/Max. Velocity (Min. Prędkość/maks. Prędkość)
      Pozwala określić minimalną i maksymalną prędkość dla wybranego slotu dźwiękowego, aby 
      mieć pewność, że użyta zostanie próbka odwzorowana w określonym zakresie. W ten sposób 
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      możesz używać instrumentów o różnych zakresach dynamiki na tym samym klawiszu.

Sekcja Remote Settings (Ustawień zdalnych)
Ustawienia zdalne umożliwiają określenie przełączników klawiszowych lub komunikatów o 
zmianie programu w celu uruchomienia określonych gniazd dźwiękowych.
UWAGA
Jeśli nie planujesz nagrywania ani wyzwalania artykulacji za pośrednictwem urządzenia 
wejściowego MIDI, nie musisz określać klawiszy zdalnych.

Aktywne klawisze zdalne są wskazywane w Inspektorze ścieżki.

              

Key Switches/Program Change Messages pop-up menu (Wyskakujące menu Przełączniki 
klawiszowe/Komunikaty o zmianie programu)
      Umożliwia wybór, czy chcesz używać przełączników klawiszowych, czy komunikatów o 
      zmianie programu do przełączania gniazd dźwiękowych.
UWAGA
Jeśli używasz przełączników klawiszowych, klawisze te służą do wstawiania artykulacji zamiast 
nut.

Latch Mode (Tryb zatrzaskowy)
      Jeśli ta opcja jest włączona, klawisz, który naciśniesz na urządzeniu wejściowym MIDI, będzie 
      ważny do momentu naciśnięcia następnego klawisza. Jeśli ta opcja jest wyłączona, klawisz jest 
      ważny tak długo, jak długo go przytrzymujesz. Kiedy go zwolnisz, odtwarzane jest pierwsze 
      gniazdo  dźwiękowe.

WAŻNE
Latch Mode (Tryb zatrzaskowy) można aktywować/dezaktywować wyłącznie globalnie, a nie w 
przypadku pojedynczej mapy ekspresji.

Root Note (Nuta korzeń)
      Umożliwia określenie pierwszego klawisza na urządzeniu zewnętrznym, którego chcesz używać
      jako klucza zdalnego. Pozwala to na automatyczne dostosowanie istniejących przypisań 
      klawiszy zdalnych do własnych potrzeb, na przykład w przypadku korzystania z klawiatury 
      MIDI z bardzo szerokim lub bardzo wąskim zakresem klawiszy.
Set Remote Keys (Ustaw klawisze zdalne)
      Umożliwia automatyczne przypisanie zakresu klawiszy urządzenia zewnętrznego do gniazd 
      dźwiękowych na mapie ekspresji.

POWIĄZANE LINKI
Mapy ekspresji w oknie projektu na stronie 908
Okno dialogowe Set Remote Keys (Ustaw klawisze zdalne) na stronie 913

Okno dialogowe Set Remote Keys (Ustaw klawisze zdalne)
Okno dialogowe Set Remote Keys umożliwia przypisanie zakresu klawiszy na urządzeniu 
zewnętrznym do gniazd dźwiękowych na mapie ekspresji
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● Aby otworzyć okno dialogowe Set Remote Keys, kliknij przycisk Set Remote Keys w oknie 
dialogowym Expression Map Setup (Ustawienia mapy ekspresji).

            

Dostępne są następujące opcje:
Start Key (Klawisz startowy)
      Umożliwia określenie pierwszego klawisza w urządzeniu wejściowym MIDI, który ma 
      uruchamiać gniazdo dźwiękowe.
Key Mapping (Mapowanie klawiszy)
      Umożliwia określenie, za pomocą których klawiszy urządzenia chcesz uruchamiać gniazda 
      dźwiękowe.

Wyodrębnianie map ekspresji z instrumentów VST
Można wyodrębnić informacje o mapowaniu z instrumentów VST 3 i przekonwertować je na nową 
mapę ekspresji. W ten sposób możesz skonfigurować mapy ekspresji dla instrumentów, z którymi 
często pracujesz.

PROCEDURA
1. Załaduj instrument VST, którego chcesz używać i przypisz go do ścieżki MIDI lub instrumentu.
2. Załaduj preset instrumentu zawierający przełączniki klawiszowe.
    W skład Cubase wchodzi kilka presetów ścieżek, które są wstępnie skonfigurowane do użytku 
    z mapami ekspresji. Zawierają dźwięki wykorzystujące przełączniki klawiszowe i mające różną 
    artykulację. Te ustawienia wstępne mają przyrostek VX.
3. W Inspektorze ścieżki MIDI lub instrumentu otwórz sekcję Expression Map (Mapa ekspresji).
4. Kliknij opcję Expression Map Setup (Konfiguracja mapy ekspresji).

Zostanie otwarte okno Expression Map Setup (Konfiguracja mapy ekspresji).

5. Wprowadź zmiany, wprowadź nazwę mapy i kliknij Save (Zapisz).
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WYNIK
Mapa ekspresji zostanie zapisana i możesz ją wybrać w sekcji Expression Map (Mapa ekspresji) 
w Inspector inspektorze Key Editor (Edytora klawiszowego), Drum Editor (Edytora 
perkusyjnego) lub Score Editor (Edytora partytury).

POWIĄZANE LINKI
Tworzenie map ekspresji na stronie 909
Ustawienia wstępne ścieżki na stronie 192

Zapisywanie map ekspresji
Jeśli utworzyłeś i skonfigurowałeś mapę ekspresji, musisz ją zapisać.

PROCEDURA
1. W oknie Expression Maps Setup (Konfiguracja map ekspresji) wybierz mapę ekspresji w sekcji
Expression Maps (Mapy ekspresji).
2. Kliknij Save (Zapisz).
3. W oknie dialogowym pliku określ nazwę pliku i lokalizację mapy wyrażeń, a następnie kliknij 
Save

WYNIK
Mapa ekspresji została zapisana.

Ładowanie map ekspresji

PROCEDURA
1. W Inspektorze ścieżki MIDI lub instrumentu otwórz sekcję Expression Map (Mapa ekspresji).
2. Kliknij opcję Expression Map Setup (Konfiguracja mapy ekspresji).
    Zostanie otwarte okno Expression Map Setup.
3. W sekcji Expression Maps (Mapy ekspresji) po lewej stronie kliknij opcję Load (Załaduj).

4. W oknie dialogowym pliku znajdź i wybierz mapę ekspresji, którą chcesz załadować, a następnie
    kliknij Open (Otwórz).
    Mapa wyrażeń jest teraz dostępna w sekcji Expression Maps (Mapy ekspresji).
5. Powtórz kroki dla wszystkich map, które chcesz udostępnić, i zamknij okno dialogowe.

WYNIK
Wszystkie załadowane mapy są dostępne w wyskakującym menu Expression Map w Inspektorze 
Key Editor (Edytora tonacji, klawiszy), Drum Editor (Edytorze bębnów, perkusji) lub Score 
Editor (edytorze partytury).

POWIĄZANE LINKI
Tworzenie i edytowanie map ekspresji na stronie 909

Wstawianie artykulacji

Wstawianie artykulacji na pasach kontrolera
Możesz wstawiać symbole artykulacji na pasku kontrolera Key Editor (Edytora tonacji, klawiszy), 
Drum Editor (Edytora bębnów, perkusji) i In-Place Editor (Edytora lokalnego).

PROCEDURA
1. Wybierz partię MIDI.
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2. Otwórz Key Editor, Drum Editor lub In-Place Editor.
3. Na wyświetlaczu sterownika otwórz menu podręczne Controller Selection and Functions   
    (Wybór kontrolera i funkcji) i wybierz opcję Articulations/Dynamics (Artykulacje/Dynamika).
    Wszystkie artykulacje określone dla wybranej mapy wyrażeń są wyświetlane w różnych 
    wierszach na pasku kontrolera. Różne grupy oddzielone są liniami, a wyrażenia należące do tej 
    samej grupy są pokazane tym samym kolorem.
4. Wybierz narzędzie Draw (Rysuj) i na wyświetlaczu kontrolera kliknij dokładną pozycję 
    pierwszej nuty, do której chcesz zastosować tę artykulację.
    Początki nut są wyświetlane na wyświetlaczu sterownika w postaci pionowych linii.

WYNIK
Atrybut na pasku kontrolera jest teraz automatycznie łączony z odpowiednią nutą.

UWAGA
Jeśli usuniesz atrybut poprzez wybranie go i naciśnięcie klawisza Delete lub Backspace, nuta 
również zostanie usunięta. Jeśli nie tego chcesz, usuń zaznaczenie artykulacji w polu Articulations 
(Artykulacje) w wierszu informacyjnym.

WAŻNE
Podczas wstawiania symboli artykulacji należy upewnić się, że nie kolidują one z innymi 
artykulacjami.

POWIĄZANE LINKI
Wstawianie artykulacji poprzez linię informacyjną na stronie 916

Wstawianie artykulacji w Score Editor (Edytorze partytury)
Możesz wstawiać symbole artykulacji w Score Editor (Edytorze partytury)

PROCEDURA
1. Wybierz partię MIDI.
2. Wybierz Scores > Open Score Editor (Wyniki > Otwórz edytor partytury).
3. W zakładce Symbols (Symbole) w Inspektorze otwórz sekcję Expression Map (Mapa 
    ekspresji).
4. Aktywuj symbol artykulacji i kliknij żądaną pozycję na wyświetlaczu nut.

WAŻNE
Podczas wstawiania symboli artykulacji należy upewnić się, że nie kolidują one z innymi 
artykulacjami.

WYNIK
Symbole artykulacji wstawione na wyświetlaczu nut są pokazywane w innym kolorze, dzięki 
czemu można je odróżnić od innych symboli partytury.

UWAGA
Możesz przeglądać i zmieniać kolory w oknie dialogowym Preferences (Preferencje) (Scores–
Colors for Additional Meanings page) (Wyniki – strona (Kolory dla dodatkowych znaczeń)).
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Aby usunąć symbol artykulacji, zaznacz go i naciśnij klawisz Delete lub Backspace.

Wstawianie artykulacji poprzez linię informacyjną
Możesz wstawiać symbole artykulacji za pomocą linii informacyjnej Key Editor (edytora tonacji), 
Drum Editor (edytora perkusji) i Score Editor (edytora partytury).

PROCEDURA
1. Wybierz nutę MIDI na ekranie zdarzeń w Key Editor, Drum Editor lub Score Editor.
2. W wierszu informacyjnym kliknij Articulations (Artykulacje), aby otworzyć menu podręczne   
    zawierające wszystkie atrybuty nut dostępne na mapie ekspresji, a następnie wybierz żądany 
    atrybut.

WYNIK
Nazwa aktywnego atrybutu jest teraz wyświetlana w polu Articulations (Artykulacje).

UWAGA
Jeśli chcesz usunąć atrybut, odznacz artykulację w polu Articulations w linii informacyjnej.

WAŻNE
Podczas wstawiania symboli artykulacji należy upewnić się, że nie kolidują one z innymi 
artykulacjami.

POWIĄZANE LINKI
Grupy na stronie 911

Wstawianie artykulacji w List Editor (Edytorze listy)
Symbole artykulacji można wstawiać za pomocą kolumny komentarzy w List Editor (Edytorze 
listy). Działa to tylko wtedy, gdy partia MIDI zawiera już pewne symbole artykulacji.

PROCEDURA
1. Wybierz nutę MIDI na ekranie zdarzeń List Editor.
2. Kliknij kolumnę Comment (Komentarz), aby otworzyć menu podręczne zawierające wszystkie 
    atrybuty nuty dostępne na mapie ekspresji, a następnie wybierz żądany atrybut.

WYNIK
Nazwa aktywnego atrybutu jest teraz wyświetlana w kolumnie Comment.

UWAGA
Jeśli chcesz usunąć atrybut, odznacz artykulację w kolumnie Comment.

WAŻNE
Podczas wstawiania symboli artykulacji należy upewnić się, że nie kolidują one z innymi 
artykulacjami.
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Note Expression (Ekspresja nuty)
Note Expression umożliwia edycję nut MIDI i ich ekspresji jako jednej jednostki.

Note Expression umożliwia powiązanie zdarzeń wyrażeń z nutami MIDI, dzięki czemu są one 
traktowane jako całość. Kiedy kwantyzujesz, przenosisz, kopiujesz, duplikujesz lub usuwasz nuty 
MIDI, pojawiają się wszystkie powiązane z nimi informacje o kontrolerze. Pozwala to na intuicyjną
i dokładną edycję danych związanych z nutami.

Przez zdarzenia ekspresji rozumiemy następujące zdarzenia: MIDI Control Change, MIDI 
Pitchbend, MIDI Aftertouch, MIDI Poly Pressure i VST Note Expression.

Krzywe zdarzeń ekspresji są wyświetlane jako nakładka odpowiednich nut MIDI na ekranie 
zdarzeń. Wszystkie zdarzenia ekspresji dla nuty MIDI są wyświetlane jednocześnie.
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Aby móc odtwarzać i nagrywać zdarzenia ekspresji dla nut MIDI, należy użyć urządzenia 
kontrolera wejściowego obsługującego ekspresję nut, takiego jak klawiatury lub gitary zgodne z 
MPE. Jeśli nie masz takiego kontrolera wejściowego, możesz zamiast tego przypisać komunikaty 
MIDI do ekspresji.

Aby móc poprawnie słyszeć występy polifoniczne wykorzystujące zdarzenia ekspresji, należy użyć 
urządzenia sterującego wyjściem obsługującego ekspresję nut, takiego jak instrumenty 
kompatybilne z MPE lub instrumenty VST kompatybilne z ekspresją nutową VST. Jeśli nie masz 
takiego urządzenia, musisz skonfigurować swój instrument MIDI tak, aby odtwarzał ten sam 
dźwięk na wszystkich kanałach MIDI.

POWIĄZANE LINKI
VST Note Expressions (Ekspresje nut VST) na stronie 919
Kontrolery MIDI na stronie 920
Urządzenia wejściowe MIDI obsługujące MPE na stronie 920

VST Note Expressions (Ekspresje nut VST)
Ekspresje nutowe VST są specyficzne dla nut. Nadają się do kontekstów polifonicznych, ponieważ 
umożliwiają edycję ekspresji każdej pojedynczej nuty akordu.

Ekspresje nutowe VST są dostarczane przez instrumenty VST. Aby móc pracować z ekspresjami 
nutowymi VST, potrzebny jest instrument VST, który je obsługuje, taki jak HALion Sonic SE.

To, które ekspresje nutowe VST są dostępne, zależy od instrumentu.
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Ekspresje nutowe VST dopuszczają zakres wartości przekraczający zakres MIDI od 0 do 127.

Możesz używać wszystkich kanałów MIDI do oddzielania różnych dźwięków.

UWAGA
Aby używać ekspresji nutowych VST do sterowania pojedynczymi nutami, należy ustawić kanał 
MIDI ścieżki na wartość z zakresu od 1 do 16.

POWIĄZANE LINKI
Instrumenty VST kompatybilne z VST 3 na stronie 919

Instrumenty VST kompatybilne z VST 3
Instrumenty VST kompatybilne z VST 3, które obsługują ekspresję nut VST, mogą być używane z 
ekspresją nut w Cubase.

Cubase jest dostarczany z wieloma instrumentami VST kompatybilnymi z VST 3, takimi jak 
HALion Sonic SE, Retrologue lub Padshop, które zawierają kilka presetów.

W zależności od ustawienia wstępnego Cubase obsługuje określone ekspresje nutowe VST, takie 
jak strojenie (Tuning), głośność (Volume) i panorama (Pan).

UWAGA
Retrologue i Padshop zawierają dźwięki stworzone specjalnie do użytku z MPE. Do użycia z 
ekspresją nutową można także użyć gotowych dźwięków w HALion Sonic SE

Szczegółowe informacje na temat Retrologue i Padshop oraz ich parametrów można znaleźć w 
osobnym dokumencie Plug-in Reference (Informacje o wtyczkach).

Szczegółowe informacje na temat HALion Sonic SE i jego parametrów znajdują się w osobnym 
dokumencie HALion Sonic SE.

POWIĄZANE LINKI
Ładowanie ustawień wstępnych instrumentu MPE na stronie 924

Kontrolery MIDI
Kontrolery MIDI są specyficzne dla kanału, z wyjątkiem komunikatów poly pressure. Wpływają na
cały głos, niezależnie od tego, czy są wstawiane dla partii, czy nuty.

Fakt, że kontrolery MIDI są specyficzne dla kanału, ogranicza potencjał ekspresji nut do występów 
monofonicznych (solowych). Jeśli edytujesz dane artykulacyjne jednej nuty, ma to wpływ na 
wszystkie pozostałe nuty tego samego głosu, czyli każdą inną nutę odtwarzaną w tym samym czasie
na tym samym kanale.

Jednak wraz z wprowadzeniem standardu MPE można przypisać każdą nutę do innego kanału 
MIDI i w ten sposób sterować nutami indywidualnie. Standard zaleca używanie wyłącznie 
komunikatów kanału MIDI Pitchbend, Aftertouch i CC74 do kontrolowania poszczególnych nut. W
tym scenariuszu kanał MIDI 1 steruje wszystkimi nutami, podczas gdy pozostałych 15 kanałów 
MIDI może sterować pojedynczymi nutami.
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UWAGA
Aby używać kontrolerów MIDI do kontrolowania poszczególnych nut, należy ustawić kanał MIDI 
ścieżki na Any (Każdy).

POWIĄZANE LINKI
Urządzenia wejściowe MIDI obsługujące MPE na stronie 920
Wyświetlacz kontrolera na stronie 812
Nagrywanie komunikatów o zmianie sterowania MIDI jako danych ekspresji nutowych na stronie 
940
Konwertowanie komunikatów zmiany sterowania MIDI na dane ekspresji nutowych na stronie 941

Urządzenia wejściowe MIDI obsługujące MPE
MPE oznacza ekspresję polifoniczną MIDI. Niektóre urządzenia MIDI obsługują format MPE. To 
wielowymiarowe kontrolery MIDI, które pozwalają zmieniać wysokość i barwę poszczególnych 
nut podczas gry polifonicznej.

W MPE każda nuta ma przypisany własny kanał MIDI. Umożliwia to zastosowanie komunikatów 
ekspresji do poszczególnych nut.

Aby móc pracować z funkcjami MPE w Cubase, czyli polifonicznie odtwarzać i nagrywać 
ekspresje, potrzebujesz odpowiedniego urządzenia wejściowego MPE. Niektóre urządzenia 
wejściowe MPE są wykrywane i konfigurowane automatycznie.

Strona urządzenia wejściowego Note Expression (Ekspresji nuty)
Strona Note Expression Input Device (Urządzenie wejściowe Note Expression) przedstawia 
ustawienia podłączonego urządzenia wejściowego.
● Aby otworzyć stronę urządzenia wejściowego do wyrażania nut, wybierz Studio > Studio Setup 
(Studio > Konfiguracja studia) i wybierz je z listy Devices (Urządzenia). Jeśli Twojego urządzenia 
nie ma na liście, kliknij Add (Dodaj) i wybierz Note Expression Input Device (Urządzenie 
wejściowe wyrażenia nutowego).

UWAGA
Cubase automatycznie rozpoznaje niektóre obsługiwane urządzenia wejściowe do ekspresji nut 
i udostępnia określone strony ze wstępnie ustawionymi ustawieniami w oknie dialogowym Studio 
Setup (Ustawienia Studio). Jeśli Twoje urządzenie ma oryginalne ustawienia fabryczne, nie musisz 
nic zmieniać w tym oknie dialogowym. W niektórych przypadkach może być konieczne ustawienie 
urządzenia w odpowiednim trybie. Tryb ten jest często nazywany trybem MPE.
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Cubase umożliwia polifoniczne przechwytywanie trzech wymiarów ruchów wejściowych. Strona 
Note Expression Input Device (Urządzenia wejściowego ekspresji nut) zawiera sekcje Pressure 
(Nacisk), Horizontal/X (Poziomo/X) i Vertical/Y (Pionowo/Y), które umożliwiają przeglądanie 
i w razie potrzeby, edycję, które komunikaty MIDI są używane w tych trzech wymiarach 
sterowania.

Dostępne są następujące opcje:
MIDI Input (Wejście MIDI)
      Umożliwia wybór portu wejściowego MIDI, do którego podłączone jest urządzenie wejściowe.
 
W sekcji Pressure (Nacisk) dostępne są następujące opcje:
MIDI Message (Komunikat MIDI)
      Umożliwia przypisanie komunikatu MIDI do ruchu wejściowego Pressure na urządzeniu 
wejściowym do ekspresji nut. Domyślne przypisanie to Aftertouch (Dotyk).
VST Note Expression Assignment (Przypisanie ekspresji nuty VST)
      Pokazuje przypisanie ruchów wejściowych MPE do ekspresji nutowych VST.

W sekcji Horizontal/X (Poziomo/X) dostępne są następujące opcje:
MIDI Message (Komunikat MIDI)
      Umożliwia przypisanie komunikatu MIDI do ruchu wejściowego Horizontal/X na urządzeniu 
      wejściowym do ekspresji nut. Domyślnym przypisaniem jest Pitchbend.
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Send Initial Value (Wyślij wartość początkową)
      Umożliwia przesłanie pozycji początkowej ruchu wejściowego do Cubase.
      ● Off (Wyłączone)
         Przesyła pozycję absolutną. Odpowiada to następującym wartościom początkowym:
          Absolutne: włączone (Sensel Morph), względne: wyłączone (LinnStrument).
      ● Center (64) (Centrum (64))
         Najpierw przesyła wartość środkową. Ruchy wejściowe powodują zwiększenie lub 
         zmniejszenie wartości. Odpowiada to następującym wartościom początkowym: Absolutne: 
         Off (Sensel Morph), Względne: On (LinnStrument).
Use for Tuning (Użyj do strojenia)
      Aktywuj tę opcję dla bezprogowych urządzeń wejściowych do ekspresji nut, które umożliwiają 
      płynne przejście z dowolnej wysokości do dowolnej innej wysokości bez przerywania dźwięku.

UWAGA
Jeśli aktywujesz opcję Use for Tuning, to VST Note Expression Assignment zostanie 
automatycznie ustawione na Tuning (Strojenie).

Dezaktywuj tę opcję w przypadku urządzeń, które nie obsługują przesuwania, ale zamiast tego 
tworzą nowe nuty dla każdego klawisza.

Pitch Range (Zakres poziomu, wysokości tonu)
      Umożliwia określenie zakresu wysokości dźwięku urządzenia wejściowego. Jeżeli przesuniesz 
      się z jednego tonu na drugi, zwolnij klawisz i wciśnij go ponownie w tej samej pozycji i tonacji,
      zakres pitchu zostanie ustawiony prawidłowo.
      Kilkakrotne naciśnięcie określonej nuty zawsze odtwarza tę samą wysokość.
VST Note Expression Assignment (Przypisanie ekspresji nuty VST)
      Pokazuje przypisanie ruchów wejściowych MPE do ekspresji nutowych VST.

W sekcji Vertical/Y (Pionowo/Y) dostępne są następujące opcje:
MIDI Message (Komunikat MIDI)
      Umożliwia przypisanie komunikatu MIDI do ruchu wejściowego Vertical/Y na urządzeniu 
      wejściowym do ekspresji nut. Domyślne przypisanie to CC74 (Brightness) (CC74 (Jasność)).
Send Initial Value (Wyślij wartość początkową)
      Umożliwia przesłanie pozycji początkowej ruchu wejściowego do Cubase.
      ● Off (Wyłączone)
         Przesyła pozycję absolutną. Odpowiada to następującym wartościom początkowym:
         Absolute (Absolutny) (blok Seaboard), Absolute: włączony (Sensel Morph), Relative      
         (względny): wyłączony (LinnStrument).
      ● Min. (0)
         Najpierw przesyła wartość minimalną. Ruchy wejściowe powodują wzrost wartości.
         Odpowiada to następującym wartościom początkowym: Względny jednobiegunowy   
         (Seaboard Block (blok nadmorski)).
      ● Center (64) (Centrum (64))
         Najpierw przesyła wartość środkową. Ruchy wejściowe powodują zwiększenie lub 
         zmniejszenie wartości. Odpowiada to następującym wartościom początkowym: Relative 
         Bipolar (Względny dwubiegunowy) (Seaboard Block), Absolute: Off (wyłączony) (Sensel 
         Morph), Relative (Względny): włączony (LinnStrument).
      ● Maks. (127)
         Najpierw przesyła wartość maksymalną. Ruchy wejściowe powodują zmniejszenie wartości.
VST Note Expression Assignment (Przypisanie ekspresji nuty VST)
      Pokazuje przypisanie ruchów wejściowych MPE do ekspresji nutowych VST.
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W sekcji MIDI Channels (Kanały MIDI) dostępne są następujące opcje:
Multi-Channel Input Mode (Tryb wejścia wielokanałowego)
      Umożliwia wybór trybu wejścia wielokanałowego. Dostępne są następujące opcje:
      ● MPE Mode (Tryb MPE)
         Aktywuje tryb MPE i ustawia kanał 1 jako kanał podstawowy.
      ● Channel Rotation (Obrót kanałów)
         Aktywuje rotację kanałów i przypisuje poszczególne kanały MIDI do przychodzących nut 
         MIDI i ich komunikatów kontrolera. Umożliwia to polifonię 16-głosową. Aby to zadziałało, 
         kontroler wejściowy musi obsługiwać rotację kanałów.
Used Channels (Używane kanały)
      Umożliwia skonfigurowanie liczby kanałów, których chcesz używać do notatek.
First Channel (Pierwszy kanał)
      Dostępne tylko w trybie Channel Rotation (Rotacji kanałów). Umożliwia to ustawienie 
      pierwszego kanału dla rotacji kanałów.
MIDI Activity display (Wyświetlanie aktywności MIDI)
      Umożliwia monitorowanie przychodzących komunikatów MIDI.

POWIĄZANE LINKI
Przypisania ekspresji nut VST na stronie 923

Przypisania ekspresji nut VST
Sekcja VST Note Expression Assignments (Przypisania ekspresji nutowych VST) przedstawia 
przypisanie przesunięć wejściowych urządzenia wejściowego ekspresji nutowych do wyrażeń 
nutowych VST.

Przypisania są wstępnie zdefiniowane dla wszystkich obsługiwanych urządzeń wejściowych 
ekspresji nutowych, które mają określoną stronę w oknie dialogowym Studio Setup (Ustawienia 
programu Studio). Możesz zmienić te przypisania ręcznie.

UWAGA
Przypisanie zostaje odnowione po przełączeniu instrumentu lub jednego z jego ustawień wstępnych.

● Aby otworzyć stronę urządzenia wejściowego dla ekspresji nut, wybierz Studio > Studio Setup 
(Studio > Konfiguracja studia) i wybierz je z listy Devices (Urządzenia). Jeśli Twojego urządzenia 
nie ma na liście, kliknij Add (Dodaj) i wybierz Note Expression Input Device (Urządzenie 
wejściowe typu Note Expression).

              

Następujące opcje są dostępne w ramach przypisań preferowanych i alternatywnych:

Expression Name Contains (Nazwa ekspresji zawiera)
      Umożliwia przypisanie wszystkich ekspresji nutowych do przemieszczenia wejściowego, 
      którego nazwa zawiera tekst określony w polu po prawej stronie.
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Note Expression Number (Numer ekspresji nuty)
      Umożliwia przypisanie wszystkich ekspresji nutowych do przemieszczenia wejściowego,   
      którego numer odpowiada numerowi podanemu w polu po prawej stronie.
As Recommended by Instrument (Zgodnie z zaleceniami instrumentu)
      Automatycznie przypisuje wszystkie ekspresje nutowe do przemieszczeń wejściowych zgodnie 
      z zaleceniami instrumentu, jeśli są dostępne.
Volume (Głośność)
      Przypisuje ekspresję nutową Volume do przemieszczenia wejściowego.
Pan (Panorama)
      Przypisuje ekspresję nutową Pan do przemieszczenia wejściowego.
Tuning (Strojenie)
      Przypisuje ekspresję nutową Tuning do przemieszczenia wejściowego.
MIDI PolyPressure
      Przypisuje ekspresję nutową MIDI PolyPressure do przemieszczenia wejściowego.
None (Nic)
      Nie przypisuje żadnej ekspresji nutowej.

POWIĄZANE LINKI
Strona urządzenia wejściowego ekspresji nuty na stronie 920.

Ładowanie ustawień wstępnych instrumentu MPE
Możesz załadować gotowe dźwięki MPE dla Retrologue i Padshop.

PROCEDURA
1. W stojaku Media w prawej strefie kliknij kafelek VST Instruments.
2. Wykonaj jedną z następujących czynności:
      ● Kliknij kafelek Padshop, a następnie kliknij MPE Padshop.
      ● Kliknij kafelek Retrolog, a następnie kliknij Retrolog MPE.
      Wyświetlone zostaną ustawienia wstępne instrumentu MPE.
3. Wykonaj jedną z następujących czynności:
      ● Przeciągnij preset instrumentu na listę ścieżek, aby utworzyć nową ścieżkę instrumentu z 
         załadowanym presetem instrumentu.
      ● Przeciągnij preset instrumentu na ekran zdarzeń, aby utworzyć nową ścieżkę instrumentu z 
         załadowanym presetem instrumentu.
      ● Przeciągnij ustawienie wstępne instrumentu na ścieżkę instrumentu, aby zastosować 
         ustawienie wstępne do ścieżki.

WYNIK
Instrument zostanie załadowany, a ustawienie wstępne MPE zostanie zastosowane do ścieżki 
instrumentu.

Sekcja Note Expression Inspector (Inspektora ekspresji nutowych)
Sekcja Note Expression Inspector (Inspektora ekspresji nutowych) zawiera większość funkcji 
potrzebnych do pracy z ekspresjami nutowymi.

● Aby otworzyć sekcję Note Expression, wybierz ścieżkę MIDI lub instrumentu i kliknij Note 
   Expression w Inspektorze.
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Dostępne są następujące sekcje:

1   Section header/Bypass button (Przycisk nagłówka sekcji/pominięcia)
     Pokazuje nazwę sekcji. Przycisk obejścia umożliwia pominięcie wszystkich danych dotyczących
     ekspresji nut w ścieżce.
2   Expression section (Sekcja ekspresji)
     Wyświetla listę dostępnych ekspresji nut VST, kontrolerów MIDI, pitchbend, aftertouch i 
     polipressure.
3   Parameter Details section (Sekcja szczegółów parametrów)
     Umożliwia dokonanie ustawień wyrażenia wybranego w sekcji wyrażeń.
4   Global section (Sekcja globalna)
     Umożliwia dokonanie ustawień globalnych

POWIĄZANE LINKI
Sekcja ekspresji na stronie 925
Sekcja szczegółów parametrów na stronie 926
Sekcja globalna na stronie 927

Sekcja Expression (Ekspresji)
Sekcja ekspresji pokazuje ekspresje nutowe VST i kontrolery MIDI. To, które ekspresje nutowe 
VST są dostępne, zależy od używanego instrumentu. To, które komunikaty o zmianie sterowania 
MIDI są dostępne, zależy od ustawień w oknie dialogowym MIDI Controller Setup (Konfiguracja
kontrolera MIDI).

Sekcja ekspresji jest dostępna w sekcji Note Expression (Ekspresja nutowa) w Inspektorze.
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● Aby otworzyć sekcję Note Expression, wybierz ścieżkę MIDI lub instrumentu i kliknij Note    
   Expression w Inspektorze.

                   

Dostępne są następujące sekcje i funkcje:
1   Visibility (Widoczność)
     Pokazuje/ukrywa ekspresję w edytorze zdarzeń ekspresji nutowych i na wyświetlaczu zdarzeń.
2   In (Informacja)
     Pokazuje skrót komunikatu o zmianie sterowania MIDI lub przemieszczenie wejściowe  
     odwzorowane na ekspresję do nagrywania.
3   VST note expressions (Ekspresje nutowe VST)
     Wyświetla dostępne ekspresje nutowe VST.
4   MIDI controllers (Kontrolery MIDI)
     Wyświetla listę dostępnych kontrolerów MIDI.

POWIĄZANE LINKI
Okno dialogowe konfiguracji kontrolera MIDI na stronie 819

Sekcja Parameter Details (Szczegółów parametrów)
W tej sekcji możesz dokonać ustawień dla ekspresji wybranej w sekcji ekspresji, na przykład 
skonfigurować przypisanie danych wejściowych.

Szczegóły parametrów są dostępne w sekcji Note Expression (Ekspresja nutowa) w Inspektorze.

● Aby otworzyć sekcję Note Expression, wybierz ścieżkę MIDI lub instrumentu i kliknij Note   
   Expression w Inspektorze.

                             

Parameter Color (Kolor parametru)
      Umożliwia określenie koloru wybranej ekspresji.
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Input (Wejście)
      Umożliwia określenie przypisania danych wejściowych dla wybranej ekspresji.
MIDI Learn (Nauka MIDI)
      Kliknij ten przycisk i przesuń suwak lub pokrętło na zewnętrznym kontrolerze MIDI, aby 
      przypisać do niego wybraną ekspresję.
Max. Value/Min. Value (Maks. Wartość/min. Wartość)
      Umożliwia określenie zakresu wartości używanego dla wybranej ekspresji.

Sekcja Global (Globalna)
Ustawienia w sekcji Global mają zastosowanie do wszystkich ekspresji w sekcji ekspresji.

Sekcja Global jest dostępna w sekcji Note Expression (Ekspresja nutowa) w Inspektorze.

● Aby otworzyć sekcję Note Expression, wybierz ścieżkę MIDI lub instrumentu i kliknij Note 
   Expression w Inspektorze.

                        

Record MIDI as Note Exp. (Nagraj MIDI jako Note Expression)
      Aktywuj tę opcję, aby rejestrować zdarzenia kontrolera MIDI jako dane ekspresji nutowych.
Overdub Note Exp. (Dogrywanie Note Expression)
      Aktywuj tę opcję, aby dograć istniejące dane ekspresji nutowych.
Latch Buffer (Bufor zatrzaskowy)
      Umożliwia włączenie/wyłączenie bufora zatrzaskowego używanego podczas nagrywania z 
      dogrywaniem.
Show Additional Functions (Pokaż dodatkowe funkcje)
      Pokazuje dodatkowe funkcje.
●   Show only used Expressions (Pokaż tylko używane ekspresje)
     Pokazuje tylko wyrażenia na liście, dla których istnieją dane. Są one oznaczone gwiazdką (*) 
     przed nazwą ekspresji.
●   Make all Expressions visible (Spraw, aby wszystkie ekspresje były widoczne)
     Pokazuje wszystkie dostępne ekspresje na ekranie zdarzeń.
●   Make only edited Expression visible (Wyświetlaj tylko edytowaną ekspresję)
     Pokazuje tylko wybraną ekspresję na ekranie zdarzeń.
●   Load Input Assignment (Załaduj przypisanie wejścia)
     Umożliwia wczytanie gotowych ustawień mapowania.
●   Save Input Assignment (Zapisz przypisanie wejścia)
     Umożliwia zapisanie gotowych ustawień mapowania.
●   MIDI Controller Setup (Konfiguracja kontrolera MIDI)
     Otwiera okno dialogowe umożliwiające dodanie do listy komunikatów o zmianie sterowania 
     MIDI.
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POWIĄZANE LINKI
Mapowanie kontrolerów na stronie 928

Narzędzia Note Expression (ekspresji nutowych)
Narzędzia do ekspresji nutowych są dostępne na pasku narzędzi Key Editor.

Show Note Expression Data (Pokaż dane ekspresji nutowych)

       
      Przycisk ten jest dostępny w sekcji Show Note Expression Data na pasku narzędzi Key Editor
      (Edytora klawiszy). Daje wizualną informację zwrotną na temat Twoich działań. Użyj suwaka 
      po prawej stronie, aby dostosować rozmiar wyświetlanych danych ekspresji nutowych na 
      ekranie zdarzeń.
Note Expression MIDI Input (Wejście ekspresji nutowej MIDI)

       
      Przycisk ten jest dostępny w sekcji  Step/MIDI Input (Krok/Wejście MIDI) na pasku narzędzi  
      Key Editor. Umożliwia nagrywanie danych ekspresji nutowych poprzez wejście MIDI.
Acoustic Feedback (Sprzężenie akustyczne)

       
      Przycisk ten jest dostępny w sekcji Acoustic Feedback na pasku narzędzi Key Editor. 
      Zapewnia akustyczną informację zwrotną dotyczącą zdarzeń kontrolera, które są obecne w 
      pozycji myszy podczas wprowadzania lub zmiany danych dotyczących ekspresji nuty.

Mapowanie kontrolera
Zanim będzie można nagrywać zdarzenia ekspresji nut VST za pomocą klawiatur zewnętrznych, 
należy zmapować lub przypisać określone komunikaty kontrolera MIDI, pitchbend i aftertouch lub 
przemieszczenia wejściowe do ekspresji.

Możesz mapować kontrolery za pomocą Inspektora, poprzez MIDI Learn lub używając presetu 
mapowania.

POWIĄZANE LINKI
Mapowanie kontrolerów za pomocą Inspektora na stronie 928
Mapowanie kontrolerów poprzez MIDI Learn się na stronie 929
Korzystanie z gotowych ustawień mapowania na stronie 929

Mapowanie kontrolerów za pomocą Inspektora
Możesz użyć Inspektora, aby przypisać potencjometry i tłumiki instrumentu MIDI do ekspresji.

PROCEDURA
1. W sekcji ekspresji wybierz ekspresję, którą chcesz zmapować na kontroler MIDI.
2. Otwórz wyskakujące menu Input (Wejście) i wybierz kontroler, który chcesz przypisać do   
    wybranej ekspresji nutowej.
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3. Opcjonalnie: Jeśli szukanego kontrolera nie ma na liście, wybierz opcję MIDI Controller Setup 
    (Konfiguracja kontrolera MIDI) i aktywuj go w oknie dialogowym.

WYNIK
Możesz teraz rejestrować dane wyrażeń nutowych za pomocą właśnie przypisanych komunikatów 
kontrolera.
W kolumnie In (Informacja) w sekcji ekspresji wyświetlany jest numer przypisanego komunikatu 
kontrolera MIDI, PB dla pitchbend lub AT dla aftertouch, jeśli mapowanie jest aktywne.

POWIĄZANE LINKI
Sekcja globalna na stronie 927
Sekcja ekspresji na stronie 925

Mapowanie kontrolerów poprzez MIDI Learn
Funkcja MIDI Learn (Nauka MIDI) umożliwia przypisanie potencjometrów i tłumików urządzenia
MIDI do kontrolerów.

PROCEDURA
1. W sekcji wyrażeń wybierz ekspresję, do której chcesz przypisać kontroler MIDI.
2. W sekcji Parameter Details (Szczegóły parametru) kliknij opcję MIDI Learn.
3. Na urządzeniu MIDI użyj pokrętła lub tłumika, który chcesz przypisać do wybranej ekspresji.
4. Opcjonalnie: Powtórz tę czynność dla wszystkich ekspresji, którymi chcesz sterować za pomocą 
    urządzenia MIDI.

WYNIK
Możesz teraz nagrywać dane ekspresji nutowych za pomocą elementów sterujących na urządzeniu 
MIDI, które właśnie przypisałeś.

Korzystanie z gotowych ustawień mapowania
Możesz zapisać swoje mapowanie ekspresji jako ustawienie wstępne i załadować je później do 
użycia z tym samym urządzeniem MIDI.

PROCEDURA
1. W sekcji Global (Globalne) kliknij Show Additional Functions (Pokaż funkcje dodatkowe), aby
    otworzyć menu podręczne.
2. Wybierz opcję Save Input Assignment (Zapisz przypisanie danych wejściowych).
3. W otwartym oknie dialogowym pliku określ nazwę i lokalizację pliku.
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WYNIK
Tworzony jest plik z rozszerzeniem *.neinput.
Możesz załadować utworzone ustawienia wstępne mapowania, otwierając menu podręczne 
i wybierając opcję Load Input Assignment (Załaduj przypisanie danych wejściowych).

POWIĄZANE LINKI
Sekcja globalna na stronie 927

Recording (Nagrywanie)
Możesz nagrywać dane ekspresji nutowych razem z nutami MIDI lub możesz nagrywać dane 
ekspresji nutowych dla istniejących nut.

POWIĄZANE LINKI
Nagrywanie nut i danych ekspresji nutowych na stronie 930
Nagrywanie danych ekspresji nutowych poprzez dogrywanie na stronie 932
Nagrywanie danych ekspresji nutowych przez wejście MIDI na stronie 933

Recording and the Sustain Pedal (Nagrywanie i pedał podtrzymania)
Jeśli podczas nagrywania przytrzymasz pedał podtrzymania (MIDI CC 64) podłączonego 
urządzenia MIDI, obowiązują następujące zasady:
      ● Po odebraniu zdarzenia nutowego (po zwolnieniu klawisza na podłączonej klawiaturze) 
         komunikat ten nie jest wysyłany do instrumentu VST 3, ale jest tworzony przez program po 
         zwolnieniu pedału podtrzymania.
         Dzięki temu przyrząd VST 3 może odtwarzać komunikaty o zmianie sterowania, które są 
         wysyłane po zwolnieniu klawisza.
      ● Faza uwalniania nagranych nut kończy się wraz ze zwolnieniem pedału podtrzymania.

UWAGA
Nie dotyczy to ciągłych komunikatów sterownika.

Nagrywanie nut i danych ekspresji nutowych
Do nagrywania nut MIDI wraz z danymi ekspresji nutowych można używać zewnętrznego 
urządzenia MIDI.

PROCEDURA

1. W obszarze globalnego sterowania ścieżkami na liście ściweżek kliknij opcję Add Track  
    (Dodaj ścieżkę) .
2. Kliknij Instrument.
3. Otwórz menu podręczne Instrument i wybierz na przykład HALion Sonic SE.
4. Kliknij opcję Add Track (Dodaj ścieżkę).
    Ścieżka instrumentu zostanie dodana do listy ścieżek i otworzy się panel sterowania wybranego 
    instrumentu VST.
5. W Inspektorze ścieżki instrumentu otwórz sekcję Note Expression (Ekspresje nutowe).
6. W sekcji wyrażenia wybierz ekspresję.
7. W HALion Sonic SE wybierz ustawienie wstępne.

UWAGA
W przeglądarce Presets (ustawień wstępnych) wpisz noteexp w polu wyszukiwania w sekcji 
Results (Wyniki), aby wyświetlić ustawienia wstępne utworzone specjalnie do użytku 
z  ekspresjami nutowymi.
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8. Zamapuj ekspresje do nagrania.
9. Użyj odwzorowanych elementów sterujących na urządzeniu MIDI, aby nagrać nuty MIDI wraz z 
    danymi ekspresji nutowych.

WYNIK
Nuty są rejestrowane razem z danymi dotyczącymi ekspresji nutowych. Jeśli na pasku narzędzi Key
Editor włączysz opcję Show Note Expression Data (Pokaż dane ekspresji nutowych), dane 
ekspresji nutowych zostaną wyświetlone w nutach, dla których zostały zapisane.

POWIĄZANE LINKI
Mapowanie kontrolerów na stronie 928
Ładowanie ustawień wstępnych instrumentu MPE na stronie 924

Nagrywanie nut i danych ekspresji nutowych za pomocą urządzeń 
wejściowych MPE

WARUNEK WSTĘPNY
Twoje urządzenie wejściowe MPE jest podłączone do komputera i poprawnie skonfigurowane w 
Cubase.

PROCEDURA

1. W obszarze globalnego sterowania ścieżkami na liście ścieżek kliknij opcję Add Track  
    (Dodaj ścieżkę).
2. Kliknij Instrument.
3. Otwórz menu podręczne Instrument i wybierz na przykład HALion Sonic SE.
4. Kliknij opcję Add Track.
    Ścieżka instrumentu zostanie dodana do listy ścieżek i otworzy się panel sterowania wybranego 
    instrumentu VST.
5. W górnej części Inspektora ścieżki instrumentu otwórz wyskakujące menu Input Routing    
    (Routing wejściowy) i wybierz z listy urządzenie wejściowe MPE.

UWAGA
Upewnij się, że kanał MIDI nie jest ustawiony na Any (Dowolny).

6. W Inspektorze otwórz sekcję Note Expression (Ekspresja nutowa).
    Ekspresje powinny być poprawnie odwzorowane na przemieszczenia wejściowe urządzenia 
    MPE.
7. Użyj urządzenia wejściowego MPE, aby nagrać nuty MIDI wraz z danymi ekspresji nutowych.

WYNIK
Nuty są rejestrowane razem z danymi dotyczącymi ekspresji nutowych. Jeśli na pasku narzędzi Key
Editor włączysz opcję Show Note Expression Data (Pokaż dane ekspresji nutowych), dane 
ekspresji nutowych zostaną wyświetlone w nutach, dla których zostały zapisane.

POWIĄZANE LINKI
Urządzenia wejściowe MIDI obsługujące MPE na stronie 920
Ładowanie ustawień wstępnych instrumentu MPE na stronie 924

943



Nagrywanie danych ekspresji nutowych poprzez dogrywanie
Możesz nagrać lub zastąpić dane ekspresji nutowych dla istniejących nut poprzez dogrywanie.

WARUNEK WSTĘPNY
Przed rozpoczęciem dogrywania usuń zaznaczenie wszystkich nut na ekranie zdarzeń. Zapewnia to 
nagrywanie komunikatów o zmianie sterowania dla wszystkich nut dotkniętych kursorem pozycji.

PROCEDURA
1. W Inspektorze otwórz sekcję Note Expression (Ekspresja nutowa).
2. W sekcji Global (Globalne) aktywuj Overdub Note Exp. (Dograj ekspresję nutową).
3. Użyj odwzorowanych elementów sterujących na urządzeniu MIDI, aby nagrać dane dotyczące   
    ekspresji nuty dla odtwarzanej nuty.

WYNIK
Rejestrowane są tylko dane dotyczące ekspresji nutowych.

PO ZAKOŃCZENIU TEGO ZADANIA
Dezaktywuj funkcję Overdub Note Exp. gdy skończysz.

POWIĄZANE LINKI
Sekcja globalna na stronie 927

Rozpoczynanie dogrywania przy określonych wartościach kontrolera
Kiedy nagrywasz dane ekspresji nutowych poprzez dogrywanie, możesz aktywować Latch Buffer 
(bufor zatrzaskowy). Jest to przydatne, jeśli chcesz rozpocząć nagrywanie przy wstępnie 
zdefiniowanych początkowych ustawieniach pokrętła lub tłumika.

Kiedy Cubase odbiera dane kontrolera z zewnętrznego urządzenia MIDI, ustawienia tłumików i 
potencjometrów urządzenia są automatycznie zapisywane w Latch Buffer (buforze Latch). Dane te
są następnie dodawane do nut podczas odtwarzania.

PROCEDURA
1. Przypisz każdą kontrolkę do jednej z dostępnych ekspresji nutowych VST.
2. Aktywuj Latch Buffer i ustaw pokrętła i tłumiki kontrolera MIDI na odpowiednie wartości.
3. Aktywuj dogrywanie.
4. Użyj odwzorowanych elementów sterujących na urządzeniu MIDI, aby nagrać dane dotyczące 
    ekspresji nuty dla odtwarzanej nuty.

WYNIK
Wartości wszystkich elementów sterujących są dołączane do nut przekazywanych podczas 
dogrywania i zastępują wszelkie istniejące dane kontrolera tego samego typu.

PO ZAKOŃCZENIU TEGO ZADANIA
Usuń wszystkie wartości z Latch Buffer (Bufora zatrzasku), klikając Reset Latch Buffer (Resetuj 
bufor zatrzasku).

UWAGA
Podczas nagrywania w cyklu Latch Buffer jest automatycznie resetowany na koniec cyklu.
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Nagrywanie Note Expression Data (Danych ekspresji nutowych) 
poprzez wejście MIDI
Możesz nagrywać dane ekspresji nutowych dla istniejących nut, korzystając z wejścia MIDI Note 
Expression (Note Expression MIDI Input).

PROCEDURA
1. Na pasku narzędzi Key Editor, w sekcji Step/MIDI Input (Krok/Wejście MIDI), aktywuj MIDI
    Input i Note Expression MIDI Input (Wejście ekspresji nutowej MIDI).

           
2. Wybierz nutę i przesuń aktywny element sterujący na urządzeniu MIDI, aby zastąpić zdarzenia 
    kontrolera dla tej nuty.

WYNIK
Nuta jest odtwarzana w czasie rzeczywistym i zapisywane są dla niej przychodzące komunikaty o 
zmianie sterowania. Nagrywanie zatrzymuje się po osiągnięciu końca nuty, zakończeniu fazy 
uwalniania lub po odznaczeniu nuty.

POWIĄZANE LINKI
Dodawanie faz release (uwolnienia) do nut na stronie 938

Note Expression Event Editor (Edytor zdarzeń ekspresji nutowych)
Edytor zdarzeń ekspresji nutowych oferuje różne tryby edycji i dodawania zdarzeń ekspresji 
nutowych.
● Aby otworzyć edytor zdarzeń ekspresji nutowych, aktywuj opcję Double-click Opens Note 
Expression Editor (Dwukrotne kliknięcie otwiera edytor ekspresji nutowych) na pasku narzędzi 
Key Editor (Edytora klawiszy) i kliknij dwukrotnie nutę na ekranie zdarzenia. Jeśli ten przycisk nie
jest widoczny, kliknij pasek narzędzi prawym przyciskiem myszy i wybierz z menu opcję Show 
Note Expression Data (Pokaż dane ekspresji nut).
UWAGA
● W oknie dialogowym Key Commands (Polecenia klawiszowe) w kategorii Note Expression 
(Ekspresje nutowe) można także przypisać polecenie klawiszowe do Double-click Opens Note 
Expression Editor On/Off (włączania/wyłączania edytora ekspresji nutowych poprzez dwukrotne 
kliknięcie). W ten sposób można szybko zmienić funkcję podwójnego kliknięcia z usuwania nut 
(Double-Click opens Note Expression Editor jest wyłączone) na otwieranie edytora zdarzeń 
ekspresji nutowych (Double-Click opens Note Expression Editor jest aktywowane).
● Jeśli wybierzesz kilka nut w Key Editor (Edytorze klawiszy) i klikniesz dwukrotnie dowolną z 
nich, otworzy się edytor zdarzeń ekspresji nutowych dla wszystkich tych nut. W takim przypadku 
jakakolwiek edycja ma wpływ na wszystkie nuty obecne w momencie, w którym przeprowadzasz 
edycję.
● Aby zamknąć edytor, kliknij na ekranie zdarzeń.

Edytor zdarzeń ekspresji nutowych zawiera następujące elementy sterujące:
●   Note Expression controls (Elementy sterujące ekspresją nutową)
     Te elementy sterujące pozwalają wybierać parametry i dodawać zdarzenia ekspresji nutowych.
●   Smart controls (Inteligentne kontrolery)
     Umożliwiają one edycję zdarzeń ekspresji nutowych.

Sterowanie ekspresjami nutowymi
Edytor zdarzeń ekspresji nutowych zawiera następujące elementy sterujące ekspresjami nutowymi:
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1   One-Shot Mode (Tryb jednorazowy)
     Jeśli ta opcja jest aktywna i klikniesz narzędziem Rysuj w dowolnym miejscu edytora, zostanie 
     ustawiona stała wartość.
UWAGA
Ten tryb jest automatycznie aktywowany w przypadku ekspresji nutowych, które są jednorazowe.
2   Vertical Snap (Przyciąganie pionowe)
     Umożliwia wprowadzenie wysokości dźwięku (pitch) w krokach półtonowych, a nie w postaci 
     ciągłej krzywej. W ten sposób znacznie łatwiej jest tworzyć szybkie modulacje wysokości 
     dźwięku. Jest to szczególnie przydatne w przypadku parametru Tuning (Strojenie).
UWAGA
Aby tymczasowo przełączyć się na przyciąganie pionowe podczas edycji, przytrzymaj klawisz 
Shift
3   Horizontal Snap (Przyciąganie poziome)
     Odpowiada to przyciskowi Snap w oknie Project.
4   Change Release Length (Zmień długość uwolnienia)
     Umożliwia dodanie długości release do nuty.
5   Parameter Range (Zakres parametrów)
     Pokazuje aktualną wartość w pozycji kursora. Zakres wartości różni się w zależności od typu 
     parametru.
6   Change Editor Size (Zmień rozmiar edytora)
     Kliknij to i przeciągnij w górę lub w dół, aby zmienić rozmiar edytora. Umożliwia to 
     przełączanie pomiędzy 3 różnymi rozmiarami okien.
7   Parameter Selection (Wybór parametrów)
     Pokazuje wybrany parametr. Kliknij to, aby otworzyć wyskakujące menu ze wszystkimi 
     parametrami używanymi w nucie. Aby udostępnić więcej parametrów, zaznacz je 
     w Inspektorze.

Inteligentne sterowanie
Edytor zdarzeń ekspresji nutowych zawiera następujące inteligentne elementy sterujące dla 
określonych trybów edycji:

                                                    
1   Tilt Left (Przechyl w lewo)
     Klikając w lewy górny róg edytora, możesz przechylić lewą część krzywej. Umożliwia to 
     przechylenie wartości zdarzeń na początku krzywej w górę lub w dół.
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2   Compress Left (Kompresuj w lewo)
     Jeśli klikniesz Alt/Opt w lewym górnym rogu edytora, możesz skompresować lub rozszerzyć    
     lewą część krzywej. Umożliwia to kompresję lub rozszerzenie wartości zdarzeń na początku 
     krzywej.
3   Scale Vertically (Skaluj w pionie)
     Jeśli klikniesz na środku górnej krawędzi edytora, możesz przeskalować krzywą w pionie. 
     Umożliwia to zwiększenie lub zmniejszenie wartości zdarzeń na krzywej w procentach.
4   Move Vertically (Przesuń w pionie)
     Klikając górną granicę edytora, możesz przesunąć całą krzywą w pionie. Umożliwia to 
     zwiększenie lub zmniejszenie wartości zdarzeń na krzywej.
5   Compress Right (Kompresuj w prawo)
     Jeśli klikniesz Alt/Opt w prawym górnym rogu edytora, możesz skompresować lub rozszerzyć 
     prawą część krzywej. Pozwala to skompresować lub rozszerzyć wartości zdarzeń na końcu 
     krzywej.
6   Tilt Right (Przechyl w prawo)
     Klikając w prawy górny róg edytora, możesz przechylić prawą część krzywej. Umożliwia to 
     przechylenie wartości zdarzeń na końcu krzywej w górę lub w dół.
7   Scale Around Relative Center (Skaluj wokół względnego środka)
     Kliknięcie klawiszem Alt/Opt w prawym środkowym obramowaniu edytora umożliwia 
     skalowanie krzywej względem jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w 
     poziomie wokół środka edytora.
8   Scale Around Absolute Center (Skaluj wokół absolutnego środka)
     Jeśli klikniesz w prawym środkowym rogu edytora, możesz przeskalować krzywą bezwzględnie 
     do jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w poziomie wokół środka 
     edytora.
9   Stretch (Rozciągnij)
     Kliknięcie dolnej krawędzi edytora umożliwia rozciągnięcie krzywej w poziomie. Umożliwia to 
     przesuwanie wartości zdarzeń na krzywej w lewo lub w prawo.

Nawigacja w edytorze zdarzeń ekspresji nutowych
Możesz przejść do następnej/poprzedniej nuty, gdy otwarty jest edytor zdarzeń ekspresji nutowych.

● Aby przejść do następnej/poprzedniej nuty, użyj klawiszy Strzałka w lewo / Strzałka w prawo.
● Aby przeglądać nuty, naciśnij Tab i Shift - Tab.

Dodawanie zdarzeń ekspresji nutowych

PROCEDURA
1. Kliknij dwukrotnie nutę na ekranie zdarzenia, aby otworzyć edytor zdarzeń ekspresji nutowych.
2. Wykonaj jedną z poniższych czynności, aby wybrać parametr, dla którego chcesz dokonać 
    ustawień:
● Aby utworzyć zdarzenia dla parametru, który nie był jeszcze używany, wybierz parametr w 
   Inspektorze, aby udostępnił go w edytorze.
● Aby edytować istniejące zdarzenia, określ parametr, który chcesz edytować, klikając krzywą, 
wybierając odpowiedni parametr w wyskakującym menu Parameter Selection (Wybór parametru) 
lub wybierając parametr w Inspektorze w sekcji Note Expression (Ekspresja nuty).
3. Wybierz narzędzie Draw (Rysuj) lub Line (Linia) i dodaj zdarzenia wyrażenia nuty dla wybranej
notatki.

POWIĄZANE LINKI
Dodawanie zdarzeń prędkości (velocity) na stronie 821
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Usuwanie zdarzeń ekspresji nutowych

PROCEDURA
1. Na pasku narzędzi Key Editor (Edytor klawiszowy) aktywuj opcję Double-Click opens Note    
    Expression Editor (Dwukrotne kliknięcie otwiera Edytor ekspresji nutowej). Jeśli ten przycisk 
    nie jest widoczny, kliknij prawym przyciskiem myszy pasek narzędzi i wybierz z menu opcję 
    Show Note Expression Data (Pokaż dane ekspresji nutowych).
UWAGA
W oknie dialogowym Key Commands (Polecenia klawiszowe) w kategorii Note Expression 
(Ekspresje nutowe) można także przypisać polecenie klawiszowe do Double-click Opens Note 
Expression Editor On/Off (Włączania/wyłączania edytora wyrażeń nutowych poprzez dwukrotne 
kliknięcie). W ten sposób można szybko zmienić funkcję podwójnego kliknięcia z usuwania nut 
(Double-click Opens Note Expression Editor jest wyłączony) na otwieranie edytora zdarzeń 
wyrażeń nutowych (Double-click Opens Note Expression Editor jest aktywowane)

2. Kliknij dwukrotnie nutę zawierającą zdarzenia ekspresji nutowych, które chcesz usunąć. Otworzy
    się edytor ekspresji nutowych.
3. Opcjonalnie: Otwórz wyskakujące menu Parameter Selection (Wybór parametru) i wybierz  
    odpowiednie ekspresje nutowe z listy.
4. Przeciągnij prostokąt zaznaczenia, aby zaznaczyć zakres wartości wyrażeń nutowych, który 
    chcesz usunąć.
5. Wybierz opcję Edit > Delete (Edycja > Usuń).

WYNIK
Wybrane zdarzenia ekspresji nutowych zostaną usunięte z nuty.

POWIĄZANE LINKI
Dodawanie zdarzeń prędkości (velocity) na stronie 821

Wklejanie zdarzeń ekspresji nutowych do różnych nut
Możesz skopiować wszystkie zdarzenia ekspresji nutowej z jednej lub większej liczby nut i wkleić 
je do jednej lub większej liczby innych nut.

WARUNEK WSTĘPNY
Skonfigurowałeś polecenie klawiszowe dla opcji Paste Note Expression (Wklej ekspresję nutową) 
w oknie dialogowym Key Commands (Polecenia kluczowe) (kategoria Note Expression (Ekspesja
nutowa)).

PROCEDURA
1. Kliknij dwukrotnie nutę zawierającą zdarzenia ekspresji nutowej.
    Otworzy się edytor ekspresji nutowych.
2. Wybierz zdarzenia ekspresji nutowych, które chcesz skopiować.
3. Wybierz Edit > Copy (Edycja > Kopiuj).
4. Wybierz nutę, do której chcesz wkleić zdarzenia ekspresji nutowej.
5. Naciśnij klawisz przypisany do polecenia Paste Note Expression (Wklej ekspresję nutową).

WYNIK
Wszystkie skopiowane zdarzenia ekspesji nutowej zostaną wklejone do wybranej nuty.
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Jeśli skopiowałeś zdarzenia ekspresji nutowej z kilku nut źródłowych i wkleiłeś je do kilku nut 
docelowych, obowiązują następujące zasady:

● Jeżeli liczba nut źródłowych i docelowych jest zgodna, zdarzenia z pierwszej nuty źródłowej    
   zostaną wklejone do pierwszej nuty docelowej, zdarzenia z drugiej nuty źródłowej do drugiej nuty
   docelowej itd.
● Jeśli liczba nut źródłowych jest mniejsza niż liczba nut docelowych, zdarzenia nuty źródłowej są 
   wielokrotnie wklejane do nut docelowych w kolejności, w jakiej się pojawiają.
Kiedy na przykład kopiujesz zdarzenia z 2 nut źródłowych do 4 nut docelowych, pierwsza nuta 
docelowa pobiera zdarzenia ekspresji nuty z pierwszej nuty źródłowej, druga nuta docelowa 
zdarzenia z drugiej nuty źródłowej, trzeciej nuty docelowej, zdarzenia pierwszej nuty źródłowej 
i czwartej nuty docelowej, zdarzenia z drugiej nuty źródłowej.

POWIĄZANE LINKI
Polecenia klawiszowe na stronie 1123

Wklejanie zdarzeń ekspresji nutowych do różnych parametrów
Można kopiować zdarzenia ekspresji nutowych z jednego parametru i wklejać je do innego 
parametru.

PROCEDURA
1. Kliknij dwukrotnie nutę zawierającą zdarzenia ekspresji nutowych, aby otworzyć edytor zdarzeń 
    ekspresji nutowych.
2. Wybierz zdarzenie ekspresji nuty parametru, który chcesz skopiować.
3. Wybierz Edit > Copy (Edycja > Kopiuj).
4. Wybierz parametr, do którego chcesz wkleić zdarzenie ekspresji nutowej.
5. Wybierz Edit > Paste (Edycja > Wklej).

WYNIK
Wszystkie skopiowane zdarzenia ekspresji nutowych zostaną wklejone do wybranego parametru.

Powtarzanie zdarzenia ekspresji nutowych

PROCEDURA
1. Kliknij dwukrotnie nutę zawierającą zdarzenia ekspresji nutowych, aby otworzyć edytor zdarzeń 
    ekspresji nutowych.
2. Otwórz wyskakujące menu Parameter Selection (Wybór parametru) i wybierz z listy 
    odpowiednie ekspresje nutowe.
3. Przeciągnij prostokąt zaznaczenia, aby wybrać zdarzenia, które chcesz powtórzyć.
4. Kliknij zaznaczenie i przy wciśniętym przycisku myszy naciśnij klawisz Alt i przeciągnij.

WYNIK
Wybrane zdarzenia zostaną skopiowane.

Przenoszenie zdarzeń ekspresji nutowych

PROCEDURA
1. Kliknij dwukrotnie nutę zawierającą zdarzenia ekspresji nutowych, aby otworzyć edytor 
    zdarzeń ekspresji nutowych.
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2. Otwórz wyskakujące menu Parameter Selection (Wybór parametru) i wybierz z listy 
    odpowiednią ekspresję nutową.
3. Wykonaj jedną z następujących czynności:
      ● Kliknij krzywą zdarzenia ekspresji nutowej i przeciągnij, aby przenieść wszystkie zdarzenia.
      ● Przeciągnij prostokąt zaznaczenia, aby wybrać zdarzenia i przeciągnij, aby przenieść wybrane
         zdarzenia.

UWAGA
Aby ograniczyć kierunek do pionowego lub poziomego, podczas przeciągania możesz nacisnąć 
klawisz Ctrl/Cmd

Dodawanie faz Release (Uwolnienia) do nut
Do nuty możesz dodać fazę release (zwolnienia). Pozwala to na pracę nad końcówką nuty, która na 
przykład nadal brzmi po wysłaniu wiadomości o wyłączeniu nuty.

PROCEDURA
1. Kliknij dwukrotnie nutę na ekranie zdarzenia, aby otworzyć edytor zdarzeń ekspresji nutowych.
2. Kliknij i przeciągnij kontrolkę Change Release Length (Zmień długość zwolnienia) w prawym 
    dolnym rogu edytora, aby dodać fazę release.

WYNIK
Faza zwolnienia jest dodawana do nuty.

                       

UWAGA
Możesz zmienić fazę zwolnienia dla kilku nut, otwierając edytor tych nut i przytrzymując klawisz 
Alt podczas ustawiania długości zwolnienia.

PO ZAKOŃCZENIU TEGO ZADANIA
Dodaj zdarzenia kontrolera w fazie release, dogrywając lub ręcznie wprowadzając zdarzenia 
ekspresji nuty w edytorze. Kiedy dogrywasz zdarzenia ekspresji nuty, długość istniejącej fazy 
release jest wykorzystywana do kojarzenia nowo nagranych zdarzeń z nutami.

UWAGA
Jeśli podczas nagrywania przytrzymasz pedał Sustain w urządzeniu zewnętrznym, nuty 
automatycznie przejdą w odpowiednią fazę release.

Przycinanie Note Expression Data (danych ekspresji nutowych)
Możesz przyciąć dane ekspresji nutowych, aby automatycznie dopasować je do długości nuty.

PROCEDURA
1. Wybierz nuty zawierające dane dotyczące ekspresji nutowych.
2. Wybierz opcję MIDI > Note Expression > Trim Note Expression to Note Length (MIDI > 
    Ekspresja nuty > Przytnij ekspresję nuty do długości nuty).
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WYNIK
Dane ekspresji nutowych są przycinane do długości nuty, a wszelkie dane obecne po zakończeniu 
fazy release (uwalniania) są usuwane.

Usuwanie wszystkich danych ekspresji nutowych
Można usunąć wszystkie dane ekspresji nutowych z wybranej nuty lub partii MIDI.

PROCEDURA
1. Wybierz nutę MIDI lub partię MIDI zawierającą dane ekspresji nutowych, które chcesz usunąć.
2. Wybierz opcję MIDI > Note Expression > Remove Note Expression (MIDI > Ekspresja  
    nutowa > Usuń ekspresję nutową).

WYNIK
Dane ekspresji nuty zostaną usunięte.

Okno dialogowe Note Expression MIDI Setup (Konfiguracja ekspresji
nuty MIDI)
Okno dialogowe Note Expression MIDI Setup pozwala dokładnie określić, które komunikaty 
MIDI będą używane za każdym razem, gdy nagrywasz komunikaty o zmianie sterowania MIDI 
jako dane ekspresji nutowych, lub je konwertujesz.

● Aby otworzyć okno dialogowe Note Expression MIDI Setup, wybierz MIDI > Note 
Expression > Note Expression MIDI Setup (MIDI > Ekspresja nuty > Konfiguracja Ekspresji 
nuty MIDI)

                       

Dostępne są następujące opcje:
Controller (Kontroler)
      Aktywuje komunikaty o zmianie sterowania MIDI. Na poniższej liście określ komunikaty 
      o zmianie sterowania MIDI, których chcesz użyć.
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UWAGA
Dane kontrolera MIDI dla dezaktywowanych komunikatów o zmianie sterowania MIDI znajdą się 
na ścieżce kontrolera.

Pitchbend
      Aktywuje dane pitchbend.
Aftertouch (Dotyk)
      Aktywuje dane aftertouch.
Poly Pressure 
      Aktywuje dane dotyczące Poly Pressure.
Controller Catch Range (Zasięg pracy kontrolera)
      Umożliwia wprowadzenie zakresu przechwytywania kontrolera w znacznikach. Jest to 
      przydatne w celu powiązania komunikatów o zmianie kontroli z notatką, nawet jeśli zostały 
      wysłane nieco przed komunikatem dotyczącym notatki.
Load Default (Załaduj domyślnie)
      Umożliwia załadowanie ustawień domyślnych.
Save as Default (Zapisz jako domyślny)
      Umożliwia zapisanie bieżących ustawień jako ustawień domyślnych.

Nagrywanie komunikatów o zmianie sterowania MIDI jako danych 
ekspresji nutowych
Komunikaty o zmianie sterowania MIDI (Control Change) można nagrywać jako dane ekspresji 
nutowych.

PROCEDURA
1. W Inspektorze otwórz sekcję Note Expression (Ekspresja nutowa) i aktywuj MIDI jako Note   
    Expression.
2. Opcjonalnie: Ustaw ścieżkę MIDI na kanał Any (Dowolny).
    Komunikaty o zmianie sterowania MIDI, z wyjątkiem poly pressure, są specyficzne dla kanału.   
    Dzieląc polifonię na osobne kanały, można uniknąć sprzecznych komunikatów kontrolera.
3. Wprowadź nuty i komunikaty o zmianie sterowania na swoim urządzeniu MIDI.

WYNIK
Dane kontrolera są teraz powiązane z nutami. Jeśli skopiujesz, wkleisz i przeniesiesz nuty, zostaną 
powiązane z nimi dane kontrolera.

UWAGA
Jeśli chcesz edytować nuty MIDI po nagraniu, może być konieczna konsolidacja danych kontrolera.

POWIĄZANE LINKI
Konsolidowanie nakładających się ekspresji nutowych na stronie 941
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Konwertowanie komunikatów zmiany sterowania MIDI (Control 
Change) na Note Expression Data (Dane ekspresji nutowych)
Komunikaty o zmianie sterowania MIDI na ścieżkach kontrolera można konwertować na dane 
ekspresji nutowych.

WARUNEK WSTĘPNY
Komunikaty o zmianie sterowania MIDI, które chcesz nagrać, są aktywowane w oknie dialogowym
Note Expression MIDI Setup. Masz partię MIDI z danymi kontrolera zapisanymi na ścieżkach 
kontrolera.

PROCEDURA
1. Otwórz Key Editor (Edytor klawiszy) dla partii MIDI.
2. Wybierz MIDI > Note Expression > Convert to Note Expression (MIDI > Ekspresje nutowe > 
    Konwertuj na ekspresje nutowe).

WYNIK
Komunikaty sterujące MIDI zawarte na ścieżkach kontrolera są konwertowane na dane wyrażeń 
nutowych, a dane na ścieżkach kontrolera są usuwane.
Cubase wyszukuje nuty, które brzmią w tym samym czasie, co komunikaty o zmianie sterowania 
(control change). Jeżeli jednocześnie odtwarzanych jest kilka nut, przypisywane są im te same 
ekspresje nutowe i te same wartości. Fazy Release (uwolnienia) są tworzone automatycznie tam, 
gdzie jest to konieczne, tak aby żadne dane sterownika nie zostały utracone podczas tego procesu.

WAŻNE
Jeśli chcesz edytować nuty MIDI po konwersji, może zaistnieć potrzeba skonsolidowania danych 
kontrolera.

POWIĄZANE LINKI
Okno dialogowe Note Expression MIDI Setup (Konfiguracja ekspresji nut MIDI) na stronie 939
Dodawanie faz release (uwolnienia) do nut na stronie 938

Konsolidowanie nakładających się ekspresji nutowych
Jeśli przenosisz lub kwantyzujesz nuty w taki sposób, że nakładają się na siebie i jeśli te 
nakładające się nuty zawierają dane dla tego samego komunikatu o zmianie sterowania (control 
change), może zaistnieć potrzeba skonsolidowania nakładających się ekspresji nut.

PROCEDURA
● Wybierz opcję MIDI > Note Expression > Consolidate Note Expression Overlaps (MIDI > 
Ekspresje nutowe > Konsoliduj nakładanie się ekspresji nutowych)

WYNIK
Jeśli nakładające się nuty zawierają dane dla tego samego komunikatu o zmianie sterowania, 
wartości kontrolera drugiej nuty są używane od początku nakładania się.
Jeśli nuta jest umieszczona w całości w dłuższej nucie i jeśli nuty te zawierają dane kontrolera dla 
tego samego komunikatu o zmianie sterowania, wartości kontrolera dłuższej nuty są używane aż do 
rozpoczęcia objętej nuty.

Dystrybucja nut do różnych kanałów
Możesz dystrybuować nuty do różnych kanałów. Umożliwia to korzystanie z funkcji ekspresji nut, 
nawet jeśli nie posiadasz instrumentu VST 3.
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WARUNEK WSTĘPNY
Dodałeś instrument wielobrzmieniowy i przypisałeś ten sam dźwięk do różnych kanałów.

PROCEDURA
1. W Inspektorze odpowiedniej ścieżki MIDI otwórz menu podręczne Channel (Kanał) i wybierz 
    Any (Dowolny)
2. W Inspektorze otwórz sekcję Note Expression (Ekspresja nuty).
3. Włącz MIDI as Note Expression (MIDI jako ekspresja nutowa).
4. W razie potrzeby nagraj lub wprowadź nuty MIDI z ekspresjami.
5. Wybierz opcję MIDI > Note Expression > Distribute Notes to MIDI Channels (MIDI >    
    Ekspresja nuty > Rozpowszechniaj nuty na kanałach MIDI).

WYNIK
Nuty MIDI są dystrybuowane do różnych kanałów, zaczynając od kanału 1. Możesz teraz edytować
ekspresję nuty dla każdej nuty niezależnie, bez konfliktów.

Konwertowanie danych ekspresji nutowych na dane kontrolera MIDI
Możesz konwertować dane ekspresji nutowych parametrów kontrolera MIDI na dane kontrolera 
MIDI na ścieżkach kontrolera.

PROCEDURA
● Wybierz opcję MIDI > Note Expression > Dissolve Note Expression (MIDI > Ekspresja 
nutowa > Rozpuść ekspresję nutową).

WYNIK
Dane ekspresji nutowej są konwertowane. Jeśli otworzysz wyświetlacz kontrolera i wyświetlisz 
ścieżki kontrolera dla odpowiedniego typu zdarzenia, dane zostaną wyświetlone.

UWAGA
Jeśli przekonwertujesz dane ekspresji nutowych ekspresji nutowych VST na MIDI, dźwięk się 
zmieni. Dlatego należy ponownie przypisać dane kontrolera MIDI do nowego miejsca docelowego 
instrumentu.

954



Chord Functions (Funkcje akordów)
Funkcje akordów zapewniają wiele możliwości pracy z akordami.

Funkcje akordów umożliwiają:

● Tworzyć progresje akordów, dodając zdarzenia akordów do ścieżki akordów.
● Konwertować zdarzenia akordów na MIDI.
● Użyć ścieżki akordów do sterowania odtwarzaniem audio lub MIDI.
● Użyć brzmienia ścieżki akordów, aby zmienić wysokość dźwięku MIDI.
● Wyodrębnić zdarzenia akordów z danych MIDI, aby uzyskać przegląd struktury harmonicznej   
    pliku MIDI.
● Nagrywać zdarzenia akordów za pomocą klawiatury MIDI.

POWIĄZANE LINKI
Sekcja edycji akordów na stronie 866

Chord Track (Scieżka akordów)
Ścieżka akordów umożliwia dodawanie zdarzeń akordów i zdarzeń skali.

POWIĄZANE LINKI
Skaluj zdarzenia na stronie 951
Zdarzenia akordów na stronie 944
Okno dialogowe konfiguracji skali muzycznej na stronie 952

Dodawanie ścieżki akordów

PROCEDURA
● Wybierz Project > Add Track > Chord (Projekt > Dodaj ścieżkę > Akord).

WYNIK
Ścieżka akordów zostanie dodana do Twojego projektu.

       

POWIĄZANE LINKI
Ścieżka akordów na stronie 153
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Zdarzenia akordowe
Zdarzenia akordów to reprezentacje akordów, które kontrolują lub transponują odtwarzanie na 
ścieżkach MIDI, instrumentach i audio.
Zdarzenia akordów zmieniają wysokość nut MIDI i segmentów VariAudio, jeśli ich ścieżki są 
skonfigurowane tak, aby podążały za ścieżką akordów.
Zdarzenia akordów mają określoną pozycję początkową. Ich koniec wyznacza jednak początek 
kolejnego zdarzenia akordowego. Mogą mieć nutę podstawową, rodzaj, napięcie i nutę basową.

                

1   Root note (nuta podstawowa)
2   Type (typ)
3   Tension (napięcie)
4   Bass note (Nuta basowa)

POWIĄZANE LINKI
Sterowanie odtwarzaniem MIDI lub audio za pomocą ścieżki akordów na stronie 957

Chord Editor (Edytor akordów)
Edytor akordów umożliwia definiowanie lub zmianę zdarzeń akordów oraz dodawanie nowych 
zdarzeń akordów.

● Aby otworzyć Chord Editor, kliknij dwukrotnie zdarzenie akordu.

             

Go to Previous Chord/Go to Next Chord (Przejdź do poprzedniego akordu/Przejdź do następnego
akordu)
      Umożliwia wybranie poprzedniego/następnego akordu na ścieżce akordów do edycji.
Add Chord (Dodaj akord)
      Dodaje nowe, niezdefiniowane zdarzenie akordu na ścieżce akordów.
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UWAGA
Działa to tylko wtedy, gdy wybrane jest ostatnie zdarzenie akordowe na ścieżce akordów.

Chord definition buttons (Przyciski definicji akordów)
      Aktywuj te przyciski, aby zdefiniować nutę prymy, typ akordu, napięcie i nutę basową dla 
      zdarzenia akordowego.
UWAGA
Jeśli nie wybierzesz osobnej nuty basowej, ustawienie zostanie powiązane z nutą podstawową, tak 
że nie będzie słychać dodatkowej nuty basowej.

Keyboard display (Wyświetlacz klawiatury)
      Pokazuje nuty zdarzenia akordowego, biorąc pod uwagę bieżące ustawienia brzmienia.
Activate MIDI Input (Aktywuj wejście MIDI)
      Umożliwia zdefiniowanie akordu poprzez zagranie akordu na klawiaturze MIDI. Jeśli akord  
      zostanie rozpoznany, zostanie to odzwierciedlone na przyciskach akordów i na wyświetlaczu 
      klawiatury.
Define Chord by Text Input (Zdefiniuj akord poprzez wprowadzenie tekstu)
      Umożliwia zdefiniowanie akordu za pomocą klawiatury komputera.

Dodawanie zdarzeń akordowych

WARUNEK WSTĘPNY
Dodałeś ścieżkę akordów.

PROCEDURA
1. Wybierz narzędzie Draw (Rysuj) i kliknij ścieżkę akordów.
    Dodano niezdefiniowane zdarzenie akordowe o nazwie X.
2. Wybierz narzędzie Object Selection (Zaznaczanie obiektów) i kliknij dwukrotnie zdarzenie 
    akordu.
3. W Editor (Edytorze) wybierz nutę główną.
4. Opcjonalnie: Wybierz rodzaj akordu, napięcie i nutę basową.
5. Wykonaj jedną z następujących czynności:
      ● Aby zamknąć Editor, kliknij gdziekolwiek poza Edytorem.
      ● Aby dodać nowy, niezdefiniowany akord, kliknij Add Chord (Dodaj akord)

POWIĄZANE LINKI
Dodawanie ścieżki akordów na stronie 943

Definiowanie akordów poprzez wprowadzanie tekstu

W Edytorze akordów możesz użyć pola wprowadzania tekstu, aby zdefiniować akord za pomocą 
klawiatury komputera.

PROCEDURA
1. Kliknij dwukrotnie zdarzenie akordu, aby otworzyć edytor akordów.
2. Kliknij pole wprowadzania tekstu u dołu Edytora.
3. Wprowadź akord, wykonując następujące czynności:
      ● Zdefiniuj nutę podstawową, na przykład C, D, E.
      ● Zdefiniuj znaki szczególne, na przykład # lub b.
      ● Zdefiniuj typ akordu, na przykład maj, min, dim, sus lub aug.
      ● Zdefiniuj rozszerzenie akordu, na przykład 7, 9 lub 13.
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UWAGA
Jeśli aktywowałeś Solfège w wyskakującym menu Note Name (Nazwa nuty) w oknie dialogowym 
Preferences (Preferencje) (Event Display—Chords&Pitches page (Wyświetlanie zdarzeń — 
strona Akordy i tony)), możesz także wprowadzać akordy w tym formacie. Pierwszą literę należy 
napisać wielką literą i na przykład wpisać „Re” zamiast „re”. W przeciwnym razie akord nie 
zostanie rozpoznany.

4. Naciśnij Tab, aby dodać nowy, niezdefiniowany akord i go zdefiniować.

Chord Assistant (Asystent akordów)
Chord Assistant umożliwia użycie akordu jako punktu wyjścia w celu uzyskania sugestii 
dotyczących następnego akordu.

● Aby otworzyć Chord Assistant (Asystenta akordów), w Chord Editor (Edytorze akordów) 
kliknij Chord Assistant (Asystenta akordów).

               

POWIĄZANE LINKI
Chord Assistant – lista na stronie 946
Chord Assistant – Bliskość na stronie 948
Chord Assistant – Kręgi kwintowe na stronie 949

Chord Assistant – List (Asystent akordów – lista)
Tryb List (listy) programu Chord Assistant umożliwia tworzenie harmonicznych progresji 
akordów w oparciu o reguły harmoniczne, które mogą być mniej lub bardziej złożone.

● Aby otworzyć Chord Assistant (Asystenta akordów), w Chord Editor (Edytorze akordów) 
kliknij Chord Assistant (Asystenta akordów).
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Go to Previous Chord/Go to Next Chord (Przejdź do poprzedniego akordu/Przejdź do następnego
akordu)
      Umożliwia wybranie poprzedniego/następnego akordu na ścieżce akordów do edycji.
Add Chord (Dodaj akord)
      Dodaje nowe, niezdefiniowane zdarzenie akordu na ścieżce akordów.
UWAGA
Działa to tylko wtedy, gdy wybrane jest ostatnie zdarzenie akordowe na ścieżce akordów.

Suggestions list (Lista sugestii)
      Pokazuje sugestie dotyczące następnego akordu. Kliknij sugestię akordu, aby ją wybrać.
Complexity filter (Filtr złożoności)
      Pozwala zwiększyć złożoność, a tym samym liczbę sugestii. Im wyższy poziom złożoności, tym
      więcej sugestii otrzymasz.
Gap Mode (Tryb przerwy)
      Aktywuj ten przycisk, aby uzyskać sugestie dotyczące akordów pomiędzy 2 zdefiniowanymi 
      akordami, na podstawie poprzedniego i następnego akordu. Dezaktywuj ten przycisk, aby 
      uzyskać sugestie dotyczące następnego akordu na podstawie poprzedniego akordu.
UWAGA
Aby to zadziałało, musisz wybrać wszystkie niezdefiniowane akordy pomiędzy 2 zdefiniowanymi 
akordami.

Algorithm Mode (Tryb algorytmu)
      Wybierz opcję Cadence (Kadencja), aby zbudować progresję akordów w oparciu o kadencję. 
      Wybierz opcję Common Notes (Wspólne nuty), aby zbudować progresję, określając liczbę 
      wspólnych nut, jakie mają współdzielić akordy.
Cadence Type (Typ rytmu)
UWAGA
Ta opcja jest dostępna tylko po wybraniu Cadence jako Algorithm Mode (trybu algorytmu).

Umożliwia wybór typu rytmu dla sugestii. W ten sposób sugerowane są tylko akordy o określonych
funkcjach harmonicznych.

959



Chord Assistant tabs (Karty Asystenta Akordów)
      Kliknij zakładki, aby otworzyć jeden z trybów asystenta akordów.

Chord Assistant – Proximity (Asystent Akordów – Bliskość)
Tryb Proximity (zbliżeniowy) Chord Assistant uwzględnia zestaw reguł harmonicznych, aby 
zaproponować sugestie pasujące do akordu początkowego.

Jeśli otworzysz Chord Assistant dla zdarzenia akordowego, poprzednie zdarzenie zostanie 
ustawione jako akord początkowy. Jest to pokazane w dolnej środkowej części Chord Assistant. 
Im dalej sugestia znajduje się w grafice od akordu początkowego, tym bardziej złożona jest 
sugestia. Sugerowane akordy to triady lub akordy 4-dźwiękowe.

● Aby przypisać akord do wybranego zdarzenia akordu i zagrać go, kliknij go.
   Trzy ostatnie sugerowane akordy, które kliknąłeś, są pogrubione.

UWAGA
● Jeśli przesuniesz wskaźnik myszy nad jedną z sugestii w Chord Assistant (Asystencie akordów),
wyświetli się podpowiedź z sugestiami dotyczącymi progresji.
● Tryb Proximity (zbliżeniowy) podlega tym samym zasadom, co tryb List (listy).

Dodawanie zdarzeń akordów na podstawie sugestii
Jeśli nie wiesz, jak powinna wyglądać progresja akordów, możesz skorzystać z Chord Assistant 
(Asystenta akordów), aby uzyskać sugestie dotyczące następujących akordów.

WARUNEK WSTĘPNY
Dodałeś zdarzenie akordowe na ścieżce akordów.

PROCEDURA
1. Kliknij dwukrotnie zdarzenie akordu.
2. Kliknij opcję Chord Assistant (Asystent akordów).
3. Kliknij opcję Add Chord (Dodaj akord).
4. Wykonaj jedną z następujących czynności:
      ● Aby wyświetlić sugestie na liście, kliknij kartę List (Lista).

960



                 
● Aby wyświetlić sugestie w formie graficznej, kliknij zakładkę Proximity (Bliskość).

5. Kliknij sugestię, aby ją wybrać.

WYNIK
Sugerowany akord zostanie dodany jako zdarzenie akordu do ścieżki akordów. Powtórz powyższe 
kroki, aby utworzyć tyle zdarzeń akordowych, ile wymaga Twoja struktura harmoniczna.

Chord Assistant – Circle of Fifths (Asystent akordów – Krąg kwint)
Tryb Circle of Fifths w Chord Assistant pokazuje akordy w interaktywnej wizualizacji koła 
kwintowych.
Akord początkowy, który definiuje bieżącą tonację, jest pokazany na środku Asystenta akordów 
i jest oznaczony jako toniczny (I).
Zewnętrzny okrąg przedstawia dwanaście akordów głównych uporządkowanych w odstępach 
kwintowych.
Wewnętrzny okrąg wyświetla odpowiednie równoległe akordy molowe.

961



Cyfry rzymskie oznaczają akordy aktualnej tonacji wraz ze stopniem skali. Możesz używać tych 
akordów do tworzenia typowych progresji akordów lub możesz używać innych akordów, aby 
uzyskać bardziej kreatywne rezultaty.

● Aby zagrać akord i przypisać go do wybranego zdarzenia akordu, kliknij go. Trzy ostatnie  
   kliknięte akordy są pogrubione.
● Aby zdefiniować nową tonację, kliknij prawym przyciskiem myszy akord w Chord Assistant    
   (Asystencie akordów) i wybierz opcję Use as Origin (Użyj jako początku) lub użyj elementów 
   sterujących Rotate Left/Rotate Right (Obróć w lewo/Obróć w prawo).
● Aby wybrać równoległy akord molowy i zdefiniować go jako tonację, kliknij Major/Minor 
   (Dur/Moll).

Przesłuchiwanie zdarzeń Chord (akordowych)
Aby odtwarzać zdarzenia akordów na ścieżce akordów, należy podłączyć ścieżkę akordów do 
wyjścia instrumentu lub ścieżki MIDI.

WARUNEK WSTĘPNY
Dodałeś ścieżkę akordów i zdarzenia akordów.

PROCEDURA
1. W obszarze globalnego sterowania utworami na liście utworów kliknij opcję Add Track (Dodaj  

   ścieżkę) .
2. Kliknij Instrument.
3. Otwórz menu podręczne Instrument i wybierz instrument VST.
4. Kliknij opcję Add Track (Dodaj ścieżkę). Ścieżka instrumentu zostanie dodana do listy utworów
    i otworzy się panel sterowania wybranego instrumentu VST.
5. Wybierz dźwięk.
6. W Inspektorze ścieżki akordów włącz opcję Acoustic Feedback (Sprzężenie akustyczne).
7. Z wyskakującego menu Select Track for Auditioning (Wybierz ścieżkę do odsłuchania) 
    wybierz ścieżkę, której chcesz użyć do odsłuchania.
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WYNIK
Zdarzenia akordów na ścieżce akordów wyzwalają teraz dźwięk przypisanego instrumentu na 
ścieżce MIDI lub instrumentu.

POWIĄZANE LINKI
Ścieżka akordów na stronie 153
Okno dialogowe Dodaj ścieżkę – instrument na stronie 126

Zmiana sposobu wyświetlania zdarzeń akordów
Możesz zmienić sposób wyświetlania zdarzeń akordów. Jest to przydatne, jeśli zdarzenia akordów 
nakładają się na siebie przy niskim poziomie powiększenia lub jeśli nie podoba Ci się typ czcionki.

PROCEDURA
1. Na ścieżce akordów aktywuj opcję Resolve Display Conflicts (Rozwiąż konflikty wyświetlania).

               
2. W oknie dialogowym Preferences (Preferencje) wybierz opcję Event Display >    
    Chords&Pitches (Wyświetlanie zdarzeń > Chords&Pitches i ustaw czcionkę akordów.
    Tutaj możesz także określić nazwę nuty i format nazewnictwa.

Scale Events (Zdarzenia skali) 
Zdarzenia skali informują, które zdarzenia akordów pasują do określonej sekwencji nut należących 
do określonej nuty prymy (root note).

Cubase automatycznie tworzy zdarzenia skali dla zdarzeń akordów.

● Aby wyświetlić zdarzenia skali, aktywuj opcję Show Scales (Pokaż skale) na ścieżce akordów.

               
● Aby odsłuchać nuty należące do zdarzenia skali, kliknij je.

Można jednak także dodawać i edytować zdarzenia skali ręcznie.

Zdarzenia skali mają określoną pozycję początkową. Ich koniec wyznacza początek kolejnego 
zdarzenia skali.

Edycja zdarzeń skali

WARUNEK WSTĘPNY
Dodałeś ścieżkę akordów i zdarzenia akordów. Wyłączyłeś Automatic Scales (Automatyczne 
skale) w Inspektorze ścieżki akordów.

PROCEDURA
1. Na ścieżce akordów aktywuj opcję Show Scales (Pokaż skale).
    Wyświetlany jest pas skali ze zdarzeniami skali.
2. Wybierz zdarzenie akordowe.
    Zdarzenie skali jest pokazane na pasku skali.
3. Wykonaj jedną z następujących czynności:
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● Kliknij pierwsze zdarzenie skali na ścieżce akordów i w wierszu informacyjnym wybierz Root 
   Key (tonację podstawową) i Type (typ).

                               
● Kliknij dwukrotnie zdarzenie skali i na wyświetlonej klawiaturze wybierz Root Key i Type skali.

                                  
Klawisze odpowiadające skali są podświetlone.

POWIĄZANE LINKI
Asystent skalowania w Edytorze klawiszowym na stronie 849

Musical Scale Setup Dialog (Okno dialogowe ustawień skali 
muzycznej)
Okno dialogowe Musical Scale Setup umożliwia konfigurowanie skal muzycznych i zarządzanie 
nimi.
● Aby otworzyć okno dialogowe Musical Scale Setup, wybierz Project > Chord Track > Set up  
   Musical Scales (Projekt > Ścieżka akordów > Ustaw skale muzyczne) 

                     
Add Scale (Dodaj skalę)
      Dodaje nową skalę do listy. Użyj wyświetlacza klawiatury, aby zdefiniować podziałkę skali.  
      Wszystkie skale zaczynają się od C jako prymy.
Factory Defaults (Ustawienia fabryczne)
      Resetuje wszystkie skale.
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Use (Użyj)
      Aktywuje skalę.
UWAGA
Aktywowane skale muzyczne są używane na ścieżce akordów, w sekcji Scale Assistant (Asystenta 
Skali) w Inspector Key Editor (Inspektorze edytora klawiszowego), w oknie Transpose Setup 
(Ustawienia transpozycji) oraz w sekcji MIDI Modifiers (Modyfikatory MIDI) w Inspektorze.

Name (Nazwa)
      Nazwa skali. Kliknij dwukrotnie, aby to zmienić.
Scales (Skale)
      Wyświetla klawiaturę umożliwiającą zdefiniowanie wysokości skali. Kliknij klawisz, aby 
      włączyć/wyłączyć wysokość skali. Wszystkie skale zaczynają się od C jako prymy.
Preview Scale (Podgląd skali)
      Odtwarza skalę.
UWAGA
Aby możliwe było odtwarzanie, wybrana ścieżka MIDI lub instrumentu musi mieć możliwość 
nagrywania, a jej sygnał wyjściowy musi być skierowany do instrumentu.

Information (Informacja)
      Informuje, czy skala pasuje do innej skali lub ma taką samą nazwę jak inna skala.
Remove Scale (Usuń skalę)
      Usuwa odpowiednią skalę z sugestii skali.
UWAGA
Wszelkie zmiany dotyczą całej aplikacji. Dzięki temu możesz jednorazowo dostosować skale 
i używać ich we wszystkich projektach. Jeśli jednak usuniesz skale używane w innych projektach 
lub zmienisz ich nazwy, nie będzie można ich odzyskać.

POWIĄZANE LINKI
Ścieżka akordów na stronie 943
Asystent skalowania w Edytorze klawiszowym na stronie 849
Okno dialogowe ustawień transpozycji na stronie 792
Sekcja Modyfikatory MIDI na stronie 774

Głosy
Brzmienia (głosy) określają sposób konfiguracji zdarzeń akordów. Określają one odstępy w pionie 
i kolejność wysokości akordu, ale także instrumentację i gatunek utworu muzycznego.

Na przykład akord C może być rozłożony na szeroki zakres tonacji, a pianista wybierze inne nuty 
niż gitarzysta. Pianista może także grać zupełnie inne wysokości (pitches) dla różnych gatunków 
muzycznych.

● Możesz ustawić brzmienie całej ścieżki akordów w Inspektorze ścieżek akordów.
● Możesz ustawić brzmienia dla poszczególnych zdarzeń akordów w wyskakującym menu Voicing
   (Brzmienie) w wierszu informacyjnym.

UWAGA
Jeśli w Inspektorze ścieżki akordów włączona jest funkcja Adaptive Voicings (Dźwięki 
adaptacyjne), w wierszu informacyjnym można zmieniać brzmienia tylko dla pierwszego zdarzenia 
akordowego.
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Ustawienia inspektora dla głosów
Aby skonfigurować brzmienia dla całej ścieżki akordów, możesz użyć Inspektora ścieżki akordów.

                 

Voicing library (Biblioteka głosów)
      Umożliwia wybranie biblioteki brzmień Guitar (gitary), Piano (fortepianu) lub Basic   
      (podstawowy).
Voicing library subset (Podzbiór biblioteki głosów)
UWAGA
Ta opcja jest dostępna tylko wtedy, gdy jako bibliotekę brzmień ustawiono Guitar (Gitarę) lub 
Piano (Fortepian).
      Umożliwia wybranie wstępnie ustawionego podzbioru biblioteki brzmień.
Set up Voicing (Skonfiguruj głos)
      Otwiera panel Custom Voicing (Niestandardowe brzmienie), które umożliwia skonfigurowanie 
      własnych parametrów brzmienia dla określonego schematu brzmienia.
Adaptive Voicings (Dźwięki adaptacyjne)
      Aktywuj tę opcję, aby Cubase automatycznie ustawiał brzmienia. Zapobiega to nadmiernemu 
      podskakiwaniu poszczególnych głosów.
Automatic Scales (Skale automatyczne)
      Aktywuj tę opcję, aby Cubase automatycznie ustawiał skalę.
Shift Chords (Przesunięcie akordów)
      Jeśli wprowadzisz ujemną liczbę taktów, zdarzenia akordów będą miały wpływ na nuty MIDI, 
      które zostały wyzwolone zbyt wcześnie

POWIĄZANE LINKI
Panel niestandardowych brzmień na stronie 954

Custom Voicing Panel (Niestandardowy panel głosowy)

Jeśli klikniesz opcję Set up Voicing (Skonfiguruj brzmienie) w sekcji Chords (Akordy) w 
Inspektorze, możesz skonfigurować własne parametry brzmienia dla określonego schematu 
brzmienia.

● Aby otworzyć panel Custom Voicing (Niestandardowe brzmienie), kliknij opcję Set up Voicing 
(Skonfiguruj brzmienie) w sekcji Chords (Akordy) w Inspektorze.
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W sekcji Style (Styl) brzmień Piano (fortepianowych) możesz skonfigurować następujące 
parametry:
Triads (Triady)
      Ustawia triadę. Akordy zawierające więcej niż 3 nuty nie ulegają zmianie.
Triads with maj9 (Triady z maj9)
      Ustawia triadę z dziewiątą wielką, ale bez prymy. Akordy zawierające więcej niż 3 nuty nie 
      ulegają zmianie.
Triads with maj9 and min9 (Triady z maj9 i min9)
      Ustawia triadę z durową i małą dziewiątą, ale bez prymy. Akordy zawierające więcej niż 3 nuty 
      nie ulegają zmianie.
4-Note Chords (Akordy 4-nutowe)
      Ustawia 4-dźwiękowy akord bez prymy. Akordy zawierające mniej niż 3 nuty nie ulegają 
      zmianie.
4-Note Chords (Open Jazz) (Akordy 4-nutowe (otwarty jazz))
      Ustawia 4-dźwiękowy akord bez prymy i bez kwinty. Akordy zawierające mniej niż 3 nuty nie 
      ulegają zmianie.
5-Note Chords (Akordy 5-nutowe)
      Ustawia akord pięciodźwiękowy z dziewiątą. Akordy zawierające mniej niż 4 nuty nie ulegają 
      Zmianie.

W sekcji Options (Opcje) brzmień Piano (fortepianowych) możesz skonfigurować następujące 
parametry:
Add Root Note (Dodaj nutę główną)
       Dodaje nutę podstawową.
Duplicate Root (Duplikuj korzeń)
       Duplikuje nutę podstawową.
Fatten up (Tuczyć się)
       Duplikuje tenor.
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W sekcji Voicing Range (Zakres brzmień) dla brzmień Piano (fortepianowych) możesz 
skonfigurować następujące parametry:
Lowest Root Note (Najniższa nuta główna)
      Ustawia limit najniższej prymy.
Lowest Note (Najniższa nuta)
      Ustawia limit najniższej nuty, z wyjątkiem nuty prymy.
Highest Note (Najwyższa nota)
      Ustawia limit najwyższej nuty, z wyjątkiem nuty prymy.

W sekcji Style (Styl) brzmień Guitar (gitarowych) możesz skonfigurować następujące parametry:
Triads (Triady)
      Ustawia triadę z 4, 5 lub 6 głosami.
4-Note Chords (Akordy 4-nutowe)
      Ustawia 4-dźwiękowy akord z 4, 5 lub 6 głosami bez napięć (tensions).
3-String Triads (Triady 3-strunowe)
      Ustawia triadę 3-strunową.
Modern Jazz (Nowoczesny jazz)
      Ustawia akordy 4-dźwiękowe, 5-dźwiękowe i 6-dźwiękowe, częściowo bez prymy, ale z 
      napięciami (tensions)

W przypadku brzmień Basic (podstawowych) dostępne jest tylko Octave Offset from C3 
(przesunięcie oktawy z C3). Umożliwia to określenie wartości przesunięcia dla zakresu oktaw.
W sekcji Start Voicing (Brzmienie początkowe) dla brzmień Piano (fortepianowych), Guitar 
(gitarowych) i Basic (podstawowych) możesz wybrać brzmienie początkowe.

UWAGA
Opcja ta jest dostępna tylko dla ścieżek MIDI, instrumentów i audio, ale nie dla ścieżki akordów 
i tylko wtedy, gdy w wyskakującym menu Follow Chord Track (Śledź ścieżkę akordów) 
wybierzesz opcję Voicings (Brzmienia).

Konwersja zdarzeń akordów na MIDI
Możesz konwertować zdarzenia akordów na MIDI w celu dalszej edycji lub wydrukowania arkusza
prowadzącego w Score Editor (edytorze partytury).

PROCEDURA
1. W obszarze globalnego sterowania utworami na liście utworów kliknij opcję Add Track (Dodaj 
    ścieżkę) .
2. Wykonaj jedną z następujących czynności:
      ● Kliknij Instrument, aby dodać ścieżkę instrumentu.
      ● Kliknij MIDI, aby dodać ścieżkę MIDI.
3. Kliknij opcję Add Track (Dodaj ścieżkę).
4. Wykonaj jedną z następujących czynności:
      ● Aby przekonwertować wszystkie zdarzenia akordów na MIDI, wybierz Project > Chord 
         Track > Chords to MIDI (Projekt > Ścieżka akordów > Akordy na MIDI).
      ● Aby przekonwertować tylko wybrane akordy na MIDI, wybierz zdarzenia akordów i 
         przeciągnij je na ścieżkę MIDI lub instrumentu.

WYNIK
Utworzona zostanie nowa partia MIDI zawierająca akordy jako zdarzenia MIDI.

POWIĄZANE LINKI
Okno dialogowe Dodaj ścieżkę – instrument na stronie 126
Okno dialogowe Dodaj ścieżkę – MIDI na stronie 132
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Przypisywanie zdarzeń akordów do efektów MIDI lub instrumentów 
VST
WARUNEK WSTĘPNY
Utwórz progresję akordów na ścieżce akordów i dodaj do swojego projektu ścieżkę MIDI lub 
ścieżkę instrumentu.

PROCEDURA
1. W Inspektorze ścieżki MIDI lub instrumentu otwórz sekcję MIDI Inserts (wstawek MIDI).
2. Kliknij miejsce na wstawienie i wybierz Chorder (Akord) z wyskakującego menu Effect Type  
    (Typ efektu). Efekt Chorder zostanie aktywowany i otworzy się jego panel sterowania.
3. Na ścieżce akordów wybierz zdarzenia akordów i przeciągnij je do panelu sterowania Chorder. 
    Pozycja opadania określa obszar prędkości i położenie pierwszego zdarzenia akordu. Wszystkie 
    kolejne zdarzenia akordów są odwzorowywane chromatycznie. Zdarzenia akordów z więcej niż 
    jednym wystąpieniem są przypisywane tylko raz.
    Aby ponownie przypisać akordy, przytrzymaj klawisz Alt/Opt i przeciągnij ponownie.
4. Na klawiaturze MIDI naciśnij odpowiednie klawisze, aby odtworzyć akordy.

Przypisywanie zdarzeń akordów do padów HALion Sonic SE

WARUNEK WSTĘPNY
Utwórz progresję akordów na ścieżce akordów i dodaj do swojego projektu ścieżkę instrumentu za 
pomocą HALion Sonic SE jako instrumentu VST.

PROCEDURA
1. Na ścieżce akordów wybierz zdarzenia akordów i przeciągnij je do padów HALion Sonic SE. 
    Pierwsze zdarzenie akordowe jest mapowane do padu, w którym został upuszczony, a wszystkie 
    kolejne zdarzenia akordowe są mapowane do kolejnych padów.
2. Kliknij odpowiednie pady na klawiaturze HALion Sonic SE, aby uruchomić akordy.

Sterowanie odtwarzaniem MIDI lub audio za pomocą ścieżki akordów
Ścieżki akordów można używać do sterowania odtwarzaniem audio lub MIDI.

Sekcja Chords (akordów) dla ścieżek audio

Sekcja Chords w Inspektorze ścieżki audio pozwala określić, w jaki sposób zdarzenia na ścieżce 
audio są mapowane na ścieżkę akordów

● Aby otworzyć sekcję Chords (Akordy) dla ścieżki audio, wybierz ścieżkę i w Inspektorze 
kliknij sekcję Chords.
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Follow Chord Track (Podążaj ścieżką akordów)
      Wybierz opcję, aby określić, w jaki sposób zdarzenia na ścieżce są mapowane na ścieżkę 
      akordów.
This Track’s Voicings (Głosy tej ścieżki)
      Umożliwia wybranie biblioteki brzmień lub użycie brzmień ze ścieżki akordów. Opcja ta jest 
      dostępna tylko po wybraniu opcji Voicings (Brzmienia) lub Single Voice (Pojedynczy głos) w 
      wyskakującym menu Follow Chord Track (Śledź ścieżkę akordów).

POWIĄZANE LINKI
Korzystanie z funkcji Follow Chord Track na stronie 959
Postępuj zgodnie z trybami ścieżki akordów na stronie 960

Sekcja Chords (akordów) dla ścieżek MIDI
Sekcja Chords w Inspektorze ścieżek MIDI pozwala określić, w jaki sposób zdarzenia na ścieżce 
MIDI są mapowane na ścieżkę akordów.

● Aby otworzyć sekcję Chords (Akordy) dla ścieżki MIDI, wybierz ścieżkę i w Inspektorze 
   kliknij sekcję Chords.

                  
Follow Chord Track (Podążaj ścieżką akordów)
      Wybierz opcję, aby określić, w jaki sposób zdarzenia na ścieżce są mapowane na ścieżkę 
      akordów.
This Track’s Voicings (Głosy tej ścieżki)
      Umożliwia wybranie biblioteki brzmień lub użycie brzmień ze ścieżki akordów. Opcja ta jest 
      dostępna tylko po wybraniu opcji Voicings (Brzmienia) lub Single Voice (Pojedynczy głos) 
      w wyskakującym menu Follow Chord Track (Śledź ścieżkę akordów).
Live Input (Wejście na żywo)
      Umożliwia transpozycję sygnału wejściowego MIDI na żywo do sekwencji akordów na ścieżce 
      akordów.

POWIĄZANE LINKI
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Korzystanie z funkcji Follow Chord Track na stronie 959
Postępuj zgodnie z trybami ścieżki akordów na stronie 960
Korzystanie z funkcji wprowadzania na żywo na stronie 959
Strefa padów akordowych na stronie 964
Konfiguracja odtwarzacza na stronie 978

Korzystanie z wejścia na żywo
Live Input (Wejście na żywo) umożliwia transpozycję sygnału wejściowego MIDI na żywo do 
sekwencji akordów na ścieżce akordów. W ten sposób nie musisz się martwić, który klawisz 
naciśniesz na klawiaturze MIDI, ponieważ wejście MIDI jest transponowane w czasie 
rzeczywistym w celu dopasowania akordów lub skal na ścieżce akordów.

PROCEDURA
1. Utwórz ścieżkę MIDI lub instrumentu i aktywuj opcję Record Enable (Włącz nagrywanie).
2. W Inspektorze otwórz sekcję Chords (Akordy).
3. Otwórz wyskakujące menu Live Input (Wejście na żywo) i wykonaj jedną z następujących 
    czynności:
       ● Aby zmapować wejście MIDI na zdarzenia akordowe, wybierz Chords (Akordy).
       ● Aby zmapować wejście MIDI na zdarzenia skalowania, wybierz opcję Scales (Skale).
4. Naciśnij kilka klawiszy na klawiaturze MIDI lub On-Screen Keyboard (Klawiaturze 
    ekranowej).

WYNIK
Każdy naciśnięty klawisz jest mapowany w czasie rzeczywistym na zdarzenia akordów lub skali na 
ścieżce akordów.

POWIĄZANE LINKI
Asystent skalowania w Edytorze kluczy na stronie 849
Mapowanie wysokości dźwięków przychodzących nut MIDI na skale muzyczne na stronie 859

Korzystanie ze ścieżki akordów
Umożliwia to dopasowanie istniejącego nagrania do sekwencji akordów na ścieżce akordów.

PROCEDURA
1. Wybierz ścieżkę, którą chcesz dopasować do ścieżki akordów.
2. W Inspektorze kliknij Chords (Akordy).
3. Otwórz wyskakujące menu Follow Chord Track (Podążaj za ścieżką akordów) i wybierz tryb.
UWAGA
Jeśli otwierasz to menu podręczne ścieżki po raz pierwszy, otworzy się okno dialogowe Follow 
Chord Track (Podążaj za ścieżką akordów).
4. W oknie dialogowym Follow Chord Track wprowadź zmiany.
5. Kliknij OK.

WYNIK
Zdarzenia na Twojej ścieżce odpowiadają teraz progresji akordów na ścieżce akordów.

UWAGA
Jeśli dopasowałeś ścieżkę MIDI do ścieżki akordów, niektóre oryginalne nuty MIDI mogą zostać 
wyciszone. Aby ukryć te nuty w edytorach, włącz opcję Hide Muted Notes in Editors (Ukryj 
wyciszone nuty w edytorach) w oknie dialogowym Preferences (Preferencje) (Editing—Chords 
page) ((strona Edycja – Akordy)).

POWIĄZANE LINKI
Okno dialogowe Follow Chord Track (Postępuj zgodnie ze ścieżką akordów) na stronie 961
Follow Chord Track Modes (Postępuj zgodnie z trybami ścieżki akordów) na stronie 960
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Follow Chord Track Modes (Postępuj zgodnie z trybami ścieżki 
akordów)
Ta część Inspektora pozwala określić, w jaki sposób ścieżka podąża za ścieżką akordów.

                        

W wyskakującym menu Follow Chord Track (Podążaj za ścieżką akordów) dostępne są 
następujące opcje:
Off (Wyłączony)
      Follow Chord Track jest wyłączone.
Chords & Scales (Akordy i skale)
      Pozwala to zachować możliwie najszersze odstępy oryginalnego akordu lub skali.
Chords (Akordy)
      Spowoduje to transpozycję nut MIDI w celu dopasowania ich do nuty kluczowej i przypisanie 
      ich do bieżącego akordu.
Scales (Skale)
      Spowoduje to transpozycję nut MIDI w celu dopasowania do bieżącej skali. Pozwala to na 
      większą różnorodność nut i bardziej naturalne wykonanie.
Root Notes (Nuty podstawowe)
      Spowoduje to transpozycję nut MIDI w celu dopasowania do nuty podstawowej zdarzenia 
      akordowego. Efekt odpowiada użyciu ścieżki transpozycji. Ta opcja jest odpowiednia dla 
      ścieżek basowych.
Voicings (Głosy)
      Spowoduje to transpozycję nut MIDI w celu dopasowania do głosów z wybranej biblioteki 
      brzmień.
Single Voice (Pojedynczy głos)
      Mapuje nuty MIDI i segmenty VariAudio na nuty pojedynczego głosu (sopran, tenor, bas itp.) 
      dźwięczności. Użyj poniższego menu podręcznego, aby wybrać głos.

UWAGA
Jeśli zastosujesz ten tryb do wybranych ścieżek zawierających oddzielne głosy, możesz ustawić 
jedną ścieżkę jako główną, a pozostałe jako podrzędne głosy. W ten sposób możesz zmienić głos 
mastera, a slave'y będą podążać automatycznie.

POWIĄZANE LINKI
Przypisywanie brzmień do nut na stronie 962
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Okno dialogowe Follow Chord Track (Postępuj za ścieżką akordów)
To okno dialogowe otwiera się po pierwszym wybraniu opcji z wyskakującego menu Follow 
Chord Track (Podążaj za ścieżką akordów) w sekcji Chords (Akordy) w Inspektorze.

                           

Follow Directly (Śledź bezpośrednio)
   Aktywuj tę opcję, jeśli segmenty VariAudio lub nuty MIDI są już zgodne ze ścieżką akordów. 
   Dzieje się tak, jeśli wyodrębniłeś akordy ze zdarzeń MIDI na ścieżce, wybierając na przykład 
   Project > Chord Track > Create Chord Symbols (Projekt > Ścieżka akordów > Utwórz 
   symbole akordów).
Synchronize Track Data with Chord Track First (Najpierw zsynchronizuj dane ścieżki ze 
ścieżką akordów)
Aktywuj opcję Analyze Chords (Analizuj akordy), jeśli dane ścieżki nie mają nic wspólnego ze 
zdarzeniami akordów. Analizuje to zdarzenia MIDI i dopasowuje znalezione akordy do ścieżki 
akordów. Opcja ta jest dostępna tylko dla MIDI.
Aktywuj opcję Apply a Known Chord (Zastosuj znany akord), jeśli dane ścieżki nie mają nic 
wspólnego ze zdarzeniami akordów i jeśli nie ma zmian akordów. Określ Root Note (Nutę 
podstawową) i Chord Type (Typ akordu) swoich zdarzeń.

Korzystanie z mapowania na ścieżkę akordów
Umożliwia to dopasowanie poszczególnych części lub zdarzeń do sekwencji akordów na ścieżce 
akordów.

PROCEDURA
1. W oknie projektu wybierz zdarzenia lub partie, które chcesz zmapować na ścieżkę akordów.
2. Wybierz opcję Project > Chord Track > Map to Chord Track (Projekt > Ścieżka akordów >   
    Mapuj na ścieżkę akordów).
3. Z wyskakującego menu Mapping Mode (Tryb mapowania) wybierz tryb mapowania.
UWAGA
Jeśli wybierzesz opcję Voicings (Głosy) i nie zostaną znalezione żadne głosy, zamiast tego zostanie
użyty tryb Auto (automatyczny).

4. Kliknij OK.

WYNIK
Akordy i skale każdego zdarzenia lub części są analizowane i wykorzystywane do mapowania. Jeśli
nie zostaną znalezione żadne akordy, Cubase zakłada, że wykonanie odbywa się w „C”. Dostępne 
tryby mapowania i brzmienia odpowiadają parametrom Follow Chord Track (Podążaj za ścieżką 
akordów) w sekcji Chords (Akordy) w Inspector (Inspektorze).

POWIĄZANE LINKI
Postępuj zgodnie z trybami ścieżki akordów na stronie 960
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Przypisywanie głosów do nut
Możesz transponować nuty MIDI, aby dopasować je do głosów z wybranej biblioteki brzmień.

PROCEDURA
● Wybierz opcję Project > Chord Track > Assign Voices to Notes (Projekt > Ścieżka akordów > 
   Przypisz głosy do nut).

WYNIK
Wysokość nut odpowiada teraz brzmieniu ścieżki akordów i nadal można edytować nuty MIDI. 
Jeśli teraz wybierzesz notatkę w Key Editor (Edytorze klawiszowym), zobaczysz, że Voice (głos) 
w linii informacyjnej jest przypisany.

Wyodrębnianie zdarzeń akordów z MIDI
Możesz wyodrębniać akordy z nut, części lub ścieżek MIDI. Jest to przydatne, jeśli masz plik MIDI
i chcesz pokazać jego strukturę harmoniczną oraz użyć tego pliku jako punktu wyjścia do dalszych 
eksperymentów.

WARUNEK WSTĘPNY
Dodaj ścieżkę akordów i twórz nuty MIDI, które można interpretować jako akordy. Perkusja, 
monofoniczny bas lub ścieżki prowadzące (lead tracks) nie są odpowiednie

PROCEDURA
1. W oknie Project wybierz część lub jedną lub kilka ścieżek MIDI.
    Możesz także wybrać ścieżki MIDI, partie lub nuty, które chcesz wyodrębnić w Key Editor 
    (Edytorze tonacji), Score editor (Edytorze partytury) lub In-Place Editor (Edytorze lokalnym).
2. Wybierz Project > Chord Track > Create Chord Symbols (Projekt > Ścieżka akordów >  
    Utwórz symbole akordów).
3. Wprowadź zmiany i kliknij OK.

WYNIK
Zdarzenia akordów są dodawane na ścieżce akordów.

UWAGA
Możesz teraz otworzyć Chord Assistant (Asystenta Akordów) i tworzyć wariacje.

POWIĄZANE LINKI
Okno dialogowe Create Chord Symbols (Utwórz symbole akordów) na stronie 963
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Okno dialogowe Create Chord Symbols (Utwórz symbole akordów)
To okno dialogowe pozwala określić, które dane MIDI powinny być brane pod uwagę podczas 
wydobywania zdarzeń akordów z MIDI.

                             

Include Bass Notes (Dołącz nuty basowe)
   Aktywuj tę opcję, jeśli chcesz, aby zdarzenia akordów zawierały nutę basową.
Include Tensions (Uwzględnij napięcia)
   Aktywuj tę opcję, jeśli chcesz, aby zdarzenia akordów zawierały napięcia.
Detect Arpeggios (Wykryj arpeggia)
   Aktywuj tę opcję, jeśli chcesz, aby zdarzenia akordów zawierały akordy arpeggiowe, to znaczy 
   akordy, których nuty są grane jedna po drugiej, a nie wszystkie na raz.
Interpret Sustain Pedal (Interpretuj pedału Sustain)
   Aktywuj tę opcję, jeśli chcesz, aby zdarzenia akordów zawierały akordy pedału podtrzymania, 
   czyli nuty grane, gdy pedał podtrzymania jest wciśnięty.
Ignore Notes Shorter Than (Ignoruj nuty krótsze niż)
   Umożliwia określenie minimalnej długości uwzględnianych zdarzeń MIDI.

Nagrywanie zdarzeń akordów za pomocą klawiatury MIDI
Do nagrywania zdarzeń akordów na ścieżce akordów można używać klawiatury MIDI.

WARUNEK WSTĘPNY
Twój projekt zawiera ścieżkę instrumentu z włączoną opcją Record Enable (Nagrywanie 
włączone) lub Monitor.

PROCEDURA
1. Na ścieżce akordów aktywuj opcję Record Enable (Włącz nagrywanie).
2. Na panelu Transport aktywuj Record (Nagrywaj).
3. Zagraj kilka akordów na klawiaturze MIDI.

WYNIK
Wszystkie rozpoznane akordy są nagrywane jako zdarzenia akordów na ścieżce akordów.

UWAGA
Ścieżka akordów korzysta z własnych ustawień brzmienia. Dlatego nagrane zdarzenia akordów 
mogą brzmieć inaczej.

POWIĄZANE LINKI
Dodawanie zdarzeń akordów na stronie 945
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Chord Pads (Pady akordowe)

Pady akordowe umożliwiają grę akordami oraz zmianę ich brzmienia i napięcia. Pod względem 
harmonii i rytmu pozwalają na bardziej zabawne i spontaniczne podejście do kompozycji niż 
funkcje ścieżki akordowej.

Możesz:
● Grać akordami w czasie rzeczywistym za pomocą klawiatury MIDI.
● Nagrać swoje wykonanie jako zdarzenia MIDI na ścieżce MIDI lub instrumentu, a nawet na 
   ścieżce akordów.
UWAGA
Zakładamy, że masz podłączoną i skonfigurowaną klawiaturę MIDI.

POWIĄZANE LINKI
Głosy na stronie 953

Strefa Padów Akordowych
Pady akordów w dolnej części okna Project zawierają wszystkie funkcje potrzebne do pracy z 
padami akordów.

Aby otworzyć pady akordów, wybierz Project > Chord Pads > Show/Hide Chord Pads (Projekt 
> Pady akordów > Pokaż/ukryj pady akordów).

Pady akordów obsługują następujące elementy sterujące:

                     

1   Chord Pad Output Mode (Tryb wyjściowy padu akordowego)
Aktywuj tę opcję, aby wysyłać dane akordów do wszystkich ścieżek, które są monitorowane lub 
umożliwiają nagrywanie. Dezaktywuj tę opcję, aby wysyłać dane akordów wyłącznie do ścieżek, 
które są monitorowane lub umożliwiają nagrywanie i gdzie Input Routing (Przesyłanie wejściowe)
jest ustawione na Chord Pads (Pady akordowe).
UWAGA
Jeśli opcja Record-Enable allows MIDI Thru (Record-Enable pozwala na użycie MIDI Thru) jest 
wyłączona w oknie dialogowym Preferences (Preferencje) (Record—MIDI page) ((Nagrywanie – 
strona MIDI)), musisz aktywować Monitor, aby móc używać padów akordów.
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2   Current Player (Aktualny grający)
      Pokazuje wybranego gracza i otwiera wyskakujące menu, w którym możesz wybrać innego 
      grającego.
3   Current Mode (Aktualny tryb)
     Pokazuje wybrany tryb gracza i otwiera wyskakujące menu, w którym możesz wybrać inny tryb 
     gracza.
4   Chord Pad (Pad akordowy)
     Każdy pad akordowy może zawierać symbol akordu. Kliknij prawym przyciskiem myszy pad  
     akordowy, aby otworzyć menu kontekstowe tego padu akordowego. Aby zmienić akord 
     przypisany do padu akordów, kliknij opcję Open Editor (Otwórz edytor) na lewej krawędzi
     padu akordów.
5   Keyboard (Klawiatura)
     Pokazuje, które klawisze są grane po uruchomieniu padu akordowego. Aby powiększyć 
     klawiaturę, kliknij klawisz i przeciągnij w górę lub w dół. Aby przewinąć klawiaturę, kliknij i 
     przeciągnij w lewo lub w prawo.
6   Pads Remote Range (Zdalny zasięg padów)
     Klawisze podświetlone na niebiesko na klawiaturze odpowiadają klawiszom na klawiaturze 
     MIDI, które wyzwalają pady akordów. Możesz zdefiniować zdalny zasięg na stronie Pad 
Remote Control (Sterowanie padem przesyłania) w oknie dialogowym Chord Pads Setup 
(Ustawienia padów akordowych).
7   Remote Range for Voicings/Tensions/Transpose (Zdalny zakres brzmień/napięć/transpozycji)
     Klawisze podświetlone na zielono na wyświetlaczu klawiatury odpowiadają klawiszom na 
     klawiaturze MIDI, które zmieniają brzmienie, napięcie i ustawienia transpozycji padów. Możesz
     aktywować i zdefiniować te klawisze zdalne na stronie Pad Remote Control w oknie 
     dialogowym Chord Pads Setup.
8   Section Remote Range (Sekcja zdalnego zasięgu)
     Klawisze podświetlone na brązowo na klawiaturze odpowiadają klawiszom na klawiaturze 
     MIDI, które uruchamiają sekcje.
UWAGA
Sekcja zdalnego zasięgu jest wyświetlana tylko wtedy, gdy Player Modes (Tryby odtwarzacza) są 
ustawione na Sections (Sekcje).

9   Set up Chord Pads (Skonfiguruj pady akordowe)
     Otwiera okno dialogowe Chord Pads Setup (Konfiguracja padów akordowych).
10   Functions Menu (Menu funkcji)
      Otwiera wyskakujące menu z określonymi funkcjami i ustawieniami padów akordowych.
11   Chord Pads Presets (Presety padów akordowych)
       Umożliwia zapisywanie i ładowanie ustawień wstępnych dla padów akordowych i 
       odtwarzaczy.
12   Show/Hide Chord Assistant (Pokaż/ukryj asystenta akordów)
       Pokazuje/ukrywa okno Chord Assistant (Asystenta akordów), które wyświetla sugestie 
akordów pasujących do akordu określonego jako akord początkowy.
13   Show/Hide Player Setup (Pokaż/ukryj konfigurację odtwarzającego)
       Pokazuje/ukrywa opcje konfiguracji odtwarzacza.

POWIĄZANE LINKI
Okno dialogowe konfiguracji padów akordowych na stronie 985
Odtwarzanie i nagrywanie akordów na stronie 975
Odtwarzający i głosy na stronie 979
Otwieranie padów akordowych na stronie 69
Tryby odtwarzającego — sekcje na stronie 982
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Sterowanie padami akordowymi
Elementy sterujące padami akordowymi umożliwiają edycję padów akordowych.

● Aby wyświetlić elementy sterujące padem akordowym, przesuń mysz nad padem akordowym.

                               
1   Open Editor (Otwórz Edytor)
     Otwiera Chord Editor (Edytor akordów), który pozwala wybrać akord dla padu akordów.
2   Voicing indicators (Wskaźniki głosu)
     Pokazuje brzmienie akordu. Wskaźniki brzmień mogą być wyświetlane tylko wtedy, gdy poziom
     powiększenia w poziomie padów akordów jest wystarczająco wysoki.
3   Adaptive Voicing Reference/Use X as Origin for Chord Assistant (Odniesienie do  
     adaptacyjnego brzmienia/Użyj X jako początku dla Chord Assistant)
     Gdy aktywny pad akordów jest ustawiony jako odniesienie do brzmienia adaptacyjnego, jego 
     krawędzie są pokazane na żółto. Wszystkie pozostałe pady akordów podążają za jego 
     brzmieniem i są ustawione w taki sposób, aby nie odbiegały zbytnio od odniesienia. Jeśli pad 
     akordowy jest ustawiony jako początek okna Chord Assistant (Asystenta akordów), jego 
     krawędzie są pokazane na niebiesko. Ten pad akordów służy jako podstawa sugestii w oknie 
     Chord Assistant.
4   Assigned Chord (Przypisany akord)
     Pokazuje symbol akordu przypisany do padu akordów. Każdy pad akordowy może zawierać 
     jeden symbol akordu. Jeśli nazwa przypisanego akordu jest zbyt długa, aby wyświetlić ją na 
     klawiaturze akordów, zostanie ona podkreślona, a pełna nazwa akordu zostanie wyświetlona 
     w podpowiedzi.
5   AV (Adaptive Voicing)/L (Lock) (AV (dźwięk adaptacyjny)/L (blokada))
     Wszystkie pady akordów korzystają z adaptacyjnego brzmienia. Wskazuje na to AV. Jeśli 
     jednak zmienisz brzmienie padu ręcznie, brzmienie adaptacyjne zostanie wyłączone.
     Litera L oznacza, że pad akordowy jest zablokowany do edycji.
6   Voicing (Udźwiękowienie)
     Umożliwia ustawienie innego brzmienia dla padu akordowego.
7   Tensions (Napięcia)
     Umożliwia dodawanie/usuwanie napięć akordu.

Menu kontekstowe padu akordowego
● Aby otworzyć menu kontekstowe padów akordowych, kliknij pad akordowy prawym przyciskiem
myszy.
Use X as Origin for Chord Assistant (Użyj X jako początku dla Asystenta Akordów)
      Ustawia akord bieżącego padu jako akord początkowy asystenta akordów.
Assign Pad from MIDI Input (Przypisz pad z wejścia MIDI)
      Umożliwia przypisanie akordu poprzez naciśnięcie klawiszy na klawiaturze MIDI.
Lock (Zablokuj)
      Umożliwia zablokowanie padu akordów do edycji.
Adaptive Voicing (Dźwięk adaptacyjny)
      Wszystkie pady akordów korzystają z adaptacyjnego brzmienia. Jest to sygnalizowane 
      znacznikiem wyboru. Jeśli ręcznie zmienisz brzmienie padu, brzmienie adaptacyjne zostanie 
      wyłączone.
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Adaptive Voicings Reference (Odniesienie do brzmień adaptacyjnych)
      Ustawia bieżący pad jako odniesienie do brzmienia adaptacyjnego. Jeśli jest ustawione, 
      automatyczne brzmienia dla kolejnych padów są ustawione w taki sposób, aby nie odbiegały 
      zbytnio od brzmień referencyjnych. Tylko jeden pad może być ustawiony jako odniesienie do 
      brzmienia adaptacyjnego.
Unassign Pad (Usuń przypisanie padu)
      Usuwa przypisanie akordów do bieżącego padu.

Functions Menu (Funkcje menu) 

● Aby otworzyć funkcje menu, kliknij Functions Menu

                 

Show Voicing Indicators (Pokaż wskaźniki dźwięczności)
      Umożliwia włączanie/wyłączanie wskaźników brzmień, które mogą być wyświetlane na dole 
      każdego padu akordów.
Assign Pads from Chord Track (Przypisz pady ze ścieżki akordów)
      Przypisuje zdarzenia akordów ze ścieżki akordów do padów akordów w tej samej kolejności, 
      w jakiej pojawiają się na ścieżce akordów. Zdarzenia akordów, które mają więcej niż jedno   
      wystąpienie, są przypisywane tylko raz.
Snap Playback to Musical Grid (Przyciągnij odtwarzanie do siatki muzycznej)
      Umożliwia opóźnienie odtwarzania uruchomionego padu akordów do następnej określonej 
      pozycji muzycznej. Jest to przydatne, jeśli pracujesz z arpeggiatorem lub jeśli ustawisz Player 
      Modes (Tryby odtwarzacza) na Pattern (Wzór).
Transpose All Pads (Transponuj wszystkie pady)
      Transponuje wszystkie pady akordów o zdefiniowaną wartość transpozycji
Lock All Pads (Zablokuj wszystkie pady)
      Blokuje wszystkie pady akordów do edycji.
Unlock All Pads (Odblokuj wszystkie pady)
      Odblokowuje wszystkie pady akordów.
Unassign All Pads (Usuń przypisanie wszystkich padów)
      Usuwa przypisanie akordów do wszystkich padów.

Chord Assistant (Asystent akordów)
Chord Assistant umożliwia użycie akordu jako punktu wyjścia dla sugestii dotyczących 
następnego akordu. Pomaga w znalezieniu odpowiednich akordów do stworzenia sekwencji 
akordów dla utworu.

● Kliknij opcję Show/Hide Chord Assistant (Pokaż/ukryj Asystenta akordów) po lewej stronie 
obszaru padów akordów, aby otworzyć Chord Assistant (Asystenta akordów).
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Okno Chord Assistant (Asystenta akordów) ma 2 tryby:

● Proximity (Bliskość) 
● Circle of Fifths (Koło kwintowe)

Musisz zdefiniować akord początkowy w następujący sposób:

● Kliknij prawym przyciskiem myszy pad akordu, którego chcesz użyć jako początku, i wybierz 
opcję Use X as Origin for Chord Assistant (Użyj X jako początku dla Asystenta akordów).

Okno Chord Assistant wyświetla sugestie dotyczące kolejnych akordów, które można przypisać do
padów akordów.

Chord Assistant – List (Asystent akordów – lista)
Tryb List programu Chord Assistant umożliwia tworzenie harmonicznych progresji akordów w 
oparciu o reguły harmoniczne, które mogą być mniej lub bardziej złożone.

● Aby otworzyć Chord Assistant (Asystenta akordów), w Chord Editor (Edytorze akordów)  
   kliknij Chord Assistant.
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Go to Previous Chord/Go to Next Chord (Przejdź do poprzedniego akordu/Przejdź do następnego
akordu)
      Umożliwia wybranie poprzedniego/następnego akordu na ścieżce akordów do edycji.
Add Chord (Dodaj akord)
      Dodaje nowe, niezdefiniowane zdarzenie akordu na ścieżce akordów.
UWAGA
Działa to tylko wtedy, gdy wybrane jest ostatnie zdarzenie akordowe na ścieżce akordów.

Suggestions list (Lista sugestii)
      Pokazuje sugestie dotyczące następnego akordu. Kliknij sugestię akordu, aby ją wybrać.
Complexity filter (Filtr złożoności)
      Pozwala zwiększyć złożoność, a tym samym liczbę sugestii. Im wyższy poziom złożoności, tym
      więcej sugestii otrzymasz.
Gap Mode (Tryb przerwy)
      Aktywuj ten przycisk, aby uzyskać sugestie dotyczące akordów pomiędzy 2 zdefiniowanymi 
      akordami, na podstawie poprzedniego i następnego akordu.
      Dezaktywuj ten przycisk, aby uzyskać sugestie dotyczące następnego akordu na podstawie 
      poprzedniego akordu.
UWAGA
Aby to zadziałało, musisz wybrać wszystkie niezdefiniowane akordy pomiędzy 2 zdefiniowanymi 
akordami.

Algorithm Mode (Tryb algorytmu)
      Wybierz opcję Cadence (Kadencja), aby zbudować progresję akordów w oparciu o kadencję.   
      Wybierz opcję Common Notes (Wspólne nuty), aby zbudować progresję, określając liczbę 
      wspólnych nut, jakie mają współdzielić akordy.
Cadence Type (Typ rytmu)
UWAGA
Ta opcja jest dostępna tylko po wybraniu Cadence jako Algorithm Mode (trybu algorytmu).
Umożliwia wybór typu rytmu dla sugestii. W ten sposób sugerowane są tylko akordy o określonych
funkcjach harmonicznych.
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Chord Assistant tabs (Karty Asystenta Akordów)
       Kliknij zakładki, aby otworzyć jeden z trybów asystenta akordów.

Chord Assistant – Proximity Mode (Asystent akordów – Tryb 
zbliżeniowy)
Tryb zbliżeniowy okna Chord Assistant wykorzystuje zestaw reguł harmonicznych, aby oferować 
sugestie pasujące do akordu początkowego.

Akord początkowy w dolnej części okna Chord Assistant (Asystenta akordów) wyznacza środek 
tonalny. Im dalej od tego akordu znajduje się sugestia akordu, tym bardziej jest ona złożona. 
Sugerowane akordy to triady lub akordy 4-dźwiękowe.

● Aby zagrać sugerowany akord, kliknij go.
   Trzy ostatnie sugerowane akordy, które kliknąłeś, są pogrubione.
● Aby przypisać sugestię do następnego nieprzypisanego padu akordu, kliknij sugerowany akord  
   prawym przyciskiem myszy i wybierz opcję Assign to Pad (Przypisz do padu).
   Możesz także przeciągnąć sugerowany akord i upuścić go na padzie akordów.
● Aby przypisać sugestię do następnego nieprzypisanego padu akordu i użyć tego akordu jako  
   źródła dalszych sugestii, kliknij sugerowany akord prawym przyciskiem myszy i wybierz opcję    
   Assign to Pad and Use as Origin (Przypisz do padu i Użyj jako punktu początkowego).
UWAGA
Tryb Proximity (zbliżeniowy) to inna reprezentacja listy w oknie Chord Assistant (Asystenta 
akordów) dla ścieżki akordów.

POWIĄZANE LINKI
Chord Assistant – List na stronie 946

Chord Assistant – Circle of Fifths Mode (Asystent Akordów – tryb 
koła kwintowego)
Tryb Circle of Fifths w oknie Chord Assistant pokazuje akordy w interaktywnej wizualizacji koła 
kwintowego.
Akord początkowy, który definiuje bieżącą tonację, jest pokazany na środku okna Chord Assistant
(Asystenta akordów). Tonacja (I) tego klawisza jest wyświetlana nad środkiem. Zewnętrzny okrąg 
przedstawia dwanaście akordów głównych uporządkowanych w odstępach kwintowych.
Wewnętrzny okrąg wyświetla odpowiednie równoległe akordy molowe.
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Cyfry rzymskie oznaczają akordy aktualnej tonacji wraz ze stopniem skali. Możesz używać tych 
akordów do tworzenia typowych progresji akordów. Możesz jednak użyć także innych akordów, 
aby uzyskać bardziej kreatywne rezultaty.

● Aby zagrać akord, kliknij go.
   Trzy ostatnie kliknięte akordy są pogrubione.
● Aby przypisać akord do następnego nieprzypisanego padu akordowego, kliknij sugerowany akord
   prawym przyciskiem myszy i wybierz opcję Assign to Pad (Przypisz do padu).
   Możesz także przeciągnąć sugerowany akord i upuścić go na padzie akordów.
● Aby przypisać sugestię do następnego nieprzypisanego padu akordu i użyć tego akordu jako  
   początku, kliknij akord prawym przyciskiem myszy i wybierz Assign to Pad and Use as Origin 
   (Przypisz do padu i Użyj jako początku).
UWAGA
Circle of Fifths (Koło kwintowe) jest także dostępne w oknie Chord Assistant (Asystenta 
akordów) dla ścieżki akordów.

POWIĄZANE LINKI
Chord Assistant – lista na stronie 946

Przypisanie akordów
Niektóre akordy są wstępnie przypisane do padów akordów. Ale możesz także przypisać własne 
akordy.
Aby przypisać akordy do padów akordowych, możesz użyć:
● Okna Chord Editor (Edytora akordów)
● Chord Assistant – Proximity window (Asystenta Akordów – okno Bliskości)
● Chord Assistant – Circle of Fifths window (Asystent Akordów – okno Koła kwintowego)
● Twojej klawiatury MIDI
● Zdarzenia akordów ze ścieżki akordów

Usuwanie przypisania padów akordów
Możesz wyczyścić wszystkie przypisania akordów z padów akordów i zacząć od zera.

PROCEDURA
● Po lewej stronie padów akordów otwórz Functions Menu (Menu funkcji) i wybierz opcję 
   Unassign All Pads (Usuń przypisanie wszystkich padów).
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Przypisywanie akordów za pomocą edytora akordów
Jeśli wiesz dokładnie, który akord chcesz przypisać do konkretnego padu akordów, możesz 
skorzystać z Chord Editor (Edytora akordów).

PROCEDURA
1. Przesuń wskaźnik myszy na lewą krawędź padu akordów i kliknij Open Editor (Otwórz edytor).
2. W oknie Chord Editor użyj przycisków definicji akordu, aby zdefiniować nutę prymy, typ  
    akordu, napięcie (tension) i nutę basową.
    Nowy akord jest wyzwalany automatycznie, co daje informację akustyczną.

Przypisywanie akordów za pomocą Asystenta akordów – tryb 
zbliżeniowy (Proximity)
Jeśli masz akord, którego chcesz użyć jako punktu wyjścia do wyszukiwania kolejnych akordów, 
możesz skorzystać z okna Chord Assistant – Proximity (Asystent akordów – Bliskość).

PROCEDURA
1. Kliknij prawym przyciskiem myszy pad akordowy, którego chcesz użyć jako punktu  
    początkowego, i aktywuj opcję Use X as Origin for Chord Assistant (Użyj X jako punktu 
    początkowego dla Asystenta akordów).

Otworzy się okno Chord Assistant, a krawędzie padu akordów zmienią kolor, aby wskazać, że 
przypisany akord jest teraz używany jako początek.

2. W oknie Chord Assistant kliknij symbole akordów, aby uruchomić odpowiednie akordy.
    Im dalej akord znajduje się od akordu początkowego, uznawanego za środek tonalny, tym 
    bardziej złożona staje się sugestia.
3. Aby przypisać akord, przeciągnij go z okna Chord Assistant i upuść na pad akordowy.

UWAGA
Jeśli jeden z kolejnych padów akordów jest wolny, możesz także kliknąć akord prawym 
przyciskiem myszy w oknie Chord Assistant i wybrać opcję Assign to Pad (Przypisz do padu). 
Spowoduje to przypisanie akordu do następnego wolnego padu

POWIĄZANE LINKI
Chord Assistant – List na stronie 946
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Przypisywanie akordów za pomocą Asystenta akordów – tryb Circle 
of Fifths (Koła kwintowego)
Jeśli masz akord, którego chcesz użyć jako punktu wyjścia dla sekwencji akordów, ale nie wiesz, 
jak stworzyć taką progresję, możesz skorzystać z okna Chord Assistant – Circle of Fifths 
(Asystent akordów – Koło kwintowe).

PROCEDURA
1. Kliknij prawym przyciskiem myszy pad akordowy, którego chcesz użyć jako punktu     
    początkowego, i aktywuj opcję Use X as Origin for Chord Assistant (Użyj X jako punktu 
    początkowego dla Asystenta akordów).

Otworzy się okno Chord Assistant, a krawędzie padu akordów zmienią kolor, aby wskazać, że 
przypisany akord jest teraz używany jako początek.
2. Kliknij opcję Circle of Fifth (Koło kwintowe), aby przełączyć się do trybu Circle of Fifth.
    Akord początkowy jest wyświetlany pośrodku, a akordy należące do skali są pokazane nad nim.  
    Cyfry wskazują stopień skali akordów. To Ci w tym pomoże tworzyć progresje akordów.
3. W oknie Chord Assistant (Asystenta akordów) kliknij symbole akordów, aby uruchomić  
    odpowiednie akordy.
4. Aby przypisać akord, przeciągnij go z okna Chord Assistant i upuść na klawiaturze akordów.
UWAGA
Jeśli jeden z kolejnych padów akordów jest wolny, możesz także kliknąć akord prawym 
przyciskiem myszy w oknie Chord Assistant i wybrać opcję Assign to Pad (Przypisz do padu). 
Spowoduje to przypisanie akordu do następnego wolnego padu.

Przypisywanie akordów za pomocą klawiatury MIDI
Jeśli wiesz, który akord chcesz przypisać do konkretnego padu akordowego, możesz użyć 
klawiatury MIDI lub On-Screen Keyboard (klawiatury ekranowej).

WARUNEK WSTĘPNY
Wybrałeś ścieżkę MIDI lub ścieżkę instrumentu.

PROCEDURA
1. Kliknij prawym przyciskiem myszy pad akordu, którego chcesz użyć dla nowego akordu, 
    i wybierz opcję Assign Pad from MIDI Input (Przypisz pad z wejścia MIDI).
    Obramowanie padu akordowego zmienia swój kolor, wskazując, że jest on teraz gotowy do 
    nagrywania.
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2. Na klawiaturze MIDI lub On-Screen Keyboard (klawiaturze ekranowej) naciśnij klawisze 
odpowiadające akordowi, który chcesz przypisać.

Akord i jego brzmienie są przypisane do padu akordowego i słychać akustyczną informację zwrotną
dotyczącą akordu.

UWAGA
Przypisane brzmienie można zmienić za pomocą ustawienia Adaptive Voicing (Dźwięk 
adaptacyjny). Dlatego też, jeśli chcesz zachować brzmienie tego konkretnego padu, kliknij prawym 
przyciskiem myszy pad akordowy i wybierz Lock (Zablokuj) z menu kontekstowego.

POWIĄZANE LINKI
Adaptacyjne brzmienie na stronie 979

Przypisywanie akordów ze ścieżki akordów
Do padów akordów można przypisać zdarzenia akordów ze ścieżki akordów.

WARUNEK WSTĘPNY
Dodałeś do swojego projektu ścieżkę akordową ze zdarzeniami akordowymi.

PROCEDURA
● Po lewej stronie padów akordów kliknij przycisk Functions Menu (Menu funkcji) i wybierz  
   opcję Assign Pads from Chord Track (Przypisz pady ze ścieżki akordów).
   Jeśli akordy są już przypisane do padów akordowych, pojawi się komunikat ostrzegawczy 
   informujący, że wszystkie poprzednie przypisania zostaną nadpisane.

WYNIK
Zdarzenia akordów są przypisywane do padów akordów w tej samej kolejności, w jakiej pojawiają 
się na ścieżce akordów

UWAGA
Zdarzenia akordów, które mają więcej niż jedno wystąpienie na ścieżce akordów, są przypisywane 
tylko raz.

POWIĄZANE LINKI
Dodawanie ścieżki akordów na stronie 943
Dodawanie zdarzeń akordów na stronie 945

Zamiana przypisań akordów
Można zamienić przypisania akordów 2 padów.

PROCEDURA
● Kliknij pad akordowy i przeciągnij go do innego padu akordowego.
   Podczas przeciągania ramka docelowego padu akordów zmienia swój kolor.

WYNIK
Kiedy upuścisz pad na inny, przypisania akordów zostaną zamienione wraz z ich ustawieniami, z 
wyjątkiem Adaptive Voicing Reference (Odniesienie do adaptacyjnego brzmienia).
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Kopiowanie przypisań akordów
Możesz skopiować przypisanie akordów jednego padu i wkleić je do innego padu.

PROCEDURA
● Alt/Opt – kliknij pad akordowy i przeciągnij go do innego padu akordowego.
   Podczas przeciągania ramka docelowego padu akordów zmienia swój kolor.

WYNIK
Kiedy upuścisz pad na inny, przypisanie pierwszego padu zostanie skopiowane do docelowego 
padu akordów wraz z jego ustawieniami, z wyjątkiem Adaptive Voicing Reference (Odniesienie 
do adaptacyjnego brzmienia).

Odtwarzanie i nagrywanie akordów
Można odtwarzać i nagrywać akordy przypisane do padów akordów przy użyciu ścieżek MIDI lub 
ścieżek instrumentów.

Istnieją dwa różne tryby wyjścia Chord Pad Output Modes, które określają, czy akordy 
przypisane do padów akordów mogą być odtwarzane i nagrywane przy użyciu dowolnych lub 
ekskluzywnych ścieżek MIDI lub instrumentów:
●   Chord Pad Output Mode: On (Tryb wyjścia Chord Pad: Włączony)
     Umożliwia odtwarzanie i nagrywanie padów akordów przy użyciu dowolnej ścieżki MIDI lub 
     instrumentu, przy włączonej opcji Record Enable (Nagrywanie włączone) lub Monitor.
●   Chord Pad Output Mode: Off (Tryb wyjścia padu akordowego: Wyłączony)
     Umożliwia odtwarzanie i nagrywanie padów akordów przy użyciu ekskluzywnych ścieżek MIDI
     lub instrumentów, gdy włączona jest funkcja Record Enable lub Monitor i gdy w  
     wyskakującym menu Output Routing (wyjście przesyłania) wybrano opcję Chord Pads jako 
     wejście MIDI.
UWAGA
Jeśli opcja Record-Enable allows MIDI Thru (Record-Enable pozwala na użycie MIDI Thru) jest 
wyłączona w oknie dialogowym Preferences (Preferencje) (Record (Nagrywanie) – strona MIDI), 
musisz aktywować Monitor, aby móc używać padów akordów.

POWIĄZANE LINKI
Strefa padów akordowych na stronie 964
Nagrywanie akordów na ścieżce akordów na stronie 977
Nagrywanie akordów na ścieżkach instrumentów na stronie 977
Odtwarzanie padów akordów przy użyciu dowolnej ścieżki instrumentu na stronie 975
Odtwarzanie padów akordów przy użyciu wyjątkowych ścieżek instrumentów na stronie 976

Odtwarzanie padów akordów przy użyciu dowolnej ścieżki 
instrumentu
Pady akordów można odtwarzać przy użyciu dowolnej ścieżki MIDI lub instrumentu, przy 
włączonej opcji Record Enable lub Monitor.

WARUNEK WSTĘPNY
Podłączyłeś i skonfigurowałeś klawiaturę MIDI.

PROCEDURA
1. W obszarze globalnego sterowania utworami na liście ścieżek kliknij opcję Add Track (Dodaj 

    ścieżkę)  .
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2. Kliknij Instrument.
3. Otwórz menu podręczne Instrument i wybierz VST Instrument.

4. Kliknij opcję Add Track (Dodaj ścieżkę).
    Ścieżka instrumentu zostanie dodana do listy ścieżek i otworzy się panel sterowania wybranego 
    instrumentu VST.
5. Na ścieżce instrumentu kliknij opcję Record Enable (Włącz nagrywanie) lub Monitor   
    (Monitoruj).
UWAGA
Jeśli opcja Record-Enable allows MIDI Thru (Record-Enable pozwala na użycie MIDI Thru) jest 
wyłączona w oknie dialogowym Preferences (Preferencje) (Record (Nagrywanie) – strona MIDI), 
musisz aktywować Monitor, aby móc używać padów akordów.
6. Wybierz opcję Project > Chord Pads > Show/Hide Chord Pads (Projekt > Pady akordów > 
    Pokaż/ukryj pady akordów), aby otworzyć pady akordów.
7. Aktywuj Chord Pad Output Mode (Tryb wyjścia akordów).
8. Naciśnij kilka klawiszy na klawiaturze MIDI, aby uruchomić akordy przypisane do padów 
    akordowych.

POWIĄZANE LINKI
Okno dialogowe Dodaj ścieżkę – instrument na stronie 126
Okno dialogowe konfiguracji padów akordowych na stronie 985
Zmiana zasięgu pilota zdalnego sterowania padami na stronie 988

Odtwarzanie padów akordów przy użyciu wyjątkowych 
(ekskluzywnych) ścieżek instrumentów
Pady akordów można odtwarzać przy użyciu ekskluzywnych ścieżek MIDI lub ścieżek 
instrumentów, gdy włączona jest funkcja Record Enable lub Monitor i gdy w wyskakującym 
menu Input Routing wybrano opcję Chord Pads jako wejście MIDI.

WARUNEK WSTĘPNY
Skonfigurowałeś klawiaturę MIDI.

PROCEDURA
1. W obszarze globalnego sterowania utworami na liście ścieżek kliknij opcję Add Track (Dodaj 

ścieżkę)  .
2. Kliknij Instrument.
3. Otwórz menu podręczne Instrument i wybierz VST Instrument.
4. Kliknij opcję Add Track (Dodaj ścieżkę).
    Ścieżka instrumentu zostanie dodana do listy ścieżek i otworzy się panel sterowania wybranego  
    instrumentu VST.
5. Na ścieżce instrumentu kliknij opcję Record Enable (Włącz nagrywanie) lub Monitor  
    (Monitoruj).

UWAGA
Jeśli opcja Record-Enable allows MIDI Thru (Record-Enable pozwala na użycie MIDI Thru) jest 
wyłączona w oknie dialogowym Preferences (Preferencje) (Record (Nagrywanie) – strona MIDI), 
musisz aktywować Monitor, aby używać padów akordowych

6. W Inspektorze ścieżki instrumentu otwórz wyskakujące menu Input Routing (Wejście 
    przesyłania) i wybierz opcję Chord Pads (Pady akordowe).
7. Wybierz opcję Project > Chord Pads > Show/Hide Chord Pads (Projekt > Pady akordów >  
    Pokaż/ukryj pady akordów), aby otworzyć pady akordów.
8. Dezaktywuj Chord Pad Output Mode (Tryb wyjścia akordów).
9. Naciśnij kilka klawiszy na klawiaturze MIDI, aby uruchomić akordy przypisane do padów  
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    akordowych.

WYNIK
Ścieżka instrumentu otrzymuje teraz dane MIDI wyłącznie z urządzenia z padem akordowym. Do 
wyzwalania padów akordowych można używać podłączonej klawiatury MIDI. To nadal działa, jeśli
ukryjesz Chord Pads (Pady akordów).

UWAGA
Na stronie Chord Pads (Pady akordowe) w oknie dialogowym Studio Setup (Konfiguracja studia) 
możesz wybrać podłączoną klawiaturę MIDI z wyskakującego menu MIDI Input (Wejście MIDI). 
Jest to przydatne, jeśli chcesz używać określonej klawiatury MIDI wyłącznie do wyzwalania padów
akordowych.

Nagrywanie akordów na ścieżkach instrumentów
Można nagrywać akordy wyzwalane przez pady akordowe na ścieżkach MIDI lub instrumentach.

WARUNEK WSTĘPNY
Podłączyłeś i skonfigurowałeś klawiaturę MIDI, otworzyłeś i skonfigurowałeś pady akordów oraz 
dodałeś instrument lub ścieżkę MIDI, dla której załadowano instrument VST.

PROCEDURA
1. Na ścieżce instrumentu kliknij opcję Record Enable (Włącz nagrywanie) lub Monitor 
    (Monitoruj).
UWAGA
Jeśli opcja Record-Enable allows MIDI Thru (Record-Enable pozwala na użycie MIDI Thru) jest 
wyłączona w oknie dialogowym Preferences (Preferencje) (Record (Nagrywanie – strona MIDI), 
musisz aktywować Monitor, aby móc używać padów akordów.

2. Na panelu Transport aktywuj Record (Nagrywaj).
3. Na klawiaturze MIDI naciśnij klawisze uruchamiające pady akordowe.

WYNIK
Wyzwalane akordy są nagrywane na ścieżce. Zdarzenia nutowe są automatycznie przypisywane do 
różnych kanałów MIDI zgodnie z ich wysokością. Zdarzenia nutowe odpowiadające głosowi 
sopranowemu są przypisane do kanału MIDI 1, altowe do kanału MIDI 2 itd.

PO ZAKOŃCZENIU TEGO ZADANIA
Otwórz Key Editor (Edytor klawiaturowy) i dostrój nagrane partie MIDI, na przykład za pomocą 
funkcji edycji akordów. Możesz także użyć opcji MIDI > Dissolve Part (MIDI > Rozłóż część), 
aby rozłożyć nagrane akordy według wysokości/kanałów.

Nagrywanie akordów na ścieżce akordów
Na ścieżce akordów można nagrywać akordy wyzwalane przez pady akordów. W ten sposób 
możesz łatwo tworzyć zdarzenia akordów, na przykład dla arkusza prowadzącego.

WARUNEK WSTĘPNY
Podłączyłeś i skonfigurowałeś klawiaturę MIDI, otworzyłeś i skonfigurowałeś pady akordów oraz 
dodałeś instrument lub ścieżkę MIDI, dla której załadowano instrument VST.

PROCEDURA
1. Na ścieżce instrumentu kliknij opcję Record Enable (Włącz nagrywanie) lub Monitor  
    (Monitoruj).
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UWAGA
Jeśli opcja Record-Enable allows MIDI Thru (Record-Enable pozwala na użycie MIDI Thru) jest 
wyłączona w oknie dialogowym Preferences (Preferencje) (strona Record (Nagrywanie) – MIDI), 
musisz aktywować Monitor, aby móc używać padów akordów.

2. Wybierz Project > Add Track > Chord (Projekt > Dodaj ścieżkę > Akord).
    Ścieżka akordów zostanie dodana do listy ścieżek.
3. W Inspektorze ścieżki akordów kliknij opcję Record Enable (Włącz nagrywanie).
4. Na panelu Transport aktywuj Record (Nagrywaj).
5. Na klawiaturze MIDI naciśnij klawisze uruchamiające pady akordów.

WYNIK
Zdarzenia akordów są nagrywane na ścieżce akordów.

UWAGA
Nagrane zdarzenia akordów mogą brzmieć inaczej niż odtwarzane za pomocą padu akordów. 
Dzieje się tak, ponieważ ustawienia brzmień ścieżki akordów różnią się od brzmień padów 
akordów.

POWIĄZANE LINKI
Ścieżka akordów na stronie 153
Funkcje akordów na stronie 943
Głosy na stronie 953

Player Setup (Ustawienia odtwarzacza)
Player Setup umożliwiają wybranie odtwarzacza i ustawień brzmienia typowych dla tego rodzaju 
odtwarzacza oraz określenie, czy nuty akordu mają być odtwarzane jako zwykłe akordy, jako wzór 
czy jako sekcje.

● Aby otworzyć Player Setup, kliknij opcję Show/Hide Player Setup (Pokaż/ukryj konfigurację 
odtwarzacza).

W sekcji Select Player (Wybierz odtwarzacz) dostępne są następujące opcje:

List of Added Players (Lista dodanych odtwarzaczy)
      Pokazuje dodane odtwarzacze i umożliwia aktywację odtwarzacza oraz użycie jego stylu 
      brzmienia i trybu odtwarzania dla padów akordów.
Player Options (Opcje odtwarzacza)
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      Umożliwia dodanie odtwarzacza oraz zmianę nazwy lub usunięcie bieżącego odtwarzacza.

W sekcji Selected Player Settings (Ustawienia wybranego odtwarzacza) dostępne są następujące 
opcje:
Chord Voicing Style (Styl brzmienia akordów)
      Umożliwia wybór stylu brzmienia akordów dla wybranego odtwarzacza. Określa sposób 
      odtwarzania akordów i używanych tonów.
Player Modes (Tryby odtwarzacza)
      ● Plain Chords (Zwykłe akordy) wyzwala jednocześnie wszystkie nuty akordu.
      ● Pattern (Schemat) odtwarza arpeggio oparte na nutach wzoru.
      ● Sections (Sekcje) kontrolują odtwarzanie pojedynczych nut lub grup nut akordu.

POWIĄZANE LINKI
Odtwarzacze i głosy na stronie 979
Głosy na stronie 953
Konfiguracja odtwarzacza na stronie 978

Odtwarzacze i głosy
Różne typy instrumentów i stylów mają różne biblioteki brzmień. Określają one sposób 
odtwarzania akordów i tonację. Te głosy nazywane są odtwarzaczami.

POWIĄZANE LINKI
Głosy na stronie 953

Adaptive Voicing (Dźwięk adaptacyjny)
W Cubase ustawienie adaptacyjnego brzmienia zapewnia, że wysokość tonów w progresjach 
akordów nie zmienia się gwałtownie.

Aktywowane jest brzmienie adaptacyjne, a brzmienie padów akordowych jest określane 
automatycznie zgodnie z określonymi zasadami prowadzenia głosu.

            
Jeśli chcesz ręcznie ustawić brzmienie określonego padu akordowego i nie chcesz, aby zmieniało 
się ono automatycznie, możesz skorzystać z regulatora brzmienia znajdującego się po prawej 
stronie padu akordowego. Kiedy przypiszesz własne brzmienie, brzmienie adaptacyjne zostanie 
wyłączone dla tego padu akordów, tak że pad nie będzie już przestrzegał zasad wiodących brzmień 
odniesienia do brzmień. Aby ponownie aktywować brzmienie adaptacyjne, kliknij prawym 
przyciskiem myszy pad akordów i aktywuj Adaptive Voicing (Brzmienie adaptacyjne).

Aby zablokować brzmienie padu akordowego, możesz kliknąć pad prawym przyciskiem myszy i 
włączyć opcję Lock (Zablokuj). Spowoduje to zablokowanie tego padu na potrzeby edycji i zmian 
przy użyciu pilota oraz dezaktywację funkcji Adaptive Voicing. Aby ponownie odblokować pad 
akordowy, kliknij pad prawym przyciskiem myszy i dezaktywuj Lock (blokadę).

Player Modes—Plain Chords (Tryby odtwarzacza — zwykłe akordy)
Możesz sterować odtwarzaniem zwykłych akordów.            
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● Kliknij opcję Show/Hide Player Setup (Pokaż/Ukryj konfigurację odtwarzacza), aby otworzyć 
ustawienia odtwarzacza, a następnie w wyskakującym menu Player Modes (Tryby odtwarzacza) 
wybierz opcję Plain Chords (Zwykłe akordy).

              

Dostępne są następujące opcje:
Overlaps (Nakładają się)
      Pozwala wybrać, co stanie się z nutami pierwszego akordu, gdy zagrasz akord bez zwalniania 
      poprzedniego akordu.
      ● Hold First przechowuje nuty pierwszego akordu. Nie jest wysyłana żadna wiadomość 
         informująca o wyłączeniu. Jeśli akordy mają wspólne nuty, nie są one ponownie wyzwalane.
      ● Legato uwalnia nuty pierwszego akordu, z wyjątkiem wspólnych nut. Są one wstrzymywane i
         nie są uruchamiane ponownie.
      ● Stop First uwalnia nuty pierwszego akordu, łącznie z nutami wspólnymi.
Filter Notes (Filtruj nuty)
      Umożliwia wybranie, które klawisze mają być filtrowane.
      ● Off (Wył.) nie filtruje niczego.
      ● From MIDI Thru filtruje nieprzypisane klawisze oraz klawisze przypisane jako klawisze 
         zdalne dla brzmień, napięć i transpozycji.

POWIĄZANE LINKI
Okno dialogowe konfiguracji padów akordowych na stronie 985

Player Modes—Pattern (Tryby odtwarzacza – Wzór)
Jeśli wybierzesz opcję Pattern (Schemat) w wyskakującym menu Player Modes (Tryby 
odtwarzacza), umożliwi to odtwarzanie nut tworzących akord jedna po drugiej jako arpeggio 
opartego na nutach schematu.
● Kliknij opcję Show/Hide Player Setup (Pokaż/Ukryj konfigurację odtwarzacza), aby otworzyć 
ustawienia odtwarzacza, a następnie w wyskakującym menu Player Modes (Tryby odtwarzacza) 
wybierz opcję Pattern (Wzór).

             
Dostępne są następujące opcje:

W sekcji Selected Player Settings (Ustawienia wybranego odtwarzacza) dostępne są następujące 
opcje:
Import MIDI Loop (Importuj pętlę MIDI)
      Umożliwia wybranie pętli MIDI używanej jako wzór.
Pattern (Wzór)
      Umożliwia usunięcie części MIDI z ekranu zdarzeń, która jest używana jako patern.    
      Wyświetlona zostanie nazwa wybranej pętli lub części.
Velocity from (Prędkość od)
● Pattern (Schemat) wykorzystuje wartości dynamiki z pętli MIDI lub partii MIDI wybranej jako 
   wzór.
● MIDI Keyboard (Klawiatura MIDI) umożliwia określenie wartości dynamiki poprzez 
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   mocniejsze lub słabsze naciskanie klawiszy klawiatury MIDI.

Pattern Presets (Wstępne ustawienia wzorów)
      Umożliwia zapisanie gotowych ustawień wzorów.

Korzystanie z Pattern Player (odtwarzacza wzorców)
Za pomocą padów akordowych możesz odtwarzać wzorzec pętli MIDI lub partię MIDI. Spowoduje 
to odtworzenie wzorca z nutami tworzącymi akord.

PROCEDURA
1. Po lewej stronie padów akordów aktywuj opcję Show/Hide Player Setup (Pokaż/Ukryj 
    konfigurację odtwarzacza).
2. W sekcji Selected Player Settings (Wybrane ustawienia odtwarzacza) otwórz wyskakujące 
    menu Player Modes (Tryby odtwarzacza) i wybierz opcję Pattern (Wzór).

          

3. Wykonaj jedną z następujących czynności:
      ● Kliknij opcję Import MIDI Loop (Importuj pętlę MIDI), aby wybrać pętlę MIDI, której 
         chcesz użyć jako wzorca.
      ● Przeciągnij partię MIDI z ekranu zdarzeń i upuść ją w polu Pattern (Wzór).
UWAGA
Pętla lub część musi zawierać od 3 do 5 głosów. W MediaBay liczba głosów jest wyświetlana w 
kolumnie Voices (Głosy) na liście Result (Wynik).
Pętla lub część traktowana jest jako odniesienie i określa sposób grania akordu.
4. W polu Velocity from (Prędkość z) wybierz źródło prędkości dla nut.

POWIĄZANE LINKI
Przypisywanie brzmień do nut na stronie 962
Konfigurowanie kolumn listy wyników na stronie 645

Używanie różnych odtwarzaczy na wielu ścieżkach
Możesz ustawić różne odtwarzacze z różnymi dźwiękami na różnych ścieżkach. Jeśli włączysz 
nagrywanie tych ścieżek i zagrasz na padach akordów, każda ścieżka będzie korzystała z 
dedykowanego odtwarzacza.

PROCEDURA
1. W obszarze globalnego sterowania ścieżkami na liście ścieżek kliknij opcję Add Track (Dodaj 

    ścieżkę .
2. Kliknij Instrument.
3. W polu Count (Wartość licznika) wybierz liczbę ścieżek, które chcesz dodać.
4. Otwórz menu podręczne Instrument i wybierz instrument VST.
5. Kliknij opcję Add Track (Dodaj ścieżkę).
    Ścieżki instrumentów zostaną dodane do listy utworów i otwarte zostaną panele sterowania 
    wybranego instrumentu VST.
6. Wybierz opcję Project > Chord Pads > Show/Hide Chord Pads (Projekt > Pady akordów >   
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    Pokaż/ukryj pady akordów), aby otworzyć pady akordów.
7. Aktywuj Chord Pad Output Mode (Tryb wyjścia padów akordów).
8. Kliknij Show/Hide Player Setup (Pokaż/Ukryj konfigurację odtwarzacza).

9. Wybierz ścieżkę pierwszego instrumentu, wybierz brzmienie instrumentu VST i skonfiguruj 
    odtwarzacz. Na przykład wybierz dźwięk fortepianu i aktywuj Piano Player (Odtwarzacz 
    fortepianu).
UWAGA
Konfigurując odtwarzacz dla utworu, upewnij się, że opcja Record Enable (Włącz nagrywanie) lub
Monitor jest aktywna tylko dla tej konkretnej ścieżki.
10. Wybierz ścieżkę drugiego instrumentu, wybierz brzmienie instrumentu VST i skonfiguruj inny  
      odtwarzacz. Na przykład wybierz brzmienie gitary i aktywuj Guitar Player (Odtwarzacz 
      gitary).
11. Wybierz następną ścieżkę instrumentu i postępuj jak w przypadku pozostałych 2 ścieżek. Na 
      przykład wybierz dźwięk smyczkowy, kliknij Player Options (Opcje odtwarzacza) i wybierz   
      Add Basic Player (Dodaj podstawowy odtwarzacz).
12. Wybierz wszystkie ścieżki instrumentów i kliknij opcję Record Enable (Włącz nagrywanie).

WYNIK
Możesz teraz grać na padach akordów i używać parametrów zdalnego strowania do regulacji napięć
(tensions) i transpozycji, aby jednocześnie zmieniać wszystkie symbole akordów dla każdego 
odtwarzacza. Jeśli jednak zmienisz Voicing (brzmienie), będzie to miało wpływ tylko na wybrany 
odtwarzacz.

POWIĄZANE LINKI
Okno dialogowe Dodaj ścieżkę – instrument na stronie 126

Tryby odtwarzacza — sekcje
Można sterować odtwarzaniem pojedynczych nut lub grup nut, tzw. sekcji, akordu przypisanego do 
padu akordów. Sekcje zawierają nuty akordów, zaczynając od dołu do góry: pierwsza sekcja 
reprezentuje najniższą nutę lub brzmienie akordu, zwykle basu. Druga sekcja reprezentuje tenor i 
tak dalej.
● Kliknij opcję Show/Hide Player Setup (Pokaż/Ukryj konfigurację odtwarzacza), aby otworzyć   
   ustawienia odtwarzacza, a następnie w wyskakującym menu Player Modes (Tryby odtwarzacza) 
   wybierz opcję Sections (Sekcje).

           
Dostępne są następujące opcje:
Overlaps (Nakładają się)
   Pozwala wybrać, co stanie się z nutami pierwszego akordu, gdy zagrasz akord bez zwalniania 
   poprzedniego akordu.
      ● Hold First (przytrzymaj pierwszy) przechowuje nuty pierwszego akordu. Nie jest wysyłana 
         żadna wiadomość informująca o wyłączeniu. Jeśli akordy mają wspólne nuty, nie są one 
         ponownie wyzwalane.
      ● Legato uwalnia nuty pierwszego akordu, z wyjątkiem wspólnych nut. Są one wstrzymywane i
         nie są uruchamiane ponownie.
      ● Stop First uwalnia nuty pierwszego akordu, łącznie z nutami wspólnymi.
Filter Notes (Filtruj nuty)
      Umożliwia wybranie, które klawisze mają być filtrowane.
      ● Off (Wył.) nie filtruje niczego.
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      ● From MIDI Thru filtruje nieprzypisane klawisze oraz klawisze przypisane jako klawisze 
          zdalne dla brzmień, napięć (tensions) i transpozycji.

Section Player Settings (Sekcja Ustawienia odtwarzacza)
      Otwiera okno dialogowe Custom Section Player Settings (Ustawienia odtwarzacza sekcji 
      niestandardowej.)

POWIĄZANE LINKI
Okno dialogowe konfiguracji padów akordowych na stronie 985
Okno dialogowe Ustawienia odtwarzacza sekcji niestandardowej na stronie 983

Okno dialogowe Custom Section Player Settings (Ustawienia 
odtwarzacza sekcji niestandardowej)
Niestandardowe ustawienia odtwarzacza sekcji pozwalają określić, w jaki sposób sekcje są 
uruchamiane, w jaki sposób są one dystrybuowane i czy w ogóle są odtwarzane. Dostępne są tylko 
sekcje z przypisanymi klawiszami zdalnymi.
● W ustawieniach odtwarzacza otwórz wyskakujące menu Player Modes (Tryby odtwarzacza)
i wybierz opcję Sections (Sekcje), następnie otwórz wyskakujące menu Section Player Settings 
(Ustawienia odtwarzacza sekcji) i wybierz opcję Custom (Własne).

              
Dostępne są następujące ustawienia:

          
Play Modes (Tryby gry)
●   Chord Pads (Pady akordowe)
     Umożliwia odsłuchanie nut akordów odpowiadających danej sekcji, jeśli naciśniesz klawisz  
     zdalnego sterowania dla określonej sekcji na klawiaturze MIDI.
●   Sections (Sekcje)
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     Na klawiaturze MIDI naciśnij najpierw klawisz przypisany do padu akordów, a następnie 
     naciśnij klawisz zdalnego sterowania odpowiadający określonej sekcji, aby usłyszeć nuty 
     akordów odpowiadające tej sekcji.

●   Combination (Kombinacja)
     Łączy sekcje i pady akordów, dzięki czemu nie ma znaczenia, czy najpierw naciśniesz klawisz    
     zdalnego sterowania dla padu akordów, czy dla sekcji.
●   Latch Chord Pads (Zatrzaśnij pady akordów)
     Aktywuj tę opcję dla trybów sekcji i kombinacji. W ten sposób, jeśli zwolnisz klawisz zdalnego  
     sterowania padu akordowego, nadal będziesz słyszeć sekcje, jeśli przytrzymasz klawisze  
     zdalnego sterowania sekcji.
Chord Note Distribution (Dystrybucja nut akordowych)
      Umożliwia określenie sposobu rozmieszczenia nut akordów w sekcjach, jeśli akord przypisany 
      do padu akordów zawiera więcej nut niż sekcji.
Mute Sections (Wycisz sekcje)
      Wyklucza sekcję z odtwarzania. Jest to przydatne, jeśli chcesz wykluczyć określone brzmienia 
      z odtwarzania.
Subsection Assignments (Zadania podsekcji)
Są one dostępne, jeśli skonfigurowałeś klawisze zdalne dla podsekcji na karcie Player Remote 
Control (Zdalne sterowanie odtwarzacza).
      ● Otwórz wyskakujące menu assigned to (przypisane do), aby przypisać podsekcję do sekcji.
      ● Użyj elementu sterującego Offset (Odsunięcie), aby określić odsunięcie od przekroju. W ten  
         sposób, gdy naciśniesz klawisz zdalnego sterowania danej podsekcji, usłyszysz nuty akordów 
         odpowiadające tej sekcji, transponowane o określone przesunięcie.

Odtwarzanie Chord Sections (sekcji akordów)
Możesz odtwarzać sekcje akordów padu akordów. Możesz grać sekcje i odpowiadające im nuty 
akordów, używając przypisanych do nich klawiszy zdalnego sterowania oraz klawiszy zdalnego 
sterowania przypisanych do padu akordów. Aby wyświetlić i edytować przypisanie zdalnego 
sterowania do sekcji, możesz otworzyć kartę Player Remote Control (Zdalne sterowanie 
odtwarzacza).

WARUNEK WSTĘPNY
Dodałeś ścieżkę instrumentu z instrumentem przypisanym do Twojego projektu. Włączyłeś 
nagrywanie ścieżki instrumentu. Masz podłączoną i skonfigurowaną klawiaturę MIDI. W strefie 
padów akordowych aktywowałeś Chord Pad Output Mode (Tryb wyjścia padów akordowych).

PROCEDURA
1. Kliknij Show/Hide Player Setup (Pokaż/Ukryj konfigurację odtwarzacza) i w wyskakującym  
    menu Player Modes (Tryby odtwarzacza) aktywuj Sections (Sekcje).
Na klawiaturze sekcja zdalnego zasięgu jest podświetlona na brązowo.

2. Na klawiaturze MIDI naciśnij dowolny klawisz odpowiadający zakresowi zdalnego sterowania   
    padami. Zwykle uruchamia to pad akordowy, jednak w trybie sekcji nic nie słychać, dopóki nie  
    naciśniesz klawisza zdalnego sterowania sekcji.
3. Na klawiaturze MIDI naciśnij dowolny klawisz odpowiadający zakresowi zdalnej sekcji.

WYNIK
Odtwarzana jest sekcja akordów akordu, którego pad akordowy został uruchomiony. Możesz 
nacisnąć dowolny inny klawisz w zasięgu sekcji, aby zagrać różne sekcje tego samego akordu, lub 
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nacisnąć je wszystkie naraz. Klawiszy zdalnych można używać do zmiany brzmienia, napięcia 
(tension) i transpozycji, aby urozmaicić brzmienie.

Okno dialogowe Chord Pads Setup (Konfiguracji padów akordowych)
Okno dialogowe Chord Pads Setup umożliwia zmianę przypisań klawiszy zdalnego sterowania 
i układu padów akordowych.

● Aby otworzyć okno dialogowe Chord Pads Setup, kliknij opcję Set up Chord Pads (Ustaw 
pady akordowe).

        

Pad Remote Control (Zdalne sterowanie Padem)
   Umożliwia określenie zakresu klawiszy zdalnych uruchamiających akordy przypisane do padów 
   akordowych. W tym miejscu możesz także skonfigurować modyfikatory akordów, które 
   pozwalają określić sposób odtwarzania akordów.
Player Remote Control (Zdalne sterowanie odtwarzaczem)
   Umożliwia określenie zakresu klawiszy zdalnych, które uruchamiają nuty akordów oraz 
   wybierają lub wyciszają odtwarzacze.
Pad Layout (Układ padu)
   Umożliwia zmianę układu używanego dla padów akordów.

POWIĄZANE LINKI
Zakładka Pad Remote Control (Zdalne sterowanie padem) na stronie 986
Zakładka Player Remote Control (Zdalne sterowanie odtwarzacza) na stronie 988
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Zakładka Pad Layout (Układ padu) na stronie 990

Zakładka Pad Remote Control (Zdalne sterowanie padem)
Zakładka Pad Remote Control w oknie dialogowym Chord Pads Setup (Konfiguracja padów 
akordowych) umożliwia określenie zakresu klawiszy zdalnych uruchamiających akordy przypisane 
do padów akordowych.

● Aby otworzyć zakładkę Pad Remote Control, kliknij opcję Set up Chord Pads, a następnie w 
   oknie dialogowym Chord Pads Setup (Konfiguracja padów akordowych) kliknij opcję Pad 
   Remote Control.

             

W sekcji Chord Pad Triggers (Wyzwalacze padów akordowych) dostępne są następujące opcje:
Latch Chords (Zablokuj akordy)
      Aktywuj tę opcję, jeśli chcesz, aby pad akordów był odtwarzany do momentu ponownego 
      uruchomienia.
Pads Remote Range Start (Zdalny start padów)
      Umożliwia ustawienie nuty początkowej dla zasięgu zdalnego. Domyślnie jest to ustawione na 
      C1.
Pads Remote Range End (Koniec zasięgu zdalnego padów)
      Umożliwia ustawienie nuty końcowej dla zasięgu zdalnego. Domyślnie jest to ustawione na B1.
MIDI Learn (Nauka MIDI)_
      Aktywuje/dezaktywuje funkcję MIDI Learn umożliwiającą przypisanie wejścia MIDI do 
      zakresu zdalnego sterowania padami.
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W sekcji Chord Modifiers (Modyfikatory akordów) dostępne są następujące opcje:

Activate (Aktywuj)
      Aktywuje/dezaktywuje przypisanie zdalnego klawisza do parametrów brzmień, napięć  
      (tensions) i transpozycji. Jeśli ta opcja jest wyłączona, aktywne będzie tylko przypisanie pilota 
      do zasięgu zdalnego sterowania padami.

UWAGA
Jeśli użyjesz klawiszy zdalnego sterowania do zmiany brzmień, napięć (tensions) lub transpozycji 
po zwolnieniu klawisza pilota dla padu akordowego, będzie to miało wpływ na ostatnio odtwarzany
pad akordowy.

UWAGA
Jeśli używasz kontrolerów MIDI, które są już przypisane do innych funkcji zdalnego sterowania, na
przykład szybkich kontrolerów ścieżki lub szybkich kontrolerów VST, wszystkie poprzednie 
przypisania zostaną utracone.

W sekcji Voicing Modifiers (Modyfikatory głosu) dostępne są następujące opcje:

Next Voicing (Następne brzmienie)
      Odtwarza następne brzmienie ostatnio granego akordu.
Previous Voicing (Poprzednie brzmienie)
      Odtwarza poprzednie brzmienie ostatnio granego akordu.
Modify All Pad Voicings (Zmodyfikuj wszystkie brzmienia padów)
      Umożliwia ustawienie brzmień dla wszystkich padów akordowych przy użyciu jednego 
      z następujących modyfikatorów:
      ●   No Modifier (Brak modyfikatora)
      ●   Aftertouch (Dotyk)
      ●   Pitchbend
      ●   Controller (Kontroler)
      Jeśli wybierzesz opcję Controller, możesz ustawić numer kontrolera w polu Controller 
      Number (Numer kontrolera).
MIDI Learn (Nauka MIDI)
      Aktywuje/dezaktywuje funkcję MIDI Learn służącą do przypisania wejścia MIDI do 
      parametrów zmiany brzmień.

W sekcji Tension Modifiers (Modyfikatory napięcia) dostępne są następujące opcje:

More Tensions (Więcej napięć)
      Odtwarza ostatnio grany akord z większym napięciem.
Fewer Tensions (Mniej napięć)
      Odtwarza ostatnio grany akord z mniejszym napięciem.
Modify All Pad Tensions (Zmodyfikuj wszystkie napięcia padów)
      Umożliwia ustawienie napięcia wszystkich padów akordów przy użyciu jednego z 
      następujących modyfikatorów: 
      ●   No Modifier (Brak modyfikatora)
      ●   Aftertouch (Dotyk)
      ●   Pitchbend
      ●   Controller (Kontroler)
      Jeśli wybierzesz opcję Controller, możesz ustawić numer kontrolera w polu Controller 
      Number (Numer kontrolera).
MIDI Learn (Nauka MIDI)
      Aktywuje/dezaktywuje funkcję MIDI Learn umożliwiającą przypisanie wejścia MIDI do 
      parametrów zmieniających się napięć.
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W sekcji Transpose Modifiers (Modyfikatory transpozycji) dostępne są następujące opcje:

Transpose Up (Transponuj w górę)
      Odtwarza ostatnio grany akord i transponuje go w górę.
Transpose Down (Transpozycja w dół)
      Odtwarza ostatnio grany akord i transponuje go w dół.
Transpose All Pads (Transponuj wszystkie pady)
      Umożliwia transpozycję wszystkich padów akordów przy użyciu jednego z następujących 
      modyfikatorów:
      ●   No Modifier (Brak modyfikatora)
      ●   Aftertouch (Dotyk)
      ●   Pitchbend
      ●   Controller (Kontroler)
      Jeśli wybierzesz opcję Controller, możesz ustawić numer kontrolera w polu Controller 
      Number (Numer kontrolera).
MIDI Learn (Nauka MIDI)
      Aktywuje/dezaktywuje funkcję MIDI Learn umożliwiającą przypisanie wejścia MIDI do 
      parametrów zmieniających się napięć.

Zmiana zasięgu zdalnego sterowania padów
Możesz poszerzyć zakres zdalnych padów, aby uzyskać dostęp do większej liczby padów 
akordowych. Jeśli chcesz używać szerszego zakresu klawiszy na klawiaturze MIDI do regularnej 
gry, możesz zawęzić zakres zdalnych padów.

PROCEDURA
1. Kliknij opcję Set up Chord Pads (Skonfiguruj pady akordów).
2. Otwórz zakładkę Pad Remote Control (Pilot zdalnego sterowania padem), aby otworzyć 
    przypisania zdalnego sterowania.
3. Wykonaj jedną z następujących czynności:
      ● Kliknij przycisk MIDI Learn, aby zaświecił się przycisk, a następnie na klawiaturze MIDI 
         naciśnij 2 klawisze, które chcesz przypisać jako początek i koniec zakresu.
      ● Wprowadź nową wartość w polach Pads Remote Range Start (Początek zakresu zdalnego 
         sterowania padami) i Pads Remote Range End (Koniec zakresu zdalnego sterowania 
         padami).

WYNIK
Na klawiaturze zmienia się wskazanie zasięgu zdalnego padów.

          

Zakładka Player Remote Control (Zdalne sterowanie padem)
Zakładka Player Remote Control w oknie dialogowym Chord Pads Setup (Konfiguracja padów 
akordowych) umożliwia określenie zakresu klawiszy zdalnych uruchamiających akordy przypisane 
do sekcji.

● Aby otworzyć zakładkę Player Remote Control, kliknij opcję Set up Chord Pads (Skonfiguruj 
   pady akordowe), a następnie w oknie dialogowym Chord Pads Setup kliknij opcję Player 
   Remote Control.
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Sections (Sekcje)
      Umożliwia przypisanie zdalnego sterowania do maksymalnie 5 stref. Klawiszy zdalnych sekcji 
      można używać razem z klawiszem zdalnego sterowania padem, aby uruchamiać nuty akordów 
      odpowiadające sekcjom.
   Domyślnie Sekcja 1 jest ustawiona na G2, Sekcja 2 jest ustawiona na A2, Sekcja 3 jest ustawiona 
   na B2 i Sekcja 4 jest ustawiona na C3.
MIDI Learn (Nauka MIDI)
      Aktywuje/dezaktywuje funkcję MIDI Learn umożliwiającą przypisanie wejścia MIDI do 
      sekcji.
Select/Mute Player (Wybierz/wycisz odtwarzacz)
      Umożliwia przypisanie klawiszy zdalnych do nawigacji odtwarzacza i wyciszania, jeśli 
      używasz różnych odtwarzaczy na wielu ścieżkach.
MIDI Learn (Nauka MIDI)
      Aktywuje/dezaktywuje funkcję MIDI Learn umożliwiającą przypisanie wejścia MIDI do   
      parametrów wybierania i wyciszania odtwarzaczy.
Subsections (Podsekcje)
      Umożliwia przypisanie kluczy zdalnych do maksymalnie 5 podsekcji. Możesz używać klawiszy
      zdalnych podsekcji razem z klawiszem zdalnym padu, aby wyzwalać nuty akordów 
      odpowiadające sekcji transponowanej o przesunięcie określone w jej podsekcji.
MIDI Learn (Nauka MIDI)
      Aktywuje/dezaktywuje funkcję MIDI Learn umożliwiającą przypisanie wejścia MIDI do 
      podsekcji.

POWIĄZANE LINKI
Tryby odtwarzacza — Sekcje na stronie 982
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Pad Layout Tab (Zakładka Układ padu)
Zakładka Pad Layout w oknie dialogowym Chord Pads Setup (Ustawienia padów akordowych) 
umożliwia zmianę układu padów akordowych.

UWAGA
Domyślnie układ klawiatury jest aktywny, ale jeśli wolisz, możesz zmienić go na układ siatki. Po 
zmianie układu padów może zaistnieć potrzeba dostosowania konfiguracji pilota zdalnego 
sterowania.

● Aby otworzyć zakładkę Pad Layout (Układ padów), kliknij opcję Set up Chord Pads (Ustaw   
   pady akordów), a następnie w oknie dialogowym Chord Pads Setup (Ustawienia padów 
   akordów) kliknij Pad Layout (Układ padów). 

                

Pad Layout Type (Typ układu padu)
      Aktywuj Keyboard (klawiatura), aby wyświetlić pady akordów w układzie klawiatury.
      Aktywuj opcję Grid (siatka), aby wyświetlić pady akordów w układzie siatki.
Number of Octaves/Number of Rows (Liczba oktaw/liczba wierszy)
      W trybie Keyboard możesz wybrać liczbę oktaw, które chcesz wyświetlić.
      W trybie Grid możesz wybrać liczbę wierszy, które chcesz wyświetlić.
Start Note (Nuta startowa)
      W trybie Keyboard możesz wybrać nutę początkową pierwszego padu akordu.
Number of Columns (Liczba kolumn)
      W trybie Grid możesz wybrać liczbę kolumn, które chcesz wyświetlić.

Wstępne ustawienia padów akordowych
Chord Pads Presets (Wstępne ustawienia padów akordowych) to szablony, które można 
zastosować do nowo utworzonych lub istniejących padów akordowych.

Chord Pads Presets zawierają akordy przypisane do padów akordów, a także konfiguracje 
odtwarzacza, w tym wszelkie dane wzorców zaimportowane przez MediaBay lub metodą 
„przeciągnij i upuść”. Ustawienia wstępne Chord Pads Presets umożliwiają szybkie ładowanie 
akordów lub ponowne wykorzystanie ustawień odtwarzacza. Wyskakujące menu Chord Pads 
Presets znajduje się po lewej stronie padów akordów. Ustawienia wstępne Chord Pads Presets są 
zorganizowane w MediaBay i możesz je kategoryzować za pomocą atrybutów.
● Aby zapisać/załadować gotowe ustawienie padów akordowych, kliknij Chord Pads Presets    
   (Wstępne ustawienia padów akordowych) i wybierz opcję Save Chord Pads Preset/Load Chord
   Pads Preset (Zapisz wstępne ustawienie padów akordowych/Załaduj wstępne ustawienie padów 
   akordowych).

Możesz także załadować tylko przypisane akordy z presetu, bez ładowania konfiguracji 
odtwarzacza. Jest to przydatne, jeśli chcesz użyć określonych akordów, które zapisałeś jako 
ustawienie wstępne, ale nie chcesz zmieniać bieżących ustawień odtwarzacza. 
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● Aby załadować tylko akordy z zestawów Chord Pads, kliknij opcję Chord Pads Presets 
(Ustawienia wstepne padów akordowych) i wybierz opcję Load Chords from Preset (Załaduj 
akordy z ustawień wstępnych).

W ten sam sposób możesz także załadować tylko konfiguracje odtwarzacza z Chord Pads Presets 
(Presety padów akordowych). Jest to przydatne, jeśli zapisałeś bardzo złożone ustawienia 
odtwarzacza i chcesz użyć ich ponownie na innych padach akordowych bez zmiany przypisanych 
akordów.
● Aby załadować tylko ustawienia odtwarzacza z zestawów Chord Pads, kliknij opcję Chord 
Pads Presets i wybierz opcję Load Players from Preset (Załaduj odtwarzacze z ustawień 
wstępnych).

Zapisywanie ustawień padów akordowych
Jeśli skonfigurowałeś pady akordowe, możesz je zapisać jako Chord Pads Presets (Presety padów 
akordowych).

PROCEDURA
1. Po lewej stronie padów akordów kliknij opcję Chord Pads Presets (Wstępne ustawienia padów  
    akordów) i wybierz opcję Save Chord Pads Preset (Zapisz ustawienie wstępne padów 
    akordów).
2. W sekcji New Preset (Nowe ustawienie wstępne) wprowadź nazwę nowego ustawienia 
    wstępnego.
UWAGA
Można także zdefiniować atrybuty ustawienia wstępnego.
3. Kliknij OK, aby zapisać ustawienie wstępne i wyjść z okna dialogowego.

Tworzenie zdarzeń akordowych z padów akordowych
Możesz używać akordów przypisanych do padów akordów do tworzenia zdarzeń akordów w oknie 
Project

PROCEDURA
● Kliknij pad akordowy i przeciągnij go na ścieżkę akordów.

WYNIK
Utworzono zdarzenie akordowe.

POWIĄZANE LINKI
Nagrywanie zdarzeń akordów za pomocą klawiatury MIDI na stronie 963

Tworzenie partii MIDI z padów akordowych
Możesz używać akordów przypisanych do padów akordów do tworzenia partii MIDI w oknie 
Project.

PROCEDURA
● Kliknij pad akordowy i przeciągnij go na ścieżkę MIDI lub instrumentu.

WYNIK
Zostanie utworzona część MIDI. Zawiera zdarzenia MIDI, które tworzą akord i ma długość jednego
taktu.
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Logical Editor (Edytor logiczny)
Edytor logiczny to potężne narzędzie do wyszukiwania i zamiany danych MIDI.

Edytora logicznego można używać w następujący sposób:
● Konfigurujesz warunki filtrowania, aby znaleźć określone elementy.
   Mogą to być elementy określonego typu, z określonymi atrybutami lub wartościami, lub na 
   określonych pozycjach, w dowolnej kombinacji. Można łączyć dowolną liczbę warunków filtra 
   i tworzyć warunki złożone za pomocą operatorów And/Or.
● Wybierasz podstawową funkcję, która ma zostać wykonana.
   Opcje obejmują Transform (Przekształć), aby zmienić właściwości znalezionych elementów, 
   Delete (Usuń), aby usunąć elementy, Insert (Wstaw), aby dodać nowe elementy na podstawie 
   znalezionych pozycji innych elementów i więcej.
● Tworzysz listę akcji, która dokładnie określa, co ma zostać zrobione.
   Nie jest to konieczne w przypadku wszystkich funkcji.

Łącząc warunki filtrów, funkcje i określone działania, można wykonać bardzo wydajne 
przetwarzanie.

Aby opanować Logical Editor (Edytor logiczny), potrzebujesz wiedzy na temat struktury 
komunikatów MIDI. Istnieje jednak również bogaty wybór ustawień wstępnych, umożliwiających 
dostęp do mocy obliczeniowych bez zagłębiania się w bardziej skomplikowane aspekty.

POWIĄZANE LINKI
Ustawienia wstępne na stronie 1006.

Przegląd okna
Okno Logical Editor umożliwia łączenie warunków filtrów, funkcji i akcji w celu przeprowadzenia
bardzo wydajnego przetwarzania MIDI.
● Aby otworzyć Logical Editor, wybierz MIDI > Logical Editor (MIDI > Edytor logiczny).
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1   Warunki filtra
     Umożliwia określenie warunków, takich jak typ, atrybut, wartość lub pozycja, które musi spełnić
     konkretny element, aby został znaleziony. Można łączyć dowolną liczbę warunków filtrowania 
     za pomocą operatorów AND/OR.
2   Lista działań
     Umożliwia skonfigurowanie listy akcji, która dokładnie określa, co zostanie wykonane. Nie jest 
     to konieczne w przypadku wszystkich funkcji.
3   Wyskakujące menu funkcji
     Umożliwia wybór funkcji.
4   Apply (Zastosuj)
     Zastosuje Twoje ustawienia.

Filter Conditions (Warunki filtra)
Na górnej liście konfigurujesz warunki filtrowania, określające, które elementy mają zostać 
znalezione. Lista może zawierać jeden lub kilka warunków, każdy w osobnej linii.

Aby skonfigurować warunek filtra, dokonaj następujących ustawień:
Left bracket (Lewy nawias)
   W połączeniu z prawym nawiasem umożliwia to łączenie wielu warunków filtrowania, czyli    
   wielu linii z operatorami boolowskimi And/Or.
Filter Target (Cel filtra)
   Ustawia właściwość elementu. To ustawienie wpływa na opcje dostępne w pozostałych 
   kolumnach.
Condition (Warunek)
   Określa, w jaki sposób Logical Editor (Edytor logiczny) porównuje właściwość w kolumnie 
   Filter Target (Cel filtra) z wartościami w kolumnach Parameter (Parametr). Dostępne opcje 
   zależą od ustawienia Filter Target (Celu filtru).
Parameter 1 (Parametr 1)
   Ustawia wartość, z którą porównywane są właściwości elementu. Zależy to od Filter Target.
Parameter 2 (Parametr 2)
   Dostępne tylko wtedy, gdy w kolumnie Condition (Warunek) ustawiona jest jedna z opcji Range 
   (Zakres). Umożliwia znalezienie wszystkich elementów o wartościach mieszczących się w lub 

1005



   poza zakresem pomiędzy Parameter 1 (Parametrem 1) i Parameter 2 (Parametrem 2).
Bar Range/Time Base (Zakres taktów/podstawa czasu)
   Dostępne tylko wtedy, gdy Filter Target jest ustawiony na Position (Pozycja). Jeśli w kolumnie  
   Condition (Warunek) wybrana jest jedna z opcji Bar Range (Zakres taktów), kolumna Bar 
   Range/Time Base (Zakres taktów/podstawa czasu) służy do określenia stref w obrębie każdego 
   taktu. Pozwala to na przykład znaleźć wszystkie elementy na lub wokół pierwszego taktu każdego
   taktu. Jeśli wybrana jest którakolwiek z pozostałych opcji Condition, możesz użyć kolumny Bar 
   Range/Time Base, aby określić podstawę czasu, taką jak PPQ, sekundy itp.
Right bracket (Prawy nawias)
   Razem z lewym nawiasem pozwala to na połączenie kilku warunków filtra.
bool
   Umożliwia wstawianie operatorów logicznych And/Or podczas tworzenia warunków z wieloma 
   liniami.

UWAGA
Jeśli popełnisz błąd podczas łączenia wielu warunków w nawiasach, zostanie to wyświetlone w 
wierszu stanu.

UWAGA
Jeśli zdefiniowałeś już warunki filtrowania i/lub zastosowałeś ustawienie wstępne, ale chcesz 
zacząć od nowa, możesz zainicjować ustawienia, wybierając opcję Init z wyskakującego menu 
Presets (Ustawienia wstępne).

UWAGA
Możesz także skonfigurować warunki filtrowania, przeciągając zdarzenia MIDI bezpośrednio na 
górną listę.
Jeśli lista nie zawiera żadnych wpisów, zdarzenie MIDI przeciągnięte do tej sekcji utworzy warunki
obejmujące stan i typ zdarzenia. Jeśli zawiera wpisy, przeciągnięte zdarzenie zainicjuje pasujące 
parametry. Na przykład, jeśli zostanie użyty warunek długości, długość zostanie ustawiona na 
podstawie długości zdarzenia.

W zależności od ustawienia elementu Filter Target (docelowego filtru) w kolumnie Condition 
(Warunek) można wybrać następujące opcje:
Equal (Równy)
   Ma dokładnie taką samą wartość jak ustawiona w kolumnie Parameter 1.
Unequal (Nierówny)
   Ma dowolną wartość inną niż ustawiona w kolumnie Parameter 1 (Parametr 1).
Bigger (Większy)
   Ma wartość wyższą niż ustawiona w kolumnie Parameter 1.
Bigger or Equal (Większy lub równy)
   Ma wartość taką samą lub wyższą od ustawionej w kolumnie Parameter 1.
Less (Mniej)
   Ma wartość mniejszą niż ustawiona w kolumnie Parameter 1.
Less or Equal (Mniej lub równo)
   Ma wartość taką samą lub niższą od ustawionej w kolumnie Parameter 1.
Inside Range (Wewnątrz zasięgu)
   Ma wartość mieszczącą się pomiędzy wartościami ustawionymi w kolumnach Parameter 1 
   i Parameter 2. Należy pamiętać, że Parameter 1 powinien mieć niższą wartość, a Parameter 2 
   wyższą.
Outside Range (Poza zasięgiem)
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   Ma wartość, która nie mieści się pomiędzy wartościami ustawionymi w kolumnach Parametr 1 
   i Parameter 2.
Inside Bar Range (Wewnątrz zakresu taktu)
   Ma wartość mieszczącą się w strefie ustawionej w kolumnie Bar Range/Time Base (Zakres 
   taktu/Podstawa czasu) w każdym słupku w ramach bieżącego zaznaczenia. Jest to używane tylko 
   wtedy, gdy Filter Target (Cel filtra) jest ustawiony na Position (Pozycja).
Outside Bar Range (Zewnętrzny zakres taktów)
   Ma wartość poza strefą ustawioną w kolumnie Bar Range/Time Base (Zakres taktu/Podstawa 
   czasu), w każdym takcie w ramach bieżącego zaznaczenia. Jest to używane tylko wtedy, gdy 
   Filter Target jest ustawiony na Position.
Before Cursor (Przed kursorem)
   Znajduje się przed pozycją kursora utworu. Jest to używane tylko wtedy, gdy Filter Target jest 
   ustawiony na Position.
Beyond Cursor (Poza kursorem)
   Występuje po pozycji kursora utworu. Tylko Position.
Inside Track Loop (Wewnątrz pętli ścieżki)
   Znajduje się w ustawionej pętli ścieżki. Jest to używane tylko wtedy, gdy Filter Target jest 
   ustawiony na Position.
Inside Cycle (Cykl wewnętrzny)
   Znajduje się w ustalonym cyklu. Jest to używane tylko wtedy, gdy Filter Target jest ustawiony 
   na Position.

Exactly Matching Cycle (Dokładnie dopasowany cykl)
   Dokładnie odpowiada ustawionemu cyklowi. Jest to używane tylko wtedy, gdy Filter Target 
   (Cel filtra) jest ustawiony na Position (Pozycja).
Note is equal to (Nuta jest równa)
   Czy nuta jest określona tylko w kolumnie Parameter 1, niezależnie od oktawy. Na przykład 
pozwala znaleźć wszystkie nuty C we wszystkich oktawach. Jest to używane tylko wtedy, gdy 
Filter Target jest ustawiony na Pitch.

UWAGA
Warunki Property (Właściwości) docelowego filtru są inne.

POWIĄZANE LINKI
Łączenie wielu linii warunków na stronie 1016
Wyszukiwanie nieruchomości na stronie 998
Wyszukiwanie elementów w określonych pozycjach na stronie 995

Wyszukiwanie elementów w określonych pozycjach
Możesz wyszukiwać elementy zaczynając od określonych pozycji, albo względem początku 
projektu, albo w obrębie każdego taktu.

PROCEDURA
1. Otwórz wyskakujące menu Filter Tatrget (Filtruj cel) i wybierz opcję Position (Pozycja).
    Pozwala to znaleźć elementy rozpoczynające się w określonych pozycjach, albo względem 
    początku projektu, albo w obrębie każdego taktu.
2. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
      ● Aby znaleźć wszystkie elementy w określonej pozycji, wybierz pozycję w kolumnie 
         Parameter 1.
         Możesz ustawić podstawę czasu, taką jak PPQ, sekundy, próbki lub klatki, w kolumnie Bar 
         Range/Time Base column (Zakres taktu/Podstawa czasu).
      ● Aby znaleźć wszystkie elementy wewnątrz lub na zewnątrz zakresu, wybierz opcję Inside 
         Bar Range (Wewnątrz zakresu taktów) lub Outside Bar Range (Poza zakresem taktów).
         Możesz ustawić zakres taktu w kolumnie Bar Range/Time Base (Zakres taktu/Podstawa 
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         czasu), klikając i przeciągając na wyświetlaczu słupkowym lub dopasowując pozycję 
         początkową zakresu w kolumnie Parameter 1 i pozycję końcową w kolumnie Parameter 2.  
         Podstawę czasu można zmienić za pomocą kolumny Bar Range/Time Base. Pozycja Bar 
         Range jest mierzona w znacznikach związanych z początkiem taktu

PRZYKŁAD
Możesz skonfigurować Logical Editor (Edytor logiczny) tak, aby znajdował wszystkie elementy 
projektu na pozycji 1.1.1.0.

Możesz skonfigurować Logical Editor (Edytor logiczny) tak, aby znajdował elementy 
rozpoczynające się wokół drugiego taktu w każdym takcie.

Wyszukiwanie nut o określonych długościach 
Możesz wyszukiwać nuty o określonej długości.

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Filtruj cel) i wybierz Length (Długość).
    Dzięki temu można znaleźć nuty tylko o określonej długości.
UWAGA
Parametr Length (Długość) jest interpretowany poprzez ustawienie podstawy czasu w kolumnie 
Bar Range/Time Base (Zakres taktu/Podstawa czasu), to znaczy w PPQ, sekundach, próbkach lub 
klatkach.
2. Otwórz menu podręczne Parameter 1 i ustaw długość, którą chcesz wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz opcję. Jeśli wybierzesz opcję Inside 
    Range (Wewnątrz zakresu) lub Outside Range (Poza zakresem), użyj Parameter 1 i Parameter
    2, aby ustawić początek i koniec zakresu.

4. Kliknij    poniżej listy, aby dodać kolejną linię warunku.
    Parameter 1 jest automatycznie ustawiany na Note (Nuta), ponieważ Length Filter Target 
    (Wartość docelowa filtra długości) obowiązuje tylko dla nut.

POWIĄZANE LINKI
Łączenie wielu linii warunków na stronie 1016

Value 1 and Value 2 (Wartość 1 i Wartość 2)
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Zdarzenia MIDI mogą składać się z wartości 1 i wartości 2.

Wartość 1 i wartość 2 mają różne znaczenie dla różnych typów zdarzeń:

     Typ zdarzenia       Value 1       Value 2

   Notes (Nuty)
   The Note Number/Pitch
   (Numer/wysokość nuty)

   The velocity of the note.
   (Prędkość nuty)

   Poly Pressure
   Klawisz, który został 
     naciśnięty.

   Wielkość nacisku na klawisz.

   Controller
   Typ kontrolera, wyświetlany 
     jako liczba.

   Wielkość Control Change

   Program Change    Numer Program Change    Nie używane

   Aftertouch (Dotyk)    Wielkość nacisku    Nie używane

   Pitchbend
   „Dostrojenie” wygięcia.
   Nie zawsze używane.

   Gruba wielkość wygięcia.

   VST 3 Event    Nie używane

   Wartość parametru zdarzenia 
VST 3. Zakres wartości
zdarzenie VST 3 (0.0 do 1.0) 
jest przekształcane w MIDI
zakres wartości (0-127), czyli 
wartość zdarzenia VST 3 0,5 
odpowiada 64. W przypadku 
niektórych operacji 
wymagających wyższej 
rozdzielczości można 
skorzystać z parametru 
„Operacja wartości VST 3”.

UWAGA
Zdarzenia System Exclusive nie korzystają z wartości Value 1 i 2.

POWIĄZANE LINKI
Cel akcji na stronie 1003

Wyszukiwanie wysokości nut (Note Pitches) lub prędkości (Velocities)

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Filtruj cel) i wybierz Value 1 (Wartość 1) dla 
    nachylenia (pitches) lub Value 2 (Wartość 2) dla prędkości (velocities).
2. Opcjonalnie dla wysokości dźwięków: W kolumnie Parameter 1 (Parametr 1) wprowadź 
    wysokość nuty jako nazwę nuty, np. C3, D#4 itp., lub jako numer nuty MIDI od 0 do 127.

UWAGA
Aby znaleźć wszystkie nuty określonej tonacji, we wszystkich oktawach, otwórz wyskakujące 
menu Condition (Warunek) i wybierz Note is equal to (Nuta jest równa).

3. Kliknij   poniżej listy, aby dodać kolejną linię warunku.
    Parameter 1 (Parametr 1) jest automatycznie ustawiany na Note (Nuta). Ponadto Value 1    
    (Wartość 1) i Value 2 (Wartość 2) będą wyświetlane odpowiednio jako Pitch (Wysokość) 
    i Velocity (Prędkość).

1009



POWIĄZANE LINKI
Łączenie wielu linii warunków na stronie 1016

Wyszukiwanie kontrolerów

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel filtru) i wybierz Value 1 (Wartość 1).

2. Kliknij    poniżej listy, aby dodać kolejną linię warunku.
3. Otwórz menu podręczne Parameter 1 (Parametr 1) i wybierz opcję Controler (Kontroler).
    Filter Target jest automatycznie ustawiany na MIDI Controller No. (Numer kontrolera MIDI), 
    a kolumna Parameter 1 (Parametr 1) pokaże nazwy kontrolerów MIDI.

POWIĄZANE LINKI
Łączenie wielu linii warunków na stronie 1016

Wyszukiwanie kanałów MIDI
Wyszukiwanie kanałów MIDI jest przydatne, jeśli nagrałeś MIDI z instrumentu wysyłającego na 
kilku różnych kanałach lub jeśli zaimportowałeś plik MIDI typu 0 z jedną ścieżką, zawierający 
zdarzenia MIDI z różnymi ustawieniami kanałów.

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel Filtru) i wybierz Channel (Kanał).
2. W polu Parameter 1 (Parametr 1) wprowadź kanał MIDI od 1 do 16.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz opcję.

Wyszukiwanie typów elementów

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Filtruj cel) i wybierz Type (Typ).
2. Otwórz wyskakujące menu Condition (Warunek) i wybierz opcję.
3. Otwórz menu podręczne Parameter 1 (Parametr 1) i wybierz typ, taki jak nuta, ciśnienie poli 
    (poly pressure), kontroler (controller) itp.

Wyszukiwanie właściwości
Możesz wyszukiwać właściwości, które nie są częścią standardu MIDI, ale raczej ustawieniami 
specyficznymi dla Cubase.

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel filtru) i wybierz Property (Właściwość).
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2. Otwórz menu podręczne Parameter 1 (Parametr 1) i wybierz właściwość, którą chcesz 
    wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
      ● Wybierz Property is set (Właściwość jest ustawiona), jeśli chcesz wyszukiwać zdarzenia 
         posiadające określoną właściwość.
      ● Wybierz Property is not set (Właściwość nie jest ustawiona), jeśli chcesz wyszukiwać  
         zdarzenia, które nie mają określonej właściwości.

PRZYKŁAD
Możesz znaleźć wszystkie wyciszone zdarzenia.

Możesz znaleźć wybrane i wyciszone zdarzenia.

Możesz skonfigurować Logical Editor (Edytor logiczny) tak, aby znajdował wszystkie dane 
ekspresji nutowych.

Możesz skonfigurować Logical Editor tak, aby znajdował wszystkie zdarzenia kontrolera MIDI, 
które stanowią część danych ekspresji nutowych.

Możesz skonfigurować Edytor logiczny tak, aby znajdował wszystkie zdarzenia VST 3, których nie
można odtworzyć, ponieważ na powiązanej ścieżce nie ma instrumentu VST kompatybilnego z 
ekspresją nutową.

Poszukiwanie kontekstów zdarzeń
Można wykonywać wyszukiwania zależne od kontekstu. Jest to szczególnie przydatne w przypadku
Input Transformer (Transformatora wejściowego).

Ostatnie zdarzenie docelowe filtra wskazuje stan zdarzenia, które przeszło już przez Input 
Transformer lub Logical Editor (Edytor logiczny). Warunek należy połączyć z Parameter 1 
(Parametrem 1) i Parameter 2 (Parametrem 2).

PRZYKŁAD
Możesz skonfigurować Logical Editor tak, aby wykonywał czynności tylko wtedy, gdy pedał 
podtrzymania jest wciśnięty.

Możesz skonfigurować Input Transformer lub Transformer tak, aby wykonywał działania tylko 
po naciśnięciu nuty C1.

W tym przykładzie akcja jest wykonywana po zagraniu C1.
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Wyszukiwanie najwyższych/najniższych nut w akordach
Możesz wyszukiwać najwyższą lub najniższą nutę akordu.

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel filtru) i wybierz Type (Typ).
2. Otwórz wyskakujące menu Condition (Warunek) i wybierz Equal (Równe).
3. Otwórz menu podręczne Parameter 1 (Parametr 1) i wybierz opcję Note (Nuta).

4. Kliknij    poniżej listy, aby dodać kolejną linię warunku.
5. Otwórz wyskakujące menu Filter Target i wybierz Context Variable (Zmienna kontekstowa).
6. Otwórz wyskakujące menu Condition i wybierz opcję Bigger or Equal (Większy lub Równy).
7. Otwórz menu podręczne Parameter 1 i wybierz opcję Highest in Chord at Least n Notes 
(Najwyższy w akordzie z co najmniej n nut) lub Lowest in Chord from at Least n Notes 
(Najniższy w akordzie z co najmniej n nut).
8. Otwórz menu podręczne Parameter 2 (Parametr 2) i wybierz, ile nut musi zawierać akord, aby 
    został on uwzględniony.

Wyszukiwanie akordów
Akordy można wyszukiwać w partii MIDI lub na ścieżce akordów

WARUNEK WSTĘPNY
UWAGA
Nuta należy do akordu, jeśli w tym samym czasie zagrają co najmniej 2 inne nuty.

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel filtra) i wybierz Context Variable (Zmienna 
    kontekstowa).
2. Otwórz menu podręczne Parameter 1 i wybierz właściwość, którą chcesz wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz opcję.

Chords Filter (Filtr akordów)

Jeśli Filter Target jest ustawiony na Context Varible (Zmienną kontekstową), możesz 
wyszukiwać następujące parametry:
Highest/Lowest/Average Pitch (Najwyższy/najniższy/średni ton)
   Znajduje nuty o najwyższej, najniższej lub średniej wysokości w wybranej części MIDI.
Highest/Lowest/Average Velocity (Najwyższa/najniższa/średnia prędkość)
   Znajduje nuty o najwyższej, najniższej lub średniej prędkości w wybranej partii MIDI.
Highest/Lowest/Average CC Value (Najwyższa/najniższa/średnia wartość CC)
   Kontrolery z najwyższą, najniższą lub średnią wartością CC w wybranej partii MIDI.

Następujące ustawienia Parameter 1 wymagają Parameter 2:
Number of Notes in Chord (Part) (Liczba nut w akordzie (część))
   Jeśli ustawisz Parameter 2 na liczbę nut w akordzie, zostaną znalezione akordy z określoną 
   liczbą nut w wybranej partii MIDI.
Number of Voices (Part) (Liczba głosów (część))
   Jeśli ustawisz Parameter 2 na liczbę głosów akordu, zostaną znalezione akordy z określoną 
   liczbą głosów w wybranej partii MIDI.
Position in Chord (Part) (Pozycja w akordzie (część))
   Jeśli ustawisz Parameter 2 na pozycję w akordzie, spowoduje to znalezienie akordów 
   z określonym interwałem akordów w wybranej partii MIDI.

1012



Note Number in Chord (lowest = 0) (Numer nuty w akordzie (najniższy = 0))
   Jeśli ustawisz Parameter 2 na numer brzmienia akordu, w wybranej partii MIDI zostaną 
   znalezione akordy o określonym numerze brzmienia.
Position in Chord (Chord Track) (Pozycja w akordzie (ścieżka akordu))
   Jeśli ustawisz Parameter 2 na pozycję w akordzie, spowoduje to znalezienie określonego 
   interwału akordu w wybranej partii MIDI. Ścieżka akordów jest traktowana jako odniesienie.
Voice (Głos)
   Jeśli ustawisz Parameter 2 na brzmienie akordu, spowoduje to znalezienie określonego 
   brzmienia w wybranej partii MIDI.
Highest in Chord from at Least n Notes (Najwyższy w akordzie od co najmniej n nut)
   Znajduje najwyższą nutę akordu w wybranej partii MIDI. Ustaw Parameter 2, aby określić, ile 
   nut musi zawierać akord, aby został wzięty pod uwagę.
Lowest in Chord from at Least n Notes (Najniższy w akordzie od co najmniej n nut)
   Znajduje najniższą nutę akordu w wybranej partii MIDI. Ustaw Parameter 2, aby określić, ile nut
   musi zawierać akord, aby został wzięty pod uwagę.

UWAGA
Wstępne ustawienia Musical Context (Kontekstu muzycznego) dają wyobrażenie o możliwościach 
tego celu filtra.

POWIĄZANE LINKI
Wyszukiwanie najwyższych/najniższych nut w akordach na stronie 999

Łączenie wielu linii warunków
Można dodawać linie warunków i łączyć je za pomocą operatorów logicznych And i Or oraz 
nawiasów.

● Aby dodać nowy warunek, kliknij    poniżej listy.
   Nowa linia zostanie dodana na dole listy.

● Aby usunąć warunek, wybierz go i kliknij    poniżej listy.

Kolumna Bool
W kolumnie bool po prawej stronie listy możesz wybrać operator boolowski: And lub Or.

Operator boolowski łączy 2 linie warunku i określa wynik w następujący sposób:
●  And (I) określa, że aby element został znaleziony, muszą zostać spełnione oba warunki.
●  Or (Lub) stwierdza, że aby element został znaleziony, musi zostać spełniony co najmniej jeden 
    z warunków.

WAŻNE
Po dodaniu nowej linii warunku jej domyślnym ustawieniem logicznym jest And.

PRZYKŁAD
Możesz znaleźć elementy będące nutami i zacząć od początku trzeciego taktu.

Można znaleźć wszystkie zdarzenia będące nutami (niezależnie od ich położenia) oraz wszystkie 
zdarzenia rozpoczynające się od początku trzeciego taktu (niezależnie od ich rodzaju).
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Korzystanie z nawiasów
Kolumny nawiasów umożliwiają umieszczenie 2 lub więcej linii warunku, dzieląc wyrażenie 
warunkowe na mniejsze jednostki. Ma to znaczenie tylko wtedy, gdy masz 3 lub więcej linii 
warunków i chcesz użyć operatora logicznego Or.

Aby dodać nawiasy, kliknij kolumny nawiasów i wybierz opcję. Można wybrać maksymalnie 
potrójne nawiasy.

Jeśli dodasz kilka warstw nawiasów, będą one oceniane od środka na zewnątrz, zaczynając od 
nawiasów najbardziej wewnętrznych.

Wyrażenia w nawiasach są oceniane w pierwszej kolejności.

PRZYKŁAD
Możesz znaleźć wszystkie nuty MIDI z wysokością C3, a także wszystkie zdarzenia (niezależnie od
ich typu) ustawione na kanał MIDI 1.

Możesz znaleźć wszystkie nuty, które mają wysokość C3 lub kanał MIDI 1 (ale nie zawierają 
zdarzeń innych niż nuty).

Wybór funkcji
Wyskakujące menu na dole Logical Editor (Edytora logicznego) umożliwia wybranie funkcji, czyli
podstawowego typu edycji, która ma zostać wykonana.

              

Delete (Usuń)
   Usuwa wszystkie elementy znalezione przez Logical Editor (Edytor logiczny).
Transform (Przekształć)
   Zmienia jeden lub kilka aspektów znalezionych elementów. Skonfigurowałeś dokładnie to, co jest
   zmienione na liście działań.
Insert (Wstaw)
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   Tworzy nowe elementy i wstawia je do części. Nowe elementy będą oparte na elementach 
   znalezionych w warunkach filtra, ale z uwzględnieniem wszelkich zmian wprowadzonych na 
   liście akcji.
   Innym sposobem wyrażenia tego jest to, że funkcja Insert (Wstaw) kopiuje znalezione elementy, 
   przekształca je zgodnie z listą akcji i wstawia przekształcone kopie pomiędzy istniejące elementy.
Insert Exclusive (Wstaw specjalnie)
   Przekształca znalezione elementy zgodnie z listą akcji. Wszystkie elementy niespełniające 
   warunków filtra są usuwane.
Copy (Kopiuj)
   Kopiuje wszystkie znalezione elementy, przekształca je zgodnie z listą akcji i wkleja do nowej 
   części na nowej ścieżce MIDI. Nie ma to wpływu na oryginalne zdarzenia.
Extract (Wyciąg)
   Przekształca wszystkie znalezione zdarzenia i przenosi je do nowej części na nowej ścieżce MIDI.
Select (Wybierz)
   Wybiera wszystkie znalezione zdarzenia i podświetla je do dalszej pracy w zwykłych edytorach 
   MIDI.

POWIĄZANE LINKI
Określanie działań na stronie 1003

Określanie działań
Możesz określić akcje, czyli zmiany dokonane w znalezionych elementach, na dolnej liście Logical
Editor (Edytora logicznego). Akcje dotyczą wszystkich typów funkcji z wyjątkiem Delete (Usuń) 
i Select (Wybierz).

Możesz dodać linie akcji klikając   i usunąć je zaznaczając je i klikając  .

Action Target (Cel akcji)

Action Target umożliwia wybranie właściwości, która ma zostać zmieniona w zdarzeniach.

Position (Pozycja)
   Przemieszcza zdarzenia.
Length (Długość)
   Zmienia rozmiar zdarzeń nutowych.
Value 1 (Wartość 1)
   Dopasowuje wartość 1 w zdarzeniach. To, co jest wyświetlane dla wartości 1, zależy od typu 
   zdarzenia. W przypadku nut wartość 1 oznacza wysokość tonu (pitch).
Value 2 (Wartość 2)
   Dostosowuje wartość 2 w zdarzeniach. To, co jest wyświetlane dla wartości 2, zależy od typu 
   zdarzenia. W przypadku nut wartość 2 to wartość prędkości (velocity).
Channel (Kanał)
   Umożliwia zmianę ustawień kanału MIDI.
Type (Typ)
   Umożliwia zmianę typu zdarzenia, czyli przekształcenie zdarzeń aftertouch w zdarzenia 
   modulacyjne lub zdarzenia pitchbend w zdarzenia VST 3 Tuning.
Value 3 (Wartość 3)
   Dostosowuje wartość 3 w zdarzeniach, która jest używana do obsługi szybkości Note-Off podczas
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   wyszukiwania właściwości.
NoteExp Operation (Operacja NoteExp)
   Umożliwia określenie operacji ekspresji nuty w kolumnie Operation (Operacja).
VST 3 Value Operation (Operacja wartości VST 3)
   Umożliwia wykonywanie typowych operacji w zakresie wartości VST 3 (0,0 do 1,0) zamiast 
   standardowego zakresu wartości MIDI (0-127) w celu dokładniejszej regulacji.

UWAGA
Parametry Position (Pozycja) i Length (Długość) są interpretowane poprzez ustawienie podstawy 
czasu w kolumnie Bar Range/Time Base (Zakres taktu/Podstawa czasu), z wyjątkiem ustawienia 
Random (Losowy), które wykorzystuje podstawę czasu zdarzeń, których to dotyczy.

POWIĄZANE LINKI
Wyszukiwanie Właściwości na stronie 998
Wartość 1 i Wartość 2 na stronie 996

Operation (Operacja)

Kolumna Operation pozwala określić, co zrobić z Action Target (Celem Akcji).
Opcje w tym wyskakującym menu różnią się w zależności od wybranego Action Target.

Add (Dodaj)
   Dodaje wartość określoną w kolumnie Parameter 1 do Action Target.
Subtract (Odejm)
   Odejmuje wartość określoną w kolumnie Parameter 1 od Action Target.
Multiply by (Pomnóż przez)
   Mnoży Action Target przez wartość określoną w kolumnie Parameter 1.
Divide by (Podziel przez)
   Dzieli Action Target przez wartość określoną w kolumnie Parameter 1.
VST 3 Value Operation – Invert (Operacja na wartości VST 3 – Odwróć)
   Odwraca dane ekspresji nuty zawierające określony parametr zdarzenia VST 3.
Round by (Zaokrągl do)
   Zaokrągla wartość Action Target, korzystając z wartości określonej w kolumnie Parameter 1.
Set Random Values between (Ustaw losowe wartości pomiędzy)
   Ustawia wartość Action Target na losową wartość z zakresu określonego za pomocą Parameter 
   1 i Parameter 2.
Set to fixed value (Ustaw na stałą wartość)
   Ustawia Action Target na wartość określoną w kolumnie Parameter 1.
Set Relative Random Values between (Ustaw względne wartości losowe pomiędzy)
   Dodaje losową wartość do bieżącej wartości Action Target. Dodana wartość losowa będzie 
   mieściła się w zakresie określonym za pomocą Parameter 1 i Parameter 2. Należy pamiętać, że 
   można je ustawić na wartości ujemne.
Add Length (Dodaj długość)
   Jest to dostępne tylko wtedy, gdy ustawisz Action Target na Position (Pozycję). Co więcej, jest 
   to ważne tylko wtedy, gdy znalezione zdarzenia są nutami. Jeśli wybierzesz opcję Add Length, 
   długość każdego zdarzenia nutowego zostanie dodana do wartości Position.
Transpose to Scale (Transponuj do skali)
   Jest to dostępne tylko wtedy, gdy ustawisz Action Target (Cel akcji) na Value 1 (Wartość 1) i 
   jeśli warunki filtrowania są skonfigurowane specjalnie do wyszukiwania nut (dodano wiersz 
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   warunku filtru Type = Note (Typ = Nuta). Gdy wybrana jest opcja Transpose to Scale, możesz 
   określić skalę muzyczną, korzystając z kolumn Parameter 1 i Parameter 2. Parameter 1 to 
   tonacja (C, C#, D itp.), natomiast Parameter 2 to rodzaj skali (dur, melodyczny lub harmoniczny 
   moll itp.). Każda nuta zostanie transponowana do najbliższej nuty w wybranej skali.
Use Value 2 (Użyj wartości 2)
   Jest to dostępne tylko wtedy, gdy ustawisz Action Target na Value 1 (Wartość 1). Jeśli ta opcja 
   zostanie wybrana, ustawienie Value 2 (Wartość 2) w każdym zdarzeniu zostanie skopiowane do 
   ustawienia Value 1 (Wartość 1).
Use Value 1 (Użyj wartości 1)
   Jest to dostępne tylko wtedy, gdy ustawisz Action Target na Value 2 (Wartość 2). Jeśli ta opcja 
   zostanie wybrana, ustawienie Value 1 (Wartość 1) w każdym zdarzeniu zostanie skopiowane do 
   ustawienia Value 2 (Wartość 2).
Mirror (Lustro)
   Jest to dostępne tylko wtedy, gdy ustawisz Action Target na Value 1 lub Value 2. Po wybraniu   
   tej opcji wartości zostaną odzwierciedlone wokół wartości ustawionej w kolumnie Parameter 1.
   W przypadku nut powoduje to odwrócenie skali, z klawiszem ustawionym w kolumnie 
   Parameter 1 jako punkt środkowy.

Linear Change in Loop Range (Liniowa zmiana zakresu pętli)
   Ma to wpływ tylko na zdarzenia pomiędzy lewym i prawym lokalizatorem. Tworzy liniową 
   rampę wartości (zastępując wartości oryginalne), zaczynając od wartości w kolumnie 
   Parameter 1 i kończąc na wartości Parameter 2.
Relative Change in Loop Range (Względna zmiana zakresu pętli)
   Tworzy to rampę wartości, wpływającą tylko na zdarzenia w zasięgu pętli, czyli pomiędzy 
   lokalizatorami. Jednak tutaj zmiany są względne, co oznacza, że wartości zostaną dodane do 
   istniejących wartości.

Innymi słowy, konfigurujesz rampę wartości zaczynającą się od Parameter 1 i kończącą na 
Parameter 2 (należy pamiętać, że wartości mogą być ujemne). Powstała rampa wartości jest 
następnie dodawana do istniejących wartości zdarzeń w zakresie pętli.

Na przykład, jeśli zastosujesz to do zanotowania prędkości (velocity) z Parameter 1 ustawionym 
na 0 i Parameter 2 ustawionym na -100, stworzysz zanik dynamiki, zachowując oryginalne relacje 
prędkości:

NoteExp Operation – Remove Note Expression (Operacja NoteExp – Usuń wyrażenie notatki)
   Ta opcja jest dostępna tylko w przypadku nut. Umożliwia usunięcie wszystkich danych ekspresji 
   nuty z nuty.
NoteExp Operation – Create One-Shot (Operacja NoteExp – utwórz jednorazową operację)
   Ta opcja jest dostępna tylko w przypadku nut. Umożliwia dodanie danych ekspresji nutowych do 
   nut w trybie One Shot, co oznacza, że dodajesz parametr jako dane ekspresji nutowych. Po 
   dodaniu parametru jednorazowego należy za drugim razem ustawić żądaną wartość.
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NoteExp Operation – Reverse (Operacja NoteExp – odwróć)
   Odwraca dane ekspresji nutowych.

POWIĄZANE LINKI
Value 1 (Wartość 1) i Value 2 (Wartość 2) na stronie 996

Stosowanie zdefiniowanych działań
Po skonfigurowaniu warunków filtrowania, wybraniu funkcji i ustawieniu wymaganych akcji lub 
załadowaniu ustawienia wstępnego można zastosować akcje zdefiniowane w Logical Editor 
(Edytorze logicznym), klikając przycisk Apply (Zastosuj).

WAŻNE
Transformer (Transformator) z efektem wstawiania MIDI nie ma przycisku Apply (Zastosuj). 
Tutaj bieżące ustawienia są automatycznie stosowane w czasie rzeczywistym podczas odtwarzania 
lub gry na żywo.

Operacje Logical Editor można cofnąć tak samo, jak każdą inną edycję.

Presets (Ustawienia wstępne)
Możesz ładować, zapisywać i zarządzać Logical Presets (Ustawieniami logicznymi).

Aby załadować ustawienie wstępne, wykonaj jedną z następujących czynności:
● Otwórz Logical Editor (Edytor logiczny), otwórz wyskakujące menu Select Preset (Wybierz 
   ustawienie wstępne) i wybierz opcję.
● Wybierz opcję MIDI > Logical Presets (MIDI > Ustawienia logiczne) i wybierz opcję.
● Otwórz List Editor (Edytor list) i na pasku filtrów wybierz ustawienie wstępne z sekcji Show 
   (Pokaż).

UWAGA
Jeśli skonfigurujesz polecenie klawiszowe dla ustawienia wstępnego, możesz wygodnie zastosować
tę samą operację do kilku wybranych zdarzeń za jednym razem.

POWIĄZANE LINKI
Polecenia klawiszowe na stronie 1123

Zapisywanie własnych ustawień jako ustawień wstępnych
Możesz zapisać ustawienia, których chcesz użyć ponownie, jako ustawienia wstępne.

PROCEDURA
1. W sekcji w lewym górnym rogu Logical Editor (Edytora logicznego) kliknij opcję Store Preset 
    (Zapisz ustawienie wstępne).
2. W otwartym oknie dialogowym podaj nazwę ustawienia wstępnego i kliknij OK.

WYNIK
Ustawienie wstępne zostało zapisane.

UWAGA
Aby usunąć ustawienie wstępne, załaduj je i kliknij Remove Preset (Usuń ustawienie wstępne).
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Organizowanie i udostępnianie ustawień wstępnych

Presety Logical Editor (Edytora logicznego) są przechowywane w folderze aplikacji w podfolderze
Presets\Logical Edit Project.

Gotowych plików nie można edytować ręcznie, ale można je zreorganizować. Ułatwia to także 
udostępnianie presetów innym użytkownikom Cubase poprzez przesyłanie poszczególnych plików 
presetów.

UWAGA
Lista presetów jest odczytywana przy każdym otwarciu Edytora logicznego.

Project Logical Editor (Edytor logiczny 
projektu)
Project Logical Editor to potężne narzędzie do wyszukiwania i zamieniania funkcji w oknie 
Project.

Project Logical Editor umożliwia określenie warunków filtrowania i łączenie ich z akcjami. W ten
sposób możesz na przykład wyszukać wszystkie otwarte ścieżki folderów w swoim projekcie 
i zamknąć je.
Zawiera szereg ustawień wstępnych, które pokazują możliwości tej funkcji i które można 
wykorzystać jako punkt wyjścia do własnych ustawień.

POWIĄZANE LINKI
Ustawienia wstępne na stronie 1021
Omówienie okna Edytora logicznego projektu na stronie 1007

Omówienie okna Project Logical Editor (Edytora logicznego projektu)
Okno Project Logical Editor umożliwia łączenie warunków filtrów, funkcji, akcji i makr w celu 
przeprowadzenia bardzo wydajnego przetwarzania.

● Aby otworzyć Project Logical Editor, wybierz Project > Project Logical Editor
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1   Filter Conditions (Warunki filtra)
     Pozwalają określić warunki takie jak typ, atrybut, wartość, pozycja, które musi spełnić 
     konkretny element, aby został znaleziony. Można łączyć dowolną liczbę warunków filtrowania 
     za pomocą operatorów And/Or.
2   Action List (Lista działań)
     Umożliwia skonfigurowanie listy akcji, która dokładnie określa, co zostanie wykonane. Nie jest 
     to konieczne w przypadku wszystkich funkcji.
3   Function pop-up menu (Wyskakujące menu funkcji)
     Umożliwia wybranie, czy znalezione elementy mają zostać przekształcone, usunięte, czy 
     wybrane.

4   Macro pop-up menu (Wyskakujące menu makro)
     Umożliwia wybór makra.
5   Apply (Zastosuj)
     Zastosuje Twoje ustawienia.

WAŻNE
Nie każda kombinacja ustawień zawsze ma sens. Poeksperymentuj trochę, zanim zastosujesz 
zmiany w ważnych projektach.

UWAGA
Możesz cofnąć te operacje, wybierając Edit > Undo (Edycja > Cofnij).

POWIĄZANE LINKI
Ustawienia wstępne na stronie 1021

Filter Conditions (Warunki filtra)
Konfigurując warunki filtrowania, możesz określić, który cel filtra (filter target), czyli jakie 
elementy chcesz znaleźć.
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Aby skonfigurować warunek filtra, wykonaj następujące ustawienia:
Filter Target (Cel filtra)
    Ustawia właściwość elementu. To ustawienie wpływa na opcje dostępne w pozostałych 
    kolumnach.
Condition (Warunek)
    Określa, w jaki sposób Logical Editor (Edytor logiczny) projektu porównuje właściwość w 
    kolumnie Filter Target z wartościami w kolumnach Parameter. Dostępne opcje zależą od 
    ustawienia Filter Target.
Parameter 1 (Parametr 1)
    Ustawia wartość, z którą porównywane są właściwości elementu. Zależy to od Filter Target.
Parameter 2 (Parametr 2)
    Dostępne tylko wtedy, gdy w kolumnie Condition ustawiona jest jedna z opcji Range (Zakres). 
    Umożliwia znalezienie wszystkich elementów o wartościach mieszczących się w lub poza 
    zakresem pomiędzy Parameter 1 i Parameter 2.
Bar Range/Time Base (Zakres taktu/podstawa czasu)
    Dostępne tylko wtedy, gdy Filter Target (Cel filtru) jest ustawiony na Position (Pozycja). Jeśli 
    w kolumnie Condition (Warunek) wybrana jest jedna z opcji Bar Range (Zakres taktu), 
    kolumna Bar Range/Time Base służy do określenia stref w obrębie każdego taktu. Pozwala to 
    na przykład znaleźć wszystkie elementy na lub wokół pierwszego taktu każdego taktu. Jeśli 
    wybrana jest którakolwiek z pozostałych opcji Condition, możesz użyć kolumny Bar 
    Range/Time Base, aby określić podstawę czasu, taką jak PPQ, sekundy itp.
Left Bracket (Lewy nawias)
    W połączeniu z prawym nawiasem umożliwia to łączenie wielu warunków filtrowania, czyli 
    wielu linii z operatorami boolowskimi And/Or.

Right bracket (Prawy nawias)
    Razem z lewym nawiasem pozwala to na połączenie kilku warunków filtra.
bool
    Umożliwia wstawianie operatorów logicznych And/Or podczas tworzenia warunków z wieloma 
    liniami.

UWAGA
Jeśli popełnisz błąd podczas łączenia wielu warunków w nawiasach, zostaniesz o tym 
poinformowany w pasku stanu.

UWAGA
Jeśli zdefiniowałeś już warunki filtrowania i/lub zastosowałeś ustawienie wstępne, ale chcesz 
zacząć od nowa, możesz zainicjować ustawienia, wybierając opcję Init z wyskakującego menu 
Presets (Ustawienia wstępne).

POWIĄZANE LINKI
Wyszukiwanie elementów w określonych pozycjach na stronie 1012
Łączenie wielu linii warunków na stronie 1016
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Wyszukiwanie typów multimediów
Elementy można wyszukiwać według typu multimediów.

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel filtrowania) i wybierz Media Type (Typ nośnika).
2. Otwórz wyskakujące menu Parameter 1 i wybierz typ nośnika, który chcesz wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
    ● Wybierz opcję Equal (Równy), jeśli chcesz wyszukać określony typ multimediów.
    ● Wybierz opcję Unequal (Nierówne), jeśli chcesz wyszukać inny typ multimediów niż   
       określony.
    ● Wybierz opcję All Types (Wszystkie typy), jeśli chcesz wyszukać wszystkie typy 
       multimediów.

Media Type Filter (Filtr typu multimediów)
Gdy Filter Target (Cel filtra) jest ustawiony na Media Type (Typ nośnika), w wyskakującym 
menu wyświetlana jest lista dostępnych typów multimediów.

Audio
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia audio, części audio i ścieżki 
    audio.
MIDI
    Jeśli nie określono typu kontenera, zostaną znalezione części MIDI i ścieżki MIDI.
Automation (Automatyzacja)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia automatyzacji i ścieżki 
    automatyzacji.
Marker (Znacznik)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia znaczników i ścieżki 
    znaczników.
Transpose (Transponować)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia transpozycji i ścieżki 
    transpozycji.
Arranger (Aranżer)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia aranżera i ścieżki aranżera.

Tempo
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia tempa i ścieżki tempa.
Signature (Klucz)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia klucza i ścieżki klucza.
Chord (Akord)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia akordów i ścieżki akordów.
Scale Event (Zdarzenie Skala)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia skalowania.
Video (Wideo)
    Jeśli nie określono typu kontenera, zostaną znalezione zdarzenia wideo.
Group (Grupa)
    Jeśli nie określono typu kontenera, zostaną znalezione ścieżki grupowe.
Effect (Efekt)
    Jeśli nie określono typu kontenera, zostaną znalezione ścieżki kanału FX.
Device (Urządzenie)
    Jeśli nie określono typu kontenera, zostaną znalezione ścieżki urządzenia.
VCA
Jeśli nie określono typu kontenera, zostaną znalezione ścieżki tłumika VCA.
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W przypadku typów nośników dostępne są następujące opcje Condition (Warunek):
Equal (Równy)
    Spowoduje to znalezienie typu nośnika ustawionego w kolumnie Parameter 1.
All Types (Wszystkie typy)
    Spowoduje to znalezienie wszystkich typów multimediów.

Wyszukiwanie typów kontenerów

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel Filtru) i wybierz Container Type (Typ 
    kontenera).
2. Otwórz menu podręczne Parameter 1 i wybierz typ kontenera, który chcesz wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
      ● Wybierz opcję Equal (Równy), jeśli chcesz wyszukać określony typ kontenera.
      ● Wybierz opcję Unequal (Nierówny), jeśli chcesz wyszukać inny typ kontenera niż określony.
      ● Wybierz opcję All Types (Wszystkie typy), jeśli chcesz wyszukać wszystkie typy 
          kontenerów.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu) tak, aby znajdował 
wszystkie ścieżki folderów w projekcie.

Container Type Filter (Filtr typu kontenera)
Gdy Fiolter Target (Cel filtra) jest ustawiony na Container Type (Typ kontenera), 
w wyskakującym menu Parameter 1 wyświetlana jest lista dostępnych typów kontenerów.

Folder Track (Ścieżka folderu)
    Spowoduje to znalezienie wszystkich ścieżek folderów, w tym folderów kanałów FX i kanałów 
    grupowych.
Track (Ścieżka)
    Spowoduje to znalezienie wszystkich typów ścieżek.
Part (Część)
    Wyszukuje części audio, MIDI i instrumentów. Części folderu nie zostaną znalezione.
Event (Zdarzenie)
    Znajduje punkty automatyzacji, znaczniki, a także zdarzenia audio, aranżera, transpozycji, tempa 
    i metrum

W przypadku typów kontenerów dostępne są następujące opcje Condition (Warunek):
Equal (Równy)
    Spowoduje to znalezienie typu kontenera ustawionego w kolumnie Parameter 1.
All Types (Wszystkie typy)
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    Spowoduje to znalezienie wszystkich typów kontenerów.

Łączenie Media Type (typu nośnika) i Container Type (typu 
kontenera)
Kombinacja celów filtra Media Type (Typ nośnika) i Container Type (Typ kontenera) stanowi 
wszechstronne narzędzie do operacji logicznych.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu) tak, aby znajdował w 
projekcie wszystkie partie MIDI i instrumentów.

Możesz skonfigurować Project Logical Editor tak, aby znajdował wszystkie ścieżki automatyzacji
(nie zdarzenia) w projekcie, którego nazwa zawiera vol.

Możesz skonfigurować Project Logical Editor tak, aby znajdował w projekcie wszystkie partie 
MIDI i instrumenty (nie ścieżki), które są wyciszone.

Możesz skonfigurować Project Logical Editor tak, aby znajdował wszystkie partie MIDI i 
instrumentów (nie ścieżki) lub wszystkie zdarzenia audio (nie części i ścieżki) w projekcie, które są 
wyciszone.

Wyszukiwanie nazw

PROCEDURA
1. Otwórz pole Wartość Filter Target (docelowa filtra) i wybierz opcję Name (Nazwa).
2. Kliknij menu podręczne Parameter 1 i wprowadź nazwę lub część nazwy, którą chcesz 
    wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
      ● Wybierz opcję Equal (Równe), jeśli chcesz wyszukać dokładną nazwę.
      ● Wybierz opcję Contains (Zawiera), jeśli chcesz wyszukać nazwę zawierającą określoną 
         nazwę.
      ● Wybierz opcję Contains not (Nie zawiera), jeśli chcesz wyszukać inną nazwę niż określona.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu) tak, aby znajdował 
wszystkie ścieżki w projekcie, których nazwa zawiera voc.
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Wyszukiwanie elementów w określonych pozycjach
Możesz wyszukiwać elementy zaczynając od określonych pozycji, albo względem początku 
projektu, albo w obrębie każdego taktu.

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Filtruj cel) i wybierz opcję Position (Pozycja).
    Pozwala to znaleźć elementy rozpoczynające się w określonych pozycjach, albo względem 
    początku projektu, albo w obrębie każdego taktu.
2. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
      ● Aby znaleźć wszystkie elementy w określonej pozycji, wybierz pozycję w kolumnie 
         Parameter 1.
         Możesz ustawić podstawę czasu, taką jak PPQ, sekundy, próbki lub klatki, w kolumnie 
         Bar Range/Time Base (Zakres taktu/Podstawa czasu).
      ● Aby znaleźć wszystkie elementy wewnątrz lub na zewnątrz zakresu, wybierz opcję 
         Inside Bar Range (Wewnątrz zakresu taktów) lub Outside Bar Range (Poza zakresem 
         taktów).
         Możesz ustawić zakres taktu w kolumnie Bar Range/Time Base (Zakres taktu/Podstawa 
         czasu), klikając i przeciągając na wyświetlaczu słupkowym lub dopasowując pozycję 
         początkową zakresu w kolumnie Parameter 1 i pozycję końcową w kolumnie Parameter 2. 
         Podstawę czasu można zmienić w kolumnie Bar Range/Time Base. Pozycja Bar Range jest 
         mierzona w znacznikach (ticks) związanych z początkiem taktu.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu) tak, aby znajdował 
wszystkie elementy na pozycji PPQ 5.1.1. w projekcie.

Możesz skonfigurować Project Logical Editor tak, aby znajdował elementy rozpoczynające się 
wokół drugiego taktu w każdym takcie:

Position Filter (Filtr pozycji)
Dla pozycji dostępne są następujące opcje Condition (Warunków):

Equal (Równy)
    Ma dokładnie taką samą wartość jak ustawiona w kolumnie Parameter 1.
Unequal (Nierówny)
    Ma dowolną wartość inną niż ustawiona w kolumnie Parameter 1.
Bigger (Większy)
    Ma wartość wyższą niż ustawiona w kolumnie Parameter 1.
Bigger or Equal (Większy lub równy)
    Ma wartość taką samą lub wyższą od ustawionej w kolumnie Parameter 1.
Less (Mniej)
    Ma wartość mniejszą niż ustawiona w kolumnie Parameter 1.
Less or Equal (Mniej lub równo)
    Ma wartość taką samą lub niższą od ustawionej w kolumnie Parameter 1.
Inside Range (Wewnątrz zakresu)
    Ma wartość mieszczącą się pomiędzy wartościami ustawionymi w kolumnach Parameter 1 
    i Parameter 2. Należy pamiętać, że Parameter 1 powinien mieć niższą wartość, a Parameter 2 
    wyższą.
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Outside Range (Poza zakresem)
    Ma wartość, która nie mieści się pomiędzy wartościami ustawionymi w kolumnach Parameter 1 
    i Parameter 2.
Inside Bar Range (Wewnątrz zakresu taktu)
    Znajduje się w strefie określonej w kolumnie Bar Range/Time Base (Zakres taktu/Podstawa 
    czasu), w każdym takcie w ramach bieżącego wyboru.
Outside Bar Range (Zewnętrzny zakres taktów)
    Znajduje się poza strefą ustawioną w kolumnie Bar Range/Time Base, w każdym takcie 
    w ramach bieżącego wyboru.
Before Cursor (Przed kursorem)
    Znajduje się przed pozycją kursora.
Beyond Cursor (Poza kursorem)
    Znajduje się po pozycji kursora.
Inside Track Loop (Wewnątrz pętli ścieżki)
    Znajduje się w ustawionej pętli ścieżki.
Inside Cycle (Cykl wewnętrzny)
    Znajduje się w ustalonym cyklu.
Exactly Matching Cycle (Dokładnie dopasowany cykl)
    Dokładnie odpowiada ustawionemu cyklowi.

Wyszukiwanie elementów o określonych długościach

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Filtruj cel) i wybierz Length (Długość).
      Dzięki temu można znaleźć tylko elementy o określonej długości.

UWAGA
Parametr Length (Długość) jest interpretowany poprzez ustawienie podstawy czasu w kolumnie 
Bar Range/Time Base (Zakres taktu/Podstawa czasu), to znaczy w PPQ, sekundach, próbkach lub 
klatkach (ramkach).

2. Otwórz menu podręczne Parameter 1 i ustaw długość, którą chcesz wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz opcję.
    Jeśli wybierzesz opcję Inside Range (Wewnątrz zakresu) lub Outside Range (Poza zakresem), 
    użyj Parameter 1 i Parameter 2, aby ustawić początek i koniec zakresu.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu) tak, aby znajdował 
wszystkie części audio i zdarzenia w projekcie o długości poniżej 200 próbek (samples).

POWIĄZANE LINKI
Length Filter (Filtr długości) na stronie 1014
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Length Filter (Filtr długości)

W przypadku długości dostępne są następujące opcje Condition (Warunek):
Equal (Równy)
    Ma dokładnie taką samą wartość jak ustawiona w kolumnie Parameter 1.
Unequal (Nierówny)
   Ma dowolną wartość inną niż ustawiona w kolumnie Parameter 1.
Bigger (Większy)
   Ma wartość wyższą niż ustawiona w kolumnie Parameter 1.
Bigger or Equal (Większy lub równy)
    Ma wartość taką samą lub wyższą od ustawionej w kolumnie Parameter 1.
Less (Mniej)
    Ma wartość mniejszą niż ustawiona w kolumnie Parameter 1.
Less or Equal (Mniej lub równo)
    Ma wartość taką samą lub niższą od ustawionej w kolumnie Parameter 1.
Inside Range (Wewnątrz zakresu)
    Ma wartość mieszczącą się pomiędzy wartościami ustawionymi w kolumnach Parameter 1 
    i Parameter 2. Należy pamiętać, że Parameter 1 powinien mieć niższą wartość, a Parameter 2 
    wyższą.
Outside Range (Poza zakresem)
    Ma wartość, która nie mieści się pomiędzy wartościami ustawionymi w kolumnach Parameter 1 
    i Parameter 2.

Wyszukiwanie nazw kolorów

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel filtru) i wybierz opcję Color Name (Nazwa 
    koloru).
2. Kliknij pole wartości Parameter 1 i wpisz nazwę koloru, który chcesz wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
      ● Wybierz opcję Equal (Równy), jeśli chcesz wyszukać dokładną nazwę koloru.
      ● Wybierz opcję Contains (Zawiera), jeśli chcesz wyszukać nazwę koloru zawierającą 
         określoną nazwę koloru.
      ● Wybierz opcję Contains not (Nie zawiera), jeśli chcesz wyszukać inną nazwę koloru niż 
         podana.

Wyszukiwanie Properties (Właściwości)

PROCEDURA
1. Otwórz wyskakujące menu Filter Target (Cel filtru) i wybierz Property (Właściwość).

1027



2. Otwórz menu podręczne Parameter 1 i wybierz właściwość, którą chcesz wyszukać.
3. Otwórz wyskakujące menu Condition (Warunek) i wybierz jedną z następujących opcji:
      ●  Wybierz Property is set (Właściwość jest ustawiona), jeśli chcesz wyszukiwać zdarzenia 
          posiadające określoną właściwość.
      ● Wybierz Property is not set (Właściwość nie jest ustawiona), jeśli chcesz wyszukiwać 
          zdarzenia, które nie mają określonej właściwości.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu) tak, aby znajdował 
wszystkie wyciszone partie MIDI i instrumentów.

Możesz skonfigurować Project Logical Editor tak, aby znajdował wszystkie puste elementy.

Możesz skonfigurować Project Logical Editor tak, aby znajdował wszystkie wybrane części 
audio, które są zaznaczone, ale nie wyciszone.

Properties Filter (Filtr właściwości)
W przypadku właściwości dostępne są następujące opcje Condition (Warunek):
Property is set (Właściwość jest ustawiona)
    Spowoduje to znalezienie wszystkich zdarzeń, które mają właściwość ustawioną w kolumnie    
    Parameter 1.
Property is not set (Właściwość nie jest ustawiona)
    Spowoduje to znalezienie wszystkich zdarzeń, które nie mają właściwości ustawionej w 
    kolumnie Parameter 1.

Gdy Filter Target (Cel filtra) jest ustawiony na Property (Właściwość), w menu podręcznym 
znajdują się dostępne właściwości Parameter 1.

Event is muted (Zdarzenie jest wyciszone)
    Spowoduje to znalezienie wszystkich wyciszonych zdarzeń.
Event is selected (Zdarzenie zostało wybrane)
    Spowoduje to znalezienie wszystkich wybranych zdarzeń.
Event is empty (Zdarzenie jest puste)
    Spowoduje to znalezienie wszystkich pustych zdarzeń.
Event inside NoteExp (Zdarzenie wewnątrz NoteExp)
    Spowoduje to znalezienie wszystkich zdarzeń, które stanowią część danych automatyzacji Note 
    Expression. Mogą to być zdarzenia kontrolera VST 3 lub MIDI.
Event is valid VST 3 (Zdarzenie jest ważne VST 3)
    Spowoduje to znalezienie wszystkich prawidłowych zdarzeń VST 3 w nucie. Oznacza to, że 
    odpowiednia ścieżka jest kierowana do instrumentu, który je obsługuje.
Is Hidden (Jest ukryty)
    Spowoduje to odnalezienie wszystkich ukrytych ścieżek.
Has Track Version (Ma wersję ścieżki)
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    Spowoduje to znalezienie wszystkich utworów, które mają wersje utworów.
Follows Chord Track (Podąża za ścieżką akordów)
    Spowoduje to znalezienie wszystkich ścieżek, które podążają za ścieżką akordów.
Is Disabled (Jest wyłączony)
    Spowoduje to znalezienie wszystkich wyłączonych ścieżek.

Łączenie wielu linii warunków
Można dodawać linie warunków i łączyć je za pomocą operatorów logicznych And i Or oraz 
nawiasów.

● Aby dodać nowy warunek, kliknij    poniżej listy.
   Nowa linia zostanie dodana na dole listy.

● Aby usunąć warunek, wybierz go i kliknij     poniżej listy.

Kolumna Bool
W kolumnie bool po prawej stronie listy możesz wybrać operator boolowski: And lub Or.

Operator boolowski łączy 2 linie warunku i określa wynik w następujący sposób:
     ● And (I) określa, że aby element został znaleziony, muszą zostać spełnione oba warunki.
     ● Or (Lub) stwierdza, że aby element został znaleziony, musi zostać spełniony co najmniej 
        jeden z warunków.

WAŻNE
Po dodaniu nowej linii warunku domyślnym ustawieniem logicznym jest And.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu) tak, aby znajdował 
ścieżki MIDI.

Możesz skonfigurować Project Logical Editor (Edytor logiczny projektu), aby znaleźć wszystkie 
części lub zdarzenia, które dokładnie pasują do cyklu.

Korzystanie z nawiasów
Kolumny nawiasów umożliwiają umieszczenie 2 lub więcej linii warunku, dzieląc wyrażenie 
warunkowe na mniejsze jednostki. Ma to znaczenie tylko wtedy, gdy masz 3 lub więcej linii 
warunków i chcesz użyć operatora logicznego Or.

Możesz dodać nawiasy, klikając kolumny nawiasów i wybierając odpowiednią opcję. Można 
wybrać maksymalnie potrójne nawiasy.

Jeśli dodasz kilka warstw nawiasów, będą one oceniane od środka na zewnątrz, zaczynając od 
nawiasów najbardziej wewnętrznych.
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Wyrażenia w nawiasach są oceniane w pierwszej kolejności.

PRZYKŁAD
Możesz skonfigurować Project Logical Editor tak, aby znajdował wszystkie partie i zdarzenia 
audio, których nazwa zawiera perc, a także inne partie i zdarzenia MIDI, których nazwa zawiera 
drums (perkusję)

Możesz skonfigurować Project Logical Editor tak, aby znajdował wszystkie części audio lub 
zdarzenia, których nazwa zawiera perc lub drums.

Określanie działań
Możesz określić akcje, czyli zmiany dokonane w znalezionych elementach, na dolnej liście Project 
Logical Editor (Edytora logicznego projektu). Akcje mają zastosowanie tylko w przypadku funkcji
typu Transform.

Możesz wykonać następujące typy akcji:
● Działania oparte na ścieżkach, takie jak Track Operation (operacja ścieżka), Name (nazwa).
● Działania oparte na zdarzeniach, takie jak Position (pozycja), Length (długość), Name (nazwa).
● Akcje, które mają wpływ tylko na dane automatyzacji, takie jak Trim (Przytnij).

   Możesz dodać linie akcji, klikając    i usunąć je, zaznaczając je i klikając 

Action Target (Cel akcji)
Action Target umożliwia wybranie zmienianej właściwości.

Position (Pozycja)
Dostosowanie wartości Position przesuwa elementy.

Parametr ten jest interpretowany poprzez ustawienie podstawy czasu w kolumnie Bar Range/Time 
Base (Zakres taktu/Podstawa czasu), z wyjątkiem ustawienia Random (Losowy), które 
wykorzystuje podstawę czasu zdarzeń, których to dotyczy:

Add (Dodaj)
     Dodaje wartość określoną w kolumnie Parameter 1 do Position (pozycji).
Subtract (Odejmij)
     Odejmuje wartość określoną w kolumnie Parameter 1 od Position.
Multiply by (Pomnóż przez)
    Mnoży wartość Position przez wartość określoną w kolumnie Parameter 1.
Divide by (Podziel przez)
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    Dzieli wartość Position przez wartość określoną w kolumnie Parameter 1.
Round by (Zaokrąglij przez)
    Spowoduje to zaokrąglenie wartości Position przy użyciu wartości określonej w kolumnie 
    Parameter 1. Innymi słowy, wartość Position jest zmieniana na najbliższą wartość, którą można 
    podzielić przez wartość Parameter 1.
Set relative Random Values between (Ustaw względne wartości losowe pomiędzy)
    Spowoduje to dodanie losowej wartości do bieżącej wartości Position. Dodana wartość losowa 
    będzie mieściła się w zakresie określonym za pomocą Parameter 1 i Parameter 2. Należy 
    pamiętać, że można je ustawić na wartości ujemne.
Set to fixed value (Ustaw na stałą wartość)
    Spowoduje to ustawienie Position na wartość określoną w kolumnie Parameter 1.

Length (Długość)
Dostosowanie wartości Length umożliwia zmianę rozmiaru elementów.

Parametr ten jest interpretowany poprzez ustawienie podstawy czasu w kolumnie Bar Range/Time 
Base (Zakres taktu/Podstawa czasu), z wyjątkiem ustawienia Random (Losowy), które 
wykorzystuje podstawę czasu zdarzeń, których to dotyczy:

Add (Dodaj)
    Dodaje wartość określoną w kolumnie Parameter 1 do Length.
Subtract (Odejmij)
    Odejmuje wartość określoną w kolumnie Parameter 1 od Length.
Multiply by (Pomnóż przez)
    Mnoży wartość Length przez wartość określoną w kolumnie Parameter 1.
Divide by (Podziel przez)
    Dzieli wartość Length przez wartość określoną w kolumnie Parameter 1.
Round by (Zaokrąglij przez)
    Spowoduje to zaokrąglenie wartości Length przy użyciu wartości określonej w kolumnie 
    Parameter 1. Innymi słowy, wartość Length jest zmieniana na najbliższą wartość, którą można 
    podzielić przez wartość Parameter 1.

Set to fixed value (Ustaw na stałą wartość)
    Spowoduje to ustawienie Length na wartość określoną w kolumnie Parameter 1.
Set Random Values between (Ustaw losowe wartości pomiędzy)
    Spowoduje to dodanie losowej wartości do bieżącej długości. Dodana wartość losowa będzie 
    mieściła się w zakresie określonym Parameter 1 i Parameter 2.

Track Operation (Operacja ścieżka)
Dostosowanie wartości Track Operation (Operacja na ścieżce) umożliwia zmianę stanu ścieżki.

UWAGA
Operacje na ścieżkach mogą również wpływać na ścieżki automatyzacji. Może to prowadzić do 
nieoczekiwanych rezultatów, zwłaszcza jeśli użyjesz akcji Toggle (Przełącz).

Folder (Teczka)
    Otwiera, zamyka lub przełącza foldery.
Record (Nagraj)
    Włącza, wyłącza lub przełącza stan umożliwienia nagrywania.
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Monitor
    Włącza, wyłącza lub przełącza stan monitora.
Solo
    Włącza, wyłącza lub przełącza status solo.
Mute (Wycisz)
    Włącza, wyłącza lub przełącza stan wyciszenia.
Read (Czytaj)
    Włącza, wyłącza lub przełącza stan umożliwienia odczytu.
Write (Pisz)
    Włącza, wyłącza lub przełącza stan umożliwienia zapisu.
EQ Bypass (Obejście korektora)
    Włącza, wyłącza lub przełącza status obejścia korektora.
Inserts Bypass (Wstawia obejście)
    Włącza, wyłącza lub przełącza stan obejścia wstawek.
Sends Bypass (Wysyła obejście)
    Włącza, wyłącza lub przełącza status pomijania wysyłek.
Lanes Active (Pasy aktywne)
    Włącza, wyłącza lub przełącza stan aktywnych pasów.
Hide Track (Ukryj ścieżkę)
    Włącza, wyłącza lub przełącza stan widoczności ścieżki.
Time Domain (Domena czasu)
    Ustawia domenę czasu utworu na Musical lub Linear lub przełącza status.

Name (Nazwa)
Dostosowanie wartości Name umożliwia zmianę nazw znalezionych elementów.

Replace (Zastąp)
    Zastępuje nazwy tekstem określonym w kolumnie Parameter 1.
Append (Dodaj)
    Do nazwy zostanie dołączony ciąg znaków określony w kolumnie Parameter 1.
Prepend (Przygotuj)
    Nazwa zostanie poprzedzona ciągiem znaków określonym w kolumnie Parameter 1.
Generate Name (Wygeneruj nazwę)
    Nazwa zostanie zastąpiona tekstem podanym w kolumnie Parameter 1, a następnie numerem 
    ustawionym w Parameter 2. Liczba zostanie zwiększona o 1 za każdy znaleziony element.
Replace Search String (Zamień szukany ciąg)
    Można określić ciąg wyszukiwania w Parameter 1, który zostanie zastąpiony tekstem 
    określonym w kolumnie Parameter 2.
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Trim (Przytnij)
Dostosowanie wartości Trim umożliwia przycięcie znalezionych elementów. Służy wyłącznie do 
automatyzacji.

Multiply by (Pomnóż przez)
    Mnoży wartość Trim przez wartość określoną w kolumnie Parameter 1.
Divide by (Podziel przez)
    Dzieli wartość Trim przez wartość określoną w kolumnie Parameter 1.

Set Color (Ustaw kolor)
Dostosowanie wartości Set Color umożliwia ustawienie koloru elementu.

W przypadku tego Action Target (Celu akcji) jedyną dostępną opcją jest Set to fixed value (Ustaw
na stałą wartość). Aby ustawić konkretny kolor, kliknij kolumnę Parameter 1 i wybierz pozycję z 
wyskakującego menu.

Wybór funkcji
W lewym wyskakującym menu na dole Project Logical Editor (Edytora logicznego projektu) 
wybierasz funkcję – podstawowy typ edycji, który ma zostać wykonany.

           

Dostępne opcje to:

Delete (Usuń)
    Usuwa wszystkie elementy znalezione przez Project Logical Editor (Edytor logiczny projektu).

UWAGA
Jeśli usuniesz ścieżki automatyzacji i cofniesz tę operację, wybierając opcję Undo (Cofnij) z menu 
Edit (Edycja), ścieżki automatyzacji zostaną przywrócone, ale ścieżki zostaną zamknięte.

Transform (Przekształć)
    Zmienia jeden lub kilka aspektów znalezionych elementów. Konfigurujesz dokładnie to, co ma 
    zostać zmienione na liście akcji.
Select (Wybierz)
    Spowoduje to po prostu wybranie wszystkich znalezionych elementów i podświetlenie ich do 
    dalszej pracy w oknie Project.

Stosowanie makr
W wyskakującym menu Macro możesz wybrać makro, które zostanie wykonane automatycznie po 
wykonaniu zdefiniowanych działań.

Aby z tego skorzystać, skonfiguruj potrzebne makro w oknie dialogowym Key Commands 
(Komendy klawiszowe), a następnie wybierz je w Project Logical Editor (Edytorze logicznym 
projektu) z wyskakującego menu Macro.

POWIĄZANE LINKI
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Polecenia klawiaturowe na stronie 1123

Stosowanie zdefiniowanych działań
Po skonfigurowaniu warunków filtrowania, wybraniu funkcji i ustawieniu wymaganych akcji lub 
załadowaniu ustawienia wstępnego można zastosować akcje zdefiniowane w Project Logical 
Editor (Edytorze logicznym projektu), klikając przycisk Apply (Zastosuj).

Operacje Project Logical Editor można cofnąć tak samo, jak każdą inną edycję.

Presets (Ustawienia wstępne)
Sekcja w lewej górnej części okna umożliwia ładowanie, zapisywanie i zarządzanie ustawieniami 
wstępnymi Project Logical Editor.

Aby załadować ustawienie wstępne, wykonaj jedną z następujących czynności:
    ● Otwórz wyskakujące menu Select Preset (Wybierz ustawienie wstępne) i wybierz opcję.
    ● Wybierz opcję Project > Apply Project Logical Editor Preset (Projekt > Zastosuj ustawienie
       wstępne edytora logicznego projektu) i wybierz opcję.

UWAGA
Jeśli skonfigurujesz polecenie klawiszowe dla ustawienia wstępnego, możesz wygodnie zastosować
tę samą operację do kilku wybranych zdarzeń za jednym razem.

POWIĄZANE LINKI
Polecenia klawiaturowe na stronie 1123

Zapisywanie własnych ustawień jako ustawień wstępnych
Możesz zapisać ustawienia, których chcesz użyć ponownie, jako ustawienia wstępne.

PROCEDURA
1. W sekcji w lewym górnym rogu Project Logical Editor (Edytora logicznego projektu) kliknij 
    opcję Store Preset (Zapisz ustawienie wstępne).
2. W otwartym oknie dialogowym podaj nazwę ustawienia wstępnego i kliknij OK

WYNIK
Ustawienie wstępne zostało zapisane.

UWAGA
Aby usunąć ustawienie wstępne, załaduj je i kliknij przycisk Remove Preset (Usuń ustawienie 
wstępne).

Organizowanie i udostępnianie ustawień wstępnych
Ustawienia wstępne Project Logical Editor (Edytora Logicznego Projektu) są przechowywane w 
folderze aplikacji w podfolderze Presets\Logical Edit Project.

Gotowych plików nie można edytować ręcznie, ale można je zreorganizować. Ułatwia to także 
udostępnianie presetów innym użytkownikom Cubase poprzez przesyłanie poszczególnych plików 
presetów.

UWAGA
Lista presetów jest odczytywana każdorazowo po otwarciu Project Logical Editor.

Konfigurowanie poleceń klawiaturowych dla ustawień wstępnych
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Jeśli zapisałeś ustawienia wstępne Project Logical Editor, możesz skonfigurować dla nich 
polecenia klawiszowe.

PROCEDURA
1. Wybierz Edit > Key Commands (Edycja > Polecenia klawiszowe).
2. W kolumnie Commands (Polecenia) przejdź do kategorii Process Logical Preset (Wstępne 
    ustawienia logiczne procesu) i kliknij znak plus, aby wyświetlić elementy w folderze.
3. Wybierz z listy element, do którego chcesz przypisać polecenie klawiszowe, kliknij pole Type in
    Key (Wpisz klawisz) i wprowadź nowe polecenie klawiszowe.
4. Kliknij przycisk Assign (Przypisz) nad polem.
    Nowe polecenie klawiszowe zostanie wyświetlone na liście Keys (Klawisze).
5. Kliknij OK.

POWIĄZANE LINKI
Polecenia klawiaturowe na stronie 1123

Editing Tempo and Time Signature 
(Edycja tempa i metrum)
Możesz ustawić tempo i metrum dla swojego projektu. Domyślnie tempo jest ustawione na 120 
bpm, a metrum na 4/4.

Tryby tempa projektu
Dla każdego projektu możesz ustawić tryb tempa, w zależności od tego, czy Twoja muzyka ma 
stałe tempo, czy też zmienia się w trakcie projektu.

W panelu Transport możesz ustawić następujące tryby tempa:
●   Fixed Tempo Mode (Tryb stałego tempa)
     Jeśli chcesz pracować w jednym stałym tempie, które nie zmienia się w trakcie projektu, wyłącz 
     opcję z (Aktywuj ścieżkę tempa) w panelu Transport. Możesz zmienić 
     wartość tempa, aby ustawić stałe tempo próby.
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●   Tempo Track Mode (Tryb śledzenia tempa)
     Jeśli tempo Twojej muzyki zawiera zmiany tempa, aktywuj opcję Activate Tempo Track 
     (Aktywuj ścieżkę tempa) na panelu Transport. Możesz zmienić wartość tempa, aby zmienić 
     tempo przy kursorze. Jeśli Twój projekt nie zawiera żadnych zmian tempa, tempo zostanie 
     zmienione na początku projektu.

           

POWIĄZANE LINKI
Konfigurowanie projektów pod kątem zmian tempa na stronie 1028

Track Time Base (Ścieżka podstawy czasu)
Podstawa czasu ścieżki określa, czy ścieżka może nadążać za zmianami tempa projektu 
ustawionego na tryb śledzenia tempa.

W Inspektorze ścieżek MIDI, ścieżek instrumentów i ścieżek związanych z dźwiękiem możesz 
włączyć/wyłączyć opcję Toggle Time Base (Przełącz podstawę czasu), aby przełączyć podstawę 
czasu ścieżki.

Dostępne są następujące tryby podstawy czasu:

●   Musical (Muzyczny)
     Tego trybu należy używać w przypadku materiału o podstawie muzycznej, czyli opartej na 
     tempie. Wszystkie ścieżki ustawione na muzyczną podstawę czasu podlegają zmianom tempa 
     dodanym na ścieżce tempa.
UWAGA
W przypadku zdarzeń audio na ścieżkach audio ustawionych na muzyczną podstawę czasu zmiany 
tempa na ścieżce tempa wpływają tylko na pozycję początkową, a nie na rzeczywisty dźwięk.

●   Linear (Liniowy)
     Tego trybu należy używać w przypadku materiałów o liniowej podstawie czasu zależnej od 
     czasu.

POWIĄZANE LINKI
Inspektor ścieżki instrumentu na stronie 127
Inspektor ścieżek MIDI na stronie 134
Inspektor ścieżki audio na stronie 124

Tempo Track Editor (Edytor ścieżki tempa)
Tempo Track Editor zapewnia przegląd ustawień tempa projektu. Umożliwia dodawanie i edycję 
zdarzeń tempa.

Aby otworzyć Tempo Track Editor, wykonaj jedną z następujących czynności:
      ● Wybierz opcję Project > Tempo Track (Projekt > Ścieżka tempa).
      ● Naciśnij Ctrl/Cmd - T.
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Tempo Track Editor (Edytor ścieżki Tempo) jest podzielony na kilka sekcji:

1   Tempo Scale (Skala tempa)
     Pokazuje skalę tempa w BPM.
2   Toolbar (Pasek narzędzi)
     Zawiera narzędzia do wybierania, dodawania i zmiany tempa i metrum.
3   Info line (Linia informacyjna)
     Wyświetla informacje o wybranym zdarzeniu dotyczącym tempa lub metrum.
4   Ruler (Linijka)
     Pokazuje oś czasu i format wyświetlania projektu.
5   Time signature display (Wyświetlacz metrum)
     Pokazuje zdarzenia metrum w projekcie.
6   Tempo curve display (Wyświetlacz krzywej tempa)
     Jeśli w projekcie ustawiono stałe tempo, wyświetlane jest tylko jedno zdarzenie tempa i stałe 
     tempo. Jeśli projekt jest ustawiony na tryb śledzenia tempa, wyświetlacz krzywej pokazuje 
     krzywą tempa ze zdarzeniami tempa w projekcie.

Pasek narzędzi edytora ścieżek tempa
Pasek narzędzi zawiera narzędzia służące do wybierania, dodawania i zmiany tempa oraz metrum.

Dostępne są następujące narzędzia:

Activate Tempo Track (Aktywuj ścieżkę tempa)
Activate Tempo Track

       
      Przełącza tempo projektu pomiędzy trybem stałego tempa a trybem śledzenia tempa

Left Divider (Lewy rozdzielacz)
Left Divider
      Narzędzia umieszczone po lewej stronie rozdzielacza są zawsze pokazane.

Auto Scroll (Automatyczne przewijanie)
Auto Scroll
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      Utrzymuje kursor projektu widoczny podczas odtwarzania.
Select Auto-Scroll Settings (Wybierz Ustawienia automatycznego przewijania)

       
      Umożliwia aktywację przewijania strony lub nieruchomego kursora oraz aktywację 
      wstrzymania automatycznego przewijania podczas edycji.

Tool Buttons (Przyciski narzędzi)
Object Selection (Wybór obiektu)

       
      Wybiera zdarzenia.
Draw (Rysuj)

       
      Rysuje zdarzenia.
Erase (Usuń)

       
      Usuwa zdarzenia.
Zoom (Powiększenie)

       
      Powiększ. Przytrzymaj Alt/Opt i kliknij, aby pomniejszyć.

New Tempo Type (Nowy typ tempa)
Type of New Tempo Points (Rodzaj nowych punktów tempa)

       
      Umożliwia wybór typu nowych punktów tempa. Wybierz opcję Ramp (Rampa), jeśli chcesz,    
      aby nowe punkty tempa zmieniały się stopniowo od poprzedniego punktu krzywej do nowego.   
      Wybierz opcję Step (Krok), jeśli chcesz, aby nowe punkty tempa zmieniały się natychmiast. 
      Wybierz opcję Automatic (Automatycznie), jeśli nowe punkty tempa mają być tego samego 
      typu, co poprzedni punkt krzywej.

Current Tempo (Aktualne tempo)
Current Tempo

       
      W trybie stałego tempa umożliwia zmianę bieżącego tempa.

Snap (Przyciągnij)
Snap On/Off (Włączanie/wyłączanie przyciągania)

       
      Ogranicza ruch w poziomie i pozycjonowanie do pozycji określonych przez typ przyciągania. 
      Zdarzenia metrum zawsze przyciągane są do początku taktów.
Snap Type (Typ przyciągania)

       
      Umożliwia określenie pozycji, do których mają być przyciągane zdarzenia.

Tempo Recording (Nagrywanie tempa)
Open Tempo Recording Panel (Otwórz panel nagrywania tempa)
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      Otwiera panel umożliwiający rejestrowanie zmian tempa.

Process Tempo (Tempo procesu)
Open Process Tempo Dialog (Otwórz okno dialogowe Tempo procesu)

       
      Otwiera okno dialogowe Tempo procesu.
Open Process Bars Dialog (Otwórz okno dialogowe pasków procesowych)

       
      Otwiera okno dialogowe Process Bars (Paski procesowe).

Right Divider (Prawy rozdzielacz)
Right Divider
      Narzędzia umieszczone po prawej stronie rozdzielacza są zawsze pokazane.

Show Info Line (Pokaż linię informacyjną)
Show/Hide Info (Pokaż/ukryj informacje)

       
      Otwiera/zamyka linię informacyjną.

Set up Toolbar (Skonfiguruj pasek narzędzi)
Set up Toolbar

       
      Otwiera wyskakujące menu, w którym możesz ustawić, które elementy paska narzędzi mają być
      widoczne.

Tempo Track (Ścieżka tempa)
Ścieżki tempa można używać do tworzenia zmian tempa w projekcie.

● Aby dodać ścieżkę tempa do swojego projektu, wybierz Project > Add Track > Tempo (Projekt 
   > Dodaj ścieżkę > Tempo).
● Możesz używać narzędzi na pasku narzędzi okna Project, aby dodawać i edytować zdarzenia 
   tempa.
● Możesz użyć edytora zdarzeń tempa, aby edytować wybrane zdarzenia tempa.
● Aby wybrać zdarzenie tempa, kliknij je narzędziem Object Selection (Zaznaczanie obiektów).

● Aby wybrać wiele zdarzeń, przeciągnij prostokąt zaznaczenia za pomocą narzędzia Object   
   Selection (Zaznaczanie obiektów) lub klawisza Shift i kliknij zdarzenia.
● Aby wybrać wszystkie zdarzenia tempa na ścieżce tempa, kliknij ścieżkę tempa prawym 
   przyciskiem myszy i wybierz opcję Select All Events (Wybierz wszystkie zdarzenia) z menu 
   kontekstowego.

POWIĄZANE LINKI
Inspektor ścieżek Tempo na stronie 157
Sterowanie ścieżką tempa na stronie 158

Edytor zdarzeń Tempo
Edytor zdarzeń tempa umożliwia edycję wybranych zdarzeń na ścieżce tempa.
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● Aby otworzyć edytor zdarzeń tempa, aktywuj narzędzie Object Selection (Zaznaczanie 
   obiektów) i przeciągnij prostokąt zaznaczenia na ścieżce tempa.

Edytor zdarzeń tempa zawiera następujące inteligentne elementy sterujące dla określonych trybów 
edycji:

                     
1   Tilt Left (Przechyl w lewo)
     Klikając w lewy górny róg edytora, możesz przechylić lewą część krzywej. Umożliwia to 
     przechylenie wartości zdarzeń na początku krzywej w górę lub w dół.
2   Compress Left (Kompresuj w lewo)
     Jeśli klikniesz Alt/Opt w lewym górnym rogu edytora, możesz skompresować lub rozszerzyć 
     lewą część krzywej. Umożliwia to kompresję lub rozszerzenie wartości zdarzeń na początku 
     krzywej.
3   Scale Vertically (Skaluj w pionie)
     Jeśli klikniesz na środku górnej krawędzi edytora, możesz przeskalować krzywą w pionie.  
     Umożliwia to zwiększenie lub zmniejszenie wartości zdarzeń na krzywej w procentach.
4   Move Vertically (Przesuń w pionie)
     Klikając górną granicę edytora, możesz przesunąć całą krzywą w pionie. Umożliwia to 
     zwiększenie lub zmniejszenie wartości zdarzeń na krzywej.
5   Compress Right (Kompresuj w prawo)
     Jeśli klikniesz Alt/Opt w prawym górnym rogu edytora, możesz skompresować lub rozszerzyć 
     prawą część krzywej. Umożliwia to kompresję lub rozszerzenie wartości zdarzeń na końcu 
     krzywej.
6   Tilt Right (Przechyl w prawo)
     Klikając w prawy górny róg edytora, możesz przechylić prawą część krzywej. Umożliwia to 
     przechylenie wartości zdarzeń na końcu krzywej w górę lub w dół.
7   Scale Around Relative Center (Skaluj wokół względnego środka)
     Kliknięcie klawiszem Alt/Opt w prawym środkowym obramowaniu edytora umożliwia 
     skalowanie krzywej względem jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w 
     poziomie wokół środka edytora.
8   Scale Around Absolute Center (Skaluj wokół absolutnego środka)
     Jeśli klikniesz w prawym środkowym rogu edytora, możesz przeskalować krzywą bezwzględnie 
     do jej środka. Pozwala to podnosić lub obniżać wartości zdarzeń w poziomie wokół środka 
     edytora.
9   Stretch (Rozciągnij)
     Kliknięcie dolnej krawędzi edytora umożliwia rozciągnięcie krzywej w poziomie. Umożliwia to 
     przesuwanie wartości zdarzeń na krzywej w lewo lub w prawo.

Zmiany tempa projektów
Jeśli ścieżka tempa jest włączona, możesz skonfigurować zmiany tempa w swoim projekcie.

WAŻNE
Jeśli Twój projekt jest ustawiony na tryb śledzenia tempa i skonfigurujesz zmiany tempa, zmiany 
tempa będą uwzględniały tylko ścieżki, które są ustawione na muzyczną podstawę czasu.
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UWAGA
Jeśli pracujesz w trybie śledzenia tempa, upewnij się, że format wyświetlania na linijce okna 
Project jest ustawiony na Bars+Beats (Takty+Uderzenia). W przeciwnym razie możesz uzyskać 
mylące wyniki.

Jeśli aktywujesz opcję Activate Tempo Track (Aktywuj ścieżkę tempa) na panelu Transport, 
krzywa ścieżki tempa zostanie wyświetlona na wyświetlaczu krzywej tempa.

Jeśli znasz tempo swojej muzyki, możesz dostosować wartość tempa w następujący sposób:
      ● Dodając zdarzenia tempa w Tempo Track Editor (Edytorze ścieżki tempa).
      ● Nagrywając zmiany tempa za pomocą panelu Tempo Recording (Nagrywanie tempa) 
         w Tempo Track Editor (Edytorze ścieżki tempa).
      ● Dodając zdarzenia tempa na ścieżce tempa.
      ● Importując ścieżki tempa.

Jeśli nie znasz tempa swojej muzyki, Cubase oferuje narzędzia do jego obliczenia i ustawienia:
      ● Panel Tempo Detection (Wykrywania tempa)
      ● Narzędzie Time Warp (Zakrzywienie Czasu)
      ● Okno dialogowe Process Bars (Takty procesu)
      ● Okno dialogowe Process Tempo (Tempo procesu)

POWIĄZANE LINKI
Konfigurowanie projektów pod kątem zmian tempa na stronie 1028

Konfigurowanie projektów pod kątem zmian tempa
Kiedy tworzysz nowy projekt, tempo projektu jest automatycznie ustawiane na tryb stałego tempa. 
Jeśli Twoja muzyka zawiera zmiany tempa, musisz ustawić projekt w trybie śledzenia tempa.

PROCEDURA
● Aby ustawić tryb śledzenia tempa projektu, wykonaj jedną z następujących czynności:
      ● Na panelu Transport aktywuj opcję Activate Tempo Track (Aktywuj ścieżkę tempa).
      ● Wybierz opcję Project > Tempo Track (Projekt > Ścieżka tempa) i aktywuj opcję Activate 
         Tempo Track.

WYNIK
Tempo projektu jest teraz skonfigurowane tak, aby podążało za ścieżką tempa.
Wszystkie ścieżki ustawione na muzyczną (związaną z tempem) podstawę czasu podążają za 
zmianami tempa dodanymi na ścieżce tempa.

POWIĄZANE LINKI
Ścieżka Podstawy czasu na stronie 1023
Sterowanie ścieżką tempa na stronie 158
Edytor ścieżek Tempo na stronie 1024

Konfigurowanie ścieżki tempa poprzez dodanie zmian tempa

PROCEDURA
1. Wybierz Project > Add Track > Tempo (Projekt > Dodaj ścieżkę > Tempo).
    Ścieżka tempa zostanie dodana do listy ścieżek.
2. Na ścieżce tempa otwórz menu podręczne Type of New Tempo Points (Typ nowych punktów 
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    tempa) i wybierz opcję.
3. Wykonaj jedną z następujących czynności:
      ● Na pasku narzędzi wybierz narzędzie Object Selection (Zaznaczanie obiektów) i kliknij 
         krzywą tempa.
      ● Na pasku narzędzi wybierz narzędzie Draw (Rysuj), kliknij i narysuj krzywą tempa.

UWAGA
Jeśli funkcja Snap (Przyciąganie) jest aktywna, określa, w jakich pozycjach czasowych można 
wstawiać punkty krzywej tempa.

WYNIK
Zdarzenie tempa zostanie dodane do krzywej tempa.

Konfigurowanie ścieżki tempa poprzez rejestrowanie zmian tempa
Można ustawić pełną ścieżkę tempa, nagrywając zmiany tempa. Jest to przydatne, jeśli chcesz na 
przykład stworzyć naturalnie brzmiące ritardando.

PROCEDURA
1. Otwórz projekt, dla którego chcesz ustawić tempo ścieżki i rozpocznij odtwarzanie.
2. Wybierz opcję Project > Tempo Track (Projekt > Ścieżka tempa).
3. Na pasku narzędzi Tempo Track Editor (Edytora ścieżki tempa) użyj panelu Tempo Recording
    (Nagrywanie tempa), aby na bieżąco dodawać zmiany tempa.
    Przesuwając suwak w prawo, możesz zwiększyć tempo projektu, przesuwając go w lewo, możesz
    je obniżyć.

WYNIK
Zmiany tempa są rejestrowane i dodawane do krzywej tempa w Tempo Track Editor (Edytorze 
ścieżki tempa).

POWIĄZANE LINKI
Pasek narzędzi edytora ścieżek tempa na stronie 1024

Konfigurowanie ścieżki tempa poprzez stukanie (tapping)
Możesz stworzyć pełną ścieżkę tempa w oparciu o wystukanie tempa swobodnie nagranego 
materiału audio lub MIDI.

WARUNEK WSTĘPNY
Otworzyłeś projekt ze swobodnie nagranym plikiem audio lub MIDI. Dodałeś ścieżkę instrumentu i
załadowałeś instrument. Podłączyłeś i skonfigurowałeś klawiaturę MIDI.

PROCEDURA
1. W Inspektorze ścieżki instrumentu wyłącz opcję Toggle Time Base (Przełącz podstawę czasu), 
    aby ustawić podstawę czasu ścieżki na liniową.
2. Na ścieżce instrumentu aktywuj opcję Record Enable (Włącz nagrywanie).
3. Na panelu Transport aktywuj Record (Nagrywaj).
4. Na klawiaturze MIDI wyznaczaj tempo, naciskając klawisz w rytm muzyki.
5. Zatrzymaj nagrywanie i odtwórz nagrane nuty MIDI razem z oryginalnym nagraniem, aby 
    sprawdzić, czy synchronizacja jest prawidłowa.
6. Wykonaj jedną z następujących czynności:
      ● Wybierz partię MIDI w oknie Project.
      ● Otwórz partię MIDI w Key Editor i wybierz nuty, których chcesz użyć do obliczeń.
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7. Wybierz opcję MIDI > Functions > Merge Tempo From Tapping (MIDI > Funkcje > Połącz 
    tempo ze stukania).
8. Otwórz wyskakujące menu Tapping (Stuknięcie), aby określić rodzaj nuty, którą stuknąłeś 
    podczas nagrania.
9. Opcjonalnie: Aby rozpocząć obliczanie krzywej tempa na początku taktu, aktywuj opcję   
      Begin at Bar Start (Rozpocznij na początku taktu).
10. Kliknij OK.

WYNIK
Tempo projektu jest ustawione na nabijane (tapped) tempo.

PO ZAKOŃCZENIU TEGO ZADANIA
Otwórz Tempo Track Editor (Edytor ścieżki tempa), aby zobaczyć i edytować nową krzywą 
tempa.

POWIĄZANE LINKI
Konfigurowanie wszystkich wejść MIDI na stronie 23

Konfigurowanie ścieżki tempa na podstawie wykrywania tempa
Można ustawić pełną ścieżkę tempa, korzystając z wyniku wykrycia tempa zdarzenia audio lub 
partii MIDI.

PROCEDURA
1. W oknie Project wybierz zdarzenie audio lub część MIDI, którą chcesz analizować.
2. Wybierz opcję Project > Tempo Detection (Projekt > Wykrywanie tempa).
3. W Tempo Detection Panel (Panelu wykrywania tempa) kliknij opcję Analyze (Analizuj).

WYNIK
      ● Do projektu dodano ścieżkę tempa. Na ścieżce tempa zdarzenia tempa tworzone są na 
         podstawie analizy wybranego zdarzenia audio lub partii MIDI.
      ● Do projektu dodano ścieżkę z metrum. Na ścieżce metrum dodawane jest zdarzenie metrum 
         o wartości 1/4.
      ● Na pasku narzędzi okna Project wybrane jest narzędzie Time Warp (Zagięcie czasu).

PO ZAKOŃCZENIU TEGO ZADANIA
W zależności od jakości rytmicznej materiału analiza może od razu doprowadzić do doskonałego 
wyniku. Możesz sprawdzić jakość analizy, aktywując kliknięcie metronomu w panelu Transport 
i odtwarzając projekt. Aby ręcznie skorygować wynik, użyj funkcji na Tempo Detection Panel 
(Panelu wykrywania tempa).

POWIĄZANE LINKI
Panel wykrywania tempa na stronie 1035
Ręczne korygowanie analizy tempa na stronie 1031

Ręczne korygowanie analizy tempa
Jeśli na przykład Twoja muzyka zawiera sekcje odtwarzane w innym tempie lub o specjalnych 
cechach rytmicznych, musisz ręcznie dostosować zdarzenia tempa.

WARUNEK WSTĘPNY
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Przeanalizowałeś swój materiał, a Tempo Detection Panel (Panel wykrywania Tempa) jest nadal 
otwarty. Kliknięcie metronomu jest włączone.

PROCEDURA
1. Odtwórz utwór z analizowanym materiałem od początku i posłuchaj kliknięcia.
2. Opcjonalnie: Jeśli pracujesz ze zdarzeniem audio, powiększ przebieg, aby móc porównać stany 
przejściowe ze zdarzeniami tempa na ścieżce tempa.
3. Opcjonalnie: Jeśli pierwsze zdarzenie tempa, które nie zostało prawidłowo umieszczone,  
    znajduje się na początku materiału, kliknij przycisk strzałki w lewo na Tempo Detection Panel   
    (Panelu wykrywania tempa), aby zmienić kierunek ponownej analizy.
4. Wybierz narzędzie Time Warp i przesuń pierwsze zdarzenie tempa, które nie jest prawidłowo 
    umieszczone, we właściwe miejsce.

WYNIK
Materiał jest ponownie analizowany i przeliczane jest tempo.

PO ZAKOŃCZENIU TEGO ZADANIA
Kontynuuj słuchanie materiału i korygowanie zdarzeń tempowych do końca. Zamknij Tempo 
Detection Panel  (Panel wykrywania tempa).

UWAGA
Jeśli Twój materiał zawiera wiele sekcji o różnych tempach, możesz także podzielić materiał przy 
każdej większej zmianie tempa i przeprowadzić wykrywanie tempa dla każdej wynikowej sekcji. 
Każda sekcja musi mieć długość co najmniej 7 sekund.

Edytowanie zdarzeń tempa
W Tempo Track Editor (Edytorze ścieżki tempa) możesz edytować wybrane zdarzenia tempa.

Użyj następujących metod:
      ● Za pomocą narzędzia Object Selection (Zaznaczanie obiektów) kliknij i przeciągnij w   
         poziomie i/lub w pionie.
      ● W wierszu informacyjnym dostosuj wartość tempa w polu Value (Wartość).

UWAGA
Podczas edycji zdarzeń tempa na krzywych tempa upewnij się, że format wyświetlania na linijce 
okna projektu jest ustawiony na Bars+Beats (Takty+Uderzenia). W przeciwnym razie możesz 
uzyskać mylące wyniki

Użyj następujących metod, aby usunąć zdarzenia tempa:
      ● Za pomocą narzędzia Erase (Wymaż) kliknij zdarzenie tempa.
      ● Wybierz zdarzenie tempa i naciśnij Backspace.

UWAGA
Nie można usunąć pierwszego zdarzenia tempa.

Użyj poniższej metody, aby zmienić typ krzywej tempa:
● W wierszu informacyjnym dostosuj typ krzywej tempa w polu Type (Typ).

Regulacja tempa zakresu
Można dostosować tempo zakresu, aby dopasować je do określonej długości lub czasu zakończenia.
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PROCEDURA
1. Ustaw lewy i prawy lokalizator, aby określić początek i koniec zakresu, który chcesz dostosować.
2. Wybierz opcję Project > Tempo Track (Projekt > Ścieżka tempa).
3. Kliknij Open Process Tempo Dialog (Otwórz okno dialogowe tempa procesu).
4. Otwórz wyskakujące menu Time Display Format (Format wyświetlania czasu) i wybierz format
    wyświetlania czasu dla nowego zakresu.
5. W sekcji New Range (Nowy zakres) wprowadź nowy czas zakończenia lub nową długość 
    zakresu.
6. Kliknij opcję Process (Przetwarzaj).

WYNIK
Zakres zostanie dostosowany w celu dopasowania do nowego czasu zakończenia lub nowej 
długości. Ścieżka tempa zostanie dostosowana tak, aby pokazywać nowe tempo zakresu.

Ustawianie stałego tempa projektu
Jeśli Twoja muzyka nie zawiera zmian tempa, a ścieżka tempa jest wyłączona, możesz ustawić stałe
tempo dla swojego projektu.

Gdy ścieżka tempa jest wyłączona, krzywa ścieżki tempa jest wyszarzona. Stałe tempo jest 
wyświetlane jako pozioma linia na wyświetlaczu krzywej tempa.

Jeśli znasz tempo swojej muzyki, możesz dostosować wartość tempa w następujących obszarach:

● Pole Tempo na panelu Transport
● Pole Current Tempo (Bieżące tempo) na pasku narzędzi Tempo Track Editor (Edytora ścieżki 
    tempa)
● Pole Current Tempo (Bieżącego tempa) na ścieżce tempa.

Jeśli nie znasz tempa swojej muzyki, użyj jednego z poniższych narzędzi, aby je obliczyć i ustawić:

● Beat Calculator (Kalkulator uderzeń)
● Merge Tempo From Tapping (Połącz tempo ze stukania)
● Set Project Tempo from Loop (Ustaw tempo projektu z pętli)

POWIĄZANE LINKI
Ustawianie tempa projektu na podstawie nagrania na stronie 1033
Ustawianie tempa projektu poprzez stuknięcie (tapping) na stronie 1033
Ustawianie tempa projektu z pętli audio na stronie 1034

Ustawianie tempa projektu z nagrania
Za pomocą Beat Calculator (Kalkulatora beatów (uderzeń)) możesz obliczyć tempo dowolnie 
nagranego materiału audio lub MIDI i ustawić je jako tempo projektu.

WARUNEK WSTĘPNY
Tempo Track (Ścieżka tempa) jest wyłączona, co oznacza, że tryb tempa jest ustawiony na Fixed 
(Stały)

PROCEDURA
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1. Na pasku narzędzi okna Project wybierz narzędzie Range Selection (Zaznaczanie zakresu).
2. Na ekranie zdarzeń dokonaj wyboru obejmującego dokładną liczbę uderzeń nagrania.
3. Wybierz Project > Beat Calculator (Projekt > Kalkulator Beatu (uderzenia)).
4. W polu  wartości Beats (uderzeń) wprowadź liczbę uderzeń, które obejmuje zaznaczenie.
    Obliczone tempo jest wyświetlane w polu BPM.
5. W sekcji Insert Tempo into Tempo Track (Wstaw tempo do ścieżki tempa) kliknij opcję At   
    Tempo Track Start (Na początku ścieżki tempa).

WYNIK
Tempo projektu jest ustawione na tempo obliczone na podstawie nagrania.

POWIĄZANE LINKI
Kalkulator Beatów (uderzeń) na stronie 1034

Ustawianie tempa projektu poprzez stukanie (tapping)
Stukając, możesz ustawić tempo dowolnie nagranego materiału audio lub MIDI.

WARUNEK WSTĘPNY
Ścieżka tempa jest wyłączona, co oznacza, że tryb tempa jest ustawiony na Fixed (Stałe).

PROCEDURA
1. Włącz odtwarzanie.
2. Wybierz Project > Beat Calculator (Projekt > Kalkulator Beatu (uderzeń)).
3. Kliknij opcję Tap Tempo (Wybierz tempo).
    Otworzy się okno Tap Tempo.

             

4. Użyj spacji, aby wystukać tempo odtwarzanego nagrania.
    Obliczone tempo w polu BPM jest aktualizowane po każdym stuknięciu.
5. Kliknij OK, aby zamknąć okno.
    Wystukane tempo jest wyświetlane w polu BPM Beat Calculator (kalkulatora rytmu).
6. Kliknij jeden z przycisków w sekcji Insert Tempo into Tempo Track (Wstaw tempo do ścieżki 
    tempa), aby wstawić obliczone tempo do ścieżki tempa.

WYNIK
Tempo projektu jest ustawione na nabijane tempo.

POWIĄZANE LINKI
Konfigurowanie stałego tempa projektu na stronie 1032

Ustawianie tempa projektu z pętli audio
Tempo projektu można ustawić na podstawie tempa pętli audio.

WARUNEK WSTĘPNY
Twój projekt zawiera pętlę audio, która nie jest w Musical Mode (trybie muzycznym).
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PROCEDURA
1. Na linijce okna Project ustaw lewy znacznik na początek pętli audio.
2. Ustaw prawy lokalizator na koniec ostatniego taktu.
    Nie musi to odpowiadać końcowi pętli audio, ale liczbie taktów.
3. Wybierz pętlę audio.
4. Wybierz opcję Audio > Advanced > Set Tempo from Event (Audio > Zaawansowane > Ustaw 
    tempo ze zdarzenia).
    Zostaniesz zapytany, czy chcesz ustawić globalne tempo projektu.
5. Wykonaj jedną z następujących czynności:
       ● Kliknij Yes (Tak), aby globalnie dostosować tempo projektu.
       ● Kliknij No (Nie), aby dostosować tempo projektu tylko w sekcji zdarzenia audio.

WYNIK
Tempo projektu jest ustawione na tempo obliczone dla pętli audio.

Beat Calculator (Kalkulator beatów, rytmu, stuknięć, uderzeń)
Beat Calculator to narzędzie służące do obliczania tempa dowolnie nagranego materiału audio lub 
MIDI. Umożliwia także ustawienie tempa poprzez stukanie.

● Aby otworzyć Beat Calculator (Kalkulator Beatu) dla nagrania audio lub MIDI, wybierz Project
   > Beat Calculator (Projekt > Kalkulator Beatu).

           

Beats (Beaty)
    Umożliwia wprowadzenie liczby uderzeń dla wybranej sekcji nagrania.
BPM
    Pokazuje tempo obliczone dla wybranego fragmentu.
Tap Tempo (Pozyskaj Tempo)
    Otwiera okno, w którym możesz określić tempo, stukając.
At Tempo Track Start (Na początku ścieżki Tempo)
    Jeśli projekt działa w trybie śledzenia tempa, obliczone tempo jest ustawiane jako pierwszy punkt
    krzywej tempa. Jeśli projekt działa w trybie stałego tempa, obliczone tempo jest ustawiane dla 
    całego projektu.

At Selection Start (Na początku selekcji)
    Jeśli projekt znajduje się w trybie śledzenia tempa, obliczone tempo jest ustawiane jako nowe 
    zdarzenie tempa na początku zaznaczenia.
Refresh (Odśwież)
    Umożliwia ponowne obliczenie tempa. Jest to przydatne, jeśli na przykład dostosowujesz wybór.

Tempo Detection (Wykrywanie tempa)
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Możesz wykryć tempo dowolnej rytmicznej treści muzycznej, nawet jeśli nie została ona nagrana z 
kliknięciem metronomu lub jeśli zawiera zmianę tempa.

Wykrywanie tempa materiału muzycznego jest przydatne w następujących przypadkach:
   ● Jeśli chcesz, aby Twoje ścieżki audio lub MIDI podążały za tempem swobodnie nagranego  
      materiału.
   ● Jeśli chcesz dowolnie dostosować nagrany materiał do tempa projektu.

Aby przeprowadzić wykrywanie tempa, muszą zostać spełnione następujące wymagania:
   ● Zdarzenie audio lub część MIDI musi trwać co najmniej 7 sekund.
   ● Materiał musi mieć wyczuwalne uderzenia i rytmy.

Tempo Detection Panel (Panel wykrywania tempa)
Tempo Detection Panel umożliwia analizę tempa zdarzeń audio lub partii MIDI.

● Aby otworzyć Tempo Detection Panel dla zdarzenia audio lub części MIDI, wybierz zdarzenie 
   lub część i wybierz opcję Project > Tempo Detection (Projekt > Wykrywanie tempa).

               

Name (Nazwa)
    Pokazuje nazwę wybranego zdarzenia lub części.
Analyze (Analizuj)
    Rozpoczyna wykrywanie tempa.
Multiply by 2 (Pomnóż przez 2)
    Umożliwia podwojenie wykrytego tempa. Jest to przydatne, jeśli materiał jest dwa razy szybszy 
    niż wykryte tempo.
Divide by 2 (Podziel przez 2)
   Umożliwia zmniejszenie o połowę wykrytego tempa. Jest to przydatne, jeśli Twój materiał jest o 
   połowę szybszy niż wykryte tempo.
Multiply by 4/3 (Pomnóż przez 4/3)
   Umożliwia dostosowanie wykrytego tempa ze współczynnikiem 4/3. Jest to przydatne, jeśli 
   materiał zawiera nuty z kropkami lub trójki, a algorytm wykrywa 3 miary, podczas gdy 
   oczekiwane są 4.

Multiply by 3/4 (Pomnóż przez ¾)
    Umożliwia dostosowanie wykrytego tempa ze współczynnikiem 3/4. W połączeniu z funkcją    
    Multiply by 2 (Pomnóż przez 2) jest to przydatne, jeśli rzeczywista sygnatura wynosi 2/4, 
    a algorytm wykrywa 6/8 uderzeń i odwrotnie.
Offbeat Correction (Nietypowa korekta)
    Umożliwia przesunięcie wykrytych zdarzeń tempa o pół taktu. Jest to przydatne w przypadku 
    materiału, w którym niecodzienny rytm jest tak dominujący, że algorytm bierze go za optymalny.
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Smooth Tempo (Płynne tempo)
    Umożliwia ponowne uruchomienie analizy tempa i usunięcie nieregularnych skoków lub zmian 
    tempa w przypadku materiału o stałym tempie. Jest to przydatne, jeśli wykryto nieregularne 
    zmiany tempa, nawet jeśli wiesz, że tempo materiału jest mniej więcej stałe.
Reset the analysis result (Zresetuj wynik analizy)
    Resetuje dane analizy.
Direction of reanalysis buttons (Kierunek przycisków ponownej analizy)
    Kiedy korygujesz wykrytą krzywą tempa poprzez ponowną jej analizę ręczną, przyciski te 
    umożliwiają zmianę kierunku analizy materiału. Aby ponownie przeanalizować początek 
    krzywej tempa, aktywuj przycisk strzałki w lewo.

Eksportowanie ścieżki tempa
Możesz wyeksportować ścieżkę tempa jako plik XML, aby użyć jej w innych projektach.

PROCEDURA
1. Wybierz opcję File > Export > Tempo Track (Plik > Eksportuj > Ścieżka tempa).
2. W otwartym oknie dialogowym pliku określ nazwę i lokalizację pliku.
3. Kliknij Save (Zapisz).

WYNIK
Informacje o ścieżce tempa są zapisywane wraz ze zdarzeniami metrum z rozszerzeniem pliku .smt.

Importowanie ścieżki tempa
Możesz zaimportować ścieżkę tempa z innego projektu.

PROCEDURA
1. Wybierz opcję File > Import > Tempo Track (Plik > Importuj > Ścieżka tempa).
2. W otwartym oknie dialogowym pliku przejdź do pliku, który chcesz zaimportować.
3. Kliknij Open (Otwórz).

WYNIK
Ścieżka tempa zostanie zaimportowana do projektu wraz z charakterystycznymi zdarzeniami. 
Wszystkie dane ścieżki tempa w projekcie zostaną zastąpione.

Okno dialogowe Process Tempo (Tempo procesu)
Okno dialogowe Process Tempo umożliwia ustawienie zakresu na określoną długość lub 
dostosowanie czasu jego zakończenia poprzez automatyczne dostosowanie ścieżki tempa.

● Aby otworzyć okno dialogowe Process Tempo, aktywuj opcję Activate Tempo Track (Aktywuj
   ścieżkę tempa), wybierz Project > Tempo Track (Projekt > Ścieżka tempa), aby otworzyć 
   Tempo Track Editor (Edytor ścieżki tempa) i kliknij Open Process Tempo Dialog (Otwórz 

1049



   okno dialogowe tempa procesu).

    

W sekcji Bar Range (Zakres taktów) dostępne są następujące opcje:
Start at Bar (Zacznij od taktu)
    Pokazuje czas rozpoczęcia zakresu lokalizatora w taktach i uderzeniach (beatach).
Finish at Bar (Zakończ w takcie)
    Pokazuje czas zakończenia zakresu lokalizatora w taktach i uderzeniach.

W sekcji Alternative Time Format (Alternatywny format czasu) dostępne są następujące opcje:
Time Display Format (Format wyświetlania czasu)
    Umożliwia wybór alternatywnego formatu czasu.
Start at Position (Zacznij od pozycji)
    Pokazuje czas rozpoczęcia zakresu lokalizatora w wybranym formacie czasu.
Finish at Position (Zakończ na pozycji)
    Pokazuje czas końcowy zakresu lokalizatora w wybranym formacie czasu.

W sekcji New Range (Nowy zakres) dostępne są następujące opcje:
New End Position (Nowa pozycja końcowa)
    Pokazuje czas zakończenia nowego zakresu w wybranym formacie czasu.
New Length (Nowa długość)
    Pokazuje długość nowego zakresu w wybranym formacie czasu.
Equivalent Tempo Scaling (Równoważne skalowanie tempa)
    Pokazuje wartość skalowania.

Process (Przetwarzaj)
    Stosuje proces.

Okno dialogowe Process Bars (Przetwarzanie taktów)
Okno dialogowe Process Bars umożliwia wstawianie, usuwanie, zastępowanie lub reinterpretację 
zdarzeń metrum poprzez automatyczne dostosowanie zdarzeń metrum i tempa.
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● Aby otworzyć okno dialogowe Process Bars, wybierz Project > Tempo Track (Projekt > 
   Ścieżka tempa), aby otworzyć Tempo Track Editor (Edytor ścieżki tempa) i kliknij Open 
   Process Bars Dialog (Otwórz okno dialogowe Przetwarzanie taktów).

             

Dostępne są następujące opcje:
Start at Bar (Zacznij od taktu)
    Umożliwia ustawienie pozycji początkowej procesu.
Length in Bars (Długość w taktach)
    Umożliwia ustawienie długości procesu.
Process Type (Typ procesu)
    Umożliwia wybór typu procesu:
    ●   Insert Bars (Wstaw takty)
         Wstawia puste takty z określonym metrum w pozycji taktu rozpoczęcia procesu.
    ●   Delete Bars (Usuń takty)
         Usuwa takt w pozycji położenia taktu początku procesu.
    ●   Reinterpret Bars (Reinterpretuj takty)
         Reinterpretuje takty z określonym metrum w pozycji taktu rozpoczęcia procesu. Jednakże 
         odtwarzanie nut pozostaje takie samo.
    ●   Replace Bars (Wymień takty)
          Zastępuje takty w pozycji położenia taktu początku procesu.

Time Signature (Metrum) 
    Umożliwia określenie metrum używanego w przypadku akcji Insert Bars, Reinterpret Bars 
    i Replace Bars.
Process (Przetwarzaj)
    Stosuje określony typ procesu.

Time Warp (Zniekształcenie czasu)
Narzędzie Time Warp umożliwia dostosowanie pozycji muzycznych zdarzeń lub części do pozycji
czasowych.

● Możesz dostosować pozycje w materiale muzycznym opartym na czasie do pozycji w czasie.

● Można dopasować materiał z muzyczną podstawą czasu do materiału z liniową podstawą czasu.

UWAGA
Narzędzie Time Warp może tworzyć wartości tempa do 360 BPM.

Jeśli na pasku narzędzi włączysz opcję Time Warp, linijka pokaże zdarzenia tempa jako flagi z 
wartościami tempa.
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Jeśli ponownie klikniesz Time Warp (Zniekształcenie czasu), otworzy się wyskakujące menu, w 
którym możesz wybrać jeden z następujących trybów:

●   Warp Grid (Zniekształcona siatka)
      Jeśli w tym trybie użyjesz narzędzia Time Warp, zachowane zostaną bezwzględne pozycje 
      czasu dla wszystkich utworów, dla których ustawiona jest muzyczna podstawa czasu.
●    Warp Grid (musical events follow) (Zniekształcona siatka (następują zdarzenia muzyczne))
      Jeśli w tym trybie użyjesz narzędzia Time Warp, wszystkie ścieżki ustawione na muzyczną 
      podstawę czasu zostaną objęte zmianami.
Kliknięcie narzędziem Time Warp powoduje jego przyciągnięcie do siatki tempa w oknie. Jeśli 
zamiast tego chcesz, aby narzędzie Time Warp przyciągało znacznik lub początek lub koniec 
zdarzenia, aktywuj Snap (Przyciąganie) i ustaw Snap Type to Events (Typ przyciągania do 
Zdarzeń).

Dostosowywanie pozycji muzycznych do pozycji czasowych
Za pomocą narzędzia Time Warp możesz dostosowywać pozycje muzyczne do pozycji w czasie.

WARUNEK WSTĘPNY
Tryb śledzenia tempa jest aktywny. Snap (Przyciąganie) jest aktywowane i wybrałeś odpowiedni 
Snap Type (Typ przyciągania).

PROCEDURA
1. Na pasku narzędzi okna Project kliknij Time Warp (Zniekształcenie czasu).
    Linijka jest automatycznie ustawiana w formacie Bars+Beats (Takty i uderzenia).
2. Na ekranie zdarzeń znajdź pozycję muzyczną, którą chcesz dostosować, i przeciągnij pozycję 
    czasu, aby ją dopasować.
    Może to być początek zdarzenia, określone trafienie w ramach zdarzenia itp.
3. Zwolnij przycisk myszy.

WYNIK
Pozycja muzyczna jest dostosowywana do pozycji czasowej i zmieniana jest wartość tempa 
ostatniego zdarzenia tempa przed pozycją kliknięcia. Jeżeli istnieją późniejsze zdarzenia tempa, w 
miejscu kliknięcia tworzone jest nowe zdarzenie tempa.

POWIĄZANE LINKI
Tryby tempa projektu na stronie 1023
Zniekształcenie czasu na stronie 1038

Okno dialogowe Set Definition from Tempo (Ustaw definicję na 
podstawie Tempa)
Okno dialogowe Set Definition from Tempo umożliwia ustawienie dowolnie nagranego materiału 
audio w określonym tempie.
●   Aby otworzyć okno dialogowe Set Definition from Tempo dla nagrania audio, wybierz opcję   
     Audio > Advanced > Set Definition from Tempo (Audio > Zaawansowane > Ustaw definicję 
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     na podstawie tempa).

                                        
Save Definition in Project Only (Zapisz definicję tylko w projekcie)
    Zapisuje informacje o tempie tylko w pliku projektu.
Write Definition to Audio Files (Zapisz definicję do plików audio)
    Zapisuje informacje o tempie w wybranych plikach audio. Jest to przydatne, jeśli chcesz użyć ich
    w innych projektach razem z informacjami o tempie.
Set all Tracks to Musical Time Base (Ustaw wszystkie utwory na muzyczną podstawę czasu)
    Ustawia wszystkie utwory na muzyczną podstawę czasu. Jeśli ta opcja jest wyłączona, tylko 
    utwory z wybranymi zdarzeniami zostaną ustawione na muzyczną podstawę czasu.

Dostosowywanie tempa dźwięku do tempa projektu
Możesz dostosować tempo dowolnie nagranego materiału audio do tempa projektu.

PROCEDURA
1. Wybierz zdarzenia audio, które chcesz dostosować do tempa projektu.
2. Wybierz opcję Audio > Advanced > Set Definition from Tempo (Audio > Zaawansowane 
    > Ustaw definicję z tempa.)
3. Opcjonalnie: Dostosuj ustawienia.
4. Kliknij OK.

WYNIK
Informacje o tempie są kopiowane do pliku audio, a ścieżki są ustawiane na muzyczną podstawę 
czasu. Osiąga się to poprzez zastosowanie zniekształcania zdarzeń. Musical Mode (Tryb 
muzyczny) jest aktywowany dla zdarzeń audio. Ścieżki audio śledzą teraz wszelkie zmiany tempa 
w projekcie.

Time Signature Events (Zdarzenia metrum)
Dla projektu można ustawić jedno lub więcej metrum.

Możesz ustawić pierwsze zdarzenie metrum swojego projektu w panelu Transport. Możesz dodać 
kolejne zdarzenia metrum w Tempo Track Editor (Edytorze ścieżki tempa).

Do zdarzeń metrum można przypisać wzorce kliknięć. Umożliwiają one tworzenie różnych rytmów
i odczuć kliknięcia metronomu. Można na przykład utworzyć wzór kliknięcia potrójnego dla 
metrum 4/4.

POWIĄZANE LINKI
Pasek narzędzi okna projektu na stronie 46
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Pasek transportu na stronie 60
Ścieżka metrum na stronie 156
Dodawanie zdarzeń metrum w edytorze ścieżki tempa na stronie 1041
Konfigurowanie wzorca kliknięcia dla zdarzenia metrum na stronie 1042

Dodawanie zdarzeń metrum w edytorze ścieżki tempa

PROCEDURA
1. Wybierz opcję Project > Tempo Track (Projekt > Ścieżka tempa), aby otworzyć Tempo Track 
    Editor (Edytor ścieżki tempa).
2. Wybierz opcję Draw (Rysuj) na pasku narzędzi i na ekranie metrum kliknij pozycję czasu, 
    w której chcesz wstawić zdarzenie metrum.
3. Edytuj licznik i mianownik, aby zmienić wartość zdarzenia metrum.

UWAGA
Można także wybrać zdarzenie metrum i edytować wartość metrum w wierszu informacyjnym.

WYNIK
Zdarzenie metrum jest dodawane w określonej pozycji czasowej. Oś czasu i zdarzenia wyświetlane 
w oknie Project oraz w edytorach odzwierciedlają zmiany.

Dodawanie zdarzeń metrum na ścieżce metrum
Do projektu można dodać wiele zdarzeń metrum. Jest to przydatne, jeśli chcesz na przykład zmienić
metrum w określonym takcie.

PROCEDURA
1. Wybierz Project > Add Track > Signature (Projekt > Dodaj ścieżkę > Metrum).
    Ścieżka metrum zostanie dodana do listy ścieżek.
2. Wybierz opcję Draw (Rysuj) na pasku narzędzi okna Project i na ścieżce metrum kliknij pozycję
    czasu, w której chcesz wstawić zdarzenie metrum.
3. Edytuj licznik i mianownik, aby zmienić wartość zdarzenia metrum.

WYNIK
Zdarzenie metrum jest dodawane w określonej pozycji czasowej. Oś czasu i zdarzenia wyświetlane 
w oknie Project oraz w edytorach odzwierciedlają zmiany.

POWIĄZANE LINKI
Ścieżka metrum na stronie 156

Konfigurowanie wzorca kliknięcia dla zdarzenia metrum
Dla każdego zdarzenia metrum w projekcie możesz ustawić wzór kliknięcia metronomu.

PROCEDURA
1. Kliknij dwukrotnie znak plus, aby otworzyć Click Pattern Editor (Edytor wzorców kliknięć).
2. Wykonaj jedną z następujących czynności:
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      ● Otwórz wyskakujące menu Pattern (Wzór) i wybierz jedno z gotowych ustawień.
      ● Użyj ustawienia Clicks (Kliknięcia), aby określić liczbę kliknięć, które chcesz usłyszeć, a 
         następnie kliknij na ekranie zdarzenia, aby skonfigurować nowy wzorzec kliknięć.
3. Kiedy już skończysz, kliknij poza Click Pattern Editor, aby go zamknąć.
4. Powtórz tę czynność dla każdego zdarzenia metrum, dla którego chcesz skonfigurować wzór 
    kliknięcia.

WYNIK
Jeśli odtwarzasz projekt i aktywujesz kliknięcie metronomu, różne części projektu korzystają ze 
zdefiniowanych wzorców kliknięć. Click Pattern Editor (Edytor wzorców kliknięć) na Transport
Bar (pasku transportu) pokazuje wzór w pozycji kursora projektu.

POWIĄZANE LINKI
Edytor wzorców kliknięć na stronie 252

Project Browser (Przeglądarka projektów)
Project Browser udostępnia reprezentację projektu opartą na liście. Umożliwia przeglądanie 
i edycję wszystkich zdarzeń na wszystkich ścieżkach.

● Aby otworzyć Project Browser, wybierz Project > Browser (Projekt > Przeglądarka).
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UWAGA
Project Browser można otworzyć podczas pracy w innych oknach. Wszelkie zmiany w oknie 
Project lub edytorze są natychmiast odzwierciedlane w Project Browser i odwrotnie.

1   Project Structure (Struktura projektu)
     Umożliwia wybranie określonych typów ścieżek do przeglądania i edycji na ekranie zdarzeń.
2   Toolbar (Pasek narzędzi)
     Zawiera narzędzia i ustawienia do edycji.
3   Info Line (Infolinia)
     Pokazuje informacje o wybranym elemencie.
4   Event Display (Wyświetlanie zdarzeń)
     Umożliwia przeglądanie i edycję wybranego elementu.

Project Browser Toolbar (Pasek narzędzi przeglądarki projektów)
Pasek narzędzi zawiera narzędzia i ustawienia umożliwiające edycję w Project Browser 
(Przeglądarce projektu).

+/- All (+/- Wszystko)
    Otwiera/zamyka wszystkie foldery na liście Project Structure (Struktura projektu).
Time Format (Format czasu)
    Umożliwia zmianę formatu wyświetlania czasu w Project Browser (Przeglądarce Projektu).
Track/Part/Event (Ścieżka/część/zdarzenie)
    Pokazuje, co zostanie dodane po kliknięciu Add (Dodaj).
Add (Dodaj)
    Dodaje typ ścieżki, części lub zdarzenia wyświetlany w wyskakującym menu po lewej stronie.

Filter (Filtr)
    Umożliwia filtrowanie wyświetlania zdarzeń według typu zdarzenia.
Sync Selection (Wybór synchronizacji)
    Łączy wybór w Project Browser (Przeglądarce projektu) z wyborem w oknie Project. Dzięki  
    temu możesz zlokalizować zdarzenia w dwóch oknach.

Project Structure (Struktura projektu)
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Project Structure umożliwia wybranie określonych typów ścieżek do przeglądania i edycji na 
ekranie zdarzeń. W zależności od wybranego typu ścieżki w Project Structure mogą być dostępne 
różne elementy.

Track Data (Dane ścieżki)

             
Jeśli wybierzesz opcję Track Data, Project Structure (struktura projektu) pokaże zdarzenia audio 
i/lub części audio, które z kolei mogą zawierać zdarzenia audio, lub części MIDI, które z kolei 
mogą zawierać zdarzenia MIDI.

Track Data (Dane ścieżki) są dostępne dla ścieżek audio i MIDI

Automation (Automatyzacja)
Wybranie Automation w Project Structure pokazuje zdarzenia automatyzacji ścieżki, jeśli są 
dostępne.
Każdy element Automation w Project Structure ma podpozycje dla każdego zautomatyzowanego
parametru.

Event Display (Wyświetlanie zdarzeń)
Wyświetlanie zdarzeń Project Browser (Przeglądarki projektów) umożliwia przeglądanie i edycję 
wybranego elementu.

UWAGA
Nie wszystkie kolumny są dostępne dla wszystkich zdarzeń. Możesz zmienić kolejność kolumn, 
klikając nagłówek i przeciągając w lewo lub w prawo.

Name (Nazwa)
    Kliknij dwukrotnie nazwę, aby ją zmienić. Nie można zmienić nazwy lewego i prawego 
    lokalizatora.
    Zdarzenia audio: kliknij dwukrotnie obraz przebiegu, aby otworzyć zdarzenie w Sample Editor 
    (Edytorze próbek).
    Części audio: kliknij dwukrotnie obraz przebiegu, aby otworzyć wydarzenie w Audio Editor 
    (Edytorze audio).
    Partie MIDI: kliknij dwukrotnie obraz części, aby otworzyć zdarzenie w Key Editor (Edytorze 
    Klawiszy)

File (Plik)
    Zdarzenia audio: nazwa pliku audio, do którego odwołuje się klip audio zdarzenia.
Type (Typ)
    Zdarzenia MIDI: Typ zdarzenia MIDI.
    Ścieżka tempa: rodzaj krzywej tempa.
Start (Początek)
    Pozycja początkowa zdarzenia.

1057



End (Koniec)
    Końcowa pozycja zdarzenia.
Position (Pozycja)
    Pozycja zdarzenia.
Tempo
    Wartość tempa zdarzenia tempa
Signature (Metrum)
    Wartość metrum zdarzenia metrum.
Bar (Takt)
    Takt charakterystycznego zdarzenia.
Pattern (Wzór)
    Wzór kliknięcia zdarzenia metrum.
Snap (Przyciąganie)
    Zdarzenia audio: położenie punktu przyciągania zdarzenia. Dostosuj tę wartość, aby przenieść 
    zdarzenie audio.
Length (Długość)
    Długość zdarzenia.
Offset (Zrównoważ, przesunięcie)
    Pozycja początkowa zdarzenia w klipie.

UWAGA
Jeśli zdarzenie odtwarza już cały klip, to tej wartości nie można dostosować.

Volume (Głośność)
    Głośność zdarzenia.
Fade In/Fade Out (Narastanie/Zanikanie)
    Długość odpowiednio obszarów narastania i zanikania.

UWAGA
Jeśli dodasz zanikanie, tworzone jest zanikanie liniowe. Jeśli dostosujesz długość istniejącego 
przejścia, poprzedni kształt przejścia zostanie zachowany.

Mute (Wycisz)
    Wycisza lub wyłącza wyciszenie zdarzenia.
Image (Obraz)
    Zdarzenia audio: wyświetla przebieg zdarzenia.

Edytowanie danych ekspresji nutowych
W Project Browser (Przeglądarce projektu) możesz przeglądać i edytować zdarzenia kontrolera 
MIDI lub zdarzenia VST 3 nuty MIDI z danymi ekspresji nutowych.

PROCEDURA
1. W Project Structure (Strukturze projektu) wybierz podelement Note Expression nuty MIDI, 
    którą chcesz wyświetlić lub edytować.
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    Na ekranie zdarzeń wyświetlane są wszystkie kontrolery MIDI lub zdarzenia VST 3 zawarte 
    w danych ekspresji nutowych.
2. Na ekranie zdarzeń edytuj wartości parametrów.

WYNIK
Zdarzenie odpowiednio się zmienia.

PRZYKŁAD
Jeżeli wpisałeś inną wartość Start (startową), zdarzenie zostanie przeniesione.

POWIĄZANE LINKI
Ekspresja nutowa na stronie 918

Usuwanie zdarzeń

PROCEDURA
1. Wybierz zdarzenie lub część na ekranie zdarzeń.
2. Wykonaj jedną z następujących czynności:
      ● Wybierz opcję Edit > Delete (Edycja > Usuń).
      ● Naciśnij klawisz Delete lub Backspace.

WYNIK
Wybrane zdarzenie zostanie usunięte.

WAŻNE
Nie można usunąć pierwszego zdarzenia tempa ani pierwszego zdarzenia metrum projektu.

Renderowanie Audio i MIDI
Istniejący materiał można renderować na nowy materiał audio.

Możesz renderować następujące elementy:
● Ścieżki audio
● Ścieżki instrumentów
● Wydarzenia lub części audio na ścieżkach audio
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● Partie MIDI na ścieżkach instrumentów
● Wybór zakresu na ścieżkach audio lub instrument
● Wybór zakresu na wielu ścieżkach audio lub instrument

WAŻNE
Funkcja renderowania nie obsługuje routingu bocznego.

Okno dialogowe Render Tracks (Renderuj ścieżki)
Okno dialogowe Render Tracks umożliwia dostosowanie ustawień renderowania ścieżki.

● Aby otworzyć okno dialogowe Render Tracks, usuń zaznaczenie wszystkich zdarzeń w oknie 
projektu i wybierz jedną lub więcej ścieżek audio, ścieżek instrumentów lub ścieżek MIDI 
i wybierz Edit > Render in Place > Render Settings (Edycja > Renderuj na miejscu > Ustawienia 
renderowania).

               

W sekcji Mode (Tryb) dostępne są następujące ustawienia:
As Separate Events (Jako osobne zdarzenia)
    Tworzy jedną lub więcej ścieżek zawierających oddzielne zdarzenia lub części zapisane jako 
    osobne pliki audio.
As Block Events (Jako zdarzenia blokowe)
    Tworzy jedną lub więcej ścieżek zawierających sąsiadujące zdarzenia/części połączone w bloki. 
    Każdy blok jest zapisywany jako oddzielny plik audio.
As One Event (Jako jedno zdarzenie)
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    Tworzy jedną lub więcej ścieżek zawierających zdarzenia/części i łączy je w jedno    
    zdarzenie/części. Każda kombinacja jest zapisywana jako oddzielny plik audio.

W sekcji Processing (Przetwarzanie) dostępne są następujące ustawienia:
Dry (Suche)
    Kopiuje wszystkie efekty i ustawienia panoramy do nowych ścieżek audio. Powstałe ścieżki 
    audio zachowują formaty ścieżek źródłowych. Na przykład ścieżka monofoniczna skutkuje 
    powstaniem ścieżki monofonicznej.
Channel Settings (Ustawienia kanału)
    Renderuje wszystkie efekty w wynikowych plikach audio. Obejmuje to efekty wstawiania, 
    ustawienia pasków kanałów, ustawienia kanałów grupowych i ustawienia kanałów wysyłki FX. 
    Ustawienia Pannera zostały przeniesione do nowych ścieżek audio. Powstałe ścieżki audio 
    zachowują formaty ścieżek źródłowych. Na przykład ścieżka monofoniczna skutkuje powstaniem
    ścieżki monofonicznej.
Complete Signal Path (Kompletna ścieżka sygnału)
    Renderuje pełną ścieżkę sygnału do nowych plików audio, w tym wszystkie ustawienia kanałów, 
    ustawienia kanałów grupowych, ustawienia kanałów wysyłania efektów i ustawienia panoramy.   
    Nowa ścieżka dźwiękowa jest tworzona bez efektów. Włączono ustawienia panoramy balansu 
    stereo. Wynikowy format pliku audio jest określony przez kanał wyjściowy ścieżki źródłowej. 
    Ścieżka monofoniczna kierowana do szyny stereo daje w rezultacie plik audio stereo.
Complete Signal Path + Master FX (Kompletna ścieżka sygnału + efekt główny)
    Renderuje pełną ścieżkę sygnału i ustawienia magistrali głównej w wynikowych plikach audio. 
    Obejmuje to wszystkie ustawienia kanałów, ustawienia kanałów grupowych, ustawienia kanałów 
    wysyłania efektów i ustawienia panoramy. Wynikowy format pliku audio jest określony przez 
    kanał wyjściowy ścieżki źródłowej. Ścieżka monofoniczna kierowana do szyny stereo daje w 
    rezultacie plik audio stereo.

W sekcji  Properties (Właściwości) dostępne są następujące ustawienia:
Tail Mode (Tryb ogona, tyłu)
    Umożliwia ustawienie trybu ogona na Bars & Beats (Takty i uderzenia), Seconds lub Off.
Tail Size (Rozmiar ogona, tyłu)
    Umożliwia ustawienie długości tyłu renderowanych plików. Zwiększa to czas na końcu 
    renderowanego pliku, umożliwiając całkowite wyciszenie tyłów pogłosu i opóźnienia.
Bit Depth (Głębia bitowa)
    Umożliwia ustawienie głębi bitowej pliku wynikowego.

W sekcji File Name Settings (Ustawienia nazwy pliku) dostępne są następujące ustawienia:
Use Custom Name (Użyj nazwy niestandardowej)
    Aktywuje użycie niestandardowych nazw renderowanych plików.
Name (Nazwa)
    Umożliwia wprowadzenie niestandardowej nazwy renderowanych plików.

W sekcji File Location (Lokalizacja pliku) dostępne są następujące ustawienia:
File Path (Ścieżka pliku)
    Umożliwia wybranie niestandardowego folderu, do którego renderowane będą wynikowe pliki 
    .wav.
Mix down to One Audio File (Zmiksuj do jednego pliku audio)
    Tworzy jeden plik audio ze wszystkich materiałów źródłowych. Ta opcja jest dostępna tylko 
    wtedy, gdy wybranych jest kilka ścieżek i wyłączona jest opcja Dry (Transfer Channel 
    Settings) (Suche (Ustawienia kanału transferu)).

W sekcji e Source Track Settings (Ustawienia ścieżki źródłowej) dostępne są następujące 
ustawienia:
Source Tracks (Ścieżki źródłowe)
   ●   Keep Source Tracks Unchanged (Zachowaj ścieżki źródłowe w niezmienionym stanie)
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        Zachowuje ścieżki źródłowe bez zmian.
   ●   Mute Source Tracks (Wycisz ścieżki źródłowe)
        Automatycznie wycisza ścieżki źródłowe.
   ●   Disable Source Tracks (Wyłącz ścieżki źródłowe)
        Wyłącza ścieżki źródłowe. Ta opcja zwalnia zasoby procesora i pamięci RAM i dlatego jest 
        podobna do funkcji Freeze (Zamrożenie). Aby ponownie włączyć ścieżki, kliknij prawym 
        przyciskiem myszy wyłączoną ścieżkę, aby otworzyć menu kontekstowe i wybierz opcję 
        Enable Track (Włącz ścieżkę).
   ●   Remove Source Tracks (Usuń ścieżki źródłowe)
        Usuwa ścieżki źródłowe z listy ścieżek.
Hide Source Tracks (Ukryj ścieżki źródłowe)
    Ukrywa ścieżki źródłowe po renderowaniu. Aby ponownie wyświetlić ścieżki źródłowe, wybierz
    zakładkę Visibility (Widoczność) w oknie Project i wybierz ścieżkę, którą chcesz wyświetlić.

POWIĄZANE LINKI
Sterowanie panoramą na stronie 376

Renderowanie ścieżek
Możesz renderować wybrane ścieżki za pomocą okna dialogowego Render Tracks (Renderuj 
ścieżki) lub bezpośrednio używając polecenia Render (with Current Settings) (Renderuj (z 
bieżącymi ustawieniami)).

PROCEDURA
1. Odznacz wszystkie zdarzenia.
2. Wybierz jedną lub więcej ścieżek audio, MIDI lub instrumentów.
3. Wybierz Edit > Render in Place > Render Settings (Edycja > Renderuj na miejscu >    
    Ustawienia renderowania).
4. Określ opcje renderowania.
5. Kliknij Render (Renderuj).

WYNIK
Cały wybrany materiał źródłowy jest przetwarzany zgodnie z ustawieniami renderowania. Opcje 
renderowania zostaną zapisane i użyte we wszystkich dalszych operacjach renderowania.

UWAGA
Możesz także rozpocząć operację renderowania bezpośrednio, wybierając Edit > Render in Place 
> Render (with Current Settings) (Edycja > Renderuj na miejscu > Renderuj (z bieżącymi 
ustawieniami)).

Okno dialogowe Render Selection (Renderuj zaznaczenie)
Możesz renderować wybrane zdarzenia audio i/lub części MIDI przy użyciu ustawień domyślnych 
lub niestandardowych. Okno dialogowe Render Selection umożliwia dostosowanie ustawień 
renderowania zaznaczenia.

● Aby otworzyć okno dialogowe Render Selection, wybierz zakres i wybierz Edit > Render in 
   Place > Render Settings (Edycja > Renderuj na miejscu > Ustawienia renderowania.
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W sekcji Mode (Tryb) dostępne są następujące ustawienia:
As Separate Events (Jako osobne zdarzenia)
    Tworzy jedną lub więcej ścieżek zawierających oddzielne zdarzenia lub części zapisane jako 
    osobne pliki audio.
As Block Events (Jako zdarzenia blokowe)
    Tworzy jedną lub więcej ścieżek zawierających sąsiadujące zdarzenia/części połączone w bloki.  
    Każdy blok jest zapisywany jako oddzielny plik audio.
As One Event (Jako jedno zdarzenie)
    Tworzy jedną lub więcej ścieżek zawierających zdarzenia/części i łączy je w jedno  
    zdarzenie/części. Każda kombinacja jest zapisywana jako oddzielny plik audio.

W sekcji Processing (Przetwarzanie) dostępne są następujące ustawienia:
Dry (Suche)
    Kopiuje wszystkie efekty i ustawienia panoramy do nowych ścieżek audio. Powstałe ścieżki 
    audio zachowują formaty ścieżek źródłowych. Na przykład ścieżka monofoniczna skutkuje 
    powstaniem ścieżki monofonicznej.
Channel Settings (Ustawienia kanału)
    Renderuje wszystkie efekty w wynikowych plikach audio. Obejmuje to efekty wstawiania, 
    ustawienia pasków kanałów, ustawienia kanałów grupowych i ustawienia kanałów wysyłki FX.   
    Ustawienia Pannera zostały przeniesione do nowych ścieżek audio. Powstałe ścieżki audio 
    zachowują formaty ścieżek źródłowych. Na przykład ścieżka monofoniczna skutkuje powstaniem
    ścieżki monofonicznej.
Complete Signal Path (Kompletna ścieżka sygnału)
    Renderuje pełną ścieżkę sygnału do nowych plików audio, w tym wszystkie ustawienia kanałów, 
    ustawienia kanałów grupowych, ustawienia kanałów wysyłania efektów i ustawienia panoramy.   
    Nowa ścieżka dźwiękowa jest tworzona bez efektów. Włączono ustawienia panoramy balansu 
    stereo. Wynikowy format pliku audio jest określony przez kanał wyjściowy ścieżki źródłowej. 
    Ścieżka monofoniczna kierowana do szyny stereo daje w rezultacie plik audio stereo
Complete Signal Path + Master FX (Kompletna ścieżka sygnału + efekt główny)
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    Renderuje pełną ścieżkę sygnału i ustawienia magistrali głównej w wynikowych plikach audio. 
    Obejmuje to wszystkie ustawienia kanałów, ustawienia kanałów grupowych, ustawienia kanałów 
    wysyłania efektów i ustawienia panoramy. Wynikowy format pliku audio jest określony przez 
    kanał wyjściowy ścieżki źródłowej. Ścieżka monofoniczna kierowana do szyny stereo daje 
    w rezultacie plik audio stereo.

W sekcji Properties (Właściwości) dostępne są następujące ustawienia:
Tail Mode (Tryb ogona, tyłu)
    Umożliwia ustawienie trybu ogona na Bars & Beats (Takty i uderzenia), Seconds lub Off.
Tail Size (Rozmiar ogona)
    Umożliwia ustawienie długości ogona renderowanych plików. Zwiększa to czas na końcu 
    renderowanego pliku, umożliwiając całkowite wyciszenie ogonów pogłosu i opóźnienia.
Bit Depth (Głębia bitowa)
    Umożliwia ustawienie głębi bitowej pliku wynikowego.

W sekcji File Name Settings (Ustawienia nazwy pliku) dostępne są następujące ustawienia:
Use Custom Name (Użyj nazwy niestandardowej)
    Aktywuje użycie niestandardowych nazw renderowanych plików.
Name (Nazwa)
    Umożliwia wprowadzenie niestandardowej nazwy renderowanych plików.

W sekcji File Location (Lokalizacja pliku) dostępne są następujące ustawienia:
File Path (Ścieżka pliku)
    Umożliwia wybranie niestandardowego folderu, do którego renderowane będą wynikowe pliki 
    .wav.
Mix down to One Audio File (Zmiksuj do jednego pliku audio)
    Tworzy jeden plik audio ze wszystkich materiałów źródłowych. Ta opcja jest dostępna tylko 
    wtedy, gdy wybranych jest kilka utworów i wyłączona jest opcja Dry (Transfer Channel 
    Settings) (Suche (Ustawienia kanału transferu)).

W sekcji Source Event Settings (Ustawienia zdarzenia źródłowego) dostępne są następujące 
ustawienia:
Source Events (Zdarzenia źródłowe)
      ●   Keep Source Events Unchanged (Zachowaj zdarzenia źródłowe bez zmian)
           Zachowuje zdarzenia źródłowe bez zmian.
      ●   Mute Source Events (Wycisz zdarzenia źródłowe)
            Automatycznie wycisza zdarzenia źródłowe.

Rendering Selections (Renderowanie zaznaczenia)
Możesz renderować zaznaczenia lub zaznaczenia zakresu zdarzeń audio i/lub części MIDI za 
pomocą okna dialogowego Rendering Selections (Renderuj zaznaczenie).

PROCEDURA
1. Wybierz jedno lub więcej zdarzeń audio i/lub partii MIDI albo dokonaj wyboru zakresu.
2. Wybierz Edit > Render in Place > Render Settings (Edycja > Renderuj na miejscu > 
    Ustawienia renderowania).
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3. W oknie dialogowym Render Selection (Wybór renderowania) określ opcje renderowania.
4. Kliknij Render (Renderuj).

WYNIK
Cały wybrany materiał źródłowy jest przetwarzany zgodnie z ustawieniami renderowania. Opcje 
renderowania zostaną zapisane i użyte we wszystkich dalszych operacjach renderowania.

UWAGA
Możesz także rozpocząć operację renderowania bezpośrednio, wybierając Edit > Render in Place 
> Render (with Current Settings) (Edycja > Renderuj na miejscu > Renderuj (z bieżącymi 
ustawieniami)).

Export Audio Mixdown (Eksportuj miks audio)
Funkcja Export Audio Mixdown umożliwia miksowanie i eksportowanie całego dźwięku 
zawartego pomiędzy lewym i prawym lokalizatorem projektu lub w zakresach określonych przez 
znaczniki cykli.
● Aby otworzyć okno dialogowe Export Audio Mixdown, wybierz File > Export > Audio 
   Mixdown (Plik > Eksportuj > Miks audio).
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Okno dialogowe Export Audio Mixdown (Eksport miksu Audio)
Okno dialogowe Export Audio Mixdown umożliwia skonfigurowanie sposobu miksowania i 
eksportowania dźwięku.

● Aby otworzyć okno dialogowe Export Audio Mixdown, wybierz File > Export > Audio 
   Mixdown (Plik > Eksportuj > Miks audio).

Okno dialogowe Export Audio Mixdown jest podzielone na kilka sekcji. 
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Channel Selection (Wybór kanału)

W sekcji Channel Selection dostępne są następujące opcje:
Single (Pojedynczy)
    Umożliwia eksport pojedynczego kanału.
Multiple (Wiele)
    Umożliwia eksport wielu kanałów.
Expand All (Rozwiń wszystkie)
    Rozwija wszystkie kategorie kanałów na liście.
Collapse All (Zwinąć wszystkie)
    Zwija wszystkie kategorie kanałów na liście.
Sync Selection to Channel/Track Selection (Zsynchronizuj wybór z wyborem kanału/ścieżki)
    Filtruje listę kanałów według kanałów wybranych w MixConsole lub ścieżek wybranych na 
    liście ścieżek w oknie Project. Ta opcja jest dostępna tylko w przypadku eksportowania wielu 
    kanałów.

UWAGA
Aby wyświetlić kanały dla ścieżek MIDI podłączonych do instrumentu VST, musisz wybrać 
odpowiedni kanał VSTi na liście ścieżek w oknie Project.
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Search Channel (Wyszukaj kanał)
    Umożliwia wprowadzenie tekstu w celu wyszukania określonego kanału według nazwy. Jest to 
    przydatne, jeśli projekt zawiera dużą liczbę kanałów.
Channel List (Lista kanałów)
    Wyświetla listę wszystkich kanałów dostępnych w Twoim projekcie. Lista kanałów pokazuje typ
    kanału, kolor kanału i szerokość kanału. Aktywuj kanał na liście, aby go wyeksportować.
    Uwzględniane są ustawienia MixConsole i efekty wstawiania. Dla każdego aktywowanego 
    kanału tworzony jest indywidualny plik.

Export Range (Zakres eksportu)

W sekcji Export Range dostępne są następujące opcje:
Locators (Lokalizatory)
    Umożliwia eksport zakresu lokalizatora.
Cycle Markers (Znaczniki Cyklu)
    Umożliwia eksport jednego lub większej liczby zakresów znaczników cykli. Uwzględniane są 
    ustawienia MixConsole, możliwość nagrywania i efekty wstawiania. Wyświetla listę wszystkich 
    znaczników cykli dostępnych w projekcie. Aktywuj znacznik cyklu na liście, aby wyeksportować
    zakres, który obejmuje. Dla każdego aktywowanego zakresu znaczników cykli tworzony jest 
    indywidualny plik.

UWAGA
Można wybrać tylko znaczniki cykli aktywnej ścieżki znacznika.

Export Queue (Kolejka eksportu)

W sekcji Export Queue dostępne są następujące opcje:
Add to Queue (Dodaj do kolejki)
    Dodaje zadanie do listy kolejki zadań. Uwzględniane są wszystkie bieżące ustawienia okna 
    dialogowego Export Audio Mixdown (Eksportuj miks audio)
Remove All from Queue (Usuń wszystko z kolejki)
    Usuwa wszystkie zadania z listy kolejki zadań.
Expand All (Rozwiń wszystkie)
    Rozwija wszystkie kategorie stanowisk na liście.
Collapse All (Zwiń wszystkie)
    Zwija wszystkie kategorie stanowisk na liście.
Job list (Lista pracy)
    Wyświetla listę wszystkich zadań dodanych do sekcji Export Queue.

File Location (Lokalizacja pliku)

W sekcji File Location dostępne są następujące opcje:
Name (Nazwa)
    Umożliwia określenie nazwy pliku miksu.
    Kliknij File Name Options (Opcje nazwy pliku), aby otworzyć menu podręczne z opcjami 
    nazewnictwa:
    ● Set to Project Name (Ustaw na nazwę projektu) wstawia nazwę projektu w polu Name 
      (Nazwa).
   ● Funkcja Auto Update Name (Automatycznej aktualizacji nazwy) dodaje numer do nazwy  
      pliku i zwiększa go przy każdym eksporcie pliku
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     Kliknij opcję Set up Naming Scheme (Skonfiguruj schemat nazewnictwa), aby otworzyć okno 
     dialogowe, w którym możesz określić schemat nazewnictwa.
Path (Ścieżka)
    Umożliwia określenie ścieżki pliku miksu.
    Kliknij Path Options (Opcje ścieżki), aby otworzyć menu podręczne z opcjami ścieżki pliku:
    ●   Choose (Wybierz) otwiera okno dialogowe umożliwiające przeglądanie lokalizacji pliku.
    ●   Use Project Audio Folder (Użyj folderu audio projektu) ustawia ścieżkę do folderu Audio 
          twojego projektu.
    ●   Folder Project Mixdown ustawia ścieżkę do folderu Mixdown Twojego projektu

UWAGA
Jeśli aktywujesz Project Mixdown Folder (Folder miksowania projektu), opcja Use Project 
Audio Folder (Użyj folderu audio projektu) zostanie automatycznie wyłączona.
Folder Mixdown jest automatycznie tworzony w folderze projektu. Jest używany domyślnie, jeśli 
nie są dostępne żadne informacje o ścieżce eksportu, to znaczy, jeśli tworzysz nowy pusty projekt 
lub jeśli ładujesz lub tworzysz projekt z szablonu.

    ●   Recent Paths (Ostatnie ścieżki) pozwalają wybrać ostatnio wybrane lokalizacje plików.
         Folder Mixdown nie jest dodawany do listy Recent Paths.
    ●   Clear Recent Paths (Wyczyść ostatnie ścieżki) umożliwia usunięcie wszystkich ostatnio 
         wybranych lokalizacji plików.
Preview (Zapowiedź)
    Pokazuje nazwę pliku z zastosowanym schematem nazewnictwa.
Conflicts (Konflikty)
    Eksportowanie dźwięku może powodować konflikty nazw z istniejącymi plikami o tej samej 
    nazwie. Możesz zdefiniować sposób rozwiązywania konfliktów nazw plików:
    ●  Always Ask (Zawsze pytaj) otwiera ostrzeżenie, które pozwala wybrać, czy istniejący plik 
        powinien zostać nadpisany, czy też należy utworzyć nową, unikalną nazwę pliku poprzez 
        dodanie przyrostowej liczby.
    ●   Create Unique File Name (Utwórz unikalną nazwę pliku) tworzy unikalną nazwę pliku 
         poprzez dodanie przyrostowego numeru.
    ●   Opcja Always Overwrite (Zawsze nadpisuj) zawsze zastępuje istniejący plik.

File Format (Format pliku)

W sekcji File Format dostępne są następujące opcje:
Preset (Wstępnie ustawione)
    Umożliwia zapisanie gotowych ustawień formatu pliku.
    ●   No Preset (Brak ustawień wstępnych) umożliwia eksport pliku bez stosowania wstępnie   
         ustawionego formatu pliku.
    ●   Preset list (Lista ustawień wstępnych) umożliwia wybranie z listy wstępnie ustawionego 
         formatu zapisanego pliku.
    ●   Save Preset (Zapisz ustawienie wstępne) umożliwia zapisanie bieżących ustawień formatu 
         pliku jako ustawienie wstępne.
    ●   Remove Preset (Usuń ustawienie wstępne) umożliwia usunięcie wybranego ustawienia 
         wstępnego.
    ●   Rename Preset (Zmień nazwę ustawienia wstępnego) otwiera okno dialogowe, w którym 
         możesz zmienić nazwę wybranego ustawienia wstępnego.
File Type (Typ pliku)
    Umożliwia wybór typu pliku miksu.
Sample Rate (Częstotliwość próbkowania) 
    Ustawia częstotliwość próbkowania dla pliku miksowanego.
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UWAGA
● Tylko pliki Wave, AIFF: Jeśli ustawisz wartość niższą niż częstotliwość próbkowania projektu, 
jakość dźwięku ulegnie pogorszeniu, a zawartość wysokich częstotliwości zostanie zmniejszona. 
Jeśli ustawisz wartość wyższą niż częstotliwość próbkowania projektu, rozmiar pliku wzrośnie bez 
poprawy jakości dźwięku. W przypadku nagrywania płyt CD wybierz częstotliwość 44,100 kHz, 
ponieważ jest to częstotliwość próbkowania stosowana na płytach audio CD.

Bit Depth (Wave, AIFF, FLAC) (Głębia bitowa (wave, AIFF, FLAC))
    Umożliwia wybór głębi bitowej pliku miksowania.
Bit Rate (MPEG 1 Layer 3) (Szybkość transmisji (MPEG 1 warstwa 3))
    Ustawia szybkość transmisji pliku MP3. Im wyższa szybkość transmisji, tym lepsza jakość 
    dźwięku i większy plik. W przypadku dźwięku stereo uważa się, że prędkość 128 kBit/s 
    zapewnia dobrą jakość dźwięku.
Export as (Eksportuj jako)
    Umożliwia wybór trybu kanału dla pliku miksowania:
    ●    Interleaved (Przeplatane)
          Umożliwia eksport do pliku z przeplotem.
    ●   Split Channels (Podzielone kanały)
         Umożliwia eksport 2 kanałów magistrali stereo lub wszystkich podkanałów magistrali 
         wielokanałowej jako oddzielne pliki mono.
    ●   Mono Downmix (Monofoniczny miks)
         Umożliwia miksowanie wszystkich podkanałów kanału stereo lub surround lub szyny do 
         pojedynczego pliku mono.
         W przypadku stereo stosuje się Stereo Pan Law (zasadę panoramy stereo) zdefiniowaną w  
         oknie dialogowym Project Setup (Ustawienia projektu), aby uniknąć przesterowania.
         W przypadku dźwięku przestrzennego kanały są sumowane i dzielone przez liczbę używanych
          kanałów (w przypadku kanału 5.1 = (L+R+C+LFE+Ls+Rs)/6).
    ●   L/R Channels from Surround (Kanały L/R z surround)
        Umożliwia eksport tylko lewego i prawego podkanału magistrali wielokanałowej do pliku 
        stereo.
Insert Broadcast Wave Chunk (Wave, AIFF) (Wstaw fragment fali transmisji (Wave, AIFF))
    Aktywuje osadzanie dodatkowych informacji o pliku w formacie Broadcast Wave.

UWAGA
Aktywując tę opcję, tworzysz plik Broadcast Wave. Niektóre aplikacje mogą nie obsługiwać tych 
plików. Jeśli wystąpią problemy z używaniem pliku w innej aplikacji, wyłącz opcję Insert 
Broadcast Wave Chunk (Wstaw fragment fali transmisji) i wyeksportuj plik ponownie

Set up Broadcast Wave Chunk (Wave, AIFF) (Skonfiguruj fragment fali transmisji (Wave, 
AIFF))
    Otwiera okno dialogowe Broadcast Wave Chunk (Fragment fali transmisji), w którym można 
    wprowadzić informacje.
Don’t Use Wave Extensible Format (Wave) (Nie używaj rozszerzalnego formatu Wave (Wave))
    Dezaktywuje format Wave Extensible, który zawiera dodatkowe metadane, takie jak konfiguracja
    głośników.
Don’t Use RF64-Compliant File Format (Wave) (Nie używaj formatu pliku zgodnego ze 
standardem RF64 (Wave))
    Dezaktywuje format zgodny z RF64, który umożliwia rozmiar pliku przekraczający 4 GB.
Insert iXML Chunk (Wave, AIFF) (Wstaw fragment iXML (Wave, AIFF))
    Zawiera dodatkowe metadane związane z projektem, takie jak nazwa projektu, autor i liczba 
    klatek na sekundę projektu.
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Insert Tempo Definition (Wave, AIFF) (Wstaw definicję tempa (wave, AIFF))
    Ta opcja jest dostępna tylko wtedy, gdy włączona jest opcja Insert iXML Chunk (Wstaw 
    fragment iXML). Umożliwia dołączenie informacji o tempie ze ścieżki tempa lub sekcji 
    Definition (Definicja) Sample Editor (Edytora próbek) do fragmentu iXML eksportowanych 
    plików.
High-Quality Mode (MPEG 1 Layer 3) (Tryb wysokiej jakości (MPEG 1 warstwa 3))
    Ustawia koder na inny tryb ponownego próbkowania. Może to dać lepsze wyniki w zależności od
    ustawień. Nie pozwala jednak na wybór Sample Rate (częstotliwości próbkowania).
Insert ID3 Tag (MPEG 1 Layer 3) (Wstaw znacznik ID3 (MPEG 1, warstwa 3))
    Zawiera informacje o znaczniku ID3 w wyeksportowanym pliku.
Edit ID3 Tag (MPEG 1 Layer 3) (Edytuj znacznik ID3 (MPEG 1 warstwa 3))
    Otwiera okno dialogowe Setup ID3 Tag (Konfiguracja znacznika ID3), w którym można  
    wprowadzić informacje o pliku. Informacje te są osadzone w pliku i mogą być wyświetlane 
    w większości aplikacji do odtwarzania plików MP3.
Compression Level (FLAC) (Poziom kompresji (FLAC))
    Ustawia poziom kompresji pliku FLAC. Ponieważ FLAC jest formatem bezstratnym, poziom ma
    większy wpływ na szybkość kodowania niż na rozmiar pliku.
Quality (OggVorbis) (Jakość (OggVorbis))
    Ustawia jakość kodowania ze zmienną przepływnością. To ustawienie określa, w jakich 
    granicach będzie się zmieniać przepływność. Im wyższa wartość, tym wyższa jakość dźwięku, 
    ale także większy rozmiar plików.
Effects (Efekty)
    Jeśli aktywujesz opcję Multiple (Wiele) w sekcji Channel Selection (Wybór kanału), aby 
    wyeksportować wiele kanałów, możesz wybrać opcję określającą proces, który ma zostać 
    zastosowany do eksportowanych plików.
    ●   Inserts and Strip (Wstawki i paski)
         Zawiera efekty wstawiania, korektor i inne ustawienia kanałów. Konfiguracja kanałów jest 
         eksportowana po panoramie, co oznacza, że kanały monofoniczne kierowane do grupy stereo 
         są eksportowane jako kanały stereo.
    ●   Disabled (DRY) (Wyłączone (SUCHE))
         Pomija efekty wstawiania, ustawienia korektora itp. Konfiguracja kanałów jest eksportowana 
         w pozycji przed panoramą, co oznacza, że kanały monofoniczne kierowane do grupy stereo są
         eksportowane jako kanały mono.
    ●   + Groups/Sends (CSP) (+ Grupy/Wysyłki (CSP))
         Zawiera efekty wstawiania, korektor i inne ustawienia kanałów. Obejmuje również efekty 
         i ustawienia we wszystkich kanałach, na przykład kanałach grupowych i FX, w kierunku 
         kanału wyjściowego. Ustawienia efektów i korektora sygnału wejściowego kanału głównego 
         są ignorowane. Konfiguracja kanałów jest eksportowana po panoramowaniu.
    ●   + Master/Groups/Sends (CSPM) (+ Master/Grupy/Wysyłki (CSPM))
         Zawiera efekty wstawiania, korektor i inne ustawienia kanałów. Obejmuje także efekty 
         i ustawienia we wszystkich kanałach, na przykład kanały grupowe i FX w kierunku kanału 
         wyjściowego oraz ustawienia efektów i korektora efektów w kanałach wyjściowych. 
         Konfiguracja kanałów jest eksportowana po panoramowaniu.
After Export (Po eksporcie)
    ●   Opcja „Do Nothing” (Nie rób nic) nie powoduje żadnego działania po eksporcie.
    ●   Open in WaveLab (Otwórz w WaveLab) otwiera po wyeksportowaniu plik miksu w wersji   
         WaveLab. Wymaga to zainstalowania na komputerze wersji WaveLab.
    ●   Create New Project (Utwórz nowy projekt)

UWAGA
Ta opcja jest dostępna tylko dla nieskompresowanych formatów plików i jeśli opcja Use Project 
Audio Folder (Użyj folderu audio projektu) jest wyłączona.
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Tworzy nowy projekt zawierający ścieżkę audio dla każdego z eksportowanych kanałów, a także 
ścieżkę metrum i tempa oryginalnego projektu.
Ścieżki będą miały odpowiedni plik miksowania jako zdarzenie audio. Nazwy utworów będą 
identyczne z nazwami kanałów eksportu. Nowy projekt będzie projektem aktywnym.
Aktywacja tej opcji wyłącza opcje Insert to Pool (Wstaw do puli) i Create Audio Track (Utwórz 
ścieżkę audio).

●   Create Audio Track (Utwórz ścieżkę audio)
     Tworzy zdarzenie audio, które odtwarza klip na nowej ścieżce audio, zaczynając od lewego 
     lokalizatora. Aktywacja tej opcji aktywuje również opcję Pool (Pula).
●   Insert to Pool (Wstaw do puli)
     Automatycznie importuje powstały plik audio z powrotem do puli w postaci klipu.
     Dezaktywacja tej opcji powoduje również dezaktywację opcji Create Audio Track (Utwórz   
     ścieżkę audio).
Pool Folder (Folder puli)
     Umożliwia określenie folderu puli dla klipu.

General Options (Opcje ogólne)

W dolnej części dostępne są następujące opcje:
Keep Dialog Open (Pozostaw okno dialogowe otwarte)
    Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Export Audio (Eksportuj
    Audio)
Update Display (Zaktualizuj wyświetlacz)
    Aktualizuje liczniki podczas procesu eksportu. Umożliwia to na przykład sprawdzenie 
    przycięcia.
Realtime Export (Eksport w czasie rzeczywistym)
Umożliwia eksport miksu audio w czasie rzeczywistym. Eksport w czasie rzeczywistym zajmuje co
najmniej tyle samo czasu, co zwykłe odtwarzanie. Aktywuj tę opcję, jeśli używasz zewnętrznych 
efektów lub instrumentów lub jeśli używasz wtyczek VST, które wymagają czasu na poprawną 
aktualizację podczas miksowania. Więcej informacji można znaleźć w dokumentacji 
poszczególnych wtyczek. Podczas eksportu pojedynczego kanału w czasie rzeczywistym w oknie 
dialogowym postępu wyświetlany jest suwak głośności Audition Volume. Umożliwia regulację 
głośności w Control Room (Reżyserce).

UWAGA
● Jeśli eksportujesz zewnętrzne efekty lub instrumenty w czasie rzeczywistym, musisz także 
aktywować Monitor dla odpowiednich kanałów audio.
● Jeśli szybkość procesora i dysku komputera nie pozwala na jednoczesne eksportowanie 
wszystkich kanałów w czasie rzeczywistym, program zatrzymuje proces, zmniejsza liczbę kanałów 
i rozpoczyna od nowa. Następnie eksportowana jest kolejna partia plików. Czynność tę powtarza 
się tak często, jak to konieczne, aby wyeksportować wszystkie wybrane kanały.

Deactivate External MIDI Inputs (Dezaktywuj zewnętrzne wejścia MIDI)
     Dezaktywuje wejścia MIDI, które są wykonywane na urządzeniach zewnętrznych podczas 
     procesu eksportu.
Export Audio/Start Queue Export (Eksportuj dźwięk/rozpocznij eksport kolejki)
     Umożliwia eksportowanie dźwięku zgodnie z określonymi ustawieniami.

POWIĄZANE LINKI
Dostępne kanały do eksportu na stronie 1067
Eksportuj sekcję kolejki na stronie 1065
Formaty plików na stronie 1067
Zapisywanie ustawień formatu pliku na stronie 1073
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Naming Scheme Dialog (Okno dialogowe schematu nazewnictwa)
Okno dialogowe Naming Scheme umożliwia zdefiniowanie schematów nazewnictwa dla nazwy 
pliku materiału audio, który chcesz wyeksportować.

Atrybuty nazewnictwa dostępne w tym oknie dialogowym zależą od kanału wybranego do 
eksportu.

● Aby otworzyć okno dialogowe Naming Scheme, otwórz okno dialogowe Export Audio 
Mixdown (Eksportuj miks audio) i w sekcji File Location (Lokalizacja pliku), na prawo od pola 
Name (Nazwa), kliknij opcję Set up Naming Scheme (Skonfiguruj schemat nazewnictwa).

             

Scheme (Schemat)
     Umożliwia zapisywanie i usuwanie schematów nazewnictwa.
Attributes (Atrybuty)
     Zawiera następujące atrybuty schematu nazewnictwa:
     ●   Name (Nazwa)
          Dodaje nazwę do wynikowej nazwy pliku.
     ●   Free Text (Dowolny tekst)
          Umożliwia wprowadzenie dowolnego tekstu.
     ●   Channel Number (Numer kanału)
          Dodaje numer kanału do wynikowej nazwy pliku.
     ●    Channel Type (Typ kanału)
           Dodaje typ kanału do wynikowej nazwy pliku.
     ●   Channel Name (Nazwa kanału)
          Dodaje nazwę kanału do wynikowej nazwy pliku.
     ●   Project Name (Nazwa projektu)
          Dodaje nazwę projektu do wynikowej nazwy pliku.
Result (Wynik)
     Umożliwia upuszczanie atrybutów nazwy pliku i zmianę ich kolejności poprzez przeciąganie.
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SettIngs (Ustawienia)
      Umożliwia wybór ustawień separatora i licznika.
      ●   Separator
           Oddziela atrybuty od siebie.
      ●    Counter (Licznik)
            Wartość, od której licznik rozpoczyna zliczanie.
      ●   Digits (Cyfry)
            Liczba cyfr wartości licznika.
Preview (Zapowiedź)
      Wyświetla podgląd bieżących ustawień.

Definiowanie schematów nazewnictwa
Można zdefiniować schemat nazewnictwa, łącząc atrybuty określające strukturę nazw plików 
eksportowanych plików audio.

W zależności od ustawień w sekcji Channel Selection (Wybór kanału) i sekcji Export Range 
(Eksportuj zakres) dostępne są różne atrybuty nazewnictwa.

PROCEDURA
1. W oknie dialogowym Naming Scheme (Schemat nazewnictwa) przeciągnij maksymalnie 5 
    atrybutów do sekcji Result (Wynik).
    Możesz także kliknąć dwukrotnie atrybut, aby dodać go do sekcji Result.
2. Opcjonalnie: w sekcji Settings (Ustawienia) kliknij dwukrotnie pole tekstowe Separator, aby 
    zmienić separator.
    Sekcja Preview (Podgląd) wyświetla schemat nazw plików zgodnie z ustawieniami.
3. Opcjonalnie: Ustaw Counter (licznik) i liczbę Digits (cyfr)

UWAGA
Opcje te są dostępne tylko po dodaniu atrybutu Counter (Licznik).

Licznik rozpoczyna zliczanie od tej wartości. Ustawienie Digits (Cyfry) określa, ile cyfr zawierają 
liczniki.

4. Opcjonalnie: Kliknij pole wartości Name (Nazwa) w sekcji Scheme (Schemat) i wprowadź 
    wstępnie ustawioną nazwę. Naciśnij Return, aby zapisać ustawienia jako ustawienie wstępne.

UWAGA
Zaprogramowane ustawienie jest dostępne tylko dla kanałów wybranych w sekcji Channel 
Selection (Wybór kanału).

5. KLiknij OK.

Wprowadzanie dowolnego tekstu
Można wprowadzić dowolny tekst dodawany do nazw eksportowanych plików audio.

PROCEDURA
1. W sekcji File Location (Lokalizacja pliku) okna dialogowego Export Audio Mixdown 
(Eksportuj miks audio) kliknij opcję Set up Naming Scheme (Skonfiguruj schemat nazewnictwa).

Zostanie otwarte okno dialogowe Naming Scheme (Schemat nazewnictwa)
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2. Otwórz wyskakujące menu Scheme (Schemat) i wybierz New Scheme (Nowy schemat).
3. Kliknij dwukrotnie atrybut Free Text (Dowolny tekst), aby dodać go do pola Result (Wynik).
4. W polu Result kliknij dwukrotnie etykietę Free Text i wprowadź tekst, który chcesz dodać.
5. Naciśnij Return, aby potwierdzić zmiany.
6. Kliknij OK.

WYNIK
Wprowadzony tekst zostanie dodany do schematu nazw plików i zostanie zastosowany podczas 
eksportu.

Miksowanie do plików audio
Możesz miksować wybrane kanały do plików audio.

WARUNEK WSTĘPNY
● Ustawiłeś lewy i prawy lokalizator lub utworzyłeś znacznik cyklu obejmujący zasięg
● Skonfigurowałeś swoje utwory tak, aby odtwarzały się tak, jak chcesz.
   Obejmuje to wyciszanie niechcianych ścieżek lub części, ręczne wprowadzanie ustawień 
   MixConsole i/lub aktywację przycisków automatyzacji R (Odczyt) dla kanałów MixConsole.

WAŻNE
Ustawienie Output Routing (Routingu wyjściowego) w odpowiednim Inspektorze ścieżki określa
szerokość kanału eksportu Export Audio Mixdown (Eksportu miksu audio). Oznacza to, że jeśli 
nie zostanie wybrana żadna główna szyna wyjściowa, wyeksportowany plik audio będzie zawierał 
jedynie ciszę.

PROCEDURA
1. Wybierz opcję File > Export > Audio Mixdown (Plik > Eksportuj > Miksowanie audio).
2. W sekcji Channel Selection (Wybór kanału) wykonaj jedną z następujących czynności:
      ● Kliknij opcję Single (Pojedynczy), aby wyeksportować pojedynczy kanał audio.
      ● Kliknij Multiple (Wiele), aby wyeksportować wiele kanałów audio.
3. Na liście kanałów wybierz kanały, które chcesz wyeksportować.
4. W sekcji Export Range (Zakres eksportu) wykonaj jedną z następujących czynności:
      ● Kliknij Locators (Lokalizatory), aby wyeksportować zakres lokalizatorów.
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UWAGA
Obszar lokalizatora nie może być pusty ani odwrócony.

● Kliknij opcję Cycle Markers (Znaczniki cykli) i na liście znaczników cykli aktywuj znaczniki  
   cykli, aby wyeksportować odpowiednie zakresy.

UWAGA
Twój projekt musi zawierać co najmniej jeden znacznik cyklu.

WAŻNE
● Jeśli ustawisz zakres eksportu w taki sposób, aby efekty, takie jak pogłos, zastosowane do 
poprzedniego zdarzenia, sięgały do następnego, efekty te będą słyszalne w miksie, nawet jeśli samo
zdarzenie nie zostanie uwzględnione. Aby tego uniknąć, wycisz pierwsze zdarzenie.

5. Opcjonalnie: otwórz menu podręczne Effects (Efekty) i wybierz opcję.
    Opcja ta jest dostępna tylko po wybraniu opcji Multiple (Wiele) w sekcji Channel Selection 
    (Wybór kanału). Możesz na przykład wyeksportować dźwięk z efektami, ustawieniami kanałów, 
    panoramą i ustawieniami magistrali głównej.
6. W sekcji File Location (Lokalizacja pliku) ustaw prawidłową ścieżkę eksportu.
7. Ustaw nazwę pliku.

UWAGA
Możesz zdefiniować schemat nazewnictwa w oknie dialogowym Naming Scheme (Schemat 
nazewnictwa).

8. W sekcji File Format (Format pliku) skonfiguruj ustawienia zgodnie ze swoimi potrzebami.
9. Kliknij opcję Export Audio (Eksportuj dźwięk).

WYNIK
Audio zostanie wyeksportowane.

Miksowanie do plików audio przy użyciu kolejek zadań
Można miksować wiele plików audio, tworząc kolejkę zadań. Pozwala to na przykład eksportować 
stemy (główne łodygi) lub cue (wskazówka), nawet w różnych formatach plików. Można utworzyć 
do 20 zadań eksportu i dodać je do kolejki zadań. Kolejki zadań są zapisywane z projektem.

PROCEDURA
1. Wybierz opcję File > Export > Audio Mixdown (Plik > Eksportuj > Miksowanie audio).
2. W sekcji Channel Selection (Wybór kanału) wykonaj jedną z następujących czynności:
      ● Kliknij opcję Single (Pojedynczy), aby wyeksportować pojedynczy kanał audio.
      ● Kliknij Multiple (Wiele), aby wyeksportować wiele kanałów audio.
3. Na liście kanałów wybierz kanały, które chcesz wyeksportować.
4. W sekcji Export Range (Zakres eksportu) wykonaj jedną z następujących czynności:
      ● Kliknij Locators (Lokalizatory), aby wyeksportować zakres lokalizatorów.

UWAGA
Obszar lokalizatora nie może być pusty ani odwrócony.

      ● Kliknij opcję Cycle Markers (Znaczniki cykli) i na liście znaczników cykli aktywuj 
         znaczniki cykli, aby wyeksportować odpowiednie zakresy.
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UWAGA
Twój projekt musi zawierać co najmniej jeden znacznik cyklu.

5. Opcjonalnie: otwórz menu podręczne Effects (Efekty) i wybierz opcję.
    Opcja ta jest dostępna tylko po wybraniu opcji Multiple (Wiele) w sekcji Channel Selection 
    (Wybór kanału). Możesz na przykład wyeksportować dźwięk z efektami, ustawieniami kanałów, 
    panoramą i ustawieniami magistrali głównej.
6. W sekcji File Location (Lokalizacja pliku) ustaw prawidłową ścieżkę eksportu.
7. Ustaw nazwę pliku.
UWAGA
Możesz zdefiniować schemat nazewnictwa w oknie dialogowym Naming Scheme (Schemat 
nazewnictwa).

8. Otwórz sekcję Export Queue (Kolejka eksportu) i kliknij Add to Queue (Dodaj do kolejki)
UWAGA
Jeśli zlecenie jest nieaktualne, np. zakres lokalizatora jest pusty lub nie wybrano żadnego znacznika
cyklu, nie można dodać zadania. W takim przypadku zostanie wyświetlony komunikat 
ostrzegawczy

9. Opcjonalnie: Powtórz powyższe kroki dla dowolnej liczby zadań.
10. Opcjonalnie: Na liście kolejek zadań wybierz poszczególne zadania, aby po kolei sprawdzić, 
      czy wszystko jest poprawnie skonfigurowane.
      Po wybraniu zadania na liście kolejki zadań wszystkie ustawienia tego zadania zostaną 
      pokazane w oknie dialogowym Export Audio Mixdown (Eksportuj miks audio). Jeśli to 
      konieczne, możesz zmienić ustawienia wybranego zadania i kliknąć Update Job (Aktualizuj 
      zadanie).
11. Kliknij opcję Start Queue Export (Rozpocznij eksport kolejki).
UWAGA
Możesz anulować cały eksport kolejki, klikając Cancel (Anuluj). Spowoduje to zatrzymanie 
procesu eksportu i usunięcie już wyeksportowanych plików z dysku twardego. Lista kolejek zadań 
zostanie zachowana.

WYNIK
Zadania z Twojej kolejki eksportu są eksportowane jedno po drugim. Pasek postępu informuje o 
szacowanym pozostałym czasie eksportu, aktualnie eksportowanym kanale, nazwach kanałów i 
liczbie pozostałych zadań.

POWIĄZANE LINKI
Eksportuj sekcję kolejki na stronie 1065
Aktualizowanie zadań w kolejce zadań na stronie 1064
Definiowanie schematów nazewnictwa na stronie 1061

Aktualizowanie zadań w kolejce zadań
Możesz zaktualizować zadania, które już dodałeś do kolejki zadań.

PROCEDURA
1. Na liście kolejki zadań wybierz zadanie, dla którego chcesz zmienić ustawienia.
    Ustawienia wybranego zadania zostaną pokazane w oknie dialogowym Export Audio Mixdown 
    (Eksportuj miks audio).
2. Wprowadź zmiany w odpowiednich sekcjach okna dialogowego.
    Symbol Update Job (Aktualizuj zadanie) dla zadania zmienia swój kolor, aby wskazać, że 
    zadanie zostało zmienione.
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3. W sekcji Export Queue (Kolejka eksportu) kliknij opcję Update Job (Aktualizuj zadanie).

WYNIK
Zadanie eksportu zostanie zaktualizowane zgodnie z Twoimi ustawieniami. Wszystkie pozostałe 
zadania na liście kolejek zadań pozostają niezmienione i ważne.

POWIĄZANE LINKI
Eksportuj sekcję kolejki na stronie 1065
Miksowanie do plików audio przy użyciu kolejek zadań na stronie 1063

Sekcja Export Queue (Eksportuj kolejkę)
Sekcja Export Queue umożliwia utworzenie do 20 zadań eksportu i dodanie ich do kolejki 
eksportu. Kolejka zadań jest częścią projektu i jest zapisywana wraz z projektem.

●  Aby rozwinąć sekcję Export Queue, kliknij strzałkę w lewym dolnym rogu okna dialogowego 
    Export Audio Mixdown (Eksportuj miks audio).

Add to Queue (Dodaj do kolejki)
    Dodaje zadanie z bieżącymi ustawieniami do kolejki zadań.
Remove All from Queue (Usuń wszystko z kolejki)
    Usuwa wszystkie zadania z listy kolejki zadań.
Expand All (Rozwiń wszystkie)
    Rozwija wszystkie zadania na liście.
Collapse All (Zwinąć wszystkie)
    Zwija wszystkie zadania na liście.
Job (Zadanie)
    Numer zadania w kolejce.
File Name (Nazwa pliku)
    Pokazuje jedno z poniższych:
    ●   File Name (Nazwa pliku)
         Nazwa eksportowanego pliku. Jest to wyświetlane, jeśli dodasz pojedynczy kanał do kolejki 
         eksportu i aktywujesz Locators (Lokalizatory) jako zakres eksportu.
    ●   Channel Batch (Partia kanałów)
         Folder Channel Batch zawierający wszystkie kanały należące do tej grupy. Liczba plików  
         jest wyświetlana obok folderu. Jest to wyświetlane, jeśli dodasz wiele kanałów do kolejki 
         eksportu i aktywujesz Locators jako zakres eksportu.
    ●   Cycle Marker (Znacznik cyklu)
    Folder Cycle Marker zawierający znacznik cyklu. Jest to wyświetlane, jeśli dodasz pojedynczy 
    kanał do kolejki eksportu i aktywujesz Cycle Markers (Znaczniki cykli) jako zakres eksportu.
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    ●   Cycle Marker + Batch (Znacznik cyklu + partia)
         Folder Cycle Marker + Batch zawierający wszystkie kanały należące do tej partii. Liczba 
         plików jest wyświetlana obok folderu. Jest to wyświetlane, jeśli dodasz wiele kanałów do 
         kolejki eksportu i aktywujesz Cycle Markers (Znaczniki cykli) jako zakres eksportu.
File Path (Ścieżka pliku)
    Ścieżka pliku eksportowanego pliku.
File Format (Format pliku)
    Ustawienia formatu eksportowanego pliku.
Effects (Efekty)
    Pokazuje ustawienia eksportowanego pliku. Jeśli nic nie jest określone, plik jest eksportowany z 
    ustawieniami kanałów (po panoramie):
    ●   DRY (Suche)
         Plik jest eksportowany w postaci suchej (wstępna panorama).
    ●   CSP
         Plik jest eksportowany poprzez pełną ścieżkę sygnałową.
    ●   CSPM
         Plik jest eksportowany za pomocą pełnej ścieżki sygnałowej i efektów głównych.
Progress (Postęp)
    Pokazuje status zadania eksportu.
Update Job (Aktualizuj zadanie)
    Aktualizuje wybrane zadanie eksportu.
Remove Job (Usuń zadanie)
    Usuwa wybrane zadanie eksportu z listy.

POWIĄZANE LINKI
Aktualizowanie zadań w kolejce zadań na stronie 1064
Eksportuj zadania na stronie 1066
Miksowanie do plików audio przy użyciu kolejek zadań na stronie 1063

Export Jobs (Eksportuj zadania)
Zadania eksportu umożliwiają eksport wielu plików audio z różnymi ustawieniami. Możesz dodać 
do 20 zadań eksportu w kolejce zadań.

Zadanie eksportu zawiera Channel Selection (Wybór kanału), Export Range (zakres eksportu), 
Name (nazwę), Path (ścieżkę), File Format (format pliku) i ustawienia Effects (efektów).

Dla eksportowanych plików audio używany jest bieżący schemat nazewnictwa, a ustawienie 
konfliktów jest automatycznie ustawiane na Create Unique File Name (Utwórz unikalną nazwę 
pliku), co oznacza, że do każdego eksportowanego pliku dodawany jest numer.

UWAGA
Ustawienia After Export (po eksporcie) nie są częścią kolejki zadań i zostaną wykonane po 
eksporcie.

Do kolejki eksportu możesz dodać maksymalnie 20 zadań eksportu. Kolejka zadań jest częścią 
projektu i jest zapisywana wraz z projektem.

POWIĄZANE LINKI
Eksportuj sekcję kolejki na stronie 1065
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Dostępne kanały do eksportu
Sekcja Channel Selection (Wybór kanału) w oknie dialogowym Export Audio Mixdown 
(Eksportuj miks audio) zawiera listę kanałów, które możesz wyeksportować jako miks audio.

Kanały są zorganizowane w strukturę hierarchiczną. Kanały tego samego typu są grupowane. 
Pozwala to łatwo zidentyfikować i wybrać kanały do eksportu.

UWAGA
Kanały MIDI nie są dostępne do eksportu. Można jednak wyeksportować kanał instrumentu VST 
ścieżek MIDI podłączonych do VSTi lub nagrać MIDI na ścieżki audio.

Możesz miksować następujące typy kanałów:
● Kanały wyjściowe
   Wszystkie kanały wyjściowe skonfigurowane w oknie dialogowym Audio Connections 
   (Połączenia audio) są wymienione w sekcji Channel Selection (Wybór kanału). Aktywując kanał 
   wyjściowy na liście, instruujesz Cubase, aby zmiksował wszystkie ścieżki kierowane do tego 
   kanału wyjściowego.
● Kanały audio
   Wszystkie kanały audio dostępne w Twoim projekcie są wymienione w sekcji Channel 
   Selection. Aktywując kanał audio na liście, instruujesz Cubase, aby zmiksował go do pliku.
● Wszelkie kanały MixConsole związane z Audio
   Wszystkie kanały instrumentów VST, ścieżki instrumentów, kanały powrotne efektów (ścieżki 
   kanałów FX), kanały grupowe i kanały ReWire Twojego projektu, które są wymienione w sekcji 
   Channel Selection. Aktywując kanał audio na liście, instruujesz Cubase, aby go zmiksował.

POWIĄZANE LINKI
Połączenia audio na stronie 26

File Formats (Formaty plików)
Wyskakujące menu File Type (Typ pliku) w sekcji File Formats pozwala wybrać format i 
wprowadzić dodatkowe ustawienia dla pliku miksowanego.

Wave file (plik Wave)
    Jest to najpopularniejszy format plików na platformie PC. Pliki Wave mają rozszerzenie .wav.
AIFF file (plik AIFF)
    Jest to standard formatu plików audio zdefiniowany przez firmę Apple Inc. Pliki AIFF są   
    używane na większości platform komputerowych. Pliki mogą zawierać osadzone ciągi tekstowe. 
    Pliki AIFF mają rozszerzenie .aif.
MPEG 1 Layer 3 file (plik MPEG 1 Layer 3)
    Jest to rodzina standardów używanych do kodowania informacji audiowizualnych, takich jak 
    filmy, wideo i muzyka, w skompresowanym formacie cyfrowym. Cubase odczytuje formaty 
    MPEG Layer 2 i MPEG Layer 3. Pliki MP3 to pliki wysoce skompresowane, które nadal 
    zapewniają dobrą jakość dźwięku. Pliki mają rozszerzenie .mp3.
FLAC file (plik FLAC)
    Jest to format open source, który zmniejsza rozmiar plików audio o 50 % do 60 % w porównaniu 
    ze zwykłymi plikami Wave. Pliki mają rozszerzenie .flac.
Ogg Vorbis file (Plik Ogg Vorbis)
    Jest to otwarta, wolna od patentów technologia kodowania i przesyłania strumieniowego 
    dźwięku. Koder Ogg Vorbis wykorzystuje kodowanie ze zmienną szybkością transmisji. Oferuje 
    skompresowane pliki audio o niewielkich rozmiarach, ale o stosunkowo wysokiej jakości 
    dźwięku. Pliki mają rozszerzenie .ogg.
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POWIĄZANE LINKI
Pliki Wave na stronie 1068
Pliki AIFF na stronie 1069
Pliki MP3 (MPEG 1 Layer 3) na stronie 1070
Pliki FLAC na stronie 1071
Pliki Ogg Vorbis na stronie 1072
Format pliku na stronie 1056
Zapisywanie ustawień formatu pliku na stronie 1073

Pliki Wave
Pliki Wave mają rozszerzenie .wav i są najpopularniejszym formatem plików na platformie PC.
● Aby otworzyć ustawienia plików Wave, wybierz Wave z wyskakującego menu File Type (Typ 
pliku).

Sample Rate (Częstotliwość próbkowania)
    Ustawia częstotliwość próbkowania pliku miksowania.

UWAGA
Jeśli ustawisz wartość niższą niż częstotliwość próbkowania projektu, jakość dźwięku ulegnie 
pogorszeniu, a zawartość wysokich częstotliwości zostanie zmniejszona. Jeśli ustawisz wartość 
wyższą niż częstotliwość próbkowania projektu, rozmiar pliku wzrośnie bez poprawy jakości 
dźwięku. W przypadku nagrywania płyt CD wybierz częstotliwość 44,100 kHz, ponieważ jest to 
częstotliwość próbkowania stosowana na płytach audio CD.

Bit Depth (Głębia bitowa)
    Umożliwia wybór głębi bitowej pliku miksowania. Możesz wybrać wersję 8-bitową, 16-bitową, 
    24-bitową, 32-bitową, 32-bitową (float) lub 64-bitową (float). Jeśli planujesz ponownie 
    zaimportować plik miksu do Cubase, wybierz wersję 32-bitową (float). Jest to rozdzielczość 
    używana do przetwarzania dźwięku w Cubase. Pliki 32-bitowe (float) są dwa razy większe niż 
    pliki 16-bitowe. W przypadku nagrywania płyt CD użyj opcji 16-bitowej, ponieważ dźwięk CD 
    jest zawsze 16-bitowy. W takim przypadku zalecamy dithering.
    Aktywacja wtyczki ditheringu UV-22HR zmniejsza skutki szumu kwantyzacji i artefaktów 
    podczas konwersji dźwięku do formatu 16-bitowego. Rozdzielczość 8-bitowa powoduje 
    ograniczoną jakość dźwięku i powinna być używana tylko w razie potrzeby.
Export as (Eksportuj jako)
    Umożliwia wybór trybu kanału dla pliku miksowania:
       ●   Interleaved (Przeplatane)
            Umożliwia eksport do pliku z przeplotem.
       ●   Split Channels (Rozdzielone kanały)
            Umożliwia eksport 2 kanałów magistrali stereo lub wszystkich podkanałów magistrali 
            wielokanałowej jako oddzielne pliki mono.
       ●   Mono Downmix (Monofoniczny miks)
            Umożliwia miksowanie wszystkich podkanałów kanału stereo lub surround lub szyny do 
            pojedynczego pliku mono.
            W przypadku stereo stosuje się Stereo Pan Law (zasadę panoramy stereo) zdefiniowaną w 
            oknie dialogowym Project Setup (Ustawienia projektu), aby uniknąć przesterowania.
            W przypadku dźwięku przestrzennego kanały są sumowane i dzielone przez liczbę 
            używanych kanałów (w przypadku kanału 5.1 = (L+R+C+LFE+Ls+Rs)/6).
       ●   L/R Channels from Surround (Kanały L/R z surround)
            Umożliwia eksport tylko lewego i prawego podkanału magistrali wielokanałowej do pliku 
            stereo.
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Insert Broadcast Wave Chunk (Wstaw fragment fali transmisji)
    Aktywuje osadzanie dodatkowych informacji o pliku w formacie Broadcast Wave.

UWAGA
Aktywując tę opcję, tworzysz plik Broadcast Wave. Niektóre aplikacje mogą nie obsługiwać tych 
plików. Jeśli wystąpią problemy z używaniem pliku w innej aplikacji, wyłącz opcję Insert 
Broadcast Wave Chunk i wyeksportuj plik ponownie.

Set up Broadcast Wave Chunk (Skonfiguruj fragment fali transmisji)
    Otwiera okno dialogowe Broadcast Wave Chunk (Fragment fali transmisji), w którym można 
    wprowadzić informacje.
Insert iXML Chunk (Wstaw fragment iXML)
    Zawiera dodatkowe metadane związane z projektem, takie jak nazwa projektu, autor i liczba 
    klatek na sekundę projektu.
Insert Tempo Definition (Wstaw definicję tempa)
    Ta opcja jest dostępna tylko wtedy, gdy włączona jest opcja Insert iXML Chunk. Umożliwia 
    dołączenie informacji o tempie ze ścieżki tempa lub z sekcji Definition (Definicja) Sample 
    Editor (Edytora próbek) do fragmentu iXML eksportowanych plików.
Don’t Use Wave Extensible Format (Nie używaj rozszerzalnego formatu Wave)
    Dezaktywuje format Wave Extensible, który zawiera dodatkowe metadane, takie jak konfiguracja
    głośników.
Don’t Use RF64-Compliant File Format (Nie używaj formatu pliku zgodnego ze standardem 
RF64)
    Dezaktywuje format zgodny z RF64, który umożliwia rozmiar pliku przekraczający 4 GB.

POWIĄZANE LINKI
Inspektor atrybutów na stronie 659
Zapisywanie ustawień formatu pliku na stronie 1073

Pliki AIFF
AIFF to skrót od Audio Interchange File Format (Format pliku wymiany audio), standardu 
zdefiniowanego przez firmę Apple Inc. Pliki AIFF mają rozszerzenie .aif i są używane na 
większości platform komputerowych.
● Aby otworzyć ustawienia plików AIFF, wybierz AIFF w wyskakującym menu File Type (Typ 
   pliku).

Sample Rate (Częstotliwość próbkowania)
    Ustawia częstotliwość próbkowania dla pliku miksowanego.

UWAGA
Jeśli ustawisz wartość niższą niż częstotliwość próbkowania projektu, jakość dźwięku ulegnie 
pogorszeniu, a zawartość wysokich częstotliwości zostanie zmniejszona. Jeśli ustawisz wartość 
wyższą niż częstotliwość próbkowania projektu, rozmiar pliku wzrośnie bez poprawy jakości 
dźwięku. W przypadku nagrywania płyt CD wybierz częstotliwość 44,100 kHz, ponieważ jest to 
częstotliwość próbkowania stosowana na płytach audio CD.

Bit Depth (Głębia bitowa)
    Umożliwia wybór głębi bitowej pliku miksowania. Możesz wybrać wersję 8-bitową, 16-bitową, 
    24-bitową, 32-bitową, 32-bitową (float) lub 64-bitową (float). Jeśli planujesz ponownie 
    zaimportować plik miksu do Cubase, wybierz wersję 32-bitową (float). Jest to rozdzielczość 
    używana do przetwarzania dźwięku w Cubase. Pliki 32-bitowe (float) są dwa razy większe niż 
    pliki 16-bitowe. W przypadku nagrywania płyt CD użyj opcji 16-bitowej, ponieważ dźwięk CD 
    jest zawsze 16-bitowy. W takim przypadku zalecamy dithering.
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    Aktywacja wtyczki ditheringu UV-22HR zmniejsza skutki szumu kwantyzacji i artefaktów 
    podczas konwersji dźwięku do formatu 16-bitowego. Rozdzielczość 8-bitowa powoduje 
    ograniczoną jakość dźwięku i powinna być używana tylko w razie potrzeby.
Export as (Eksportuj jako)
    Umożliwia wybór trybu kanału dla pliku miksowania:
       ●   Interleaved (Przeplatane)
            Umożliwia eksport do pliku z przeplotem.
       ●   Split Channels (Rozdzielone kanały)
            Umożliwia eksport 2 kanałów magistrali stereo lub wszystkich podkanałów magistrali 
            wielokanałowej jako oddzielne pliki mono.
       ●   Mono Downmix (Monofoniczny miks)
            Umożliwia miksowanie wszystkich podkanałów kanału stereo lub surround lub szyny do 
            pojedynczego pliku mono.
            W przypadku stereo stosuje się Stereo Pan Law (zasadę panoramy stereo) zdefiniowaną w  
            oknie dialogowym Project Setup (Ustawienia projektu), aby uniknąć przesterowania.
            W przypadku dźwięku przestrzennego kanały są sumowane i dzielone przez liczbę 
            używanych kanałów (w przypadku kanału 5.1 = (L+R+C+LFE+Ls+Rs)/6).
       ●   L/R Channels from Surround (Kanały L/R z surround)
            Umożliwia eksport tylko lewego i prawego podkanału magistrali wielokanałowej do pliku 
            stereo.
Insert Broadcast Wave Chunk (Wstaw fragment fali transmisji)
    Aktywuje osadzanie dodatkowych informacji o pliku w formacie Broadcast Wave.

UWAGA
Aktywując tę opcję, tworzysz plik Broadcast Wave. Niektóre aplikacje mogą nie obsługiwać tych 
plików. Jeśli wystąpią problemy z używaniem pliku w innej aplikacji, wyłącz opcję Insert 
Broadcast Wave Chunk (Wstaw fragment fali transmisji) i wyeksportuj plik ponownie.

Set up Broadcast Wave Chunk (Skonfiguruj fragment fali transmisji)
    Otwiera okno dialogowe Broadcast Wave Chunk (Fragment fali transmisji), w którym można 
    wprowadzić informacje.
Insert iXML Chunk (Wstaw fragment iXML)
    Zawiera dodatkowe metadane związane z projektem, takie jak nazwa projektu, autor i liczba 
    klatek na sekundę projektu.
Insert Tempo Definition (Wstaw definicję tempa)
    Ta opcja jest dostępna tylko wtedy, gdy włączona jest opcja Insert iXML Chunk. Umożliwia 
    dołączenie informacji o tempie ze ścieżki tempa lub z sekcji Definition (Definicja) Sample 
    Editor (Edytora próbek) do fragmentu iXML eksportowanych plików.

POWIĄZANE LINKI
Zapisywanie ustawień formatu pliku na stronie 1073

Pliki MP3 (MPEG 1 Layer 3).
Pliki MP3 to pliki wysoce skompresowane, które nadal zapewniają dobrą jakość dźwięku. Mają 
rozszerzenie .mp3.

●   Aby otworzyć ustawienia plików MP3, wybierz MPEG 1 Layer 3 z wyskakującego menu File 
     Type (Typ pliku)

Sample Rate (Częstotliwość próbkowania)
    Ustawia częstotliwość próbkowania pliku miksowania.
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Bit Rate (Szybkość transmisji)
    Ustawia szybkość transmisji pliku MP3. Im wyższa szybkość transmisji, tym lepsza jakość 
    dźwięku i większy plik. W przypadku dźwięku stereo uważa się, że prędkość 128 kBit/s 
    zapewnia dobrą jakość dźwięku.
Export as (Eksportuj jako)
    Umożliwia wybór trybu kanału dla pliku miksowania:
       ●   Interleaved (Przeplatane)
            Umożliwia eksport do pliku z przeplotem.
       ●   Split Channels (Rozdzielone kanały)
            Umożliwia eksport 2 kanałów magistrali stereo lub wszystkich podkanałów magistrali  
            wielokanałowej jako oddzielnych plików mono.
       ●   Mono Downmix (Monofoniczny miks)
            Umożliwia miksowanie wszystkich podkanałów kanału stereo lub surround lub szyny do 
            pojedynczego pliku mono.
            W przypadku stereo stosuje się Stereo Pan Law (zasadę panoramy stereo) zdefiniowaną w 
            oknie dialogowym Project Setup (Ustawienia projektu), aby uniknąć przesterowania.
            W przypadku dźwięku przestrzennego kanały są sumowane i dzielone przez liczbę 
            używanych kanałów (w przypadku kanału 5.1 = (L+R+C+LFE+Ls+Rs)/6).
       ●   L/R Channels from Surround (Kanały L/R z surround)
            Umożliwia eksport tylko lewego i prawego podkanału magistrali wielokanałowej do pliku 
            stereo.
High-Quality Mode (Tryb wysokiej jakości)
    Ustawia koder na inny tryb ponownego próbkowania. Może to dać lepsze wyniki w zależności od
    ustawień. Nie pozwala jednak na wybór Sample Rate (częstotliwości próbkowania).
Insert ID3 Tag (Wstaw znacznik ID3)
    Zawiera informacje o znaczniku ID3 w wyeksportowanym pliku.
Edit ID3 Tag (Edytuj znacznik ID3)
    Otwiera okno dialogowe Setup ID3 Tag (Konfiguracja znacznika ID3), w którym można 
    wprowadzić informacje o pliku. Informacje te są osadzone w pliku i mogą być wyświetlane 
    w większości aplikacji do odtwarzania plików MP3.

POWIĄZANE LINKI
Zapisywanie ustawień formatu pliku na stronie 1073

Pliki FLAC
Pliki Free Lossless Audio Codec (bezpłatnych bezstratnych kodeków audio) to pliki audio, które są 
zazwyczaj od 50 % do 60 % mniejsze niż zwykłe pliki Wave.

● Aby otworzyć ustawienia plików FLAC, wybierz FLAC w wyskakującym menu File Type (Typ 
   pliku).

Sample Rate (Częstotliwość próbkowania)
    Ustawia częstotliwość próbkowania pliku miksowania.

UWAGA
Jeśli ustawisz wartość niższą niż częstotliwość próbkowania projektu, jakość dźwięku ulegnie 
pogorszeniu, a zawartość wysokich częstotliwości zostanie zmniejszona. Jeśli ustawisz wartość 
wyższą niż częstotliwość próbkowania projektu, rozmiar pliku wzrośnie bez poprawy jakości 
dźwięku. W przypadku nagrywania płyt CD wybierz 44,100 kHz, ponieważ jest to częstotliwość 
próbkowania używana na płytach audio CD
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Bit Depth (Głębia bitowa)
    Umożliwia wybór głębi bitowej pliku miksowania. Możesz wybrać wersję 8-bitową, 16-bitową, 
    24-bitową, 32-bitową, 32-bitową (float) lub 64-bitową (float). Jeśli planujesz ponownie 
    zaimportować plik miksu do Cubase, wybierz wersję 32-bitową (float). Jest to rozdzielczość 
    używana do przetwarzania dźwięku w Cubase. Pliki 32-bitowe (float) są dwa razy większe niż 
    pliki 16-bitowe. W przypadku nagrywania płyt CD użyj opcji 16-bitowej, ponieważ dźwięk CD 
    jest zawsze 16-bitowy. W takim przypadku zalecamy dithering.
    Aktywacja wtyczki ditheringu UV-22HR zmniejsza skutki szumu kwantyzacji i artefaktów 
    podczas konwersji dźwięku do formatu 16-bitowego. Rozdzielczość 8-bitowa powoduje 
    ograniczoną jakość dźwięku i powinna być używana tylko w razie potrzeby.
Export as (Eksportuj jako)
    Umożliwia wybór trybu kanału dla pliku miksowania:
    ●   Interleaved (Przeplatane)
         Umożliwia eksport do pliku z przeplotem.
    ●   Split Channels (Rozdzielone kanały)
         Umożliwia eksport 2 kanałów magistrali stereo lub wszystkich podkanałów magistrali 
         wielokanałowej jako oddzielnych plików mono.
    ●   Mono Downmix (Monofoniczny miks)
         Umożliwia miksowanie wszystkich podkanałów kanału stereo lub surround lub szyny do 
         pojedynczego pliku mono.
         W przypadku stereo stosuje się Stereo Pan Law (zasadę panoramy stereo) zdefiniowaną w 
         oknie dialogowym Project Setup (Ustawienia projektu), aby uniknąć przesterowania.
         W przypadku dźwięku przestrzennego kanały są sumowane i dzielone przez liczbę używanych
         kanałów (w przypadku kanału 5.1 = (L+R+C+LFE+Ls+Rs)/6).
    ●   L/R Channels from Surround (Kanały L/R z surround)
         Umożliwia eksport tylko lewego i prawego podkanału magistrali wielokanałowej do pliku 
         stereo.
Compression Level (Poziom kompresji)
    Ustawia poziom kompresji pliku FLAC. Ponieważ FLAC jest formatem bezstratnym, poziom ma
    większy wpływ na szybkość kodowania niż na rozmiar pliku.

POWIĄZANE LINKI
Zapisywanie ustawień formatu pliku na stronie 1073

Pliki Ogg Vorbis
Ogg Vorbis to otwarta, wolna od patentów technologia kodowania i przesyłania strumieniowego 
dźwięku, oferująca skompresowane pliki audio o niewielkich rozmiarach, ale o stosunkowo 
wysokiej jakości dźwięku. Pliki Ogg Vorbis mają rozszerzenie .ogg.

● Aby otworzyć ustawienia plików Ogg Vorbis, wybierz OggVorbis z wyskakującego menu File 
   Type (Typ pliku).

Quality (Jakość)
    Ustawia jakość kodowania ze zmienną przepływnością. To ustawienie określa, w jakich    
    granicach będzie się zmieniać przepływność. Im wyższa wartość, tym wyższa jakość dźwięku, 
    ale także większy rozmiar plików.
Export as (Eksportuj jako)
    Umożliwia wybór trybu kanału dla pliku miksowania:
       ●   Interleaved (Przeplatane)
            Umożliwia eksport do pliku z przeplotem.
       ●   Split Channels (Rozdzielone kanały)
            Umożliwia eksport 2 kanałów magistrali stereo lub wszystkich podkanałów magistrali 
            wielokanałowej jako oddzielnych plików mono.
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      ●    Mono Downmix (Monofoniczny miks)
            Umożliwia miksowanie wszystkich podkanałów kanału stereo lub surround lub szyny do 
            pojedynczego pliku mono.
            W przypadku stereo stosuje się Stereo Pan Law (zasadę panoramy stereo) zdefiniowaną w 
            oknie dialogowym Project Setup (Ustawienia projektu), aby uniknąć przesterowania.
            W przypadku dźwięku przestrzennego kanały są sumowane i dzielone przez liczbę    
            używanych kanałów (w przypadku kanału 5.1 = (L+R+C+LFE+Ls+Rs)/6).
       ●   L/R Channels from Surround (Kanały L/R z surround)
            Umożliwia eksport tylko lewego i prawego podkanału magistrali wielokanałowej do pliku 
            stereo.

POWIĄZANE LINKI
Zapisywanie ustawień formatu pliku na stronie 1073

Zapisywanie ustawień formatu pliku
Możesz tworzyć wstępne ustawienia formatu pliku na podstawie ulubionych lub najczęściej 
używanych ustawień formatu pliku.

PROCEDURA
1. W sekcji File Format (Format pliku) skonfiguruj File Type (Typ pliku) i ustawienia specyficzne
    dla typu pliku, które chcesz zapisać w swoim ustawieniu wstępnym.
2. Kliknij pole Preset (wstępne ustawienie) i wybierz Save Preset (Zapisz Preset) z wyskakującego
    menu.

   
3. Wprowadź nazwę wstępnie ustawionego formatu pliku.
4. Kliknij OK.

WYNIK
Zapisywany jest wstępnie ustawiony format pliku, obejmujący typ pliku, częstotliwość 
próbkowania, głębię bitową oraz ustawienia Export as (Eksportuj jako). Można go wybrać z 
wyskakującego menu Preset (Ustawienia wstępne).
Ustawienia wstępne są zapisywane w programie i można je wykorzystać w dowolnym projekcie. 
Presety są przechowywane w następującej lokalizacji:

● W systemie Windows: „\Users\<nazwa użytkownika>\AppData\Roaming\Steinberg\<nazwa 
programu>\Presets\AudioFileFormatPreset”
W systemie macOS: „/Library/Preferences/<nazwa programu>/Presets/AudioFileFormatPreset” w 
katalogu domowym
Ustawienia wstępne są również zapisywane w profilach w Profile Manager (Menedżerze profili)

POWIĄZANE LINKI
Okno dialogowe Menedżera profili na stronie 1147
Profile na stronie 1147
Formaty plików na stronie 1067
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Synchronization (Synchronizacja)

Synchronizacja to proces, dzięki któremu co najmniej 2 urządzenia odtwarzają razem z tą samą 
prędkością, położeniem i fazą. Urządzenia te mogą obejmować maszyny taśmowe audio i wideo, 
cyfrowe stacje robocze audio, sekwencery MIDI, kontrolery synchronizacji i cyfrowe urządzenia 
wideo.
Jeśli znasz położenie i prędkość urządzenia głównego, możesz przypisać mu prędkość i położenie 
urządzenia podrzędnego, tak aby oba urządzenia grały ze sobą w idealnej synchronizacji.

Position (Time) (Pozycja (czas))

Do określenia pozycji czasowych wykorzystywane są następujące sygnały zegarowe:
       ●   Audio word clock (Zegar dźwiękowy)
               Określa pozycje czasowe w próbkach.
       ●   Timecode (Kod czasowy)
               Określa pozycje czasowe w klatkach wideo.
       ●   MIDI clock (Zegar MIDI)
               Określa pozycje czasowe w taktach muzycznych i uderzeniach.

Speed (Clock) (Prędkość (zegar))

Następujące sygnały zegarowe mierzą prędkość urządzenia:
       ●   Audio word clock (Zegar dźwiękowy)
                Mierzy częstotliwość próbkowania.
       ●   Timecode (Kod czasowy)
                Mierzy liczbę klatek na sekundę.
       ●   MIDI clock (Zegar MIDI)
                Mierzy tempo.

Phase (Faza)

Faza to wzajemne wyrównanie składników położenia i prędkości. Aby uzyskać największą 
dokładność, każdy impuls składowej prędkości powinien być wyrównany z każdym pomiarem 
pozycji. Każda klatka kodu czasowego powinna być idealnie dopasowana do właściwej próbki 
dźwięku.
Mówiąc prościej, faza to bardzo dokładne położenie zsynchronizowanego urządzenia względem 
urządzenia głównego (sample accuracy (dokładność próbki)).

Master and Slave (Zwierzchnik i podwładny)
Nazywanie jednego urządzenia masterem, a drugiego slavem może prowadzić do zamieszania. 
Dlatego też należy pod tym względem rozróżnić relację kodu czasowego i relację sterowania 
maszyną.

        ●   Timecode Master (Urządzenie nadrzędne kodu czasowego)
             Urządzenie generujące informacje o pozycji lub kod czasowy.
        ●   Timecode Slave (Urządzenie podrzędne kodu czasowego)
             Dowolne urządzenie odbierające kod czasowy i synchronizujące go lub blokujące.
        ●   Machine Control Master (Urządzenie nadrzędne sterowania maszyną)
             Urządzenie wysyłające do systemu polecenia transportowe.
        ●   Machine Control Slave (Urządzenie podrzędne sterujące maszyną)
             Urządzenie odbierające polecenia kodu czasowego i odpowiadające na nie.
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Cubase może być głównym kontrolerem maszyny, wysyłającym polecenia transportu do urządzenia
zewnętrznego, które z kolei wysyła informacje o kodzie czasowym i zegarze audio z powrotem do 
Cubase. W takim przypadku Cubase byłby również podwładnym kodu czasowego.

UWAGA
W większości scenariuszy urządzenie podrzędne sterujące maszyną jest jednocześnie głównym 
urządzeniem kodu czasowego. Po otrzymaniu polecenia odtwarzania urządzenie zaczyna 
generować kod czasowy dla wszystkich urządzeń podrzędnych kodu czasowego w celu 
synchronizacji.

Formaty kodu czasowego
Położenie dowolnego urządzenia jest najczęściej opisywane za pomocą kodu czasowego. Kod 
czasowy reprezentuje czas przy użyciu godzin, minut, sekund i klatek, aby zapewnić lokalizację 
każdego urządzenia. Każda klatka reprezentuje film wizualny lub klatkę wideo.

Obsługiwane są następujące formaty kodu czasowego:

● LTC
Podłużny kod czasowy lub LTC to sygnał analogowy, który można nagrać na taśmie. Należy go 
używać przede wszystkim do informacji o położeniu. Można go również wykorzystać do informacji
o prędkości i fazie w ostateczności, jeśli nie jest dostępne żadne inne źródło zegara.
● VITC
Kod czasowy z interwałem pionowym lub VITC jest zawarty w złożonym sygnale wideo. Jest 
nagrywany na taśmę wideo i fizycznie powiązany z każdą klatką wideo.
● MTC
Kod czasowy MIDI lub MTC jest identyczny z LTC, z tą różnicą, że jest to sygnał cyfrowy 
przesyłany przez MIDI.

Standardy kodu czasowego
Kod czasowy (timecode) ma kilka standardów. Temat różnych formatów kodu czasowego może 
być bardzo zagmatwany ze względu na użycie i niewłaściwe użycie skróconych nazw dla 
określonych standardów kodu czasowego i liczby klatek na sekundę. Format kodu czasowego 
można podzielić na 2 zmienne: liczbę klatek i liczbę klatek na sekundę

Frame count (frames per second) (Liczba klatek (klatek na sekundę))
    Liczba klatek kodu czasowego określa standard, według którego jest on oznaczony. 
    Istnieją 4 standardy kodu czasowego:

24 fps Film (F) (Film 24 kl./s (F))
    Ta liczba klatek jest tradycyjną liczbą dla filmu. Jest również używany w formatach wideo HD i 
    powszechnie określany jako 24p. Jednak w przypadku wideo HD rzeczywista liczba klatek na 
    sekundę lub prędkość odniesienia synchronizacji wideo jest mniejsza i wynosi 23,976 klatek na 
    sekundę, więc kod czasowy nie odzwierciedla rzeczywistego czasu zegara w przypadku 
    wideo HD 24p.
25 fps PAL (P) (25 kl./s PAL (P))
    Jest to standardowa liczba klatek transmisji wideo dla transmisji telewizyjnych w Europie 
    (i innych krajach PAL).
30 fps non-drop SMPTE (N) (30 kl./s bez kropli SMPTE (N))
    Jest to liczba klatek nadawanego wideo w systemie NTSC. Jednak rzeczywista liczba klatek na 
    sekundę lub prędkość formatu wideo wynosi 29,97 klatek na sekundę. Ten zegar kodu 
    czasowego nie działa w czasie rzeczywistym. Jest nieco wolniejszy o 0,1 %.
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30 fps drop-frame SMPTE (D) (SMPTE ze stratą klatek na sekundę przy 30 kl./s (D))
    Liczenie klatek pomijanych przy 30 kl./s to adaptacja, która umożliwia wyświetlaniu kodu 
    czasowego działającego z szybkością 29,97 kl./s faktyczne pokazywanie czasu na osi czasu na 
    zegarze ściennym poprzez upuszczanie lub pomijanie określonych numerów klatek w celu 
    dotrzymania do zegara czasu rzeczywistego.

UWAGA
Pamiętaj, aby zachować standard kodu czasowego (lub liczbę klatek) i liczbę klatek na sekundę (lub
prędkość).

Frame rate (speed) (Liczba klatek na sekundę (prędkość))
Niezależnie od systemu zliczania klatek, rzeczywista prędkość, z jaką płyną klatki wideo w czasie 
rzeczywistym, jest rzeczywistą szybkością klatek.

Cubase obsługuje następujące szybkości klatek:

23.98 fps (23,98 kl./s)
    Ta liczba klatek na sekundę jest używana w przypadku filmu przesyłanego do formatu wideo 
    NTSC i musi zostać spowolniona w przypadku przesyłania telecine 2-3 pull-down. Jest również 
    używany w przypadku wideo HD określanego jako 24p.
24 fps (24 kl/s)
    Jest to rzeczywista prędkość standardowych kamer na kliszę.
24,98 fps (24,98 kl./s)
    Ta liczba klatek na sekundę jest powszechnie stosowana w celu ułatwienia transferu pomiędzy 
    źródłami wideo i filmowymi w systemie PAL i NTSC. Służy głównie do kompensacji jakiegoś 
    błędu.
25 fps (25 kl./s)
    Jest to liczba klatek na sekundę wideo w systemie PAL.
29.97 fps/29.97 dfps (29,97 kl./s/29,97 kl./s)
    Jest to liczba klatek na sekundę wideo NTSC. Liczba może być non-drop-frame lub drop-frame.
30 fps/30 dfps (30 kl./s/30 kl./s)
    Ta liczba klatek na sekundę nie jest już standardem wideo, ale jest powszechnie stosowana przy 
    nagrywaniu muzyki. Wiele lat temu był to czarno-biały standard transmisji NTSC. Jest to 
    równoznaczne z przyspieszeniem wideo NTSC do szybkości filmu po przesłaniu telecine 2-3 
    razy. Liczba może być non-drop-frame lub drop-frame.
50 fps (50 kl/s)
    Stawka ta jest również określana jako 50 p (pensów)
59,94 fps (59,94 kl./s)
    Ta częstotliwość klatek wideo jest obsługiwana przez kamery wysokiej rozdzielczości i jest 
    zgodna z systemem NTSC.
60 fps (60 kl/s)
    Ta częstotliwość klatek wideo jest obsługiwana przez wiele kamer wysokiej rozdzielczości.   
    Jednak liczba klatek na sekundę zgodna z NTSC wynosząca 59,94 kl./s jest znacznie bardziej 
    powszechna.

WAŻNE
Formaty wideo ze zmienną liczbą klatek na sekundę (VFR) nie są obsługiwane.
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Frame count vs. frame rate (Liczba klatek a liczba klatek na sekundę)
Część zamieszania w kodzie czasowym wynika z użycia klatek na sekundę zarówno w standardzie 
kodu czasowego, jak i rzeczywistej szybkości klatek. Kiedy jest używany do opisu standardu kodu 
czasowego, liczba klatek na sekundę określa, ile klatek kodu czasowego jest zliczanych przed jedną
sekundą w przyrostach licznika. Opisując liczbę klatek na sekundę, liczba klatek na sekundę 
określa, ile klatek jest odtwarzanych w ciągu jednej sekundy czasu rzeczywistego. Innymi słowy: 
niezależnie od tego, ile klatek wideo przypada na sekundę kodu czasowego (liczba klatek), klatki te 
mogą poruszać się z różną szybkością w zależności od szybkości (częstotliwość wyświetlania 
klatek) formatu wideo. Na przykład kod czasowy NTSC (SMPTE) ma liczbę klatek wynoszącą 30 
klatek na sekundę. Jednak wideo w systemie NTSC działa z szybkością 29,97 kl./s. Zatem standard 
kodu czasowego NTSC, znany jako SMPTE, to standard 30 fps działający z szybkością 29,97 fps w
czasie rzeczywistym.

Clock Sources (Źródła zegara)
Po ustaleniu pozycji kolejnym istotnym czynnikiem synchronizacji jest prędkość odtwarzania. Gdy 
2 urządzenia zaczną odtwarzać z tej samej pozycji, muszą działać z dokładnie tą samą prędkością, 
aby zachować synchronizację. Dlatego należy zastosować jedno odniesienie do prędkości i 
wszystkie urządzenia w systemie muszą dostosować się do tego odniesienia. W przypadku dźwięku 
cyfrowego prędkość jest określana na podstawie częstotliwości zegara audio. W przypadku wideo 
prędkość jest określana na podstawie sygnału synchronizacji wideo.

Audio clock (Zegar audio)
Sygnały zegara audio działają z szybkością próbkowania stosowaną przez cyfrowe urządzenie 
audio i są przesyłane na kilka sposobów:

Word Clock (Zegar słowny)
    Word Clock to dedykowany sygnał działający z bieżącą częstotliwością próbkowania, przesyłany
    pomiędzy urządzeniami za pomocą kabli koncentrycznych BNC. Jest to najbardziej niezawodna 
    forma zegara audio, stosunkowo łatwa w podłączeniu i obsłudze.
AES/SPDIF Digital Audio (Dźwięk cyfrowy AES/SPDIF)
    Źródło zegara audio jest osadzone w cyfrowych sygnałach audio AES i SPDIF. To źródło zegara 
    może być użyte jako prędkość odniesienia. Najlepiej, aby sam sygnał nie zawierał żadnego 
    rzeczywistego dźwięku (cyfrowa czerń), ale w razie potrzeby można było użyć dowolnego 
    cyfrowego źródła dźwięku.
ADAT Lightpipe (Latarnia ADAT)
    ADAT Lightpipe, 8-kanałowy cyfrowy protokół audio opracowany przez Alesis, zawiera 
    również zegar audio i może być używany jako prędkość odniesienia. Transmisja odbywa się za 
    pomocą kabli optycznych pomiędzy urządzeniami.
UWAGA
Nie należy mylić zegara audio wbudowanego w protokół Lightpipe z funkcją ADAT Sync, która 
umożliwia sterowanie kodem czasowym i maszyną poprzez zastrzeżone złącze wtykowe DIN.

MIDI clock (Zegar MIDI)
Zegar MIDI to sygnał wykorzystujący dane dotyczące pozycji i taktowania w oparciu o takty i 
uderzenia muzyczne w celu określenia lokalizacji i szybkości (tempa). Może pełnić tę samą 
funkcję, co odniesienie pozycyjne i odniesienie prędkości dla innych urządzeń MIDI. Cubase 
obsługuje wysyłanie zegara MIDI do urządzeń zewnętrznych, ale nie może być podporządkowane 
przychodzącemu zegarowi MIDI.
WAŻNE
Zegara MIDI nie można używać do synchronizacji dźwięku cyfrowego. Jest używany wyłącznie w 
przypadku urządzeń MIDI do wzajemnej synchronizacji muzycznej. Cubase nie obsługuje funkcji 
slave zegara MIDI.
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Okno dialogowe Project Synchronization Setup (konfiguracja 
synchronizacji projektu)
Okno dialogowe Project Synchronization Setup stanowi centralne miejsce do konfiguracji 
złożonego zsynchronizowanego systemu. Oprócz ustawień źródeł kodu czasowego i ustawień 
sterowania maszyną, dostępne są podstawowe elementy sterujące transportem do testowania 
systemu.

Aby otworzyć okno dialogowe Project Synchronization Setup, wykonaj jedną z następujących 
czynności:
       ● Wybierz opcję Transport > Project Synchronization Setup (Transport > Konfiguracja 
          synchronizacji projektu).
       ● Na pasku transportu naciśnij Ctrl/Cmd i kliknij Sync (Synchronizuj)

UWAGA
Jeśli aktywujesz Steinberg SyncStation jako źródło wejściowe, istnieje kilka opcji kierowania tych
poleceń w samej stacji SyncStation. Szczegółowe informacje można znaleźć w dokumentacji 
dołączonej do stacji SyncStation.

                       

POWIĄZANE LINKI
Strona Źródła na stronie 1079
Strona miejsc docelowych na stronie 1081
Strona sterowania maszyną na stronie 1082
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Strona Sources (Źródła)
Strona Sources umożliwia skonfigurowanie wejść synchronizacji i określenie, które sygnały 
zewnętrzne docierają do aplikacji.

               

W najwyższej sekcji dostępne są następujące opcje:
Activate External Sync (Aktywuj synchronizację zewnętrzną)
     Aktywuje/dezaktywuje synchronizację zewnętrzną.

Timecode Source (Źródło kodu czasowego)
Sekcja Timecode Source pozwala określić, czy Cubase działa jako master czy slave kodu 
czasowego. Dostępne są następujące opcje:
Internal Timecode (Wewnętrzny kod czasowy)
    Ustawia Cubase jako główny kod czasowy, który generuje wszystkie odniesienia do pozycji dla 
    dowolnego innego urządzenia w systemie w oparciu o oś czasu projektu i ustawienia konfiguracji
    projektu.
MIDI Timecode (Kod czasowy MIDI)
    Jeśli aktywowano opcję Activate External Sync (Aktywuj zewnętrzną synchronizację), ustawia  
    to Cubase jako urządzenie podrzędne kodu czasowego dla dowolnego przychodzącego kodu 
    czasowego MIDI. Porty MTC Input (wejściowe MTC) można wybrać w sekcji MIDI Timecode
    Settings (Ustawienia kodu czasowego MIDI.
ASIO Audio Device (Windows only) (Urządzenie audio ASIO (tylko Windows))
    Dostępne tylko dla kart dźwiękowych obsługujących protokół pozycjonowania ASIO. Karty te 
    mają zintegrowany czytnik LTC lub port synchronizacji ADAT i mogą wykonywać wyrównanie 
    fazowe kodu czasowego i zegara audio.
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VST System Link (Łącze systemowe VST)
    Ustawia VST System Link jako źródło kodu czasowego. Pozwala to na wszystkie aspekty 
    przykładowej dokładnej synchronizacji pomiędzy różnymi komputerami połączonymi za pomocą
    łącza VST System Link.

UWAGA
Rozbieżności pomiędzy Project Frame Rate (Szybkością klatek projektu) a przychodzącym 
kodem czasowym mogą powodować problemy podczas postprodukcji, nawet jeśli Cubase będzie w 
stanie zablokować ten kod czasowy.

MIDI Timecode Settings (Ustawienia kodu czasowego MIDI)
MIDI Timecode Settings staną się dostępne, jeśli aktywujesz MIDI Timecode (Kod czasowy 
MIDI) jako Timecode Source (źródło kodu czasowego).
MTC Input (Wejście MTC)
    Umożliwia wybór portów wejściowych MIDI. Aby umożliwić Cubase synchronizację z kodem 
czasowym MIDI z dowolnego połączenia MIDI, wybierz opcję All MIDI Inputs (Wszystkie 
wejścia MIDI).

Timecode Source Preferences (Preferencje źródła kodu czasowego)
Jeśli aktywujesz MIDI Timecode (Kod czasowy MIDI) jako Timecode Source (Źródło kodu 
czasowego), możesz skonfigurować Timecode Source Preferences do pracy z zewnętrznym 
kodem czasowym. Dostępne są następujące opcje:
Lock Frames (Zablokuj ramki)
    Określa, ile pełnych klatek kodu czasowego potrzeba, aby Cubase zablokował, czyli ustanowił 
    Synchronizację.

UWAGA
Jeśli masz zewnętrzny transport taśm z bardzo krótkim czasem uruchamiania, ustaw Lock Frames 
na niską wartość, aby blokowanie było jeszcze szybsze.

Drop Out Frames (Usuń ramki)
    Ustawia liczbę klatek kodu czasowego, które muszą zostać pominięte, aż Cubase się zatrzyma.   
    Używanie LTC na analogowej maszynie taśmowej może zwiększyć liczbę porzuceń.
Inhibit Restart ms (Zablokuj Uruchom ponownie ms)
    Niektóre synchronizatory nadal transmitują MTC przez krótki czas po zatrzymaniu zewnętrznego
    magnetofonu. Te dodatkowe klatki kodu czasowego czasami powodują nagłe ponowne 
    uruchomienie Cubase. Inhibit Restart ms pozwala kontrolować ilość czasu w milisekundach, 
    przez który Cubase czeka przed ponownym uruchomieniem (ignorując przychodzące MTC) po 
    jego zatrzymaniu.
Auto-Detect Frame Rate Changes (Automatycznie wykrywaj zmiany szybkości klatek)
    Powiadamia o zmianach liczby klatek na sekundę lub kodu czasowego i przerywa odtwarzanie 
    lub nagrywanie. Aktywuj tę opcję, jeśli chcesz zdiagnozować problemy z kodem czasowym i 
    urządzeniami zewnętrznymi.
Transport Start/Stop (Rozpoczęcie/zatrzymanie transportu)
    Rozpoczyna/zatrzymuje odtwarzanie w Cubase.

POWIĄZANE LINKI
Aktywacja łącza systemowego VST na stronie 1091
Okno dialogowe Project Setup (Ustawienia projektu) na stronie 104
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Strona Destinations (Miejsc docelowych)
Strona Destinations umożliwia ustawienie wyjść synchronizacji oraz określenie, które sygnały 
zewnętrzne opuszczają aplikację.

         

MIDI Clock Destinations (Miejsca docelowe zegara MIDI)
W sekcji MIDI Clock Destinations możesz wybrać dowolne porty MIDI, z których chcesz 
wysyłać zegar MIDI. Niektóre urządzenia MIDI, takie jak automaty perkusyjne, mogą dopasować 
swoje tempo i lokalizację do przychodzącego zegara MIDI.

MIDI Clock Preferences (Preferencje zegara MIDI)
W sekcji MIDI Clock Preferences dostępne są następujące opcje:

MIDI Clock Follows Project Position (Zegar MIDI podąża za pozycją projektu)
     Zapewnia, że zegar MIDI podąża za Cubase.
Always Send Start Message (Zawsze wysyłaj wiadomość startową)
     Polecenia transportu zegara MIDI obejmują start, stop i kontynuowanie. Aktywuj tę opcję, jeśli 
     urządzenie MIDI nie rozpoznaje polecenia Continue (Kontynuuj).
Send MIDI Clock in Stop Mode (Wyślij zegar MIDI w trybie zatrzymania)
     Aktywuj tę opcję, jeśli urządzenie MIDI wymaga ciągłej pracy zegara MIDI, aby móc 
     obsługiwać arpeggiatory i generatory pętli.

MIDI Timecode Destinations (Miejsca docelowe kodu czasowego MIDI)
W sekcji MIDI Timecode Destinations możesz określić porty MIDI, do których kierowany jest 
MTC.
UWAGA
Niektóre interfejsy MIDI domyślnie wysyłają MTC przez wszystkie porty. W takim przypadku 
należy wybrać tylko jeden port interfejsu dla MTC.
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MIDI Timecode Preferences (Preferencje kodu czasowego MIDI)
W sekcji MIDI Timecode Preferences dostępne są następujące opcje:

MIDI Timecode Follows Project Time (Kod czasowy MIDI odpowiada czasowi projektu)
     Zapewnia, że wyjście MTC zawsze jest zgodne z pozycją czasową Cubase.

Strona Machine Control (Sterowanie maszyną)

               

Machine Control Input Settings (Ustawienia wejścia sterowania maszyną)
Ustawienia te staną się dostępne, jeśli jako wejście sterujące maszyną wybierzesz MIDI Machine 
Control. W sekcji Machine Control Input Settings możesz skonfigurować Cubase tak, aby 
podążał za przychodzącymi poleceniami transportu i odpowiadał na polecenia umożliwiające 
nagrywanie ścieżek audio. Umożliwia to integrację Cubase z większymi systemami studyjnymi ze 
scentralizowaną kontrolą maszyn i synchronizacją, np. scenami miksowania w teatrach.

Dostępne są następujące opcje:
MMC Input (Wejście MMC)
      Umożliwia wybór wejścia MIDI podłączonego do głównego urządzenia sterującego maszyną.
MMC Output (Wyjście MMC)
      Umożliwia wybór wyjścia MIDI podłączonego do głównego urządzenia sterującego maszyną.
MMC Device ID (Identyfikator urządzenia MMC)
     Określa identyfikator MIDI używany do identyfikacji maszyny w Cubase.

UWAGA
Protokół MMC obejmuje odpytywanie urządzeń o ich status, co wymaga komunikacji 
dwukierunkowej. Dlatego zalecamy podłączenie zarówno wejścia MIDI, jak i portu wyjściowego 
MIDI urządzeń MMC.

Machine Control Output Settings (Ustawienia wyjściowe sterowania maszyną)
W sekcji Machine Control Output Settings dostępne są następujące opcje:
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MMC Master Active (Aktywny MMC Master)
      Kieruje polecenia transportu do dowolnego urządzenia, gdy włączona jest synchronizacja.
MMC Input (Wejście MMC)
     Określa, który port MIDI w systemie odbiera polecenia MMC. Ustaw tę opcję na port MIDI 
     podłączony do żądanego urządzenia MIDI.
MMC Output (Wyjście MMC)
     Określa, który port MIDI w systemie wysyła polecenia MMC. Ustaw tę opcję na port MIDI 
     podłączony do żądanego urządzenia MIDI.
MMC Device ID (Identyfikator urządzenia MMC)
     Ustaw ten sam identyfikator urządzenia, jak w sekcji Ustawienia wejścia sterowania maszyną.
UWAGA
Jeśli więcej niż jedno urządzenie otrzymuje polecenia MMC lub jeśli nie znasz identyfikatora 
urządzenia, możesz ustawić identyfikator na All (Wszystkie). Jednakże urządzenia, które mogą 
odsłuchiwać tylko swoje określone identyfikatory, nie będą działać, jeśli identyfikator jest 
ustawiony na All.

Number of Audio Tracks (Liczba ścieżek audio)
     Określa, ile przycisków umożliwiających nagrywanie jest wyświetlanych w MMC Master 
     Panel (głównym panelu MMC). Ustaw tę opcję na liczbę dostępnych ścieżek audio 
     w urządzeniu docelowym.

MMC Master Panel (Panel główny MMC)
● Aby otworzyć MMC Master Panel, wybierz Studio > More Options > MMC Master Panel 
   (Studio > Więcej opcji > Główny panel MMC).

              

1, 2, 3, 4
      Użyj tych przycisków, aby uzbroić ścieżki taśmy do nagrywania.
A1, A2, TC, VD
      Przyciski te odnoszą się do dodatkowych ścieżek, które zwykle znajdują się na magnetowidach. 
      Zapoznaj się z instrukcją obsługi swojego urządzenia VTR, aby sprawdzić, czy te ścieżki są 
      obsługiwane.
Online
     Aktywuj tę opcję, aby używać przycisków transportu do sterowania transportem urządzenia.
UWAGA
W oknie dialogowym Preferences (Preferencje) wybierz opcję MIDI > MIDI Filter (MIDI > Filtr 
MIDI) i upewnij się, że w sekcji Thru włączono funkcję SysEx.
Jest to konieczne, ponieważ MMC wykorzystuje komunikację dwukierunkową, w której 
magnetofon odpowiada na wiadomości MMC otrzymane od Cubase. Odfiltrowując SysEx Thru, 
masz pewność, że te wyjątkowe odpowiedzi systemu MMC nie zostaną odzwierciedlone 
z powrotem do magnetofonu.

Synchronizacja zewnętrzna
Aby aktywować synchronizację zewnętrzną, wykonaj jedną z następujących czynności:
      ● Wybierz opcję Transport > Activate External Sync (Transport > Aktywuj synchronizację 
         zewnętrzną).
      ● Wybierz opcję Transport > Project Synchronization Setup (Transport > Konfiguracja 
         synchronizacji projektu) i na stronie Sources (Źródła) aktywuj opcję Activate External Sync 
         (Aktywuj synchronizację zewnętrzną).
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      ● Polecenia transportu są kierowane do docelowego wyjścia sterowania maszyną, jak określono
         w oknie dialogowym Project Synchronization Setup (Konfiguracja synchronizacji projektu).
         Polecenia lokalizacji, odtwarzania, zatrzymywania i nagrywania będą teraz wysyłane do 
         urządzenia zewnętrznego.
      ● Cubase oczekuje na przychodzący kod czasowy z wybranego źródła kodu czasowego 
         zdefiniowanego w oknie dialogowym Project Synchronization Setup, aby móc odtwarzać.
         Cubase wykryje nadchodzący kod czasowy, zlokalizuje go w bieżącej pozycji i rozpocznie 
         odtwarzanie zsynchronizowane z przychodzącym kodem czasowym.

W typowym scenariuszu zewnętrzna maszyna taśmowa, taka jak VTR, ma wyjście kodu czasowego
podłączone do Cubase. Cubase wysyła polecenia sterujące maszyną na pokład. Po włączeniu opcji 
Activate External Sync (Aktywuj synchronizację zewnętrzną) i kliknięciu przycisku Start na 
panelu Transport do magnetowidu wysyłane jest polecenie odtwarzania. VTR z kolei rozpoczyna 
odtwarzanie, wysyłając kod czasowy z powrotem do Cubase. Cubase następnie synchronizuje się z 
nadchodzącym kodem czasowym.

Konfigurowanie synchronizacji dla Personal Music Studio (Osobistego
studia muzycznego)
W osobistym studiu muzycznym warto przeprowadzić synchronizację z zewnętrznym urządzeniem 
nagrywającym, takim jak przenośna nagrywarka z dyskiem twardym, używana do zdalnych nagrań 
na żywo.

WARUNEK WSTĘPNY
Użyj połączeń MIDI do sterowania kodem czasowym i maszyną oraz cyfrowych połączeń audio 
Lightpipe dla zegara audio i sygnałów audio.
UWAGA
● Cubase powinien wysłać polecenia MMC do rejestratora z dyskiem twardym i zdalnie rozpocząć 
   odtwarzanie z rejestratora.
● Nagrywarka z dyskiem twardym powinna odesłać MTC do Cubase. Kiedy rejestrator rozpoczyna 
   odtwarzanie, kod MTC jest wysyłany z powrotem do Cubase, który synchronizuje się z tym 
   kodem czasowym.
● Nagrywarka z dyskiem twardym wykorzystuje zegar audio z interfejsu audio Cubase jako 
   prędkość odniesienia.

PROCEDURA
1. Wybierz opcję Transport > Project Synchronization Setup (Transport > Konfiguracja 
    synchronizacji projektu), otwórz stronę Sources (Źródła) i w sekcji Timecode Source (Źródło 
    kodu czasowego) aktywuj MIDI Timecode (Kod czasowy MIDI).
    Jeśli nagrywasz z rejestratora dysku twardego do Cubase, Cubase jest urządzeniem głównym 
    sterowania maszyną i modułem podrzędnym kodu czasowego, blokującym przychodzące MTC.
2. Otwórz stronę Machine Control (Sterowanie maszyną) i w sekcji Machine Control Output    
    Settings (Ustawienia wyjścia sterowania maszyną) aktywuj MMC Master Active.
    Cubase wysyła teraz polecenia MMC do nagrywarki z dyskiem twardym w celu zlokalizowania 
    i rozpoczęcia odtwarzania.
3. W sekcji Machine Control Output Settings wybierz porty MMC Input (Wejścia MMC) 
    i MMC Output (Wyjścia MMC) podłączone do rejestratora z dyskiem twardym.
    Ponieważ MMC wykorzystuje komunikację dwukierunkową, oba porty MIDI powinny być 
    połączone. Upewnij się, że filtr MIDI nie odbija echa danych SysEx.
4. Otwórz stronę Sources (Źródła) i aktywuj opcję Activate External Sync (Aktywuj    
    synchronizację zewnętrzną. To kieruje polecenia transportu do rejestratora dysku twardego 
    poprzez MIDI i ustawia Cubase jako urządzenie podrzędne kodu czasowego.
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5. Na nagrywarce z dyskiem twardym włącz MMC i MTC.
    Postępuj zgodnie z instrukcjami dotyczącymi konfigurowania urządzenia do odbierania poleceń 
    MMC i przesyłania MTC.
6. W Cubase rozpocznij odtwarzanie.

WYNIK
Nagrywarka z dyskiem twardym rozpoczyna odtwarzanie i wysyła MTC do Cubase. Gdy Cubase 
zsynchronizuje się z MTC, status na panelu Transport zmienia się na Lock (Zablokowane) 
i wyświetlana jest bieżąca liczba klatek na sekundę przychodzącego MTC.
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VST System Link (Łącze systemowe VST)
VST System Link to cyfrowy system sieci audio, który umożliwia połączenie kilku komputerów za
pomocą cyfrowego sprzętu audio i kabli.

Połączenie 2 lub więcej komputerów umożliwia rozdzielenie różnych zadań i różnych ścieżek 
pomiędzy różnymi komputerami. Możesz uruchamiać procesy obciążające procesor, takie jak 
wtyczki efektów wysyłania lub instrumenty VST, na jednym komputerze i nagrywać ścieżki audio 
na innym.

VST System Link zapewnia kontrolę transportu i synchronizacji, a także maksymalnie 16 portów 
MIDI po 16 kanałów każdy.
Dzięki VST System Link sygnał jest przekazywany z jednej maszyny do drugiej i ostatecznie 
wraca do pierwszej maszyny.

Aby to zadziałało, potrzebne są co najmniej 2 komputery korzystające z tego samego lub różnych 
systemów operacyjnych, a dla każdego komputera w sieci:
      ● Sprzęt audio z cyfrowymi wejściami i wyjściami oraz specjalnym sterownikiem ASIO.
         Te same formaty cyfrowe i typy połączeń.
      ● Co najmniej jeden cyfrowy kabel audio, taki jak S/PDIF, ADAT, TDIF lub AES.
      ● Aplikacja hosta VST System Link.

UWAGA
Możesz zainwestować w skrzynkę rozdzielczą KVM (klawiatura, wideo, mysz). Dzięki temu 
można używać tej samej klawiatury, monitora i myszy do sterowania każdym komputerem w 
systemie i bardzo szybko przełączać się między komputerami.

Konfigurowanie VST System Link (łącza systemowego VST)

Aby móc pracować z VST System Link, należy najpierw skonfigurować sieć, skonfigurować 
sprzęt audio i skonfigurować cyfrowe połączenia audio.

Sekcja VST System Link (Łącza systemu VST)
Sekcja VST System Link umożliwia skonfigurowanie VST System Link.

● Aby otworzyć sekcję VST System Link, wybierz Studio > Studio Setup (Studio > Konfiguracja
   studia i wybierz VST System Link na liście Devices (Urządzenia).
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Active (Aktywne)
      Aktywuje łącze systemowe VST.
Online (Na linii)
      Przełącza komputer w tryb online.
ASIO Input (Wejście ASIO)
      Umożliwia zdefiniowanie sieciowego kanału wejściowego.
ASIO Output (Wyjście ASIO)
      Umożliwia zdefiniowanie sieciowego kanału wyjściowego.
Use Selected ASIO Ports for Data only (Używaj wybranych portów ASIO tylko do przesyłania 
danych)
      Aktywuj tę opcję, jeśli chcesz przeznaczyć większą przepustowość na MIDI i wysyłać  
      informacje VST System Link na całym kanale. Ten kanał nie będzie już dostępny do 
      przesyłania dźwięku.
Offset Samples (Próbki offsetowe)
      Umożliwia ustawienie offsetu dla komputera, dzięki czemu gra on nieco przed lub za resztą.
Transfer Bits (Przenieś bity)
      Umożliwia określenie, czy chcesz przesyłać 24, czy 16 bitów. Dzięki temu można używać 
      starszych kart dźwiękowych, które nie obsługują transferu 24 bitów.
MIDI Inputs (Wejścia MIDI)
      Umożliwia ustawienie liczby portów wejściowych MIDI.
MIDI Outputs (Wyjścia MIDI)
      Umożliwia ustawienie liczby portów wyjściowych MIDI.
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Self test (Autotest)
      Umożliwia przetestowanie sieci.
Receiving (Otrzymujący)
      Świeci się, jeśli komputer jest aktywny.
Sending (Wysyłanie)
      Świeci się, jeśli komputer jest aktywny.
List (Lista)
      Pokazuje nazwę każdego komputera.

Konfigurowanie sieci
Sieć można skonfigurować łącząc komputery.

PROCEDURA
1. Za pomocą cyfrowego kabla audio połącz cyfrowe wyjście komputera 1 z cyfrowym wejściem  
    komputera 2.
    Jeśli masz więcej niż 2 komputery, dodawaj pozostałe jeden po drugim.
2. Za pomocą kabla połącz wyjście cyfrowe komputera 2 z wejściem cyfrowym komputera 1. VST 
    System Link to system łańcuchowy, co oznacza, że wyjście komputera 1 idzie do wejścia 
    komputera 2, a wyjście komputera 2 komputer 2 łączy się z wejściem komputera 3 i tak dalej w  
    całym łańcuchu. Wyjście ostatniego komputera w łańcuchu musi zawsze wrócić do wejścia 
    komputera 1, aby zakończyć pierścień.
UWAGA
Jeśli karta ma więcej niż jeden zestaw wejść i wyjść, wybierz ten, który Ci odpowiada – dla 
uproszczenia zazwyczaj najlepszy jest pierwszy zestaw.

Konfigurowanie Audio Clock (Zegara audio)
Aby móc korzystać z VST System Link, sygnały zegara na kartach ASIO muszą być poprawnie 
zsynchronizowane.

WARUNEK WSTĘPNY
Dla każdego komputera w sieci muszą obowiązywać następujące zasady:
● W oknie dialogowym Studio Setup (Ustawienia programu Studio) został wybrany właściwy 
   sterownik audio.
● Tryb zegara lub tryb synchronizacji konfiguruje się w panelu sterowania ASIO sprzętu audio.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz sprzęt audio.
3. Kliknij Control Panel (Panel sterowania).
4. Ustaw jeden sprzęt audio jako główny zegar, a wszystkie pozostałe karty jako podrzędne zegara. 
    W razie potrzeby zapoznaj się z dokumentacją.

WAŻNE
Jeśli ustawisz więcej niż jedną kartę jako master zegara, sieć nie będzie działać poprawnie. Jeśli 
jednak korzystasz np. z zewnętrznego zegara z cyfrowego miksera lub specjalnego synchronizatora 
Word Clock, musisz pozostawić wszystkie karty ASIO w trybie clock slave lub AutoSync 
i upewnić się, że każda z nich nasłuchuje sygnału pochodzącego z synchronizatora. Sygnał ten jest 
zwykle przepuszczany przez kable ADAT lub złącza Word Clock w sposób łańcuchowy.
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WYNIK
Zwykle panel sterowania ASIO karty dźwiękowej zawiera informacje o tym, czy karta odbiera 
prawidłowy sygnał synchronizacji, łącznie z częstotliwością próbkowania tego sygnału. To dobry 
znak, że karty zostały podłączone i prawidłowo skonfigurowana synchronizacja zegara. 
Szczegółowe informacje można znaleźć w dokumentacji sprzętu audio.

POWIĄZANE LINKI
Wybieranie sterownika audio na stronie 16
Strona konfiguracji sterownika ASIO na stronie 19

Dopasowywanie rozmiaru bufora
W sieci VST System Link dostosowanie rozmiaru bufora w celu zminimalizowania opóźnień jest 
niezwykle ważne. Wynika to z faktu, że opóźnienie sieci VST System Link to całkowite 
opóźnienie wszystkich kart ASIO w systemie zsumowanych.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz sprzęt audio.
3. Kliknij Control Panel (Panel sterowania).
4. Zmniejsz rozmiar buforów.
    Im mniejszy rozmiar bufora, tym mniejsze opóźnienie. Najlepiej jest zachować dość małe 
    rozmiary buforów, jeśli Twój system sobie z tym poradzi. Zwykle dobrym pomysłem jest czas 
    około 12 ms lub mniej.

WAŻNE
Opóźnienie nie wpływa na synchronizację, ale może mieć wpływ na czas potrzebny na wysyłanie 
i odbieranie sygnałów MIDI i audio lub powodować spowolnienie systemu.

Ustawienia sprzętu audio wpływające na łącze systemowe VST
Specyficzne ustawienia sprzętu audio mogą zmienić informacje cyfrowe w sposób wpływający na 
prawidłowe funkcjonowanie VST System Link (Łącza systemowego VST).

Ustawienia te znajdziesz w panelu sterowania lub w dodatkowej aplikacji dla swojego sprzętu 
audio. Upewnij się, że spełnione są następujące warunki:

● Wszelkie dodatkowe ustawienia formatu portów cyfrowych używanych do transmisji danych     
   VST System Link (Łącze sytemowe VST) muszą być wyłączone. Jeśli na przykład używasz 
   połączenia S/PDIF dla łącza VST System Link, wyłącz Professional format (format 
   profesjonalny), Emphasis (uwypuklenie) i dithering.
● Jakakolwiek aplikacja miksera w sprzęcie audio, która pozwala na regulację poziomu cyfrowych 
   wejść i wyjść, musi być wyłączona. Alternatywnie można ustawić poziomy kanałów VST System
   Link na ±0dB.
● Cyfrowe przetwarzanie sygnału, takie jak panorama lub efekty, musi być wyłączone dla sygnału 
   VST System Link.
● W przypadku sprzętu audio RME Audio Hammerfall DSP wybierz domyślne lub zwykłe 
   ustawienie wstępne dla funkcji Totalmix.

W przeciwnym razie mogą wystąpić pętle sygnału i VST System Link (Łącze systemowe VST) nie
będzie działać.
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Konfigurowanie częstotliwości próbkowania
Wszystkie projekty na wszystkich komputerach muszą być ustawione na tę samą częstotliwość 
próbkowania.

PROCEDURA
1. Wybierz Project > Project Setup (Projekt > Ustawienia projektu).
2. W sekcji Project Time Displays (Wyświetlanie czasu projektu otwórz wyskakujące menu   
    Sample Rate (Częstotliwość próbkowania) i wybierz częstotliwość próbkowania.

Konfigurowanie cyfrowych połączeń audio

PROCEDURA
1. Wybierz Studio > Audio Connections (Studio > Połączenia audio).
2. Kliknij kartę Inputs (Wejścia) i kliknij opcję Add Bus (Dodaj magistralę).
3. W oknie dialogowym Add Input Bus (Dodaj magistralę wejściową) skonfiguruj magistralę.
4. Kliknij opcję Add Bus (Dodaj magistralę).
5. Kliknij kartę Outputs (Wyjścia) i kliknij opcję Add Bus.
6. W oknie dialogowym Add Output Bus (Dodaj magistralę wyjściową) skonfiguruj magistralę.
7. Kliknij opcję Add Bus.
8. Powtórz te kroki dla wszystkich aplikacji.
    Skonfiguruj tę samą konfigurację we wszystkich aplikacjach. Jeśli masz 4 szyny wyjściowe 
    stereo na komputerze 1, potrzebujesz 4 szyn wejściowych stereo na komputerze 2 itd.
9. Skieruj aplikacje do wejść i wyjść cyfrowych.

POWIĄZANE LINKI
Konfiguracja magistrali audio na stronie 22
Okno Połączenia audio na stronie 26

Sprawdzanie połączenia cyfrowego

PROCEDURA
1. Podłącz źródło dźwięku do interfejsu audio.
2. Rozpocznij nagrywanie, odtwarzanie i miksowanie.
3. Na komputerze 1 odtwórz dźwięk.
4. Wybierz Studio > MixConsole i skieruj kanał zawierający materiał audio do jednej z cyfrowych 
    szyn wyjściowych.
5. Na komputerze 2 wybierz Studio > MixConsole i zlokalizuj odpowiednią cyfrową szynę 
    wejściową. Odtwarzany dźwięk powinien teraz pojawić się w aplikacji działającej na 
    komputerze 2, a wskaźniki poziomu szyny wejściowej powinny się poruszyć.

WYNIK
Teraz sprawdziłeś, że połączenie cyfrowe działa tak, jak powinno. Można odwrócić tę procedurę, 
tak aby komputer 2 odtwarzał, a komputer 1 słuchał.
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Aktywacja VST System Link (Łącza systemowego VST)
Aby móc współpracować z VST System Link, musisz aktywować VST System Link na 
wszystkich komputerach w sieci.

PROCEDURA
1. Wybierz opcję Transport > Project Synchronization Setup (Transport > Konfiguracja 
    synchronizacji projektu) i na karcie Sources (Źródła) aktywuj łącze VST System Link jako 
    źródło kodu czasowego.
2. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
3. Na liście Devices (Urządzenia) wybierz opcję VST System Link.

               

4. Użyj wyskakujących menu ASIO Input (Wejście ASIO) i ASIO Output (Wyjście ASIO), aby 
    określić, który kanał jest kanałem sieciowym przesyłającym informacje o VST System Link 
    (łączu systemowym VST).
UWAGA
Sygnał sieciowy jest przesyłany tylko na jednym bicie jednego kanału. W przypadku systemu 
opartego na ADAT do połączenia sieciowego będzie używanych 7 kanałów 24-bitowego dźwięku i 
1 kanał 23-bitowego dźwięku. Na tym kanale nadal będziesz mieć zapas około 138 dB.
5. Aktywuj Active (Aktywny) w lewym górnym rogu konfiguracji VST System Link.
6. Powtórz kroki dla każdego komputera w sieci.

WYNIK
Wskaźniki wysyłania i odbierania na każdym aktywnym komputerze migają, a nazwa każdego 
komputera pojawia się na liście w sekcji Self Test (Autotest) okna dialogowego. Każdemu 
komputerowi przypisany jest losowy numer.
Nazwa zostanie wyświetlona w oknie VST System Link każdego komputera w sieci. Możesz 
kliknąć dwukrotnie nazwę komputera i wprowadzić inną nazwę.
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UWAGA
Jeśli nie widzisz nazwy każdego komputera, wykonaj ponownie powyższą procedurę i upewnij się, 
że wszystkie karty ASIO prawidłowo odbierają sygnały zegara cyfrowego i że każdy komputer ma 
odpowiednie wejścia i wyjścia przypisane do sieci VST System Link (Łącze systemowe VST).

POWIĄZANE LINKI
Strona Sources (Źródła) na stronie 1079

Udostępnianie komputerów sieciowych w trybie online
Należy ustawić komputery sieciowe w trybie online, aby mogły wysyłać i odbierać sygnały 
transportu i kodu czasowego oraz aby można było uruchamiać i zatrzymywać ich aplikacje 
sekwencyjne.

WARUNEK WSTĘPNY
Wszystkie komputery mają ustawione tempo na tę samą wartość.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz opcję VST System Link.
3. Aktywuj Online.
4. Powtórz tę czynność dla każdego komputera w sieci.

WYNIK
Komputery są teraz online.

PO ZAKOŃCZENIU TEGO ZADANIA
Rozpocznij odtwarzanie na jednym komputerze, aby sprawdzić, czy system działa i czy wszystkie 
komputery uruchamiają się i grają idealnie w odpowiednim czasie.
VST System Link wysyła i rozumie wszystkie polecenia transportowe. Dzięki temu można 
sterować całą siecią z jednego komputera. Jednakże każdy komputer może sterować dowolnymi 
pozostałymi. Wynika to z faktu, że VST System Link jest siecią typu peer-to-peer i nie ma 
absolutnego komputera nadrzędnego.

Aktywacja portów MIDI dla łącza systemowego VST
Możesz aktywować porty wejściowe i wyjściowe MIDI dla VST System Link. Umożliwia to 
kierowanie ścieżek MIDI do instrumentów VST działających na innym komputerze.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz opcję VST System Link (Łącze systemowe VST).
3. Określ liczbę potrzebnych portów MIDI, korzystając z pól wartości MIDI Inputs (Wejścia 
    MIDI) i MIDI Outputs (Wyjścia MIDI).
4. Utwórz ścieżkę MIDI.

    
    
    
    
    

WYNIK
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W górnej części Inspektora ścieżek MIDI wyskakujące menu Input Routing (Routing wejściowy)  
i Output Routing (Routing wyjściowy) pokazują teraz określone porty VST System Link (łącza 
systemowego VST).
Umożliwia to kierowanie ścieżek MIDI do instrumentów VST działających na innym komputerze.

Przykłady aplikacji
VST System Link umożliwia dzielenie różnych zadań pomiędzy 2 lub więcej komputerami. 
Poniższe przykłady zastosowań powinny dać Ci wyobrażenie o tym, co jest możliwe.

Konfigurowanie Main Mix Computer (głównego komputera 
miksującego)
Skonfigurowanie jednego komputera jako głównego komputera miksującego, który odbiera dźwięk 
z innych komputerów, umożliwia miksowanie wewnętrzne w komputerze.

W poniższym przykładzie zakładamy, że używasz 2 komputerów: komputera 1 jako głównego 
komputera miksującego i komputera 2 dla 2 dodatkowych ścieżek audio stereo, ścieżki kanału FX z
wtyczką pogłosu i wtyczki instrumentu VST z wyjściami stereo.

PROCEDURA
1. Na komputerze 1 użyj nieużywanego zestawu wyjść, np. analogowego wyjścia stereo, do którego
    należy podłączyć sprzęt monitorujący, aby słuchać odtwarzanego dźwięku.
2. Na komputerze 2 poprowadź każdą z 2 ścieżek audio do osobnej szyny wyjściowej podłączonej 
    do wyjść cyfrowych, na przykład szyn 1 i 2.
3. Skieruj ścieżkę kanału FX do innej szyny VST System Link, na przykład szyny 3.
4. Skieruj kanał przyrządów VST do kolejnej magistrali, na przykład magistrali 4.
5. Na komputerze 1 sprawdź odpowiednie 4 szyny wejściowe VST System Link.
    Jeśli rozpoczniesz odtwarzanie na komputerze 2, dźwięk powinien pojawić się na szynach  
    wejściowych komputera 1. Jednak do miksowania tych źródeł dźwięku potrzebne są rzeczywiste 
    kanały miksera.
6. Dodaj 4 nowe ścieżki audio stereo na komputerze 1 i skieruj je do szyny wyjściowej, której   
    używasz do słuchania, np. analogowych wyjść stereo.
7. Dla każdej ścieżki audio wybierz jedną z 4 szyn wejściowych.
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    Teraz każda magistrala komputera 2 jest kierowana do oddzielnego kanału audio                           
    w komputerze 1.
8. Aktywuj monitorowanie dla 4 ścieżek.
WYNIK
Jeśli teraz rozpoczniesz odtwarzanie, dźwięk z komputera 2 zostanie przesłany na żywo do nowych 
ścieżek na komputerze 1, dzięki czemu będziesz mógł je usłyszeć razem ze wszystkimi utworami 
odtwarzanymi na komputerze 1.

PO ZAKOŃCZENIU TEGO ZADANIA
Jeśli zauważysz opóźnienie w przetwarzaniu podczas słuchania sygnałów pochodzących z innych 
komputerów podczas monitorowania, spróbuj wykonać poniższe czynności, aby zrekompensować 
problemy z opóźnieniami:
● Jeśli Twój sprzęt audio to obsługuje, aktywuj ASIO Direct Monitoring (Bezpośrednie    
   monitorowanie ASIO) na panelu urządzeń systemu audio dla swojego sprzętu.
● Alternatywnie otwórz okno dialogowe Studio Setup (Konfiguracja studia) i na stronie VST 
   System Link (Łącze systemowe VST) zmień wartość Offset Samples (Próbki offsetowe).

Konfigurowanie komputera jako submiksera
Jeśli masz więcej ścieżek audio niż szyn VST System Link, możesz użyć miksera komputerowego 
jako submiksera.

PROCEDURA
● Skieruj kilka kanałów audio do tej samej szyny wyjściowej i w razie potrzeby dostosuj poziom    
   szyny wyjściowej.
UWAGA
Jeśli Twoje karty dźwiękowe mają wiele zestawów złączy wejściowych i wyjściowych, możesz 
połączyć wiele kabli ADAT i przesyłać dźwięk za pośrednictwem dowolnej magistrali dowolnego 
kabla.

Kierowanie ścieżek MIDI do VST-ów na innych komputerach
Można kierować ścieżki MIDI z jednego komputera do instrumentów VST na innym komputerze. 
Dzięki temu można używać jednego komputera do odtwarzania i nagrywania, a drugiego jako 
stojaka VST - ów.

PROCEDURA
1. Nagraj ścieżkę MIDI na komputerze 1.
2. Po zakończeniu nagrywania skieruj wyjście MIDI tej ścieżki do portu 1 MIDI VST System 
    Link.
3. Na komputerze 2 otwórz okno VST Instruments i przypisz instrument do pierwszego gniazda w 
    stojaku.
4. Skieruj kanał instrumentu VST do żądanej szyny wyjściowej. Jeśli używasz komputera 1 jako 
    głównego komputera miksującego, będzie to jedna z szyn wyjściowych VST System Link 
    podłączona do komputera 1.
5. Utwórz nową ścieżkę MIDI w oknie Project komputera 2 i przypisz wyjście MIDI ścieżki do 
    utworzonego instrumentu VST.
6. Przypisz wejście MIDI ścieżki do portu VST System Link 1. Teraz ścieżka MIDI na 
    komputerze 1 jest kierowana do ścieżki MIDI na komputerze 2, która z kolei jest kierowana do 
    instrumentu VST.
7. Teraz aktywuj monitorowanie ścieżki MIDI na komputerze 2, aby słuchał i reagował na wszelkie
    przychodzące polecenia MIDI. W Cubase kliknij przycisk Monitor na liście ścieżek lub w 
    Inspektorze.
8. Rozpocznij odtwarzanie na komputerze 1.
    Wyśle teraz informacje MIDI o ścieżce do instrumentu VST załadowanego na komputerze 2.

WYNIK
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Nawet przy wolnym komputerze powinieneś być w stanie ułożyć w ten sposób całą masę 
dodatkowych instrumentów VST, znacznie poszerzając swoją paletę dźwiękową. Nie zapominaj, że
VST System Link MIDI jest również dokładny w zakresie próbek, a zatem ma znacznie ściślejsze 
taktowanie niż jakikolwiek inny sprzętowy interfejs MIDI, jaki kiedykolwiek wynaleziono!

Kierowanie wysyłek audio do innych komputerów
Wysyłane efekty dla kanału audio w Cubase mogą być kierowane albo na ścieżkę kanału FX, albo 
do dowolnej aktywowanej grupy lub szyny wyjściowej. Pozwala to na użycie oddzielnego 
komputera jako wirtualnego stojaka z efektami.

PROCEDURA
1. Na komputerze 2, maszynie, której będziesz używać jako stojaka na efekty, dodaj nową ścieżkę 
    audio stereo.
2. Dodaj żądany efekt jako efekt wstawiania do ścieżki.
3. W Inspektorze wybierz jedną z szyn VST System Link (Łącze systemowe VST) jako wejście 
    dla ścieżki audio.
4. Skieruj kanał do jednej z szyn wyjściowych VST System Link podłączonych do komputera 1.
5. Włącz monitorowanie ścieżki.
6. Wróć do komputera 1 i wybierz ścieżkę, do której chcesz dodać pogłos.
7. Otwórz stojak Sends (Wysyłki) dla ścieżki w Inspektorze lub MixConsole.
8. Otwórz menu podręczne Send Routing dla jednej z wysyłek i wybierz magistralę VST System 
    Link przypisaną do efektu.
9. Użyj suwaka Send (Wyślij), aby w zwykły sposób dostosować siłę efektu.

WYNIK
Sygnał zostanie przesłany do ścieżki na komputerze 2 i przetworzony poprzez efekt wstawiania, bez
użycia mocy procesora na komputerze 1.
Możesz powtórzyć powyższe kroki, aby dodać więcej efektów do wirtualnego stojaka efektów. 
Liczba dostępnych w ten sposób efektów jest ograniczona jedynie liczbą portów używanych w 
połączeniu VST System Link i wydajnością komputera 2.

Nagrywanie utworów na innych komputerach
Możesz nagrywać utwory na innym komputerze. Jest to przydatne, jeśli dysk twardy w jednym 
komputerze nie jest wystarczająco szybki, aby obsłużyć tyle ścieżek audio, ile potrzebujesz.

PROCEDURA
● Dodaj ściezki na innym komputerze i nagrywaj na nich.

WYNIK
Tworzy to wirtualny system RAID, w którym kilka dysków działa razem. Wszystkie ścieżki 
pozostaną ze sobą połączone tak samo mocno, jak gdyby wszystkie działały na tej samej maszynie.

Odtwarzanie wideo na innych komputerach
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Możesz odtwarzać wideo na innym komputerze, aby zwolnić zasoby do przetwarzania Audio 
i MIDI na głównym procesorze. Jest to przydatne, ponieważ odtwarzanie wideo o wysokiej 
rozdzielczości może dość obciążać procesor.

PROCEDURA
● Przenieś ścieżki wideo na inny komputer

WYNIK
Ponieważ wszystkie polecenia transportu odpowiadają na komputerach VST System Link (Łącze 
systemowe VST), przeglądanie wideo jest możliwe nawet wtedy, gdy pochodzi z innego 
komputera.
Podczas szorowania (scrubbing) odtwarzanie w połączonych systemach może nie być idealnie 
zsynchronizowane. Istnieją również pewne dalsze ograniczenia dotyczące szorowania za 
pośrednictwem łącza VST System Link:
● Zawsze używaj systemu, od którego zacząłeś szorowanie, aby kontrolować szorowanie.
   Zmiana prędkości szorowania w systemie zdalnym spowoduje zmianę tylko prędkości w systemie
   lokalnym.
● Możesz rozpocząć odtwarzanie na wszystkich systemach.
   Spowoduje to zatrzymanie czyszczenia i rozpoczęcie odtwarzania zsynchronizowanego na 
   wszystkich systemach.
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Video
Cubase umożliwia pracę z treściami wideo.

Możesz odtwarzać pliki wideo w różnych formatach i za pośrednictwem różnych urządzeń 
wyjściowych z poziomu Cubase, wyodrębniać materiał audio z pliku wideo i edytować muzykę do 
wideo.
Funkcja eksportu wideo umożliwia udostępnianie filmów klientom lub innym użytkownikom.

WAŻNE
Filmy eksportowane są w rozdzielczości 1920x1080px (Full HD). Pliki wideo o rozdzielczości 
niższej lub wyższej niż Full HD są podczas eksportu skalowane w górę lub w dół.

POWIĄZANE LINKI
Zgodność plików wideo na stronie 1097
Importowanie plików wideo na stronie 1099
Przygotowania do odtwarzania wideo na stronie 1101
Eksportuj wideo na stronie 1105
Wyodrębnianie dźwięku z wideo na stronie 1108

Zgodność plików wideo
Pracując nad projektem obejmującym plik wideo, musisz upewnić się, że typ pliku wideo działa w 
Twoim systemie Cubase.

UWAGA
Jeśli nie możesz odtworzyć określonego pliku wideo, użyj zewnętrznej aplikacji, aby 
przekonwertować plik na zgodny format.

Aby dowiedzieć się, które pliki wideo są obsługiwane, przejdź do obszaru pomocy na stronie 
steinberg.net.

POWIĄZANE LINKI
Kodeki na stronie 1098

Formaty kontenerów wideo
Pliki wideo i inne pliki multimedialne są dostępne w formacie kontenera.

Kontener ten przechowuje różne strumienie informacji, w tym wideo i audio, ale także metadane, 
takie jak informacje o synchronizacji wymagane do jednoczesnego odtwarzania audio i wideo. 
Dane dotyczące dat utworzenia, autorów, oznaczeń rozdziałów i inne mogą być również 
przechowywane w formacie kontenera.

Cubase obsługuje następujące formaty kontenerów:

MOV
      To jest film QuickTime.
MPEG-4
      Ten format może zawierać różne metadane do przesyłania strumieniowego, edycji, odtwarzania 
      lokalnego i wymiany treści. Jego rozszerzenie to .mp4.
AVI
      Jest to format kontenera multimedialnego wprowadzony przez firmę Microsoft.
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Kodeki
Kodeki to metody kompresji danych stosowane w celu zmniejszania plików wideo i audio i 
ułatwiania nimi zarządzania komputerami.
Dalsze szczegóły można znaleźć w obszarze wsparcia na stronie steinberg.net.

Frame Rates (Liczba klatek na sekundę)
Cubase obsługuje różne szybkości klatek wideo i filmowych.

Frame rate (speed) (Liczba klatek na sekundę (prędkość))
Niezależnie od systemu zliczania klatek, rzeczywista prędkość, z jaką płyną klatki wideo w czasie 
rzeczywistym, jest rzeczywistą szybkością klatek.

Cubase obsługuje następujące szybkości klatek:

23,98 fps
     Ta liczba klatek na sekundę jest używana w przypadku filmu przesyłanego do formatu wideo 
     NTSC i musi zostać spowolniona w przypadku przesyłania telecine 2-3 pull-down. Jest również 
     używany w przypadku wideo HD określanego jako 24p.
24 fps
     Jest to rzeczywista prędkość standardowych kamer na kliszę.
24,98 fps
     Ta liczba klatek na sekundę jest powszechnie stosowana w celu ułatwienia przesyłania pomiędzy
     źródłami wideo i filmowymi w systemie PAL i NTSC. Służy głównie do kompensacji jakiegoś 
     błędu.
25 fps
     Jest to liczba klatek na sekundę wideo w systemie PAL.
29,97 fps/29,97 dfps
     Jest to liczba klatek na sekundę wideo NTSC. Liczba może być non-drop-frame lub drop-frame.
30 fps/30 dfps
     Ta liczba klatek na sekundę nie jest już standardem wideo, ale jest powszechnie stosowana przy 
     nagrywaniu muzyki. Wiele lat temu był to czarno-biały standard transmisji NTSC. Jest to 
     równoznaczne z przyspieszeniem wideo NTSC do szybkości filmu po przesłaniu 3 telecine. 
     Liczba może być non-drop-frame lub drop-frame.
50 fps
     Stawka ta jest również określana jako 50 pensów.
59,94 fps
     Ta częstotliwość klatek wideo jest obsługiwana przez kamery wysokiej rozdzielczości i jest 
     zgodna z systemem NTSC.
60 fps
     Ta częstotliwość klatek wideo jest obsługiwana przez wiele kamer wysokiej rozdzielczości. 
     Jednak liczba klatek na sekundę zgodna z NTSC wynosząca 59,94 kl./s jest znacznie bardziej 
     powszechna.

WAŻNE
Formaty wideo ze zmienną liczbą klatek na sekundę (VFR) nie są obsługiwane.
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Urządzenia wyjściowe wideo
Cubase obsługuje kilka urządzeń wyjściowych wideo.

Wyświetlanie plików wideo na ekranie w oknie Video Player (Odtwarzacza wideo) może działać 
dobrze w wielu aplikacjach, ale często konieczne jest wyświetlanie wideo w dużym formacie, aby 
wyświetlić drobne szczegóły, aby inne osoby biorące udział w sesji mogły również zobaczyć 
wideo. W tym celu Cubase umożliwia wykorzystanie kilku typów urządzeń wyjściowych wideo.

Dedykowane karty graficzne
Możesz użyć dedykowanej karty graficznej. Wideo jest wysyłane bezpośrednio na wyjście tego 
urządzenia wideo.

Obsługiwane są następujące karty graficzne:
● Blackmagic Design video output devices 

WAŻNE
● Musisz zainstalować odpowiedni sterownik dla urządzenia wideo i ustawić wyjście karty 
graficznej na rozdzielczość pliku wideo zastosowaną w Twoim projekcie.
● Wyjście wideo poprzez FireWire nie jest obsługiwane.

POWIĄZANE LINKI
Strona odtwarzacza wideo na stronie 1101.

Przygotowania do tworzenia projektów wideo
Zanim zaczniesz pracować z wideo w Cubase, należy poczynić pewne podstawowe przygotowania.
W Cubase możesz pracować z wieloma plikami wideo w różnych formatach na tej samej ścieżce 
wideo.

UWAGA
Aby zapewnić prawidłową synchronizację zdarzeń audio i wideo, upewnij się, że częstotliwość 
klatek projektu jest zgodna z szybkością klatek pliku wideo.

POWIĄZANE LINKI
Okno dialogowe Project Setup (Ustawienia projektu) na stronie 104

Importowanie plików wideo
Jeżeli posiadasz zgodny plik wideo, możesz zaimportować go do swojego projektu.

PROCEDURA
1. Wybierz opcję File > Import > Video File (Plik > Importuj > Plik wideo).
2. W oknie dialogowym Import Video (Importuj wideo) wybierz plik wideo, który chcesz 
    zaimportować.
3. Opcjonalnie: Aktywuj opcję Extract Audio from Video (Wyodrębnij dźwięk z wideo), aby 
    zaimportować dowolne osadzone strumienie audio.
4. Kliknij Open (Otwórz).

WYNIK
Cubase tworzy ścieżkę wideo ze zdarzeniem wideo. Jeśli aktywowano opcję Extract Audio from 
Video (Wyodrębnij dźwięk z wideo), ścieżka audio ze zdarzeniem audio zostanie umieszczona pod 
ścieżką wideo. Odpowiedni klip audio zostanie zapisany w folderze Pool Record.
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UWAGA
Możesz także importować pliki wideo, przeciągając je z MediaBay, File Explorer/macOS Finder 
i upuszczając je w projekcie. Jeśli chcesz, aby Cubase automatycznie wyodrębniał dźwięk, aktywuj 
opcję Extract Audio on Import Video File (Wyodrębnij dźwięk podczas importowania pliku 
wideo) w oknie dialogowym Preferences (Preferencje) (strona Video).

POWIĄZANE LINKI
Pool (Pula) na stronie 610
Wyodrębnianie Audio z wideo na stronie 1108

Przyjęcie szybkości klatek projektu
Aby mieć pewność, że wyświetlanie czasu w Cubase odpowiada rzeczywistej liczbie klatek wideo, 
należy ustawić liczbę klatek projektu na liczbę klatek na sekundę importowanego pliku wideo.

WARUNEK WSTĘPNY
Liczba klatek na sekundę importowanego pliku wideo różni się od szybkości klatek projektu

              

PROCEDURA
1. Wybierz Project > Project Setup (Projekt > Ustawienia projektu).
2. W oknie dialogowym Project Setup (Ustawienia projektu) kliknij opcję Get Frame Rate from 
    Vdeo (Pobierz liczbę klatek na sekundę z wideo).
3. Kliknij OK.

WYNIK
● Jeśli Cubase obsługuje liczbę klatek na sekundę wideo, liczba klatek projektu zostanie do niego 
dostosowana. W razie potrzeby czas rozpoczęcia projektu jest automatycznie dostosowywany w 
celu odzwierciedlenia zmiany liczby klatek na sekundę.
Na przykład, jeśli szybkość klatek projektu zostanie przełączona z 30 fps na 29,97 fps, czas 
rozpoczęcia projektu zostanie przyjęty w taki sposób, aby wszystkie zdarzenia w projekcie 
pozostały na tych samych pozycjach w stosunku do czasu rzeczywistego.

UWAGA
Jeśli chcesz, aby godzina rozpoczęcia projektu pozostała taka sama, musisz ręcznie zmienić ją z 
powrotem. W takim przypadku należy przyciągnąć zdarzenie wideo do osi czasu, aby zapewnić 
odpowiednie umiejscowienie i synchronizację w projekcie.

Pliki Thumbnail Cache (pamięci podręcznej miniatur)

Dla każdego zaimportowanego pliku wideo Cubase automatycznie tworzy plik pamięci podręcznej 
miniatur.

POWIĄZANE LINKI
Ręczne generowanie plików pamięci podręcznej miniatur na stronie 1101
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Ręczne generowanie plików pamięci podręcznej miniatur
Można ręcznie generować pliki pamięci podręcznej miniatur. Jest to konieczne, jeśli podczas 
importowania nie można wygenerować pliku pamięci podręcznej miniatur, ponieważ folder jest 
chroniony przed zapisem lub plik był edytowany w zewnętrznej aplikacji do edycji wideo.

PROCEDURA
● Wykonaj jedną z następujących czynności:
      ● W Pool (Puli) kliknij plik wideo prawym przyciskiem myszy i wybierz opcję Generate 
         Thumbnail Cache (Generuj pamięć podręczną miniatur).
      ● W oknie Project wybierz zdarzenie wideo i wybierz Media > Generate Thumbnail Cache 
         (Media > Generuj pamięć podręczną miniatur).

UWAGA
Możesz odświeżyć już istniejące pliki pamięci podręcznej miniatur z poziomu Pool (puli).

WYNIK
Plik pamięci podręcznej miniatur jest generowany w tle, dzięki czemu możesz kontynuować pracę z
Cubase.

Przygotowania do odtwarzania wideo
Możesz odtwarzać zaimportowane pliki wideo z poziomu Cubase, korzystając z elementów 
sterujących transportem.
Aby to zadziałało, musisz aktywować i skonfigurować urządzenie wyjściowe wideo.

WAŻNE
Twoja karta graficzna musi obsługiwać OpenGL 2.0 lub nowszy.

Strona Video Player (Odtwarzacza wideo)
Strona konfiguracji Video Player w oknie dialogowym Studio Setup (Ustawienia studia) 
umożliwia skonfigurowanie odtwarzacza wideo i sprawdzenie, czy sprzęt wideo umożliwia 
odtwarzanie wideo z poziomu Cubase.
● Aby otworzyć stronę Video Player, wybierz Studio > Studio Setup (Studio > Konfiguracja 
studia i aktywuj Video Player (Odtwarzacz wideo) na liście Devices (Urządzenia).

                        

Wyświetlane są następujące opcje:
Device (Urządzenie)
      Wyświetla listę urządzeń wyjściowych wideo dostępnych w systemie.
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Format
      Umożliwia wybór formatu wyjściowego.

UWAGA
Urządzenie Onscreen Window obsługuje tylko stały format.

Offset (Przesunięcie)
      Jeśli obraz wideo nie jest zgodny z dźwiękiem, możesz wprowadzić wartość przesunięcia w 
      milisekundach, aby określić, o ile wcześniej wideo powinno zostać dostarczone. To kompensuje
      opóźnienie wyświetlania. Przesunięcie jest używane tylko podczas odtwarzania. Jest 
      zapisywany globalnie dla każdego urządzenia wyjściowego i jest niezależny od projektu.
Active (Aktywny)
      Umożliwia aktywację urządzenia, którego chcesz używać do odtwarzania wideo.
Show Timecode (Pokaż kod czasowy)
      Umożliwia pokazanie kodu czasowego.
Position (Pozycja)
      Umożliwia określenie pozycji wyświetlania kodu czasowego.

Aktywacja urządzenia wyjściowego wideo

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) aktywuj Video Player (Odtwarzacz wideo).
    Dostępne urządzenia wyjściowe wideo są wymienione w kolumnie Urządzenie.
3. W kolumnie Active (Aktywne) zaznacz pole wyboru przy urządzeniu, którego chcesz używać do 
    odtwarzania wideo.

UWAGA
Jeśli nie masz podłączonego urządzenia zewnętrznego, możesz skorzystać z urządzenia Onscreen 
Window, które umożliwia odtwarzanie pliku wideo na monitorze komputera.

POWIĄZANE LINKI
Urządzenia wyjściowe wideo na stronie 1099

Okno Video Player (Odtwarzacza wideo)
Okno Video Player udostępnia różne opcje rozmiaru odtwarzania wideo na ekranie komputera. 
Jednak im większy rozmiar okna i im wyższa rozdzielczość wideo, tym większe jest obciążenie 
procesora.

● Aby otworzyć okno Video Player (Odtwarzacza wideo), wybierz Studio > Video Player 
   (Studio > Odtwarzacz wideo).
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Fullscreen Mode (Pełny ekran)
     Ustawia okno w tryb pełnoekranowy. Aby wyjść z trybu pełnoekranowego, otwórz menu 
     kontekstowe i wybierz opcję Exit Fullscreen Mode (Wyjdź z trybu pełnoekranowego) lub 
     naciśnij klawisz Esc.
Quarter Size (Rozmiar ćwiartki)
     Zmniejsza okno do jednej czwartej rzeczywistego rozmiaru.
Half Size (Pół rozmiaru)
     Zmniejsza okno do połowy rzeczywistego rozmiaru.
Actual Size (Rzeczywisty rozmiar)
     Ustawia okno na rozmiar wideo.
Double Size (Podwójny rozmiar)
     Powiększa okno dwukrotnie w stosunku do rzeczywistego rozmiaru.
Aspect Ratio (Współczynnik proporcji)
Możesz także przeciągnąć krawędzie okna Video Player (Odtwarzacza wideo), aby zmienić jego 
rozmiar. Może to jednak prowadzić do zniekształcenia obrazu. Aby temu zapobiec, możesz ustawić 
opcję w wyskakującym menu Aspect Ratio (Współczynnik proporcji).

● Jeśli wybierzesz opcję None (Brak), proporcje obrazu wideo nie zostaną zachowane podczas 
   zmiany rozmiaru okna. Obraz zostanie powiększony/zmniejszony tak, aby zajmował całe okno 
   Odtwarzacza wideo.
● Internal (Wewnętrzne) umożliwia swobodną zmianę rozmiaru okna przy zachowaniu proporcji 
   obrazu wideo. Wokół obrazu wideo mogą zostać wyświetlone obramowania w celu wypełnienia 
   okna.
● External (Zewnętrzne) umożliwia zmianę rozmiaru okna w pewnych granicach, tak aby obraz 
   wideo zawsze wypełniał całe okno i zachowywał jego proporcje.
● UWAGA
   W trybie pełnoekranowym proporcje obrazu wideo są zawsze zachowywane.
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Scrubbing Video (Przewijanie wideo)
Możesz przewijać zdarzenia wideo, czyli odtwarzać je do przodu lub do tyłu.

PROCEDURA
1. Wybierz  Studio > Video Player (Studio > Odtwarzacz wideo).
2. Wykonaj jedną z następujących czynności:
      ● Kliknij w oknie Video Player (Odtwarzacza wideo) i przesuń mysz w lewo lub w prawo.
      ● Użyj pokrętła jog na pilocie zdalnego sterowania.

Edycja wideo
Zdarzenia wideo są tworzone automatycznie po zaimportowaniu pliku wideo.

Podczas pracy ze zdarzeniami wideo obowiązują następujące zasady:
● Możesz przeglądać i edytować zdarzenia wideo w oknie Project. Zdarzenie wideo uruchamia 
   odtwarzanie odpowiedniego klipu wideo.
● Możesz kopiować i przycinać zdarzenia wideo. Możesz także zablokować zdarzenia wideo w 
   oknie Project.
● Nie można rysować, sklejać i wyciszać zdarzeń wideo, a także stosować zanikania lub 
   przenikania.

POWIĄZANE LINKI
Użyj trybu edycji wideo zgodnie z opisem na stronie 1104

Użyj trybu edycji wideo
Use Video Follows Edit Mode (Tryb edycji Użyj wideo podążającego) umożliwia edycję audio 
przy jednoczesnym uzyskiwaniu ciągłej informacji wizualnej na wyświetlaczu wideo.

Jeśli w menu Transport aktywujesz opcję Use Video Follows Edit Mode (Użyj trybu edycji wideo
podążającego), kursor projektu i wideo będą automatycznie podążać za każdą dokonaną edycją. 
Dzięki temu możesz natychmiast zobaczyć, gdzie w filmie odbywa się edycja.

Wyświetlacz wideo zapewnia wizualną informację zwrotną podczas następujących czynności:
● Wybór zakresów
● Edycja dźwięku
● Przenoszenie zdarzeń audio
● Przesuwanie zdarzeń audio lub wybranych zakresów
● Zmiana rozmiaru zdarzeń audio lub wybranych zakresów
● Korzystanie z narzędzia Time Warp (Zniekształcenie czasu)
● Regulacja uchwytów zanikania (fade) dźwięku

UWAGA
Use Video Follows Edit Mode (Użyj trybu edycji wideo podążającego) za wykorzystaniem punktu
przyciągania zdarzeń audio. Dostosowując punkt przyciągania, możesz dostosować się do pozycji 
audio znajdującej się w środku zdarzenia.

PRZYKŁAD
Dźwięk zatrzymującego się samochodu można łatwo zgrać w czasie, łącząc koniec dźwięku 
poślizgu z zatrzymywaniem się samochodu na nagraniu. Jeśli jednak samochód po wpadnięciu w 
poślizg wpadnie w ramę, wyrównanie dźwięku może być bardzo trudne. W takim przypadku 
przesuń punkt przyciągania na koniec dźwięku poślizgu i włącz opcję Use Video Follows Edit 
Mode (Użyj trybu edycji śledzenia wideo), aby dopasować ten punkt do zatrzymanego samochodu 
na ekranie.
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POWIĄZANE LINKI
Punkt przyciągania na stronie 528
Edycja tempa i metrum na stronie 1023

Export Video (Export Video)
Możesz wyeksportować plik wideo ze swojego projektu. Dzięki temu możesz na przykład 
udostępniać sekcje wyników pośrednich lub gotowych filmów klientom lub innym użytkownikom.

Funkcja Export Video eksportuje sygnał wideo i dźwięk stereo zawarty pomiędzy lewym i prawym
lokalizatorem. Dzięki temu możesz wyeksportować konkretny zakres lub cały projekt poprzez 
odpowiednie ustawienie lokalizatorów.

Filmy są eksportowane w następującym formacie:
● Format kontenera: MP4
● Kodek kompresji wideo: H.264 bez długich grup obrazów (Long GOP).
● Rozdzielczość: 1920x1080px (Full HD)

WAŻNE
Wideo o rozdzielczości niższej lub wyższej niż Full HD jest podczas eksportu skalowane w górę 
lub w dół.

● Liczba klatek na sekundę: Taka sama jak liczba klatek na sekundę w projekcie
● Kodek kompresji dźwięku: AAC
● Częstotliwość próbkowania: Taka sama jak częstotliwość próbkowania projektu

WAŻNE
Eksport wideo obsługuje tylko częstotliwości próbkowania 44,1 kHz i 48 kHz.

● Głębia bitowa: 16 bitów

Do wyeksportowanego pliku wideo można dodać wyłącznie kanał wyjściowy stereo. Zalecamy 
skierowanie wszystkich kanałów mono, stereo lub wielokanałowych, które chcesz wyeksportować 
do kanału wyjściowego stereo za pomocą funkcji wysyłania, i wybranie tego kanału wyjściowego w
oknie dialogowym Export Video (Eksport wideo).

POWIĄZANE LINKI
Okno dialogowe Eksportuj wideo na stronie 1105
Eksportowanie plików wideo na stronie 1107

Okno dialogowe Export Video (Eksport wideo)

Okno dialogowe Export Video udostępnia ustawienia umożliwiające eksport pliku wideo z 
projektu.

● Aby otworzyć okno dialogowe Export Video, wybierz File > Export > Video (Plik > Eksportuj  
   > Wideo).

Okno dialogowe Export Video jest podzielone na kilka sekcji.
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File Location (Lokalizacja pliku)
File Name (Nazwa pliku)
      Umożliwia określenie nazwy eksportowanego pliku wideo.
File Path (Ścieżka pliku)
      Umożliwia określenie ścieżki eksportowanego pliku wideo.
      Kliknij Path Options (Opcje ścieżki), aby otworzyć menu podręczne z opcjami ścieżki pliku:
      ● Choose (Wybierz) otwiera Eksplorator plików/wyszukiwarkę macOS, umożliwiając 
         przeglądanie lokalizacji plików.
      ● Recent Paths (Ostatnie ścieżki) umożliwia wybranie ostatnio wybranych lokalizacji plików.
      ● Clear Recent Paths (Wyczyść ostatnie ścieżki) umożliwia usunięcie wszystkich ostatnio 
         wybranych lokalizacji plików.

Video Settings (Ustawienia wideo)
Video Format (Format wideo)
      Pokazuje format eksportowanego pliku wideo.
Add Timecode (Dodaj kod czasowy)
      Dodaje kod czasowy projektu do wyeksportowanego pliku wideo.

Audio Settings (Ustawienia dźwięku)
Channel Selection (Wybór kanału)
      Umożliwia wybór kanału wyjściowego stereo do eksportu. Uwzględniane są ustawienia    
      MixConsole i efekty wstawiania.
Realtime Export (Eksport w czasie rzeczywistym)
      Umożliwia eksport miksu audio w czasie rzeczywistym. Eksport w czasie rzeczywistym 
      zajmuje co najmniej tyle samo czasu, co zwykłe odtwarzanie. Aktywuj tę opcję, jeśli używasz 
      zewnętrznych efektów lub instrumentów lub jeśli używasz wtyczek VST, które wymagają czasu
      na poprawną aktualizację podczas miksowania. Więcej informacji można znaleźć w 
      dokumentacji poszczególnych wtyczek.
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UWAGA
● Jeśli eksportujesz zewnętrzne efekty lub instrumenty w czasie rzeczywistym, musisz je także 
   aktywować.
   Monitor (Monitoruj) odpowiednie kanały audio.
● Realtime Export (Eksport w czasie rzeczywistym) wpływa tylko na eksport audio. Film jest 
   przetwarzany normalnie.

Export Range (Zakres eksportu)
   W tej sekcji znajdują się informacje o wyeksportowanym zakresie lokalizatorów.
File Information (Informacje o pliku)
   W tej sekcji znajdują się szczegółowe informacje na temat eksportowanego pliku wideo.
General Options (Opcje ogólne)
   W dolnej części dostępne są następujące opcje:
   Keep Dialog Open (Pozostaw okno dialogowe otwarte)
          Aktywuj tę opcję, aby okno dialogowe pozostało otwarte po kliknięciu Export Video 
          (Eksportuj wideo).
   Export Video (Eksportuj wideo)
          Umożliwia eksportowanie wideo zgodnie z określonymi ustawieniami.

POWIĄZANE LINKI
Eksport wideo na stronie 1105

Eksportowanie plików wideo
Możesz wyeksportować wideo zawierające sygnał audio stereo całego projektu lub określonego 
zakresu jako plik wideo MP4.

WARUNEK WSTĘPNY
● Częstotliwość próbkowania projektu jest ustawiona na 44,1 kHz lub 48 kHz.
● Jeśli chcesz eksportować zewnętrzne sygnały audio, aktywowałeś Monitor dla odpowiedniego 
   kanału.

PROCEDURA
1. Ustaw lewy i prawy lokalizator tak, aby obejmował sekcję, którą chcesz wyeksportować.
2. Skonfiguruj dźwięk w swoim projekcie tak, aby odtwarzał się tak, jak chcesz.

UWAGA
Do wyeksportowanego pliku wideo można dodać wyłącznie kanał wyjściowy stereo. Zalecamy 
przekierowanie wszystkich kanałów mono, stereo lub wielokanałowych, które chcesz 
wyeksportować do kanału wyjściowego stereo za pomocą funkcji wysyłania.

3. Wybierz opcję File > Export > Video (Plik > Eksportuj > Wideo).
4. W oknie dialogowym Export Video (Eksport wideo) wybierz kanał wyjściowy stereo, który 
    chcesz wyeksportować.

UWAGA
Upewnij się, że wybrany kanał wyjściowy zawiera całe audio, które chcesz użyć w eksportowanym 
pliku. Na przykład wyłącz kanały, które chcesz wyeksportować, lub wycisz kanały, których nie 
chcesz eksportować.

5. Wprowadź dalsze ustawienia eksportu.
6. Kliknij opcję Export Video (Eksportuj wideo)

1120



WYNIK
Plik wideo zostanie wyeksportowany.

POWIĄZANE LINKI
Okno dialogowe Export Video (Eksportuj wideo) na stronie 1105

Wyodrębnianie dźwięku z wideo
Podczas importowania możesz wyodrębnić strumień audio z pliku wideo.

PROCEDURA
1. Wykonaj jedną z następujących czynności:
      ● Wybierz opcję File > Import > Audio from Video File (Plik > Importuj > Audio z pliku 
          wideo).
         Spowoduje to utworzenie klipu audio w puli, ale nie spowoduje dodania żadnych zdarzeń do 
         okna Project.
      ● Wybierz opcję Media > Extract Audio from Video File (Multimedia > Wyodrębnij dźwięk 
          z pliku wideo).
2. W oknie dialogowym wybierz plik wideo i kliknij Open (Otwórz).
3. W oknie dialogowym Import Options (Opcje importu) wybierz żądane opcje importu.

WYNIK
Wyodrębniony strumień audio jest dodawany do projektu na nowej ścieżce audio i można go 
edytować jak każdy inny materiał audio.

POWIĄZANE LINKI
Pool (Pula) na stronie 610
O ustawieniach importowania plików audio na stronie 286
Importowanie plików wideo na stronie 1099

1121



Wymiana plików z innymi aplikacjami

Cubase obsługuje wiele formatów plików, których można używać do wymiany plików z innymi 
aplikacjami.

POWIĄZANE LINKI
Pliki OMF na stronie 1109
Pliki AAF na stronie 1113

OMF Files (Pliki OMF)
Open Media Framework Interchange (OMFI) to niezależny od platformy format pliku, który 
umożliwia przesyłanie multimediów cyfrowych między różnymi aplikacjami.

Cubase może importować i eksportować pliki OMF

Importowanie plików OMF

PROCEDURA
1. Wybierz opcję File > Import > OMF (Plik > Importuj > OMF).
2. W oknie dialogowym pliku wybierz plik OMF i kliknij Open (Otwórz).
3. Opcjonalnie: Jeśli projekt jest otwarty, wybierz, czy chcesz utworzyć nowy projekt.
    Jeśli wybierzesz No (Nie), plik OMF zostanie zaimportowany do bieżącego projektu.
4. W oknie dialogowym Import Options (Opcje importu) wybierz ścieżki, które chcesz 
    zaimportować i wprowadź zmiany.
5. Kliknij OK.
6. Opcjonalnie: Jeśli plik OMF zawiera informacje o zdarzeniu wideo, wybierz, czy chcesz 
    utworzyć znaczniki w pozycji początkowej zdarzeń wideo.

UWAGA
Możesz użyć tych znaczników jako odniesień do pozycji, jeśli chcesz ręcznie zaimportować pliki 
wideo.

WYNIK
Zostaną dodane zdarzenia audio zaimportowanego pliku OMF.

Okno dialogowe OMF Import Options (Opcje importu OMF)
Okno dialogowe OMF Import Options umożliwia aktywację ścieżek do importu, określenie 
miejsca docelowego w aktywnym projekcie oraz danych, które mają zostać zaimportowane.

● Aby otworzyć okno dialogowe OMF Import Options, wybierz File > Import > OMF (Plik > 
   Importuj > OMF).

1122



         

Import
     Umożliwia wybranie ścieżki do zaimportowania.
Type (Typ)
     Pokazuje typ multimediów ścieżki.
Track Name (Nazwa ścieżki)
     Pokazuje nazwę ścieżki.
Select All Tracks (Wybierz Wszystkie ścieżki)
     Wybiera wszystkie ścieżki do zaimportowania.
Import All Media Files (Importuj wszystkie pliki multimedialne)
    Importuje pliki multimedialne, do których nie odwołują się zdarzenia.
Import Clip Gain as Automation (Importuj wzmocnienie klipu jako automatyzację)
     Importuje automatyzację głośności i obwiednie ścieżki automatyzacji głośności każdej ścieżki.
Import at Timecode Position (Importuj w pozycji kodu czasowego)
     Wstawia elementy zawarte w pliku w ich oryginalnych pozycjach kodu czasowego.
     Zapewnia to, że elementy zostaną umieszczone we właściwych pozycjach czasowych, nawet 
     jeśli Cubase używa innej szybkości klatek niż plik.
Import at Absolute Time (Importuj w czasie bezwzględnym)
     Wstawia elementy zawarte w pliku zaczynając od pozycji kodu czasowego zapisanej w pliku, 
     zachowując względne odległości pomiędzy elementami.
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Eksportowanie plików OMF

PROCEDURA
1. Wybierz opcję File > Export > OMF (Plik > Eksportuj > OMF).
2. W oknie dialogowym Export Options (Opcje eksportu) wybierz ścieżki, które chcesz 
    uwzględnić w eksportowanym pliku i wprowadź zmiany.
3. Kliknij OK.
4. W oknie dialogowym pliku określ nazwę i lokalizację.
5. Kliknij Save (Zapisz).

WYNIK
Plik OMF zostanie wyeksportowany. Zawiera lub odwołuje się do wszystkich plików audio 
odtwarzanych w projekcie, w tym plików zanikania i edycji.
Plik nie zawiera nieużywanych plików audio, do których odwołuje się Pool (Pula), ani żadnych 
danych MIDI. Pliki wideo nie są uwzględniane.

Okno dialogowe OMF Export Options (Opcje eksportu OMF)
Okno dialogowe OMF Export Options pozwala aktywować ścieżki do eksportu i określić, jakie 
dane mają być zawarte w eksportowanych plikach.

● Aby otworzyć okno dialogowe OMF Export Options, wybierz File > Export > OMF (Plik > 
   Eksportuj > OMF)
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Eksport
     Umożliwia wybranie ścieżki do eksportu.
Track Name (Nazwa ścieżki)
     Pokazuje nazwę ścieżki.
Select All (Zaznacz wszystko)
     Wybiera wszystkie ścieżki w projekcie do eksportu.
From Left to Right Locator (Od lewego do prawego lokalizatora)
     Umożliwia eksport tylko zakresu pomiędzy lokalizatorami.
Media Destination Path (Ścieżka docelowa multimediów)
     Umożliwia określenie lokalizacji eksportowanych plików. Możesz także kliknąć Browse 
     (Przeglądaj).

UWAGA
Można tworzyć odniesienia do miejsc docelowych multimediów, które nie istnieją w systemie, z 
którym pracujesz. Dzięki temu można przygotować pliki do wykorzystania np. w projektach na 
innym systemie lub w środowisku sieciowym.

Copy Media (Kopiuj multimedia)
     Umożliwia tworzenie kopii wszystkich plików multimedialnych. Domyślnie skopiowane pliki 
     audio umieszczane są w podkatalogu w docelowym folderze eksportu. Aby określić inną 
     lokalizację dla skopiowanych plików, użyj pola Media Destination Path (Ścieżka docelowa 
     nośnika).
Consolidate Events (Konsoliduj zdarzenia)
     Umożliwia kopiowanie tylko tych fragmentów plików audio, które są użyte w projekcie.
     Wartość Handle Length (Długość uchwytu) pozwala zdefiniować długość w milisekundach 
     obejmującą audio poza granicą każdego zdarzenia w celu późniejszego dostrojenia. Uchwyty 
     umożliwiają dostosowanie zanikań (fades) lub edycję punktów podczas importowania projektu 
     do innej aplikacji.
OMF 1.0 File (Plik OMF 1.0)
     Umożliwia wybór wersji OMF. Wybierz tę opcję w zależności od wersji obsługiwanej przez 
     aplikację, w której planujesz zaimportować plik.
OMF 2.0 File (Plik OMF 2.0)
     Umożliwia wybór wersji OMF. Wybierz tę opcję w zależności od wersji obsługiwanej przez 
     aplikację, w której planujesz zaimportować plik.
Export Media File References (Eksportuj odniesienia do plików multimedialnych)
     Eksportuje tylko odniesienia do plików multimedialnych. Dzięki temu eksportowany plik będzie
     mały. Jednakże wskazane pliki audio muszą być dostępne dla aplikacji odbierającej.
Export All to One File (Eksportuj wszystko do jednego pliku)
     Eksportuje wszystkie dane do jednego, samodzielnego pliku. Może to spowodować duży 
     rozmiar pliku.
Export Clip-Based Volume (OMF 2.0 only) (Eksportuj wolumin oparty na klipach (tylko 
OMF 2.0))
     Zawiera ustawienia głośności skonfigurowane za pomocą uchwytów głośności zdarzeń.
Use Fade Curves (OMF 2.0 only) (Użyj krzywych zanikania (tylko OMF 2.0))
     Zawiera zanikanie skonfigurowane za pomocą uchwytów zanikania zdarzeń.
Export Clip Names (OMF 2.0 only) (Eksportuj nazwy klipów (tylko OMF 2.0))
     Zawiera nazwy klipów dla zdarzeń.
Export Sample Size (Eksportuj rozmiar próbki)
     Umożliwia ustawienie przykładowego rozmiaru eksportowanych plików.
Quantize Events to Frames (Kwantyzacja zdarzeń do ramek)
Przesuwa pozycje zdarzeń w eksportowanym pliku do dokładnych ramek. Jest to czasami 
konieczne podczas eksportowania projektów na stacje robocze wideo, co ogranicza dokładność 
edycji ramki.
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AAF Files (Pliki AAF)
Advanced Authoring Format (AAF) (Zaawansowany format autorski) to format plików 
multimedialnych, który umożliwia wymianę multimediów cyfrowych i metadanych pomiędzy 
różnymi systemami i aplikacjami na wielu platformach. Metadane obejmują zanikanie, 
automatyzację i przetwarzanie informacji.

POWIĄZANE LINKI
Importowanie plików AAF na stronie 1113
Eksportowanie plików AAF na stronie 1115

Importowanie plików AAF
Advanced Authoring Format (AAF) (Zaawansowany format autorski) to format plików 
multimedialnych, który umożliwia wymianę multimediów cyfrowych i metadanych pomiędzy 
różnymi systemami i aplikacjami na wielu platformach. Metadane obejmują zanikanie, 
automatyzację i przetwarzanie informacji.

POWIĄZANE LINKI
Importowanie plików AAF na stronie 1113
Eksportowanie plików AAF na stronie 1115

Importowanie plików AAF

PROCEDURA
1. Wybierz opcję File > Import > AAF (Plik > Importuj > AAF).
2. W Eksploratorze plików/wyszukiwarce macOS wybierz plik AAF i kliknij Open (Otwórz).
3. Jeżeli projekt jest już otwarty w Cubase, otworzy się okno dialogowe umożliwiające wybranie 
    miejsca docelowego dla zaimportowanego pliku AAF.
      ● Aby zaimportować plik AAF do nowego projektu, kliknij Yes (Tak).
      ● Aby zaimportować plik AAF do aktywnego projektu, kliknij No (Nie) i przejdź do kroku 5.
4. W Eksploratorze plików/wyszukiwarce macOS określ folder projektu i kliknij Select Folder 
    (Wybierz folder).
5. W oknie dialogowym Import Options (Opcje importu) wybierz ścieżki, które chcesz 
    zaimportować i wprowadź zmiany.
6. Kliknij OK.
UWAGA
W zależności od rozmiaru importowanego projektu oraz tego, czy pliki są osadzone, czy też istnieją
odniesienia, proces importowania może zająć trochę czasu.

WYNIK
Dodane zostaną ścieżki audio i zdarzenia z zaimportowanego pliku AAF. Jeśli zaimportowałeś plik 
do nowego projektu, zdarzenia zostaną umieszczone w ich oryginalnej pozycji w kodzie czasowym.
Jeśli zaimportowałeś plik do aktywnego projektu, zdarzenia zostaną umieszczone w miejscu 
określonym w oknie dialogowym Import Options (Opcje importu).

POWIĄZANE LINKI
Okno dialogowe Opcje importu AAF na stronie 1113

Okno dialogowe AAF Import Options (Opcje importu AAF)
Okno dialogowe AAF Import Options pozwala aktywować ścieżki do importu i określić miejsce 
docelowe w aktywnym projekcie.
● Aby otworzyć okno dialogowe AAF Import Options, wybierz File > Import > AAF (Plik > 
Importuj > AAF).
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Import
     Umożliwia wybranie ścieżki do zaimportowania.
Type (Typ)
     Pokazuje typ multimediów ścieżki.
Track Name (Nazwa ścieżki)
     Pokazuje nazwę ścieżki.
Select All Tracks (Wybierz wszystkie ścieżki)
     Wybiera wszystkie ścieżki do zaimportowania.
Import All Media Files (Importuj wszystkie pliki multimedialne)
     Importuje pliki multimedialne, do których nie odwołują się zdarzenia.
Import at Absolute Position (Importuj w pozycji bezwzględnej)
     Umieszcza zaimportowane dane ścieżki w ich oryginalnej pozycji kodu czasowego w aktywnym
     projekcie.
Import at Relative Position (Importuj w pozycji względnej)
     Umieszcza zaimportowane dane ścieżki względem czasu rozpoczęcia aktywnego projektu, 
     biorąc pod uwagę czas rozpoczęcia projektu źródłowego. Na przykład, jeśli projekt źródłowy 
     rozpoczyna się o kodzie czasowym 01:00:00:00 ze zdarzeniem zlokalizowanym o godzinie 
     02:00:00:00, a aktywny projekt rozpoczyna się o godzinie 02:00:00:00, zaimportowane 
     zdarzenie jest umieszczane o kodzie czasowym 03:00:00:00.
Import at Cursor Position (Importuj w pozycji kursora)
     Umieszcza zaimportowane dane ścieżki względem pozycji kursora w aktywnym projekcie, 
     biorąc pod uwagę czas rozpoczęcia projektu źródłowego. Na przykład, jeśli projekt źródłowy 
     rozpoczyna się o kodzie czasowym 01:00:00:00 ze zdarzeniem zlokalizowanym o godzinie 
      02:00:00:00, a kursor w aktywnym projekcie znajduje się o godzinie 02:00:00:00, 
      zaimportowane zdarzenie jest umieszczane w kodzie czasowym 03:00:00:00.
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UWAGA
● Jeśli pierwotna pozycja kodu czasowego zaimportowanych danych wykracza poza zakres    
    projektu, czas rozpoczęcia/zakończenia projektu zostanie zmodyfikowany.
● Opcje importu pozycji są dostępne tylko w przypadku importowania pliku AAF do aktywnego 
    projektu.

AAF File Info (Informacje o pliku AAF)
     Wyświetla informacje o pliku.

Eksportowanie plików AAF

PROCEDURA
1. Wybierz opcję File > Export > AAF (Plik > Eksportuj > AAF).
2. W oknie dialogowym Export Options (Opcje eksportu) wybierz ścieżki, które chcesz 
    uwzględnić w eksportowanym pliku i wprowadź zmiany.
3. Kliknij OK.
4. W oknie dialogowym pliku określ nazwę i lokalizację.
5. Kliknij Save (Zapisz).

WYNIK
Plik AAF zostanie wyeksportowany.

POWIĄZANE LINKI
Okno dialogowe Opcje eksportu AAF na stronie 1115

Okno dialogowe AAF Export Options (Opcje eksportu AAF)
Okno dialogowe AAF Export Options pozwala aktywować ścieżki do eksportu i określić, jakie 
dane mają być zawarte w eksportowanych plikach.

● Aby otworzyć okno dialogowe AAF Export Options, wybierz File > Export > AAF (Plik >  
   Eksportuj > AAF).
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Eksport
      Umożliwia wybranie ścieżki do eksportu.
Track Name (Nazwa ścieżki)
      Pokazuje nazwę ścieżki.
Select All (Zaznacz wszystko)
     Wybiera wszystkie ścieżki w projekcie do eksportu.
From Left to Right Locator (Od lewego do prawego lokalizatora)
     Umożliwia eksport tylko zakresu pomiędzy lokalizatorami.
Media Destination Path (Ścieżka docelowa multimediów)
     Umożliwia określenie lokalizacji eksportowanych plików. Możesz także kliknąć Breowse  
     (Przeglądaj).

UWAGA
Można tworzyć odniesienia do miejsc docelowych multimediów, które nie istnieją w systemie, 
z którym pracujesz. Dzięki temu można przygotować pliki do wykorzystania np. w projektach na 
innym systemie lub w środowisku sieciowym.

Copy Media (Kopiuj multimedia)
     Umożliwia tworzenie kopii wszystkich plików multimedialnych. Domyślnie skopiowane pliki 
     audio umieszczane są w podkatalogu w docelowym folderze eksportu. Aby określić inną 
     lokalizację dla skopiowanych plików, użyj pola Media Destination Path (Ścieżka docelowa 
     nośnika).

1129



Export Muted Events with Volume -inf dB (Eksportuj wyciszone zdarzenia z głośnością -inf dB)
     Ustawia wyciszone zdarzenia na głośność -inf dB podczas eksportu.
Consolidate Events (Konsoliduj zdarzenia)
     Umożliwia kopiowanie tylko tych fragmentów plików audio, które są użyte w projekcie.
     Wartość Handle Length (Długość uchwytu) pozwala zdefiniować długość w milisekundach 
     obejmującą dźwięk poza granicą każdego zdarzenia w celu późniejszego dostrojenia. Uchwyty 
     umożliwiają dostosowanie zanikań (fades) lub edycję punktów podczas importowania projektu 
     do innej aplikacji.
Export Media File References (Eksportuj odniesienia do plików multimedialnych)
     Eksportuje tylko odniesienia do plików multimedialnych. Dzięki temu eksportowany plik będzie
     mały. Jednakże wskazane pliki audio muszą być dostępne dla aplikacji odbierającej.
Export All to One File (Eksportuj wszystko do jednego pliku)
     Eksportuje wszystkie dane do jednego, samodzielnego pliku. Może to spowodować duży 
     rozmiar pliku.
Export Sample Size (Eksportuj rozmiar próbki)
     Umożliwia ustawienie przykładowego rozmiaru eksportowanych plików.
Quantize Events to Frames (Kwantyzacja zdarzeń do ramek)
     Przesuwa pozycje zdarzeń w eksportowanym pliku do dokładnych ramek. Jest to czasami 
     konieczne podczas eksportowania projektów na stacje robocze wideo, co ogranicza dokładność 
     edycji ramki.
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ReWire
ReWire to specjalny protokół do strumieniowego przesyłania dźwięku pomiędzy dwiema 
aplikacjami komputerowymi.

Opracowany przez Propellerhead Software i Steinberg, ReWire zapewnia następujące możliwości i 
funkcje:
● Przesyłanie strumieniowe w czasie rzeczywistym do 256 oddzielnych kanałów audio, przy pełnej 
   przepustowości, z aplikacji syntezatora do aplikacji miksera.
   W tym przypadku aplikacją miksera jest Cubase. Przykładem aplikacji syntezatora jest  
   oprogramowanie Propellerhead firmy Reason.
● Automatyczna, dokładna synchronizacja pomiędzy audio w obu programach.
● Możliwość współdzielenia przez oba programy jednej karty dźwiękowej i korzystania z wielu 
   wyjść na tej karcie.
● Połączone sterowanie transportem, które pozwala na odtwarzanie, przewijanie itp., albo z  
   poziomu Cubase, albo z aplikacji syntezatora (pod warunkiem, że posiada ona jakąś 
   funkcjonalność transportu).
● Funkcje automatycznego miksowania dźwięku oddzielnych kanałów, jeśli zajdzie taka potrzeba.  
   Na przykład w przypadku Reason pozwala to na posiadanie oddzielnych kanałów dla różnych 
   urządzeń.
● Dodatkowo ReWire oferuje możliwość trasowania ścieżek MIDI w Cubase do innej aplikacji w 
   celu uzyskania pełnej kontroli MIDI.
   Dla każdego urządzenia kompatybilnego z ReWire, w Cubase dostępnych jest kilka dodatkowych 
   wyjść MIDI. W przypadku Reason umożliwia to kierowanie różnych ścieżek MIDI w Cubase do 
   różnych urządzeń w Reason, przy czym Cubase służy jako główny sekwencer MIDI.
● Całkowite obciążenie systemu jest znacznie zmniejszone w porównaniu do wspólnego   
   korzystania z programów w konwencjonalny sposób.

Włączanie aplikacji ReWire
Aby w projekcie wykorzystać dostępne na komputerze aplikacje ReWire, należy je włączyć w 
oknie dialogowym ReWire Setup (Konfiguracja ReWire).

WAŻNE
● Włączenie aplikacji ReWire może mieć wpływ na wydajność i stabilność Cubase, nawet jeśli 
   połączenie ReWire nie jest używane. Dlatego zalecamy włączenie tylko tych aplikacji ReWire, 
   których chcesz używać w swoim projekcie.
● Wyłączenie aplikacji ReWire powoduje usunięcie odpowiednich kanałów ReWire z projektu.    
   Wszystkie powiązane ustawienia automatyki lub parametrów zostaną utracone.

PROCEDURA
1. Wybierz Studio > ReWire > ReWire Setup (Studio > ReWire > Konfiguracja ReWire).
2. Aktywuj aplikacje ReWire, których chcesz używać.
3. Kliknij Apply (Zastosuj).

WYNIK
Włączone aplikacje ReWire staną się dostępne w podmenu ReWire.

PO ZAKOŃCZENIU TEGO ZADANIA
Kanały ReWire możesz aktywować w panelu ReWire aplikacji.

POWIĄZANE LINKI
Aktywacja kanałów ReWire na stronie 1120
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Uruchamianie i kończenie

Podczas korzystania z ReWire bardzo ważna jest kolejność uruchamiania i zamykania obu 
programów.

Uruchamianie do normalnego użytkowania z ReWire
Kiedy używasz Cubase z ReWire, kolejność uruchamiania obu programów jest bardzo ważna.

PROCEDURA
1. Najpierw uruchom Cubase.
2. Włącz jeden lub kilka kanałów ReWire w oknie dialogowym ReWire Device dla drugiej 
    aplikacji.
3. Uruchom inną aplikację.
    W przypadku korzystania z ReWire uruchomienie aplikacji może zająć nieco więcej czasu.

POWIĄZANE LINKI
Aktywacja kanałów ReWire na stronie 1120

Zamykanie sesji ReWire
Po zakończeniu korzystania z ReWire należy zamknąć aplikacje w określonej kolejności.

PROCEDURA
1. Najpierw zamknij aplikację syntezatora.
2. Następnie zamknij Cubase.

Uruchomienie obu programów bez użycia ReWire
Możliwe jest jednoczesne uruchomienie Cubase i aplikacji syntezatora na tym samym komputerze, 
bez użycia ReWire, chociaż przypadki użycia tego mogą być rzadkie.

PROCEDURA
1. Najpierw uruchom aplikację syntezatora.
2. Następnie uruchom Cubase.

UWAGA
Należy pamiętać, że te dwa programy konkurują teraz o zasoby systemowe, takie jak karty 
dźwiękowe, tak samo jak podczas pracy z innymi aplikacjami audio nie obsługującymi ReWire.
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Aktywacja kanałów ReWire
ReWire obsługuje przesyłanie strumieniowe do 256 oddzielnych kanałów audio. Dokładna liczba 
dostępnych kanałów ReWire zależy od zastosowania syntezatora. Panele urządzeń ReWire w 
Cubase umożliwiają aktywację kanałów, z których chcesz korzystać.

WARUNEK WSTĘPNY
W oknie dialogowym ReWire Setup (Konfiguracja ReWire) włączono aplikację ReWire, której 
chcesz używać.

PROCEDURA
1. Wybierz Studio > ReWire i wybierz aplikację ReWire, której chcesz używać. Pojawi się   
    odpowiedni panel ReWire. Składa się z szeregu wierszy, po jednym dla każdego dostępnego 
    kanału ReWire.
2. Kliknij przyciski zasilania po lewej stronie, aby włączyć/wyłączyć kanały.
    Przyciski podświetlają się, wskazując aktywowane kanały.
3. Opcjonalnie: kliknij dwukrotnie etykiety w prawej kolumnie i wpisz inną nazwę.
    Etykiety te są używane w projekcie do identyfikacji kanałów ReWire.

WYNIK
Aktywowane kanały ReWire zostaną dodane do projektu.

UWAGA
● Im więcej kanałów ReWire aktywujesz, tym większa jest wymagana moc obliczeniowa.
● Informacje o tym, jaki sygnał jest przesyłany na każdym kanale, znajdziesz w dokumentacji  
   aplikacji syntezatora.

WAŻNE
Dezaktywacja kanałów ReWire w panelu ReWire powoduje usunięcie kanałów z projektu. 
Wszystkie powiązane ustawienia automatyki lub parametrów zostaną utracone.

POWIĄZANE LINKI
Włączanie aplikacji ReWire na stronie 1118

Korzystanie z kontrolerów sterujących transportem i tempem

WAŻNE
Ma to znaczenie tylko wtedy, gdy aplikacja syntezatora ma wbudowany sekwencer lub podobną 
aplikację.
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Podstawowe kontrolery transportu
Po uruchomieniu ReWire transporty w obu programach są całkowicie powiązane. Nie ma 
znaczenia, w którym programie odtwarzasz, zatrzymujesz, przewijasz do przodu lub do tyłu. Jednak
nagrywanie (jeśli ma to zastosowanie) jest nadal całkowicie oddzielne w obu aplikacjach.

Ustawienia pętli
Jeśli w aplikacji syntezatora dostępna jest pętla lub cykl, pętla ta zostanie całkowicie połączona z 
cyklem w Cubase. Oznacza to, że możesz przesunąć punkt początkowy i końcowy pętli lub włączyć
lub wyłączyć pętlę w jednym z programów, co znajdzie odzwierciedlenie w drugim programie.

Ustawienia tempa
Jeśli chodzi o tempo, Cubase jest zawsze „master” (zwierzchnik). Oznacza to, że oba programy 
będą działać w tempie ustawionym w Cubase.
Jeśli jednak nie używasz ścieżki tempa w Cubase, możesz dostosować tempo w dowolnym 
programie, co natychmiast znajdzie odzwierciedlenie w drugim programie.

WAŻNE
Jeśli używasz ścieżki tempa w Cubase i na panelu Transport jest aktywny przycisk Activate 
Tempo Track (Aktywuj ścieżkę tempa), nie powinieneś regulować tempa w aplikacji syntezatora, 
ponieważ żądanie tempa z ReWire automatycznie dezaktywuje ścieżkę tempa w Cubase.

Sposób obsługi kanałów ReWire
Kiedy aktywujesz kanały ReWire na panelach urządzeń ReWire, staną się one dostępne jako kanały
w MixConsole.

Kanały ReWire mają następujące właściwości:
● Kanały ReWire mogą być dowolną kombinacją mono i stereo, w zależności od zastosowania 
   syntezatora.
● Kanały ReWire mają tę samą funkcjonalność, co zwykłe kanały audio.
   Oznacza to, że możesz ustawić głośność i panoramę, dodać korektor, wstawić efekty i wysyłki 
   oraz skierować wyjścia kanałów do grup lub szyn. Jednakże kanały ReWire nie mają przycisków 
   monitora.
● Wszystkie ustawienia kanałów można zautomatyzować za pomocą przycisków Read/Write    
   (Odczyt/Zapis).
   Gdy napiszesz automatyzację, w oknie Project automatycznie pojawią się ścieżki automatyzacji 
   kanałów. Umożliwia to graficzne przeglądanie i edycję automatyki, podobnie jak w przypadku 
   kanałów instrumentów VST itp.
● Możesz miksować dźwięk z kanałów ReWire do pliku na dysku twardym za pomocą funkcji   
   Export Audio Mixdown (Eksportuj miksowanie dźwięku).
   Możesz wyeksportować magistralę wyjściową, do której przekierowałeś kanały ReWire. Możesz 
   także bezpośrednio eksportować poszczególne kanały ReWire – „renderując” każdy kanał  
   ReWire do osobnego pliku audio.

POWIĄZANE LINKI
Miksowanie do plików audio na stronie 1062
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Routing MIDI przez ReWire
Kiedy używasz Cubase z aplikacją kompatybilną z ReWire, dodatkowe wyjścia MIDI 
automatycznie pojawią się w wyskakujących menu Output Routing (Trasowanie wyjściowe) dla 
ścieżek MIDI. Umożliwia to odtwarzanie aplikacji syntezatora poprzez MIDI z Cubase, używając 
go jako jednego lub kilku oddzielnych źródeł dźwięku MIDI.

                

● Liczba i konfiguracja wyjść MIDI zależy od zastosowania syntezatora.

Rozważania i ograniczenia

Sample rates (Częstotliwości próbkowania)
Aplikacje syntezatorów mogą ograniczać się do odtwarzania dźwięku z określonymi 
częstotliwościami próbkowania. Jeśli Cubase jest ustawiony na inną częstotliwość próbkowania, 
aplikacja syntezatora będzie odtwarzać w niewłaściwej wysokości. Aby uzyskać szczegółowe 
informacje, zapoznaj się z dokumentacją aplikacji syntezatora.

ASIO drivers (Sterowniki ASIO)
ReWire dobrze współpracuje ze sterownikami ASIO. Korzystając z systemu magistrali Cubase, 
możesz kierować dźwięki z aplikacji syntezatora do różnych wyjść na karcie dźwiękowej 
kompatybilnej z ASIO.
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Key Commands (skróty klawiszowe)
Komendy klawiszowe są przypisane do większości głównych menu i funkcji w Cubase. Są one 
przechowywane jako Preferences (Preferencje) używane we wszystkich Twoich projektach.

Możesz przeglądać i dodawać polecenia klawiszowe w oknie dialogowym Key Commands (skróty
klawiszowe). Przypisania klawiszowych skrótów są również pokazane w etykietach narzędzi.

                   

Etykietki narzędzi zakończone wykrzyknikiem nie mają jeszcze przypisanego polecenia 
klawiszowego.
Możesz zapisać ustawienia poleceń klawiszowych jako plik poleceń klawiszowych, który jest 
przechowywany oddzielnie i można go zaimportować do dowolnego projektu. W ten sposób można
szybko i łatwo przywołać niestandardowe ustawienia, na przykład podczas przenoszenia projektów 
między różnymi komputerami. Ustawienia zapisywane są w pliku XML na dysku twardym.

POWIĄZANE LINKI
Zapisywanie ustawień skrótów klawiszowych na stronie 1127

Okno dialogowe Key Commands (Skróty klawiszowe)
Okno dialogowe Key Commands umożliwia przeglądanie i edycję skrótów klawiszowych dla 
głównych menu i funkcji Cubase.

● Aby otworzyć okno dialogowe Key Commands, wybierz Edit > Key Commands (Edycja > 
   Skróty klawiszowe).
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Dostępne są następujące opcje:
+ All (+ Wszystkie)
      Rozwija wszystkie foldery.
- All (- Wszystkie)
      Minimalizuje wszystkie foldery.
Search (Szukaj)
      Umożliwia wyszukiwanie funkcji Cubase. Jest to przydatne, jeśli chcesz wiedzieć, który 
      skrót klawiszowy jest przypisany do konkretnej funkcji.
Reset Current Key Command (Zresetuj bieżące polecenie klawiszowe)
      Umożliwia zresetowanie wybranego polecenia klawiszowego do ustawień domyślnych.
Commands list (Lista poleceń)
      Pokazuje funkcje Cubase, do których można przypisać skróty klawiszowe, uporządkowane w 
      folderach kategorii.
Keys (Klawisze)
      W tym miejscu wyświetlane jest przypisane polecenie klawisza dla funkcji wybranej na liście 
      Commands (Polecenia).
Delete Selected Key Command (Usuń wybrane polecenie klawiszowe)
      Usuwa przypisanie polecenia klawiszowego do funkcji wybranej na liście Commands.
Assign Key (Przypisz klawisz)
      Przypisuje klawisz z pola Type in Key (Wpisz wartość klawisza) do funkcji wybranej na liście  
      Commands.
Type in Key (Wpisz klawisz)
      W tym miejscu możesz wprowadzić klawisz przypisany do funkcji wybranej z listy 
      Commands.
Assigned to: (Przypisane do:)
      Pokazuje funkcję, do której przypisany jest klawisz w polu Type in Key. Kliknij przycisk 
      Select (Wybierz), aby wybrać tę funkcję z listy Commands.
Select Preset (Wybierz ustawienie wstępne)
      Otwiera menu z zapisanymi ustawieniami skrótów klawiszowych.
Store (Zachowaj)
      Otwiera okno dialogowe umożliwiające zapisanie gotowych poleceń klawiszowych.
Delete (Usuń)
      Usuwa wybrane ustawienie wstępne poleceń klawiszowych.
Show Macros (Pokaż makra)
      Otwiera sekcję Macros (Makra), która umożliwia skonfigurowanie kombinacji kilku funkcji lub
      poleceń do wykonania za jednym razem w postaci makra.
Reset All (Zresetuj wszystko)
      Resetuje wszystkie skróty klawiszowe do ustawień domyślnych.

POWIĄZANE LINKI
Sekcja Makra na stronie 1125
Przypisywanie klawiszowych poleceń na stronie 1126
Wyszukiwanie klawiszowych poleceń na stronie 1126
Resetowanie klawiszowych poleceń na stronie 1128
Usuwanie klawiszowych poleceń na stronie 1127
Ładowanie gotowych ustawień poleceń klawiszowych na stronie 1128
Zapisywanie ustawień klawiszowych poleceń na stronie 1127
Konfigurowanie makr na stronie 1127
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Sekcja Macros (Makra)
Sekcja Macros umożliwia skonfigurowanie kombinacji kilku funkcji lub poleceń, które chcesz 
wykonać za jednym razem

● Aby otworzyć sekcję Macros, wybierz Edit > Key Commands (Edycja > Polecenia klawiszowe)
i kliknij Show Macros (Pokaż makra).

Macros list (Lista makr)
      Pokazuje wszystkie dodane makra.
New (Nowe)
      Umożliwia dodanie nowego makra.
Duplicate (Duplikuj)
      Umożliwia zduplikowanie wybranego makra.
Delete (Usuń)
      Usuwa wybrany element z listy Macros (Makra).
Add (Dodaj)
      Umożliwia dodanie do makra funkcji wybranej z listy Commands (Polecenia).
Move up (Przesuń w górę)
      Umożliwia zmianę położenia wybranego polecenia poprzez przesunięcie go w górę listy.
Move down (Przesuń w dół)
      Umożliwia zmianę pozycji wybranego polecenia poprzez przesunięcie go w dół listy.
Remove (Usuń)
      Umożliwia usunięcie polecenia wybranego na liście Commands w górnej części okna 
      dialogowego.
Hide Macros (Ukryj makra)
      Ukrywa sekcję Macros.
Reset All (Zresetuj wszystko)
      Resetuje wszystkie polecenia (skróty) klawiszowe do ustawień domyślnych

POWIĄZANE LINKI
Okno dialogowe klawiszowe polecenia na stronie 1123
Konfigurowanie makr na stronie 1127
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Assigning Key Commands (Przypisywanie poleceń (skrótów) 
klawiszowych)
Polecenia klawiszowe można dodawać w oknie dialogowym Key Commands (Polecenia 
klawiszowe).

PROCEDURA
1. Wybierz Edit > Key Commands (Edycja > Polecenia klawiszowe).
2. Wykonaj jedną z następujących czynności:
      ● Na liście Commands (Polecenia) kliknij znak plus, aby otworzyć folder kategorii i wybierz 
         funkcję, do której chcesz przypisać polecenie klawiszowe.
      ● W polu wyszukiwania wpisz nazwę funkcji, do której chcesz przypisać polecenie klawiszowe.

Przypisane polecenia klawiszowe są pokazane w kolumnie Keys (Klawisze) oraz na liście Keys po 
prawej stronie.

   

3. Kliknij pole Type in Key (Wpisz klawisz) i naciśnij klawisze, których chcesz użyć jako 
    polecenia klawiszowego.
    Możesz naciskać pojedyncze klawisze lub kombinację jednego lub kilku klawiszy 
    modyfikujących ( Ctrl/Cmd , Alt/Opt , Shift ) plus dowolny klawisz.
4. Kliknij Assign (Przypisz).
    Polecenie klawiszowe jest pokazane w sekcji Keys (Klawisze).
5. Kliknij OK.

UWAGA
Dla tej samej funkcji można skonfigurować kilka różnych poleceń klawiszowych. Dodanie 
polecenia klawiszowego do funkcji, która ma już inne polecenie klawiszowe, nie zastępuje 
polecenia klawiszowego wcześniej zdefiniowanego dla tej funkcji.

Wyszukiwanie poleceń (skrótów) klawiszowych.
Możesz wyszukiwać funkcje Cubase w oknie dialogowym Key Commands (Komendy 
klawiszowe). Jest to przydatne, jeśli chcesz wiedzieć, które polecenie klawiszowe jest przypisane 
do konkretnej funkcji.

PROCEDURA
1. Wybierz Edit > Key Commands (Edycja > Polecenia klawiszowe).
2. W polu wyszukiwania wpisz nazwę funkcji, dla której chcesz poznać polecenie klawiszowe.
3. Kliknij opcję Start/Continue Search (Rozpocznij/Kontynuuj wyszukiwanie).

WYNIK
Wybrane zostanie pierwsze pasujące polecenie i wyświetlone na liście Commands (Polecenia). 
Kolumna Keys (Klawisze) i lista Keys (Klawisze) pokazują przypisane polecenia klawiszowe, jeśli 
takie istnieją.
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Usuwanie poleceń klawiszowych

PROCEDURA
1. Wybierz Edit > Key Commands (Edycja > Polecenia klawiszowe).
2. Na liście Commands (Polecenia) kliknij znak plus, aby otworzyć folder kategorii i wybierz 
    funkcję, dla której chcesz usunąć polecenie klawiszowe.
3. Wybierz polecenie klawiszowe na liście Keys (Klawisze) i kliknij Delete selected key command
    (Usuń wybrane polecenie klawiszowe).
4. Kliknij Remove (Usuń), aby usunąć wybrane polecenie klawiszowe.
5. Kliknij OK.

Konfigurowanie makr
Można skonfigurować kombinację kilku funkcji lub poleceń do wykonania za jednym razem w 
postaci makra.

PROCEDURA
1. Wybierz Edit > Key Commands (Edycja > Polecenia klawiszowe).
2. Kliknij opcję Show Macros (Pokaż makra).
3. Kliknij New (Nowe).
4. Wprowadź nazwę makra i naciśnij klawisz Return, aby ją zatwierdzić.
5. Na liście Commands (Polecenia) wybierz pierwsze polecenie, które chcesz uwzględnić w 
    makrze.
6. Kliknij Add (Dodaj).
7. Wybierz kolejne polecenie i kliknij Add (Dodaj).
UWAGA
Polecenia dodawane są po wybranym poleceniu na liście Macros (Makra). Pozwala to określić 
kolejność poleceń makra.
8. Kliknij OK.

WYNIK
Wszystkie makra są dostępne w podmenu Macros (Makra) w menu Edit (Edycja).

PO ZAKOŃCZENIU TEGO ZADANIA
Do makra można także przypisać polecenia klawiszowe. Makra są wyświetlane na liście 
Commands (Polecenia) w folderze kategorii Macro (Makra).

POWIĄZANE LINKI
Sekcja Makra na stronie 1125

Zapisywanie ustawień wstępnych poleceń klawiszowych
Możesz zapisać ustawienia poleceń klawiszowych jako ustawienia wstępne.

WARUNEK WSTĘPNY
Skonfigurowałeś polecenia klawiszowe według własnych upodobań.

PROCEDURA
1. W sekcji Presets (Ustawienia wstępne) kliknij Save (Zapisz).
2. Wprowadź nazwę ustawienia wstępnego i kliknij OK.

WYNIK
Ustawienia poleceń klawiszowych są teraz dostępne jako ustawienia wstępne w wyskakującym 
menu Presets (Ustawienia wstępne).

1140



Ładowanie gotowych ustawień poleceń klawiszowych
Możesz załadować gotowe ustawienia poleceń klawiszowych.

PROCEDURA
● W sekcji Presets (Ustawienia wstępne) otwórz menu podręczne i wybierz ustawienie wstępne.

WYNIK
Wstępnie ustawione polecenia klawiszowe zastępują bieżące ustawienia poleceń klawiszowych i 
makra.

Resetowanie poleceń klawiszowych

PROCEDURA
1. Wybierz Edit > Key Commands (Edycja > Polecenia klawiszowe).
2. Wykonaj jedną z następujących czynności:
      ● Na liście Commands (Polecenia) wybierz polecenie klawiszowe, które chcesz przywrócić 
         i kliknij Reset (Resetuj).

               

● Kliknij Reset All (Resetuj wszystko).

               

WYNIK
Klawiszowe polecenia zostaną zresetowane.

WAŻNE
Wszelkie zmiany wprowadzone w domyślnych poleceniach klawiszowych zostaną utracone. Jeśli 
chcesz mieć możliwość ponownego przywrócenia tych ustawień, pamiętaj o ich uprzednim 
zapisaniu.

Polecenia klawiszowe domyślne
Domyślne polecenia klawiszowe są pogrupowane w kategorie.

UWAGA
Gdy wyświetlana jest On-Screen Keyboard (Klawiatura ekranowa, zwykłe polecenia klawiszowe 
są blokowane, ponieważ są zarezerwowane dla Klawiatury ekranowej. Jedynymi wyjątkami są: 
Ctrl/Cmd - S (Zapisz), Num * (Rozpocznij/Zatrzymaj nagrywanie), Spacja 
(Rozpocznij/Zatrzymaj odtwarzanie), Num 1 (Przeskocz do lewego lokalizatora), Delete lub 
Backspace (Usuń), Num / ( Włącz/wyłącz cykl), F2 (Pokaż/Ukryj panel Transport) i Alt/Opt - K 
(Pokaż/Ukryj klawiaturę ekranową).
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Kategoria Add Track (Dodaj ścieżkę)

Opcja Skrót klawiszowy

   Add Track  (Dodaj ścieżkę)    T

Kategoria Audio

Opcja Skrót klawiszowy
Adjust Fades to Range (Dostosuj zanikanie do 
zakresu)

   A

   Auto-Grid (Automatyczna siatka)    Shift - Q

   Crossfade (Przenikanie)    X

Kategoria Automation (Automatyzacja)

Opcja Skrót klawiszowy

   Open Panel (Otwórz panel)      F6

Read Automation for All Tracks On/Off (Czytaj 
automatyzację dla wszystkich ścieżek wł./wył.)

   Alt/Opt - R

Write Automation for All Tracks On/Off (Pisz 
automatyzację dla wszystkich ścieżek wł./wył.)

   Alt/Opt - W

Kategoria Chords (Akordy)

Opcja Skrót klawiszowy
Show/Hide Chord Pads (Pokaż/ukryj pady 
akordów)

   Ctrl/Cmd - Shift - C

Kategoria Devices (Studio) (Urządzenia (Studio)).

Opcja Skrót klawiszowy

   Audio Connections (Połączenia Audio)    F4

   Audio Performance (Wydajność dźwięku)    F12

   MixConsole (Konsola mikserska)    F3
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Opcja Skrót klawiszowy
MixConsole in Project Window (MixConsole 
w oknie projektu)

   Alt/Opt - F3

   On-Screen Keyboard (Klawiatura ekranowa)    Alt/Opt -K

   Video Player (Odtwarzacz wideo)    Alt/Opt - F3

   VST Instruments (Instrumenty VST)    Alt/Opt -K

Kategoria bezpośredniego przetwarzania offline

Opcja Skrót klawiszowy
Direct Offline Processing (Bezpośrednie 
przetwarzanie offline)

   F7

Kategoria edycji

Opcja Skrót klawiszowy
Activate/Deactivate Focused Object 
(Aktywuj/dezaktywuj obiekt fokusowany)

   Alt/Opt –A

Auto-Scroll On/Off (Włączanie/wyłączanie 
automatycznego przewijania)

   F7

   Copy (Kopuj)    Ctrl/Cmd - C

   Cut (Wytnij)    Ctrl/Cmd – X

   Cut Time (Wytnij czas)    Ctrl/Cmd - Shift -X

   Delete (Usuń)    Delete lub Backspace

   Delete Time (Usuń czas)    Shift -Backspace

   Duplicate (Powiel)    Ctrl/Cmd - D

   Expand/Reduce (Rozwiń/zmniejsz)    Alt/Opt - E

   Find Track/Channel (Znajdź ściezkę/kanał)    Alt/Opt - F

   Group (Grupuj)    Alt/Opt - G

   Group Editing on Selected Tracks On/Off 
(wł./wył. grupowej edycji wybranych ścieżek)

   K

   Insert Silence (Wstaw ciszę)    Ctrl/Cmd - Shift - E

   Invert (Odwróć)    Alt/Opt - F
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Opcja Skrót klawiszowy

   Invert Selection (Odwróć wybór)    Ctrl/Cmd -Alt/Opt –I

Left Selection Side to Cursor (Lewa strona 
zaznaczenia do kursora)

   E

   Lock (Zablokuj)    Ctrl/Cmd - Shift - L

   Move to Cursor (Przejdź do kursora)    Ctrl/Cmd - L

Move to Front (Uncover) (Przesuń się na przód 
(odkryj))

   U

   Mute (Wycisz)    M

   Mute Events (Wycisz zdarzenia)    Shift - M

Mute/Unmute Objects (Wycisz/włącz 
wyciszenie obiektów)

   Alt/Opt - M

   Open (Otwórz)    Ctrl/Cmd - E

   Paste (Wklej)    Ctrl/Cmd - V

Paste at Origin (Wklej w miejscu pochodzenia)    Alt/Opt - V

Paste Relative to Cursor (Wklej względem 
kursora)

   Shift - V

   Paste Time (Wklej czas)    Ctrl/Cmd - Shift - V

Primary Parameter: Decrease (Podstawowy 
parametr: Zmniejszenie)

   Ctrl/Cmd - Shift – strzałka w dół

Primary Parameter: Increase (Podstawowy 
parametr: wzrost)

   Ctrl/Cmd - Shift – strzałka w górę

   Record Enable (Włącz nagrywanie)    R

   Redo (Przerób)    Ctrl/Cmd - Shift - Z

   Repeat (Powtórz)    Ctrl/Cmd - K

Right Selection Side to Cursor (Prawa strona 
zaznaczenia do kursora)

   D

Secondary Parameter: Decrease (Parametr 
drugorzędny: spadek)

   Ctrl/Cmd - Shift – strzałka w lewo

Secondary Parameter: Increase (Parametr 
drugorzędny: wzrost)

   Ctrl/Cmd - Shift – strzałka w prawo

   Select All (Wybierz wszystko)    Ctrl/Cmd -A

   Select None (Wybierz opcję Brak)    Ctrl/Cmd - Shift -A

   Snap On/Off (Wł./wył. przyciągania)    J
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Opcja Skrót klawiszowy

   Solo    S

   Split At Cursor (Rozdziel przy kursorze)    Alt/Opt –X

   Split Range (Podziel zakres)    Shift – X

   Stationary Cursor (Stacjonarny kursor)    Alt/Opt - C

   Undo (Cofnij)    Ctrl/Cmd – Z

   Ungroup (Rozgrupuj)    Ctrl/Cmd – U

   Unlock (Odblokuj)    Ctrl/Cmd - Shift - U

   Unmute Events (Wyłącz wyciszenie zdarzeń)    Shift - U

   Write (Pisz)    W

Kategoria edytory

Opcja Skrót klawiszowy

   Edit In-Place (Edytuj lokalnie)    Ctrl/Cmd - Shift -I

   Open Score Editor (Otwórz edytor partytury)    Ctrl/Cmd - R

   Open/Close Editor (Otwórz/zamknij edytor)    Return

Kategoria plik

Opcja Skrót klawiszowy

   Close (Zamknij)    Ctrl/Cmd - W 

   New (Nowy)    Ctrl/Cmd – N

   Open (Otwórz)    Ctrl/Cmd – O

   Quit (Zrezygnuj)    Ctrl/Cmd – Q

   Save (Zapisz)    Ctrl/Cmd – S

   Save as (Zapisz jako)    Ctrl/Cmd - Shift - S

   Save New Version (Zapisz nową wersję)    Ctrl/Cmd -Alt/Opt - S
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Kategoria Multimedia

Opcja Skrót klawiszowy

   Open MediaBay (Otwórz MediaBay)    F5

Open/Close Attribute Inspector (Otwórz/zamknij
inspektora atrybutów)

   Ctrl -Alt/Opt - Num 6

Open/Close Favorites (Otwórz/zamknij 
ulubione)

   Ctrl -Alt/Opt - Num 8

Open/Close File Browser (Otwórz/zamknij 
przeglądarkę plików)

   Ctrl -Alt/Opt - Num 4

   Open/Close Filters (Otwórz/zamknij filtry)    Ctrl -Alt/Opt - Num 5

Open/Close Previewer (Otwórz/zamknij 
podgląd)

   Ctrl -Alt/Opt - Num 2

Preview Cycle On/Off (Podgląd 
włączenia/wyłączenia cyklu)

   Shift - Num /

   Preview Start (Rozpocznij podgląd)    Shift - Enter

   Preview Stop (Podgląd stop)    Shift - Num 0

   Search MediaBay (Wyszukaj MediaBay)    Shift - F5

Kategoria MIDI

Opcja Skrót klawiszowy
Show/Hide Controller Lanes (Pokaż/ukryj pasy 
kontrolerów)

   Alt/Opt - L

 
Kategoria historii MixConsole

Opcja Skrót klawiszowy
Undo MixConsole Step (Cofnij krok 
MixConsole)

   Alt/Opt - Z

Redo MixConsole Step (Powtórz krok 
MixConsole)

   Alt/Opt - Shift - Z
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Opcja Skrót klawiszowy
Add down (Dodaj w dół):

Rozwiń/Cofnij zaznaczenie w oknie Projektu na 
dół/Przesuń wybrane zdarzenie w Key Editorze   
(Edytor klawiszy) o jedną oktawę w dół

   Shift – strzałka w dół

Add left (Dodaj w lewo):

Rozwiń/Cofnij wybór w oknie Projektu/Edytorze
klawiszy po lewej stronie

   Shift – strzałka w lewo

Add Right (Dodaj w prawo):
Rozwiń/Cofnij wybór w oknie Projektu/Edytorze
klawiszy po prawej stronie

   Shift – strzałka w prawo

Add up (Dodaj w górę):

Rozwiń/Cofnij zaznaczenie w oknie Projektu na 
górę/Przenieś wybrane zdarzenie w Key Editor   
o jedną oktawę w górę

   Shift – strzałka w górę

Bottom (Spód):

Wybierz dolną ścieżkę na liście ścieżek
   End

Down: (W dół):

Wybierz następny w oknie projektu/Przesuń 
wybrane zdarzenie w edytorze tonacji (Key 
Editor) o pół tonu w dół

   Strzałka w dół

Left (Lewy):

Wybierz poprzedni w oknie projektu/Edytorze 
klawiszy (Key Editor) 

   Strzałka w lewo

Right (Prawy):

Wybierz Następny w oknie Projektu/Edytorze 
klawiszy

   Strzałka w prawo

   Toggle Selection (Przełącz wybór)    Ctrl/Cmd – Space

Top (Szczyt):

Wybierz najwyższy utwór na liście utworów
   Home

Up (W górę):

Wybierz następny w oknie projektu/Przesuń 
wybrane zdarzenie w edytorze tonacji o pół tonu 
w górę

   Strzałka w górę

Kategoria nudge (trącanie)

1147



Opcja Skrót klawiszowy

   End Left (Koniec z lewej)    Alt/Opt - Shift – Strzałka w lewo

   End Right (Koniec z prawej)    Alt/Opt - Shift – Strzałka w prawo

   Left (Z lewej)    Ctrl/Cmd – Strzałka w lewo

   Right (Z prawej)    Ctrl/Cmd – Strzałka w prawo

   Start Left (Zacznij z lewej)    Alt/Opt – Strzałka w lewo

   Start Right (Zacznij z prawej)    Alt/Opt – Strzałka w prawo

Kategoria Projekt

Opcja Skrót klawiszowy

   Colors (Kolory)    Alt/Opt - Shift - S

   Open Browser (Otwórz przeglądarkę)    Ctrl/Cmd –B 

   Open Markers (Otwórz znaczniki)    Ctrl/Cmd –M 

   Open Pool (Otwórz pulę)    Ctrl/Cmd –P 

   Open Tempo Track (Otwórz ścieżkę tempa)    Ctrl/Cmd –T 

Remove Selected Tracks (Usuń wybrane ścieżki)    Shift - Delete

Set Track/Event Color (Ustaw kolor 
ścieżki/zdarzenia)

   Alt/Opt - Shift - C

   Setup (Konfiguruj)    Shift - S

Kategoria Quantize (Kwantyzacja)

Opcja Skrót klawiszowy

   Quantize (Kwantyzuj)    Q

Kategoria Set Insert Length (Ustaw długość wstawienia)
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Opcja Skrót klawiszowy

   1/1    Alt/Opt - 1

   1/2    Alt/Opt – 2

   1/4    Alt/Opt – 3

   1/8    Alt/Opt – 4

   1/16    Alt/Opt – 5

   1/32    Alt/Opt – 6

   1/64    Alt/Opt – 7

   1/128    Alt/Opt – 8

   Toggle Dotted (Przełącz kropkowane)    Alt/Opt - .

   Toggle Triplet (Przełącz trójkę)    Alt/Opt - ,

Kategoria Tool (Narzędzia)

Opcja Skrót klawiszowy
Combine Selection Tools On/Off (Połącz 
narzędzia zaznaczania Wł./Wył)

   Alt/Opt - Shift - 1

   Draw Tool (Narzędzie do rysowania)    R

   Drumstick Tool (Narzędzie pałeczka do bębna)    0

   Erase Tool (Narzędzie do usuwania)    S

   Glue Tool (Narzędzie do klejenia)    4

   Mute Tool (Narzędzie wyciszenia)    7

   Next Tool (Następne narzędzie)    F10

Object Selection Tool (Narzędzie do wybierania 
obiektów)

   1

   Play Tool (Narzędzie odtwarzaj)    9

   Previous Tool (Poprzednie narzędzie)    F9
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Opcja Skrót klawiszowy
Range Selection Tool (Narzędzie wyboru 
zakresu)

   2

   Split Tool (Narzędzie rozdziel)    3

   Zoom Tool (Narzędzie powiększ)    6

Kategoria Track Versions (Wersje ścieżek)

Opcja Skrót klawiszowy

   Duplicate Version (Zduplikowana wersja)    Ctrl/Cmd - Shift – D

   New Version (Nowa wersja)    Ctrl/Cmd - Shift – N

   Next Version (Następna wersja)    Ctrl/Cmd - Shift – H

   Previous Version (Poprzednia wersja)    Ctrl/Cmd - Shift – G

Kategoria Transport

Opcja Skrót klawiszowy
Activate External Sync (Aktywuj synchronizację
zewnętrzną)

   Alt/Opt - Shift - T

   Activate Metronome (Aktywuj metronom)    C

   Activate Punch In (Aktywuj wbijanie)    I

   Activate Punch Out (Aktywuj wybijanie)    O

   Cycle (Cykl)    Num /

Enter Left Locator (Wprowadź lewy lokalizator)    Shift – L

Enter Locator Range Duration (Wprowadź czas 
trwania zakresu lokalizatora)

   Shift – D

Enter Project Cursor Position (Wprowadź 
pozycję kursora projektu)

   Shift – P

Enter Punch In Position (Wprowadź pozycję 
wbicia)

   Shift – I

Enter Punch Out Position (Wprowadź pozycję 
wybicia)

   Shift – O

Enter Right Locator (Wprowadź prawy 
lokalizator)

   Shift – R

   Enter Tempo (Wprowadź tempo)    Shift – T
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Opcja Skrót klawiszowy

   Enter Time Signature (Wprowadź metrum)    Shift - C

Exchange Time Formats (Formaty czasu 
wymiany)

   .

   Fast Forward (Szybkie przewijanie do przodu)    Shift - Num +

   Fast Rewind (Szybkie przewijanie do tyłu)    Shift - Num -

   Forward (Do przodu)    Num +

Go to Left Locator (Przejdź do lewego 
lokalizatora)

   Num 1

Go to Project Start (Przejdź do Rozpoczęcia 
projektu)

   Num . lub Num , lub Num ;

Go to Right Locator (Przejdź do prawego 
lokalizatora)

   Num 2

Insert Marker (Windows only) (Wstaw znacznik 
(tylko system Windows))

   Insert

  Locate Next Event (Znajdź następne zdarzenie)    N

Locate Next Hitpoint (Znajdź następny punkt 
hitowy)

   Alt/Opt – N

Locate Next Marker (Znajdź następny znacznik)    Shift – N

Locate Previous Event (Znajdź poprzednie 
zdarzenie)

   B

Locate Previous Hitpoint (Znajdź poprzedni 
punkt hitowy)

   Alt/Opt – B 

Locate Previous Marker (Znajdź poprzedni 
znacznik)

   Shift – B 

Locate Selection Start (Znajdź początek 
zaznaczenia)

   L

 Locators to Selection (Lokalizatory do wyboru)    P

   Loop Selection (Wybór pętli)    Alt/Opt – P

MIDI Retrospective Record: Insert from All 
MIDI Inputs (Retrospektywny zapis MIDI: 
Wstaw ze wszystkich wejść MIDI)

   Shift - Num - -* 

   Nudge Cursor Left (Przesuń kursor w lewo)    Ctrl/Cmd - Num -

   Nudge Cursor Right (Przesuń kursor w prawo)    Ctrl/Cmd - Num +

Panel (Transport panel) (Panel (panel 
transportu))

   F2

  Play Selection Range (Odtwórz zakres wyboru)    Alt/Opt – Spacja
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Opcja Skrót klawiszowy
Recall Cycle Marker 1 to 9 (Przywołaj znacznik 
cyklu od 1 do 9)

   Shift - Num 1 do Num 9

   Record (Nagrywaj)    Num *

   Rewind (Przewin do tyłu)    Num -

Set Left Locator to Project Cursor Position 
(Ustaw lewy lokalizator na pozycję kursora 
projektu)

   Ctrl/Cmd - Num 1

   Set Marker 1 (Ustaw znacznik 1)    Ctrl/Cmd – 1

   Set Marker 2 (Ustaw znacznik 2)    Ctrl/Cmd – 2

   Set Marker 3 to 9 (Ustaw znacznik 3 do 9)
   Ctrl/Cmd - Num 3 do Num 9 lub Ctrl/Cmd - 
      3 do 9

Set Right Locator to Project Cursor Position 
(Ustaw Prawy lokalizator na pozycję kursora 
projektu)

   Ctrl/Cmd - Num 2

   Start (Zacznij)    Enter

   Start/Stop    Spacja

   Stop (Zatrzymaj)    Num 0

   To Marker 1 (Do znacznika 1)    Shift - 1

   To Marker 2 (Do znacznika 2)    Shift – 2

   To Marker 3 to 9 (Do znacznika 3 do 9)    Num 3 do Num 9 lub Shift - 3 do 9

Kategoria Window Zones (Strefy Okienne)

Opcja Skrót klawiszowy

 Show/Hide Left Zone (Pokaż/ukryj lewą strefę)    Ctrl/Cmd -Alt/Opt - L ; Alt/Opt -I

Show/Hide Right Zone (Pokaż/Ukryj prawą 
strefę)

   Ctrl/Cmd -Alt/Opt - R

Show/Hide Upper Zone (Pokaż/ukryj górną 
strefę)

   Ctrl/Cmd - Alt/Opt - U

Show/Hide Lower Zone (Pokaż/ukryj dolną 
strefę)

   Ctrl/Cmd -Alt/Opt - E lub Ctrl/Cmd –
   Alt/Opt - B

Show/Hide Transport Bar (Pokaż/ukryj pasek 
transportu)

   Ctrl/Cmd -Alt/Opt - T

   Show Previous Tab (Pokaż poprzednią kartę)    Ctrl/Cmd -Alt/Opt – strzałka w lewo

   Show Next Tab (Pokaż następną kartę)    Ctrl/Cmd -Alt/Opt -  strzałka w prawo
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Opcja Skrót klawiszowy

  Show Previous Page (Pokaż poprzednią stronę)
Ctrl/Cmd-Alt/Opt-Up=strzałka w górę lub 
Page Up

   Show Next Page (Pokaż następną stronę)
Ctrl/Cmd -Alt/Opt – strzałka w dół lub Page 
Down

Show/Hide Info Line (Pokaż/ukryj linię 
informacyjną)

   Ctrl/Cmd –I

   Show/Hide Overview (Pokaż/ukryj przegląd)    Alt/Opt – O

Kategoria Workspaces (obszarów roboczych)

Opcja Skrót klawiszowy

   New (Nowy)    Ctrl/Cmd - Num 0

   NO Workspace (Brak obszaru roboczego)    Alt/Opt - Num 0

Update Workspace (Zaktualizuj obszar roboczy)    Alt/Opt – U

   Workspace 1-9 (Obszar roboczy 1-9)    Alt/Opt - Num 1 - Num 9

   Workspace X (Przestrzeń robocza X)    Ctrl/Cmd -Alt/Opt - Num 0

Kategoria Zoom (powiększenia)

Opcja Skrót klawiszowy

   Zoom Ful (Zoom pełny)    Shift – F

   Zoom In (Powiększ)    H

Zoom In On Waveform Vertically (Powiększ 
przebieg w pionie)

   Alt/Opt – H

   Zoom In Tracks (Powiększ ścieżki)    Ctrl/Cmd – strzałka w dół

   Zoom In Vertically (Powiększ w pionie)    Shift – H

   Zoom Out (Pomniejsz)    G

Zoom Out Of Waveform Vertically (Pomniejsz 
przebieg w pionie)

   Alt/Opt – G

   Zoom Out Tracks (Pomniejsz ścieżki)    Ctrl/Cmd – strzałka w górę

   Zoom Out Vertically (Pomniejsz w pionie)    Shift – G
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Opcja Skrót klawiszowy

   Zoom to Event (Powiększ do zdarzenia)    Shift - E

   Zoom to Selection (Powiększ do zaznaczenia)    Alt/Opt – S

Zoom Tracks Exclusive (Powiększ ekskluzywne 
ścieżki)

   Z

Konfigurowanie klawiszy modyfikujących narzędzia 
Można skonfigurować klawisze modyfikujące narzędzia, które umożliwiają uzyskanie 
alternatywnej funkcji podczas korzystania z narzędzia.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wybierz Editing > Tool Modifiers (Edycja > 
    Modyfikatory narzędzi).

            

2. Wybierz opcję na liście Categories (Kategorie) i znajdź akcję, dla której chcesz edytować 
    klawisz modyfikujący.
3. Na liście Action (Akcja) wybierz akcję.
4. Przytrzymaj żądane klawisze modyfikujące i kliknij Assign (Przypisz).

UWAGA
Jeżeli naciśnięte modyfikowane klawisze są już przypisane do innego narzędzia, zostaniesz 
zapytany, czy chcesz je zastąpić. Jeśli to zrobisz, drugie narzędzie pozostanie bez przypisanych 
klawiszy modyfikujących.

5. Kliknij OK

WYNIK
Klawisze modyfikujące dla akcji zostały zastąpione.
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Customizing (Dostosowywanie)

W Cubase możesz organizować okna i okna dialogowe w obszarach roboczych, konfigurować 
wygląd określonych elementów i zapisywać ustawienia programu jako profile.

POWIĄZANE LINKI
Obszary robocze na stronie 1142
Opcje konfiguracji na stronie 1145
Profile na stronie 1147

Workspaces (Obszary robocze)
Obszary robocze w Cubase pozwalają organizować okna i określone okna dialogowe dla typowych 
procedur pracy.

Obszar roboczy zapisuje rozmiar, położenie i układ lub ustawienia ważnych okien i okien 
dialogowych, takich jak okno Project, MixConsole lub panel Transport. Można zdefiniować kilka
obszarów roboczych. Umożliwia to szybkie przełączanie pomiędzy różnymi trybami pracy za 
pomocą menu Workspaces (Obszary robocze) lub za pomocą poleceń klawiszowych

Możesz zdefiniować różne typy obszarów roboczych, które są dostępne dla wszystkich projektów 
na Twoim komputerze lub specyficzne dla jednego projektu. Jednak po otwarciu projektu 
domyślnie otwierany jest jego ostatni zapisany widok. Widok to układ okna i ustawienie 
zdefiniowane dla projektu. Ostatni zapisany widok może być widokiem obszaru roboczego lub 
widokiem zapisanym bez wybierania żadnego obszaru roboczego. Kiedy otwierasz projekt 
zewnętrzny, domyślnie używany jest ostatnio używany widok na Twoim komputerze.

Workspaces Organizer (Organizator obszarów roboczych) i menu Workspaces (Obszary 
robocze) umożliwiają tworzenie i modyfikowanie obszarów roboczych.

UWAGA
● Możesz także pracować bez przestrzeni roboczych. W takim przypadku podczas tworzenia 
   nowego projektu zostanie użyty ostatnio używany widok poprzedniego projektu.
● W oknie dialogowym Preferences (Preferencje) (strona General (Ogólne)) możesz wybrać, 
   który widok będzie używany podczas otwierania projektu.

POWIĄZANE LINKI
Otwórz projekty w widoku Ostatnio używanego na stronie 1170

Typy obszarów roboczych
Można tworzyć globalne obszary robocze lub obszary robocze projektu.

Global Workspaces (Globalne obszary robocze)
Umożliwia zapisanie określonego układu okien dialogowych i okien dla wszystkich projektów na 
komputerze. Globalne obszary robocze są oznaczone literą G w menu Workspaces (Obszary 
robocze).

Project Workspaces (Obszary robocze projektu)
Umożliwia zapisanie określonego układu okien dialogowych i okien, który jest zapisany w 
bieżącym projekcie. Dzięki temu możesz otworzyć układ projektu na innych komputerach. Obszary
robocze projektu są oznaczone literą P w menu Workspaces.
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Przestrzenie robocze dla projektów zewnętrznych
Możesz określić widok projektów zewnętrznych po otwarciu ich w Cubase.

Kiedy otwierasz projekty zewnętrzne, czyli projekty utworzone na innych komputerach, domyślnie 
stosowane są ustawienia okien i okien dialogowych ostatnio używanych na Twoim komputerze. 
Może to być ostatni używany widok zapisany na Twoim komputerze lub jeden z określonych 
globalnych obszarów roboczych.

Jeśli chcesz otworzyć oryginalne ustawienia układu projektu, masz następujące możliwości:
● Wybierz oryginalny układ projektu z obszarów roboczych projektu w menu Workspaces  
   (Przestrzenie robocze) lub w Workspace Organizer (Organizatorze przestrzeni roboczej).
● W oknie dialogowym Preferences (Preferencje) (strona General (Ogólne)) wybierz opcję Never 
   (Nigdy) z menu Open Projects in Last Used View (Otwórz projekty w widoku Ostatnio 
   używanym). Spowoduje to otwarcie wszystkich projektów zewnętrznych przy użyciu ich 
   oryginalnego układu. Może to jednak prowadzić do modyfikacji niestandardowego układu.
Aby powrócić do ostatnio zapisanego widoku bez przypisanego obszaru roboczego, wybierz opcję 
No Workspace (Brak obszaru roboczego) w menu Workspaces (Obszary robocze).

POWIĄZANE LINKI
Organizator obszarów roboczych na stronie 1144
Otwórz projekty w widoku Ostatnio używane na stronie 1170

Tworzenie obszarów roboczych
Aby zapisać bieżące ustawienia okna dialogowego i okna do wykorzystania w przyszłości, możesz 
utworzyć nowy obszar roboczy.

PROCEDURA
1. Wybierz Workspaces > Add Workspace (Obszary robocze > Dodaj obszar roboczy).
2. W polu Name (Nazwa) okna dialogowego New Workspace (Nowy obszar roboczy) wprowadź 
    nazwę obszaru roboczego.
3. Wybierz typ przestrzeni roboczej, którą chcesz utworzyć.
      ●   Global Workspace (Globalna przestrzeń robocza)
      ●   Project Workspace (Obszar roboczy projektu)
4. Kliknij OK.

WYNIK
Obszar roboczy zostanie zapisany i dodany do menu Workspaces (Obszary robocze).

Edytowanie obszarów roboczych
Możesz modyfikować utworzone obszary robocze.
UWAGA
Aby zmienić globalny obszar roboczy na obszar roboczy projektu i odwrotnie, należy zapisać go 
jako obszar roboczy innego typu.

PROCEDURA
1. W menu Workspaces (Obszary robocze) wybierz obszar roboczy, który chcesz zmodyfikować.
2. Wprowadź wymagane zmiany.
3. W menu Workspaces wybierz jedną z następujących opcji:
● Aby zaktualizować bieżący obszar roboczy, kliknij Update Workspace (Aktualizuj obszar 
   roboczy).
● Aby zapisać swój obszar roboczy jako inny obszar roboczy lub typ obszaru roboczego, kliknij    
   Add Workspace (Dodaj obszar roboczy).
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POWIĄZANE LINKI
Tworzenie obszarów roboczych na stronie 1143

Workspaces Organizer (Organizator przestrzeni roboczych)
Workspaces Organizer umożliwia zarządzanie istniejącymi obszarami roboczymi.

● Aby otworzyć Workspaces Organizer kliknij Workspaces > Organize (Obszary robocze > 
   Organizuj).

                 

Workspaces Organizer wyświetla globalne obszary robocze i obszary robocze projektu na 
osobnych listach. Do każdego obszaru roboczego przypisane jest polecenie klawiszowe, które 
umożliwia szybkie przełączanie widoków. Przenoszenie lub usuwanie obszarów roboczych na 
listach powoduje zmianę przypisań poleceń klawiszowych. Kiedy zmieniasz położenie obszaru 
roboczego, przypisania poleceń klawiszowych pozostają na pierwotnej pozycji na liście. Możesz 
kliknąć polecenie klawiszowe wybranego obszaru roboczego, aby otworzyć przypisanie 
odpowiedniego polecenia klawiszowego w kategorii Workspace (Obszar roboczy) w oknie 
dialogowym Key Commands (Polecenia klawiszowe).

Aby zorganizować przestrzeń roboczą, masz następujące możliwości:
Add (Dodaj)
     Umożliwia utworzenie nowego obszaru roboczego za pomocą okna dialogowego New 
     Workspace (Nowy obszar roboczy).
Delete (Usuń)
     Usuwa wybrany obszar roboczy.
Move Up (Podnieś)
     Przesuwa obszar roboczy o jedną pozycję w górę.
Move Down (Opuść)
     Przechodzi w dół obszaru roboczego o jedną pozycję.

UWAGA
● Możesz także kliknąć i przeciągnąć obszar roboczy w inne miejsce na liście.
● Obszary robocze można przenosić wyłącznie w ramach listy. Aby globalny obszar roboczy stał   
   się obszarem roboczym projektu i odwrotnie, należy zapisać go jako obszar roboczy innego typu.
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● Aby zmienić nazwę obszaru roboczego, możesz dwukrotnie kliknąć nazwę obszaru roboczego.

POWIĄZANE LINKI
Kategoria Obszary robocze na stronie 1140

Opcje konfiguracji

Możesz dostosować wygląd następujących elementów:
● Panel Transport
● Linia stanu
● Linia informacyjna
● Paski narzędzi
● Inspektor

Konfiguracja menu kontekstowego
Menu kontekstowe ustawień są dostępne dla panelu Transport, pasków narzędzi, linii 
informacyjnych i Inspektora.

● Aby otworzyć menu kontekstowe ustawień, kliknij prawym przyciskiem myszy odpowiedni 
   element.
● UWAGA
   Możesz także kliknąć odpowiednie przyciski konfiguracji, aby otworzyć menu kontekstowe.

W menu kontekstowym ustawień dostępne są następujące opcje ogólne:
●   Show All (Pokaż wszystko) powoduje, że wszystkie elementy stają się widoczne.
●   Reset All (Resetuj wszystko) resetuje interfejs do ustawień domyślnych.
●   Setup (Konfiguracja) otwiera okno dialogowe konfiguracji.

Jeśli dostępne są ustawienia wstępne, można je wybrać w dolnej połowie menu.
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Menu kontekstowe konfiguracji linii informacyjnej

Okno dialogowe Setup (Konfiguracja)
Okno dialogowe ustawień pozwala określić, które elementy są widoczne/ukryte i w jakiej 
kolejności mają być wyświetlane. Można zapisywać i przywoływać gotowe ustawienia wstępne 
ustawień.
● Aby otworzyć okno dialogowe ustawień, kliknij prawym przyciskiem myszy element, który 
   chcesz skonfigurować i wybierz Setup (Ustawienia).

               

Hidden Items (Ukryte elementy)
      Wyświetla listę elementów, które są ukryte.
Visible Items (Widoczne elementy)_
      Wyświetla listę elementów, które są widoczne.
Add (Dodaj)
      Wybierz element na liście Hidden Items (Ukrytych elementów) i kliknij Add (Dodaj), aby był 
      widoczny.
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Remove (Usuń)
      Wybierz element na liście Visible Items (widocznych elementów) i kliknij Remove, aby go 
      ukryć.
Move Up (Podnieś)
      Wybierz element na liście Visible Items i kliknij Move Up (Przenieś w górę), aby zmienić 
      kolejność elementów.
Move Down (Opuść)
      Wybierz element na liście Visible Items i kliknij Move Down (Przenieś w dół), aby zmienić  
      kolejność elementów.
Store (Zachowaj)
      Umożliwia nazwanie bieżącej konfiguracji i zapisanie jej jako ustawienia wstępnego.
Delete (Usuń)
      Usuń wybrane ustawienie wstępne.
Reset All (Zresetuj wszystko)
      Przywraca konfigurację domyślną.

Profile
Profile umożliwiają zapisanie dostosowanych ustawień i preferencji programu. Możesz przełączać 
się między profilami oraz importować i eksportować swoje profile do użytku na różnych 
komputerach.

Profile są przydatne, jeśli pracujesz na różnych komputerach, jeśli używasz różnych ustawień dla 
różnych rodzajów projektów lub w środowisku studyjnym, gdzie kilku użytkowników pracuje na 
tym samym komputerze. Profile zapisywane są jako pliki z rozszerzeniem nazwy pliku .srf.

Profile obejmują:
● Preferencje
● Ustawienia paska narzędzi dla wszystkich okien
● Globalne przestrzenie robocze
● Ustawienia kontrolerów ścieżki
● Ustawienia wstępne kontrolerów ścieżki
● Presety dla szyn wejściowych i wyjściowych
● Wstępne ustawienia formatu pliku
● Kolekcje wtyczek
● Predefiniowane ustawienia kwantyzacji
● Wstępne ustawienia przenikania
● Polecenia klawiszowe (skróty klawiszowe)

Wszystkie zmiany dokonane w tych ustawieniach są zapisywane w aktywnym profilu.

WAŻNE
Następujące elementy nie są uwzględniane w profilach: Ustawienia w oknie dialogowym Studio 
Setup (Ustawienia studia) i w oknie Audio Connections (Połączenia audio), Ustawienia wstępne 
na karcie Control Room (Reżyserka) w oknie Audio Connections, Ustawienia wstępne ścieżek, 
Ustawienia wstępne wtyczek i szablony projektów.

Okno dialogowe Profile Manager (Menedżer profili)
Profile Manager umożliwia zapisywanie dostosowanych ustawień programu w postaci profili 
i organizowanie profili na komputerze.

● Aby otworzyć Profile Manager, wybierz Edit > Profile Manager (Edycja > Menedżer profili).
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W oknie dialogowym zostaną wyświetlone wszystkie dostępne profile. Aktywny profil jest 
oznaczony znacznikiem wyboru.

Aby uporządkować swoje profile, masz następujące możliwości:
New (Nowy)
      Dodaje nowy profil z ustawieniami fabrycznymi.
Duplicate (Duplikuj)
      Duplikuje wybrany profil.
Rename (Przemianuj)
      Umożliwia zmianę nazwy wybranego profilu.
Delete (Usuń)
      Usuwa wybrany profil.
Import
      Otwiera okno dialogowe umożliwiające import profilu z pliku.
Export (Eksport)
      Otwiera okno dialogowe umożliwiające eksport wybranego profilu do pliku.
Activate Profile (Aktywuj profil)
      Aktywuje wybrany profil. Aby zmiana zaczęła obowiązywać, należy ponownie uruchomić 
      program.
Close (Zamknij)
      Zamyka okno dialogowe.

Tworzenie profili
Profile Manager (Menedżer profili) umożliwia utworzenie nowego profilu opartego na 
domyślnych ustawieniach fabrycznych.

PROCEDURA
1. Wybierz Edit > Profile Manager (Edycja > Menedżer profili).
2. W Profile Manager (Menedżerze profili) kliknij New (Nowy).
3. W oknie dialogowym Add New Profile (Dodaj nowy profil) wprowadź nazwę profilu i kliknij 
    OK.

WYNIK
Nowy profil zostanie dodany do listy.
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PO ZAKOŃCZENIU TEGO ZADANIA
Aktywuj nowy profil, aby zastosować ustawienia.

POWIĄZANE LINKI
Aktywacja profili na stronie 1149

Powielanie profili
Profile Manager (Menedżer profili) umożliwia utworzenie duplikatu profilu i zapisanie go pod 
inną nazwą.

PROCEDURA
1. Wybierz Edit > Profile Manager (Edycja > Menedżer profili).
2. W Profile Manager (Menedżerze profili) wybierz profil, który chcesz powielić.
3. Kliknij opcję Duplicate (Duplikuj).
4. W oknie dialogowym Duplicate Profile (Powiel profil) wprowadź nazwę profilu i kliknij OK.

WYNIK
Nowy profil zostanie dodany do listy.

Aktywacja profili
Profile Manager (Menedżer profili) umożliwia przełączenie na inny profil. Zmiana profilu 
wymaga ponownego uruchomienia Cubase.

WARUNEK WSTĘPNY
Zapisałeś co najmniej dwa profile.

PROCEDURA
1. Wybierz Edit > Profile Manager (Edycja > Menedżer profili).
2. W Profile Manager (Menedżerze profili) wybierz profil, który chcesz aktywować.
3. Kliknij Activate Profile (Aktywuj profil).
4. Kliknij OK.
5. Uruchom ponownie aplikację.

WYNIK
Ustawienia profilu są teraz aktywne.

Zmiana nazwy profili
Profile Manager (Menedżer profili) umożliwia zmianę nazw profili.

PROCEDURA
1. Wybierz Edit > Profile Manager (Edycja > Menedżer profili).
2. W Profile Manager (Menedżerze profili) wybierz profil, którego nazwę chcesz zmienić.
3. Kliknij Rename (Zmień nazwę).
4. W oknie dialogowym Rename Profile (Zmień nazwę profilu) wprowadź nazwę profilu 
    i kliknij OK.
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Usuwanie profili
Profile Manager (Menedżer profili) umożliwia usuwanie profili.

WARUNEK WSTĘPNY
Zapisałeś co najmniej dwa profile.

UWAGA
Nie można usunąć aktywnego profilu.

PROCEDURA
1. Wybierz Edit > Profile Manager (Edycja > Menedżer profili).
2. W Profile Manager (Menedżerze profili) wybierz profil, który chcesz usunąć.
    Wybierz wiele profili, aby je usunąć jednocześnie.
3. Kliknij Delete (Usuń).
4. Kliknij OK.

POWIĄZANE LINKI
Aktywacja profili na stronie 1149

Eksportowanie profili
Profile Manager (Menedżer profili) umożliwia eksport profili do użycia na innym komputerze.

PROCEDURA
1. Wybierz Edit > Profile Manager (Edycja > Menedżer profili).
2. W Profile Manager (Menedżerze profili) wybierz profil, który chcesz wyeksportować.
3. Kliknij Export (Eksportuj).
4. W oknie dialogowym pliku określ nazwę pliku i lokalizację.
5. Kliknij Save (Zapisz).

WYNIK
Wyeksportowany profil zostanie zapisany jako plik .srf we wskazanej lokalizacji.

PO ZAKOŃCZENIU TEGO ZADANIA
Zaimportuj profil na inny komputer.

Importowanie profili
Profile Manager (Menedżer profili) umożliwia importowanie profili.

PROCEDURA
1. Wybierz Edit > Profile Manager (Edycja > Menedżer profili).
2. W Profile Manager (Menedżerze profili) kliknij opcję Import (Importuj).
3. W oknie dialogowym pliku wybierz profil, który chcesz zaimportować.
4. Kliknij Open (Otwórz).

WYNIK
Zaimportowany profil zostanie dodany do listy dostępnych profili.
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PO ZAKOŃCZENIU TEGO ZADANIA
Aktywuj nowy profil, aby zastosować ustawienia.

POWIĄZANE LINKI
Aktywacja profili na stronie 1149

Okno dialogowe Windows (Okna)
Okno dialogowe Windows pozwala na zarządzanie otwartymi oknami w Cubase.

● Aby otworzyć okno dialogowe Windows, wybierz Window > Windows (Okno > Windows).

              

Okno dialogowe zawiera listę wszystkich otwartych okien dialogowych, okien i edytorów. 
Dostępne są następujące opcje:
OK
      Zamyka okno dialogowe.
Mode (Tryb)
      Umożliwia wybór trybu wpływającego na daną funkcję.
      ●   Selected (Wybrane)
              Wpływa tylko na wybrane okno.
      ●   Cascaded (Kaskadowo)
              Ma wpływ również na powiązane okna, na przykład na edytory okna projektu.
      ●   All (Wszystko)
              Wpływa na wszystkie okna.
Activate (Aktywuj)
      Aktywuje wybrane okno.
Minimize (Zminimalizuj)
      Minimalizuje wybrane lub wszystkie okna.
Restore (Przywróć)
      Przywraca wybrane lub wszystkie okna.
Close Windows (Zamknij system Windows)
      Zamyka wybrane lub wszystkie okna.
Reset Layout (Zresetuj układ)
      Resetuje układ wybranego okna.
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Gdzie są przechowywane ustawienia?
Istnieje wiele sposobów dostosowywania Cubase. Chociaż niektóre wprowadzone ustawienia są 
przechowywane w każdym projekcie, inne są przechowywane w oddzielnych plikach preferencji.

Jeśli na przykład chcesz przenieść swoje projekty na inny komputer w innym studiu, możesz zabrać
ze sobą wszystkie ustawienia, kopiując żądane pliki preferencji i instalując je na innym komputerze.

UWAGA
Po skonfigurowaniu wszystkiego tak, jak chcesz, dobrym pomysłem jest wykonanie kopii 
zapasowej plików preferencji! W ten sposób, jeśli inny użytkownik Cubase będzie chciał skorzystać
ze swoich osobistych ustawień podczas pracy na Twoim komputerze, będziesz mógł później 
przywrócić swoje preferencje.

● W systemie Windows pliki preferencji są przechowywane w następującej lokalizacji: 
   „\Użytkownicy\<nazwa użytkownika>\AppData\Roaming\Steinberg\<nazwa programu>\”.
   W menu Start znajdziesz skrót do tego folderu, zapewniający łatwy dostęp.
● W systemie macOS pliki preferencji są przechowywane w następującej lokalizacji:   
   „/Library/Preferences/<nazwa programu>/” w katalogu domowym.
   Pełna ścieżka to: „/Users/<nazwa użytkownika>/Library/Preferences/<nazwa programu>/”.

UWAGA
Plik RAMpresets.xml, który zawiera różne ustawienia presetów, jest zapisywany przy wyjściu z 
programu.

UWAGA
Funkcje programu, takie jak crossfade, czy konfiguracje, takie jak panele, nie użyte w projekcie nie 
zostaną zapisane.

Aktualizacja z poprzedniej wersji Cubase

Podczas aktualizacji z wersji Cubase 6 lub nowszej większość dostosowanych ustawień z 
poprzedniej instalacji jest używana w nowej wersji Cubase.

Jeśli Twoja poprzednia wersja Cubase jest starsza niż Cubase 6, jej ustawienia zostaną odrzucone i 
użyte zostaną ustawienia domyślne nowej wersji Cubase.

Okno dialogowe Safe Mode (trybu awaryjnego)
Okno dialogowe Safe Mode zawiera opcje rozwiązywania problemów.

● Aby otworzyć okno Safe Mode (Trybu Awaryjnego), uruchom Cubase i przytrzymaj Ctrl/Cmd –
   Shift -Alt/Opt.
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W sekcji Plug-Ins (Wtyczki) dostępne są następujące opcje:
Deactivate all third-party plug-ins (Dezaktywuj wszystkie wtyczki innych firm)
    Czasowo wyłącza wszystkie wtyczki innych firm. Po uruchomieniu dostępne są tylko wtyczki 
    Steinberg.

W sekcji Preferences (Preferencje) dostępne są następujące opcje:
Use current program preferences (Użyj aktualnych preferencji programu)
    Otwiera program z bieżącymi ustawieniami preferencji.
Disable program preferences (Wyłącz preferencje programu)
    Wyłącza bieżące preferencje i zamiast tego otwiera program z domyślnymi ustawieniami 
    fabrycznymi.
Delete program preferences (Usuń preferencje programu)
    Usuwa preferencje i zamiast tego otwiera program z domyślnymi ustawieniami fabrycznymi. 
    Tego procesu nie można cofnąć. Dotyczy to wszystkich wersji Cubase zainstalowanych na 
    Twoim komputerze.

POWIĄZANE LINKI
Wyłączanie wtyczek innych firm na stronie 1154
Wyłączanie preferencji na stronie 1153

Wyłączanie preferencji
Czasami możesz doświadczyć dziwnego zachowania programu, które może wynikać z niespójnych 
ustawień preferencji. W takim przypadku powinieneś zapisać swój projekt i ponownie uruchomić 
Cubase. Możesz wyłączyć lub usunąć bieżące ustawienia preferencji i zamiast tego załadować 
ustawienia fabryczne.

PROCEDURA
1. Opuść Cubase.
2. Uruchom Cubase i przytrzymaj Ctrl/Cmd -Alt/Opt - Shift .
3. W sekcji Preferences (Preferencje) okna dialogowego Safe Start Mode (Tryb bezpiecznego 
    startu) aktywuj jedną z opcji rozwiązywania problemów.
      ●   Use current program preferences (Użyj bieżących preferencji programu)
              Otwiera program z bieżącymi ustawieniami preferencji.
      ●   Disable program preferences (Wyłącz preferencje programu)
              Wyłącza bieżące preferencje i zamiast tego otwiera program z domyślnymi ustawieniami 
              fabrycznymi.
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      ●   Delete program preferences (Usuń preferencje programu)
             Usuwa preferencje i zamiast tego otwiera program z domyślnymi ustawieniami 
             fabrycznymi. Tego procesu nie można cofnąć. Pamiętaj, że dotyczy to wszystkich wersji 
             Cubase zainstalowanych na Twoim komputerze.
4. Kliknij OK.

PO ZAKOŃCZENIU TEGO ZADANIA
Jeśli program działa poprawnie z wyłączonymi preferencjami, rozważ usunięcie i ponowne 
zainicjowanie preferencji

POWIĄZANE LINKI
Okno dialogowe trybu awaryjnego na stronie 1152
Preferencje na stronie 1159

Wyłączanie wtyczek innych firm
Jeśli Cubase nie uruchamia się lub projekt się nie ładuje, istnieje prawdopodobieństwo, że jest to 
spowodowane przez wtyczkę innej firmy. W takim przypadku możesz wyłączyć wtyczki innych 
firm podczas uruchamiania, aby sprawdzić, czy przyczyną jest wtyczka.

PROCEDURA
1. Opuść Cubase.
2. Uruchom Cubase i przytrzymaj Ctrl/Cmd -Alt/Opt - Shift .
3. W sekcji Plug-Ins (Wtyczki) okna dialogowego Safe Start Mode (Tryb bezpiecznego startu)   
    aktywuj opcję Deactivate all third-party plug-ins (Dezaktywuj wszystkie wtyczki innych firm).
4. Kliknij OK.

WYNIK
Po uruchomieniu dostępne są tylko wtyczki Steinberg, a wtyczki innych firm są tymczasowo 
wyłączone.

POWIĄZANE LINKI
Okno dialogowe trybu awaryjnego na stronie 1152
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Optymalizacja wydajności dźwięku

Aby jak najlepiej wykorzystać system Cubase pod względem wydajności, możesz zoptymalizować 
określone ustawienia.

UWAGA
Szczegółowe informacje oraz aktualne informacje na temat wymagań systemowych i właściwości 
sprzętu można znaleźć na stronie internetowej firmy Steinberg.

Aspekty wydajności

Ścieżki i efekty
Im szybszy komputer, tym więcej ścieżek, efektów i korektorów możesz odtwarzać. To, co 
dokładnie składa się na szybki komputer, jest prawie nauką samą w sobie, ale poniżej podano 
pewne wskazówki.

Krótkie czasy reakcji (Latency (opóźnienie))
Jednym z aspektów wydajności jest czas reakcji. Termin „latency” odnosi się do buforowania, czyli
tymczasowego przechowywania małych fragmentów danych audio na różnych etapach procesu 
nagrywania i odtwarzania na komputerze. Im większe są te fragmenty i im jest ich więcej, tym 
większe jest opóźnienie.

Duże opóźnienia są najbardziej irytujące podczas gry na instrumentach VST i podczas 
monitorowania przez komputer, to znaczy podczas słuchania źródła dźwięku na żywo za 
pośrednictwem Cubase MixConsole i efektów. Jednakże bardzo długie czasy opóźnienia (kilkaset 
milisekund) mogą mieć także wpływ na inne procesy, np. miksowanie, gdy na przykład efekt ruchu 
tłumika jest słyszalny dopiero z zauważalnym opóźnieniem.

Chociaż bezpośrednie monitorowanie i inne techniki redukują problemy związane z bardzo długimi 
czasami opóźnień, praca z systemem, który reaguje szybko, zawsze będzie wygodniejsza.

● W zależności od sprzętu audio możliwe może być skrócenie czasów opóźnień, zwykle poprzez  
   zmniejszenie rozmiaru i liczby buforów.
● Szczegółowe informacje można znaleźć w dokumentacji sprzętu audio.

Sprzęt audio i sterownik
Sprzęt i jego sterownik mogą mieć pewien wpływ na normalną wydajność. Źle napisany sterownik 
może zmniejszyć wydajność komputera. Jednak największą różnicą w konstrukcji sterownika 
sprzętowego jest opóźnienie (latency).

UWAGA
Zalecamy używanie sprzętu audio, dla którego istnieje specjalny sterownik ASIO.

Jest to szczególnie prawdziwe w przypadku korzystania z Cubase dla Windows:
● W systemie Windows sterowniki ASIO napisane specjalnie dla tego sprzętu są bardziej wydajne 
   niż ogólny sterownik ASIO o niskim opóźnieniu i zapewniają krótsze czasy opóźnień.
● W systemie macOS sprzęt audio z prawidłowo napisanymi sterownikami macOS (Core Audio) 
   może być bardzo wydajny i zapewniać bardzo niskie czasy opóźnień.
Istnieją jednak dodatkowe funkcje dostępne tylko w przypadku sterowników ASIO, takie jak 
protokół pozycjonowania ASIO.
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Ustawienia wpływające na wydajność

Ustawienia bufora audio
Bufory audio wpływają na sposób przesyłania dźwięku do i ze sprzętu audio. Rozmiar buforów 
audio wpływa zarówno na opóźnienie, jak i na jakość dźwięku.

Ogólnie rzecz biorąc, im mniejszy rozmiar bufora, tym mniejsze opóźnienie. Z drugiej strony praca 
z małymi buforami może być wymagająca dla komputera. Jeśli bufory audio są zbyt małe, mogą 
wystąpić kliknięcia, trzaski lub inne problemy z odtwarzaniem dźwięku.

Dopasowywanie rozmiaru bufora
Aby zmniejszyć opóźnienie, można zmniejszyć rozmiar bufora.

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz sterownik sprzętu audio.
3. Kliknij Control Panel (Panel sterowania).
4. Wykonaj jedną z następujących czynności:
      ●   Windows: Dostosuj rozmiar bufora w otwartym oknie dialogowym.
      ●   macOS: Dostosuj rozmiar bufora w oknie dialogowym CoreAudio Device Settings  
           (Ustawienia urządzenia CoreAudio).

Wieloprzetwarzanie
Wieloprzetwarzanie rozkłada obciążenie przetwarzania równomiernie na wszystkie dostępne 
procesory, umożliwiając Cubase pełne wykorzystanie łącznej mocy wielu procesorów.

Domyślnie włączone jest przetwarzanie wielokrotne (multiprocessing). To ustawienie można 
znaleźć w oknie dialogowym Studio Setup (konfiguracji studia) (strona Audio System (System 
audio)).

Okno Audio Performance (wydajności audio)
To okno pokazuje obciążenie przetwarzania dźwięku i szybkość transferu dysku twardego. Dzięki 
temu możesz sprawdzić, czy nie występują problemy z wydajnością, na przykład podczas 
dodawania efektów lub wtyczek.

● Aby otworzyć okno Audio Performance (Wydajność audio), wybierz Studio > Audio 
   Performance (Studio > Wydajność audio).

               

Average load (Średnie obciążenie)
     Pokazuje, jaka część dostępnej mocy procesora jest wykorzystywana do przetwarzania dźwięku.
Real-time peak (Szczyt w czasie rzeczywistym)
     Pokazuje obciążenie przetwarzania w ścieżce czasu rzeczywistego silnika audio. Im wyższa 
     wartość, tym większe ryzyko wystąpienia rezygnacji.
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Overload indicator (Wskaźnik przeciążenia)
     Wskaźnik przeciążenia po prawej stronie real-time peak (wskaźnika szczytowego czasu 
     rzeczywistego) i wskaźnika average load (średniego obciążenia) wyświetlają przeciążenia 
     wskaźnika średniego lub wskaźnika czasu rzeczywistego. Jeśli się zaświeci, zmniejsz liczbę 
     modułów EQ, aktywnych efektów i kanałów audio odtwarzanych jednocześnie. Możesz także 
     aktywować ASIO-Guard.
Disk (Dysk)
     Pokazuje obciążenie transferu dysku twardego.
Disk overload indicator (Wskaźnik przeciążenia dysku)
     Wskaźnik przeciążenia po prawej stronie wskaźnika dysku zapala się, jeśli dysk twardy nie  
     dostarcza danych wystarczająco szybko. Jeśli się zaświeci, użyj opcji Disable Track (Wyłącz 
     ścieżkę), aby zmniejszyć liczbę odtwarzanych ścieżek. Jeśli to nie pomoże, potrzebujesz 
     szybszego dysku twardego.

UWAGA
Możesz wyświetlić prosty widok miernika wydajności na panelu Transport i na pasku narzędzi 
okna Project. Mierniki te posiadają jedynie średnią i wskaźnik dysku.

ASIO-Guard
ASIO-Guard umożliwia przeniesienie jak największej ilości przetwarzania ze ścieżki czasu 
rzeczywistego ASIO na ścieżkę przetwarzania ASIO-Guard. Dzięki temu system jest bardziej 
stabilny.

ASIO-Guard umożliwia wstępne przetwarzanie wszystkich kanałów, a także instrumentów VST, 
które nie wymagają obliczeń w czasie rzeczywistym. Prowadzi to do mniejszej liczby przerw, 
możliwości przetwarzania większej liczby ścieżek lub wtyczek oraz możliwości korzystania z 
mniejszych rozmiarów buforów.

Opóźnienie ASIO-Guard
Wysokie poziomy ASIO-Guard prowadzą do zwiększonego opóźnienia ASIO-Guard. Na przykład 
podczas regulacji tłumika głośności zmiany parametrów będą słyszalne z niewielkim opóźnieniem. 
Opóźnienie ASIO-Guard, w przeciwieństwie do opóźnienia sprzętu audio, jest niezależne od 
sygnału wejściowego na żywo.

Ograniczenia

ASIO-Guard nie może być używany do:
      ●   Sygnałów zależnych od czasu rzeczywistego
      ●   Zewnętrznych efektów i instrumentów

UWAGA
Jeśli wybierzesz Studio > VST Plug-in Manager (Studio > Menedżer wtyczek VST) i klikniesz  
Show VST Plug-in Information (Pokaż informacje o wtyczce VST), możesz dezaktywować opcję 
ASIO-Guard dla wybranych wtyczek.

Jeśli aktywujesz monitorowanie dla kanału wejściowego, instrumentu MIDI lub kanału instrumentu
VST, kanał audio i wszystkie zależne kanały zostaną automatycznie przełączone z ASIO-Guard na 
przetwarzanie w czasie rzeczywistym i odwrotnie. Powoduje to delikatne zanikanie i zanikanie 
kanału audio.

POWIĄZANE LINKI
Ustawienia ścieżki wtyczki VST 2 na stronie 746
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Aktywacja ASIO-Guarda

PROCEDURA
1. Wybierz Studio > Studio Setup (Studio > Konfiguracja studia).
2. Na liście Devices (Urządzenia) wybierz Audio System (System audio).
3. Aktywuj opcję Activate ASIO-Guard (Aktywuj ASIO-Guard).

UWAGA
Ta opcja jest dostępna tylko po włączeniu opcji Activate Multi Processing (Aktywuj 
przetwarzanie wielokrotne).

4. Select an ASIO-Guard Level (Wybierz poziom ASIO-Guard).
    Im wyższy poziom, tym wyższa stabilność przetwarzania i wydajność przetwarzania dźwięku. 
    Jednak wyższe poziomy prowadzą również do zwiększonego opóźnienia ASIO-Guard i zużycia 
    pamięci.
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Preferences (Preferencje)

Okno dialogowe Preferences udostępnia opcje i ustawienia sterujące globalnym zachowaniem 
programu.

Okno dialogowe Preferences (Preferencje)
Okno dialogowe Preferences jest podzielone na listę nawigacyjną i stronę ustawień. Kliknięcie 
jednego z wpisów na liście nawigacyjnej powoduje otwarcie strony ustawień.

● Aby otworzyć okno dialogowe Preferences, wybierz Edit > Preferences (Edycja > Preferencje).

 
Oprócz ustawień okno dialogowe udostępnia następujące opcje:
Preference Presets (Wstępne ustawienia preferencji)
      Umożliwia wybranie zapisanego ustawienia wstępnego preferencji.
Store (Zachowaj)
      Umożliwia zapisanie bieżących preferencji jako ustawienie wstępne.
Rename (Przemianuj)
      Umożliwia zmianę nazwy ustawienia wstępnego.
Delete (Usuń)
      Umożliwia usunięcie ustawienia wstępnego.
Store marked preferences only (Przechowuj tylko zaznaczone preferencje)
      Umożliwia wybranie stron uwzględnionych w ustawieniach wstępnych.
Defaults (Domyślne)
      Resetuje opcje na aktywnej stronie do ustawień domyślnych.
Apply (Zastosuj)
      Stosuje wszelkie wprowadzone zmiany bez zamykania okna dialogowego.
OK
      Stosuje wszystkie wprowadzone zmiany i zamyka okno dialogowe.
Cancel (Anuluj)
      Zamyka okno dialogowe bez zapisywania zmian.
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Zapisywanie ustawień wstępnych preferencji
Możesz zapisać pełne lub częściowe ustawienia preferencji jako ustawienia wstępne.

PROCEDURA
1. W oknie dialogowym Preferences (Preferencje) wprowadź zmiany.
2. Kliknij opcję Store (Zachowaj) w lewej dolnej części okna dialogowego.
3. Wprowadź nazwę ustawienia wstępnego i kliknij OK

WYNIK
Twoje ustawienia są teraz dostępne w wyskakującym menu Preference Presets (Wstępne 
ustawienia preferencji).

Zapisywanie częściowych ustawień preferencji
Możesz zapisać częściowe ustawienia preferencji. Jest to przydatne, jeśli na przykład dokonano 
ustawień odnoszących się tylko do określonego projektu lub sytuacji. Po zastosowaniu zapisanych 
ustawień wstępnych częściowych preferencji zmieniasz tylko zapisane ustawienia. Wszystkie 
pozostałe preferencje pozostają niezmienione.

PROCEDURA
1. W oknie dialogowym Prferences (Preferencje) wprowadź zmiany.
2. Aktywuj Store marked preferences only (Zachowaj tylko zaznaczone preferencje).
    Na liście preferencji wyświetlana jest kolumna Store (Zachowaj).

               

3. Kliknij kolumnę Store obok stron preferencji, które chcesz zapisać.
4. Kliknij opcję Store w lewej dolnej części okna dialogowego.
5. Wprowadź nazwę ustawienia wstępnego i kliknij OK.
      
WYNIK
Twoje ustawienia są teraz dostępne w wyskakującym menu Preference Presets (Wstępne 
ustawienia preferencji).
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Editing (Redagowanie)

‘Edit Solo’/’Record in MIDI Editors’ Follow Focus („Edytuj solo”/„Nagraj w edytorach MIDI” 
Follow Focus)
     Wstrzymuje Record in Editor (Nagrywanie w edytorze) i Solo Editor (Edytorze solo) 
     w edytorze MIDI, jeśli okno Project zostanie aktywne.
Default Track Time Type (Domyślny typ czasu ścieżki)
     Umożliwia wybranie domyślnego typu czasu utworu dla nowych ścieżek.
      ●   Musical (Muzyczny)
            Ustawia nowe ścieżki na muzyczną podstawę czasu.
      ●   Time Linear (Liniowy czas)
            Ustawia nowe ścieżki na liniową podstawę czasu.
      ●   Follow Transport Main Display (Podążaj za głównym wyświetlaczem transportu)
            Ustawia nowe utwory zgodnie z podstawowym formatem czasu: Format Bars+Beats 
            (Takty+Uderzenia) ustawia nowe ścieżki na muzyczną podstawę czasu. Seconds (Sekundy),
            Timecode (kod czasowy), Samples (próbki) itp. ustawiają nowe ścieżki na liniową 
            podstawę czasu.
Display Warning before Deleting Non-Empty Tracks (Wyświetl ostrzeżenie przed usunięciem 
niepustych scieżek)
     Wyświetla ostrzeżenie w przypadku usunięcia ścieżek, które nie są puste.
Select Track on Background Click (Wybierz ścieżkę po kliknięciu w tle)
     Umożliwia wybranie ścieżki poprzez kliknięcie tła wyświetlacza zdarzenia.
Auto Select Events under Cursor (Automatycznie wybierz zdarzenia pod kursorem)
     Automatycznie zaznacza wszystkie zdarzenia w oknie Project lub w edytorze, które znajdują się
     pod kursorem projektu.
Cycle Follows Range Selection (Cykl następuje po wyborze zakresu)
     Ustawia lewy lokalizator na pozycję początkową zakresu, a prawy lokalizator na pozycję 
     końcową zakresu wybranego zakresu.
Delete Overlaps (Usuń nakładające się elementy)
     Usuwa nakładające się, czyli ukryte sekcje nakładających się wydarzeń. Przytrzymaj Shift   
     podczas przenoszenia zdarzeń, aby zastąpić to ustawienie.
Parts Get Track Names (Części otrzymują nazwy ścieżek)
     Automatycznie zmienia nazwy zdarzeń na nazwę ścieżki, na którą są przenoszone.
Lock Event Attributes (Zablokuj atrybuty zdarzeń)
     Określa, na które właściwości ma wpływ zablokowanie zdarzenia. Możesz użyć dowolnej 
     kombinacji z poniższych:
      ●   Position (Pozycja)
           Blokuje pozycję tak, że zdarzenie nie może zostać przesunięte.
      ●   Size (Rozmiar)
           Blokuje rozmiar, uniemożliwiając zmianę rozmiaru zdarzenia.
      ●   Other (Inne)
           Blokuje wszystkie inne możliwości edycji zdarzenia. Obejmuje to regulację zanikania i 
           głośności zdarzenia, przetwarzanie itp.
Quick Zoom (Szybkie powiększenie)
     Przerysowuje zawartość części i zdarzeń dopiero po zatrzymaniu zmiany powiększenia. Jest to 
     przydatne, jeśli ponowne rysowanie ekranu w systemie jest powolne.
Use Up/Down Navigation Commands for Selecting Tracks only (Użyj nawigacji w górę/w dół 
wyłącznie do wybierania ścieżek)
     Używa klawiszy Strzałka w górę / Strzałka w dół do wyboru ścieżki, a nie do wyboru 
     zdarzenia/części.
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Track Selection Follows Event Selection (Wybór ścieżki następuje po wyborze zdarzenia)
     Automatycznie wybiera odpowiednią ścieżkę, jeśli wybierzesz zdarzenie w oknie Project.
Automation Follows Events (Automatyzacja podąża za zdarzeniami)
     Umożliwia automatyczne śledzenie zdarzeń automatyzacji po przeniesieniu, zduplikowaniu, 
     skopiowaniu lub wklejeniu zdarzenia lub części na ścieżce. Dzięki temu łatwiej jest ustawić 
     automatyzację związaną z konkretnym zdarzeniem lub częścią, a nie z konkretną pozycją 
     w projekcie.
Drag Delay (Przeciągnij opóźnienie)
     Umożliwia ustawienie opóźnienia w ms używanego podczas przenoszenia zdarzeń. Jest to    
     przydatne, aby uniknąć przypadkowego przeniesienia zdarzeń po kliknięciu na nie w oknie 
     Project.

Editing – Audio (Edycja – dźwięk)

Treat Muted Audio Events like Deleted (Traktuj wyciszone zdarzenia audio jak usunięte)
     Umożliwia odtworzenie ukrytego zdarzenia składającego się z 2 nakładających się zdarzeń audio
     po wyciszeniu zdarzenia głównego.
Use Mouse Wheel for Event Volume and Fades (Użyj kółka myszy, aby ustawić głośność 
zdarzenia i zanikanie)
     Umożliwia użycie kółka myszy do przesuwania głośności i zanikania zdarzeń.
      ● Poruszanie kółkiem myszy przesuwa krzywą głośności zdarzenia w górę lub w dół.
      ● Przytrzymanie Shift podczas poruszania kółkiem myszy przesuwa krzywe zanikania.
      ● Pozycjonowanie myszy w lewej połowie zdarzenia powoduje przesunięcie punktu końcowego
          narastania (fade in).
      ● Pozycjonowanie myszy w prawej połowie zdarzenia przesuwa punkt początkowy zanikania 
         (fade out).
On Import Audio Files (O importowaniu plików audio)
     Określa, co się stanie po zaimportowaniu pliku audio.
      ●    Open Options Dialog (Otwórz okno dialogowe opcji)
            Otwiera okno dialogowe, w którym możesz wybrać, czy chcesz skopiować plik do folderu 
            audio i/lub przekonwertować go do ustawień projektu.
      ●   Use Settings (Użyj ustawień)
           Używa domyślnych ustawień importowania dźwięku.
Remove Regions/Hitpoints on all Offline Processes (Usuń regiony/punkty hitowe ze wszystkich 
procesów offline)
     Usuwa regiony/punkty hitowe zakresów audio podczas przetwarzania w trybie offline.
On Processing Shared Clips (O przetwarzaniu udostępnionych klipów)
     Określa, co się stanie, jeśli zastosujesz przetwarzanie do udostępnionego klipu, który jest 
     używany przez więcej niż jedno zdarzenie w projekcie.
      ●   Open Options Dialog (Otwórz okno dialogowe opcji)
            Otwiera okno dialogowe Options (Opcje), w którym możesz wybrać, czy chcesz utworzyć 
            nową wersję klipu, czy zastosować przetwarzanie do istniejącego klipu.
      ●   Create New Version (Utwórz nową wersję)
           Tworzy nową wersję klipu do edycji i stosuje do niej przetwarzanie, pozostawiając 
            oryginalny klip bez zmian.
      ●   Process Existing Clip (Przetwórz istniejący klip)
           Stosuje przetwarzanie do istniejącego klipu. Ma to wpływ na wszystkie zdarzenia 
           odtwarzające ten klip.
Enable Automatic Hitpoint Detection (Włącz automatyczne wykrywanie punktów hitowych)
     Włącza automatyczne wykrywanie punktu hitowego dla importowanych lub nowo nagranych 
     plików audio.
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Time Stretch Tool Algorithm (Algorytm narzędzia rozciągania czasu)
     Ustawia domyślny algorytm stosowany podczas korzystania z narzędzia Object Selection  
     (Zaznaczanie obiektów) w trybie Sizing Applies Time Stretch (Rozciąganie czasu 
     z zastosowaniem rozmiaru).
Default Warping Algorithm (Domyślny algorytm wypaczania)
     Ustawia algorytm wypaczania dla nowych klipów audio w projekcie.

Editing – Chords (Edycja – Akordy)

‘X’ Chords Mute Notes on Tracks That are in Follow Chord Track Mode (Akordy „X” 
wyciszają nuty na ścieżkach znajdujących się w trybie śledzenia akordów)
     Wycisza odtwarzanie, gdy odtwarzasz ścieżkę następującą po ścieżce akordu, a kursor dotrze do 
     niezdefiniowanego zdarzenia akordu (akord X).
Disable ‘Acoustic Feedback’ during Playback (Wyłącz opcję „Sprzężenie akustyczne” podczas 
odtwarzania)
     Wyłącza sprzężenie akustyczne podczas odtwarzania. Dzięki temu zdarzenia akordowe nie będą 
     uruchamiane dwukrotnie.
Hide Muted Notes in Editors (Ukryj wyciszone nuty w edytorach)
     Ukrywa nuty, które są wyciszane, ponieważ ich ścieżka MIDI podąża za ścieżką akordów.

Editing – Controls (Edycja – Sterowanie)

Value Box/Time Control Mode (Pole wartości/tryb kontroli czasu)
     Umożliwia wybór preferowanego sposobu kontrolowania pól wartości.
      ●   Text Input on Left-Click (Wprowadzanie tekstu po kliknięciu lewym przyciskiem myszy)
            Kliknięcie otwiera pole wartości do edycji.
      ●    Increment/Decrement on Left/Right-Click (Zwiększanie/zmniejszanie po kliknięciu 
             lewym/prawym przyciskiem myszy)
             Kliknięcie zmniejsza wartość, kliknięcie prawym przyciskiem myszy zwiększa wartość. 
             Podwójne kliknięcie umożliwia ręczne wprowadzenie wartości.
      ●    Increment/Decrement on Left-Click and Drag (Zwiększanie/zmniejszanie po kliknięciu 
             lewym przyciskiem myszy i przeciągnięciu)
             Kliknięcie i przeciągnięcie w górę lub w dół dostosowuje wartość. Podwójne kliknięcie 
             umożliwia ręczne wprowadzenie wartości.
Knob Mode (Tryb pokrętła)
     Umożliwia wybór preferowanego sposobu sterowania pokrętłami.
      ●   Circular (Okrągły)
           Kliknięcie i przeciągnięcie okrężnym ruchem powoduje zmianę ustawienia. Kliknięcie 
           w dowolnym miejscu wzdłuż krawędzi kodera natychmiast zmienia ustawienie.
      ●   Relative Circular (Okólnik względny)
           Kliknięcie w dowolnym miejscu kodera i przeciągnięcie zmienia bieżące ustawienie. Nie ma 
           potrzeby klikania dokładnej aktualnej pozycji.
      ●   Linear (Liniowy)
           Kliknięcie kodera i przeciągnięcie w górę lub w dół, w lewo lub w prawo zmienia 
           ustawienie.
Slider Mode (Tryb suwaka)
     Umożliwia wybór preferowanego sposobu kontrolowania suwaków wartości.
      ●   Jump (Skok)
           Kliknięcie w dowolnym miejscu suwaka natychmiast przesuwa uchwyt suwaka do tej 
           pozycji.
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      ●   Touch (Dotknij)
           Kliknięcie i przeciągnięcie uchwytu suwaka dostosowuje ustawienie.

      ●   Ramp (Rampa)
           Kliknięcie i przeciągnięcie suwaka powoduje płynne przejście uchwytu do nowej pozycji.
      ●   Relative (Względny)
           Kliknięcie i przeciągnięcie w górę lub w dół zmienia ustawienie w zależności od tego, jak 
           daleko przeciągasz, a nie w zależności od miejsca kliknięcia.

Editing – MIDI (Edycja – MIDI)

Select Controllers in Note Range: Use Extended Note Context (Wybierz kontrolery w zakresie 
nut: Użyj rozszerzonego kontekstu nuty)
     Uwzględnia rozszerzony kontekst nuty podczas przenoszenia nut wraz z ich kontrolerami.   
     Oznacza to, że kontrolery pomiędzy ostatnią wybraną nutą a następną nutą lub końcem partii 
     również zostaną przesunięte.
Legato Overlap (Nakładanie się Legato)
     Umożliwia ustawienie nakładania się funkcji Legato. Legato pozwala na przedłużenie nut MIDI
     tak, aby sięgały kolejnych nut.
     Ustawienie nakładania się na 0 ticków powoduje, że każda wybrana nuta rozciąga się tak, że 
     dociera dokładnie do następnej nuty. Wartość dodatnia powoduje, że nuty nakładają się na siebie
     o określoną liczbę ticków. Wartość ujemna powoduje niewielką przerwę między nutami.
Legato Mode: Between Selected Notes Only (Tryb Legato: Tylko pomiędzy wybranymi nutami)
     Dostosowuje długość wybranych nut tak, aby sięgały do następnej wybranej nuty.
Split MIDI Events (Rozdzielone zdarzenia MIDI)
     Dzieli zdarzenia MIDI po podzieleniu partii MIDI w oknie Project, a pozycja podziału przecina 
     zdarzenia MIDI. Spowoduje to również utworzenie nowych nut na początku drugiej części.
Split MIDI Controllers (Rozdzielone kontrolery MIDI)
     Dzieli kontrolery MIDI w przypadku podziału części MIDI w oknie Project, która zawiera 
     kontroler. Jeśli wartość kontrolera w pozycji podziału nie wynosi zero, nowe zdarzenie 
     kontrolera tego samego typu i wartości jest wstawiane w pozycji podziału na początku drugiej 
     części.
 
UWAGA
Jeśli po prostu podzielisz część i odtworzysz wynik, dźwięk będzie brzmiał tak samo niezależnie od
tego ustawienia. Jeśli jednak podzielisz część i usuniesz pierwszą połowę lub przeniesiesz drugą 
połowę w inne miejsce w projekcie, możesz chcieć aktywować Split MIDI Controllers, aby 
upewnić się, że wszystkie kontrolery mają prawidłową wartość na początku drugiej części.

Editing - Project & MixConsole (Edycja — Project i MixConsole)

Select Channel/Track on Solo (Wybierz kanał/ścieżkę w trybie Solo)
     Wybiera kanały/ścieżki po kliknięciu ich przycisku Solo.
Select Channel/Track on Edit Settings (Wybierz kanał/ścieżkę w opcji Edytuj ustawienia)
     Wybiera kanały/ścieżki po kliknięciu przycisku Edit Channel Settings (Edytuj ustawienia) 
     kanału.
Scroll to Selected Track (Przewiń do wybranej scieżki)
     Przewija listę ścieżek, gdy wybierzesz kanał MixConsole, a odpowiednia ścieżka jest 
     niewidoczna.
Sync Selection in Project Window and MixConsole (Synchronizuj wybór w oknie projektu i 
MixConsole)
     Synchronizuje wybór w oknie Project i MixConsole.
Enable Record on Selected MIDI Track (Włącz nagrywanie na wybranej ścieżce MIDI)
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     Nagrywanie — umożliwia nagrywanie ścieżek MIDI po ich wybraniu.

Enable Record on Selected Audio Track (Włącz nagrywanie na wybranej ścieżce audio)
     Nagrywanie — umożliwia nagrywanie ścieżek audio po ich wybraniu.
Enable Solo on Selected Track (Włącz solo na wybranej ścieżce)
     Czyni ścieżki solowe po ich wybraniu.
Deep Track Folding (Głębokie składanie ścieżek)
     Stosuje funkcje składania ścieżek do wszystkich podelementów ścieżek.
Enlarge Selected Track (Powiększ wybraną ścieżkę)
     Powiększa ścieżkę po jej wybraniu. Jeśli wybierzesz inną ścieżkę, utwór ten zostanie 
     powiększony, a poprzednio wybrany utwór zostanie wyświetlony w oryginalnym rozmiarze.

Editing - Tool Modifiers (Edycja - Modyfikatory narzędzi)
Na tej stronie możesz określić, które klawisze modyfikujące będą używane w celu zapewnienia 
dodatkowej funkcjonalności podczas korzystania z narzędzi.

PROCEDURA
1. Wybierz opcję na liście Categories (Kategorie).
2. Wybierz akcję, dla której chcesz edytować klawisze modyfikujące na liście Action (Akcja).
3. Na klawiaturze komputera przytrzymaj klawisze modyfikujące i kliknij Assign (Przypisz).

WYNIK
Bieżące klawisze modyfikujące dla akcji zostaną zastąpione. Jeżeli do tego narzędzia przypisano 
już klawisze modyfikujące, zostanie wyświetlony monit o ich zastąpienie.

Editing – Tools (Edycja - Narzędzia)

Show Toolbox on Right Click (Pokaż Przybornik po kliknięciu prawym przyciskiem myszy)
     Otwiera przybornik po kliknięciu prawym przyciskiem myszy na ekranie zdarzeń i w edytorach. 
     Aby otworzyć menu kontekstowe zamiast przybornika, naciśnij dowolny klawisz modyfikujący 
     po kliknięciu prawym przyciskiem myszy.
Cross-Hair Cursor (Kursor krzyżowy)
     Umożliwia ustawienie kolorów linii i maski kursora krzyżowego oraz jego szerokości.
Zoom Tool Standard Mode: Horizontal Zooming Only (Tryb standardowy narzędzia Powiększ: 
Tylko powiększanie w poziomie)
     Powiększa okno w poziomie bez zmiany wysokości ścieżki podczas powiększania za pomocą  
     narzędzia Zoom (Powiększenie).
Select Tool: Show Extra Info (Wybierz narzędzie: Pokaż dodatkowe informacje)
     Wyświetla bieżącą pozycję wskaźnika oraz nazwę ścieżki i zdarzenia, na które wskazujesz, 
     korzystając z narzędzia Object Selection (Zaznaczanie obiektów) w oknie Project.
Show Notification when Switching Tool Mode with Key Command (Pokaż powiadomienie 
podczas przełączania trybu narzędzia za pomocą polecenia klawiszowego)
     Wyświetla powiadomienie po przełączeniu trybu narzędzia za pomocą polecenia klawiszowego.

Editors (Edytory)

Use Drum Editor when Drum Map is assigned (Użyj edytora bębnów, gdy przypisana jest mapa 
bębnów)
     Pokazuje symbole nut perkusyjnych w partiach ścieżek MIDI, do których przypisane są mapy 
     perkusji. Partie otwierają się automatycznie w Drum Editor (Edytorze bębnów) po dwukrotnym
     kliknięciu. Spowoduje to zastąpienie ustawienia Default MIDI Editor (Domyślnego edytora 
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     MIDI).

Default MIDI Editor (Domyślny edytor MIDI)
     Określa, który edytor zostanie otwarty po dwukrotnym kliknięciu partii MIDI lub po jej 
     zaznaczeniu i naciśnięciu klawiszy Ctrl/Cmd - E. To ustawienie jest zastępowane w przypadku 
     ścieżek z mapami perkusyjnymi, jeśli włączona jest opcja Use Drum Editor when Drum Map 
     is assigned (Użyj edytora perkusyjnego, gdy przypisana jest mapa perkusyjna).
Editor Content Follows Event Selection (Treść edytora podąża za wyborem zdarzenia)
     Otwarte edytory pokazują zdarzenia wybrane w oknie Project.
Double-click opens Editor in a Window/in Lower Zone (Podwójne kliknięcie otwiera Edytor w 
oknie/w dolnej strefie)
     Określa, gdzie zostanie otwarty edytor po dwukrotnym kliknięciu zdarzenia audio lub partii  
     MIDI albo po użyciu polecenia klawiszowego przypisanego do Open/Close Editor 
     (Otwórz/Zamknij edytor).
Open Editor Commands open Editors in a Window/in Lower Zone (Otwórz edytor Polecenia 
otwierają edytory w oknie/w dolnej strefie)
     Określa, gdzie zostanie otwarty edytor, gdy użyjesz polecenia otwarcia z menu Audio lub MIDI
     albo odpowiednich poleceń klawiszowych.

Event Display (Wyświetlanie zdarzeń)
Sekcja Event Display zawiera kilka ustawień umożliwiających dostosowanie wyświetlania w oknie
Project.

Show Event Names (Pokaż nazwy zdarzeń)
     Pokazuje nazwy części i zdarzeń.
Hide Truncated Event Names (Ukryj skrócone nazwy zdarzeń)
     Ukrywa nazwy zdarzeń, jeśli są za długie.
Show Overlaps (Pokaż nakładki)
     Określa sposób wyświetlania nakładających się zdarzeń.
Grid Overlay Intensity (Intensywność nakładki siatki)
     Ustawia intensywność nałożenia wyświetlanych linii siatki.
Event Handling Opacity (Nieprzezroczystość obsługi zdarzeń)
     Ustawia przezroczystość nakładających się zdarzeń podczas ich przenoszenia.
Event Opacity (Nieprzezroczystość zdarzenia)
     Ustawia przezroczystość tła zdarzenia.

UWAGA
● Jeśli zmniejszysz przezroczystość zdarzenia, pomocne może być zwiększenie Waveform  
   Brightness (Jasności kształtu fali) w przypadku zdarzeń audio lub Note Brightness (Jasności 
   nuty) w przypadku zdarzeń MIDI.
● Zmniejszenie przezroczystości może spowodować, że interfejs użytkownika będzie mniej 
   responsywny.

Smallest Track Height to Show Data (Najmniejsza wysokość ścieżki do wyświetlenia danych)
     Określa, z jakiej wysokości ścieżki wyświetlana jest zawartość ścieżki.
Smallest Track Height to Show Name (Najmniejsza wysokość ścieżki, aby wyświetlić nazwę)
     Określa, od jakiej wysokości ścieżek wyświetlane są nazwy ścieżek.

POWIĄZANE LINKI
Jasność przebiegu na stronie 1167
Jasność nuty na stronie 1169
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Event Display – Audio (Wyświetlanie zdarzeń — Audio)

Interpolate Audio Waveforms (Interpolacja przebiegów audio)
     Interpoluje wartości próbek w celu utworzenia krzywych po powiększeniu do jednej próbki na 
     piksel lub mniej.
Show Event Volume Curves Always (Zawsze pokazuj krzywe głośności zdarzeń)
     Pokazuje krzywe głośności zdarzeń, niezależnie od tego, czy zdarzenie zostało wybrane.
Show Waveforms (Pokaż przebiegi)
     Pokazuje przebiegi zdarzeń audio.
Show Hitpoints on Selected Events (Pokaż punkty hitowe w wybranych zdarzeniach)
     Pokazuje punkty hitowe dla wybranych zdarzeń audio.
Waveform Brightness (Jasność przebiegu)
     Ustawia jasność przebiegu.
Waveform Outline Intensity (Intensywność zarysu fali)
     Ustawia intensywność konturu fali.
Fade Handle Brightness (Zmniejsz jasność uchwytu)
     Ustawia jasność linii zanikania zdarzeń audio.
Background Color Modulation (Modulacja koloru tła)
     Odzwierciedla dynamikę przebiegu w tle przebiegów audio.

Event Display - Chords & Pitches (Wyświetlanie zdarzeń — akordy i 
tony)

Pitch Notation (Notacja wysokości dźwięku)
     ●   Note Name (Nazwa notatki)
          Umożliwia wybór sposobu wyświetlania symboli akordów. Możesz wybrać English 
          (angielski), German (niemiecki) lub Solfege.
     ●   Naming Format (Format nazewnictwa)
          Umożliwia określenie sposobu wyświetlania nazw nut MIDI w edytorach itp.
     ●   Display ‘Bb’ as ‘B’ (Wyświetl „Bb” jako „B”)
          Wyświetla „B” jako nazwę tonu. Ta opcja jest dostępna tylko po wybraniu English (języka 
          angielskiego) w wyskakującym menu Note Name (Nazwa notatki)
     ●   Display ‘B’ as ‘H’ (Wyświetlaj „B” jako „H”)
          Wyświetla „H” jako nazwę tonu. Ta opcja jest dostępna tylko po wybraniu English (języka 
          angielskiego) w wyskakującym menu Note Name.
     ●   Enharmonics from Chord Track (Enharmoniczne ze ścieżki akordów)
          Wykorzystuje zdarzenia akordów na ścieżce akordów, aby określić, czy równoważne pod 
          względem harmonicznym nuty w Key Editor (Edytorze tonacji) i List Editor (Edytorze list) 
          są wyświetlane jako ostre czy płaskie.
Chord Font (Czcionka akordu)
     Umożliwia określenie czcionki dla wszystkich symboli akordów.
Chord Symbols (Symbole akordów)
     Umożliwia wybór preferowanej metody wyświetlania akordów septymowych durowych, 
     akordów molowych, akordów zmniejszonych w połowie, akordów zmniejszonych i akordów 
     zwiększonych.
Custom Chord Symbols (Niestandardowe symbole akordów)
     Umożliwia modyfikację domyślnych symboli akordów używanych na ścieżce akordów, 
     w padach akordów i w Score Editor (Edytorze partytury).
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● New Custom Chord (Nowy niestandardowy akord) umożliwia dodanie nowego 
    niestandardowego symbolu akordu.
● Opcje po lewej stronie pozwalają określić akord, dla którego chcesz zmienić symbol akordu.
● Kliknij kolumnę Type (Typ) i Tension (Napięcie) i wprowadź własny symbol.
UWAGA
Należy zdefiniować niestandardowe symbole dla każdego zestawu napięć (tensions).
● Kolumna Result (Wynik) pokazuje, w jaki sposób akord będzie wyświetlany.
● Przycisk Remove Custom Chord (Usuń niestandardowy akord) umożliwia usunięcie 
   niestandardowego symbolu akordu wybranego z listy.

PRZYKŁAD
Aby zmienić wygląd wszystkich akordów molowych z Xmin na X-, kliknij New Custom Chord 
(Nowy akord niestandardowy), aktywuj 5 i min3/#9, aby zdefiniować typ akordu i zmień symbol w
kolumnie Type (Typ) z min na -.

Event Display – Folders (Wyświetlanie zdarzeń — foldery)

Show Event Details (Pokaż szczegóły zdarzenia)
     Wyświetla szczegóły zdarzenia zamiast bloków danych.
     To ustawienie zależy od ustawienia Show Data on Folder Tracks (Pokaż dane na ścieżkach 
     folderu).
Show Data on Folder Tracks (Pokaż dane na ścieżkach folderów)
     Określa, w którym przypadku bloki danych lub szczegóły zdarzeń są wyświetlane na ścieżkach 
     folderu.
●   Always Show Data (Zawsze pokazuj dane)
     Zawsze wyświetla bloki danych lub szczegóły zdarzenia.
●   Never Show Data (Nigdy nie pokazuj danych)
     Nic nie wyświetla.
●   Hide Data When Expanded (Ukryj dane po rozwinięciu)
     Ukrywa wyświetlanie zdarzeń podczas otwierania ścieżek folderu.

Event Display – MIDI (Wyświetlanie zdarzeń — MIDI)
Part Data Mode (Tryb danych części)
     Określa, czy i w jaki sposób wyświetlane są zdarzenia w partiach MIDI. To ustawienie jest 
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     zastępowane w przypadku ścieżek z mapami perkusyjnymi, jeśli włączona jest opcja Use Drum 
     Editor when Drum Map is assigned (Użyj edytora perkusyjnego, gdy przypisana jest mapa 
     perkusyjna).
Show Controllers (Pokaż kontrolery)
     Pokazuje zdarzenia niebędące nutami, takie jak kontrolery itp. w partiach MIDI

Note Brightness (Jasność nuty)
      Ustawia jasność zdarzeń nutowych.
Controller Brightness (Jasność kontrolera)
     Ustawia jasność zdarzeń kontrolera.

POWIĄZANE LINKI
Użyj edytora bębnów, gdy przypisano mapę bębnów na stronie 1165.

Event Display – Markers (Wyświetlanie zdarzeń — znaczniki)

Show Marker Lines (Pokaż linie znaczników)
     Umożliwia określenie, czy linie znaczników mają być wyświetlane na innych ścieżkach w oknie 
     Project.
      ●   Off (Wyłączone)
           Linie znaczników są pokazane tylko na ścieżkach znaczników.
      ●   From Active Marker Track (Z aktywnej ścieżki znaczników)
           Linie znaczników aktywnego toru znaczników są pokazane na innych ścieżkach w oknie 
           Project.
      ●   From All Marker Tracks (Ze wszystkich ścieżek znaczników)
           Linie znaczników wszystkich ścieżek znaczników są pokazane na innych ścieżkach w oknie  
           Project.

POWIĄZANE LINKI
Markery na stronie 336

Event Display – Tracks (Wyświetlanie zdarzeń — ścieżki)

Default Track Name Width (Domyślna szerokość nazwy ścieżki)
     Ustawia domyślną szerokość nazwy dla wszystkich typów ścieżek.

General (Ogólne)
Strona General zawiera ustawienia ogólne mające wpływ na interfejs użytkownika programu. 
Ustaw je zgodnie z preferowanymi metodami pracy.

Enable HiDPI (Windows only) (Włącz HiDPI (tylko Windows))
     Włącza odpowiednią rozdzielczość, aby elementy GUI Cubase były ostre i precyzyjne na 
     wyświetlaczach o wysokiej rozdzielczości z obsługiwanymi współczynnikami skalowania 100%,
     125%, 150%, 175% i 200%.

UWAGA
Inne współczynniki skalowania, takie jak 133%, nie są obsługiwane.

UWAGA
W systemie macOS możesz wyłączyć obsługę HiDPI w folderze aplikacji Cubase, wywołując opcję
Get Info (Pobierz informacje) i zaznaczając opcję Open in Low Resolution (Otwórz w niskiej 
rozdzielczości).
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Usage Logger Options (Opcje rejestratora użycia)
     Jeśli aktywujesz tę opcję, Cubase zbiera informacje o użytkowaniu i zapisuje je w pliku 
     dziennika, który można znaleźć w następującej lokalizacji:

●   W systemie Windows: „\Users\<nazwa użytkownika>\AppData\Local\Steinberg\usagelogger”
     W systemie macOS: „/Users/<nazwa użytkownika>/Library/Logs/Steinberg/usagelogger”

     Aktywacja tej opcji w celu zapisania takiego pliku, a następnie wysłanie pliku do zespołu 
     wsparcia Steinberga może być przydatna w przypadku awarii Cubase, a pliki zrzutu awaryjnego 
     nie ujawniają wystarczających informacji.
     Domyślnie opcja Enable Usage Logging (Włącz rejestrowanie użycia) jest wyłączona. 
     Zalecamy dezaktywację tej funkcji, gdy już jej nie potrzebujesz.
Language (Język)
     Umożliwia wybór języka używanego w programie. Po zmianie języka należy ponownie 
     uruchomić program, aby zmiana odniosła skutek.
Auto Save (Automatyczne zapisywanie)
     Automatycznie zapisuje kopie zapasowe wszystkich otwartych projektów z niezapisanymi 
     zmianami. Nazywają się one Name.bak, gdzie nazwa jest nazwą projektu i są zapisywane w 
     folderze projektu. Kopie zapasowe niezapisanych projektów noszą nazwę #UntitledX.bak, gdzie 
     X jest liczbą przyrostową, aby umożliwić wielokrotne tworzenie kopii zapasowych w tym 
     samym folderze projektu.
Auto Save Interval (Interwał automatycznego zapisywania)
     Umożliwia określenie częstotliwości tworzenia kopii zapasowej.
Maximum Backup Files (Maksymalna liczba plików kopii zapasowych)
     Umożliwia określenie liczby utworzonych plików kopii zapasowych. Po osiągnięciu 
     maksymalnej liczby plików kopii zapasowych istniejące pliki zostaną nadpisane, zaczynając od 
     najstarszego.
Show Tips (Pokaż podpowiedzi)
     Wyświetla objaśniającą podpowiedź po umieszczeniu wskaźnika myszy nad ikoną lub 
     przyciskiem w Cubase.
Maximum Undo Steps (Maksymalna liczba kroków cofania)
     Umożliwia określenie liczby kroków cofania.
Run Setup on Create New Project (Uruchom instalację podczas tworzenia nowego projektu)
     Otwiera okno dialogowe Project Setup (Ustawienia projektu) za każdym razem, gdy tworzysz 
     nowy projekt.
Open Projects in Last Used View (Otwórz projekty w widoku Ostatnio używane)
     Pozwala określić, jaki układ okna będzie używany podczas otwierania projektu.
      ●   Never (Nigdy)
           Wykorzystuje oryginalny układ i ustawienia okna.
      ●   Only External Projects (Tylko projekty zewnętrzne)
           Projekty utworzone na innym komputerze korzystają z widoku, którego ostatnio używałeś na
           swoim komputerze. Projekty, które zostały utworzone na tym komputerze, korzystają 
           z oryginalnego układu okien i ustawień.
      ●   Always (Zawsze)
           Używa widoku, którego ostatnio używałeś na swoim komputerze.
Use Hub (Użyj Huba)
     Otwiera Hub po uruchomieniu Cubase lub utworzeniu nowego projektu za pomocą menu File 
     (Plik).

POWIĄZANE LINKI
Menu kontekstowe instrumentu VST na stronie 732
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General – Personalization (Ogólne - Personalizacja)

Default Author Name (Domyślna nazwa autora)
     Umożliwia określenie nazwiska autora, które będzie domyślnie używane w nowych projektach. 
     Jest to uwzględniane jako metadane podczas eksportowania plików audio z fragmentem iXML.
Default Company Name (Domyślna nazwa firmy)
     Umożliwia określenie nazwy firmy, która będzie domyślnie używana w nowych projektach. Jest 
     to uwzględniane jako metadane podczas eksportowania plików audio z fragmentem iXML.

MIDI
Ta strona zawiera ustawienia wpływające na nagrywanie i odtwarzanie MIDI.

MIDI Thru Active
     Ustawia wszystkie ścieżki MIDI, które umożliwiają nagrywanie lub mają włączone 
     monitorowanie, aby wyświetlały echo przychodzących danych MIDI i wysyłały je z powrotem 
     na odpowiednie wyjścia i kanały MIDI. Dzięki temu podczas nagrywania można usłyszeć 
     prawidłowy dźwięk z instrumentu MIDI.

UWAGA
Jeśli używasz MIDI Thru, wybierz tryb Local Off na swoim instrumencie MIDI, aby zapobiec 
podwójnemu wybrzmiewaniu każdej nuty.

Reset on Stop (Zresetuj po zatrzymaniu)
     Ustawia Cubase tak, aby przy zatrzymaniu wysyłał komunikaty resetowania MIDI, włączając 
     nuty i resety kontrolera.
Never Reset Chased Controllers (Nigdy nie resetuj ściganych kontrolerów)
     Nigdy nie resetuje kontrolerów do 0, gdy zatrzymasz odtwarzanie lub przejdziesz do nowej 
     pozycji w projekcie.
Length Adjustment (Regulacja długości)
     Umożliwia wprowadzenie wartości regulacji długości w taktach, według której dopasowywane 
     są nuty o tej samej wysokości i kanale MIDI. Dzięki temu między końcem jednej nuty 
     a początkiem drugiej zawsze jest krótki czas. Domyślnie na nutę 1/16 przypada 120 ticków, ale 
     można to dostosować za pomocą ustawienia MIDI Display Resolution (Rozdzielczości 
     wyświetlacza MIDI).
Chase Events (Zdarzenia pościgowe)
     Typy zdarzeń pościgów, dla których jedna z opcji pościgu jest aktywowana po znalezieniu 
     nowej pozycji i rozpoczęciu odtwarzania. Dzięki temu Twoje instrumenty MIDI brzmią tak, jak 
     powinny, gdy znajdziesz się w nowej pozycji i rozpoczniesz odtwarzanie. Jeżeli aktywna jest 
     funkcja Chase notlimited to Part Boundaries (Ściganie nie ogranicza się do granic części ), 
     kontrolery MIDI również będą działać poza granicami partii, a sekwencja będzie wykonywana 
     zarówno na partii pod kursorem, jak i na wszystkich partiach po jej lewej stronie. Dezaktywuj tę 
     opcję w przypadku bardzo dużych projektów, ponieważ spowalnia to procesy takie jak 
     pozycjonowanie i granie solo.
MIDI Display Resolution (Rozdzielczość wyświetlacza MIDI)
     Umożliwia ustawienie rozdzielczości wyświetlania do przeglądania i edytowania danych MIDI.
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Extend Playback Range of Notes that start before the Part (Rozszerz zakres odtwarzania nut 
rozpoczynających się przed partią)
     Rozszerza zakres odtwarzania nut MIDI rozpoczynających się przed częścią w tickach. Jest to 
     przydatne, jeśli zdarzenia MIDI rozpoczynają się na krótko przed rozpoczęciem partii MIDI.   
     Jeśli nie rozszerzysz zakresu odtwarzania, zdarzenia te nie będą odtwarzane. To ustawienie jest 
     również brane pod uwagę podczas odtwarzania cyklicznego.

Insert Reset Events after Record (Wstaw Resetuj zdarzenia po nagraniu)
     Wstawia zdarzenie resetowania na końcu każdej nagranej części. Spowoduje to zresetowanie  
     danych kontrolera, takich jak Sustain (pedał podtrzymania), Aftertouch, Pitchbend, 
     Modulation (Modulacja) lub Breath Control (Kontrola Oddechu). Jest to przydatne, jeśli na 
     przykład zatrzymasz nagrywanie przed wysłaniem polecenia wyłączenia nuty.
Audition through MIDI Inserts/Sends (Odsłuch poprzez wstawki/wysyłki MIDI)
     Aktywuje nakładanie warstw instrumentów MIDI (poprzez wysyłki MIDI) także w edytorach 
     MIDI. W ten sposób akustyczna informacja zwrotna edytorów wysyła dane MIDI nie tylko do 
     wyjścia wybranego dla ścieżki, ale dodatkowo przez dowolne przypisane do niego wstawki 
     MIDI i wysyłki MIDI. Oznacza to jednak również, że zdarzenia MIDI będą przesyłane za 
     pośrednictwem wszelkich wtyczek MIDI przypisanych do tej ścieżki.
MIDI Latency Mode (Tryb opóźnienia MIDI)
     Umożliwia określenie opóźnienia silnika odtwarzania MIDI.
     Low (Niski) zmniejsza opóźnienie i zwiększa responsywność silnika odtwarzania MIDI. Jednak 
     to ustawienie może również zmniejszyć wydajność komputera, jeśli projekt zawiera mnóstwo 
     danych MIDI.
     Normal (Normalny) jest trybem domyślnym i zalecanym ustawieniem dla większości 
     przepływów pracy.
     High (Wysoki) zwiększa opóźnienie i bufor odtwarzania. Użyj tej opcji, jeśli pracujesz ze  
     złożonymi bibliotekami instrumentów VST lub z projektami o bardzo wysokim poziomie 
     wydajności.
MIDI Max. Feedback in ms (Maks. MIDI Informacje zwrotne w ms)
     Umożliwia ustawienie maksymalnej długości nut podczas korzystania z funkcji Acoustic 
     Feedback (Akustyczne sprzężenie zwrotne) w edytorach MIDI.

MIDI - MIDI File (MIDI – plik MIDI)

Export Options (Opcje eksportu)
Opcje te pozwalają określić, jakie dane mają być zawarte w eksportowanych plikach MIDI.

Export Inspector Patch (Poprawka inspektora eksportu)
     Zawiera ustawienia poprawek MIDI w Inspektorze jako wybór banku MIDI i zdarzenia zmiany 
     programu w pliku MIDI.
Export Inspector Volume/Pan (Eksportuj głośność/panoramę Inspektora)
     Zawiera ustawienia głośności i panoramy w Inspektorze jako zdarzenia głośności i panoramy 
     MIDI w pliku MIDI.
Export Automation (Automatyzacja eksportu)
     Zawiera automatyzację jako zdarzenia kontrolera MIDI w pliku MIDI. Dotyczy to również 
     automatyzacji nagranej za pomocą wtyczki MIDI Control (Sterowanie MIDI).
     Jeśli zarejestrujesz sterownik ciągły (na przykład CC7) i wyłączysz opcję Read Automation 
     (Czytaj automatyzację) dla ścieżki automatyzacji, eksportowane będą tylko dane części dla tego 
     kontrolera.
Export Inserts (Eksportuj wstawki)
     Zawiera modyfikatory MIDI i wstawki MIDI w pliku MIDI.
Export Sends (Eksportuj wysyłki)
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     Zawiera wysyłki MIDI w pliku MIDI.
Export Markers (Eksportuj znaczniki)
     Zawiera znaczniki jako standardowe zdarzenia znaczników pliku MIDI w pliku MIDI.
Export as Type 0 (Eksportuj jako typ 0)
     Eksportuje plik MIDI typu 0 ze wszystkimi danymi na jednej ścieżce, ale na różnych kanałach 
     MIDI. Jeśli wyłączysz tę opcję, eksportowany będzie plik MIDI typu 1 z danymi na oddzielnych
     ścieżkach.

Export Resolution (Eksportuj rozdzielczość)
     Umożliwia ustawienie rozdzielczości pliku MIDI w zakresie od 24 do 960. Rozdzielczość to 
     liczba impulsów lub ticków na ćwierćnutę (PPQ) i określa precyzję, z jaką będziesz mógł 
     przeglądać i edytować dane MIDI. Im wyższa rozdzielczość, tym większa precyzja.   
     Rozdzielczość należy wybrać w zależności od aplikacji lub sekwencera, z którym plik MIDI 
     będzie używany, ponieważ niektóre aplikacje i sekwencery mogą nie być w stanie obsłużyć 
     pewnych rozdzielczości.
Export Locator Range (Eksportuj zakres lokalizatora)
     Eksportuje tylko zakres pomiędzy lewym i prawym lokalizatorem.
Export includes Delay (Eksport obejmuje opóźnienie)
     Zawiera ustawienia opóźnienia dokonane w Inspektorze w pliku MIDI.

Import Options (Opcje importu)
Import Options plików MIDI pozwalają określić, jakie dane mają być zawarte w importowanych 
plikach MIDI.

               

Extract First Patch (Wyodrębnij pierwszy fragment)
     Konwertuje pierwsze zdarzenia Program Change i Bank Select dla każdej ścieżki na 
     ustawienia Inspektora dla ścieżki.
Extract First Volume/Pan (Wyodrębnij pierwszą głośność/panoramę)
     Konwertuje pierwsze zdarzenia MIDI Volume i Pan dla każdej ścieżki na ustawienia 
     Inspektora dla ścieżki.
Import Controller as Automation Tracks (Importuj kontroler jako ścieżki automatyzacji)
     Konwertuje zdarzenia MIDI Controller (kontrolera MIDI) w pliku MIDI na dane automatyzacji
     dla ścieżek MIDI.
Import to Left Locator (Importuj do lewego lokalizatora)
     Wyrównuje zaimportowany plik MIDI do pozycji lewego lokalizatora.
Import Markers (Importuj znaczniki)
     Importuje standardowe znaczniki plików MIDI do pliku i konwertuje je na znaczniki Cubase.
Import Dropped File as Single Part (Importuj upuszczony plik jako pojedynczą część)
     Umieszcza plik na jednej ścieżce, jeśli przeciągniesz plik MIDI do projektu.
Ignore Master Track Events on Merge (Ignoruj zdarzenia ścieżki wzorcowej podczas scalania)
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     Ignoruje dane ścieżki tempa, jeśli importujesz plik MIDI do bieżącego projektu. Zaimportowany
     plik MIDI będzie odtwarzany zgodnie z bieżącym tempem ścieżki w projekcie.
Auto Dissolve Format 0 (Automatyczne rozpuszczanie Format 0)
     Automatycznie rozpuszcza zaimportowane pliki MIDI typu 0. Każdy osadzony w pliku kanał 
     MIDI jest umieszczany na osobnej ścieżce w oknie projektu.
Destination (Miejsce docelowe)
     Pozwala określić, co się stanie, gdy przeciągniesz plik MIDI do projektu.

●   MIDI Tracks (Ścieżki MIDI) tworzą ścieżki MIDI dla zaimportowanego pliku.
●   Instrument Tracks (Ścieżki instrument) tworzy ścieżki instrumentów dla każdego kanału MIDI
     w pliku MIDI i pozwala programowi automatycznie załadować odpowiednie ustawienia 
     wstępne.
●   Multitimbral HALion Sonic SE tworzy kilka ścieżek MIDI, każda kierowana do osobnej 
     instancji HALion Sonic SE w oknie VST Instruments i ładuje odpowiednie ustawienia 
     wstępne.
Import Karaoke Lyrics as Text (Importuj teksty karaoke jako tekst)
     Konwertuje teksty karaoke w pliku MIDI na tekst, który można wyświetlić w Score Editor 
     (Edytorze partytury). Jeśli ta opcja jest wyłączona, teksty będą wyświetlane tylko w List Editor 
     (Edytorze listy).

MIDI - MIDI Filter (MIDI – filtr MIDI)
Na tej stronie można zapobiec nagrywaniu i/lub odtwarzaniu echa niektórych komunikatów MIDI 
za pomocą funkcji MIDI thru (thruput).

Strona jest podzielona na 4 sekcje:
Record (Nagraj)
     Uniemożliwia nagrywanie komunikatów MIDI odpowiedniego typu. Będzie jednak przesyłany 
     i jeśli został już nagrany, będzie odtwarzany normalnie.
Thru (Przez)
     Zapobiega przesyłaniu komunikatów MIDI odpowiedniego typu. Będzie on jednak nagrywany 
     i odtwarzany normalnie.
Channels (Kanały)
     Uniemożliwia nagrywanie lub przesyłanie komunikatów MIDI na tym kanale MIDI. Już nagrane
     wiadomości są jednak odtwarzane normalnie.
Controller (Kontroler)
     Uniemożliwia nagrywanie lub przesyłanie niektórych typów kontrolerów MIDI. Aby 
     odfiltrować typ kontrolera, wybierz go z listy u góry sekcji i kliknij Add (Dodaj). Pokazano to 
     na poniższej liście.
     Aby usunąć typ kontrolera z listy (zezwolić na jego rejestrację i przesłanie), zaznacz go na 
     dolnej liście i kliknij Remove (Usuń).

MediaBay (Zatoka multimediów)

Maximum Items in Results List (Maksymalna liczba elementów na liście wyników)
      Ustawia maksymalną liczbę plików wyświetlanych na liście Results (Wyniki).
Allow Editing in Results List (Zezwalaj na edycję na liście wyników)
      Umożliwia edycję atrybutów na liście Results (Wyniki).
Show File Extensions in Results List (Pokaż rozszerzenia plików na liście wyników)
      Wyświetla rozszerzenia nazw plików na liście Results (Wyniki).
Scan Folders Only When MediaBay Is Open (Skanuj foldery tylko wtedy, gdy otwarte jest okno 
MediaBay)
      Skanuje w poszukiwaniu plików multimedialnych, gdy okno MediaBay jest otwarte.
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UWAGA
Podczas odtwarzania lub nagrywania nie jest wykonywane żadne skanowanie folderów.

Scan Unknown File Types (Skanuj nieznane typy plików)
      Skanuje wszystkie typy plików.

Metering (Pomiar)

Map Input Bus Metering to Audio Track (in Direct Monitoring) (Mapowanie pomiaru 
magistrali wejściowej na ścieżkę audio (w trybie bezpośredniego monitorowania))
     Mapuje pomiar magistrali wejściowej na ścieżki audio z włączonym monitorowaniem, dając 
     możliwość oglądania poziomów wejściowych ścieżek audio podczas pracy w oknie projektu. 
     Aby to zadziałało, aktywuj Direct Monitoring (monitorowanie bezpośrednie) w oknie 
     dialogowym Studio Setup (Ustawienia studia).
     Zwróć uwagę, że ścieżki odzwierciedlają sygnał szyny wejściowej, co oznacza, że w obu  
     miejscach zobaczysz ten sam sygnał. Podczas korzystania z pomiaru mapowanego wszelkie 
     funkcje, takie jak przycinanie, stosowane do ścieżki audio nie są odzwierciedlane w jej 
     miernikach.
Meters’ Peak Hold Time (Maksymalny czas utrzymywania liczników)
     Umożliwia określenie czasu utrzymywania poziomów szczytowych w licznikach. Aby to 
     zadziałało, wyłącz opcję Meters - Hold Forever (Metry - Trzymaj na zawsze) w MixConsole.
Meters’ Fallback (Awaryjny licznik metrów)
     Pozwala określić, jak szybko liczniki w MixConsole powracają do niższych wartości po 
     szczytach sygnału.

Metering – Appearance (Pomiar – wygląd)
Na tej stronie możesz przypisać kolory do wartości miernika poziomu, aby szybko określić, które 
poziomy zostały osiągnięte. Możesz edytować wygląd indywidualnie dla wszystkich dostępnych 
skal.

Add (Dodaj)
     Dodaje kolorowy uchwyt na górze licznika.
Remove (Usuń)
     Usuwa wybrany uchwyt koloru.
Scale (Skala)
     Umożliwia wybór skali do edycji.
UWAGA
Do mierników kanałów używana jest skala cyfrowa +3dB Digital

POWIĄZANE LINKI
Konfigurowanie kolorów miernika na stronie 378

Record (Nagrywaj)
Ta strona zawiera ustawienia związane z nagrywaniem Audio i MIDI.
Deactivate Punch In on Stop (Dezaktywuj Punch In przy zatrzymaniu)
     Dezaktywuje Punch In (uderzyć w) na panelu Transport za każdym razem, gdy wchodzisz w  
     tryb zatrzymania.
Stop after Automatic Punch Out (Zatrzymaj po automatycznym wybiciu)
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     Zatrzymuje odtwarzanie po automatycznym Punch Out (wybiciu). Jeżeli wartość post-roll na 
panelu Transport jest ustawiona na wartość inną niż zero, odtwarzanie będzie kontynuowane przez
ustawiony czas, po czym zostanie zatrzymane.

Record – Audio (Nagrywaj – Audio)

Audio Pre-Record Seconds (Sekundy wstępnego nagrania dźwięku)
Ustawia, przez ile sekund odtwarzany dźwięk jest przechwytywany w pamięci buforowej podczas 
odtwarzania lub w trybie zatrzymania.

When Recording Wave Files Larger than 4 GB (Podczas nagrywania plików WAV większych 
niż 4 GB)
     Określa, co się stanie, jeśli nagrasz pliki Wave o rozmiarze większym niż 4 GB.
     ● Aby podzielić plik Wave, wybierz opcję Split Files (Rozdziel pliki).
        Użyj tej opcji, jeśli pracujesz w systemie plików FAT32, który obsługuje tylko pliki 
        o rozmiarze do 4 GB.
     ● Aby zapisać plik Wave jako plik RF64, wybierz opcję Use RF64 Format (Użyj formatu 
        RF64).
        Pliki RF64 mają rozszerzenie .wav. Można je jednak otworzyć tylko za pomocą aplikacji 
        obsługującej standard RF64.
Create Audio Images during Record (Twórz obrazy audio podczas nagrywania)
     Tworzy i wyświetla obraz przebiegu podczas procesu nagrywania.
UWAGA
Te obliczenia w czasie rzeczywistym zużywają dodatkową moc obliczeniową.

Record - Audio - Broadcast Wave (Nagranie - Audio - Fala transmisji)
Na tej stronie można określić ciągi tekstowe Description (Opis), Author (Autor) i Reference 
Value (Wartość odniesienia), które są osadzone w nagranych plikach Broadcast Wave. Ustawienia, 
które tu dokonasz, pojawią się także jako domyślne ciągi w oknie dialogowym Broadcast Wave 
Chunk (Kawałek fali transmisji) podczas eksportowania plików do określonych formatów. 
Informacje osadzone mogą zawierać nie tylko pliki Broadcast Wave, ale także pliki Wave i AIFF

Record – MIDI (Nagrywanie – MIDI)
Record-Enable allows MIDI Thru (Funkcja nagrywania umożliwia przesyłanie sygnału MIDI 
Thru)
     Zapobiega odbijaniu się echa przychodzących danych MIDI w ścieżkach MIDI lub 
     instrumentach obsługujących nagrywanie. W ten sposób ścieżki umożliwiające nagrywanie, do 
     których przypisany jest instrument VST, nie będą odtwarzać podwójnych nut.
Snap MIDI Parts to Bars (Przyciągaj części MIDI do taktów)
     Wydłuża nagrane partie MIDI tak, aby zaczynały się i kończyły na pozycjach całego taktu. Jeśli 
     pracujesz w kontekście opartym na taktach i uderzeniach, może to ułatwić edycję, na przykład 
     przenoszenie, powielanie i powtarzanie.
MIDI Record Catch Range in ms (Zakres przechwytywania rekordu MIDI w ms)
     Zapewnia uwzględnienie samego początku nagrania rozpoczynającego się w lewym 
     lokalizatorze.
Retrospective Record Buffer Size (Rozmiar bufora zapisu retrospektywnego)
     Możesz przechwytywać dane MIDI odtwarzane w trybie Stop (zatrzymania) lub podczas 
     odtwarzania i przekształcać je w partię MIDI. Retrospective Record Buffer Size (Rozmiar 
     bufora zapisu retrospektywnego) określa, ile danych MIDI można przechwycić w buforze.
ASIO Latency Compensation Active by Default (Kompensacja opóźnień ASIO jest domyślnie 
aktywna)
     Określa początkowy stan przycisku ASIO Latency Compensation (Kompensacja opóźnień  
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     ASIO) na liście ścieżek dla ścieżek MIDI lub instrumentów.
     Jeśli nagrywasz na żywo na instrumencie VST, zwykle kompensujesz opóźnienie karty 
     dźwiękowej, grając zbyt wcześnie. W efekcie znaczniki czasu są rejestrowane zbyt wcześnie. Po
     włączeniu tej opcji wszystkie nagrane zdarzenia zostaną przesunięte o aktualne opóźnienie, a 
     odtwarzanie będzie brzmiało jak podczas nagrywania.
Add Latency to MIDI-Thru Processing (Dodaj opóźnienie do przetwarzania MIDI-Thru)
     Jeśli na przykład ustawisz duży rozmiar bufora audio i będziesz odtwarzać arpeggiator w czasie 
     rzeczywistym, nuty MIDI będą odtwarzane ze zwiększonym opóźnieniem. Jeśli konsekwentnie 
     dostosujesz swoją grę do opóźnienia wyjściowego, nuty zostaną nagrane jeszcze później. Aby 
     zminimalizować ten efekt, możesz włączyć opcję Add Latency to MIDI-Thru Processing. 
     Dodaje to regularne opóźnienie do każdej nuty odtwarzanej w czasie rzeczywistym.

Replace Recording in Editors (Zamień nagranie w edytorach)
      Wpływa na wynik nagrywania w edytorze MIDI, gdy jako tryb nagrywania wybrany jest tryb 
      Replace (Zamień):
      ●   None (Brak)
           Nic nie jest zastępowane.
      ●   Controller (Kontroler)
           Zastępowane są tylko dane kontrolera, a nie nuty.
      ●   All (Wszystko)
           Tryb wymiany działa normalnie. Podczas nagrywania nuty i kontrolery są wymieniane.

Scores (Partytury)
Na tej stronie możesz dokonać ustawień Score Editor (Edytora partytury). Wybierz jeden z 
dostępnych wpisów.

Partytury - Kolory dla dodatkowych znaczeń
Umożliwia określenie różnych kolorów w celu identyfikacji niestandardowych elementów 
partytury.
● Kliknij kolumnę Active (Aktywne), aby aktywować tę funkcję dla odpowiedniego elementu.
● Kliknij pole koloru po prawej stronie, aby określić kolor.

Partytury - Edycja

Insert Tool (Wstaw narzędzie)
Display Object Selection Tool after Inserting Symbol (Wyświetl narzędzie wyboru obiektu po 
wstawieniu symbolu)
      Przełącza z powrotem do narzędzia Object Selection (Zaznaczanie obiektów) po dodaniu 
      symbolu.
Double-Click Symbol to Get Draw Tool (Kliknij dwukrotnie symbol, aby uzyskać narzędzie do 
rysowania)
      Aktywuje narzędzie Draw (Rysuj) na palecie po dwukrotnym kliknięciu narzędziem Object 
      Selection (Zaznaczanie obiektów).

Selections (Wybory)
Tied Notes Selected as Single Units (Powiązane nuty wybrane jako pojedyncze jednostki)
      Zaznacza obie nuty po kliknięciu dowolnej nuty w powiązanej parze nut.

Note Tool (Narzędzie nuta)
Show Bars and Beats Positions When Inserting Notes (Pokaż pozycje taktów i uderzeń podczas 
wstawiania nut )
      Pokazuje pozycje taktów i uderzeń podczas wstawiania nut za pomocą myszy lub klawiatury 
      komputera.
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Show Pitch When Inserting Notes (Pokaż wysokość podczas wstawiania nut)
      Wskazuje wysokość dźwięku podczas wstawiania nut.
Use Mouse Wheel to Transpose Notes (Użyj kółka myszy, aby transponować nuty)
      Umożliwia transpozycję wybranych nut za pomocą kółka myszy.
Show Note Info by the Mouse (Pokaż informacje o nucie za pomocą myszy)
      Wyświetla podpowiedź z informacjami o wysokości i pozycji podczas wstawiania lub 
      przeciągania nuty w partyturze.

Layout Tool (Narzędzie układ)
Global Staff Spacings with Alt/Opt - Ctrl/Cmd (Globalne odstępy między pięcioliniami za 
pomocą Alt/Opt – Ctrl/Cmd)
      Stosuje odstępy do wszystkich pięciolinii na bieżącej i wszystkich kolejnych stronach, gdy 
      naciśniesz Alt/Opt - Ctrl/Cmd i dostosujesz odstępy między pięcioliniami.
Show Braces in Edit Mode (Pokaż nawiasy klamrowe w trybie edycji)
      Pokazuje nawiasy klamrowe także w Edit Mode (Trybie edycji), nie tylko w Page Mode    
      (Trybie strony).
Unlock Layout When Editing Single Parts (Odblokuj układ podczas edycji pojedynczych części)
      Jeśli na ścieżce znajduje się więcej niż jedna część i otworzysz Score Editor (Edytor partytury) 
      dla jednej z tych partii, pozostałe partie zostaną wyświetlone jako puste miejsce, aby zachować 
      układ. Jeśli ta opcja jest aktywna, ta pusta przestrzeń jest omijana, dzięki czemu można 
      drukować tę pojedynczą część bez niekończących się przerw.

UWAGA
Ta opcja usuwa układ całej ścieżki. Gdy następnym razem otworzysz całą ścieżkę, poprzedni układ 
zostanie nadpisany ustawieniami układu wprowadzonymi dla pojedynczej edytowanej części.

Double-Click on Staff Flips between Full Score/Part (Kliknij dwukrotnie przewrót pięciolinii 
pomiędzy pełną partyturą/częścią)
      Przełącza pomiędzy wyświetlaniem całej ścieżki lub bieżącej części po dwukrotnym kliknięciu 
      pięciolinii.

UWAGA
W takim przypadku okno dialogowe Score Settings (Ustawienia partytury) otworzy się tylko 
wtedy, gdy wybierzesz Scores > Settings (Partyrury > Ustawienia).

Miscellaneous (Różnorodne)
Show Position Cursor (Pokaż kursor pozycji)
      Pokazuje kursor projektu jako pionową linię w partyturze. Możesz kliknąć i przeciągnąć linię, 
      aby przesunąć kursor, lub przytrzymać klawisz Ctrl/Cmd i kliknąć w dowolnym miejscu 
      partytury, aby przenieść kursor tam bezpośrednio.
“Apply” closes Property Windows („Zastosuj” zamyka okna właściwości)
      Zamyka okna właściwości i niemodalne okna dialogowe po kliknięciu Apply (Zastosuj).
Hide Notes beyond Limits (Ukryj nuty poza limitami)
      Ukrywa nuty poza zakresem Note Limits (Limitów nut) ustawionym w oknie dialogowym   
      Score Settings (Ustawienia partytury) (strona Staff (Pięciolinia) – zakładka Options (Opcje)).
Default Number of Bars per Staff (Domyślna liczba taktów na pięciolinię)
      Stosuje się to w 2 przypadkach:
      ● W trybie edycji określa liczbę taktów wyświetlanych na stronie.
      ● W trybie strony ustawia liczbę taktów wyświetlanych na stronie w nowym układzie.
UWAGA
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Podczas korzystania z funkcji Auto Layout (automatycznego układu) zostaniesz poproszony o 
podanie maksymalnej liczby taktów na stronie, co spowoduje zastąpienie tego ustawienia.

Scores - Note Layer (Partytury - warstwa nut)

Podczas przenoszenia i edytowania notatek możesz przypadkowo przesunąć inne obiekty w 
pobliżu. Aby tego uniknąć, możesz przypisać różne typy obiektów do różnych warstw nut (do 3)
i poinstruować Cubase, aby zablokował jedną lub 2 z tych warstw, uniemożliwiając ich 
przesuwanie. Na tej stronie określasz, do której warstwy należy każdy typ obiektu. Właściwe 
blokowanie warstw odbywa się na rozszerzonym pasku narzędzi Score Editor (Edytora partytury).

Transport
Ta strona zawiera opcje związane z odtwarzaniem, nagrywaniem i pozycjonowaniem.

Playback Toggle Triggers Local Preview (Przełącznik odtwarzania uruchamia lokalny podgląd)
      Umożliwia użycie Space (spacji) na klawiaturze do rozpoczęcia/zatrzymania lokalnego 
      odtwarzania wybranego pliku w Sample Editor (Edytorze próbek) lub w Pool (puli).
      Gdy Sample Editor nie jest otwarty lub gdy w Pool nie jest wybrany żaden plik audio, Space   
      (Spacja) nadal przełącza globalne odtwarzanie projektu.
Show Timecode Subframes (Pokaż ramki pomocnicze kodu czasowego)
      Pokazuje ramki pomocnicze dla wszystkich formatów wyświetlania opartych na ramkach.
User-definable Frame Rate (Definiowana przez użytkownika liczba klatek na sekundę)
      Umożliwia ustawienie szybkości klatek dla formatu wyświetlania linijki User (Użytkownika).
Return to Start Position on Stop (Wróć do pozycji początkowej po zatrzymaniu)
      Automatycznie ustawia kursor projektu w pozycji, w której ostatnio rozpoczęło się nagrywanie 
      lub odtwarzanie, gdy zatrzymasz odtwarzanie.
Stop Playback while Winding (Zatrzymaj odtwarzanie podczas przewijania)
      Zatrzymuje odtwarzanie po kliknięciu przycisku Rewind (Przewiń do tyłu) lub Fast Forward  
      (Przewiń do przodu) na panelu Transport.
Wind Speed Options (Opcje prędkości przewijania)
      Opcje te wpływają na prędkość szybkiego przewijania do przodu/do tyłu.
      ●   Adjust to Zoom (Dostosuj do powiększenia) dostosowuje prędkość przewijania do 
           współczynnika powiększenia w poziomie. Jeśli przybliżysz bardzo blisko w celu 
           szczegółowej edycji, prawdopodobnie nie chcesz, aby prędkość przewijania do przodu/do 
           tyłu była duża. Z tego powodu Speed Factor (współczynnik prędkości) nie ma żadnego 
           wpływu w tym trybie. Fast Wind Factor (Współczynnik szybkiego przewijania) nadal 
           obowiązuje.
      ●   Fixed (Stała) utrzymuje stałą prędkość wiatru niezależnie od współczynnika powiększenia w
           poziomie.
      ●   Speed Factor (Współczynnik prędkości) umożliwia ustawienie prędkości przewijania.  
           Można ustawić wartość od 2 do 50. Im wyższa wartość, tym większa będzie prędkość 
           przewijania. Jeśli włączona jest opcja Adjust to Zoom (Dostosuj do powiększenia), nie daje 
           to żadnego efektu.
      ●   Fast Wind Factor (Współczynnik szybkiego przewijania) umożliwia ustawienie 
           wielokrotności prędkości przewijania w celu szybkiego przewijania.
           Jeśli naciśniesz Shift podczas szybkiego przewijania do przodu lub do tyłu, prędkość   
           przewijania wzrośnie. Wzrost prędkości jest wielokrotnością Speed Factor (Współczynnika 
           prędkości). Oznacza to, że jeśli ustawisz Fast Wind Factor na 2, prędkość przewijania   
           będzie dwa razy większa. Jeśli ustawisz wartość na 4, prędkość przewijania będzie 4 razy 
           większa itd. Możesz ustawić wartość od 2 do 50.
Cursor Width (Szerokość kursora)
      Dostosowuje szerokość linii kursora projektu.
Zoom while Locating in Time Scale (Powiększ podczas lokalizacji w skali czasu)
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      Umożliwia powiększanie i pomniejszanie poprzez kliknięcie linijki i przeciągnięcie w dół lub w
      górę.
Clicking Locator Range in Upper Part of the Ruler Activates Cycle (Kliknięcie zakresu 
lokalizatora w górnej części linijki aktywuje cykl)
      Umożliwia włączenie/wyłączenie trybu cyklicznego po kliknięciu zakresu lokalizatora w górnej
      części linijki.
Locate when Clicked in Empty Space (Zlokalizuj po kliknięciu w pustej przestrzeni)
      Umożliwia przesuwanie kursora projektu poprzez kliknięcie pustego obszaru okna Project.

Transport – Scrub (Transport - szorowanie)

Scrub Volume (Głośność szorowania)
      Ustawia głośność odtwarzania narzędzia Scrub w oknie projektu i edytorach audio.
UWAGA
Nie ma to wpływu na głośność szorowania kontrolowaną przez podłączony sprzęt.

Use High Quality Scrub Mode (Użyj trybu szorowania wysokiej jakości)
      Włącza efekty do czyszczenia i wykorzystuje wyższą jakość ponownego próbkowania. Jednak 
      szorowanie będzie bardziej wymagające dla procesora.
Use Inserts While Scrubbing (Podczas szorowania używaj wstawek)
      Umożliwia aktywację efektów insertowych podczas szorowania za pomocą kontroli prędkości 
      wahadłowej. Domyślnie efekty insertowe są pomijane.

Interfejs użytkownika
Na tej stronie znajdują się opcje umożliwiające dostosowanie domyślnych kolorów interfejsu 
użytkownika.

Color schemes (Schematy kolorów)
      Umożliwia dostosowanie schematu kolorów aplikacji i pokrywy pulpitu.
      ● Kliknij jeden z kolorów w sekcji Choose Color Scheme (Wybierz schemat kolorów), aby 
         zastosować wstępnie zdefiniowany kolor.
      ● Kliknij pole w sekcji Choose Custom Color (Wybierz kolor niestandardowy, aby otworzyć 
         Color Picker (Próbnik kolorów) i wybrać kolor niestandardowy.
Track & MixConsole Channel Colors (Kolory kanałów Track & MixConsole)
      Umożliwia ustawienie trybu Auto Track/Channel Color Mode (Automatycznego 
      śledzenia/koloru kanału, kolorowanie elementów sterujących ścieżki i kanałów MixConsole 
      oraz określanie jasności wybranych kanałów.
Track Type Default Colors (Domyślne kolory typu ścieżki)
      Umożliwia ustawienie kolorów dla różnych typów ścieżek.
MixConsole Fader Colors (Kolory tłumików MixConsole)
      Umożliwia ustawienie kolorów tłumików poziomu typów kanałów w MixConsole.
MixConsole Rack Colors (Kolory stojaków MixConsole)
      Umożliwia ustawienie kolorów stojaków w MixConsole.
MixConsole Channel Strip Colors (Kolory pasków kanałów MixConsole)
      Umożliwia ustawienie kolorów pasków kanałów w MixConsole.

Dostosowywanie kolorów interfejsu użytkownika
Możesz zmienić kolor pulpitu Cubase, typy ścieżek, okno Project, elementy edytora i elementy 
MixConsole.

PROCEDURA
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1. W oknie dialogowym Preferences (Preferencje) wybierz opcję User Interface > Color Schemes
    (Interfejs użytkownika > Schematy kolorów).
2. Wykonaj jedną z następujących czynności:
      ● Aktywuj domyślny schemat kolorów, klikając go.
      ● Kliknij opcję Choose Custom Color (Wybierz kolor niestandardowy) i w Color Picker 
         (Próbniku kolorów) wybierz nowy kolor.

WYNIK
Schemat kolorów zostanie natychmiast zastosowany.

Interfejs użytkownika — kolory kanałów Track & MixConsole
Umożliwia ustawienie trybu Auto Track/Channel Color Mode (automatycznego 
śledzenia/kanału) w celu pokolorowania elementów sterujących ścieżki i tłumików kanałów oraz 
określenia jasności wybranych kanałów.

Auto Track/Channel Color Mode (Tryb automatycznego śledzenia/kanału w kolorze)
Umożliwia ustawienie trybu automatycznego przypisywania kolorów dla nowych ścieżek lub 
nowych kanałów.
Use Track’s Default Color (Użyj domyślnego koloru ścieżki)
      Nowe ścieżki otrzymują domyślny kolor zdarzenia.
Use Previous Track Color (Użyj poprzedniego koloru ścieżki)
      Nowe ścieżki otrzymują ten sam kolor, co ścieżka znajdująca się nad nimi na liście ścieżek.
Use Previous Track Color +1 (Użyj koloru poprzedniego utworu +1)
      Działa to podobnie do opcji Use Previous Track Color, z tą różnicą, że nowe ścieżki 
      otrzymują kolejny kolor z palety kolorów.
Use Last Applied Color (Użyj ostatnio zastosowanego koloru)
      Nowe ścieżki otrzymują kolor ostatnio zastosowany do zdarzenia/części.
Use Random Track Color (Użyj losowego koloru ścieżki)
      Nowe ścieżki otrzymują losowe kolory ścieżek.

Colorize Tracks and MixConsole Channels (Koloruj ścieżki i kanały MixConsole)
Stosuje kolor ścieżki/kanału do elementów sterujących ścieżki/kanału.
Tracks (Ścieżki)
      Umożliwia zastosowanie koloru ścieżki do elementów sterujących ścieżki.
Folder Tracks (Ścieżki folderów)
      Umożliwia zastosowanie koloru ścieżki folderu do elementów sterujących ścieżki.
MixConsole Channels (Kanały MixConsole)
      Umożliwia zastosowanie koloru kanału MixConsole do elementów sterujących kanału.
Color Strength (Siła koloru)
      Umożliwia regulację intensywności koloru.
Selected Channel Brightness (Wybrana jasność kanału)
      Umożliwia regulację jasności wybranego kanału MixConsole.
Show Color for Selected Channel (Pokaż kolor dla wybranego kanału)
      Koloruje wybrany kanał i nadaje mu większą siłę koloru, zamiast wyświetlać go w kolorze 
      szarym.

VST 
Ta strona zawiera ustawienia silnika audio VST.
Activate ‘Link Panners’ for New Tracks (Aktywuj „Link Panners” dla nowych ścieżek)
      Aktywuje domyślnie Link Panners dla nowych ścieżek, dzięki czemu sekcja nadawcza kanału 
      zawsze odzwierciedla ustawienia panoramy dokonane w sekcji tłumika kanału.
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Warn if realtime mixdown is required in order to include external plug-in (Ostrzegaj, jeśli 
wymagane jest miksowanie w czasie rzeczywistym w celu dołączenia zewnętrznej wtyczki)
      Wyświetla ostrzeżenie, jeśli wymagane jest miksowanie w czasie rzeczywistym.
Default Stereo Panner Mode (Domyślny tryb panoramy stereo)
      Umożliwia określenie domyślnego trybu panoramy dla wstawionych ścieżek audio.
Connect Sends Automatically for Each Newly Created Channel (Connect (połączenie) wysyła 
automatycznie dla każdego nowo utworzonego kanału)
      Automatycznie łączy routing wysyłek dla istniejących kanałów FX podczas tworzenia nowego 
      kanału audio lub grupowego.

Instruments use Automation Read All and Write All (Instrumenty korzystają z automatyzacji 
Odczyt wszystkiego i Zapis wszystkiego)
      Jeśli tę opcję aktywujesz, na stan automatyzacji Read (Odczytu) i Write (Zapisu) w panelach   
      sterowania dla instrumentów VST będą miały wpływ opcje Activate/Deactivate Read for All 
     Tracks (Włącz/Wyłącz odczyt dla wszystkich ścieżek) i Activate/Deactivate Write for All 
     Tracks (Włącz/Wyłącz zapis dla wszystkich ścieżek).
Mute Pre-Send when Mute (Wycisz wstępne wysyłanie po wyciszeniu)
      Wycisza wysyłane sygnały przed tłumikiem, gdy wyciszysz ich kanały.
Default Send Level (Domyślny poziom wysyłania)
      Umożliwia określenie domyślnego poziomu efektów wysyłkowych.
Group Channels: Mute Sources as well (Kanały grupowe: Wycisz także źródła)
      Wycisza kanały, które są bezpośrednio kierowane do kanału grupowego, gdy wyciszysz kanał 
      grupowy. Kanały, które zostały wyciszone przed wyciszeniem kanału grupowego, nie będą 
      pamiętać swojego stanu wyciszenia i wyciszenie zostanie wyłączone, gdy wyciszenie kanału 
      grupowego zostanie wyłączone.

UWAGA
Nie ma to wpływu na sposób pisania automatyzacji wyciszenia.

Delay Compensation Threshold (for Recording) (Próg kompensacji opóźnienia (dla 
nagrywania))
      Minimalizuje skutki opóźnienia wynikające z kompensacji opóźnienia, zachowując 
      jednocześnie dźwięk miksu tak dalece, jak to możliwe. Funkcja Constrain Delay 
      Compensation (Ograniczenie kompensacji opóźnienia) wpływa tylko na wtyczki z 
      opóźnieniem wyższym niż to ustawienie progowe. Domyślnie jest to ustawione na 0,0 ms, co 
      oznacza, że będzie to miało wpływ na wszystkie wtyczki. Jeśli uważasz, że niewielkie  
      opóźnienie jest akceptowalne, możesz podnieść tę wartość progową.

UWAGA
Cubase posiada pełną kompensację opóźnienia – wszelkie opóźnienia występujące w wtyczkach 
VST, których używasz, zostaną automatycznie skompensowane podczas odtwarzania. Jednakże, 
gdy grasz na instrumencie VST w czasie rzeczywistym lub nagrywasz dźwięk na żywo (z 
włączonym monitorowaniem przez Cubase), ta kompensacja opóźnienia może skutkować 
dodatkowym opóźnieniem.

Do Not Connect Input/Output Busses When Loading External Projects (Nie podłączaj szyn 
wejścia/wyjścia podczas ładowania projektów zewnętrznych)
      Zapobiega podłączaniu szyn wejściowych i wyjściowych do portów ASIO systemu podczas 
      ładowania projektów zewnętrznych.

Auto Monitoring (Automatyczne monitorowanie)
Określa sposób, w jaki Cubase obsługuje monitorowanie. Dostępne są następujące opcje:
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      ●   Manual (Ręczny)
           Włącza lub wyłącza monitorowanie wejścia po kliknięciu opcji Monitor.
      ●   While Record-Enabled (Gdy włączone jest nagrywanie)
           Łączy źródło dźwięku z wejściem kanału po kliknięciu opcji Record Enable (Włącz 
           nagrywanie).
      ●   While Record Running (Podczas nagrywania)
           Przełącza na monitorowanie wejścia tylko podczas nagrywania.
      ●   Tapemachine Style (Styl taśmy magnetofonowej)
           Aktywuje monitorowanie wejścia w trybie zatrzymania i podczas nagrywania, ale nie 
           podczas odtwarzania.

UWAGA
Opcje automatycznego monitorowania mają zastosowanie w przypadku monitorowania poprzez 
Cubase lub w przypadku korzystania z bezpośredniego monitorowania ASIO. Jeśli monitorujesz 
zewnętrznie (na przykład słuchasz sygnału wejściowego z zewnętrznego miksera), wybierz tryb 
Manual (Ręczny) i wyłącz wszystkie przyciski Monitor (monitora) audio w Cubase.

Warn on Processing Overloads (Ostrzegaj o przeciążeniach przetwarzania)
      Wyświetla ostrzeżenie, jeśli podczas nagrywania zaświeci się wskaźnik przeciążenia procesora 
      na panelu Transport.

POWIĄZANE LINKI
Eksport w czasie rzeczywistym na stronie 1059

VST - Plug-ins (VST - Wtyczki)

Warn before Removing Modified Effects (Ostrzegaj przed usunięciem zmodyfikowanych 
efektów)
      Wyświetla ostrzeżenie, jeśli usuniesz wtyczkę z efektem, dla której dokonałeś zmian 
      parametrów.
Open Effect Editor after Loading It (Otwórz Edytor efektów po załadowaniu)
      Otwiera panel sterowania efektami podczas ładowania efektów VST lub instrumentów VST.
Create MIDI Track when Loading VSTi (Utwórz ścieżkę MIDI podczas ładowania VSTi)
      Umożliwia określenie, czy po dodaniu instrumentu w stojaku tworzona jest ścieżka MIDI.
      ●   Always (Zawsze)
           Zawsze tworzona jest ścieżka MIDI.
      ●   Do not (Nie)
           Nie została utworzona żadna ścieżka MIDI.
      ●   Always ask to (Zawsze o to proś)
           Zostaniesz zapytany, czy powinna zostać utworzona odpowiednia ścieżka MIDI.
Synchronize Plug-in Program Selection to Track Selection (Synchronizuj wybór programu 
wtyczki, aby śledzić wybór)
      Synchronizuje wybór ścieżek i programów wtyczek, jeśli kierujesz wiele ścieżek MIDI do 
      instrumentów multitimbralnych.
Suspend VST 3 plug-in processing when no audio signals are received (Wstrzymaj 
przetwarzanie wtyczki VST 3, gdy nie zostaną odebrane żadne sygnały audio)
      Wstrzymuje przetwarzanie wtyczki VST w fragmentach, w których przez wtyczkę nie 
      przechodzi żaden dźwięk. Może to znacząco poprawić wydajność systemu.

UWAGA
Zalecamy pozostawienie tej opcji wyłączonej.
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Plug-in Editors “Always on Top” (Edytory wtyczek „Zawsze na wierzchu”)
      Zawsze pokazuje panele sterowania dla wtyczek efektów i instrumentów VST nad innymi 
      oknami.

VST - Control Room (VST – sterownia¸reżyserka)
Ta strona zawiera ustawienia Control Room.

Show Control Room Volume in Transport Panel (Pokaż głośność sterowni w panelu transportu)
      Jeśli Control Room jest włączona, głośność Control Room jest wyświetlana na panelu 
      Transport.
Auto Disable Talkback Mode (Automatyczne wyłączanie trybu rozmowy)
      Określa, czy funkcja Talkback jest wyłączona podczas nagrywania, odtwarzania i nagrywania, 
      czy też nie jest w ogóle wyłączona.

UWAGA
Ustaw poziom Talkback DIM na 0 dB, aby nie zmieniać radykalnie poziomu miksu podczas 
wchodzenia i wychodzenia z trybu nagrywania.

Use Phones Channel as Preview Channel (Użyj kanału Phones jako kanału podglądu)
      Wykorzystuje kanał telefoniczny do monitorowania.
Dim Cue during Talkback (Przycisz sygnał podczas rozmowy)
      Przyciemnia sygnał dźwiękowy słyszany w studiu o wartość ustawioną w polu poziomu    
      Talkback Dim w Control Room na tak długo, jak długo używany jest kanał talkback.
Exclusive Device Ports for Monitor Channels (Ekskluzywne porty urządzeń dla kanałów 
monitorowych)
      Sprawia, że przypisanie portów dla kanałów monitora jest wyłączne. Jeśli Twój scenariusz nie 
      wymaga przypisania portów do kilku kanałów monitora, zaleca się aktywację tej opcji. W ten   
      sposób możesz mieć pewność, że nie przypiszesz przypadkowo portów do wejść/wyjść i 
      jednocześnie będziesz monitorować kanały.

UWAGA
To ustawienie jest zapisywane z ustawieniami wstępnymi Control Room.

Reference Level (Poziom odniesienia)
      Umożliwia określenie poziomu odniesienia, który można przypisać do poziomu Control Room.
      Poziom odniesienia to poziom stosowany w skalibrowanych środowiskach miksowania, takich 
      jak sceny dubbingu filmów.

UWAGA
Możesz także ręcznie dostosować poziom odniesienia w ustawieniach Control Room.

Main Dim Volume (Główna przyciemniona głośność)
      Ustawia wielkość redukcji wzmocnienia zastosowaną do kanału Control Room, gdy przycisk 
      DIM jest aktywny.
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VariAudio

Inhibit warning when changing the Sample Data (Ostrzeżenie o wstrzymaniu podczas zmiany 
danych próbki)
      Blokuje wyświetlanie ostrzeżenia w przypadku modyfikacji materiału audio używanego w kilku
      miejscach projektu.
Inhibit warning when applying Offline Processes (Zablokuj ostrzeżenie podczas stosowania 
procesów offline)
      Blokuje wyświetlanie komunikatu ostrzegającego, gdy zastosujesz procesy offline do materiału 
      audio, który jest używany w kilku miejscach projektu.

Video (Wideo)

Extract Audio on Import Video File (Wyodrębnij dźwięk podczas importowania pliku wideo)
      Wyodrębnia i zapisuje dane audio zaimportowanych plików wideo jako oddzielny klip audio.
Thumbnail Memory Cache Size (Rozmiar pamięci podręcznej miniatur)
      Umożliwia ustawienie rozmiaru pamięci podręcznej miniatur.
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